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Introduction

With Autodesk®  Architectural Desktop, you can move 

smoothly from 2D drafting to building information 

modeling in an AutoCAD-based environment. Autodesk 

Architectural Desktop respects your current practices 

and helps you to take advantage of your knowledge of 

AutoCAD software. You can reap productivity benefits 

because the many features offered by Autodesk Archi-

tectural Desktop, such as intelligent architectural 

objects, minimize tedious drafting and rework and pro-

vide powerful software for design and documentation.

Autodesk provides many resources to ensure that you 

quickly become productive with Autodesk Architectural 

Desktop and the many new features available in this 

release of the software. Online and print documenta-

tion, real-world tutorials, and technical support chan-

nels help answer your questions as you begin working 

with the software.

In this Chapter

� Where to Begin

� Finding Help

� Contacting Autodesk

1
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Where to Begin

After you have installed Autodesk Architectural Desktop 2004, you can begin 
drawing according to your level of experience, whether you are a skilled user 
who is upgrading from a previous version or a user who is new to Autodesk 
products.

Additional Topics

� Beginning Users

� Experienced Users

Beginning Users

If you are a new user of Autodesk Architectural Desktop, you can begin by 
completing some of the procedures in the tutorials. Tutorials are exercises 
designed to take you through practical applications. For more information 
on running the tutorials, see “Online Documentation” in “Finding Help” on 
page 2.

If you are new to AutoCAD 2004, it is important to begin with AutoCAD 

tutorials or AutoCAD Learning AssistanceTM and to refer often to the online 
AutoCAD 2004 User’s Guide.

Experienced Users

If you are upgrading from a previous version of Architectural Desktop, see 
“Autodesk Architectural Desktop 2004 Overview” on page 7 to read about 
the new features and improvements. Additionally, refer to the online 
AutoCAD 2004 User’s Guide to find out about important innovations in 
AutoCAD drawing tools.

Finding Help

There are various available resources to help you learn about Autodesk 
Architectural Desktop 2004 and AutoCAD 2004.

Additional Topics

� Online Documentation
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Online Documentation

The following online manuals help you learn more about both Autodesk 
Architectural Desktop 2004 and AutoCAD 2004.

The advantage of online manuals is that they present information quickly 
while you are in a drawing session. Although online Help topics provide 
some conceptual and overview material, their main purpose is to help you 
get a task done efficiently. Therefore, the Architectural Desktop online Help 
emphasizes step-by-step procedures relevant to command selection. It also 
incorporates visual examples and links to more information.

Additionally, online tutorials are an excellent way to become familiar with 
Autodesk Architectural Desktop. You can use the tutorials to learn program 
concepts, and you can keep the tutorial window open in the drawing area 
while you perform the steps.

To access online Help

� From the Help menu, choose Architectural Desktop Help or AutoCAD 
2004 Help.

When the Help window is displayed, browse Contents to locate the infor-
mation you need or look up index entries to pinpoint specific topics.

To access online tutorials

� From the Help menu, choose Architectural Desktop Tutorial.

When the Help window is displayed, browse Contents to locate the 
Autodesk Architectural Desktop tutorials. The tutorials are available in 

Documentation Description

Autodesk Architectural Desktop 2004 
Installation Guide

Explains how to install and configure 
Autodesk Architectural Desktop 2004.

Autodesk Architectural Desktop 2004 Help Explains Autodesk Architectural Desktop 
concepts and provides step-by-step 
procedures. Includes a glossary with 
definitions of Autodesk Architectural 
Desktop terms.

AutoCAD 2004 User’s Guide Provides conceptual and overview 
material with step-by-step procedures 
for AutoCAD 2004.
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either metric or imperial units and include datasets that correspond to 
each exercise.

Contacting Autodesk

Autodesk, Inc.
11 McInnis Parkway
San Rafael, CA 94903 USA
Phone: 415-507-5000
Web site: http://www.autodesk.com

Additional Topics

� Sales Information

� Customer Satisfaction

� Technical Support

� Feedback

Sales Information

To purchase additional Autodesk software, contact your local reseller. For the 
name of the authorized reseller nearest you, call 1-800-964-6432 or access the 
Resellers and Training Centers web site, http://www.autodesk.com/resellers/
index.htm.

Customer Satisfaction

Phone: 1-800-538-6401
FAX: 603-621-3387
Web Site: http://www.autodesk.com/feedback/

Technical Support

If you have technical questions about the products, you should contact your 
local reseller or check the frequently asked questions (Technical Solutions & 
FAQS) section and Discussion Groups on the web site for Architectural 
Desktop at http://www.autodesk.com/archdesktop. News groups are another 
good source of information. You can look through the questions that have 
already been posted, or you can post your own questions.
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Feedback

Let us know what you think! If you have a suggestion for product enhance-
ment or a compliment, or a complaint, or if you think you have found a bug, 
then we’d like to know about it.

To make comments and find additional information, visit our Web site at 
http://www.autodesk.com/archdesktop.
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Autodesk Architectural 
Desktop 2004 Overview

Autodesk®  Architectural Desktop 2004 improves your 

design and documentation efficiency while protecting 

your technology investment. It gives you the best of 

both worlds by providing traditional drafting methods 

in an AutoCAD®  environment, as well as efficiency 

gains through intelligent building model objects. And 

now Architectural Desktop offers new productivity tools 

such as a streamlined user interface and direct manipu-

lation of architectural objects; coordination features like 

file and level management; design visualization features 

such as Autodesk®  VIZ Render; and collaboration and 

data exchange tools like Export to AutoCAD and inte-

gration with the Autodesk®  Buzzsaw™  online collabora-

tion service.

Autodesk Architectural Desktop—building information 

modeling on the AutoCAD platform. 

In this Chapter

� Productivity: Reduce Tedious 
Drafting Tasks

� Coordination: Do the Work 
Once

� Design Visualization: Bring Your 
Designs to Life

� Collaboration: Work Effectively 
with Your Extended Design 
Team

2
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Productivity: Reduce Tedious Drafting Tasks

With intelligent architectural objects—such as walls, doors, and windows 
that relate to each other logically—Autodesk Architectural Desktop provides 
many tools that automate tedious drafting tasks. Enhancements to the 
Autodesk Architectural Desktop user interface, and new features such as 
direct manipulation, let you easily make changes in a workspace that is both 
visual and intuitive, providing a smoother, nondisruptive means of design. 

Streamlined User Interface

The streamlined user interface in Autodesk Architectural Desktop marks a 
dramatic improvement from traditional CAD design software in terms of 
“look and feel” and overall functionality. Highly visual and more intuitive, 
the new interface makes the software even easier to use. With less focus on 
dialog boxes and more emphasis on designing directly in the workspace, the 
software's design tools speak your language—the language of design. 
Enhanced tool palettes and the Properties palette as well as the new Content 
Browser complement the redesigned workspace to help you work more effi-
ciently. 

Tool Palettes
Tool palettes provide instant access to a complete inventory of stock 
Autodesk Architectural Desktop tools, such as walls, doors, and windows. 
Highly visual, tool palettes include a preview of each style. 

You can create custom tool palettes that address your specific design needs. 
For example, you might create a single palette to store a custom list of com-
monly used curtain wall, stair, and window styles. You could then group 
these tool palettes into project-based catalogs. Because tool palettes and cat-

alogs both use i-drop® technology, they can be posted externally—on an 
intranet, the Web, or the new Content Browser—and accessed via drag-and-
drop functionality.
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Tool Palettes are highly visual and customizable

Tool palettes also provide the following functionality:

� Docking—You can dock tool palettes so they are always visible and easily 
accessible.
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Tool palettes can be docked for more design space

� Auto-hide—When this feature is on, inactive tool palettes are minimized, 
increasing screen space.

� Transparency—Save screen space by displaying the drawing geometry 
beneath the tool palette. You can even apply transparency to the com-
mand line.

� View customization—View options let you modify the appearance of tools 
to suit your environment. Detailed tool descriptions make it easier to 
learn about new tools. Once you are familiar with the tools, you can 
switch to icon-only tool display to save screen space. You can apply view 
options to individual tool palettes or to all tool palettes at once.

� Icon creation—Auto-generate the icon from a preview image of the object 
or select a JPG, PNG, or BMP file.

� Tool grouping—You can group multiple tool palettes into project-based 
catalogs.

� Palette refresh—Refresh the tools on a palette, including an individual 
tool’s properties retrieved from a tool catalog, over your intranet or the 
Internet.
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Tool palettes support transparency

Properties Palette
The enhanced Properties palette consolidates tools for adding and modifying 
building model objects into a single, consistent user interface, eliminating 
the add and modify dialog boxes. The Properties palette also provides a hier-
archical display of design options, ranging from basic to advanced. 

In addition, the Properties palette gives you access to two other key features: 
extended property set data, for scheduling purposes; and worksheets, for 
more design options. 

The Properties palette provides the following enhancements:

� A centralized location for adding and modifying objects
� Hierarchical display of basic and advanced modification options
� Easy access to extended object data and worksheets
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The Properties Palette supports design changes in one consistent user interface

Content Browser
The new Content Browser provides quick access to Autodesk Architectural 
Desktop tools—such as catalogs, tool palettes, and design content—in the 
form of blocks and multi-view blocks. The Content Browser is the central 
location for project-based tools and content, ensuring that every member of 
your design team has access to the most up-to-date tools.
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Create catalogs for specific projects

The Content Browser enhances data exchange with its use of i-drop technol-
ogy. You and your team members can drag standard, project-based, and man-
ufacturer content via your own company intranet or over the Web.

Browse project-based catalogs for specific tools; drag and drop them onto tool 
palettes
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Menus
Menus have been streamlined to contain all-purpose application commands 
and access to formatting and manager dialog boxes, such as the Style Man-
ager and Display Manager.

Drawing Window Status Bar
The new Drawing Window status bar provides access to pertinent informa-
tion and tools for each drawing. Now you have a central location to access 
the following:

� Project information—Displays the project name associated with your cur-
rent drawing to let you know that you're in the correct project or that you 
need to associate the drawing to a project. For more information, see 
“Drawing Management” on page 209. 

� Display configuration information—Shows the drawing's current display 
configuration. This tool provides a central location to toggle to different 
levels of plan view detail. It also lets you switch to other views of your 
design, such as Reflected and Presentation, providing even more control 
over display of your designs.

� Drawing Management information—Indicates whether the current draw-
ing is a sheet, view, construct, or element, and gives the drawing name. 
(Sheets, views, constructs, and elements are part of the new Drawing Man-
agement feature.)

� Xref Manager—If a colleague revises a file associated with your current 
drawing, the Xref Manager icon alerts you if external references require 
reloading. This ensures that you are working with the most current view 
of your overall design.

Xref Manager notifies you of drawing updates

� Communication Center—This in-product notification system keeps you 
up-to-date on service pack availability. It also provides information for 
Autodesk Subscription Program members, such as extension availability, 
product tips and tricks, and product support information.
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Communication Center provides access to software updates

� Drawing menu—This tool provides a central location to launch common 
setup and export operations, such as the following:

� Drawing Setup—Set up units, annotation scale, and layer schemes
� Plot—Plot DWGs to paper sheets or publish to DWF™  (Design Web For-

mat™  ) files
� Publish to Autodesk®  Architectural Studio—Import drawings into a 

running version of Autodesk Architectural Studio for review
� Link to Autodesk VIZ Render—Transfer designs to VIZ Render for 

design visualization
� Publish to web—Make designs available for review via a web browser
� eTransmit—Send files to colleagues

Drawing Menu provides a central location to do common tasks such as plotting
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Style Manager
In earlier releases, the Style Manager provided access to every style-based 
object in Autodesk Architectural Desktop, and the advanced grouping and 
filtering options enhanced productivity and ease of use. 

In this release, the enhanced Style Manager takes productivity a step further 
by introducing grouping by functionality.

The Style Manager is now grouped into the following categories: 

� Architectural (such as doors, walls, and windows)
� Documentation (such as sections, elevations, and schedules)
� Multi-purpose (such as profiles and material definitions) 

Grouping by functionality helps you to focus at a glance on a specific object 
style. Filtering functionality is still available, giving even more control over 
display of the Style Manager.

New grouping enhancement sorts objects by use for faster access

Display Manager
The Display Manager lets you quickly change the way your designs are dis-
played. By clicking a button, you can change the level of detail that your 
floor plans display, without layer manipulation. You can even change the 
way your design data is displayed through various phases of design. For 



Productivity: Reduce Tedious Drafting Tasks | 17

example, you can change the view from a plotted floor plan to a reflected 
ceiling plan to a custom plan, such as demolition, without creating separate 
drawings for each view. And because each view is based on your design, any 
change you make is reflected properly throughout all views of your design 
data.

Autodesk Architectural Desktop 2004 improves the Display Manager with 
the introduction of classifications. Classifications give you even more display 
control over your designs because you control the view of all AEC objects and 
multi-view blocks independently, without layer manipulation. 

With classifications, for example, you can create clean structural base sheets 
that display only walls (bearing), grids, slabs, openings, structural members, 
and multi-view blocks (such as column labels and structural member call-
outs) without needing to freeze the layers of other objects and multi-view 
blocks (such as stairs and door tags).

Use the Display Manager to switch to multiple views of your building model

Layer Manager
Autodesk Architectural Desktop enhances the Layer Manager with tools for 
layer standardization. Because the Layer Manager also supports project-based 
standards through layer key styles, you can keep a library of layer standards 
to use as needed. 

Although you can create your own layer standards, Autodesk Architectural 
Desktop provides the following standards for local, regional, and even inter-
national projects:

� AIA
� BS1192
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� DIN 276
� ISYBAU
� STLB

Using the Layer Manager, you can be confident that everything you draw is 
placed on the correct layer, reducing manual layer management and ensur-
ing accuracy. 

The Autodesk Architectural Desktop Layer Manager enables you to:

� Define project-based layer standards through layer keys
� Override layer standards to account for status changes such as New, Exist-

ing, or Demolition
� Remap a drawing from one layer standard to another during file exchange

Layer Manager assigns layers as you design

Direct Manipulation

Direct manipulation is the ability to make common design modifications or 
to explore alternate design possibilities directly on an object, without dialog 
boxes. This streamlined approach to design enhances productivity by keep-
ing you focused on the task at hand.
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Direct manipulation functionality has been implemented for all Autodesk®  
Architectural Desktop building model objects. It enables you to make design 
changes with either grip manipulation or in-place object editing. 

Grips
With enhanced grip functionality, you can make quick design changes 
directly in the workspace, without using dialog boxes. With a single click, 
you can perform design changes such as adjusting door widths and window 
heights, modifying wall rooflines, or reversing wall direction. 

Use grips to adjust position, height, and width of AEC objects without dialog boxes

Tooltips indicate the function that each grip performs. An added enhance-
ment is dynamic dimensions. As you make design changes, dynamic dimen-
sions ensure that your changes are precise and accurate. You enter values 
directly in the workspace, eliminating the need to enter numeric input at the 
command line.
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Grips provide tooltips, enhancing ease of use

Edit-in-Place
The new Edit-in-Place functionality reduces the number of steps required to 
edit or create object styles, significantly enhancing design productivity. And 
because you can make design changes directly in the workspace, you stay 
focused on the task at hand, working fluidly with your designs. 

Edit-in-Place functionality enables you to:

� Create custom profiles as you work
� Customize existing object styles or create new ones as you work
� Explore different design alternatives quickly and easily

Building Model Enhancements

Autodesk® Architectural Desktop 3.3 enhanced user productivity by adding 
objects such as curtain walls, window assemblies, and structural members. 
Autodesk Architectural Desktop 2004 takes productivity a step further by 
extending the usability of objects, so that you can design faster and more 
accurately in an AutoCAD-based environment.

Areas and Area Groups
After the floor plan design is complete, you can calculate areas and group 
them to export pertinent information from your model in various formats, 
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such as Microsoft®  Excel. You use areas and area groups to create an area eval-
uation of a floor plan. You can even add modifiers, such as price per unit area, 
to each area or group and extract cost estimations based on your designs, 
which saves time compared to calculating these estimates manually.

Group and color-code areas

Spaces
You can create spaces from closed boundaries, such as walls and linework. 
Use the Auto Generate feature to quickly create color-coded space studies for 
the purpose of generating reports, such as room finish schedules. 
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Space information can be used to generate reports that you can export to an external 
database

Mass Elements
Not only are mass elements instrumental throughout the conceptual phases 
of the design process, but they can also be used effectively in design develop-
ment. These multi-purpose elements can aid you in creating complex mass-
ing models or in adding detail to other architectural elements, such as a 
recess in a wall, to indicate design intent.

Enhancements for Autodesk Architectural Desktop 2004 include the follow-
ing:

� Mass element styles—Save mass element styles with display, material, and 
classification settings for reuse

� Free-form editing—Use new grip functionality for face, vertex, and edge 
modification

� Trim/split behavior—Create planes for trimming or splitting mass ele-
ments
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New direct manipulation options allow you to easily modify mass elements

� Above and below cut plane display—Define cut plane and plan view dis-
play of mass elements

� Drape—Convert polylines with different elevations into a free-form mass 
element that can represent terrain. Because it is a mass element, you can 
then use the Boolean operations (addition, subtraction, intersection) for 
cut and fill

Convert contour lines to terrain models
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Walls
With enhancements to wall creation, display, and cleanup, walls provide 
even greater productivity boosts through their increased ease of use. 

Wall creation: Creating wall styles is easier because of the enhanced Wall 
Style properties interface. This tool includes features such as the following: 

� Real-time Preview Pane—Updates your wall preview as you add and adjust 
components, ensuring that you get exactly what you want.

Preview Pane updates in real time as you adjust components

� Auto-Calculate Edge Offset toggle—Adjusts the distance between wall 
components.

� Wall Style browser—Explore a library of wall styles on a component level, 
and save time by dragging them into your new wall style.
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Browse existing wall components; drag and drop them into new wall styles

� Curved wall display—Faceting has been removed from wireframe views of 
any curved AEC object, such as walls. 

Wall Display: Autodesk Architectural Desktop has improved wall display in 
2D and 3D with the following enhancements:

� Global cut plane—Set the cut plane globally at specified heights for all 
walls in your current drawing.

� Endcap—Create endcaps directly on walls through the Edit-in-Place fea-
ture.

� Opening endcaps—For even greater detail, openings for endcaps now 
appear in 3D.

Create more detailed sections with 3D endcaps
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Wall Cleanup: The following enhancements to wall cleanup help to make 
you more productive: 

� Xref cleanup—Walls clean up across external reference files so that you 
can organize and manage designs more efficiently. For more information, 
see “Drawing Management” on page 209.

New cleanup options allow walls to clean up across xrefs

� Graphline toggle—Enhanced grips let you directly manipulate cleanup 
radii with graphic information displayed.

� Additional clean-up routines—The added “T” and “L” routines automate 
common cleanup tasks. You can even extend or trim a wall to an xref wall.
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Create sweeps by adjusting wall profiles

Doors
Doors have been enhanced because of the system-wide implementation of 
the direct manipulation functionality and enhanced display controls in 
Autodesk Architectural Desktop.

Direct manipulation enhancements include the following:

� Edit-in-Place—Edit existing or create custom door styles.
� Grips—Easily adjust door standard sizes (width and length) and position.
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In-Place editing allows you to make design changes quickly and easily

Enhanced display control includes the following:

� Dynamic dimensions—Appear upon door insertion and provide visual 
feedback.

� Above/below cut plane display—Controls appearance of panel, swing, 
stop, and frame.

� Muntins—Add further graphic detail to the glass component of door pan-
els for more accurate sections and elevations.

In addition to a useful collection of stock door styles, Autodesk Architectural 
Desktop provides the following door types for custom door style creation: 

Door Types

Accordion Overhead Single-Double Hung

Bifold Double-Double Hung Sliding

Bifold Double Panel Sliding Double 
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Windows
Windows also benefit from the system-wide implementation of direct 
manipulation functionality and enhanced display controls in Autodesk 
Architectural Desktop.

Direct manipulation enhancements include the following:

� Edit-in-Place—Edit existing or create custom window styles.
� Grips—Easily adjust window standard sizes (width and length) and posi-

tion.

Enhanced display control includes the following:

� Dynamic dimensions—Appear upon window insertion and provide visual 
feedback.

� Above/below cut plane display—Controls appearance of frame, sash, and 
glass.

� Muntins—Add further graphic detail to the glass component of windows 
for more accurate sections and elevations.

Temporary dimensions aid in accurate placement of windows, doors, and other 
openings.

Communicating Passthrough Sliding Triple

Double Pocket Uneven

Double Opposing Revolving Uneven Double Hung 

Double Pocket Single

Door Types
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Parametric muntins come in seven basic types that you can modify for more 
complex window designs:

* Indicates new types available only in this release. 

In addition to a useful collection of stock window styles, Autodesk Architec-
tural Desktop provides the following window types for custom window style 

creation:

Openings
With Autodesk Architectural Desktop, you can easily create an opening that 
interacts with walls. Simply highlight a wall, right-click, and choose Opening 
from the wall's insert options. Openings have been enhanced to provide 
more graphic detail in plan view. New display control over openings lets you 
represent openings with hatch patterns as well as custom blocks.

New to this release, hatching options include Cross A, Cross B, Triangle A, 
and Triangle B.

Parametric Muntin Types

Diamond Prairie-9 Lights* Sunburst

Gothic Rectangular

Prairie-12 Lights* Starburst

Window Types

Awning-Transom Horizontal Pivot Single Hopper

Double Casement Passthrough Single Hung

Double Hung Picture Uneven Double Hung

Glider Single Awning Uneven Single Hung

Hopper-Transom Single Casement Vertical Pivot
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Openings have more display options

Curtain Walls
Use Autodesk Architectural Desktop curtain walls to create parametric cur-
tain walls for commercial and institutional project designs. Curtain walls 
have a high capacity for detail and are easy to use. You can use them as the 
basis for accurate sections, elevations, and details.

You can also create curtain walls from custom linework, walls, or layout grids 
and modify them to include doors, windows, window assemblies, curtain 
wall units, and AEC polygons. Enhancements to curtain walls make it easy to 
remove framing members below doors.

Enhancements to curtain walls include the following: 

� Edit-in-Place—Easily adjust frame/mullion position and profiles.
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Adjust mullion spacing with grips

� New worksheets—For frame and infill overrides. 
� Global cut plane—Supports multi-story curtain walls.
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Spanning elements such as curtain walls respect level cut plane heights

Door/Window Assemblies
Door/window assemblies provide a framework for inserting windows or 
doors that are commonly used in the design of storefront windows. With this 
framework, you can create complex door or window groupings for insertion 
into a wall or curtain wall. 
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Convert elevation sketches into intelligent door/window assemblies

Autodesk Architectural Desktop lets you quickly create door/window assem-
blies and convert existing linework, walls, or layout grids to window assem-
blies.

Door/window assemblies offer the following enhancements:

� Sill Plan display representation—You can now display the sill component 
of your assembly.

� Edit-in-Place—Easily edit assemblies “on the fly” without dialog boxes.
� Parametric behavior—Stretch a door/window assembly and it inserts addi-

tional mullions based on design rules that you define.

Stairs
Designing stairs with Autodesk Architectural Desktop is flexible, making it 
easier to create customized shapes. You can modify stair runs and landings 
separately and create non-rectangular stairs or landings with tapered edges or 
a curved shape. Stairs have been enhanced to display more detail in compo-
nents and allow for improved interaction with other objects.
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Stairs can be edited and reshaped by grips. Stairs support customized edges 
based on projection to Autodesk Architectural Desktop objects like walls and 
AutoCAD entities like polylines. The stairs object also supports sloping risers 
used in concrete stairs.

The following features make it easy to explore stair design. And because stairs 
follow proper design codes, you can be confident that your designs are accu-
rate. 

Enhancements to stairs include the following:

� General user interface improvements—Greater control in Add, Properties, 
and Style dialog boxes.

� More detail in components—Riser number display and more stringer 
types, including Saddled, Housed, Slab, and Ramp.

� Interference with walls and slabs—Automatic openings.
� Multi-flight stair enhancements—Stairs can now cross over themselves.
� Spiral stair enhancements—Stairs can be greater than 360 degrees.
� Landing enhancements—Stairs can now start and end with a landing.

Stairs have been greatly enhanced

Railings
Railings in Autodesk Architectural Desktop let you control every aspect of rail 
design while still adhering to design standards. Railings are style based; they 
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support vertical and horizontal railing styles; and they can be freestanding or 
anchored to stairs.

Enhancements to railing include the following:

� Edit-in-Place—Customize railings “on the fly.”
� Extended anchoring—Anchor railings to any AEC object.
� Offsets—Have greater control over the bottom rail component.
� Extensions—Extend posts and balusters below floor level.

Railings anchor to mass elements

Column Grids
The column grids object lets you structure and organize your designs on grid 
work that supports standard and irregular building shapes. You have even 
greater control over the column grid through the following enhancements: 

� Expanded shape support—Generate rectangular, radial, and complex cus-
tom grids from any linework.

� Gridline control—Manually control gridlines with grip movement.
� Enhanced grid bubbles—Control the appearance and placement of grid 

bubbles on standard and custom grids for even more graphic detail.



Productivity: Reduce Tedious Drafting Tasks | 37

� AEC Dimensions—AEC dimension support has been expanded to include 
column grids, giving you instant updates as you explore different grid 
design options.

Easily attach structural members to column grids

Structural Members
Structural members in Autodesk Architectural Desktop include columns, 
beams, and braces. Structural information is kept in an extensive catalog that 
contains industry-recognized steel standards, such as AISC, BS4, CISC, and 
DIN, as well as cast-in-place and precast concrete, timber, and lumber struc-
tural members. 

You can add structural members to column grids for structural plans, and you 
can use structural members to visually check for interferences in your model, 
improving the accuracy and integrity of your designs.
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Use structural members to create framing plans

A structural member has several parameters that define its shape. From pro-
file sweeps to custom block additions, a structural member can be custom-
ized to any type of shape. Additional options let you make a broad range of 
shapes, including tapered members. 

Other customizing options include the following:

� Trimming-in-Place—Trim Plane editing is supported. The structural mem-
ber can also be trimmed with other entities like lines and polylines.

� Block attachment—Attach any block to a member in order to modify its 
shape.

� Start and end shapes—Any component in a structural member can start 
out as one profile and end as another.

� Structural Member Style wizard—The Structural Member Style wizard sup-
plements the existing structural member catalog by letting you create 
alternate sizes for standard structural member shapes. 
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The Structural Member wizard walks you through the creation process

Roof Slabs
Autodesk Architectural Desktop lets you convert existing roofs into roof slabs 
for even greater control of design aspects, such as vertical and horizontal off-
sets, thickness, and slope values. With this palette of slab tools, you can 
extend, trim, or miter the roof slab object, as well as add or remove holes. 
These tools are useful on any project, whether it's residential, commercial, or 
institutional.

Roof slabs support a high level of detail, and through the object's many mod-
ification features, you can model complex roofs and reduce documentation 
time. Because you start with an accurate model, you can extract accurate roof 
sections and elevations.

Roof slabs offer the following functionality:

� Dormers—Routines automatically generate dormers from walls and roofs.
� Hole creation—Add and remove holes in roof slabs.
� Edge styles—Add soffits and fascias for greater detail.
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Roof slabs can be created with fascia and soffit styles

Roof Slab Edges
Roof slabs can be customized to have any edge style, which you can use to 
create roof fascias and soffits. These edge styles are easy to create through the 
use of AEC profiles. You can also define edge orientation, such as plumb or 
square cut. Edit-in-Place functionality lets you make direct changes to fascias 
and soffits without using dialog boxes.

Slabs
Slabs are similar to roof slab objects and support the creation of floors. The 
flexibility of slab objects gives you greater control over your designs. With 
slabs, you have the freedom to create flat or sloped floors with edge styles for 
an even more realistic model, which you can use as the basis for details, sec-
tions, and elevations.

Using an extensive palette of slab tools, you can extend, trim, or miter the 
slab object, as well as add or remove holes.

Slab Edges
As with roof slab edges, you can use slab edge styles to customize floor slabs 
with fascias and soffits. These edge styles are easy to create through the use 
of AEC profiles. You can also define edge orientation of slab edges with 
plumb or square cut options.
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AEC Content
Autodesk Architectural Desktop provides a library of industry-recognized 
metric and imperial symbols that are easily accessible through drag-and-drop 
technology. Content such as furniture, equipment, detail, and elevation 
marks simplify the design process through automated layering, command, 
scale, and text styles that you can customize.

You can add interference conditions to AEC content such as ducts and 
chases, so that the AEC Content interacts with other objects like walls and 
slabs for an even more accurate representation of your building information 
model.

Coordination: Do the Work Once

Because daily revisions are a fact of life in most design projects, it is impor-
tant to have your designs well coordinated with your construction docu-
ments. Autodesk®  Architectural Desktop 2004 ensures that your design work 
is available for immediate use during the documentation process. And 
because your designs are linked to your construction documents, you can be 
confident that any change you make in your design is reflected in your con-
struction documentation, helping to reduce errors and omissions. 



42 | Chapter 2 Autodesk Architectural Desktop 2004 Overview

Materials

Materials are a new addition to Autodesk Architectural Desktop. They can be 
used to provide graphic and non-graphic detail to your drawings for design, 
documentation, and visualization purposes.

Graphically, materials can be attached to AEC object styles and their respec-
tive components for even greater visual detail. For example, you can now 
specify different materials for a door’s panel, frame, stop, and glass compo-
nents. 

Because materials are style based, coordination between designs and con-
struction documents is further enhanced; if you change a material of a wall 
and its individual components, all sections and elevations derived from that 
wall are also updated.

Assign materials to AEC objects, such as wall components

Materials also streamline the way presentation graphics are produced. With 
Autodesk®  VIZ Render (for more information, see “Design Visualization: 
Bring Your Designs to Life” on page 54), you can quickly create visualizations 
at any stage of the design process in a manner that doesn’t disrupt your work. 
At the click of a button, your Autodesk Architectural Desktop designs, com-
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plete with materials, appear in Autodesk VIZ Render for immediate render-
ing.

Though materials are highly visual by nature, they can also be used to pro-
vide nongraphic data. For example, through the use of property set data and 
formulas (for more information, see “Schedule Tables” on page 48), materials 
can provide information for keynoting and quantity take-offs.

Materials provide the following graphical uses: 

� Plan hatching
� Surface hatching

� Displays in both 2D sections/elevations and 3D model views.
� Allows precise control over placement and orientation of hatching per 

face.

� Section hatching
� Sectioned components display material hatching in both 2D and 3D 

live sections. 
� Allows precise control over placement and orientation of hatching per 

face.

� Rendering
� Materials display in shaded 3D views.
� Materials automatically transfer to VIZ Render for visualization.
� Eliminates material assignment via AutoCAD Color Index (ACI). 

Materials provide the following non-graphical uses: 

� Labeling—Use materials to aid in keynoting. 
� Quantify AEC object components—Combine lengths, areas, and volumes 

with property sets and formulas (for more information, see “Schedule 
Tables” on page 48); cost estimates can be extracted.

File and Level Management Tools

Autodesk®  Architectural Desktop has also improved coordination by address-
ing the way your designs are managed. Prior releases simply enabled users to 
continue to use their existing standards for organizing file structure and xref 
relationships managing projects. While continuing to respect your practices 
and standards, this release of Architectural Desktop introduces the new 
Drawing Management feature for users who want to take advantage of its 
automated project and level management tools. 
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Drawing Management
With an emphasis on enhancing coordination through automated xref man-
agement, this long-awaited feature formalizes and automates the processes 
relating to building model design and documentation. This feature provides 
tools that aid you in the management, viewing, and construction of your 
building information model and documents.

Because your project files are managed with this feature, you have consis-
tency throughout all aspects of the project. Everyone on your design team 
will have a centralized project environment for accessing the most current 
documents—from project templates to sections and elevations.

The Drawing Management feature enables you to create and manage 
projects, create and manage levels, and automate sheet creation.

Create and Manage Projects
At the highest level, building information models are organized into 
projects. A project is conceptually composed of two parts—the building 
information model and the reports, which are generated from sheets derived 

from the building information model.

Create and Manage Levels
The Drawing Manager helps you to assign your drawings to levels, which are 
analogous to floors. Levels contain elevation and floor-to-floor height infor-
mation. 
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Manage levels and divisions

Automate Sheet Creation
When you create drawing sheets, Autodesk Architectural Desktop creates and 
names the appropriate drawing file (according to your project specifications) 
and places the new drawing in the relevant project folder. All this, including 
loading pertinent external references (xrefs), is done automatically.

Last, when you create sheets, the viewports, scale, view direction, and display 
configuration are created according to your predefined specifications. Simply 
drag and drop your drawing to a layout sheet, and Autodesk Architectural 
Desktop handles the rest.

Building Model Enhancements

Coordination between designs and construction documents is the corner-
stone of Autodesk®  Architectural Desktop. Design changes, such as moving 
a door, adding a window, or substituting construction materials, can have a 
significant impact on your schedules, sections and elevations, and details. 

Autodesk Architectural Desktop improves this type of coordination with the 
introduction of materials and enhancements to other building model objects 
such as sections and elevations, live sections, schedules, and AEC dimen-
sions.
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Sections and Elevations
Sections and elevations are style based and remain consistent with your 
building information model. When you make a change in your design, the 
sections and elevations are updated, so you save time and can be confident 
that your data is accurate.

Sections and elevations have a high capacity for detail and can be customized 
to fit your design needs. For example, sections and elevations can display 
hidden lines as well as user-defined linework, including other Autodesk 
Architectural Desktop objects or merged vector entities such as lines, 
polylines, arcs, and circles. 

Enhancements to sections and elevations include the following:

� Edit linework in place—This feature has been enhanced. Now you can 
select multiple lines simultaneously. Furthermore, user linework edits are 
applied as soon as sections and elevations are updated, so earlier edits are 
not lost.

� Integrated section and surface hatching—When sections and elevations 
are generated from your model, the material assignments in your design 
generate the appropriate hatch patterns in your sections and elevations, 
eliminating the need to create manual hatch patterns. 

� Material boundaries—Once you have created sections and elevations, you 
can define boundaries for section and surface hatching for presentation 
purposes. Simply draw a closed polyline over your section or elevation 
and convert it to a material boundary. With the boundary in place, you 
can either limit or mask out specific material hatching and linework. 
Material boundaries also support direct manipulation with Edit-in-Place 
functionality. Simply edit the material boundary through grips, and the 
boundary hatching is updated.
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Materials have surface and section hatching (image courtesy of Paul Aubin)

Live Sections
Live sections provide a good way to work on a limited area of a large model, 
with each design change reflected in real time. You eliminate tedious, man-
ual updating of your designs. 

Since live sections now employ materials, they are highly valuable as a design 
visualization tool. Link a live section to VIZ Render to create stunning pre-
sentations.
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Create live sections and toggle sectioned body display on or off

Enhancements for Live Sections include the following:

� Integrated display—Toggle live sections on and off via section lines.
� Material based—Use live sections to display design intent.
� Xref functionality—Create live sections across multiple xref files, includ-

ing your entire building model.
� Sectioned body and face display—Material hatching displays on sectioned 

bodies.
� Supports multiple section lines.

Schedule Tables
The scheduling features in Autodesk Architectural Desktop provide the abil-
ity to track any object or entity in a drawing. Because schedules are dynami-
cally linked to your design data, they are updated as your design changes. 
You can easily create accurate schedules from the building model, making 
you more productive than ever. You can create schedule tables with page 
breaks, tag objects through xrefs, and create schedules of drawings—even of 
your completed building information model.

Enhancements for Schedule tables also include the following:

� Schedules perform page breaks, with the following definable parameters: 
� Direction—Specifies that page overflow is either right or down from 

the schedule table’s insertion point.
� Repeat title—Specifies whether to repeat the schedule table’s title on 

each page.
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� Repeat headers—Specifies whether to repeat the schedule table’s header 
on each page.

� Manual heights—Specifies whether the height of each page is set man-
ually or controlled by the maximum height that you determine.

� Maximum heights—Specifies maximum height for all pages.
� Spacing—Specifies the spacing between each page.

� Improved Display Control
� Control every aspect of your schedule table’s appearance, including 

color and lineweight.

� Tag through Xrefs 
� Tag drawings through xrefs in both model space and paper space.
� Multi-tag—Tag multiple objects at once, reducing tedium.

� Alpha-Increment
� Alphabetic tags increment like their numeric counterparts. 

� Extended Scheduling 
� Schedule external drawing files, such as complete 3D models.

Control table break direction

In this release, scheduling functionality has been greatly enhanced by the 
introduction of formulas, location, and classification properties.

Formulas
Use formulas and schedules to extract and report additional information 
about your building information model. Formulas let you control how this 
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information is displayed in your schedules through concatenation (linked 
properties) and calculation functionality.

For example, you can create a formula that reflects a door’s size simply by 
linking its width and height. A door with a width of 30 and a height of 80 is 
shown as 3080 in the Size column of your schedule table. 

Use formulas to create link schedule information

Using formulas as a calculation tool, you can extract even more useful data 
from your building information model. For example, you can use formulas 
to determine the area of a wall. If you combine formulas with materials, you 
can easily calculate cost estimates.

Location Properties
Assign location properties to AEC objects so that even greater detail can be 
provided about your building information model. 

Location properties provide both graphical and non-graphical data for sched-
uling purposes. For example, you can assign doors to spaces or areas that rep-
resent rooms. With the location property in place, door numbers are gener-
ated based on the room number. 
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Use location properties to link doors to room numbers for enhanced tagging

Classifications
Use classifications to create even more precise schedules. When layer filters 
don’t provide enough control, use classifications to create detailed schedules 
of blocks and other AEC content such as furniture and equipment. For exam-
ple, if you want to create a schedule of chairs listed on the layer A-Furn, you 
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can do so without including other objects, such as desks, that are also on that 
layer.

Use Classifications to schedule generic content

You can create your own custom schedules or choose from the following 
templates:

� Doors
� Equipment
� Furniture
� Room finish 
� Space inventory
� Wall
� Windows

You can use these schedules to track most everything, including quantities 
and cost. Quantities and cost can be multiplied for even more up-to-date 
data.

AEC Dimensions
AEC dimensions give you the ability to create associative dimensions for 
your designs. Associative dimensions update as your designs change, saving 
you time and eliminating the tedium of updating dimensions manually.

Enhancements for AEC Dimensions include the following:

� Support for column grids
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� AEC Dimension wizard guidance to create other dimension styles
� Support for AutoCAD linework (lines, polylines, arcs, circles). Support for 

endpoint, midpoint, center, quadrant dimension points.
� Dimension objects through xrefs
� Override text and linework by hiding text and underline text, adding pre-

fix or suffix to dimension text, or hiding dimension segments (text and 
lines).

� Extended Edit-in-Place grip editing. “Edit Override” state to grip edit 
extension lines and dimension text. 

AEC Dimensions have enhanced grip-editing capabilities
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Design Visualization: Bring Your Designs to 
Life

To communicate their design intent effectively, designers require tools to 
visualize and present their design intent at every stage of the design process 
in a way that is fluid and non-disruptive. New visualization capabilities in 
Autodesk®  Architectural Desktop make this possible.

Autodesk VIZ Render

Autodesk®  Architectural Desktop 2004 marks the introduction of VIZ Render, 
an advanced visualization and rendering tool incorporating industry leading 
technology from Discreet, the creators of 3D Studio Max and Autodesk VIZ. 
Featuring fully automated data linking, VIZ Render provides a visualization 
solution that is effectively integrated into the Autodesk Architectural Desk-
top environment, enhancing design workflow. 

VIZ Render provides a streamlined, interactive environment for exploring 
material finishes and lighting while also offering a range of rendering and 
presentation options for communicating and marketing design intent.

Import and linking
Data Linking between Autodesk Architectural Desktop and VIZ Render is 
fully automated, providing enhanced productivity and workflow. Simply 
select Autodesk VIZ Render from the document fly out and begin visualizing 
your designs. As you develop your design is Architectural Desktop, incremen-
tal changes can be automatically updated.
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Link Autodesk Architectural Desktop designs directly to Autodesk VIZ Render

Materials
Materials from Autodesk Architectural Desktop are linked into VIZ Render 
and are available via the Material palette. In addition, libraries of rendering 
materials are available for both applications through the Content Browser, 
including the VIZ Render extensive, ready-to-use catalog of predefined mate-
rials.

Material placement with Autodesk Architectural Desktop objects has been 
greatly improved with component-level access. Now, you can simply drag 
and drop material directly onto any object component, such as the frame on 
a door. This type of interaction eliminates the need to create multi-sub-object 
materials, as was the case with Autodesk VIZ. VIZ Render recognizes that 
components belong to styles and, therefore, material assignments to individ-
ual components of objects will be applied to all members of that style.

VIZ Render provides the following features:

� New physically based material type to simplify the process of defining 
new materials

� Extensive, ready-to-use catalogue of predefined materials
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� Interactive viewport for fast and direct feedback on material placement

Autodesk Architectural Desktop materials appear in the current Autodesk VIZ Render 
scene

Lighting
VIZ Render uses physically based lights so you can intuitively set up and eval-
uate the lighting in your scenes as you would in the real world. The intensity 
and color of any light can be specified using photometric units. VIZ Render 
also supports the industry-standard IES (Illuminating Engineering Society) 
data format for describing the performance of manufactured lighting fix-
tures. If desired, designers can obtain luminaire photometric data or com-
plete 3D luminaire models from manufacturer web sites for use in their 
scenes. Natural sunlight and daylight can be specified by simply indicating 
the location, date, and time of your scene. 

VIZ Render provides the following features:

� Interactive viewport for fast and direct feedback on lighting setup
� Global illumination algorithms, including radiosity and ray tracing 
� Support for physically based lighting and luminaires
� Support for natural daylight and sunlight 
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� Lighting analysis tools

Autodesk VIZ Render uses real-world lighting 

Rendering
With VIZ Render, you can leverage the building model to produce design pre-
sentations suitable for any stage of design development or marketing. Simply 
place lights in your scene, choose from a clearly presented selection of ren-
dering and output possibilities, and get fast, high-quality renderings of 
designs. 

VIZ Render provides the following features:

� Multiple output formats, including AVI for walkthrough animations and 
panoramic images for real-time panning

� Fast high-quality scanline rendering for quick design studies and presen-
tations
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� Advanced global illumination rendering for photorealistic images and 
animations of the highest caliber 

Create photorealistic renderings

Substitution
Substitution refers to the ability to replace one or more instances of a partic-
ular object in a scene with another object and to streamline the way data 
migrates from Autodesk Architectural Desktop to VIZ Render. It lets you use 
the representation of an object that is most appropriate to the application. 
For example, you may represent a particular light fixture as a 2D symbol 
block on a reflected ceiling plan. Within VIZ Render, you could easily substi-
tute this 2D representation with a full 3D photometric luminaire that would 
be suitable for rendering and lighting analysis. 
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True Color/Color Books Support

Popular color palettes enhance your ability to create presentation-quality 
output. The Select Color dialog box has been updated to include multiple 
tabs. The Index Color tab provides the traditional AutoCAD Color Index pal-
ette, while two new tabs enable you to use real-world color palettes in your 
designs. The True Color tab lets you enter values using either HSL (Hue Satu-
ration Luminance) or RGB (Red Green Blue) color models. The Color Books 

tab lets you select colors from a variety of PANTONE®  and RAL color books.

Gradient Fills

A new Gradient tab available in the Boundary Hatch and Fill dialog box lets 
you apply gradient coloring to solid hatch patterns. Choose between one- 
and two-color options, various gradient patterns, and rotation angle to get 
the gradient you want.

The flexibility of the gradient patterns, combined with the True Color, 
PANTONE, and RAL color options, enables you to create presentation-quality 
drawings in Autodesk Architectural Desktop.

Gradient hatching for presentation graphics
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Shaded Viewport Plotting

You can plot shaded and rendered 3D isometric views for presentation out-
put. Functionality includes the ability to plot shaded/rendered models from 
model space as well as paper space layouts.

Generate Perspectives

Autodesk®  Architectural Desktop provides cameras that you can insert into 
your building information model to create perspectives. Create layout sheets 
for shaded perspective views, complete with materials, and plot these views 
for further analysis and presentation purposes. 

Link perspectives created in Autodesk Architectural Desktop to VIZ Render 
for photorealistic renderings.

Napkin Sketch

Generate Napkin Sketch is a great tool for applying a hand-drawn look to 
your drawing. You can apply this tool to part of your design, such as an area 
that has not been finalized. Or, you can apply a hand-drawn effect to your 
entire design to generate a more artistically pleasing version for presentation 
purposes. You can then further enhance your design in Autodesk Architec-
tural Studio or Autodesk VIZ Render.

Give designs a hand-drawn effect that can be enhanced in Autodesk Architectural 
Studio

AEC Polygons

Primarily a tool to create presentation graphics, AEC polygons can be used to 
provide true color fills for enhancing your designs, such as 3D views of cur-
tain walls and 2D graphic renderings of sections and elevations. 

AEC polygons support the following features:

� True color fills
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� Hatched boundaries
� Boolean operations to combine, intersect, and subtract objects

Collaboration: Work Effectively with Your 
Extended Design Team

Autodesk®  Architectural Desktop works with other Autodesk building design 
solutions and services as well as with third-party applications that address 
specific needs such as estimating or facilities management. Autodesk Archi-
tectural Desktop includes extensive tools and business solutions that let you 
extract vital information from your building information model that can be 
used to save time and money during analysis, estimating, procurement, con-
struction, and management of the building throughout its life cycle. 

AutoCAD 2004 Support

Autodesk Architectural Desktop 2004 is built on AutoCAD®  2004 software—
the latest AutoCAD version. The following sections outline some of the soft-
ware’s enhancements. For a complete listing of AutoCAD 2004 enhance-
ments, please refer to the AutoCAD 2004 Preview Guide.

Export to AutoCAD
Collaborating with professionals who need access only to 2D (DWG) design 
data couldn’t be easier. With the Export to AutoCAD feature, you can easily 
export your designs to AutoCAD 2004 and AutoCAD 2000 DWG and DXF™ 
formats, making file exchange possible without the use of object enablers. 
This feature also has an option to append the ACAD prefix or a user-defined 
prefix to each drawing for easy identification. Combine this functionality 
with web-enabled tools such as eTransmit or the Autodesk Buzzsaw project 
hosting service, and you have a great way to exchange and review data with 
your extended design team.

DWG Performance
Because the DWG file format has been optimized, opening and saving draw-
ings is significantly faster than in previous releases, particularly when DWG 
data is located on a network drive. You save time accessing drawings whether 
they are stored locally or on a network drive.
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Drawing Thumbnails

In Microsoft®  Windows®  Explorer, you can now view thumbnails (preview 
images) in your directory folders. This means you can quickly view and 
access drawings by previewing them first.

Drawing thumbnails in Windows Explorer

Multiline Text (MTEXT)
Valuable enhancements to the Multiline text editor offer easy, timesaving 
functionality for creating and modifying text in drawings. 

Key functionality includes:

� A new frameless editor
� A new shortcut menu
� Support for tabs and indents
� Full display text drag
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Creating new multiline text or double-clicking an existing multiline text 
object displays the new frameless editor with ruler as well as the Text Format-
ting toolbar. If you are zoomed out from the text so that it is too small to 
read, the Multiline Text Editor displays it in an enlarged view. If you are 
zoomed too closely to the text, the editor displays it in a reduced view. If the 
current display of the text is visually appropriate, the editor maintains that 
size. 

Multiline text editor and text formatting toolbar

Drawing Sets
The new Publish feature provides an easy way to publish electronic and paper 
drawing sets. It gives you the flexibility to publish directly to paper or to an 
electronic Design Web Format (DWF), which can be distributed instead of 
paper drawings. The DWF file format has evolved from a representation of a 
single plot to a container that can hold many sheets. This file format is the 
electronic representation of a drawing (or plan) set. 

These publishing tools let you create complete electronic drawing sets in a 
single DWF file. You can minimize the number of files being transmitted and 
avoid confusion regarding file order for viewing and printing. Distributing 
DWF versus DWG files helps to ensure data security, because unlike DWG 
files, DWF files cannot be modified. You can further enhance drawing secu-
rity by using password protection, which prevents unauthorized personnel 
from viewing or printing the DWF-based drawings.

The enhanced DWF—the best format for exchanging files over the Web—
provides the following features:

� Neutral format—Team members don’t need AutoCAD-based software to 
view and plot DWF files. 
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� Easy distribution—The small file size means speedy transmission; team 
members can view DWF files with Autodesk®  Express Viewer, which can 
be attached to an email.

� Security—Recipients can view and plot, but not edit, geometry. 
� Rich information—Metadata, such as layers and named views, remains 

intact. 
� Fidelity—Plot to scale and get the visual fidelity of an AutoCAD DWG file. 
� Flexibility—Combine multiple drawing sheets in a single, convenient file, 

or create multiple DWF files containing individual sheets.

Autodesk Express Viewer Support
Autodesk Express Viewer is a small, fast viewer with easy-to-use tools for any-
one who needs to quickly view and print to scale multi-sheet DWF files. You 
can open a DWF file either by double-clicking it in the Windows Explorer or 
by choosing Open from the File menu. Autodesk Express Viewer supports 
viewing for all DWF file formats, including the new DWF 6. 

Autodesk Express Viewer can be distributed as an ActiveX control for 
Microsoft Internet Explorer or as a stand-alone application. The installation 
file for Autodesk Express Viewer is less than 2MB and can be emailed to 
design partners or posted on a project website.

Drawing Security
New security options, such as password protection and digital signatures, 
offer powerful functionality for transmitting drawings securely. 

Security Options dialog box

Password Protection
Applying password protection to your drawings means you can distribute 
them with the assurance that they cannot be opened by an unintended 
source.
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On the Password tab of the Security Options dialog box, you can provide a 
password that the recipient must enter to open the drawing. In the Advanced 
Options dialog box, you can choose from various encryption types.

Advanced Options dialog box

Anyone trying to open a password-protected drawing must enter a password 
in the Password dialog box.

Password dialog box presented upon opening

IMPORTANT If a password is lost or forgotten, the drawing cannot be recov-
ered. Password-protection functionality can be disabled by selecting a custom 
installation and turning off the Drawing Encryption feature. If the password fea-
ture is disabled, the Password tab does not appear in the Security Options dialog 
box.
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Drawing Encryption option

Digital Signatures
Digital signatures functionality provides another way to ensure the security 
of your digital design data. Digitally signed drawings can be verified for ori-
gin (confirming identity of the signer), state (confirming that the drawings 
have not been changed), and nonrepudiation (signers may not claim that 
they didn’t sign the drawings).

On the Digital Signature tab in the Security Options dialog box, you select an 
installed signature and attach it to the current drawing. If you have not 
installed a digital signature, you can use any number of digital certificate pro-
viders. Many providers, such as VeriSign, offer a free trial.

Digital Signature tab
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In addition to selecting a digital signature, you can select from a list of time 
stamps and include a comment with your signature.

Opening a drawing with a digital signature attached displays the Digital Sig-
nature Contents dialog box, where you can review information associated 
with the digital signature.

Digital Signature Contents dialog box

A digital signature icon appears on the status bar, indicating whether an open 
drawing has a digital signature attached. Additionally, the drawing icon in 
the Windows Explorer indicates the presence of a digital signature.
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Digital Signature icons

Opening and then saving a digitally signed drawing invalidates the signature 
for security purposes. The signature data, however, is maintained with the 
drawing.

Invalid digital signature

Software Licensing

Take advantage of powerful new functionality offered by FLEXlm®  8.3 that 
helps you to maximize your use of Autodesk Architectural Desktop licenses.

License Borrowing
License borrowing provides the ability to install a time-limited license on 
your computer while disabling the license on the server for that same period. 
The license can then be used on your computer, so you can run Autodesk 
Architectural Desktop without having a connection to the license server. 
License borrowing is a great benefit if you need to take your computer on a 
business trip or occasionally work from home. 

The license borrowing functionality is a deployment option and must be 
enabled for users who might need to borrow a network license.



Collaboration: Work Effectively with Your Extended Design Team | 69

License borrowing option in Deployment wizard

You can control the maximum borrowing period via an environment vari-
able in the Options file, setting it for up to 30 days. The license can be 
returned to the server at any time before expiration.

The Options file offers new controls, including the ability to set a maximum 
number of licenses that can be borrowed at any time. Additionally, the sys-
tem administrator can explicitly allow or deny use of the borrow feature to 
any user or user group.

Using the License Borrowing Utility, users can borrow a license for up to the 
maximum borrowing period. 

Autodesk License Borrowing Utility
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When the borrowing period expires, the license is revoked on the user’s com-
puter and is restored on the server, without requiring a connection to the 
license server. If the specified borrowing period is not needed, the Autodesk 
License Borrowing Utility can return the license early. Users who need more 
time after the borrowing period has ended can connect to the server to bor-
row another license.

License Time-Out
With license time-out you can set a time-out period on your license server to 
return a license to the server so that it is available for use. License time-out 
returns a license to the license server when a client connection is lost and 
prevents a license from being checked out and unused indefinitely on a user’s 
computer.

When you set the license time-out flag in the Options file, the license server 
reclaims the license if the client connection is lost or if the product is idle on 
a workstation for longer than the defined time-out period.

If a user’s license is lost because of the idle time-out, the product attempts to 
claim a new license when the user restarts the software. If no license is avail-
able, the user can save work before the product shuts down.

Autodesk Building Systems Support

Autodesk®  Building Systems software is the premier CAD software for design, 
development, and construction documentation of complex electrical and 
mechanical building systems. Now a single, stand-alone application, 
Autodesk Building Systems incorporates mechanical, electrical, and plumb-
ing modules along with Autodesk Architectural Desktop. And because it’s 
built on Autodesk Architectural Desktop software’s object technology, multi-
discipline firms can use both Autodesk Architectural Desktop and Autodesk 
Building Systems for architectural, mechanical, plumbing, and electrical 
design. Combined, these two products ensure that coordination among team 
members and design teams is easier than ever within the complex building 
design process.
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Autodesk Architectural Desktop drawings seamlessly integrate with Autodesk 
Building Systems Designs

Autodesk Buzzsaw Support

Autodesk Architectural Desktop is integrated with the Autodesk®  Buzzsaw™  
online project collaboration service, letting you share drawings, documents, 
and project team communications in one central and secure online 
location. You can easily access and distribute drawings with a user-friendly 
direct link to your Autodesk Buzzsaw site.

Autodesk Architectural Studio Support

Autodesk®  Architectural Studio complements Autodesk’s building design 
products. Sketches and conceptual models created in Architectural Studio 
integrate with Autodesk Architectural Desktop. For example, you can create 
loose, conceptual drawings and models in Architectural Studio and then 
bring them into Architectural Desktop for further refinement during design 
development and construction documentation. Then you can return to 
Architectural Studio to view, annotate, and sketch on top of your drawing.
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Use Autodesk Architectural Studio to communicate design intent

Autodesk Architectural Studio enhances an iterative design approach and the 
communication of design intent within your project team. Your conceptual 
design data enters the digital workflow from the outset, so it’s more tightly 
integrated with design development and construction documentation. It 
also means that drawing revisions and critiques among the design team 
members remain digital, increasing efficiency and reducing drawing errors.

Autodesk Professional Services

Autodesk Professional Services provides integrated consulting, training, and 
support to help you maximize the value of your investment in Autodesk®  
technology. Autodesk consulting professionals have advanced product 
knowledge and industry experience to guide you through projects of any size 
or complexity. Autodesk training professionals offer the right blend of classes 
and online learning to ensure that you use your software to its full potential. 
Autodesk support professionals can help you when problems arise, providing 
answers that minimize downtime and boost productivity. Whatever your 
requirements, Autodesk Professional Services helps you to achieve the high-
est possible return on your technology investment.



Collaboration: Work Effectively with Your Extended Design Team | 73

Third-Party Support

Many third-party applications worldwide, which run directly in or alongside 
Autodesk Architectural Desktop, extract and use the intelligent data created 
by Autodesk Architectural Desktop and address needs such as facilities man-
agement, cost estimating, and other niche functions.

If you have professional software developers on staff, the Autodesk Developer 
Network program offers resources—whether you’re developing custom appli-
cations or tools for internal use—providing consulting and system integra-
tion services, performing research, or writing and publishing learning mate-
rials.

For a complete listing of third-party solutions, go to http://partnerprod-

ucts.autodesk.com.
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Setting Up the 
Environment

Topics in Part 2

� The Workspace

� Content Browser

� Drawing Management

� Layer Management

� Display System

� Materials

� Style Manager

� Creating and Saving Drawings

II
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The Workspace

A new user interface combines with object technology 

to bring you the Autodesk®  Architectural Desktop 2004 

workspace. Designed to appeal to architectural profes-

sionals, the workspace presents controls and commands 

in a visual context. 

In this chapter

� The Workspace

� How to Use the Information in 
this Chapter

� Starting Autodesk 
Architectural Desktop

� Workspace Components

� Tool Palettes

� Tools

� The Properties Palette

� Direct Editing with Grips and 
Dynamic Dimensions

� In-Place Editing

� Styles and Support Files

� Integration of Autodesk 
Architectural Desktop and 
AutoCAD

3
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The Autodesk Architectural Desktop workspace

Tools and Tool Palettes
Tools and tool palettes provide you with a visual and tactile way to design. A 
tool can create an architectural object, a block, a schedule, or add a hatch pat-
tern or solid fill to a 2D AutoCAD® object. By simply clicking a tool, you can 
easily create it in the drawing area. You can use the stock tools provided in 
the software, or you can create your own tools and organize them in tool pal-
ettes for easy access. Customized tools and tool palettes can be saved in a tool 
catalog and accessed from the Content Browser. For more information, see 
“Tools” on page 123 and “Content Browser” on page 171.

Properties Palette
As you draw an object with a tool, the Properties palette displays the proper-
ties of the object. After you draw the object, use the properties palette to edit 
the object properties. Design options are arranged hierarchically in the Prop-
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erties palette, beginning with the most basic design options and ending with 
the more advanced worksheet options. For more information, see “The Prop-
erties Palette” on page 142.

Content Browser
The Content Browser is a new utility that stores tools and design content. 
The Content browser provides a central location where you can store project-
specific tools to share among your design team. You can browse tool catalogs 
in the Content Browser and drag-and-drop tools onto your tool palettes. 
When you change a tool in the Content Browser, you can refresh it in 
Autodesk Architectural Desktop, so that it is updated with the changed tool 
properties. You can also easily drag-and-drop tools and tool palettes from 
Autodesk Architectural Desktop to the Content Browser to fill and modify 
your tool catalogs. For more information, see “Tool Palettes” on page 108 
and “Content Browser” on page 171.

Direct Manipulation
With the enhanced grip functionality, you can make quick design changes 
directly in the workspace without using dialog boxes. Now, in a single click 
you can perform changes such as adjusting door width and window height, 
modifying a wall roofline, or reversing the wall direction. For some grips, the 
CTRL-key gives you additional manipulation options. This is indicated in the 
grip tips of the grips. An added enhancement is the introduction of dynamic 
dimensions. As you make design changes, dynamic dimensions appear, 
ensuring that your changes are precise and accurate. You can enter values 
directly in the drawing, which eliminates the need to enter numeric input at 
the command line. For more information, see “Direct Editing with Grips and 
Dynamic Dimensions” on page 149.

In-Place Editing
In-place editing allows you to make direct on-screen changes to object com-
ponents. These include wall endcaps, roof and floor lines, and any kind of 
profile-based custom components, such as rails and posts or curtain wall 
mullions and frames. Additionally, you can in-place edit a 3D body modifier 
on a wall, and the surface hatch of a material. You can save changes from the 
in-place edit session back to the style you started from or create a new style. 
For more information, see “In-Place Editing” on page 157.

Templates and Styles
Autodesk® Architectural Desktop offers metric and imperial template sets for 
designing the building model and creating plotting sheets. The templates 
have been designed to work optimally with the new Drawing Management 
feature. For more information, see “Drawing Management” on page 209.

To make the templates smaller, all object styles have been moved out of the 
templates and into the Styles drawings. The new tool palette concept makes 
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it easy to define the style location of each tool you use. For more informa-
tion, see “Tools” on page 123 and “Styles and Support Files” on page 167.

Drawing Management
The Drawing Management feature formalizes and automates the processes 
related to building model design and documentation. The feature provides 
automated tools that aid you in the management, viewing, and construction 
of your building information model and documents. You have consistency 
throughout all aspects of the project with Drawing Management. Every user 
on the design team has a centralized project environment for accessing the 
most current documents, from project templates to sections and elevations. 
For more information, see “Drawing Management” on page 209.

Related Topics and Procedures

� How to Use the Information in this Chapter

� Starting Autodesk Architectural Desktop

� Workspace Components

� Tool Palettes

� Tools

� The Properties Palette

� Direct Editing with Grips and Dynamic Dimensions

� In-Place Editing

� Styles and Support Files

� Integration of Autodesk Architectural Desktop and AutoCAD

How to Use the Information in this Chapter

This chapter offers a general overview over the new workspace components 
and the workspace concepts introduced in Autodesk Architectural Desktop 
2004. You will find high-level descriptions of the user interface and workflow 
changes in the application and examples of how to use them. For detailed 
instructions for using the new workspace with specific objects, refer to the 
chapters for the individual objects.

For example, the Properties Palette section in this chapter introduces the 
concept of accessing and using object properties from a palette. It describes 
how to start the Properties palette, how to set its appearance, and how to 
work with its tabs. 

For detailed information about using the Properties palette for creating a spe-
cific object—for example a wall—refer to the appropriate object’s chapter, 
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such as “Creating a Wall with User-Specified Settings” on page 1760. This sec-
tion contains all of the specific steps for creating a wall with the Properties 
palette. 

Starting Autodesk Architectural Desktop

You can start Autodesk® Architectural Desktop three ways:

� Double-click the Autodesk Architectural Desktop 2004 icon on your desk-
top.

The icon displays on your desktop if you choose to create it when you 
installed the software.

� Windows 2000 only: On the Start menu, click 
Programs ➤ Autodesk ➤ Autodesk Architectural 
Desktop ➤ Autodesk Architectural Desktop 2004.

� Windows XP only: On the Start menu, click All 
Programs ➤ Autodesk ➤ Autodesk Architectural 
Desktop ➤ Autodesk Architectural Desktop 2004.

Customizing Startup
You can use command line switches in the shortcut properties of the desktop 
icon to specify Autodesk Architectural Desktop startup options:

� Run a start-up script when you start the software
� Start the software with a specific template
� Start the software with a specific profile (ARG file)
� Create several desktop icons, each with different start-up options

For more information, see Customize Startup in the online AutoCAD 2004 
User’s Guide.

Workspace Components

You use the workspace environment as you design and interact with an archi-
tectural project. With this release of Autodesk® Architectural Desktop, a num-
ber of new, intuitive workspace components have been added to enhance the 
architectural workflow. You can configure the workspace according to your 
needs and processes and save specific workspace layouts in a user profile. 
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This sections presents an overview of the available workspace components. 

Related Topics and Procedures

� Pulldown Menus

� Toolbars

� Shortcut Menu

� Tool Palettes

� Properties Palette

� Command Line

� Drawing Window Status Bar

� Application Status Bar

� Communication Center

� Project Navigator Palette

� Creating and Saving a Workspace Configuration

� A Guideline to the New User Interface

� How to Create a Workspace for Transitioning from Autodesk Architectural 
Desktop 3.3
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Pulldown Menus

The pulldown menus have been restructured for Autodesk® Architectural 
Desktop 2004. While in previous releases most of the object-related com-
mands could be accessed from pulldown menus, the current pulldown 
menus have been consolidated to only display general drawing-wide com-
mands, such as the drawing setup or accessing Style Manager and Display 
Manager. Objects and object-related commands are now primarily accessed 
from the tool palettes, the Properties palette, the shortcut menu, and 
through grip-editing. 

Pulldown menu commands are grouped according to the workflow. 

Menu Contents

File drawing file commands, access to the Project Browser, 
drawing utilities, and drawing transmittal commands

Edit standard Microsoft Windows editing commands, such as 
Copy and Paste

View commands that change the working view

Insert general insertion commands for external files and file types, 
access to DesignCenter

Format formatting and management commands, including Display 
Manager, Layer Manager, and Style Manager

Window commands that affect the workspace and the windows 
contained within the workspace; includes commands that 
add the CAD Manager menu, the AutoCAD 3D Solids 
menus, and the Autodesk Architectural Desktop 3.3 legacy 
pulldown menus to the menu bar

Help access to the online Help, online tutorials, and other 
resources to help you learn and use Autodesk Architectural 
Desktop
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In addition to the standard pulldown menus, you can load these menus: 

To load the additional pulldown menus, click Pulldowns on the Window 
menu, and then select the menu you want to add to the menu bar. 

Toolbars

The concept of the toolbars has been restructured for this release of 
Autodesk®  Architectural Desktop. While in previous releases most of the 
objects and object-related commands could be accessed from toolbars, the 
new toolbars contain only those commands that the user will often need at 
any point in the drawing sessions, like those items found on the Standard 
toolbar, the Navigation toolbar, the Shapes toolbar. Objects and object-
related commands are now accessed primarily from the tool palettes, the 
Properties palette, the shortcut menu, and through grip-editing.

Menu Contents

Design contains a pulldown menu similar to the Design menu of 
Autodesk Architectural Desktop 3.3. Note that this menu 
does not contain all commands of the original Design 
menu; it is meant as a tool for transitioning seamlessly 
between Autodesk Architectural Desktop 3.3 and Autodesk 
Architectural Desktop 2004

Document contains a pulldown menu similar to the Documentation 
menu of Autodesk Architectural Desktop 3.3. Note that this 
menu does not contain all commands of the original 
Documentation menu; it is meant as a tool for transitioning 
seamlessly between Autodesk Architectural Desktop 3.3 and 
Autodesk Architectural Desktop 2004 

CAD Manager contains advanced features like the VBA Editor, the LISP 
Editor, the Script command, Visual Audit, and Explode AEC 
Objects. When the CAD Manager menu is loaded, you have 
also access to the CAD Manager toolbar that contains 
buttons for Style Manager, Display Manager, Visual Audit, 
and the AutoCAD features Configure Standards, Check 
Standards, and Layer Translator

3D Solids gives access to the AutoCAD® 3D Solids objects and 
commands



Workspace Components | 85

Some frequently used toolbars

These toolbars available in Autodesk Architectural Desktop: 

Toolbar Contents

Standard standard drawing commands, like opening, saving, 
publishing and printing drawings. Contains also Copy, Paste, 
Undo, and Regenerate Model. 

Navigation commands for opening the Content Browser, the Project 
Navigator Palette, the Tool Palettes Set, the Properties 
Palette, and DesignCenter. Contains also flyout toolbars for 
Zoom, Views, UCS, and Shading.

Layer Properties commands to start the Layer Manager and change the status 
of a layer

Shapes commands for adding 2D AutoCAD objects, like lines, arcs, 
polylines and splines

3D Orbit commands for moving the model in 3D space

Dimension commands for working with AutoCAD dimensions

Inquiry commands for measuring distances, areas, and volumes. 
Also contains the AutoCAD Point tool and the List command.

Modify standard commands for editing objects and linework. 
Includes Copy, Erase, Move, Scale, Mirror, Offset, Array, 
Stretch, Trim, Extend, Break, Chamfer, Fillet, and Explode. 

NOTE These commands are also available from the general 
shortcut menu.
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To access the toolbars, right-click into the toolbar area below the menu, and 
click ADT. A flyout in the shortcut menu displays the available toolbars. 

Accessing the toolbars

Object Snap commands for setting the Object Snap

Properties commands for changing color, linetype, lineweight and 
linetype scale for an object

Refedit commands for working with external references in the 
drawing

Shading commands for different shade modes

UCS, UCS II commands for setting and changing the UCS of the drawing

Views commands for switching between 2D and 3D views of the 
drawing

Zoom commands for zooming and panning the drawing

Toolbar Contents
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Shortcut Menu

The shortcut menu of an object is the central location for any object-related 
commands. Different objects have different shortcut commands, depending 
on the object type. To prevent this menu from becoming too big, the existing 
standard commands—like Copy, Paste, Move, and Rotate—have been 
restructured. 

To access the shortcut menu of an object, select the object, and right-click on 
it.

Shortcut menu of a wall

A general shortcut menu is also available when you right-click into the draw-
ing area without an object selected. This general shortcut menu contains all 
general modify commands.
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General drawing shortcut menu

Tool Palettes

Tool palettes provide the main method for accessing tools to create objects in 
your model. You can have tools for standard objects in your drawing and for 
objects with specific styles and specific properties. Tool palettes are organized 
in a tool palettes set. You can easily create your own tool palettes or copy 
existing tool palettes from the Content Browser. 

Tool palette with door tools
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For more information, see “Tool Palettes” on page 108 and “Tools” on 
page 123.

Properties Palette 

The Properties palette offers you a centralized location to enter and change 
object properties. You can enter information about the style, dimensions, 
location, property set data, and other important properties. You will typically 
keep the Properties palette permanently open during an Autodesk® Architec-
tural Desktop session. 

Properties palette of a wall

For more information, see “The Properties Palette” on page 142.

Command Line

You can directly enter commands using the command line. For a list of avail-
able commands, enter arx on the command line and then c (commands). 
This gives you a list of all available commands.
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Drawing Window Status Bar

The drawing window status bar provides a quick and intuitive way to display 
status information about the current drawing:

Drawing window status bar

� Project information: If the drawing is part of an Autodesk Architectural 
Desktop project, the drawing window status bar displays the name of the 
project, as well as the file type of the drawing. For more information, see 
“Drawing Management” on page 209.

� Display configuration of the active viewport: You can see and change the 
current display configuration.

� Drawing menu: When you click  in the drawing window status bar, a 
shortcut menu with frequently used commands in the drawing is dis-
played. These commands are available on the regular pulldown menus as 
well; the Drawing menu provides a shortcut to them. 
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Application Status Bar

The application status bar contains settings valid for the whole drawing ses-
sion in Autodesk Architectural Desktop. 

The application status bar gives access to these settings:

� Snap: On/Off/Settings
� Grid: On/Off/Settings
� Ortho: On/Off
� Polar Tracking: On/Off/Settings
� Object Snap: On/Off/Settings
� Object Track: On/Off/Settings
� Lineweight: On/Off/Settings
� Model Space/Paper Space

To turn one of these components on or off, click on its button. To change the 
settings for one of these components, right-click the button, and select Set-
tings. 

Communication Center

This in-product notification system keeps you up-to-date on service pack 
availability as well as information for Autodesk® Subscription Program mem-
bers, such as extension availability, product tips and tricks, and product sup-
port information. You can set the Communication Center to automatically 
notify you of any updates and other important information at specified 
intervals. Alternatively, you can update on demand. 
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When new updates are available, the Communication Center icon displays 

with a yellow exclamation mark . When you click on the icon, the Com-
munication Center is displayed, allowing you to download the latest 
updates. To set the update properties, click the Communication Center icon, 
and click Settings.

Communication Center dialog box

Project Navigator Palette

The Drawing Management feature formalizes and automates the processes 
relating to building model design and documentation. This feature provides 
automated tools that aid you in the management, viewing, and construction 
of your building information model and documents.



Workspace Components | 93

Project Navigator Palette

The Project Navigator Palette is the central location to create, modify, and 
access Autodesk® Architectural Desktop project files. You will typically have 
the Project Navigator Palette open in the workspace while you are working 
on a project. For more information, see “Drawing Management” on 
page 209.

Creating and Saving a Workspace Configuration

Autodesk® Architectural Desktop offers a number of user interface compo-
nents to choose from and flexibility in combining and arranging those com-
ponents. To ensure that a specific workspace configuration—including tool 
palettes, menus, toolbars, Properties palette, and Project Navigator Palette—
remains unchanged, you can create a user-defined profile that contains your 
settings. 

For detailed information on the display of the individual user interface com-
ponents, see the sections for the individual components. 

The following user interface characteristics are saved in the user profile: 
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� On/Off state of the tool palettes set, the Properties palette, the Project 
Navigator Palette, the toolbars, menus, and the command line window

� Size and position of the tool palettes set, the Properties palette, the Project 
Navigator Palette, the toolbars, and the command line window

� View settings of the Properties palette and the tool palettes set
� Support file path to the tool palettes set

Workspace layout
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Changing workspace layout

You can save any number of workspace layouts in Autodesk Architectural 
Desktop. 

1 On the Format menu, click Options. 

2 Click the Profiles tab. 

3 Click Add to list, and enter a name for the new workspace profile. 

4 Click Apply&Close. 

5 Select the profile in the list, and click Set Current. 

6 If you want to use a different tool palettes set, click the File tab, and enter 
the path to the correct tool palettes set under Tool Palettes File Location. 

For detailed information, see “Specifying Different Tool Palettes for the 
Tool Palettes Set” on page 114 and “Creating a New Tool Palettes Set from 
Autodesk® Architectural Desktop” on page 114.

7 Click OK. 

8 In the Autodesk Architectural Desktop workspace, arrange palettes, tool-
bars, and other user interface components according to your needs. 
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The configuration you create is linked to the currently selected workspace 
profile. Whenever you set this profile current, the associated workspace 
configuration is restored. 

NOTE You cannot create a workspace layout on screen and then save that 
configuration to a new profile. In that case, the currently selected profile is 
overwritten with the new configuration.

A Guideline to the New User Interface

The new user interface offers visual workflow and intuitive access to objects 
and commands. The new user interface is considerably different from the 
user interface of previous releases, so that users of previous releases might, at 
first glance, ask themselves “Where are my objects and commands?” To help 
you find your way through the new user interface, refer to the following 
guidelines. 

Related Topics and Procedures

� Adding Objects

� Modifying Objects

� Object-related Command Tools

� Other Commands

Adding Objects

In previous releases of Autodesk® Architectural Desktop, objects would 
mainly be added to the drawing via pulldown menus and object toolbars. 

In the new workspace, you add objects to the drawing with tools. 
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When you click on an object tool to add an object in the drawing, the Prop-
erties palette opens so you can enter properties for the new object, similar to 
the old Add dialog boxes. The difference is that unlike the old method, tools 
can have preset creation parameters to enable 'one-click add' of an object 
without even the need to change properties before placement. For detailed 
information, see “Tools” on page 123.
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Tools are arranged on tool palettes for easy access. To open the tool palettes, 
click Tool Palettes on the Window menu.
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The Autodesk Architectural Desktop Sample Palette catalog is installed by 
default and contains the following tool palettes:

Tool Palette Content

Design This tool palette is a good starting point for exploring the new 
workspace. Because this palette contains tools for all standard 
design objects. All of the objects on this palette are inserted 
with the Standard style, and with standard properties. The 
Design Tool palette contains the following objects:

� Wall
� Door
� Window
� Opening
� Door/Window Assembly
� Curtain Wall
� Structural Column
� Structural Beam
� Structural Brace
� Slab
� Roof Slab
� Roof
� Stair
� Railing
� Structural Column Grid
� Ceiling Grid
� Space
� Auto Generate Spaces
� Space Boundary
� Section Line
� Elevation Line



100 | Chapter 3 The Workspace

Massing This tool palette contains tools for all predefined mass 
element shapes. The mass elements are inserted with the 
Standard style. The Massing Tool palette contains the 
following mass elements:

� Arch
� Barrel Vault
� Box
� Pyramid
� Isosceles Triangle
� Right Triangle
� Cone
� Cylinder
� Dome
� Sphere
� Gable
� Drape
� Extrusion
� Revolution

This palette also contains the following tools:

� Mass Groups
� Slice
� Camera

General Drafting This tool palette contains tools for frequently used AutoCAD 
commands. Note that the tools on the General Drafting 
palette do not necessarily represent objects, but rather 
AutoCAD commands. The General Drafting Tool palette 
contains the following tools:

� Point ID tool
� Distance tool
� Area Tool 
� Fillet - 0"
� Fillet - 24"
� Chamfer
� Line Hatch
� Hatch and Gradient Tool
� Sample Pantone hatch tools

These are sample tools. You can copy and paste them on the 
tool palette to create new tools. 

Tool Palette Content
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Documentation This tool palette contains tools for the documentation phase 
of the architectural workflow. The Documentation Tool 
Palette contains the following object tools:

� Door schedule (Sample)
� Window schedule (Sample)
� Space Inventory schedule (Sample)
� Room Finish schedule (Sample)
� Area
� Area Group
� Area Group from Template

In addition, the Documentation palette contains these 
command tools: 

� Area Evaluation
� Browse Property Data
� Renumber Data

For more information about command tools, see “Object-
related Command Tools” on page 105 and “Creating a 
Command Tool” on page 134.

Annotation This tool palette contains tools for the annotation of a 
drawing. The Annotation Tool Palette contains the following 
tools: 

� AEC Dimension 
� Manual AEC Dimension
� Text Tools
� Plan Elevation Label
� Door/Window Tag
� Section/Elevation Marks
� Detail Boundaries
� Revision Clouds

The annotation symbols are sample tools and can also be 
dragged into a tool palette from DesignCenter. For more 
information, see “Creating a Tool from AEC Content in 
DesignCenter” on page 133.

Walls This tool palette contains a number of wall style tools 
representing the wall styles from the Wall Styles drawings. 
When you start a wall style tool, a wall with this style is 
inserted in the drawing. 

Doors This tool palette contains a number of door style tools 
representing the door styles from the Door Styles drawing. 
When you start a door style tool, a door with this style is 
inserted in the drawing. 

Tool Palette Content
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Modifying Objects

In previous releases of Autodesk® Architectural Desktop, you could modify 
objects through the object property dialog box. 

Wall Properties dialog box in Autodesk Architectural Desktop 3.3

In the new workspace, you can modify an object using any of the following 
methods: 

� Properties palette: The Properties palette is the central location for enter-
ing and changing information about an object. This palette has categories 
that correspond to the tabs in the old Properties dialog boxes. 

For detailed information, see “The Properties Palette” on page 142.

Windows This tool palette contains a number of window style tools 
representing the window styles from the Window Styles 
drawings. When you start a window style tool, a window with 
this style is inserted in the drawing. 

Tool Palette Content
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Modifying a wall with the Properties palette

� Shortcut menu: A number of object-related commands have been added 
to the shortcut menus. Right-click the object to display its available short-
cut commands. 
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Shortcut menu for a wall

� Direct editing with grips: A number of commands for modifying objects 
are now accessible from the object’s grips. Click on an object in two-
dimensional (2D) or three-dimensional (3D) view to display its grips. 

For detailed information about object grips, see “Direct Editing with Grips 
and Dynamic Dimensions” on page 149. Information about grip-editing 
is also covered in the individual object chapters.
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Window grips for direct editing

Object-related Command Tools
The tool palettes contain a number of object-related commands. These tools 
are called command tools or helper tools, because they do not represent 
objects but rather utilities for working with objects. 

You can create your own command tools. For more information, see “Creat-
ing a Command Tool” on page 134.

In the Autodesk®  Architectural Desktop Sample Palette catalogs, the follow-
ing command tools are available:

Tool Location Description

Design Palette Automatically generates spaces from 
walls and linework

Design Palette Creates a building section line
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Other Commands
The pulldown menus from the previous releases of the software are now con-
solidated to ensure more intuitive and direct user interaction. The main 
menu for accessing commands is the Format menu. The Format menu pro-
vides access to these features: 

� Drawing Setup, Drafting Settings, Drawing Limits, and Drawing Options
� Style Manager, Display Manager, Layer Manager

Design Palette Creates a building elevation line

Massing Palette Creates a slice through a building 
model

Massing Palette Creates user-defined perspective views 
of the building model

Annotation Palette Starts the AutoCAD Mtext tool

Documentation Palette Creates an evaluation document for 
areas and area groups 

Documentation Palette Renumbers property data in selected 
property sets by increment or by a 
user-defined number

Documentation Palette Allows you to browse the existing 
property data of all objects in the 
drawing, including external references

Tool Location Description
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� Structural Member Catalog 
� Structural Member Wizard, AEC Dimension Style Wizard, and AEC Con-

tent Wizard
� Plotter Manager and Plot Style Manager
� Blocks, Multi-View Blocks, and Profiles
� Material and Classification Definitions
� AutoCAD®  Text Style, Point Style, Color, Linetype and Lineweight Settings

How to Create a Workspace for Transitioning 
from Autodesk Architectural Desktop 3.3

Use this procedure to add two transitional pulldown menus to Autodesk®  
Architectural Desktop 2004 that resemble the Design and Documentation 
menus of Autodesk Architectural Desktop 3.3. 

If you are a user of a previous version of Autodesk Architectural Desktop, you 
may need time to get used to the new workspace concept. If you are in the 
middle of a project and want to use the new version without having to adapt 
to the new user interface immediately, you can use a transitional user inter-
face. This transitional interface provides access to the new workspace compo-
nents such as the tool palettes set, the Properties palette, and the Content 
Browser, while at the same time offering you a menu structure that is similar 
to Autodesk Architectural Desktop 3.3. 

Transitional Design menu 

1 On the Window menu, click Pulldowns. 
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2 Display the appropriate pulldown menu. 

Tool Palettes

Tool palettes provide instant access to a complete inventory of Autodesk® 
Architectural Desktop tools—such as walls, doors, and windows—in one con-
sistent user interface. Highly visual, tool palettes include a preview of each 
style. You can create a set of custom tool palettes that address your specific 
design needs. For example, you can create a palette to store a list of com-
monly used curtain wall, stair, and window tools.

Tool Palettes Set
Tool palettes are organized in a tool palettes set, and you can add, remove, 
and rearrange palettes in the set. Additionally, you can rename the tool pal-

If you want to . . . Then . . .

display the Design menu click Design Pulldown.

display the Documentation 
menu

click Document Pulldown.
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ettes set. A tool palettes set with default tools is available when you start 
Autodesk Architectural Desktop. Additional tool palettes are stored in the 
Content Browser, and you can drag and drop them onto the tool palettes. 

You can add tool palettes to the tool palettes set from a tool catalog. For 
example, you could create one tool catalog for imperial tools and another for 
metric tools. For more information, see “Creating and Saving a Workspace 
Configuration” on page 93 and “Specifying Different Tool Palettes for the 
Tool Palettes Set” on page 114. 

Only one tool palettes set can be active simultaneously during an Autodesk 
Architectural Desktop session, although you can set different tool palettes for 
different user profiles. You do this by collecting tool palettes from several 
locations (paths) in a profile and let the workspace combine them into the 
one tool palettes set.

Tool Palettes
Tool palettes are the individual tabs of the tool palettes set. A number of 
default tool palettes are available from the Autodesk Architectural Desktop 
Sample Palette catalogs. You can create new tool palettes in Autodesk Archi-
tectural Desktop or in the Content Browser. Usually you place tools on tool 
palettes according to tool type or design phase. For example, you could place 
all your wall tools on a tool palette called “Walls” or all of your preliminary 
conceptual tools on a tool palette called “Massing Study.” When you create 
a tool palette in the Content Browser, you can link it to Autodesk Architec-
tural Desktop. Whenever the tool palette is updated in the Content Browser, 
the changes are updated in the tool palette in Autodesk Architectural Desk-
top too. This is very useful for large projects where consistency of styles and 
tools is necessary. For more information, see “Working with Tool Palettes 
from a Central Location” on page 120.

Tools
Tools represent the individual objects you can add to a drawing. A tool con-
tains creating parameters about the object it creates.

When you add an object with a specific object tool, the object has the set-
tings you defined in the tool. This eases the design process immensely and 
enhances consistency across a project. 

For example, if you might define a wall tool that contains the style “CMU 8 
Furring” and that has automatic cleanup and a baseline offset of 1". When-
ever you add a wall with this wall tool, the wall will be of the style “CMU 8 
Furring,” clean up automatically, and have an offset of 1". For more informa-
tion, see “Tools” on page 123.
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Tool Palettes and the Content Browser
When you are working on a large project with multiple users, consistency of 
tools is especially important. Typically the objects for the project, their styles 
and properties are set up by a CAD manager or system administrator and 
then distributed to the team. This administrator can then put tools and pal-
ettes in a central location in the Content Browser and link them to the indi-
vidual users’ computers. Whenever the tools or palettes are updated in the 
Content Browser, the tools or palettes are updated on the users’ computers 
too. Users cannot individually change tools and tool palettes, thus prevent-
ing accidental modification of standard tools. 

For more information, see “Working with Tool Palettes from a Central Loca-
tion” on page 120 and “Working with Tools from a Central Location” on 
page 136.

Related Topics and Procedures

� Opening the Tool Palettes Set

� Setting the Appearance of the Tool Palettes Set

� Specifying Different Tool Palettes for the Tool Palettes Set

� Creating a New Tool Palettes Set from Autodesk® Architectural Desktop

� Creating a New Tool Palette

� Setting the Appearance of the Tool Palettes

� Working with Tool Palettes from a Central Location

Opening the Tool Palettes Set

Use this procedure to open the tool palettes set. 

� On the Window menu, click Tool Palettes. 

Alternatively, you can click  on the Navigation toolbar, or press 
CTRL+3. 
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Components of the tool palettes set

Setting the Appearance of the Tool Palettes Set

Typically, the tool palettes remains open during the Autodesk®  Architectural 
Desktop session, since it is the central location from which you add objects 
to the drawing and start object-related commands. To work optimally with 
the tool palettes set, it has a number of user-definable display options to inte-
grate it seamlessly with your workspace. 
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Related Procedures

� Docking the Tool Palettes Set

� Hiding the Tool Palettes Set

� Adjusting the Transparency of the Tool Palettes Set

� Renaming the Tool Palettes Set

Docking the Tool Palettes Set
Use this procedure to dock the tool palettes set on the left or right side of your 
workspace.

1 In the title bar of the tool palettes set, click , and then click Allow 
Docking.

2 Position the cursor over the title bar, and drag the tool palettes set to one 
side of your workspace.

A preview graphic shows you the new position of the tool palettes set. 

3 Release the tool palettes set when it is in the location you want. 

Hiding the Tool Palettes Set
Use this procedure to hide the tool palettes set when not in use. The tool pal-
ettes set automatically hides when you move the cursor away from it, leaving 
only the title bar visible. When you move the cursor over the title bar, the 
tool palettes set is re-displayed. 
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Tool palettes set hidden (left) and re-displayed (right)

1 In the title bar of the tool palettes set, click  (Auto-hide).

The tool palettes set is hidden, except for the title bar. 

2 To re-display the tool palettes set, move the cursor over the title bar. 

Adjusting the Transparency of the Tool Palettes Set
Use this procedure to adjust the transparency of the tool palettes set. The 
more transparent the tool palettes set is, the more easily you can see objects 
in your drawing underneath it.

NOTE Transparency is not available if hardware acceleration is enabled.

1 In the title bar of the tool palettes set, click , and then click Transpar-
ency.

2 To adjust the transparency of the tool palettes set, move the slider.

3 To turn off transparency, select Turn off window transparency.

4 Click OK.

Renaming the Tool Palettes Set
Use this procedure to rename the tool palettes set. You may want to name it 
with a project or company name.
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1 In the title bar of the tool palettes set, click , and then click Rename 
Palette Set.

2 Enter a name for the tool palettes set, and press ENTER.

Specifying Different Tool Palettes for the Tool 
Palettes Set

Use this procedure to switch between different palette combinations in the 
tool palettes set. 

Only one tool palettes set can be active simultaneously during an Autodesk 
Architectural Desktop session. You can, however, set different tool palettes to 
be included in it for different user profiles. You do this by collecting tool pal-
ettes from several locations (paths) in a profile and let the workspace com-
bine them into the one tool palettes set.

For information about user profiles, see “Creating and Saving a Workspace 
Configuration” on page 93.

1 On the Format menu, click Options. 

2 Define the tool palettes used for the current session. 

� If you have created a workspace profile containing a tool palettes path, 
click the Profiles tab, select the desired profile, and click Set Current. 

� If you have created no workspace profile, click the Files tab, and click 
the Tool Palettes File Location entry. Then, click Browse, and browse for 
a folder containing the desired tool palette (ATC). 

Add paths to all additional tool palettes to be included in the tool pal-
ettes set of this profile. 

3 Click OK. 

Creating a New Tool Palettes Set from 
Autodesk® Architectural Desktop

Use this procedure to create a new tool palettes set from Autodesk Architec-
tural Desktop. 

1 On the Format menu, click Options. 

2 Click the Profiles tab. 

3 Click Add to List, and create a new profile that will contain the new tool 
palettes set, for example “Design - Metric Palette Set. “
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4 Select the new profile, and click Set Current.

5 Click the Files tab. 

6 Under Tool Palettes File Locations, set the support path for the tool pal-
ettes set to an empty folder in which you want to create the new tool pal-
ettes set. 

NOTE If you point to a folder already containing a tool palettes set (ATC) 
file, no new tool palettes set is created; instead the existing tool palettes set 
will be used in the profile.

7 Click OK.

8 In the Autodesk Architectural Desktop workspace, an empty tool palettes 
set is displayed. 

New tool palettes set

9 To rename the tool palettes set, click , and then click Rename Palette 
Set. 
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10 Add tool palettes and tools to the new set. 

The changes you make are saved to the tool palettes set. 

Creating a New Tool Palette

Use this procedure to add an empty tool palette to your tool palettes set. 

After creating the tool palette, you can add tools to it. For more information, 
see “Tools” on page 123.

1 In the title bar of the tool palettes set, click , and then click New Palette.

2 Enter a name for the new tool palette, and press ENTER.

Setting the Appearance of the Tool Palettes

Use this procedure to define the appearance of individual tool palettes. 

The display of the tool palettes set depends on the settings you choose for the 
overall tool palettes set, as described in “Setting the Appearance of the Tool 
Palettes Set” on page 111 and the settings you choose for the individual tool 
palettes. In the tool palettes set, you set the transparency of the tool palettes 
set, its size and position, as well as whether to auto-hide the tool palettes set 
when not using it. 

In the tool palette, you set the size of the tool images and their arrangement 
on the tool palette. 

If you want to . . . Then . . .

add a new empty tool palette see “Creating a New Tool Palette” on page 116.

add a tool palette from the 
Content Browser

see “Adding a Tool Palette from a Tool Catalog in 
the Content Browser” on page 121.

add a tool to a palette see “Creating a Tool from an Object in the 
Drawing” on page 131.
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Setting the tool size for a tool palette

When you set your tool images to a smaller size, you can display more tools 
on a tool palette. This might become important if you display different pal-
ettes as well, such as the Properties palette or the Project Navigator palette. 

To save space, you can also display only tool images without tool text below 
them. This method is best suited when the icons for your tools are easy to 
differentiate. If the icon alone proved insufficient to identify a tool, the tool 
tips for each icon provide additional guidance. 
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Icon-only display in the tool palette

You can also display your tools in a single column list within the tool palette. 
When you are using the list view, tool texts are always displayed. 
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Tool palette in list view

1 Open the tool palette that you want to change.

2 Right-click the palette, and click View Options. 

3 In the View Options worksheet, select the appearance of the tool palette: 

4 To apply these changes to all palettes in the tool palettes set, select All Pal-
ettes for Apply to. 

5 Click OK. 

If you want to . . . Then . . .

view only tool icons select Icon only for View style.

view tool icons and tool text select Icon with text for View style.

view tool icons and tool text 
in a single column list

select List view for View style.



120 | Chapter 3 The Workspace

Working with Tool Palettes from a Central 
Location

When you are working on a large project with multiple users, consistency of 
tools is especially important. Typically the objects for the project, their styles 
and properties are set up by a CAD manager or system administrator and 
then distributed to the team. This administrator can then put tools and pal-
ettes in a central location in the Content Browser and link them to the indi-
vidual users’ machines. Whenever the tools or palettes are updated in the 
Content Browser, they are updated on the users’ computers too. Users cannot 
individually change tools and tool palettes, thus preventing accidental dele-
tion of standard tools. 

Using tool palettes from the Content Browser

Related Procedures

� Adding a Tool Palette from a Tool Catalog in the Content Browser

� Updating a Tool Palette from a Tool Catalog in the Content Browser
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Adding a Tool Palette from a Tool Catalog in the Content 
Browser
Use this procedure to link a tool palette from a tool catalog in the Content 
Browser to the tool palettes set in Autodesk® Architectural Desktop. 

For information on how to create tool palettes in the Content Browser, see 
“Adding Content to a Tool Catalog” on page 189.

1 On the Window menu, click Content Browser. 

Alternatively, you can click  on the Navigation toolbar, or press 
CTRL+4.

2 Open the tool catalog containing the tool palette you want to copy. 

3 Move the pointer over the i-drop®  icon next to the tool palette so that the 

pointer image changes to an eyedropper ( ).

To copy multiple tool palettes, press and hold CTRL while clicking each 
palette; then position the eyedropper over any of the selected palettes.

4 Drag the palette to the tool palettes set in the Autodesk Architectural 
Desktop workspace.

The tool palette is dropped into the tool palettes set. 

5 Right-click into the palette, and click Properties. 

The text below the check box displays the name of the catalog in the Con-
tent Browser from which the palette is updated. 

If you click on that name, it will jump to the catalog from which the tool 
palette was linked.
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6 Select or clear Auto-Refresh.

The name of the tool palette in the Content Browser from which the 
selected tools palette is updated is displayed under Name. 

7 Click OK.

Updating a Tool Palette from a Tool Catalog in the Content 
Browser
Use this procedure to update a linked tool palette in the tool palettes set from 
its source tool catalog in the Content Browser.

1 Link a tool palette from a catalog in the Content Browser to the tool pal-
ettes set, as described in “Adding a Tool Palette from a Tool Catalog in the 
Content Browser” on page 121.

If you want to . . . Then . . .

automatically update the linked tool palette 
from the Content Browser when starting 
Autodesk Architectural Desktop

select Enable Auto-Refresh.

update the linked tool palette manually with 
one of the methods described in “Updating a 
Tool Palette from a Tool Catalog in the 
Content Browser” on page 122

clear Enable Auto-Refresh.
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When a tool palette is linked to the tool palettes set from a catalog in the 

Content Browser, a Refresh  button is displayed at the bottom. 

2 Click the Refresh button to update your local tool palette with the latest 
changes from the catalog in the Content Browser.

Alternatively, you can right-click the palette, and click Refresh Palette. 

NOTE You can also update the whole palette set by clicking  in the tool 
palettes set, and then clicking Refresh Palette Set. This command updates all 
linked tool palettes in the tool palettes set.

Tools

Tools represent the individual objects you can add to a drawing. A tool con-
tains creation parameters about the object it represents.

Whenever you add an object with a specific object tool, the object has all of 
the settings you have defined in the tool. This eases the design process 
immensely and enhances consistency across a project. 

For example, if you might define a wall tool that contains the style “CMU 8 
Furring” and that has automatic cleanup and a baseline offset of 1". When-
ever you add a wall with this wall tool, it will be of the style “CMU 8 Furring,” 
clean up automatically, and have an offset of 1". 



124 | Chapter 3 The Workspace

Standard object tools

In a tool, you can define these general properties: 

� Tool name
� Tool description

NOTE The description you enter for the tool is used as a tooltip; addition-
ally it is used as the tool description when the tool is copied to a tool catalog 
in the Content Browser.

� Description of objects inserted with this tool
� Layer key of objects inserted with this tool
� Layer overrides of objects inserted with this tool
� Object style
� Location of object style

In addition, you can define all object-specific properties that apply to this 
tool type. For example, if you create a wall tool, you can set the wall cleanup, 
width, height, baseline settings, and the roof/floor lines of walls that are 
inserted with this tool. 
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Style Location
In this release of Autodesk®  Architectural Desktop, the object styles have 
been moved out of the templates and into the Styles drawings. If you want 
to assign a style to an object tool, you can either point to a style in the draw-
ing or to a style in an external drawing. For more information, see “Styles and 
Support Files” on page 167.

Tool Types
Tools in Autodesk Architectural Desktop fall into one of the following cate-
gories.

Related Topics and Procedures

� Creating an Object with a Tool

� Changing the Tool Properties

� Changing a Tool Icon

� Refreshing a Tool Icon

� Creating a Tool from an Object in the Drawing

� Copying a Tool from a Tool Palette

� Creating a Tool from the Style Manager

� Creating a Tool from AEC Content in DesignCenter

� Creating a Command Tool

Tool Type Description

Object tools An object tool inserts a design object—such as a wall or a 
window assembly—into a drawing. An object tool has a 
specific style and specific object properties: for example, a 
wall tool with the style “Brick-4 Brick-4”. 

Command tools Command tools are a graphical representation of an object-
related command. For example, the Browse Property Data 
tool opens a dialog box for browsing the property data of all 
objects in a drawing. Another example is the Renumber 
Data tool, which renumbers property data in selected 
property sets by increment or by a user-defined number. In 
addition, you can create your own tools for each command 
in Autodesk Architectural Desktop. For a list of available 
command tools, see “Object-related Command Tools” on 
page 105 and “Creating a Command Tool” on page 134.

AEC Content tools You can create tools for frequently used AEC Content items 
that have been created with the AEC Content Wizard. For 
more information, see “Creating a Tool from AEC Content in 
DesignCenter” on page 133 and “Custom Content” on 
page 2343. 
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� Working with Tools from a Central Location

� Applying the Properties of a Tool to an Existing Object

� Re-Importing Styles for a Tool

� Deleting a Tool

Creating an Object with a Tool

Use this procedure to create an object with a tool. 

1 On the Window menu, click Tool Palettes. 

2 Click the tool palette that contains the tool for the object you want to 
insert. 

For example, if you want to insert a bifold double door, click the Doors 
palette, and navigate to the Bifold Double Door tool. 

3 Click the tool. 

4 In the Properties palette, enter all necessary values and settings. 
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NOTE Certain values can be set only when inserting the object; for exam-
ple, the position of a door along the wall it is inserted into can only be defined 
when inserting the door. You cannot change the position later for an existing 

door. Values you can set only during insertion are marked with a  in the 
Properties palette. 

5 Click in the drawing where you want to insert the object. 

6 Proceed with the steps for creating the object in the drawing, and then 
press ENTER. 

Changing the Tool Properties

Use this procedure to define the properties of a tool in a tool palette. 

You can set these general properties for an object tool:

� Tool name
� Tool description

NOTE The description you enter for the tool is used as a tooltip; addition-
ally it is used as the tool description when the tool is copied to a tool catalog 
in the Content Browser.

� Description of objects inserted with this tool
� Layer key of objects inserted with this tool
� Layer overrides of objects inserted with this tool
� Object style
� Location of object style

In addition, you can define all object-specific properties that apply to this 
object type. For example, if you create a wall tool, you can set the wall 
cleanup, width, height, baseline settings and the roof/floor lines for all walls 
inserted with this tool. 

1 On the Window menu, click Tool Palettes. 

2 Click a tool palette.

3 Select the tool, right-click, and click Properties. 
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4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Enter a description of the objects that you can create using this tool.

8 Specify a layer key and any layer key overrides; otherwise, the layer assign-
ments specified in the layer key style in the drawing are used.

9 Select an object style, and select a style location, if the location is other 
than the current drawing.

10 Add object-specific properties. 

NOTE When you click a property to add a value that you do not select from 
a drop list, the property value underneath the current property is hidden and 
the property field highlighted. This is intended behavior. Enter a value for the 
current property in the appropriate location.

11 Click OK. 

Changing a Tool Icon

Use this procedure to change the display icon of a tool. 
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A new tool is inserted with either the tool icon of the tool it was copied from 
or with a default icon. You can change this by selecting a new icon from an 
image file or from an object in the drawing. 

Changing the tool icon

You can use the following image formats for tool icons: 

� PNG
� GIF
� JPG
� BMP
� TIFF

NOTE PNG is the recommended image format for tool icons. It supports loss-
less compression and background transparency; all the other formats will leave 
a background to the tool image.

Icons in the tool palettes can have a maximum size of 64x64 pixels. Larger 
images are scaled when inserted. 

In the tool itself, you can only define the tool icon. To change the display size 
of the tool on the palette, see “Setting the Appearance of the Tool Palettes” 
on page 116.

1 On the Window menu, click Tool Palettes. 

2 Click the tool palette that contains the tool for which you want to select 
a new icon. 

3 Select the tool, right-click, and click Properties. 

4 In the Tool Properties worksheet, right-click on the existing icon, and click 
Specify Image. 
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5 In the Select Image dialog box, select the image you want to use as a tool 
icon, and click Open. 

6 Click OK.

To create an icon from an object in the drawing, select the tool in the tool 
palette, right-click, and click Set Image from Selection. Then, select the object 
in the drawing you want to use as a tool icon, and press ENTER. 

When you create a tool icon from an object in the drawing, it is created with 
the last used view direction and display configuration set in the viewer of the 
properties of this tool type. For example, if the tool viewer of the last used 
wall is set to TOP view and the Medium Detail display configuration, any 
wall you select in the drawing as a tool icon is displayed in TOP view and 
with the Medium Detail display configuration.

You cannot create icons from custom blocks. If you need to create an icon 
based on a custom block, specify an external image. 

Refreshing a Tool Icon

Use this procedure to refresh a tool icon after editing the viewer settings of 
the tool. 

1 On the Window menu, click Tool Palettes. 

2 Click the tool palette that contains the tool the icon of which you want 
to refresh. 

3 Select the tool, right-click, and click Properties. 

4 In the Tool Properties worksheet, change the Viewer settings of the tool. 

For example, switch from a SW Isometric view to a TOP view.

5 Right-click on the existing icon, and click Refresh Image. 

6 Click OK.
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Creating a Tool from an Object in the Drawing

Use this procedure to create a tool from an object in the drawing. 

You can only create object tools with this method. For information on creat-
ing command tools, see “Creating a Command Tool” on page 134.

1 Create an object with the appropriate style and properties in the drawing.

NOTE The drawing containing the style should be saved and located in a 
location where it will be available in the future or the tool will not be able to 
access the style, and will revert to the Standard style.

2 Open the tool palette where you want to create the new tool. 

3 Select the object, and drag it to the tool palette. 

4 Define additional properties for the tool, if necessary. 

For more information, see “Changing the Tool Properties” on page 127.

Copying a Tool from a Tool Palette

Use this procedure to copy a tool from one tool palette to another. 

1 Open the tool palette that contains the tool you want to copy. 

2 Select the tool, right-click, and click Copy. 

3 Open the tool palette onto which you want to copy the tool, right-click, 
and click Paste. 

4 Change the properties of the tool, if necessary. 
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For more information, see “Changing the Tool Properties” on page 127.

Creating a Tool from the Style Manager

Use this procedure to create a tool from a style in the Style Manager. 

NOTE You can create tools only from object styles. You cannot, for example, 
create a tool from a 2D section style or a property set definition.

Creating a tool from the Style Manager

1 Open the tool palette where you want to create the new tool. 

2 On the Format menu, click Style Manager, and navigate to the style you 
want to use. 

For example, if you want to create a wall tool with the Demolition style, 
expand Wall Styles, and select the Demolition style.

3 Drag the style to the tool palette. 

A new tool with the selected style is inserted in the tool palette. 

4 Close the Style Manager.

5 Define additional properties for the tool in the tool palette, if necessary.
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For more information, see “Changing the Tool Properties” on page 127.

Creating a Tool from AEC Content in 
DesignCenter

Use this procedure to create a tool on a tool palette from an AEC Content 
item in DesignCenter.

NOTE You can also create tools from blocks in DesignCenter, but they have 
slightly different tool options. 

You can drag and drop AEC content items from a DesignCenter folder to a 
tool palette. For more information on creating AEC Content, see “Custom 
Content” on page 2343.

Autodesk Architectural Desktop provides the Design Tool Catalog and the 
Documentation Tool Catalog in the Content Browser, which already have 
tools set up for all predefined AEC Content and sample object styles. These 
catalogs are available for both metric and imperial units.

Adding an AEC Content item to a tool palette
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1 Open the tool palette where you want to create the new tool. 

2 On the Insert menu, click DesignCenter, and navigate to the AEC Content 
item you want to create a tool from. 

3 Drag the item to the tool palette. 

A new tool is inserted in the tool palette. 

To change the icon of the new tool, see “Changing a Tool Icon” on 
page 128.

NOTE An AEC Content tool uses the last used Viewer settings of this tool 
type for the automatic generation of the tool icon. If the last used Viewer set-
ting has been a Gouraud 3D view, and the user then creates a tool from a 2D 
AEC Content item, the tool icon will be invisible. In this case, you need to 
change the Viewer setting of the tool to a TOP view, and wireframe. 

4 Define additional properties for the tool, if necessary.

For more information, see “Changing the Tool Properties” on page 127.

Creating a Command Tool

Use this procedure to create a tool for a command in Autodesk® Architectural 
Desktop.

Tools usually represent objects or AEC content items; however, you can also 
create a tool for a command in Autodesk Architectural Desktop.

You can either copy an existing command tool from one of your tool palettes 
and exchange its command, or use the Stock Command Tool from the Stock 
Tool Catalog in the Content Browser. 

For a list of predefined command tools, see “Object-related Command Tools” 
on page 105.
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Command tool properties

1 Place a copy of a command tool on another tool palette:

2 Select the command tool, right-click, and click Properties. 

3 For Command, enter the command that should be initiated when starting 
the tool. 

If you want to . . . Then . . .

copy an existing command 
tool from a tool palette 

navigate to the tool palette, right-click the 
command tool, and click Copy. Then, navigate to 
the tool palette on which you want to insert the 
new command tool, right-click, and click Paste.

use the Stock Command 
Tool from the Stock Tool 
Catalog

open the Content Browser, and navigate to Stock 
Tool Catalog ➤ General Purpose Tools ➤ Helper 
Tools. Then, move the pointer over the i-drop icon 
next to the tool, and drag the Stock Command 
Tool to the tool palette where you want to create 
the new command tool. 
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TIP For a list of all available Autodesk Architectural Desktop commands, 
type arx on the command line, and then c (Commands).

4 Click OK. 

Working with Tools from a Central Location

You can use the Content Browser to store and organize your tools in a catalog 
in a central location. In the Content Browser, a number of stock tools are 
available in the Autodesk® Architectural Desktop Stock Tool Catalog. Addi-
tionally, there are a number of sample catalogs containing tools with the 
styles from the Styles drawings. You can copy these tools to a tool palette and 
modify them. You can also create your own tool palettes and tools in a cata-
log in the Content Browser, copy them to a tool palette, and still retain the 
link from the Content Browser to the tool palette. In this case, the tool is 
refreshed in the tool palette when it is modified in the catalog in the Content 
Browser. 

NOTE If you want to link a complete tool palette from Content Browser to 
Autodesk Architectural Desktop, see “Adding a Tool Palette from a Tool Catalog 
in the Content Browser” on page 121.

Related Procedures

� Linking a Tool from a Catalog in the Content Browser

� Updating a Tool in Autodesk Architectural Desktop from the Content 
Browser

� Updating a Tool in the Content Browser from a Linked Tool in Autodesk 
Architectural Desktop

� Removing the Link of a Tool to a Catalog in the Content Browser

Linking a Tool from a Catalog in the Content Browser
Use this procedure to link a tool from a catalog in the Content Browser to a 
tool palette in Autodesk Architectural Desktop.
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Linking a tool from a catalog in the Content Browser

1 Open the tool palette on which you want to place a tool from the Content 
Browser. 

2 On the Window menu, click Content Browser, and navigate to the tool 
palette or category in the tool catalog that contains the tool you want to 
copy. 

For more information, see “Searching for Items in a Tool Catalog” on 
page 187.

3 Move the pointer over the i-drop icon next to the tool, so that the pointer 

image changes to an eyedropper ( ).

To copy multiple tools, press and hold CTRL while clicking each tool; then 
position the eyedropper over any of the selected tools. You can also select 
all the tools in the current category by right-clicking, and clicking Select 
All.

4 Drag the eyedropper to a tool palette in the tool palettes set.

5 To refresh the tool, select it, right-click and click Refresh Tool. 

Alternatively, you can select the tool in the tool palette, right-click, and 
click Properties. Then, select Refresh from in the Properties worksheet. 
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Updating a tool from the Properties worksheet

NOTE When you select Refresh from, all tool properties in the worksheet 
are set to read-only. Properties for this tool must be changed in the Content 
Browser.

6 Click OK.

Updating a Tool in Autodesk Architectural Desktop from the 
Content Browser
Use this procedure to update a tool in an Autodesk Architectural Desktop pal-
ette that has a link to the Content Browser. 

NOTE You cannot change and update tools from the Stock Tool Catalog in the 
Content Browser. These tools are read-only. 

1 Open the tool palette that contains the tool you want to update.

2 Select the tool that you want to update, right-click, and click Refresh Tool. 
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Updating a Tool in the Content Browser from a Linked Tool in 
Autodesk Architectural Desktop
Use this procedure to update a tool in a catalog in the Content Browser with 
the properties of a linked tool from Autodesk Architectural Desktop.

For example, perhaps you have a tool in the Content Browser that adds a Box 
mass element of 3x3x3 meters. You want to change the tool so that it adds a 
Box mass element of 4x4x4 meters. In this case, you would first link the mass 

element tool from the Content Browser to a tool palette in Autodesk® Archi-
tectural Desktop. You would then temporarily deactivate the link of the tool 
to the Content Browser and change the dimension properties of the tool to 
4x4x4 meters. When you finish changing the tool properties, you copy the 
tool back to the Content Browser. The Content Browser catalog is updated 
with the new tool properties. To recreate the link from the Content Browser 
tool to the Autodesk Architectural Desktop palettes, reactivate the linking.

1 Link a tool from a catalog in the Content Browser to a tool palette as 
described in “Linking a Tool from a Catalog in the Content Browser” on 
page 136.

2 Select the tool in the tool palette, right-click, and click Properties. 

3 In the Tool Properties worksheet, clear Refresh from. 

The tool properties can now be edited. 

4 Make the necessary changes to the tool properties. 

5 Click OK. 

6 Select the tool in the tool palette, and copy it back to its original location 
in the Content Browser catalog. 

NOTE You can copy a tool to a catalog in the Content Browser by either 
using the Copy and Paste commands from the shortcut menu, or by dragging 
the tool onto the Content Browser icon in the Windows task bar. To select 
multiple tools in a tool palette, use CTRL-A to select all or drag while holding 
the CTRL key to create a selection window. 

7 Click Yes when prompted to overwrite the previous version of the tool.

8 If you want the tool in the Autodesk Architectural Desktop tool palette to 
refresh from the new version stored in the Content Browser, go back to the 
Autodesk Architectural Desktop tool, right-click, and in the Tool Proper-
ties worksheet, reactivate Refresh from. 
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Removing the Link of a Tool to a Catalog in the Content 
Browser
Use this procedure to permanently remove the link of a tool to its source tool 
in the Content Browser. 

NOTE This action cannot be undone.

1 Open the tool palette that contains the tool you want to unlink from a cat-
alog in the Content Browser.

2 Select the tool, right-click, and click Remove Catalog Link.

Applying the Properties of a Tool to an Existing 
Object

Use this procedure to apply the properties of a tool to an existing object. 

You can apply the properties of a tool to an existing object in two different 
ways: 

� Applying the properties of a tool to an object of the same type: You can 
apply the properties of a tool to objects of the same type, for example, 
apply the properties of a wall tool to an existing wall. In previous versions 
of Autodesk Architectural Desktop, you would use the Match command to 
do this. All object tools have this functionality.

� Applying the properties of a tool to a different object type: When you 
apply the properties of a tool to a different object type, you convert the 
object to an object of the same type as the tool. For example, when you 
apply the properties of a wall tool to a polyline, the polyline is converted 
to wall with the settings defined in the wall tool. Depending on their type, 
various object tool types may have commands for converting other 
objects, or not. For detailed information, see the chapters for the individ-
ual objects. 

1 Open the tool palette that contains the tool the properties of which you 
want to apply to a different object.

2 Select the tool, and right-click.
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3 Define to which object type you want to apply the tool properties. 

4 Select the object to which you want to apply the tool properties in the 
drawing, and press ENTER. 

Re-Importing Styles for a Tool

Use this procedure to re-import the style of a tool that uses a style from an 
external Styles drawing. 

When you create a tool, you can choose if you are assigning it a style from 
the current drawing or from an external Styles drawing. Usually you define a 
style from a Styles drawing, so that the tool can be used in other drawings as 
well. 

When the style in the external Styles drawing has been changed, you need to 
update the tool to reflect these changes. 

NOTE When you update the style of a tool, all existing objects inserted with 
this tool are updated, too. 

1 Open the tool palette that contains the tool for which you want to update 
the style.

2 Select the tool, right-click, and click <Style Name> <Object Name> Style. 

For example, if you want to update the Brick-4 Furring-4 style of a wall 
tool, click Import ’Brick-4 Furring-4’ Wall Style. 

Deleting a Tool

Use this procedure to delete a tool from a tool palette. 

if you want to . . . Then . . .

apply the properties of the 
tool to an object of the 
same type

click Apply Tool Properties to <Object>. For 
example, to apply the tool properties of a door 
tool to an existing door, click Apply Tool 
Properties to Door.

apply the properties of the 
tool to an object of a 
different type

click Apply Tool Properties to ➤ <Object>. For 
example, to apply the tool properties of a wall to 
tool to an AutoCAD polyline, click Apply Tool 
Properties to ➤ Linework.



142 | Chapter 3 The Workspace

When you delete a tool from a tool palette, existing objects in the drawing 
that have been inserted with this tool are not deleted. 

NOTE If you have linked a tool palette from the Content Browser to the tool 
palettes set as described in “Adding a Tool Palette from a Tool Catalog in the 
Content Browser” on page 121, you cannot delete individual tools from it. To 
delete the tool, you need to delete it from the palette in the Content Browser, 
and then update the palette in Autodesk Architectural Desktop as described in 
“Updating a Tool Palette from a Tool Catalog in the Content Browser” on 
page 122.

1 Open the tool palette that contains the tool you want to delete.

2 Select the tool, right-click, and click Delete Tool.

The Properties Palette

The Properties palette provides a central location to enter and change the 
properties of an object. You can enter information about the style, dimen-
sions, location, property set data, and other important characteristics of an 
object. You will typically keep the Properties palette open during an 
Autodesk® Architectural Desktop session. 
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Related Topics and Procedures

� Opening the Properties Palette

� Setting the Appearance of the Properties Palette

� The Design Tab

� The Extended Data Tab
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� Worksheets

Opening the Properties Palette

Use one of these procedures to open the Properties palette: 

� On the Window menu, click Properties Palette. 

�  Click  on the Navigation toolbar.
� Press CTRL+1.
� Select an object in the drawing, right-click, and click Properties.
� Double-click an object in the drawing. 

Setting the Appearance of the Properties Palette

The Properties palette is usually kept open during the Autodesk® Architec-
tural Desktop session, since it is the central location from which you add and 
change properties of an object. 

Related Procedures

� Docking the Properties Palette

� Hiding the Properties Palette

� Adjusting the Transparency of the Properties Palette

Docking the Properties Palette
Use this procedure to dock the Properties palette on the left or right side of 
your workspace.

1 In the title bar of the Properties palette, click , and then click Allow 
Docking.

2 Position the cursor over the title bar, and drag the Properties palette to one 
side of your workspace.

A preview graphic shows you the new position of the Properties palette. 

3 Release the Properties palette at the location you want.

Hiding the Properties Palette
Use this procedure to hide the Properties palette when not in use. The Prop-
erties palette can be configured to automatically hide when you move the 
cursor away from it, leaving only the title bar visible. When you move the 
cursor over the title bar, the Properties palette is re-displayed. 
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Properties palette hidden (left) and re-displayed (right)

1 In the title bar of the Properties palette, click  (Auto-hide).

The Properties palette is hidden, except for the title bar. 

2 To re-display the Properties palette, move the cursor over the title bar. 

Adjusting the Transparency of the Properties Palette
Use this procedure to adjust the transparency of the Properties palette. The 
more transparent the Properties palette is, the better you can see objects in 
your drawing underneath it.

NOTE Transparency is not available if hardware acceleration is enabled.

1 In the title bar of the Properties palette, click , and then click Transpar-
ency.

2 To adjust the transparency of the Properties palette, move the slider.

3 To turn off transparency, select Turn off window transparency.

4 Click OK.
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The Design Tab

Most properties of an object are entered on the Design tab of the Properties 
palette. 

Design tab of a wall

In the Design tab, you can enter a number of general object properties: 

� Description of the object
� Layer key of the object
� Layer overrides of the object
� Object style
� Location of object style

As a default, these properties are defined by the properties you have set in the 
tool used to create the object. You can change these properties for an individ-
ual object instance. For more information, see “Changing the Tool Proper-
ties” on page 127.

On the Design tab, you also enter object-specific design properties. The 
object properties that are available depends on the object you are editing: 

� Dimensions: Most objects in Autodesk® Architectural Desktop have 
dimension settings for width, height, and other basic dimensions. Many 
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objects have additional settings. A wall, for example, has additional 
length and baseline justification settings. 

� Location: Most objects in Autodesk Architectural Desktop have settings 
for the object location. Anchored objects, like windows and doors, also 
have Anchor properties. 

For detailed information about entering properties for a specific object, see 
the individual object chapters. 

The Extended Data Tab

The Extended Data tab of the Properties palette contains the following object 
properties: 

� Hyperlink: You can add a hyperlink to an object. For more information, 
see “Add Hyperlinks to a Drawing” in the AutoCAD 2004 User’s Guide. 

� Text Notes and Reference Files: You can add a note or an associated refer-
ence file to an object. 

� Property Set Data: You can add, edit, and remove property set data for an 
object. For more information, see “Attaching Property Set Data to 
Objects” on page 2205.
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Property set data in the Properties palette

Worksheets

The properties of an object are entered and changed in the Properties Palette. 
Most properties are directly entered and immediately updated on screen. 
Some objects have complex properties that are entered in worksheets within 
the Properties Palette. 

Worksheets are designed to focus on a particular task of an object. They will 
only appear when they are launched from a palette or from an object. They 
cannot be accessed from the pulldown menus, as they always refer to a spe-
cific object or object tool. 
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Opening the Anchor worksheet

A worksheet is a modal dialog box that must be closed before continuing to 
work in the drawing. 

Direct Editing with Grips and Dynamic 
Dimensions

With the enhanced grip functionality, you can make quick design changes 
directly in the workspace without using dialog boxes. Now in a single click, 
you can perform design changes such as adjusting the door width and the 
window height, modifying the wall roofline, or reversing the wall direction. 
For some grips, the CTRL-key gives you additional manipulation options. 
This is indicated in the grip tips of the grips. For example, the “Width” grip 
of a wall can either maintain the wall baseline when dragging or the opposite 
face of the wall. To switch between these two options, you use the CTRL-key. 
An added enhancement is the introduction of dynamic dimensions. As you 
make design changes, dynamic dimensions appear and ensure that your 
changes are precise and accurate. 
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Window dimension grips in Plan view and Model view

Depending on the object type, different grips are available. For example, a 
wall and a freestanding railing have a direction (arrow) grip to change the 
direction of the object. A railing that is attached to a stair or a structural 
member does not have a direction grip. 

Objects can have different grips depending on the view they are in. For exam-
ple, a structural beam has an additional “Roll” grip in Model views that is not 
visible in Plan views. Because rolling a beam is a 3D operation that you can 
only perform in an isometric view, it makes no sense to display the Roll grip 
in Plan views. Similarly, roof and floor line grips are only useful in a 3D view; 
therefore, they are displayed only in Model views. 
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Curtain wall grips in Plan view and Model view

For detailed information about the grips for Autodesk® Architectural Desktop 
objects, refer to the illustrations and descriptions in the grip-editing sections 
of the individual object chapters. 

Related Topics and Procedures

� Grip Tips

� Grip Color

� Using the CTRL Key with Grips

� Trigger Grips

� Grip Constraints

� Temporary Grip Coordinate Systems

� Dynamic Dimensions

Grip Tips 

For a quick description of the function of a specific grip, you can hover over 
the grip to display its grip tip. Each grip has its name displayed in the grip 
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tip, for example, “Flip” or “Lengthen.” In some cases, the grip tip contains 
additional information about the grip functionality.

Grip Color

The color of a grip specifies whether the grip modifies a selected object or 
other objects in a drawing when you use it. Typically, a grip is used to change 
a property of a selected object. However, some grips might change the prop-
erties of all other objects in a drawing with the same style as the selected 
object. Other grips do not change the selected object at all, but are used to 
change the grip editing mode of the object.

Grip Type and Default Color Function

Object (Cyan) changes a property of a selected object

Style (Magenta) changes a property of a selected object and all 
other objects with the same style in the current 
drawing

Auxiliary (Gray) does not change any property of any object
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Different grip types display in different colors in an in-place editing session

You can change the color of these grips on the AEC Editor tab in the Options. 
For more information, see “Changing the AEC Editor Settings” in the online 
Autodesk Architectural Desktop 2004 User’s Guide.

Using the CTRL Key with Grips

Some object grips have multiple functions. For example, a face grip on a free-
form mass element has these possible grip modes: 

� Move ortho
� Move
� Move plane
� Pull ortho
� Pull
� Push ortho

When a grip has multiple modes, this information is displayed in the grip tip. 
To switch between the different grip modes, use the CTRL key.

1 Select the object with the grip.

2 Hover over the grip, to see what grip modes are available. 

The first mode listed is the mode that will be started when you select the 
grip without using the CTRL key. 

3 Select the grip. 

4 Press CTRL to toggle to the next editing mode. 

NOTE You just need to press the CTRL key once, and then release it. This 
toggles the grip to the next editing mode. After releasing the CTRL key, you 
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can start editing the grip. Do not keep pressing CTRL while editing the grip. 

Trigger Grips

Trigger grips are a special type of grip. A trigger grip immediately performs an 
action on an object when you select it, as opposed to a normal drag grip, 
which changes a dimension property only when you drag it. You can use trig-
ger grips to set discrete properties of an object, such as the swing direction of 
a door or the justification of a wall. You can also use trigger grips to change 
the grip edit mode of an object. For example, selecting the Edit Grid grip in 
a curtain wall initiates an in-place editing mode for the curtain wall grid. 
Selecting the Edit In Place grip in an AEC dimension activates additional 
grips for the individual dimension chains, text strings, and extension lines. 
A trigger grip typically displays with a circle or an arrow. 

AEC dimension before and after activating Trigger grip

In some cases, such as with the AEC dimension Trigger grip, the grip edit 
mode is exited when you deselect the object. In other cases, you must click 
the Trigger grip again to exit the grip edit mode. 
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Dynamic Dimensions

When you use grips to change the dimensions of an object, temporary 
dimension objects show you the changes you are making. 

Dynamic dimensions for changing the window width

These dynamic dimensions give you instant feedback about your changes. 
You can also use the dynamic dimensions to enter new dimension values 
directly on screen. 
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Three types of dynamic dimensions display on grips:

� Focal dimensions, which display in a rectangular box in magenta text. If 
you type a value while a dynamic dimension is focused, an edit box imme-
diately displays at the dimension text location.

� Editable dimensions, which display in black or white text. If you press TAB 
while a dynamic dimension is focused, the dimension focus shifts forward 
to the next editable dimension. You can continue pressing TAB to cycle 
forward through all editable dimensions, or press SHIFT+TAB to cycle back-
wards through all editable dimensions.

� Non-editable dimensions, which display in gray text. These dimensions 
typically display the current value of a property that you can modify with 
a grip.

You can set the color of the focal dynamic dimension text on the AEC Editor 
tab in the Options. For more information, see “Changing the AEC Editor Set-
tings” in the online Autodesk Architectural Desktop 2004 User’s Guide.

NOTE When a dimension edit box displays, pressing ENTER sets the value of 
the property that you are editing and ends the grip operation. Pressing TAB sets 
the value, changes the focused dimension, and continues the same grip editing 
operation.

NOTE When one or more editable dimensions display, you can always press 
TAB to a state where no dimension has focus, during which you can use normal 
direct distance entry on the command line. You can always reach this non-
focused state by pressing SHIFT+TAB immediately after selecting a grip.

1 Select the grip representing the dimension you want to change. 
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For example, to change the length of a curtain wall, select one of its 
Lengthen grips. 

2 Directly enter the new value on screen, and press ENTER. 

Grip Constraints

When you select and drag a grip, its final position might not be the same as 
the current cursor position, which might be constrained in some way. For 
example, for the Lengthen grip on a linear wall, the cursor position is pro-
jected to the nearest point on the wall. Whenever the constrained position 
of a grip differs from the current cursor position, a set of dotted lines or arcs 
are drawn from the cursor to the grip to indicate how the grip was con-
strained.

A square-shaped grip typically indicates that the cursor movement is con-
strained to a plane. An isosceles triangle-shaped grip indicates that the cursor 
movement is constrained to a line or curve.

Temporary Grip Coordinate Systems

When you drag a grip, the current cursor position is typically projected to the 
XY plane of the current User Coordinate System (UCS). Some grip editing 
operations are not possible in the current coordinate system. For example, if 
the current UCS is in plan, you cannot change the height of a wall while in 
an isometric view. For this reason, some grips have their own coordinate sys-
tem that is temporarily set while the grip is active. Once the grip editing oper-
ation is complete, the UCS is set back to its previous state. To identify 
whether or not a grip is setting a temporary coordinate system, set UCSICON 

to on, and display the icon at the origin.

In-Place Editing

In-place editing is a special editing mode for making direct on-screen 
changes to components of an object. For example, you can edit wall endcaps, 
wall or curtain wall roof lines, profile based railing posts, or extruded mass 
element outlines with in-place editing. While in-place editing mode is active, 
all other commands and objects in the drawing are “frozen.” To access the 
commands and objects again, exit the in-place editing mode. 

When you enter an in-place editing session, a temporary in-place edit profile 
is drawn around the object being edited. After making your changes to the 
in-place edit profile, exit the in-place edit session, and save the changes. You 
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may also discard all changes upon exiting the in-place session, and revert the 
object to the state before the in-place editing session began. 

In-place edit profile of extruded mass element

The in-place edit profile is displayed in a different color and hatching from 
the object it outlines. You can change the display of the in-place edit profile 
by changing its colors, lineweights, and hatching. 

Sometimes, multiple in-place editing entities are created in a single in-place 
editing session. This is the case for walls that have multiple sweeps or modi-
fiers or for roof slabs and slabs that have both a fascia and a soffit profile.

The in-place editing work mode is invoked from the shortcut menu of an 
object. 

Invoking in-place editing from the shortcut menu of a wall

To access the shortcut menu, select the object, and right-click. Then, select 
the appropriate in-place editing command. When you enter the in-place 
editing mode, a special toolbar displays that helps you to zoom to the cur-
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rently active in-place profile, to save changes to the component, or to discard 
all changes. When you exit the in-place editing mode, the toolbar is closed. 

Related Topics

� In-Place Editing of Polyline-Based Components

� In-Place Editing of Profile-Based Objects and Components

� In-Place Editing of 3D Body Modifiers

� In-Place Editing of Material Hatches

In-Place Editing of Polyline-Based Components

The following objects in Autodesk® Architectural Desktop can have custom 
components based on polylines attached to them:

� Wall endcaps
� Wall/Curtain wall roof and floor lines
� Wall plan modifiers

Once you have assigned a polyline-based component to an object—for exam-
ple, a wall endcap to a wall—you can edit it directly on screen with in-place 
editing. During an in-place editing session, the selected polyline is isolated 
for editing, so that you can perform changes on its shape, such as grip-editing 
or adding and removing vertex points. Before you exit the in-place edit ses-
sion, you can save the changes to the existing style, save to a new style, or 
discard the change. 

Endcap polyline highlighted for in place editing
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You can use in-place editing to modify the polyline-based components of a 
wall either in two-dimensional (2D) Plan views or in three-dimensional (3D) 
Model views.

When you edit a component in a 3D view, the UCS is automatically aligned 
to the component, so that you can easily add and remove vertices and grip-
edit the component. 

The available editing commands for polyline-based components in an in-
place edit session are available on the shortcut menu of the in-place editing 
profile.

Shortcut menu for wall endcap in-place edit profile

To access the shortcut menu, select the in-place editing profile, and right-
click. The available commands for editing polyline-based objects vary, 
depending on the object type. For example, a wall endcap in-place edit pro-
file has commands for adding and removing vertices and hiding and replac-
ing endcap components; the in-place edit profile of a wall roof/floor line has 
commands for adding gables and steps and projecting the roof and floor lines 
to a polyline. For more information, see the chapters on the individual 
objects. 
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In-place editing: Adding a vertex to a wall endcap

In-Place Editing of Profile-Based Objects and 
Components

You can use in-place editing for profile-based objects and object components. 
You can change the shape of the profile, add and remove rings, and, for some 
profiles, move the insertion point.

The following objects are profile-based or can have profile-based compo-
nents to edit with in-place editing:

� Mass elements (extrusions)
� Mask blocks 
� Wall sweeps
� Fascia and soffits of roof slabs and slabs
� Frames and mullions of curtain walls, curtain wall units, and window 

assemblies
� Custom (profile-based) shapes of doors, openings, windows, and window 

assemblies
� Custom (profile-based) shapes of rails and posts in railings
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In-place edit profile on extruded mass elements

NOTE In-place editing for the objects listed above is available only if one or 
more components of the object have been based on profiles. For example, if you 
have a railing where no rails or posts have been based on profiles, the in-place 
editing command is not available. However, if one or more railing components 
are based on a profile definition, you can select the appropriate in-place editing 
command from the shortcut menu of the object. 

Profile-based baluster in a railing
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Shortcut menu of railing component in-place edit profile

The following commands are available to edit a profile-based object compo-
nent: 

Command Description

Add Vertex adds a vertex to the selected profile

Remove Vertex removes a vertex from the selected profile

Add Ring adds a closed polyline, circle, ellipse, or spline to the 
selected profile; you have the option to add the ring 
to the profile or to subtract it

Replace Ring replaces the selected profile with a closed polyline, 
circle, ellipse, or spline

Save Changes saves the changed geometry back to the profile

Save as New Profile saves the changed geometry to a new profile 
definition

Discard All Changes discards all changes to the geometry of the profile 
and reverts back to the profile shape before the in-
place edit session
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For detailed information, see the chapters for the individual objects. 

In-Place Editing of 3D Body Modifiers

You can use in-place editing for editing a 3D body modifier on a wall. You 
can change the shape of the body and perform boolean operations on the 3D 
body modifier.

Shortcut menu of 3D body modifier in in-place edit mode

The following commands are available to edit a 3D body modifier:

Edit Object Display changes the display of the in-place edit profile; you 
can change the display of the profile boundary, the 
profile hatch and—for polyline-based profiles—the 
display of the modifiable and hidden edges

Command Description

Boolean ➤ Union joins the body modifier with a selected 3D object

Command Description
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In-Place Editing of Material Hatches

You can make changes to the surface hatch of an object with an in-place edit 
profile, provided the surface hatch is coming from a material. Unlike the 
other in-place edit types, you do not change the shape of the object with in-
place editing but only the display of the hatch on a specific object face. 

In-place edit profile on a hatched wall

When you use the in-place edit profile to change the appearance of a surface 
hatch on an object face, you create a hatch override. 

You can perform the following changes to a material hatch with in-place 
editing:

� display/hide the surface hatch

Boolean ➤ Subtract subtracts a selected 3D object from the 3D body 
modifier 

Boolean ➤ Intersect creates an intersection object of the 3D body 
modifier and a selected object

Split Face Splits a face of the selected 3D body modifier

Join Faces Joins two previously split faces of a 3D body modifier

Save Changes saves the changed geometry back to the 3D body 
modifier

Discard All Changes discards all changes to the geometry of the 3D body 
modifier and reverts back to the body shape before 
the in-place edit session

Edit Object Display changes the display of the in-place edit profile. 

Command Description
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� Change the rotation of the hatch pattern
� Change the vertical and horizontal offsets of the hatch pattern

You can apply these overrides to all corresponding object faces with the same 
material or to only the selected object face. 

In-place editing a surface hatch

For more information, see “Working with Surface Hatches” on page 504.
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Changing the hatch rotation with in-place editing

Styles and Support Files

With this release of Autodesk®  Architectural Desktop, the location of styles, 
templates, and other support files have changed. For example, styles are no 
longer integrated into the templates but are instead contained in Styles draw-
ings from which you select styles to add to your drawing. In previous releases 
these same style drawings existed and contained all the same styles that were 
also in the templates. This ensures smaller templates and a clearer structure 
of your drawings. In addition, to conform to Microsoft®  Windows®  standards 
some file paths have changed. 
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Support files are in the following locations:

Files Location

Plotter Configurations C:\Documents and Settings\<Username>\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Plotters

Plot Styles C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Plot Styles

DesignCenter Content C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\AEC Content

PropertySetDefs.dwg C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\AEC Content\<Imperial or 
Metric>\Documentation\Schedule Tags

Layer Standards drawing C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Layers

Styles drawings C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles

Drawing templates C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Templates

Area Evaluation templates C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Templates\Evaluation Templates

Sample Drawing 
Management Project

\\Program Files\Autodesk Architectural Desktop 
2004\Sample\ADT Sample Project

Default Used Workspace 
Catalog

C:\Documents and Settings\<Username>\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Support\WorkspaceCatalog 
(Imperial/Metric)

Stock Tool Catalog \\Program Files\Autodesk Architectural Desktop 
2004\Catalogs\StockToolCatalog

Structural Member 
Catalog

\\Program Files\Autodesk Architectural Desktop 
2004\Catalogs\Structural
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Integration of Autodesk Architectural 
Desktop and AutoCAD

Autodesk®  Architectural Desktop 2004 is integrated with the AutoCAD®  
2004 design platform. The commands and features of both applications are 
blended within the tool palettes, menus, and toolbars. There are some differ-
ences between working in a pure AutoCAD environment and accessing 
AutoCAD commands from within Autodesk Architectural Desktop. These 
differences are listed in this section. 

AutoCAD Tools
Differences with the AutoCAD tools include:

� You cannot create a block or hatch tool by dropping a sample object in the 
drawing to the tool palette. You must do this from DesignCenter.

�  AutoCAD tools do not use the Properties Palette during adding them to 
the drawing.

� AutoCAD tools do not have the same tool properties as Architectural 
Desktop tools, for example the layer key.

� AutoCAD Hatch tools and Block tools cannot have a user-defined tool 
image. 

� The tool properties of AutoCAD tools cannot be applied to an existing 
AutoCAD object in the drawing. 

AutoCAD Tool Palettes 
Differences with the AutoCAD tool palettes include:

� When you are working in plain AutoCAD, you cannot create and link 
AutoCAD tool palettes from the Content Browser. 

� When you are working in plain AutoCAD, AutoCAD tool palettes do not 
support palette properties.

Sample Tool Palette 
Catalogs

\\Program Files\Autodesk Architectural Desktop 
2004\Sample

Sample Render Material 
Catalog

\\Program Files\Autodesk Architectural Desktop 
2004\Sample\Autodesk Render Material Catalog

VIZ Sample Catalogs \\Program Files\Autodesk Architectural Desktop 
2004\Default Catalogs\ToolCatalogs

Files Location
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Other Differences
Other differences with AutoCAD include:

� Properties Palette: When you are working in plain AutoCAD, you cannot 
set the AutoCAD Properties palette to transparent. 

� Materials: Render materials created by VIZ Render and used by Autodesk 
Architectural Desktop materials use 256 character naming abilities. If you 
are working with the AutoCAD rmat dialog box, only 16 characters are 
displayed. It is recommended that you create your Render materials 
through VIZ Render and not through AutoCAD.

� Revision clouds: The Revision cloud feature in AutoCAD is not identical to 
the Revision Cloud feature in Autodesk Architectural Desktop. Revision 
clouds in Autodesk Architectural Desktop have addition1al scaling and 
layer key functionality, as well as the option of adding a Delta symbol. 

� Layers: Running the layer command from the command line opens the 
Autodesk Architectural Desktop Layer Manager. If you want to open the 
AutoCAD Layer Manager, enter _.layer on the command line. 

� Units: Running the units command from the command line opens the 
Autodesk Architectural Desktop Drawing Setup dialog box. If you want to 
open the AutoCAD Units dialog box, enter ddunits on the command line. 

WARNING! To change the drawing setup of Autodesk Architectural Desk-
top, you must use the Drawing Setup command of Autodesk Architectural 
Desktop. If you change the units in the AutoCAD Units dialog box, Autodesk 
Architectural Desktop drawing units are not affected. 
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In this Chapter

� Tool Catalogs and Websites

� Catalog Libraries

� Tool Catalogs Supplied with 
Autodesk Architectural 
Desktop

� Exploring the Content Browser

� Managing Your Catalog Library

� Searching for Items in a Tool 
Catalog

� Adding Content to a Tool 
Catalog

� Using Tool Catalog Items in 
Autodesk Architectural 
Desktop

� Working with Multiple Content 
Browser Windows

� Starting the Content Browser 
from a Windows Command 
Prompt
The Content Browser lets you store, share, and 
exchange Autodesk® Architectural Desktop con-
tent, tools, and tool palettes. The Content 
Browser runs independently of the software, 
allowing you to exchange tools and tool pal-
ettes with other Autodesk applications, such as 
VIZ® Render.
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Tool Catalogs and Websites

Autodesk Architectural Desktop tools and content are shared in the Content 
Browser using tool catalogs and websites. A tool catalog can contain one or 
more of the following items:

� Tools; for example, a tool to create a customized wall used throughout a 
building project.

� Tool palettes, which contain tools used to support a particular workflow 
or task. For example, a tool palette may contain a set of annotation tools 
used in a project or a set of tools to draw each type of door used in a 
project. A tool palette is treated as a single object.

� Tool packages, which are collections of tools that users can select and use. 
For example, a tool package may contain a set of productivity tools and 
utilities.

A single copy of a tool catalog can be shared among users on your local area 
network. If tools in the catalog are updated, you have immediate access to 
the latest version of the tools.

Websites containing Autodesk Architectural Desktop tools, and content that 

you can download using i-drop® technology, can also function as tool cata-
logs.

Several tool catalogs are provided with Autodesk Architectural Desktop, and 
you can create additional catalogs of your own.

Catalog Libraries

Tool catalogs are organized into catalog libraries, and each Autodesk Archi-
tectural Desktop user has a personal catalog library. 

Tool catalog data is not stored in the catalog library. Rather, the catalog 
library contains pointers to the physical tool catalogs. It is like the card cata-
log in a real library—it tells you where to find a book, but it does not contain 
the book itself. 

You cannot create additional catalog libraries, but you can open catalog 
libraries created by other users if you are authorized to do so.
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Tool Catalogs Supplied with Autodesk 
Architectural Desktop

The following tool catalogs are supplied with your personal catalog library:

Catalog Name Contents

Autodesk® Architectural Desktop 
Stock Tool Catalog

A catalog that contains the standard, stock tools 
in Autodesk Architectural Desktop.

Autodesk® Architectural Desktop 
Sample Palette Catalog - Imperial

A sampling of tools in imperial units for objects 
such as doors, walls, and windows 

Autodesk® Architectural Desktop 
Sample Palette Catalog - Metric

A sampling of tools in metric units for objects 
such as doors, walls, and windows 

 Architectural Desktop Design Tool 
Catalog - Imperial

Content tools in imperial units for design and 
documentation of multi-view blocks and symbols 

 Architectural Desktop Design Tool 
Catalog - Metric

Content tools in metric units for design and 
documentation of multi-view blocks and symbols 

Architectural Desktop 
Documentation Tool Catalog - 
Imperial

Content tools in imperial units for annotation 
and documentation 

Architectural Desktop 
Documentation Tool Catalog - 
Metric

Content tools in metric units for annotation and 
documentation 

Autodesk® Sample Render Material 
Catalog

Architectural render materials for use with 
Autodesk Architectural Desktop and Autodesk 
VIZ Render

My Tool Catalog An empty tool catalog provided so that you can 
create your own tool set

Autodesk® Architectural Desktop 
Tutorial Palette Catalog 

A catalog of the tools used in the metric-based 
Autodesk Architectural Desktop tutorial

Autodesk® Architectural Desktop 
Tutorial Tool Catalog 

A catalog of the tools used in the imperial-based 
Autodesk Architectural Desktop tutorial

Architectural Desktop VIZ Render 
Plug-ins 

Links to 3rd party plug-ins for Autodesk 
Architectural Desktop.
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You cannot add or remove items from the Autodesk-supplied tool catalogs, 
but you can create your own tool catalogs. You can also copy other tool cat-
alogs and website links into your catalog library.

Related Topics and Procedures

� Exploring the Content Browser

� Managing Your Catalog Library

� Searching for Items in a Tool Catalog

� Adding Content to a Tool Catalog

� Using Tool Catalog Items in Autodesk Architectural Desktop

� Working with Multiple Content Browser Windows

� Starting the Content Browser from a Windows Command Prompt

Exploring the Content Browser

To open the Content Browser, click  on the Navigation toolbar.
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Content Browser window at opening

The Content Browser window is usually divided into two panes (web pages 
displayed in the Content Browser occupy the entire window). Tool catalogs 
and their contents are displayed in the right pane. When you start the Con-
tent Browser, your personal catalog library, named <user_name>’s Catalog 
Library, displays in the right pane. The left pane is used mostly for navigation; 
it contains toolbar buttons and other controls that determine what displays 
in the right pane. The buttons at the top of the left pane work much like the 

equivalent controls in a web browser. If you click  the currently open cat-
alog library displays in the right pane.
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You can have more than one instance of the Content Browser open at a time. 
To open an additional Content Browser window, press CTRL+N. For more 
information, see “Working with Multiple Content Browser Windows” on 
page 204.

Related Topics and Procedures

� Viewing a Tool Catalog

� Using the Items in a Tool Catalog

Viewing a Tool Catalog

To view a tool catalog, click the catalog in the catalog library. For example, 
click the Stock Tool catalog to display a window like the following illustra-
tion:

View of the Stock Tool catalog

When you open the Stock Tool catalog, a cover page describing the catalog is 
displayed in the right pane. If no cover page is defined for a tool catalog, 
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items contained in the tool catalog are displayed in the right pane. For infor-
mation about specifying a cover page, see “Editing Tool Catalog Properties” 
on page 185.

To continue past the cover page to the contents of the tool catalog, click the 
catalog name in the left pane of the Content Browser window.

The contents of a tool catalog may be organized into categories. When a tool 
catalog is open in the right pane, any categories are listed in the left pane. For 
example, the Stock Tool catalog is organized into the categories shown in the 
previous illustration.

Categories can be subdivided into one or more levels. A list of subcategories, 
appears when you move the pointer over the category. For example, in the 
Stock Tool catalog, move the pointer over Modeling Tools to see the Mass Ele-
ment Tools and 3D Solids subcategories.

Displaying subcategories in a category

To open a category or subcategory, click it. For example, click Mass Element 
Tools to display the following window:
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Mass Element Tools category of the Stock Tool catalog

Associated with each item in the tool catalog is the following i-drop® icon: 

.

You click the i-drop icon to drag a tool or other tool catalog item into the 
Autodesk Architectural Desktop workspace or into another catalog, tool pal-
ette, or tool package.

You can modify the contents and properties of a tool catalog if you are autho-
rized to do so, unless the catalog is read-only. Read-only tool catalogs are 
identified in the Content Browser title bar when you open the catalog. For 
example, the following title bar identifies the Stock Tool catalog as read-only:

Viewing the Content Browser title bar
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A tool catalog category may contain more items than can fit on a page. If 
multiple pages are needed, navigation controls appear at the top and bottom 
of each page. The Mass Element Tools category shown earlier requires two 
pages to display its contents. You can specify the page to be displayed by 
clicking the page number or by clicking Next or Prev. (Note that these con-
trols appear at the bottom of the page too.) You can also change the number 
of items that display on a Content Browser page.

Specifying the Number of Rows on a Content Browser Page
Use this procedure to specify the number of rows that display on a Content 
Browser page.

1 Click  to display the catalog library.

2 Right-click the catalog library name, and click View Options.

3 In the View Options dialog box, enter the number of rows to be displayed 
on each page. You can specify up to 100 rows, and must specify at least 5.

4 Click OK.

Using the Items in a Tool Catalog

To use a tool catalog item in Autodesk® Architectural Desktop, drag the item 
into the software’s workspace. Dragging a tool palette into the workspace 
adds the tool palette to the default tool palette set.

Autodesk Architectural Desktop tool palette set, with added tool palette

Once added to the tool palette set, the palette remains a part of the set and 
is available each time you start Autodesk Architectural Desktop.
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You can use a catalog tool immediately in the drawing area from the Content 
Browser. For example, with the Mass Element Tools category open in the 
Stock Tool Catalog, drag the Arch tool into the drawing area with the i-drop 
icon to begin adding an arch mass element to your drawing.

If you use a tool frequently, it will save you time if you add the tool to a pal-
ette in the tool palette set, where you can access it without using the Content 
Browser.

Managing Your Catalog Library

You manage your catalog library by adding and deleting tool catalogs and 
website links and by setting catalog properties as needed. You can create a 
catalog from scratch or copy an existing catalog and tailor it to your needs. 
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You can reorganize tool catalogs by moving and copying items between 
them.

Related Topics and Procedures

� Creating a New Tool Catalog

� Adding an Existing Tool Catalog to Your Catalog Library

� Copying a Tool Catalog

� Moving a Tool Catalog

� Adding a Website to Your Catalog Library

� Editing Tool Catalog Properties

� Removing a Tool Catalog or Website Link

� Opening a Different Catalog Library

� Renaming a Catalog Library

Creating a New Tool Catalog

Use this procedure to create a new tool catalog in your catalog library.

1 Click  to display the catalog library.

2 Click  to create a catalog.

3 In the Add Catalog dialog box, select Create a new catalog.

4 Enter a name for your tool catalog. 

Tool catalog names can include spaces and can contain any characters 
except the following:

\ / : * ? " < > |

The name you assign is used for both the file containing the catalog defi-
nition and the folder containing the catalog’s contents. The name is also 
used in the title identifying the tool catalog in the catalog library. You can 
change the title displayed in the catalog library without affecting the file 
and folder name. For information about changing the title, see “Editing 
Tool Catalog Properties” on page 185.

5 Identify the folder in which to store your tool catalog:

If you want to . . . Then . . .

store the tool catalog in 
the default location

click OK.
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NOTE The full path name of the catalog file cannot exceed 255 characters, 
so be careful about using long catalog names. 

The tool catalog is displayed in the catalog library with the following default 
graphic image:

For information about changing the graphic image and other tool catalog 
properties, see “Editing Tool Catalog Properties” on page 185.

Adding an Existing Tool Catalog to Your Catalog 
Library

Use this procedure to add an existing tool catalog to your catalog library.

Adding a tool catalog to a catalog library does not physically move or copy 
any files. Instead, a pointer to the catalog’s location is added to the catalog 
library. If you add a tool catalog that resides on another computer and then 
a tool in that catalog is updated, you always reference the latest version of 
the tool in the catalog library.

1 Click  to display the catalog library.

2 Click  to create a catalog.

3 In the Add Catalog dialog box, select Add an existing catalog or website.

4 Enter the location of the tool catalog you want to add, or click Browse and 
select a catalog.

Tool catalog files typically have the extension .atc. 

5 Click OK.

store the tool catalog in 
a different location

click Browse, select the folder in which to store the 
catalog, and then click OK.

If you want to . . . Then . . .
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Copying a Tool Catalog

Use this procedure to make a copy of a tool catalog. You can then customize 
the contents of the catalog or create a new catalog using the original as its 
basis.

1 Click  to display the catalog library.

2 Right-click the tool catalog you want to copy, and click Copy ‘Catalog 
Name.’

3 In the Copy Catalog dialog box, specify the folder location for the copy of 
the catalog.

4 Click OK.

The new file is named Copy of <catalog_name>.

NOTE You cannot copy a tool catalog using the Copy command in Microsoft® 
Windows Explorer. The tool catalog file contains internal references that must be 
updated when the catalog is copied to a new location. The Content Browser 
updates these references during Copy operations.

Moving a Tool Catalog

Use this procedure to move a tool catalog from one folder to another. This 
procedure works like Copy, except that the original catalog is deleted.

1 Click  to display the catalog library.

2 Right-click the tool catalog you want to move, and click Move.

3 In the Move Catalog dialog box, specify the new folder location for the 
tool catalog.

4 Click OK.

After the tool catalog is moved, the new location is reflected in the catalog 
library. You can verify the location by right-clicking the catalog, clicking 
Properties, and then looking at the value in File or Target.

NOTE You cannot move a tool catalog using the Move command in Windows 
Explorer. The tool catalog file contains internal references that must be updated 
when the catalog is moved to a new location. The Content Browser updates 
these references during Move operations. 
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Adding a Website to Your Catalog Library

Use this procedure to add a website link to your catalog library. Links are use-
ful for websites containing Autodesk Architectural Desktop tools and content 

that you can download using i-drop® technology.

You can also add a website link by dragging the URL from the Address bar of 

Internet Explorer into the Content Browser window.

1 Click  to display the catalog library.

2 Click  to create a catalog.

3 In the Add Catalog dialog box, select Add an existing catalog or website.

4 Enter the location of the website to link:

5 Click OK.

The link to the website is represented in the catalog library by a default 
graphic image, which you can change. For information about changing this 
image and other Tool Catalog properties, see “Editing Tool Catalog Proper-
ties” on page 185.

Opening Web Pages in the Content Browser
Use this procedure to open a web page through a website link in your catalog 
library.

If you want to . . . Then . . .

link to a website on the 
Internet or on an intranet 

enter the URL of the website, including the http:// 
prefix.

TIP Here is the easiest way to specify a URL:
1. Open a web browser, such as Internet Explorer.
2. Open the web page you want to link to.
3. Copy the URL from your browser’s Address bar.
4. Paste the URL into the Add Catalog dialog box.

link to a web page in an 
HTML file on your computer 
or on your network

enter the file name, or click Browse and select the 
file you want to link to.
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TIP If you have any problem viewing a web page in the Content Browser win-
dow, try opening the page in Internet Explorer.

� Move your pointer over the website link you want to open, and do one of 
the following:

Editing Tool Catalog Properties

Use this procedure to view and modify the properties of a tool catalog. If you 
have write access to the tool catalog, you can select a different source file or 
target, and you can change the cover page. 

1 With the catalog library open in the right pane of the Content Browser, 
right-click the desired tool catalog, and click Properties.

2 Edit the properties:

If you want to . . . Then . . .

view the web page in the 
Content Browser window

click the link.

view the web page in a new 
Content Browser window

right-click the link, and click Open in New 
Window.

view the web page in a new 
Internet Explorer window

right-click the link, and click Open With Internet 
Explorer.

If you want to . . . Then . . .

change the graphic image 
that represents the tool 
catalog in the catalog 
library

click the image in the Properties dialog box, and 
then select a graphic file to use. 

You can use a BMP, JPEG, PNG, or TIFF file for your 
graphic.

The graphic image is displayed at 90 ×120 pixels. If 
you specify an image of a different size, the image 
is scaled to fit.

NOTE The graphic file you select is copied into 
the tool catalog’s image folder.

change the title displayed 
beneath the tool catalog’s 
graphic image in the 
catalog library

enter a new title.
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3 Click OK.

Removing a Tool Catalog or Website Link

Use this procedure to remove a tool catalog or website link from your catalog 
library.

When you remove a tool catalog or website link, only a pointer to the item 
is removed; no files or web pages are physically deleted.

1 With the catalog library open in the right pane of the Content Browser, 
right-click the tool catalog or website link to delete, and click Remove 
from Library.

2 When prompted, click Yes to confirm deletion, or click No to cancel dele-
tion.

Opening a Different Catalog Library

Use this procedure to open a catalog library other than your personal catalog 
library or to reopen your personal catalog library.

A catalog library is stored in a file having the extension .cbl. The default file 
name for your personal catalog library is ContentBrowserLibrary.cbl; it is stored 
in the folder My Documents\My AEC Content Browser Library.

1 Click  to display the current open catalog library.

2 Right-click the catalog library name, and click Open New Library.

3 In the Open dialog box, select the catalog library that you want to open.

change the descriptive text 
that displays when you 
move the pointer over the 
tool catalog’s graphic image

enter a new description.

change the tool catalog file 
or website

enter the new file in File or Target, or click Browse 
to select a tool catalog file.

change or specify the HTML 
file that displays when the 
tool catalog is opened 

enter the new HTML file in Cover Page, or click 
Browse to select a cover page.

change the publisher of the 
tool catalog

enter a new publisher name.

If you want to . . . Then . . .
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Renaming a Catalog Library

Use this procedure to rename the currently open catalog library. The name 
change affects the title of the catalog library displayed in the Content 
Browser, but no files are renamed.

1 Click  to display the catalog library.

2 Right-click the catalog library name, and click Rename Library.

3 Enter the new library name, and click OK.

Searching for Items in a Tool Catalog

You can use the Search feature to help you find a particular tool. You can 
search a tool catalog, a tool palette, or a tool package. For example, if you are 
looking for a tool to help you create a roof dormer, you could search on the 
keyword roof or the keyword dormer. 

The Search feature looks at the text in the following properties of tool catalog 
items for the keywords you specify:

� Name
� Description
� Keywords

The Search tool is only as helpful as the tool names and descriptions that you 
assign. A tool name should indicate the tool’s function, and the description 
should indicate the tool’s use.

If you enter a search term containing more than one word, the Search feature 
looks for items containing any of the words you entered. Only one catalog 
can be searched at a time.

Search results are displayed in the right pane of the Content Browser window. 
The following illustration shows the results of a search on the term roof in the 
Stock Tool catalog: 
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The search term and the number of items found are listed on the line below 
the tool catalog name. If multiple pages are returned, you can specify the 
page to display by clicking the page number or by clicking Next or Prev.

Related Procedures

� Performing a Search

Performing a Search

Use this procedure to search all or part of a tool catalog. 

1 Open the tool catalog you want to search:

2 Enter the term to search for under Search.

If you enter more than one word, items containing any of those words are 
returned. The Search feature does not recognize operators such as AND 
and AND NOT.

3 Click GO.

Items that match your search criteria are displayed in the right pane of the 
Content Browser.

If you want to . . . Then . . .

search for tools only within 
a specific category and its 
subcategories

open the category you want to search, and select 
the box labeled in <category name>.

search for tools only in a 
specific tool palette

open the tool palette you want to search, and 
select the box labeled in <palette name>.

search for tools anywhere 
in the open catalog

leave the box under the search term deselected.
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4 To perform another search, click the  button located near the top of 
the left pane.

Adding Content to a Tool Catalog

Tool catalogs can contain tools, tool palettes, and tool packages, which may 
be organized into categories.

Categorizing the Items in a Tool Catalog
You can define categories and subcategories in a tool catalog to organize a 
large number of items. For example, the Stock Tool catalog contains dozens 
of tools. If these tools were not grouped into categories, you would have to 
scroll through page after page to find a particular tool. To make it easier to 
find tools, the Stock Tool catalog is organized into categories and subcatego-
ries, as shown in the following diagram:
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Organizational structure of the Stock Tool catalog

About Tool Palettes
A tool palette is a collection of tools used to support a task. For example, a 
palette might contain tools to create the different types of doors (single-
hinged, double-hinged, revolving, and so on) used in a building project. Stor-
ing a tool palette in a tool catalog makes the palette available to multiple 
users.

The date and time at which the tool palette was created and last modified are 
identified in the Tool Palette Properties dialog box. To view the dialog box, 
right-click the tool palette, and click Properties. For information about other 
tool palette properties, see “Adding a Tool Palette to a Tool Catalog” on 
page 193.
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About Tool Packages
A tool package is a group of tools stored together for distribution. For exam-
ple, a package might contain a set of productivity tools and utilities.

The date and time at which the tool package was created and last modified 
are identified in the Tool Package Properties dialog box. To view the dialog 
box, right-click the tool package, and click Properties. For information about 
other tool package properties, see “Adding a Tool Package to a Tool Catalog” 
on page 193.

Customizing Tools
You customize a tool by copying it to a palette in the Autodesk Architectural 
Desktop tool palette set, modifying the tool’s properties, and then copying it 
back to its original location in the tool catalog.

Related Topics and Procedures

� Defining Categories in a Tool Catalog

� Adding a Tool Palette to a Tool Catalog

� Adding a Tool Package to a Tool Catalog

� Adding Tools to a Tool Catalog

� Copying and Moving Tool Palettes and Tool Packages

� Copying and Moving Tools

� Customizing a Tool

� Deleting Tool Catalog Items

Defining Categories in a Tool Catalog

Use this procedure to define categories and subcategories in a tool catalog.

Categories are listed in the left pane of the Content Browser, below the name 
of the open tool catalog.
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List of categories in the Tutorial Tool catalog

1 Open the tool catalog in which to define categories.

2 Select the location for the new category: 

3 In the right pane of the Content Browser window, right-click a blank area, 
and click Add Category.

4 Enter a name for the category, and click OK.

5 To define additional categories and subcategories, continue from step 2.

If . . . Then . . .

the tool catalog already has one 
or more categories defined and 
you want to add a subcategory

in the left pane of the Content Browser, 
navigate to the desired category, and click the 
category name. 

the tool catalog is not currently 
divided into categories and is 
open to a cover page

in the left pane of the Content Browser, click 
the catalog name.

the tool catalog is not currently 
divided into categories and the 
content page is displayed

do nothing; this is where you define your first 
category.
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Adding a Tool Palette to a Tool Catalog

Use this procedure to add a tool palette to a tool catalog. You must have write 
access to the tool catalog in order to add a palette.

You can also drag a tool palette from the Autodesk Architectural Desktop 
workspace into a tool catalog. Click in the tab of the tool palette to drag it.

1 In the Content Browser, open the tool catalog in which to add the tool 
palette.

To add the palette to a specific category in the catalog, open that category.

If no graphics appear at the bottom of the left pane, the tool catalog is 
read-only, and you cannot add a tool palette.

2 Click  in the left pane of the Content Browser.

3 In the Tool Palette Properties dialog box, enter a name for the tool palette, 
and enter any other desired properties: 

Adding a Tool Package to a Tool Catalog

Use this procedure to add a tool package to a tool catalog. You must have 
write access to the tool catalog in order to add a package.

1 In the Content Browser, open the tool catalog in which to add the tool 
package.

To add the package to a specific category in the catalog, open that cate-
gory.

2 Click  in the left pane of the Content Browser.

If you want to . . . Then . . .

add a description to be 
displayed in the tool catalog and 
queried in catalog search 
operations

enter a description.

define terms that will be found 
during a search of the tool 
catalog

enter the terms for Keywords.

identify the publisher of the tool 
palette

enter a publisher.
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3 In the Package Properties dialog box, enter a name for the tool package, 
and enter any other desired properties: 

If the tool catalog is read-only, the Package Properties dialog box is dis-
played, but you cannot enter anything in it.

Adding Tools to a Tool Catalog

Use this procedure to add a tool to a tool catalog or to a tool palette or tool 
package stored in a catalog. You must have write access to the tool catalog in 
order to add a tool to it. 

You can also drag a tool from a tool palette in the Autodesk Architectural 
Desktop workspace to a tool catalog in the Content Browser.

1 In the Content Browser, open the tool catalog in which to add a tool. 

If you are adding the tool to a specific category in the catalog or to a pal-
ette or package in a specific category, open that category.

2 Double click the image to open the palette or package if you are adding 
the tool to a tool palette or tool package.

3 In the Autodesk Architectural Desktop workspace, open the tool palette 
that contains the tool to add to the tool catalog.

4 Right-click the tool, and click Copy.

5 In the right pane of the Content Browser window, right-click in a blank 
area, and click Paste.

NOTE If there is no Paste option on the shortcut menu, then the pointer is 
probably positioned over a tool, even though the space may appear to be 
blank. Move the pointer and try again.

If you want to . . . Then . . .

add a description to be 
displayed in the tool catalog and 
queried in catalog search 
operations

enter a description.

define terms that will be found 
during a search of the tool 
package

enter the terms in Keywords.

identify the publisher of the tool 
package

enter a publisher.
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Copying and Moving Tool Palettes and Tool 
Packages

Use this procedure to copy or move tool palettes or tool packages between 
tool catalogs or between categories in the same catalog. To copy an item, you 
must have write access to the catalog you are copying to. To move an item, 
you must have write access to both the catalog you are copying from and the 
catalog you are copying to.

You can also open multiple Content Browser windows and drag tool palettes 
and tool packages from one window to another. For information about using 
multiple windows to copy and move items, see “Dragging Catalog Items 
Between Content Browser Windows” on page 206.

1 Open the tool catalog containing the tool palette or tool package to copy 
or move. If the item is located in a specific category of the catalog, open 
that category.

2 Right-click the item, and select an action:

3 Select the item’s destination:

If you want to . . . Then . . .

add a copy of the tool palette 
or tool package in another 
location

click Copy.

move the tool palette or tool 
package to another location, 
deleting it from its original 
location

click Cut.

If the destination is . . . Then . . .

a category within the current 
tool catalog

click that category in the left pane of the Content 
Browser window.

another tool catalog
click  to return to the catalog library, then 
click the tool catalog.

a category in another tool 
catalog click  to return to the catalog library, click 

the tool catalog you are copying to, and then 
select its category in the left pane of the Content 
Browser window.
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4 In the right pane of the Content Browser window, right-click in a blank 
area, and click Paste.

NOTE If there is no Paste option on the shortcut menu, then the pointer is 
probably positioned over a catalog item, even though the space may appear 
to be blank. Move the pointer and try again.

Copying and Moving Tools

Use this procedure to copy or move tools between tool palettes, tool pack-
ages, or tool catalogs. 

You can also open multiple Content Browser windows and drag items from 
one window to another. For information about using multiple windows to 
copy and move items, see “Working with Multiple Content Browser Win-
dows” on page 204.

1 Open the tool catalog containing the tool to copy or move.

2 Open the item containing the tool to copy or move:

3 Right-click the tool, and select an action:

4 If the destination of the tool is in a different tool catalog, click  to 
return to the catalog library, and then click the tool catalog to open it.

If the tool is in . . . Then . . .

a category of the tool catalog open the category.

a tool palette in the tool catalog open the category for that tool palette, if 
necessary, and then click the tool palette.

a tool package in the tool catalog open the category for that tool package, if 
necessary, and then click the tool package.

If you want to . . . Then . . .

add a copy of the tool in 
another location

click Copy.

move the tool to another 
location, deleting it from its 
original location

click Cut.
196 | Chapter 4 Content Browser



5 Open the destination of the tool:

6 In the right pane of the Content Browser window, right-click in a blank 
area, and click Paste.

NOTE If there is no Paste option on the shortcut menu, then the pointer is 
probably positioned over a catalog item, even though the space may appear 
to be blank. Move the pointer and try again.

Tool File Dependencies
A tool definition may refer to drawing files. For example, a slab tool may refer 
to a style that is defined in a specific drawing file. If the file resides on a 
remote server, or is referenced through a drive letter that is mapped to a 
remote server, the file is copied to the destination catalog when you copy or 
move the tool. If the drawing containing the style is not available at the time 
the tool is copied (for example, if the server is down, or the drawing file is 
referenced by a drive letter that the server is not currently mapped to), the 
following message appears:

If the destination is . . . Then . . .

a category of the tool catalog open the category.

a tool palette in the tool catalog open the category for that tool palette, if 
necessary, and then click the tool palette.

a tool package in the tool catalog open the category for that tool package, if 
necessary, and then click the tool package.
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The error message identifies the file or files that were not available. The tool 
is still copied to the destination folder, but it may no longer behave the same 
as the original tool. To correct this, reestablish the connection to the server 
containing the dependent files, and copy the tool again.

Customizing a Tool

Use this procedure to modify a tool that is stored in a tool catalog.

When you begin this procedure, both the Autodesk Architectural Desktop 
tool palette set and the Content Browser window should be visible, so that 
you can drag items between them.

1 In the Content Browser, open the tool catalog that contains the tool to 
customize. If the tool is located in a specific category of the catalog, open 
that category.

2 Move the pointer over the i-drop icon next to the tool you want, so that 

the pointer image changes to an eyedropper ( ).

3 Click the eyedropper and drag it to a palette in the tool palette set.

If the tool palette does not accept the tool, it might be because the palette 
is set to allow updates only from a linked tool palette in a tool catalog. To 
check this, right-click on the palette, click Properties, and look at the 
Refresh from setting. If Refresh from is selected, the palette is linked to a 
palette in a tool catalog. To break the link, clear Refresh from. For more 
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information about linked tool palettes, see “Using the Items in a Tool Cat-
alog” on page 179.

4 Right-click the copy of the tool in the tool palette set, and click Properties.

5 In the Tool Properties worksheet, clear Refresh from.

If Refresh from is selected, the tool is linked to its source in the tool catalog 
and can be updated only from the source tool.

6 Make any property changes, and then click OK.

7 Drag the tool from the tool palette set back to its original location in the 
Content Browser. 

TIP Right-click the title bar of the Autodesk Content Browser, and select 
Always on Top before dragging the tool to the Content Browser.

8 When prompted to confirm catalog item replacement, click Yes.

Deleting Tool Catalog Items

Use this procedure to delete a tool palette, tool package, or tool in a tool cat-
alog. You must have write access to the tool catalog in order to delete items.

1 Open the tool catalog containing the item to delete. If the item is located 
in a specific category of the catalog, open the category.

2 Right-click the item, and click Delete.

3 When prompted, click Yes to delete the item, or click No to cancel dele-
tion.

Using Tool Catalog Items in Autodesk 
Architectural Desktop

You can use a tool immediately in the drawing area or store it in a palette in 
the tool palette set. You can add a catalog tool palette or tools in a tool pack-
age to the tool palette set.

TIP When working with both the Autodesk Architectural Desktop workspace 
and the Content Browser, you may find it helpful to keep the Content Browser 
window displayed on your screen at all times. To keep the Content Browser win-
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dow in view while other applications are active, right-click the title bar of the 
Autodesk Content Browser, and select Always on Top. 

Linked and Unlinked Tool Catalog Items

When you copy a tool or tool palette from the Content Browser to the tool 
palette set, you can choose whether the copy retains its association with the 
original. Linking the copy to the original means that, if you copy the item 
back to its original location, the Content Browser assumes you are updating 
the original item. This is the default behavior. If you change the original, you 
can update a linked copy using a single mouse click.

An unlinked copy of a tool or tool palette is treated as a new item, with no 
relationship to the original item. If you copy an unlinked item back to its 
original location in a tool catalog, the Content Browser simply adds it to the 
catalog; you end up with two copies of that item with the same name. 

Any time you copy an item from the Stock Tool catalog to the tool palette 
set, the item is treated as unlinked.

You can tell whether an item in the tool palette set is linked by right-clicking 
the item and clicking Properties. If Refresh from is available and lists a source, 
the item is linked. The following illustration shows the properties of a palette 
linked to the Autodesk Architectural Desktop Tutorial Tool catalog:

Refresh from property of a linked palette

You can have linked tool palettes updated automatically each time you start 
Autodesk Architectural Desktop. If you select automatic updating, any 
changes made to the tool palette and its contents in the tool catalog will be 
reflected in the tool palette set when you open the software.
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Related Topics and Procedures

� Using a Tool in the Autodesk Architectural Desktop Workspace

� Copying a Tool Palette to the Autodesk Architectural Desktop Workspace

� Copying a Tool Package to the Autodesk Architectural Desktop Workspace

� Refreshing Linked Tools

� Specifying Refresh Options for Linked Tool Palettes

Using a Tool in the Autodesk Architectural 
Desktop Workspace

Use this procedure to use a tool from a tool catalog in the Autodesk Architec-
tural Desktop workspace. You can also copy tools stored in a tool package to 
a tool palette in the tool palette set.

A tool copied into the tool palette set can be linked or unlinked. A linked 
copy remains connected to the original in the tool catalog, so that you can 
update the copy with any changes made to the original. An unlinked copy is 
treated as a new tool, with no relationship to the original. For more informa-
tion about linked and unlinked tools, see “Using the Items in a Tool Catalog” 
on page 179.

1 Open the tool catalog containing the tool you want to use. If the tool is 
located in a specific category of the catalog, open that category.

2 Move the pointer over the i-drop icon next to the tool, so that the pointer 

image changes to an eyedropper ( ).

To select multiple tools to copy, press and hold CTRL while clicking each 
tool; then position the eyedropper over any of the selected tools. You can 
also select all the tools in the current category by right-clicking and click-
ing Select All.

3 Drag the eyedropper according to the desired action:

If you want to . . . Then . . .

use the tool immediately click the eyedropper and drag it into the drawing 
area.

store a linked copy of the tool 
on a tool palette in the tool 
palette set

click the eyedropper and drag it to a tool palette 
in the tool palette set.
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NOTE If a tool palette does not accept a tool, it might be because the pal-
ette is set to allow updates only from a linked tool palette in a tool catalog. 
To check this, right-click on the palette, click Properties, and look at the 
Refresh from setting. If Refresh from is selected, the palette is linked to a pal-
ette in a tool catalog. To break the link, clear Refresh from.

Copying a Tool Palette to the Autodesk 
Architectural Desktop Workspace

Use this procedure to store a copy of a tool palette in the tool palette set.

You can create a linked or unlinked copy of the tool palette. A linked copy 
remains connected to the original in the tool catalog, so that you can easily 
update the copy with any changes made to the original. An unlinked copy is 
treated as a new tool palette, with no relationship to the original. For more 
information about linked and unlinked tool palettes, see “Using the Items in 
a Tool Catalog” on page 179.

1 Open the tool catalog containing the tool palette to copy to the tool pal-
ette set. If the palette is located in a specific category of the catalog, open 
that category.

2 Move the pointer over the i-drop icon next to the tool palette, so that the 

pointer image changes to an eyedropper ( ).

To copy multiple tool palettes, press and hold CTRL while clicking each 
palette; then position the eyedropper over any of the selected palettes.

3 Drag the eyedropper according to the desired action:

create an unlinked copy of 
the tool on a tool palette in 
the tool palette set

press and hold ALT, then click the eyedropper 
and drag it to a tool palette in the tool palette 
set.

If you want to . . . Then . . .

store a linked copy of the tool 
palette in the tool palette set

click the eyedropper and drag it to a tool palette 
in the tool palette set. 

create an unlinked copy of 
the tool palette in the tool 
palette set

press and hold ALT, then click the eyedropper 
and drag it to a tool palette in the tool palette 
set.

If you want to . . . Then . . .
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Copying a Tool Package to the Autodesk 
Architectural Desktop Workspace

Use this procedure to copy a tool package to a palette in the tool palette set.

You can create linked or unlinked copies of the tools in the package. A linked 
copy remains connected to the original in the tool catalog, so that you can 
easily update the copy with any changes made to the original. An unlinked 
copy is treated as a new tool, with no relationship to the original. For more 
information about linked and unlinked tools, see “Using the Items in a Tool 
Catalog” on page 179.

1 Open the tool catalog containing the tool package to copy into the tool 
palette set. If the package is located in a specific category of the catalog, 
open that category.

2 Move the pointer over the i-drop icon next to the tool package, so that the 

pointer image changes to an eyedropper ( ).

To copy multiple tool packages, press and hold CTRL while clicking each 
package; then position the eyedropper over any of the selected packages.

3 Drag the eyedropper according to the desired action:

Refreshing Linked Tools

Use this procedure to update a linked tool with the contents of its source 
copy in a tool catalog.

� In the tool palette set, right-click the tool you want to refresh, and click 
Refresh Tool.

If Refresh Tool is not listed on the shortcut menu, click Properties, and 
then, in the Tool Properties worksheet, select Refresh from.

If you want to . . . Then . . .

store linked copies of the 
package’s tools in the tool 
palette set

click the eyedropper and drag it to a tool palette 
in the tool palette set.

create unlinked copies of the 
package’s tools in the tool 
palette set

press and hold ALT, then click the eyedropper 
and drag it to a tool palette in the tool palette 
set.
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Refreshing Linked Tool Palettes

Use this procedure to update a linked tool palette with the contents of its 
source copy in a tool catalog.

� In the tool palette set, right-click the tool palette you want to refresh, and 
click Refresh Palette.

If Refresh Palette is not listed on the shortcut menu, click Properties, and 
then, in the Tool Palette Properties worksheet, select Refresh from.

Specifying Refresh Options for Linked Tool 
Palettes

Use this procedure to determine whether a linked tool palette and its tools 
are refreshed automatically from the tool catalog when you start Autodesk 
Architectural Desktop.

1 In the tool palette set, right-click the desired tool palette, and click Prop-
erties.

2 Select an Auto-refresh option:

3 Click OK.

Working with Multiple Content Browser 
Windows

You can open more than one copy of the Content Browser and you can move 
or copy items by dragging them between the windows. You can copy tool pal-
ettes, tool packages, and tools; you cannot copy tool catalogs between Con-
tent Browser windows. Only one catalog library can be open at any time.

If you want . . . Then . . .

the tool palette and all its 
tools to refresh automatically 
when you start Autodesk 
Architectural Desktop

select Enable Auto-refresh.

NOTE Refresh from must also be selected in 
order to enable Auto-refresh.

no automatic refreshing of 
the tool palette

clear Enable Auto-refresh.
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When you drag tool catalog items between Content Browser windows, the 
following rules apply:

� If a different catalog is open in each Content Browser window, dragging 
an item copies it to the new location and leaves the original copy in place.

� If the same catalog is open in both Content Browser windows, dragging 
items from one window to the other moves the item (for example, from 
one category to another), removing the original copy.

If you have the same tool catalog open in multiple windows, and you add an 
item to the catalog, the tool catalog display is updated in all open Content 
Browser windows.

Opening Additional Content Browser Windows
You can open a new instance of the Content Browser by pressing CTRL+N in 
the Content Browser. You can also open a specific tool catalog, tool palette, 
or tool package in a new Content Browser window.

Closing Content Browser Windows
Closing one Content Browser window has no effect on other Content 
Browser windows. You can close all open Content Browser windows at once 
by right-clicking in the title bar of any window and selecting Close All Win-
dows.

Related Topics and Procedures

� Opening a Tool Catalog in a New Content Browser Window

� Opening Catalog Items in a New Content Browser Window

� Dragging Catalog Items Between Content Browser Windows

Opening a Tool Catalog in a New Content 
Browser Window

Use this procedure to open a tool catalog in a new Content Browser window 
or display an open catalog in a new Content Browser window.

� With the catalog library displayed in the right pane of the Content 
Browser window, right-click the catalog to open, and click Open in New 
Window. 

or

� If a tool catalog is already open in the right pane of the Content Browser 
window, right-click in a blank area of the catalog, and click New Window.
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You can open a specific category of the tool catalog in a new Content 
Browser window by opening the category. 

Opening Catalog Items in a New Content 
Browser Window

Use this procedure to open a tool palette or tool package in a new Content 
Browser window.

1 Open the catalog containing the desired tool palette or tool package. If the 
item is located in a specific category of the catalog, open that category.

2 Right-click the tool palette or tool package, and click Open in New Win-
dow.

Dragging Catalog Items Between Content 
Browser Windows

Use this procedure to send tools, tool palettes, or tool packages from one cat-
alog location to another by dragging them between two Content Browser 
windows. Moving an item removes it from its original location, while copy-
ing an item retains the original. 

NOTE You must have write access to the original catalog before you can move 
it.

1 Open two Content Browser windows.

2 In the first Content Browser window, display the catalog item that you 
want to move or copy.

3 In the second Content Browser window, open the catalog, category, tool 
palette, or tool package to send the item to (only tools can be sent to pal-
ettes and packages).
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4 In the first Content Browser window, move the pointer over the i-drop 
icon associated with the item to be moved, so that the pointer image 

changes to an eyedropper ( ).

If you want to . . . Then . . .

move an item from one location 
to another within the same 
catalog

right-click  and drag the item to its 
destination catalog or category in the second 
Content Browser window, and click Copy 
Here.

copy an item from one location 
to another in the same catalog press CTRL; then click  and drag the item to 

its destination catalog or category in the 
second Content Browser window.

move an item to a different 
catalog press CTRL; then click  and drag the item to 

its destination catalog or category in the 
second Content Browser window.

copy an item to a different 
catalog click  and drag the item to its destination 

catalog or category in the second Content 
Browser window.

move a tool to a tool palette or 
tool package in the same catalog click  and drag the item to its destination 

palette or package in the second Content 
Browser window.

copy a tool to a tool palette or 
tool package in the same catalog press CTRL; then click  and drag the item to 

its destination palette or package in the 
second Content Browser window.

move a tool to a tool palette or 
tool package in a different 
catalog

press CTRL; then click  and drag the item to 
its destination palette or package in the 
second Content Browser window.

copy a tool to a tool palette or 
tool package in a different 
catalog

click  and drag the item to its destination 
palette or package in the second Content 
Browser window.
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Starting the Content Browser from a 
Windows Command Prompt

Use this procedure to open the Content Browser from a Windows command 
prompt, even if Autodesk Architectural Desktop is not currently open. 

1 From the Windows Start menu, click Command Prompt.

The location of the Command Prompt application varies from one version 
of Windows to another. It is most likely to be found either in Programs or 
on the Accessories menu within Programs.

2 At the command prompt, specify the Autodesk Architectural Desktop pro-
gram folder as the current directory.

3 Enter the command aeccb, followed optionally by the path to the tool cat-
alog you want the Content Browser to open. For example:

aeccb "c:\my documents\my aec content browser library\mystuff\mystuff.atc”
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Drawing Management

The Drawing Management feature formalizes and auto-

mates the processes relating to building model design 

and documentation. The feature provides automated 

tools that aid you in the management, viewing, and 

construction of your building information model and 

documents.

Because your project files are being managed with this 

feature, you can have consistency throughout all 

aspects of the project. Everyone on your design team 

has a centralized project environment for accessing the 

most current documents, from project templates to sec-

tions and elevations. 

The Drawing Management feature enables you to create 

and manage projects, create and manage levels, and 

automate sheet creation.

Related Topics

� Concepts of Drawing Management

� Before You Begin: External References within 
a Project

In this Chapter

� Concepts of Drawing 
Management

� Process Overview

� The Project Browser

� The Project Navigator

� Levels

� Divisions

� Categories

� Constructs

� Elements

� Views

� Plotting Sheets

� Updating (Re-Pathing) the 
Project

� Refreshing the Project View

� Object Display in External 
References

� Annotating a Building Project

� Working with Cut Planes in a 
Project

� Running Drawing Management 
from the Command Line

� Frequently Asked Questions

5
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� Before You Begin: Working in a Network Environment

� Process Overview: Working in a Project Environment

� The Project Browser

� The Project Navigator

� Levels

� Divisions

� Categories

� Constructs

� Elements

� Views

� Plotting Sheets

� Updating (Re-Pathing) the Project

� Refreshing the Project View

� Object Display in External References

� Annotating a Building Project

� Working with Cut Planes in a Project

� Running Drawing Management from the Command Line

� Frequently Asked Questions about Drawing Management
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Concepts of Drawing Management

The Drawing Management feature of Autodesk® Architectural Desktop lets 
you create large building projects distributed among many drawing files, lev-
els, and divisions (wings). The key concepts of the feature are described here.

3D view of building project

Project
At the highest level, building information models are organized into 
projects. A project is composed of two parts: the building information model 
and the reports generated from the model. The building information model 
is composed of constructs and elements, while reports consist of views and 
plotting sheets. Within a project, elements are referenced into constructs, 
constructs are referenced into views, and views are referenced into plotting 
sheets.

For more information on projects, see “The Project Browser” on page 223.
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External Reference Management
The basis of the Drawing Management feature is a sophisticated external ref-
erence mechanism that has been enhanced from its standard functionality. 
Powerful linking features ensure that your source files can be distributed over 
many different locations on your computer or on a network. You can assign 
schedule tables, annotation tags, and dimensions to external references eas-
ily. Different people can work simultaneously on the same project without 
time delays. 

For more information on external references, see “Reference Other Drawing 
Files (Xrefs)” in the AutoCAD 2004 Online User Guide. 

For more information on annotating external references in a project, see 
“Annotating a Building Project” on page 341.

XML Structure
A project has an underlying XML structure. For each drawing file you create 
within a project—for example a floor drawing or a structural drawing—an 
accompanying XML file is created. The XML file contains project-relevant 
information, such as level and division information. You can reuse any draw-
ing file created within a project outside the project as well, because the draw-
ing file itself does not contain project-relevant information. 

Constructs
A construct describes one unique portion of a building project and is 
assigned to a specific level and division within the project. Spanning con-
structs, like curtain walls, can be assigned to multiple levels and divisions. 
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Plan view of curtain wall spanning construct

For example, the first level of your building project may consist of an exterior 
shell construct, a first-level core construct, and a first-level interior partitions 
construct. 

A construct can contain drawing objects, like walls and doors, external refer-
ences to elements, or a combination of both. For example, a first-level core 
construct can contain the core walls directly drawn into the construct and an 
elevator element inserted as an external reference. 

Constructs are referenced into views.

You can create and modify constructs within the current project. You can 
also import drawings and then convert them and add them to constructs. 
You can import constructs into the project physically or by creating a link. 

For more information, see “Constructs” on page 268.

Elements
Elements are used for pieces of the building that are repeated multiple times 
within the building. For example, you could use an element to create a 
repeating design object like a desk/chair combination to be used for a num-
ber of cubicles in an office building. 
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3D view of cubicle element

An element is a generic building block for multiple use. The element knows 
nothing about which level or division it is placed on; that is determined by 
the construct it is referenced into. If you create a bathroom layout as an ele-
ment, you can use it on the second floor of the west wing just as well as on 
the first floor of the east wing. To place the element on a specific floor and 
wing, you need to reference it into a construct. A construct has a level and 
division assignment. For example, you could create an element named 
“Generic Bathroom Layout” and reference it into constructs named “First 
Floor—Left Apartment,” “First Floor—Middle Apartment,” First Floor—Right 
Apartment,” and so on. 

Because the enhanced Schedule feature allows you to annotate instances of 
an external reference individually, you can use the same element and anno-
tate it differently depending on its position.

You cannot automatically reference an element into a view, but you can ref-
erence an element directly into a plotting sheet. This might be done for title 
blocks or the documentation of a detail on the plotting sheet.

For more information, see “Elements” on page 290.

Views
Once the structure of the building information model is defined and con-
structs are assigned to levels and divisions, you can begin creating reports of 
the data. A view automatically references a number of constructs to present 
a specific view of the building project. To create a view you first decide what 
portion of the building you wish to look at and the type of view to generate. 
You could, for example, create a first-floor reflected ceiling plan or a second-
floor framing plan. You could also create a composite view of all floors in the 
building. Views automatically reference the appropriate constructs according 
to their location within the building. For example, to create a floor plan of 
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the west wing of the second floor, you would create a view that references all 
constructs assigned to the second floor and the west wing. This would also 
include a curtain wall spanning the first through fifth floors. You can refer-
ence additional constructs that do not lie on that floor but which you want 
to see in the view, such as a building outline or grid. 

3D view of entire building view

In the view you can also add project-wide data like annotation, dimensions, 
and schedule tables. Whether to create the annotation in the view or in a 
plotting sheet is a decision you make based on your workflow and individual 
needs. New functionality has been added to the Schedule feature for gener-
ating annotation data in a view and a plotting sheet.

For more information, see “Views” on page 307.

Plotting Sheets
Plotting sheets are used to plot plans of your building project. The plotting 
sheet references views. When a view is dragged onto a layout in a sheet, it is 
referenced into model space. A viewport is created on the layout large 
enough to fit the view at the zoom specified by the view. The viewport is 
zoomed to match the scale specified by the view and has the display config-
uration assigned as specified by the view. The viewport may also have a layer 
snapshot applied as specified by the view. 
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Plotting sheet with building plan view

In the plotting sheet, you can add annotation like tags, dimensions, and 
schedule tables. Whether to create the annotation in the view or in a plotting 
sheet is a decision you make based on your workflow and individual needs. 
New functionality has been added to the Schedule feature for generating 
annotation data in a view and a plotting sheet.

For more information, see “Plotting Sheets” on page 324.

Levels and Divisions
The building information model provides a framework of levels and divisions 
(also called wings). By default, a new project consists of one level and one 
division. You can add levels and divisions throughout the lifetime of a 
project. The matrix of levels and divisions act as labels to help uniquely iden-
tify the building information model. For example, you could have a con-
struct in your building named “First Floor—West Wing.” 
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Levels and divisions schematic

Building objects can span multiple levels and divisions. You can use a span-
ning construct for curtain walls, elevator shafts, and similar building ele-
ments.

For more information, see “Levels” on page 250, and “Divisions” on 
page 257. 

Categories
To help organize the building information model, the parts of the building 
project—elements, constructs, views, and sheets—can be categorized. You 
can use categories like shell, core, and interior partitions. You can also use 
design-phase categories like conceptual design, building design, and docu-
mentation. Categorizing a construct also acts as a label for the construct that 
can be used when generating views. 
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Construct categories in the Project Navigator

For more information, see “Categories” on page 260.

Cut Planes
When working on a complex building, you need optimal control over the cut 
plane settings. The Drawing Management feature provides the ability to 
define a global cut plane that is applied to a building level. You can define 
visible ranges above and below the cut plane offering flexibility when creat-
ing plans. In addition, objects such as walls, curtain walls, and slabs can use 
an individual cut plane set in the object or the object style. 
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3D view of curtain showing global and manual cut planes at each level

For more information, see “Working with Cut Planes in a Project” on 
page 362.

Converting Legacy Drawings to Project Drawings
You may have a set of drawing files that you want to convert into a project. 
You have the option to save any existing DWG file as an element, a construct, 
a view, or a sheet. Furthermore, you can use an existing folder structure as a 
categorization scheme by dragging and dropping entire folders with subfold-
ers into the Project Navigator. 

For more information, see “Converting a Legacy Drawing to an Element” on 
page 296, and “Converting a Legacy Drawing to a Construct” on page 276.

NOTE Views and plotting sheets are not well suited for conversion from 
legacy drawings. Because they contain project-specific settings that are not 
present in regular drawing files, it is easier to create views and plotting sheets 
from scratch. 
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Before You Begin: External References within 
a Project

The Drawing Management feature uses external references as a means to cre-
ate a project and maintain it. Elements are referenced into constructs, con-
structs are referenced into views, and views are referenced into plotting 
sheets. The mechanism of referencing is identical to the regular AutoCAD 
External References Management. However, the background methods 
employed have additional features.

Whenever you define a project drawing, an accompanying XML file is cre-
ated. That XML file contains information about level and division assign-
ments and viewport and content information appropriate for the type of 
drawing. This XML file is vital for the project. Under no circumstances 
should you delete it (unless you are deleting the entire project). 

The Project Navigator has a number of commands for referencing project 
files—like elements, constructs, and views—into other project files. 

If you are working in a project environment, use the Project Navigator com-
mands to reference project drawings into other project drawings. Do not use 
the standard AutoCAD Xref Manager to reference project drawing files into 
other project drawing files. The AutoCAD Xref Manager cannot differentiate 
between project drawings (with an accompanying XML file) and non-project 
drawings (plain DWG files). If you reference a non-project file into a project 
file by mistake, you cannot use the full set of Drawing Management func-
tionality on that file. For example, a drawing file referenced into a project file 
via the AutoCAD Xref Manager is not assigned a project category and does 
not display in the Project Navigator tree.

Keep these considerations in mind when working with a project:

� Do not delete any XML files the Drawing Management feature generates. 
They are vital for the project.

� Use the commands of the Project Navigator to create, modify and refer-
ence project files within the project. If you want to use existing non-
project files in a project, convert them to project files first. For more infor-
mation, see “Converting a Legacy Drawing to an Element” on page 296 
and “Converting a Legacy Drawing to a Construct” on page 276.
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Before You Begin: Working in a Network 
Environment

When you are working on a large project, the project will often be hosted on 
a network server and be accessed by multiple users simultaneously. There are 
two points to note to create a seamless workflow:

� Access restrictions on the network server: 

You can limit other users’ ability to edit and delete project files by using 
the network permissions. You can limit the Delete rights for the entire 
project, so that users cannot delete files from the project or move files 
around within the project. You might also consider just limiting the delete 
rights to the top project folder (containing the APJ file) and allow deleting 
in the subfolders.

� Keeping the project tree current: 

When multiple users are working on the same project simultaneously, the 
situation can occur that one user’s view of the project gets out of sync with 
the changes of another user. 

For example, you might have one user who is adding/moving/deleting 
constructs in a project. At the same time, another user is annotating some 
plotting sheets. The user that is working on the plotting sheets is not auto-
matically notified that his coworker has removed some constructs from 
the project. So if he tries to open a removed construct from his Project 
Navigator, he will get an error message. 

To prevent this situation, it is necessary to frequently refresh the project 
view. When you refresh the project view, all items are updated to reflect 
the current project status. 

For more information, see “Refreshing the Project View” on page 334.

Process Overview: Working in a Project 
Environment

Working in a project environment is a new way of working within Autodesk® 
Architectural Desktop. In previous releases you worked on individual draw-
ings, which contained architectural objects, annotation, and plot informa-
tion. Now you can choose to work within a project environment, where 
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drawing files are interlinked and connected by a project file. You select 
numerous settings for the project, such as template locations, folder catego-
ries, and building data like levels and divisions. A drawing created within a 
project environment is edited and saved within the project structure. You can 
create specific views of your building constructs, and define tailor-made plot 
sheets for views. You can define categories such as Architectural, Structural, 
or HVAC into which your constructs are saved. 

The Drawing Management feature has two main components—the Project 
Browser and the Project Navigator. In the Project Browser, you define the cur-
rent project, create new projects, and set high-level project information such 
as default templates, file prefixes, and user-defined additional information 
like contact, financial, or legal details. In the Project Navigator, you perform 
all project-specific tasks, like creating project drawings or plotting sheets and 
setting levels and divisions.

The following basic steps lead you from start to finish through your project:

Step 1: Open the Project Browser.

Step 2: Create a new project or select an existing project, and define it as the 
current project environment. 

For information on creating new projects, see “Creating a New Project” on 
page 229.

For information on selecting a project environment, see “Selecting the 
Current Project” on page 229.

Step 3: If necessary, change the high-level project data, such as default tem-
plate locations or contact, financial, or legal information. 

For more information, see “Changing the Project Properties” on page 235 
and “Adding Project Details” on page 231.

Step 4: Close the Project Browser. 

For more information, see “Closing the Project Browser” on page 238.

Step 5: Open the Project Navigator, if it is not already open.
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Step 6: Define levels and divisions for the project selected in step 2. 

For more information, see “Levels” on page 250 and “Divisions” on 
page 257.

Step 7: Create the elements and constructs of your building project. 

For more information, see “Elements” on page 290 and “Constructs” on 
page 268.

Step 8: Create views of your building project: for example, a first-floor view 
or a structural view. 

For more information, see “Views” on page 307.

Step 9: Create plotting sheets for the building project, including property set 
data, annotation tags, and dimensions. 

For more information, see “Plotting Sheets” on page 324 and “Annotating 
a Building Project” on page 341. 

The Project Browser

In the Project Browser, you perform high-level project-related tasks, such as 
creating a new project, selecting the current project, and setting default tem-
plates for elements, constructs, views, and sheets.

Related Topics

� Setting the Project Browser to Display at Startup

� Using the Project Browser

� The Project Structure

� Selecting the Current Project

� Creating a New Project

� Adding Project Details

� Creating a New Project with the Structure of an Existing Project

� Copying a Project

� Opening a Drawing File from the Project Browser

� Changing the Project Properties

� Moving a Project

� Renaming a Project

� Closing a Project

� Closing the Project Browser
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� Deleting a Project

� Removing the Project Context

Setting the Project Browser to Display at Startup

By default, the Project Browser does not appear directly at startup. If you 

want to start the Project Browser each time you start Autodesk® Architectural 
Desktop, you can set this in the options. 

NOTE The Project Browser displays after the AutoCAD startup dialog box.

1 On the Format menu, click Options. 

2 Click the AEC Project Defaults tab.

3 Select Show Project Browser at Startup. 

4 Click OK. 

Using the Project Browser

In the Project Browser, you create new projects, assign high-level project 
information, and select the current project. 
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Project Browser

On the left side of the Project Browser, you select the current project, create 
new projects, browse existing projects, edit project details, close a project, 
and refresh the project after making changes. All information you enter here 
pertains to the project as a whole. On the right side of the Project Browser, 
an embedded Internet Explorer allows you to browse your project home 
page. 

NOTE The projects you create in the Project Browser will appear as files and 
folders in Internet Explorer. As a general rule you should not, however, perform 
any file operations on a project file there, except in those cases where a proce-
dure explicitly states that you should. Changes in Internet Explorer will not 
always be updated correctly in the Project Browser, so that you might get an 
inconsistent view of your project data. Any changes you make to the project 
within the Project Browser are managed and coordinated by Autodesk Architec-
tural Desktop. Changes made outside of the software might not be correctly 
updated and processed. 

Related Topics

� The Project Header

� The Project Navigation Bar
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� The Project Selector

� The Embedded Internet Explorer View

The Project Header
The currently selected project is displayed in the upper-left area of the Project 
Browser. The header contains the project name, project number, a user-
selected bitmap representing the project, and an optional short project 
description. You enter this information when you create a new project or edit 
an existing one.

The Project Navigation Bar
Below the project header, toolbar buttons help you to navigate in your folder 
structure. 

The Project Selector
The project selector on the left side of the Project Browser displays the 
projects you have created in Architectural Desktop. You have several options 
for displaying projects:

Button Description

Returns you to the previously displayed folder.

Displays the folder structure one level above the currently 
displayed folder.

Takes you to the Project File Navigator, where you can browse 
for project (APJ) files

Displays the projects in the folder selected in the list below. 
For detailed information, see “The Project Selector” on 
page 226.

Displays a historic list of projects sorted by various criteria. For 
detailed information, see “The Project Selector” on page 226.
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The Embedded Internet Explorer View
When you create a new project, you can connect it to an HTML page. You 
might do this, for example, to provide a link to your company’s home page 
or a project web site. The HTML page is displayed in the right window of the 
Project Browser. At the bottom of the page, there is a standard Internet 

View Option Description

By Folder
When you click  in the Navigation bar, the list below 
displays the folder structure of your computer. The 
contents of the currently selected folder are displayed in 
the project selector. Project files are displayed with the 

project icon .

By History

When you click  in the Navigation bar, the list below 
presents display options: 
� If you select Most Recently Used, the last eight projects 

you have made current are displayed in descending 
order in the project selector.

� If you select By Date, a list of project dates is displayed, 
sorted by current day, current week, and previous 
weeks.

� If you select By Project, a list of project names is 
displayed, sorted alphabetically.

� If you select By Location, a list of folders containing 
project files is displayed, in alphabetical order. If you 
double-click a folder, the projects contained in it are 
displayed.
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Explorer navigation bar with buttons for Back, Forward, Stop, Refresh and 
Project Home. 

The Project Structure

When you are creating a new project, Autodesk® Architectural Desktop auto-
matically creates a project environment to connect the individual files into 
one project. 

Related Topics

� The Project (APJ) File

� The Default Category Structure

The Project (APJ) File 
The project (APJ) file is the highest level of the project. It contains general 
information like project name, number, level and division information, 
default templates for new elements, constructs, views, and sheets. The 
project file also contains a user-configurable detail sheet in which you can 
put additional information, such as contractor information or legal details. 
You typically set up the project file once during the lifetime of the project, 
changing only details about it when necessary.

NOTE The APJ file is a well-formed XML document. If you open it in an XML 
editor, you can change it there. 

The Default Category Structure
The categories within a project are represented by file folders. 

When you create a new project, the following default category structure is 
created:

� <MyProjectName>: The top category uses the name you have given your 
project.

� Constructs: The default category for constructs in the project. 
� Elements: The default category for elements in the project. 
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� Views: The default category for views in the project. 
� Sheets: The default category for plotting sheets in the project. 

When you create a new project, these categories are empty.

These top four categories cannot be changed. You can however create subcat-
egories in each of these basic categories. Categories are very useful within a 

project. For more information, see “Categories” on page 260.

Selecting the Current Project

Use this procedure to select the current project.

If you want to work on a project, you must first define the current project. 
Only one project per session can be current and all project operations you 
perform, such as adding elements and constructs or changing levels and divi-
sions, are done within the current project. 

When you select a project as the current one, its project header and default 
HTML bulletin board are displayed in the Project Browser. 

NOTE If your Project Browser does not yet contain any projects, see “Creating 
a New Project” on page 229.

1 On the File menu, click Project Browser.

2 In the project selector, select a project. 

Projects are displayed with a project icon .

3 Right-click, and click Set Project Current.

NOTE Alternatively, you can double-click the project.

The selected project is loaded in Autodesk® Architectural Desktop, and you 
can work with it until you close it or select another one. 

Creating a New Project

Use this procedure to create a new project. 

1 On the File menu, click Project Browser.

2 In the project selector, locate the folder in which you want to place the 
new project. 

3 Create a new project in one of these ways: 
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� Right-click in the project selector, and click Add ➤ Project. 

� In the toolbar below the project selector, click .

4 Define the settings for the new project: 

Setting Description

Number Each project needs a unique identification number. You 
can use numerals, alphabetic characters, or a 
combination, such as 100A.

The project number appears in the project header. 

NOTE The number you assign here can be used as a 
prefix for all drawings you create in the project. 

NOTE You can also use the number as a property for a 
title block. For more information, see “Creating a Title 
Block for a Project” on page 356.

Name Enter the project name here. This appears in the project 
header. 

NOTE You can also use the name as an automatic 
property for a title block. For more information, see 
“Creating a Title Block for a Project” on page 356.

Description This field is optional. The description you enter here 
should be brief; it appears in the project header. Click the 
setting for Description, enter a short description of the 
project, and click OK. Note that this is not usually the 
place where you enter details about the project—you have 
a separate worksheet to do this. For information about 
adding detailed information on the project, see “Adding 
Project Details” on page 231.

Bulletin Board You can connect a project in the Project Browser with an 
HTML file, pointing to your company home page or a 
project web site. Click the setting for Bulletin Board, and 

click . Then, select the HTML page to appear in the 
Project Browser, and click Open. The page selected is 
displayed in the right side of the Project Browser in an 
embedded Internet Explorer. 
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5 When you are finished with the project settings, click OK. 

Adding Project Details

Use this procedure to add detailed information about the project.

Project Image You can select a BMP image for the project header. Click 

the setting for Project Image, and click . Then, select 
the bitmap file to appear in the project header, and click 
Open. 

TIP Due to the relatively small size of the header (64x64 
pixels), a simple image with clear contrasts creates the 
best effect. 

Prefix Filenames 
with Project 
Number

When you select Prefix Filenames with Project Number, 
drawing files created within this project have the project 
number prefixed to their file names. You could create file 
names like “100A-First Floor” or “100A-Structural.” If you 
select No, no prefix is added to drawing files created 
within this project. 

NOTE Omitting a prefix has no influence on whether 
drawing files are assigned to the project. Every drawing 
file you create and save within a project is connected to 
that project, regardless of prefixes. 

TIP When you add or change the prefix setting in an 
existing project, only the new files created within the 
project reflect the prefix change. Existing files still have the 
old prefix settings. 

Default Sheet/View/
Construct/Element 
Template

Click the setting for the appropriate template, and click 

.Then, select a drawing template, and click OK. 
The template you set here is used by default for all new 
drawing files of the selected type. For example, if you set 
the Architectural Sheet (Imperial - stb).dwt as the default 
sheet template, all new plotting sheets are created with 
that template. 

NOTE Autodesk® Architectural Desktop is shipped with 
default templates for sheets, elements, constructs, and 
views. 

The default location for drawing templates is at 
\\Documents and Settings\All Users\Local 
Settings\Application Data\Autodesk\Architectural Desktop 
2004\R16.0\enu\Template. 

Setting Description
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Detailed information might include contact information about contractors, 
legal representatives, or others. You can also track changes and improve-
ments to the project here. 

 You can create detail categories and detail items. A detail category could be 
“Financial Data.” A possible detail item in it could be “Loan Amount” or 
“Grant Amount.” The structure of the details worksheet lets you create an 
information model that meets your needs.

You can use project details later to create schedule tables of your project or 
title blocks for plotting sheets. For more information, see “Annotating a 
Building Project” on page 341.

NOTE The information you enter here is saved in the APJ file in XML format. 
You can open the APJ file in an XML editor in order to edit the detail information. 
For more information, see “The Project (APJ) File” on page 228. 

1 On the File menu, click Project Browser.

2 Create a new project or select an existing project, right-click, and click 
Project Properties.

3 Click . 

By default, a list of proposed details and categories has already been set up. 
The details themselves have not yet been filled in. You can use those cat-
egories or delete them and create different ones. 

4 Design your project information model: 

If you want to . . . Then . . .

add content to a detail 
item

enter the content in the right column of the 
appropriate detail row. 

add a detail category
click . Then, enter a name for the new detail 
category, and click OK.

add a detail item within 
a detail category select the category, and click . Then, enter a 

name for the new detail, and press ENTER. 

remove a detail item

select the detail item, and click . 
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5 Click OK twice to finish editing the detail information of your project and 
to return to the Project Browser.

Creating a New Project with the Structure of an 
Existing Project

Use this procedure to create a new project with the structure of an existing 
project.

Creating a new project based on an existing project saves a lot of time 
because many settings are already defined. Settings copied to the new project 
include the following: 

� Project number (appended with a numeral)
� Project name (appended with a numeral)
� Project prefix
� Project location
� Default element, construct, view, and sheet template path locations
� HTML bulletin board
� Project image
� Project details
� Project structure (categories)
� Levels and divisions

NOTE The files contained in the source project are not copied to the new 
project. 

1 On the File menu, click Project Browser.

2 In the project selector, locate the folder in which the project you want to 
copy is located. 

3 Select the project you want to copy, right-click, and click Copy Project 
Structure.

remove a detail 
category

first delete all detail items in the detail category; then 

select the category, and click .

If you want to . . . Then . . .
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4 Define the settings for the new project:

5 When you are finished with the project settings, click OK. 

Copying a Project

Use this procedure to copy a project with all of its files.

To copy a project and its files, use Internet Explorer. To rename it correctly, 
use the Project Browser.

NOTE It is recommended that you close Autodesk® Architectural Desktop 
before copying a project.

1 In Internet Explorer, navigate to the folder of the project you want to 
copy. 

Setting Description

Number Each project needs a unique identification number. You 
can use numerals, alphabetic characters, or a 
combination, such as 100A.

The project number appears in the project header. 

NOTE The number you assign here can be used as a 
prefix for all drawings you create in the project. 

NOTE You can also use the number as a property for a 
title block. For more information, see “Creating a Title 
Block for a Project” on page 356.

Name Enter the project name here. This appears in the project 
header. 

Description This field is optional. The description you enter here 
should be brief; it appears in the project header. Click the 
setting for Description, enter a short description of the 
project, and click OK. Note that this is not usually the 
place where you enter details about the project—you have 
a separate worksheet to do this. For information on 
adding detailed information on the project, see “Adding 
Project Details” on page 231.

Copy To... Select a folder in which you want to save the copied 

project. Click the setting for Copy To, and click . 
Then, browse to the desired folder location.
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2 Copy the folder, and paste it to the desired folder location. 

3 Open Autodesk Architectural Desktop.

4 On the File menu, click Project Browser.

5 In the project selector, navigate to the folder to which you have copied the 
project folder. 

The copied project is listed in the new location, but still with its old name. 

6 Select the project, right-click, and click Rename Project.

7 Enter the new name, and click OK. 

Opening a Drawing File from the Project Browser

Use this procedure to open a drawing file from the Project Browser.

NOTE Usually, you open project drawing files from the Project Navigator. For 
information, see “The Tabs of the Project Navigator” on page 241.

1 On the File menu, click Project Browser.

2 Click .

3 Browse your hard disk or a server volume for the DWG file that you want 
to work on.

4 Click Open.

The selected project is opened in the drawing area. You are able to work 
on it after you have closed the Project Browser. 

Changing the Project Properties

Use this procedure to change the default templates, the bulletin board, or the 
project details of an existing project.

1 On the File menu, click Project Browser.

2 In the project selector, select the project for which to change the proper-
ties, right-click, and click Project Properties.

3 Change the properties as needed. For detailed information about project 
properties, see “Creating a New Project” on page 229, and “Adding Project 
Details” on page 231.

4 Click OK to finish editing the project properties, and return to the Project 
Browser.
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Moving a Project

Use this procedure to move a project with all its associated files to a different 
file location. 

When you move a project, all internal paths between the project files are 
automatically updated, so that all relationships between drawings are kept 
current.

To move a project to a different file location, it must be closed. For more 
information, see “Closing a Project” on page 237.

NOTE Do not move a project file to a different file location with the Internet 
Explorer. This might result in inconsistent project data.

1 On the File menu, click Project Browser.

2 Select the project you want to move, right-click, and click Move Project. 

3 Select the location into which you want to move the project. 

4 Click OK. 

The project and all its files and folders are moved to the new location. 

Renaming a Project

Use this procedure to rename an existing project.

Renaming a project performs the following changes on the project files:

� Renames the project in Project Browser
� Renames the APJ file
� Renames the top project folder

When you rename a project, all internal paths between the project files are 
automatically updated, so that all relationships between drawings are kept 
current.

Renaming a project renames both the APJ file and the project folder. 

To rename a project, it must be closed. For more information, see “Closing a 
Project” on page 237.

NOTE Do not rename the project file in the Internet Explorer. This might result 
in inconsistent project data.



The Project Browser | 237

1 On the File menu, click Project Browser.

2 In the project selector, select the project you want to rename, right-click, 
and click Rename Project. 

3 Enter the new name, and click OK.

Closing a Project

Use this procedure to close a project. 

If you do not want to work in a project environment in Autodesk® Architec-
tural Desktop, you have the option of closing the current project, so that the 
program is in a non-project related state. You could do this if you are working 
on non-project drawing files, and do not want to accidentally make changes 
to a project. 

To work with a project again, you need to set a project current, as described 
in “Selecting the Current Project” on page 229.

1 Open the Project Browser. 

2 In the project selector, locate the currently active project.

NOTE The currently active project is listed in the project header. 

3 Select the project, right-click, and click Close Current Project. 

Deleting a Project

Use this procedure to delete a project. 

Deleting a project is a system administrator task. Therefore, you do not per-
form it from within the Project Browser but from Internet Explorer. 

Deleting the project folder deletes all DWG files, XML files, and the APJ file. 
Before you do this, make sure that you really do not need any of these files 
anymore. If you do not work on a project any longer but still want to save 
the DWG files in it, it is often sufficient to just remove the project context, 
as described in “Removing the Project Context” on page 238.

NOTE Before you delete a project, make sure that is not the current project in 
Autodesk Architectural Desktop. 

1 In Internet Explorer, navigate to the folder of the project you want to 
delete. 
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2 Delete the project there. 

Closing the Project Browser

Closing the Project Browser leads you to the next phase, where you are work-
ing on the actual building project, as represented by elements, constructs, 
building views, and plotting sheets. In this phase, you work mainly with the 
Project Navigator. For more information, see “The Project Navigator” on 
page 239.

Close the Project Browser with one of these buttons:

Removing the Project Context

Use this procedure to remove all project-related information from the draw-
ing files of a project. You could call this “exploding” a project.

NOTE You remove the project-specific information in Internet Explorer. 

In some cases, you need to revert project-related files to plain drawing files. 
You could do that if you wanted to hand over the files to a contractor who 

does not work with the latest version of Autodesk® Architectural Desktop, or 
if the project does not exist any longer but you do not want to delete the 
drawing files. 

Much of the project-related information of a drawing file does not reside in 
the drawing file itself, but in the accompanying, automatically created XML 
file of the drawing. This means that you can use all of your project files at any 
time in a non-project related drawing context. However, if you want to per-
manently work without the project context, it is recommended that you 
clean your file set of the unused project files. 

All of the project related information resides in the following files:

Button Description

Click the Autodesk® Architectural Desktop button in 
the dialog box header, right-click, and click Close.

Click the Close button in the lower-right corner of 
the Project Browser.

Click the Windows Close button in the upper-right 
corner of the Project Browser. 
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� The APJ file: contains the general, high-level project data, like name, num-
ber, and project details.

� The accompanying XML files of the drawing files: stores the project infor-
mation of the individual drawing files. 

If you delete these files, the remaining drawing files have no connections to 
a project anymore. They are regular Autodesk Architectural Desktop drawing 
files and can be copied, edited, and deleted like any other drawing file.

1 In Internet Explorer, navigate to the folder containing the project.

2 In the project folder, delete the APJ file. For example, if you have a project 
named “Office Building,” delete the “Office Building.apj” file.

3 Open the Elements, Constructs, Sheets, and Views folders, and delete the 
accompanying XML files of your drawing files. 

For example, if you have a drawing named “First Floor Construct.dwg” in 
your Constructs folder, select the accompanying “First Floor Con-
struct.xml” file, and delete it. 

4 Repeat step 3 for each drawing file.

5 If necessary, organize the remaining drawing files in a different folder 
structure. 

NOTE If you reorganize files into a difference file structure you will have to 
manually reset each of the drawings external reference paths, if they have 
them. 

The Project Navigator

Once you have selected a project in the Project Browser, you open the Project 
Navigator to create the actual building and documentation data. Here you 
create elements, constructs, views, sheets, and connect them with one 
another.

NOTE The project files and categories you create in the Project Navigator will 
appear as files and folders in the Internet Explorer. You should not, however, per-
form any file operations on a project file there. Do not move, copy, delete, or 
rename project files from Internet Explorer. These changes will not be updated 
in the Project Navigator, so that you might get an inconsistent view of your 
project data. Any changes you make to the project within the Project Navigator 
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are managed and coordinated by Autodesk Architectural Desktop. Changes 
made outside of the software might not be correctly updated and processed. 

NOTE When you have made changes to a project file in the Project Navigator, 
such as renaming, deleting, or changing the properties of a project file, you can-
not undo these changes by using the AutoCAD Undo commands. 

Related Topics

� Opening the Project Navigator

� Working in the Project Navigator without an Open Drawing

� The Tabs of the Project Navigator

� Using the Project Navigator

� The Project Status Bar

Opening the Project Navigator

Use this procedure to open the Project Navigator. 

NOTE You can open the Project Navigator only when a drawing file is open in 

Autodesk® Architectural Desktop. 

1 On the Window menu, click Project Navigator Palette.

2 Click the tab you want to display.

Working in the Project Navigator without an 
Open Drawing

When you start Autodesk® Architectural Desktop, a new drawing is automat-
ically opened. When a drawing is open, you can access the Autodesk Archi-
tectural Desktop commands for opening the Project Browser and opening 
the Project Navigator. If you close all open drawings, you cannot open the 
Project Browser and the Project Navigator.

However, if the Project Navigator is open while you close all open drawings, 
it remains open and works in a reduced way.

WARNING! When you perform changes in the Project Navigator that require 
re-pathing files in the project, such as renaming a file or moving it to a different 
location, the re-pathing process is not initiated upon exiting the application. All 
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changes to the project are lost. For information on re-pathing files, see “Updat-
ing (Re-Pathing) the Project” on page 333.

In a program state with no open drawings you can do the following:

� Open existing project drawings
� Create categories in the Project Navigator tabs

It is strongly recommended that you always have a drawing file open when 
working in the Project Navigator. 

The Tabs of the Project Navigator

The Project Navigator has four tabs on which you can enter project data. The 
tabs correspond to the main phases of project creation: general project infor-
mation (levels and divisions), creating building data (elements and con-
structs), and creating building documentation (views and sheets). 

Related Topics

� The Project Tab

� The Constructs Tab

� The Views Tab

� The Sheets Tab

The Project Tab
In the Project tab, you enter information pertaining to the entire project. 
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In the Project tab, you can perform the following actions: 

� Adding, modifying, and deleting levels. For more information, see “Lev-
els” on page 250.

� Adding, modifying, and deleting divisions. For more information, see 
“Divisions” on page 257.

� Changing project information.
� Launching the Project Browser.

The Constructs Tab
In the Constructs tab, you add the basic building data for your project. 
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In the Constructs tab, you can perform the following actions:

� Adding, modifying, and deleting elements and constructs within the 
project. For more information, see “Elements” on page 290 and “Con-
structs” on page 268.

� Opening existing element and construct drawings. For more information, 
see “Opening and Closing an Element” on page 299 and “Opening and 
Closing a Construct” on page 279.

� Creating categories for elements and constructs. For more information, 
see “Categories” on page 260. 

� Referencing elements into constructs. For more information, see “Attach-
ing an Element as an External Reference to a Construct” on page 283 and 
“Overlaying an Element as an External Reference to a Construct” on 
page 283.

The Views Tab
In the Views tab, you assemble individual views of your project. Views are 
created from constructs within the project. 
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In the Views tab, you can perform the following actions: 

� Adding, modifying, and deleting views in the project. For more informa-
tion, see “Views” on page 307.

� Opening existing views. For more information, see “Opening and Closing 
a View” on page 320.

� Changing the contents of views. For more information, see “Changing the 
Properties of a View” on page 321.

� Creating categories for views. For more information, see “Categories” on 
page 260.

The Sheets Tab
In the Sheets tab, you create plotting sheets for your project. Plotting sheets 
contain referenced views and annotation and are used exclusively for plot-
ting drawings. In the plotting sheet you typically define plot-related settings 
like plot style tables and specific print layouts. 
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In the Sheets tab, you can perform the following actions:

� Adding, modifying, and deleting plotting sheets in the project. For more 
information, see “Plotting Sheets” on page 324.

� Opening existing plotting sheets. For more information, see “Opening 
and Closing a Plotting Sheet” on page 328.

� Creating categories for plotting sheets. For more information, see “Cate-
gories” on page 260. 

Using the Project Navigator

The Project Navigator is the main point from which you work with the 
project. Its four tabs have a number of interface components you can work 
with. 

Related Topics

� The Shortcut Menu

� The Project Navigator Toolbar

� Drag and Drop in the Project Navigator
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The Shortcut Menu
Each tab of the Project Navigator except the Project tab has a tree where the 
associated project drawing files—elements, constructs, views, and sheets—
are displayed. Within the tree you can select a drawing file, and right-click it 
to display its shortcut menu. 

The commands on the shortcut menu may vary slightly depending on the 
type of project file selected, but they have a common structure:

Command Description

Open Opens the selected project drawing file within Autodesk® 
Architectural Desktop.

Show External 
References 

Displays a worksheet that lists all external references in the 
selected project drawing file.

Properties Opens the properties of the selected project drawing file. 
Depending on the file type, the properties can differ. A 
construct, for example, has settings for level and division 
assignment; a view has a list of constructs assigned to it. For 
detailed information on file properties, see the appropriate 
sections for the individual file types.

New ➤ Category Creates a new category for the file type selected: for 
example, an element category or a construct category. For 
more information, see “Categories” on page 260.

New ➤ Element/
Construct/View/Sheet

Creates a new project file of the specified type. For more 
information, see “Creating a New Element” on page 294, 
“Creating a New Construct” on page 272, “Creating a New 
View” on page 313, and “Creating a New Plotting Sheet” 
on page 327.
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The Project Navigator Toolbar
Each Project Navigator tab has a toolbar at the bottom. The toolbar helps you 
to perform the tasks on each tab. The buttons on the toolbar may vary 

Save Current DWG as 
Element/Construct/
View/Sheet

Converts legacy drawings (created outside the project 
environment) into project file drawings. 

NOTE The legacy file must be open to run this command. 

Xref Attach Attaches the selected drawing as an external reference to 
the currently active drawing in Autodesk Architectural 
Desktop. 

NOTE The drawing must be closed when you attach it. 

Xref Overlay Overlays the selected drawing as an external reference to 
the currently active drawing in Autodesk Architectural 
Desktop. 

NOTE The drawing must be closed when you overlay it.

Insert as Block Inserts the selected drawing as a block into the currently 
active drawing. 

NOTE The drawing must be closed when you insert it as a 
block.

Cut Cuts the selected file from the tree. Use this command 
together with Paste to relocate drawing files within the tree. 

NOTE You cannot cut a file that is currently open.

Copy Copies the selected file. Use this command together with 
Paste to copy a file to a different location. 

Paste Pastes a cut or copied file to a new file location. When you 
have pasted a file in a different location, you should re-path 
the project to update the file information.

Delete Deletes the selected file. 

NOTE You cannot delete a file that is currently open. 

Rename Renames the selected file. 

NOTE You cannot rename a file that is currently open. 
When you have renamed a file, you should re-path the 
project to update the file information.

Re-path File Updates all path and file information for project files. You 
should do this every time you have renamed or moved a 
project file.

Command Description
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depending on the tab selected, but they have a common structure:

Button Description

Launches the Project Browser from within the Project 
Navigator. This button is available from every tab on the 
Project Navigator.

Refreshes the project information in the project tree. The 
Refresh button guarantees that your tree and preview are 
updated to the current state and synchronized with 
information added or changed by other users. This button is 
available from every tab on the Project Navigator.

NOTE Refreshing the project frequently is especially 
important when you are working with a project on a network 
server. 

Adds a new category for elements, constructs, views, and 
sheets. You can nest categories and create an organizational 
tree. Note that the category type is determined by the tab 
sheet; when you create a new category in the Views tab, a 
view category is created. This button is available from all tabs 
except the Project tab.

NOTE Alternatively, you can create a new category from the 
shortcut menu.

Creates a new element. This button is available only from the 
Constructs tab. 

NOTE Alternatively, you can create a new element from the 
shortcut menu.

Creates a new construct. This button is available only from 
the Constructs tab. 

NOTE Alternatively, you can create a new construct from the 
shortcut menu.

Shows the external references attached to the selected 
project file drawing. This button is available from all tabs 
except the Project tab.

NOTE Alternatively, you can display the external references 
from the shortcut menu.

Use this button to update the file names and paths in the 
project after moving, copying, or renaming files. To 
guarantee current project information, you should run this 
command after each change. This button is available from all 
tabs except the Project tab. 
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Drag and Drop in the Project Navigator
The Project Navigator allows comfortable drag-and-drop operations within 

the Project Navigator tabs, from the Project Navigator to the Autodesk® 
Architectural Desktop drawing area, and to and from Internet Explorer. 

The following drag-and-drop operations are supported:

� Dragging elements, constructs, views, and sheets from one category in the 
tree to another

� Dragging elements, constructs, views, and sheets from the tree into the 
Autodesk Architectural Desktop drawing area

� Dragging and dropping objects from an open drawing in the drawing area 
onto an element or construct in the Project Navigator

� Dragging drawing files from Internet Explorer to the Project Navigator 
tree; depending on where you drag them, drawing files are converted to 
elements, constructs, views, or plotting sheets.

For detailed information on dragging and dropping files, see the appropriate 
sections for the project files. 

The Project Status Bar

When you are working with a drawing in a project, the project status bar of 

the Autodesk® Architectural Desktop drawing area displays the name of the 
current project, the name of the project file, and the project file type. When 

Use this button to create a new view. This button is available 
only from the Views tab. 

NOTE Alternatively, you can create a new view from the 
shortcut menu.

Use this button to reload all of the external references needed 
to generate the selected view after editing external references 
in the view, or adding new references. This button is available 
only from the Views tab. 

NOTE Alternatively, you can regenerate a view from the 
shortcut menu.

Use this button to create a new plotting sheet drawing. This 
button is available only from the Sheets tab. 

NOTE Alternatively, you can create a new sheet from the 
shortcut menu.

Button Description
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you open a drawing that does not belong to a project, no project information 
is displayed.

Levels

Buildings are segmented into levels in the vertical plane. When you create a 
project, you determine the number of levels, their floor-to-floor height, and 
their floor elevation. When you add or remove levels, the project is updated 
with the new level information.

Plan view of identical building core levels

Level Cut Plane
The cut plane is not set directly in the level. To set a cut plane for a level, you 
typically create a view for the level—for example, “First Floor”—and set the 
cut plane height in the display configuration of the First Floor view. For more 
information, see “Working with Cut Planes in a Project” on page 362.
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Level Defaults
By default, the first level is present in each new project. It has a floor eleva-
tion of zero and represents the ground floor. The unit in which the level 
height is displayed is dependent on the drawing defaults of the currently 
active drawing. You can change the elevation value for the first level, which 
is then used as the default elevation for each new level you insert. 

Copying Levels with Constructs
You can quickly and easily duplicate floors with identical plans. After creat-
ing one level and assigning the floor plan constructs to it—for example, a lay-
out of apartments on the first floor—you can easily create new levels, which 
have copies of the first level’s constructs assigned to them. You can edit and 
rename these constructs later in the Constructs tab. 

TIP If you duplicate floor plans in this way, a construct is created for each new 
level. If you edit the floor plan later, for example, to add an extra door, you need 
to edit each level and construct individually. If your floor plans are going to be 
absolutely identical, you can avoid this task. Create an element containing the 
floor plan, and reference it into the first construct. Then copy the constructs to 
the levels. Each of the copied constructs have the same reference, and you can 
change them quickly by changing the referenced element once. 

For information on creating constructs and assigning them to levels, see 
“Creating a New Construct” on page 272. 

For information on creating elements and referencing them into constructs, 
see “Creating a New Element” on page 294, and “Attaching an Element as an 
External Reference to a Construct” on page 283.

Related Topics

� Creating a New Level

� Copying a Level with Assigned Constructs

� Changing the Properties of a Level

� Deleting a Level

� Changing Levels: Interactions with the Project

Creating a New Level

Use this procedure to add levels to a building. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Project tab. 
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3 Under Levels, click .

4 If you want each new level to take its floor elevation from the height of 
the level below, click Auto-Adjust Elevation.

5 Add a level in one of the following ways: 

NOTE If you add a level between existing levels and you have selected 
Auto-Adjust Elevation, the elevations of all levels above or below the new level 
are automatically adjusted. 

6 If necessary, edit the properties of the new level: 

If you want to . . . Then . . .

add a level above the 
current level click . The default floor-to-floor height of the 

new level is identical to the level below. If you have 
selected Auto-Adjust Elevation, the level’s floor 
elevation starts on top of the previous level.

NOTE Alternatively, you can select the level above 
which you want to add a level, right-click, and click 
Add Level Above.

add a level below the 
current level

select the level below which you want to add a level, 
right-click, and click Add Level Below. 

NOTE If you add a level below the ground floor and 
you have selected Auto-Adjust Elevation, the 
elevation of the new level is a negative height.

If you want to . . . Then . . .

change the name of 
the level

click the name, and enter a new one. Note that you 
cannot give the same name to two different levels—the 
name is the unique identifier of the level when 
assigning constructs.

change the base 
elevation of the level

enter a new value. If you have selected Auto-Adjust 
Elevation, the base elevation fits with the elevation and 
floor height of the level below, and you won’t need to 
make changes here. 

NOTE The base elevation of a level determines where 
the level starts on the horizontal plane. Usually, the base 
elevation of a level is determined by the floor-to-floor 
height of the level below. 
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7 When you are finished adding levels to the project, click OK. 

8 Click Yes in the subsequent dialog box to update the changed level infor-
mation throughout the project. 

Copying a Level with Assigned Constructs

Use this procedure to copy an existing level and all its assigned constructs 
within the building. 

3D view of copied levels with assigned constructs

When you create a new level, it is empty and has no constructs assigned. 
After you have assigned constructs to the level, as described in “Creating a 
New Construct” on page 272, you can copy that level and its constructs 
within the building. For example, perhaps you have created a first-floor level 

change the floor-to-
floor height of the level

enter a new value. If you add levels above this level and 
you have selected Auto-Adjust Elevation, they use the 
floor height of this level is used as the base elevation. 

change the ID of the 
level

enter a new ID. The ID can be used in schedule tables. 
For more information on scheduling a project, see 
“Annotating a Building Project” on page 341.

add a description to 
the level

enter a description for the level. 

If you want to . . . Then . . .
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and assigned three apartment constructs to it. To create a second-floor level 
with exactly the same layout, you can copy and paste the first level with its 
apartment constructs and rename it “Second Floor.”

1 Create a level and assign constructs to it.

For more information, see “Creating a New Construct” on page 272.

2 On the Window menu, click Project Navigator Palette. 

3 Click the Project tab. 

4 Under Levels, click .

5 Select the name of the level you want to copy, right-click, and click Copy 
Level and Contents.

6 Click the level above or below the one on which you want to place the 
copied level, right-click, and click Paste Level Above or Paste Level Below. 

7 Rename the pasted level accordingly: for example, “Second Level.”

8 If necessary, edit the description and the ID. 

9 Click OK. 

10 Click Yes in the subsequent dialog box to update the changed level infor-
mation throughout the project. 

11 Click the Constructs tab.

12 Locate the Constructs category. 

The constructs that were created by copying the level and constructs are 
below the original construct. For example, if you copied the first-floor-
level with a construct named “First Floor—Left Apartment,” you now have 
two constructs: “First Floor—Left Apartment” and “First Floor—Left 
Apartment (2).“

13 If necessary, rename the copied construct with an appropriate name: for 
example, “Second Floor—Left Apartment.”

14 To update the tree in the Project Navigator, click .

Changing the Properties of a Level

Use this procedure to change the properties of a level.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Project tab. 

3 Under Levels, click .



Levels | 255

4 Change the level information as needed:

5 Click OK. 

6 Click Yes in the subsequent dialog box to update the changed level infor-
mation throughout the project. 

Deleting a Level

Use this procedure to delete a level from a building.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Project tab. 

3 Under Levels, click .

4 Click the name of the level to delete.

5 Delete the level in one of these ways: 

� Right-click, and click Delete Level.

� Click .

If you want to . . . Then . . .

change the name of the 
level

click the name, and enter a new one. 

change the elevation of a 
level

click the floor elevation, and change it.

NOTE If you have selected Auto-Adjust Elevation, 
the levels above and below the level are changed 
accordingly. To prevent this, clear Auto-Adjust 
Elevation before making changes to the elevation.

change the floor-to-floor 
height of a level

click the floor-to-floor height, and change it.

NOTE If you have selected Auto-Adjust Elevation 
and there are levels above the changed level, their 
elevations are changed to accommodate the new 
height. If you do not want that effect, clear Auto-
Adjust Elevation before making changes to the 
height.

change the ID of a level click the ID, and change it. 

change the description of a 
level

click the description, and change it.
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6 Click OK. 

7 Click Yes in the subsequent dialog box to update the changed level infor-
mation throughout the project. 

Changing Levels: Interactions with the Project

Changes made to one part of a project frequently influence other parts of the 
project. The following information describes the changes you can make to a 
level and the effects of the changes on other parts of the building project:

� Adding new levels: When you add a new level to a project, you must fill 
it with constructs. You also need views and plotting sheets to represent 
that level. 

For more information, see “Constructs” on page 268, “Views” on 
page 307, and “Plotting Sheets” on page 324.

� Changing the level name: When you change the name of a level, the con-
structs assigned to it are automatically updated with the new name. For 
example, if you change the name of a level from “1” to “First Floor,” the 
constructs assigned to that level are automatically updated to be assigned 
to “First Floor.” 

� Changing the level ID: Level IDs can be used in schedule tables. If you 
change the information here, the information in your schedule table 
changes. 

� Changing the floor-to-floor height of a level: When you change the floor-
to-floor height of a level and you have selected Auto-Adjust Elevation, all 
levels above the changed level are adjusted. For example, if you change 
the height of the first floor from 3 meters to 4 meters, the elevation of the 
second level changes from 3 meters to 4 meters. If you have chosen not to 
auto-adjust levels, you need to update all other levels manually to avoid 
gaps or overlapping levels. In any case, make sure that the objects in the 
assigned constructs retain the correct height for the level after changing 
it. That way, you avoid displaying 4 meter walls in a 3 meter level. 

� Changing the floor elevation of a level: If you are changing the elevation 
of a level, the elevation above the level is adjusted. The floor-to-floor 
height of the level below the selected level is also changed. For example, 
if you change the elevation of the second floor from 2.5 meters to 2.6 
meters, the floor-to-floor height of the first floor below it is changed from 
2.5 meters to 2.6 meters. Also, the floor elevation of all levels above the 
second level will be heightened by 0.1 meter.

� Deleting a level: When you delete a level, constructs assigned to that level 
are not deleted with it. They remain in the project, but they are 
“orphaned” i.e., have lost their level. You can chose what to do with them:
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� Delete them, because the level on which they are placed no longer 
exists.

� Assign them to a different level within the project.

When you delete a level that has been used for a view, the view is not 
deleted from the project. If you update the view however, it is missing this 
level. You can choose among these actions:

� Delete the view, because the level it was displaying no longer exists.
� Create a new selection set for the view.

For more information, see “Views” on page 307.

Divisions

Divisions segment the building in the horizontal plane. A division might be 
a wing of a building or a center shaft. By default, each new project in 

Autodesk® Architectural Desktop has one division. You can add divisions, 
change their properties, and delete them. 

Building and wing schematic

NOTE A division contains no geometric information. The width and length of 
a division are determined by the constructs assigned to it. The division itself does 
not “know” anything about its dimensions. 

In smaller projects, like residential homes, you often work with only one hor-
izontal division. 

Related Topics

� Creating a New Division
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� Changing a Division

� Deleting a Division

� Changing Divisions: Interactions with the Project

Creating a New Division

Use this procedure to add divisions to a project. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Project tab. 

3 Under Divisions, click .

4 Add a division in one of these ways: 

�  Right-click in the list, and click Add Division. 

� Click .

5 If necessary, edit the division settings: 

NOTE The division names are displayed in the order of their creation.

6 When you have finished adding new divisions to the project, click OK. 

Changing a Division

Use this procedure to change the properties of a division.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Project tab. 

If you want to . . . Then . . .

change the name of 
the division

click the name, and enter a new one. Note that you 
cannot give the same name to two divisions; the name 
is the unique identifier of the division when assigning 
constructs to it. 

change the ID of the 
division

enter a new ID. The ID can be used for schedule tables. 
For more information on scheduling a project, see 
“Annotating a Building Project” on page 341.

add a description to 
the division

enter a description, and press ENTER. 
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3 Under Divisions, click .

4 Change the division information as needed:

5 Click OK. 

Deleting a Division

Use this procedure to delete a division from the building project.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Project tab. 

3 Under Divisions, click .

4 Click the name of the division to delete.

5 Delete the division in one of these ways: 

� Right-click, and click Delete Division.

� Click .

6 Click OK. 

7 Click Yes in the subsequent dialog box to update the changed division 
information throughout the project. 

Changing Divisions: Interactions with the Project

Changes made to one part of a project frequently influence other parts of the 
project. The following information describes the changes you can make to a 
division, and the effects of the changes on other parts of the building project:

� Adding new divisions: When you add new divisions to a project, you must 
fill them with constructs. You also need views and plotting sheets to rep-

If you want to . . . Then . . .

change the name of the 
division

click the name, and change it.

change the ID of the 
division

click the ID, and change it. The ID can be used in 
schedule tables. 

change the description of 
the division

click the description, and change it. 



260 | Chapter 5 Drawing Management

resent that division. For example, you might create a view named “South 
Wing” and a plotting sheet “Plan—South Wing.”

For more information, see “Creating a New View” on page 313.

� Changing the division name: When you change the name of a division, 
the constructs assigned to it are updated with the new name. For example, 
if you change the name of a division from “SW” to “South Wing,” the con-
structs assigned to that division are updated to be assigned to “South 
Wing.” 

� Changing the division ID: Division IDs can be used in schedule tables. If 
you change the information here, the information in your schedule table 
changes. 

� Deleting a division: When you delete a division, constructs assigned to 
that division are not deleted with it. They are “orphaned” and have lost 
their division. You can choose among the following actions:

� delete the constructs because the division in which they were placed no 
longer exists

� assign them to a different division within the project

When you delete a division that has been used for a view, the view is not 
deleted from the project. If you update the view, however, the deleted 
division is missing. You can choose among the following actions:

� delete the view because the division it was displaying no longer exists
� create a new selection set for the view

Categories

Categories are a folder structure within the project and help you to organize 
your project files according to disciplines, drawing types, design phases, and 
workflows.

The Basic Project Categories
Every building project in Architectural Desktop has the following basic cate-
gory structure:

� <ProjectName>: The top node in the project, represented by a folder with 
the project name. 
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� Constructs: The default folder for constructs in the project. When you cre-
ate a construct, it is saved into the Constructs category or one of its sub-
categories. For more information on constructs, see “Constructs” on 
page 268.

� Elements: The default folder for elements in the project. When you create 
an element, it is saved into the Elements category or one of its subcatego-
ries. For more information on elements, see “Elements” on page 290.

� Views: The default folder for views in the project. When you create a view, 
it is saved into the Views category or one of its subcategories. For more 
information, see “Views” on page 307.

� Sheets: The default folder for plotting sheets in the project. When you cre-
ate a plotting sheet, it is saved into the Sheets category or one of its sub-
categories. For more information, see “Plotting Sheets” on page 324.

The basic project structure is fixed; you cannot delete these basic categories 
from the project. 

User-defined Categories
Below the fixed category structure, you can create subcategories and subcat-
egory trees. Subcategories usually represent components of your workflow. 
You might set up subcategories by discipline, by phase, by view type (work-
ing, presentation, sections, rendering, and so on), by sheet type (floor plans, 
ceiling plans, elevations, and so on), or by any other system that you find 
helpful.

NOTE You cannot mix basic category types. For example, you cannot create 
a construct subcategory within the Views category or an element subcategory 
within the Sheets category.

 Your Constructs tab might look like this: 
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The Benefits of Categories
There are many benefits of using user-defined categories in your project: 

� Categories reflect your workflow. By creating categories for different 
phases and stages of the project, your practical day-to-day work is accu-
rately reflected in the project, making it easier to work intuitively and effi-
ciently.

� Categories offer optimal organization and transparency. Even small build-
ing projects contain a large number of individual drawings that are diffi-
cult to track. Putting them into descriptive categories helps you quickly 
find the correct files.

� Categories help to assemble views. When you create views of your build-
ing data, you can use categories as selection criteria. For example, for a 
complete view of framing constructs in your building, you could set up a 
view that references the “Framing” subcategory, thereby referencing all 
drawing files from that category. If you add more framing drawings to the 
Framing category later, the view is updated. For more information, see 
“Creating a View: Selecting the Constructs” on page 316.

Methods of Creating Categories
You can create categories in several ways:
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� Creating a category in the tabs of the Project Navigator
� Creating a category by adding a folder to Internet Explorer
� Create a category by dragging a folder from Internet Explorer to the 

Project Navigator

Related Procedures

� Creating a Category in the Project Navigator

� Creating a Category by Dragging a Folder from Internet Explorer to the 
Project Navigator

� Changing the Subcategory of a Project File

� Deleting a Category

Creating a Category in the Project Navigator

Use this procedure to create a new category within the Project Navigator. 

1 On the Window menu, click Project Navigator Palette. 

2 Depending on the category type you want to create, navigate to the appro-
priate tab:

3 To create a category under an existing category, click the existing category 
in the tree, and create a new subcategory in one of these ways: 

� Right-click, and click New ➤ Category. 

� Click  in the Project Navigator toolbar at the bottom of the tab. 

4 Enter a name for the category, and press ENTER. 

You can now add project files to the new category.

If you want to . . . Then . . .

create an element or construct 
category

click the Constructs tab. 

create a view category click the Views tab.

create a plotting sheet 
category

click the Sheets tab.



264 | Chapter 5 Drawing Management

Creating a Category by Dragging a Folder from 
Internet Explorer to the Project Navigator

Use this procedure to create a new category by dragging a folder from Inter-
net Explorer into the Project Navigator.

1 On the Window menu, click Project Navigator Palette. 

2 Depending on the category type you want to create, navigate to the appro-
priate tab:

3 Start Internet Explorer and position it next to the Project Navigator. 

4 Select the folder in Internet Explorer from which you want to create a cat-
egory. 

If you want to . . . Then . . .

create an element or construct 
category

click the Constructs tab. 

create a view category click the Views tab.

create a plotting sheet 
category

click the Sheets tab.
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5 Place the folder in the tree of the selected tab of the Project Navigator: 

NOTE If the folder you are dragging into the Project Navigator contains 
drawing (DWG) files, you are prompted to convert them to project files. For 
example, if you drag a folder into the Elements category in the Project Navi-
gator, you are prompted to convert all DWG files within that folder into ele-
ments. For detailed information on converting existing drawing files into 
project files, see the appropriate sections for the individual file types. 

6 To update your project with the new file information, select the new cat-
egory in the Project Navigator tree, right-click, and click Re-Path Files.

7 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

Changing the Subcategory of a Project File

Each drawing file you create within a project belongs to one of the basic, pre-
defined categories of Elements, Constructs, Views, or Sheets. If you make no 
specific assignment, the file is assigned to the base category folder of that spe-
cific project file type—element, construct, view, or sheet. Once you have cre-
ated a more detailed category system for your project, you can move drawing 
files into the subcategories. 

Related Procedures

� Creating a File in a Subcategory

� Changing the Category of an Existing File

Creating a File in a Subcategory
Use this procedure to create a project file within a subcategory.

If you want to . . . Then . . .

move the folder into the selected 
project folder location, and 
create a new category from it

drag the folder into the desired location in 
the tree of the selected tab in the Project 
Navigator.

copy the folder into the selected 
project folder location, and 
create a new category from it

CTRL-drag the folder into the desired 
location in the tree of the selected tab in the 
Project Navigator.



266 | Chapter 5 Drawing Management

1 On the Window menu, click Project Navigator Palette. 

2 Depending on the file type you want to create, navigate to the appropriate 
tab:

3 Locate the subcategory in which you want to create a new project file. 

4 Select the subcategory, right-click, and click New ➤ Element/Con-
struct/View/Sheet.

NOTE Alternatively, you can use the Add button at the bottom of the tab. 

5 Specify the properties of the new file. 

For more information on specifying new project files, see the appropriate 
sections for the individual file types. 

Changing the Category of an Existing File
Use this procedure to change the category of an existing file.

1 On the Window menu, click Project Navigator Palette. 

2 Depending on the file type you want to change, navigate to the appropri-
ate tab:

3 Locate the project file you want to move to another category. 

4 Change the file category in one of these ways: 

If you want to . . . Then . . .

create an element or construct click the Constructs tab. 

create a view click the Views tab.

create a plotting sheet click the Sheets tab.

If you want to . . . Then . . .

change an element or 
construct

click the Constructs tab. 

change a view click the Views tab.

change a plotting sheet click the Sheets tab.
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� Select the file, right-click, and click Properties. In the Modify dialog 
box, change the file category. 

� Select the file, and drag it into another subcategory. 

5 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

6 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

Deleting a Category

Use this procedure to delete unneeded categories from a project.

If you delete a category that contains drawings, the drawings are deleted with 
the category.

NOTE Do not delete a category from the Internet Explorer. This might result 
in inconsistent project data.

1 On the Window menu, click Project Navigator Palette. 

2 Depending on the category type you want to delete, navigate to the appro-
priate tab:

3 Select the category you want to delete, right-click, and click Delete. 

4 Click Yes in the subsequent dialog box. 

If you want to . . . Then . . .

delete an element or construct 
category

click the Constructs tab. 

delete a view category click the Views tab.

delete a plotting sheet 
category

click the Sheets tab.
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Constructs

Constructs are the main building blocks of the building model. A construct 
describes one unique portion of a building. A construct can be, for example, 
an elevator shaft, a flight of stairs, an apartment, or an entire floor. The con-
struct needs to be assigned to a level and a division within the project. Span-
ning constructs, like curtain walls, can be assigned to multiple levels and 
divisions. 

3D view of spanning curtain wall construct

Constructs and Levels and Divisions
Constructs are assigned to a level and a division. For example, an architec-
tural construct named “Office—First Floor/South Wing” is assigned to the 
first level and the south wing division of the building. The structural con-
struct “Framing—First Floor/South Wing” is also assigned to the first level 
and south wing division, but it has a different purpose. Constructs can span 
more than one level, a requirement for objects such as curtain walls, elevator 
shafts, or other core elements. 

When you remove a level or a division from a project, the constructs assigned 
to that level or division are “orphaned” and need to be either removed from 
the project or assigned to a different level or division. 

Constructs and Views
Constructs are used to create views of a project. You could create a view 
named “First Floor,” which displays the constructs “Office—First Floor/South 
Wing,” “Framing—First Floor/South Wing,” “Ceiling—First Floor/South 
Wing,” and “Spanning Front Curtain Wall.” This view would contain all 
objects on the first floor as well as objects that are partly on the first floor, 
like the part of the spanning curtain wall that crosses the first floor. The user 
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selects the constructs to include in the view. Constructs can be added or 
removed from views. 

3D view of building first floor

Converting Legacy Drawings to Constructs 
You can convert an existing drawing file into a construct within a project. 
You specify the subcategory into which to move or copy the source drawing. 
When you copy the source drawing, you do not lose your original drawing, 
and you can continue to use it outside the project. 

When you convert a legacy drawing file into a construct, the following pro-
cess is performed within the software: 

� The drawing file is either moved, copied, or connected via a link to the 
project category you specify.

� You assign a level and a division to the construct (multiple assignments 
are possible). 

� If necessary, you give the construct a different name, and add a descrip-
tion to it.

� An accompanying XML file with the necessary project information is 
automatically generated. 

For detailed information, see “Converting a Legacy Drawing to a Construct” 
on page 276.

Construct Files
A construct is a drawing (DWG) file. As opposed to other non-project related 
drawing files, an additional XML file with the same name is created. The 
accompanying XML file contains information to connect the construct to 
the project. 

NOTE The XML file is created and updated automatically. You do not need to 
edit it, but be careful not to accidentally delete it in Internet Explorer. 
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Construct Templates
When you create a project, you set a default template for new constructs. If 
you convert an existing drawing file to a construct, it might be based on a 
different template. If necessary, import styles, layer information, and other 
settings from the default template into the legacy drawing before or after 
converting it to a construct. 

For more information on project templates, see “Creating a New Project” on 
page 229.

Copying Constructs to Levels
In multi-story buildings, levels may have identical floor plans. You can create 
the constructs for one level and copy them to the other levels in one quick 
step. For detailed information, see “Copying Constructs to Levels” on 
page 275.

Related Topics

� When to Start with Constructs

� Processing Constructs in the Building Project

� The Content of Constructs

� Creating a New Construct

� Copying Constructs to Levels

� Converting a Legacy Drawing to a Construct

� Opening and Closing a Construct

� Dragging Objects into a Construct

� Referencing Elements into Constructs

� Referencing an Element into Multiple Constructs

� Displaying External References of a Construct

� Changing the Properties of a Construct

� Deleting a Construct

� Converting a Construct to an Element

� Changing Constructs: Interactions with the Project

When to Start with Constructs

You would start creating constructs in the following cases:

� when you want to assemble the basic structure of your building project
� when you have identified the unique portions of the building
� when you have identified the repeating, non-unique units of the project, 

and have created elements for them
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Typically, you begin a project by creating constructs. Adding details like ele-
ments often comes later in the process. For example, perhaps you know how 
many offices you need on a floor before you know the exact furniture layout 
of the offices. Therefore, you would first create the construct for the office, 
“First Floor—Office Space.” Later, you could create elements for cubicle/desk 
combinations or generic printer/copier layouts and reference them into the 
construct.

Plan view of construct with highlighted furniture elements

Keep these considerations in mind when creating constructs: 

� A construct can contain building objects, referenced elements, or a com-
bination of both.

� A construct represents a unique portion of a building. If you want to reuse 
a construct within the project, create an element instead. For more infor-
mation, see “Elements” on page 290. 

Processing Constructs in the Building Project

Constructs are the main building blocks of the building model. A construct 
can contain referenced elements and building objects, such as walls, roofs, 
and doors. It can also contain more abstract information, like structural 
grids, building outlines, and footpaths. After creating constructs, you can cre-
ate different views of your building data. A view might contain the framing 
constructs for floors 1–4, the foundation construct, and the column grid con-
struct. Or, a view of the first floor might include the partition walls of the first 
floor, the framing of the first floor, and the shell components of the building. 

The Content of Constructs

There are three different types of content you can place in a construct: 



272 | Chapter 5 Drawing Management

� Drawing objects: You can draw an apartment layout, a frame drawing, or 
a ceiling grid as a construct. Also, spanning objects like curtain walls or 
elevator shafts are usually created directly as constructs.

� Element references: You can display repeating components within the 
construct, such as desk/chair combinations, bathroom layouts, or stairs. 
For more information, see “Referencing Elements into Constructs” on 
page 282, and “Referencing an Element into Multiple Constructs” on 
page 284.

� A combination of drawing objects and element references: If you have a 
floor with different office types, but repeating furniture elements, you 
could draw the office walls directly in the construct but reference the fur-
niture as elements. 

You should not, as a general rule, reference constructs into constructs. A con-
struct has a defined level and division assignment. If a construct were to be 
referenced into another construct, it would have two contradicting level and 
division assignments. However, there are situations where the necessity to do 
this can occur. For example, when you are checking the correct vertical align-
ment of a ceiling in the building, you could view a ceiling construct with an 
overlaid floor plan construct in it. Or, you might want to display alternating 
versions of a two car garage and a three car garage within a plan construct. If 
you encounter a situation where you would need to do this, there are several 
options of working around it: 

� Convert the first construct to an element, as described in “Converting a 
Construct to an Element” on page 287, and then reference it into the 
other construct.

� Overlay the construct onto the other construct. 

WARNING! Do not attach property set data to an overlaid construct from 
within the host construct. This data is processed incompletely. If you want to 
attach property data to a construct that will be overlaid into another con-
struct, attach the property data locally in the overlaid construct.

� Create a view into which you reference both constructs. For more infor-
mation, see “Creating a New View” on page 313. 

Which of theses options is best for you largely depends on your workflow 
and the results you want to achieve. 

Creating a New Construct

Use this procedure to create a new construct. 
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3D view of spanning curtain wall construct

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Constructs category or any subcategory of the Con-
structs category. 

4 Add a new construct to the project in one of the following ways:
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� Right-click the category in which to place the new construct, and click 
New ➤ Construct.

� In the toolbar at the bottom of the Constructs tab, click .

5 Define the construct properties:

6 Click OK.

7 Open the construct, as described in “Opening and Closing a Construct” 
on page 279.

8 Edit the construct as necessary:

� Add objects to the construct. 
� Reference elements into the construct. 

For information on adding content to constructs, see “The Content of 
Constructs” on page 271.

9 To update the tree in the Project Navigator, click .

If you want to . . . Then . . .

name the new construct enter a name. If the project number is used as a prefix 
for project file names, you do not need to enter the 
prefix here. The complete name with prefix is displayed 
under File Name. For more information on prefixes, see 
“Creating a New Project” on page 229.

enter a description for the 
construct

click the setting for Description, enter a description of 
the construct, and click OK.

change the category of the 
construct

select one from the Category list. By default, the 
category you chose in step 3 is suggested. 

select a different template 
file click , and browse for a new template. By default, 

the default template set for constructs in the project is 
used. 

assign the construct to a 
level and a division

select the correct level and division in the assignments 
table. Select the desired level row and the division 
column, and check the appropriate box. 

NOTE Unless you are defining a spanning construct, 
you should check only one level and division. Multiple 
levels and divisions create spanning constructs. 



Constructs | 275

Copying Constructs to Levels

Use this procedure to copy a construct to multiple levels.

Copying constructs to levels offers you an easy way to fill multi-story build-
ings with content. You draw the construct for the first level, and then create 
a copy of that construct for each level you select.

Copying constructs to all levels schematic

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 Select the construct to copy to multiple levels, right-click, and click Copy 
Construct to Levels.

4 Select the levels on which to create a copy of the construct. 

NOTE The level on which the original construct is situated is selected by 
default. You cannot clear the selection here. 

5 Click OK. 
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In the Constructs tab, a new construct is created for each level selected. 
The level number is appended in brackets after the construct name.

NOTE If necessary, rename the constructs. Select a copied construct, right-
click, and click Rename. 

Converting a Legacy Drawing to a Construct

You may have legacy drawing files in Autodesk® Architectural Desktop that 
you want to convert into constructs. 

When you convert a legacy drawing into a construct, the following process 
is performed by the software: 

� The drawing file is either moved, copied, or connected via a link to the 
project category you specify.

� You assign a level and a division to the construct (multiple assignments 
are possible). 

� If necessary, you give the construct a different name, and add a descrip-
tion to it.

� An accompanying XML file with the necessary project information is 
automatically generated. 

There are two ways to convert a legacy drawing file into a construct: you can 
open the drawing file in Autodesk Architectural Desktop and save it as a con-
struct, or you can drag a drawing file from Internet Explorer to the Project 
Navigator. 

Related Procedures

� Converting Drawing Files to Constructs by Opening and Saving

� Converting Drawing Files to Constructs by Dragging and Dropping from 
Internet Explorer

Converting Drawing Files to Constructs by Opening and Saving
Use this procedure to convert a legacy drawing file to a construct by opening 

the file in Autodesk® Architectural Desktop and then saving it as a construct.

1 On the File menu, click Open, and open the desired drawing file. 

2 On the Window menu, click Project Navigator Palette. 

3 Click the Constructs tab. 

4 In the tree, locate the Constructs category or any of its subcategories. 
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5 Right-click, and click Save Current Dwg as Construct. 

6 Define the construct properties:

7 Click OK. 

8 To close the construct, on the File menu, click Close.

9 Click Yes to save the changes in the drawing.

10 To update the tree in the Project Navigator, click .

Converting Drawing Files to Constructs by Dragging and 
Dropping from Internet Explorer
Use this procedure to convert legacy drawing files to constructs by dragging 
and dropping them from Internet Explorer. 

Internet Explorer offers three different modes of conversion: 

� Converting a file to a construct and moving it into a project folder
� Copying a file, and converting the copy to a construct in a project folder
� Converting a file to a construct and creating a link to its original location 

If you want to . . . Then . . .

change the name of the 
drawing file

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.

enter a description for the 
construct

click the setting for Description, enter a description of 
the construct, and click OK.

change the category of the 
construct

select one from the Category list. By default, the 
category you chose in step 4is suggested. 

assign the construct to a 
level and a division

select the correct level and division in the assignments 
table. Select the desired level row and the division 
column, and check the appropriate box.

NOTE Unless you are defining a spanning construct, 
you should check only one level and division. Multiple 
levels and divisions create spanning constructs. 
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1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab.

3 Start Internet Explorer, and position it next to the Project Navigator. 

4 In Internet Explorer, open the folder that contains the legacy document. 

5 Place the legacy drawing in the Constructs category or one of its subcate-
gories:

NOTE You can also drag an entire legacy folder into the project. The folder 
is converted into a category, and all drawings within it are converted to con-
structs. For instructions on converting legacy folders to categories, see “Cre-

If you want to . . . Then . . .

move the legacy drawing into 
the selected category, and 
convert it to a construct

drag the drawing into the desired location 
in the Project Navigator.

move a copy of the legacy 
drawing into the selected 
category, and convert it to a 
construct

CTRL-drag the drawing into the desired 
location in the Project Navigator.

create a link to the legacy 
drawing in its original location, 
and convert it to a construct

ALT-drag the drawing into the desired 
location in the Project Navigator.



Constructs | 279

ating a Category by Dragging a Folder from Internet Explorer to the Project 
Navigator” on page 264.

6 Define the construct properties:

7 Click OK. 

8 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

9 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

10 To update the tree in the Project Navigator, click .

Opening and Closing a Construct

Use this procedure to open and close a construct. 

If you want to . . . Then . . .

change the name of the 
drawing file

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.

enter a description for the 
construct

click the setting for Description, enter a description of 
the construct, and click OK.

change the category of the 
construct

select from the Category list. By default, the category 
you chose in step 5 is suggested. 

assign the construct to a 
level and a division

select the correct level and division in the assignments 
table. Select the desired level row and the division 
column, and check the appropriate box. 

NOTE Unless you are defining a spanning construct, 
you should check only one level and division. Multiple 
levels and divisions create spanning constructs. 
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When you open a construct, the status line in the Autodesk® Architectural 
Desktop drawing area displays the name of the associated project. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Constructs category or the subcategory that con-
tains the construct to open.

4 Open the construct in one of these ways: 

� Select the construct, right-click, and click Open. 
� Double-click the construct. 

The construct is opened in the drawing area of Autodesk Architectural 
Desktop. 

5 To close the construct, click File ➤ Close, and save the changes, if nec-
essary. 
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6 To update the preview of the construct in the Project Navigator, click .

Dragging Objects into a Construct

Use this procedure to drag and drop objects into a construct. 

When you create a new construct, you have several choices for adding con-
tent to it. You can draw objects within the construct, you can reference ele-
ments into a construct, or you can drag and drop objects from other drawing 
files into a construct. 

1 Open the drawing that contains the objects you want to drag and drop 
into the construct. 

NOTE The drawing containing the objects is not required to be a part of a 
project. 

2 On the Window menu, click Project Navigator Palette. 

3 Click the Constructs tab. 

4 In the tree, locate the Constructs category or the subcategory that con-
tains the construct to which you want to add objects from another draw-
ing file. 

5 In the open drawing file, select the objects you want to drag and drop into 
the construct.

6 Move or copy the objects into the construct. 

If you want to . . . Then . . .

move the objects from 
the open drawing to the 
construct

drag them from the drawing onto the desired 
construct in the Project Navigator. 

copy the objects from 
the open drawing to the 
construct 

CTRL-drag them from the drawing onto the desired 
construct in the Project Navigator. 
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Referencing Elements into Constructs

There are several ways to reference an element into a construct:

3D view of cubicle element referenced four times into office space construct

Related Procedures

� Attaching an Element as an External Reference to a Construct

� Overlaying an Element as an External Reference to a Construct

� Inserting an Element as a Block into a Construct

� Referencing an Element into Multiple Constructs

If you want to . . . Then . . .

attach an element as an 
external reference

create a link from the element to the construct. Any 
changes to the referenced element are displayed in the 
construct when it is opened or refreshed.

For more information, see “Attaching an Element as an 
External Reference to a Construct” on page 283.

overlay an element as an 
external reference

create a link from the element to the construct. An overlaid 
reference is not included when the construct is attached or 
overlaid as a reference to a view. 

For more information, see “Overlaying an Element as an 
External Reference to a Construct” on page 283.

insert an element as a 
block reference

cut off the link between the element and the construct. 
The inserted element is converted to a block and is not 
updated when the reference element is changed. You can, 
however, edit the block in the construct.

For more information, see “Inserting an Element as a Block 
into a Construct” on page 284.
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� Displaying External References of a Construct

Attaching an Element as an External Reference to a Construct
Use this procedure to attach an element as an external reference to a con-
struct. 

For detailed information on attaching external references to drawings, see 
“Reference Other Drawing Files (Xrefs)” in the AutoCAD 2004 Online User’s 
Guide.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 Locate the construct into which to reference an element.

4 Select the construct, right-click, and click Open. 

5 In the Project Navigator, locate the element to attach.

6 Reference the element into the construct in one of these ways: 

� Select the element, and drag it into the open construct drawing.
� Select the element, right-click, and click Xref Attach. 

The element is inserted as an external reference into the construct.

NOTE If you cannot see the element, it may be inserted at a very small 
scale. Use the AutoCAD Zoom Extents command to display it. 

Overlaying an Element as an External Reference to a 
Construct
Use this procedure to overlay an element as an external reference to a con-
struct. 

For detailed information on overlaying external references to drawings, see 
“Reference Other Drawing Files (Xrefs)” in the AutoCAD 2004 Online User’s 
Guide.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 Locate the construct into which to reference an element.

4 Select the construct, right-click, and click Open. 

5 In the Project Navigator, locate the element to overlay.

6 Select the element, right-click, and click Xref Overlay. 

The element is inserted as an external reference into the construct.
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NOTE If you cannot see the element, it may be inserted at a very small 
scale. Use the AutoCAD Zoom Extents command to display it. 

Inserting an Element as a Block into a Construct
Use this procedure to insert an element as a block into a construct. 

For detailed information on blocks, see, see “Create and Insert Symbols 
(Blocks)” in the AutoCAD 2004 Online User’s Guide.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 Locate the construct into which to insert an element as a block.

4 Select the construct, right-click, and click Open. 

5 In the Project Navigator, locate the element to insert as a block. 

6 Select the element, right-click, and click Insert as Block. 

7 Specify the Insert options—such as insertion point, scale and rotation 
angle—and click OK.

Referencing an Element into Multiple Constructs
Use this procedure to reference an element into multiple constructs.

This procedure is useful for updating a number of similar floor constructs in 
a building.

Referencing an element into a construct

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 Locate the element to reference into multiple constructs.
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4 Select the element, right-click, and click Attach Elements to Constructs. 

5 Check the boxes of the constructs into which to reference the element.

NOTE As a shortcut, you can select an entire category for referencing. 

6 Define the referencing method:

7 Repeat steps 5-6 for each construct the element should be attached to. 

8 Click OK.

Displaying External References of a Construct

Use this procedure to display the external references of a construct. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the construct for which to display external references. 

4 Select the construct.

5 Display the external references in one of these ways: 

� Right-click, and click Show External References.

� Click .

A worksheet with the external references of the construct is displayed. You 
can expand or collapse the list by clicking individual items. 

6 Click OK to close the worksheet. 

If you want to . . . Then . . .

attach the element as an 
external reference

select the construct, right-click, and click Set to 
Attach. 

NOTE If the Set to Attach command is 
unavailable, the element is already set to attach.

overlay the element as an 
external reference

select the construct, right-click, and click Set to 
Overlay. 

NOTE If the Set to Overlay command is 
unavailable, the element is already set to overlay.
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NOTE You can also display external references by opening the construct in the 

Autodesk® Architectural Desktop drawing area, and using the AutoCAD Xref 
Manager. For more information, see “Reference Other Drawing Files (Xrefs)” in 
the AutoCAD 2004 Online Users Guide.

Changing the Properties of a Construct

Use this procedure to change the properties of a construct.

NOTE The construct must be closed in order to change its properties. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Constructs category or the subcategory that con-
tains the construct you want to change. 

4 Select the construct, right-click, and click Properties. 

5 Change the construct properties:

6 Click OK.

7 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

If you want to . . . Then . . .

change the name of the 
drawing file

enter a name. If the project number is used as a prefix 
for project file names, you do not need to enter the 
prefix here. The complete name with prefix is displayed 
under File Name. For more information on prefixes, see 
“Creating a New Project” on page 229.

enter a description for the 
construct

click the setting for Description, enter a description of 
the construct, and click OK.

change the category of the 
construct

select one from the Category list. By default, the 
category you chose in step 3 is suggested. 

assign the construct to a 
different level and a division

select the correct combination of both in the 
assignments table. Select the desired level row and 
division column, and check the appropriate box. 

NOTE Unless you are defining a spanning construct, 
you should check only one level and division. Multiple 
levels and divisions create spanning constructs. 
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8 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

Deleting a Construct

Use this procedure to delete a construct. 

For information on the consequences of deleting constructs, see “Changing 
Constructs: Interactions with the Project” on page 289.

The construct must be closed in order to delete it. 

NOTE Do not delete a construct from the Internet Explorer. This might result 
in inconsistent project data.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Constructs category or subcategory that contains 
the construct to delete. 

4 Select the construct, right-click, and click Delete. 

5 Click Yes in the subsequent message box. 

Converting a Construct to an Element

Use this procedure to convert a construct to an element.
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You may create a construct, and then realize that this is actually a repeating 
element. For example, you might create a column grid and then decide to use 
it on another floor. You can easily convert the construct to an element and 
reference it into multiple constructs. 

NOTE When you convert a construct to an element, the level and division 
information is lost. Should you later convert the element back to a construct, you 
must redefine the level and division.

NOTE Do not drag a construct into the Elements folder within Internet 
Explorer. This will result in inconsistent project data.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the construct to convert to an element. 

4 Select the construct, and drag it into the Elements category or one of its 
subcategories. 

5 Specify the element properties, as described in “Creating a New Element” 
on page 294.
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6 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

7 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

NOTE If you want to convert the element back to a construct, drag the ele-

ment to the Constructs category.

Changing Constructs: Interactions with the 
Project

Changes made to one part of a project frequently influence other parts of the 
project. The following information describes the changes you can make to a 
construct and the effects of the changes on other parts of the building 
project:

� Adding a new construct: When you add new constructs to a project, you 
must fill them with drawing objects or referenced elements. Also, you 
must create views in which to display them. For more information, see 
“Creating a New View” on page 313.

� Changing the construct name and category (location): Constructs can 
contain external element references and are referenced into views. There-
fore, any name and location changes to a construct need to be updated 
throughout the project. To update the path, re-path the project, as 
described in “Updating (Re-Pathing) the Project” on page 333. 

� Changing the level and division of a construct: If you change the level and 
division, (for example, if you switch an apartment from the first floor to 
the second floor), an empty space remains in the original location. You 
must either fill the space with a different construct or erase the level and 
division altogether. Also, be careful not to reference double constructs 
into a location. An apartment layout and a structural grid could have the 
same level/division assignment, as they exist in the same location; how-
ever, two different apartment layouts could not exist in the same location. 

� Deleting a construct: If you delete a construct that has been referenced 
into a view and update the view, that view is now incomplete and has 
missing references. Furthermore, you have an empty space in your build-
ing. That could be the desired effect, if, for example you are erasing a level 
from a building. In any case, check to see if the construct is still used else-
where. 
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For detailed information on deleting constructs, see “Deleting a Con-
struct” on page 287.

For detailed information on views, see “Views” on page 307.

Elements

Elements represent pieces that are used multiple times within a building. For 
example, you can create an element for a repeating design object like a desk/
chair combination to be placed in a number of cubicles. You can also create 
an element for a typical bathroom layout and reference it multiple times into 
an apartment construct. Because you can annotate individual instances of an 
external reference, you can use the same element and annotate it differently 
depending on its position. 

Plan view of furniture layout

For information on scheduling repeating elements, see “Attaching Property 
Sets to Objects from External References” on page 349.

3D view of single cubicle element
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Element Files
An element is a drawing (DWG) file. As opposed to other non-project related 
drawing files, an additional XML file with the same name is created. The 
accompanying XML file contains information to connect the drawing file to 
the project. 

NOTE The XML file is created and updated automatically. You do not need to 
edit it, but be careful not to accidentally delete it in Internet Explorer. 

Converting Legacy Drawings to Elements 
You can convert an existing drawing file into an element within a project. 
You specify the subcategory into which to move or copy the source drawing. 
When you copy the source drawing, you do not lose your original drawing, 
and you can continue to use it outside the project. 

When you convert a legacy drawing file into an element, the following pro-
cess is performed within the software: 

� The drawing file is moved, copied, or linked to the project category you 
specify.

� You can assign a different name and add a description to the file.
� An accompanying XML file with the project information is generated. 

Element Templates
When you create a project, you set a default template for new elements. If 
you convert an existing drawing file to an element, it might be based on a 
different template. If necessary, import styles, layer information, and other 
settings from the default template into the legacy drawing before or after 
converting it to an element. 

For more information about project templates, see “Creating a New Project” 
on page 229.

Elements and Constructs
An element is a generic building block for multiple use. The element knows 
nothing about which level or division it is placed on; this information is set 
by the construct it is referenced into. If you create a bathroom layout as an 
element, you can use it on the second floor of the west wing just as well as 
on the first floor of the east wing. To place the element on a specific floor and 
wing, you need to reference it into a construct. A construct has a level and 
division assignment. For example, you could create an element named 
“Generic Bathroom Layout” and reference it into constructs named “First 
Floor—Left Apartment,” “First Floor—Middle Apartment,” First Floor—Right 
Apartment,” and so on. 
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Referencing an element into a construct

Referencing Elements to Multiple Constructs 
In multi-story buildings, levels may have identical elements. You can create 
an element once, and then reference it into multiple constructs in one single, 
convenient step. For detailed information, see “Referencing an Element into 
Multiple Constructs” on page 284.

Related Topics

� When to Start with Elements

� Processing Elements in the Building Project

� Creating a New Element

� Converting a Legacy Drawing to an Element

� Opening and Closing an Element

� Dragging Objects into an Element

� Changing the Properties of an Element

� Deleting an Element

� Referencing an Element into Another Element

� Displaying External References of an Element

� Converting an Element to a Construct

� Changing Elements: Interactions with the Project

When to Start with Elements

You would start a project with creating elements in the following cases:

� when you can identify generic building blocks in your project
� when you start the design process from the inside-out
� when you have not yet decided on the larger structures of your building
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Elements can be small units like a desk/chair combination or large units like 
an entire apartment layout or a generic furniture layout. You might use an 
element as a placeholder until you have more specific information, like plac-
ing a generic furniture layout on a office floor or placing a building core with 
bathrooms, elevator shafts, and heating rooms. You can also define an ele-
ment that uses other elements as external references in its content. A generic 
building core element, for example, could contain references for bathroom 
elements or staircase elements. You can nest external references multiple lev-
els deep.

Keep these points in mind when creating elements: 

� An element needs to be referenced into a construct before it can be used 
for views.

� An element is re-usable; if you do not need the element more than once 
in your drawing, create a construct instead. 

Processing Elements in the Building Project

Once you have created and modified a number of elements in your project, 
you need to decide how to use them further downstream in the project. The 
following list describes typical uses for elements and where to find additional 
information: 

Plan view of furniture layout with highlighted element

Use Further Information

reference an element into a 
construct

This is the most frequent use case for an element. A 
generic element, like a bathroom layout, is referenced 
into a specific construct, like a floor plan. For more 
information, see “Referencing Elements into 
Constructs” on page 282, and “Referencing an 
Element into Multiple Constructs” on page 284.
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Creating a New Element

Use this procedure to create an element. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Elements category or any subcategory of the Ele-
ments category. 

reference an element into 
another element

For example, if you want to have different elements for 
single cubicles—a 4-cubicle group, and an 8-cubicle 
group—you could create an element for one cubicle, 
and reference that four times into the 4-cubicle group 
element. For more information, see “Referencing an 
Element into Another Element” on page 303. 

NOTE When you reference an element into another 
element, the host element still needs to be referenced 
into a construct before it can be used for views.

reference an element into a 
plotting sheet

You can directly reference an element into a plotting 
sheet. This can be useful for title block elements or the 
documentation of a detail.

convert an element to a 
construct

If you have created an element, and realize that it 
shows a unique portion of the building, for example a 
staircase, you have the option of converting the 
element into a construct. For more information, see 
“Converting an Element to a Construct” on page 305.

Use Further Information
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4 Add the new element to the project in one of the following ways:

� Right-click the category in which to place the new element, and click 
New ➤ Element.

� In the toolbar at the bottom of the Constructs tab, click .

5 Define the element properties:

If you want to . . . Then . . .

name the new element enter a name. If the project number is used as a prefix 
for project file names, you do not need to enter the 
prefix here. The complete name with prefix is displayed 
under File Name. For more information on prefixes, see 
“Creating a New Project” on page 229.

add a description for the 
element

click the setting for Description, enter a description of 
the element, and click OK.

change the category of the 
element

select from the Category list. By default, the category 
you chose in step 3 is suggested. 
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6 Click OK.

7 Open the element, as described in “Opening and Closing an Element” on 
page 299.

8 Edit the element as necessary:

� Add objects to the element. 
� Reference other elements into the element. 

For more information, see “Referencing an Element into Another Ele-
ment” on page 303.

9 To update the tree in the Project Navigator, click .

Converting a Legacy Drawing to an Element

You may have legacy drawing files in Autodesk® Architectural Desktop that 
you want to convert into elements. 

When you convert a legacy drawing file into an element, the following pro-
cess is performed by the software: 

� The drawing file is either moved, copied, or connected via a link to the ele-
ment category you specify.

� If necessary, a different name is given to the file and a description is added 
to it.

� An accompanying XML file with the necessary project information is 
automatically generated. 

There are two ways to convert a legacy drawing file into an element: you can 
open the drawing file in Autodesk Architectural Desktop and save it as an ele-
ment, or you can drag a drawing file from Internet Explorer to the Project 
Navigator. 

Related Procedures

� Converting Drawing Files to Elements by Opening and Saving

� Converting Drawing Files to Elements by Dragging and Dropping from 
Internet Explorer

select a different template 
file click , and browse for a new template. By default, 

the default template for elements set in the project is 
used. 

If you want to . . . Then . . .
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Converting Drawing Files to Elements by Opening and Saving
Use this procedure to convert a legacy drawing file to an element by opening 
it in Autodesk® Architectural Desktop and then saving it as an element.

1 On the File menu, click Open, and open the desired drawing file. 

2 On the Window menu, click Project Navigator Palette. 

3 Click the Constructs tab. 

4 In the tree, locate the Elements category or any of its subcategories. 

5 Right-click, and click Save Current Dwg as Element. 

6 Define the element properties:

7 Click OK. 

8 To close the element, click Close on the File menu.

9 To update the tree in the Project Navigator, click .

Converting Drawing Files to Elements by Dragging and 
Dropping from Internet Explorer
Use this procedure to convert legacy drawing files to elements by dragging 
and dropping them from Internet Explorer. 

Internet Explorer offers three different modes of conversion: 

� Converting a file to an element and moving it into a project folder
� Copying a file, and converting the copy to the element in a project folder
� Converting a file to an element and creating a link to its original location 

If you want to . . . Then . . .

change the name of the 
drawing file

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.

enter a description for the 
element

click the setting for Description, enter a description of 
the element, and click OK.

change the category of the 
element

select one from the Category list. By default, the 
category you chose in step 4 is suggested. 
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1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab.

3 Start Internet Explorer, and position it next to the Project Navigator. 

4 In Internet Explorer, open the folder that contains the legacy document. 

5 Place the legacy drawing in the Elements category or one of its subcatego-
ries:

NOTE You can also drag an entire legacy folder into the project. The folder 
is converted into a category, and all drawings within are converted to ele-
ments. For instructions on converting legacy folders to categories, see “Cre-
ating a Category by Dragging a Folder from Internet Explorer to the Project 
Navigator” on page 264.

If you want to . . . Then . . .

move the legacy drawing into 
the selected category, and 
convert it to an element

drag the drawing into the desired location 
in the Project Navigator.

move a copy of the legacy 
drawing into the selected 
category, and convert it to an 
element

CTRL-drag the drawing into the desired 
location in the Project Navigator.

create a link to the legacy 
drawing in its original location, 
and convert it to an element

ALT-drag the drawing into the desired 
location in the Project Navigator.
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6 Define the element properties:

7 Click OK. 

8 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

9 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

10 To update the tree in the Project Navigator, click .

Opening and Closing an Element

Use this procedure to open and close an element. 

If you want to . . . Then . . .

change the name of the 
drawing file

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.

enter a description for the 
element

click the setting for Description, enter a description of 
the element, and click OK. 

change the category of the 
element

select one from the Category list. By default, the 
category you chose in step 5 is suggested. 
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When you open an element, the status line in the Autodesk® Architectural 
Desktop drawing area displays the name of the associated project. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Elements category or the subcategory that contains 
the element you want to open.

4 Open the element in one of these ways: 

� Select the element, right-click, and click Open. 
� Double-click the element. 

The element is opened in the drawing area of Autodesk Architectural 
Desktop. You can now edit it. 

5 To close the element, click Close on the File menu, and save the changes 
if necessary. 
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6 To update the preview of the element in the Project Navigator, click .

Dragging Objects into an Element

Use this procedure to drag and drop objects into an element. 

When you create a new element, you may choose to add content to it in sev-
eral ways. You can draw objects within the element, you can reference exter-
nal drawings into an element, or you can drag and drop objects from other 
drawing files into an element. 

1 Open the drawing that contains the objects you want to drag and drop 
into an element. 

NOTE The drawing containing the objects is not required to be a part of a 
project. 

2 On the Window menu, click Project Navigator Palette. 

3 Click the Constructs tab. 

4 In the tree, locate the Elements category or the subcategory that contains 
the element to which you want to add objects from another drawing file. 

5 In the open drawing file, select the objects you want to drag and drop into 
the element.

6 Move or copy the objects into the element. 

Changing the Properties of an Element

Use this procedure to change the properties of an element. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

If you want to . . . Then . . .

move the objects from 
the open drawing to the 
element

drag the objects from the drawing onto the desired 
element in the Project Navigator. 

copy the objects from 
the open drawing to the 
element 

CTRL-drag the objects from the drawing onto the 
desired element in the Project Navigator. 
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3 In the tree, locate the Elements category or the subcategory that contains 
the element you want to change. 

4 Select the element, right-click, and click Properties. 

5 Change the element properties:

6 Click OK.

7 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

8 In the Reference File Re-Path Queue worksheet, click Re-path. 

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

Deleting an Element

Use this procedure to delete an element. 

The element must be closed in order to delete it. 

NOTE Do not delete an element from Internet Explorer. This might result in 
inconsistent project data.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the Elements category or the subcategory that contains 
the element to delete. 

4 Select the element, right-click, and click Delete. 

If you want to . . . Then . . .

change the name of the 
element

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.

change the description of 
the element

click the setting for Description, change the description 
of the element, and click OK.

change the category of the 
element

select one from the Category list. Changing the 
category of an element means changing its location in 
the project. 
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5 Click Yes in the subsequent message box. 

Referencing an Element into Another Element

Use this procedure to reference an element into another element.

NOTE When you are working in a project environment, make sure that all files 
you are using belong to this project or another project. Drawing files that do not 
belong to a project have no accompanying XML file and, therefore, do not give 
access to the full functionality of Drawing Management. For example, a non-
project drawing file referenced into a project file via the AutoCAD Xref Manager 
is not assigned a project category and does not turn up in the Project Navigator 
tree. So, while you could technically reference a non-project drawing file into an 
element with standard AutoCAD commands, it is not advisable. To reference a 
non-project drawing file into the project, convert the file into an element, and 
then reference it. 

3D view of cubicle element referenced four times into cubicle group

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate and open the element into which you want to reference 
another element.

4 In the Project Navigator, locate the element to reference into the open ele-
ment. 



304 | Chapter 5 Drawing Management

5 Reference the element into the open element in one of these ways: 

6 If necessary, edit the external reference in the open element. 

For more information on external references, see “Attach External Refer-
ences” in the AutoCAD 2004 Online Users Guide.

For more information on blocks, see “Create and Insert Symbols (Blocks)” 
in the AutoCAD 2004 Online Users Guide.

If you want to . . . Then . . .

attach the element as an 
external reference to the 
open element

select the element in the Project Navigator, right-
click, and click Xref Attach, or

select the element in the Project Navigator, and 
drag it into the open element in the Autodesk® 
Architectural Desktop drawing area.

When you attach an element as an external 
reference, you create a link from the referenced 
element to the current element; any changes to 
the referenced element are displayed in the 
current element when it is opened or refreshed.

overlay the element as an 
external reference on the 
open element

select the element in the Project Navigator, right-
click, and click Xref Overlay. 

When you overlay an external reference, you also 
create a link from the referenced element to the 
current element. Unlike an attached reference, an 
overlaid reference is not included when the 
element is itself attached or overlaid as a reference 
to another element or construct.

insert the element as a 
block into the open 
element

select the element in the Project Navigator, right-
click, and click Insert as Block. 

When you insert an element as a block reference 
into another element, the link between the 
referenced element and the current element is cut 
off. The inserted element is converted to a block 
and does not update when the reference element 
is changed. You can, however, edit the block in 
the current element.
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Displaying External References of an Element

Use this procedure to display the external references contained in an ele-
ment. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the element for which to display external references. 

4 Select the element.

5 Display the external references in one of these ways: 

� Right-click, and click Show External References.

� Click .

A worksheet with the external references contained in the element is dis-
played. You can expand or collapse the list by clicking individual items. 

6 Click OK to close the worksheet. 

NOTE You can also display external references by opening the element in the 
Autodesk® Architectural Desktop drawing area and using the AutoCAD Xref 
Manager. For more information, see “Reference Other Drawing Files (Xrefs)” in 
the AutoCAD 2004 Online Users Guide.

Converting an Element to a Construct

Use this procedure to convert an element to a construct.

If you create an element and realize later that you do not need this drawing 
as a repeating element, you can convert it into a construct. 

NOTE Do not drag an element to the Constructs folder within Internet 
Explorer. This will result in inconsistent project data.
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1 On the Window menu, click Project Navigator Palette. 

2 Click the Constructs tab. 

3 In the tree, locate the element to convert into a construct. 

4 Select the element, and drag it into the Constructs category or one of its 
subcategories. 

5 Specify the construct properties, as described in“Creating a New Con-
struct” on page 272.

6 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

7 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

NOTE If you want to convert the construct back to an element, drag it back 
to the Elements category.



Views | 307

Changing Elements: Interactions with the Project

Changes made to one part of a project frequently influence other parts of the 
project. The following information describes the changes you can make to an 
element, and the effects of the changes on other parts of the building project.

� Adding new elements: When you add new elements to a project, you 
must reference them into other elements, constructs, or plotting sheets. 

� Changing the element name and category (location): Elements are used 
as external references in other files. When you change the name and the 
location of an element, its external reference path is no longer correct. To 
update the project, re-path it, as described in “Updating (Re-Pathing) the 
Project” on page 333.

� Deleting an element: When you delete an element that has been refer-
enced into another element or into a construct or a plotting sheet, that 
drawing is now incomplete and has missing references. If a construct with 
deleted elements has been referenced into a view, and the view is updated, 
it also is incomplete. Therefore, before deleting an element, check to see 
if it is still used elsewhere. 

For detailed information on deleting elements, see “Deleting an Element” 
on page 302.

Views

Once the structure and the individual parts of the building are defined by 
constructs, you can begin creating reports of that data. A view is a drawing 
that references a number of constructs to present a specific aspect of the 
building project. You could, for example, create a first-floor reflected ceiling 
plan or second-floor framing plan. You could also create a composite view of 
all floors in the building. Views combine the appropriate constructs via exter-
nal references according to their location within the building model. For 
example, to create a floor plan of the west wing of the second floor, you 
would create a view that references all constructs assigned to the second floor 
and the west wing. This would also include a curtain wall spanning the first 
through fifth floor. You can reference additional constructs that do not lie on 
that floor but that you still want to see in the view, such as a building outline 
or a grid. 
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3D view of building first floor

Views and Constructs
You create a view by selecting constructs from your project and referencing 
them into the view. When creating multi-level views, each construct is refer-
enced at its level height. 

3D view of copied building core constructs at each building level

Views and Plotting Sheets
Views are used to create plotting sheets. You reference a view into a plotting 
sheet and supplement it with plot-sheet specific objects like title blocks and 
other annotation components. 
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Plotting sheet with building plan

Views and Annotation
You can generate project-wide data like annotation, dimensions, and sched-
ule tables in a view or a plotting sheet, depending on your specific workflow 
and needs. The Autodesk® Architectural Desktop Scheduling feature makes it 
easy to generate annotation in both views and plotting sheets. For more 
information on annotating a project, see “Annotating a Building Project” on 
page 341.

View drawing with annotation tags

Views and Layer Snapshots
The default plotting sheet template can contain layer snapshots that you can 
select when creating a new view. The selected layer snapshot is used when 
the view is referenced into a plotting sheet that is based on the default sheet 
template. 
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Updating Views
A view can include either individual constructs or entire construct categories. 
For example, if you select the Architectural—First Floor construct category, 
all constructs within this category are included in the view. If you add con-
structs to that category later, the view is updated to include the new con-
structs. Therefore, it is recommended that you use categories in order to keep 
your views current throughout the project. 

Plan view of view with and without furniture layout

View Files
A view is a drawing (DWG) file. As opposed to other non-project related 
drawing files, when you create a view an additional XML file with the same 
name is created. The accompanying XML file contains information to con-
nect the drawing file into the project. 

NOTE The XML file is created and updated automatically. You do not need to 
edit it, but be careful not to accidentally delete it in Internet Explorer. 

NOTE Do not convert an existing drawing file into a view. Because views con-
sist of referenced constructs in the drawing, it is better to create a new view 
within the project and then fill it with constructs. 
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View Templates
When you create a project, you set a default template for new views.

The view template should be saved so that it will create a drawing that opens 
to the model tab, or the model space of a layout tab. When you create a new 
view, all of the constructs assigned to the view will automatically be refer-
enced into the view drawing. The view must open into the model tab, or a 
model space viewport in a different layout to avoid the building being refer-
enced into paper space.

For more information about project templates, see “Creating a New Project” 
on page 229.

Related Topics

� When to Start with Views

� Process Overview: Creating a View

� Creating a New View

� Displaying External References of a View

� Opening and Closing a View

� Changing the Properties of a View

� Regenerating a View

� Deleting a View

� Changing Views: Interactions with the Project

When to Start with Views

Typically, you create views after you have defined your basic constructs. 
There are different view types you can create. For example, you could create 
a series of views for individual floors: “First Floor,” “Second Floor,” “Base-
ment,” “Roof.” You could also create a series of views based on plan type: 
“Plan View,” “Model View,” “Reflected View.” Another schema could be by 
function: “Walls,” “Framing,” “Furniture.“
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3D view of first floor plan and framing plan

You can add tags, dimension the building objects, and create a schedule table 
in a view. Tags and schedule tables contain a number of new project proper-
ties, such as level and division assignments. For detailed information on 
annotating a project, see “Annotating a Building Project” on page 341.

Keep these points in mind when creating views:

� You can only reference constructs directly into a view. To see elements in 
a view, they must be referenced by a construct. 

� You can add tags, dimensions, and schedule tables to a view. 

Process Overview: Creating a View 

Creating a view involves the following main steps:

Step 1: Select levels and divisions to include in the view. 

For more information, see “Creating a View: Assigning Levels and Divi-
sions” on page 315.

Step 2: Select the constructs to be contained in the view.
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For more information, see “Creating a View: Selecting the Constructs” on 
page 316.

Step 3: Select the viewport settings to be used when the view is referenced 
into a plotting sheet. 

For more information, see “Creating a View: Setting Viewport Defaults for 
the Plotting Sheet” on page 318.

Step 4: If necessary, annotate and dimension the new view. 

For more information, see “Annotating a Building Project” on page 341.

Creating a New View

A wizard leads you through the steps for creating a view. 

NOTE Views are containers for constructs. Typically, you start to create a view 
when you already have the necessary constructs in the drawing. However, you 
can also create an empty view first and add constructs to it later. 

Related Procedures

� Creating a View: Defining General Properties

� Creating a View: Assigning Levels and Divisions

� Creating a View: Selecting the Constructs

� Creating a View: Setting Viewport Defaults for the Plotting Sheet

Creating a View: Defining General Properties
Use this procedure to set the name, description, category, and template file 
of a new view.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Views tab. 

3 In the Views tree, locate the category in which to place the new view. If 
you have not defined any categories, the new view is placed in the basic 
Views category.
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4 Add a new view to the project in one of these ways:

� Right-click the category in which to place the new view, and click 
New ➤ View.

� In the toolbar at the bottom of the Views tab, click .
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5 Define the general view properties.

6 Click Next, and proceed to “Creating a View: Assigning Levels and Divi-
sions” on page 315.

Creating a View: Assigning Levels and Divisions
Use this procedure to assign the levels and divisions included in the view.

You can choose multiple levels and divisions for a view, for example, to create 
a view of the entire building. 

When you select one or more levels as view context, all constructs that 
belong to those levels are referenced into the view at the elevation you set for 
the level in “Creating a New Level” on page 251. For example, the first-floor 
constructs might be referenced at zero elevation and second-floor constructs 
at 2.75 meters. A spanning element would be referenced at the elevation of 
the lowest level to which it is assigned.

The level and divisions you choose serve as preselection for the next step. For 
example, if you choose the first level and the south wing as view context, all 
constructs belonging to that level and wing are checked in the content selec-
tor. You can exclude constructs if you wish, but preselection saves time and 
effort. 

1 Define the general properties of the view, as described in “Creating a View: 
Defining General Properties” on page 313.

2 Click Next. 

If you want to . . . Then . . .

name the new view enter a name. If the project number is used as a prefix 
for project file names, you do not need to enter the 
prefix here. The complete name with prefix is displayed 
under File Name. For more information on prefixes, see 
“Creating a New Project” on page 229.

enter a description for the 
view

click the setting for Description, enter a description of 
the view, and click OK.

change the category of the 
view

select from the Category list. By default, the category 
you chose in step 3 is suggested. 

select a different template 
file click , and browse for a new template. By default, 

the default template for views set in the project is used.
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3 Select the levels and divisions to be included in the view. 

4 When you are finished setting the levels and divisions, click Next, and 
proceed to defining the view content as described in “Creating a View: 
Selecting the Constructs” on page 316.

Creating a View: Selecting the Constructs
Use this procedure to select constructs to be referenced in the view. 

You can attach or overlay constructs into the view. By default, each construct 
is attached as an external reference. For detailed information on attaching 
and overlaying external references, see “Reference Other Drawing Files” in 
the AutoCAD 2004 Online User’s Guide. 

If more than one level is selected, the constructs are inserted at the elevation 
of the level to which they are assigned. For example, if you assign an apart-
ment construct to the second level, which has an elevation of 2.75 meters, 
the apartment construct is referenced into the view at 2.75 meters.

Selecting constructs is the key to creating a view. The view consists mainly of 
referenced constructs. 

There are several ways to make the selection of constructs easier: 

� Preselect levels and divisions: Depending on the level and division you 
selected in the Level/Divisions Assignments tab, all constructs at that level 
and division are already checked. 
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� Work with categories: When you select a category, all constructs within 
that category are selected. When you add constructs to the category later, 
they are included in the view. 

1 Define the context of the view, as described in “Creating a View: Assigning 
Levels and Divisions” on page 315.

2 Click Next. 

Based on the context you chose in the previous tab, a number of con-
structs and categories have been selected. You can use this preselected set, 
or make changes to it. 

3 Create the selection set of constructs for the view: 

If you want to . . . Then . . .

select an entire category 
to include in the view

select the category. All constructs in the category are 
selected automatically. When you add constructs to 
the category later, they are included in the view.

select a construct to 
include in the view

select the construct.

exclude a category from 
the view

clear the category’s box. All constructs in the 
category are cleared automatically.

exclude a construct from 
the view

clear the construct’s box. 
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4 Determine the referencing mode of the constructs in the view: 

5 Click Next, and proceed to “Creating a View: Setting Viewport Defaults for 
the Plotting Sheet” on page 318.

Creating a View: Setting Viewport Defaults for the Plotting 
Sheet
Use this procedure to define the view direction, display configuration, layer 
snapshot, and viewport scale to assign when referencing the view into a plot-
ting sheet. 

All the available settings come from the default sheet template. For example, 
if your default sheet template contains a layer snapshot named “Construc-
tion,” you can select that layer snapshot when setting up a new view. If you 
reference a view into a sheet that is not based on the default sheet template, 
you cannot access the selected layer snapshot.

1 Define the content of the view, as described in “Creating a View: Selecting 
the Constructs” on page 316.

2 Click Next. 

If you want to . . . Then . . .

attach the construct to the 
view

select the construct, right-click, and click Set to 
Attach. 

NOTE Attaching an external reference is the 
default insertion method for views. When the Set 
to Attach command is unavailable, the construct 
has already been set to be attached. 

overlay the construct to the 
view

select the construct, right-click, and click Set to 
Overlay. 

NOTE  When the Set to Overlay command is 
unavailable, the construct has already been set to 
be overlaid. 
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3 Select the view direction and display configuration. 

NOTE The view direction and display configuration determine how the 
view is displayed when it is referenced into a plotting sheet layout. The view 
direction and display configuration for the view itself are determined from the 
view template selected in “Creating a View: Defining General Properties” on 
page 313.

4 Select a layer snapshot to use for referencing the view into a plotting 
sheet.

If the default sheet template does not contain any layer snapshots, this list 
is empty. 

5 Select the viewport scale to use when referencing the view into a plotting 
sheet. 

6 Click Finish. 

Displaying External References of a View

Use this procedure to display the external references of a view.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Views tab. 

3 In the tree, locate the view for which to display external references. 

4 Select the view.
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5 Display the external references in one of these ways: 

� Right-click, and click Show External References.

� Click .

A worksheet with the external references of the view is displayed. You can 
expand or collapse the list by clicking individual items. 

6 Click OK to close the worksheet. 

NOTE You can also display external references by opening the view, and using 
the AutoCAD Xref Manager. For more information, see “Reference Other Draw-
ing Files (Xrefs)” in the AutoCAD 2004 Online Users Guide.

Opening and Closing a View

Use this procedure to open and close a view. 

When you open a view, the status line in the Autodesk® Architectural Desk-
top drawing area displays the name of the associated project. 
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1 On the Window menu, click Project Navigator Palette. 

2 Click the Views tab. 

3 In the Views tree, locate the view you want to open.

4 Open the view in one of these ways: 

� Select the view, right-click, and click Open. 
� Double-click the view. 

The view is opened in the drawing area of Autodesk Architectural Desktop. 

5 To close the view, click Close on the File menu, and save the changes, if 
necessary. 

6 To update the preview of the view in the Project Navigator, click .

Changing the Properties of a View

Use this procedure to change the properties of a view. 

If you have changed the name or the location of constructs included in the 
view, you need to repath the view.

If you have changed the level or division assignment of constructs included 
in the view, you need to reload the external references in the view. For infor-
mation, see “Regenerating a View” on page 322.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Views tab.

3 In the Views tree, select the view, right-click, and click Properties. 

4 Click the General category on the left, and change the general view prop-
erties:

If you want to . . . Then . . .

change the name of the 
view

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.
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5 Click the Context category on the left, and change the levels and divisions 
to include in the view. 

6 Select the Content category on the left, and change the selected constructs 
for the view. 

7 Click the Viewport Defaults category on the left, and change the settings 
of the view when referenced into a plotting sheet. 

8 Click OK.

9 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

10 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

Regenerating a View

Use this procedure to regenerate all views in the project. You need to regen-
erate a view if its content has changed—for example, if you have changed the 

change the description of 
the view

click the setting for Description, change the description 
of the view, and click OK.

change the category of the 
view

select from the Category list. 

If you want to . . . Then . . .

add a construct or category 
to the view

check the box for the construct or category. 

remove a construct or 
category from the view

clear the box for the construct or category. 

change the referencing 
mode of a construct

select the construct, right-click, and select one of these 
commands:
� To attach a previously overlaid construct to a view, 

click Set to Attach. 
� To overlay a previously attached construct to a 

view, click Set to Overlay. 

NOTE If one of these commands is unavailable, its 
mode is already selected.

If you want to . . . Then . . .
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constructs assigned to it. When you regenerate a view, you reload all of the 
external references used to generate the view. 

1 In the Project Navigator, click the Views tab. 

2 Click the  button. 

All views in the project are updated with the changed constructs. 

Deleting a View

Use this procedure to delete a view. 

For information on the consequences of deleting views, see “Changing 
Views: Interactions with the Project” on page 323.

The view must be closed in order to delete it. 

NOTE Do not delete a view from Internet Explorer. This might result in incon-
sistent project data.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Views tab. 

3 In the Views tree, select the view, right-click, and click Delete. 

4 Click Yes in the subsequent message box. 

Changing Views: Interactions with the Project

Changes made to one part of a project frequently influence other parts of the 
project. The following information describes the changes you can make to a 
view and the effects of the changes on other parts of the building project:

� Adding a new view: When you create a new view, all or most of the refer-
enced constructs should be present. For quick and comfortable selection 
of the constructs, you should place them in categories.

� Changing the view name and category (location): A view has a number of 
constructs referenced into it, and the view itself is referenced into a plot-
ting sheet. Therefore, any name and location changes to a view need to be 
updated throughout the project. To update the path, re-path the project, 
as described in “Updating (Re-Pathing) the Project” on page 333. 

� Changing the content of a view: Any changes made to the content of a 
view are also made to the plotting sheets that reference that view. 
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� Deleting a view: If you delete a view that has been referenced into a plot-
ting sheet, that plotting sheet is now incomplete and has missing refer-
ences. Check to see if the view is still used in a sheet before deleting it. 

For detailed information on deleting views, see “Deleting a View” on 
page 323.

Plotting Sheets

Plotting sheets are used to plot plans of your building project. The plotting 
sheet references views and can be used to add annotation data to the project. 
Typically, you create one plotting sheet for each view you want to plot. You 
might, however, also create a plotting sheet that references multiple views. 

Plotting sheet with building plan view

Plotting Sheet Viewports
A view dragged onto a layout in a plotting sheet is referenced into model 
space. The viewport created on the layout is scaled to match the scale speci-
fied by the view, and has the display configuration and layer snapshot spec-
ified by the view. 

For more information on setting display configurations and layer snapshots 
in a view, see “Creating a View: Setting Viewport Defaults for the Plotting 
Sheet” on page 318.

Plotting Sheets and Annotation
You can generate project-wide data like annotation, dimensions, and sched-
ule tables in a view or a plotting sheet, depending on your specific workflow 
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and needs. The Autodesk® Architectural Desktop Scheduling feature makes it 
easy to generate annotation in both views and plotting sheets. For more 
information on annotating a project, see “Annotating a Building Project” on 
page 341.

Plotting Sheet Files
A plotting sheet is a drawing (DWG) file. As opposed to other non-project 
related drawing files, an additional XML file with the same name is created 
when you create a plotting sheet. The accompanying XML file contains 
information to connect the drawing file into the project. 

NOTE The XML file is created and updated automatically. You do not need to 
edit it but be careful not to accidentally delete it in Internet Explorer. 

NOTE Do not convert an existing drawing file into a plotting sheet. Because 
plotting sheets typically contain views and a view consists mainly of referenced 
constructs in the drawing, it is better to create a new plotting sheet within the 
project and then fill it with views. 

Plotting Sheet Templates
When you create a project, you set a default template for new plotting sheets.

The plotting sheet template should be saved so that it will create a drawing 
that opens to a layout without a viewport. Because a view referenced into a 
plotting sheet will automatically create a viewport in the layout, the plotting 
sheet should have an empty layout ready to use the viewport set in the view. 

For more information about project templates, see “Creating a New Project” 
on page 229.

Related Procedures

� When to Start with Plotting Sheets

� The Content of Plotting Sheets

� Creating a New Plotting Sheet

� Opening and Closing a Plotting Sheet

� Referencing a View into a Plotting Sheet

� Changing the Properties of a Plotting Sheet

� Displaying External References of a Plotting Sheet

� Deleting a Plotting Sheet

� Changing Plotting Sheets: Interactions with the Project
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When to Start with Plotting Sheets

Plotting sheets are the final output of a building plan. You create plotting 
sheets after you have created elements and constructs for all parts of the 
building model along with the necessary views.

Designing a building is an iterative process. You often revisit planning stages 
and make changes to elements and constructs. These changes are reflected in 
the views and plotting sheets. 

Plotting sheet with building plan

Keep these points in mind when creating plotting sheets:

� The content of a plotting sheet depends on the view that is referenced into 
it and the constructs and elements referenced into the view.

� The viewport settings of a plotting sheet are defined in the view that is ref-
erenced into it. For more information, see “Creating a View: Setting View-
port Defaults for the Plotting Sheet” on page 318.

� A plotting sheet contains all plotting-specific settings like title blocks and 
print annotation. 

The Content of Plotting Sheets

Plotting sheets are predominantly used to reference views for printing pur-
poses. However, plotting sheets can contain these other components as well:

� Annotation: You can add schedule tables, object tags, and dimensions to 
a plotting sheet. 
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� Elements: You can use elements directly in plotting sheets. For example, 
you could use an element for a title block (although you could also add 
the title block to the plotting sheet template). You could also highlight a 
specific detail of the building object, like a chair/desk combination, and 
document that in the plotting sheet. Note that this might influence the 
scheduling in the plotting sheet, so make sure that this is really the desired 
effect. 

Creating a New Plotting Sheet

Use this procedure to create a new plotting sheet.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Sheets tab. 

3 Add a new plotting sheet to the project in one of these ways:

� Right-click the folder in which to place the new plotting sheet, and 
click New ➤ Sheet.

� In the toolbar at the bottom of the Sheets tab, click .
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4 Define the sheet properties:

5 Click OK.

6 Open the plotting sheet, as described in “Opening and Closing a Plotting 
Sheet” on page 328.

7 Edit the plotting sheet as necessary:

� Reference views into the plotting sheet. 

For more information, see “Referencing a View into a Plotting Sheet” 
on page 330.

� Create or import title blocks, if these are not in the template. 
� Add tags, property set data, and dimensions to the sheet. 

For more information, see “Annotating a Building Project” on 
page 341.

8 To update the tree in the Project Navigator, click .

Opening and Closing a Plotting Sheet

Use this procedure to open and close a plotting sheet. 

If you want to . . . Then . . .

name the new sheet enter a name. If the project number is used as a prefix 
for project file names, you do not need to enter the 
prefix here. The complete name with prefix is displayed 
under File Name. For more information on prefixes, see 
“Creating a New Project” on page 229.

enter a description for the 
plotting sheet

click the setting for Description, enter a description of 
the plotting sheet, and click OK.

change the category of the 
plotting sheet

select from the Category list. By default, the category 
you chose in step 3 is suggested. 

select a different template 
file click , and browse for a new template. By default, 

the default template for plotting sheets set in the 
project is used here. 
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When you have opened a plotting sheet, the status line in the Autodesk® 
Architectural Desktop drawing area displays the name of the associated 
project. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Sheets tab. 

3 Locate the sheet you want to open.

4 Open the sheet in one of these ways: 

� Select the sheet, right-click, and click Open. 
� Double-click the sheet. 

The sheet is opened in the drawing area of Autodesk Architectural Desk-
top. You can now edit it. 

5 To close the sheet, on the File menu, click Close, and save the changes, if 
necessary. 



330 | Chapter 5 Drawing Management

6 To update the preview of the sheet in the Project Navigator, click .

Referencing a View into a Plotting Sheet

Use this procedure to reference a view into a plotting sheet.

When you reference a view into a plotting sheet, the following information 
is taken from the view: 

� View Direction: The view direction of the referenced view is determined 
by the setting you have made in the view. When you have set the view 
direction in the view to TOP, the referenced view is displayed in TOP view 
in the associated viewport of the plotting sheet. 

� Display configuration: The display configuration set in the view is used to 
display the referenced view. 

� Layer Snapshot: The layer snapshot set in the view is used to display the 
referenced view.

� Viewport Scale: The viewport scale defined in the view is used to display 
the referenced view. 

For more information on how to set the display in a view, see “Creating a 
View: Setting Viewport Defaults for the Plotting Sheet” on page 318.

NOTE When you drag and drop a view into a sheet, the view is referenced into 
the sheet as an attachment. 

TIP You can reference multiple views into a sheet. For each additional view you 
drag-and-drop into the sheet, an additional viewport will be generated. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the Sheets tab. 

3 Open the plotting sheet into which to reference a view.

4 In the Project Navigator, click the Views tab.
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5 Reference the view into the open plotting sheet in one of these ways: 

Changing the Properties of a Plotting Sheet

Use this procedure to change the properties of a plotting sheet.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Sheets tab. 

3 Select the sheet, right-click, and click Properties. 

4 Change the sheet properties:

5 Click OK.

6 To update your project with the new file information, select the file in the 
Project Navigator tree, right-click, and click Re-Path File.

7 In the Reference File Re-Path Queue worksheet, click Re-path.

For more information on updating files, see “Updating (Re-Pathing) the 
Project” on page 333.

If you want to . . . Then . . .

attach the view to the 
plotting sheet

select the view, right-click, and click Xref Attach, 
or
select the view, and drag it into the open plotting 
sheet in the Autodesk® Architectural Desktop 
drawing area.

overlay the view on the 
plotting sheet

select the view, right-click, and click Xref Overlay. 

If you want to . . . Then . . .

change the name of the 
sheet

enter a new name. If the project number is used as a 
prefix for project file names, you do not need to enter 
the prefix here. The complete name with prefix is 
displayed under File Name. For more information on 
prefixes, see “Creating a New Project” on page 229.

change the description of 
the sheet

click the setting for Description, change the description 
of the sheet, and click OK.

change the category of the 
sheet

select one from the Category list. Changing the 
category changes its location in the project. 
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Displaying External References of a Plotting 
Sheet

Use this procedure to display the external references of a plotting sheet.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Sheets tab. 

3 In the tree, locate the plotting sheet for which to display external refer-
ences. 

4 Select the plotting sheet.

5 Display the external references in one of these ways: 

� Right-click, and click Show External References.

� Click .

A worksheet with the external references of the plotting sheet is displayed. 
You can expand or collapse the list by clicking individual items. 

6 Click OK to close the worksheet. 

NOTE You can also display external references by opening the view, and using 
the AutoCAD Xref Manager. For more information, see “Reference Other Draw-
ing Files (Xrefs)” in the AutoCAD 2004 Online Users Guide.

Deleting a Plotting Sheet

Use this procedure to delete a plotting sheet.

The plotting sheet must be closed in order to delete it. 

NOTE Do not delete a plotting sheet from Internet Explorer. This will result in 
inconsistent project data.

1 On the Window menu, click Project Navigator Palette. 

2 Click the Sheets tab. 

3 Select the sheet, right-click, and click Delete. 

4 Click Yes in the subsequent message box. 
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Changing Plotting Sheets: Interactions with the 
Project

Changes made to one part of a project frequently influence other parts of the 
project. The following information describes the changes you can make to a 
plotting sheet and the effects of the changes on other parts of the building 
project:

NOTE Because the sheet is the last stage of the project, it has fewer interac-
tions with the project than the other components do. For example, deleting a 
plotting sheet has no influence on other drawings, like views or constructs. 

� Adding a new plotting sheet: Normally, a plotting sheet is created to ref-
erence one specific view. For example, if you create a view called “First 
Floor Plan,” you need to create a plotting sheet that contains this view.

� Changing the plotting sheet name and category (location): A plotting 
sheet has one or more views referenced into it. Therefore, any name and 
location changes to a plotting sheet need to be updated throughout the 
project. To update the path, re-path the project, as described in “Updating 
(Re-Pathing) the Project” on page 333. 

For detailed information on deleting views, see “Deleting a View” on 
page 323.

Updating (Re-Pathing) the Project

Use this procedure to update the paths within the project after making 
changes to the name or location of elements, constructs, views, or plotting 
sheets. For example, if you move a project file into another category, or 
rename it, you must update the file to reflect that change in the Project Nav-
igator. 

An update is always prompted for when you change the current project in 
the Project Browser. For more information, see “Selecting the Current 
Project” on page 229.

When you are zipping a project, and send it to another user who unpacks the 
project to a different location on his computer, the project will be updated in 
its new location when it is set current for the first time on the new machine. 
For example, if your project resides in C:\Project1\, and the user you are 
sending it to, unpacks it to D:\Project1, the path information is updated 
when the new user sets the project current in his version of Autodesk Archi-
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tectural Desktop. This, however, will only work, if all project paths were cor-
rect and current when you zipped them. If, for example, you have moved the 
project to another location on your computer before zipping it, and not re-
pathed it before zipping, the re-pathing on the new user’s machine will not 
work correctly. Before you zip and send a project, you must make sure that 
all external reference paths in the project are valid at the time of zipping. 

WARNING! If you close Autodesk Architectural Desktop without updating 
the file paths in your project, all changed path information is lost. The next time 
you open your project, it will not have current and correct file path information. 
Therefore, it is strongly recommended that you update your project frequently 
during the work session. 

You have the choice between these updating options:

� Updating a single project file
� Updating all files in a category
� Updating all files in the project

1 On the Window menu, click Project Navigator Palette. 

2 Change the name or the location of a project file or project folder in the 
Project Navigator.

3 Update your files:

4 In the Reference File Re-Path Queue worksheet, click Re-path.

Refreshing the Project View

Use this procedure to refresh the project view in the Project Navigator. 

If you want to . . . Then . . .

update a single project file select the project file, right-click, and click Re-path 
File.

update all files in a category select the category folder, right-click, and click Re-
Path Files.

update all files in the 
project Click .
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When multiple users are working on the same project simultaneously, the sit-
uation can occur that one user’s tree in the Project Navigator gets out of sync 
with the changes of another user. 

For example, you might have one user who is adding/moving/deleting con-
structs of a project. At the same time, another user is annotating some plot-
ting sheets. The user that is working on the plotting sheets is not automati-
cally notified that his coworker has removed some constructs from the 
project; so if he tries to open a removed construct from his Project Navigator, 
he will get an error message. 

To prevent this situation, it is necessary to frequently refresh the project tree. 
When you refresh the project tree, all tree items are updated to reflect the 
current file status. 

1 On the Window menu, click Project Navigator Palette. 

2 Click the tab for which you want to refresh the file tree. 

3 Click .

NOTE It is recommended that you do this frequently during the project 
session.

Object Display in External References

When you reference a project drawing into another project drawing—an ele-
ment into a construct, a construct into a view, or a view into a plotting sheet 
—the referenced drawing has the display settings of the host drawing.

NOTE An exception to this is a situation where you insert the external refer-
ence as an overlay and have activated the setting for using the overlay’s display 
settings. Typically, you would do this when using a file in the Object Enabler. For 
more information, see “Using the Display Configuration of an External Reference 
with the Object Enabler” on page 338.
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Viewing new and existing walls in Xref detail

In some cases, you need to change the display of an external reference for a 
specific view. For example, you may want to display new walls with their reg-
ular settings, and existing walls as a light gray background image. Because the 
definition of “new walls” and “existing walls” changes from one project 
phase to the next, this information is not usually present in the referenced 
construct drawing. 

Autodesk® Architectural Desktop offers the possibility to use the display con-
figurations of the referenced drawing within the drawing that holds the 
external reference. 

You could, for example, define in a construct a display configuration called 
“Existing Walls” and assign a light gray color to it. Because you do not know 
into which views or during which project phase the construct will be refer-
enced, you do not assign this display configuration to the walls. When you 
reference the construct into a view during the first phase of the project, you 
use the regular display configuration for new walls. When you reference that 
construct into a view in a later phase, you can assign the “Existing Walls” dis-
play configuration. This change of display in the view has no influence on 
the source construct, which retains its original settings. In this way, you can 
reference a construct into a number of views with different displays, without 
changing the original construct.

Related Topics

� Using the Display Configurations of an External Reference

� Using the Display Configuration of an External Reference with the Object 
Enabler

� Example: Displaying Part of the Model as Background
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Using the Display Configurations of an External 
Reference

Use this procedure to use the display configurations of an external reference 
within the host drawing.

1 Create a project drawing that contains the display configurations you 
need for all phases of the project. For example, you could create display 
configurations named “New Walls,” “Existing Walls,” and “Demolition 
Walls.”

Because you do not yet know in which phase of the project you will use 
the drawing, you do not assign any of these display configurations but 
rather assign a standard Plan or Model configuration.

2 Reference the drawing into another project drawing. 

3 Select the reference in the host drawing, right-click, and click Edit Object 
Display. 

4 Click the Xref Display tab.

The display configurations from the referenced drawing are listed. 

5 Select Override the Display Configuration Set in the Host Drawing. 

6 Select a display configuration, for example “Existing Walls.”

7 Click OK. 

The external reference is displayed with the selected display configura-
tion. 
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Using the Display Configuration of an External 
Reference with the Object Enabler

Use this procedure to apply the display configuration of an external reference 
when overlaying it in the Object Enabler.

Viewing drawing entities in Architectural Desktop and AutoCAD

During the life cycle of a large project, drawings might be transferred to a 
contractor who uses standard AutoCAD. Opening a drawing containing 
external references can then cause visual fidelity problems. To ensure that 
your external references are displayed with their original display configura-
tion, perform the following steps:
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1 Open the external reference source drawing in Autodesk Architectural 
Desktop. 

2 Assign to the Model tab the display configuration to appear when the 
drawing is opened in AutoCAD using the Object Enabler. 

3 On the Format menu, click Drawing Setup. 

4 Click the Display tab. 

5 Select When Used as an Xref Overlay use Display Configurations from this 
Drawing only. 

6 Click OK.

7 Save and close the drawing.

8 Open AutoCAD with the Object Enabler. 

9 Overlay the source drawing into the current drawing. 

The display configuration you have assigned to the referenced drawing is 
used. 

Example: Displaying Part of the Model as 
Background

You might want to include in a view one or more constructs for informa-
tional purposes that may be outside the selected categories. These constructs 
would be displayed differently than the other constructs in the view. For 
example, you could display the geometry of an adjacent floor as a “back-
ground” for reference when working on a floor. The part of the building dis-
played as “background” and as “foreground” depends on the view. For exam-
ple, in a view of the west wing, the adjacent east wing would be the back-
ground. In a view of the east wing, the west wing would be the background. 
Because this information is context-dependent, you cannot apply the back-
ground and foreground display configurations to the constructs. You must be 
able to change the display configuration for each view the constructs are ref-
erenced in.
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Plan view of existing and new construction detail

1 Create constructs for the foreground and background parts of the model. 
For example, create a construct for the first floor of the north wing and 
one for the first floor of the south wing.

For more information, see “Creating a New Construct” on page 272.

2 Within the constructs, create a display configuration for background dis-
play. This configuration could display in light gray and with a thin line-
weight. 

TIP If you are using the templates provided with Autodesk® Architectural 
Desktop, you can use the Screened display configuration to achieve this 
effect.

TIP For optimal reuse, create the display configurations in the construct 
template before creating the constructs.

3 Create a view. 

For more information, see “Creating a New View” on page 313.

4 Select the constructs created in step 1, and reference them into the views. 

5 Open the view. 

6 Select the external reference that you want to display as background, 
right-click, and click Edit Object Display. 
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7 Click the Xref Display tab.

All display configurations from the construct drawing are listed. 

8 Select Override the Display Configuration set in the Host Drawing.

9 Select a display configuration, for example “Background” or “Screened.”

10 Click OK. 

The external reference is displayed with the selected display configura-
tion. 

Annotating a Building Project

A building model can contain annotation for the objects contained in it. A 
number of annotation features of Autodesk® Architectural Desktop have been 
enhanced to work optimally with the Drawing Management feature. 

The following sections summarize the enhancements of the Scheduling fea-
ture for annotating a building project.

Related Topics

� Preparing the Project for Annotating

� Tagging a Project

� Property Set Data and Schedule Tables in Projects

� Dimensioning a Project

� Creating a Title Block for a Project
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Preparing the Project for Annotating

You typically annotate a project when you have finished the design phase. 
Before you start creating annotation for the building objects, you might need 
to perform some extra steps with the building objects:

� Create areas from walls and other objects: You may want to report infor-
mation on the rooms of a building, such as room numbers, room finishes, 
or physical information like net and gross areas, perimeters, and calcula-
tion modifiers. An area object can schedule this information. You can eas-
ily create areas from walls and other building objects. For more informa-
tion, see “Creating Areas from Linework and Object Outlines” on 
page 1994 and “Creating Areas from Closed Boundaries” on page 1995. 

� Create spaces from walls and other objects: Spaces are similar to areas. 
You can also schedule room-specific information from spaces. For infor-
mation on creating spaces from walls, see “Generating a Space from 
Walls” on page 667, and “Generating a Space from Walls, Lines, Arcs, 
Polylines, and Circles” on page 669.

For detailed information on the differences between the two object types, 
see “Areas” on page 1986, and “Spaces” on page 656.

Tagging a Project

Use this procedure to tag objects in a project drawing. 

One of the most frequent uses of annotation in a project is tagging the indi-
vidual objects. Tags can be attached to objects in a drawing or to objects in 
an external reference. You can tag objects in source drawings like elements or 
constructs, or you can tag them in higher-level drawings like views or plot-
ting sheets. 

Property set definitions have property definitions for project information. 
You can use these to create project-specific tags that display, for example, 
level and division information. 

For more information, see “Project Properties” on page 346, “Creating a 
Property Set Definition with Project Property Definitions” on page 348, and 
“Custom Tags” on page 2237.

1 Open the project drawing in which to add your tags. 

This may not be the drawing in which the object to be tagged is located. 
It can also be a drawing that references the drawing with the object. 

2 On the Format menu, click DesignCenter™.
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3 In DesignCenter, click the Custom view.

4 Expand Architectural Desktop, and expand Imperial or Metric.

5 Locate the tag to insert in the drawing. 

6 Drag it into the drawing. 

7 Select the object to which to attach the tag. 

NOTE You can select an object within an external reference. 

8 Specify the location of the tag in the drawing. 

9 If necessary, edit the information in the property set of the tag, and click 
OK. 

NOTE It is not necessary to tag objects in order to include those objects in 
a schedule table. Tags are a convenient mechanism for attaching property set 
data to objects.

Property Set Data and Schedule Tables in 
Projects

Schedules are tables that list specific information about selected components 
in your building model. You can create different types of schedules by attach-
ing property set data to objects and object styles, and then extracting and dis-
playing the data in a schedule table.

For detailed information on property sets and schedule tables, see “Sched-
ules” on page 2197.

The existing scheduling features have been enhanced to work optimally in a 
Drawing Management environment. 

You can schedule each instance of each external reference individually. For 
example, if you have an element that contains a typical door, you can refer-
ence that door element five times into a construct. When you create a door 
schedule in the construct, all five instances of the door element are sched-
uled independently. 

When you work in a non-project environment, you attach property data to 
objects in the drawing. When you use the Drawing Management feature, you 
work extensively with external references and are able to perform the follow-
ing tasks:
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� Attach property set data to objects in external references: You can, for 
example, reference a construct into a view, and attach property sets in the 
view to the objects from the referenced construct. Attaching property sets 
to external references works for any nested levels—you can reference an 
element into a construct; a construct into a view; a view into a plotting 
sheet; and, in the plotting sheet, attach property sets to objects from all 
other project files. 

� Attach different property sets to individual instances of an external refer-
ence within a host drawing: You can reference the same door multiple 
times into the same host drawing and attach different property sets to 
each instance of the door. That way, you can reference the same floor plan 
construct multiple times in a building and schedule each floor differently. 

� Combine property sets from the source element or construct drawing 
with property sets from higher-level views or plotting sheets: You can cre-
ate a property set with physical object properties in the element drawing 
and a finish and cost-estimating property set in the plotting sheet and 
schedule both in the plotting sheet. 

Related Procedures

� Process Overview: Creating Property Sets and Schedule Tables in a Project

� Project Properties

� Creating a Property Set Definition with Project Property Definitions

� Attaching Property Sets to Objects from External References

� Creating a Schedule Table for a Project

� Example: Numbering a Door in a Project

Process Overview: Creating Property Sets and Schedule Tables 
in a Project
The main steps necessary to work with property set data and schedules in a 
project are as follows: 

Step 1: Create property set definitions and schedule table styles that contain 
the necessary project information.

For more information, see “Project Properties” on page 346 and “Creating 
a Property Set Definition with Project Property Definitions” on page 348.

You can create property set definitions and schedule table styles at differ-
ent locations in the project environment: 

� In the Autodesk® Architectural Desktop PropertySetDefs.dwg file
� In your own, user-defined property set definitions drawing
� In the drawing template
� In the drawing
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NOTE To attach a property set definition to an external reference, import 
it into the object drawing. This is done automatically when you drag a tag 
from DesignCenter into the drawing. 

NOTE The drawing that contains your property set definitions does not 
need to be a part of your project. You can import and use property set defi-
nitions from any drawing file accessible to you. 

There are a number of guidelines that can help you decide in which prop-
erty set definition to put property definitions:

� Non-manual property definitions—i.e., Automatic, Formula, Classifi-
cation, Material, and Project Property Definitions—can in many cases 
be defined in property set definitions that are applied to styles. If a 
property set definitions is to be applied to objects that do not have 
styles, it does not matter where these property definitions are defined.

� Manual property definitions containing data that does not change for 
each instance of a style should be defined in property set definitions 
that are applied to styles.

� Manual property definitions containing data that does change for each 
instance of a style should be defined in property set definitions that are 
applied to objects.

Step 2: Attach the property set definition to an object or style in a project 
drawing. 

You can attach a property set to an object at various stages of the project. 
You can attach property set data to an external reference and also override 
existing property sets from the external reference in the host drawing. For 
example, you can attach a property set definition to a door in an element 
and then override that property set with an extended one when referenc-
ing that door into a construct. You could also create an element without 
property sets, reference it into a construct and a view, and attach a prop-
erty set there.

NOTE Overriding property set definitions works only for those property 
sets attached to objects. Property sets attached to styles cannot be overridden 
when referenced into another drawing. 

For more information, see “Attaching Property Set Data to Objects” on 
page 2205 and “Attaching Property Sets to Objects from External Refer-
ences” on page 349.
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The following guidelines help you to select the correct location for attach-
ing property sets to objects within a project: 

� Property set definitions that are applied to styles must be attached to 
styles in the drawing containing the style. 

� Property set definitions that are applied to objects and that contain 
data that does not change for each instance of the object that is exter-
nally referenced should be attached to the object itself in the externally 
referenced drawing. 

� Property Set Definitions that are applied to objects and that contain 
data that does change for each instance of the object that is externally 
referenced should be overridden at the external reference, typically at 
the project construct level.

These guidelines are recommendations. The location of property data also 
depends on the processes and workflow you have established in your work 
environment. 

Step 3: Open the project drawing in which to place the schedule table. 

Step 4: If necessary, attach property sets to objects to be scheduled from 
external references, or override property sets for those objects on the external 
references that contain them. 

For more information, see “Attaching Property Sets to Objects from Exter-
nal References” on page 349.

Step 5: Create schedule tables in the drawing.

For more information, see “Creating a Schedule Table for a Project” on 
page 351.

Project Properties
A project property definition can be defined in a property set definition so 
that an object has access to information about the project in which it is cur-
rently located.

These project properties are available:

Property Description

Name Name of the project

Description Description of the project

Number Number of the project
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In addition to project properties, these properties might also be useful for 
annotating a project: 

� Location property definition: Can be used to retrieve property data from 
areas, spaces, and AEC polygons associated with an object. A data location 
grip on the object is used to define the area, space, or AEC polygon asso-
ciated with it. For example, this can be used to get the room number for 
the space in which a door opens.

For detailed information, see “Adding a Location Property Definition to a 
Property Set Definition” on page 2258.

� Formula property definition: Allows you to create formulas from other 
property definitions you have defined. For example, to subtract a finish 
quantity from a wall volume, you could set up a formula in which a 
defined finish amount is deducted from a wall volume. 

For detailed information, see “Adding a Formula Property Definition to a 
Property Set Definition” on page 2254.

� Classification property definition: Can be used to get the current classifi-
cation of an object's style, or to get other property data defined for that 
classification. For more information, see “Classification Definitions” on 
page 2289

Location File location of the project on the hard disk or network drive

Number of Levels Total number of levels in your project

Level ID ID of the level the object is on

Level Elevation Elevation of the level the object is on 

Level Height Height of the level the object is on

Number of Divisions Total number of divisions in your project

Division ID ID of the division the object is in 

Sheet Name Name of the sheet drawing that contains the object

Sheet Description Description of the sheet drawing that contains the object

Details Properties for all project details created in “Adding Project 
Details” on page 231

Property Description
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� Material property definition: Can be used to get the current material of an 
object, or to get other property data defined for that material. 

For detailed information, see “Materials” on page 491.

Creating a Property Set Definition with Project Property 
Definitions
Use this procedure to create a property set definition containing project 
property definitions.

For a list of available project properties, see “Project Properties” on page 346.

For general information on creating property set definitions, see “Creating a 
Property Set Definition” on page 2247.

NOTE A property set definition can contain different types of property defini-
tions such as automatic properties, project properties, formulas, and classifica-
tions. 

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and click Property Set Definitions. 

3 Right-click, and click New.

4 Enter a name for the new property set definition, right-click, and click 
Edit.

5 Click the Applies to tab, and define if the property set definition should 
be applied to objects or to object styles. 

6 Select the entities or styles to which the property set definition should 
apply. 

Typically, you would attach project information to objects such as areas 
and spaces, walls, doors, windows, and curtain walls. 

7 Click the Definition tab.

8 Click .

The general project properties are listed. If you have created project 
details, as described in “Adding Project Details” on page 231, they are 
listed too and can be selected for the property set definition.

9 Select a project property.

10 Enter a name, and click OK. 
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11 Repeat steps 8-10 for each project property you want to add to the prop-
erty set definition.

12 If necessary, add other properties to the definition. 

13 Click OK twice.

Attaching Property Sets to Objects from External References
Use this procedure to attach property sets to objects in external references. 

This topic explains the following procedures:

� Attaching property sets to objects from external references.
� Attaching different property sets to different instances of the same exter-

nal reference. For example, you can reference the same floor plans onto 
multiple levels and schedule each level differently.

1 Reference a project drawing, such as an element or a construct, into 
another project drawing, such as a view or a plotting sheet.

2 Open the Documentation tool palette, and select the Browse Property 
Data tool. 
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3 Under Property Set Definition, select the property set definition from the 
host drawing with which you want to work.

4 Expand the desired external reference in the tree, until you can see the 
desired object.

5 Attach property set data to objects:

6 If necessary, decrease the number of objects displayed in the tree: 

If you want to . . . Then . . .

attach a property set from the 
host drawing to an object in an 
external reference

If no property set definition with the same 
name has been attached to the object, the 
row of boxes immediately next to it is empty. 
Select the box to check it. A property set is 
attached directly to the object. It is displayed 
on the right side, and can be edited.

override a property set from an 
external reference with a 
property set from the host 
drawing

If a property set with the same name has 
been attached at a lower level to the external 
reference, a read-only box is displayed at the 
appropriate level. Select the box at that level 
next to the object. The property set is 
attached to the external reference at the 
selected level as an override for the object. If 
a property set definition with the same name 
as that selected above exists in the external 
reference, it uses it, otherwise the property 
set definition in the host drawing is copied to 
the external reference. The property set is 
displayed on the right and is editable.

attach different property sets to 
different instances of an external 
reference

Expand the desired instance of the external 
reference in the tree. Select the box next to 
the object instance. To attach a different 
property set to another instance, select a 
different property set definition, expand a 
different instance of the external reference, 
and attach the property set to it. 

remove a property set from the 
host drawing for an external 
reference

clear the box at the appropriate level next to 
the desired object. 

If you want to . . . Then . . .

show only one type of object in 
the tree

select the appropriate object under Object 
Filter. 
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7 If you are not sure whether you selected the correct object from the exter-
nal reference, click Highlight to mark the object in the drawing area. 

8 To display the correct object in the drawing area, click Zoom to.

9 If necessary, edit the property set data on the right. 

10 To display properties with the correct data format style from the property 
set definition, select Format Data. 

11 Click OK. 

Creating a Schedule Table for a Project
Use this procedure to create a schedule table that contains property data from 
an external drawing such as a project drawing.

Schedule tables can contain information from external references and block 
references, which typically must exist in the same drawing as the schedule 
table. Schedule tables now optionally specify an external drawing, which is 
scheduled as if it were an external reference in the same drawing as the table. 
The advantage to this is that the graphics of the external drawing do not 
need to be generated in order to fill out the data in the table. 

For general information on adding schedule tables, see “Adding a Schedule 
Table” on page 2216.

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the plotting sheet that will contain the schedule table.

2 Open the tool palette that you want to use, and select a Schedule Table 
tool.

If necessary, scroll to display the tool that you want to use.

3 On the Properties palette, expand Basic, and expand General.

4 Select a style.

5 Instead of selecting objects in the drawing, press ENTER.

6 Specify the insertion point of the schedule table.

7 Specify the size of the schedule table.

show only those objects that 
already have the selected 
property set attached on some 
level

clear Hide Objects without Property Set 
Definitions. 

If you want to . . . Then . . .
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An empty schedule table is inserted into the drawing. 

8 Select the empty table, right-click, and click Properties. 

9 On the Properties palette, expand Advanced, and expand External Source. 

10 For Schedule External Drawing, select Yes.

The External Drawing setting are displayed, with a list containing all 
drawings in the Views directory of the current project. Each drawing 
should correspond to a view defined in the project. If no project is active, 
the list contains all drawings in the last directory browsed.

11 Select the view you want to schedule. 

NOTE The setting for External Drawing Name is displayed only if you have 
selected Yes for Schedule External Drawing.

If the desired external view drawing is not displayed in the list, select 
Browse and find it.

Example: Numbering a Door in a Project
The following example shows how you can define property data that com-
bines object properties with project properties. The example uses door num-
bers and room information to show how you could use project, location, for-
mula, and manual property definitions. Typically a door is numbered based 
on the room in which it opens, with an alphabetic suffix for rooms with mul-
tiple doors. The following diagram shows how a door number can be built up 
from other information in the drawing and the project. 

Value Property 
Set 
Definition

Property 
Definition

Description

2 Space LevelNumber A project property definition, getting 
the Level ID for the object for the 
current project

01 Space BaseNumber A manual auto-incrementing 
property definition

201 Space RoomNumber A formula property definition, with 
the formula 
[LevelNumber][BaseNumber]
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1 Create a drawing in a project that contains a number of spaces and a num-
ber of doors. 

2 Create a property set definition for spaces. 

3 Define the following properties in the definition:

4 Create a property set definition for doors. 

5 Define the following properties in the definition:

201 Door RoomNumber A location property definition, 
getting the Space: RoomNumber 
property value for the space under 
the door's data location grip

___A Door DoorNumber 
Suffix

A manual text property definition

201A Door DoorNumber A formula property definition, with 
the formula [RoomNumber][Suffix]

Property Instruction

LevelNumber
Click , enter LevelNumber for Name, and select Level 
ID in the list. Then, click OK.

SpaceNumber
Click , enter SpaceNumber for Name, and click OK. 
Then, select Auto Increment - Integer for Type. 

RoomNumber
Click , enter RoomNumber for Name, and enter the 
formula [LevelNumber][SpaceNumber]. The easiest way 
to create the formula is by clicking the properties in the list.

Property Instruction

RoomNumber
Click , enter RoomNumber for Name, and select the 
RoomNumber formula property from the Space property 
set definition created above. Then, click OK.

Value Property 
Set 
Definition

Property 
Definition

Description
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6 Attach these property set definitions to the doors and spaces in the draw-
ing, and fill in the manual properties.

TIP The quickest way to attach property sets to multiple objects is to use the 
Browse Property Data tool on the Documentation tool palette. 

7 Select a door in the drawing. 

Notice a new star-shaped grip near the hinge jamb.

Viewing the Property Data Location grip of a door

This data location grip is displayed on an object when it has any property 
set attached to it that contains a location property definition. An object 
with a data location grip can retrieve property data from a space, area, or 
AEC polygon under the position of the grip. 

8 Select the Data Location grip, and move it over a space in the drawing. 

A curved dashed line will be drawn between the grip and the object.

9 In the Properties palette, click the Extended Data tab. If your rooms are on 
the second floor, the resulting value reads “201A.” If you attach these 
property sets to the same space and door on the third floor, it reads 
“301A.”

This is just one of many examples of how to use the new Scheduling features 
within a project. For a complete description, see “Schedules” on page 2197.

DoorNumberSuffix
Click , enter DoorNumberSuffix for Name, and click 
OK. Then, select Text for Type. 

DoorNumber
Click , enter DoorNumber for Name, and enter the 
formula [RoomNumber] [DoorNumberSuffix] by 
clicking the properties in the list.

Property Instruction
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Dimensioning a Project

Use this procedure to dimension objects in a project drawing. 

In the documentation phase of a project, you create detailed dimensions of 
objects. AEC dimensions can be attached to objects in a drawing or to objects 
in an external reference. You can dimension objects in source drawings like 
elements or constructs, or you can dimension them in higher-level drawings 
like views or plotting sheets. 

For detailed information, see “AEC Dimensions” on page 2357.

1 Open the project drawing in which to add a dimension. 

This may not be the drawing in which the object to be dimensioned is 
located. It may be a drawing that references the object. 

2 Open the tool palette that you want to use, and select an AEC dimension 
tool.

If necessary, scroll to display the tool that you want to use.

3 On the Properties palette, expand Basic, and expand General.

4 Select a style.

5 In the drawing area, select the objects to dimension.

NOTE You can select objects from the drawing, objects from external ref-
erences, or a combination of both. 

6 Press ENTER.

7 Specify the position of the new dimension: 

If you want to . . . Then . . .

insert the dimension group 
parallel to or perpendicular 
to the dimensioned object

drag the cursor in the desired direction, and 
click in the drawing at the desired insertion 
point.

NOTE If your selection set contains objects 
with different directions, the direction of the 
first selected object defines the parallel and 
perpendicular directions.
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Creating a Title Block for a Project

You can create title blocks that display project-specific information. When 
the information changes, it is updated in the title block. A title block is a 
multi-view block, which can include these automatic project attributes:

� Project number
� Project name
� Project description
� Project location
� Project sheet name
� Project sheet description
� Project details

Project attributes are set when you create a new project. For more informa-
tion, see “Creating a New Project” on page 229. 

Project details are optional information you can enter for your project. For 
more information on creating project details, see “Adding Project Details” on 
page 231.

Related Procedures

� Process Overview: Creating a Title Block for a Project

� Adding Project Attributes

insert the dimension group 
at a specified rotation

enter r (Rotation) on the command line, and 
press ENTER.Then, enter a rotation angle 
either by clicking in the drawing or by entering 
one on the command line. Press ENTER, and 
click in the drawing at the desired insertion 
point.

NOTE If your selection set contains objects 
with different directions, the rotation is 
calculated with reference to the first selected 
object.

insert the dimension group 
aligned parallel to an object 
other than the dimensioned 
object 

enter a (Align) on the command line, and press 
Enter. Then, select the object to which to align 
the dimension group. Press ENTER, and click in 
the drawing at the desired insertion point.

NOTE The direction of the dimension group is 
dependent on the rotation of the chosen 
object. The drawing direction of the object has 
no influence on the dimension group direction. 

If you want to . . . Then . . .
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� Creating a Project Block

� Creating a Multi-View Block

� Creating a Tool for the Title Block

� Inserting the Title Block into a Drawing

Process Overview: Creating a Title Block for a Project
Creating a project title block consists of these basic steps:

Step 1: Open the project drawing in which to add a title block. Typically, this 
is a plotting sheet.

Step 2: Add project attributes to the drawing. 

Step 3: Create a block from the attributes.

Step 4: Create a multi-view block from the block.

Step 5: Create a multi-view block tool.

Step 6: Insert the multi-view block as a title block in the plotting sheet.

Adding Project Attributes
Use this procedure to create project attributes for a title block in the drawing. 

The following project attributes are available for a title block: 

Project Attributes 

Attribute Description

PROJECT:NUMBER Displays the project number.

PROJECT:NAME Displays the name of the project.

PROJECT:DESCRIPTION Displays the description of the project.

PROJECT:LOCATION Displays the file location of the project file. 

PROJECT:SHEET:NAME Displays the sheet name for the drawing 
containing the title block, if it is part of the 
currently active project.

PROJECT:SHEET:DESCRIPTION Displays the sheet description for the drawing 
containing the title block, if it is part of the 
currently active project.
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1 On the command line, enter ddattdef.

2 In the Tag field, enter one of the attributes described above. For example, 
to create an attribute for the name of the project, enter PROJECT:NAME. 

3 Proceed to adding the attribute as described in “Working with Attributes” 
in the AutoCAD 2004 User’s Guide. 

4 Repeat steps 1–3 for each attribute to add to the project title block.

5 Complete the attribute block with lines, borders, and other desired com-
ponents.

As a result, you have a number of attributes and graphic elements in your 
drawing. Your attribute block might look like this:

PROJECT:<DETAILCATEGORY>:
<DETAIL>

Displays a user defined project detail. 

NOTE You must enter the detail category and 
detail name in the attribute without any spaces. 
For example, to create an attribute for the detail 
“Zoning” in the detail category “Proposed 
Improvements,” you would enter it as 
PROJECT:PROPOSEDIMPROVEMENTS:ZONING

Project Attributes 

Attribute Description
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Viewing title block attributes and data

Creating a Project Block
Use this procedure to create a block that contains the attributes you added in 
the previous step.

1 On the Format menu, click Blocks ➤ Block Definition.

2 Enter a name for the block.

3 Click Select Objects, and select the attributes and additional graphics to 
include in the title block.

4 From the Drag-and-drop units list, select Unitless.

5 Proceed to creating the block as described in “Defining Blocks” in the 
AutoCAD 2004 User’s Guide. 

Creating a Multi-View Block
Use this procedure to create a multi-view block from one or more blocks cre-
ated in the previous procedure.
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For detailed information about multi-view blocks, see “Multi-View Blocks” 
on page 2481.

1 On the Format menu, click Style Manager. 

2 Expand Multi-Purpose Objects.

3 Right-click Multi-View Block Definitions, and click New.

4 Enter a name for the new multi-view block definition, and press ENTER.

5 Select the new multi-view block definition, right-click, and select Edit.

6 Click the View Blocks tab.

7 Select a display representation for the title block.

Typically, you would display a title block in Plan views and Reflected 
views. 

8 Click Add.

9 Select the block you defined in “Creating a Project Block” on page 359, 
and click OK.

10 Select the view directions for the block.

11 Repeat steps 6–9 for each display representation in which the title block is 
to appear.

12 Click OK twice.

Creating a Tool for the Title Block
Use this procedure to create a tool for the title block. 

1 On the Format menu, click Style Manager. 

2 Expand Multi-Purpose Objects, and expand Multi-View Block Definitions.

3 Locate the multi-view block definition you created in the previous proce-
dure, and drag it to the tool palette. 

4 Click OK to close the Style Manager.

Inserting the Title Block into a Drawing
Use this procedure to insert the multi-view block you created in the previous 
procedure into the drawing as a title block.
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Viewing title block attributes and data

1 In the project drawing, click the layout tab on which to place the title 
block. 

2 Open the tool palette that you want to use, and select the multi-view 
block tool you created in “Creating a Tool for the Title Block” on page 360.

3 Specify the insertion point of the title block.

You can move or hide the Properties palette to expose more of the drawing 
area.

4 If necessary, specify the scale and rotation of the title block. 

5 Press ENTER. 
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Working with Cut Planes in a Project

You can set a global cut plane for each display configuration in a drawing, 
and individual cut planes for objects like walls, curtain walls, and wall open-
ings. 

The Global Cut Plane
You can set a global cut plane for a display configuration in a drawing. All 
objects included in that display configuration are cut at the height defined 
in the display configuration, unless they have an object-specific cut plane 
override. Each display configuration can have a different cut plane. For more 
information, see “Object-Specific Cut Planes” on page 373 and “Global Cut 
Planes” on page 364.

The Object-Specific Cut Plane
A number of objects can override the global cut plane settings and use their 
own cut planes: for example, walls, curtain walls, and stairs. For more infor-
mation, see “Object-Specific Cut Planes” on page 373.

Cut Plane Display Range
A cut plane is set to a specific height, for example, 1.4 meters. Objects above 
or below that level are by default not displayed in a Plan view. You can, how-
ever, define a display range above and below the cut plane. Object compo-
nents inside that range are displayed too. This would be useful if you want to 
display a window that lies above or below the cut plane but that should be 
included in the display.

Viewing plan view window cut plane options

You also use a display range to define clipped views, such as the model view 
of a second floor. In that case, the display range defines which levels to dis-
play and which levels to hide. 
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Clipped 3D view of second floor 

For more information, see “Using the Global Cut Plane: Creating a Clipped 
Model View” on page 370.

Cut Planes and Levels
Levels are represented separately by one or more files and are assembled in a 
view or plotting sheet to represent the entire building. 

You set the cut plane individually for each level of a building. You create a 
drawing file—a construct or a view—that represents the level, and assign a 
cut plane to a display configuration within the drawing. 

The following images illustrate a curtain wall that spans three levels. The 
images on the left indicate the cut plane for the associated level drawing. The 
plans to the right show how the curtain wall would be displayed in Plan view 
at each level. Notice the different appearance of the doors and mullions on 
the various floor plans.
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Specifying three cut plane levels

Related Topics

� Global Cut Planes

� Object-Specific Cut Planes

Global Cut Planes

The global cut plane is set for a display configuration in a drawing. It cuts all 
objects in the display configuration at the same height. You can have differ-
ent cut planes for different display configurations within a drawing: for 
example, one cut plane height for a regular Plan view, and another cut plane 
height for a Reflected view. 
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The global cut plane is used on all objects that do not have an object-specific 
cut plane override. For more information, see “Object-Specific Cut Planes” 
on page 373.

Related Topics

� Global Cut Plane Display Range

� Display Properties for the Cut Plane Display Range

� Setting the Global Cut Plane and the Display Range

� Using the Global Cut Plane: Displaying the Cut Plane of a Different Level

� Using the Global Cut Plane: Creating a Clipped Model View

Global Cut Plane Display Range
When you set a global cut plane for a display configuration, you also set a 
display range above and below the cut plane. This is the range in which 
objects, even when they do not intersect the cut plane, are displayed. For 
example, if you set the cut plane to 1.4 meters and define the visible range 
above the cut plane at 2 meters and the visible range below the cut plane at 
1 meter, then your objects are cut at 1.4 meters. Objects that lie between 1.4 
meters and 2 meters as well as objects that lie between 1.4 meters and 1 meter 
are also displayed, but with different display for above and below the cut 
plane. Objects that lie outside the range—for example, a window that is 
inserted at 0.8 meter—are not displayed at all. 

NOTE The values for the display range are calculated relative to the WCS, not 
relative to the global cut plane height.

Plan view of window cut planes

You also use a display range to define clipped views, such as the model view 
of a second floor. In that case, the display range defines which levels to dis-
play and which levels to hide. 
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Clipped 3D view of second level

For more information, see “Using the Global Cut Plane: Creating a Clipped 
Model View” on page 370.

Display Properties for the Cut Plane Display Range
Many objects have display components that you can set for display above 
and below the cut plane. For example, an object below the cut plane can be 
inserted with dashed lines and a different line color. If you want to work with 
the display range, you need to set the appropriate display components 
accordingly. 

NOTE The Above and Below Cut Plane display components appear in all Plan-
type display representations, such as Plan, Plan High Detail, Plan Low Detail, Plan 
Screened, Reflected, and Reflected Screened, as well as in user-defined display 
representations that are based on any of these display representations.

The following objects have display components for above and below the cut 
plane:

Object Components that can be set for above 
and below cut plane 

Curtain Walls/Curtain Wall Units Curtain Wall/Curtain Wall Unit body 

Doors Frame
Panel
Stop
Swing
Threshold

Door/Window Assemblies Door/Window Assembly body 

Mass Elements Mass Element body 
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For more information on setting display properties for individual objects, see 
the appropriate procedures for the objects. 

Setting the Global Cut Plane and the Display Range
Use this procedure to set the global cut plane and the visible display range 
for a display configuration. 

For information on the display system, see “Display Configurations” on 
page 445.

NOTE The values you enter for the Above and Below ranges are the absolute 
height values calculated from the WCS origin. They are not relative to the cut 
plane. For example, if you have set the global cut plane to 1.4 meters, you need 
to set the visible range above the cut plane to a value higher than 1.4 meters; 
otherwise, you get an invalid display range.

1 On the Format menu, click Display Manager.

2 Expand Configurations.

Railings Guard Rail
Hand Rail
Bottom Rail
Post

Slabs/Roof Slabs Slab Body
Slab Outline

Stairs Stringer
Stringer Facets
Riser
Riser Numbers
Nosing
Path
Outline

Structural Members Beam/Brace/Column body

Walls Wall Body

Windows Glass
Frame
Sash
Sill

Object Components that can be set for above 
and below cut plane 
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3 Select the display configuration for which to set the global cut plane. 

4 Click the Cut Plane tab. 

5 Define the cut plane and the visible ranges above and below the cut plane:

NOTE For information about displaying the cut plane of a different level, 
see “Using the Global Cut Plane: Displaying the Cut Plane of a Different 
Level” on page 368.

6 Click OK. 

Using the Global Cut Plane: Displaying the Cut Plane of a 
Different Level
Use this procedure to display the cut plane of a different level. 

Usually, you want to display the cut plane of the current level. However, in 
some cases, you might want to display a different level. 

If you want to . . . Then . . .

define the global cut plane 
height for the display 
configuration

enter the appropriate value for Cut Height. 

define the visible range above 
the cut plane

enter the appropriate value for Display Above 
Range. 

NOTE The value you enter here is calculated 
from the WCS origin and is not relative to the 
cut height.

define the visible range below 
the cut plane

enter the appropriate value for Display Below 
Range. 

NOTE The value you enter here is calculated 
from the WCS origin, and is not relative to the 
cut height.
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Specifying different cut planes results

1 Create a view containing the desired level. 

For more information, see “Creating a New View” on page 313.

2 If necessary, switch to a Plan view.

3 On the Format menu, click Display Manager.

4 Expand Display Configurations. 

5 Select the current display configuration, which is displayed in bold text.

6 Click the Cut Plane tab. 

7 Click Calculate. 

This button is only available when the drawing is part of a project. It uses 
the level information you entered in “Creating a New Level” on page 251.

8 In the Cut Plane Worksheet, select the level whose Plan view you want to 
display in the current drawing. 

For example, if you have created a view of the first floor but want to dis-
play the Plan view of the second floor, select 2. 

9 Select the cut plane height of the selected level. 

For example, to display the second level at a cut height of 1.4 meters, enter 
1.4 here.

10 Click OK.
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The display range is adapted to display the height of the selected level. 

For example, perhaps you have a three-story building with a floor height 
of 2.75 meters for each floor. You have created a view of the first floor but 
want to display the second floor in it at a cut height of 1.4 meters. In the 
Cut Plane dialog, you enter 2 for level, and 1.4 for Cut Plane Height Above 
Level. When you click OK, the display range of the view now spans the 
second level. The following values are entered into the Cut Plane Tab of 
the display configuration:

11 Click OK. 

Using the Global Cut Plane: Creating a Clipped Model View
Use this procedure to create a clipped Model view of a building level. 

If a level is crossed by a spanning element like a curtain wall or an elevator 
shaft, you want to display only those parts of the spanning element that 
actually lie on that level. You can create a clipped Model view that displays 
only those objects and object ranges within the user-defined display range. 

Clipped Model view

Field Name Value Comment

Display Below 
Range

2.75 meters This is where the second level starts. 

Cut Height 4.15 meters (2.75 
meters + 1.4 
meters)

To display a cut height of 1.4 meters, you 
need to add 1.4 meters to the start of the 
second level at 2.75 meters.

Display Above 
Range

5.5 meters The second level starts at 2.75 meters, 
and has a base height of 2.75 meters. 
This results in an overall height of 5.5 
meters.
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Some display settings for a clipped Model view are influenced by the materi-
als assigned to the clipped objects: 

� Display of object ranges outside the display range: You can display the 
parts of a spanning element that are outside the display range of the level. 
In some cases, you might want to display those parts of the object in a 
lighter color and thinner lineweight to imply the complete shape of the 
object. 

3D view of spanning element in and out of display range

How those parts are displayed is set in the Sectioned Body component of 
the objects’s materials. For information on setting the display of the Sec-
tioned Body component, see “Sectioned Body and Sectioned Boundary” 
on page 502 and “Defining the Layer, Color and Linetype of a Material” 
on page 520.

� Display of a section hatch and a section boundary where the display range 
cuts the spanning object: You might choose such a display to highlight 
the cut line.
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Section hatch and cut line displayed where display range cuts object

How the section hatch and boundary are displayed is defined in the Sec-
tion Hatch component of the materials for the object. For information on 
setting the display of these components, see “Section Hatch Material 
Component” on page 502, “Sectioned Body and Sectioned Boundary” on 
page 502, and “Defining the Layer, Color and Linetype of a Material” on 
page 520.

1 Create a view containing the desired level. 

For more information, see “Creating a New View” on page 313.

2 If necessary, switch to a Model view: for example, SW Isometric. 

3 On the Format menu, click Display Manager.

4 Expand Configurations. 

5 Select the current display configuration.

It is displayed in bold text.

6 Click the Cut Plane tab. 

7 Set the Above and Below display ranges to be identical to the level height. 

For example, if your level is 2.75 meters high, set Display Below Range to 
0.0 meters and Display Above Range to 2.75 meters. 



Working with Cut Planes in a Project | 373

NOTE For a clipped model view, it is not important how you set the cut 
plane, as the cut plane is displayed only in Plan views. Either keep the original 
value, or enter any value within the display range: for example, 1.4 meters. 

8 Expand Sets. 

9 Select the current display set (displayed in bold text).

10 Click the Display Options tab.

11 Define the display of the clipped model view:

12 Click OK. 

Object-Specific Cut Planes

Many objects in Autodesk® Architectural Desktop have individual settings for 
cut planes that can override the global cut plane setting. Object-specific cut 
planes are useful when you have objects of different heights in your Plan 
view. This happens frequently when you are working with a split-level floor 
plan or a sunken room.

An object-specific cut plane takes precedence over the global cut plane in the 
display configuration. 

For more information on the global cut plane, see “Global Cut Planes” on 
page 364.

If you want to . . . Then . . .

display the objects in the display 
range defined in step 7 with their 
regular display settings, and the 
objects outside of the display 
range as Sectioned Body

select Section AEC Objects by Display Range 
defined in Display Configuration.

show a section hatch and a 
section boundary where spanning 
objects are cut by the display 
range

select Show Materials where Display Range 
Intersects AEC Objects.

hide all parts of spanning objects 
outside of the display range

select Hide Sectioned Body Component.

suppress the surface hatch of 
objects within the display range

select Hide Surface Hatching. 
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Related Topics

� Object-Specific Cut Plane Overrides

� Example: Overriding the Cut Plane for a Wall

� Cut Planes from the Anchoring Object

� Example: Using the Cut Plane of the Anchoring Object

� Manual Cut Planes

Object-Specific Cut Plane Overrides
The following objects can have an object-specific cut plane: 

� Curtain Walls 
� Curtain Wall Units
� Door/Window Assembly
� Mass Elements
� Roof Slabs
� Slabs
� Stairs
� Walls

Example: Overriding the Cut Plane for a Wall
The object-specific cut plane is a part of the display properties of an object. 
You can set it for an individual object, an object style, or as the system 
default. 

For detailed information on display properties, see “Display Representations” 
on page 437 and “Creating a Display Representation for an Object” on 
page 463.

TIP If you want to create a clipped model view, as described in “Using the Glo-
bal Cut Plane: Creating a Clipped Model View” on page 370, or want to display 
the cut plane of a different level, as described in “Using the Global Cut Plane: 
Displaying the Cut Plane of a Different Level” on page 368, make sure to turn off 
the object specific-cut plane of the included objects. The object-specific cut 
plane overrides the global cut plane, and so you might get unexpected display 
results. 

The following example demonstrates how to set an object-specific cut plane 
for a wall style. The detailed steps for other objects may vary slightly. For 
more information, see the individual object chapters.

1 On the Format menu, click Style Manager. 

2 Expand Architectural Objects, and then expand Wall Styles. 
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3 Select the wall style for which you want to set an individual cut plane, 
right-click, and click Edit. 

4 Click the Display Properties tab.

5 Select a Plan or Reflected display representation. 

6 Click the Edit button.

7 Click the Cut Plane tab.

8 Select Override Display Configuration Cut Plane.

9 For Cut Plane Height, enter the desired cut plane. 

10 Click OK three times.

Cut Planes from the Anchoring Object
Objects like windows or doors usually are anchored into walls, curtain walls, 
and window assemblies. Normally, you want those anchored objects to have 
the same cut plane height as the object into which they are anchored. How-
ever, because the cut plane of the anchoring object can be set by either the 
display configuration or by the object itself, you need to determine in the 
anchored object whether it should use the cut plane of the display configu-
ration or of the object to which it is anchored. 

The following objects can derive their own cut plane from the cut plane of 
the object to which they are anchored:

� Curtain Wall Units
� Doors 
� Door/Window Assemblies
� Windows

Example: Using the Cut Plane of the Anchoring Object
Whether an anchored object uses the cut plane of its anchoring object or the 
cut plane of the display configuration is set in the display properties of the 
object. You can define this for an individual object, an object style, or as the 
system default. 

For detailed information about display properties, see “Display Representa-
tions” on page 437, and “Creating a Display Representation for an Object” 
on page 463.

The following example demonstrates how to set an anchored window to use 
the cut plane of the wall to which it is anchored. The detailed steps for other 
objects may vary slightly. For more information, see the individual object 
chapters. 

1 On the Format menu, click Style Manager. 
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2 Expand Architectural Objects, and then expand Window Styles. 

3 Select the window style for which you want to set the cut plane when 
anchored, right-click, and click Edit. 

4 Click the Display Properties tab.

5 Select a Plan or Reflected display representation. 

6 Click the Edit button. 

7 Click the Other tab.

8 Select Respect Cut Plane of Container Object When Anchored. 

NOTE You should use this setting as the default. Even when the cut plane 
of the anchoring object does not differ from the global cut plane, this setting 
ensures a correct display of the anchored object in Plan views. 

9 Click OK three times. 

Manual Cut Planes
You can define any number of manual cut planes for a wall or a curtain wall. 

The following illustration shows where manual cut planes might be defined 
in order to display a curtain wall sill at each level.

Manual cut planes are only displayed when they are inside the display range.

For information on setting the manual cut plane, see “Specifying the Cut 
Plane Display of a Wall” on page 1808 and “Creating Cut Planes for a Curtain 
Wall” on page 857.
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3D view of curtain wall showing global and manual cut planes at each level

Running Drawing Management from the 
Command Line

You can run certain Drawing Management commands from the command 
line. These commands are also available as toolbar buttons or shortcut menu 
commands. In some cases, for example when creating LISP routines, you 
might want to initiate them via the command line. 

Related Topics

� Command Line: Opening the Project Browser

� Command Line: Opening the Project Navigator

� Command Line: Refreshing the Project

� Command Line: Regenerating Views

� Command Line: Selecting a New Project Environment

� Command Line: Closing the Project Navigator
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Command Line: Opening the Project Browser

Use this procedure to open the Project Browser from the command line. 

� On the command line, enter AecProjectBrowser.

The Project Browser is displayed. 

NOTE Alternatively, you can click the  button on each of the Project Nav-
igator tabs. 

Command Line: Opening the Project Navigator

Use this procedure to open the Project Navigator palette from the command 
line. 

� On the command line, enter AecProjectNavigator.

The Project Navigator palette is displayed. 

NOTE Alternatively, you can click Project Navigator Palette on the Window 
menu. 

Command Line: Refreshing the Project

Use this procedure to refresh the project in the Project Navigator from the 
command line. 

� On the command line, enter AecRefreshProject.

The Project Navigator Palette is displayed, and all tabs are refreshed to dis-
play the current project state. 

NOTE Alternatively, you can click the  button on each of the Project Nav-
igator tabs. 

Command Line: Regenerating Views

Use this procedure to regenerate all views in the current project from the 
command line. When you regenerate a view, you reload all of the external 
references used to generate the view.
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� On the command line, enter AecRegenerateProjectViews.

All views in the current project are regenerated.

NOTE Alternatively, you can click the  button on the Views tab of the 
Project Navigator. 

Command Line: Selecting a New Project 
Environment

Use this procedure to select a new project environment from the command 
line. 

NOTE You can select only existing projects from the command line. To create 
a new project environment, go to the Project Browser and create a new project 
as described in “Selecting the Current Project” on page 229.

1 On the command line, enter AecSetCurrentProject, and press ENTER.

2 Enter the project you want to set current on the command line.

NOTE Alternatively, you can click the  button on each tab of the Project 
Navigator and set the new project in the Project Browser.

Command Line: Closing the Project Navigator

Use this procedure to close the Project Navigator from the command line. 

� On the command line, enter AecCloseProjectNavigator.

The Project Navigator Palette is closed.

NOTE Alternatively, you can click the  button of the Project Navigator Pal-
ette. 



380 | Chapter 5 Drawing Management

Frequently Asked Questions about Drawing 
Management

This topic contains questions and answers that can help you to achieve the 
results you need when working with Drawing Management. 

What do I have to consider when working with the XML files in the 
project?
The project data of a building model is contained in the APJ file, which con-
tains information about the overall project, and in the XML files accompa-
nying each DWG file. Both file types are well-formed XML. In most cases, 
you should not try to edit these files manually in an XML editor, as you 
might inadvertently corrupt the file. To make changes to your project, use 
the Project Browser and Project Navigator commands instead.

I have added a lot of project details in the Project Browser. Can I 
export these to another application? 
Yes. The project details you enter in the Project Browser are stored in the 
project’s APJ file, which is a well-formed XML file. If you want to export these 
details, create a copy of the APJ file, and export it to any XML application or 
database.

What should I do if my APJ file has been accidentally deleted or cor-
rupted?
Deleting or corrupting the project’s APJ files has no influence on the DWG 
files and XML files contained in the project. In the Project Browser, the 
project will not display anymore. To recreate the project with a new APJ file, 
go to the Project Browser, and create a new project of the same name in the 
same folder location as the previous APJ file. For instructions, see “Creating 
a New Project” on page 229. Then, go to the Project Navigator, and drag-and-
drop the Elements, Constructs, Views, and Sheets folders of the project from 
Internet Explorer into the corresponding tabs of the Project Navigator. For 
instructions, see “Creating a Category by Dragging a Folder from Internet 
Explorer to the Project Navigator” on page 264. This re-inserts the files into 
the project. 

What should I do if an XML file has been accidentally deleted or cor-
rupted?
Each DWG file within a project has an accompanying XML file that contains 
the project specific information. If the accompanying XML file is acciden-
tally deleted or corrupted, the DWG file is no longer recognized as part of the 
project and will not display in the Project Navigator. To insert it into the 
project again, you need to reconvert the DWG file into a project file. For 
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instructions, see “Converting a Legacy Drawing to a Construct” on page 276 
and “Converting a Legacy Drawing to an Element” on page 296.

Can I limit other users access to the project files?
You can limit other users ability to edit and delete project files by using the 
network permissions. You can limit the Delete rights for the entire project, so 
that users are not able to delete files from the project or move files around 
within the project. You might also consider just limiting the delete rights to 
the top project folder (containing the APJ file) and allow deleting in the sub-
folders.

How much additional file space will the project files need?
Working with a project does not require large additional amounts of file 
space on your computer or network folder. The XML files are less than 10K, 
most of them around 1-3K. The APJ file is slightly bigger, but in most cases 
won’t exceed 10K either. 

How can I best archive a project?
All of the project files are contained in a folder structure within the top 
project folder, which also contains the APJ file. To archive the project, just 
take the top project folder and move or copy it to the desired archive location 
on a folder, a CD, or streamer tape.

How would I best place Addenda, Alternates, or As-Builts within the 
project?
How you organize these items would largely depend on your internal pro-
cesses and workflow. One solution would be to draw the alternates as regular 
constructs and then create special views for them. 

If you want to present completely different plans/elevations to represent 
Alternates, you could use divisions to represent them; when generating the 
view, you just need to include the appropriate division into the view. 

In some cases you might also consider copying the project and putting the 
Alternates into the copied project. For instructions, see “Copying a Project” 
on page 234. If you copy a project, however, you have two different file sets 
to maintain; the copied project does not retain any links to the original one. 

How do I define the physical locations of elements and constructs in 
the building?
The location of a project file when referenced into another project file 
depends on the location in the original file. If you have drawn an element at 
0,0,0, then it is referenced at 0,0,0. When placing a construct into a view, the 
horizontal location is determined by the level the construct is on; when you 
have assigned a construct to the second level, it is inserted at the base eleva-
tion of the second level, for example 2.75 meters. 
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When referencing a project file into another project file, are base-
points other than 0,0,0 respected?
Yes. When referencing elements into constructs, and constructs into views, 
they are inserted at 0,0,0. A base point (INSBASE) other than 0,0,0 within the 
elements and constructs is respected.

Can I override the basepoints of project files when referencing them 
in other project files?
No. This is standard AutoCAD behavior.

Can I lock elements and constructs in their position to avoid acciden-
tally moving them?
Yes. If you want to lock an element or construct within the building model, 
lock the layer the element or construct has been inserted on. 

Is there an easy way to copy an element to multiple constructs at 
once?
Yes. Select the element in the Project Navigator, right-click, and click Attach 
Elements to Constructs. For detailed instructions, see “Referencing an Ele-
ment into Multiple Constructs” on page 284.

Is there an easy way to copy a construct to multiple levels at once?
Yes. There are two methods of achieving this, which are described in “Copy-
ing a Level with Assigned Constructs” on page 253 and “Copying Constructs 
to Levels” on page 275.

How do I move constructs from one level to another?
To move a construct to a different level, you need to change its level assign-
ment. Select the construct, right-click, and click Properties in the shortcut 
menu. Then, choose a different level in the Assignments matrix. For detailed 
instructions, see “Changing the Properties of a Construct” on page 286.

Will wall cleanups work across walls from different divisions?
Yes. Walls do cleanup across external references, such as divisions. You just 
need to make sure that the wall baselines are at the same elevation.

Will AEC dimensions work with objects from external references?
Yes. AEC dimensions are capable of dimensioning objects from external ref-
erences, even when they are nested. For detailed information, see “Dimen-
sioning a Project” on page 355.

Will schedule tags and property sets work with objects from external 
references?
Yes. Schedule tags and property set definitions are capable of annotating 
objects from external references, even when they are nested. For detailed 
information, see “Tagging a Project” on page 342 and “Property Set Data and 
Schedule Tables in Projects” on page 343.



Frequently Asked Questions about Drawing Management | 383

Is the Project Navigator MDI compliant?
No. During a session of Autodesk Architectural Desktop, only one project can 
be opened at a time. You can open files from different projects with the reg-
ular File ➤ Open command. You do not, however, see the associated 
project in the Project Navigator.
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Layer Management

Autodesk® Architectural Desktop adds layer 
standards, layer keying, and a layer manage-
ment interface—the Layer Manager—to the lay-

ering capabilities included in AutoCAD®. These 
additional features help you standardize, auto-
mate, and manage the use of layers in your 
office, in your projects, and in your drawings.

Layer Standards
Layer standards establish naming conventions 
for layers in your drawings. A layer standard 
contains a set of rules that determines the struc-
ture of the layer names in a drawing. When you 
install the software, you can select from a num-
ber of layer standards that you can use. You can 
change or edit each of the layer standards later, 
if needed.

Layer Keys and Layer Key Styles
Each layer standard has a corresponding layer 
key style. A layer key style contains a set of layer 
keys. The layer keys in the layer key style assign 
objects to predefined layers with names that 
conform to the layer standard. When you add 
an object, the object is automatically drawn on 
the layer assigned to it in the current layer key 
style. This process is called layer keying.

In this chapter

� Managing Drawing Layers

� Working with Layer Groups

� Working with Layer Snapshots

� Working with Layer Keys

� Creating and Editing Layer 
Standards

6
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Viewing the layer keys and layers in a layer key style

You can change any part of the layer name structure using layer key overrides 
within the layer key style. You can override the layer names for all the layer 
keys in a layer key style, or you can override individual layer key styles.

Layer Manager
You can access layer standards, layer key styles, and layer overrides, as well as 
other layering features, in the Layer Manager. The Layer Manager helps you 
organize, sort, and group layers, as well as save and coordinate layering 
schemes. In the Layer Manager you can:

� Change layer properties by clicking AutoCAD® layer property icons
� Make a layer the current layer
� Create, rename, and delete layers
� Work with layer standards and layer key styles
� Create layer groups and layer snapshots

When you display the Layer Manager, all the layers in the current drawing 
are displayed in the All layer group. If there are any external reference files 
linked to the drawing, the layers are listed in an XRef layer group.
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Viewing layers in the Layer Manager

Layer Groups
You can create additional layer groups to manage large sets of layers. You can 
specify the visibility of all the layers in the layer group by changing the layer 
group properties. The Layer Manager allows you to create two types of layer 
groups: user layer groups and filter layer groups. User groups can contain any 
layers that you put in them, while filter groups contain only layers that meet 
criteria that you specify.

Layer Snapshots
In addition to layer groups, the Layer Manager allows you to save layers and 
their settings as layer snapshots, similar to taking a picture of a layer set that 
you can restore and view later. By saving layer and view information in a 
snapshot, you can quickly recall specific layer and view configurations from 
complex data sets. For example, a facilities manager might create snapshots 
of individual floor plans and furniture, cable, and HVAC layouts to separate 
this information from a complete building layout.

Related Procedures

� Managing Drawing Layers

� Working with Layer Groups

� Working with Layer Snapshots

� Working with Layer Keys



388 | Chapter 6 Layer Management

� Creating and Editing Layer Standards

Managing Drawing Layers

The Layer Manager helps you organize, sort, and group layers, as well as save 
and coordinate layering schemes. You can also use layer standards with the 
Layer Manager to better organize the layers in multiple drawings.

When you open the Layer Manager, all the layers in the current drawing are 
displayed in the right pane. You can work with individual layers to:

� Change layer properties 
� Make a layer the current layer
� Create, rename, and delete layers

If you are working with drawings that contain large numbers of layers, you 
can improve the speed at which the Layer Manager loads layers when you 
open it by selecting Layer Manager/Optimize for Speed in the AEC Editor 
options. For more information, see “Changing the AEC Editor Settings” on 
page 388.

Related Procedures

� Changing the AEC Editor Settings

� Opening the Layer Manager

� Making a Layer Current

� Creating a Layer with a Layer Standard

� Creating a Nonstandard Layer

� Renaming a Layer

� Deleting a Layer

� Changing the Layer Standard of a Layer

� Editing the Description of a Layer

Changing the AEC Editor Settings

Use this procedure to optimize the speed of the Layer Manager. To speed 
drawing performance, you can improve the layer loading time of the Layer 
Manager.

NOTE When you optimize the speed for the Layer Manager, the layer icons 
that show if a layer is in use are turned off.
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1 On the Format menu, click Options.

2 Click the AEC Editor tab.

3 Under Optimize for Speed, select Layer Manager.

4 Click OK.

Opening the Layer Manager

Use this procedure to open the Layer Manager. When you open the Layer 
Manager, all the layers in the current drawing are displayed in the right pane 
of the Layer Manager and the layer groups are displayed in the left pane.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 To close the Layer Manager, click .

Making a Layer Current

Use this procedure to make a specific layer the current layer in the drawing. 
You must select an individual layer to make current. You cannot make mul-
tiple layers or layer groups current.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the right pane, double-click the layer that you want to make current.

You can also select the layer that you want to make current and click 

The selected layer is now the current layer and is marked with a green 
check in the Layer Manager. The layer name is displayed next to the Cur-
rent Layer button near the top of the Layer Manager. 

3 Click OK.

Creating a Layer with a Layer Standard

Use this procedure to create a layer that conforms to the layer standard. 

Autodesk® Architectural Desktop creates layers as needed according to the 
current layer standard. For example, when you add a wall to a drawing, the 
software creates the necessary wall layers if they do not yet exist.

If you need to create layers for a specific purpose, use the fields and values of 
the layer standard.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .
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3 Select the layer standard that you want to use for Layer Standard.

4 Specify the layer standard information. 

Depending on the layer standard you are using, different fields are avail-
able here. For example, if you are using the AIA 2nd Edition standard, you 
have fields for Discipline Designator, Major, Minor 1, Minor 2, and Status. 

To select a value for one of the available fields, click [ . . .], and select one 
of the values offered. 

You can also enter a new value, provided you follow the parameters spec-
ified for the layer standard components.

When you are finished, the Layer Name and Description fields display the 
combination of values you have selected. If you have, for example, created 
a new layer for wall dimensions according to the AIA 2nd Edition layer 
standard, it is named A-Anno-Dims.

NOTE If the name of the new layer is the same as an existing layer in the 
current layer key style, the properties of the new layer are automatically 
updated with the properties of the existing layer.

5 Select Make Current if you want to make the layer the current layer.

6 Select a color for the layer from the list. 

If the desired color is not available on the list, select Select Color, and 
select a color from the Color Picker. 

7 Select a linetype.

If the desired linetype is not available on the list, select Other, and select 
a linetype from the Select Linetype dialog box.

8 Select a lineweight.

9 Clear Plot if you do not want the new layer to be plotted.

10 Click OK twice.

Creating a Nonstandard Layer

Use this procedure to create a nonstandard layer. A nonstandard layer is a 
layer that does not need to conform to the naming and content standard of 
any layer standard. You might want to use nonstandard layers for elements 
like architect’s comments or construction lines, blocks you do not want to 
insert on their original layer, or walls that you want to display partially.

1 On the Format menu, click Layer Management ➤ Layer Manager.
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2 Click .

3 Select Non Standard for Layer Standard.

4 Enter a name for the new layer.

5 Select Make Current if you want to make the layer the current layer.

6 Enter a description for the new layer.

7 Select a color for the layer from the list. 

If the desired color is not available on the list, select Select Color, and 
select a color from the Color Picker. 

8 Select a linetype.

If the desired linetype is not available on the list, select Other, and select 
a linetype from the Select Linetype dialog box.

9 Select a lineweight.

10 Clear Plot if you do not want the new layer to be plotted.

11 When you finish specifying the properties of the layer, click OK twice.

Renaming a Layer

Use this procedure to specify a new name for a layer.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Right-click the layer that you want to rename, and click Rename Layer.

3 Enter a new name for the layer, and press ENTER.

4 Click OK.

Deleting a Layer

Use this procedure to delete a layer from a drawing.

Keep the following points in mind when you delete layers:

� If you try to delete a layer that still has objects on it, you receive an error 
message. To delete this layer, you must first erase all objects on it in the 
drawing.

� If the layer you try to delete is the current layer, Delete is unavailable on 
the shortcut menu. To delete this layer, make another layer current and 
then delete the layer.

� Some layers may be assigned to the components of another object, or even 
to other object styles. These layers cannot be deleted.
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1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Right-click the layer that you want to delete, and click Delete.

The layer you have deleted is marked with a red “X.” It is permanently 
deleted when you click Apply or OK.

NOTE If Apply Changes Immediately is selected, the layer is automatically 
deleted.

3 Click OK.

Changing the Layer Standard of a Layer

Use this procedure to assign a specific layer to a different layer standard.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Right-click the layer that you want to change, and click Change Layer 
Standard.

3 Select the layer standard that you want to use for Layer Standard.

The layer you selected is now assigned to the specified layer standard.

NOTE If a layer standard is unavailable on the shortcut menu, the layer that 
you selected is not valid for that standard.

4 Click OK.

Editing the Description of a Layer

Use this procedure to change the description of a layer.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Right-click the layer that you want to change, and click Change Descrip-
tion.

3 Enter a new description for the layer, and press ENTER.

4 Click OK.

Working with Layer Groups

With the Layer Manager, you can create groups of layers to produce working 
views and backgrounds from large building data sets. Layer groups help you 
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work more efficiently in drawings that have many layers. You can change the 
settings of a layer group to apply the changes to all layers in the group at one 
time. For example, you can lock a layer group to lock all the layers in the 
group. 

Types of Layer Groups
There are four types of layer groups:

Rules for Layer Groups
The following group rules apply when you are creating and working with 
layer groups:

� You can list a layer in more than one layer group.
� Multiple listings of the same layer must always have identical property 

settings. For example, a layer that is a member of two groups cannot be a 
different color in each group.

� You cannot list a layer twice in a group.
� You can delete layer groups without affecting the layers in the group.
� Changing one of the properties of a layer group changes that property for 

all the layers in that group, except where the change would be invalid. For 
example, it is not possible to freeze the current layer.

� Layer group names need not be unique.
� There is no naming convention for layer groups. Group names can 

include spaces, nonalphanumeric characters, and both uppercase and 
lowercase letters.

� Xref layer groups cannot contain other filter groups.

Managing Layer Groups
You can add and subtract layers from layer groups. You can change the stan-

dard AutoCAD® properties for the layers in groups, rename layer groups, 
delete layer groups, and change the filters in filter groups.

Type Description

All Is always present and lists all the layers and other layer groups in 
the drawing.

Xref Lists any layers in external reference files linked with the current 
drawing. This group is automatically created when you xref a 
drawing into the current drawing.

User groups Contain layers that you have assigned to them.

Filter groups Contain layers based on a filter that you specify for the group. You 
can base filters on layer names and other layer properties.
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Related Topics and Procedures

� User Groups and Filter Groups

� Creating a User Group

� Creating a Filter Group

� Adding Layers to Layer Groups

� Changing the Properties of a Layer Group

� Renaming and Deleting Layer Groups

User Groups and Filter Groups

With the Layer Manager, you can create two types of layer groups: user 
groups and filter groups. 

User-defined groups can contain any layers in the current drawing. You can 
manually add layers to, and remove layers from, user groups by dragging 
layers within the Layer Manager into the user group or by selecting an object 
in the drawing on the layer that you want to add to the user group.

A filter group contains layers that meet filter criteria that you specify for the 
group. Filter criteria can select layers according to layer states (on/off, frozen/
thawed, locked/unlocked), properties, or names. For example, you can create 
a filter group that includes all of the red layers in the current drawing.

Filter groups can be either dynamic or static: 

� Dynamic filter groups are automatically updated when you change the 
properties of layers that are part of the group. Dynamic filter groups are 
also updated when you add or modify layers that meet the criteria speci-
fied in the filter. You cannot manually add layers to, or remove layers from 
dynamic filter groups.

� Static filter groups are not automatically updated; they include only the 
layers that met the filter criteria when the group was created. You can 
manually add layers to, and remove layers from, static filter groups.

The layer groups named Xrefs and All are created automatically.

Creating a User Group

Use this procedure to create a user group. User groups can contain any layers 
in the current drawing. You can manually add layers to, and remove layers 
from, user groups by dragging layers within the Layer Manager into the user 
group or by selecting an object in the drawing on the layer that you want to 
add to the user group.
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1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the left pane of the Layer Manager, select a layer group that you want 
to create the new group under, right-click, and click New Group ➤ User, 

or click  in the Layer Manager.

3 Enter a name for the new user group, and press ENTER.

4 Edit the new user group:

5 Click OK.

Creating a Filter Group

A filter group contains layers that meet filter criteria that you specify for the 
group. Filter criteria can select layers according to layer states (on/off, frozen/
thawed, locked/unlocked), properties, or names. For example, you can create 
a filter group that includes all of the red layers in the current drawing.

You can create two types of filter layer groups:

� Dynamic filter groups automatically update when you change the proper-
ties of layers that are part of the group. You cannot manually add layers or 
remove layers.

� Static filter groups do not automatically update, and include only the lay-
ers that met the filter criteria when the group was created. You can man-
ually add layers and remove layers.

Related Topics and Procedures

� Creating Filter Groups

� Specifying a Filter for Layer State

� Specifying a Filter for Layer Color

� Specifying a Filter for Layer Linetype

� Specifying a Filter for Layer Standard

� Specifying a Filter for Layer Name

If you want to . . . Then . . .

add layers to the user 
group

see “Adding Layers to Layer Groups” on page 402.

specify properties for the 
user group

see “Changing the Properties of a Layer Group” on 
page 403.
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Creating Filter Groups
Use this procedure to create filter groups, either dynamic or static. You can 
specify more than one filter for a group. For example, you can filter by layer 
name and status to group all frozen walls layers.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the left pane of the Layer Manager, select a layer group that you want 
to create the new group under, right-click, and click New 
Group ➤ Filter.

3 Enter a name for Filter Name.

4 Specify the type of filter group:

5 Specify the filter criteria:

6 Click OK twice.

Specifying a Filter for Layer State
Use this procedure to specify a filter that includes layers based on the follow-
ing layer states:

If you want to . . . Then . . .

specify a filter group that updates when you change 
the properties of layers in the group

select Dynamic.

specify a filter group that does not automatically 
update

select Static.

If you want to . . . Then . . .

filter layers by visibility state see “Specifying a Filter for Layer State” 
on page 396.

filter layers by layer color see “Specifying a Filter for Layer Color” 
on page 398.

filter layers by layer linetype see “Specifying a Filter for Layer 
Linetype” on page 399.

filter layers by layer standard see “Specifying a Filter for Layer 
Standard” on page 400.

filter layers by wildcard characters see “Specifying a Filter for Layer 
Name” on page 401.
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� On/off
� Frozen/thawed
� Locked/unlocked
� New viewport frozen/thawed
� In use/unused

A layer must meet all the specified filter criteria to be included. For example, 
if you select Off and Frozen for the filter, a layer that is turned off but is not 
frozen will not be included in the group. The default setting for all options 
on the States tab is Both.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the left pane of the Layer Manager, select a layer group that you want 
to create the new group under, right-click, and click New 
Group ➤ Filter.

3 Enter a name for Filter Name.

4 Click the States tab.

5 Clear Ignore This Filter.

6 Specify the On/Off layer state criteria for the filter:

7 Specify the Freeze/Thaw layer state criteria for the filter:

If you want to . . . Then . . .

include all the layers in the drawing 
that are turned on

select On.

include all the layers in the drawing 
that are turned off

select Off.

select layers that are turned on and 
layers that are turned off

select Both.

If you want to . . . Then . . .

include all the layers in the drawing 
that are thawed

select Thawed.

include all the layers in the drawing 
that are frozen

select Frozen.

select layers that are thawed and layers 
that are frozen

select Both.
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8 Specify the Locked/Unlocked layer state criteria for the filter:

9 Specify the Viewport Thawed/Frozen layer state criteria for the filter:

10 Specify the In use/Unused layer state criteria for the filter:

11 Click OK.

Specifying a Filter for Layer Color
Use this procedure to specify a filter that includes layers based on layer col-
ors. 

If you want to . . . Then . . .

include all the layers in the drawing 
that are unlocked

select Unlocked.

include all the layers in the drawing 
that are locked

select Locked.

select layers that are unlocked and 
layers that are locked

select Both.

If you want to . . . Then . . .

include all the layers in the drawing 
that are thawed in a new viewport

select New VP Thawed.

include all the layers in the drawing 
that are frozen in a new viewport

select New VP Frozen.

select layers that are thawed and layers 
that are frozen in a new viewport

select Both.

If you want to . . . Then . . .

include all the layers in the drawing 
that are in use

select In Use.

include all the layers in the drawing 
that are unused

select Unused.

select layers that are used and layers 
that are unused

select Both.
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1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the left pane of the Layer Manager, select a layer group that you want 
to create the new group under, right-click, and click New 
Group ➤ Filter.

3 Enter a name for Filter Name.

4 Click the Colors tab.

5 Clear Ignore This Filter.

6 Add or remove layer colors in the filter:

7 Click OK.

Specifying a Filter for Layer Linetype
Use this procedure to specify a filter that includes layers based on linetype. 

1 On the Format menu, click Layer Management ➤ Layer Manager.

If you want to . . . Then . . .

add an individual color to the filter select the color for Available Color(s), 
and click Add.

The color you selected is moved from 
Available Color(s) to Selected Color(s).

remove an individual color from the 
filter

select the color for Selected Color(s), 
and click Remove.

The color that you selected is moved 
from Selected Color(s) to Available 
Color(s).

add all of the colors from the 
Autodesk® Architectural Desktop color 
palette to the color filter

click Add All.

All of the colors available in the 
software are moved to Selected 
Color(s).

remove all of the layer colors in the 
color filter

click Remove All.

The colors for Selected Color(s) are 
moved to Available Color(s).

add a new color to the filter from the 
full color palette

click Choose Color, select a color, and 
click OK.
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2 In the left pane of the Layer Manager, select a layer group that you want 
to create the new group under, right-click, and click New 
Group ➤ Filter.

3 Enter a name for Filter Name.

4 Click the Linetypes tab.

5 Clear Ignore This Filter.

6 Add linetypes to the filter:

7 Click OK.

Specifying a Filter for Layer Standard
Use this procedure to specify a filter that includes layers based on layer stan-
dards and layer standard categories. 

The categories available are the categories that are included in the layer stan-
dard. When you add categories to the Selected Categories list, the order in 
which you add them affects the hierarchical structure of the generated layer 
groups. For example, if you select the AIA 2nd Edition layer standard, you 
can add Discipline Designator followed by Major to create a two-tier hierar-
chy with architectural layers separated from facilities management layers. 

1 On the Format menu, click Layer Management ➤ Layer Manager.

If you want to . . . Then . . .

add an individual linetype to the filter select the linetype for Available for 
Filtering, and click Add.
The linetype you selected is moved 
from Available for Filtering to Already 
in Filter.

remove an individual linetype from the 
filter

select the linetype for Already in Filter, 
and click Remove.
The linetype that you selected is 
moved from Already in Filter to 
Available for Filtering.

add all of the available linetypes to the 
filter

click Add All.
All of the available linetypes are moved 
from Available for Filtering to Already 
in Filter.

remove all of the linetypes in the filter click Remove All.
The linetypes for Already in Filter are 
moved to Available for Filtering.
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2 In the left pane of the Layer Manager, select a layer group that you want 
to create the new group under, right-click, and click New 
Group ➤ Filter.

3 Enter a name for Filter Name.

4 Click the Standards tab.

5 Clear Ignore This Filter.

6 Specify the layer standard filter criteria:

7 If you selected a layer standard, use Add and Remove to transfer layer stan-
dard categories to and from Available Categories and Selected Categories. 

8 Click OK.

Specifying a Filter for Layer Name
Use this procedure to specify a filter that includes layers based on wildcard 
strings in a layer name. The wildcard string is not case sensitive.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the left pane of the Layer Manager, select a layer group, right-click, and 
click New Group ➤ Filter.

3 Enter a name for Filter Name.

4 Click the Wildcards tab.

5 Clear Ignore This Filter.

6 Specify the wildcard filter criteria:

If you want to . . . Then . . .

filter for layer categories that are not in 
a layer standard

select Non Standard for Layering 
Standard.

filter for layers that are in a layer 
standard

select the layer standard for Layering 
Standard.

If you want to . . . Then . . .

include in the filter all layers that 
contain a particular string

select Wildcard Layer Names Must 
Match, and enter a wildcard string and 
an asterisk (*).

exclude from the filter all layers that 
contain a particular string

click Wildcard Layer Names Must Not 
Match, and enter a wildcard string and 
an asterisk (*).
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For more information about working with wildcards, see “Filter Selection 
Sets” in the online AutoCAD 2004 User’s Guide.

7 Click OK.

Adding Layers to Layer Groups

Use this procedure to add layers to a layer group. You can manually add layers 
to a user group or to a static filter group. You can either drag them from the 
list of layers in the right pane of the Layer Manager to the group in the left 
pane or add the layer to the group by selecting an object in the current draw-
ing that is on the layer that you want to add.

You can also replace all layers in an existing group by selecting objects in the 
current drawing that are on the layers that you want to use as replacements 
for the existing layers. 

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Add layers to a layer group:

3 Click OK.

If you want to . . . Then . . .

add layers to a layer group by 
dragging

in the left pane of the Layer Manager, 
select the All layer group. In the right 
pane of the Layer Manager, drag a 
layer to the user layer group or static 
filter group in the left pane.

add layers to a layer group by selecting 
drawing objects

select the layer group, right-click, and 
click Select Layers ➤ Add. In the 
current drawing, select an object on 
each layer that you want to add to the 
group. Press ENTER to return to the 
Layer Manager.

replace layers from groups by selecting 
drawing objects

select the layer group whose layers you 
want to replace, right-click, and click 
Select Layers ➤ Replace. Select an 
object on each layer that you want to 
replace the layers in the group. Press 
ENTER to return to the Layer Manager.
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Changing the Properties of a Layer Group

Use this procedure to change the properties of all layers in a layer group. If a 
layer is in more than one group, the changes apply to that layer in all groups 
in which it is included. For example, if you freeze a group that includes the 
layer A-Wall, that layer is frozen in any other group in which A-Wall appears.

NOTE Because you cannot freeze the current layer, you do not have the 
option to freeze a group in the active viewport if the current layer is included in 
the group. You also cannot freeze the active viewport on the Model layout tab.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click the layer group whose properties you want to change, and specify 
properties:

If you want to . . . Then . . .

specify whether the group is locked right-click, click Lock, and click Lock 
On or Lock Off.

specify whether the group is frozen right-click, click Freeze/Thaw, and click 
Freeze or Thaw.

specify whether to freeze all the layers 
in the group only in the active 
viewport

right-click, click Viewport, and click 
Freeze or Thaw.

specify the visibility of the group right-click, click Visibility, and click On 
or Off.

freeze all layers in the drawing except 
those in the selected layer group

right-click, click Isolate Group, and 
click All Viewports or Active Viewport 
Only.

specify the color for all layers in the 
group

select All in the left pane, and click the 
color value for the group in the right 
pane. Select a color, and click OK.

specify the linetype for all layers in the 
group

select All in the left pane, and click the 
linetype value for the group in the 
right pane. Select a linetype, and click 
OK.

specify the lineweight for all layers in 
the group

select All in the left pane, and click the 
lineweight value for the group in the 
right pane. Select a lineweight, and 
click OK.
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3 Click OK.

Renaming and Deleting Layer Groups

Use this procedure to rename or delete layer groups. The layer group is 
deleted from the Layer Manager, but the layers listed in the group are not 
deleted.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Rename or delete a layer group:

3 Click OK.

Working with Layer Snapshots

A layer snapshot is a specific set of layers and view information that you can 
save, edit, and restore in your drawing. By saving layer and view information 
in a snapshot, you can quickly recall specific layer and view configurations 
from complex data sets. For example, a facilities manager might create snap-
shots of individual floor plans and furniture, cable, and HVAC layouts to sep-
arate this information from a complete building layout. 

You can create and name any number of layer snapshots. You can add and 
delete individual layers in a snapshot. You can edit, delete, and import and 
export the snapshot. Import snapshots into new drawings to automatically 
specify a layering scheme in your drawing. 

NOTE If you are sharing drawing files with other non-Architectural Desktop 
products that are using object enablers and want to create layer snapshots, cre-

ate layer snapshots using the AutoCAD® Layer States Manager to create LAS files 
by entering -layer. For more information, see “Layer States Manager” in the 
online AutoCAD 2004 Command Reference.

If you want to . . . Then . . .

rename the layer group right-click the layer group, and click Rename Group. 
Enter a new name, and press ENTER.

delete the layer group right-click the layer group, and click Delete Group.
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Related Procedures

� Creating a Layer Snapshot

� Editing a Layer Snapshot

� Restoring a Layer Snapshot

� Deleting a Layer Snapshot

� Exporting a Layer Snapshot

� Importing a Layer Snapshot

Creating a Layer Snapshot

Use this procedure to create snapshots of all the layers in the current drawing 
or the layers in a particular layer group:

� Create a snapshot of all the layers in a drawing when you want to restore 
or export an entire layering scheme.

� Create a snapshot of a particular layer group to store specific layering 
information.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 In the left pane of the Layer Manager, click All.

3 Create a snapshot:

4 Click OK.

Editing a Layer Snapshot

Use this procedure to edit a layer snapshot. You can edit a snapshot in several 
ways:

� adding layers
� removing layers
� modifying layer properties

If you want to . . . Then . . .

create a snapshot of all 
drawing layers click , and click New. Enter a name for the 

snapshot, and click OK twice.

create a snapshot of a 
layer group

right-click the layer group, and click Save as 
Snapshot. Enter a name for the snapshot, and click 
OK.
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1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the snapshot that you want to edit, and click Edit.

4 Edit the selected snapshot:

5 When you finish editing the layer snapshot, click OK twice.

Restoring a Layer Snapshot

Use this procedure to restore a layer snapshot. When you restore a snapshot, 
the layers in the drawing display with the settings as they are defined in the 
snapshot.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the layer snapshot that you want to restore, and click Restore.

4 Click OK twice.

Deleting a Layer Snapshot

Use this procedure to delete a layer snapshot. When you delete a snapshot, 
you do not delete the layers from the drawing. You delete only the snapshot 
of the layers.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the snapshot that you want to delete, and click Delete.

4 Click OK twice.

If you want to . . . Then . . .

add layers from the drawing to the 
snapshot

click Add, select the layer that you 
want to add, and click OK.

delete a layer from a snapshot select the layer that you want to 
delete, and click Delete.

edit the standard AutoCAD® layer 
properties of the individual layers in 
the snapshot

click the property icons or descriptions.
This affects only the snapshot. The 
layers in the drawing are not affected 
until you restore the snapshot.



Working with Layer Snapshots | 407

Exporting a Layer Snapshot

Use this procedure to export a layer snapshot so that the snapshot is available 
to import in other drawings. You can export snapshots with the following file 
extensions:

� SSL: Layer Manager Snapshot Format. Saves a layer properties, descrip-
tion, and linetype file.

� LAY: Bonus Layer Format. Compatible with the AutoCAD® Express Tools 
utility for saving layer snapshots. The layer description and linetype file 
are not saved with the snapshot.

� CSV: Comma-Delimited Format. An ASCII file that you can read or edit in 
a standard word processor.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the snapshot that you want to export, and click Export.

4 Enter a name for the new snapshot file.

5 Navigate to the folder where you want to save the layer snapshot.

6 Select a file format for Save as type.

7 Click Save, and click OK twice. 

Importing a Layer Snapshot

Use this procedure to import a layer snapshot into a drawing. A snapshot 
must first be exported from one drawing before it can be imported into 
another. For more information, see “Exporting a Layer Snapshot” on 
page 407.

You must be in the destination drawing when you open the Layer Manager 
to import from the source drawing.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Click Import.

4 Select the snapshot that you want to import, and click Open.

5 Click Yes to restore the settings.

This makes the snapshot settings active in the drawing.

6 Click OK twice.
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Working with Layer Keys

A layer key maps an object that you draw to a defined layer. Layer keys also 
specify the default properties of each layer. 

Layer Keys and Layer Keying
When you create an object, the layer key that is associated with the object 
automatically places that object on the layer to which it is mapped. Using 
layer keys to automatically place objects on predefined layers is called layer 
keying. Usually, you key objects to layers that conform to a layer standard. 
Each layer standard names layers according to a set of rules that you can 
modify. For more information, see “Creating and Editing Layer Standards” 
on page 421.

Layer Key Styles
You can create different sets of layer keys, called layer key styles, that you can 
use to place objects on defined layers in your drawings. Each layer key style 
contains a set of layer keys. Both the AIA and BS1192 layer key styles contain 
layer keys and layer properties, including layer name, description, color, line-
type, lineweight, plot style, and plot settings for all of the AEC objects. You 
can import the AIA and BS1192 layer standards and layer key styles that are 

provided with Autodesk® Architectural Desktop from the AecLayerStd.dwg in 
the \Documents and Settings\All Users\Application Data\Autodesk\Autodesk 
Architectural Desktop 2004\R16.0\Layers folder. If you are running Windows 

NT®, the drawing file is located in the \winnt\Profiles\All Users\Application 
Data\Autodesk Architectural Desktop 2004\R16.0\Layers folder. You can mod-
ify these styles, if needed, or create new layer key styles. You can also create 
layer key styles from LY files.

Properties of Layer Key Styles
You can add and remove layer keys from layer key styles. Default layer keys 
cannot be removed. The properties of any layer in an existing layer key style 
can also be edited. You can change the layer name, description, color, line-
type, lineweight, plot style, and plot settings for the layer that each layer key 
maps to. If the layer key style is based on a layer standard, you can use over-
rides on all or some of the layer keys within the layer key style. For more 
information about overrides, see “Layer Key Overrides” on page 418.

NOTE The default Standard layer key style is not based on a layer standard. It 
contains the default set of layer keys. 
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LY Files and Layer Key Styles
If you have LY files from S8 or Release 1 of Autodesk® Architectural Desktop 
that you want to use, you can create a new layer key style from an LY file. For 
more information see, “Creating a Layer Key Style from an LY File” on 
page 415.

Overrides to Layer Key Styles
Whether you create an original layer key style or one from an existing LY file, 
if you want to use overrides, you must base the layer key style on a layer stan-
dard in the current drawing. If you create a nonstandard layer key style, the 
Overrides On/Off command is unavailable. If you copy a layer key style, you 
can use layer key overrides only if the layer key style that you copied is based 
on a layer standard. For more information about using layer key overrides, 
see “Layer Key Overrides” on page 418.

Managing Layer Key Styles
To create, edit, copy, or purge layer key styles, you access the Style Manager. 

The Style Manager provides a central location in Autodesk® Architectural 
Desktop, where you can work with styles from multiple drawings and 
templates. For more information about using the Style Manager, see “Style 
Manager”.

Related Procedures

� Default Layer Keys

� Default Layer Key Values

� Creating a Layer Key Style

� Creating a Layer Key Style from an LY File

� Editing Layer Key Styles

� Attaching Notes and Files to a Layer Key Style

� Layer Key Overrides

Default Layer Keys

Autodesk® Architectural Desktop uses the following default layer keys when 
you create AEC objects.

Default layer keys for creating AEC objects

Layer Key Description

ANNDTOBJ Detail marks
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ANNELOBJ Elevation objects

ANNOBJ Notes, leaders, etc.

ANNREV Revisions

ANNSXKEY Section marks

ANNSXOBJ Section marks 

ANNSYMOBJ Annotation marks

APPL Appliances

AREA Areas

AREAGRP Area Groups

AREAGRPNO Area Group Numbers

AREANO Area Numbers

CAMERA Cameras

CASE Casework

CASENO Casework tags

CEILGRID Ceiling grids

CEILOBJ Ceiling objects

CHASE Chases

COLUMN Columns

COMMUN Communication

CONTROL Control systems

CWLAYOUT Curtain walls

CWUNIT Curtain wall units

DIMLINE Dimensions

DIMMAN Dimensions (AutoCAD points)

Default layer keys for creating AEC objects
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DOOR Doors

DOORNO Door tags

DRAINAGE Drainage

ELEC Electric

ELECNO Electrical tags

ELEV Elevations

ELEVAT Elevators

ELEVHIDE Elevations (2D)

EQUIP Equipment

EQUIPNO Equipment tags

FINCEIL Ceiling tags

FINFLOOR Finish tags

FIRE Fire system equipment

FURN Furniture

FURNNO Furniture tags

GRIDBUB Plan grid bubbles

GRIDLINE Column grids

LAYGRID Layout grids

LIGHTCLG Ceiling lighting

LIGHTW Wall lighting

MASSELEM Massing elements

MASSGRPS Massing groups

MASSSLCE Massing slices

OPENING Wall openings

Default layer keys for creating AEC objects
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PEOPLE People

PFIXT Plumbing fixtures

PLANTS Plants - outdoor

PLANTSI Plants - indoor

POLYGON AEC Polygons

POWER Electrical power

PRK-SYM Parking symbols

ROOF Rooflines

ROOFSLAB Roof slabs

ROOMNO Room tags

SCHEDOBJ Schedule tables

SEATNO Seating tags

SECT Miscellaneous sections

SECTHIDE Sections (2D)

SITE Site

SLAB Slabs

SPACEBDRY Space boundaries

SPACEOBJ Space objects

STAIR Stairs

STAIRH Stair handrails

STRUCTBEAM Structural beams

STRUCTBEAMIDEN Structural beam tags

STRUCTBRACE Structural braces

STRUCTBRACEIDEN Structural brace tags

Default layer keys for creating AEC objects
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Default Layer Key Values

The following default values are assigned to new layer keys.

STRUCTCOLS Structural columns

STRUCTCOLSIDEN Structural column tags

SWITCH Electrical switches

TITTEXT Border and title block

TOILACC Architectural specialties

TOILNO Toilet tags

UTIL Site utilities

VEHICLES Vehicles

WALL Walls

WALLFIRE Fire wall patterning

WALLNO Wall tags

WIND Windows

WINDASSEM Window assemblies

WINDNO Window tags

Default values for layer keys

Layer name Same as layer key name. Assigned to 
appropriate layer root name.

Description Blank 

Color 7 (white/black)

Linetype Continuous

Lineweight Default

Plot style Normal 

Default layer keys for creating AEC objects



414 | Chapter 6 Layer Management

Creating a Layer Key Style

Use this procedure to create a layer key style. You can create a layer key style 
by using default style properties or by copying an existing style. After you cre-
ate the style, you edit the style properties to customize the characteristics of 
the style.

If you want to use layer key overrides, you must base the layer key style you 
create on a layer standard in the current drawing. If you create a nonstandard 
layer key style, you cannot attach layer key overrides to that layer key style.

1 On the Format menu, click Layer Management ➤ Layer Key Styles, or 

in the Layer Manager, click .

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Create a new layer key style:

3 Right-click the new layer key style and click Rename. 

4 Enter a name for the new layer key style, and press ENTER.

5 To edit the new layer key style, right-click the style, and click Edit:

Plot Yes

If you want to . . . Then . . .

create a style with 
default properties

right-click Layer Key Styles, and click New.

create a style from an 
existing style

right-click the layer key style you want to copy, and 
click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

specify properties for 
layer keys

see “Editing Layer Key Styles” on page 415.

add notes and files to 
the style

see “Attaching Notes and Files to a Layer Key Style” 
on page 417.

Default values for layer keys
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6 When you finish specifying the properties of the layer key style, click OK 
twice.

Creating a Layer Key Style from an LY File

Use this procedure to create a new layer key style from an existing LY file 

from S8 or Release 1 of Autodesk® Architectural Desktop. If the LY file that 
you are using does not contain the default layer keys required by the soft-
ware, they are added to the new layer key style by default and mapped to 
default layers based on the key name. For example, the layer key ANNOBJ 
maps to the layer ANNOBJ. 

If you want to use layer key overrides, you must base the new layer key style 
on a layer standard. If you create a nonstandard layer key style, you cannot 
attach layer key overrides to that layer key style. When you create an original 
layer key style from an existing LY file, you can choose which sections of the 
LY file you want to include in your layer key style.

You must first import an existing LY file.

1 On the command line, enter -AECLYImport.

2 Enter the file name to import, or enter ? and browse for a file.

3 Select a file, and click Open.

4 Enter the name for the new layer key style.

5 Select the sections of the LY file you want to include in the new layer key 
style.

6 Click OK.

A new layer key style is created. It is not associated with a layer standard until 
you assign the new layer key style to a layer standard. For more information 
about changing style properties, see “Editing Layer Key Styles” on page 415. 

Editing Layer Key Styles

Use this procedure to edit a layer key style.

� You can change the layer standard that a layer key style is based on, or you 
can specify a layer standard for a nonstandard layer key style.

� You can add layer keys to the layer key style.
� You can remove any layer keys except the default layer keys.
� You can edit the layer properties of the layers to which the layer keys map.
� You can specify whether layer key overrides can be used with the layer key 

style.
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1 On the Format menu, click Layer Management ➤ Layer Key Styles, or 

in the Layer Manager, click .

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Right-click the layer key style that you want to change, and click Edit.

3 Click the Keys tab.

4 Specify the layer standard:

NOTE You can base more than one layer key style on the same layer stan-
dard so that each layer key style can be used with different color, linetype, 
and override settings.

5 To add a new layer key, click Add. 

New keys are added with default values.

6 To delete a layer key, select a layer key, and click Remove. 

You cannot delete the default layer keys.

TIP To change the properties of more than one layer key at a time, hold 
down CTRL and select the additional layer keys. 

7 Select a layer key, and specify the layer key properties:

If you want to . . . Then . . .

specify a different layer standard on 
which to base the layer key style

select a new layer standard for 
Standard.

specify that the layer key style is not 
based on a layer standard

select Non Standard for Standard.

If you want to . . . Then . . .

modify the description for a layer key double-click the text that you want to 
change for Description, and enter new 
text.

modify the layer name under Layer, click the [...] button. 
Specify the appropriate values for layer 
fields, and click OK.
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8 Click OK twice.

Attaching Notes and Files to a Layer Key Style

Use this procedure to enter notes and attach reference files to a layer key 
style. You can also edit notes and edit or detach reference files from a layer 
key style.

1 On the Format menu, click Layer Management ➤ Layer Key Styles, or 

in the Layer Manager, click .

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Right-click the layer key style that you want to change, and click Edit.

3 Click the General tab.

4 To add a description to the layer key style, enter it for Description.

5 Click Notes.

6 To add a note, click the Notes tab, and enter the note.

7 Click the Reference Docs tab, and attach, edit, or detach a reference file:

modify the color for a layer key under Color, click the current value. 
Select a new color, and click OK.

modify the linetype for a layer key under Linetype, click the current value. 
Select a new linetype, and click OK.

modify the lineweight for a layer key under Lineweight, click the current 
value. Select a new lineweight, and 
click OK.

specify whether a layer key will plot under Plot, click the printer icon to 
turn plotting on or off.

specify whether to allow layer field 
overrides

under Allow Overrides, clear the 
options for which overrides are not 
allowed.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

If you want to . . . Then . . .
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8 Click OK three times.

Layer Key Overrides

A layer key override enables you to change the default layer names specified 
by one or more layer keys. The structure of layer names is determined by the 
descriptive fields in the layer standard definition. You can allow overrides on 
all the layer keys within a layer key style, or you can select individual layer 
keys that you want to override. You can override all descriptive fields that 
make up the layer name, or you can specify which descriptive fields to over-
ride. You can apply overrides to any layer keys in a layer key style that is 
based on a layer standard.

For example, in the AIA 2nd Edition layer standard definition, the Discipline 
Designator field assigns a description and the Major field assigns a name by 
default. By using layer key overrides, you can change the values specified in 
these fields and add values in the unused fields, Minor Code and Status.

The information that you enter to create layer key overrides must conform 
to the field width and value types specified by the layer standard definition. 
For example, you cannot specify a four-letter override in the Discipline Des-
ignator field in the AIA 2nd Edition Layer Standard, because the maximum 
width for the Discipline Designator field as specified in the AIA layer stan-
dard definition is 1. To modify the descriptive fields, you must edit the layer 
standard definition. For more information, see “Creating and Editing Layer 
Standards” on page 421.

After you add overrides to a layer key style, you can turn the overrides on and 
off in your current drawing. When the layer key overrides are on, objects that 
you create are placed on layers defined by the layer standard definitions and 
overridden with the values that you specify. When the layer key overrides are 
off, objects that you create are placed on the layers defined only by the layer 
keys. You can start using the layer key overrides immediately after you spec-
ify them, or you can use the Overrides On/Off command to switch them on 
later.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .
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Layer key overrides do not change the layer assignments of existing objects. 
Only objects added after an override is enabled are affected by the override.

Related Topics and Procedures

� Specifying Layer Key Overrides

� Turning Layer Key Overrides On and Off

� Remapping Objects to Different Layers

� Restoring Objects to Default Layer Key Layers

Specifying Layer Key Overrides
Use this procedure to specify layer key overrides. The layer key overrides that 
you specify apply only to the layer keys that have any or all descriptive field 
overrides selected in the Layer Key Properties dialog box. For more informa-
tion, see “Editing Layer Key Styles” on page 415.

To specify layer key overrides, you must have a layer key style that is based 
on a layer standard. If you base your layer key standard on a nonstandard 
style, you cannot specify layer key overrides. 

If you do not have all overrides enabled in the Layer Key Overrides dialog 
box, objects that you draw after you exit the dialog box are placed on the 
layer defined by the layer standard. You can use the Overrides On/Off com-
mand to turn on the layer overrides later. 

NOTE Individual layer keys that do not allow overrides as specified in the Layer 
Key Properties dialog box are not overridden when you select Enable All 
Overrides.

1 On the Format menu, click Layer Management ➤ Layer Key Overrides.

2 Under Current Layer Key Style, select the layer key style that you want to 
override. 

The layer standard that the layer key style is based on is displayed under 
Based on Standard and is not editable.

3 Enter values for Override or click the [...] button to specify values to over-
ride the information in the descriptive fields.

The fields in this dialog box depend on the layer standard your layer key 
style is based on. For example, if you are using the AIA 2nd Edition layer 
standard, you can enter override values for the Discipline Designator, 
Major, Minor 1, Minor 2, and Status descriptive fields.
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4 To begin using the layer overrides immediately, select Enable All Over-
rides.

5 Click OK.

If you turned on the layer key overrides, any objects that you create now 
use the layer key overrides according to the override values that you have 
specified and whether you allowed overrides for the layer keys in the layer 
key style. If you did not turn on the layer key overrides, objects that you 
create are placed on layers defined by the layer standard. 

Turning Layer Key Overrides On and Off
You can use the Overrides On/Off command to turn layer key overrides on 
and off for the current layer key style in your drawing. This command is 
available only if your current layer key style is based on a layer standard and 
if you have specified layer key overrides. If the layer key overrides are on in 
the current drawing, a check mark is displayed next to the command name 
on the menu. 

� On the Format menu, click Layer Management ➤ Overrides On/Off.

If you turned the layer key overrides on, objects that you create are placed on 
layers defined by the layer standard definitions and are overridden with the 
values that you specified. If you turned the layer key overrides off, objects 
that you create are placed on layers defined by the layer standard.

Remapping Objects to Different Layers
Use this procedure to change the layer an object is drawn on by remapping 
it from the current layer key to a different layer key.

1 On the Format menu, click Layer Management ➤ Remap Object Lay-

ers, or in the Layer Manager toolbar, click .

2 Select the object or objects that you want to change, and press ENTER.

3 To view the list of available layer keys, enter ?.

4 Press F2 to view the list of layer keys.

5 Select the layer key that you want to map the object to, right-click, and 
click Paste To CmdLine.

6 Press F2 to close the text window, and press ENTER.

The object is mapped to a different layer in your drawing, respecting any cur-
rent layer key overrides.
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Restoring Objects to Default Layer Key Layers
Use this procedure to restore the default layer key assignment to an object 
after you remap the object to a different layer by assigning it to a different 
layer key. 

1 On the Format menu, click Layer Management ➤ Remap Object Lay-
ers.

2 Select the object or objects that you want to change, and press ENTER.

3 Enter o (byObject).

This applies the layer assigned to the default layer key of each object in 
the selection set, respecting any current layer key overrides.

4 Press ENTER.

Creating and Editing Layer Standards

A layer standard contains predefined layer names and a set of rules that deter-
mines the names of new layers that you create using that layer standard. You 
can use layer standards to establish individual, project, or office layering con-

ventions that provide consistent and informative layer names. Autodesk® 
Architectural Desktop provides a number of layer standards that you can use 
in drawings. You can also create your own layer standards by customizing an 
existing layer standard. 

How Layer Standards Determine Layer Name
When you create a new layer using a layer standard, the layer name has a 
number of parts separated by delimiters (for example, hyphens). Each part of 
the layer name is determined by rules specified in a corresponding field of 
the layer standard. 

For example, the AIA 2nd Edition layer standard includes four fields that 
form each new layer name: Discipline Designator, Major, Minor 1, Minor 2, 
and Status. Each field is separated by a hyphen (-) delimiter, as in the 
following example:

(Discipline Designator) - (Major) - (Minor 1) - (Minor 2) - (Status)

A layer in your drawing with a Discipline value of “A,” a Major value of 
“Wall,” a Minor 1 value of “Full,” a Minor 2 value of “Abov” and a Status 
value of “D,” to denote a demolition layer, would be named A-WALL-FULL-
ABOV-D. 

You can edit the layer standard definition to change these rules. For more 
information, see “Editing Component Fields” on page 429.
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You can override the information in each field to change the way a layer stan-
dard creates a layer name by specifying layer key overrides. For more infor-
mation, see “Layer Key Overrides” on page 418.

Layer Standards Included with the Layer Manager
Autodesk® Architectural Desktop provides industry-standard layering con-
ventions including: AIA 2nd Edition, BS1192 Descriptive, BS1192 - AUG 
Version 2, and NCS Version 2. Additional international layer conventions are 
also provided including: DIN 276, ISYBAU Long Format, ISYBAU Short For-
mat, and STLB. Each layer standard contains specific information organized 
in fields. You can specify how the information appears in each field by 
changing the values in the layer standard fields. For more information, see 
“Editing Component Fields” on page 429.

Related Topics and Procedures

� Component Fields in Layer Standards

� Creating a Layer Standard

� Editing Component Fields

� Editing Descriptive Fields

� Editing Descriptions

� Editing Description Specifications

� Purging Layer Standards

� Importing Layer Standards

� Exporting Layer Standards

Component Fields in Layer Standards

Each layer standard defines the number of component fields that make up a 
layer name and specifies the rules for the content allowed in each field. If you 
create or edit a layer standard, you access the layer standard properties to edit 
the component fields.
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Component Field Descriptions
Each layer standard contains the following component fields.

Value Description

Field Name Identifies the field. Field names should be as consistent as 
possible across layering systems to aid in translation.

Optional When Yes, allows the field to be omitted from the end of the 
layer name. Optional layer fields cannot precede a required layer 
field unless the match option is Yes so that the fields can be 
identified according to a match against specific descriptions.

Max Width Represents the maximum width in characters that can be used.

Fixed Width When Yes, prevents a field from being shortened from the max 
width setting.

Wildcard An AutoCAD® wildcard pattern that the field must match.
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For more information about the content of specific layer standards, see “AIA 
Long Format Layer Standard” on page 424 and “BS1192 - Descriptive Layer 
Standard” on page 426.

AIA Long Format Layer Standard
The AIA Long Format Standard contains the following fields:

Match 
Description

When Yes, recognizes the field only if it exactly matches a 
description. You can omit fields from the middle of layer names. 
For example, an AIA layer may be made up of <discipline> 
<major> <minor>, or <discipline> <major> <status>, or 
<discipline> <major> <minor> <status>, as the <minor> field 
may not precede the <status> field and can be determined only 
by matching the field value against valid <minor> field 
descriptions.

NOTE When omitting fields from layer names, verify that the 
omitted field Match Description property is No. This ensures that 
the layer name specified can be created.

Delimiter Specifies the character used to separate fields with no fixed 
width. Delimiters are often also used in fixed-width fields for 
clarity.

Default A predefined value for those field names that are not optional 
within the layer.

Field Name Description

Discipline 
Designator

Shows divisions of manageable sections. For example, A for 
architectural, M for mechanical. This field is required.

Major Designates assemblies or construction systems such as walls and 
doors. This field is required.

Minor 1 Further differentiates major groups into minor groups such as full-
height walls and partial-height walls. This field is optional and user-
defined.

Minor 2 Additional information, like title or unit information.

Status Differentiates phases of work. For example, New indicates new, 
Demo indicates to be demolished. This field is optional.

Value Description
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The following table lists the rules for the AIA Long Format Layer Standard:

BS1192 - AUG Version 2 Layer Standard
The BS1192 - AUG Version 2 layer standard contains the following fields:

AIA Long Format

Field Optional Width Fixed Wildcard Match Delimiter Default

Discipline 
Designator

No 1 Yes “@” No None A

Major No 4 Yes “@@@@” No “-“ Wall

Minor Yes 4 No “*” No “-“

Status Yes 4 No “*” No “-“

Field Description

Discipline Identifies the author of the layer by using a single character. For 
example, A for architect, S for structural engineer. This field is 
required.

Category Identifies the building element by using three digits and uses CISfB as 
a common referencing system. For example, 210 for wall, 315 for 
door. This field is required. 

Graphics Indicates information that is associated with the category by using a 
single character. For example, D for dimension, G for graphics, T for 
text. This field is required.

Grade Expresses as a single digit the recommended line thickness, where 1 is 
the thinnest and 9 is the thickest. This field applies mostly when using 
text where ISO standard pen thicknesses correlate with ISO standard 
text heights. For example, text that is 2.5mm high that is drawn with 
a 0.25mm pen is given a pen grade of 2. This field is required.

Level Differentiates viewing planes in plan, section, or elevation view by 
using a two-digit alphanumeric character. For example, 01 would be 
Level/Floor 1, EA the elevation, and SA Section A. This field is optional.

Status Indicates the state of work by using a single character. For example, N 
indicates new, R indicates to be removed. This field is optional.

Scale Indicates the level of detail to be shown by using a single character. 
For example, P indicates a planning level, D indicates a detail. This 
field is optional.



426 | Chapter 6 Layer Management

The following table lists the rules for the BS1192 - AUG Version 2 Layer Stan-
dard:

BS1192 - Descriptive Layer Standard
The BS1192 - Descriptive layer standard contains the following fields:

Phase/Time Indicates phasing or alternatives by using a single character.

User Specifies the user. It is not a fixed width field but is separated from the 
rest of the layer name with an underscore. For example, 
A210G701_WALL_L1. This field is optional.

BS1192 - AUG Version 2

Field Optional Width Fixed Wildcard Match Delimiter Default

Discipline No 1 Yes [0A-Z] No None A

C
SI

fB

CISfB-A No 1 Yes # No None 1

CISfB-B No 1 Yes # No None 0

CISfB-C No 1 Yes # No None 0

Graphics No 1 Yes [0ACDG
HTZ]

No None G

Grade No 1 Yes # No None 7

Level Yes 2 Yes [0-9A-Z]
[0-9A-Z]

No None 00

Status Yes 1 Yes [0NXR] No None 0

Scale Yes 1 Yes [0ASPD] No None 0

Phase Yes 1 Yes [0-9A-Z] No None 0

Field Name Description

Discipline Identifies the author of the layer by using a single character. For 
example, A for architect, S for structural engineer. This field is 
required.

Field Description
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The following table lists the rules for the BS1192 - Descriptive Layer Standard:

Element Identifies the building element by using a descriptive name for it. 
For example, possible choices for this field are “Equipment” or 
“Room.” This field is required. 

Graphics Indicates information that is associated with the category by using 
a single character. For example, D for dimension, G for graphics, T 
for text. This field is required.

Level Differentiates viewing planes in plan, section, or elevation view by 
using a two-digit alphanumeric character. For example, 01 would 
be Level/Floor 1, EA the elevation, and SA Section A. This field is 
optional.

Status Indicates the state of work by using a single character. For example, 
N indicates new, R indicates to be removed. This field is optional.

Scale Indicates the level of detail to be shown by using a single character. 
For example, P indicates a planning level, D indicates a detail. This 
field is optional.

Phase Indicates phasing or alternatives by using a single character.

User Specifies the user. It is not a fixed width field but is separated from 
the rest of the layer name with an underscore. For example, 
A210G701_WALL_L1. This field is optional.

BS1192 - Descriptive

Field Optional Width Fixed Wildcard Match Delimiter Default

Discipline No 1 Yes [0A-Z] No None A

Element No 15 No * No - Wall

Graphics No 1 Yes [0ACDG
HTZ]

No - G

Level Yes 2 Yes [0-9A-Z]
[0-9A-Z]

No None 00

Status Yes 1 Yes [0NXR] No None 0

Scale Yes 1 Yes [0ASPD] No None 0

Field Name Description
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Creating a Layer Standard

Use this procedure to create a layer standard, with default settings or based 
on an existing standard, that specifies naming conventions for layers in 
drawings.

If your drawing does not contain a layer standard, you can import a layer 

standard from another drawing or an Autodesk® Architectural Desktop tem-
plate. For more information, see “Importing Layer Standards” on page 432.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Click New.

4 To base the new layer standard on an existing standard, select Based On, 
and select a standard.

5 Enter a name for the new layer standard, and click OK.

6 To edit the new layer standard, right-click the standard, and click Edit:

7 Click OK twice.

Phase Yes 1 Yes [0-9A-Z] No None 0

If you want to . . . Then . . .

specify component fields 
of the layer standard

see “Editing Component Fields” on page 429.

specify descriptive fields of 
the layer standard

see “Editing Descriptive Fields” on page 429.

specify the descriptions for 
the layer standard

see “Editing Descriptions” on page 430.

specify the descriptive 
specifications of the layer 
standard

see “Editing Description Specifications” on 
page 431.

BS1192 - Descriptive

Field Optional Width Fixed Wildcard Match Delimiter Default
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Editing Component Fields

Use this procedure to specify how you want to set up the fields within the 
layer standard that determine the different parts of the layer names created 
with that standard. You can add and delete fields here.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the layer standard that you want to edit, and click Edit.

4 Click the Component Fields tab.

5 Modify the component fields:

6 Click OK three times.

Editing Descriptive Fields

Use this procedure to add a description that is applied to each component 
field in the layer name. You can add a single description to a group of layer 
name component fields.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

If you want to . . . Then . . .

delete a component field
select the field, and click .

add a component field above an 
existing field select the field, click , and enter a 

name for the new component field. 

add a component field below an 
existing field select the field, click , and enter a 

name for the new component field.

edit a field name double-click the name of the field, and 
enter a new name over the existing 
name. 

change the values of individual 
components of the fields

select the values that you want to 
change, and select a new value. For 
more information, see “Component 
Field Descriptions” on page 423.
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3 Select the layer standard that you want to edit, and click Edit.

4 Click the Edit Descriptive Fields tab.

5 Modify the descriptive fields:

6 Click OK three times.

Editing Descriptions

Use this procedure to map longer or different descriptions to the component 
fields of the layer name.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the layer standard that you want to edit, and click Edit.

4 Click the Edit Descriptions tab.

5 Modify the descriptions:

If you want to . . . Then . . .

delete a descriptive field
select the field, and click .

add a descriptive field above an 
existing field select the field, click , and enter a 

name for the new descriptive field. 

add a descriptive field below an 
existing field select the field, click , and enter a 

name for the new descriptive field.

edit a field name double-click the name of the field, and 
enter a new name over the existing 
name. 

delete a component from a descriptive 
field

select the component, and click Delete.

If you want to . . . Then . . .

delete a description select the field description, and click 

.
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6 Click OK three times.

Editing Description Specifications

Use this procedure to specify how all the fields in the layer standard deter-
mine the layer description that is displayed in the Layer Manager. You can 
change the field that is used in the description and the order of the fields, 
and you can add text to the beginning of the layer description.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the layer standard that you want to edit, and click Edit.

4 Click the Description Specification tab.

5 Specify how the fields determine the layer description:

edit a description
select the field description, click . 
Make changes to the description, and 
click OK. 

add a field with a value and a 
description click . Enter a value and a 

description for the field, and click OK.
To add multiple fields, click Apply after 
each individual field, and click OK to 
finish.

If you want to . . . Then . . .

delete a layer standard field
select the field, and click .

add a field above an existing field
select the field, click , and enter a 
name for the new field. 

add a field below an existing field
select the field, click , and enter a 
name for the new field.

edit text double-click the text for Prior Text, and 
enter a new name.

If you want to . . . Then . . .



432 | Chapter 6 Layer Management

6 Click OK three times.

Purging Layer Standards

Use this procedure to remove standards that are not in use.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Select the layer standards that you want to purge, and click Purge.

4 Click OK.

NOTE To purge all layer standards and layer key styles in a drawing, enter 
AecPurgeLayerStyles. This is beneficial to use when creating custom templates 
or when importing new layer standards and layer key styles.

Importing Layer Standards

Use this procedure to import layer standards from other drawings or from the 
AecLayerStd.dwg drawing in Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 2004\R16.0\Layers folder. If 

you are running Windows NT®, the drawing file is located in the \winnt\Pro-
files\All Users\Application Data\Autodesk Architectural Desktop 
2004\R16.0\Layers folder.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Click Import/Export.

4 Click Open.

5 Select the drawing with the layer standards that you want to import, and 
click Open. 

All the layer standards in the drawing are displayed in the External File 
list.

change a field value select the current value for Field, and 
click a new value.

If you want to . . . Then . . .
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6 Under External File, select the layer standard that you want to import, and 
click Import.

You can select more than one layer standard in a list by holding down 
CTRL while you select the additional layer standards.

If you import a layer standard that already exists in the target drawing, a 
message is displayed asking if you wish to overwrite the existing layer 
standard. Click Yes to overwrite the existing layer standard, or click No to 
cancel.

7 Click OK.

The layer standards that you imported are displayed in the Layer Standards 
dialog box. 

Exporting Layer Standards

Use this procedure to export layer standards from the current drawing to a 
new drawing or to an existing drawing.

1 On the Format menu, click Layer Management ➤ Layer Manager.

2 Click .

3 Click Import/Export.

4 Export the layer standards:

5 Select the layer standards that you want to export, and click Export. 

You can select more than one item in a list by holding down CTRL while 
you select the additional items. If you export a layer standard that already 
exists in the target drawing, a message is displayed asking if you wish to 
overwrite the existing layer standard. Click Yes to overwrite the existing 
layer standard, or click No to cancel.

6 Click OK three times.

If you want to . . . Then . . .

export layer standards to a new 
drawing

click New, enter a name for the new 
drawing, and click Save.

export layer standards to an existing 
drawing

click Open, select a drawing, and click 
Open.
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Display System

The display system in Autodesk® Architectural 
Desktop controls how AEC objects are displayed 
in a designated viewport. By specifying the dis-
play configuration in a viewport and the direc-
tion from which you want to view the objects 
shown in the viewport, you can produce differ-
ent architectural displays. The display system 
lets you produce floor plans, reflected plans, ele-
vations, 3D models, or schematic displays with-
out redrawing any objects.

Elements of the Display System
The display system has three major elements:

� A display representation, which controls 
how an individual object, such as a door or a 
wall, is displayed

� A display set, which is a group of display rep-
resentations of objects

� A display configuration, which is a collection 
of display sets assigned to particular view 
directions

These three elements are hierarchical: each dis-
play configuration contains a number of dis-
play sets, and each display set contains a num-
ber of display representations. To use a display 
configuration, you assign it to a viewport. The 
objects in the viewport then use the display 
properties specified in the display configura-
tion.

Predefined Display Configurations in Tem-
plates
You use different display configurations for dif-
ferent tasks, such as sketching and plotting. You 

In this chapter

� Display Representations

� Display Sets

� Display Configurations

� The Display Manager

� Creating and Editing Display 
Configurations

� Managing Display 
Configurations

� Troubleshooting the Display 
System

7
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also use different display configurations for different types of drawings, such 
as floor plans, 3D models, and elevations. 

Autodesk® Architectural Desktop includes templates with predefined display 
configurations applied to viewports. These display configurations are created 
for typical architectural tasks and drawing types. You can use the display con-
figurations and viewports supplied by the templates, or you can modify the 
display system settings to suit your office standards. If you want to create 
your own display configurations, you can start a drawing from scratch or 
from a template that does not contain predefined display configurations. 

Materials and the Display System
A material definition is a group of settings for the display properties of a real-
world material, such as glass, brick, or wood. The settings define how the 
components assigned to the material appear in every view.

The materials feature works with the display system to simplify the process 
of customizing the display of drawings. Rather than specifying individual 
display properties, you can control the display of objects according to the 
materials assigned to the physical components of the objects.

For example, you can assign an aluminum frame material to the frame, sash, 
and muntins of all windows whose components consist of this material. The 
display properties of the aluminum frame material are customized to look 
like typical aluminum frames for windows. By assigning the material to win-
dow components, you avoid the need to customize the display properties of 
the frame, sash, and muntins of every window that uses aluminum compo-
nents. In addition, if the materials change during the project, you can 
quickly reassign components to the new material.
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Window components assigned aluminum and wood materials

Sample styles in Autodesk® Architectural Desktop catalogs contain pre-
defined materials assigned to their components. Use these materials in your 
drawings, customize them, or create your own materials. For more informa-
tion, see “Creating and Editing Materials” on page 517.

Related Topics and Procedures

� Display Representations

� Display Sets

� Display Configurations

� The Display Manager

� Creating and Editing Display Configurations

� Managing Display Configurations

� Troubleshooting the Display System

Display Representations

A display representation defines how the components that make up an 
object are drawn. In traditional CAD and manual drafting, a single object, 
such as a door, is typically drawn multiple times in different drawings. In 
these drawings, each instance of a door is a separate collection of linework. 

In Autodesk® Architectural Desktop, display representations let you create 
only one object that can change the way it draws itself depending on the dis-
play representation used to represent that object.
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Display Components of AEC Objects
Most AEC objects are made up of individual components. For example, a 
door has the following components: door panel, frame, stop, swing, glass, 
and threshold. A door may also have muntins.

Each component of the object has both physical and graphical properties 
that help to determine the display representation of that object

� The physical properties of an object control width, height, shape, and 
location of the object in the drawing.

� The graphical properties control visibility (on/off), layer, color, and line-
type.

To represent an object in the drawing area, a display representation uses both 
the physical and graphical properties of the object. You typically decide the 
physical properties of the object when you create it. For example, you specify 
the size of a door and its location in a wall. You control the graphical prop-
erties of an object in its display representations. You can define multiple dis-
play representations for the same object.

Display Representations and View Directions
A representation of an object is not dependent on view direction, although 
a display representation is usually designed with a specific view in mind. 
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Objects displayed from different view directions that use different display 
representations

Why Most Objects Have Multiple Display Representations
All objects have predefined display representations. Most objects have Plan, 
Model, and Reflected display representations, because these are the most 
common design situations that require a different view of an object. Some 
objects, such as cameras and reference AEC objects, have only a General rep-
resentation, because the display of these objects does not change in different 
views. 
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A single object can be drawn in different ways, depending on the individual 
needs of different drawing types. For example, the Plan display representa-
tion draws the door panel, frame, stop, and swing components. The Nominal 
display representation draws the door panel, frame, and swing components. 
Although both representations draw the door panel, each representation 
draws it differently. The Plan display representation draws a door panel as a 
rectangle, while the Nominal display representation draws it as a single line. 

Door shown in the Plan and Nominal display representations

The Plan display representation is appropriate for representing objects in 
two-dimensional (2D) views when components are to be displayed from a 
plan (Top) view. The Nominal display representation is appropriate for repre-
senting objects in 2D views when a limited amount of detail is needed in 
plan view. For example, display configurations intended for plotting at small 
scales, where details of objects might be obscured, often use the Nominal dis-
play representation.

Default Display Representations
The display representations available for each object and the names of those 
display representations are based on the ways that you might need to view 
the object in your drawings. Different display representations can include 
different components of the object or additional display options. 

For example, the display properties of stairs in the Plan display representa-
tion include settings for controlling the display of break marks and other 
stair symbols. Break marks appear only in 2D Top view drawings, so other dis-
play representations, such as Model and Elevation, do not contain settings 
for break marks. Similarly, objects that never display break marks do not have 
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settings for them in their Plan display representations.

The Plan display representation for stairs includes options for break marks

Customizing the Display of an Object
When you do not use materials to control display, you customize the appear-
ance of an object by changing its display properties for the display represen-
tation that you want to use. For example, you can turn off the door swing in 
the Plan display representation, specify whether the swing is straight or an 
arc, specify the percent open, and change the layer, color, and linetype of the 
swing.

When you change the display of an object, you specify how these changes 
are applied to the instances of the object in the drawing. You do this by spec-
ifying the source of the display properties for the selected display representa-
tion

� To apply the changes to the default display properties of the object, you 
customize the drawing default. The changes affect all instances of the 
object in the drawing.
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Drawing default display properties affect all instances of an object

� To apply the changes to all instances of the object that have the same 
style, you override the drawing default with the display properties of the 
object style. 
Changes to the display properties of a style affect all objects of that style
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� To apply the changes only to the selected object, you override drawing 
default or style display properties with the display properties of the object.

The display properties of an object apply only to that object

Objects use the default display properties unless the properties are overrid-
den by the display properties of an object style or an individual object. Gen-
erally, you customize the display properties of object styles so that the 
appearance of different types of the same object are consistent throughout a 
drawing. In specific circumstances, you may need to override the display 
properties of the style for an individual object to achieve certain results.

Display Sets

Display sets are collections of display representations of objects. A display set 
determines which objects are visible, and how the objects, such as a wall 
assembly that includes a door and a window, are displayed in different views. 

Display Representations Included in a Display Set
A display set usually contains a display representation for each object that is 
appropriate for a specific task or drawing type. For example, the Reflected dis-
play set contains display representations for objects typically included in a 
reflected ceiling plan. This display set uses the Reflected display representa-
tion for most of these objects. The display uses the Plan display representa-
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tion for other objects, such as structural members, that appear the same in 
plan and reflected views.

A display set can contain more than one display representation for an object. 
For example, a display set for plotting a floor plan might include the Plan and 
Threshold Plan display representations for doors

� The Plan display representation contains components for the door panel, 
frame, stop, and swing.

� The Threshold Plan display representation contains components for the 
inner and outer thresholds of the door.

Plan and Threshold Plan display representations used alone and together to display a 
door

If a display set contains no display representations for an object, the object 
is not displayed when that display set is used. For example, a display set for 
a reflected ceiling plan does not need display representations for railings, 
which are not typically shown in these drawings.

Display Sets and View Direction
A display set is not dependent on view direction, although it is usually 
designed with a specific view in mind. For example, a Reflected display set is 
intended to be used to display objects from the Top view direction in a 
reflected ceiling plan.

Similarly, a Plan display set might contain the Plan display representations 
for a number of objects, which are intended for two-dimensional (2D), top 
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views. A three-dimensional (3D) model display set might contain the Model 
display representation for a number of objects. The specific display represen-
tations included in a display set depend on what display representations are 
available for each object. The display representations included in a display 
set also depend on whether the objects need to be drawn differently when 
displayed from different view directions.

Default Display Sets
Drawings based on templates provided with Autodesk® Architectural Desktop 
contain display sets for many purposes. However, all drawings, even those 
that are not created from templates, contain the following default display 
sets: Elevation, Model, Model High Detail, Model Low Detail, Plan, Plan High 
Detail, Plan Low Detail, and Reflected. These display sets contain display rep-
resentations for each object based on the most common design situations. 

Display Configurations

A display configuration is a collection of display sets assigned to view direc-
tions. 

Display Configurations, Viewports, and Templates
A display configuration is typically created for a specific design task or draw-
ing type. To use a display configuration, you assign it to a viewport. Drawings 

based on templates provided with Autodesk® Architectural Desktop contain 
layout tabs with viewports that are assigned appropriate display configura-
tions for various tasks. You can use the display configuration assigned to a 
viewport, assign a different display configuration to the viewport, or custom-
ize the display configuration.

Display Sets Assigned to View Directions
You can identify the display set assigned to each view direction in a display 
configuration using the Display Manager. The Display Manager is a utility for 
managing elements of the display system. The following illustration shows a 
drawing with two display configurations, Medium Detail and Standard.
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Sample display configurations in the Display Manager

In the Display Manager, the active viewport in the drawing (in bold type) is 
assigned the Medium Detail display configuration. In the left pane, the dis-
play sets used are listed below the configuration name. Icons next to each dis-
play set indicate the view directions to which the display set is applied. The 
Configuration tab in the right pane shows the display sets mapped to view 
directions. In this example, the current view direction in the drawing (in 
bold type) is Top, which uses the Plan display set. Objects in the active view-
port are shown using the display representations in the Plan display set.

If the view direction in the active viewport is changed to Front, the objects 
are shown using the display representations in the Section_Elev display set. 
This is also true when the view direction in the active viewport is changed to 
Right, Left, or Back. 

The display set assigned to the Default view direction is used when any view 
direction other than the six orthogonal views is selected or when a view 
direction is not assigned a display set. If the view direction of the active view-
port is changed to Bottom, objects are shown using the display set assigned 
to the Default view direction—the Model display set. 

For more information about the Display Manager, see “The Display Man-
ager” on page 449. 

Displaying Objects in a Viewport
A display configuration, the current viewport, and the object interact in the 
following manner to determine what is shown in a viewport:
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� The active viewport has a current view direction and a current display 
configuration. For example, the view direction is Top, and the display con-
figuration is Medium Detail.

� The display configuration has one or more display sets and uses the dis-
play set that is assigned to the current view direction. For example, in the 
Medium Detail display configuration, the Plan display set is assigned to 
the Top view.

� The display set has associated display representations and it selects the 
representation(s) associated with an object that needs to be shown. For 
example, in the Plan display set, doors, windows, and walls use their Plan 
display representations.

� The object is shown in the active viewport using the appropriate display 
representation(s) and display properties.

Examples of View Directions that Use Different Display Sets
A display configuration assigns display sets to specific view directions. When 
a view direction is selected, the display representations in the display set 
determine how each object is displayed in the viewport.

For example, the following illustration shows a viewport assigned the Plot 
display configuration and the Top view direction. In this illustration, the 
objects are shown with a Plan display representation.

Objects from Top view using a display set for plan views

If the Front view direction is selected in this viewport, the same objects are 
displayed with an Elevation display representation.
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Objects from Front view using a display set for elevation views

If the SW Isometric view direction is selected, the same objects are displayed 
with a three-dimensional (3D) representation.

Objects from SW isometric view using a display set for model views

Default Display Configuration
The display configurations in a drawing depend on the template used to cre-
ate the drawing. If a drawing is not created from a template, the drawing con-
tains the Standard display configuration, which includes the Plan and Model 
display sets.
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The Display Manager

The Display Manager is the central location of display system information for 

your drawing in Autodesk® Architectural Desktop. You use the Display Man-
ager to create and modify display configurations, display sets, and display 
representations. In the Display Manager, you can also assign a display con-
figuration to a viewport. In addition, you can view how objects display in dif-
ferent display representations. You can resize the Display Manager window 
and resize the left and right panes as needed to view display information.

Left Pane of the Display Manager
The left pane of the Display Manager organizes the display information in 
your drawings in a hierarchical tree view. You can add, purge, rename, copy, 
and send display system components in the tree view. As you select items in 
the left pane, the right pane is updated appropriately.

The left pane showing a tree view of display configurations and their components

Right Pane of the Display Manager
The right pane of the Display Manager shows detailed display information, 
depending on what you select in the tree view in the left pane. You can view 
the display sets and mapped view directions associated with each display 
configuration. You can view the display representations of different objects, 
and access the default graphical display properties of objects in your draw-
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ings. You can preview how an object is displayed with a display representa-
tion.

Right pane showing details of a selected display configuration

View Direction Icons in the Display Manager
The icons used with display sets and view directions provide a quick way to 
identify how a display set is used in a display configuration. When you 
expand a display configuration, the display sets used in the display configu-
ration are shown. The icon next to each display set indicates the view direc-
tions to which it is applied in the display configuration.

In the following example, the Model display set is applied to the default view 
direction. The Section_Elev display set is applied to the front, back, left, and 
right view directions. The Plan display set is applied to the top view direction. 
In the right pane, icons correspond to the six orthogonal view directions and 
the default view direction.



The Display Manager | 451

Using icons to identify view directions to which display sets are applied

Related Procedures

� Opening the Display Manager

� Viewing Display Configurations

� Viewing Display Sets

� Viewing Display Representations

� Viewing an Object in a Display Representation

� Viewing the Display Representation of an Object in a Display Set

� Accessing the Default Display Properties of an Object

Opening the Display Manager

Use this procedure to open the Display Manager.

1 On the Format menu, click Display Manager.

2 Move and resize the Display Manager or resize the left and right panes as 
needed to view display information.

Viewing Display Configurations

Use this procedure to view the display configurations available in the current 
drawing. The display configurations in a drawing depend on the template 
used to create the drawing. If a drawing is not created from a template, the 
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drawing contains the Standard display configuration, which includes the 
Model and Plan display sets.

1 On the Format menu, click Display Manager.

2 Expand Configurations, and select a configuration.

3 Click the Configuration tab.

The left pane lists the display sets included in the configuration. The right 
pane lists the display sets assigned to each view direction. If a display set 
is not listed next to a view direction, the display set for the Default view 
direction is used when that view direction is selected. The Default view 
direction is also used for any view directions other than the six orthogonal 
views.

Display sets assigned to view directions in the Standard display configuration

4 Click the Cut Plane tab.

The Cut Plane tab contains settings for the height of the cut plane and the 
height above and below the cut plane that are included in views when you 
assign this display configuration.

5 Click OK.

Viewing Display Sets

Use this procedure to view the display sets in the current drawing.

1 On the Format menu, click Display Manager.

2 Expand Sets, and select a display set.
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The icons next to the display set name in the left panel indicate whether 
a display set is used in a display configuration within the current drawing. 
The icon with the red check mark in it indicates that a display set is 
assigned. The icon with the green dot in it indicates that a display set is a 
standard set. Although standard sets can be renamed, they cannot be 
deleted.

3 Click the Display Representation Control tab.

The right pane contains a matrix that lists each object and display repre-
sentation. A check mark under a display representation indicates that the 
display set uses that display representation to show the corresponding 
object. For example, in the Model display set, most objects use the Model 
display representations.

Display representations selected for each object in the Model display set

4 Click the Display Options tab.

Settings on this tab enable you to filter objects by their classification. In 
addition, you can specify settings that affect how materials are displayed 
when you generate a live section view of a building model.
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Display options specified for a selected display set

5 Click OK.

Viewing Display Representations

Use this procedure to view the display representations in the current draw-
ing.

1 On the Format menu, click Display Manager.

2 Expand Representations by Object, and select an object.

In the right pane, rows list the display representations that exist for that 
object, and columns list display sets. A check mark under a display set 
indicates that the display representation is used in that display set. A dis-
play representation can be used in multiple display sets.
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Curtain wall display representations used in display sets

The icons next to the display representation name indicate whether it is a 
predefined display representation or custom display representation.  
indicates a predefined display representation.  indicates a custom dis-
play representation.

3 Click OK.

Viewing an Object in a Display Representation

Use this procedure to see how an object appears in different display represen-
tations and view directions.

1 On the Format menu, click Display Manager.

2 Click .

3 Reposition the Floating Viewer and the Display Manager so that both are 
visible.

4 Expand Representations by Object, and select an object.

5 In the right pane, select a display representation.
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NOTE  Overrides to the default display representation, made in the display 
properties of an object style or an individual object, do not show in the Dis-
play Manager.

The Floating Viewer displays the object in the display representation.

Floating Viewer displaying a curtain wall

6 Use the controls in the Floating Viewer to view the object from different 
view directions and with hidden lines removed or with shading.

7 Repeat steps 4 and 5 to view objects in various display representations.

8 Click  to close the viewer.

9 Click OK.

Viewing the Display Representation of an Object 
in a Display Set

Use this procedure to see how an object appears in the display representation 
used for the object in a selected display set.

1 On the Format menu, click Display Manager.

2 Click .
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3 Reposition the Floating Viewer and the Display Manager so that both are 
visible.

4 Expand Sets, and select a display set.

5 Click the Display Representation Control tab.

6 Select an object.

NOTE  Overrides to the default display representation, made in the display 
properties of an object style or an individual object, do not show in the Dis-
play Manager.

The Floating Viewer displays the object in the display representation 
selected for it in the display set.

7 Use the controls in the Floating Viewer to view the object from different 
view directions and with hidden lines and shading.

8 Repeat steps 6 and 7 to view other objects in the display representation 
used in the display set.

9 Select another display set, and repeat steps 6 and 7 to view objects as they 
appear in that display set.

10 Click  to close the viewer.

11 Click OK.

Accessing the Default Display Properties of an 
Object

Use this procedure to access and view the default display properties of a dis-
play representation of an object. Default display properties apply to all 
instances of the object in the drawing unless the properties are overridden by 
the object style or an individual object.

1 On the Format menu, click Display Manager.

2 Expand Representations by Object.

3 Select an object.

NOTE  Overrides to the default display representation, made in the display 
properties of an object style or an individual object, do not appear in the 
default display properties in the Display Manager.

4 Double-click a display representation.
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The Display Properties dialog box displays the default display properties 
of the object for the display representation you selected.

5 Click OK twice.

Creating and Editing Display Configurations

A display configuration is a collection of one or more display sets that control 
the representation of objects viewed from different directions in a drawing. 
You apply a display configuration to the viewport where you want the 
objects to appear. You can also select a display configuration to use as the 
default for model space and new viewports.

Drawings based on templates provided with Autodesk® Architectural Desktop 
contain display configurations for common tasks and drawing types. You can 
modify them and their display sets and display representations to meet your 
needs. You can also copy these elements of the display system to use as the 
basis for custom display configurations.

Related Topics and Procedures

� Process Overview: Creating a Display Configuration

� Tips for Working with Display Configurations, Sets, and Representations

� Creating a Display Configuration

� Creating a Display Set

� Creating a Display Representation for an Object

� Editing a Display Representation

� Assigning a Display Representation to a Display Set

� Assigning a Display Set to a View Direction

� Assigning a Display Configuration to a Viewport

� Specifying the Default Display Configuration

� Specifying the Display Configurations Used in Xref Overlays

� Changing the Display Configuration Used in Xref Drawings

� Displaying Objects by their Classification

� Specifying Settings for Live Sections and Materials
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Process Overview: Creating a Display 
Configuration

Autodesk® Architectural Desktop templates provide display configurations 
for common design, drafting, and production tasks. You can also create cus-

tom display configurations. 

The process of creating a display configuration has the following steps:

Step 1: Create a display configuration with default properties.

You can add display sets to the display configuration later, after you create 
display sets and display representations.

Step 2: Create display sets to associate with different view directions.

Although you can assign display sets to any view direction, you usually 
create them with specific view directions in mind. For example, you may 
want to create display sets for plan, elevation, and model views of a build-
ing model. You can add more display representations to the display sets 
later.

Step 3: Create or modify display representations for each object you want to 
display.

You create new display representations by duplicating an existing display 
representation for an object. Use a display representation that is similar to 
the one you want to create so that you have fewer settings to modify in 
the new representation. Although you can use display representations in 
any view direction, you usually create them with specific view directions 
in mind.

Step 4: Assign new, modified, or existing display representations to display 
sets.

A display set can include any display representations that you specify. 
Objects can use more than one display representation in a display set. 
Remember that you need to include at least one display representation for 
every object that is to appear in a viewport.

Step 5: Assign display sets to view directions in the display configuration.

You add display sets to a display configuration by assigning them to any 
of the six orthogonal view directions or to the Default view direction. The 
display system uses the display set assigned to the Default view direction 
for view directions that have no display set assigned to them in the display 
configuration.
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Step 6: Assign the display configuration to a viewport.

The display configuration you created does not become active until you 
assign it to a viewport. You can assign a display configuration to multiple 
viewports. You can also export display configurations to other drawings.

Related Topics and Procedures

� Creating and Editing Display Configurations

� Creating a Display Set

� Creating a Display Representation for an Object

� Editing a Display Representation

� Assigning a Display Representation to a Display Set

� Assigning a Display Set to a View Direction

� Assigning a Display Configuration to a Viewport

Tips for Working with Display Configurations, 
Sets, and Representations

This topic provides suggestions for working effectively when you create and 
modify display configurations and their elements.

� Templates provided with Autodesk®Architectural Desktop and drawings 
based on the templates contain display configurations for common 
design, drafting, and production tasks and various drawing types. If your 
drawing does not contain these display configurations, you can import 
them into the drawing. For more information, see “Importing a Display 
Configuration” on page 478.

� Templates and drawings based on templates contain layout tabs with dis-
play configurations already assigned to viewports for specific tasks. Exam-
ine your building model in these different layouts to see if objects are dis-
played as you want them to appear. 

� Before creating or modifying display configurations, review the pre-
defined display configurations to see if they meet your needs or if you can 
readily adapt them for your project.

� When possible, use a predefined display configuration as the basis for the 
display configuration you create. Starting with a display configuration 
that is similar to what you need helps you work efficiently. You can mod-
ify only the settings that need to change, rather than creating everything 
from scratch.

� When you modify a display representation, the changes affect every dis-
play set and display configuration that use that display representation. To 
apply the changes more selectively, create a new display representation for 
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the object and assign it to the display sets in which the changes are to 
appear.

� Similarly, when you modify a display set, the changes appear in every dis-
play configuration that uses the display set. And if you modify a display 
configuration, the changes appear in every viewport in which the display 
configuration is assigned. Create custom display sets and configurations 
to apply the changes more selectively.

� Remember that changes you make to display representations through the 
Display Manager apply only to the default display properties of objects. 
Changes to the display properties of object styles and individual objects 
override the default display properties. In addition, if the default display 
properties of an object assign a material to the object components, the dis-
play properties of the material determine the appearance of the object.

Creating a Display Configuration

Use this procedure to create a display configuration. You can create a display 
configuration using standard default properties or by creating a duplicate of 
an existing display configuration.

1 On the Format menu, click Display Manager.

2 Expand Configurations.

3 Create a display configuration:

4 Enter the name for the new display configuration, and press ENTER.

5 Specify the display sets and display representations to use in this display 
configuration:

If you want to . . . Then . . .

create a display 
configuration with default 
properties (contains no 
display sets)

right-click Configurations, and click New.

create a display 
configuration from an 
existing display 
configuration 

right-click the display configuration you want to 
copy, and click New. 

If you want to . . . Then . . .

create a display set for this 
configuration

see “Creating a Display Set” on page 462.
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6 Click OK.

Creating a Display Set

Use this procedure to create a display set. You can create a display set using 
standard default properties or by creating a duplicate of an existing display 
set.

1 On the Format menu, click Display Manager.

2 Expand Sets.

3 Create a display set:

4 Enter the name for the new display set, and press ENTER.

5 Specify the display representations to use in this display set:

create display 
representations to use in 
this display configuration

see “Creating a Display Representation for an 
Object” on page 463 and “Assigning a Display 
Representation to a Display Set” on page 465.

assign display sets to view 
directions

see “Assigning a Display Set to a View Direction” on 
page 467.

If you want to . . . Then . . .

create a display set with 
default properties 
(contains no display 
representations)

right-click Sets, and click New.

create a display set from an 
existing display set

right-click the display set you want to copy, and 
click New. 

If you want to . . . Then . . .

create display 
representations to use in 
this display set

see “Creating a Display Representation for an 
Object” on page 463.

assign display 
representations to this 
display set

see “Assigning a Display Representation to a Display 
Set” on page 465.

If you want to . . . Then . . .
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6 Click OK.

Creating a Display Representation for an Object

Use this procedure to create a display representation for a selected object. You 
create a display representation by duplicating an existing one for the object.

Each object has one or more display representations, depending on whether 
the object needs to change in different views. Select an existing display rep-
resentation that is similar to the one you want to create. That way, the dis-
play properties are available for you to customize in the new display repre-
sentation. 

For example, if you want to create a display representation for stairs that uses 
a custom break mark, duplicate a plan display representation for stairs that 
contains the settings for the break mark.

1 On the Format menu, click Display Manager.

2 Expand Representation by Object. 

3 Select the object for which to create a new display representation.

4 In the right pane of the Display Manager, right-click the display represen-
tation to duplicate, and click Duplicate.

5 Enter a new name for the display representation, and press ENTER.

The new display representation has the display properties of the display 
representation you duplicated.

6 Double-click the new display representation to edit its properties.

For more information about editing display properties, see “Editing a Dis-
play Representation” on page 464.

7 Assign the display representation to the display sets where you want the 
representation to be used.

For more information, see “Assigning a Display Representation to a Dis-
play Set” on page 465.

8 Click OK.

You can click Apply instead of OK to save the changes and continue work-
ing in the Display Manager.

add this display set to a 
display configuration

see “Assigning a Display Set to a View Direction” on 
page 467.

If you want to . . . Then . . .
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Editing a Display Representation

Use this procedure to change the following default display properties of a dis-
play representation for an object:

� Visibility (on or off), and whether the display of a component is con-
trolled by its material assignment

� Layer, color, linetype, and lineweight
� Display properties that are specific to the object and the display represen-

tation, such as the stair line and break mark in plan display representa-
tions of stairs

By default, the layer of object components is layer 0. The default color and 
linetype are ByBlock. With these defaults, the object components inherit the 
color and linetype properties of the “parent” object. For example, when the 
color and linetype of the door frame component are ByBlock, the door frame 
has the color and linetype of the door object. Object components cannot 

exist outside their parent object as typical AutoCAD® block objects can. 

The changes you make to a display representation apply to every display set 
and display configuration that use the display representation. To apply 
changes more selectively, create a display representation based on the display 
representation you want to modify. You can then change the display proper-
ties of the new display representation and assign it to specific display sets. For 
more information about creating display representations, see “Creating a 
Display Representation for an Object” on page 463.

NOTE The changes you make to a display representation using this procedure 
apply only to the default display properties for the object. Changes to the display 
properties of object styles or of individual objects override the default display 
properties.

1 On the Format menu, click Display Manager.

2 Expand Representations by Object.

3 Select the object for which you want to edit a display representation.

4 In the right pane of the Display Manager, double-click the display repre-
sentation you want to edit.

The display properties you can edit depend on the object and the display 
representation that you select. For example, a wall in a model display rep-
resentation displays only the Layer/Color/Linetype tab; a wall in a plan 
display representation displays two additional tabs to specify display 
properties for hatching and cut plane components.
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5 Click the Layer/Color/Linetype tab to change the AutoCAD properties, 
including visibility of the object components and whether their display is 
controlled by their material assignment.

6  If applicable, click tabs, such as Hatching or Other, to change object-spe-
cific display properties.

For more information about object-specific display properties, see the pro-
cedures for specifying the display properties of an object style in the Help 
topics for each object. For example, for more information about specifying 
the display properties of wall styles, see “Specifying the Display Properties 
of a Wall Style” on page 1879.

7 When you finish editing display properties, click OK twice.

Assigning a Display Representation to a Display 
Set

Use this procedure to add or remove display representations in a display set. 
Changes that you make to a display set affect every display configuration 
that uses the display set.

Keep the following points in mind when you add or remove display repre-
sentations in a display set:

� A display set can use more than one display representation for an object. 
For example, some display sets for plan views include both Plan and 
Threshold Plan display representations for doors. 

� If you want to use a display representation for an object other than the 
current one, be sure to clear the current display representation after select-
ing the new one. Otherwise, the display set uses the display properties of 
both display representations.

� If no display representation is selected for an object, the object does not 
appear when the display set is active in a viewport.

� If no check box appears under a display representation for an object, the 
object does not have the display representation. For example, some 
objects, such as layout curves and layout grids, have only one display rep-
resentation.

1 On the Format menu, click Display Manager.

2 Expand Sets.

3 Select the display set you want to edit.

4 Click the Display Representation Control tab.
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Editing a display set

5 In the right pane, add and remove display representations:

6 Click OK.

If you want to . . . Then . . .

add a display 
representation for an 
object to the display set

scroll to find the object in the list of objects. Select a 
display representation to use for the object. If no 
check box appears under a display representation, 
the object does not have the display representation.

remove a display 
representation for an 
object in the display set

scroll to find the object in the list of objects. Clear 
the display representation you want to remove. 

use the same display 
representation for all 
objects in the display set

right-click the name of the display representation, 
and click Select All. Be sure to clear any other 
display representations for the objects in this display 
set.

remove an object entirely 
from a display set

scroll to find the object in the list of objects. Right-
click the object name, and click Clear All.
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Assigning a Display Set to a View Direction

Use this procedure to specify the display set assigned to each view direction 
in a display configuration.

1 On the Format menu, click Display Manager.

2 Expand Configurations.

3 Select the display configuration you want to edit.

4 Click the Configuration tab.

5 Under Display Representation Set, select the appropriate display set for 
each view direction.

The display set you select becomes active when the view direction is 
selected in the viewport in which the display configuration is assigned. 
The display system uses the display set assigned to Default view direction 
for view directions for which you do not assign a display set and for the 
four isometric views.

6 Click OK.

To see the results of the changes, you must assign the display configura-
tion to a viewport. For more information, see “Assigning a Display Con-
figuration to a Viewport” on page 467.

Assigning a Display Configuration to a Viewport

Use this procedure to assign a display configuration to a viewport. You can 
specify a display configuration for a viewport, model space, or tiled viewport 
at any time during your design process.

NOTE You can also assign a display configuration to the current viewport in 
the Display Manager. Right-click the display configuration, and click Set To Cur-
rent Viewport.

1 Select the viewport for which you want to assign a display configuration.

2 In the drawing status area, select the setting for Display Configuration.
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Displaying the display configurations you can assign to the current viewport

3 Select the display configuration that you want to use.

4 If necessary, enter rea (Regenerate All) to update the display to show the 
new display configuration.

Specifying the Default Display Configuration

Use this procedure to specify the default display configuration applied to 
new viewports, model space, or tiled viewports in the current drawing. Exist-
ing viewports with display configurations already assigned to them are not 
affected.

NOTE You can also assign the default display configuration in the Display 
Manager. Right-click the display configuration, and click Set as Drawing Default.

1 In the drawing status area, click .

2 Click Drawing Setup.

3 Click the Display tab.

4 Under Drawing Default Display Configuration, select the display configu-
ration to apply to new viewports or when the TILEMODE system variable 
is set to 1. 

5 Click OK.

6 If necessary, enter rea (Regenerate All) to update the display in model 
space to show the new display configuration.

Specifying the Display Configurations Used in 
Xref Overlays

Use this procedure to specify whether the objects in an xref drawing are to 
use the display configurations in the xref when the drawing is referenced as 
an overlay by the host drawing. 
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By default, objects in both overlay and attached xref drawing use the display 
configurations assigned in the host drawing. This procedure describes how to 
specify that an xref overlay use only its own display configurations instead 
of those in the host drawing. If you do not turn on this option, objects in the 
xref drawing can use their own display configurations or those of the host 
drawing. Xref drawings that are referenced as an attachment can use either 
group of display configurations. For more information, see “Changing the 
Display Configuration Used in Xref Drawings” on page 470.

In the following example, the objects in the xref drawing inserted as an over-
lay use the Screened display configuration (North and East walls, doors, and 
windows). The host drawing uses the Medium Detail display configuration 
(South and West walls, doors, and windows).

An xref overlay that does not use the active display configuration in the host drawing

1 Open the drawing that you want to reference in another drawing.

2 In the drawing status area, click .

3 Click Drawing Setup.

4 Click the Display tab.

5 Under Drawing Default Display Configuration, select When used as an 
Xref Overlay use Display Configurations from this drawing only.

Clear this option if you want the xref drawing to use either its own display 
configurations or the display configurations in the host drawing.

Specifying that objects use display configurations only from the current drawing
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6 Click OK.

Changing the Display Configuration Used in Xref 
Drawings

Use this procedure to change the display configuration of an xref drawing 
that is referenced as either an attachment or an overlay in a host drawing.

NOTE If you specified that the drawing should always use its own display con-
figurations when inserted as an xref overlay, you cannot change the display con-
figuration used to display the xref objects in the host drawing. For more infor-
mation, see “Specifying the Display Configurations Used in Xref Overlays” on 
page 468.

1 Open the host drawing that contains the xref drawing for which to specify 
a different display configuration.

2 Select the xref drawing you want to change, right-click, and click Edit 
Object Display.

3 Click the Xref Display tab.

If the settings on the tab are unavailable, you cannot change the display 
configuration used for this xref overlay.

4 Select Override the display configuration set in the host drawing.

5 Select the display configuration that you want to use.

Selecting a display configuration from those in the xref drawing
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The list of display configurations are those available in the xref drawing. 
Select Drawing Default if you want to use the default display configura-
tion specified in the host drawing.

6 Click OK.

7 Enter regenall (Regenerate All) to see the changes to the display of objects 
in the xref drawing.

Displaying Objects by their Classification

Use this procedure to hide or show objects in a display set based on the clas-
sification of the objects. For example, if you classify objects by their construc-
tion status (new, existing, or demo), you can exclude objects with the demo 
classification from the display. When the display is used in the drawing, 
those objects do not appear.

Objects filtered from the display are not removed from the drawing. Their 
display is turned off only in viewports using the display set in which objects 
of that classification are filtered. You can change the filter to display them 
again. Because the objects still exist in the drawing, the display of other 
objects in the drawing does not change. For example, if you filter doors from 
a floor plan, the walls in which they are placed are still cut in the space occu-
pied by the doors.

For more information about defining classifications and assigning them to 
object styles, see “Classification Definitions” on page 2289.

1 On the Format menu, click Display Manager.

2 Expand Sets.

3 Select the display set you want to edit.

4 Click the Display Options tab.

The classification filter lists all classifications in the current drawing. The 
default setting is Show.

5 To hide objects of a specified classification, select Hide for Filter.

For example, to hide all doors and walls classified as Demo, select Hide for 
each Demo classification, as shown in the following figure.
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Hiding objects based on their classification

To redisplay objects in a classification that were hidden, select Show for 
Filter.

6 Click OK.

Specifying Settings for Live Sections and 
Materials

Use this procedure to specify how live sections and materials are displayed 
when the selected display set is active in a viewport and a live section view 
of the building model is enabled. These settings let you refine the appearance 
of a section. For example, you can remove surface hatching that may obscure 
details that are important to show in the section.

For more information about materials, see “Materials” on page 491. For more 
information about live sections, see “Creating and Editing a Live Section 
View” on page 2110.

1 On the Format menu, click Display Manager.

2 Expand Sets.

3 Select the display set you want to change, and click the Display Options 
tab.
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Specifying display options for live sections and materials

4 Under Live Sections and Materials, specify display settings:

5 Click OK.

Managing Display Configurations

The Display Manager is a utility that you use to manage display configura-
tions, display sets, and display representations. You can rename them, delete 
them, copy them between drawings, e-mail them to other users, and purge 
unused elements from drawings.

Related Topics and Procedures

� Renaming a Display Configuration or a Display Set

� Renaming a Display Representation

� Deleting a Display Configuration or a Display Set

� Deleting a Display Representation

If you want to . . . Then . . .

use the display range of the 
display configuration to 
determine the vertical extents of 
a live section view

select Section AEC objects by Display Range 
Defined in Display Configuration. If you want 
to graphically indicate where objects in the 
model extend below the display range, select 
Show Materials where Display Range intersects 
AEC Objects.

remove the display of the 
portion of sectioned objects 
that is beyond the bounding 
box of the live section

select Hide Sectioned Body Component.

remove surface hatching on 
sectioned objects

select Hide Surface Hatching.
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� Adding Notes and Reference Files to a Display Configuration or a Display 
Set

� Copying Display Configurations Between Drawings

� Purging a Display Configuration

� Purging a Display Set

� Purging a Display Representation

Renaming a Display Configuration or a Display 
Set

Use this procedure to rename a display configuration or a display set. You 
cannot rename the Standard display configuration.

1 On the Format menu, click Display Manager.

2 Select a display configuration or a display set:

3 Enter the new name, and press ENTER.

4 Click OK.

Renaming a Display Representation

Use this procedure to rename a display representation. You can rename any 
display representation that you create as well as some that are provided in 

Autodesk® Architectural Desktop templates. You cannot rename predefined 
display representations.

1 On the Format menu, click Display Manager.

2 Expand Representations by Object.

3 Select the object for which to rename a display representation.

4 Right-click the display representation to rename, and click Rename.

If Rename is unavailable on the shortcut menu, you cannot rename the 
display representation because it is predefined. Predefined display repre-

sentations have this icon  next to their names.

If you want to . . . Then . . .

rename a display configuration expand Configurations, right-click the display 
configuration, and click Rename.

rename a display set expand Sets, right-click the display set, and 
click Rename.
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5 Enter the new name for the display representation, and press ENTER.

6 Click OK.

Deleting a Display Configuration or a Display Set

Use this procedure to delete a display configuration or a display set. 

Keep the following points in mind when you delete display configurations or 
display sets:

� You cannot delete the display configuration that is assigned to the current 
viewport. 

� You cannot delete predefined display configurations, which are indicated 
by a red check mark to the left of the configuration name. 

� You cannot delete a display set that is used in a display configuration, nor 
can you delete the Standard display configuration.

NOTE Deleting a display configuration does not delete the display sets and 
display representations used in the display configuration. Deleting a display set 
does not delete the display representations used in the display set. For more 
information about deleting display representations, see “Deleting a Display Rep-
resentation” on page 475.

1 On the Format menu, click Display Manager.

2 Select a display configuration or a display set:

3 Click OK.

Deleting a Display Representation

Use this procedure to delete a display representation that is not assigned to a 
display set. You can delete any display representation that you create as well 

as some that are provided in Autodesk® Architectural Desktop templates. 
User-defined display representations have this icon  next to their names. 

If you want to . . . Then . . .

delete a display configuration expand Configurations, and right-click the 
display configuration, and click Delete.

delete a display set expand Sets, and right-click the display set, 
and click Delete.
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You cannot delete predefined display representations. Predefined display rep-

resentations have this icon  next to their names.

1 On the Format menu, click Display Manager.

2 Expand Representations by Object.

3 Select the object for which to delete a display representation.

4 To remove the display representation from all display sets, right-click the 
display representation, and click Clear All.

5 Right-click the display representation to delete, and click Delete.

You will receive an error message if you try to delete a predefined display 
representation or one that is assigned to a display set.

6 Click OK.

Adding Notes and Reference Files to a Display 
Configuration or a Display Set

Use this procedure to enter notes and attach reference files to a display con-
figuration or a display set. You can also edit notes and edit or detach refer-
ence files from a display configuration or a display set.

1 On the Format menu, click Display Manager.

2 Select a display configuration or a display set:

3 Click the General tab.

4 To add a description to the display configuration, enter it for Description.

5 Click Notes.

6 To add a note, click the Notes tab, and enter the note.

7 Click the Reference Docs tab, and attach, edit, or detach a reference file:

If you want to . . . Then . . .

add notes or files to a display 
configuration

expand Configurations, and select the display 
configuration.

add notes or files to a display set expand Sets, and select the display set.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.
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8 Click OK twice.

Copying Display Configurations Between 
Drawings

You can use the display configurations, display sets, and display representa-
tions that you create or modify in multiple drawings. 

Importing and Exporting Display Configurations and Display Sets
You can import display configurations and display sets from another drawing 
into the current drawing. You can export display configurations and display 
sets from the current drawing to new or existing drawings. 

When you import or export a display configuration, the display system also 
copies any display sets and display representations included in the selected 
configuration that do not exist in the destination drawing. Similarly, if you 
import or export a display set, the display system copies any display repre-
sentations that do not exist in the destination drawing. 

If a display set or a display representation with the same name exists in the 
destination drawing, it is not overwritten with the new display information. 
To transfer the new information, rename the existing display set or represen-
tation in the destination drawing before importing or exporting display con-
figurations or display sets. 

For example, you want to import a display set named New Reflected that con-
tains a display representation for doors named Reflected Screened, and the 
current drawing also contains a display representation for doors named 
Reflected Screened. To import the new display representation, rename the 
Reflected Screened display representation in the current drawing before 
importing the new display set and its display representations.

Importing and Exporting Display Representations
You can import and export display representations only as part of a display 
set. If you want to use a display representation in another drawing, assign the 
display representation to a display set, and copy the display set to the desti-

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .
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nation drawing. You can then use the display representation in display sets 
in the destination drawing.

E-mailing Display Configurations
If your system has e-mail, you can e-mail display configurations to other 
users from the Display Manager. You can send the entire display system in 

your drawing to another user of Autodesk® Architectural Desktop. The Dis-
play Manager copies the display system information to a new drawing, and 
attaches the drawing to a new e-mail message created using the e-mail pro-
gram on your system. Users of Autodesk Architectural Desktop who receive 
your display system by e-mail can import it into their drawings, open the 
attached drawing file, and export your display system to their drawings; or 
they can use the attached drawing file as a template for new drawings. For 
further information about importing and exporting display systems, see 
“Copying Display Configurations Between Drawings” on page 477.

Related Procedures

� Importing a Display Configuration

� Importing a Display Set

� Exporting a Display Configuration

� Exporting a Display Set

� Sending Display Configurations to Other Users

Importing a Display Configuration
Use this procedure to import one or more display configurations from 
another drawing into the current drawing. Any display sets and display rep-
resentations assigned to the display configurations that do not exist in the 
current drawing are copied into the current drawing with the display config-
urations. Display sets and display representations that have the same name 
as those in the current drawing are not imported.

1 Make sure that the drawing containing the display configuration you 
want to import is not open in the current session.

2 On the Format menu, click Display Manager.

3 Right-click Configurations, and click Import/Export.
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4 Select the drawing from which to import display configurations:

Importing display configurations from another drawing

5 Under External File, select one or more display configurations to import, 
and click Import. 

To select more than one display configuration, hold down CTRL while you 
select the display configurations.

If the current drawing contains a display configuration with the same 
name, the duplicate name is displayed in the Import/Export - Duplicate 
Names Found dialog box.

If you want to . . . Then . . .

select a drawing to which 
you previously imported or 
exported display 
information

select the drawing from the Recent Files list.

select a drawing that is not 
in the Recent Files list

click Open. Navigate to the drawing, and click 
Open.



480 | Chapter 7 Display System

6 Resolve duplicate names, if prompted:

7 Click OK twice.

Importing a Display Set
Use this procedure to import one or more display sets from another drawing 
into the current drawing. Any display representations assigned to the display 
sets that do not exist in the current drawing are copied into the current draw-
ing with the display sets. Display representations that have the same name 
as display representations in the current drawing are not imported.

1 Make sure that the drawing containing the display set you want to import 
is not open in the current session.

2 On the Format menu, click Display Manager.

3 Right-click Sets, and click Import/Export.

4 Select the drawing from which to import display sets:

If you want to . . . Then . . .

prevent the Display 
Manager from overwriting 
the existing display 
configuration with the new 
display configuration of 
the same name

select Leave Existing, and click OK.

replace the existing display 
configuration with the new 
display configuration

select Overwrite Existing, and click OK.

keep the existing display 
configuration and add the 
new display configuration 
with a different name

select Rename to Unique, and click OK. 
The Display Manager appends a number to the 
name of the new display configuration.

If you want to . . . Then . . .

select a drawing to which 
you previously imported or 
exported display 
information

select the drawing from the Recent Files list.

select a drawing that is not 
in the Recent Files list

click Open. Navigate to the drawing, and click 
Open.
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Importing display sets from another drawing

5 Under External File, select one or more display sets to import, and click 
Import. 

To select more than one display set, hold down CTRL while you select the 
display sets.

If the current drawing contains a display set with the same name, the 
duplicate name is displayed in the Import/Export - Duplicate Names 
Found dialog box.

6 Resolve duplicate names, if prompted:

If you want to . . . Then . . .

prevent the Display 
Manager from overwriting 
the existing display set 
with the new display set of 
the same name

select Leave Existing, and click OK.

replace the existing display 
set with the new display 
set

select Overwrite Existing, and click OK.

keep the existing display 
set and add the new 
display set with a different 
name

select Rename to Unique, and click OK. 
The Display Manager appends a number to the 
name of the new display set.
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7 Click OK twice.

Exporting a Display Configuration
Use this procedure to export one or more display configurations from the 
current drawing into a new or existing drawing. Any display sets and display 
representations assigned to the display configurations that do not exist in the 
destination drawing are copied into the destination drawing with the display 
configurations. Display sets and display representations that have the same 
name as those in the destination drawing are not exported.

1 Make sure that the drawing into which you will export display configura-
tions is not open in the current session.

2 On the Format menu, click Display Manager.

3 Right-click Configurations, and click Import/Export.

4 Select the drawing into which to export display configurations:

If you want to . . . Then . . .

select a drawing for which 
you previously imported or 
exported display 
information

select the drawing from the Recent Files list.

select a drawing that is not 
in the Recent Files list

click Open. Navigate to the drawing, and click 
Open.

create a drawing click New. Enter a name for the new drawing, and 
click Save.
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Exporting display configurations to another drawing

5 Under Current Drawing, select one or more display configurations to 
export, and click Export. 

To select more than one display configuration, hold down CTRL while you 
select the display configurations.

If the destination drawing (the external drawing) contains a display con-
figuration with the same name, the duplicate name is displayed in the 
Import/Export - Duplicate Names Found dialog box.

6 Resolve duplicate style names, if prompted:

If you want to . . . Then . . .

prevent the Display 
Manager from overwriting 
the existing display 
configuration with the new 
display configuration of 
the same name

select Leave Existing, and click OK.

replace the existing display 
configuration with the new 
display configuration

select Overwrite Existing, and click OK.

keep the existing display 
configuration and add the 
new display configuration 
with a different name

select Rename to Unique, and click OK. 
The Display Manager appends a number to the 
name of the new display configuration.
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7 Click OK.

8 When prompted to save changes to the destination drawing (external 
drawing), click Yes.

9 Click OK.

Exporting a Display Set
Use this procedure to export one or more display sets from the current draw-
ing into a new or existing drawing. Any display representations assigned to 
the display sets that do not exist in the destination drawing are copied into 
the destination drawing with the display sets. Display representations that 
have the same name as those in the destination drawing are not exported.

TIP  To use a display representation in another drawing, assign the display rep-
resentation to a display set, and copy the display set to the destination drawing. 
You can then use the display representation in display sets in the destination 
drawing.

1 Make sure that the drawing into which you will export display sets is not 
open in the current session.

2 On the Format menu, click Display Manager.

3 Right-click Sets, and click Import/Export.

4 Select the drawing into which to export display sets:

If you want to . . . Then . . .

select a drawing to which 
you previously imported or 
exported display 
information

select the drawing from the Recent Files list.

select a drawing that is not 
in the Recent Files list

click Open. Navigate to the drawing, and click 
Open.

create a new drawing click New. Enter a name for the new drawing, and 
click Save.
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Exporting display sets to another drawing

5 Under Current Drawing, select one or more display sets to export, and 
click Export. 

To select more than one display set, hold down CTRL while you select the 
display sets.

If the destination drawing (the external drawing) contains a display set 
with the same name, the duplicate name is displayed in the Import/
Export - Duplicate Names Found dialog box.

6 Resolve duplicate names, if prompted:

If you want to . . . Then . . .

prevent the Display 
Manager from overwriting 
the existing display set 
with the new display set of 
the same name

select Leave Existing, and click OK.

replace the existing display 
set with the new display 
set

select Overwrite Existing, and click OK.

keep the existing display 
set and add the new 
display set with a different 
name

select Rename to Unique, and click OK. 
The Display Manager appends a number to the 
name of the new display set.
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7 Click OK.

8 When prompted to save changes to the destination drawing (external 
drawing), click Yes.

Sending Display Configurations to Other Users
Use this procedure to e-mail all the display configurations and their elements 

in a drawing to other users of Autodesk® Architectural Desktop. The software 
creates a new drawing that contains only the display information from the 
current drawing and attaches the drawing to an e-mail message. Objects, lay-
ers, and other drawing content and settings are not included in the new 
drawing.

1 On the Format menu, click Display Manager.

2 Right-click the drawing name, and click Send.

An e-mail message with the subject “ADT Display System,” is created using 
your e-mail program. A drawing file containing the display information is 
added to the message as a file attachment.

If e-mail is not available on your system, the Send option is not available. 

3 Complete and send the message in your e-mail program.

4 Click OK.

Purging a Display Configuration

Use this procedure to purge unused display configurations from a drawing.

You cannot purge a display configuration assigned to a viewport or model 
space, or predefined display configurations, such as Standard.

1 On the Format menu, click Display Manager.

2 Right-click Configurations, and click Purge. 

All display configurations that you can purge are selected in the Purge Dis-
play Configurations dialog box.

3 Clear any display configurations that you do not want to purge, and click 
OK twice.

Purging a Display Set

Use this procedure to purge unused display sets from a drawing.

You cannot purge a display set assigned to a display configuration, or pre-
defined display sets such as Standard, Model, or Plan.
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TIP To find out if a display set is assigned to any display configurations, select 
Configurations in the left pane. The right pane lists each display configuration 
and the display sets it uses.

1 On the Format menu, click Display Manager.

2 Right-click Sets, and click Purge. 

All display sets that you can purge are selected in the Purge Display Sets 
dialog box.

3 Clear any display sets that you do not want to purge, and click OK twice.

Purging a Display Representation

Use this procedure to purge unused display representations from a drawing. 
You cannot purge a display representation assigned to a display set, or pre-
defined display representations such as Model or General.

1 On the Format menu, click Display Manager.

2 Expand Representations by Object.

3 Select the display representations to purge:

All display representations that you can purge are selected in the Purge 
Display Representations dialog box.

4 Clear any display representations that you do not want to purge, and click 
OK twice.

Troubleshooting the Display System

If you have problems displaying objects in your drawing, use the following 
troubleshooting suggestions to resolve the problem.

If you want to . . . Then . . .

purge unused display 
representations for a specific 
object

right-click the object name, and click Purge.

purge all unused display 
representations in the drawing

right-click Representations by Object, and click 
Purge.
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� Why isn't my object displayed?

� Why isn't my viewport updating?

� I dragged objects to another drawing. Why do they look different now?

� Is there a quick way to verify that an object exists in a drawing but is not 
displayed?

� Why doesn’t the linetype for my object display the way I expect?

Why isn't my object displayed?
When AEC objects in your model do not display correctly in a viewport, the 
following actions might help to solve the problem.

� In the drawing status area, verify the name of the selected display config-
uration. Select a different display configuration, and see if the problem is 
resolved.

� In the Display Manager, find out what display set is being used in the dis-
play configuration assigned to the viewport in question. The name of the 
current display configuration is highlighted. The names of the current dis-
play set is also highlighted.

� In the detailed view of the display sets in the Display Manager, make sure 
that a display representation for the object is selected in that display set.

� Is the object hidden because objects of its classification are filtered out in 
the current display set? On the Display Options tab, verify that objects are 
not hidden.

� If a display representation is selected in the current display set, look at the 
display properties of the display representation. Are the display 
components turned off? Are components on layers that are turned off?

� Is the display of components controlled by the material assigned (ByMa-
terial is selected in the display properties)? If so, look at the display prop-
erties of the material assigned to object components to determine the set-
tings.

� Is the object drawn on a layer that is turned off?

Why isn't my viewport updating?
Under certain circumstances, such as when you switch view directions in 
shade modes other than 2D wireframe, the display is not restored correctly. 
In such cases, enter objrelupdatedate on the command line, and either select 
the problem AEC object or press ENTER to select all the AEC objects. This 
forces the display system to regenerate all the current display 
representations. 
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I dragged objects to another drawing. Why do they look 
different now?
Objects dragged or copied from one drawing to another use the display prop-
erties of the display configuration assigned to the viewport in the destination 
drawing. The display configuration in the original drawing is not copied with 
the objects.

Is there a quick way to verify that an object exists in a drawing 
but is not displayed?
Enter DisplayDxfName on the command line to label each object in the 
drawing with its name. Labels appear even for objects that are not displayed. 
For example, if you created a display set that did not include a display repre-
sentation for doors, and you then assigned the display set to a display con-
figuration used in the current viewport, doors would not be displayed in that 
viewport. An object can also exist in a drawing and not be displayed if the 
object was filtered out by its classification in the current display set. Display-
DxfName can help you determine whether the objects are simply not dis-
played or if they are not present.

1 At the command line, enter displaydxfname.

2 Enter y (Yes).

3 Enter regenall (Regenerate All).

Displaying the names of objects, including those that are not shown

4 To turn off object names, enter displaydxfname.

5 Enter n (No).
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Why doesn’t the linetype for my object display the way I expect?
The linetype scale for the components of AEC objects works with the 

AutoCAD® linetype scale specified in the LTSCALE variable to control the 
linetype of AEC objects. The default value for linetype scale of all compo-
nents of AEC objects is 1.0. This value is multiplied by the current value for 
LTSCALE to produce the linetype scale of object components. 

For example, if the LTSCALE value is 48.0, and the linetype scale in the dis-
play properties of an object is 1.0 for an object component, the linetype scale 
of the component is 48.0. If you change the linetype scale in the display 
properties to 2.0, the linetype scale of the component is effectively 96, or 
2.0 x 48.
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Materials

In Autodesk® Architectural Desktop, a material 
corresponds to a specific structural finish mate-
rial in a building model, such as brick, concrete 
or glass. Materials are useful for creating sec-
tions, elevations, and renderings in the design 
process. Materials also provide a way to manage 
the display properties of object styles.

Building model showing materials in elevation view 

In this Chapter

� Objects that Support Materials

� Process Overview: Creating 
and Assigning Materials

� Material Components and 
Display Properties

� Displaying Materials in a 
Drawing

� Working with Surface Hatches

� Overriding the Surface Hatch 
on Individual Objects

� Displaying a List of Materials

� Displaying a Material Query

� Creating and Editing Materials

8
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Building model showing materials in rendered view

Simplifying the Design Process

Using materials makes defining the display of objects considerably easier. 
You define the display of a material, such as brick or glass, only once in the 
drawing or the drawing template, and then assign it to any object compo-
nent you want to show that material. For example, you can define a material 
“Glass” and then assign it to any number of windows, glass door insets or 
cubicle walls. You typically assign materials to components in objects styles, 
you can also assign materials to the components of individual objects.

Using a common set of materials provides centralized control for the display 
of objects across the drawing or the whole project. When the particulars of a 
material change, you change them just once in the material definition and 
all objects are automatically updated.

Predefined Materials

Autodesk® Architectural Desktop provides a large number of predefined 
materials for all common design purposes, so that you get an easy start with 
new drawings. You can use these predefined materials or modify them to 
your special designs. You can also create your own materials. Styles that are 
provided with the software have materials already assigned to them.
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You can also drag and drop render materials between Architectural Desktop 
and Autodesk® VIZ Render by accessing the Autodesk VIZ Render Material 
Catalog in Content Browser. If you are working in VIZ Render, Architectural 
Desktop imports any assigned materials.

NOTE If you open VIZ Render from the flyout Architectural Desktop automat-
ically links the geometry from the open Architectural Desktop document into VIZ 
Render. However, if you open VIZ Render from the desktop icon, or from the 
Start menu, Architectural Desktop will only open VIZ Render, and any existing 
file will need to be re-opened and any existing geometry will need to be manu-
ally linked.

Surface Hatching

The ability to assign surface hatches to objects is provided by materials. Sur-
face hatches can display in both model views and section/elevation views. 
You can precisely control placement and orientation of the hatch for each 
object face.

Section Hatching

Materials work seamlessly with sections and elevations. Section hatches can 
be specified independently of surface hatches. Special material components 
allow a realistic display of rendered live section views. 

For information on live section views, see “Creating and Editing a Live Sec-
tion View” on page 2110.
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Rendered live section view with transparent outside material

Integration with Autodesk VIZ Rendering 

Materials offer users of Autodesk® Architectural Desktop a seamless integra-
tion with VIZ Render. Material assignments prepare the drawing for editing 
and rendering in VIZ Render and AutoCAD. Furthermore, VIZ rendering 
materials can be imported into Autodesk Architectural Desktop drawings and 
applied to AEC objects. 

Related Topics and Procedures

� Objects that Support Materials

� Process Overview: Creating and Assigning Materials

� Material Components and Display Properties

� Displaying Materials in a Drawing

� Working with Surface Hatches

� Overriding the Surface Hatch on Individual Objects

� Override Operations

� Displaying a List of Materials

� Creating and Editing Materials
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Objects that Support Materials

Objects that you can assign materials are typically three-dimensional (3D) 
objects. Two-dimensional (2D) objects, such as areas, grids or AEC polygons, 
are more symbolic representations and drawing aids than actual building 
objects.

 Not all object components can take on a material. For example, a door swing 
cannot have a material assignment. Since a door swing is simply a symbolic 
graphic, it is not made of a material and therefore does not support a material 
assignment. The appearance of door swing is specified in the display proper-
ties of a door style. The door frame, however, is a physical part of the door. It 
is made of a material and can be assigned a material in the door style or the 
door.

Object Components that support materials

Curtain Walls/
Curtain Wall 
Units

infills
frames
mullions

Doors frames
panels
stops
insets
muntins

Door/Window 
Assemblies

infills
frames
mullions

Mass Elements mass element body

Mass Groups mass group body

Railings guardrails
handrails
bottom rails
posts
balusters

Roof roof body 

Slabs/Roof Slabs slab body
slab edge fascias
slab edge soffits
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Assigning Materials to Objects and Object Styles
Usually, you assign materials to object styles. All new objects based on the 
style have the same materials assigned to them. 

You can also assign materials directly to an object. You may want to do this 
in these cases:

� The object in question does not support styles, but does support materials. 
This is the case for roofs. 

� You want to override a material only for a specific object. 

Examples of Material Assignments
You can assign materials to objects in plan views, model views, section views, 
and rendered views. 

For example, if you want to draw a brick exterior wall, you can assign to it a 
material that displays a brick surface hatch in model view and a realistic brick 
display for a rendered view. If there are special insulation components in a 
wall, you can assign a light, half-transparent material to them. For sectioning 
the wall, you can assign a specific section hatch pattern that differs from the 
regular brick surface hatch.

Space Boundaries interior boundary
exterior boundary

Spaces floor
ceiling

Stairs tread
riser
landing

Structural 
Members

beam
brace
column body

Walls wall body
wall shrinkwrap
wall components

Windows glass
frames
sashes
muntins

Object Components that support materials
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Surface and section hatches assigned to walls

In another example, you can assign materials to the floor and ceiling compo-
nent of a space. You could assign a floor tiling material to the floor compo-
nent and a regular concrete material to the ceiling. 

Process Overview: Creating and Assigning 
Materials

Autodesk® Architectural Desktop offers a large number of predefined building 
materials in the drawing templates. You can, however, also create your own 
custom materials. 

The following steps describe how to create a material and assign it to an 
object or object style:

Step 1: Create a material definition for each material needed and specify the 
display properties of these materials. 

For example, create a brick material that shows a dark red surface hatch, 
matching dark red linework components, an appropriate section hatch, 
and a brick rendering material. Or create a glass material that has light 
blue linework, a transparent surface, and a light blue rendering material.

For more information, see “Creating and Editing Materials” on page 517.

Step 2: In object styles, assign a material to represent each component. 

For example, in a window style, assign the frame and the muntins a wood 
material and the window glass a glass material. Or, if you are working with 
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a wall style, assign a brick material to the wall body and an insulation 
material to insulation components. 

Step 3: Make sure that the corresponding display properties of the object or 
object style are in all display representations specified as By Material. 

Step 4: For object components that do not use materials, specify the display 
properties in each display representation. 

For example, if you want the swing graphic of a door to match the dark 
brown door frame, open the display properties of the door style, and 
change the color of the door swing to a dark brown. Perform this step for 
each display representation in which the door swing appears. 

When you create objects from these styles, their components are dis-
played as follows:

� If you have selected By Material in the Display Properties, then the 
object components that have materials assigned show the display prop-
erties you specified in the material definition. 

� Object components that have no materials assigned show the display 
properties you specified in the object style.

Material Components and Display Properties

Each material has the following display components that determine the 
appearance of object components to which a material has been assigned:

� Linework
� Plan Hatch 3D Body
� Surface Hatch
� Section Hatch
� Sectioned Body and Boundary

When you specify a material, the software determines which object compo-
nent to apply the material to. After you have specified display components 
of an object to be By Material, then you can no longer change the display 
component properties of that object.

The material components correspond to groups of object display properties 
or to display property types. For example, the material Linework component 
determines the appearance of linework components in 2D plan views, such 
as wall shrinkwraps, mass element boundaries or door frames. Surface Hatch 
determines the appearance of all surface hatching on objects in model and 
elevation views. 
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When you specify that an object component is displayed by material, the 
component uses the display properties of the associated material compo-
nent, instead of the display properties of the object.

Only object components that correspond to a physical component of the 
object can be assigned materials. For example, a door swing cannot have a 
material assignment because it is a symbolic graphic. The appearance of the 
door swing will always be set in the door display properties. The door frame, 
however, is a physical part of the door. It is made of a material and can be 
assigned a material in the door style or the door display properties.

Custom display blocks cannot have materials assigned. Objects that are 
within custom display blocks may have materials assigned.

For a detailed list of object components mapped to material components, see 
the Help topics for the objects. 

Related Topics

� Linework Material Component

� Plan Hatch Material Component

� 3D Body Material Component

� Surface Hatch Material Component

� Section Hatch Material Component

� Sectioned Body and Sectioned Boundary

Linework Material Component

The Linework component is used for object components representing line-
work in 2D plan and elevation views, such as wall boundaries, door frames, 
or mass element boundaries.

Viewing walls plan view linework material components
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Plan Hatch Material Component

The Plan Hatch component is used for hatching display components in plan 
views, such as wall component hatches, mass element hatches, and slab 
hatches.

Viewing walls plan view hatching material components

3D Body Material Component

The Body component is used for object components representing linework 
in 3D model views, such as wall bodies, mass element boundaries, door 
frames, and window frames.

Viewing walls 3D body material components

Surface Hatch Material Component

The Surface Hatch component is used for hatching display components in 
3D model views, sections, and elevations. In a section, the surface hatch 
component is used for components not cut by the section line. Components 
cut by a section line are displayed with a section hatch. 
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Viewing walls elevation view surface hatching material components

You can specify the faces of an object that display the surface hatch within 
the material definition. For example, you can specify that the hatch be only 
on the front and left side of the object.

Specifying wall face surface hatching assignments

For more information about determining the surface hatch faces, see “Speci-
fying the Surface Hatch Pattern of a Material” on page 523.
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2D Section/Elevation Linework

The 2D Section/Elevation Linework component is used specifically for 2D 
building sections or building elevations. All linework in a 2D section/eleva-
tion can be controlled by this component. For more information about using 
materials in sections, see “Surface Hatch Linework” on page 2137.

Wall displaying a 2D elevation linework component

Section Hatch Material Component

The Section Hatch component is used specifically for building sections. It is 
used for hatches on object faces cut by a section line. Section hatches can be 
applied to 2D sections, 3D sections, and live section views. For more infor-
mation on using materials on sections, see “Section Hatch Linework” on 
page 2137.

Wall displaying 2D section with section hatch

Sectioned Body and Sectioned Boundary

The Sectioned Body and Sectioned Boundary components display only in 
live section views. Live section views are a special section view of a 3D build-
ing model. The building objects are not converted into a section object but 
are retained as individual objects in the section. They keep all of their prop-
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erties and display components and may be edited in the section. The part of 
the objects that lies outside of the section line can be displayed or hidden. 
When the parts outside of the section line are displayed, they get special dis-
play components named Sectioned Body that control their appearance. 

For detailed information on live section views, see “Creating and Editing a 
Live Section View” on page 2110.

Live section view with sectioned body (grey) and sectioned boundary (red)

Displaying Materials in a Drawing

Use this procedure to turn on materials in a display representation if they are 
assigned to objects but are not displayed in the drawing.

1 On the Format menu, click Display Manager. 

2 Expand Configurations.

Material 
Component

Description

Sectioned Body the objects or object parts outside of the section

Sectioned Boundary the outline of the cut line created by the section
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The current display configuration is marked in bold.

3 Expand the current display configuration.

4 Select a display set in the current display configuration.

5 Click the Display Representation Control tab.

6 Scroll to Material Definition and select a display representation.

As a default, material definitions have only a General display representa-
tion. If this is the only available display representation listed, select it. If 
you created another display representation for materials, you can select 
that representation instead.

NOTE Make sure that you select only one display representation for mate-
rials in each display set. You should also verify that the component’s object 
layer is turned on.

7 Repeat steps 4 - 6 to select a display representation for materials in the 
other display sets in the current configuration.

8 Click OK.

The materials assignments you made now display in the drawing.

Working with Surface Hatches

Surface hatches are hatch patterns on three-dimensional (3D) objects that 
display in 3D model views and elevation views.

Each 3D object has a number of faces: Top, Bottom, Left, Right, Front, and 
Back. You can decide if it should carry a surface hatch or not. For example, if 
you view a wall in 3D view, you might want to hatch only the side facing you 
to avoid cluttering the drawing.

Which faces of an object carry the surface hatch is specified in the material 
definition. All objects that have that material assigned show the same surface 
hatch assignments, unless you create an individual surface hatch override. 

Defining the faces on a regular object such as a wall, slab or box-shaped mass 
element is intuitive. Front, Back, Left, Right, Top and Bottom are clearly 
defined faces that can easily be assigned materials. However, defining which 
direction each face lies in can be more complex for different, irregularly 
shaped objects such as curved objects, extrusion objects, or free form objects 
resulting from boolean operations. 
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For information on changing the surface hatch assignments of a material def-
inition, see “Specifying the Surface Hatch Pattern of a Material” on page 523. 

For information on surface hatch overrides, see “Overriding the Surface 
Hatch on Individual Objects” on page 510.

Specifying object face material assignments

Related Topics

� Surface Hatches on Curved Surfaces

� Surface Hatches on Multiple Faces

� Surface Hatch Material Component

� Surface Hatches on Free Form Mass Elements

Surface Hatches on Curved Surfaces
Curved surfaces do not have all of the view directions you can specify in the 
material definition. It is important to know the faces are designated on 
curved surfaces to understand how surface hatching is applied when these 
objects are assigned materials. 

An object with a vertically curved surface, such as a Barrel Vault mass ele-
ment, has no front and back faces, as there is nothing that could delineate 
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them. The curved surface of the Barrel Vault mass element is considered the 
top face of the object. 

Barrel vault mass element with material assigned to top face

An object with a horizontally curved surface, such as a Cylinder mass ele-
ment, has no left and right sides, as there is nothing to delineate them. The 
curved surface is considered the front face. 

Cylinder mass element with material assigned to front face

An object that has only one curved surface, such as a Sphere mass element, 
has only a front face. 

Sphere mass element with material assigned to front face

Surface Hatches on Multiple Faces
Irregular and complex objects can have multiple faces in one view direction. 
If necessary, you can override the surface hatch on all faces with the same 
view direction or on individual faces. For information on overriding individ-
ual faces, see “Overriding the Surface Hatch on Individual Objects” on 
page 510.
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Stair with material assigned to treads

Surface Hatches on Extrusions
The surface hatch placement on objects created from an extruded profile 
depends on two factors:

� the view directions assigned to the individual edges of the profile 
� the direction of the extrusion

The desired extrusion direction depends on the object you want to 
extrude from the profile. A rail, for example, is extruded in the X direc-
tion. A railing post is extruded in the Z direction. Custom door and win-
dow shapes are extruded in the Y direction. 

Face assignments from edges extruded in the X direction
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Face assignments from edges extruded in the Y direction

Face assignments from edges extruded in the Z direction

Specifying Faces on Extrusions
Use this procedure to specify the faces on object components created from 
extruding a profile. These objects and components include extruded mass 
elements, wall body modifiers, custom railing components, and other com-
ponents extruded from a profile.

When you create a profile, all the edges are marked for extrusion in the Z 
direction. These edge positions are calculated based upon the quadrant in 
which the midpoint of the edge lies. You can change the view direction of 
edges and the extrusion direction in the profile definition.
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Determine the direction of the profile edges before creating objects from the 
profile. For example, if you have created a profile for a custom railing baluster 
and specified the direction of the individual edges, any baluster added to the 
railing based on that profile has those assignments. If you later change the 
edge view directions in the profile, existing balusters do not change accord-
ingly. 

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Profiles.

3 Right-click the profile for the extrusion, and click Edit.

4 Click the Profile Edges tab. 

5 Select an extrusion direction.

6 For each edge, select a position that corresponds to the view direction you 
want to assign to the face created from that edge.

The edge positions that are available depend on the extrusion direction 
you selected. 

7 Click OK twice.

Surface Hatches on Free Form Mass Elements
Free Form mass elements are created when you perform a boolen operation 
on a regular mass element, adding, subtracting or intersecting another mass 
element from it. The resulting mass element can be irregularly shaped. 
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When a mass element is converted into a Free Form mass element, all previ-
ous material assignments of the source mass elements are lost. The new mass 
element reverts to the Standard material. You can assign another material to 
the new mass element. 

Overriding the Surface Hatch on Individual 
Objects

The surface hatch specified for a material determines the display of objects 
assigned the material in elevation and model views, as well as the appearance 
in rendered views. The material definition specifies which faces of objects—
Top, Bottom, Left, Right, Front, Back—display a surface hatch. 

However, in some instances, you may want to override the surface hatch for 
a selected face of an object. For example, you may want to turn off the surface 
hatch where it could obscure small details of an object when the drawing is 
plotted. 

Override Operations
You can edit the surface hatches for an individual object face:

� hide the surface hatch
� change the rotation of the surface hatch
� change the vertical and horizontal offsets of the surface hatch

You can also specify whether the changes are applied only to the selected face 
or to all faces of the object with the same direction—for example, to all front 
faces. 

Multiple Surface Hatch Overrides
You don’t need to create separate overrides for individual changes; you can 
create one surface hatch override that is both rotated and offset. In most 
cases, this is the preferred method of working. However, in some cases, you 
need to assign more than one override. For example, suppose you want to 
rotate the surface hatch of all front faces of a column, and you want to offset 
one individual front face. You first add an override for the rotation and select 
All Front Faces. Then you add an override for the offset in which you select 
Only Selected Front Face. 

Related Procedures

� Hiding a Surface Hatch
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� Specifying the Rotation of a Surface Hatch

� Specifying the Horizontal and Vertical Offset of a Surface Hatch

� Editing Surface Hatch Overrides

Hiding a Surface Hatch

Use this procedure to hide the surface hatch on an object face.

To add an override to a surface hatch, an object needs to have a surface hatch 
material assigned to it. A surface hatch on an object can come from an 
assigned material or from the display properties of the object or object style. 

If a surface hatch comes from the display properties of the object instead of 
the material assignment, you cannot override it on individual faces. You 
receive an error message upon selecting the object face. 

1 Select the object for which you want to hide an individual surface hatch, 
right-click, and click Materials ➤ Add Surface Hatch Override.

2 Select the object face where you want to hide the surface hatch. 

A profile surrounds the selected face. 

Profile defining a face of a wall

3 Specify where the override applies: 

If you want to . . . Then . . .

override only the selected face 
of the object

select Only Selected <Direction> Face for Faces. 
For example, to apply a surface hatch override 
only to the selected Front face of a wall, select 
Only Selected Front Face.

override all faces of the object 
in the same view direction

select All <Direction> Faces for Faces. For 
example, to apply a surface hatch override to all 
Top faces of a selected column, select All Top 
Faces.
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4 Select Hide Surface Hatching.

Surface hatch hidden on the front face of a wall

5 Click OK.

Displaying a Hidden Surface Hatch

Use this procedure to display a previously hidden surface hatch. 

An object must have a surface hatch material assigned to it in order to add 
an override to a surface hatch. A surface hatch on an object can come from 
an assigned material or from the display properties of the object or object 
style. 

If a surface hatch comes from the display properties of the object instead of 
the material assignment, you cannot override it on individual faces. You 
receive an error message upon selecting the object face. 

1 Select the object for which you want to re-display a hidden individual sur-
face hatch, right-click, and click Materials ➤ Edit Surface Hatch Over-
ride.

2 Select the profile around the hidden the surface hatch.

3 Right-click, and click Edit Hatch Override.

4 Clear Hide Surface Hatching.

5 Click OK.
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6 Select the profile, right-click, and click Save Changes.

Specifying the Rotation of a Surface Hatch

Use this procedure to specify the rotation of a surface hatch. 

1 Select the object for which you want to rotate an individual surface hatch, 
right-click, and click Materials ➤ Add Surface Hatch Override.

2 Select the object face where you want to change the rotation. 

A profile surrounds the selected face.

3 Specify where the override applies: 

4 Specify the rotation of the surface hatch. 

If you want to . . . Then . . .

override only the selected face 
of the object 

select Only Selected <Direction> Face for Faces. 
For example, to apply a surface hatch override 
only to the selected Front face of a wall, select 
Only Selected Front Face.

override all faces of the object 
in the same view direction

select All <Direction> Faces for Faces. For 
example, to apply a surface hatch override to all 
Top faces of a selected column, select All Top 
Faces.
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Specifying surface hatch rotation angles

5 Click OK. 

Specifying the Horizontal and Vertical Offset of a 
Surface Hatch

Use this procedure to specify the vertical and horizontal offset of a surface 
hatch. 

An object must have a surface hatch material assigned to it in order to add 
an override to a surface hatch. A surface hatch on an object can come from 
an assigned material or from the display properties of the object or object 
style. 

If a surface hatch comes from the display properties of the object instead of 
the material assignment, you cannot override it on individual faces. You 
receive an error message upon selecting the object face. 

Changing the offsets of a surface hatch lets you adjust the hatch pattern on 
individual faces to align with the face edges or to improve the appearance of 
the hatch.
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Specifying surface hatching offset and alignment

1 Select the object for which you want to change the hatch pattern offset, 
right-click, and click Materials ➤ Add Surface Hatch Override.

2 Select the object face where you want to change the hatch pattern offset. 

A profile surrounds the selected face.

3 Specify where the overrides applies:

4 Specify the horizontal and vertical offsets of the surface hatch. 

5 Click OK.

If you want to . . . Then . . .

override only the selected face 
of the object

select Only Selected <Direction> Face for Faces. 
For example, to apply a surface hatch override 
only to the selected Front face of a wall, select 
Only Selected Front Face.

override all faces of the object 
in the same view direction

select All <Direction> Faces for Faces. For 
example, to apply a surface hatch override to all 
Top faces of a selected column, select All Top 
Faces.
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Editing Surface Hatch Overrides

Use this procedure to edit a surface hatch override that you applied to an 
object.

1 Select the object that has a surface override you want to change, right-
click, and click Materials ➤ Edit Surface Hatch Overrides. 

2 Select the profile of the face you want to edit.

If you have multiple surface hatch overrides on one object face, ensure 
that you select the override you want to change.

3 Right-click, and click Edit Hatch Override.

4 Edit the surface hatch override: 

5 Click OK.

6 Select the profile, right-click, and select Save.

Displaying a List of Materials

Use this procedure to create a list of materials and their volumes for the 
objects that you select. 

The list includes all materials used in the selected objects as well as the total 
volume of each material. You can use that information for preliminary cost 
estimates. 

1 On the command line, enter MaterialList. 

2 Select the objects you want to include in the list, and press ENTER.

If you want to . . . Then . . .

hide a surface hatch select Hide Surface Hatching.

re-display a hidden surface 
hatch

clear Hide Surface Hatching.

change the rotation of the 
surface hatch enter a value for Rotation, or click  and specify 

the rotation on the drawing screen.

change the offset of the 
surface hatch enter a value for X Offset or Y Offset, or click  

and specify the offset on screen.
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3 Press F2. 

The materials list is displayed in the AutoCAD® text window.

NOTE You can also select the list of materials, press CNTRL + C to copy it, and 

then press CNTRL + V to paste the materials list into Microsoft® Word.

Displaying a Material Query

Use this procedure to obtain volume information for a selected material.

The query results includes the total volume for all objects with a selected 
material. For example, if you have two brick walls within your selection set 
that each have a volume of 8.85 m3, the overall volume of brick objects is 
listed as 17.7 m3. You can use that information for preliminary cost esti-
mates. 

1 On the command line, enter MaterialQuery. 

2 Select the objects you want to include in the query, and press ENTER.

3 Select the material you want to query. 

For example, if you want to query for bricks, select Brick from the list. 

4 Click OK.

All objects assigned the selected material are highlighted in the drawing.

5 Press F2.

6 The volume for the selected material is displayed in the AutoCAD® text 
window.

Creating and Editing Materials

Autodesk® Architectural Desktop provides a large number of predefined 
materials for all common design purposes so that you get an easy start with 
new drawings. You can use these predefined materials or modify them to 
your special designs. You can also create materials.

Each material has a set of display components that determine the appearance 
of objects to which a material has been assigned.
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Material components correspond to groups of object display properties or to 
display property types. For example, the Linework component determines 
the appearance of linework components in 2D plan views. Surface Hatch 
determines the appearance of all hatching on objects in model views. 

When you specify that an object display component is displayed by material, 
the component uses the display properties of the associated material compo-
nent instead of the display properties of the object or object style.

Only object components that correspond to a physical component of the 
object can be assigned materials. For example, a door swing cannot have a 
material assignment because the swing is a symbolic graphic. The display 
properties of a door or door style determine the appearance of the door 
swing. The door frame, however, is a physical part of the door. It can be 
assigned a material in the door style or in individual doors.

How Materials are Used
A material can be assigned to multiple object components and multiple 
objects. For example, one glazing material might be used in door styles, win-
dow styles, door/window assembly styles, and curtain wall styles. The 
appearance of the component with the same material is the same, regardless 
of where it is used. If you edit a material definition, such as the color of the 
glazing, the change applies everywhere the material is assigned in the draw-
ing.

Where you want a different appearance, you create a material definition for 
it and then assign the material where you want it used. For example, you 
might create one material for clear glass used in interior windows in an office 
building and another material for tinted glass used in exterior windows.

Naming Materials
When you select a material from the list, the materials are listed in alphabet-
ical order. You may want to devise a naming convention for your materials 
that lets you locate them quickly when you assign materials to components. 
For example, you might create glazing materials named “glass.interior.clear,” 
“glass.exterior.tinted,” and “glass.exterior.clear.” These would appear in the 
following order in the materials list:

� glass.exterior.clear
� glass.exterior.tinted
� glass.interior.clear

Managing Material Styles
To create, edit, copy, or purge material styles, you access the Style Manager. 

The Style Manager provides a central location in Autodesk® Architectural 
Desktop where you can work with styles from multiple drawings and 
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templates. For more information about using the Style Manager, see “Style 
Manager.”

Related Topics and Procedures

� Creating a Material Definition

� Defining the Layer, Color and Linetype of a Material

� Specifying the Plan and Section Hatch Patterns of a Material

� Specifying the Surface Hatch Pattern of a Material

� Assigning Materials for Rendering

� Excluding a Material from 2D Section Shrinkwrap

� Attaching Notes and Files to a Material Definition

Creating a Material Definition

Use this procedure to create a material definition.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

3 Create a material definition:

4 Enter a name for the new material definition, and press ENTER.

5 To edit the properties of your new definition right-click the definition, 
and click Edit:

If you want to . . . Then . . .

create a new definition 
with default properties

right-click Material Definitions, and click New.

create a new definition 
from an existing definition

right-click the material definition you want to copy, 
and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
material

click General. Enter a description of the material.

change the layer/color/
linetype properties

see “Defining the Layer, Color and Linetype of a 
Material” on page 520.
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6 When you finish changing the material properties, click OK twice.

Defining the Layer, Color and Linetype of a 
Material

Use this procedure to define the layer, color, and linetype of the material 
components. For a detailed description of the individual material compo-
nents, see “Material Components and Display Properties” on page 498.

NOTE If you turn off a display component in the material definition, all object 
components in the drawing that have that material assigned do not display in 
the drawing. For example, if you turn off the Linework component in a material, 
and assign that material to a door frame component, the door frame does not 
display in plan views.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

3 Select the material definition you want to change, right-click, and click 
Edit. 

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Object Override.

change the hatching 
patterns 

see “Specifying the Plan and Section Hatch Patterns 
of a Material” on page 521.

assign surface hatching to 
individual object faces

see “Specifying the Surface Hatch Pattern of a 
Material” on page 523

assign surface and live 
section rendering materials

see “Assigning Materials for Rendering” on 
page 526.

exclude components from 
2D shrinkwrap

see “Excluding a Material from 2D Section 
Shrinkwrap” on page 528

add notes, files, or 
documents to the 
definition

see “Attaching Notes and Files to a Material 
Definition” on page 530.

If you want to . . . Then . . .
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The display representation in bold is the current display representation.

6 If necessary, click 

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying the Plan and Section Hatch Patterns of 
a Material

Use this procedure to change the patterns for the Plan, Hatch, and Section 
Hatch components of a material. For a detailed description of the individual 
hatch components, see “Material Components and Display Properties” on 
page 498.

For specifying a surface hatch pattern, see “Specifying the Surface Hatch Pat-
tern of a Material” on page 523.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

3 Select the material definition you want to change, right-click, and click 
Edit. 

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

6 If necessary, click .

7 Click the Hatching tab.

8 Select Plan Hatch or Section Hatch, and click the setting for Pattern.

9 Select the hatching for the component:

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.
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10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is oriented:

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.

If you want to . . . Then . . .
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Specifying surface hatching orientation

14 Click OK twice.

Specifying the Surface Hatch Pattern of a 
Material

Use this procedure to specify the pattern used for the surface hatch. 
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Specifying material assignment by object face

NOTE After you assign a material to an object, you can edit the surface 
hatches for the individual faces of the object. For information on editing surface 
hatches, see “Overriding the Surface Hatch on Individual Objects” on page 510.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

3 Select the material definition you want to change, right-click, and click 
Edit. 

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

6 If necessary, click .

7 Click the Hatching tab.
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8 Select Surface Hatch, and click the setting for Pattern.

9 Select the hatching for the component:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is oriented:

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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Specifying surface hatch orientation

14 Click the Other tab.

15 For Surface Hatch Placement, select the object faces on which the surface 
hatching is displayed. 

16 Click OK twice.

Assigning Materials for Rendering

Use this procedure to assign materials for rendering object surfaces. 

In shaded view, rendered views, and when linking a drawing file to VIZ Ren-
der, objects may display rendering materials instead of the hatch patterns 
that are displayed in 2D wireframe and hidden line views. The following 
types of rendering materials are available:

Render Material 
Type

Description

Surface Rendering Material Any object face that has surface hatching applied 
displays the hatching in the AutoCAD® renderer or in 
VIZ Render

Live Section Rendering 
Material

All faces cut by a live section line display the live 
section rendering material when rendered with the 
AutoCAD® renderer or in VIZ Render
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You can assign rendering materials to two different component types: 

� Object surfaces: All object surfaces that have a surface hatch applied to 
them can also have rendering materials assigned. If you want to assign 
rendering materials to an object surface, make sure that the Surface Hatch 
component in the material definition is turned on. 

� Live section views: The Sectioned Body component of a live section view 
as well as the live section cut plane can have special rendering materials 
assigned. If you want to assign rendering materials to a live section view, 
make sure that the Sectioned Body component in the material definition 
is turned on. 

Rendered live section view with transparent outside component

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

Live Section Sectioned 
Boundary Rendering 
Material

All objects and object parts outside of the live section 
line display the sectioned boundary material when 
rendered with the AutoCAD® renderer or in VIZ Render

Render Material 
Type

Description
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3 Select the material definition you want to change, right-click, and click 
Edit. 

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

6 If necessary, click .

7 Click the Other tab.

8 Select rendering materials for the individual material components:

If you don’t find the right rendering material or want to see a preview of 
the material, click the Browse button and browse for the desired material. 

9 Select a new rendering material, if necessary. 

10 Click OK twice.

Excluding a Material from 2D Section Shrinkwrap

Use this procedure to exclude object components with a specific material 
assigned from the shrinkwrap of a 2D section. 

If you want to . . . Then . . .

assign a rendering material 
to object surfaces

select a material for Render Material. Then, select 
a mapping type for Mapping:

� If you select Same as Surface Hatch, only 
those surfaces which have been selected 
under Surface Hatch Placement are 
rendered.

� If you select Face Mapping, all surfaces are 
rendered and any hatch alignment overrides 
are ignored.

assign a rendering material 
to the cut plane of a live 
section view

select a material for Cut Surface Render Material.

assign a rendering material 
to the body component 
outside the live section line

select a material for Sectioned Body Render 
Material.
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When you create a 2D section, you can display a section component named 
Shrinkwrap. The shrinkwrap is the union of all object faces cut by the section 
line, merged into one component with one hatch pattern. This is a fre-
quently used view of a 2D section. 

By default, all components that are assigned materials are included in the 
shrinkwrap. However, you may want to exclude certain materials, such as 
glass, from the shrinkwrap.

2D Section Shrinkwrap with glass excluded from shrinkwrap (left)

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

3 Select the material definition you want to change, right-click, and click 
Edit. 

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

The display representation in bold is the current display representation.

6 If necessary, click .

7 Click the Other tab.

8 Select Exclude from 2D Section Shrinkwrap. 

9 Click OK twice.
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Attaching Notes and Files to a Material 
Definition

Use this procedure to enter notes and attach reference files to a material def-
inition. You can also edit notes and edit or detach reference files from a mate-
rial definition.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view. 

2 Expand Multi-Purpose Objects, and expand Material Definitions.

3 Select the material definition you want to change, right-click, and click 
Edit. 

4 Click the General tab.

5 To add a description to the material definition enter it for Description.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Style Manager

The Style Manager is a utility that provides a 

central location in Autodesk® Architectural 
Desktop where you can view and work with 
styles in drawings or from intranet sites. 

Styles
Styles are sets of parameters that you can assign 
to objects in Autodesk Architectural Desktop to 
determine their appearance or function. For 
example, a door style determines what door 
type, such as single or double, bi-fold or hinged, 
a door in a drawing represents. The door style 
also determines the shape of the door, such as 
rectangular or arched, default frame dimen-
sions, standard sizes, and display properties.

You assign a style to all instances of an object 
that you want to have the same characteristics. 
For example, you can assign one door style to 
all office doors in an office building and 
another door style to all fire doors in the build-
ing.

Objects in the software that use styles include 
two-dimensional (2D) sections and elevations, 
AEC Polygons, curtain walls, curtain wall units, 
doors, endcaps, mass elements, openings, rail-
ings, roof slab edges, roof slabs, schedule tables, 
slab edges, slabs, spaces, stairs, structural mem-
bers, wall modifiers, walls, window assemblies, 
and windows.

Using the Style Manager, you can also manage 
layer key styles, schedule data formats, and 
cleanup group, mask block, multi-view block, 
profile, and property set definitions.

In this chapter

� Getting Started with the Style 
Manager

� Creating a Style

� Creating a Tool from a Style

� Renaming a Style

� Copying Styles between 
Drawings

� Sending Styles to Other Users

� Purging Styles

9
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NOTE To view layer key styles in the Style Manager, run a Layer Management 
command (Layer Manager, Layer Key Styles, or Layer Key Overrides) before you 
display the Style Manager.

Using the Style Manager
The Style Manager allows you to readily create, customize, and share styles 
with other users. In the Style Manager, you can perform the following tasks:

� Access styles from open drawings and intranet sites
� Drag styles onto a palette to create tools
� Quickly set up new drawings and templates by copying styles from other 

drawings or templates
� Sort and view the styles in your drawings and templates by drawing or by 

style type
� Preview an object with a selected style
� Create and edit styles
� Delete unused styles from drawings and templates
� Send styles to other Autodesk Architectural Desktop users by email

Standard and Predefined Styles
Most of the objects in Autodesk Architectural Desktop have a default 
Standard style. Catalogs provided with the software contain additional pre-
defined styles that you can copy to tool palettes to use in your drawings. 

You can also access the styles for bar joists, curtain walls, doors, members, 
railings, roof slabs, slabs, spaces, stairs, walls, and windows, and property set 
definitions and schedule tables from drawings located in the \Documents and 
Settings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial or Metric folder. If you are running Windows 

NT®, these drawings are located in the \winnt\Profiles\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 2004\R16.0\Styles\Imperial or 
Metric folder.

Creating Tools from Styles
You can create object tools by dragging a style from the Style Manager to a 
tool palette. When you drag a style onto a tool palette to create a tool, a ref-
erence is created that associates the tool to the style. The reference location 
can be the current drawing, another drawing, or a remote location. If you 
edit the style in the Style Manager the tool automatically uses the updated 
style.

If an existing tool references a style from another drawing, the style is not 
added to the current drawing until you add an object of that style to the 
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drawing. The reference location is only used if the current drawing has been 
saved.

Upgrading from a Previous Release
If you are upgrading from Release 1 or Release 2 of Autodesk Architectural 
Desktop, the Style Manager replaces the Style dialog box used for creating, 
copying, editing, purging, importing, and exporting styles.

Related Procedures

� Getting Started with the Style Manager

� Creating a Style

� Creating a Tool from a Style

� Renaming a Style

� Copying Styles between Drawings

� Sending Styles to Other Users

� Purging Styles

Getting Started with the Style Manager

When you open the Style Manager, all the style information from all open 
drawings and templates is displayed. The Style Manager is split into two resiz-
able panes and has a menu bar, a toolbar, and a status bar.
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The Style Manager

Left Pane of the Style Manager
The left pane of the Style Manager organizes the styles in all open drawings 
and templates in a hierarchical tree view that you can navigate by expanding 
and collapsing the different levels in the tree. You can sort styles in the tree 
view by the drawing that contains them or by style type. The tree view is 
always displayed in the left pane, regardless of how you sort the styles.

Styles are organized into three categories: Architectural Objects, such as Door 
Styles; Documentation Objects, such as Schedule Table Styles; and Multi-Pur-
pose Objects, such as Layer Key Styles. Within each category, styles are listed 
alphabetically.

Right Pane of the Style Manager
The right pane of the Style Manager displays different style information 
depending on what you select in the tree view in the left pane. You can pre-
view how an object is displayed with a style, view style descriptions, view 
drawing information, and view the distribution of styles of a selected type 
across multiple drawings and templates.
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Style Manager Menu Bar and Toolbar
The top of the Style Manager includes a menu bar and a toolbar that enable 
you to quickly access the menu commands. If you position your mouse over 
a toolbar icon, a tooltip identifies the icon.

Status bar
The status bar at the bottom of the Style Manager indicates how the styles are 
sorted in the tree view. The status bar also lists the drawing and style type or 
style currently selected.

Related Procedures

� Opening the Style Manager

� Sorting Styles in the Style Manager

� Viewing Styles in the Style Manager

� Viewing Styles Across Multiple Drawings

� Working with Drawings and Templates in the Style Manager

Opening the Style Manager

Use this procedure to open the Style Manager. You also access the Style Man-
ager when you right-click object tools on the tool palettes.

When you open the Style Manager, all drawings and templates that are open 
in the current session are displayed in the tree view of the Style Manager.

1 On the Format menu, click Style Manager.
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Opening the Style Manager

NOTE If drawings or templates are read-only, their read-only status is indi-
cated by a lock on the folder next to the drawing in the tree view and also by 
a lock icon on the status bar.

2 Move and resize the Style Manager, or resize the left and right panes as 
needed to view style information.

Sorting Styles in the Style Manager

Use this procedure to sort information in the Style Manager by drawing and 
by style. When you open the Style Manager, the names of open drawings and 
templates are displayed in the tree view in the left pane.

When you expand a drawing in the tree view, the individual styles within the 
drawing are grouped into three categories: Architectural Objects, Documen-
tation Objects, and Multi-Purpose Objects. If you expand a category, the indi-
vidual styles are listed alphabetically by style type.
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Sorting styles by drawing in the Style Manager

To readily see the styles that are available in each drawing for a particular 
style type, such as door styles, you can sort the styles by style type. In style 
sorted view, styles are grouped by category, and organized by style type and 
then by drawing.



538 | Chapter 9 Style Manager

Sorting styles by style type

The status bar at the bottom of the Style Manager indicates whether the 
styles are sorted by drawing or by style type.

1 On the Format menu, click Style Manager.

By default, styles are sorted by drawing.

2 On the View menu, click Explore ➤ By Style.

3 Expand a category, a style type, and then a drawing to view the styles 
available in each drawing.

4 In the toolbar, click  to restore the by-drawing sort order.

5 Click  again to sort the styles by style type.
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Viewing Styles in the Style Manager

Use this procedure to preview how objects appear in selected styles and to 
view style descriptions. You can also filter styles to view only the styles of a 
selected type, such as wall styles.

NOTE Certain structural member styles do not display properly in the Style 
Manager Viewer or the Floating Viewer. This is because the “sample” member 
that displays in the viewer is a single segment that is relatively short. If a struc-
tural member style uses large start and end offsets (such as some of the Bar Joist 
sample styles) or requires multiple segments (such as a bent member), the 
viewer displays a defect marker. If properly defined, the member displays cor-
rectly when added to the drawing. 

1 In the Style Manager, expand the category and the style type that you 
want to view.

2 Select a style.

3 In the right pane, click the Viewer tab.

The object is displayed in the viewer with the characteristics of the 
selected style. Use the viewer control to see the object from different view 
directions and in wireframe, hidden, and shaded views.

4 Click the List tab to view information about the style.

The style description is generated by the AutoCAD® LIST command.

5 To view only the styles of one style type, select a style type, and in the tool-

bar, click .

Only the styles of the selected type, such as wall styles, are displayed in 
the Style Manager.

6 Click  again to display all styles.

Viewing Styles Across Multiple Drawings

Use this procedure to display a chart view of the styles of a single style type 
distributed across the drawings open in the Style Manager. In the chart, you 
can see the styles used in more than one drawing and the styles used only in 
a single drawing.

1 In the Style Manager, sort the styles by style type.
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2 In the tree view, click the style type with the styles that you want to view 
across the drawings.

In the right pane, a matrix lists the styles of the selected style type that are 
available in each drawing.

3 In the left pane, select a style.

4 In the right pane, click the Viewer tab.

The object is displayed in the viewer with the characteristics of the 
selected style. Use the viewer control to see the object from different view 
directions, and in wireframe, hidden, and shaded views.

5 Click the List tab to view information about the style.

The style description is generated by the AutoCAD® LIST command.

6 To view only the styles of one style type, select a style type, and in the tool-

bar, click .

Only the styles of the selected type, such as wall styles, are displayed in 
the Style Manager.

7 Click  again to display all styles.

Working with Drawings and Templates in the 
Style Manager

When you first open the Style Manager, any drawings or templates that are 

open in Autodesk® Architectural Desktop are displayed in the tree view. You 
can open other drawings or templates and create new drawings or templates 
within the Style Manager.

Opening drawings in the Style Manager
When you create a new drawing or template, or open an existing drawing or 
template within the Style Manager, the drawing or template is open for use 
within the Style Manager only, not in your drawing session. You can open 
the drawing in the software after you exit the Style Manager.
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Determining the status of a drawing
You can identify whether a drawing or template is open in the software or 
open only within the Style Manager. The icon next to the drawing or tem-
plate in the tree view indicates its status in the Style Manager:

A drawing may be locked in the Style Manager for the following reasons:

� The drawing is read-only.
� The drawing was created in a previous version of the software.
� The drawing is xrefed into a drawing that is currently open.
� The drawing is open in another application (for example, Volo View).
� The drawing file is locked on a network.

Hold the cursor over Lock in the status bar to view the reason for the lock in 
a tooltip.

TIP You can save your styles in a read-only source drawing and copy them to 
other drawings as necessary.

Closing drawings in the Style Manager
Any drawings and templates that you create or open in the Style Manager are 
displayed every time you open the Style Manager until you close them from 
within the Style Manager.

Related Procedures

� Starting a New Drawing or Template in the Style Manager

� Opening a Drawing or Template in the Style Manager

� Dragging a Drawing into the Style Manager

� Closing Drawings and Templates in the Style Manager

Drawing 
icon

Drawing status

Drawing is open in the software and in the Style Manager

Drawing is open only in the Style Manager 

Drawing is locked
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Starting a New Drawing or Template in the Style Manager
Use this procedure to start a new drawing or template in the Style Manager. 
The new drawing or template does not contain any styles and is open for use 
in the Style Manager only. It is not open in the Autodesk Architectural Desk-
top session. You can open the drawing in the software after you exit the Style 
Manager.

1 On the Format menu, click Style Manager.

2 In the Style Manager, click File ➤ New Drawing, or in the Style Man-

ager toolbar, click .

3 Under File Name, enter the new drawing name.

4 Under Save as Type, select Drawing (.dwg) to create a drawing, or select 
Drawing Template File (.dwt) to create a template.

5 Click Save.

6 Click OK.

Opening a Drawing or Template in the Style Manager
Use this procedure to open a drawing or template in the Style Manager. The 
drawing or template is open within the Style Manager only. It is not open in 
the Autodesk Architectural Desktop session. You can open the drawing in the 
software after you exit the Style Manager.

If you open an Autodesk Architectural Desktop Release 1 or 2 drawing in the 
Style Manager, the drawing is opened as a read-only drawing. 

1 On the Format menu, click Style Manager.

2 In the Style Manager, click File ➤ Open Drawing, or in the Style Man-

ager toolbar, click .

3 Select one or more files, and click Open. 

4 Click OK.

Dragging a Drawing into the Style Manager
Use this procedure to open a drawing or template in the Style Manager by 

dragging it from Microsoft® Windows® Explorer. The drawing or template is 
open within the Style Manager only. It is not open in the Autodesk Architec-
tural Desktop session. You can open the drawing in the software after you 
exit the Style Manager.

1 In the Style Manager, sort the styles by drawing.

2 Start Microsoft Windows Explorer.
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3 In Windows Explorer, select the drawing or template that you want to 
open in the Style Manager. 

4 Drag the drawing into the tree view in the Style Manager.

5 Click OK.

Closing Drawings and Templates in the Style Manager
Use this procedure to close the drawings and templates open only in the Style 
Manager. You cannot close drawings in the Style Manager that are open in 
the Autodesk Architectural Desktop session.

1 In the Style Manager, sort the styles by drawing.

2 Select the drawing or template that you want to close.

3 In the Style Manager, click File ➤ Close.

4 Click OK.

Creating a Style

Use this procedure to create a style. You can create a style using default style 
properties or by copying a style. After you create the style, you can edit the 
style properties to customize the characteristics of the style.

A style is not stored in the drawing until you exit the Style Manager. A style 
is saved in a drawing when you save the drawing.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand a category and then expand the style type for which you want to 
create a style. 

3 Create a style:

4 Enter a name for the new style, and press ENTER.

If you want to . . . Then . . .

create a style with 
default properties

right-click the style type, and click New.

create a style from an 
existing style

right-click the style you want to copy, and click Copy. 
Right-click, and click Paste.
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5 To edit the new style, right-click the style, and click Edit.

For more information about creating a specific objects style or definition, 
see the style or definition topics associated with the object.

6 When you finish specifying the properties of the style, click OK twice.

After you have created a style, you can drag the style onto a tool palette to 
create a tool. For more information, see “Creating a Tool from a Style” on 
page 544.

Creating a Tool from a Style

Use this procedure to create a tool from a style. You can create tools from the 
following styles and definitions: AEC Polygon, area group, area, curtain wall, 
curtain wall unit, door, door/window assembly, mask block, mass elements, 
multi-view block, railing, room object, roof slab, schedule table, slab, space, 
stair, structural member, wall, and window.

For detailed information about creating and customizing tools, see the 
appropriate topic in the Help for each object.

1 Open the tool palette where you want to create a tool.

2 On the Format menu, click Style Manager.

3 Locate the style you want to copy, and drag it to the tool palette.

The default tool name is the name of the referenced style.

The image that identifies the new tool uses the view direction last used in 
the property palette for the selected object type.

4 Click OK.

Renaming a Style

Use this procedure to rename a style.

1 In the Style Manager, right-click the style you want to rename, and click 
Rename.

2 Enter a new name for the style, and press ENTER.

3 Click OK.
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Copying Styles between Drawings

Use this procedure to copy styles or definitions from the current drawing to 
another drawing. You can copy styles and definitions between existing draw-
ings. You can also copy them from an existing drawing to a new drawing. 

If a style references other styles, those other styles are also copied to the other 
drawing. For example, if you copy a wall style into a new drawing, the wall 
endcap style used in the wall style is also copied to the new drawing.

NOTE You can also drag and drop styles and style types to copy them 
between drawings.

1 On the Format menu, click Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view. Any drawings open in the current session are also shown in the 
tree view.

2 In the Style Manager, open the drawing where you want to copy the style, 
if necessary:

3 Expand a category, and expand a style type.

4 Select the styles or definitions that you want to copy:

If you want to . . . Then . . .

copy the style to a drawing 
that is not open in the 
Style Manager

in the Style Manager, click File ➤ Open, select the 
drawing you want, and click Open.

copy the style to a new 
drawing

in the Style Manager, click File ➤ New drawing, 
enter a name for the drawing, and click Save. 

If you want to . . . Then . . .

copy an individual style or 
definition

right-click the style or definition, and click Copy.

copy all styles or 
definitions of a selected 
type, such as all wall styles

right-click the style or definition type, and click 
Copy. If your styles are sorted by style type, right-
click the drawing name under the selected style or 
definition type, and click Copy.
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5 Right-click the drawing where you want to copy the style(s), and click 
Paste.

The styles or definitions are copied into the selected drawing. If the draw-
ing already contains a style with the same name, the duplicate name is dis-
played in the Import/Export - Duplicate Names Found dialog box.

6 Resolve duplicate style names, if prompted:

7 Click OK. 

Sending Styles to Other Users

Use this procedure to e-mail styles or definitions to other users of Autodesk® 
Architectural Desktop. The software creates a new drawing that contains only 
the style information from the current drawing and attaches the drawing to 
an e-mail message. If e-mail is not available on your system, the Send option 
is not available.

1 On the Format menu, click Style Manager.

2 Expand a category.

3 Select the styles or definitions you want to send:

If you want to . . . Then . . .

prevent the Style Manager 
from overwriting the 
existing style with the new 
style of the same name

select Leave Existing, and click OK.

replace the existing style 
with the new style

select Overwrite Existing, and click OK.

keep the existing style and 
add the new style with a 
different name

select Rename to Unique, and click OK. 
The Style Manager appends a number to the name 
of the new style. Right-click a style, and click 
Rename to change a style name.

If you want to . . . Then . . .

send an individual style or 
definition

right-click the style or definition, and click Send.
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A new e-mail message with the subject “ADT Styles” is created using your 
e-mail program. A drawing file containing the styles and definitions you 
selected is added to the message as a file attachment.

4 Complete and send the message in your e-mail program.

5 Click OK.

Purging Styles

Use this procedure to remove unused styles and definitions from a drawing. 
You can purge any styles that are not applied to an object in the drawing and 
that are not used in another style. You can purge a single unused style or def-
inition. You can also purge all unused styles or definitions of a selected type. 
For example, you can purge all unused wall styles.

If a style references other styles or definitions, these are not purged when you 
purge the style that uses them. For example, if you purge a wall style, the wall 
endcap style and cleanup group definition used in the wall style are not 
purged.

1 On the Format menu, click Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

NOTE You can also purge a selected style or style type by pressing DELETE.

2 Expand a category, and expand a style type.

send all styles or definitions 
of a selected type, such as 
all wall styles

right-click the style or definition type, and click 
Send. If your styles are sorted by style type, right-
click the drawing name under the selected style or 
definition type, and click Send.

send all styles or definitions 
in the drawing (styles must 
be sorted by drawing)

right-click the drawing name, and click Send. 

If you want to . . . Then . . .
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3 Purge styles or definitions:

If a style or definition you selected to purge remains in the list after purg-
ing, the style or definition is currently applied to an object or is used in 
another style. For example, you cannot purge a wall endcap style that is 
used in a wall style or that is applied to an individual wall.

4 Click OK. 

If you want to . . . Then . . .

purge one unused style or 
definition

right-click the style or definition you want to 
remove, and click Purge.

purge all unused styles or 
definitions of a selected 
type

right-click the style or definition type, and click 
Purge. When prompted, verify that the styles you 
want to purge are selected, and click OK.
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Creating and Saving 
Drawings

Whether or not you work in a project environ-
ment, new Autodesk ® Architectural Desktop 
drawings have some common properties that 
you can specify when you create a drawing:

You can specify the template on which to base 
the drawing, or create a drawing that is not 
based on any template.

You can specify units, scale, layer standard and 
layer key style, and default display properties.

You can specify options that control drawing 
performance and behavior.

You also have a number of options for saving 
files for use with other applications, including 
AutoCAD® (without Autodesk Architectural 
Desktop). These options are useful if you work 
with vendors and consultants who do not use 
Autodesk Architectural Desktop.

Related Topics and Procedures

� About Templates

� Creating a Drawing from a Template

� Creating a Drawing from Scratch

� Opening Legacy Drawings

� Setting up a Drawing

� Specifying AEC Options

� Sharing Drawings with Other Users

� Publishing Drawings to Architectural Studio

In this chapter

� Publishing Drawings to 
Architectural Studio

� About Templates

� Creating a Drawing from a 
Template

� Creating a Drawing from 
Scratch

� Opening Legacy Drawings

� Setting up a Drawing

� Specifying AEC Options

� Sharing Drawings with Other 
Users

10



550 | Chapter 10 Creating and Saving Drawings

About Templates

The templates included in Autodesk® Architectural Desktop are drawing files 
with predefined settings that you use to create new drawings with the same 
settings. Templates have drawing units, drawing scales, and annotation plot 
sizes, that you would use in a typical project. Templates also contain a basic 
set of display configurations specific to working with architectural objects. 
You can get started on a project immediately by using one of the templates 
that are installed with Autodesk Architectural Desktop.

NOTE Tool catalogs and tool palettes provided with the software contain tools 
with sample object styles that you can add to drawings. Earlier version of the 
software stored this information in templates.

Architectural Desktop templates are installed by default in the folder, 
\Documents and Settings\All Users\Application Data\Autodesk\Autodesk Archi-
tectural Desktop\R16.0\enu\Template.

Templates contain layout tabs with predefined display configurations 
applied to viewports. You can use display configurations and viewports in the 
templates, or you can modify the display settings to suit your own office 
standards. The display system in Autodesk Architectural Desktop controls 
how objects are displayed. By specifying objects you want to display in a 
viewport and a view direction, you can produce different architectural dis-
plays, such as floor plans, reflected plans, elevations, 3D models, or sche-
matic displays. For more information, see “Display System” on page 435.

If you are a new user of Autodesk Architectural Desktop, it is recommended 
that you use a template to create your drawings until you are more familiar 
with the program.

You can also create templates by importing settings from a template into the 
current drawing, and then saving the current drawing as a template. For 
example, you can import the display configurations from the Autodesk 
Architectural Desktop template into another drawing. For more information 
about creating your own template, see “Use a Template File to Start a Draw-
ing” in the AutoCAD 2004 User’s Guide. For more information about import-
ing display settings to a custom template, see “Importing a Display Set” on 
page 480 and “Importing a Display Configuration” on page 478.
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Creating a Drawing from a Template

Use this procedure to create a drawing from an Autodesk Architectural Desk-
top® template. The default drawing templates provided with the software are 
located in\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop\R16.0\enu\Template. Template 
files use the .dwt extension.

NOTE To create a drawing that you want to include in a project, see “Process 
Overview: Working in a Project Environment” on page 221.

1 On the File menu, click New.

2 Select the template you want to use, or click Tools ➤ Find, and navigate 
to the template you want to use.

Selecting a template in the Select template dialog box

3 Click Open.

To view or change the default drawing settings for units, scale, layers, and 
display, see “Setting up a Drawing” on page 553.
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Creating a Drawing from Scratch

Use this procedure to create a drawing that is not based on a template. Draw-
ings that are not based on templates contain no customized or predefined 
settings, such as display configurations and layout tabs with viewports. 
Drawings from scratch use the default settings specified in the Drawing Setup 
dialog box.

If you are a new user of Autodesk Architectural Desktop, use a template when 
you want to create drawings until you are comfortable working with layout 
tabs and display configurations. After you are more familiar with the pro-
gram, you can create templates and customize your drawing settings by start-
ing from scratch. For more information, see “Creating a Drawing from a Tem-
plate” on page 551.

NOTE To create a drawing that you want to include in a project, see “Process 
Overview: Working in a Project Environment” on page 221.

1 On the File menu, click New.

2 Click the arrow next to Open.

3 Select Open with no Template–Imperial to begin a drawing in imperial 
units, or select Open with no Template–Metric to begin a drawing in met-
ric units.

For more information, see “Setting up a Drawing” on page 553.

Opening Legacy Drawings

Keep the following points in mind when you open drawings from earlier 
releases of Autodesk® Architectural Desktop:

� To upgrade a drawing from an earlier release to the current release, open 
the legacy drawing and then save the drawing. If the drawing references 
other legacy drawings, open and save these xref drawings to upgrade them 
to the current release.
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� Release 2 drawings are always fully opened; the partial open option is not 
available. 

� If you try to refedit a legacy drawing, a message is displayed stating that 
you need to update your previous drawings to the current release. It is rec-
ommended that you use the same version for your xref and host drawings.

� If you open a legacy drawing in the Style Manager, that drawing is marked 
as read-only, and you can to copy styles from that drawing to other draw-
ings but you cannot copy styles to the legacy drawing.

� Open and save a legacy drawing in the current version if you want to be 
able to edit them in DesignCenter.

Setting up a Drawing

When you create a drawing from an Autodesk® Architectural Desktop tem-
plate, the drawing setup options are predefined. You can use the predefined 
settings or customize them as needed. For example, you may want to use dif-
ferent drawing scales in individual drawings.

When you create a drawing from scratch (that is, without an Autodesk Archi-
tectural Desktop template), you specify settings for the drawing, such as layer 
standards and layer key styles to import to the drawing. For more informa-
tion, see “Creating a Drawing from Scratch” on page 552

You can save the drawing units, drawing scale, and layer options as the 
default settings for any drawing that you start from scratch or from a tem-
plate. 

If you are unfamiliar with the display system and layer management in 
Autodesk Architectural Desktop, review “Display System” on page 435 and 
“Managing Drawing Layers” on page 388before specifying the layering and 
display options.

In Autodesk Architectural Desktop, the LAYER and UNITS commands are as 
follows:

� Entering LAYER at the command line displays the Layer Manager for 
Autodesk Architectural Desktop.

� Entering UNITS at the command line displays the Units tab of the Draw-
ing Setup dialog box.

Related Procedures

� Specifying the Drawing Units

� Specifying the Drawing Scale
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� Specifying a Layer Standard and a Layer Key Style

� Specifying the Default Display Representations of AEC Objects

Specifying the Drawing Units

Use this procedure to specify the drawing units in a new or existing drawing. 
If you change the drawing units, you can specify whether existing objects in 
the drawing are scaled to the new units or retain their original scale. You can 
also specify whether you want to scale objects inserted from a drawing with 
different units to the units in the current drawing or at their original scale.

You can also specify the unit type and precision for linear, angular, area, and 
volume units. The precision values specify only the number of decimal places 
displayed in Autodesk® Architectural Desktop. They do not determine the 
number of decimal places used to make calculations. 

When you change the drawing units, the default options under Area and Vol-
ume change to reflect the new drawing units. The drawing scale options on 
the Scale tab also change to reflect the new drawing units. 

1 In the drawing status area, click .

2 Click Drawing Setup.

3 Click the Units tab.

4 Specify the drawing units.

The units that you select determine the unit of measurement that each 
unit in your drawing represents. For example, if you select Inches, each 
drawing unit equals one inch.

5 To scale objects that you insert into the current drawing from other draw-
ings with different drawing scales, select Scale Objects Inserted from Other 
Drawings. 

Clear this option to insert objects at their original scale.

6 Under Length, select a unit type and precision. 

7 Under Angle, select an angle type and precision.

If you want to measure angles clockwise instead of counterclockwise, 
select Clockwise.

8 Under Area, select an area type and precision. 

If you do not want to use the default suffix that is displayed for the draw-
ing units that you specify, enter a new suffix.

9 Under Volume, select a volume type and precision.
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If you do not want to use the default suffix that is displayed for the draw-
ing units that you specify, enter a new suffix.

10 Save the units settings:

NOTE You can save both default imperial and metric drawing unit and 
scale settings with the Save As Default option. When you start a drawing from 
scratch, specify English or Metric default settings in the Create a New Draw-
ing dialog box to use either the imperial or metric settings that you saved as 
the default settings. 

11 Click OK.

You are prompted to specify whether existing objects in the current draw-
ing should be scaled for the new units.

12 Specify scaling of existing objects for Model Space and Paper Space:

If you want to . . . Then . . .

save the units settings as 
the default settings for new 
drawings that you start 
from scratch or from 
templates that do not 
contain drawing setup 
information

select Save as Default. Settings on the Scale and 
Layering tabs are also saved as default settings.

save the units settings only 
for the current drawing

clear Save as Default.

If you want to . . . Then . . .

scale existing objects in 
Model Space

select Scale Model-Space Objects in Current 
Drawing to Reflect New Units.

leave objects in Model 
Space at their current size

clear Scale Model-Space Objects in Current 
Drawing to Reflect New Units.

scale existing objects in 
Paper Space

select Scale Paper-Space Objects in Current 
Drawing to Reflect New Units.

leave objects in Paper 
Space at their current scale

clear Scale Paper-Space Objects in Current Drawing 
to Reflect New Units.
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13 Click OK.

Specifying the Drawing Scale

Use this procedure to specify the drawing scale and the plot size of annota-
tions model space. Annotation plot size, multiplied by the drawing scale fac-
tor, determines the height of plotted annotation text. Scale-dependent 
objects in an Autodesk® Architectural Desktop drawing are automatically 
scaled to reflect the units that are specified in a drawing. Any styles that you 
create in metric or imperial units are scaled appropriately. 

1 In the drawing status area, click .

2 Click Drawing Setup.

3 Click the Scale tab.

4 Under Drawing Scale, select the drawing scale that you want to use.

 If you do not see the scale that you want to use, select Other and enter a 
drawing scale factor for Custom Scales. 

NOTE The scale values in the Drawing Scale list reflect the current drawing 
units. To change the drawing units, see “Specifying the Drawing Units” on 
page 554.

5 Enter a value for Annotation Plot Size.

6 Save the scale settings:

7 Click OK.

If you also changed the drawing units, you are prompted to specify 
whether existing objects in the current drawing should be scaled for the 

If you want to . . . Then . . .

save the scale settings as 
the default settings for new 
drawings that you start 
from scratch or from 
templates that do not 
contain drawing setup 
information

select Save as Default. Settings on the Units and 
Layering tabs are also saved as default settings.

save the scale settings only 
for the current drawing

clear Save as Default.
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new units. For more information, see “Specifying the Drawing Units” on 
page 554.

Specifying a Layer Standard and a Layer Key Style

Use this procedure to specify the layer standard and layer key style to deter-
mine the layers that objects are placed on in a drawing. You can specify the 
layer key style to use in the current drawing. You can also specify a layer stan-
dard and a layer key style to be imported when you set up a new drawing. 

Autodesk® Architectural Desktop includes the a number of layer standards 
and layer key styles in  AecLayerStd.dwg located in Documents and Settings\All 
Users\Application Data\Autodesk\Autodesk Architectural Desk-
top\R16.0\enu\Layers. 

If your drawing is based on an Autodesk Architectural Desktop template,  
AecLayerStd.dwg (located in the Layers folder mentioned above) is loaded. 
This file contains layer standards and layer key styles. 

NOTE If you are unfamiliar with layer keying in Autodesk Architectural 
Desktop, review the overview of layer keying before specifying layering options. 
See “Working with Layer Keys” on page 408 .

If you want to use LY files from AutoCAD® Architectural Desktop Release 1, 
you can create a layer key style from an LY file. For more information, see 
“Creating a Layer Key Style from an LY File” on page 415.

1 In the drawing status area, click .

2 Click Drawing Setup.

3 Click the Layering tab.

4 Under Layer Standards/Key File to Auto-Import, click the [...] button.

5 Navigate to a drawing that contains the layer standard and layer key styles 
you want to import, and click Open.

6 Under Default Layer Standard, select the layer key style that you want to 
use in your drawing.

7 To import the layer key style from the layer standard you specified, select 
Always import Layer Key Style when first used in drawing. 

Selecting this option has the affect of checking the current drawing to see 
if the selected layer key style exists. If it does exist, the date and time 
stored on it is checked and compared with the external file. If the external 
layer key style drawing is newer, then it re-imports the layer key style and 
standard.
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Specifying layering options for the current drawing and new drawings

IMPORTANT If you select Save as Default, the layer key style you select is 
the default layer key style for all new drawings, even if the drawings are based 
on templates that have a different default layer key standard.

8 Save the layer settings:

9 Click OK.

If you also changed the drawing units, you are prompted to specify 
whether existing objects in the current drawing should be scaled for the 
new units. For more information, see “Specifying the Drawing Units” on 
page 554.

If you want to . . . Then . . .

save the layers settings as 
the default settings for all 
new drawings

select Save as Default. Settings on the Units and 
Scale tabs are also saved as default settings.

save the layer settings only 
for the current drawing

clear Save as Default.
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Specifying the Default Display Representations of 
AEC Objects

Use this procedure to specify the default display representations of AEC 
objects. You can also specify the default display configuration for the Model 
tab and new viewports. In addition, you can specify whether the drawing 
uses its own display configurations or those of a host drawing when the 
drawing is referenced as an overlay xref in a host drawing.

You may find it easier to select and modify display representations using the 
Display Manager. The Display Manager is a utility that lets you manage 
default display information in your drawings. For more information about 
the display system, see “Display System” on page 435. For more information 
about usingt the Display Manager, see “The Display Manager” on page 449.

NOTE Changes you make on the Display tab apply only to the current draw-
ing. New drawings are not affected.

1 In the drawing status area, click .

2 Click Drawing Setup.

3 Click the Display tab.

4 To change the display representation for an object, select the object, and 
then select the display representation you want to use.

5 Select a display configuration for Default Display Configuration.

The display configuration is applied to the Model tab and new viewports.

6 To use the display configurations in the current drawing when the draw-
ing is referenced as an overlay xref in a host drawing, select When used as 
an Xref Overlay use Display Configurations from this drawing only.

Clear this option if you want objects in the current drawing to use the dis-
play configurations of the host drawing when the current drawing is an 
overlay xref.
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Specifying default display options for the current drawing

7 Click OK.

If you also changed the drawing units, you are prompted to specify 
whether existing objects in the current drawing should be scaled for the 
new units. For more information, see “Specifying the Drawing Units” on 
page 554.

Specifying AEC Options

Autodesk® Architectural Desktop adds several tabs to the AutoCAD® Options 
dialog box. You can use the AEC options to specify the default values for 
some architectural objects, to specify the location and type of content files, 
and to control performance while you are working with Autodesk Architec-
tural Desktop.

Related Procedures

� Changing the AEC Editor Settings

� Specifying AEC Object Settings

� Specifying the Display Resolution of Objects with Facets

� Changing the AEC Content Settings
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� Changing the AEC Project Defaults

Changing the AEC Editor Settings

Use this procedure to specify settings to control the following aspects of the 
software:

� the display of diagnostic essages
� the placement of dialog boxes and viewers on the screen
� whether objects retain their layer, color, and linetype when you explode 

them or export them to an AutoCAD® or DXF file

 To speed drawing performance, you can limit the snap points provided by 
certain display representations, and improve the layer loading time of the 
Layer Manager.

You can also specify settings for grip colors, and specify whether dynamic 
dimensions appear when you select and move grips to change the geometry 
of an object.

The AEC Editor settings that you specify are saved in the Windows® registry.

1 On the Format menu, click Options.

You can also display the Options dialog box by right-clicking in the com-
mand line area, and clicking Options.

2 Click the AEC Editor tab.

3 Under Diagnostic Messages, select options for displaying diagnostic 
messages on the command line: 

All diagnostic messages are off by default.

If you want to . . . Then . . .

display data about the 
relationship between 
objects in the drawing

select Object Relationship Graph.

display Display System 
errors

select Display Management System.

display object geometry-
specific data

select Geometry.
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4 Under Similar-Purpose Dialogs, select options for the default position of 
dialog boxes and viewers:

5 Under Optimize for Speed, select Object Snap to limit certain display rep-
resentations to respond only to the Node and Insert object snaps.

This setting affects stair, railing, space boundary, multi-view block, mask-
ing block, slice, and clip volume result (building section) objects.

6 Under Optimize for Speed, select Layer Manager to load layers into the 
Layer Manager faster.

If this option is cleared, each time you open the Layer Manager, the Layer 
Manager scans your current drawing to determine which layers are in use 
and which layers are not in use. After the layers are scanned and loaded 
into the Layer Manager, the status (in use/not in use) of each layer is indi-
cated by the icon to the left of the layer name in the Layer Manager.

When you select this option, the Layer Manager does not scan the draw-
ing to determine the status of the layers, speeding up the loading time. 
The icons that are displayed next to the layer name in the Layer Manager 
do not indicate whether or not the layer is in use.

7 Under Block Properties of Exploded Object, select Maintain Resolved 
Layer, Color, Linetype to maintain the layer, color, and linetype of AEC 
objects when you explode them.

When you explode an AEC object, you create several primitive objects 
grouped in a block definition. If this option is selected any objects whose 
component layer, color, and linetype properties are set to ByBlock take the 
layer, color, and linetype of the parent object. If this option is cleared, 
when you explode an object, properties that are ByBlock remain ByBlock. 
Clear this option if you want to explode the block definition even further.

8 To specify the units of measure for AutoCAD® drawings when they are 
opened in Autodesk Architectural Desktop, select Metric or Imperial for 
Units for Legacy Drawings.

If you want to . . . Then . . .

use a common position on 
the screen for similar 
dialog boxes

select Use Common Position. Some dialog boxes, 
such as those containing style properties, are always 
displayed in the center of the screen, regardless of 
this setting.

use a common position for 
similar-purpose viewers

select Use Common Viewer Position and Sizes. 
Some viewers are not controlled by this setting.
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This option enables the software to ignore the value for the AutoCAD 
MEASUREMENT variable to ensure that Autodesk Architectural Desktop 
respects the correct units when an AutoCAD drawing is opened in the 
software. Select Automatic if you want AutoCAD drawings to use the units 
that are current in Autodesk Architectural Desktop.

9 Under Export to AutoCAD, select Use Insert Method when binding Xrefs 
if you want all objects from an xref drawing referenced in the file you 
export to be incorporated into the host drawing.

If you select this option, the drawing names of the xref drawings are dis-
carded when the exported drawing is created. In addition, their layers and 
styles are incorporated into the host drawing. For example, all exploded 
walls, regardless of their source (host or xref) are located on the same layer.

Clear Use Insert Method when binding Xrefs if you want to retain the xref 
identities, such as layer names, when you export a file to AutoCAD or to 
a DXF file. For example, the blocks that define walls in the host drawng 
are located on A-Wall in the exploded drawing. Walls in an attached xref 
drawing are located on a layer whose name is created from the drawing 
name and the layer name, such as Drawing1|Wall-A.

10 Enter a prefix or a suffix to be added to the drawing filename when the 
drawing is exported to an AutoCAD drawing or a DXF file.

11 Under Unselected Grip Colors, select the colors you want to use for each 
type of grip.

12 Under Dynamic Editing, select Use Dynamic Editing if you want dimen-
sions to be displayed when you select and move grips.

The dimensions identify the current value of the dimension being edited, 
such as the length of a wall, the difference between the current value and 
the new dimension based on the position of the grip, and the total value. 
For example, when you select and move a Lengthen grip on a wall, the 
dimensions shown are the current length, the difference between the cur-
rent length and the length based on where you moved the grip, and the 
total new length of the wall. 

Clear this option if you do not want to see dimensions when you edit 
objects using grips.

13 Under Dynamic Editing, select a size for Dimension Text Size, and select 
the text color for the dimension value that you can edit for Focus Text 
Color.

14 Click OK.
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Specifying AEC Object Settings

Refer to the following topics to specify AEC options for walls, stairs, and the 
display of curved objects:

� “Specifying Drawing Defaults for Walls” on page 1758
� “Specifying AEC Options for Stairs” on page 1412
� “Specifying the Display Resolution of Objects with Facets” on page 564

Specifying the Display Resolution of Objects with 
Facets

Use this procedure to specify the facet deviation and the maximum number 
of facets that can be used to display a curved object, such as a Cylinder mass 
element, or a curved wall. The values you specify apply to the current draw-
ing.

The number you specify for facet deviation defines the maximum distance 
from the chord to the arc, the chord being an edge that is created from 
faceting the curve, to the true mathematical arc. The facet deviation must be 
greater than zero (0) and has no upper limit.

1 On the Format menu, click Options.

You can also display the Options dialog box by right-clicking in the com-
mand line area, and clicking Options.

2 Click the AEC Object Settings tab.

3 Under AEC Display Resolution, enter a value for Facet Deviation.

The default value is 1/2” for drawings created from imperial templates and 
is 12.7 mm for drawings created from metric templates. The value you 
enter is stored in the AecFacetDev variable.

4 Enter the maximum number of facets that can be used to draw curved 
objects.

You can enter a value between 100 and 10,000. The value you enter is 
stored in the AecFacetMax variable.

The default value is 500 for new drawings. Drawings created with earlier 
versions of Autodesk® Architectural Desktop have a default value of 128 
for this setting. 

5 Click OK.
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Changing the AEC Content Settings

Use this procedure to specify the location of the content files accessed by the 
Custom View in AutoCAD® DesignCenter, choose between imperial and met-
ric content, and specify whether the Edit Property Data dialog box is dis-
played when you insert schedule tags.

The AEC Content settings that you specify are saved in the Windows® regis-
try. 

1 On the Format menu, click Options.

You can also display the Options dialog box by right-clicking in the com-
mand line area, and clicking Options.

2 Click the AEC Content tab.

3 Under Content Path, edit the path and location of your content files, or 
click Browse to locate for content files.

4 To display the Edit Property Data dialog box when you insert a schedule 
tag in the drawing, select Display Edit Property Data Dialog During Tag 
Insertion.

5 Click OK.

Changing the AEC Project Defaults

Use this procedure to specify the folders in which Autodesk® Architectural 
Desktop searches for projects, palettes, templates, and other project files. 

1 On the Format menu, click Options.

You can also display the Options dialog box by right-clicking in the com-
mand line area, and clicking Options.

2 Click the AEC Project Defaults tab.

3 Expand a category, and select a path.

4 Change, add, or remove a path:

If you want to . . . Then . . .

change the current path select the path, and click Browse. Navigate to the 
new path, and click OK.

add a path to the list of 
paths

select the category, such as Default Project 
Template Files, and click Add. Specify the new path, 
and click OK. If Add is unavailable, you can specify 
only one path for this category.
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5 Select Show Project Browser at startup if you want to the Project Browser 
to open when you open Autodesk Architectural Desktop.

6 Click OK.

Sharing Drawings with Other Users

Autodesk Architectural Desktop provides a number of methods for making 
drawings available to users who do not have the software. The method you 
choose depends on the software others are using, how exactly the drawing 
must match the original drawing, and the views the user requires of the draw-
ing content.

Turning on Proxy Graphics
When you turn on proxy graphics in a drawing, users who do not have 
Autodesk Architectural Desktop but have another AutoCAD 2004-based 
product, such as Autodesk Land Desktop 2004, Mechanical Desktop 2004, or 
Autodesk Map 2004, can view and plot AEC objects and design data. 

Using the Object Enabler
The Object Enabler is a free application that users can install that lets them 
view, plot, manipulate, and copy AEC objects and design data in AutoCAD 
2004-based products.

Using AEC Object Explode
The AEC Object Explode feature lets you explode AEC objects in a drawing 
with some control over how the objects are exploded into primitive 
AutoCAD objects.

Exporting to AutoCAD Drawings and DXF Files
You can export Autodesk® Architectural Desktop drawings to AutoCAD® 
drawings for the following versions:

� AutoCAD 2004
� AutoCAD 2000 (including 2000i and 2002)

You can also export a drawing created in Autodesk® Architectural Desktop to 
a drawing interchange format (DXF) file. A DXF file is a text or binary file that 
contains drawing information that can be read by other CAD systems. For 

remove a path select the path, and click Remove. If Remove is 
unavailable, you can edit the path but you cannot 
delete it. 

If you want to . . . Then . . .
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more information about DXF files, see DXF Files in the AutoCAD 2004 User’s 
Guide.

You can export drawings to the following DXF formats:

� AutoCAD 2004 DXF
� AutoCAD 2000 DXF (including 2000i and 2002)
� AutoCAD Release 12 DXF

Exporting drawings to an AutoCAD drawing or to a DXF file creates a sepa-
rate drawing in which all AEC objects, such as walls, doors, windows, and 
roofs, are exploded to AutoCAD primitive objects, such as lines, arcs, and 3D 
faces. The resulting AutoCAD objects cannot be converted back to Autodesk 
Architectural Desktop objects. 

NOTE You can open DXF files generated in earlier versions of Autodesk Archi-
tectural Desktop in the software if the files do not contain any AEC objects. DXF 
files that contain AEC objects cannot be imported into Autodesk Architectural 
Desktop 2004.

Related Topics and Procedures

� Comparing Methods of Sharing Drawings

� Generating Proxy Graphics

� Using the Object Enabler

� Exploding AEC Objects

� Viewport Layer Mapping

� Managing Xrefs

� Exporting a Drawing to AutoCAD

� Exporting a Drawing to a DXF File
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Comparing Methods of Sharing Drawings

The following table lists the features of the various methods of sharing 
Autodesk® Architectural Desktop drawings with other users who do not have 
the software.

Generating Proxy Graphics

Use this procedure to create proxy graphics in an Autodesk Architectural 
Desktop drawing you want to make available to users who do not have the 
software. 

Proxy graphics store the last viewed image of AEC objects, which lets users 
view your drawing without modifying the original objects. Proxy graphics 
store only the display representation for the current active viewport. 

NOTE Depending on the complexity and density of the drawing, a drawing 
saved with proxy graphics turned on can become extremely large and slow 
drawing performance. It is recommended that you make a copy of the drawing 

Proxy 
Graphics

Object 
Enabler

AEC Object Explode, 
Export to AutoCAD 
(DWG or DXF)

Use of AEC objects 
in other AutoCAD-
based applications

View/plot AEC 
objects and 
design data; no 
manipulation of 
objects

View, plot, 
copy, 
manipulate AEC 
objects and 
design data

View, plot, manipulate AEC 
objects and design data

Status of AEC 
objects in other 
applications

AEC objects are 
displayed as 
proxy graphics 
with no 
intelligence

AEC objects are 
maintained as 
intelligent 
objects

No AEC objects

Multiple 
representations of 
objects in different 
viewports

No Yes Yes

AEC objects still 
exist when 
reopened in 
Autodesk 
Architectural 
Desktop

Yes Yes No
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without proxy graphics before turning them on in the drawing you want to 
share with other users.

1 Arrange the view for which you want to create proxy graphics.

2 At the command line, enter Proxygraphics.

3 Enter 1.

4 Save the drawing.

5 To turn off proxy graphics, enter Proxygraphics, and then enter 0.

Using the Object Enabler

Users who do not have Autodesk® Architectural Desktop but who have an 
AutoCAD® 2004-based product can install the Object Enabler to view your 
drawing exactly as you created it. The Object Enabler is available on the 
Autodesk Architectural Desktop installation CD and on the Autodesk web 
site. There is no charge for its distribution.

After a user installs the Object Enabler, the user can open the drawing and 
view, plot, manipulate, and copy AEC objects using standard AutoCAD com-
mands. AEC objects are maintained as intelligent objects, and the drawing be 
re-used in Autodesk Architectural Desktop.

Exploding AEC Objects

Use this procedure to explode AEC objects in a drawing that you want to 
share with users who do not have Autodesk® Architectural Desktop. The 
exploded AEC objects become AutoCAD primitive objects, such as block def-
initions, lines, arcs, and 3D faces, and lose their intelligence as architectural 
objects. The exploded objects cannot be restored to AEC objects.

Using this method of sharing drawing information is appropriate for users 
who do not have AutoCAD-based applications, but who can open an 
AutoCAD format drawing that contains primitive objects.

WARNING! Before you explode AEC objects, save a copy of the original 
drawing. After AEC objects are exploded into AutoCAD primitive objects, they 
cannot be restored to AEC objects.

1 If the CAD Manager menu is not displayed, on the Window menu, click 
Pulldowns ➤ CAD Manager Pulldown.

2 On the CAD Manager menu, click Explode AEC Objects.
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3 Specify whether to explode AEC objects:

4 Specify the views in which to explode AEC objects:

5 Select Re-use Existing Layer and Block Names if you are converting all lay-
outs.

Selecting this option minimizes the number of layers and block defini-
tions produced when a drawing is exploded more than once. Clear this 
option if you want to preserve the exact appearance of the AEC objects in 
the viewports.

If you want to . . . Then . . .

explode all AEC objects to 
AutoCAD primitive objects

select Explode AEC Objects To Primitive Graphics. 
Proceed to step 4.

remove AEC objects 
without creating AutoCAD 
objects from them

clear Explode AEC Objects to Primitive Graphics. 
Proceed to step 5. Use this option if you have 
exploded individual AEC objects needed by other 
users, and now want to remove any other AEC 
object data from the drawing.

If you want to . . . Then . . .

explode objects as they 
appear in the current view 
on the Model tab, the 
active Model space 
viewport on a layout tab, 
or an entire layout tab if 
Paper space is active

select Current View. 

explode objects on all 
layout tabs, creating block 
definitions for each 
viewport on each layout 
tab

select All Layouts. Select Model Tab as Additional 
Block if, in addition to the layout tabs, you want to 
create a block definition for the objects as they 
currently appear on the Model tab. For more 
information, see “Viewport Layer Mapping” on 
page 572.
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6 If the drawing contains xref drawings, specify how they are bound to the 
host drawing when exploded:

For more information, see “Managing Xrefs” on page 573.

NOTE Do not select both Explode to Anonymous Blocks and Maintain 
Resolved Layer, Color, Linetype, or clear both options. Select one option and 
clear the other as described in the following steps.

7 Select Explode to Anonymous Blocks if you want AEC objects to be 
exploded to blocks that contain the primitive objects for each AEC object.

If you select this option, it is recommended that you clear Maintain 
Resolved Layer, Color, Linetype. If you clear Explode to Anonymous 
Blocks, the primitive objects created from an exploded AEC object are not 
maintained in a single block.

8 Clear Maintain Resolved Layer, color, Linetype if you selected Explode to 
Anonymous Blocks.

Select Maintain Resolved Layer, Color, Linetype if you cleared Exploded to 
Anonymous Blocks. Selecting this option ensures that objects with 
ByBlock properties inherit the layer, color, and linetype of their parent 
AEC object.

9 Select Erase AEC Objects if you want to remove the original objects from 
the drawing after they are exploded to primitive objects.

10 Select Shorten Symbol Names, and enter a maximum length if the 
exploded drawing will be referenced into another drawing.

The range is 20-31. For example, if the maximum length were set to 20, 
the block “I_CASE_CORNER_WALL 30IN HIGH_F” would be renamed 
“I_CASE_CORNER_WALL~1”. If you require more control over the final 
names, use the RENAME command.

If you want to . . . Then . . .

maintain the xref drawing 
name as part of the layer 
names for its objects when 
exploded

select Bind Xref, and select Bind.

incorporate objects from 
the xref drawing onto the 
layers created for the host 
drawing

select Bind Xref, and select Insert.
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TIP You can also use Shorten Symbol Names to create shorter symbol 
names without doing anything to AEC objects. If you select this option, but 
Explode AEC Objects To Primitive Graphics and Erase AEC Objects are not 
selected, the AEC objects remain unchanged, and all existing symbol names 
are shortened to the selected length. 

11 Select Display Status Messages if you want to display messages at the com-
mand line that show the progress of the conversion to primitive graphics.

The messages list the objects that are exploded and erased.

12 Click OK.

13 When the conversion to primitive objects is complete, save the drawing. 
Be sure to change the drawing name so that the original drawing still has 
intact AEC objects.

Viewport Layer Mapping

AEC objects have the ability to display themselves differently in each view-
port. When AEC objects are exploded into AutoCAD primitive entities, each 
display representation must create a different set of primitives. For each view-
port, a new layer and a new block definition are created to hold all exploded 
entities. A block reference (INSERT) to this definition is also created and 
placed on the given layer. For the given viewport, all layers created for other 
viewports are then frozen so that only the graphics for the display represen-
tation that was originally visible remain visible.

For a given layout tab, the following block definitions are created:

AecObjExplode_LayoutName_PspaceBlock containing AEC objects in paper 
space
AecObjExplode_LayoutName_Vport_VportHandle1Block containing AEC objects 
from MVIEW 1
AecObjExplode_LayoutName_Vport_VportHandle2Block containing AEC objects 
from MVIEW 2
…
AecObjExplode_LayoutName_Vport_VportHandleN
LayoutName is the name of the specific layout tab, and VportHandle# is the 
unique AutoCAD entity handle for that specific viewport.

NOTE To determine the handle for a viewport, enter LIST at the command 
line and select the viewport boundary. The handle is a hexadecimal number, 
such as 4D2A.
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A layer is also created with the same names so that the blocks that do not 
apply to that viewport can be on a frozen layer, and thus not visible.

The “template” used to generate the block and layer names is stored in the 
Windows Registry under the key (note that the language code, shown as 409, 
will vary depending on your locale):

//HKEY_CURRENT_USER/Software/Autodesk/AutoCAD/R16.0/ACAD-204:409/
AEC/4.0/AecObjExplode40/Preferences
/AecObjExplode/Preferences
You can change these templates to be another character string, but it must 
contain the “%1!s!” and similar format specifiers that are currently present. 
The format specifiers are replaced by the layout name and the viewport han-
dle number in the final block and layer names.

NOTE When in the Model tab (TILEMODE=1), all representations are visible at 
the same time. This is because there is no way to freeze a layer in a tiled viewport 
without freezing it in all PaperSpace viewports. However, you can freeze all but 
one of the viewport layers to get the desired representation.

Managing Xrefs

Exploding AEC objects into primitive AutoCAD® objects is more complex 
when you do not use the “Automatically Bind Xrefs” option. This is because 
objects in xrefs actually belong to a different drawing file than the one that 
they are currently being viewed in. There are two methods you can use to 
convert the xref files.

� Use the Bind Xrefs option. This performs an Xref Bind on all xrefs before 
beginning the conversion process. This option ensures that the visual 
appearance of the converted drawing remains the same as the original. 
However, this also results in the xref drawing becoming part of the con-
verted drawing.

� Run the Explode AEC Objects command on each of the xref drawings first, 
before running it on the host file. This also requires you to re-identify all 
converted xrefs when you have changed their name by specifying a differ-
ent output file. 

NOTE First copy all the parent and all xref drawing files. Then open the parent 
drawing, and use the Xref Manager to change the Saved Path for each Xref. 
Select them one at a time, and change each file name in the Xref Found At edit 
box. Finally, open, explode and save each of the drawings.
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You should choose this method only when keeping the drawing as separate 
xrefs is mandatory. Also, in some cases you may not get the exact same 
graphics. This is because objects in the xref drawings display themselves 
based on the display configuration in effect for a given viewport in the host 
drawing. However, when the xref drawing is converted, the objects only 
know about viewports from their own drawing. If the same display configu-
ration is not used in both drawings, the graphic output when converted to 
AutoCAD primitives may be different. 

For example, if the xref drawing only has a single viewport that shows the 
plan representation, but both plan and model representations are used in the 
host file, exploding the files separately gives you only the plan representa-
tion in the final file. If the xref drawings have multiple representations, you 
need to clear one or more xref viewport layers in the host drawing to get the 
appropriate representations in each viewport.

Exporting a Drawing to AutoCAD

Use this procedure to export a drawing created in Autodesk® Architectural 
Desktop to AutoCAD®. This process creates a new AutoCAD 2004 or 2000 
drawing with all AEC objects exploded. The original drawing is not affected.

Depending on the size and complexity of the original drawing, the resulting 
AutoCAD drawing may contain very large numbers of primitive objects, 
which can affect drawing performance.

NOTE When you export a drawing to an AutoCAD drawing, all AEC objects 
are exploded to AutoCAD primitive objects. Reopening the file in Autodesk 
Architectural Desktop does not restore these primitive objects to AEC objects.

1 Choose whether to export a single representation of the AEC objects, or 
all visible representations. 

If the Model tab is displayed, only the representations in the current active 
view will be generated. If any layout tab is displayed, the representations 
for ALL layouts will be generated. This will usually result in duplicate 
graphics on the model tab, which makes the drawing less useful for some 
purposes.

For example, when creating a drawing for a consultant to use as an xref 
attached background, you should have a top view displayed in the active 
Model tab viewport. When creating a drawing to be used to produce a ren-
dering, you should have an isometric view displayed in the active Model 
tab viewport.
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To create a drawing that includes the exact graphics used in all layout tab 
viewports, have any layout tab active. These drawings can be sent to a 
printing service, for example, to make plots without the need for 
Autodesk Architectural Desktop or the object enabler.

2 Enter the command UCS ➤ World.

It is important that the active Model viewport has the UCS set to World. 
Otherwise the resulting objects will be rotated from the current orienta-
tion.

3 On the File menu, click Export to AutoCAD, and click the version you 
want to use.

4 Enter a filename, and specify a path, if necessary.

The default filename includes any prefix or suffix that you specified on 
the AEC Editor tab of the Options dialog box. For more information, see 
“Changing the AEC Editor Settings” on page 561.

5 Click Save.

Exporting a Drawing to a DXF File

Use this procedure to export a drawing created in Autodesk® Architectural 
Desktop to a drawing interchange format (DXF) file. A DXF file is a text file 
that contains drawing information that can be read by other CAD systems. 
For more information about DXF files, see DXF Files in the AutoCAD® 2004 
User’s Guide.

You can export drawings to the following DXF formats:

� AutoCAD 2004 DXF
� AutoCAD 2000 DXF (including 2000i and 2002)
� AutoCAD Release 12 DXF

This process creates a new DXF file with all AEC objects exploded. The origi-
nal drawing is not affected.

Depending on the size and complexity of the original drawing, the resulting 
AutoCAD drawing may contain very large numbers of primitive objects, 
which can affect drawing performance.

NOTE When you export a drawing to a DXF file, all AEC objects are exploded 
to AutoCAD primitive objects. Reopening the file in Autodesk Architectural Desk-
top does not restore these primitive objects to AEC objects.
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1 On the File menu, click Export to AutoCAD, and click the DXF format you 
want to use.

2 Enter a filename, and specify a path, if necessary.

The .dxf extension for the file name is specified by default. The default file 
name also includes any prefix or suffix that you specified on the AEC Edi-
tor tab of the Options dialog box. For more information, see “Changing 
the AEC Editor Settings” on page 561.

3 Click Save.



Publishing Drawings to Architectural Studio | 577

Publishing Drawings to Architectural Studio

You can “publish” or electronically plot floor plans, sections, elevations, and 
other building model views to Autodesk® Architectural Studio, an Internet-
based conceptual design and collaboration environment designed to repli-
cate a designer’s desktop.

Any view on a layout tab of an Autodesk® Architectural Desktop drawing can 
be published to Autodesk Architectural Studio, where you can use pen-based 
input devices with the Autodesk Architectural Studio conceptual design, 
sketching, modeling, and presentation tools to work with your published 
designs. For example, a designer could publish an Autodesk Architectural 
Desktop floor plan to Autodesk Architectural Studio, where a project archi-
tect could sketch on top of it in Autodesk Architectural Studio.

A conceptual design sketched on top of a floor plan in Autodesk Architectural Studio

Exporting Autodesk Architectural Studio files to Autodesk Architec-
tural Desktop
You can also export Autodesk Architectural Studio files to Autodesk Architec-
tural Desktop. Three-dimensional conceptual models from Autodesk Archi-
tectural Studio can be imported into Autodesk Architectural Desktop, where 
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building models can take shape. 3D solids in your Autodesk Architectural 
Studio drawings are imported to Autodesk Architectural Desktop as Free 
Form mass elements. For more information, see the Autodesk Architectural 
Studio Help system.

Publishing a Drawing to Autodesk Architectural 
Studio

Use this procedure to publish any view on a layout tab in Autodesk Architec-
tural Desktop to Autodesk Architectural Studio. When you publish a view of 
an Autodesk Architectural Desktop building model to Autodesk Architectural 
Studio, you use a plotter configuration file (PC3) to electronically plot your 
designs to Autodesk Architectural Studio in Drawing to Web Format (DWF).

NOTE Because DWF files are 2D vector files, 3D views are published to 
Autodesk Architectural Studio as 2D line drawings. Any views that are currently 
using AutoCAD SHADE or RENDER will not display as shaded or rendered in 
Autodesk Architectural Studio.

For more information about DWF, see DWF Files in the online AutoCAD 2004 
User’s Guide.

1 Start Autodesk Architectural Studio.

Architectural Studio must be running to publish an Autodesk Architec-
tural Desktop layout.

2 In Autodesk Architectural Desktop, select the layout tab in the drawing 
with the view that you want to publish.

3 On the File menu, click Page Setup.

4 Click the Plot Device tab.

5 Under Plot configuration, from the Name list, select a DWF plotter config-
uration.

6 Click the Layout Settings tab.

7 Specify the size, orientation, plot scale, plot area, and plot options for the 
layout.

For more information, see Overview of Layout Setup in the online 
AutoCAD 2004 User’s Guide.

8 Click OK.

9 In Autodesk Architectural Desktop, in the drawing status area, click .

10 Click Publish to Architectural Studio.
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A meter displays the plot progress to Autodesk Architectural Studio. The pub-
lished Autodesk Architectural Desktop layout displays in Autodesk Architec-
tural Studio as a DWF drawing on a sheet of trace, a yellow overlay designed 
to look like a sheet of tracing paper.
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Creating Conceptual 
Models

A conceptual model, which represents the idea for a 

building design, is comprised of a variety of building 

blocks. In Autodesk® Architectural Desktop, the build-

ing blocks include mass elements, mass groups, spaces, 

and slices. Combined, they produce a three-dimen-

sional (3D) model.

In this Chapter

� Mass Elements and Mass 
Groups

� Using Massing Tools to Create 
Mass Elements

� Editing Mass Elements

� Mass Element Styles

� Using Massing Tools to Create 
Mass Groups

� Using Materials for Mass 
Elements and Mass Groups

� Using the Model Explorer to 
Create Mass Models

� Spaces

� Space Boundaries

� Creating Slice Floorplates from 
a Conceptual Model

11
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Mass Elements and Mass Groups

Mass elements are primitive parametric objects that have specific shapes, 
such as arch, box, cylinder, and gable. They function as the building blocks 
of conceptual design (also schematic design) in Autodesk Architectural Desk-
top. You can create preliminary studies, or mass models, by grouping mass 
elements together in mass groups. 

Mass Groups and Mass Models
When you create a mass group, you can combine the shapes of mass ele-
ments in the mass group by adding, subtracting, and intersecting them in a 
specific order. The resulting complex shape of the mass group forms your 
conceptual building design, or mass model. The mass model defines the basic 
structure and proportion of a building model.

Developing Mass Models
As you continue developing your mass model, you can combine mass ele-
ments into mass groups and create complex building shapes by adding, sub-
tracting, and intersecting the mass elements.

After you create a mass group, you can change mass elements in the mass 
group as necessary to reflect the building design. You can edit individual 
mass elements that are attached to a mass group to further refine the building 
model. You can also nest mass groups within other mass groups. For more 
information, see “Creating a Mass Group” on page 628.

Using the Model Explorer
You can use the Model Explorer to create your entire mass model, or you can 
create your mass model in the current drawing. You can also modify your 
mass model or change the relationships of mass elements in the mass model 
in the Model Explorer. In addition to a graphics area that displays the mass 
model, the Model Explorer has a tree view in which you can drag and drop 
mass elements and mass groups to arrange and view the building blocks of 
your model in a hierarchical structure. For more information, see “Using the 
Model Explorer to Create Mass Models.”

When creating massing studies, you can create mass groups with any 
AutoCAD 3D object, including AutoCAD ACIS solids. These can be combined 
with mass elements in the Model Explorer to allow more complex studies of 
potential designs. However, only objects that have volume affect the appear-
ance of the mass group. For example, a polyline, even with thickness, does 
not contribute to the mass group.
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Continuing Building Design from a Mass Model
The mass model that you create with mass elements and mass groups is a 
refinement of your original idea that you carry forward into the next phase 
of the project, where you can slice floorplates from the mass model. You can 
convert the floorplates to space boundaries to start space planning, or you 
can convert them to polylines and then to walls to begin your building 
design. 

Display Configurations and Layouts for Mass Modeling
Drawings created from templates provided with Autodesk® Architectural 
Desktop contain display configurations and layouts that enable you to work 
effectively with mass elements and mass groups. For example, one layout has 
two viewports: one is assigned a display configuration that displays only 
mass groups and another display configuration that displays only mass ele-
ments.

Materials in Mass Elements
In Autodesk Architectural Desktop, you can assign materials to a mass ele-
ment. These materials are displayed in wireframe and working shade views, 
or when linked into VIZ Render. Materials have specific settings for individ-
ual components of a mass element, such as linework or surface hatches.

Mass elements with assigned materials in rendered view

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for roof slabs. 
You can use these predefined materials, or modify them to your special 
designs. You can also create your own materials from scratch.
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For more information, see “Using Materials for Mass Elements and Mass 
Groups” on page 641.

Other Uses of Mass Elements and Mass Groups
You can also use mass elements and mass groups to create three-dimensional 
body pieces of the building model. For example, you can apply them to walls 
as 3D body modifiers.

Related Procedures

� Using Massing Tools to Create Mass Elements

� Editing Mass Elements

� Mass Element Styles

� Creating a Mass Group

� Using Materials for Mass Elements and Mass Groups

� Using the Model Explorer to Create Mass Models

Using Massing Tools to Create Mass Elements

Tools provided with Autodesk® Architectural Desktop let you quickly place 
mass elements by selecting a tool from the Massing tool palette. Each mass-
ing tool has a specific mass element style and other predefined properties. 
When you place mass elements using massing tools, you can use the default 
settings of the tool, or you can change settings for the mass element proper-
ties. You can also use massing tools to apply the settings of a massing tool to 
existing mass elements.
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Tool palettes containing massing tools

The default tool palettes in the workspace contain sample massing tools that 
you can use and customize as needed. In addition, the following catalogs pro-
vided with the software contain massing tools that you can add to your tool 
palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� My Tool catalog

Custom palettes created by your CAD manager or other users may also con-
tain massing tools with mass element styles and properties that are custom-
ized for your projects or office standards.

Related Procedures

� Creating a Mass Element

� Creating a Mass Element with User-Specified Settings

� Creating an Arch Mass Element

� Creating a Barrel Vault Mass Element

� Creating a Box Mass Element
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� Creating a Pyramid Mass Element

� Creating an Isosceles Triangle Mass Element

� Creating a Right Triangle Mass Element

� Creating a Cone Mass Element

� Creating a Cylinder Mass Element

� Creating a Dome Mass Element

� Creating a Sphere Mass Element

� Creating a Gable Mass Element

� Creating a Drape Mass Element

� Creating a Doric Column Mass Element

� Creating Profiles for Extrusion and Revolution Mass Elements

� Creating a Mass Element by Extruding a Profile

� Creating a Mass Element by Revolving a Profile

� Converting 3D Objects to Mass Elements

� Creating a Mass Element Tool

Creating a Mass Element

Use this procedure to add a new mass element that has the properties speci-
fied in the massing tool that you select. To specify settings when you add a 
mass element, see “Creating a Mass Element with User-Specified Settings” on 
page 589.

Shapes of Mass Elements
To create mass elements, you start with basic shapes and then manipulate 
them for the desired result. The twelve basic mass element shapes are Arch, 
Barrel Vault, Box, Pyramid, Isosceles Triangle, Right Triangle, Cone, Cylinder, 
Dome, Sphere, Gable, and Drape. You can also create custom mass elements 
by extruding and revolving profiles and by creating free form mass elements.

You can modify a mass element based on its shape. For example, you can 
specify the width, depth, and height of a box mass element, and the radius 
and height of a cylinder mass element. For more information, see “Editing 
Mass Elements” on page 601.

Specifying the Size of Mass Elements
When you create a mass element, you can graphically specify some size 
parameters:

� A rectangular mass element is any element that has four lines at its base 
such as an Arch, Barrel Vault, Box, Gable, Pyramid, Isosceles Triangle, or 
Right Triangle. You can graphically specify the width, depth, and height 
of rectangular mass elements.
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� When you create a circular mass element, you graphically specify all the 
valid size parameters. Circular mass elements are Cone, Cylinder, Dome, 
and Sphere.

Some parameters are fixed during input; for example, the radius of an arch is 
automatically one quarter of the width, and the rise of a gable is automati-
cally half of the height. These parameters can be edited after the mass ele-
ments are placed in the drawing.

1 Open the tool palette that you want to use, and select a massing tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the mass element.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the next point.

This point can be the second corner (for a rectangular mass element) or 
the radius (for a circular mass element).

4 Specify the height, if prompted.

5 Specify the rotation of the mass element.

6 Continue adding mass elements, and press ENTER.

Creating a Mass Element with User-Specified 
Settings

Use this procedure to add a mass element with settings that you specify.

1 Open the tool palette that you want to use, and select a massing tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Select a shape.

5 Specify the mass group to which to attach the mass element.

6 Expand Dimensions.

The options that display under Dimensions depend on the shape you 
selected for the mass element.
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7 Specify the dimensions of the mass element:

8 In the drawing area, specify the insertion point of the mass element.

You can move or hide the Properties palette to expose more of the drawing 
area.

9 Continue adding mass elements, and press ENTER.

Creating an Arch Mass Element

Use this procedure to dynamically create an Arch mass element. The inser-
tion point of an Arch mass element is at the centroid of its bottom face.

Arch mass element in 3D and plan views

1 On the Massing tool palette, select the Arch tool.

2 Specify the first corner of the Arch.

3 Drag the cursor and specify the second corner of the Arch.

4 Drag the cursor and specify the height of the Arch.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Arch mass elements, and press ENTER.

If you want to . . . Then . . .

specify the width of the mass element 
in its relative X direction

enter a value for Width.

specify the depth of the mass element 
in its relative Y direction

enter a value for Depth.

specify the height of the mass element 
in its relative Z direction

enter a value for Height.

specify the radius of the mass element enter a value for Radius.

specify the rise of the mass element enter a value for Rise.
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Creating a Barrel Vault Mass Element

Use this procedure to create a Barrel Vault mass element. The insertion point 
of the Barrel Vault mass element is at the centroid of its bottom face.

Barrel Vault mass element in 3D and plan views

1 On the Massing tool palette, select the Barrel Vault tool.

2 Specify the first corner of the Barrel Vault.

3 Drag the cursor and specify the second corner of the Barrel Vault.

4 Enter a rotation angle, or press ENTER to accept the default angle of 0.

5 Continue adding Barrel Vault mass elements, and press ENTER.

Creating a Box Mass Element 

Use this procedure to create a Box mass element. The insertion point of the 
Box mass element is at the centroid of its bottom face.

Box mass element in 3D and plan views

1 On the Massing tool palette, select the Box tool.

2 Specify the first corner of the Box.

3 Drag the cursor and specify the second corner of the Box.

4 Drag the cursor and specify the height of the Box.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Box mass elements, and press ENTER.
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Creating a Pyramid Mass Element

Use this procedure to create a Pyramid mass element. The insertion point of 
a Pyramid mass element is at the centroid of its bottom face.

Pyramid mass element in 3D and plan views

1 On the Massing tool palette, select the Pyramid tool.

2 Specify the first corner of the Pyramid.

3 Drag the cursor and specify the second corner of the Pyramid.

4 Drag the cursor and specify the height of the Pyramid.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Pyramid mass elements, and press ENTER.

Creating an Isosceles Triangle Mass Element

Use this procedure to create an Isosceles Triangle mass element. The insertion 
point of an Isosceles Triangle mass element is at the centroid of its bottom 
face.

Isosceles Triangle mass element in 3D and plan views

1 On the Massing tool palette, select the Isosceles Triangle tool.

2 Specify the first corner of the Isosceles Triangle.

3 Drag the cursor and specify the second corner of the Isosceles Triangle.

4 Drag the cursor and specify the height of the Isosceles Triangle.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Isosceles Triangle mass elements, and press ENTER.
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Creating a Right Triangle Mass Element

Use this procedure to create a Right Triangle mass element. The insertion 
point of a Right Triangle mass element is at the centroid of its bottom face.

Right Triangle mass element in 3D and plan views

1 On the Massing tool palette, select the Right Triangle tool.

2 Specify the first corner of the Right Triangle.

3 Drag the cursor and specify the second corner of the Right Triangle.

4 Drag the cursor and specify the height of the Right Triangle.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Right Triangle mass elements, and press ENTER.

Creating a Cone Mass Element

Use this procedure to create a Cone mass element. The insertion point of the 
Cone mass element is at the centroid of its bottom face.

Cone mass element in 3D and plan views

1 On the Massing tool palette, select the Cone tool.

2 Specify the insertion point of the Cone.

3 Drag the cursor and specify the radius of the Cone.

4 Drag the cursor and specify the height of the Cone.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Cone mass elements, and press ENTER.
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Creating a Cylinder Mass Element

Use this procedure to create a Cylinder mass element. The insertion point of 
the Cylinder mass element is at the centroid of its bottom face.

Cylinder mass element in 3D and plan views

1 On the Massing tool palette, select the Cylinder tool.

2 Specify the insertion point of the Cylinder.

3 Drag the cursor and specify the radius of the Cylinder.

4 Drag the cursor and specify the height of the Cylinder.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Cylinder mass elements, and press ENTER.

Creating a Dome Mass Element

Use this procedure to create a Dome mass element. The insertion point of the 
Dome mass element is at the centroid of its bottom face.

Dome mass element in 3D and plan views

1 On the Massing tool palette, select the Dome tool.

2 Specify the insertion point of the Dome.

3 Drag the cursor and specify the radius of the Dome.

4 Enter a rotation angle, or press ENTER to accept the default angle of 0.

5 Continue adding Dome mass elements, and press ENTER.
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Creating a Sphere Mass Element

Use this procedure to create a Sphere mass element. The insertion point of a 
Sphere mass element is at its centroid.

Sphere mass element in 3D and plan views

1 On the Massing tool palette, select the Sphere tool.

2 Specify the insertion point of the Sphere.

3 Drag the cursor and specify the radius of the Sphere.

4 Enter a rotation angle, or press ENTER to accept the default angle of 0.

5 Continue adding Sphere mass elements, and press ENTER.

Creating a Gable Mass Element

Use this procedure to create a Gable mass element. The insertion point of a 
Gable mass element is at the centroid of its bottom face.

 Gable mass element in 3D and plan views

1 On the Massing tool palette, select the Gable tool.

2 Specify the first corner of the Gable.

3 Drag the cursor and specify the second corner of the Gable.

4 Drag the cursor and specify the height of the Gable.

5 Enter a rotation angle, or press ENTER to accept the default angle of 0.

6 Continue adding Gable mass elements, and press ENTER.
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Creating a Drape Mass Element

Use this procedure to create a Drape mass element. A drape is useful when 
working with a conceptual model of a building site because you can create 
polylines at different elevations that represent topographic lines, and then 
drape a mass element over the polylines to show the contours of the site.

Creating a Drape mass element

1 On the Massing tool palette, select the Drape tool.

2 Select the polylines to represent contours, and press ENTER.

3 Select the mesh corner, and then select the opposite mesh corner.

4 Enter the mesh size, and press ENTER.

5 Enter the base thickness, and press ENTER.

Creating a Doric Column Mass Element

Use this procedure to create a Doric Column mass element. The insertion 
point of a Doric column mass element is at the centroid of its bottom face.
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Doric Column mass element in 3D and plan views

1 On the Massing tool palette, select a massing tool.

2 In the Properties palette, select Doric for Shape.

3 Specify the insertion point of the Doric column.

4 Drag the cursor and specify the radius of the Doric column.

5 Drag the cursor and specify the height of the Doric column.

6 Enter a rotation angle, or press ENTER to accept the default angle of 0.

7 Continue adding Doric column mass elements, and press ENTER.

Creating Profiles for Extrusion and Revolution 
Mass Elements

Use this procedure to define a profile from a polyline to create either of the 
following mass elements:

� Extrusion mass element, in which the shape of the two-dimensional (2D) 
profile is projected to create a three-dimensional (3D) mass element

� Revolution mass element, in which the 2D profile is revolved around its 
X axis to create a 3D mass element

You can draw more than one polyline within the outermost polyline to cre-
ate voids in the resulting mass element. Polylines cannot intersect or overlap.

1 Draw one or more closed polylines in the shape you want to extrude or 
revolve.

2 Select the polyline, right-click, and click Convert To ➤ Profile Defini-
tion.

3 Enter c (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the mass 
element.

4 Press ENTER to specify a New profile definition.
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5 Enter a name for the profile, and click OK.

You can now use the profile as an Extrusion or Revolution mass element. 
For more information, see “Creating a Mass Element by Extruding a Pro-
file” on page 598 or “Creating a Mass Element by Revolving a Profile” on 
page 599.

Creating a Mass Element by Extruding a Profile

Use this procedure to create a custom-shaped mass element by using a profile 
as the basis of its shape. The extrusion projects the shape of the profile to cre-
ate the mass element.

The width and depth of the Extrusion mass element are based on the original 
width and depth of the profile. You can specify different width and depth 
values if necessary.

The insertion point is at the centroid of the bottom face of the Extrusion 
mass element.

Creating an Extrusion mass element from a profile

1 Create the profile to use as the basis of the mass element.

For more information, see “Creating Profiles for Extrusion and Revolution 
Mass Elements” on page 597.

2 On the Massing tool palette, select the Extrusion tool.

3 On the Properties palette, expand Basic and expand General.

4 Select the profile you created in step 1 for Profile.

5 Specify the insertion point in the drawing.

6 Specify the height of the Extrusion mass element.

7 Specify a rotation angle, or press ENTER for a rotation angle of zero degrees.

8 Press ENTER.
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Creating a Mass Element by Revolving a Profile

Use this procedure to create a mass element by defining a profile as the basis 
of its shape and then revolving the profile about an axis. The axis of revolu-
tion is along the X axis of the profile as it is drawn. The insertion point is at 
the centroid of the bottom face of the Revolution mass element.

Creating a Revolution mass element from a profile

1 Create a profile to use as the basis of the mass element.

For more information, see “Creating Profiles for Extrusion and Revolution 
Mass Elements” on page 597.

2 On the Massing tool palette, select the Revolution tool.

3 On the Properties palette, expand Basic and expand General.

4 Select the profile you created in step 1 for Profile.

5 Specify the insertion point in the drawing.

6 Specify a rotation angle, or press ENTER for a rotation angle of zero degrees.

7 Press ENTER.

Converting 3D Objects to Mass Elements

Use this procedure to convert AEC objects and other AutoCAD® ACIS solids 
to Free Form mass elements. When you convert an object to a Free Form mass 
element, the object is split into a collection of faces that compose the original 
shape.

NOTE When you convert objects to Free Form mass elements, your drawing 
size increases, potentially slowing drawing performance.

1 On the command line, enter masselement.

2 Enter c (Convert), and press ENTER.

3 Select the AEC object(s) or AutoCAD ACIS solid(s) that you want to con-
vert to a Free Form mass element, and press ENTER.
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4 Enter y (Yes) to erase the layout geometry, and press ENTER.

5 Enter n (Name) to name the mass element, and press ENTER.

6 Enter a name, and press ENTER three times.

Creating a Mass Element Tool

Use this procedure to create a mass element tool and add it to a tool palette. 
You may want to create your own mass element tools if you are placing mul-
tiple mass elements of specific styles with additional mass element properties 
that you want to be the same each time you add a mass element of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the mass element 
created from this tool, and click OK.

8 Specify a layer key and any layer overrides if you do not want to use the 
layer assignments specified in the layer key style used in the drawing.

If you want to . . . Then . . .

create a tool from a mass 
element in the drawing

select the object, and drag it to the tool 
palette.

create a tool from a mass 
element style in the Style 
Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool and click Copy; open the 
other palette, and click Paste.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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9 Select a mass element style.

10 Select the drawing file containing the style used for this mass element.

11 Select a shape.

12 Expand Dimensions.

The options that display under Dimensions depend on the mass element 
tool you copied to create the new tool.

13 Specify the dimensions of the mass element:

14 Click OK.

Editing Mass Elements

After you create mass elements, you can edit and reposition them to generate 
the general form of your building mass model.

You can use grips to manipulate mass elements after you create them. The 
grip editing features available depend upon the shape of the selected mass 
element. Because mass elements are parametric, each mass element shape 
has specific behavior when you modify it. For example, if you select and drag 
the corner grip point of a Box mass element, the width and depth of the mass 
element are modified.

Autodesk® Architectural Desktop offers several methods for editing mass ele-
ments:

� You can directly edit mass elements using grips for dimensions and other 
physical characteristics.

If you want to . . . Then . . .

specify the width of the mass element 
in its relative X direction

enter a value for Width.

specify the depth of the mass element 
in its relative Y direction

enter a value for Depth.

specify the height of the mass element 
in its relative Z direction

enter a value for Height.

specify the radius of the mass element enter a value for Radius.

specify the rise of the mass element enter a value for Rise.
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� You can change mass element settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

mass element.

Related Procedures

� Using Grips to Edit Mass Elements

� Changing the Area of a Rectangular Mass Element

� Changing the Height of a Mass Element

� Moving a Mass Element

� Changing the Arch Radius of an Arch Mass Element

� Changing the Roof Height of a Gable Mass Element

� Changing the Rise of a Gable Mass Element

� Changing the Radius of a Circular Mass Element

� Changing the Shape, Size, and Mass Group of a Mass Element

� Editing the Faces of a Mass Element

� Assigning Materials to a Mass Element

� Specifying the Display Properties of a Mass Element

� Specifying the Hatching of a Mass Element

� Changing the Location of a Mass Element

� Attaching Hyperlinks, Notes, or Files to a Mass Element

Using Grips to Edit Mass Elements

Refer to the illustrations and steps in this topic to use mass element grips to 
edit mass elements.

Editing Mass Element Dimensions

1 Select the mass element.

2 Select the grip for the dimension you want to change.
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Viewing mass element grips and dimensions

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.

Changing the Location or Position of a Mass Element

1 Select the mass element.

2 Select the Location grip.

3 Move the mass element to the desired location, and click once.

Viewing a mass element Location grip
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Changing the Area of a Rectangular Mass 
Element

Use this procedure to change the area of a rectangular mass element using 
grips. A rectangular mass element is any element that has four lines at its 
base, such as an Arch, Barrel Vault, Box, Gable, Pyramid, Isosceles Triangle, 
Right Triangle, or Extrusion.

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the mass element area dimensions on the Properties pal-
ette.

Editing a Box mass element with its corner grip

1 Select the rectangular mass element to display its grips.

2 Click a corner grip, and move it to the new location.

The location of the opposite corner remains fixed while you are moving 
the mass element corner.
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Changing the Height of a Mass Element

Use this procedure to change the height of a mass element using grips.

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the mass element height on the Properties palette.

Editing a Pyramid mass element with its Height grip

1 Switch to a 3D view.

2 Select the mass element to display its grips.

3 Click the Height grip at the top of the mass element, and move it to the 
new location.

The height of the mass element changes as you move the grip.

Moving a Mass Element

Use this procedure to move a mass element using grips.

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the mass element location on the Properties palette.
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Moving a Dome mass element with its Location grip

1 Select the mass element to display its grips.

2 Click the Location grip, and move it to the new location.

The entire mass element moves as you move the grip.

Changing the Arch Radius of an Arch Mass 
Element

Use this procedure to change the radius of the arch within an Arch mass ele-
ment using grips. 

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the arch radius on the Properties palette.
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Editing an Arch mass element with its Radius grip

1 Select the Arch mass element to display its grips.

2 Click the Arch Radius grip, and move it to the new location.

The radius of the arch changes as you move the grip.

Changing the Roof Height of a Gable Mass 
Element

Use this procedure to change the roof height of a Gable mass element using 
grips.

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the Gable roof height on the Properties palette.
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Editing a Gable mass element with its Height grip

1 Switch to a 3D view.

2 Select the Gable mass element to display its grips.

3 Click the Height grip at the midpoint of the roof ridgeline.

4 Move the grip to change the height of the roof.

The height of the roof ridgeline and the walls changes as you move the 
grip, leaving the roof slope and gable configuration unchanged.

Changing the Rise of a Gable Mass Element

Use this procedure to change the wall height of a Gable mass element using 
grips.

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the gable rise on the Properties palette.
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Editing a Gable mass element with its Rise grip

1 Switch to a 3D view.

2 Select the Gable mass element to display its grips.

3 Click the Rise grip at the top of the wall. 

4 Move the grip to change the height of the wall.

The height of the wall changes as you move the grip, while the roof ridge-
line position remains fixed. This changes the roof slope and gable config-
uration.

Changing the Radius of a Circular Mass Element

Use this procedure to change the radius of a circular mass element using 
grips. Circular mass elements include Cones, Cylinders, Domes, Doric Col-
umns, Spheres, and Revolutions.

For more information about mass element grips, see “Using Grips to Edit 
Mass Elements” on page 602.

You can also change the mass element radius on the Properties palette.
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Editing a Dome mass element with its Radius grip

1 Select the circular mass element to display its grips.

2 Click the Radius grip on the mass element. 

You can select any one of the radius grips on the same circle to change the 
size.

3 Move the grip in or out.

The mass element becomes larger or smaller depending on the direction 
you move the grip.

Changing the Shape, Size, and Mass Group of a 
Mass Element

Use this procedure to change a mass element into another mass element 
shape, add it to a mass group, and change its size.

1 Double-click a mass element.

2 Expand Basic, and expand General.

3 Select a new basic shape for Shape.

4 To attach the mass element to a mass group, select a mass group for 
Attached to.

5 Expand Dimensions.

6 Enter new dimension values for the mass element.
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NOTE When you change the size of a mass element, the center point 
remains constant and the change is applied to both sides of the element. 

Combining Mass Elements Using Boolean 
Operations

Use this procedure to combine mass elements using Boolean operations.

1 Select the mass element to which you want to join another mass element.

2 Selected the desired Boolean operation:

3 Select the objects you want to combine, and press ENTER.

4 Enter y (Yes) to erase the original geometry, or enter n (No) to keep the 
original geometry in the drawing.

Dividing a Mass Element

Use this procedure to divide a mass element. The divide plane you specify 
splits the original mass element into two separate mass elements.

1 Select the mass element you want to divide, right-click, and click Split.

2 Specify the divide plane start point.

3 Specify the divide plane end point.

If you want to . . . Then . . .

combine the total volume of two or 
more mass elements into a composite 
object

right-click, and click 
Boolean ➤ Union.

remove the common area of one mass 
element from another

right-click, and click 
Boolean ➤ Subtract.

remove non-overlapping portions and 
create a composite solid from the 
common volume

right-click, and click 
Boolean ➤ Intersect.
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Dividing a mass element

The original mass element is split along the divide plane, creating two 
mass elements.

Trimming a Mass Element

Use this procedure to trim a mass element. The divide plane you specify acts 
as the trim line, and you specify which side of the mass element to remove.

1 Select the mass element you want to divide, right-click, and click Trim.

2 Specify the divide plane start point.

3 Specify the divide plane end point.

4 Select the side of the mass element to remove.
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Trimming a mass element

Dividing the Face of a Mass Element

Use this procedure to divide the face of a mass element. In order for the face 
to split, the mass element is automatically converted to a free form mass ele-
ment.

1 Select the mass element whose face you want to divide, right-click, and 
click Split Face.

2 Select the first point on the face.

3 Select the second point on the same face, and press ENTER.

The original mass element is converted to a free form mass element, and 
the selected face is divided along the line you specified.

Joining the Faces of a Mass Element

Use this procedure to join previously split faces of a mass element. After the 
faces are joined, the mass element is automatically converted back to the 
shape it was before being split.
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1 Select the mass element whose faces you want to join, right-click, and 
click Join Faces.

2 Select the edge of the coplanar faces, and press ENTER.

The mass element is converted to its original shape, and the selected faces 
are joined into a single face.

Editing the Faces of a Mass Element
Use this procedure to edit individual faces of a mass element. You must first 
convert the mass element to a Free Form mass element in order to edit its 
faces.

1 Double-click the mass element you want to edit.

2 On the Properties palette, expand Basic and expand General.

3 Select Free Form for Shape.

The mass element is in edit in-place mode. Each face of the Free Form mass 
element is available to edit in this mode.

4 Select the Face grip for the face of the mass element that you want to edit.

Depending on the original shape of the mass element, Edge and Vertex 
grips are displayed.

5 Click and hold on the Face grip to edit the selected face of the mass ele-
ment:

If you want to . . . Then . . .

move the face orthogonally, while 
stretching adjacent faces

click and drag the Face grip.

move the face freely, while stretching 
adjacent faces

click and hold the Face grip, press 
CTRL once, and drag the grip.

move the face on a plane, while 
maintaining the plane of adjacent faces

click and hold the Face grip, press 
CTRL twice, and drag the grip.

pull the face orthogonally, while 
adding adjacent faces

click and hold the Face grip, press 
CTRL three times, and drag the grip.

pull the face freely, while adding 
adjacent faces

click and hold the Face grip, press 
CTRL four times, and drag the grip.

push the face orthogonally, while 
adding adjacent faces and possibly 
creating a hole

click and hold the Face grip, press 
CTRL five times, and drag the grip.
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Use CTRL to cycle through the choices available for editing the face.

6 Press ESC or right-click and click Deselect All to exit the editing session.

Assigning Materials to a Mass Element

Use this procedure to assign materials to the individual components of a 
mass element. 

1 Select the mass element you want to assign materials to, right-click and 
click Edit Object Display.

2 To verify that the material assignment determines the display properties 
of the component, click the Display Properties tab, select the display rep-

resentation where you want the changes to appear, and click .

3 Click the Layer/Color/Linetype tab, verify that By Material is selected for 
the component, and click OK.

4 Click the Materials tab. 

The Component column displays all components of the mass element 
that can be assigned a material. Components that are only symbolical 
graphics, like the bounding box, are not listed because they cannot have 
a material assignment.

The Material Definition column displays the currently assigned materials. 
If no previous material assignments have been made, the default material 
is Standard. 

5 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

6 Click OK twice.
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Specifying the Display Properties of a Mass 
Element

Use this procedure to change the following display properties of the compo-
nents of a mass element: 

� Visibility (component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the properties of a mass element 
display component, you can change the properties of the display component by 
clearing By Material or by overriding the material assignment with a different 
material. For more information, see “Assigning Materials to a Mass Element” on 
page 615.

1 Select the mass element you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Specifying the Hatching of a Mass Element

Use this procedure to specify the hatching of the components of an individ-
ual mass element. Hatching is displayed only in display representations, such 
as Plan, that are used in the Top view (plan view) of a drawing.
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NOTE If a material assignment determines the hatching properties of a mass 
element display component, you can change the hatching of the display com-
ponent by clearing By Material or by overriding the material assignment with a 
different material. For more information, see “Assigning Materials to a Mass Ele-
ment” on page 615.

1 Select the mass element you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Hatching tab.

6 Select a display component, and click the setting for Pattern.

7 Select the hatching for the display component:

8 Click OK.

9 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

10 Click Angle, and enter the angle for the selected pattern.

If you want to select . . . Then . . .

a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

single hatching select User-defined for Type, and clear Double 
Hatch.

double hatching select User-defined for Type, and select 
Double Hatch.

solid fill select Solid Fill for Type.
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11 Click Orientation, and specify how the hatching is oriented:

12 Click OK twice.

Changing the Location of a Mass Element

Use this procedure to relocate a mass element by changing the coordinate 
values of its insertion point. The mass element also has an orientation with 
respect to the world coordinate system (WCS) or the current user coordinate 
system (UCS). For example, if the top and bottom of the mass element are 
parallel to the XY plane, its normal is parallel to the Z axis. You can change 
the orientation of the mass element by aligning its normal with another axis. 
You can also rotate the mass element on its plane by changing the rotation 
angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Double-click the mass element you want to change.

2 In the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the mass element:

If you want to orient . . . Then . . .

the hatching to the object, 
regardless of the object rotation

select Object.

the hatching to the World 
Coordinate System

select Global.

If you want to . . . Then . . .

relocate the mass element enter new coordinate values under Insertion Point.

locate the mass element 
on the XY plane

make the normal of the mass element parallel to 
the Z axis: under Normal, enter 1 for Z, and enter 0 
for X and Y. 

locate the mass element 
on the YZ plane

make the normal of the mass element parallel to 
the X axis: under Normal, enter 1 for X and enter 0 
for Y and Z. 
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5 Click OK twice.

Attaching Hyperlinks, Notes, or Files to a Mass 
Element

Use this procedure to attach hyperlinks, notes, or files to a mass element. You 
can also edit hyperlinks and notes, and edit or detach reference files from a 
mass element.

1 Double-click the mass element you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK twice.

locate the mass element 
on the XZ plane

make the normal of the mass element parallel to 
the Y axis: under Normal, enter 1 for Y, and enter 0 
for X and Z.

change the rotation of the 
mass element

enter a new value for Rotation Angle.

If you want to . . . Then . . .

attach a reference file click Add, and select a file. click open, and OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .
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Mass Element Styles

A mass element style is a collection of settings for variables associated with a 
mass element. Depending on the scope of the drawing, you could create dif-
ferent mass element styles to represent a wide range of different types of mass 
elements.

Properties that Mass Element Styles Control
The mass element style you select determines the properties of mass elements 
you create in the drawing. When you edit the display properties of a mass ele-
ment style, those changes are applied to existing mass elements of that style 
throughout the current drawing.

Creating Mass Element Styles
Typically, you create mass element styles that represent the basic building 
blocks of the drawing. When you name a mass element style, mass elements 
are automatically grouped and can generate reports based on the first part of 
the mass element style name.

Editing Mass Element Styles
The changes you make to an existing mass element style take effect the next 
time you use it to create a mass element. Mass elements already created with 
the mass element style are not updated unless you change the display prop-
erties of the mass element style.

Managing Mass Element Styles
When you create, import, export, or edit styles, you access the Style Manager. 
The Style Manager provides a central location in Autodesk Architectural 
Desktop where you can work with styles from multiple drawings and tem-
plates. For more information about using the Style Manager, see “Getting 
Started with the Style Manager” on page 533.

Related Procedures

� Creating a Mass Element Style

� Assigning Materials to a Mass Element Style

� Specifying the Display Properties of a Mass Element Style

� Specifying the Hatching for Components of a Mass Element Style

� Attaching Notes and Files to a Mass Element Style

Creating a Mass Element Style

Use this procedure to create a mass element style. You can create a style using 
default style properties or by copying an existing style. After you create the 
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style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Multi-Purpose Objects, and expand Mass Element Styles.

3 Create a mass element style:

4 Enter a name for the new mass element style, and press ENTER.

5 To edit the new mass element style, right-click the style, and click Edit:

6 When you finish specifying the properties of the mass element style, click 
OK twice.

Specifying the Materials of a Mass Element Style

A mass element consists of a number of components whose display proper-
ties can be determined by the materials assigned to each component.

When you assign materials to a mass element style, you assign one material 
to each physical component of the mass element. You assign materials to 

If you want to . . . Then . . .

create a style with default 
properties

right-click Mass Element Styles, and click New.

create a style from an 
existing style

right-click the mass element style you want to copy, 
and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

specify materials for mass 
element components

see “Assigning Materials to a Mass Element Style” 
on page 623.

specify the display 
properties of the style

see “Specifying the Display Properties of a Mass 
Element Style” on page 624.

specify hatching for 
components of the style

see “Specifying the Hatching for Components of a 
Mass Element Style” on page 625.

add notes and files to the 
style

see “Attaching Notes and Files to a Mass Element 
Style” on page 626.
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components in each display representation where you want the materials to 
be used.

If you want to use the display properties of the mass element style, instead of 
using material display properties, you can turn off the material assignments 
in the display properties of the mass element style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three-dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Mass Element Materials and Display Components

� Assigning Materials to a Mass Element Style

Mass Element Materials and Display Components
The following table lists all mass element components plus information 
about which material components determine them in specific views.

Mass Element 
Component

Material Component

Plan, Plan High Detail, Plan Low Detail, Plan Presentation, Plan 
Screened

Above Cut Plane Plan Linework

Below Cut Plane Plan Linework

Hatch Plan Hatch

Cut Plane No Material

Model

Entity 3D Body

Bounding Box No Material

Reflected, Reflected Screened

Entity 3D Body

Bounding Box No Material

Hatch Plan Hatch
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Assigning Materials to a Mass Element Style
Use this procedure to assign materials to the individual components of a 
mass element style. When you assign a material to a mass element compo-
nent, the component uses the display properties of the material instead of 
the style display properties.

You can assign a material to any physical component of the mass element. 
Custom components and components that are only symbolic graphics do 
not use materials for their display properties. For example, the hatch is a 
physical component. The cut plane is a symbolic component.

NOTE If a material assignment does not determine the display properties of a 
mass element component, you can change the display properties of the mass 
element style as described in “Specifying the Display Properties of a Mass Ele-
ment Style” on page 624.

1 Open a tool palette that has a mass element tool.

2 Right-click a mass element tool, and click Mass Element Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.
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11 Click OK twice.

Specifying the Display Properties of a Mass 
Element Style

Use this procedure to change the following display properties of the display 
components of a mass element style: 

� Visibility (component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

To change these display properties for an individual mass element, see “Spec-
ifying the Display Properties of a Mass Element” on page 616.

NOTE If a material assignment determines the display properties of compo-
nents in the mass element style, you can change the properties of the display 
component by clearing By Material. You can also override the material assign-
ment with a different material. For more information, see “Assigning Materials 
to a Mass Element Style” on page 623.

1 Open a tool palette that has a mass element tool.

2 Right-click a mass element tool, and click Mass Element Styles.

3 Right-click the mass element style you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 Click the Layer/Color/Linetype tab.

7 Select the component to change, and select a different setting for the 
property.

8 Click OK twice.
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Specifying the Hatching for Components of a 
Mass Element Style

Use this procedure to specify the hatching of the components of a mass ele-
ment style. Mass element hatching is displayed only in display representa-
tions, such as Plan, that are used in the Top view (plan view) of a drawing.

1 Open a tool palette that has a mass element tool.

2 Right-click a mass element tool, and click Mass Element Styles.

3 Right-click the mass element style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and click Style Override.

The display representation in bold is the current display representation.

6 Click the Hatching tab.

7 Select a display component, and click the setting for Pattern.

8 Select the hatching for the  display component:

9 Click OK.

10 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

11 Click Angle, and enter the angle for the selected pattern.

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.
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12 Click Orientation, and specify how the hatching is oriented:

13 Click OK twice.

Attaching Notes and Files to a Mass Element 
Style

Use this procedure to enter notes and attach reference files to a mass element 
style. You can also edit notes and edit or detach reference files from a mass 
element style.

1 Open a tool palette that has a mass element tool.

2 Right-click a mass element tool, and click Mass Element Styles.

3 Right-click the mass element style you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the mass element style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Using Massing Tools to Create Mass Groups

Tools provided with Autodesk® Architectural Desktop let you quickly place 
mass groups by selecting a tool from the Massing tool palette. The mass 
group tool has predefined properties. When you place mass groups using 
mass group tools, you can use the default settings of the tool, or you can 
change settings for the mass group properties.

Tool palettes containing mass group tools

The default tool palettes in the workspace contain sample mass group tools 
that you can use and customize as needed. In addition, the following catalogs 
provided with the software contain mass group tools that you can add to 
your tool palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog

Custom palettes created by your CAD manager or other users may also con-
tain mass group tools with mass group properties that are customized for 
your projects or office standards.
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Related Procedures

� Creating a Mass Group

� Adding a Mass Group Marker

� Assigning Materials to a Mass Group

� Changing the Size of the Mass Group Marker

� Adding a New Mass Element to a Mass Group

� Attaching an Existing Mass Element to a Group

� Detaching a Mass Element from a Group

� Making a Mass Element Additive

� Making a Mass Element Subtractive

� Creating an Intersection from Mass Elements

� Creating a Nested Mass Group

� Removing a Nested Mass Group from a Mass Group

� Changing the Location of a Mass Group

� Attaching Hyperlinks, Notes, or Files to a Mass Group

� Creating a Mass Group Tool

Creating a Mass Group

Use this procedure to add a new mass group that has the properties specified 
in the mass group tool that you select.

A mass group is a display object that allows you to visualize and manipulate 
combinations of mass elements. After you create mass elements, you can 
combine their shapes through Boolean operations (addition, subtraction, 
and intersection) in a mass group. The resulting complex shape of the mass 
group represents your mass model. 

Mass Groups and Mass Group Markers
To create a mass group, you attach mass elements, other AEC objects, or 

AutoCAD® objects to a mass group marker that you place in a convenient 
area of your drawing. The mass elements and other objects that you attach 
to the mass group marker form the body of the mass group. The mass group 
marker becomes the “handle” that allows you to select and move the mass 
group. The mass group is created on a different layer than the mass elements 
that form it.

Using Boolean Operations to Create a Mass Group
You can combine the shapes of mass elements in the mass group, adding, 
subtracting, and intersecting them in a specific order:
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� An additive operation combines the total volume of two or more solids or 
two or more regions into a composite object.

� A subtractive operation removes the common area of one set of solids 
from another.

� An intersection removes non-overlapping portions and creates a compos-
ite solid from the common volume.

You can attach anything to a mass group marker, but the mass group com-
bines only closed, solid shapes. For example, a line has no solid properties 
and does not contribute anything to the shape of the mass group. However; 
an AutoCAD 3D solid does contribute to the final shape.

You can also create and work with mass groups in the Model Explorer. For 
more information, see “Using the Model Explorer to Create Mass Models” on 
page 646.

To further refine the building model, you can still edit individual mass ele-
ments attached to a mass group.

Materials in Mass Groups
In Autodesk Architectural Desktop, you can assign materials to a mass group. 
These materials then are displayed in wireframe or rendered views. Materials 
have specific settings for individual components of a mass group.

Mass groups with assigned materials in rendered view

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for mass 
groups. You can use these predefined materials, or modify them to your spe-
cial designs. You can also create your own materials from scratch entirely.
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For more information, see “Using Materials for Mass Elements and Mass 
Groups” on page 641.

1 Open the tool palette that you want to use, and select a mass group tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the mass group.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the rotation angle.

Adding a Mass Group Marker

Use this procedure to add a mass group marker. The mass group is controlled 
by a mass group marker that you place in the drawing. The mass group 
marker is view dependent and changes size as you zoom within the drawing. 
Attach mass elements to the marker to create a mass group.

1 On the Massing tool palette, select the Mass Group tool.

2 Select a location for the mass group marker in the drawing. 

The location does not represent the location of the mass elements that 
you attach to the marker, so locate the marker in any convenient area in 
the drawing.

3 Specify a rotation angle for the mass marker.
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Adding a mass group marker to a group of mass elements

Assigning Materials to a Mass Group

Use this procedure to assign materials to the individual components of a 
mass group. 

1 Select the mass group you want to assign materials to, right-click and click 
Edit Object Display.

2 To verify that the material assignment determines the display properties 
of the component, click the Display Properties tab, select the display rep-

resentation where you want the changes to appear, and click .

3 Click the Layer/Color/Linetype tab, verify that By Material is selected for 
the component, and click OK.

4 Click the Materials tab. 

The Component column displays all components of the mass group that 
can be assigned a material. Components that are only symbolical graph-
ics, like the bounding box, are not listed because they cannot have a mate-
rial assignment.

The Material Definition column displays the currently assigned materials. 
If no previous material assignments have been made, the default material 
is Standard. 
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5 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

6 Click OK twice.

Changing the Size of the Mass Group Marker

Use this procedure to change the size of the mass group marker by editing its 
display properties.

1 Select the mass group marker, right-click and click Edit Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and click Object Override.

4 Click the Other tab, and change the size of the mass group marker.

5 Click OK twice.

Adding a New Mass Element to a Mass Group

Use this procedure to add a new mass element to create a mass group after 
you have placed a mass group marker in the drawing. 

1 Select an existing mass group marker, right-click and click Add New Ele-
ment.

2 In the Properties palette, select a shape for the mass element.

3 Select Add, Subtract, or Intersect for Operation.

4 Specify an insertion point in the drawing.

5 Specify additional parameters for the mass element.

Depending on the shape of the mass element, you need to specify a sec-
ond corner, the radius, or the height.

6 Specify a rotation angle.

7 Press ENTER.



Using Massing Tools to Create Mass Groups | 633

The newly created mass element is now part of the selected mass group. 

Attaching an Existing Mass Element to a Group

Use this procedure to add existing mass elements to a mass group.

While it is possible to attach any number of objects to a single mass group, 
performance will be improved if this single group is subdivided into a series 
of nested groups. Your design will also be more manageable if a group is bro-
ken into logical divisions. In addition, if one of the subgroups fails to display 
as expected, it will be easier to track down the problem. In most cases, you 
can adjust the order of the objects in the group to get the correct appearance.

Attaching mass elements to a mass group

1 Select the mass group marker, right-click and click Attach Elements.

2 Select one or more mass elements to attach to the mass group.
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3 Press ENTER.

Detaching a Mass Element from a Group

Use this procedure to detach a mass element from a mass group. After you 
have defined a mass group and added mass elements to it, you may decide 
that one or more elements do not fit your model. You can detach these from 
the mass group and use them elsewhere or delete them.

1 Select the mass group marker, right-click and click Detach Elements. 

2 Select one or more mass elements to detach from the mass group.

3 Press ENTER.

Making a Mass Element Additive

Use this procedure to change the operation of a mass element. All objects are 
additive by default when they are created. When two mass elements are 
grouped together, they form one mass containing both objects.

NOTE When you select the mass element, make sure you select the mass ele-
ment, not the view of the mass group. When a mass element becomes part of a 
mass group, it gets placed in that display set, which is usually displayed with a 
different layer and color. To select a single element, you need to turn off the mass 
group layer.

� Select the mass element you want to make additive, right-click, and click 
Mass Group Operation ➤ Additive.
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Adding a mass element to a mass group

Making a Mass Element Subtractive

Use this procedure to change the operation of a mass element. When a mass 
element in a group operates by subtraction, the mass element subtracts its 
mass where it overlaps another object.
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Subtracting a mass element from a mass group

NOTE When you select the mass element, make sure you select the mass ele-
ment, not the view of the mass group. When a mass element becomes part of a 
mass group, it gets placed in that display set, which is usually displayed with a 
different layer and color. To select a single element, you need to turn off the mass 
group layer.

1 Select the mass element you want to make subtractive.

2 On the Properties palette, expand Basic, and expand General.

3 Select Subtract for Operation.

4 Press ENTER.

Creating an Intersection from Mass Elements

Use this procedure to create a new mass shape using the intersection of two 
mass elements.
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Generating an intersection mass group from mass elements

NOTE When you select the mass element, make sure you select the mass ele-
ment, not the view of the mass group. When a mass element becomes part of a 
mass group, it gets placed in that display set, which is usually displayed with a 
different layer and color. To select a single element, you need to turn off the mass 
group layer.

1 Select the mass element you want to make intersecting.

2 On the Properties palette, expand Basic, and expand General.

3 Select Intersect for Operation.

4 Press ENTER.
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Creating a Nested Mass Group

Use this procedure to attach a mass group to another mass group. This action 
nests the current mass group within the mass group that you select.

You may find it easier to nest mass groups using the Model Explorer. For more 
information, see “Moving a Mass Element or Group from One Mass Group 
to Another” on page 656.

1 Select the mass group that you want to nest within another mass group.

2 On the Properties palette, expand Basic, and expand General.

3 Click the mass group where you want to nest the current mass group for 
Attached to.

4 Specify Add, Subtract, or Intersect for Operation.

This option determines how the mass group is nested within the mass 
group you selected.

5 Press ENTER.

Removing a Nested Mass Group from a Mass 
Group

Use this procedure to remove a mass group from another mass group in 
which the first mass group is nested. The mass group you remove remains in 
the drawing.

1 Select the mass group you want to remove.

2 On the Properties palette, expand Basic, and expand General.

3 Select None for Group.

Changing the Location of a Mass Group

Use this procedure to relocate a mass group by changing the coordinate val-
ues of its insertion point. The mass group also has an orientation with respect 
to the WCS or the current UCS. For example, if the top and bottom of the 
mass group are parallel to the XY plane, its normal is parallel to the Z axis. 
You can change the orientation of the mass group by aligning its normal with 
another axis. You can also rotate the mass group on its plane by changing the 
rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.
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1 Double-click the mass group you want to change.

2 In the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the mass group:

5 Click OK twice.

Attaching Hyperlinks, Notes, or Files to a Mass 
Group

Use this procedure to attach hyperlinks, notes, or files to a mass group. You 
can also edit hyperlinks and notes, and edit or detach reference files from a 
mass group.

1 Double-click the mass group you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

If you want to . . . Then . . .

relocate the mass group enter new coordinate values under Insertion Point.

locate the mass group on 
the XY plane

make the normal of the mass group parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the mass group on 
the YZ plane

make the normal of the mass group parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the mass group on 
the XZ plane

make the normal of the mass group parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
mass group

enter a new value for Rotation Angle.
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5 To attach, detach, or edit a reference file, click  next to Reference doc-
uments, and then do any of the following:

6 Click OK twice.

Creating a Mass Group Tool

Use this procedure to create a mass group tool and add it to a tool palette. 
You may want to create your own mass group tools if you are placing multi-
ple mass groups with mass group properties that you want to be the same 
each time you add a mass group of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If you want to . . . Then . . .

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 To add keywords to the tool, click More Info.

7 Enter the keywords, and click OK twice.

Using Materials for Mass Elements and Mass 
Groups

Using materials simplifies defining the display of objects. You define the dis-
play of a material, such as brick or glass, only once in the drawing or the 
drawing template, and then assign it to any object component or object 
style. For example, you can define a material “Glass” and assign it to any 
number of windows, glass door insets, or cubicle walls.

Using a common set of materials provides centralized control across the dis-
play of objects in a drawing or throughout the whole project. When the par-
ticulars of a material change, you change them just once in the material def-
inition, and all objects are automatically updated.

For more information, see “Materials” on page 491.

Rendered building with different materials

Predefined Materials
Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes. You can use these predefined materials, 
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or modify them to your special designs. You can also create your own mate-
rials.

Surface Hatching
The ability to assign surface hatches to objects has greatly been improved by 
materials. Surface hatches can display in both model views and section/ele-
vation views. Placement and orientation of the hatch can be precisely con-
trolled and specified for each object face individually.

For detailed information about surface hatches, see “Working with Surface 
Hatches” on page 504.

Related Topics

� Mass Element and Mass Group Display Components and Materials

� Process Overview: Creating and Applying a Material for a Mass Element or 
Mass Group

Mass Element and Mass Group Display 
Components and Materials

A mass element or a mass group consists of a number of display components 
that can be determined by materials. 

Workflow
When you assign materials to a mass element or a mass group, you assign one 
material to each display component of the mass element or mass group. For 
example, you assign a dark wood material to the mass element body and a 
light brown material to the mass element hatch. When you assign a material 
to a mass group, the display properties of the attached mass elements are 
overridden with the mass group settings.

If you want to use the display properties of the mass element instead of the 
material display properties, you can deactivate the material assignments in 
the display properties of the mass element. 

Display Representations
The display properties of an object are specified for each display representa-
tion individually. Mass elements and mass groups have, by default, display 
representations for plan, model, reflected, and sketch views. You can create 
new display representations for mass elements and mass groups by copying 
an existing display representation. For example, you can create a new display 
representation “Plan 1:25” to create a plan view optimized for display in a 
view scaled to 1:25. This new display representation has the same display 
components as the original one from which it was copied. The copied com-
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ponents will be influenced by the same material components as the original 
components.

Material Component Assignments
Material definitions consist of display components which correspond to 
component types of objects. For example, the Linework component of a 
material is used for all linework in Plan view. The Surface Hatch component 
of a material is used to hatch all object surfaces in 3D model views and ele-
vations. 

For a complete list of material components and their description, see “Mate-
rial Components and Display Properties” on page 498.

The following table lists all mass element components plus information 
about which material components determine them.

The following table lists all mass group components plus information about 
which material components determine them.

Mass Element 
Component

Material Component

Plan High Detail, Plan Low Detail, Plan Presentation, Plan Screened

Hatch Plan Hatch

Cut Plane No Material

Model

Entity 3D Body

Bounding Box No Material

Reflected, Reflected Screened, Sketch

Entity Plan Linework

Bounding Box No Material

Hatch Plan Hatch

Mass Group 
Component

Material Component

Plan High Detail, Plan Low Detail

Marker No Material
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Process Overview: Creating and Applying a 
Material for a Mass Element or Mass Group

If you create a material, you can then apply it to all types of objects that sup-
port materials. For example, a concrete material could be used for a wall and 
for a structural element. Mass elements and mass groups are often used for 
columns, elevator shafts, or chimneys. If you want to create a material to use 
only for mass elements or mass groups, it is recommended that you name it 
accordingly. For example, if the materials have specific names such as Mass 
Element - Concrete Column or Mass Group - Cable Shaft, you can simplify 
the organization of your material definitions. 

Step 1: Create a new material definition or edit an existing material defini-
tion.

For information on creating and editing materials, see “Creating and Edit-
ing Materials” on page 517.

Cut Plane No Material

Hatch No Material

Plan, Plan Presentation, Plan Screened

Entity Plan Linework

Marker No Material

Model

Entity 3D Body

Marker No Material

Reflected, Reflected Screened

Entity Plan Linework

Marker No Material

Mass Group 
Component

Material Component
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Step 2: In the material definition, define the settings that affect the display 
of materials in mass elements and mass groups:

Step 3: Turn on the assigned materials in the individual display representa-
tions, and then assign the materials to the mass elements and mass groups in 
your building model. 

For information on assigning materials to mass elements, see “Assigning 
Materials to a Mass Element” on page 615.

For information on assigning materials to mass groups, see “Assigning 
Materials to a Mass Group” on page 631.

If you want to . . . Then . . .

display a surface hatch for 
a mass element or a mass 
group in 3D model views

turn on the Surface Hatch component and 
specify its display properties. For more 
information, see “Defining the Layer, Color and 
Linetype of a Material” on page 520 and 
“Specifying the Surface Hatch Pattern of a 
Material” on page 523.

display a section hatch for 
a mass element or mass 
group in a 2D section, 3D 
section, or live section

turn on the Section Hatch component and 
specify its display properties. For more 
information, see “Defining the Layer, Color and 
Linetype of a Material” on page 520 and and 
“Specifying the Plan and Section Hatch Patterns 
of a Material” on page 521.

display the sectioned 
boundary and sectioned 
body of a mass element or 
mass group in a live 
section

turn on the Sectioned Boundary and Sectioned 
Body components and specify their display 
properties. For more information, see “Defining 
the Layer, Color and Linetype of a Material” on 
page 520.

add special rendering 
materials for mass 
elements or mass groups 
in live sections

select rendering materials. For more 
information, see “Assigning Materials for 
Rendering” on page 526.

exclude mass element or 
mass group components 
from a 2D section 
shrinkwrap hatch

specify this setting in the material definition. For 
information, see “Excluding a Material from 2D 
Section Shrinkwrap” on page 528.
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Using the Model Explorer to Create Mass 
Models

The Model Explorer is a window in which you can create, view, and manip-
ulate mass elements and mass groups. You can create your entire conceptual 
model by using Model Explorer. The main viewing window display is similar 
to the 3D orbit view. You can attach objects and mass elements to mass 
groups and view them in the Model Explorer. In the Model Explorer, you can 
simultaneously view the conceptual and the hierarchical structure of mass 
groups and mass elements that make up the model.

The Model Explorer is divided into three areas: the tree view in the left pane, 
the graphics area in the right pane, and the menu bar and toolbar across the 
top.

The Model Explorer

Left Pane of the Model Explorer
The tree view lists all open drawings as Projects. Any mass groups are dis-
played under their associated drawing in the tree view. If you expand a mass 
group in the tree view, the mass elements attached to the mass group display. 
One of the following icons displays next to each mass element in the mass 
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group, indicating which Boolean operation they use to combine with each 
other in the mass group:

An additive operation in the Model Explorer combines the total volume of 
two or more solids or two or more regions into a composite object. A subtrac-
tive operation removes the common area of one set of solids from another. 
An intersection removes non-overlapping portions and creates a composite 
solid from the common volume.

The order of the objects and mass elements in the tree view dictates the out-
come of the group when mass elements are combined. You can drag and drop 
the mass elements within the mass group to change the order in which they 
are combined.

You can also drag and drop mass groups to nest them within other mass 
groups to build your model. For example, if you are modeling a building with 
multiple wings, each wing can be a mass group containing multiple mass ele-
ments. You can then add these mass groups to a mass group of the entire 
building.

Right Pane of the Model Explorer
The right pane of the Model Explorer displays a graphical view of the mass 
elements or mass groups that you select in the left pane.

Model Explorer Menu Bar and Toolbar
The top of the Model Explorer includes a menu bar and toolbar that allow 
you to access the menu commands. If you position your pointing device over 
a toolbar icon, a tooltip displays with an explanation of the icon. For more 
information, see “Using Toolbar Commands in the Model Explorer” on 
page 650.

If you turn off the Model Explorer toolbars from the commands on the View 
menu, the tree view and viewer initially are blank the next time you display 
the Model Explorer. Click any of the pull-down menu headings to restore the 
proper display.

Icon

Both squares yellow = additive

Top portion of the two squares yellow = subtractive 

Middle of squares yellow = intersection 
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Related Procedures

� Displaying the Model Explorer

� Using Display Commands in the Model Explorer

� Viewing Objects on a Nonvisible Layer

� Maintaining Zoom Percentage and Position of an Object

� Using Toolbar Commands in the Model Explorer

Displaying the Model Explorer

Use this procedure to open the Model Explorer. Any mass groups in the cur-
rent drawing display in the right pane. The tree view in the left pane lists the 
mass groups in your open drawings.

1 Select a mass group, right-click, and click Show Model Explorer.

2 You can move, resize, or close the Model Explorer:

Using Display Commands in the Model Explorer

The following toolbar commands change the display of the objects in the 
Model Explorer:

If you want to . . . Then . . .

move the Model Explorer drag the Model Explorer title bar to the 
desired location.

resize the Model Explorer click the edge of the Model Explorer 
and drag to the desired size.

close the Model Explorer click the “X” in the top right side of the 
Model Explorer.

Icon

Wireframe: Displays objects in the current view with all lines showing, 
including those hidden by other objects.

Hidden: Displays objects in the 3D wireframe representation with 
hidden lines.

Flat Shaded: Shades objects in a 3D view between the polygon faces. 
Objects appear flatter and less smooth than Gouraud shaded objects.
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You can select the following views from the list:

� six orthogonal views (Top, Bottom, Left, Right, Front, Back): Sets the cur-
rent view to the selected view.

� four isometric views (SW Isometric, SE Isometric, NE Isometric, NW 
Isometric): Sets the current view to the selected isometric view.

� Any named views.

You can also use keyboard shortcuts to change the view in the graphics area:

� Hold down SHIFT and click to pan in the graphics area of the Model 
Explorer. 

� Hold down CTRL and click to zoom in the graphics area of the Model 
Explorer.

Viewing Objects on a Nonvisible Layer

Use this procedure to change the settings in the Model Explorer to be able to 
view all objects, regardless of the visibility of the layer on which they reside. 
Any object on a layer that is frozen or turned off is not displayed initially.

1 Open the Model Explorer.

2 On the Model Explorer View menu, click Show All Layers.

The check mark in the menu next to Show All Layers indicates that all objects 
are displayed in the Model Explorer. 

Gouraud Shaded: Shades objects in a 3D view and smooths the edges 
between polygon faces. Objects appear smoother and more realistic 
than flat shaded objects. AEC objects use a faceted representation, so 
there is no visible change when you switch from flat shading to Gouraud 
shading.

Pan: Pans the view in the graphics area of the Object Viewer.

Zoom: Real-time Zooms the Object Viewer display as you move your 
pointing device.

Orbit: Sets the display in the graphics area to 3D orbit view.

Adjust Distance: Moves the view in the graphics area.

Icon



650 | Chapter 11 Creating Conceptual Models

Maintaining Zoom Percentage and Position of an 
Object

Use this procedure to select an object in the Model Explorer tree view. The 
zoom percentage and location of the object is maintained. This is useful 
when you want to examine how the object relates to the rest of the drawing. 

In the Model Explorer, you can specify to display the selected object only and 
display it at maximum size.

1 Open the Model Explorer.

2 On the Model Explorer View menu, click Auto Zoom Extents.

3 Select the object to view from the tree view. 

The Model Explorer graphics window displays only the selected object, 
zoomed to fit the window.

Using Toolbar Commands in the Model Explorer
The following toolbar commands allow you to work with mass elements and 
mass groups in the Model Explorer:

Icon

New Grouping: Creates a new mass group in the drawing.

New Element: Creates a new mass element in the drawing.

Cut: Cuts the selected item in the tree view to the Clipboard. 

Copy: Copies the selected item from the tree view to the Clipboard.

Paste: Pastes the selected item into the tree view at the selected 
location.

Delete Item: Deletes an item from the tree view and from the drawing.

Attach Items: Attaches existing mass elements or objects to the 
selected mass group. Select one or more elements or objects in the 
drawing. This option is available only when a mass group is selected in 
the tree view. 
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Creating a Mass Element with the Model 
Explorer

Use this procedure to create a mass element in the Model Explorer. For 
detailed information about specifying the shape and dimensions of a mass 
element, see “Creating a Mass Element” on page 588.

1 Open the Model Explorer.

2 In the left pane, select the level at which you want the mass element cre-
ated.

If you select the drawing name, the new mass element is created at the 
next hierarchical level. If you select a mass group name with a drawing, 
the new mass element is attached to the selected mass group.

3 On the Model Explorer File menu, click Create Element, or click .

4 On the command line, specify a shape. 

5 Specify the insertion point for the mass element.

Depending on the shape you specified, you need to specify a second cor-
ner, the radius, or the height. 

6 Specify the rotation angle.

7 Press ENTER.

Creating a Mass Group

Use this procedure to create a mass group in the Model Explorer.

1 Open the Model Explorer.

2 In the left pane, select the level at which you want the mass group created.

Detach Items: Detaches the selected mass elements or objects from the 
mass group. This option is available only when a mass group is selected 
in the tree view.

Properties: Opens the properties dialog box for the selected mass 
element, object, or mass group.

Display Configuration: Changes the display configuration of the 
objects in the Model Explorer. Select a display configuration from the 
list.

Icon
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If you select the drawing name, the new mass group is created at the next 
hierarchical level. If you select a mass group name with a drawing, the 
new mass group is nested within the existing mass group.

3 On the Model Explorer File menu, click Create Group, or click .

4 Specify a location for the mass marker. 

The location does not represent the location of the mass elements that are 
added to the marker. Therefore, you can locate the mass marker in any 
convenient area. 

5 Specify the rotation angle.

The new mass group is added to the project tree in the Model Explorer.

Attaching a Mass Element to a Mass Group

Use this procedure to attach existing mass elements to the group after a mass 
group is created.

1 Open the Model Explorer.

2 In the left pane, select a mass group, right-click, and click Attach Ele-
ments.

3 Select the mass elements to add to the group.

4 Press ENTER.

Attaching Objects to a Mass Group

Use this procedure to attach objects, such as doors, walls, and curtain walls, 
to the group after a mass group is created. 

1 Open the Model Explorer.

2 In the left pane, select a mass group, right-click, and click Attach Ele-
ments.

3 Select the objects to add to the group.

4 Press ENTER.

Changing a Mass Element Operation to Additive

Use this procedure to change a mass element operation to additive. Mass ele-
ments are additive when you create them. After a mass element is added to a 
mass group, its operation can be changed to produce different results.
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Adding a mass element to a mass group

1 Open the Model Explorer.

2 In the left pane, select a mass element, right-click, and click 
Operation ➤ Additive.

3 In the left pane, click Project to update the display.

The display changes to indicate the new operation property of the mass 
element.

Changing a Mass Element Operation to 
Subtractive

Use this procedure to change a mass element operation to subtractive. Mass 
elements are additive when you create them. After a mass element is added 
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to a mass group, its operation can be changed to produce different results. If 
the mass element is subtractive, its shape is removed from the mass group. 

Subtracting a mass element from a mass group

1 Open the Model Explorer.

2 In the left pane, select a mass element, right-click, and select 
Operation ➤ Subtractive.

3 In the left pane, click Project to update the display.

The display changes to indicate the new subtractive operation of the mass 
element.

Changing a Mass Element Operation to 
Intersection

Use this procedure to change a mass element operation to intersection. Mass 
elements are additive when you create them. After a mass element is added 
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to a mass group, its operation can be changed to produce different results. 
The intersect operation creates a shape that is defined by the overlap where 
the mass element intersects with another mass element.

Creating an intersection mass group from mass elements

1 Open the Model Explorer.

2 In the left pane, select a mass element, right-click, and select 
Operation ➤ Intersect.

3 In the left pane, click Project to update the display.

The display changes to indicate the new intersection operation of the mass 
element.

Specifying the Order of Mass Elements

Use this procedure to specify the order of mass elements. The operation 
(additive, subtractive, intersection) of each mass element in a mass group is 
based on the hierarchy of mass elements in the project tree. You can drag and 
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drop mass elements within mass groups in the project tree. By default, mass 
elements are listed in the left pane of the Model Explorer in the order they 
are created in the Model Explorer or selected for the mass group.

1 Open the Model Explorer.

2 Select the mass element you want to move, and drag it to the target loca-
tion in the project tree.

Moving a Mass Element or Group from One Mass 
Group to Another

Use this procedure to move a mass element or a mass group from one mass 
group to another in the Model Explorer project tree.

1 Open the Model Explorer.

2 In the left pane, select the mass element or mass group you want to move, 
and drag it to another mass group.

When you move a mass group within another mass group, it is known as 
a nested mass group.

Spaces

Spaces and space boundaries are useful for planning an inside-out design pro-
cess in which you define the interior spaces of the building and then define 
the boundary around those spaces.

Spaces are objects that are used to represent square footage at the conceptual 
level. As you design from the inside out, you can think of spaces as equiva-
lent to rooms,  edges as walls, and a group of spaces within a boundary as a 
department.

Using Spaces in Space Planning
Often, the controlling factor in the design of a building is not the overall 
form, but the size, proportion, and required relationships of the necessary 
spaces. You can use space objects to study these variables. 

Solving Spatial Problems
You solve spatial problems conceptually, using space boundaries as forms and 
spaces as voids. The display system can help you visualize your spatial 
arrangement. For more information, see “The Display Manager” on 
page 449.
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After all the spaces have been created, you can convert the boundaries into 
walls and use them later in the building design phase.

Variables Tracked in Spaces
A space is an object with volume that includes visual representations of a 
floor and ceiling. Its primary variables are area, length, width, and room 
height (measured from top of floor to bottom of ceiling). Additional variables 
are floor thickness, space height (measured from bottom of floor to top of 
ceiling), ceiling thickness, and distance above the ceiling to the top of the 
volume (this area is not normally visible but is reserved by the space object 
for use in conjunction with space boundaries). Spaces are used as placehold-
ers for future rooms in the interior of a building. 

Materials in Spaces
In Autodesk Architectural Desktop, you can assign materials to a space. These 
materials then are displayed in wireframe or rendered views. Materials have 
specific settings for individual components of a space, such as the floor and 
the ceiling.

Space with assigned materials

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for spaces. You 
can use these predefined materials, or modify them to your special designs. 
You can also create your own materials.

For more information, see “Using Materials for Spaces” on page 683.

Using Space Styles
You can create space styles and use them to create spaces that conform to cer-
tain size rules that you control. For example, you can set limits for an office 
space style to keep the size of an office within certain constraints. For more 
information, see “Creating a Space Style” on page 688.
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Space styles hold the “target” size to allow you to quickly lay out required 
areas of a design. Space styles also include a net-to-gross offset that is used if 
the space perimeter is converted to a space boundary.

Creating Spaces from Other Objects
You can convert closed polylines into spaces. You can also generate spaces 
from walls and linework in your drawing, assigning tags and property set 
information automatically.

Organizing and Querying Spaces
You can place and organize spaces individually and then cluster them 
together to convert them to space boundaries. Spaces have a floor and a ceil-
ing. Spaces have a separate query function that allows you to find square 
footages easily.

Spaces and Room Finish Schedules
All of the sample room tags and room finish schedules provided with the 
software are designed to be used in conjunction with spaces. When you drag 
a room tag into a drawing, it will need to be associated with a space object.

Related Procedures

� Using Space Tools to Create Spaces

� Editing Spaces

� Using Materials for Spaces

� Space Styles

� Viewing Information About Spaces

� Creating a Space Report

Using Space Tools to Create Spaces

Tools provided with Autodesk®  Architectural Desktop let you quickly place 
spaces by selecting a space tool with a specific space style and other pre-
defined properties. When you place spaces using space tools, you can use the 
default settings of the tool, or you can change settings for the space proper-
ties. You can also use space tools to convert linework to spaces and to apply 
the settings of a space tool to existing spaces.
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Tool palettes containing space tools

The default tool palettes in the workspace contain sample space tools that 
you can use and customize as needed. In addition, the following catalogs pro-
vided with the software contain space tools that you can add to your tool pal-
ettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

Custom palettes created by your CAD manager or other users may also con-
tain space tools with space styles and properties that are customized for your 
projects or office standards.

Related Procedures

� Creating a Space

� Creating a Space with a Ceiling Boundary

� Creating a Space with a Floor Boundary

� Constraining a Space

� Changing the Drag Point of a Space



660 | Chapter 11 Creating Conceptual Models

� Converting Polylines to Spaces

� Generating a Space from Walls

� Generating a Space from Walls, Lines, Arcs, Polylines, and Circles

� Generating Spaces from All Linework

� Updating Generated Spaces

� Creating a Space Tool

Creating a Space

Use this procedure to add a new space that has the properties specified in the 
space tool that you select. To specify settings when you add a space, see “Cre-
ating a Space with User-Specified Settings” on page 660.

1 Open the tool palette that you want to use, and select a space tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the space.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the rotation angle.

4 Continue adding spaces, and press ENTER.

Creating a Space with User-Specified Settings

Use this procedure to add a space with settings that you specify. Spaces are 
inserted with a ceiling boundary and a floor boundary.

NOTE The space style controls the target area of the space. Although you can-
not exceed the maximum space area while adding a space, you may adjust the 
space with stretch grip points after the space has been placed in the drawing. 



Spaces | 661

Creating a space

1 Open the tool palette that you want to use, and select a space tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Expand Component Dimensions.

5 Specify the component dimensions of the space:

6 Expand Actual Dimensions.

7 Specify the actual dimensions of the space:

If you want to . . . Then . . .

specify the clear height 
of the space

enter a value for Space height.

specify the thickness of 
the space floor 
boundary

enter a value for Floor boundary thickness.

specify the thickness of 
the space ceiling 
boundary

enter a value for Ceiling boundary thickness.

specify the distance 
from the top of the 
space ceiling boundary 
to the top of the space

enter a values for Height above ceiling.

If you want to . . . Then . . .

specify which 
dimension to contrain 
to

select Area, Length, Width, or None for Constrain.
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8 Expand Target Dimensions.

9 Specify the target dimensions of the space:

specify the area of the 
space

enter a value for Area.

specify the length of 
the space along its 
relative X direction

enter a value for Length.

specify the width of the 
space along its relative 
Y direction

enter a values for Width.

If you want to . . . Then . . .

specify the target area 
for the space

enter a value for Target area.

specify the maximum 
area allowed for the 
space

enter a value for Maximum area.

specify the minimum 
area allowed for the 
space

enter a value for Minimum area.

specify the target 
length of the space

enter a values for Target length.

specify the maximum 
length allowed for the 
space along its relative 
X direction

enter a value for Maximum length.

specify the minimum 
length allowed for the 
space along its relative 
X direction

enter a value for Minimum length.

specify the target width 
for the space

enter a value for Target width.

specify the maximum 
width allowed for the 
space along its relative 
Y direction

enter a value for Maximum width.

If you want to . . . Then . . .
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10 In the drawing area, specify the insertion point of the space.

You can move or hide the Properties palette to expose more of the drawing 
area.

11 Expand Location.

12 Specify the location of the space:

13 Continue adding spaces, and press ENTER.

Creating a Space with a Ceiling Boundary

Use this procedure to create a space with a ceiling boundary, which is a visual 
representation of a ceiling. The ceiling boundary is a solid volume above the 
space whose top represents the future ceiling. Defining a ceiling boundary at 
a point lower than the top of the space might represent a typical dropped 
ceiling grid in an office. 

The thickness of the ceiling boundary is determined by the space style being 
used. You can change the ceiling thickness as you create spaces by changing 
the dimensions of the space. For more information, see “Changing the Com-
ponent Dimensions of a Space” on page 681.

specify the minimum 
width allowed for the 
space along its relative 
Y direction

enter a value for Minimum width.

If you want to . . . Then . . .

specify a rotation 
reference angle for the 
space object

enter a value for Rotation.

specify the elevation of 
the space

enter a value for Elevation.

If you want to . . . Then . . .
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Ceiling Boundary Parameters

1 Open the tool palette that you want to use, and select a space tool.

2 On the Properties palette, expand Basic, and expand Component Dimen-
sions.

3 Enter 0 for Floor boundary thickness. 

To remove a boundary, change its thickness to zero.

4 Specify a location for the space object. 

5 Specify a rotation angle.

6 Press ENTER.

Creating a Space with a Floor Boundary

Use this procedure to create a space with a floor boundary, which is a solid 
volume below the space that represents the future floor.

By default, the floor extends below the current UCS by the depth of the floor 
as defined in the Space Properties dialog box.

The thickness of the floor boundary is determined by the space style being 
used. You can change the floor thickness as you create spaces by changing 
the dimensions of the space. For more information, see “Changing the Com-
ponent Dimensions of a Space” on page 681.
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Floor Boundary Thickness

NOTE To remove a floor boundary, change the thickness of the floor boundary 
to zero.

1 Open the tool palette that you want to use, and select a space tool.

2 On the Properties palette, expand Basic, and expand Component Dimen-
sions.

3 Enter 0 for Ceiling boundary thickness. 

To remove a boundary, change its thickness to zero.

4 Specify a location for the space object. 

5 Specify a rotation angle.

6 Press ENTER.

Constraining a Space

Use this procedure to create a space whose overall dimensions are con-
strained by any of the following individual dimensions:

� Area
� Length
� Width

For example, if you constrain a space by a specified area, the length and 
width of the space can vary, but their product must always equal the value 
specified for Area. The space style determines the initial constraint.
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Creating a space with a specified area

1 Open the tool palette that you want to use, and select a space tool.

2 On the Properties palette, expand Basic, and expand Actual Dimensions.

3 Select Area, Length, or Width for Constrain.

4 Select Yes for Specify On Screen.

5 In the drawing, right-click, and click Drag point.

6 Specify the insertion point of the space at the drag point.

7 Specify a second point.

8 Specify a rotation angle.

9 Press ENTER. 

Changing the Drag Point of a Space

Use this procedure to change the drag point of a space, which is the corner 
point you use to insert the space in your drawing. You may want to place a 
group of space objects in a row or in a particular pattern. By changing the 
drag point of a space to a different corner and using an object snap, you can 
precisely locate the space in the drawing.

Specifying space object drag points

1 Open the tool palette that you want to use, and select a space tool.



Spaces | 667

2 In the drawing, right-click and click Drag point until the crosshairs are at 
the correct corner of the space.

3 Specify an insertion point. 

NOTE You can use object snaps to locate the insertion point precisely.

4 Specify a rotation angle.

5 Click Close.

Converting Polylines to Spaces

Use this procedure to convert a closed polyline to a space. This method is also 
useful for creating a space with an irregular shape.

You can use a series of lines and arcs to create the polyline. The polyline must 
not intersect itself, and it must be closed.

1 Draw a closed polyline from which you want to create a space.

2 Right-click a space tool, and click Apply Tool Properties to ➤ Polyline.

3 Select the polyline.

4 Enter y (Yes) to erase the polyline, or enter n (No) to keep the polyline in 
the drawing.

5 Press ENTER.

Generating a Space from Walls

Use this procedure to create a space from walls. The walls need to be closed, 
but can have openings in them, such as doors or windows. These objects in 
the wall are ignored when creating a space. The space can have tags automat-
ically associated with it.

For more information about tags and property sets, see “Adding and Editing 
Property Set Data” on page 2204.

1 Open the tool palette that you want to use, and select a space auto gener-
ate tool.

2 Select Walls only for Selection Filter, and click OK.

3 Select the walls from which to generate the spaces, and press ENTER.

4 Select a style for the spaces.
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5 Click Tag Settings, and specify the settings:

6 Click OK.

7 Click within an area enclosed by the selected walls.

If you want to . . . Then . . .

add a tag to the space select Add Tag to New Spaces, and 
specify a definition for Tag Definition.

add a property set to the space select Add Property Set to New Spaces, 
and specify a property set for Property 
Set. Select either Number or Name for 
Property 1 and for Property 2.

automatically increment the number 
associated with the space tag

select Auto-Increment Numeric 
Properties, and enter a value for 
Increment.
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Creating a space from walls

A space is created in that area with the selected tag and property set, if 
selected.

8 To view information about all spaces in the drawing, click Space Query, 
and then click OK.

9 Click Close.

Generating a Space from Walls, Lines, Arcs, 
Polylines, and Circles

Use this procedure to create a space from walls, lines, arcs, polylines, and cir-
cles. The walls and lines need to be closed, but the walls can have openings 
in them, such as doors or windows. These objects in the wall are ignored 
when creating a space. The space can have tags automatically associated with 
it.
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For more information about tags and property sets, see “Adding and Editing 
Property Set Data” on page 2204.

1 Open the tool palette that you want to use, and select a space auto gener-
ate tool.

2 Select Walls, lines, arcs, polylines, and circles for Selection Filter, and click 
OK.

3 Select the objects from which to generate the space, and press ENTER.

4 Select a style for the space.

5 Click Tag Settings, and specify the settings:

6 Click within each area enclosed by the selected walls and lines to create a 
space in that area.

Creating a space from a polyline

If you want to . . . Then . . .

add a tag to the space select Add Tag to New Spaces, and 
specify a definition for Tag Definition.

add a property set to the space select Add Property Set to New Spaces, 
and specify a property set for Property 
Set. Select either Number or Name for 
Property 1 and for Property 2.

automatically increment the number 
associated with the space tag

select Auto-Increment Numeric 
Properties, and enter a value for 
Increment.
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The space created in that area has the selected tag and property set, if 
selected.

7 To view information about all spaces in the drawing, click Space Query, 
and then click OK.

8 Click Close.

Generating Spaces from All Linework

Use this procedure to create spaces from all the lines in a drawing. The lines 
need to form closed areas. When generating spaces, it is similar to exploding 
all the objects and creating spaces from that linework. These spaces can have 
tags automatically associated with them.

For more information about tags and property sets, see “Adding Schedule 
Tags” on page 2231.

1 Open the tool palette that you want to use, and select a space auto gener-
ate tool.

2 Select All linework for Selection Filter, and click OK.

3 Select the objects from which to generate the spaces, and press ENTER.

4 Select a style for the spaces.

5 Click Tag Settings, and specify the settings:

6 Click within an area enclosed by the selected lines.

The space created in that area has the selected tag and property set, if 
selected.

7 To view information about all spaces in the drawing, click Space Query, 
and then click OK.

8 Click Close.

If you want to . . . Then . . .

add a tag to the space select Add Tag to New Spaces, and 
specify a definition for Tag Definition.

add a property set to the space select Add Property Set to New Spaces, 
and specify a property set for Property 
Set. Select either Number or Name for 
Property 1 and for Property 2.

automatically increment the number 
associated with the space tag

select Auto-Increment Numeric 
Properties, and enter a value for 
Increment.
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Updating Generated Spaces
Use this procedure to update spaces that have been generated from walls and 
linework. If you have moved any of the objects that form the boundary set 
for the generated spaces, you can update the space to match the new shape.

Updating spaces after modifying walls

1 Open the tool palette that you want to use, and select a space auto gener-
ate tool.

2 Select the Selection Filter you used to generate the spaces, and click OK.

3 Select the items in the boundary set from which to update the spaces, and 
press ENTER.

4 Select a different style for the spaces, if needed.

5 Click Update Space.
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6 Click the space to update.

7 Click an internal point in the new area for the space.

8 Click Close.

Creating a Space Tool
Use this procedure to create a space tool and add it to a tool palette. You may 
want to create your own space tools if you are placing multiple spaces of spe-
cific styles with additional space properties that you want to be the same 
each time you add a space of that type.

For example, you are creating an office floor plan with partition walls for 
cubicles. Although all partition walls use the same wall style in your floor 
plan, the walls in administrative areas are lower than the walls in office areas. 
To work efficiently, you can quickly create a wall tool for each wall height. 
You can then select the appropriate tool to place the walls with the correct 
height in each area of the floor plan.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

If you want to . . . Then . . .

create a tool from a space in the 
drawing

select the object, and drag it to the tool 
palette.

create a tool from a space style 
in the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 To add keywords to the tool, click More Info.

7 Enter the keywords, and click OK.

8 Expand Basic, and expand General.

9 Click the setting for Description, enter a description of the space created 
from this tool, and click OK.

10 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

11 Select a space style.

12 Select the drawing file containing the style used for this space.

13 Expand Component Dimensions.

14 Specify the component dimensions of the space:

15 Expand Actual Dimensions.

16 Specify the actual dimensions of the space:

If you want to . . . Then . . .

specify the clear height 
of the space

enter a value for Space height.

specify the thickness of 
the space floor 
boundary

enter a value for Floor boundary thickness.

specify the thickness of 
the space ceiling 
boundary

enter a value for Ceiling boundary thickness.

specify the distance 
from the top of the 
space ceiling boundary 
to the top of the space

enter a values for Height above ceiling.

If you want to . . . Then . . .

specify which 
dimension to contrain 
to

select Area, Length, Width, or None for Constrain.

specify the area of the 
space

enter a value for Area.
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17 Click OK.

Editing Spaces

After you place space objects in a drawing, you can move them, resize them, 
create interference conditions, and change their properties to fit your design 
needs. 

Autodesk® Architectural Desktop offers several methods for editing spaces:

� You can directly edit spaces using grips for dimensions and other physical 
characteristics.

specify the length of 
the space along its 
relative X direction

enter a value for Length.

specify the width of the 
space along its relative 
Y direction

enter a values for Width.

If you want to . . . Then . . .
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Viewing spaces grips

� You can change space settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

space.

Related Procedures

� Changing the Style of a Space

� Changing the Size of a Space

� Changing a Space Using Grips

� Joining Spaces

� Dividing a Space

� Creating Interference Conditions for a Space

� Removing an Interference Condition from a Space

� Changing the Component Dimensions of a Space

� Changing the Location of a Space

� Attaching Hyperlinks, Notes, or Files to a Space
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Changing the Style of a Space
Use this procedure to assign a different space style to an existing space. The 
new space style defines the target, minimum, and maximum size, and assigns 
display properties for the net boundary, gross boundary, and space hatch. 
You create the new space style before applying it to new or existing spaces.

1 Double-click the space you want to change.

2 In the Properties palette, select a new style for Style.

Changing the Size of a Space
Use this procedure to change the length and width of a space after it has been 
created. If the length is changed, the area is changed, keeping the width con-
stant. Similarly, if you change the width, the area is changed and the length 
stays constant.

You can also change the height of the space or add or remove the floor or 
ceiling boundary.

NOTE The height displayed for Space Height is the space between the upper 
surface of the floor slab and the lower surface of the ceiling plane, which is 
referred to as the room height. It is not the overall height of the space object.

1 Double-click the space you want to change.

2 On the Properties palette, expand Basic, and expand Component Dimen-
sions.

3 To change the height of the space, enter a new value for Space height.

4 To add or remove the floor boundary or the ceiling boundary, enter a new 
value for Floor boundary thickness or Ceiling boundary thickness.

5 Expand Actual Dimensions.

6 To change the length or width of the space, enter a new value for Length 
or Width.

Changing a Space Using Grips
Use this procedure to create non-rectangular spaces by using grips to edit 
spaces. The length of the space is displayed as the value of the longest dis-
tance between any two vertices on the X axis. The width is the longest dis-
tance between any two vertices on the Y axis. The area is calculated from the 
size of the space.
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Changing a space using edge grips

1 Select the space you want to change.

2 Select an Edge or a Vertex grip, and move it to change the size or shape of 
the space.
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Joining Spaces
Use this procedure to join two spaces to create one larger space. The spaces 
may be overlapping, tangential, or separate. The resulting space is considered 
one space even if the two original spaces did not touch. The characteristics 
of the first space selected override those of the second space selected.

Joining existing spaces

1 Select the first space, right-click, and click Join Spaces.

2 Select a space to join with the first space.

Dividing a Space
Use this procedure to divide a space into smaller spaces by using a divide line. 
The space is split at the line.

Adding space boundary edges also divides spaces if the space boundary is 
specified as Manage Contained Spaces. This option creates a space within the 
space boundary. Any changes to the space boundary also affect the space 
managed by the boundary. If the Manage Contained Spaces option is cleared 
when a space boundary is edited, any changes to the space boundary do not 
change the spaces within it. For more information, see “Adding Boundary 
Edges” on page 704.

Dividing existing spaces
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NOTE The start point and endpoint of the divide line establish a line that 
extends to the edges of the space, dividing all parts of the selected space that lie 
on opposite sides of the line. 

1 Select a space to divide, right-click and click Divide Spaces.

2 Specify the divide line start point.

3 Specify the divide line end point.

The space is divided into smaller spaces at the divide line.

Creating Interference Conditions for a Space
Use this procedure to place objects, such as mass elements, in a space to cre-
ate custom openings or cutouts in the space. This process is called creating 
an interference condition. For example, a column grid structure might have 
columns within the space. Once defined as interference conditions, the col-
umns cut out an area at the floor and ceiling of the space. 

Calculations of the area of the space are correctly based on both the space 
and the interference conditions defined for that space. These calculations 
can be used in schedules. For more information, see “Creating and Editing 
Schedule Tables” on page 2211.

Other objects attached to the space, such as a ceiling grid, recognize the inter-
ference condition. For example, if you add a column to the space as an inter-
ference condition, as long as the ceiling grid is anchored to the space object, 
the ceiling grid is cut. If you move the column, the ceiling grid is updated 
automatically with the new column location.

1 Place the object you want to use as the interference condition in the loca-
tion where it is needed.

2 Select the space to which you want to the interference condition, right-
click and click Interference Condition.

3 Enter a (Add).

4 Select spaces you want to be affected by the interference condition.

5 Select the object intersecting the space as the interference condition, and 
press ENTER.

Removing an Interference Condition from a Space
Use this procedure to remove existing interference conditions from spaces.
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NOTE Make sure that the interference object is visible in the drawing so you 
can select it to remove. 

1 Select the space with the interference condition, right-click and click 
Interference Condition.

2 Enter r (Remove). 

3 Select spaces that are affected by the interference condition.

4 Select the object intersecting the space as the interference condition, and 
press ENTER.

Changing the Component Dimensions of a Space
Use this procedure to control the constraints of the space and its component 
dimensions by changing its dimension properties. 

You can control all dimension aspects of the space, including the floor and 
ceiling boundary thickness and the height of the space above the ceiling 
boundary.

1 Double-click the space you want to change.

2 On the Properties palette, expand Basic, and expand Component Dimen-
sions.

3 Modify height and thickness dimensions:

Changing the Location of a Space
Use this procedure to relocate a space by changing the coordinate values of 
its insertion point. The space also has an orientation with respect to the 
world coordinate system (WCS) or the current user coordinate system (UCS). 
For example, if the top and bottom of the space are parallel to the XY plane, 
its normal is parallel to the Z axis. You can change the orientation of the 

If you want to . . . Then . . .

change the height of the space enter a new value for Space height.

change the thickness of the space floor 
boundary

enter a new value for Floor boundary 
thickness.

change the thickness of the space 
ceiling boundary

enter a new value for Ceiling boundary 
thickness.

change the height of the space above 
the ceiling boundary

enter a new value for Height above 
ceiling.
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space by aligning its normal with another axis. You can also rotate the space 
on its plane by changing the rotation angle.

For information about the WCS and the UCS, see “Use Coordinates and 
Coordinate Systems” in the online AutoCAD 2004 User’s Guide.

1 Double-click the space you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information.

4 On the Location worksheet, specify the location of the space:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Space
Use this procedure to attach hyperlinks, notes, or files to a space. You can also 
edit hyperlinks and notes, and edit or detach reference files from a space.

1 Double-click the mass element you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

If you want to . . . Then . . .

relocate the space enter new coordinate values under Insertion Point.

locate the space on the XY 
plane

make the normal of the space parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the space on the YZ 
plane

make the normal of the space parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the space on the XZ 
plane

make the normal of the space parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
space

enter a new value for Rotation Angle.
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7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK twice.

Using Materials for Spaces

Using materials simplifies defining the display of objects. You define the dis-
play of a material, such as shingles or glass, only once in the drawing or the 
drawing template, and then assign it to any object component or object 
style. For example, you can define a material “Glass” and then assign it to 
any number of windows, glass door insets, or cubicle walls.

Using a common set of materials provides centralized control across the dis-
play of objects in a drawing or throughout the whole project. When the par-
ticulars of a material change, you change them just once in the material def-
inition and all objects are automatically updated.

For more information, see “Materials” on page 491.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Rendered building with different materials

Predefined Materials
Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes. You can use these predefined materials, 
or modify them to your special designs. You can also create your own mate-
rials.

Surface Hatching
The ability to assign surface hatches to objects has greatly been improved by 
materials. Surface hatches can display in both model views and section/ele-
vation views. Placement and orientation of the hatch can be precisely con-
trolled and specified for each object face individually.

For detailed information about surface hatches, see “Working with Surface 
Hatches” on page 504.

Related Topics

� Space Display Components and Materials

� Process Overview: Creating and Applying a Space Material

Space Display Components and Materials
A space object consists of a number of display components that can be deter-
mined by materials. 

Workflow
When you assign materials to a space, you assign one material to each display 
component of the space. For example, you assign a tile material to the space 
floor and a concrete material to the ceiling. 
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If you want to use the display properties of the space instead of the material 
display properties or the space style, you can deactivate the material assign-
ments in the display properties of the space or the space style.

Display Representations
The display properties of an object or an object style are specified for each 
display representation individually. A space has, by default, display represen-
tations for plan views, model views, reflected views, and volume views. You 
can create new display representations for spaces by copying an existing dis-
play representation. For example, you can create a new display representa-
tion “Plan 1:25” to create a plan view optimized for display in a view scaled 
to 1:25. This new display representation has the same display components as 
the original one from which it was copied. The copied components will be 
influenced by the same material components as the original components.

Material Component Assignments
Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in Plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in 3D model views and elevations.

For a complete list of material components and their description, see “Mate-
rial Components and Display Properties” on page 498.

The following table lists all space components plus information about which 
material components determine them in specific views.

Space Component Material Component

Plan, Plan High Detail, Plan Low Detail, Plan Presentation, Plan 
Screened

Net Boundary Plan Linework

Gross Boundary No Material

Hatch Plan Hatch

Model

Floor 3D Body

Ceiling 3D Body

Reflected, Reflected Screened

Net Boundary Plan Linework

Gross Boundary No Material
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Process Overview: Creating and Applying a Space Material
If you create a material, you can then apply it to all types of objects that sup-
port materials. For example, a concrete material could be used for a wall and 
for a structural element. Spaces usually represent a room bounded by floor 
and ceilings, so that you might use floor tiles or cassette ceilings materials. If 
you want to create a material to use only for spaces, it is recommended that 
you name it accordingly. For example, if the materials have specific names 
such as Space - Floor Tile or Space - Cassette Ceiling, you can simplify the 
organization of your material definitions.

Step 1: Create a new material definition or edit an existing material defini-
tion.

For information on creating and editing materials, see “Creating and Editing 
Materials” on page 517.

Step 2: In the material definition, define the settings that affect the display 
of materials in spaces:

Hatch Plan Hatch

Volume

Entity No Material

If you want to . . . Then . . .

display a surface hatch for 
a space in 3D model views

turn on the Surface Hatch component and 
specify its display properties. For more 
information, see “Defining the Layer, Color and 
Linetype of a Material” on page 520 and 
“Specifying the Surface Hatch Pattern of a 
Material” on page 523.

display a section hatch for 
the space in a 2D section, 
3D section, or live section

turn on the Section Hatch component and 
specify its display properties. For more 
information, see “Defining the Layer, Color and 
Linetype of a Material” on page 520 and and 
“Specifying the Plan and Section Hatch Patterns 
of a Material” on page 521.

display the sectioned 
boundary and sectioned 
body of a space in a live 
section

turn on the Sectioned Boundary and Sectioned 
Body components and specify their display 
properties. For more information, see “Defining 
the Layer, Color and Linetype of a Material” on 
page 520.

Space Component Material Component
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Step 3: Assign the materials created to the space styles used in your building 
model. 

For information on assigning materials to space styles, see “Assigning Mate-
rials to a Space Style” on page 692.

Space Styles

A space style is a collection of settings for variables associated with a space 
object. Depending on the scope of the drawing, you could create different 
space styles to represent a wide range of different types of spaces, from sepa-
rate zoning areas in a master plan to different room types in an office build-
ing. 

Properties that Space Styles Control
The space style you select determines the properties of spaces you create in 
the drawing. The space style controls the target width, length, and area of a 
space. When you are creating a space, the minimum and maximum area, 
length, and width specified in the current space style cannot be exceeded.

You can enter a description of the style that is stored with the style. This 
information is used when you perform a space inquiry as one of the basic 
divisions in its queries. For more information, see “Viewing Information 
About Spaces” on page 695.

When you edit the display properties of a space style, those changes are 
applied to existing spaces of that style throughout the current drawing.

Creating Space Styles
Typically, you create space styles that represent the basic divisions of the 
drawing that you need to keep track of separately. These may be departmen-

tal or functional divisions. For example, space styles provided with Autodesk® 

Architectural Desktop include kitchens, offices of different sizes, restrooms, 
cafeterias, and libraries. When you name a space style, spaces are automati-
cally grouped and can generate reports based on the first part of the space 
style name.

add special rendering 
materials for spaces in live 
sections

select rendering materials. For more 
information, see “Assigning Materials for 
Rendering” on page 526.

exclude space 
components from a 2D 
section shrinkwrap hatch

specify this setting in the material definition. For 
information, see “Excluding a Material from 2D 
Section Shrinkwrap” on page 528.

If you want to . . . Then . . .
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Editing Space Styles
The changes you make to an existing space style take effect the next time you 
use it to create a space. Spaces already created with the space style are not 
updated unless you change the display properties of the space style or the Net 
to Gross Offset. If you edit the display properties or the Net to Gross Offset 
of a space style, those changes are applied to existing spaces of that style.

Managing Space Styles
When you create, import, export, or edit styles, you access the Style Manager. 
The Style Manager provides a central location in Autodesk Architectural 
Desktop where you can work with styles from multiple drawings and tem-
plates. For more information about using the Style Manager, see “Getting 
Started with the Style Manager” on page 533.

Related Procedures

� Creating a Space Style

� Specifying the Dimensions of a Space Style

� Assigning Materials to a Space Style

� Specifying the Display Properties of a Space Style

� Specifying the Hatching for Components of a Space Style

� Attaching Notes and Files to a Space Style

Creating a Space Style
Use this procedure to create a space style. You can create a style using default 
style properties or by copying an existing style. After you create the style, you 
edit the style properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Space Styles.

3 Create a space style:

4 Enter a name for the new space style, and press ENTER.

If you want to . . . Then . . .

create a style with default 
properties

right-click Space Styles, and click New.

create a style from an 
existing style

right-click the space style you want to copy, and 
click Copy. Right-click, and click Paste.
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5 To edit the new space style, right-click the style, and click Edit:

6 When you finish specifying the properties of the space style, click OK 
twice.

Specifying the Dimensions of a Space Style

Use this procedure to specify the following dimensions for a space style: 

� the target area and the minimum and maximum areas
� the target length and the minimum and maximum lengths
� the target width and the minimum and maximum widths

When you create spaces, if you specify a space area, length, or width that falls 
outside the sizes specified for that style, the area, length, or width is trun-
cated to the target size, and a warning is displayed. 

The Net to Gross Offset value controls the width of the boundary when you 
convert spaces to walls. The net area of the space (after subtracting the offset) 
becomes the usable floor area. This value also defines the Node object snap 
for the placement of spaces. By default, the Net to Gross Offset is turned off 
(not visible).

NOTE When you change the Net to Gross Offset value for a space style, the 
new value is applied both to new and existing spaces of that style in the drawing.

If you want to . . . Then . . .

specify default dimensions 
for the style

see “Specifying the Dimensions of a Space Style” on 
page 689.

specify materials for space 
components

see “Assigning Materials to a Space Style” on 
page 692 .

specify the display 
properties of the style

see “Specifying the Display Properties of a Space 
Style” on page 693.

specify hatching for 
components of the style

see “Specifying the Hatching for Components of a 
Space Style” on page 693.

add notes and files to the 
style

see “Attaching Notes and Files to a Space Style” on 
page 695.
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Specifying a space net to gross offset

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Space Styles.

3 Select the space style that you want to change, right-click, and click Edit.

4 Click the Dimensions tab.

5 Specify the dimensions for the space style:

Target values must fall between the set minimum and maximum values.

6 Enter a new value for Net to Gross Offset.

7 Click OK twice.

Specifying the Materials of a Space Style

A space consists of a number of components whose display properties can be 
determined by the materials assigned to each component.

When you assign materials to a space style, you assign one material to each 
physical component of the space. For example, you assign a wood material 
to the floor and a tile material to the ceiling. You assign materials to compo-
nents in each display representation where you want the materials to be 
used.

If you want to . . . Then . . .

specify a different area for the space 
style

enter a new value for Target Area, Min 
Area, or Max Area.

specify a different length for the space 
style

enter a new value for Target Length, 
Min Length, or Max Length.

specify a different width for the space 
style

enter a new value for Target Width, 
Min Width, or Max Width.
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If you want to use the display properties of the space style, instead of using 
material display properties, you can turn off the material assignments in the 
display properties of the space style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Space Materials and Display Components

� Assigning Materials to a Space Style

Space Materials and Display Components
The following table lists all space components plus information about which 
material components determine them in specific views.

Space Component Material Component

Plan, Plan High Detail, Plan Low Detail, Plan Presentation, Plan 
Screened

Net Boundary Plan Linework

Gross Boundary No Material

Hatch Plan Hatch

Model

Floor 3D Body

Ceiling 3D Body

Reflected, Reflected Screened

Net Boundary Plan Linework

Gross Boundary No Material

Hatch Plan Hatch

Volume

Entity No Material
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Assigning Materials to a Space Style
Use this procedure to assign materials to the individual components of a 
space style. When you assign a material to a space component, the compo-
nent uses the display properties of the material instead of the style display 
properties.

You can assign a material to any physical component of the space. Custom 
components and components that are only symbolic graphics do not use 
materials for their display properties. For example, the floor and ceiling are 
physical components. The gross boundary is a symbolic component.

NOTE If a material assignment does not determine the display properties of a 
space component, you can change the display properties of the space style as 
described in “Specifying the Display Properties of a Space Style” on page 693.

1 Open a tool palette that has a space tool.

2 Right-click a space tool, and click Space Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.



Spaces | 693

Specifying the Display Properties of a Space Style

Use this procedure to change the following display properties of the display 
components of a space style: 

� Visibility (component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

To change these display properties for an individual space, see “Space Display 
Components and Materials” on page 684.

NOTE If a material assignment determines the display properties of compo-
nents in the space style, you can change the properties of the display component 
by clearing By Material. You can also override the material assignment with a dif-
ferent material. For more information, see “Specifying the Materials of a Space 
Style” on page 690.

1 Open a tool palette that has a space tool.

2 Right-click a space tool, and click Space Styles.

3 Right-click the space style you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 Select Space Style for the property source, and click Attach Override.

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying the Hatching for Components of a 
Space Style

Use this procedure to specify the hatching of the components of a space 
style. Space hatching is displayed only in display representations, such as 
Plan, that are used in the Top view (plan view) of a drawing.
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1 Open a tool palette that has a space tool.

2 Right-click a space tool, and click Space Styles.

3 Right-click the space style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and click Style Override.

The display representation in bold is the current display representation.

6 Click the Hatching tab.

7 Select a display component, and click the setting for Pattern.

8 Select the hatching for the  display component:

9 Click OK.

10 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

11 Click Angle, and enter the angle for the selected pattern.

12 Click Orientation, and specify how the hatching is oriented:

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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13 Click OK twice.

Attaching Notes and Files to a Space Style

Use this procedure to enter notes and attach reference files to a space style. 
You can also edit notes and edit or detach reference files from a space style.

1 Open a tool palette that has a space tool.

2 Right-click a space tool, and click Space Styles.

3 Right-click the space style you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the space style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

Viewing Information About Spaces

Use this procedure to view the total area used by each space, as well as the 
quantity of each space used. For individual spaces, you can view the space 
style, description, individual area, and maximum and minimum size.

1 On the command line, enter space, and then enter q (Query).

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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2 Specify the information you want to view:

3 Click OK, and then press ENTER.

Creating a Space Report

Use this procedure to create a database file from the results of a space inquiry.

1 On the command line, enter space, and then enter q (Query).

2 Click either the Space Info Total tab or the Space Information tab.

3 Click Create MDB.

4 Enter a name for the database file. 

The default name is the current drawing name.

5 Click Save, and then click OK.

6 Press ENTER.

Space Boundaries

A space boundary is a division between spaces that may exist as a solid form 
boundary or as an area separation boundary. In inside-out designing, you can 
think of spaces as equivalent to rooms, space boundary edges as walls, and 
the grouping of spaces by a boundary as a department.

Spaces and Space Boundaries
You can create space boundary objects with or without included space 
objects. If spaces are created with space boundary objects, the boundaries are 
dependent on those space objects. If you delete such a space, the boundary 
edges are removed as well. Spaces and boundaries combine to create the com-
plete representation of the space, the interior space, and the surrounding 
boundaries. You can attach spaces to boundaries after both have been cre-
ated. 

If you want to . . . Then . . .

view the information about the total 
spaces in the drawing

click the Space Info Total tab.

view the information about the 
individual spaces in the drawing

click the Space Information tab.
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Viewing spaces and space boundaries

Solid Form and Area Separation Boundaries
There are two types of space boundaries, solid form and area separation. Solid 
form boundaries equate to walls with a specified thickness. You can convert 
a solid form boundary to a wall between two spaces. This boundary shares all 
the characteristics of a wall, including the following settings:

� Justification
� Base height
� Thickness (width)

Area separation boundaries have a thickness of zero and cannot be converted 
to walls. An area separation boundary divides a space without anything solid 
between the spaces. For example, an area separation boundary might sepa-
rate two departments in an open office.

Viewing solid form and area separation space boundaries

Creating Space Boundaries
You can create space boundaries from existing spaces, slices, polylines, arcs, 
and lines. For more information about slices, see “Creating Slice Floorplates 
from a Conceptual Model” on page 713.
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Space Boundary Edges
Each section of a space boundary is also called a space boundary edge. When 
you select a section of the space boundary, the section that is highlighted is 
one space boundary edge. You can manipulate each edge separately.

Related Procedures

� Creating a Space Boundary

� Converting a Space to a Boundary

� Converting a Slice to a Boundary

� Converting Sketching to a Boundary

� Attaching Spaces to a Space Boundary

� Merging Boundaries

� Splitting Space Boundaries

� Adding Boundary Edges

� Editing Boundary Edges

� Removing Boundary Edges

� Anchoring Objects to Boundaries

� Releasing Objects from Space Boundaries

� Converting Space Boundaries to Walls

� Editing Space Boundaries

Creating a Space Boundary

Use this procedure to create a solid form boundary or an area separation 
boundary:

� You can create a space boundary with a solid form around the edge of the 
boundary that represents walls around the space. Solid form boundaries 
can be straight lines or arcs. You can later convert solid form boundaries 
to walls. See “Converting Space Boundaries to Walls” on page 710.

� You can create a space boundary with a line of zero thickness around the 
edge of the boundary. An area separation boundary cannot be converted 
to walls. 

When you create a space boundary, you can also create a space object within 
the boundary. For more information about space objects, see “Spaces” on 
page 656.
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Creating a space boundary

1 Open the tool palette that you want to use, and select a space boundary 
tool.

2 On the Properties palette, expand Basic, and expand General.

3 Specify either Solid or Separation for Boundary type.

4 Specify either Line or Arc for Segment type.

5 Specify the dimensions of the space boundary:

If you want to specify . . . Then . . .

the distance between the top of the 
solid form space ceiling boundary to 
the top of the space

enter a value for Base height.
When you convert the space boundary 
to a wall, the wall uses the height 
parameters of the space boundary.

the width of a solid form boundary enter a value for Width.
When you convert the space boundary 
to a wall, the wall uses the width of the 
space boundary.

the justification of a solid form 
boundary in relation to selected points

select Left, Center, or Right for Justify.

the offset distance of a solid form 
boundary as you draw the space 
boundary

enter a value for Baseline offset.
The offset distance is measured from 
the start and end points of the space 
boundary segment to the space 
boundary baseline.

that the space is associative to its space 
boundary

select Yes for Manage contained 
spaces.
Any changes to the space boundary 
also affect the space managed by the 
boundary. 



700 | Chapter 11 Creating Conceptual Models

Specifying the height of a space boundary

Specifying the offset distance of a space boundary

Specifying the width of a space boundary
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Specifying space boundary justification

6 Specify boundary conditions:

7 Specify points to define the boundary.

8 Specify the endpoint of the boundary:

If you want to specify . . . Then . . .

the ceiling boundary automatically select Automatic for Ceiling condition.

the ceiling to stop at the boundary select Ceiling stops at boundary for 
Ceiling condition.

the boundary to stop at the ceiling select Boundary stops at ceiling for 
Ceiling condition.

the floor boundary automatically select Automatic for Floor condition.

the floor to stop at the boundary select Floor stops at boundary for Floor 
condition.

the boundary to stop at the floor select Boundary stops at floor for Floor 
condition.

If you want to . . . Then . . .

close the boundary by 
drawing two segments 
that meet at a right angle

enter or (Ortho Close), and then specify a point in 
the direction you want the boundary to close. The 
segment is extended until it meets a segment 
perpendicular to the first segment.
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9 Press ENTER.

When a closed shape is created, it is designated by a hatched space contained 
within the space boundary in plan view.

Converting a Space to a Boundary

Use this procedure to create space boundaries from existing spaces. Two or 
more non-overlapping spaces create one space boundary that surrounds each 
space object. These boundaries do not need to be connected to be considered 
the same space boundary.

NOTE If the space has a style with a net-to-gross offset, the space boundary is 
displayed in model view as a solid “wall” structure, where the width of the 
boundary edges is defined by the offset. If the space style has no net-to-gross 
offset, the space boundary is displayed as a flat area identical to the space 
ground area. For more information about net-to-gross offset, see “Using Space 
Styles” on page 657.

1 On the command line, enter spaceboundary, and enter c (Convert).

2 Enter sp (Spaces), and select the spaces to convert.

3 Press ENTER twice.

Converting a Slice to a Boundary

Use this procedure to create a space boundary from a slice. The interior floor 
line of the bounded space is set at the elevation of the slice; the thickness of 
the floor may extend below the slice. 

The slice you select must have objects attached to it. 

1 On the command line, enter spaceboundary, and enter c (Convert).

2 Enter sl (Slices), and select the slice to convert.

3 Press ENTER twice.

complete the segment at 
a point that you specify

specify the endpoint of the boundary, and enter c 
(Close).

If you want to . . . Then . . .
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Converting Sketching to a Boundary

Use this procedure to create space boundary edges from polylines, lines, arcs, 
and circles. 

Converting a polyline to a space boundary

1 On the command line, enter spaceboundary, and enter c (Convert).

2 Enter e (Edges), and select the polyline, line, arc, or circle to convert.

3 Enter y (Yes) to erase the original geometry, or enter n (No) to keep them 
in the drawing.

4 Specify the properties for the new space boundary edges. 

For more information, see “Editing Boundary Edges” on page 705.

5 Press ENTER twice.

Attaching Spaces to a Space Boundary

Use this procedure to add spaces to an existing space boundary. You add 
spaces by attaching them to an existing boundary and creating a space 
boundary around each space. The boundary is considered to be the same 
boundary, such as for space information totals. 

NOTE The space boundary must have the Manage Contained Spaces option 
selected before spaces are attached to it. See “Creating a Space Boundary” on 
page 698.

1 Select the space boundary, right-click and click Attach Spaces to Boundary.

2 Select the spaces to attach to the selected boundary.

3 Press ENTER.
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The spaces have boundaries created around each one, and they are added to 
the existing space boundary.

Merging Boundaries

Use this procedure to combine two or more boundaries to make one space 
boundary.

1 Select the first space boundary, right-click and click Merge Boundaries.

2 Select a second boundary to merge with the first boundary.

Splitting Space Boundaries

Use this procedure to split a space boundary into two smaller boundaries if 
the boundary contains more than one space.

1 Select the space boundary, right-click and click Split Boundary.

2 Select the spaces in the boundary to split from the larger boundary.

3 Press ENTER.

Adding Boundary Edges

Use this procedure to add an additional edge to an existing space boundary. 
The newly added edge becomes a part of the space boundary. The new edge 
cuts the space within the boundary if the boundary manages the spaces 
within it. For more information, see “Creating a Space Boundary” on 
page 698.

1 Select the space boundary, right-click and click Add Edges.

2 Select a space boundary.

3 Specify the properties of the space boundary:

4 Specify a start point and an end point for the new space boundary edge.

If you want to . . . Then . . .

specify unique properties for the newly 
added space boundary edge

select the segment type, and enter 
values for Base height, Width, Justify, 
and Baseline offset.

match the properties of an existing 
space boundary edge click , and select the existing 

space boundary.
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The start point and end point must touch the spaces inside the existing 
boundaries to form a new space within the added edges.

Editing Boundary Edges

Use this procedure to change specific edges on a space boundary. You can 
modify a space boundary edge by changing its segment type, width, height, 
and its boundary conditions for both floor and ceiling.

1 Select the space boundary, right-click and click Edit Edges.

2 Select space boundary edges to change, and press ENTER. 

3 Click the Dimensions tab.

4 Change the segment type:

5 Enter a new value for Width, if needed. 

If you want to . . . Then . . .

create boundary edges with a specific 
width

select Solid Form for Segment Type.
The boundary edges can be later 
converted to a wall the width of the 
space boundary.

create a boundary that is a partition or 
space divider line

select Area Separation for Segment 
Type.
An area separation boundary cannot 
be converted to a wall.
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6 Change the justification, which controls how the boundary is drawn with 
respect to the selected points:

7 Click the Design Rules tab.

8 Specify the boundary conditions at the ceiling:

If you want to . . . Then . . .

use the selected points for the location 
of the inner surface of the space 
boundary

select Left for Justify.

use the selected points for the location 
of the centerline of the space boundary

select Center for Justify.

use the selected points for the location 
of the exterior face of the space 
boundary

select Right for Justify.

If you want to . . . Then . . .

change the boundary conditions at the 
ceiling

clear Automatically Determine from 
Spaces.
If you select this option, the conditions 
are automatically set from the 
contained spaces.

change the height of the space 
boundary from the top of the floor to 
the bottom of the ceiling.

enter a value for Base Height.
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Specifying ceiling conditions

Specifying the upper extension of a boundary

locate the ceiling below the top of the 
wall (for example, to create a dropped 
ceiling)

select Ceiling Stops at Wall, and enter a 
value for Upper Extension.

locate the bottom of the ceiling at the 
top of the wall

select Wall Stops at Ceiling.

If you want to . . . Then . . .
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9 Specify the boundary conditions at the floor:

Specifying floor conditions

Specifying the lower extension of a boundary

If you want to . . . Then . . .

change the boundary conditions at the 
floor

clear Automatically Determine from 
Spaces.
If you select this option, the conditions 
are automatically set from the 
contained spaces.

locate the floor below the bottom of 
the wall

select Floor Stops at Wall, and enter a 
value for Lower Extension.

locate the bottom of the wall at the 
top of the floor

select Wall Stops at Floor.
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10 Click OK.

Removing Boundary Edges

Use this procedure to remove specific edges from a space boundary. If the 
space boundary is managing contained spaces and if removing the boundary 
edge opens an enclosed boundary, the managed spaces are deleted as well.

1 Select the space boundary, right-click and click Remove Edges.

2 Select the space boundary edges to delete, and press ENTER.

Anchoring Objects to Boundaries

Use this procedure to anchor objects to space boundaries. An anchored 
object is constrained to the space boundary. You can move an anchored 
object along the space boundary, but you cannot move the object off the 
boundary unless you release the object from the boundary. 

The center of the bottom face of the object is anchored to the insertion point 
on the bottom face of the space boundary and midway in the boundary 
width.

For more information about anchors, see “Working with Curve Anchors” on 
page 754.

1 Select the space boundary, right-click and click Anchor to Boundary.

2 Enter a (Attach objects) to anchor an object to the space boundary.

3 Select the object to anchor to the boundary.

4 Select the space boundary to anchor the object to.

The object is placed on the space boundary and is anchored to the location 
you selected on the space boundary.

Releasing Objects from Space Boundaries

Use this procedure to detach objects that are anchored to space boundaries.

1 Select the space boundary, right-click and click Anchor to Boundary.

2 Enter f (Free objects) to detach an object from the space boundary.

3 Select the object to detach from the boundary.

4 Press ENTER to release the attached object. 

The object is no longer anchored and can now be moved off the space 
boundary.
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Converting Space Boundaries to Walls

Use this procedure to convert space boundaries to walls to be carried forward 
into the design phase of the drawing.

If you want to create a wall up to ceiling height only, set the value of the 
space above ceiling height to zero. Also, the wall generated has a baseline at 
zero if the boundary is created in the World Coordinate System (WCS), but 
the wall itself extends below baseline by a distance equal to the floor thick-
ness. For more information about the WCS, see “Use Coordinates and Coor-
dinate Systems” in the online AutoCAD 2004 User’s Guide.

NOTE When walls are generated from a space boundary, any boundary edges 
(segments) that are adjoining and collinear become a single wall. To prevent 
segments from joining automatically, make them different widths. This is useful, 
for example, when the resulting wall segments must be different styles. You can 
change the widths after converting the boundary to walls.

The walls created from space boundaries have the properties of the Standard 
wall style. After you convert the space boundaries to walls, you can edit them 
as you do any other walls, including changing their style. For more informa-
tion, see “Editing Walls” on page 1769.

The space boundary and any spaces that it is managing stay in the drawing, 
but there is no link between the space boundary and the created wall object. 
If you need to edit a boundary, delete the walls, change the boundary, and 
then convert it to walls again.

NOTE Only space boundaries that have a Solid boundary type can be con-
verted to walls.

� Select a space boundary, right-click and click Generate Walls.

Editing Space Boundaries

You can change an existing space boundary from a solid form boundary to 
an area separation boundary. You can also change the notes, descriptions, or 
reference files attached to a space boundary; segment type, width, and justi-
fication; design rules; and location properties. 

Related Procedures

� Modifying a Space Boundary
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� Changing the Location of a Space Boundary

� Attaching Hyperlinks, Notes, or Files to a Space Boundary

Modifying a Space Boundary
Use this procedure to change an existing space boundary from a solid form 
boundary to an area separation boundary. Depending on the type of bound-
ary, you can change its height and width, how it is drawn with respect to the 
points you specified (justification), and whether changes to the boundary 
change the space contained within it.

1 Double-click the space boundary you want to change.

2 On the Properties palette, expand Basic, and expand General.

3 Specify the space boundary type:

4 Expand Dimensions.

5 Specify the space boundary dimensions:

If you want to . . . Then . . .

designate the space boundary as one 
with edges of specific width

select Solid for Boundary type.
This boundary edge can be later 
converted to a wall. 

designate the space boundary as one 
that is a partition or space divider line

select Separation for Boundary type.
An area separation boundary edge 
cannot be converted to a wall.

If you want to . . . Then . . .

modify the height of the space 
boundary

enter a new value for Base height.

modify the width and justification of a 
solid space boundary

enter a new value for Width, and select 
a different option for Justify.

manage the spaces within the space 
boundary

select Manage contained spaces.
Any changes to the space boundary 
also affect the space managed by the 
boundary.
If the Manage contained spaces option 
is cleared when a space boundary is 
edited, any changes to the space 
boundary do not change the spaces 
within it.
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Changing the Location of a Space Boundary
Use this procedure to relocate a space boundary by changing the coordinate 
values of its insertion point. The space boundary also has an orientation with 
respect to the world coordinate system (WCS) or the current user coordinate 
system (UCS). For example, if the top and bottom of the space boundary are 
parallel to the XY plane, its normal is parallel to the Z axis. You can change 
the orientation of the space boundary by aligning its normal with another 
axis. You can also rotate the space boundary on its plane by changing the 
rotation angle.

For information about the WCS and the UCS, see “Use Coordinates and 
Coordinate Systems” in the online AutoCAD 2004 User’s Guide.

1 Double-click the space boundary you want to modify.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information.

4 Specify the location of the space boundary:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Space Boundary
Use this procedure to attach hyperlinks, notes, or files to a space boundary. 
You can also edit hyperlinks and notes, and edit or detach reference files from 
a space boundary.

If you want to . . . Then . . .

relocate the space 
boundary

enter new coordinate values under Insertion Point.

locate the space boundary 
on the XY plane

make the normal of the space boundary parallel to 
the Z axis: under Normal, enter 1 for Z, and enter 0 
for X and Y. 

locate the space boundary 
on the YZ plane

make the normal of the space boundary parallel to 
the X axis: under Normal, enter 1 for X and enter 0 
for Y and Z. 

locate the space boundary 
on the XZ plane

make the normal of the space boundary parallel to 
the Y axis: under Normal, enter 1 for Y, and enter 0 
for X and Z.

change the rotation of the 
space boundary

enter a new value for Rotation Angle.
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1 Double-click the space boundary you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD®  2004 
Command Reference.

4 To add a note, click the setting for Notes, and enter the note.

5 Click OK.

6 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

7 Click OK twice.

Creating Slice Floorplates from a Conceptual 
Model

A slice can be thought of as a representation of a theoretical floor level. Slice 
floorplates provide a way to translate the 3D geometry of a mass group into 
something that can be used to generate the individual floors of a building. 
Slices can be converted to space boundaries or polylines, and then to walls. 

Slices and Mass Models
Like mass groups, slices are chosen and manipulated by an associated marker, 
the slice marker. When you attach mass groups to the slice marker, the slice 
marker creates the perimeter geometry of the building, known as a floorplate. 
Anytime you change the mass groups attached to the slice marker, the floor-
plate is updated.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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If you attach mass elements instead of mass groups to the slice, the opera-
tional aspects (additive, subtractive, and intersection) of the mass elements 
are not recognized by the slice. To have these aspects recorded by the slice, 
attach the mass group. For more information about additive, subtractive, and 
intersection operations, see “Creating a Mass Group” on page 628.

From Slice Floorplate to Walls
After you create the floorplates, you can convert slices to space boundaries or 
polylines, and then generate walls. You cannot create walls directly from the 
slice. The slice is simply a way to mark each floor level of the mass group.

Related Procedures

� Generating a Slice

� Specifying the Slice Elevation

� Attaching Objects to a Slice

� Detaching Objects from a Slice

� Converting a Slice to a Polyline

� Changing the Location of a Mass Element

� Attaching Hyperlinks, Notes, or Files to a Mass Element

Generating a Slice

Use this procedure to generate a slice. The slice object is defined by a small 
crossed box. Like the mass group marker, the slice marker can be located in a 
convenient place in your drawing. For more information about the mass 
group marker, see “Adding a Mass Group Marker” on page 630.

You can create multiple slices at regular height intervals. A slice marker is cre-
ated for each slice.

Generating slice objects
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1 Open the tool palette that you want to use, and select a slice tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the number of slices you want to create.

3 Specify the lower-left and upper-right corners for the slice marker.

TIP Keep the slice marker small so as not to clutter your drawing.

4 Specify a rotation for the slice marker.

5 Enter the starting height of the slice. 

6 Enter the distance between the slices.

7 Press ENTER.

Specifying the Slice Elevation

Use this procedure to change the elevation of a slice after creating it.

1 Select the slice marker, right-click, and click Set Elevation.

2 Enter a new slice elevation.

If more than one slice was created together, only the elevation of the 
selected slice changes. The distance between slices remains constant.

Attaching Objects to a Slice

Use this procedure to attach mass elements or mass groups to a slice to create 
the building floorplate. You can freeze the layer(s) containing the mass ele-
ments and mass groups to display only the slices.
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Attaching a mass group to slice objects

1 Select the slice marker, right-click, and click Attach Objects.

2 Select the mass elements or mass groups you want to include in the slice.

3 Press ENTER.

Detaching Objects from a Slice

Use this procedure to detach mass elements or mass groups from a slice to 
change a floorplate.

1 Select the slice marker, right-click, and click Detach Objects.

2 Select the mass elements or mass groups you want to remove from the 
slice.

3 Press ENTER.

Converting a Slice to a Polyline

Use this procedure to convert a slice to a polyline after objects have been 
attached to a slice marker. You can then convert polylines to spaces, walls, or 
profiles.

� Select the slice marker, right-click, and click Convert to Polyline.

The outlines of the objects attached to the slice marker are converted to 
polylines.

Changing the Location of a Slice

Use this procedure to relocate a slice by changing the coordinate values of its 
insertion point. The slice also has an orientation with respect to the world 
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coordinate system (WCS) or the current user coordinate system (UCS). For 
example, if the top and bottom of the slice are parallel to the XY plane, its 
normal is parallel to the Z axis. You can change the orientation of the slice 
by aligning its normal with another axis. You can also rotate the slice on its 
plane by changing the rotation angle.

For information about the WCS and the UCS, see “Use Coordinates and 
Coordinate Systems” in the online AutoCAD 2004 User’s Guide.

1 Double-click the slice you want to modify.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information.

4 Specify the location of the slice:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Slice

Use this procedure to attach hyperlinks, notes, or files to a slice. You can also 
edit hyperlinks and notes, and edit or detach reference files from a slice.

1 Double-click the slice you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

If you want to . . . Then . . .

relocate the slice enter new coordinate values under Insertion Point.

locate the slice on the XY 
plane

make the normal of the slice parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the slice on the YZ 
plane

make the normal of the slice parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the slice on the XZ 
plane

make the normal of the slice parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
slice

enter a new value for Rotation Angle.
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4 To add a note, click the setting for Notes, and enter the note.

5 Click OK.

6 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

7 Click OK.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Developing Designs

Topics in Part 4

� AEC Polygons

� Anchors

� Curtain Walls

� Doors

� Door/Window Assemblies

� Grids

� Layout Curves and Grids

� Openings

� Roofs

� Stairs

� Structural Members

� Railings

� Slabs

� Walls

� Windows

IV
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AEC Polygons

An AEC Polygon is a two-dimensional (2D) area object 

that can be used as infill for structures such as curtain 

walls and layout grids. You can use a True Color display 

representation to assign a solid fill to the edges and inte-

riors of AEC Polygons, making these objects useful for 

conceptual rendering.

In this chapter

� Using AEC Polygon Tools to 
Create AEC Polygons

� Creating a New AEC Polygon

� Creating an AEC Polygon with 
User-specified Settings

� Creating an AEC Polygon Tool

� Creating an AEC Polygon from 
a Polyline

� Creating an AEC Polygon from 
a Profile

� Editing AEC Polygons

� AEC Polygon Styles

� Rendering the Exact Colors of 
an AEC Polygon by Defeating 
Lighting and Shading Effects

12
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AEC Polygons and Curtain Walls
Curtain walls provide a framework for inserting objects such as panels, 
windows, and doors. You can use curtain walls to model structures such as 
the following:

� Large scale curtain walls
� Storefronts with components
� Assemblies of custom-shaped doors and windows

In Autodesk® Architectural Desktop, a curtain wall object consists of one or 
more grids. Each grid contains cells that can be filled by a panel, or by an 
object such as a window or door. AEC Polygons are ideally suited to create 
panel infills for curtain walls. 

Curtain wall with AEC Polygon infill assignment

A curtain wall can include curtain wall units. Curtain wall units are similar 
to curtain walls except that their grid cells can contain only panel infills, and 
not objects. Curtain wall units are designed to represent complex elements 
that are repeated within the main curtain wall. You can use AEC Polygons to 
fill the grids in a curtain wall unit.

Paving and Tiling Patterns
You can use AEC Polygons to create intricate paving and tiling patterns in a 
drawing. Using the join, subtract, trim, and split functions of AEC Polygons, 
and by creating AEC Polygons from profiles and polylines, you can create 
complex and irregular polygon outlines. By adding edges and hatch patterns 
to the AEC Polygons, you can display a realistic tiling and paving look. 

AEC Polygon Style Components
You can use AEC Polygon styles to define the look and edge widths of a poly-
gon. You can use the edges to display framing components of infill panels, or 
to represent a shadow. Framing components can have different dimensions, 
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casting shadows with different widths along the edges. When you render the 
curtain wall, you can depict different sun angles with different edge widths.

AEC Polygon components

Polylines and Profiles
Using straight line segments, you can create a freehand AEC Polygon by 
drawing a closed contour of the object.

Creating an AEC Polygon

To define complex and curved shapes, either convert an existing polyline 
into an AEC Polygon or use a profile definition as the source of the AEC Poly-
gon. 
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Converting a polyline to an AEC Polygon

Converting a complex polyline to an AEC Polygon

True Color Display
AEC Polygons have a True Color display representation. When you attach 
AEC Polygons as infill panels to curtain walls, you can use the True Color dis-
play representation to create a conceptual rendering of the curtain wall. 

Related Procedures

� Creating a New AEC Polygon

� Creating an AEC Polygon from a Polyline

� Creating an AEC Polygon from a Profile

� Editing AEC Polygons

� AEC Polygon Styles

� Rendering the Exact Colors of an AEC Polygon by Defeating Lighting and 
Shading Effects
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Using AEC Polygon Tools to Create AEC 
Polygons

Tools provided with Autodesk® Architectural Desktop let you quickly create 
AEC Polygons by selecting an AEC Polygon tool with a specific style and 
other predefined properties. You can use the default settings of tools, or you 
can change the settings for AEC Polygon properties. You can also use AEC 
Polygon tools to convert linework to AEC Polygons and to apply the settings 
of an AEC Polygon tool to existing AEC Polygons.

An AEC Polygon tool is included in the Autodesk® Architectural Desktop 
Stock Tool catalog supplied with the Content Browser. For information about 
using the Content Browser, see “Content Browser” on page 171.

Custom palettes created by your CAD manager or other users may also con-
tain AEC Polygon tools with styles and properties customized for your 
projects or office standards.

Related Procedures

� Creating a New AEC Polygon

� Creating an AEC Polygon with User-specified Settings

� Creating an AEC Polygon Tool

� Creating an AEC Polygon from a Polyline

� Creating an AEC Polygon from a Profile

Creating a New AEC Polygon

Use this procedure to create a new AEC Polygon.

You create an AEC Polygon from straight line segments. The AEC Polygon 
must have a minimum of three sides and must not intersect itself. The style 
that you select controls the width and the justification of the AEC Polygon 
edges. The justification determines whether the edges are displayed inside, 
outside, or centered on the AEC Polygon vertices.

1 Open a tool palette containing an AEC Polygon tool, and select the tool.

To use the AEC Polygon tool supplied in the Autodesk® Architectural Desk-
top Stock Tool catalog, open the Content Browser and navigate to General 
Purpose Tools ➤ Helper Tools in the Stock Tool catalog; then drag the 
AEC Polygon to the drawing area. For more information on using a cata-
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log tool, see “Using a Tool in the Autodesk Architectural Desktop Work-
space” on page 201.

2 Specify the start point of the AEC Polygon.

3 Specify further points to define the AEC Polygon.

NOTE You must specify enough points to create at least three sides for the 
AEC Polygon.

4 Enter c (Close) to close the AEC Polygon.

Creating an AEC Polygon

Creating an AEC Polygon with User-specified 
Settings

Use this procedure to create an AEC Polygon with settings that you specify.

1 Open a tool palette containing an AEC Polygon tool, and select the tool.

To use the AEC Polygon tool supplied in the Autodesk® Architectural Desk-
top Stock Tool catalog, open the Content Browser and navigate to General 
Purpose Tools ➤ Helper Tools in the Stock Tool catalog; then drag the 
AEC Polygon to the drawing area. For more information on using a cata-
log tool, see “Using a Tool in the Autodesk Architectural Desktop Work-
space” on page 201.

2 On the Properties palette, expand Basic, and expand General.

3 Specify the start point of the AEC Polygon.
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4 Specify further points to define the AEC Polygon.

NOTE You must specify enough points to create at least three sides for the 
AEC Polygon.

5 Enter c (Close) to close the AEC Polygon.

Creating an AEC Polygon Tool

Use this procedure to create an AEC Polygon tool and add it to a tool palette. 
You may want to create your own AEC Polygon tools if you are placing mul-
tiple AEC Polygons of specific styles that have the same properties.

You can use any of the following methods to create an AEC Polygon tool:

� Drag an AEC Polygon with the desired properties to a tool palette.
� Drag an AEC Polygon style from the Style Manager to a tool palette, and 

then customize the properties of the new tool.
� Copy an existing AEC Polygon tool, and then customize the properties of 

the new tool.
� Drag an AEC Polygon tool from a tool catalog in the Content Browser to 

a tool palette, and then customize the properties of the tool.

1 Open the tool palette on which you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from an AEC 
Polygon in the drawing

select the AEC Polygon and drag it to the tool 
palette.

create a tool from an AEC 
Polygon style in the Style 
Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy under Multi-
Purpose Objects, and drag it to the tool 
palette. Click OK to close the Style Manager.

copy a tool in the current 
palette

right-click the tool, click Copy, and click Paste.

copy a tool from another 
palette

right-click the tool and click Copy; open the 
other palette, and click Paste.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

6 Expand Basic and expand General.

7 Enter a description of the AEC Polygon that you can create using this AEC 
Polygon tool.

8 Specify a layer key and any layer key overrides, if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select an AEC Polygon style.

10 For Style location, select the drawing file containing the style used for this 
AEC Polygon, or select Browse and use a standard file selection dialog box 
to select the file.

11 Click OK.

Creating an AEC Polygon from a Polyline

Use this procedure to create an AEC Polygon from a closed polyline in a 
drawing.

Converting a polyline to an AEC Polygon

copy a tool from a tool catalog open the tool catalog in the Content Browser, 
and locate the tool you want to copy. Position 
the cursor over the i-drop handle, and drag 
the tool to the tool palette.

If you want to . . . Then . . .
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When you create an AEC Polygon by converting a closed polyline in your 
drawing, the object that you convert can be created from a combination of 
line and arc segments. The polyline must have a minimum of three sides and 
must not intersect itself. After you convert the polyline to an AEC Polygon, 
the width and justification of the AEC Polygon edges are set by the style that 
you select for the AEC Polygon.

1 Draw a polyline in your drawing. 

2 Open a palette containing an AEC Polygon tool, right-click the tool, and 
click Apply Tool Properties to ➤ Closed Polyline.

3 Select the polyline that you created in step 1, and press ENTER.

4 Enter y (Yes) to erase the polyline after creating the AEC Polygon, or  n 
(No) to keep the polyline in the drawing.

5 Press ENTER.

Creating an AEC Polygon from a Profile

Use this procedure to create an AEC Polygon from a profile definition in a 
drawing.

Converting a profile into an AEC Polygon

The profile definition that you convert can be created from a combination of 
line and arc segments. The profile definition must have a minimum of three 
sides and must not intersect itself. After you create an AEC Polygon from the 
profile definition, the width and justification of the AEC Polygon edges are 
set by the style that you select for the AEC Polygon.

1 At the Command prompt, enter aecpolygon.

2 Enter c (Convert) and press ENTER. 

3 Enter pr (Profile) and press ENTER. 

4 Select the desired profile definition and click OK.
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5 Select the insertion point for the new AEC Polygon.

6 Press ENTER. 

Editing AEC Polygons

You can change the location of an AEC Polygon, adjust the width and justi-
fication of its edges, and change how it is displayed in your drawing. You can 
also redefine the geometry of an AEC Polygon or define how AEC Polygons 
interact with each other. You can join two AEC Polygons, create a hole in an 
AEC Polygon by subtracting the area of another one, create an AEC Polygon 
from the intersection of two others, divide or trim an AEC Polygon, and add 
or remove its vertices.

Related Procedures

� Using Grips to Edit AEC Polygons

� Changing the AEC Polygon Style

� Joining Two AEC Polygons

� Creating a Hole in an AEC Polygon

� Creating AEC Polygons from the Intersection of Other AEC Polygons

� Trimming an AEC Polygon

� Dividing an AEC Polygon

� Adding a Vertex to an AEC Polygon

� Removing a Vertex from an AEC Polygon

� Creating a Polyline from an AEC Polygon

� Creating a Profile from an AEC Polygon

� Changing the Rotation of an AEC Polygon

� Changing the Elevation of an AEC Polygon

� Changing the Location of an AEC Polygon

� Attaching Hyperlinks, Notes, or Files to an AEC Polygon

Using Grips to Edit AEC Polygons

Use this procedure to change the shape and size of an AEC Polygon in your 
current drawing by using grips. 

1 Select an existing AEC Polygon.

2 Select a vertex or edge grip.

3 Move the pointing device to change the shape or size of the AEC Polygon.
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Using grips to edit the edge of an AEC Polygon
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Using grips to edit the vertex of an AEC Polygon

Changing the AEC Polygon Style

Use this procedure to change the style of one or more AEC Polygons. The 
style controls the width and justification of the AEC Polygon edges. The jus-
tification determines whether the edges are displayed inside, outside, or cen-
tered on the vertices of the AEC Polygon. The style can also control the dis-
play properties of the AEC Polygon.

1 Double-click the AEC Polygon you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select an AEC Polygon style.

Joining Two AEC Polygons

Use this procedure to join two or more AEC Polygons in a drawing. When 
you join two AEC Polygons that overlap each other, their common boundary 
is combined to form the boundary of the joined AEC Polygon. 

NOTE When you join one AEC Polygon to another, the second AEC Polygon 
no longer exists as a separate object. Properties of the second AEC Polygon are 
deleted and replaced with the corresponding properties of the first one.
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1 Create two overlapping AEC Polygons. For more information, see “Creat-
ing a New AEC Polygon” on page 725.

2 Select one of the AEC Polygons to be joined, right-click, and click 
Operation ➤ Join.

3 Select the AEC Polygon to join with the first AEC Polygon.

NOTE You can join only those AEC Polygons that lie on the same Z-plane. 
Two AEC Polygons with different Z-positions in the same coordinate system 
cannot be joined.

Joining two overlapping AEC Polygons

Creating a Hole in an AEC Polygon

Use this procedure to subtract AEC Polygons from one another in order to 
create a hole in an AEC Polygon. This would be useful, for example, for cre-
ating a complex pattern for a curtain wall infill. 
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Subtracting an AEC Polygon from an AEC Polygon

To perform a subtraction operation, you need to select AEC Polygons that 
intersect one another. You can choose whether to keep the subtracted AEC 
Polygon in the drawing as a separate unit. For example, you may want to 
keep the AEC Polygon if you need to subtract the same shape from other AEC 
Polygons.

1 Create an AEC Polygon from which to subtract a hole. For more informa-
tion, see “Creating a New AEC Polygon” on page 725.

2 Create a second, smaller AEC Polygon to represent the area to be sub-
tracted from the larger AEC Polygon.

You can draw the second AEC Polygon within or overlapping the area of 
the first AEC Polygon, or you can draw it in another location and then 
move it onto the larger AEC Polygon.

3 Select the larger AEC Polygon, right-click, and click 
Operation ➤ Subtract.

4 Select the smaller AEC Polygon to subtract from the larger AEC Polygon.

5 Enter y (Yes) to erase the subtracted AEC Polygon, or n (No) to leave the 
AEC Polygon in the drawing.
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Creating AEC Polygons from the Intersection of 
Other AEC Polygons

Use this procedure to create a new AEC Polygon from the overlapping por-
tion of two intersecting AEC Polygons. You can choose whether to retain the 
original geometry after creating the new intersection AEC Polygon.

Intersecting AEC Polygons with original geometry erased

Intersecting AEC Polygons with original geometry retained

1 Create two overlapping AEC Polygons. For more information, see “Creat-
ing a New AEC Polygon” on page 725.

2 Select the first overlapping AEC Polygon, right-click, and click 
Operation ➤ Intersect.

3 Select the second overlapping AEC Polygon.

4 Enter y (Yes) to erase the original AEC Polygons, or n (No) to leave the AEC 
Polygons in the drawing.
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Trimming an AEC Polygon

Use this procedure to trim a side from an AEC Polygon by defining a trim line 
through an existing AEC Polygon.

Trimming an AEC Polygon

1 Select the AEC Polygon to be trimmed, right-click, and click 
Operation ➤ Trim.

2 Specify a start point for the trim line. This line cuts through the 
AEC Polygon, creating the area to trim and the area to retain.

3 Specify an endpoint for the trim line. 

4 Select the side of the AEC Polygon to be trimmed.

Dividing an AEC Polygon

Use this procedure to divide an AEC Polygon into two separate AEC Polygons 
by defining a division line through it.
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Dividing an AEC Polygon

1 Select the AEC Polygon to be divided, right-click, and click 
Operation ➤ Divide.

2 Specify a start point for the division line.

NOTE You can specify only a start point and endpoint for your division line. 
You cannot specify additional points.

3 Specify an endpoint for the division line.

The AEC Polygon is divided by the line that you defined.

Adding a Vertex to an AEC Polygon

You can add a vertex to an existing AEC Polygon to change its shape. A vertex 
is the location where the edges of the AEC Polygon meet.
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Adding a vertex to an AEC Polygon

1 Select the AEC Polygon for which to add a vertex, right-click, and click 
Vertex ➤ Add.

2 Select the point in your drawing to add the new vertex.

Line segments are drawn from the two existing vertices of the AEC Poly-
gon closest to the point that you selected to form the new vertex.

3 Press ENTER.

Removing a Vertex from an AEC Polygon

You can remove a vertex from an existing AEC Polygon to change its shape.

Removing a vertex from an AEC Polygon

1 Select the AEC Polygon from which to remove a vertex, right-click, and 
click Vertex ➤ Remove.
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2 Select the vertex you want to remove.

3 Press Enter.

Creating a Polyline from an AEC Polygon

Use this procedure to create polylines from an existing AEC Polygon. When 
you create a polyline from an AEC Polygon that contains a hole, each ring of 
the AEC Polygon is converted into an individual polyline.

1 Select the AEC Polygon from which to create a polyline, right click, and 
click Convert To ➤ Polyline. 

2 Specify the base point of the resulting polyline, or press ENTER to use the 
centroid as the base point.

3 Specify the insertion point of the polyline.

Creating a Profile from an AEC Polygon

Use this procedure to create a profile definition from an existing AEC Poly-
gon. You can create a new profile definition or overwrite an existing profile 
definition.

1 Select the AEC Polygon from which to create a profile definition, right 
click, and click Convert To ➤ Profile. 

2 Specify the insertion point of the resulting profile, or press ENTER to use 
the centroid as the insertion point.

3 Enter n (New) to create a new profile definition, or e (Existing) to replace 
an existing profile.

4 Enter a name for the new profile definition, or select the profile definition 
to be replaced by the one you are creating from an AEC Polygon.

Changing the Rotation of an AEC Polygon

Use this procedure to change the rotation of an AEC Polygon.

1 Double-click the AEC Polygon whose rotation you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Enter a value for Rotation. 

Changing the Elevation of an AEC Polygon

Use this procedure to change the elevation of an AEC Polygon.

1 Double-click the AEC Polygon for which to change the elevation.
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2 On the Properties palette, expand Basic, and expand Location.

3 Enter a value for Elevation. 

Changing the Location of an AEC Polygon

Use this procedure to relocate an AEC Polygon by changing the coordinate 
values of its insertion point. You can also move an AEC Polygon by cutting 
and pasting it.

AEC Polygons are oriented with respect to the WCS or the current UCS. For 
example, if the top and bottom of an AEC Polygon are parallel to the XY 
plane, its normal is parallel to the Z axis. You can change the orientation of 
the AEC Polygon by aligning its normal with another axis. You can also 
rotate the AEC Polygon on its plane by changing the rotation angle. For 
information about the world coordinate system (WCS) and the user coordi-
nate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
AutoCAD 2004 User’s Guide.

1 Double-click the AEC Polygon you want to move.

2 On the Properties palette, expand Location.

3 Click Additional information.

4 Specify the location of the AEC Polygon:

5 Click OK.

If you want to . . . Then . . .

relocate the AEC Polygon enter new coordinate values under Insertion Point.

locate the AEC Polygon on 
the XY plane

make the normal of the AEC Polygon parallel to the 
Z axis: under Normal, enter 1 for Z, and enter 0 for 
X and Y. 

locate the AEC Polygon on 
the YZ plane

make the normal of the AEC Polygon parallel to the 
X axis: under Normal, enter 1 for X and enter 0 for 
Y and Z. 

locate the AEC Polygon on 
the XZ plane

make the normal of the AEC Polygon parallel to the 
Y axis: under Normal, enter 1 for Y and enter 0 for X 
and Z.

change the rotation of the 
AEC Polygon

enter a new value for Rotation Angle.
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Attaching Hyperlinks, Notes, or Files to an AEC 
Polygon

Use this procedure to attach hyperlinks, enter notes, or attach reference files 
to an AEC Polygon. You can also edit notes and edit or detach reference files 
from an AEC Polygon.

1 Double-click the AEC Polygon to which to attach information.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click next to Hyperlink, and specify the link. 

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add or edit a note, click  next to Notes, enter text, and click OK.

5 To attach, detach, or edit a reference file, click t to Reference docu-
ments, and then do any of the following:

6 Click OK.

AEC Polygon Styles

An AEC Polygon style is a group of properties that determines the appearance 
and other characteristics of AEC Polygons. AEC Polygon styles control the 
following parameters:

� default dimensions, including edge width and justification

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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� default display properties for the interior and edges of the AEC Polygon

The display properties of an AEC Polygon allow you to hatch its interior 
and edges, or fill its edges and interior with a solid color fill.

Creating Tools from AEC Polygon Styles
You can create an AEC Polygon tool from any AEC Polygon style. You can 
drag the style from the Style Manager onto a tool palette. You can then spec-
ify default settings for any AEC Polygon created with that tool. For more 
information, see “Using AEC Polygon Tools to Create AEC Polygons” on 
page 725.

Managing AEC Polygon Styles
To create, copy, or edit styles, you access the Style Manager. The Style Man-

ager provides a central location in Autodesk® Architectural Desktop where 
you can work with styles from multiple drawings and templates. For more 
information, see “Style Manager” on page 531.

Related Topics and Procedures

� Creating an AEC Polygon Style

� Changing the Width and Justification of the AEC Polygon Edges

� Specifying the Display Properties of an AEC Polygon Style

� Setting the Colors of the True Color Display Representation

� Attaching Notes and Files to an AEC Polygon Style

� Adding Classifications to an AEC Polygon Style

Creating an AEC Polygon Style

Use this procedure to create an AEC Polygon style. You can create a new style 
using default style properties, or by copying an existing style. After you create 
a style, you edit its properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand AEC Polygon Styles.

3 Create an AEC Polygon style:

If you want to . . . Then . . .

create a style with default 
properties

right-click AEC Polygon Styles, and click New.

create a style from an 
existing style

right-click the AEC Polygon style you want to copy, 
and click Copy. Right-click, and click Paste.
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4 To rename the new AEC Polygon style, right-click the style, and click 
Rename. 

5 Enter a name for the new AEC Polygon style, and press ENTER.

6 To edit the style properties of the new AEC Polygon style, right-click the 
style, and click Edit:

7 If you want to create an AEC Polygon tool from the new style, drag the 
style from the Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating an AEC Polygon Tool” on page 727.

8 Click OK.

Changing the Width and Justification of the AEC 
Polygon Edges

Use this procedure to change the width and justification of the edges of an 
AEC Polygon in the AEC Polygon style. The justification determines whether 
the edges are displayed inside, outside, or centered on the vertices of the AEC 
Polygon.

If you want to . . . Then . . .

change the edge width 
and edge alignment

see “Changing the Width and Justification of the 
AEC Polygon Edges” on page 743.

change the Layer/Color/
Linetype properties

see “Specifying the Layer, Color, and Linetype of an 
AEC Polygon Style” on page 746.

change the AEC Polygon 
interior and exterior 
hatching

see “Specifying the Hatching of an AEC Polygon 
Style” on page 747.

change the colors of the 
True Color display 
representation

see “Setting the Colors of the True Color Display 
Representation” on page 748.

add notes and files to the 
style

see “Attaching Notes and Files to an AEC Polygon 
Style” on page 749.

add classifications to an 
AEC Polygon style

see “Adding Classifications to an AEC Polygon 
Style” on page 750.
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Justifying AEC Polygon edges

1 Open a tool palette containing an AEC Polygon tool.

2 Right-click an AEC Polygon tool, and click AEC Polygon Styles.

3 Select the AEC Polygon style, right-click, and click Edit.

4 Click the Dimensions tab.

5 To change the width of the AEC Polygon edges, enter a new value for Edge 
Width.

6 Change the justification of the AEC Polygon edges as desired:

7 Click OK twice.

If you want to . . . Then . . .

display the edges inside 
the AEC Polygon vertices

select In for Justify.

display the edges centered 
within the vertices of the 
AEC Polygon

select Center for Justify.

display the edges outside 
the AEC Polygon vertices

select Out for Justify.
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Specifying the Display Properties of an AEC 
Polygon Style

In most cases, you want the appearance of AEC Polygons that belong to the 
same style to be consistent throughout a drawing. To achieve this, you spec-
ify the display properties of the AEC Polygons in each AEC Polygon style:

� The layer, color, and linetype of AEC Polygon components
� The hatching used for the components of the AEC Polygon

AEC Polygon components

Display components in Model view

Component Description

Interior Edge Inner edge of the AEC Polygon. 

NOTE When the edge dimensions are set to 0, the 
interior edge is the only edge of the AEC Polygon.

Exterior Edge Outer edge of the AEC Polygon.

NOTE When the edge dimensions are set to 0, the 
exterior edge is not displayed in the AEC Polygon.

Interior Hatch Hatch component of the inner part of the AEC 
Polygon. 

NOTE When the edge dimensions are set to 0, the 
interior hatch is the only hatch of the AEC Polygon.

Edge Hatch Hatch component of the outer part of the AEC 
Polygon.

NOTE When the edge dimensions are set to 0, the 
edge hatch is not displayed in the AEC Polygon.
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Related Procedures

� Specifying the Layer, Color, and Linetype of an AEC Polygon Style

� Specifying the Hatching of an AEC Polygon Style

Specifying the Layer, Color, and Linetype of an AEC Polygon 
Style
Use this procedure to change the following display properties of an AEC Poly-
gon style:

� Visibility (component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype Scale

Materials cannot be assigned to AEC Polygons.

Interior Fill The fill component of the inner part of the AEC 
Polygon. This component is displayed only in 
rendered views. Make sure that for each rendered 
view you use either the Interior Fill and Edge Fill 
components of the Model display representation or 
the Interior Fill and Edge Fill components of the True 
Color display representation. If you use both display 
representations simultaneously, the fills are drawn on 
top of each other. For detailed information, see 
“Setting the Colors of the True Color Display 
Representation” on page 748.

Edge fill The fill component of the outer part of the AEC 
Polygon. This component is displayed only in 
rendered views. Make sure that for each rendered 
view you use either the Interior Fill and Edge Fill 
components of the Model display representation or 
the Interior Fill and Edge Fill components of the True 
Color display representation. If you use both display 
representations simultaneously, the fills are drawn on 
top of each other. For detailed information, see 
“Setting the Colors of the True Color Display 
Representation” on page 748.

NOTE When the edge dimensions have been set to 
0, the edge fill is not displayed in a rendered AEC 
Polygon.

Display components in Model view (continued)

Component Description
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1 Open a tool palette containing an AEC Polygon tool.

2 Right-click an AEC Polygon tool, and click AEC Polygon Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the Model display representation, and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying the Hatching of an AEC Polygon Style
Use this procedure to specify the hatching of an AEC Polygon style.

1 Open a tool palette containing an AEC Polygon tool.

2 Right-click an AEC Polygon tool, and click AEC Polygon Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which changes should appear, and 
select Style Override.

6 If necessary, click .

7 Click the Hatching tab.

8 Click the setting for Pattern.

9 Select the hatching pattern:

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.
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TIP Mask blocks do not hide the True Color representation of AEC Polygons, 
but you can use hatching to work around this. Use the Model representation 
of the AEC Polygon, set the hatch to Solid, and select the appropriate True 
Color for the hatch.

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is oriented:

14 Click OK three times.

Setting the Colors of the True Color Display 
Representation

Use this procedure to set the colors of the AEC Polygon with True Color dis-
play representations. Use True Color display representation for high-resolu-
tion renderings.

NOTE Make sure that you do not use the True Color display representation 
and the Model display representation of an AEC Polygon simultaneously in one 
view. The Interior Fill and Edge Fill components of the Model display represen-
tation would be drawn on top of the Interior Fill and Edge Fill components of the 
True Color display representation. It is recommended that you create separate 
views for regular viewing and True Color renderings. 

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the AEC 
Polygon, regardless of the 
object’s rotation

select object.

orient the hatching to the World 
Coordinate System

select global.

If you want to . . . Then . . .
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1 Open a tool palette containing an AEC Polygon tool.

2 Right-click an AEC Polygon tool, and click AEC Polygon Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the True Color display representation, and select Style Override.

6 If necessary, click .

7 Specify the fill properties:

NOTE If the edge dimensions of the AEC Polygon are set to 0, the edge fill 
is not displayed.

8 Click OK three times.

Attaching Notes and Files to an AEC Polygon 
Style

Use this procedure to enter notes and attach reference files to an AEC Poly-
gon style. You can also edit notes and edit or detach reference files from an 
AEC Polygon style.

1 Open a tool palette containing an AEC Polygon tool.

2 Right-click an AEC Polygon tool, and click AEC Polygon Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the AEC Polygon, enter it under Description.

6 Click Notes.

7 To add or edit a note, click the Notes tab, and enter the note.

If you want . . . Then . . .

a True Color fill for the outer 
part of the AEC Polygon

select Edge Fill, and select a color for Edge 
Color, or click Other to choose a different 
color.

a True Color fill for the inner 
part of the AEC Polygon

select Interior Fill, and select a color for Interior 
Color, or click Other to choose a different 
color.
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8 To attach, edit, or detach a reference file, click the Reference Docs tab:

9 Click OK three times.

Adding Classifications to an AEC Polygon Style

Use this procedure to specify classifications for any classification definition 
applied to an AEC Polygon style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette containing an AEC Polygon tool.

2 Right-click an AEC Polygon tool, and click AEC Polygon Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to AEC 
Polygon styles.

5 For each classification definition, select the classification you want 
applied to the current AEC Polygon style.

6 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click open. Click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

change the reference file double-click the reference file to start its application. 
Close the application when you are finished editing. 

detach a reference file select the file name, and click Delete.



Rendering the Exact Colors of an AEC Polygon by Defeating Lighting and Shading

Rendering the Exact Colors of an AEC 
Polygon by Defeating Lighting and Shading 
Effects

The procedures in this topic allow you to display the exact colors of an AEC 
Polygon on screen after you render it, without lighting or shading effects.

Related Procedures

� Changing the 3D Graphics System Display Properties

� Changing the Ambient Light Intensity

� Modifying the Global Rendering Material

Changing the 3D Graphics System Display 
Properties

Use this procedure to change the 3D graphics system display properties of the 
drawing. 

1 On the Format menu, click Options.

2 Click the System tab.

3 Under Current 3D Graphics Display, click Properties.

4 Select Render Options.

5 Select Enable Lights.

6 Click Apply & Close.

7 Click OK.

Changing the Ambient Light Intensity

Use this procedure to change the ambient light intensity and create a new 
distant light.

1 At the Command prompt, enter light.

2 In the Lights dialog box, under Ambient Light, enter 1.0 for Intensity.

3 Select Distant Light from the list of lights (next to the New button).

4 Click New.

5 Enter a name for the new light.

6 Enter 0.0 for Intensity.
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7 Under Color, set Red, Green, and Blue to 0.0.

8 Click OK.

9 Delete any lights other than the new distant light.

To delete a light, select it from the Lights list, and click Delete.

10 Click OK.

Modifying the Global Rendering Material

Use this procedure to modify the global rendering material.

1 At the Command prompt, enter rmat.

2 In the Materials dialog box, under Materials, select *Global*, and click 
Modify.

3 In the Modify Standard Material dialog box, select Color/Pattern, and 
enter 1.0 for Value.

4 Select Ambient, and enter 1.0 for Value.

5 Select Reflection, and enter 1.0 for Value.

6 Click OK twice.

Now the RENDER and SHADEMODE settings match. When you render an 
AEC Polygon (or any other object), the AEC Polygon renders in the original 
object colors, without shading or lighting effects.
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Anchors

An anchor links an AEC object to another 
object or to a layout curve or grid. You can cre-
ate anchors between objects and also remove 
anchors from objects. AEC objects can be 

anchored to each other, to AutoCAD® objects 
like lines and circles, or to layout curves or 
grids. 

Automatic and user-defined anchors in 

Autodesk® Architectural Desktop enable you to 
use anchors for many different purposes.

Automatic and User-Defined Anchors
Automatic anchors are set by the program. Cer-
tain objects are by default anchored to other 
objects. For example, doors and windows are 
usually anchored to walls or space boundaries. 
Curtain wall units or window assemblies might 
be anchored to curtain walls. Although these 
anchors are all inserted automatically, when 
you place the objects their behavior can differ 
slightly. For example, a door that is anchored to 
a wall can be moved to an unconnected wall. 
The door cannot, however, be moved outside a 
wall and stand alone. To do this, you must first 
remove the anchor between door and wall. The 
anchor of a column to a column grid behaves 
differently: you can move the column inside 
the grid, but you cannot move the column to 
another grid without first removing the anchor. 

User-defined anchors are manual links that you 
can create between two objects. Most anchors 
are used with layout curves, layout grids, or vol-
umes. You can also attach anchors to other AEC 
objects or AutoCAD objects. 

In this chapter

� Working with Curve Anchors

� Working with Leader Anchors

� Working with Node Anchors

� Working with Cell Anchors

� Working with Volume Anchors

� Releasing and Positioning 
Anchored Objects

� Creating an Anchor Tool

13
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Anchoring objects to a layout curve can be useful for positioning washbasins 
along a wall or rafters along a roof. Anchoring objects to layout grids can help 
you to position columns on a column grid, planters on a sidewalk grid, or tile 
accents on a floor tile grid. For information about layout curves or grids, see 
“Using Layout Curves” on page 1246 and “Using Layout Grids” on 
page 1253.

Types of User-Defined Anchors
There are five different types of anchors that you can use to attach objects:

Related Procedures

� Working with Curve Anchors

� Working with Leader Anchors

� Working with Node Anchors

� Working with Cell Anchors

� Working with Volume Anchors

Working with Curve Anchors

You can use curve anchors to attach AEC objects to the base curve of other 
AEC objects or AutoCAD objects, such as lines, arcs, circles, mass elements, 
polylines, roofs, or walls. The movement of an object that is anchored to 

If you want to . . . Then . . .

attach objects to the base 
curve of other objects, 
such as lines, arcs, circles, 
mass elements, polylines, 
roofs, or walls

use curve anchors.

attach objects to nodes on 
layout curves or grids with 
leaders

use leader anchors.

attach objects to nodes on 
layout curves or grids

use node anchors.

attach objects to the cell 
positions on 2D layout 
grids and 3D volume grids

use cell anchors.

attach objects to volumes 
on 3D grids

use volume anchors.
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another object with a curve anchor is constrained by the object to which it 
is anchored. Curve anchors are best suited for attaching objects to linear 
objects like lines, arcs, or walls as opposed to grids or layout volumes.

Related Procedures

� Adding Curve Anchors

� Changing the Position of Objects Anchored to Curves

� Anchoring Objects to New Curves

Adding Curve Anchors

Use this procedure to add a curve anchor to attach objects to the base of other 
objects. 

Anchoring an object to a layout curve

1 Open the tool palette that you want to use, and select a curve anchor tool.

If necessary, scroll to display the tool that you want to use.

A curve anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Enter at (Attach object), and select the object to be anchored.

3 Select a point on the curve that you want to anchor the object to. 

The object is anchored to the curve at the X position. When the object is 
first placed, the Y and Z positions are 0.

4 Press ENTER.
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Changing the Position of Objects Anchored to 
Curves

Use this procedure to change the position of objects anchored to curves. You 
can change the position of an anchored object relative to the curve in the X, 
Y, and Z directions. You can also rotate and flip the object along its axes. 

NOTE The positioning of multi-view blocks assumes that the insertion point of 
the multi-view block is at its midpoint.

1 Double-click the anchored object.

2 On the Properties palette, expand Basic, and expand Location on Curve.

3 Click Anchor.

4 Change the position along the X-axis:

5  Change the position along the Y-axis:

If you want to . . . Then . . .

Select the X reference point on the 
curve

select start, midpoint, or end of 
curve. 

Specify the X distance between the 
reference point on the curve and the 
anchored object 

enter a value for distance.

Select from which point on the 
anchored object the X distance to the 
curve is measured

select start edge, center, or end 
edge. 

If you want to . . . Then . . .

Select the Y reference point on the 
curve

select left edge of curve width, 
center, or right edge of curve 
width. 

Specify the Y distance between the 
reference point on the curve and the 
anchored object 

enter a value for distance.

Select from which point on the 
anchored object the Y distance to the 
curve is measured

select front, center, or back. 
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6 Change the position along the Z-axis (vertical):

7 To change the rotation of the anchored object, enter values for the X and 
Z rotation.

8 To flip the object along one of the axes, select Flip X, Flip Y, or Flip Z.

9 Click OK.

Anchoring Objects to New Curves

Use this procedure to anchor objects to new curves. You can anchor an object 
to a new object without first releasing the previous anchor. The new anchor 
is of the same type as the previous one; in this case, a curve anchor. 

1 Open the tool palette that you want to use, and select a curve anchor tool.

If necessary, scroll to display the tool that you want to use.

A curve anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Enter s (Set curve), and select anchored objects.

NOTE You can select only AEC objects here.

3 Press ENTER.

4 Select a new object to anchor the object to.

NOTE You can select AEC objects and AutoCAD objects here. 

If you want to . . . Then . . .

Select the Z reference point on the 
curve

select bottom of curve height, 
center, or top of curve height. 

Specify the Z distance between the 
reference point on the curve and the 
anchored object 

enter a value for distance.

Select from which point on the 
anchored object the Z distance to the 
curve is measured

select bottom of object, center, or 
top of object. 
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5 Press ENTER.

Working with Leader Anchors

Use leader anchors to anchor objects to nodes on layout curves or grids with 
leaders. The movement of the anchored object is constrained by the leader 
on the anchor. 

For information about creating layout curves or grids and nodes, see “Using 
Layout Curves” on page 1246 and “Using Layout Grids” on page 1253.

Related Procedures

� Adding Leader Anchors

� Changing the Position of Objects Anchored to Layout Nodes with Leader 
Anchors

� Grip Editing Leaders

� Extending Leaders

� Copying Objects to All Layout Nodes

Adding Leader Anchors

Use this procedure to add leader anchors to your drawing. An object can be 
anchored to only one node at a time. When you try to anchor it to a second 
node, the object is first released from the first node. You can, however, 
anchor any number of objects to a single layout node.

1 Open the tool palette that you want to use, and select a leader anchor tool.

If necessary, scroll to display the tool that you want to use.

A leader anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Enter a (Attach object), select the object to be anchored, then specify a 
point on or near a node on a layout curve, layout grid, or volume grid.

The object is anchored to the node that you selected. By default, the leader 
anchor is created at a direction of 0 from the node and has first and second 
extensions of 1 inch (2.54 cm) each. These extensions are measured from 
the node to the center of the anchored object.

3 Press ENTER.
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Changing the Position of Objects Anchored to 
Layout Nodes with Leader Anchors

Use this procedure to change the position of objects anchored to layout 
nodes with leader anchors. You can change the coordinate system, orienta-
tion, and rotation of an object anchored to a layout node. You can also define 
offsets from the node.

1 Double-click the layout node.

2 On the Properties palette, expand Basic, and expand Location from Node.

3 Click Anchor.

4 Specify changes in the position or orientation of anchored objects:

5 Click OK.

Grip Editing Leaders

Use this procedure to grip edit leaders. A leader anchor connects an object to 
a layout node with a leader between the two. You can change the length and 
shape of the leader. 

If you want to . . . Then . . .

specify an offset from the 
object to the node

specify insertion offset values for the X, Y, or Z 
position.

anchor the object to the 
center of the node

select Center on Node.

have the anchored object 
use the coordinate system 
of the node

select Use Node Coordinate System.

not have the anchored 
object use the coordinate 
system of the node

specify X, Y, or Z normals for the anchored object.

change the rotation angle 
of the anchored object

specify values for the X, Y, or Z rotation angles.

flip the object along the 
X, Y, or Z axes

select Flip X, Flip Y, or Flip Z.

change the angle of the 
leader to the node

specify a value for Angle to Node.
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A leader consists of one segment or several segments. You can change the 
leader shape by grip editing the object or by changing the values on the 
Anchors tab of the anchored object. 

You can use grips to add segments to existing leaders.

1 Select the anchored object.

2 Move the leader grip to move the leader in the appropriate direction. 

3 After you have released the leader, select the anchored object again. 

An additional leader grip is added at the point from which the leader orig-
inally started.

4 Move the leader grip at the start of the leader line to add another segment 
to the leader.

5 Repeat this procedure until the leader has all the segments you need. 

You can later edit the leader in the same way you edit an AutoCAD 
polyline.

Extending Leaders

Use this procedure to extend the leader line beyond the first and last grip 
points on the leader line. 

1 Double-click the anchored object.

2 On the Properties palette, expand Basic, and expand Location from Node.

3 Click Anchor.

4 Edit the leader line:

5 Click OK.

If you want to extend . . . Then . . .

the start point of the leader line in the First Extension field, enter the 
extension value.

the end point of the leader line in the Second Extension field, enter the 
extension value.



Working with Node Anchors | 761

Copying Objects to All Layout Nodes

Use this procedure to copy objects to all layout nodes. You can select an AEC 
object and, instead of manually anchoring it to a layout node, you can copy 
the object and anchor one copy to each node on a layout curve or grid.

TIP If you want the leader to be displayed in the same way at every node, first 
anchor the object to a single node. Adjust the leader attributes (direction, exten-
sion, or properties), and then use the Copy to Nodes option. Next, select the 
object that is anchored to the single node, and select the layout curve or grid.

1 Open the tool palette that you want to use, and select a leader anchor tool.

If necessary, scroll to display the tool that you want to use.

A leader anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 To copy the object to every node on the layout curve or grid, enter c (Copy 
to Nodes).

3 Select the object that you want to copy and anchor to every node on the 
layout curve or grid.

4 Select the layout curve or grid.

If there is an existing object anchored to any of the nodes, you are 
prompted to specify whether you want to skip nodes that already have 
something anchored to them. Enter y to avoid duplicate anchored objects 
on those nodes.

Working with Node Anchors

Use node anchors to attach objects to nodes on layout curves or grids. 
Anchoring objects to a layout curve might be useful for positioning washba-
sins along a wall or rafters along a roof. Anchoring objects to layout grids 
might help you to position columns on a column grid, planters on a sidewalk 
grid, or tile accents on a floor tile grid. 

WARNING! When you change the position of an object that is anchored to 
a curve, the anchored objects need to stay on the curve. Keeping the association 
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between the object and the node prevents the objects that are being moved 
from all attaching to the same node.

Related Procedures

� Adding Node Anchors

� Changing the Position of Objects Anchored to Layout Nodes with Node 
Anchors

� Anchoring Objects to Different Nodes

� Copying Objects to All Layout Nodes

Adding Node Anchors

Use this procedure to add node anchors. You can add as many node anchors 
in your drawing as you have layout nodes. An individual object can be 
anchored only to one layout node. If you try to anchor an object to a second 
node, the first anchor is released. You can, however, anchor several objects to 
the same layout node and edit them individually.

Anchoring an object to a layout curve node

1 Open the tool palette that you want to use, and select a node anchor tool.

If necessary, scroll to display the tool that you want to use.

A node anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Enter a (Attach object), and select the object to be anchored.

3 Specify a point on or near a node on a layout curve or grid.

The object is anchored to the node that you selected.



Working with Node Anchors | 763

Changing the Position of Objects Anchored to 
Layout Nodes with Node Anchors

Use this procedure to change the position of objects anchored to layout 
nodes with node anchors. You can change the coordinate system and orien-
tation of an object anchored to a layout node. You can also define offsets 
from the node. 

1 Double-click the layout node.

2 On the Properties palette, expand Basic, and expand Location from Node.

3 Click Anchor.

4 Change the position or orientation of anchored objects: 

5 Click OK.

Anchoring Objects to Different Nodes

Use this procedure to anchor objects to different nodes. You can attach an 
anchored object to another node on the same layout curve or grid, or to 
another layout curve or grid altogether. 

If you want to . . . Then . . .

specify an offset from the 
object to the node

specify offset values for the X, Y, or Z position.

anchor the object to the 
center of the node

select Center on Node.

have the anchored object 
use the coordinate system 
of the node

select Use Node Coordinate System.

not have the anchored 
object use the coordinate 
system of the node

specify X, Y, or Z normals for the anchored object.

flip the object along the 
X, Y, or Z axes

select Flip X, Flip Y, or Flip Z.
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Moving an anchored object to another layout curve node

NOTE If you want to move an anchored object to a different node on the 
same layout curve or grid, you can also drag the object to the node.

1 Open the tool palette that you want to use, and select a node anchor tool.

If necessary, scroll to display the tool that you want to use.

A node anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Enter s (Set node), and select the anchored object.

3 Press ENTER.

4 Select the node you want to anchor the object to.

Copying Objects to All Layout Nodes

Use this procedure to copy objects to all layout nodes. You can select an AEC 
object and, instead of manually anchoring it to a layout node, you can copy 
the object and anchor one copy to each node on the layout curve or grid.

Copying an object to all layout curve nodes

1 Open the tool palette that you want to use, and select a node anchor tool.

If necessary, scroll to display the tool that you want to use.

A node anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
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this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 To copy the object to every node on the layout curve or grid, enter c (Copy 
to each node).

3 Select the object that you want to copy and anchor to every node on the 
layout curve or grid.

4 Select the layout curve or grid.

If an object is already anchored to any of the nodes, you are prompted to 
specify whether you want to skip nodes that already have something 
anchored to them. Enter y (Yes) to avoid duplicate anchored objects on 
those nodes.

Working with Cell Anchors

A cell is a subdivision of a layout grid or volume grid. A cell anchor attaches 
objects to cell positions on layout grids and volume grids. When an object is 
anchored to a cell, the object is resized to fit the cell size. When the grid or 
volume itself is resized, you can decide whether the anchored object is 
updated accordingly or remains its original size. 

Related Procedures

� Adding Cell Anchors

� Changing the Position and Size of Objects Anchored to Layout Cells

� Anchoring Objects to a Different Cell

� Copying Objects to All Layout Cells

Adding Cell Anchors

Use this procedure to add cell anchors. You can add cell anchors to objects to 
connect them to cells in layout grids and volume grids. 
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Anchoring an object to a layout grid cell

NOTE There is no rule that determines which cell the object attaches to when 
you anchor it. You can turn on the Node display component to display the cell 
nodes of the layout grid or volume for easier cell selection. You can also move 
the object after you anchor it to the layout grid or volume.

1 Open the tool palette that you want to use, and select a cell anchor tool.

If necessary, scroll to display the tool that you want to use.

A cell anchor tool is located within the General Purpose Tools under Para-
metric Layout and Anchoring in the Stock Tool catalog. You can add this 
tool to any tool palette. For more information, see “Content Browser” on 
page 171.

2 Enter a (Attach object), and select the object to be anchored.

3 Specify a point on or near a cell of a layout grid or volume grid. 

The object is automatically scaled to fill the entire cell.

4 Press ENTER.

Changing the Position and Size of Objects 
Anchored to Layout Cells

Use this procedure to change the position and size of objects anchored to lay-
out cells. You can change the coordinate system and orientation of an object 
anchored to a layout cell. You can also define insertion and size offsets and 
indicate whether the object should be resized when the cell is resized. 

1 Double-click the anchored object.

2 On the Properties palette, expand Basic, and expand Location from Cell.

3 Click Anchor.
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4 Change the position or orientation of anchored objects: 

5 Specify how an anchored object is resized to fit the edges of the cell:

6 Click OK.

Anchoring Objects to a Different Cell 

You can attach an anchored object to another cell in the same layout grid or 
volume grid, or to another layout curve or grid altogether.

If you want to . . . Then . . .

specify an offset from the 
object to the cell

specify offset values for the X, Y, or Z position.

anchor the object to the 
center of the cell

select Center on Cell.

have the anchored object 
use the coordinate system 
of the cell

select Use Cell Coordinate System.

not have the anchored 
object use the coordinate 
system of the cell

specify X, Y, or Z normals for the anchored object.

flip the object along the 
X, Y, or Z axes

select Flip X, Flip Y, or Flip Z.

If you want to . . . Then . . .

have the object be resized 
every time the cell is 
resized

select Apply Resize.

not have the object be 
resized every time the cell 
is resized

clear Apply Resize.

specify a distance 
between the anchored 
object and the cell

enter an appropriate negative value for Size Offset.

extend the anchored 
object beyond the cell 
edges

enter an appropriate positive value for Size Offset.
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1 Open the tool palette that you want to use, and select a cell anchor tool.

If necessary, scroll to display the tool that you want to use.

A cell anchor tool is located within the General Purpose Tools under Para-
metric Layout and Anchoring in the Stock Tool catalog. You can add this 
tool to any tool palette. For more information, see “Content Browser” on 
page 171.

2 Enter se (Set cell), and select the object.

3 Press ENTER. 

4 Select the cell you want to anchor the object to. 

The object is moved to the new cell. If the new cell is different in size from 
the original one, the object is resized accordingly.

NOTE You can also drag the object if you want to move an anchored object 
to a different cell on the same layout grid or volume grid.

Copying Objects to All Layout Cells

Use this procedure to copy objects to all layout cells. You can select an AEC 
object and, instead of manually anchoring it to a layout cell, you can copy 
the object and anchor one copy to each cell on the layout grid or volume 
grid.

1 Open the tool palette that you want to use, and select a cell anchor tool.

If necessary, scroll to display the tool that you want to use.

A cell anchor tool is located within the General Purpose Tools under Para-
metric Layout and Anchoring in the Stock Tool catalog. You can add this 
tool to any tool palette. For more information, see “Content Browser” on 
page 171.

2 To copy the anchored object to every cell in the layout grid or volume 
grid, enter c (Copy to each cell).

3 Select the object.

4 Select the layout grid or volume grid that you want to copy and anchor 
the object to.

If there is already an object anchored to any of the cells, you are prompted 
to specify whether you want to skip cells that already have something 
anchored to them. Enter y (Yes) to avoid duplicate anchored objects 
appear in those cells.
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Working with Volume Anchors

Use volume anchors to attach objects to volumes in 3D volume grids. The 
movement of an object that is anchored to a volume grid is constrained by 
that volume grid.

When an object is anchored to a volume inside a volume grid, the object is 
resized to fit the volume size. When the volume itself is resized, you can 
decide whether the anchored object is updated accordingly or remains its 
original size. 

Related Procedures

� Adding Volume Anchors

� Changing the Position and Size of Objects Anchored to Volumes

� Anchoring Objects to a Different Volume

� Copying Objects to All Layout Volumes

Adding Volume Anchors

Use this procedure to add volume anchors. You can add volume anchors to 
objects to connect them to volume grids. 

Anchoring an object to a volume grid

1 Open the tool palette that you want to use, and select a volume anchor 
tool.

If necessary, scroll to display the tool that you want to use.

A volume anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.
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2 Enter a (Attach object), and select the object to be anchored.

3 Specify a point on or near a volume in a volume grid. 

The object is scaled to fill the entire volume.

4 Press ENTER.

Changing the Position and Size of Objects 
Anchored to Volumes

Use this procedure to change the position and size of objects anchored to vol-
umes. You can change the coordinate system and orientation of an object 
anchored to a volume. You can also define insertion and size offsets and indi-
cate whether the object should be resized when the volume is resized. 

1 Double-click the anchored object.

2 On the Properties palette, expand Basic, and expand Location in Volume.

3 Click Anchor.

4 Change the position or orientation of anchored objects:

5 Specify how an anchored object is resized to fit the edges of the volume:

If you want to . . . Then . . .

specify an offset from the object to the 
volume

specify offset values for the 
X, Y, or Z position.

anchor the object to the center of the 
volume

select Center on Node.

have the anchored object use the 
coordinate system of the volume grid

select Use Node Coordinate 
System.

not have the anchored object use the 
coordinate system of the volume grid

specify X, Y, or Z normals 
for the anchored object.

flip the object along the X, Y, or Z axes select Flip X, Flip Y, or Flip Z.

If you want to . . . Then . . .

have the object be resized every time the 
volume is resized

select Apply Resize.

not have the object be resized every time 
the volume is resized

clear Apply Resize.
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6 Click OK.

Anchoring Objects to a Different Volume

Use this procedure to anchor objects to a different volume. You can attach an 
anchored object to another volume in the same volume grid, or to another 
volume grid. 

NOTE If you want to move an anchored object to a different volume on the 
same volume grid, you can also drag it there.

1 Open the tool palette that you want to use, and select a volume anchor 
tool.

If necessary, scroll to display the tool that you want to use.

A volume anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Enter s (Set volume), and select the anchored object.

3 Press ENTER. 

4 Select the volume you want to anchor the object to. 

The object is moved to the new volume. If the new volume is different in 
size from the original one, the object is resized accordingly.

Copying Objects to All Layout Volumes

Use this procedure to copy objects to all layout volumes. You can select an 
AEC object and, instead of manually anchoring it to a volume, you can copy 
the object and anchor one copy to each volume on the volume grid.

1 Open the tool palette that you want to use, and select a volume anchor 
tool.

specify a distance between the anchored 
object and the volume

enter an appropriate negative 
value for Size Offset.

extend the anchored object beyond the 
volume edges

enter an appropriate positive 
value for Size Offset.

If you want to . . . Then . . .
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If necessary, scroll to display the tool that you want to use.

A volume anchor tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 To copy the anchored object to every volume in the volume grid, enter c 
(Copy to each volume).

3 Select the object that you want to copy and anchor to every volume in the 
volume grid.

4 Select the volume grid.

If there is already an object anchored to any of the volumes, you are 
prompted to specify whether you want to skip volumes that already have 
something anchored to them. Enter y (Yes) to avoid duplicate anchored 
objects on those volumes.

Releasing and Positioning Anchored Objects

You can release and position anchored objects. Release an anchored object 
from another object to remove the relationship between the objects. Position 
an anchored object to offset it from the object it is anchored to.

Related Procedures

� Releasing Anchored Objects

� Positioning Anchored Objects

Releasing Anchored Objects

Use this procedure to release objects from anchors to remove the anchoring 
relationship. Any anchored object can be released, including a railing that is 
anchored to a stair object or a window that is anchored to a wall. 

� Right-click the anchored object, and click Anchor ➤ Release.

Positioning Anchored Objects

Use this procedure to position anchored objects. You can position an object 
with anchors to offset it from the object that it is anchored to.
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1 Right-click the anchored object, and change the position of the anchored 
object:

2 Enter an XYZ coordinate value for the desired offset position. 

Entering a coordinate for the offset distance is equivalent to setting all 
three of the individual position offsets.

Creating an Anchor Tool

Use this procedure to create an anchor tool and add it to a tool palette. You 
may want to create your own anchor tools if you are placing multiple 
anchors of specific styles with additional properties that you want to be the 
same each time you add an anchor of each type.

For example, you are creating an office floor plan with partition walls for 
cubicles. Although all partition walls use the same wall style in your floor 
plan, the walls in administrative areas are lower than the walls in office areas. 
To work efficiently, you can quickly create a wall tool for each wall height. 
You can then select the appropriate tool to place the walls with the correct 
height in each area of the floor plan.

You can use any of the following methods to create an anchor tool:

� Drag a copy of a tool from another palette to the current palette and then 
customize the properties of the new tool.

If you want to . . . Then . . .

specify the X position click Set X Position.

specify the Y position click Set Y Position.

specify the Z position click Set Z Position.

specify the end position click Set Anchored End.

specify the rotation click Set Rotation.

flip the X position click Flip X.

flip the Y position click Flip Y.

flip the Z position click Flip Z.
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� Copy an existing tool in the current palette and then customize the prop-
erties of the new tool.

� Drag a tool from the Content Browser to a tool palette and then customize 
the properties of the new tool.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Click OK.

If you want to . . . Then . . .

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.
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Curtain Walls

Curtain walls provide a grid or framework for inserting 

objects such as windows and doors. Curtain walls have 

many similarities to standard walls, such as baseline, 

roof line, and floor line, and they allow for interfer-

ences. You can insert doors, windows, and door/window 

assemblies into a curtain wall, just like standard walls, 

but the insertion process is different. 

Curtain walls are also different from standard walls in 

that they are made up of one or more grids.

In this chapter

� Creating Curtain Walls Using 
Curtain Wall Tools

� Curtain Wall Styles

� Using Overrides in Curtain 
Walls

� Modifying Element Definitions 
for Curtain Wall Styles

� Editing Curtain Walls

� Changing the Roof Line and the 
Floor Line of a Curtain Wall

� Editing Objects Anchored in 
Curtain Walls

� Curtain Wall Units

� Creating Curtain Wall Units

� Curtain Wall Unit Styles

� Using Overrides in Curtain 
Wall Units

� Editing Curtain Wall Units

14



776 | Chapter 14 Curtain Walls

Curtain Wall Grids
Curtain walls are made up of one or more grids. Each grid in a curtain wall 
has either a horizontal division or a vertical division, but you can nest the 
grids to create a variety of patterns from simple to complex.

Curtain wall nested grid example

Each cell in a grid can contain either a panel infill, to represent basic cladding 
materials such as a stone wall panel or glazing, or an object such as a window 
or a door.

Curtain Wall Units and Door/Window Assemblies
Other objects you can insert in a grid include curtain wall units and door/
window assemblies. Curtain wall units are very similar to curtain walls except 
that the grid cells can contain only panel infills, not objects. Curtain wall 
units are designed to represent complex elements that are repeated within 
your main curtain wall.
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Specifying curtain wall unit infill

Window assemblies serve a similar function as curtain wall units but can con-
tain panel infills or objects such as doors or windows. Door/window assem-
blies can be inserted into curtain walls and standard walls.

Specifying door/window assembly infill

Both curtain wall units and door/window assemblies can reduce the need for 
nested grids, making edits to the curtain wall easier.

Elements of Grids
Grids are the foundation of curtain walls, curtain wall units, and door/win-
dow assemblies. Every grid has four element types:

� Divisions: Define the direction of the grid (horizontal or vertical) and the 
number of cells

� Cell Infills: Contain another grid, a panel infill, or an object such as a win-
dow or a door

� Frames: Define the edge around the outside of the primary grid and 
nested grids

� Mullions: Define the edges between the cells
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NOTE Division is an abstract element, in contrast to the other three element 
types that represent physical elements of the curtain wall.

Each element type is assigned a default definition that describes what 
elements of that type look like.

Specifying grid element types

You can create new element definitions and assign those definitions within 
the curtain wall. For example, you can create multiple infill definitions, and 
then assign different infills to specific cells in the grid.

Element type Default definitions

Divisions Primary horizontal grid with a fixed cell dimension of 13' 
and secondary vertical grid with a fixed cell dimension of 3'

Cell Infills Cells containing simple panels 2" thick

Frames Left, right, top, and bottom outer edges of grid 3" wide 
and 3" deep

Mullions Edges between cells 1" wide and 3" deep
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Assigning different infills to curtain wall cells

Likewise, you can create multiple frame definitions and then assign a differ-
ent definition to each frame edge (top, bottom, left, or right). You can also 
create multiple mullion definitions.

Specifying different frame definitions for each edge of a frame

Experimenting with Curtain Wall Designs
The templates provided with Autodesk® Architectural Desktop offer curtain 
wall styles as well as curtain wall unit styles and door/window assembly 
styles. To familiarize yourself with the curtain wall feature, you can look at 
those existing styles and experiment with them. That will make it easier to 
understand curtain wall behavior and create your own curtain wall designs. 

Related Procedures

� Creating Curtain Walls Using Curtain Wall Tools

� Curtain Wall Styles

� Using Overrides in Curtain Walls

� Modifying Element Definitions for Curtain Wall Styles

� Editing Curtain Walls

� Editing Objects Anchored in Curtain Walls
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� Curtain Wall Units

Creating Curtain Walls Using Curtain Wall 
Tools

Curtain walls are created in much the same way as standard walls. You can 
specify a style, a height, and start and endpoints. Curtain walls can be 
straight, curved, or a combination of the two. You can also create curtain 
walls that are based on a curve, convert a 2D layout grid to a curtain wall, or 
create a custom grid from two dimensional (2D) lines, arcs, and circles. You 
can also convert standard walls to curtain walls.

Tool palettes provided with Autodesk Architectural Desktop let you quickly 
place curtain walls by selecting a curtain wall tool with a specific curtain wall 
style and other predefined properties. You can also use curtain wall tools to 
convert linework to curtain walls and to apply the settings of a curtain wall 
tool to existing curtain walls.

Tool palettes containing curtain wall tools
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The following palettes contain one or more curtain wall tools:

When you place curtain walls using curtain wall tools, you can use the 
default settings of the tool, or you can change settings for any curtain wall 
properties that are not controlled by the style.

Related Procedures

� Creating a Straight Curtain Wall

� Creating a Curtain Wall with User-Specified Settings

� Creating a Curved Curtain Wall

� Creating a Curtain Wall that References a Curve

� Converting a Layout Grid to a Curtain Wall

� Creating a Curtain Wall from an Elevation Sketch

� Converting a Wall to a Curtain Wall

� Creating a Curtain Wall Tool

Creating a Straight Curtain Wall

Use this procedure to create a straight curtain wall that has the properties 
specified in the curtain wall tool that you select. To specify settings when you 
add a curtain wall, see “Creating a Curtain Wall with User-Specified Settings” 
on page 782.

Tool Palette Curtain Wall Tools

General Building Object palette 
in the Design Tools palette set

a tool for the Standard curtain wall style and 
default settings for other curtain wall 
properties

custom tool palettes created by 
your CAD manager

tools with curtain wall styles and properties 
that your CAD manager customized for your 
projects or office standards
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Drawing a straight curtain wall segment 

1 Open the tool palette that you want to use, and select a curtain wall tool.

If necessary, scroll to display the tool that you want to use.

2 Specify a start point for the curtain wall.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify an end point.

4 Press ENTER.

Creating a Curtain Wall with User-Specified 
Settings

Use this procedure to add a curtain wall with settings that you specify.

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a curtain wall tool.

If necessary, scroll to display the tool that you want to use.
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2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Expand Dimensions.

5 Modify the dimensions of the curtain wall:

6 In the drawing area, specify the insertion point of the curtain wall.

You can move or hide the Properties palette to expose more of the drawing 
area.

7 Specify the endpoint of the curtain wall:

Creating a Curved Curtain Wall

Use this procedure to create a curved curtain wall in a drawing.

If you want to 
specify . . .

Then . . .

the base height of the 
curtain wall

enter a value for Base Height.

the length of the 
curtain wall

enter a value for Length.

start and end miters enter miter values for Start Miter and End Miter.

If you want to . . . Then . . .

close the curtain wall by 
drawing two curtain wall 
segments that meet at a 
right angle

right-click, click Ortho, and then specify a point in 
the direction you want the curtain wall to close. The 
curtain wall segment is extended until it meets a wall 
segment perpendicular to the first wall segment.

close the curtain wall by 
adding a curtain wall 
segment from the 
previous point to the 
start point of the curtain 
wall

right-click, and click Close.

complete the curtain wall 
segment at a point that 
you specify

specify the endpoint of the curtain wall, and press 
ENTER.
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The display of curved objects is dependent on the facet deviation set in the 
application. For information see “Facet Deviation” on page 999.

Drawing a curved curtain wall segment

1 Open the tool palette that you want to use, and select a curtain wall tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Select Arc for Segment type.

5 Expand Dimensions.

6 Specify curtain wall settings:

If you want to 
specify . . .

Then . . .

the base height of the 
curtain wall,

enter a value for Base Height.

the length of the 
curtain wall

enter a value for Length.
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7 Specify a start point for the curved curtain wall segment.

You can move or hide the Properties palette to expose more of the drawing 
area.

8 Specify the midpoint of the curved curtain wall segment.

9 Specify the endpoint of the curved curtain wall segment.

A marker on top of the curtain wall indicates the direction the curtain wall 
is being drawn.

10 Continue placing curtain walls to create, for example, a building exterior 
or a room.

11 Press ENTER.

Creating a Curtain Wall that References a Curve

Use this procedure to create a curtain wall from linework such as lines, 
polylines, arcs, and circles.

If you want to create a curtain wall with a mixture of straight and curved seg-
ments, you can use the Add Curtain Wall command. However, for compli-
cated designs, you might find it easier to draw the segments using lines, arcs, 
and circles, and then reference that curve as the baseline for the curtain wall. 
This method has an added advantage in that the curve remains in control of 
the length and baseline of the curtain wall. Any changes you make to the 
curve are reflected in changes to the curtain wall.

start and end miters enter miter values for Start Miter and End Miter.

If you want to 
specify . . .

Then . . .
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Creating a curtain wall that references a curve

Use any of the following objects to create the reference curve:

� Line
� Arc
� Circle
� Polyline
� Spline
� AEC objects (excluding stairs and multi-view blocks)

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a curtain wall tool, and click Apply Tool Properties 
to ➤ Referenced Base Curve.

3 Select the geometry to reference.

If the geometry you want to reference consists of multiple segments, you 
must repeat this procedure for each segment.

4 Edit the properties of the curtain walls in the Properties palette, if needed.

Converting a Layout Grid to a Curtain Wall

Use this procedure to create a curtain wall that is based on a 2D layout grid. 
If you already have 2D layout grids in a drawing, you can easily convert them 
to curtain walls. Or if you are already familiar with layout grids, it is an effi-
cient way to create a curtain wall, and then experiment with the curtain wall 
commands to learn more about them.
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Converting a 2D layout grid to a curtain wall

When you create a curtain wall from a 2D layout grid, you also create a new 
curtain wall style. The divisions in the new curtain wall style are taken from 
the divisions in the layout grid.

Curtain wall grids are one dimensional—divided either horizontally or verti-
cally. To create the horizontal and vertical patterns in the 2D layout grid, the 
curtain wall uses a primary grid with a secondary grid nested inside it. For 
more information about nested grids, see “Working with Nested Grids in 
Curtain Walls” on page 834.

When you create a curtain wall grid from a 2D layout grid, you need to decide 
the direction of the primary grid in the curtain wall. If you select horizontal, 
the primary grid has horizontal divisions that cross over the vertical divisions 
of the secondary grid. If you select vertical, the primary grid has vertical divi-
sions that cross over the horizontal divisions of the secondary grid. 

Specifying primary division directions

The horizontal and vertical lines of the 2D layout grid define the divisions 
for the curtain wall grids. The grid cells, frame, and mullions are assigned 
default definitions. For more information, see “Assigning Definitions to Cur-
tain Wall Elements” on page 832. 
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1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a curtain wall tool, and click Apply Tool Properties 
to ➤ Layout Grid.

3 Select the layout grid to convert.

4 When prompted to erase the original geometry, press ENTER to keep the 
layout grid, or enter y (Yes) to erase it.

5 Press ENTER to specify horizontal as the orientation for the primary divi-
sion, or enter v to specify vertical.

6 Enter a name for the curtain wall, and click OK.

7 Edit the properties of the curtain wall in the Properties palette, if needed.

Creating a Curtain Wall from an Elevation 
Sketch

You can create a sketch of a custom grid with lines, arcs, and circles, and then 
convert that linework into a curtain wall.

NOTE Curtain wall grids are either horizontal or vertical. To create a grid pat-
tern with horizontal and vertical cells, nested grids are used. For more informa-
tion about nested grids, see “Working with Nested Grids in Curtain Walls” on 
page 834.

The resulting curtain wall is assigned a custom grid division definition, 
which you cannot modify. You can, however, assign a different division def-
inition to it. For more information, see “Assigning a Division to a Curtain 
Wall Grid” on page 833.

1 Use lines, arcs, and circles to create an elevation sketch in the current 
world coordinate system (WCS).

2 Right-click a curtain wall tool, and click Apply Properties 
to ➤ Elevation Sketch.

3 Select the linework of the sketch.

4 Press ENTER.

5 Select one of the grid lines as the baseline for the curtain wall or press 
ENTER to use the line along the X axis as the default baseline.
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Converting linework to curtain walls using the default baseline option

TIP If you draw your linework in the XY plane (in Plan view) and accept the 
default baseline, the resulting curtain wall is displayed as it is projected in the 
Z direction. 

Converting linework to curtain walls using the specified baseline option

6 To erase the lines, enter y (Yes). To have the lines remain after the curtain 
wall is created, enter n (No).

If there is a style applied to the curtain wall tool, the new custom style is 
based on the existing style. The infill, mullion, and frame definitions are 
those of the existing style. You can modify the style without having to cre-
ate one from scratch. For more information, see “Assigning Definitions to 
Curtain Wall Elements” on page 832. 

7 Select the resulting custom curtain wall, right-click, and click Design 
Rules ➤ Save to Style. 
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8 Click New to create a new curtain wall style. 

9 Enter a name for the new curtain wall style. 

10 Click OK twice. 

Converting a Wall to a Curtain Wall

Use this procedure to create curtain walls based on existing standard walls. 
For each wall segment, a separate curtain wall is created. During the conver-
sion process, you are prompted to select a curtain wall style that determines 
the number and size of cells in the curtain wall grid as well as the appearance 
of the cells, frame, and mullions. For more information, see “Curtain Wall 
Styles” on page 793.

Converting a wall to a curtain wall

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a curtain wall tool, and click Apply Tool Properties 
to ➤ Walls.

3 Select the wall, and press ENTER.

4 Specify the alignment.

You can align the curtain wall baseline with the baseline, left, right, or 
center of the standard wall.
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Specifying justification for converting walls to curtain walls

5 To erase the wall, enter y (Yes). To have the wall remain after the curtain 
wall is created, enter n (No). 

6 Press ENTER.

Creating a Curtain Wall Tool

Use this procedure to create a curtain wall tool and add it to a tool palette. 
You may want to create your own curtain wall tools if you are placing multi-
ple curtain walls of specific styles with additional properties that you want to 
be the same each time you add a curtain wall of each type.

You can use any of the following methods to create a curtain wall tool:

� Drag a curtain wall that has the properties you want to a tool palette.
� Drag a curtain wall style from the Style Manager to a tool palette, and then 

customize the properties of the new tool.
� Drag a copy of a tool from another palette to the current palette, and then 

customize the properties of the new tool.
� Copy an existing tool in the current palette and then customize the prop-

erties of the new tool.
� Drag a tool from the Content Browser to a tool palette and then customize 

the properties of the new tool.

1 Open the tool palette where you want to create a tool.
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2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the curtain wall 
created from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a style.

When you add a curtain wall using this tool, it is the style you specify on 
the Tool Properties worksheet.

10 Specify a style location.

Click Browse to navigate to an external file source for the style.

If you want to . . . Then . . .

create a tool from a curtain wall 
in the drawing

select the object, and drag it to the tool 
palette.

create a tool from a curtain wall 
style in the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.
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11 Modify the dimensions of the curtain wall:

12 Click OK.

Curtain Wall Styles

Curtain walls are style-based, which means there are preset characteristics 
assigned to each curtain wall that determine its appearance and function. By 
changing from one style of curtain wall to another, you can quickly study 
several different design options. Any changes you make to the style updates 
all curtain walls of that particular style. You can also apply overrides to a sin-
gle curtain wall, without changing other curtain walls of the same style.

A curtain wall style controls the following properties of a curtain wall:

� Element definitions
� Definition assignments for each element
� Materials for each element
� Display properties for each element
� Notes about the style and any associated reference files

Using Materials in Curtain Wall Styles
You can use materials to control how curtain walls of each style are displayed 
in a drawing. You assign materials to the curtain wall components in the 
style. The components are then displayed using the display properties of the 
assigned materials.

If you want to 
specify . . .

Then . . .

the base height of the 
curtain wall

enter a value for Base Height.

start and end miter 
angles

enter miter values for Start Miter and End Miter.

the roof line offset from 
the base height of the 
curtain wall

enter a value for Roof line offset.

the floor line offset 
from the baseline of the 
curtain wall

enter a value for Floor line offset.
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Autodesk Architectural Desktop provides a large number of predefined mate-
rials for common design purposes. You can use these materials, modify them 
for your project requirements, and define new materials. For more informa-
tion about materials and how to define them, see “Materials” on page 491.

Creating Tools from Curtain Wall Styles
You can create a curtain wall tool from any curtain wall style. You can drag 
the style from the Style Manager onto a tool palette. You can then specify set-
tings for any curtain wall properties for the tool. For more information, see 
“Creating a Curtain Wall Tool” on page 791.

To create, edit, copy, or purge styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop to 
work with styles from multiple drawings and templates. For more informa-
tion about using the Style Manager, see “Getting Started with the Style Man-
ager” on page 533.

Related Procedures

� Process Overview: Creating a Curtain Wall Style

� Tips for Working Efficiently with Curtain Wall Styles

� Creating Element Definitions for a Curtain Wall Style

� Creating a Curtain Wall Style

� Defining Divisions for Curtain Wall Grids

� Defining Infills for Curtain Wall Cells

� Defining Curtain Wall Frames

� Defining Curtain Wall Mullions

� Assigning Definitions to Curtain Wall Elements

� Assigning a Division to a Curtain Wall Grid

� Assigning Infills to Curtain Wall Cells

� Assigning Definitions to Curtain Wall Frames

� Assigning Definitions to the Mullions of a Curtain Wall

� Specifying the Materials of a Curtain Wall Style

� Specifying the Display of Curtain Walls

� Attaching Notes and Files to a Curtain Wall Style

Process Overview: Creating a Curtain Wall Style

When you create a curtain wall style, you assign characteristics to any or all 
elements of a curtain wall and save them as a named style. In this way, you 
standardize the appearance of all curtain walls that use the style. When you 



Curtain Wall Styles | 795

modify a style, all curtain walls in your drawing that use the style are updated 
to reflect the changes.

Step 1: Define divisions for the curtain wall grid.

For information on defining curtain wall grid definitions, see “Defining 
Divisions for Curtain Wall Grids” on page 799.

Step 2: Define the infill for the cells of the curtain wall.

For information on creating infills, see “Defining Infills for Curtain Wall 
Cells” on page 812.

Step 3: Define the curtain wall frame, including using profiles and specifying 
offsets.

For information on defining a frame for a curtain wall, see “Defining Cur-
tain Wall Frames” on page 818.

Step 4: Define the mullions for the curtain wall, including using profiles and 
specifying offsets.

For information on ways to define mullions, see “Defining Curtain Wall 
Mullions” on page 825.

Step 5: Assign the element definitions you created:

Step 6: Specify the materials of the curtain wall style.

For information on specifying materials, see “Specifying the Materials of 
a Curtain Wall Style” on page 850.

Step 7: Specify the display properties of the curtain wall, including layer, 
color, linetype, and hatching.

If you want to assign . . . Then . . .

a division to a curtain wall grid see “Assigning a Division to a Curtain 
Wall Grid” on page 833.

infills to curtain wall cells see “Assigning Infills to Curtain Wall 
Cells” on page 833.

definitions to curtain wall frames see “Assigning Definitions to Curtain 
Wall Frames” on page 843.

definitions to curtain wall mullions see “Assigning Definitions to the 
Mullions of a Curtain Wall” on 
page 846.
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For information on specifying the display properties of a curtain wall, see 
“Specifying the Display of Curtain Walls” on page 852.

Step 8: Attach notes and reference documents to the curtain wall style.

For information on attaching notes and files, see “Attaching Notes and 
Files to a Curtain Wall Style” on page 858.

Tips for Working Efficiently with Curtain Wall 
Styles

Use these suggestions to work efficiently and productively with curtain wall 
styles:

� Name grids and elements very clearly to identify where they are used and 
what they are. For example, use the name L3-FL1-H to represent a third-
level grid used on the first floor and that is horizontally divided. Incorpo-
rating this suggestion makes it easier to ensure that you are using elements 
correctly.

� Use the element definition that is applied most often as the default ele-
ment definition. For example, if most cells are stone panels, define the 
default infill as the stone panel. This panel is then used in every cell that 
is not specifically assigned to another infill. Apply this rule to the default 
frame, mullion, and division.

� Use curtain wall units and door/window assemblies to simplify the com-
plexity of a curtain wall style.

� Name the styles for doors, windows, curtain wall units, AEC polygons, and 
curtain walls to indicate where they are used and what they are.

� Remember that you can use cell and edge overrides to define special con-
ditions not accounted for in the curtain wall style.

Creating Element Definitions for a Curtain Wall 
Style

Element definitions determine the appearance of the four basic curtain wall 
elements. There is a different definition type for each element.

Element type Default definitions

Divisions Primary horizontal grid with a fixed cell dimension of 13' 
and secondary vertical grid with a fixed cell dimension of 5'

Cell Infills Cells containing simple panels
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Curtain wall grid element types

Each type of element can have multiple definitions. For example, you can 
define a division to create a horizontal grid or a vertical grid, and you can 
define the cells to contain a nested grid or a door/window assembly. To make 
reuse easier, you can save the element definitions, and then assign them to 
grids, cells, frames, or mullions as needed. 

Element definitions are style-specific. When you create element definitions 
for a specific curtain wall style, those definitions are available only for curtain 
walls of that style. For example, if you define a door/window assembly infill 
for one curtain wall style, that infill is not available as an option when you 
edit a curtain wall of a different style.

For information about defining the color, linetype, or layer of curtain wall 
elements, see “Specifying the Display of Curtain Walls” on page 852.

Creating a Curtain Wall Style

Use this procedure to create a curtain wall style. You can create a style using 
default style properties or by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 

Frames Left, right, top, and bottom outer edges of grid 3" wide 
and 3" deep

Mullions Edges between cells 1" wide and 3" deep

Element type Default definitions
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style. You can also create a curtain wall tool based on the newly created cur-
tain wall style. When you use the tool to add curtain walls, each curtain wall 
has the style specific to the tool.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Create a new curtain wall style:

4 Enter a name for the new curtain wall style, and press ENTER.

5 To edit the new curtain wall style, right-click the style, and click Edit:

If you want to create 
a style . . .

Then . . .

with default properties right-click Curtain Wall Styles, and click New.

from an existing style right-click the curtain wall style you want to copy, 
and click Copy. Right-click, and click Paste.

from a curtain wall, curtain 
wall unit, or door/window 
assembly in the drawing

right-click Curtain Wall Styles, and click New. Right-
click the new style, click Set From, and then select a 
curtain wall, a curtain wall unit, or a door/window 
assembly.

If you want to . . . Then . . .

define the elements of a 
curtain wall style

see “Defining Divisions for Curtain Wall Grids” on 
page 799, “Defining Infills for Curtain Wall Cells” on 
page 812, “Defining Curtain Wall Frames” on 
page 818, and “Defining Curtain Wall Mullions” on 
page 825.

assign element definitions 
to the curtain wall style

see “Assigning Definitions to Curtain Wall Elements” 
on page 832, “Assigning a Division to a Curtain 
Wall Grid” on page 833, “Assigning Infills to Curtain 
Wall Cells” on page 833, “Assigning Definitions to 
Curtain Wall Frames” on page 843, and “Assigning 
Definitions to the Mullions of a Curtain Wall” on 
page 846.

add curtain wall element 
definitions as display 
components

see “Adding Curtain Wall Element Definitions as 
Display Components” on page 853.

specify layer, color and 
linetype settings for the 
display components of a 
curtain wall

see “Specifying the Layer, Color, and Linetype of a 
Curtain Wall Style” on page 854.
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6 When you finish specifying the properties of the curtain wall style, click 
OK.

7 If you want to assign the style to a curtain wall tool, drag the style from 
the Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Curtain Wall Tool” on page 791.

8 Click OK.

Defining Divisions for Curtain Wall Grids

The divisions of a grid define the orientation that determines the direction 
of the grid cells and mullions, and they define a division type that deter-
mines the number and size of cells. 

NOTE Creating a nested grid is not a division rule. To create a nested grid, add 
a cell assignment. For more information, see “Creating a Nested Grid in a Cur-
tain Wall” on page 837 and “Working with Nested Grids in Curtain Walls” on 
page 834.

You can create a variety of division definitions under different names, and 
then assign different divisions to each grid in your curtain wall. Although 
you can create multiple definitions, there can be only one division assign-
ment per grid. You create division definitions for a specific curtain wall style 
and those definitions can be assigned only to grids in curtain walls of that 
style. 

specify curtain wall 
hatching

see “Specifying the Hatching for Components of a 
Curtain Wall Style” on page 855.

add custom graphics as 
display components of a 
curtain wall style

see “Adding Custom Graphics as a Display 
Component of a Curtain Wall” on page 856

create individual cut planes 
for curtain wall styles

see “Creating Cut Planes for a Curtain Wall” on 
page 857.

specify the materials of the 
curtain wall style

see “Specifying the Materials of a Curtain Wall 
Style” on page 850.

add notes and files to the 
style

see “Attaching Notes and Files to a Curtain Wall 
Style” on page 858.

If you want to . . . Then . . .
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For more information about assigning divisions to a particular grid, see 
“Assigning a Division to a Curtain Wall Grid” on page 833.

Related Procedures

� Division of Curtain Wall Grids

� Creating a Division Definition for a Curtain Wall

� Specifying a Fixed Size for Cells in a Curtain Wall Grid

� Specifying a Fixed Number of Cells for a Curtain Wall Grid

� Manually Defining the Number and Size of Cells in a Curtain Wall Grid

� Excluding Gables and Steps from a Curtain Wall Grid

� Dividing a Vertical Curtain Wall Grid at Each Vertex Along a Polyline

� Specifying an Offset for a Curtain Wall Grid

� Removing a Division Definition from a Curtain Wall Style

Division of Curtain Wall Grids
A curtain wall consists of one or more grids, which are the framework for 
placing design elements in the curtain wall. The highest-level grid is the pri-
mary grid, which is also the outside edge of the curtain wall. 

Each grid in a curtain wall has one division assignment that determines 
whether the grid is divided horizontally or vertically. The division also deter-
mines the number of cells, their size, and their placement.

Within the primary grid, you can define multiple levels of grids. These grids 
within the primary grid are called nested grids. Each subdivision of a grid is 
called a cell. 

Creating a Division Definition for a Curtain Wall
Use this procedure to create divisions for a curtain wall grid.

Because curtain walls can contain multiple nested grids, it is helpful to use a 
naming convention for grids that indicates the level of each grid and the grid 
location or the purpose within the curtain wall. For example, L3-FL1-Stone 
Panels can identify a third level grid that provides a row of stone panels on 
Floor 1.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Click New Division.
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7 Enter a name for this division definition.

8 Click either Vertical Orientation or Horizontal Orientation.

9 Select one of the following division types and specify offsets if needed.

After you create a division definition, you can assign the definition to a 
specific grid in a curtain wall. For more information, see “Assigning a Divi-
sion to a Curtain Wall Grid” on page 833.

10 When you are finished creating division definitions, click OK.

Specifying a Fixed Size for Cells in a Curtain Wall Grid
Use this procedure to define a specific size for the cells in a grid. In this case, 
the number of cells is determined by the length or height of the grid, depend-
ing on how the grid is divided.

When you specify a fixed cell size in a grid, you can control how the cells of 
the grid adjust to accommodate any leftover space. This space occurs if the 
length (or the height) of the curtain wall cannot be evenly divided by the 

Division Type Description

Fixed Cell Dimension Creates a grid where the size of the individual cells is 
predetermined. For more information, see 
“Specifying a Fixed Size for Cells in a Curtain Wall 
Grid” on page 801.

Fixed Number of Cells Creates a grid where the number of grid cells is 
predetermined. For more information, see 
“Specifying a Fixed Number of Cells for a Curtain 
Wall Grid” on page 804.

Manual Creates a grid where the size and number of 
individual cells is manually determined by the user. 
For more information, see “Manually Defining the 
Number and Size of Cells in a Curtain Wall Grid” on 
page 805.

Baseline/ Base Height 
(horizontal grids only)

Creates a horizontal grid that does not extend to 
gables or steps in a curtain wall. For more 
information, see “Excluding Gables and Steps from a 
Curtain Wall Grid” on page 807.

Polyline (vertical grids 
only)

Creates a vertical grid from a polyline that adds a 
grid line for each vertex of the polyline. For more 
information, see “Dividing a Vertical Curtain Wall 
Grid at Each Vertex Along a Polyline” on page 808.
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fixed size of the cell. For more information, see “Using the Auto-Adjust Cells 
Option” on page 803.

Specifying a fixed size for cells

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Divisions definition or create a new one.

7 Select Fixed Cell Dimension as the division type.

8 Specify a size for the cells in Cell Dimension. 

If you are defining a vertical division, the cell dimension is the length of 
the cell from mullion to mullion. If you are defining a horizontal division, 
the cell dimension is the height of the cell.



Curtain Wall Styles | 803

9 To specify an offset for the grid, enter an offset distance in Start Offset or 
End Offset. For more information, see “Specifying an Offset for a Curtain 
Wall Grid” on page 809.

TIP The frame width is calculated as part of the cell size. Therefore, cells 
adjacent to the frame can appear to be a different size than the other cells. If 
you do not want the frame width included in the cell size, specify an offset for 
the grid that is equal to the frame width. 

When you draw a curtain wall using a fixed cell dimension, there is often 
extra space between the last full-size cell and the end of the curtain wall.

10 Adjust the cells to accommodate this extra space:

For information about offsets, see “Specifying an Offset for a Curtain Wall 
Grid” on page 809

11 Click OK. 

For information about assigning the division definition to a specific grid in 
your curtain wall, see “Assigning a Division to a Curtain Wall Grid” on 
page 833.

Using the Auto-Adjust Cells Option
Use this procedure to automatically resize cells in a grid when the result of 
dividing the grid by the specified cell dimension is not a whole number.

For example, if a vertical primary grid in a curtain wall style is 17 feet in 
length and you specify a fixed cell dimension of 3 feet, the grid has five cells 
of 3 feet each with 2 feet remaining. Using the Auto-Adjust Cells option, you 
can specify how the grid distributes the remaining quantity.

1 On the Format menu, click Style Manager.

If you want to . . . Then . . .

add the space to grid 
cells

select Auto-Adjust Cells, select Grow for Cell 
Adjustment, and select the specific cells where the 
space is to be added.
You can select any combination of Specific Cells.

remove the space from 
grid cells

select Auto-Adjust Cells, select Shrink for Cell 
Adjustment, and select the specific cells where the 
space is to be removed.
You can select any combination of Specific Cells.
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2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Divisions definition or create a new one.

7 Select Fixed Cell Dimension as the division type.

8 Select Auto-Adjust Cells, and specify the cell adjustment:

The cells that you do not select maintain the fixed value you specified for 
Cell Dimension.

Specifying a Fixed Number of Cells for a Curtain Wall Grid
Use this procedure to define a specific number of cells in a grid. In this case, 
the size of the cells is determined by the length or height of the grid, depend-
ing on how the grid is divided.

In some cases, when you create a complex curtain wall grid, you might want 
to start with a standard grid with a fixed number of cells, and then later fine-
tune that manually. You can first create a grid with fixed cell numbers and 
then convert that to a manual grid. For information on manual grids, see 
“Manually Defining the Number and Size of Cells in a Curtain Wall Grid” on 
page 805.

If you want to . . . Then . . .

add the remaining space to grid cells select Grow, and select the specific 
cells to which you want the space 
added.

remove the remaining space from grid 
cells

select Shrink, and select the specific 
cells from which you want the space 
removed. You can then select Maintain 
at least half of cell dimension in order 
to control the cell shrinkage.
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Specifying a fixed number of cells

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Fixed Number of Cells for Division Type.

8 Specify the  number of cells. 

9 To specify an offset for the grid, enter an offset distance for Start Offset or 
End Offset. 

For more information, see “Specifying an Offset for a Curtain Wall Grid” 
on page 809.

NOTE If you want to fine-tune the initial layout with a fixed number of cells, 
click Convert To Manual Division and edit the grid as described in“Manually 
Defining the Number and Size of Cells in a Curtain Wall Grid” on page 805. 

10 Click OK. 

For information about assigning the division definition to a specific grid in 
your curtain wall, see “Assigning a Division to a Curtain Wall Grid” on 
page 833.

Manually Defining the Number and Size of Cells in a Curtain 
Wall Grid
Use this procedure to manually add gridlines and specify an offset for each 
one when you need to create a unique grid that does not fit into any of the 
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other division types. You can also start with a fixed cell dimension grid or a 
fixed number of cells grid, and then manually adjust the grid lines to suit 
your needs.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Manual for Division Type.

8 Click Add Gridline to insert a grid line. Insert as many grid lines as you 
need. If you need to remove a grid line, select it from the table and click 
Remove Gridline.

9 Under Offset in the gridline table, specify an offset distance for each grid 
line.

Gridline offset

10 Under From in the grid line table, select the grid location from which the 
grid line is offset. 

Offset grid line from option

11 To specify an offset for the grid, enter an offset distance for Start Offset or 
End Offset. 

For more information, see “Specifying an Offset for a Curtain Wall Grid” 
on page 809.

12 Click OK.
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For information about assigning the division definition to a specific grid 
in your curtain wall, see “Assigning a Division to a Curtain Wall Grid” on 
page 833.

Excluding Gables and Steps from a Curtain Wall Grid
If you are designing a curtain wall that has gables in the roof line or steps in 
the floor line, there may be occasions when you do not want the grid to 
extend into those areas. To define your curtain wall in this case, you can 
define a single-cell horizontal grid that excludes those areas, and then use 
that grid as a starting point for nested grids. For information about nested 
grids, see “Working with Nested Grids in Curtain Walls” on page 834.

NOTE For information about adding steps or gables to your curtain wall, see 
“Changing the Roof Line and the Floor Line of a Curtain Wall” on page 891.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Horizontal for Orientation.

8 Select Baseline/Base Height for Division Type.

9 Select Divide at Baseline or Divide at Base Height.

� Divide at Baseline: Forces a division at the baseline to exclude steps 
from the grid.

� Divide at Base Height: Forces a division at the base height to exclude 
gables from the grid. 
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10 To offset the division from the baseline, enter a positive number for Base-
line Offset.

11 To offset the division from the base height, enter a positive number for 
Base Height Offset.

12 Click OK twice.

The resulting grid contains a single, horizontal cell. To add additional divi-
sions, use nested grids. For more information, see “Creating a Nested Grid in 
a Curtain Wall” on page 837.

For information about assigning the division definition to a specific grid in 
your curtain wall, see “Assigning a Division to a Curtain Wall Grid” on 
page 833.

Dividing a Vertical Curtain Wall Grid at Each Vertex Along a 
Polyline
If you create a curtain wall by referencing a polyline, you can define a vertical 
grid for your curtain wall by placing grid lines at each vertex along the 
polyline. 

1 Draw a polyline and use it as a reference curve to create a curtain wall. 

For more information, see “Creating a Curtain Wall that References a 
Curve” on page 785.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Curtain Wall Styles.

4 Select a curtain wall style, right-click, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Divisions under Element Definitions.

7 Select a Division definition or create a new one.

8 Select Vertical for Orientation.
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9 Select Polyline for Division Type.

10 Click OK twice.

For information about assigning the division definition to a specific grid in 
your curtain wall, see “Assigning a Division to a Curtain Wall Grid” on 
page 833.

Specifying an Offset for a Curtain Wall Grid
By default, grids cells are measured from the start and end points of the cur-
tain wall baseline (for horizontal divisions) or from the floor line to the roof 
line (for vertical divisions). The width of the grid frame is not considered in 
calculating the size of the cell. For example, if you draw a curtain wall with 
a 14' baseline and a 1' frame on the left and right, and you specify a fixed 
number of vertical cells, the cells do not appear equal in size. The first and 
last cells appear smaller because they include the frame. To make the cells 
equal in size, offset the start and end of the grid by the width of the frame. 
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Specifying grid offset directions

NOTE You can offset the grid only when the division type is Fixed Cell 
Dimension, Fixed Number of Cells, or Manual.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Fixed Cell Dimension, Fixed Number of Cells, or Manual for 
Division Type.

8 Specify an offset for the grid. 

If you want to specify the 
distance between . . .

Then . . .

the start point of the curtain wall 
baseline and the start of the first cell in 
a horizontal grid

enter a value for Start Offset.
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9 Click OK twice.

Removing a Division Definition from a Curtain Wall Style
Use this procedure to remove a division definition that you no longer need. 
You cannot remove a division definition when it is currently assigned to a 
grid. In addition, you cannot remove the default division definition, but you 
can modify it.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition that you want to remove.

7 Click Remove Division.

8 Click OK twice.

the end point of the curtain wall 
baseline and the end of the last cell in a 
horizontal grid

enter a value for End Offset.

the floor line of the curtain wall and 
the start of the bottom cell in a vertical 
grid

enter a value for Bottom Offset.

the roof line of the curtain wall and the 
end of the top cell in a vertical grid

enter a value for Top Offset.

If you want to specify the 
distance between . . .

Then . . .
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Defining Infills for Curtain Wall Cells

An infill defines the contents of a curtain wall cell. A curtain wall cell can be 
empty (no infill), can contain a grid (nested grid), or can contain one of two 
infills: a panel or a style. Use the style infill for inserting doors, windows, and 
other objects into a curtain wall. Panels typically represent glazing or other 
plain cladding, such as stone or concrete.

Specifying different infills

NOTE Nested grids and no infill are options you select when assigning an infill 
to a cell. These options do not require infill definitions. For more information, see 
“Creating a Nested Grid in a Curtain Wall” on page 837 and “Removing an Infill 
from a Curtain Wall Cell” on page 840.

You can define as many infills as you need, and then use cell assignments to 
specify the cells that use each infill. You can modify, as needed, a default infill 
that is used for all unassigned cells. For more information about cell assign-
ments, see “Assigning Definitions to Curtain Wall Elements” on page 832.

NOTE Create infill definitions for a specific curtain wall style. Those definitions 
can be assigned only to grid cells in curtain walls of that style.

Materials
Styles use the materials of the object style assigned to each panel. For exam-
ple, if you specify an infill to use the Standard door style, the materials of that 
infill are those designated in the door style. Simple Panels need material 
assigned in the curtain wall style.

If you do not use materials to control the display properties of infills, you can 
specify their display properties in the curtain wall style. The layer, color, line-
type, and other display properties of the default infill are applied to all infills 
unless you create a custom display component for each infill definition. You 
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can then control the display of each infill definition independently. For more 
information, see “Specifying the Display of Curtain Walls” on page 852.

Related Procedures

� Creating a Panel Infill for a Curtain Wall

� Creating an Infill for Inserting an Object into a Curtain Wall

� Specifying an Alignment for a Curtain Wall Infill

� Specifying an Offset for a Curtain Wall Infill

� Removing an Infill Definition from a Curtain Wall Style

Creating a Panel Infill for a Curtain Wall
Use this procedure to create a simple panel infill to represent basic cladding 
materials in the curtain wall, such as a stone wall panel, concrete panel, 
metal panel, or glazing infill.

Because curtain walls can contain multiple infills, it is helpful to use a nam-
ing convention for panel infills that indicates the infill location or purpose 
within the curtain wall. For example, L3-FL1- Stone Panel can identify a 
stone panel in a third-level grid on Floor 1. 

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Click New Infill.

7 Enter a descriptive name for the infill.

8 Select Simple Panel as the infill type.

9 Specify an alignment for the infill. 

For more information, see “Specifying an Alignment for a Curtain Wall 
Infill” on page 815.

10 Specify an offset for the infill. 

For more information, see “Specifying an Offset for a Curtain Wall Infill” 
on page 816.

11 Specify a thickness for the panel.
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Specifying infill panel thickness

12 Click OK twice.

After you create an infill definition, you can assign it to any cell in a curtain 
wall grid. For more information, see “Assigning Infills to Curtain Wall Cells” 
on page 833.

Creating an Infill for Inserting an Object into a Curtain Wall
Use this procedure to create a style infill to insert objects into a curtain wall. 
You can insert doors, windows, door/window assemblies, curtain wall units, 
and AEC Polygons by defining a specific style of that object as an infill.

TIP After you insert an object in a cell, you can select that object independent 
of the grid and access editing options for the object.

Because curtain walls can contain multiple object styles, it is helpful to use a 
naming convention for style infills that indicates the infill location or pur-
pose within the curtain wall. For example, L3-FL1-Octagonal Window can 
identify an octagonal window in a third-level grid on Floor 1. 

NOTE The object styles you use in infills must exist in the current drawing to 
be added to an infill definition.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Click New Infill.
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7 Enter a descriptive name for the infill.

8 Select Style as the infill type.

The bottom right pane changes to display a tree view of the object styles 
available for insertion into a curtain wall.

9 Select an object style.

There is a unique icon for each type of style. For example, the door style 

icon  and the curtain wall unit icon . These icons are also displayed 
next to the infill name at the top of the dialog box to help you identify 
the type of infill.

10 Specify an alignment for the infill. For more information, see the next sec-
tion “Specifying an Alignment for a Curtain Wall Infill” on page 815.

11 Specify an offset for the infill. For more information, see “Specifying an 
Offset for a Curtain Wall Infill” on page 816.

12 Click OK twice.

After you create an infill definition, you can assign it to any cell in a curtain 
wall grid. For more information, see “Assigning Infills to Curtain Wall Cells” 
on page 833.

Specifying an Alignment for a Curtain Wall Infill
Use this procedure to align an infill so that it is centered with the baseline of 
the curtain wall, in front of the baseline, or behind the baseline. In Plan view, 
the front of a curtain wall (drawn from left to right) is below the baseline and 
the back is above the baseline.

NOTE To move the infill away from the baseline, see “Specifying an Offset for 
a Curtain Wall Infill” on page 816.

Specifying infill alignments

1 On the Format menu, click Style Manager.
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2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select an infill, or create a new one.

7 Select an alignment: front, center, or back.

8 Click OK twice.

Specifying an Offset for a Curtain Wall Infill
Use this procedure to specify an offset for a curtain wall infill. By default, 
infills are centered on the curtain wall baseline. If your design requires that 
the infill be aligned with frame edges or some other part of the curtain wall, 
you can specify an offset for the infill.

You can also edit individual style-based infills directly in the drawing. The 
selected infill has Flip grips in both the X and Y directions so that you can 
change the orientation of the infill.
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Specifying panel infill offsets

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select an infill, or create a new one.

7 Enter an offset distance. 

In Plan view, positive numbers offset the infill above the baseline and neg-
ative numbers offset the infill below the baseline. The offset is also 
affected by the selected alignment for the infill.

8 Click OK twice.
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Removing an Infill Definition from a Curtain Wall Style
Use this procedure to delete an infill definition that you no longer need from 
the Infills definitions list. You cannot remove an infill definition when it is 
currently assigned to a cell. In addition, you cannot remove the default infill 
definition, but you can modify it as needed.

NOTE For information about removing an infill from a cell, see “Removing an 
Infill from a Curtain Wall Cell” on page 840.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select the unneeded infill definition, and click Remove Infill.

7 Click OK twice.

Defining Curtain Wall Frames

All curtain wall grids, including the primary grid, can have frame definitions. 
The frame of the primary grid defines the outer edges of the curtain wall. The 
overall frame size is determined by the length and height of the primary cur-
tain wall grid or a nested curtain wall grid. You can define a frame by speci-
fying a width and depth or by selecting a profile.
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Specifying default and profile-based frames

You create frame definitions for a specific curtain wall style. Those defini-
tions can be assigned only to frames in curtain walls of that style. You can 
create as many frame definitions as you want, and then assign the definitions 
to the frames as needed. If you have nested grids, each grid has its own frame. 
There is a default frame definition that you can modify and assign as needed. 
Unassigned frames are not displayed. For more information, see “Assigning 
Definitions to Curtain Wall Frames” on page 843.

TIP Using Style Manager, you can copy a mullion definition and use it as a 
frame definition. Select the mullion definition and drag it to Frames in the left 
pane of the Design Rules tab.

Materials and Display Properties for Frames
If you do not use materials to control the display properties of frames, you 
can specify their display properties in the curtain wall style. The layer, color, 
linetype, and other display properties of the default frame are applied to all 
frames unless you create a custom display component for each definition. 
You can then control the display of each frame definition independently. For 
more information, see “Specifying the Display of Curtain Walls” on 
page 852.
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Related Procedures

� Defining a Curtain Wall Frame by Width and Depth

� Creating a Profile for a Curtain Wall Frame

� Defining a Curtain Wall Frame Using a Profile

� Specifying Offsets for a Curtain Wall Frame

� Removing a Frame Definition from a Curtain Wall Style

Defining a Curtain Wall Frame by Width and Depth
You can define a frame by specifying its width and depth. The overall frame 
size is determined by the length and height of the curtain wall grid.

Specifying frame width and depth

Because curtain walls can contain multiple object styles with different 
frames, it is helpful to use a naming convention for grid frames that indicates 
the grid location or purpose within the curtain wall. For example, L3-FL1- 
Metal Frame can identify a metal frame for a third-level grid on Floor 1. 

TIP To remove the frame edge and have the infill adjust to fill the space occu-
pied by the frame, create a frame definition with both width and depth set to 
zero. Then, assign that definition to the frame edge that you want to remove. 
This is necessary for the infill to be mitered as it would be for a butt-glazed con-
dition. For more information, see “Removing a Frame Edge from a Curtain Wall” 
on page 844.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.
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6 Click  to create a new frame definition.

7 Enter a descriptive name for the frame.

8 Specify a width and depth for the frame.

9 Specify any offsets. 

For more information, see “Specifying Offsets for a Curtain Wall Frame” 
on page 823.

10 Click OK.

After you create a frame definition, you can assign it to any frame in a curtain 
wall. For more information, see “Assigning Definitions to Curtain Wall 
Frames” on page 843.

Creating a Profile for a Curtain Wall Frame
Use this procedure to create a profile that you can use to define the shape of 
a curtain wall frame. You can then extrude the profile to create a curtain wall 
frame.

The height and the width of the polyline you use to create the profile define 
the default height and width of the curtain wall frame. The insertion point 
of the profile is aligned with the centroid of the frame. 

1 Draw a closed polyline of the height and the depth needed for the result-
ing curtain wall frame.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Enter c (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the frame. 

4 Enter a name for the profile, and click OK.

You can now use the profile as a curtain wall frame. For more information, 
see “Defining a Curtain Wall Frame Using a Profile” on page 821.

Defining a Curtain Wall Frame Using a Profile
Use this procedure to create a frame element definition from a profile. If you 
do not want a straight edge to your frame, you can use a profile to define 
edges with curves, jags, or any other shape you require.

You can also use an edit in-place routine to create a frame from a profile. For 
more information, see “Creating a Frame or Mullion Edge from a Polyline or 
Profile using In-Place Editing” on page 868.
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Two profile-based frame examples

NOTE The insertion point of the profile is aligned with the centroid of the 
frame. 

1 Create the profile for the frame. 

For information on creating profiles for curtain wall frames, see “Creating 
a Profile for a Curtain Wall Frame” on page 821.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Curtain Wall Styles.

4 Select a curtain wall style, right-click, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Frames under Element Definitions.

7 Click New Frame.

8 Enter a descriptive name for the frame.

9 Specify a width and depth for the frame edge. 

These dimensions are used to calculate the center point of the edge for 
aligning the profile and also to specify a boundary for the adjacent infill.

10 Select Use Profile.

NOTE The Profile options are available only if you have profiles in the cur-
rent drawing.

11 Select a profile from the list.

By default, the profile is inserted using the same width and depth with 
which it was created. 

12 To adjust the size of the profile to fit within the width or depth dimension 
of the frame edge, select Auto-Adjust Profile Width or Depth.

13 To mirror the profile, select to mirror along the X or Y axis.
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14 To rotate the profile, specify an angle for Rotation.

15 Specify any offsets. 

For more information, see “Specifying Offsets for a Curtain Wall Frame” 
on page 823.

16 Click OK.

After you create a frame definition, you can assign it to any frame in a curtain 
wall. For more information, see “Assigning Definitions to Curtain Wall 
Frames” on page 843.

Specifying Offsets for a Curtain Wall Frame
Use this procedure to define the distance that a curtain wall frame is from the 
floor line, roof line, or baseline. By default, the outside edges of the frame 
align with the start and end of the floor line and the start and end of the roof 
line. When you adjust the width of the frame, the frame expands inward. 
However, you can use offsets to expand or contract the frame away from 
these default limits or to shift the frame away from the baseline in either the 
X or Y direction. 

Offset Description 

X Positive X offset moves the frame edge outward 
beyond the end of the curtain wall, while a 
negative X offset moves the frame edge inward 
toward the center of the curtain wall.

Y In Plan view, a positive Y offset moves the frame 
edge above the baseline, while a negative Y offset 
moves the frame below the baseline.

Start Negative Start offset lengthens the frame beyond 
the start point, while a positive Start offset shortens 
the frame. The start point for vertical edges is the 
baseline, and the start point for horizontal edges 
(drawn left to right) is the left side.

End Negative End offset lengthens the frame beyond 
the end point, while a positive End offset shortens 
the frame. The end point for vertical edges is the 
base height, and the end point for horizontal 
edges (drawn left to right) is the right side.
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Specifying frame offsets in the x and y directions

TIP To quickly identify the start and end of a curtain wall, select the curtain 
wall. The Reverse Direction grip is displayed near the center of the curtain wall 
and points toward the end of the curtain wall.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Select a frame definition from the list.

7 Specify an offset distance for the frame edge.

8 Click OK.

Removing a Frame Definition from a Curtain Wall Style
Use this procedure to remove a frame definition from the Frame definitions 
list. You cannot remove a frame definition if it is currently assigned to a 
frame edge, but you can remove it if it is assigned as an override to a frame 
edge. In addition, you cannot remove the default frame definition, but you 
can modify it as needed.
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NOTE For information about removing a frame edge, see “Removing a Frame 
Edge from a Curtain Wall” on page 844.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Select the unneeded frame definition.

7 Click Remove Frame.

8 Click OK.

Defining Curtain Wall Mullions

All curtain wall grids, including the primary grid, can have mullion defini-
tions. The mullion of the primary grid defines the outer edges of the curtain 
wall. You can define the mullions by specifying a width and depth or by 
selecting a profile from which the mullion is extruded.

Because curtain walls can contain multiple nested grids with different mul-
lions, it is helpful to use a naming convention for grid mullions that indi-
cates the level of each grid and the grid location or purpose within the cur-
tain wall. For example, L3-FL1-Window Mullion can identify a mullion for a 
window in a third-level grid on Floor 1. 
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Specifying default and profile-based mullions

You create mullion definitions for a specific curtain wall style and those def-
initions can be assigned only to mullions in curtain walls of that style. You 
can create as many mullion definitions as you want, and then assign the def-
initions to mullions as needed. If you have nested grids, each grid has its own 
mullions. There is a default mullion definition that you can modify as 
needed that is used for any unassigned mullions. For more information, see 
“Assigning Definitions to the Mullions of a Curtain Wall” on page 846.

TIP Using Style Manager, you can copy a frame definition and use it as a mul-
lion definition. Select the frame definition and drag it to Mullions in the left pane 
of the Design Rules tab.

Materials and Display Properties for Mullions
If you do not use materials to control the display properties of mullions, you 
can specify their display properties in the curtain wall style. The layer, color, 
linetype, and other display properties of the default mullion are applied to 
all mullions unless you create a custom display component for each defini-
tion. You can then control the display of each mullion definition indepen-
dently. For more information, see “Specifying the Display of Curtain Walls” 
on page 852.
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Related Procedures

� Defining Curtain Wall Mullions by Width and Depth

� Creating a Profile for Curtain Wall Mullions

� Defining the Mullions of a Curtain Wall Using a Profile

� Specifying Offsets for the Mullions of a Curtain Wall 

� Removing a Mullion Definition from a Curtain Wall Style

Defining Curtain Wall Mullions by Width and Depth
You can define mullions by specifying a width and a depth. 

Specifying mullion width and depth

TIP To remove mullions for butt glazing, create a definition with both width 
and depth set to zero. Then, assign that definition to the mullions that you want 
to remove. For more information, see “Removing Mullions from a Curtain Wall 
Grid” on page 849.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Click New Mullion.

7 Enter a descriptive name for the mullion.

8 Specify a width and depth for the mullion.

9 Specify the offsets you want. 

For more information, see “Specifying Offsets for the Mullions of a Cur-
tain Wall” on page 830.
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10 Click OK.

After you create a mullion definition, you can assign it to any mullion in a 
curtain wall. For more information, see “Assigning Definitions to the Mul-
lions of a Curtain Wall” on page 846.

Creating a Profile for Curtain Wall Mullions
Use this procedure to create a profile that you can use to define the shape of 
a curtain wall mullion definition. You can then extrude the profile to create 
mullions from it. 

The height and the width of the polyline you use to create the profile define 
the default height and width of the curtain wall mullion. The insertion point 
of the profile is aligned with the centroid of the mullion.

1 Draw a closed polyline of the height and the depth needed for the result-
ing curtain wall mullion.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Enter c (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the mul-
lion. 

4 Enter a name for the profile, and click OK.

You can now use the profile as a curtain wall mullion. For more informa-
tion, see “Defining the Mullions of a Curtain Wall Using a Profile” on 
page 828.

Defining the Mullions of a Curtain Wall Using a Profile
Use this procedure to create a mullion element definition from a profile. If 
you do not want a straight edge to your mullions, you can use a profile to 
define mullions with curves, jags, or any other shape.

You can also use an edit in-place routine to create a mullion from a profile. 
For more information, see “Creating a Frame or Mullion Edge from a Polyline 
or Profile using In-Place Editing” on page 868.

NOTE The insertion point of the profile is aligned with the centroid of the 
mullion.
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Infill alignments with default and profile-based mullions

1 Create the profile to use for the mullion. 

For information, see “Creating a Profile for Curtain Wall Mullions” on 
page 828.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Curtain Wall Styles.

4 Select a curtain wall style, right-click, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Mullions under Element Definitions.

7 Click New Mullion.

8 Enter a descriptive name for the mullion.

9 Specify a width and depth for the mullion. 

These dimensions are used to calculate the center point of the mullion for 
aligning the profile, and also to specify a boundary for the adjacent infill.

10 Select Use Profile.

NOTE The Profile options are available only if you have profiles in the cur-
rent drawing.
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11 Select a profile from the list.

By default, the profile is inserted using the same width and depth with 
which it was created.

12 To adjust the size of the profile to fit within the width or depth dimension 
of the mullion, select Auto-Adjust Profile Width or Depth.

13 To mirror the profile, select X or Y for Mirror In.

14 To rotate the profile, specify a rotation angle for Rotation.

15 Specify any offsets. 

For more information, see “Specifying Offsets for the Mullions of a Cur-
tain Wall” on page 830.

16 Click OK.

After you create a mullion definition, you can assign it to any mullion in a 
curtain wall. For more information, see “Assigning Definitions to the Mul-
lions of a Curtain Wall” on page 846.

Specifying Offsets for the Mullions of a Curtain Wall
Use this procedure to define mullions that are offset from the start or end of 
the curtain wall to lengthen or shorten the edge or offset in the X or Y direc-
tion to shift the edge. For example, you might want to represent butt glazing 
by offsetting the mullions to be behind glass panel infills.

Offset Description

X For vertical mullions, a positive X offset moves the 
mullions toward the end of the curtain wall, while a 
negative X offset moves the mullions toward the start of 
the curtain wall. For horizontal mullions, a positive 
X offset moves the mullions toward the top of the 
curtain wall, while a negative X offset moves the 
mullions toward the bottom of the curtain wall.

Y In Plan view, a positive Y offset moves the mullions 
above the baseline, while a negative Y offset moves the 
mullions below the baseline.

Start Negative Start offset lengthens the mullions beyond the 
start point, while a positive Start offset shortens the 
mullions.

End Negative End offset lengthens the mullions beyond the 
end point, while a positive End offset shortens the 
mullions.
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Specifying mullion offsets in x and y directions

TIP To quickly identify the start and end of a curtain wall, select the curtain 
wall. The Reverse Direction grip is displayed near the center of the curtain wall 
and points toward the end of the curtain wall.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Select a mullion definition from the list.

7 Specify an offset distance for the X, Y, Start, or End.

8 Click OK.

Removing a Mullion Definition from a Curtain Wall Style
Use this procedure to remove a mullion definition from the Mullions defini-
tions list. You cannot remove a mullion definition if it is assigned to a mul-
lion, but you can remove it if it is assigned as an override to a mullion. In 
addition, you cannot remove the default mullion definition, but you can 
modify it as needed.
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NOTE For information about removing mullions from between cells, see 
“Removing Mullions from a Curtain Wall Grid” on page 849.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Select the unneeded mullion definition from the list.

7 Click Remove Mullion.

8 Click OK.

Assigning Definitions to Curtain Wall Elements

After you’ve created element definitions for a curtain wall style, you can 
assign those definitions to each of the curtain wall element types: divisions, 
cell infills, frames, and mullions. 

By default, one definition is assigned to all elements of a particular type. 
However, you can assign definitions to individual elements as well. For 
example, all cells in the grid are assigned the default infill. You can, however, 
create a new cell assignment, select a different infill, and then specify the 
cells to use that infill.

Assignment list

For more information about element definitions, see “Creating Element Def-
initions for a Curtain Wall Style” on page 796.
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Assigning a Division to a Curtain Wall Grid

Use this procedure to assign a division to a curtain wall grid. A division 
defines the grid orientation (whether the direction of the grid cells and mul-
lions is horizontal or vertical) and the division type (number and size of 
cells).

After you define a division, you can assign it to the primary grid or to nested 
grids. Nested grids are created by selecting Nested Grid as the cell assignment. 
For more information, see “Working with Nested Grids in Curtain Walls” on 
page 834.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid you want to assign a division to. 

The name of the grid you select is displayed in the table under the Divi-
sion Assignment row.

TIP To rename a grid, select it, and click Rename and enter a new name. 

6 Click the Element column for that grid and select a division definition 
from the list. 

7 Click OK.

Assigning Infills to Curtain Wall Cells

An infill defines the contents of a curtain wall cell. A curtain wall cell can be 
empty (none), can contain a grid (nested grid), or can contain one of two 
infills: a panel or a style. The style infill is for inserting doors, windows, and 
other objects into a curtain wall.
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Cell Assignments
A cell assignment defines the infill definition used for the cells. You can use 
one cell assignment to assign the same infill to all cells, or you can create 
multiple cell assignments to assign different infills to different cells.

Cell assignments

Do not assign multiple definitions to the same cell because only the last 
assigned definition to the cell is used. 

Default Cell Assignment
The default cell assignment is used by all unassigned cells. You can modify 
the default assignment to be any type of infill, but you cannot delete the 
default cell assignment.

You may want to modify the default cell assignment to use the infill defini-
tion that occurs most frequently in your design. Any cells not assigned to 
other infills then use this infill definition.

Materials and Display Properties of Infills 
The layer, color, linetype, and other display properties of the default infill are 
applied to all infills unless you assign materials to the infills you created or 
you create a custom display component for each definition. You can then 
control the display of each infill definition independently. For more infor-
mation, see “Specifying the Display of Curtain Walls” on page 852.

Related Procedures

� Working with Nested Grids in Curtain Walls

� Creating a Nested Grid in a Curtain Wall

� Filling a Curtain Wall Cell with a Simple Panel

� Inserting an Object into a Curtain Wall Cell 

� Removing an Infill from a Curtain Wall Cell

� Specifying Which Curtain Wall Cells Use a Cell Assignment

� Removing an Assignment from a Curtain Wall Style

Working with Nested Grids in Curtain Walls
Each curtain wall grid is one-dimensional with either a horizontal or vertical 
division. By nesting grids in the curtain wall style, you can create a variety of 
patterns from simple to complex.
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Example of nested grids

Simple Primary Grids
When you nest grids, you start with one primary grid. Each cell in the pri-
mary grid can then be filled with another grid. For example, if your primary 
grid is horizontal and has three cells, you can nest a vertical grid in each hor-
izontal cell to create a simple two-dimensional (2D) grid. This is the nesting 
configuration for the Standard curtain wall style.

Specifying cell division definitions 1

The previous illustration shows all cells in the grid with the same cell assign-
ment—a vertical division. However, each cell in a grid is independent and 
can have a separate assignment. For example, the following illustration 
shows a three cell horizontal grid with different assignments in each cell. The 
bottom cell contains another horizontal division, the middle cell contains 
vertical divisions of varying width, and the top cell contains a vertical divi-
sions of a fixed width.
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Specifying cell division definitions 2

Multiple Nested Grids
You can continue to nest grids to create multiple levels. For example, the fol-
lowing illustrations show the Standard curtain wall style, which is a simple 
two-dimensional (2D) grid, with one horizontal cell and three vertical cells. 
Another grid is nested in the first cell of the secondary grid. This creates a ter-
tiary grid. The final illustration shows the nested grids assigned to all cells.

Specifying a sequence of nested grids

Defining Nested Grids
You can define nested grids by using the Design Rules tab of the Curtain Wall 
Style Properties dialog box. The tree in the left pane lists the grids. There is 
always one primary grid. The primary grid can have one or more secondary 
grids. Each secondary grid can have one or more tertiary grids, and so on.

TIP To quickly create nested grids in all cells, change the default cell assign-
ment to Nested Grid. If you want multiple levels of nesting, be sure to change 
the default cell assignment for each grid. For more information, see “Creating a 
Nested Grid in a Curtain Wall” on page 837.

Each grid has its own cell assignments. You assign cells to contain another 
grid, a panel infill, or an object such as a door or window. For more informa-
tion, see “Assigning Infills to Curtain Wall Cells” on page 833.
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Primary grid and cell assignments

Secondary grid and cell assignments

Creating a Nested Grid in a Curtain Wall
Use this procedure to create a nested grid in a curtain wall. A nested grid is a 
grid within a grid. Each nested grid has its own division, cell assignments, 
frame, and mullions. By default, the frame is turned off for nested grids.

For more information, see “Working with Nested Grids in Curtain Walls” on 
page 834.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a nested grid. 

6 Click New Cell Assignment.

A new cell assignment is displayed in the list of cell assignments.

7 Select the cell assignment in the top right frame, right-click and click 
Rename, and then enter a descriptive name.

8 Select Nested Grid in the Element column.

A new grid is added to the list of grids in the left pane. If you are editing 
the primary grid, the new grid is added at the secondary level. If you are 
editing a grid at the secondary level, the additional grid is placed at the 
tertiary level, and so on.
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Creating a nested grid 

New nested grid in tree

NOTE To rename a grid, select it in the right pane, right-click and click 
Rename, and enter a new name.

9 Specify the cells to contain this nested grid. 

For more information, see “Specifying Which Curtain Wall Cells Use a 
Cell Assignment” on page 841.

10 Click OK.

Filling a Curtain Wall Cell with a Simple Panel
Use this procedure to fill a curtain wall cell with a simple panel. Simple pan-
els are generally used to represent basic cladding materials in the curtain 
wall, such as a stone wall panel or a concrete panel.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to put a simple panel 
infill. 
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6 Click New Cell Assignment.

A new cell assignment is displayed in the list of cell assignments.

7 Select the cell assignment in the top right pane, right-click and click 
Rename, and then enter a descriptive name.

8 Under Element, select an infill that defines a simple panel. 

If you do not have a simple panel infill defined, then select New Infill and 
define one. For more information, see “Creating a Panel Infill for a Cur-
tain Wall” on page 813.

9 Specify the cells to contain this simple panel. 

For more information, see “Specifying Which Curtain Wall Cells Use a 
Cell Assignment” on page 841.

10 Click OK.

Inserting an Object into a Curtain Wall Cell
Use this procedure to insert objects, such as doors, windows, door/window 
assemblies, curtain wall units, and AEC Polygons, into a curtain wall cell. 
Curtain wall cells can contain these objects when you create infill definitions 
that use them. For more information, see “Creating an Infill for Inserting an 
Object into a Curtain Wall” on page 814.

TIP After you insert an object in a cell, you can select that object independent 
of the grid, right-click, and access editing options for the object.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.
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5 In the left pane, select the grid in which you want to insert objects. 

6 Click New Cell Assignment.

A new cell assignment is displayed in the list of cell assignments.

7 Select the cell assignment in the top right frame, right-click and click 
Rename, and then enter a descriptive name.

8 Select an infill that uses an object style. 

9 Specify the cells to contain this object. 

For more information, see “Specifying Which Curtain Wall Cells Use a 
Cell Assignment” on page 841.

10 Click OK.

Removing an Infill from a Curtain Wall Cell
Use this procedure to remove the infill of a cell and leave the cell empty. To 
do this, use None as the element definition. Using None also removes any 
frame edges that border the cell, but it does not affect the mullions.

Removing an infill assignment from a cell

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid that contains the cells you want to assign 
to None.

6 Create a new cell assignment or select an existing cell assignment.

7 Select NONE under the Element column.

8 Specify the cells to contain the None infill. 

For more information, see “Specifying Which Curtain Wall Cells Use a 
Cell Assignment” on page 841.
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9 Click OK.

Specifying Which Curtain Wall Cells Use a Cell Assignment
When you create a cell assignment you need to specify the cells in the grid 
to use that assignment. There are two options for selecting cells:

� Use Location to insert the infill into the start, middle, or end cells of a ver-
tical grid or into the bottom, middle, or top cells of a horizontal grid. If 
there is an even number of cells (four or more), Middle refers to the two 
cells in the middle of the grid. If there is an odd number of cells (three or 
more), Middle refers to one cell in the middle of the grid.
Specifying cell assignments by location

� Use Index to insert the infill into specific cells based on cell numbers. Cells 
are numbered from start to end or bottom to top. For example, typing 1, 
3, 5 would place the infill in the first, third, and fifth cells.

Specifying cell assignment by index

Any cells that are not assigned a specific cell assignment use the default infill.
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1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 In the right pane, select Location or Index for Type.

7 Select a cell assignment:

NOTE Do not assign multiple definitions to a cell because the last definition 
assigned to the cell is used. 

8 Click OK.

Removing an Assignment from a Curtain Wall Style

Use this procedure to remove cell assignments, frame assignments, and mul-
lion assignments from a curtain wall style. You cannot remove default assign-
ments, but you can modify them to suit your needs.

NOTE Each grid requires one division assignment. Therefore, you cannot 
remove the division assignment, although you can change the division element 
used for the division assignment.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

If you select . . . Then . . .

Location click the Used In column, and click the button 
at the far right of the row. Select the cells you 
want to use this assignment, and click OK.

Index enter the cell numbers separated by commas 
in the Used In column. For vertical grids, cells 
are numbered from start to end and for 
horizontal grids, cells are numbered from 
bottom to top.
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5 In the left pane, select the grid from which you want to remove an assign-
ment.

6 Select a cell assignment, frame assignment, or a mullion assignment.

7 Click Remove Assignment.

8 Click OK.

Assigning Definitions to Curtain Wall Frames

The curtain wall frame is represented by the outer edges of the primary grid. 
Each nested grid has its own frame that is defined separately from the pri-
mary grid frame. By default, the frames of nested grids are turned off. For 
more information about nested grids, see “Working with Nested Grids in 
Curtain Walls” on page 834.

Frame Assignments
A frame assignment defines the frame definition that is used by each frame 
edge. You can use one frame assignment to assign the same definition to all 
four edges of the frame, or you can create multiple frame assignments to 
assign different definitions to different edges of the frame. Unassigned edges 
are not displayed. 

Do not assign multiple definitions to the frame edge because only the last 
definition assigned to the edge is used. 

Default Frame Assignment
There is a default frame assignment and you can select the frame edges it 
applies to. You can modify the default assignment to use any frame defini-
tion, but you cannot delete the default frame assignment.

Materials and Display Properties of Frames
The layer, color, linetype, and other display properties of the default frame 
are applied to all frame edges unless you assign materials to the frame defini-
tion or you create a custom display component for each definition. You can 
then control the display of each frame definition independently. For more 
information, see “Specifying the Display of Curtain Walls” on page 852.

Related Procedures

� Adding a New Frame Assignment to a Curtain Wall 

� Removing a Frame Edge from a Curtain Wall

� Specifying Which Curtain Wall Edges Use a Frame Assignment
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Adding a New Frame Assignment to a Curtain Wall
Use this procedure to add a frame assignment to a curtain wall. To assign dif-
ferent definitions to different frame edges, you need multiple frame assign-
ments.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a new frame 
assignment. 

6 Click New Frame Assignment.

A new frame assignment is displayed in the list of frame assignments.

New frame assignment

7 Select the frame assignment in the right pane, right-click and click 
Rename, and then enter a descriptive name.

8 Select a frame definition from the Element column.

9 Specify the sides of the frame to use this frame assignment. 

For more information, see “Specifying Which Curtain Wall Edges Use a 
Frame Assignment” on page 845.

10 Click OK.

Removing a Frame Edge from a Curtain Wall
Use this procedure to remove a frame edge from a curtain wall. There are 
three ways to remove a frame edge: 

� Set the width and depth of the edge to zero
� Leave the edge unassigned
� Specify None as an override to the edge assignment

The first two methods remove the frame edge and expand the adjacent infills 
into the space occupied by the edge.
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Specifying a frame width and depth of zero

By specifying None as an override, the frame edge is not displayed, but the 
adjacent infill is not expanded into the space the edge occupied.

Overriding a frame edge definition

For information about setting the width and depth to zero, see “Defining a 
Curtain Wall Frame by Width and Depth” on page 820.

For information about leaving the edge unassigned, see “Specifying Which 
Curtain Wall Edges Use a Frame Assignment” on page 845.

For information about overriding the edge, see “Overriding Curtain Wall 
Frames and Mullions” on page 866.

Specifying Which Curtain Wall Edges Use a Frame Assignment
Use this procedure to specify edges that use a frame assignment. When you 
create a frame assignment, you need to specify the edges of the frame to use 
that assignment.

Frame edges that are not assigned a frame definition are not displayed.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.
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3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Select a frame assignment.

Location is the only way to specify the frame edges.

7 Click the Used In column, and then click the [...] button at the far right of 
the row.

Specifying frame location

8 Select the edges that you want to use this assignment - Left, Right, Top, or 
Bottom - and click OK.

Assigning frames to nested grids

Do not assign multiple definitions to the same frame edge because only 
the last definition assigned to the edge is used.

9 Click OK.

Assigning Definitions to the Mullions of a Curtain 
Wall

The mullions of a curtain wall are the edges between the grid cells. The pri-
mary grid and each nested grid have mullions that are defined separately 
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from the other grids. For more information about nested grids, see “Working 
with Nested Grids in Curtain Walls” on page 834.

Assign mullions to a nested grid

Mullion Assignments
A mullion assignment defines the definition used by each mullion. You can 
use one assignment to define all mullions, or you can create multiple assign-
ments and assign different definitions to different mullions in any grid.

Do not assign multiple definitions to the same mullion because only the last 
definition assigned to the mullion is used. 

Default Mullion Assignment
There is a default mullion assignment used by all unassigned mullions. You 
can modify the default assignment to be any mullion definition, but you 
cannot delete the default mullion assignment.

Related Procedures

� Adding a New Mullion Assignment to a Curtain Wall Style

� Removing Mullions from a Curtain Wall Grid

� Specifying Which Curtain Wall Mullions Use an Assignment

Adding a New Mullion Assignment to a Curtain Wall Style
Use this procedure to add a new mullion assignment to a curtain wall style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a new mullion 
assignment. 
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6 Click New Mullion Assignment.

A new mullion assignment is displayed in the list of mullion assignments.

New mullion assignment

7 Select the mullion assignment, right-click and click Rename, and then 
enter a descriptive name.

8 Select a mullion definition from the Element column.

9 Specify the mullions to use this assignment. 

For more information, see “Specifying Which Curtain Wall Mullions Use 
an Assignment” on page 848.

10 Click OK.

Specifying Which Curtain Wall Mullions Use an Assignment
When you create a mullion assignment you need to specify the mullions in 
the grid to use that assignment. There are two options for selecting 
mullions:

� Use Location to assign a definition to the start, middle, or end mullions of 
a vertical grid or the bottom, middle, or top mullions of a horizontal grid. 
If there is an even number of mullions (four or more), Middle refers to the 
two mullions in the middle of the grid. If there is an odd number of mul-
lions (three or more), Middle refers to the one mullion in the middle of 
the grid.

� Use Index to assign a definition to specific mullions based on mullion 
numbers. Mullions are numbered from start to end or bottom to top. For 
example, typing 1, 2, 3 would assign the definition to the first, second, 
and third mullions.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Create a new mullion assignment or select an existing assignment.

7 Select Location or Index for Type.
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8 Select a cell assignment.

NOTE Do not assign multiple definitions to the same mullion because only 
the last definition assigned to the mullion is used. 

9 Click OK.

Any mullions that are not assigned a specific mullion assignment use the 
default mullion definition.

Removing Mullions from a Curtain Wall Grid
Use this procedure to remove a mullion from the curtain wall. You can create 
a mullion definition whose edge width and depth are zero. Adjacent infills 
expand to fill in the space that was occupied by the mullion. This is an effec-
tive way to represent butt glazing.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to remove a mullion. 

If you selected . . . Then . . .

Location click the Used In column, and click the button at the 
far right of the row. Select the cells you want to use 
this cell assignment, and click OK.

Index enter the mullion numbers separated by commas in 
the Used In column. For vertical grids, mullions are 
numbered from start to end and, for horizontal 
grids, mullions are numbered from bottom to top.
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6 Create a new mullion assignment and enter 0 (zero) for the width and 
depth. 

For more information, see “Defining Curtain Wall Mullions by Width and 
Depth” on page 827.

7 Under Mullion Assignments, select the mullion definition you created for 
any cell edges of any mullion assignment, where you want to remove the 
mullions. 

For more information, see “Specifying Which Curtain Wall Mullions Use 
an Assignment” on page 848.

8 Click OK.

Specifying the Materials of a Curtain Wall Style

A curtain wall consists of a number of components whose display properties 
can be determined by the materials assigned to each component.

When you assign materials to a curtain wall style, you assign one material to 
each display component of the curtain wall. For example, you assign a wood 
material to the frame and a glass material to the glass inset. You assign mate-
rials to components in each display representation where you want the mate-
rials to be used.

If you want to use the display properties of the curtain wall style, instead of 
using material display properties, you can turn off the material assignments 
in the display properties of the curtain wall style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Curtain Wall Materials and Display Components

� Assigning Materials to a Curtain Wall Style
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Curtain Wall Materials and Display Components
The following table identifies the material component that corresponds to 
each curtain wall component in the specified views. 

Assigning Materials to a Curtain Wall Style
Use this procedure to assign materials to the individual components of a cur-
tain wall style. When you assign a material to a curtain wall component, the 
component uses the display properties of the material instead of the style dis-
play properties.

You can assign a material to any physical component of the curtain wall. 
Custom components and components that are only symbolic graphics do 
not use materials for their display properties. For example, the frame, mul-
lion, and infill are physical components of a curtain wall. The cell marker is 
a symbolic component.

NOTE If a material assignment does not determine the display properties of a 
curtain wall component, you can change the display properties of the curtain 
wall style as described in “Specifying the Display of Curtain Walls” on page 852.

Curtain Wall 
Component

Material Component

Plan, Plan High Detail, Plan Low Detail, Screened, Reflected Plan

Frame Definitions Linework

Mullion Definitions Linework

Infill Definitions Linework

Frame Definitions Hatch Linework

Mullion Definitions Hatch Linework

Infill Definitions Hatch Linework

Model

Frame 3D Body

Mullion 3D Body

Infill 3D Body
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1 Open a tool palette that has a curtain wall tool.

2 Right-click a curtain wall tool, and click Curtain Wall Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, select the value for Material 
Definition, and select a different material definition.

You can select any material definition in the current drawing, or click 

 to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display of Curtain Walls

The display of a curtain wall depends on the direction from which you view 
the curtain wall. In Plan view, the curtain wall object is displayed as parallel 
lines with vertices marking the grid lines, as an architect would typically 
draw a curtain wall. In 3D isometric views, the curtain wall object is dis-
played as it would appear in the real world, with surfaces showing length, 
thickness, and height. You control what you want to display in each partic-
ular view.

Element Definitions and Custom Display Components
By default, the display of all infills, frames, and mullions is controlled by the 
display properties of the default infill, default frame, and default mullions. 
However, you can add individual element definitions as components with 
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separate display properties. For example, if you define two infills called stone 
panel and glass panel, by default they are both controlled by the default infill 
display properties. However, you can add each definition as a new display 
component, and then control the display properties separately.

NOTE The component name in the Custom Display Component dialog box 
must match the name of element definition in the Design Rules tab. Otherwise 
the element definition does not display properly.

For more information about the display system, see “Display System” on 
page 435.

Materials and Display Properties
You can use materials to control the display of both default and custom 
infills, frames, and mullions. When you assign materials to the element def-
initions you create, you do not need to define these definitions as custom dis-
play components. For more information, see “Specifying the Materials of a 
Curtain Wall Style” on page 850.

Related Procedures

� Adding Curtain Wall Element Definitions as Display Components

� Specifying the Layer, Color, and Linetype of a Curtain Wall Style

� Specifying the Hatching for Components of a Curtain Wall Style

� Adding Custom Graphics as a Display Component of a Curtain Wall

� Creating Cut Planes for a Curtain Wall

Adding Curtain Wall Element Definitions as Display 
Components
Use this procedure to add curtain wall element definitions. Before you can 
control the display properties of curtain wall elements according to the defi-
nition assigned to the element, you must create display components for each 
element definition.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select the curtain wall style that you want to change, and click Edit.

4 Click the Display Properties tab. 

5 Select Model as the display representation.

6 Click .
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The default list of components includes only the three basic elements and 
cell markers.

Default Model display components for curtain walls

7 Click the Other tab, and then click Add.

8 Select Infill, Frame, or Mullion for Component Type.

9 Enter a name for Component Name, or click Select Element and select an 
element from the list.

10 Click OK.

11 Click the Layer/Color/Linetype tab.

The element definition that you added is displayed in the list of compo-
nents.

12 Click the Other tab to continue adding element definitions, or click OK 
three times.

Specifying the Layer, Color, and Linetype of a Curtain Wall 
Style
Use this procedure to change the following display properties of the compo-
nents of a curtain wall style: 

� Visibility (component is on or off)
� By Material
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Right-click the curtain wall style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear.

6 Click Style Override.
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7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK three times.

Specifying the Hatching for Components of a Curtain Wall 
Style
Use this procedure to specify the hatching of the components of a curtain 
wall style. Curtain wall hatching is displayed only in display representations, 
such as Plan, that are used in Top view (Plan view) of a drawing.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Right-click the curtain wall style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and click Style Override.

6 Click the Hatching tab.

7 Select a component, and click the setting for Pattern.

8 Specify the hatching for the component:

9 Click OK.

10 Click the setting for Scale/Spacing, and enter a value that determines how 
the selected pattern is repeated.

If you want to specify . . . Then . . .

a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

single hatching select User-defined for Type, and clear Double 
Hatch.

double hatching select User-defined for Type, and select 
Double Hatch.

solid fill select Solid Fill for Type.
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11 Click the setting for Angle, and enter the angle for the selected pattern.

12 Click the setting for Orientation, and specify how the hatching is ori-
ented:

13 Click OK three times.

Adding Custom Graphics as a Display Component of a Curtain 
Wall
There may be instances where an infill, frame, or mullion requires a custom 
two-dimensional (2D) or three-dimensional (3D) graphic. For example, you 
might need a highly detailed 3D truss as the mullions or a decorative light 
fixture applied to an infill. In cases like these, you can create a custom block, 
add a display component with the block attached, and associate that compo-
nent with an element definition. When you assign that definition to an ele-
ment, the block is also displayed.

1 Draw your custom component, and save it as a block.

2 Select a curtain wall, right-click and click Edit Curtain Wall Style. 

3 Click the Display Properties tab.

4 Click .

5 Click the Other tab.

6 Click Add.

7 Select Infill, Frame, or Mullion as the element type.

8 Select the specific element from the list.

9 Select Draw Custom Graphics.

10 Specify the display of the element:

If you want to orient the 
hatching . . .

Then . . .

to the object, regardless of the 
object rotation

select Object.

to the World Coordinate System select Global.

If you want to . . . Then . . .

display the block instead of the 
associated curtain wall element

select Replace Graphics.
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11 Click Select Block, and select the custom block that you created.

12 Click OK.

13 Specify further settings for the custom display block: 

14 Click OK three times.

Creating Cut Planes for a Curtain Wall
Use this procedure to specify the properties of one or more cut planes for a 
curtain wall style. Cut plane display properties apply only to display repre-
sentations, such as Plan, that are used in Top view (Plan view) of a drawing.

To better visualize the elements of a curtain wall in Plan view, you can create 
cut planes. The main cut plane is where the shrinkwrap and hatching are 
applied. The plan display shows the components and objects in the wall as 
they are displayed at the height of each cut plane.

1 Select a curtain wall, right-click, and click Edit Curtain Wall Style. 

2 Click the Display Properties tab.

3 Select Plan, and click .

superimpose the block over the 
curtain wall element so that both 
are displayed

clear Replace Graphics. 

If you want to . . . Then . . .

scale the block to fit a particular 
dimension

select Width, Height, or Depth. To prevent 
the block from losing its proportions, select 
Lock XY Ratio.

specify how the block is inserted 
into the grid in the X, Y, and Z 
directions

specify an insertion point on the X, Y, and Z 
planes.

mirror the block determine if it should mirror in the X, Y, or Z 
direction.

offset the block from the grid specify the offset in the X, Y, or Z direction.

If you want to . . . Then . . .
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NOTE The Cut Plane tab is displayed only in some display representations, 
such as Plan. 

4 Click the Cut Plane tab to set the cut plane to be displayed in each display 
representation for the curtain wall style.

5 Enter a value for Cut Plane Height to specify the cut plane at which hatch-
ing takes effect.

6 To specifically define a cut plane, click Add, and enter the height of the 
new cut plane.

Below and Above components

You can click Remove to delete a cut plane that you added.

7 Click OK twice.

Attaching Notes and Files to a Curtain Wall Style

Use this procedure to enter notes and attach reference files to a curtain wall 
style. You can also edit notes and edit or detach reference files from a curtain 
wall style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

If you add a cut plane . . . Then . . .

at a height that is lower than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Below Cut Plane component 
on the Layer/Color/Linetype tab.

at a height that is higher than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Above Cut Plane component 
on the Layer/Color/Linetype tab.
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3 Right-click the curtain wall style you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the curtain wall style, enter it for Description.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

Using Overrides in Curtain Walls

Curtain walls are geometrically complex objects that often have a large num-
ber of different elements, such as frames, panels, and window infills. The set-
tings for these elements are defined in the curtain wall style and can be mod-
ified using Style Manager. However, there are cases when modifying a curtain 
wall directly on screen is more suitable:

� You want to add custom frame or mullion edges to a curtain wall and need 
direct visual feedback. 

� You want to create an override, like a merged infill or an irregular panel 
shape in only one specific place in the curtain wall. 

� You want to experiment with different visuals without having to change 
the curtain wall style for each idea immediately.

When you have finished your onscreen edits, you have three choices:

� apply the overrides to the curtain wall you have edited.
� save the overrides to the current curtain wall style.
� create a new style for the overrides.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Overrides you can set include assigning a different definition to a selected 
cell, frame, or mullion, and assigning a profile to a frame or mullion edge. 
Note that the definition or profile must already exist in the current drawing 
before you can use it as an override. For example, if you want to override a 
cell that has a simple panel infill with an octagonal window infill, you must 
first define the window (octagonal) style as a valid infill in the curtain wall 
style. Similarly, if you want to override a frame or mullion edge assignment 
in the curtain wall, the curtain wall style must contain the edge profile as a 
frame or mullion definition.

NOTE You cannot modify a definition using the Override method. For infor-
mation about modifying definitions, see “Modifying Element Definitions for Cur-
tain Wall Styles” on page 878.

Overrides do not affect the Design Rules for the curtain wall style. However, 
you can transfer overrides to a curtain wall style if you want all curtain walls 
of that style to have the same overrides. 

You can view a list of overrides that are currently assigned to a curtain wall 
from the Overrides tab of the Curtain Wall Properties dialog box. For more 
information, see “Removing Curtain Wall Overrides” on page 878.

NOTE Overrides are also listed on the Overrides tab in the Curtain Wall Style 
Properties dialog box.

Related Topics

� Overriding Curtain Wall Infills

� Overriding Curtain Wall Frames and Mullions

� Overriding Curtain Wall Divisions

� Removing Curtain Wall Overrides

Overriding Curtain Wall Infills

The cell infills of a curtain wall are set in the curtain wall style. You can, how-
ever, create overrides for these infills in cells. For example, you might want a 
row of glider windows for a first floor facade. In one specific position, how-
ever, you want a frosted glass window. In this case, you would set the row of 
glider windows in the curtain wall style, and then override the infill style in 
one specific cell with a frosted glass window. 

Curtain wall infills can consist of simple panels, objects like windows or 
doors, or nested grids. You can change one infill for another, merge cells, or 
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remove the frame from an infill altogether. This would be useful if you add a 
door into a grid cell and want to remove the bottom frame from that cell.

Related Procedures

� Turning on Cell Markers

� Merging Curtain Wall Cells

� Creating a Curtain Wall Infill Override

Turning on Cell Markers
Use this procedure to turn on the cell markers for each grid cell in a curtain 
wall. The cell markers must be on in order to select individual cells and make 
changes to them.

Viewing Cell Markers

1 Select the curtain wall for which you want to create an infill override. 

2 Right-click, and click Infill ➤ Show Markers.

Merging Curtain Wall Cells
Use this procedure to merge two curtain wall cells. 

NOTE To merge curtain wall cells, the cell markers need to be visible. For infor-
mation on turning on cell markers, see “Turning on Cell Markers” on page 861.

You can only merge cells which are adjacent to each other.

In most cases you merge cells with the same infill type. The merged cell is 
then the same type as the original cells. For example, if you merge two solid 
panel infills, the resulting merged cell also has a solid panel infill. In some 
cases however, you might want to merge two cells that have different infill 
types. In that case, the infill type of the first selected cell is used for the 
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merged cell. For example, if you want to merge a cell with a simple panel 
infill and a cell with a window infill, and you select the cell with the simple 
panel first during the merge command, the merged cell contains a simple 
panel infill, not a window. If you select the two cells in the opposite order, 
the merged cell contains a window and no simple panel infill.

Merging two cells

1 Select the curtain wall on which you want to merge two cells.

2 Right-click, and click Infill ➤ Merge.

3 Select the first cell to be merged.

4 Select the second cell to be merged.

The cells are merged into one.

5 Specify where you want to save the curtain wall override:

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall

no further steps are necessary. The override is saved 
to the curtain wall. For information about how to 
remove an override from a curtain wall, see 
“Removing Curtain Wall Overrides” on page 878.
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6 If you have chosen to save the override to a curtain wall style, select the 
curtain wall again, right-click and click Design Rules ➤ Save to Style 
and decide to which curtain wall style you want to save the override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the curtain wall, where they can be removed as described in 
“Removing Curtain Wall Overrides” on page 878, but they are not saved back 
to a curtain wall style.

Creating a Curtain Wall Infill Override
Use this procedure to override the infill of a curtain wall cell.

to a curtain wall style select the curtain wall, right-click, and select Design 
Rules ➤ Transfer to Object.

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
style

select Transfer Merge Operations to Style, and 
click OK.

NOTE If you have created only a cell merge, 
only the Transfer Merge Operations to Style 
checkbox is active. If you have also created other 
overrides, such as a new cell assignment or a 
frame or mullion edge override, these 
checkboxes are available as well. If you also want 
to save these overrides to the style, select their 
checkboxes, too. 

to a new curtain wall style select Transfer Merge Operations to Style, and 
click New. Then, enter a name for the new 
curtain wall style, and click OK.

NOTE If you have created only a cell merge, 
only the Transfer Merge Operations to Style 
checkbox is active. If you have also created other 
overrides, such as a new cell assignment or a 
frame or mullion edge override, these 
checkboxes are available as well. If you also want 
to save these overrides to the style, select their 
checkboxes, too. 

If you want to save 
the override . . .

Then . . .
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For example, you might have a row of simple concrete panels in your curtain 
wall, but want in one location a round window instead of the concrete panel. 
In that case, it might be simpler to use an infill override, instead of creating 
complex curtain wall unit definitions. 

NOTE To override an infill assignment, the cell markers must be visible. For 
information on turning on cell markers, see “Turning on Cell Markers” on 
page 861.

To exchange an infill definition, the new infill definition must already be 
defined in the curtain wall style. For information on creating infill defini-
tions, see “Defining Infills for Curtain Wall Cells” on page 812.

1 Select the curtain wall on which you want to override an infill.

2 Right-click, and click Infill ➤ Override Assignment. 

3 Select the marker of the cell where you want to create an override, and 
press ENTER.

4 Create the override. 

If you want to . . . Then . . .

exchange the existing 
infill for another

select a new infill definition from the list.

remove one or more of 
the frames around the 
infill

select the frame component to be removed. You 
could, for example, override a cell to contain a door 
infill instead of a panel infill; in this case, you would 
want to remove the bottom frame of the cell.
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5 Click OK.

6 Specify where you want to save the curtain wall override.

7 If you have chosen to save the override to a curtain wall style, select the 
curtain wall again, right-click and click Design Rules ➤ Save to Style 
and decide to which curtain wall style you want to save the override. 

remove the complete 
infill and its frame

select Remove Infill and Frames.

NOTE This works only for infills that border the 
exterior of the curtain wall.

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall

no further steps are necessary. The override is saved 
to the curtain wall. For information about how to 
remove an override from a curtain wall, see 
“Removing Curtain Wall Overrides” on page 878.

to a curtain wall style select the curtain wall, right-click, and select Design 
Rules ➤ Transfer to Object. 

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
style

select Transfer Cell Overrides to Style, and click 
OK.

NOTE If you have created only an infill override, 
only the Transfer Cell Overrides to Style checkbox 
is active. If you have also created other overrides, 
such as a cell merge or a frame or mullion edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes, too. 

to a new curtain wall style select Transfer Cell Overrides to Style, and click 
New. Then, enter a name for the new curtain wall 
style, and click OK.

NOTE If you have created only an infill override, 
only the Transfer Cell Overrides to Style checkbox 
is active. If you have also created other overrides, 
such as a cell merge or a frame or mullion edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes, too.

If you want to . . . Then . . .
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NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
remain on the curtain wall, where they can be removed as described in 
“Removing Curtain Wall Overrides” on page 878, but they are not saved back 
to a curtain wall style.

Overriding Curtain Wall Frames and Mullions

You can change a selected frame edge or mullion edge by using an edge 
assignment override.

NOTE To exchange a frame edge or mullion edge, the new edge definition 
must already be defined in the curtain wall style.

Removing the edge does not affect the width of the cell. To remove the edge 
and have the adjacent cell resize, create an edge definition with a width and 
depth of zero. For more information, see “Defining a Curtain Wall Frame by 
Width and Depth” on page 820 or “Defining Curtain Wall Mullions by 
Width and Depth” on page 827.

You can also create a new edge profile by drawing a polyline or using an exist-
ing profile in the drawing. This edge profile can be interactively edited 
onscreen by in-place editing.

Related Procedures

� Creating a Frame or Mullion Override

� Creating a Frame or Mullion Edge from a Polyline or Profile using In-Place 
Editing

� In-Place Editing of Edge Profiles for Curtain Walls

Creating a Frame or Mullion Override
Use this procedure to override an individual frame or mullion.

To exchange a frame or mullion, the new definition must already be defined 
in the curtain wall style. For information on creating frames and mullions, 
see “Defining Curtain Wall Frames” on page 818 and “Defining Curtain Wall 
Mullions” on page 825.

1 Select the curtain wall on which you want to override an edge.

2 Right-click, and click Frame/Mullion ➤ Override Assignment. 

3 Select the frame or mullion edge you want to override.
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If you selected a frame edge, the Frame Assignment Override dialog box is 
displayed.

If you selected a mullion, the Mullion Assignment Override dialog box is 
displayed.

4 Create the override. 

5 Click OK.

6 Specify where you want to save the curtain wall override.

If you want to . . . Then . . .

exchange the existing 
edge for another

select a new edge definition from the list.

remove the frame or 
mullion edge

select Remove Edge.

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall

no further steps are necessary. The override is saved 
to the curtain wall. For information about how to 
remove an override from a curtain wall, see 
“Removing Curtain Wall Overrides” on page 878.

to a curtain wall style select the curtain wall, right-click, and select Design 
Rules ➤ Transfer to Object. 
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7 If you have chosen to save the override to a curtain wall style, select the 
curtain wall again, right-click and click Design Rules ➤ Save to Style 
and decide to which curtain wall style you want to save the override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
remain on the curtain wall, where they can be removed as described in 
“Removing Curtain Wall Overrides” on page 878, but they are not saved back 
to a curtain wall style.

Creating a Frame or Mullion Edge from a Polyline or Profile 
using In-Place Editing
Use this procedure to assign a profile to a vertical edge of a frame or mullion. 
The curtain wall edge profile can be any profile or any closed polyline that 
you specify. You can use a profile edge to create a unique corner in situations 
where a simple miter is not sufficient.

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
style

select Transfer Edge Overrides to Style, and click 
OK. 

NOTE If you have created only a frame or 
mullion edge override, only the Transfer Edge 
Overrides to Style checkbox is active. If you have 
also created other overrides, such as a cell merge 
or a division override, these checkboxes are 
available as well. If you also want to save these 
overrides to the style, select their checkboxes, 
too. 

to a new curtain wall style select Transfer Edge Overrides to Style, and click 
New. Then, enter a name for the new curtain wall 
style, and click OK.

NOTE If you have created only a frame or 
mullion edge override, only the Transfer Edge 
Overrides to Style checkbox is active. If you have 
also created other overrides, such as a cell merge 
or a division override, these checkboxes are 
available as well. If you also want to save these 
overrides to the style, select their checkboxes, 
too. 
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NOTE Adjacent infills are not trimmed or expanded to accommodate the new 
edge. To adjust the infill, change the width of the frame edge. For more infor-
mation, see “Defining a Curtain Wall Frame by Width and Depth” on page 820.

Overriding edge profile

1 Draw a closed polyline in the location where you want it to display in the 
curtain wall. 

NOTE For best results, it is recommended to draw the polyline in Plan view. 

2 Select the curtain wall for which you want to create a frame or mullion 
edge profile override.

3 Specify the mode in which to edit the curtain wall:

4 Right-click, and click Frame/Mullion ➤ Add Profile. 

5 Select a vertical frame or mullion edge.

If you want to edit . . . Then . . .

this instance of the curtain wall right-click, and click Design 
Rules ➤ Transfer to Object.

the curtain wall style right-click, and click Design 
Rules ➤ Revert to Style Design Rules.
If this option is not available, the 
design rules are already style-based for 
the curtain wall.
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6 Select a profile for the override. 

7 Select whether to apply the profile to the shared edge element definition 
or as an edge profile override.

8 Click OK.

You are now in in-place edit mode, and can edit the profile.

9 On the In-Place Edit toolbar, click  to zoom to the profile.

10 Select the profile and edit it using Edge and Vertex grips, or by using the 
right-click context menu.

11 Save or discard changes to the curtain wall grid:

If you want to create 
the edge profile . . .

Then . . .

from the polyline drawn in 
step 1

select Start from scratch for Profile Definition, and 
enter a name for New Profile Name.

from an existing profile in 
the drawing

select the existing profile for Profile Definition, 
and click Continue Editing.

If you want to exit the in-
place editing session . . .

Then . . .

without saving your changes

click  on the In-Place Edit 
toolbar.
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In-Place Editing of Edge Profiles for Curtain Walls
Use this procedure to edit profile edges using in-place editing.

With in-place editing, you can edit the profile directly and interactively on 
screen, and later save the changes to the profile definition.

1 Select a curtain wall that has the edge profile you want to edit onscreen 
with in-place editing. 

2 Right-click, and click Frame/Mullion ➤ Edit Profile In Place. 

This command is only available if you have profile-based edges in the cur-
tain wall.

NOTE If the profile is not drawn to size, it must be converted in order for 
you to begin the in-place editing session. Click Yes if prompted to convert the 
profile to its actual size.

3 Select the edge you want to edit. 

NOTE You have entered the in-place editing session now. You can see this 
from the magenta-colored grips and light blue hatch of the temporary in-
place editing profile, as well as the faded color of all other objects in the draw-
ing. Note that while you are in the in-place editing session, you have only lim-
ited editing access to other commands in the drawing. Before working on 
other objects, you should first end the in-place editing session.

4 Edit the profile: 

after saving your changes

click  on the In-Place Edit 
toolbar.

If you want to . . . Then . . .

use grips to edit the 
profile

move the grips as needed.

If you want to exit the in-
place editing session . . .

Then . . .
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5 Save the changes to the profile.

Overriding Curtain Wall Divisions

The grid of a curtain wall is made up of one or more divisions that define how 
the curtain wall is partitioned. Divisions can be horizontal or vertical, and 
can be nested in each other. For detailed information on curtain wall divi-
sions, see “Defining Divisions for Curtain Wall Grids” on page 799.

add a vertex to the 
profile

select the profile, right-click and click Add Vertex. 
Then, add new vertices as needed. End adding new 
vertices by pressing ENTER. 

remove a vertex from 
the profile

select the profile, right-click and click Remove Vertex. 
Then, remove vertices as needed. End removing 
vertices by pressing ENTER. 

add a ring to the profile select the profile, right-click and click Add Ring. Then, 
select a closed polyline, spline, ellipse, or circle for an 
additional ring. Specify if you want to erase the source 
linework, and press ENTER. 

remove a ring from a 
profile

select the profile, right-click and click Remove Ring. 
Then select the ring you want to remove.

NOTE You cannot remove the last ring from a profile. 

replace a ring on a 
profile

select the profile, right-click and click Replace Ring. 
Then, select a closed polyline, spline, ellipse, or circle 
for the replaced ring. Specify if you want to erase the 
source linework, and press ENTER. 

If you want to . . . Then . . .

change the existing profile 
definition to reflect the 
new shape

select the profile, right-click, and click Save. The in-
place edit session is exited and the profile definition 
is updated.

create a new profile 
definition with the shape 
you have created

select the profile, right-click, and click Save As New 
Profile. Then, enter a name for the new profile and 
click OK. The in-place edit session is exited and the 
new profile definition is available in the Style 
Manager.

discard all changes on the 
profile and revert back to 
the previous shape

select the profile, right-click, and click Discard all 
Changes. The in-place edit session is exited and all 
changes you have made to the profile are purged.

If you want to . . . Then . . .
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You can override a division in a curtain wall, thereby changing the grid of the 
curtain wall.

Related Topics

� Creating a Division Override

� In-Place Editing of Curtain Wall Divisions

Creating a Division Override
Use this procedure to create a division override on a curtain wall.

NOTE To exchange a curtain wall division, the new division definition must 
already be defined in the curtain wall style. For information on curtain wall divi-
sions, see “Defining Divisions for Curtain Wall Grids” on page 799. 

1 Select the curtain wall for which you want to create a division override.

2 Right-click, and click Division ➤ Override Assignment.

3 Select an edge of the curtain wall to determine if a horizontal or vertical 
division is overridden. 

For example, if you want to override the primary horizontal division, you 
could select the bottom horizontal frame of the curtain wall.

TIP The Division Assignment Override dialog box shows you which grid 
type and which grid division you have selected, e.g. Selected Nested Grid: 
Secondary Grid, Division Element Definition: Vertical 3 Cells. If you have acci-
dentally selected the wrong division, click Cancel and reselect the correct 
grid.

4  Select the appropriate division override, and click OK.
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5 Specify where you want to save the curtain wall override:

6 If you have chosen to save the override to a curtain wall style, select the 
curtain wall again, right-click and click Design Rules ➤ Save to Style 
and decide to which curtain wall style you want to save the override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
remain on the curtain wall, where they can be removed as described in 

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall

no further steps are necessary. The override is saved 
to the curtain wall. For information about how to 
remove an override from a curtain wall, see 
“Removing Curtain Wall Overrides” on page 878.

to a curtain wall style select the curtain wall, right-click, and select Design 
Rules ➤ Transfer to Object. 

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
style

select Transfer Division Overrides to Style, and 
click OK. 

NOTE If you have created only a profile edge 
override, only the Transfer Division Overrides to 
Style checkbox is active. If you have also created 
other overrides, such as a cell merge or a edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes, too. 

to a new curtain wall style select Transfer Division Overrides to Style, and 
click New. Then, enter a name for the new 
curtain wall style, and click OK.

NOTE If you have created only a profile edge 
override, only the Transfer Division Overrides to 
Style checkbox is active. If you have also created 
other overrides, such as a cell merge or a edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes, too. 
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“Removing Curtain Wall Overrides” on page 878, but they are not saved back 
to a curtain wall style.

In-Place Editing of Curtain Wall Divisions 
Use this procedure to edit divisions using in-place editing.

With in-place editing, you can edit the curtain wall directly and interactively 
on screen, and later save the changes to the curtain wall or curtain wall style.

1 Select a curtain wall on which you want to edit divisions onscreen with 
in-place editing. 

2 Specify the mode in which to edit the curtain wall:

3 Click the Edit Grid grip.

4 Select an edge on the division you want to edit. 

For example, if you want to edit the primary grid, select an edge on the 
outer curtain wall frame. 

Viewing edit in-place grips for a primary division

If you want to edit . . . Then . . .

this instance of the curtain wall right-click, and click Design 
Rules ➤ Transfer to Object.

the curtain wall style right-click, and click Design 
Rules ➤ Revert to Style Design Rules.
If this option is not available, the 
design rules are already style-based for 
the curtain wall.
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NOTE You have entered the in-place editing session now. You can see this 
from the faded color of all objects in the drawing, as well as from the different 
grips at your disposal. Note that while you are in the in-place editing session, 
you have only limited editing access to other commands in the drawing. 
Before working on other objects, you should first end the in-place editing ses-
sion.

Viewing edit in-place grips for adding and removing bays

5 Edit the division: 

If you want to . . . Then . . .

add a bay to the grid click the Add Bay grip.

remove a bay from the 
grid

click the Remove Bay grip.

change the start offset 
of the grid

select the Start Offset grip and move it to the 
appropriate position.

change the end offset of 
the grid

select the End Offset grip and move it to the 
appropriate position.

change the spacing of 
bays

click the Auto Grid Bay Spacing grip and move it to 
the appropriate position.

manually edit the grid right-click and click Convert To Manual.
You can manually add and remove gridlines, change 
the offsets, and change the position of individual 
gridlines.
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6 Save or discard changes to the curtain wall grid:

7 In the Save Changes dialog box, specify to which division to save the 
changes:

use a worksheet to edit 
the cell dimensions

click the Set Fixed Cell Dimension Rules command 
grip, and edit the values in the worksheet.

If you want to exit the in-
place editing session . . .

Then . . .

without saving your changes

click  on the In-Place Edit 
toolbar.

after saving your changes

click  on the In-Place Edit 
toolbar.
If you edited the grid by instance, the 
changes are saved to the design rules 
for the individual grid. If you edited the 
curtain wall style, the Save Changes 
dialog box is displayed.

If you want to . . . Then . . .

save the changes to the style in the 
current curtain wall division

verify the current division is selected 
for Save Changes to Existing Division, 
and click Save.
The changes are made in the style and 
affect all curtain walls of that style in 
the drawing.

create an override to the style by 
saving the changes in a new curtain 
wall division

click New, enter a name for the new 
division override, and click OK. Click 
Save.
The changes are saved as an override 
to the style, and affect only the curtain 
walls to which the override is applied.

If you want to . . . Then . . .
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Removing Curtain Wall Overrides

Use this procedure to remove curtain wall overrides either from the curtain 
wall or the curtain wall style.

1 Select the curtain wall.

2 Select an override from the list and click Remove.

3 Click OK.

Modifying Element Definitions for Curtain 
Wall Styles

Use this procedure to modify existing elements in a curtain wall style. A cur-
tain wall consists of division, infill, frame and mullion elements, all of which 
are defined in the design rules of the curtain wall style. 

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Right-click the curtain wall style that you want to change, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, click Element Definitions.

The list of element types is displayed. 

If you want to 
remove an 
override . . .

Then . . .

from a curtain wall select the curtain wall, expand Advanced in the 
Properties palette, and click Overrides.

from the curtain wall style select the curtain wall, right-click and click Edit 
Curtain Wall Style, and then click the Overrides tab.
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Element definitions list

6 Decide the type of elements you want to edit: 

7 Click OK twice.

If you want to 
modify . . .

Then . . .

a division definition click Divisions under Element Definitions. In the right 
pane, select the division definition you want to modify 
and edit it as described in “Defining Divisions for 
Curtain Wall Grids” on page 799.

an infill definition click Infills under Element Definitions. In the right 
pane, select the infill definition you want to modify 
and edit it as described in “Defining Infills for Curtain 
Wall Cells” on page 812.

a frame definition click Frames under Element Definitions. In the right 
pane, select the frame definition you want to modify 
and edit it as described in “Defining Curtain Wall 
Frames” on page 818.

a mullion definition click Mullions under Element Definitions. In the right 
pane, select the mullion definition you want to modify 
and edit it as described in “Defining Curtain Wall 
Mullions” on page 825.



880 | Chapter 14 Curtain Walls

Editing Curtain Walls

Most relevant settings for a curtain wall are defined in the curtain wall style. 
These include divisions, infills, frames, and mullions. For information on 
modifying a curtain wall style, see “Curtain Wall Styles” on page 793.

You can make other changes directly to individual curtain walls. These 
changes affect only the curtain wall you select:

� Dimensions of a curtain wall
� roof and floor line settings
� Interference conditions
� Cleanup settings

Methods of Editing Curtain Walls
Autodesk Architectural Desktop offers several methods for editing curtain 
walls:

� You can directly edit curtain walls using grips for dimensions and other 
physical characteristics.

� You can change curtain wall settings on the Properties palette.
� You can select editing commands from the context menu for a selected 

curtain wall.

Related Procedures

� Using Grips to Edit Curtain Walls

� Changing the Base Height of a Curtain Wall

� Changing the Length of a Curtain Wall

� Changing the Radius of a Curtain Wall

� Selecting a Different Curtain Wall Style

� Matching the Properties of an Existing Curtain Wall

� Changing the Dimensions of a Curtain Wall 

� Reversing the Direction of a Curtain Wall

� Changing the Roof Line and the Floor Line of a Curtain Wall

� Changing the Curtain Wall Location Properties

� Adding an Interference Condition to a Curtain Wall

� Removing an Interference Condition from a Curtain Wall

� Mitering Curtain Walls

� Specifying a Miter Angle for a Curtain Wall Unit Adjacent to Another 
Object

� Attaching Hyperlinks, Notes, or Files to a Curtain Wall 
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Using Grips to Edit Curtain Walls

Refer to the illustrations and steps in this topic to use curtain wall grips to 
edit curtain walls.

Editing Curtain Wall Dimensions

1 Select the curtain wall.

2 Select the grip for the dimension you want to change.

You can modify the dimensions of the base height, length, roof line, and 
floor line for a curtain wall.

Veiwing Curtain Wall Lengthen and Base Height grips

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Changing the Location or Position of a Curtain Wall

1 Select the curtain wall.
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2 Move the appropriate grip to change the location of the curtain wall, its 
start point, or its endpoint.

Viewing Curtain Wall Start, End, Location, and Reverse Direction Grips

Changing the Base Height of a Curtain Wall

Use this procedure to change the base height of a curtain wall. You can also 
change the base height on the Properties palette.

1 Select the curtain wall.

2 Select the Base Height grip, move the grip until the height value you want 
is displayed, and click once.

NOTE As you move the grip, the original base height value is displayed in 
addition to the new base height and the difference between the two values.
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After selecting the grip, you can also enter a new value for the base height 
of the curtain wall.

Changing the Length of a Curtain Wall

Use this procedure to change the length of a curtain wall. You can also 
change the length on the Properties palette. For more information, see 
“Changing the Dimensions of a Curtain Wall” on page 886.

1 Select the curtain wall.

2 Select the Lengthen grip, move the grip until the length value you want is 
displayed, and click once.

NOTE As you move the grip, the original length value is displayed in addi-
tion to the new length and the difference between the two values.
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After selecting the grip, you can also enter a new value for the length of 
the curtain wall.

Changing the Radius of a Curtain Wall

Use this procedure to change the radius of a curved curtain wall. You can also 
change the radius on the Properties palette. For more information, see 
“Changing the Dimensions of a Curtain Wall” on page 886.

1 Select the curtain wall.

2 Select the Curve Radius grip, move the grip until the radius value you 
want is displayed, and click once.

NOTE As you move the grip, the original radius value is displayed in addi-
tion to the new radius and the difference between the two values.

After selecting the grip, you can also enter a new value for the radius of 
the curtain wall.
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Selecting a Different Curtain Wall Style

Use this procedure to select a different style for the curtain wall.

1 Select the curtain wall for which you want to change the style.

You can select multiple curtain walls and change the style for all at the 
same time.

2 On the Properties Palette, scroll to the General subcategory.

3 Select a different style.

Matching the Properties of an Existing Curtain 
Wall

Use this procedure to apply the properties of a curtain wall tool to one or 
more existing curtain walls. The properties include the curtain wall style and 
any other settings specified in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a curtain wall tool, and click Apply Tool Properties 
to ➤ Curtain Wall.

3 Select the curtain wall(s), and press ENTER.
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The properties of the selected curtain wall(s) match the properties of the 
curtain wall tool.

Changing the Dimensions of a Curtain Wall

Use this procedure to change the dimensions of a curtain wall.

1 Double-click a curtain wall.

2 Expand Dimensions.

3 Change the  dimension:

Reversing the Direction of a Curtain Wall

Use this procedure to change the direction in which a curtain wall is drawn 
by reversing the start point and the end point of the curtain wall. 

Curtain walls are drawn from the first specified point to the last point. Some 
commands and properties are affected by that order. 

To determine the direction in which a curtain wall was drawn, select the cur-
tain wall. The Reverse Direction grip point points in the direction in which 
the curtain wall has been drawn.

1 Select the curtain wall for which you want to reverse the direction.

2 Click on the Reverse Direction grip, which is shaped like an arrow.

The direction of the wall is reversed, which switches the Start and End 
grips.

Dimension Description

Base Height Height of the curtain wall from the baseline 

Length Length of a straight curtain wall from the start grip on 
the baseline to the end grip

Radius (curved 
curtain walls only)

Radius of a curved curtain wall from the start grip on the 
baseline to the end grip

Start Miter Angle of all infills and horizontal edges (frame or 
mullion) at the start of the curtain wall: for more 
information about miter angles, see “Mitering Curtain 
Walls” on page 889

End Miter Angle of all infills and horizontal edges (frame or 
mullion) at the end of the curtain wall
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Changing the Curtain Wall Location Properties

Use this procedure to relocate a curtain wall by changing the coordinate val-
ues of its insertion point. The curtain wall also has an orientation with 
respect to the WCS or the current UCS. For example, if the top and bottom 
of the curtain wall are parallel to the XY plane, its normal is parallel to the Z 
axis. You can change the orientation of the curtain wall by aligning its nor-
mal with another axis. You can also rotate the curtain wall on its plane by 
changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Double-click the curtain wall you want to change.

2 Expand Location.

3 Click Additional information.

4 Specify the location of the curtain wall:

5 Click OK.

Adding an Interference Condition to a Curtain 
Wall

Use this procedure to add an interference condition to a curtain wall. Inter-
ference conditions use the geometry of 3D objects to create custom openings 

If you want to . . . Then . . .

relocate the curtain wall enter new coordinate values under Insertion Point.

locate the curtain wall on 
the XY plane

make the normal of the wall parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the curtain wall on 
the YZ plane

make the normal of the curtain wall parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the curtain wall on 
the XZ plane

make the normal of the curtain wall parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
curtain wall

enter a new value for Rotation Angle.
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or cutouts in curtain walls. You can specify how the interference condition is 
applied to the curtain wall: added to the curtain wall, subtracted from the 
curtain wall, or ignored.

You can specify whether the interference condition applies to an infill, 
frame, or mullions of a curtain wall.

1 Place the object in the location where you want to specify the interference 
condition.

2 Select the curtain wall to which you want to add an interference condi-
tion, right-click, and click Interference ➤ Add.

3 Select the object intersecting the curtain wall, and press ENTER.

4 Specify to which curtain wall component the interference should be 
added:

5 Press ENTER.

Removing an Interference Condition from a 
Curtain Wall

Use this procedure to remove an object, such as a mass element, from a cur-
tain wall that the object was added to as an interference condition. 

1 Select the curtain wall from which you want to remove an interference 
object, right-click, and click Interference ➤ Remove.

2 Select the object intersecting the curtain wall, and press ENTER.

If you want to add 
the interference 
condition . . .

Then . . .

to the infill enter y (Yes) when prompted for the infill 
component.

to the frame enter y (Yes) when prompted for the frame 
component.

to the mullion enter y (Yes) when prompted for the mullion 
component.
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Mitering Curtain Walls

Use this procedure to miter the corners where curtain walls meet. The corner 
where adjacent curtain walls meet is not mitered by default. However, you 
can determine the necessary angles automatically.

The miter angle applies to all infills and horizontal edges (frame or mullion) 
that are adjacent to the corner. Vertical edges are not affected.

TIP If you want to create a custom corner condition between two curtain walls, 
you can replace the edge of one curtain wall with an AEC profile and remove the 
edge of the other curtain wall by using the frame override Remove Edge option. 
For more information, see “Overriding Curtain Wall Frames and Mullions” on 
page 866 and “Defining Curtain Wall Frames” on page 818. 

1 Select one of the curtain walls, right-click, and click Set Miter Angles.

2 Select the other curtain wall.

If you change the angle of either curtain wall, use Set Miter Angles again 
to recalculate the angles.

Specifying a Miter Angle for a Curtain Wall 
Adjacent to Another Object

Use this procedure to manually create a mitered corner between a curtain 
wall and another object, such as a standard wall or a mass element. For exam-
ple, if your curtain wall connects with a standard wall that is at a 60-degree 
angle from the curtain wall, you would set the miter angle to 30.

The miter angle applies to all infills and horizontal edges that are adjacent to 
the corner. Vertical edges are not affected.

TIP To quickly identify the start and end of a curtain wall, select the curtain 
wall. The Reverse Direction grip points toward the end of the curtain wall.



890 | Chapter 14 Curtain Walls

Frame miter angles for a curtain wall

1 Double-click the curtain wall.

2 Expand Dimensions.

3 Miter the curtain wall on the start or the end point:

Attaching Hyperlinks, Notes, or Files to a 
Curtain Wall

Use this procedure to enter notes and attach reference files to a curtain wall. 
You can also edit notes and edit or detach reference files from a curtain wall.

1 Double-click the curtain wall.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add a note, click the setting for Notes, and enter the text.

5 Click OK.

If you want to miter 
the curtain wall . . .

Then . . .

at its start point enter an angle for Start Miter, and press 
ENTER.

at its end point enter an angle for End Miter, and press ENTER.
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6 To attach a reference file, click under Reference documents, and attach, 
edit, or detach a reference file:

7 Click OK twice.

Changing the Roof Line and the Floor Line of 
a Curtain Wall

You can modify the roof and floor lines of a curtain wall to create a non-rect-
angular curtain wall:

� You edit vertex locations on the roof line to create steps, gables, and other 
roof conditions.
Modifying the roof line of a curtain wall

� You edit vertex locations on the floor lines to create steps and other floor 
conditions. 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click the description. Enter the 
new text, and press ENTER.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Modifying the floor line of a curtain wall

You can also create non-rectangular roof and floor conditions by projecting 
to polylines.

Autodesk Architectural Desktop offers multiple methods of editing roof lines 
and floor lines. You may want to begin by graphically creating a custom roof 
line or floor line condition. You can then fine-tune that condition by speci-
fying precise values in the Roof/Floor Line worksheet on the Properties pal-
ette.

Related Procedures

� Offsetting or Projecting the Roof Line of a Curtain Wall

� Offsetting or Projecting the Floor Line of a Curtain Wall

� Adding a Gable to the Roof Line of a Curtain Wall

� Adding a Step to the Roof Line or Floor Line of a Curtain Wall

� Changing Vertices in the Roof Line or Floor Line of a Curtain Wall

� Changing Vertices in the Roof Line or Floor Line of a Curtain Wall

� Specifying Gable Settings for a Roof Line

� Specifying Step Settings for a Roof Line or Floor Line

� Specifying Vertex Settings for a Roof Line or Floor Line

Offsetting or Projecting the Roof Line of a 
Curtain Wall

Use this procedure to change the height or the shape of the roof line of a cur-
tain wall:

� Offset the roof line from the current height of the curtain wall.
� Project the roof line of the curtain wall to a polyline.
� Project the roof line of the curtain wall to another object, such as a roof 

or stairs.



Changing the Roof Line and the Floor Line of a Curtain Wall | 893

You can also create a polyline that represents the current roof line of the 
selected curtain wall. You can then use this polyline to change the roof line 
of other curtain walls.

NOTE To project the roof line to a polyline, draw the polyline first in Elevation 
view. For best results, the polyline should be parallel to the curtain wall. The 
polyline does not need to be in the same plane as the curtain wall.

1 Select a curtain wall, right-click, and click Roof Line / Floor 
Line ➤ Modify Roof Line.

The current roof line is the default value in the curtain wall style.

2 Change the roof line of the wall:

3 Press ENTER.

The new roof line value is used only on the selected curtain walls. The cur-
tain wall style is unchanged.

If you want to . . . Then . . .

offset the roof line from the 
current height of the curtain 
wall

enter o (Offset), select the curtain walls to 
change, and enter an offset distance. Enter a 
negative value to project the roof line below 
the current curtain wall height.

project the roof line to a 
polyline

enter p (Project), select the curtain walls to 
change, and select the polyline.

generate a polyline of the 
current roof line

enter g (Generate), and select the curtain walls 
for the polyline to be created from.

project the roof line to another 
object, such as a roof or stairs

enter a (Auto-project), select the curtain walls 
to change, and select the object to project to.
When projecting to stairs, make sure that the 
bottom riser or the stringer does not create a 
zero-height segment of curtain wall.

remove any changes to the roof 
line

enter r (Reset), and select the curtain walls to 
change.
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Offsetting or Projecting the Floor Line of a 
Curtain Wall

Use this procedure to change the height or the shape of the floor line of a  
curtain wall:

� Offset the floor line from the current baseline of the curtain wall.
� Project the floor line of the curtain wall to a polyline.
� Project the floor line of the curtain wall to another object, such as a floor 

slab or stairs.

You can also create a polyline that represents the current floor line of the 
selected curtain walls. You can then use this polyline to change the floor line 
of other curtain walls.

NOTE To project the floor line to a polyline, draw the polyline first in Elevation 
view. For best results, the polyline should be parallel to the curtain wall. The 
polyline does not need to be in the same plane as the curtain wall.

1 Select a curtain wall, right-click, and click Roof Line / Floor 
Line ➤ Modify Floor Line.

The current floor line is the default value in the curtain wall style.

2 Change the floor line of the curtain wall:

If you want to . . . Then . . .

offset the floor line from the 
current baseline of the curtain 
wall

enter o (Offset), select the curtain walls to 
change, and enter an offset distance. Enter a 
negative value to offset the floor line below 
the current baseline.

project the floor line to a 
polyline

enter p (Project), select the curtain walls to 
change, and select the polyline.

generate a polyline of the 
current floor line

enter g (Generate), and select the curtain walls 
for the polyline to be created from.

project the floor line to another 
object, such as a floor slab or 
stairs

enter a (Auto-project), select the curtain walls 
to change, and select the object to project to.

remove any changes to the floor 
line

enter r (Reset), and select the curtain walls to 
change.
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3 Press ENTER.

The new floor line value is used only in the selected curtain wall. The cur-
tain wall style is unchanged.

Editing the Roof Line or the Floor Line of a 
Curtain Wall

Use this procedure to edit the geometry of the roof line or the floor line of a 
curtain wall:

� Add, modify, or remove gables.
� Add, modify, or remove steps.
� Project the roof line or the floor line to a polyline or to other objects, such 

as roofs, roof slabs, slabs, and stairs.
� Create custom roof line or floor line conditions by adding and adjusting 

vertices and edges.
� Reverse the roof line or the floor line of the curtain wall without reversing 

the curtain wall itself.
� Remove all changes to the roof line or the floor line of a curtain wall.

You can also edit the roof line and the floor line on the Roof/Floor Line work-
sheet on the Properties palette. For more information, see “Changing Verti-
ces in the Roof Line or Floor Line of a Curtain Wall” on page 900.

NOTE If you want to project the roof line or the floor line to a polyline, draw 
the polyline before you start this procedure. 

1 Select the curtain wall that has the roof line or floor line you want to 
change, right-click, and click Roof/Floor Line ➤ Edit in Place.

A temporary profile is created for you to edit the geometry of the roof line 
or the floor line.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the menu, select the profile, 
and right-click to display the shortcut menu.
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2 Edit the profile:

NOTE To add a gable or a step to a roof line or a floor line that has been 
edited, first use the Remove option on the shortcut menu to remove an exist-
ing roof line or floor line condition.

If you want to . . . Then . . .

add a gable to the roof line or 
the floor line

select the profile, right-click, and click Add 
Gable. Select the roof line or the floor line.

add a step to the roof line or the 
floor line

select the profile, right-click, and click Add 
Step. Select the roof line or the floor line.

change the shape of the roof 
line or the floor line

select the profile, and use Vertex and Edge 
grips to adjust the shape.

add vertices to the roof line or 
the floor line

select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the roof 
line or the floor line

select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

project the roof line or the floor 
line to a polyline

select the profile, right-click, and click Project. 
Select the roof line or the floor line, and select 
the polyline. Press ENTER to keep the 
geometry, or enter n (No) to erase it.

project the roof line or the floor 
line to another object, such as a 
stair or a roof

select the profile, right-click, and click Auto 
Project. Select the roof line or the floor line, 
and select the object. 

reverse the roof line or the floor 
line

select the profile, right-click, and click Reverse. 
Select the roof line or the floor line.

restore the roof line to the base 
height of the curtain wall, or 
restore the floor line to the 
baseline of the curtain wall

select the profile, right-click, and click 
Remove. Select the roof line or the floor line.
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3 Save or discard the changes:

Changing the Roof Line and the Floor Line

Use this procedure to change the height or the shape of the roof line and the 
floor line using grips. 

1 Select a curtain wall.

2 Select a Roof Line End or Floor Line End grip, move the grip to the appro-
priate position, and click once. 

Adding a Gable to the Roof Line of a Curtain Wall

Use this procedure to add a gable to the roof line of a curtain wall. You can 
also add a gable on the Roof/Floor Line worksheet on the Properties palette. 
For more information, see “Specifying Gable Settings for a Roof Line” on 
page 901.

NOTE This option is available only if the roof line has not been edited. After 
the roof line changes, you cannot add a gable using this option. To add a gable 
to a roof line that has been edited, see “Changing Vertices in the Roof Line or 
Floor Line of a Curtain Wall” on page 900.

1 Select the curtain wall, right-click, and click Roof/Floor Line ➤ Edit in 
Place.

A temporary profile is created for you to edit the geometry of the Roof 
line.

2 Right-click, and click Add Gable.

If Add Gable is not listed on the menu, the roof line was previously edited.

If you want to . . . Then . . .

restore the roof line and the 
floor line to their shape before 
editing select the profile, and click .

save the changes

select the profile, and click .
The curtain wall uses the edited profile to 
define its geometry. 
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3 Select the roof line.

Modifying a curtain wall roof line by adding a gable

A third vertex is added to the roof line halfway between the two ends of 
the roof line.

4 Continue editing the roof line or the floor line, if needed.

For more information, see “Changing the Roof Line and the Floor Line” 
on page 897.

5 Save or discard the changes:

If you want to . . . Then . . .

restore the roof line to its 
previous shape

select the profile, and click .

save the changes to the roof line

select the profile, and click .
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Adding a Step to the Roof Line or Floor Line of a 
Curtain Wall

Use this procedure to add a step to the roof line or the floor line of a curtain 
wall. You can also add a step on the Roof/Floor Line worksheet on the Prop-
erties palette. For more information, see “Specifying Step Settings for a Roof 
Line or Floor Line” on page 903.

NOTE This option is available only when the roof line or the floor line has not 
been edited. After the line has been changed, you cannot automatically add a 
step using this option. To add a step to a roof line or a floor line that has been 
edited, see “Changing Vertices in the Roof Line or Floor Line of a Curtain Wall” 
on page 900.

1 Select the curtain wall, right-click, and click Roof/Floor Line ➤ Edit in 
Place.

A temporary profile is created for you to edit the geometry of the roof line 
or the floor line.

2 Right-click, and click Add Step.

If Add Step is not listed on the menu, the roof line or the floor line was 
previously edited.

3 Select the roof line or the floor line.

Modifying a curtain wall floor line by adding a step
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A third vertex is added to the line halfway between the two ends of the 
line and four feet from the line. A step is created from the selected vertex 
to the second vertex.

4 Continue editing the roof line or the floor line, if needed.

For more information, see “Changing the Roof Line and the Floor Line” 
on page 897.

5 Save or discard the changes:

Changing Vertices in the Roof Line or Floor Line 
of a Curtain Wall

Use this procedure to perform the following tasks:

� Add, move, or remove vertices and edges in the roof line or the floor line 
of a curtain wall.

� Add gables or steps to a roof line or steps to a floor line that was previously 
edited by adding vertices that define these conditions.

� Remove all changes to the roof line or the floor line, restoring the original 
base height or baseline of a curtain wall.

NOTE You can also edit vertices in a curtain wall with the curtain wall work-
sheets. For information, see “Specifying Vertex Settings for a Roof Line or Floor 
Line” on page 904.

1 Select the curtain wall in which you want to edit vertices, right-click, and 
click Roof Line/Floor Line ➤ Edit in Place. 

A temporary profile is created for you to edit the geometry of the roof line 
or the floor line.

If you want to . . . Then . . .

restore the roof line or the floor 
line to its previous shape

select the profile, and click .

save the changes to the roof line 
or the floor line

select the profile, and click .
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2 Edit the vertices: 

3 Save the changes to the curtain wall:

Specifying Gable Settings for a Roof Line

Use this procedure to add a gable to the roof line of a curtain wall by adding 
a vertex to the roofline.

If you want to . . . Then . . .

change the position of a 
vertex or an edge

select its grip and move it to the appropriate 
position.

add a vertex select the profile, right-click, and click Add Vertex. 
Specify new vertices in the drawing. When you 
are finished adding vertices, press ENTER. 

remove a vertex select the profile, right-click, and click Remove 
Vertex. Select the vertices you want to remove. 
Press ENTER. 

restore the original roof 
line or floor line

select the profile, right-click, and click Remove. 
Select the roof line or the floor line.

If you want to . . . Then . . .

save the changes to the 
current curtain wall

select the profile, right-click, and click Save All 
Changes.

discard all changes on the 
curtain wall and revert 
back to the previous shape

select the profile, right-click, and click Discard all 
Changes. Changes you made to the roof line or 
floor line of the curtain wall are discarded.
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Modifying a curtain wall roof line by adding a gable

NOTE This option is available only if the roof line has not been edited. After 
the roof line changes, you cannot add a gable using this option. To add a gable 
to a roof line that has been edited, see “Changing Vertices in the Roof Line or 
Floor Line of a Curtain Wall” on page 900.

1 Double-click the curtain wall.

2 Expand Advanced.

3 Click Roof/floor line.

4 Select Edit Roof Line or Edit Floor Line.

5 Click Add Gable.

A third vertex is added to the roof line halfway between the two ends of 
the roof line.

The table at the top of the dialog box displays information about each ver-
tex in the curtain wall. You can also select the vertex to edit from the list.
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6 Click OK.

Specifying Step Settings for a Roof Line or Floor 
Line

Use this procedure to add a step to the roof line or the floor line of a curtain 
wall.

Modifying a curtain wall roof line by adding a gable
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NOTE This option is available only when the roof line or the floor line has not 
been edited. After the line has been changed, you cannot automatically add a 
step using this option. To add a step to a roof line or a floor line that has been 
edited, see “Changing Vertices in the Roof Line or Floor Line of a Curtain Wall” 
on page 900

1 Double-click the curtain wall.

2 Expand Advanced.

3 Click Roof/floor line.

4 Select Edit Roof Line or Edit Floor Line.

5 Click Add Step.

A third vertex is added to the line halfway between the two ends of the 
line. A step is created from the selected vertex to the second vertex.

The table at the top displays information about each vertex in the curtain 
wall. You can select a vertex to edit from the list.

6 Click OK.

Specifying Vertex Settings for a Roof Line or 
Floor Line

Use this procedure to perform the following tasks:

� Add, move, or remove vertices in the roof line or the floor line of a curtain 
wall.
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� Add gables or steps to a roof line or steps to a floor line that was previously 
edited by adding vertices that define these conditions.

1 Double-click the curtain wall.

2 Expand Advanced.

3 Click Roof/floor line.

4 Select Edit Roof Line or Edit Floor Line.

The active vertex in the illustration changes when you select a different 
line to edit. Any changes you make to the wall are reflected in the illustra-
tion.

5 Specify vertex settings:

6 Specify the horizontal offset.

The horizontal offset specifies the existing vertex from which to measure 
the placement of the next vertex and how far away from the existing ver-
tex to place the new one. Distance is measured in the direction the curtain 
wall is drawn. You can enter a negative number to offset the vertex in the 
reverse direction.

7 Specify the vertical offset.

The vertical offset specifies the location from which to measure the height 
of the next vertex and how far away from the existing location to place 
the new vertex. You can enter a negative number to offset the vertex 
toward the ground.

8 Click OK twice.

If you want to . . . Then . . .

add a vertex click Insert Vertex.
In the Wall Roof/Floor Line Vertex dialog box, specify 
the horizontal offset and vertical offset for the new 
vertex, specify a distance, and click OK.

move a vertex select a vertex from the list, and then click Edit 
Vertex.

delete a vertex select a vertex from the list, and then click Delete 
Vertex.
The selected vertex is deleted, and the line 
automatically connects the two adjacent vertices.
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Editing Objects Anchored in Curtain Walls

When you fill a curtain wall cell with an infill that contains an object, such 
as a door or window, you can edit that object independently from the curtain 
wall. For example, you can select a door from a curtain wall and edit its prop-
erties. You can edit the anchor settings for the door to change the orientation 
of the door and the alignment or offset of the door in relation to the curtain 
wall. 

You can also move objects from one cell to another or release the object 
anchor so that the object moves independently of the curtain wall.

When you move or release an object or edit its properties, you are creating a 
variation from the infill cell assignment for the curtain wall style. By default, 
these variations (except release) are allowed to persist in the drawing when 
you reapply the style to a curtain wall. However, if you want these variations 
to be overridden when you reapply a curtain wall style, turn off the Allow 
Variation from Infill Element Definition option on the Anchor worksheet of 
the Properties palette of the object. This option is set on a per object basis.

Related Procedures

� Changing the Orientation of an Object Anchored in a Curtain Wall

� Changing the Alignment of an Object Anchored in a Curtain Wall

� Changing the Offset of an Object Anchored in a Curtain Wall

� Swapping Two Objects Anchored in a Curtain Wall

� Releasing an Object Anchored in a Curtain Wall

Changing the Orientation of an Object Anchored 
in a Curtain Wall

Use this procedure to change the orientation of an object anchored in a cur-
tain wall using grips.

1 Click the object in the curtain wall for which you want to change the ori-
entation.

2 Click the appropriate Flip grip to change the X or Y direction of the object. 

You can also change the orientation of an object, including the Z direc-
tion, using the Anchor worksheet found on the object’s Properties palette.
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Changing the Alignment of an Object Anchored 
in a Curtain Wall

Use this procedure to modify the alignment of an object that is anchored in 
a curtain wall. 

1 Double-click the object in the curtain wall.

2 Expand Location, and click Anchor.

3  Click Allow Variation from Infill Element Definition.

4 Select a new alignment for the object. 

For more information, see “Specifying an Alignment for a Curtain Wall 
Infill” on page 815.

5 Click OK.

Changing the Offset of an Object Anchored in a 
Curtain Wall

Use this procedure to change the offset of an object anchored in a curtain 
wall.

1 Double-click the object in the curtain wall.

2 Expand Location, and click Anchor.

3 Click Allow Variation from Infill Element Definition.

4 Specify a new offset for the object. 

For more information, see “Specifying an Offset for a Curtain Wall Infill” 
on page 816.

5 Click OK.

Swapping Two Objects Anchored in a Curtain 
Wall

When you fill a curtain wall cell with an object, such as a door or window, 
you can swap that object with another object in the curtain wall.

1 Select one of the objects from the curtain wall and click Infill 
Anchor ➤ Swap Objects.

2 Select the object you want to swap with.
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Releasing an Object Anchored in a Curtain Wall

When you fill a curtain wall cell with an object, such as a door or window, 
that object is anchored to the curtain wall. While the anchor is in place, the 
object moves when you move the curtain wall and is removed when you 
erase the curtain wall. If you want to move or erase an object independently 
from the curtain wall, you can release the anchor of the object.

NOTE You can also move or erase the object by changing the element defini-
tion for the cell that contains the object. For more information, see “Defining 
Infills for Curtain Wall Cells” on page 812.

� Select one of the objects from the curtain wall, and click Infill 
Anchor ➤ Release.

Curtain Wall Units

Curtain wall units are an important building block of curtain walls. 

The Concept of Curtain Wall Units
Curtain wall units can significantly reduce the complexity of the curtain wall 
design and, thereby, the necessary design time.

You can think of a curtain wall unit as a “mini” curtain wall itself, which can 
have frames, mullions and divisions, but is normally not a standalone build-
ing object. A curtain wall unit is used in the larger context of a curtain wall. 
You usually assign curtain wall units to specific cells within a curtain wall 
grid. For more information, see “Inserting an Object into a Curtain Wall Cell” 
on page 839.

Curtain Wall Unit Styles
Curtain wall units are style-based, permitting maximum efficiency and flex-
ibility. Curtain wall unit styles are created and edited independently from the 
curtain wall style. You can use a curtain wall unit style in different curtain 
wall styles. For example, you can create a decorative three-tiled panel as a cur-
tain wall unit and use that for several curtain wall styles.

Curtain Wall Units and Door/Window Assemblies
Curtain wall units and door/window assemblies are very similar in their func-
tionality. Both can contain nested grids and be anchored as building blocks 
in curtain walls. A curtain wall unit, however, can contain no objects, such 
as windows or doors, but only panel infills. Furthermore, a curtain wall unit 
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usually is not used as a standalone object, whereas a door/window assembly 
could be. 

Curtain Wall Unit Grids
Like curtain walls, curtain wall units are made up of one or more grids. Each 
grid has either a horizontal division or a vertical division, but you can nest 
the grids to create a variety of patterns. 

Using curtain wall units in a curtain wall can help you limit the complexity 
in the curtain wall design.

Elements of Grids
Grids are the foundation of curtain walls and curtain wall units. Every grid 
has four element types:

� Divisions: Define the direction of the grid (horizontal or vertical) and the 
number of cells

� Cell Infills: Contain another grid, a panel infill, or an object such as a win-
dow or a door

� Frames: Define the edge around the outside of the primary grid and 
nested grids

� Mullions: Define the edges between the cells

NOTE Division is an abstract element, in contrast to the other three element 
types that represent physical elements of the curtain wall unit.

Each element type is assigned a default definition that describes what ele-
ments of that type look like.

Element type Default definitions

Divisions Horizontal grid with two manual divisions offset from the 
top and bottom of the grid

Cell Infills Cells containing simple panels

Frames Outer edges of grid 3" wide and 3" deep

Mullions Edges between cells 1" wide and 3" deep
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Curtain wall units default element definitions

Getting Started with Curtain Wall Units
To get started with curtain wall units, draw a curtain wall unit using one of 
the methods described in “Creating Curtain Wall Units” on page 910. Try a 
variety of the existing curtain wall unit styles, find a style you like and make 
a copy of it. Then, modify the element definitions and assignments to suit 
your own needs. For more information, see “Creating Element Definitions 
for a Curtain Wall Unit Style” on page 916.

For more information about element definitions and assignments, see “Cre-
ating Element Definitions for a Curtain Wall Unit Style” on page 916 and 
“Assigning Infills to Curtain Wall Unit Cells” on page 946.

Creating Curtain Wall Units

Creating curtain wall units is similar to creating curtain walls. You specify a 
style, a height, and start and end points. You can also create curtain wall 
units by converting a 2D layout grid to a curtain wall or converting two-
dimensional (2D) lines, arcs, and circles. Unlike curtain walls, you cannot 
create a curtain wall unit based on a curve. Curtain wall units can only be pla-
nar.

Related Procedures

� Creating a Curtain Wall Unit

� Converting a Layout Grid to a Curtain Wall Unit
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� Creating a Curtain Wall Unit with a Custom Grid

Creating a Curtain Wall Unit

Use this procedure to create a curtain wall unit.

Drawing a curtain wall unit

1 At the command line, enter cwunit.

2 Enter a (Add).

3 Select a start point and an end point.

4 Specify a height for the curtain wall unit.

5 Select a style, and click OK.

For information about curtain wall unit styles, see “Curtain Wall Unit Styles” 
on page 915.

Converting a Layout Grid to a Curtain Wall Unit

You can create a curtain wall unit grid that is based on a 2D layout grid. If 
you already have 2D layout grids in a drawing, you can easily convert them 
to curtain wall units. Or if you are already familiar with layout grids, it is an 
efficient way to create a curtain wall unit, and then experiment with the cur-
tain wall commands to learn more about them.
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Converting a 2D layout grid to a curtain wall unit

When you create a curtain wall unit from a 2D layout grid, you also create a 
new curtain wall unit style. The divisions in the new curtain wall unit style 
are taken from the divisions in the layout grid.

Curtain wall unit grids are one-dimensional, divided either horizontally or 
vertically. To create the horizontal and vertical patterns in the 2D layout grid, 
the curtain wall unit uses a primary grid with a secondary grid nested inside 
it. For more information about nested grids, see “Working with Nested Grids 
in Curtain Walls” on page 834.

When you create a curtain wall unit grid from a 2D layout grid, you need to 
decide the direction of the primary grid in the curtain wall unit. If you select 
horizontal, the primary grid has horizontal divisions that cross over the ver-
tical divisions of the secondary grid. If you select vertical, the primary grid 
has vertical divisions that cross over the horizontal divisions of the second-
ary grid. 

Specifying primary division directions
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The horizontal and vertical lines of the 2D layout grid define the divisions 
for the curtain wall unit grids. The grid cells, frame, and mullions are 
assigned default definitions. 

1 Create a layout grid.

For more information, see “Using Layout Grids” on page 1253.

2 At the command line, enter cwunit.

3 Enter c (Convert).

4 Enter LA (LAyoutGrid).

5 Select the layout grid.

6 To erase the layout grid, enter y (Yes). To have the layout grid remain after 
the curtain wall unit is created, enter n (No).

7 When prompted for the primary division, enter v (Vertical) or h (Horizon-
tal) as the orientation.

8 Enter a name for this new curtain wall unit style.

9 Click OK, and press ENTER to end the command.

Creating a Curtain Wall Unit with a Custom Grid

Curtain wall units contain one or more grids. You can define a custom grid 
with lines, arcs, and circles, and then convert that linework into a curtain 
wall unit. 

NOTE Curtain wall unit grids are either horizontal or vertical. To create a grid 
pattern with horizontal and vertical cells, nested grids are used. For more infor-
mation about nested grids, see “Working with Nested Grids in Curtain Walls” on 
page 834.

You cannot modify the division definition of a custom grid created from 
lines, arcs, and circles. You can, however, assign a different division defini-
tion to it. For more information, see “Assigning a Division to a Curtain Wall 
Unit Grid” on page 945.

1 Use lines, arcs, and circles to draw a grid in the current world coordinate 
system (WCS).

2 At the command line, enter cwunit.

3 Enter c (Convert).

4 Enter LI (LInework).

5 Select the lines, arcs, or circles that define your grid.
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6 Press ENTER.

7 Select one of the grid lines as the baseline for the curtain wall or press 
ENTER to use the line along the X axis as the baseline.

Converting linework to curtain walls units using the default baseline option

TIP If you draw your linework in the XY plane (in Plan view) and accept the 
default baseline, the resulting curtain wall unit is displayed as it is projected 
in the Z direction. 

Converting linework to curtain walls using the specified baseline option

8 To erase the lines, enter y (Yes). To have the lines remain after the curtain 
wall unit is created, enter n (No).

Each enclosed area is assigned the default cell infill. The lines between the 
cells are assigned the default mullion definition, and the boundary 
around the grid is assigned the default frame definition. For more infor-
mation, see “Assigning Definitions to Curtain Wall Elements” on 
page 832. 
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9 Select the resulting custom curtain wall unit, right-click, and click Design 
Rules ➤ Save to Style. 

10 Click New to create a new curtain wall unit style. 

11 Enter a name for the new curtain wall unit style. 

12 Click OK twice.

Curtain Wall Unit Styles

Curtain wall units are style-based, meaning there are preset characteristics 
assigned to each curtain wall unit that determine its appearance and func-
tion. By changing from one style of curtain wall unit to another, you can 
quickly study several different design options. Any changes you make to the 
style are reflected throughout your building, updating all curtain walls that 
use that particular curtain wall unit style. You can also apply overrides to a 
single curtain wall unit, without changing other curtain walls of the same 
style.

A curtain wall unit style controls the following properties of a curtain wall:

� Element definitions
� Definition assignments for each element
� Materials for each element
� Display properties for each element
� Notes about the style and any associated reference files

To create, edit, copy, or purge styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop 
where you can work with styles from multiple drawings and templates. For 
more information about using the Style Manager, see “Getting Started with 
the Style Manager” on page 533.

Related Procedures

� Creating Element Definitions for a Curtain Wall Unit Style

� Creating a Curtain Wall Unit Style

� Defining Divisions for Curtain Wall Unit Grids

� Defining Infills for Curtain Wall Unit Cells

� Defining Curtain Wall Unit Frames

� Defining Curtain Wall Unit Mullions

� Assigning a Division to a Curtain Wall Unit Grid

� Assigning Infills to Curtain Wall Unit Cells
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� Assigning Definitions to Curtain Wall Unit Frames

� Assigning Definitions to the Mullions of a Curtain Wall Unit

� Specifying the Materials of a Curtain Wall Unit Style

� Specifying the Display of Curtain Wall Units

� Attaching Notes and Files to a Curtain Wall Unit Style

Creating Element Definitions for a Curtain Wall 
Unit Style

Element definitions determine the appearance of the four basic curtain wall 
unit elements. There is a different definition type for each element.

Each type of element can have multiple definitions. For example, you can 
define a division to create a horizontal grid or a vertical grid, and you can 
define the cells to contain a nested grid or a panel infill. To make reuse easier, 
you can save the element definitions, and then assign them to grids, cells, 
frames, or mullions as needed. 

Element definitions are style-specific. When you create element definitions 
for a specific curtain wall unit style, those definitions are available only for 
curtain wall units of that style. For example, if you define a panel infill for 
one curtain wall unit style, that infill is not available as an option when you 
edit a curtain wall unit of a different style.

For information about defining the color, linetype, or layer of curtain wall 
elements, see “Specifying the Display of Curtain Wall Units” on page 962.

Creating a Curtain Wall Unit Style

Use this procedure to create a curtain wall unit style. You can create a style 
using default style properties or by copying an existing style. After you create 

Element type Default definitions

Divisions Horizontal grid with two manual divisions offset from the 
top and the bottom of the grid

Cell Infills Cells containing simple panels

Frames Left, right, top, and bottom outer edges of grid 3" wide 
and 3" deep

Mullions Edges between cells 1" wide and 3" deep
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the style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Create a new curtain wall style:

4 Enter a name for the new curtain wall unit style, and press ENTER.

5 To edit the new curtain wall unit style, right-click the style, and click Edit:

If you want to create 
a style . . .

Then . . .

with default properties right-click Curtain Wall Unit Styles, and click New.

from an existing style right-click the curtain wall unit style you want to 
copy, and click Copy. Right-click, and click Paste.

from a curtain wall, curtain 
wall unit, or door/window 
assembly in the drawing

right-click Curtain Wall Unit Styles, and click New. 
Right-click the new style, click Set From, and then 
pick a curtain wall, a curtain wall unit, or a door/
window assembly.

If you want to . . . Then . . .

define the elements of a 
curtain wall unit style

see “Defining Divisions for Curtain Wall Unit Grids” 
on page 918, “Defining Infills for Curtain Wall Unit 
Cells” on page 927, “Defining Curtain Wall Unit 
Frames” on page 932, and “Defining Curtain Wall 
Unit Mullions” on page 939.

assign element definitions 
to the curtain wall unit 
style

see “Assigning a Division to a Curtain Wall Unit 
Grid” on page 945, “Assigning Infills to Curtain Wall 
Unit Cells” on page 946, “Assigning Definitions to 
Curtain Wall Unit Frames” on page 952, and 
“Assigning Definitions to the Mullions of a Curtain 
Wall Unit” on page 956.

add curtain wall element 
definitions as display 
components

see “Adding Curtain Wall Unit Element Definitions 
as Display Components” on page 963.

specify layer, color and 
linetype settings for the 
display components of a 
curtain wall

see “Specifying the Layer, Color, and Linetype of a 
Curtain Wall Unit Style” on page 964.
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6 Click OK twice.

Defining Divisions for Curtain Wall Unit Grids

The divisions of a grid define the orientation that determines the direction 
of the grid cells and mullions, and they define a division type that deter-
mines the number and size of cells. 

NOTE Creating a nested grid is not a division rule. To create a nested grid, add 
a cell assignment. For more information, see “Creating a Nested Grid in a Cur-
tain Wall Unit” on page 947 and “Working with Nested Grids in Curtain Walls” 
on page 834.

You can create a variety of division definitions under different names, and 
then assign different divisions to each grid in your curtain wall unit. 
Although you can create multiple definitions, there can be only one division 
assignment per grid. You create division definitions for a specific curtain wall 
unit style and those definitions can be assigned only to grids in curtain wall 
units of that style. 

For more information about assigning divisions to a particular grid, see 
“Assigning a Division to a Curtain Wall Unit Grid” on page 945.

Related Procedures

� Division of Curtain Wall Unit Grids

� Creating a Division Definition for a Curtain Wall Unit

� Specifying a Fixed Size for Cells in a Curtain Wall Unit Grid

� Specifying a Fixed Number of Cells for a Curtain Wall Unit Grid

specify curtain wall unit 
hatching

see “Specifying the Layer, Color, and Linetype of a 
Curtain Wall Unit Style” on page 964.

add custom graphics as 
display components of a 
curtain wall unit style

see “Adding Custom Graphics as a Display 
Component of a Curtain Wall Unit” on page 966.

create individual cut planes 
for curtain wall unit styles

see “Creating Cut Planes for a Curtain Wall Unit” on 
page 967.

add notes and files to the 
style

see “Attaching Notes and Files to a Curtain Wall 
Unit Style” on page 968.

If you want to . . . Then . . .
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� Manually Defining the Number and Size of Cells in a Curtain Wall Unit 
Grid

� Specifying an Offset for a Curtain Wall Unit Grid

� Removing a Division Definition from a Curtain Wall Unit Style

Division of Curtain Wall Unit Grids
A curtain wall unit consists of one or more grids, which are the framework 
for placing design elements in the curtain wall unit. The highest-level grid is 
the primary grid, which is also the outside edge of the curtain wall unit. 

Each grid in a curtain wall unit has one division assignment that determines 
whether the grid is divided horizontally or vertically. The division also deter-
mines the number of cells, their size and their placement.

Within the primary grid, you can define multiple levels of grids. These grids 
within are called nested grids. Each subdivision of a grid is called a cell. 

Creating a Division Definition for a Curtain Wall Unit
Use this procedure to create divisions for a curtain wall unit grid.

Because curtain wall units can contain multiple nested grids, it is helpful to 
use a naming convention for grids that indicates the level of each grid and 
the grid location or the purpose within the curtain wall unit. For example, 
L3-FL1-Stone Panels can identify a third level grid that provides a row of 
stone panels on Floor 1.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Click New Division.

7 Enter a name for this division definition.

8 Click either Horizontal or Vertical for Orientation.

9 Select one of the following division types and specify offsets if needed.

Division Type Description

Fixed Cell Dimension Creates a grid where the size of the individual cells is 
predetermined. For more information, see 
“Specifying a Fixed Size for Cells in a Curtain Wall 
Unit Grid” on page 920.
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After you create a division definition, you can assign the definition to a 
specific grid in a curtain wall unit. For more information, see “Assigning 
a Division to a Curtain Wall Unit Grid” on page 945.

10 When you are finished creating division definitions, click OK twice.

Specifying a Fixed Size for Cells in a Curtain Wall Unit Grid
Use this procedure to define a specific size for the cells in a grid. In this case, 
the number of cells is determined by the length or height of the grid, depend-
ing on how the grid is divided.

When you specify a fixed cell size in a grid, you can control how the cells of 
the grid adjust to accommodate any leftover space. This space occurs if the 
length (or the height) of the curtain wall unit cannot be evenly divided by 
the fixed size of the cell. For more information, see “Using the Auto-Adjust 
Cells Option to Resize Cells in a Curtain Wall Unit Grid” on page 922.

Fixed Number of Cells Creates a grid where the number of grid cells is 
predetermined. For more information, see 
“Specifying a Fixed Number of Cells for a Curtain 
Wall Unit Grid” on page 923.

Manual Creates a grid where the size and number of 
individual cells is manually determined by the user. 
For more information, see “Manually Defining the 
Number and Size of Cells in a Curtain Wall Unit Grid” 
on page 924.

Division Type Description
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Specifying a fixed size for cells

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Fixed Cell Dimension for Division Type.

8 Specify a size for the cells in Cell Dimension. 

If you are defining a vertical division, the cell dimension is the length of 
the cell from mullion to mullion. If you are defining a horizontal division, 
the cell dimension is the height of the cell.
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9 To specify an offset for the grid, enter an offset distance in Start Offset or 
End Offset. For more information, see “Specifying an Offset for a Curtain 
Wall Unit Grid” on page 926.

TIP The frame width is calculated as part of the cell size. Therefore, cells 
adjacent to the frame can appear to be a different size than the other cells. If 
you do not want the frame width included in the cell size, specify an offset for 
the grid that is equal to the frame width. 

When you draw a curtain wall unit using a fixed cell dimension, there is 
often extra space between the last full-size cell and the end of the curtain 
wall unit.

10 To adjust the cells and accommodate this extra space automatically as you 
draw curtain wall units, select the Auto-Adjust Cells option.

11 Adjust the cells to accommodate this extra space:

For information about offsets, see “Specifying an Offset for a Curtain Wall 
Unit Grid” on page 926.

12 Click OK. 

For information about assigning the division definition to a specific grid in 
your curtain wall unit, see “Assigning a Division to a Curtain Wall Unit Grid” 
on page 945.

Using the Auto-Adjust Cells Option to Resize Cells in a Curtain 
Wall Unit Grid
Use this procedure to automatically resize cells in a grid when the result of 
dividing the grid by the specified cell dimension is not a whole number.

If you want to . . . Then . . .

add the space to grid 
cells

select Auto-Adjust Cells, select Grow for Cell 
Adjustment, and select the specific cells where the 
space is added.
You can select any combination of specific cells.

remove the space from 
grid cells

select Auto-Adjust Cells, select Shrink for Cell 
Adjustment, and select the specific cells where the 
space is removed.
You can select any combination of specific cells.
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For example, if a vertical primary grid in a curtain wall unit style is 17 feet in 
length and you specify a fixed cell dimension of 3 feet, the grid has five cells 
of 3 feet each with 2 feet remaining. Using the Auto-Adjust Cells option, you 
can specify how the grid distributes the remaining quantity.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Divisions definition or create a new one.

7 Select Fixed Cell Dimension as the division type.

8 Select Auto-Adjust Cells, and specify the cell adjustment:

The cells that you do not select maintain the fixed value you specified for 
Cell Dimension.

Specifying a Fixed Number of Cells for a Curtain Wall Unit 
Grid
Use this procedure to define a specific number of cells in a grid. In this case, 
the size of the cells is determined by the length or height of the grid, depend-
ing on how the grid is divided.

In some cases, when you create a complex curtain wall unit grid, you might 
want to start with a standard grid with a fixed number of cells, and then later 
fine-tune that manually. You can first create a grid with fixed cell numbers 
and then convert that to a manual grid. For information on manual grids, see 
“Manually Defining the Number and Size of Cells in a Curtain Wall Unit 
Grid” on page 924.

If you want to . . . Then . . .

add the remaining space to grid cells select Grow, and select the specific 
cells to which you want the space 
added.

remove the remaining space from grid 
cells

select Shrink, and select the specific 
cells from which you want the space 
removed. You can then select Maintain 
at least half of cell dimension in order 
to control the cell shrinkage.
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Specifying a fixed number of cells

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Fixed Number of Cells for Division Type.

8 Specify the number of cells. 

9 To specify an offset for the grid, enter an offset distance for Start Offset or 
End Offset. For more information, see “Specifying an Offset for a Curtain 
Wall Unit Grid” on page 926.

NOTE If you want to fine-tune the initial layout with a fixed number of cells, 
click Convert To Manual Division and edit the grid as described in“Manually 
Defining the Number and Size of Cells in a Curtain Wall Unit Grid” on 
page 924. 

10 Click OK. 

For information about assigning the division definition to a specific grid in 
your curtain wall unit, see “Assigning a Division to a Curtain Wall Unit Grid” 
on page 945.

Manually Defining the Number and Size of Cells in a Curtain 
Wall Unit Grid
Use this procedure to manually add gridlines and specify an offset for each 
one when you need to create a unique grid that does not fit into any of the 
other division types. You can also start with a fixed cell dimension grid or a 
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fixed number of cells grid, and then manually adjust the grid lines to suit 
your needs.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Manual for Division Type.

8 Click the Add Gridline icon to insert a grid line. Insert as many grid lines 
as you need. If you need to remove a grid line, select it from the table and 
click the Remove Gridline icon.

9 Under Offset in the gridline table, specify an offset distance for each grid 
line.

Gridline offset

10 Under From in the grid line table, select the grid location from which the 
grid line is offset. 

Offset grid line from option

11 To specify an offset for the grid, enter an offset distance for Start Offset or 
End Offset. 

For more information, see “Specifying an Offset for a Curtain Wall Unit 
Grid” on page 926.

12 Click OK.

For information about assigning the division definition to a specific grid 
in your curtain wall, see “Assigning a Division to a Curtain Wall Unit 
Grid” on page 945.
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Specifying an Offset for a Curtain Wall Unit Grid
By default, grids cells are measured from the start and end points of the cur-
tain wall unit baseline. The width of the grid frame is not considered in cal-
culating the size of the cell. For example, if you draw a curtain wall unit with 
a 14' baseline and a 1' frame on the left and right, and you specify a fixed 
number of vertical cells, the cells do not appear equal in size. The first and 
last cells appear smaller because they include the frame. To make the cells 
equal in size, offset the start and end of the grid by the width of the frame. 

Specifying grid offset directions

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.
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7 Specify an offset for the grid:

8 Click OK twice.

Removing a Division Definition from a Curtain Wall Unit Style
Use this procedure to remove a division definition that you no longer need. 
You cannot remove a division definition when it is currently assigned to a 
grid. In addition, you cannot remove the default division definition, but you 
can modify it.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition that you want to remove.

7 Click Remove Division.

8 Click OK twice.

Defining Infills for Curtain Wall Unit Cells

An infill defines the contents of a curtain wall unit cell. A curtain wall unit 
cell can be empty (no infill), can contain a grid (nested grid), or can contain 
a panel. Panels typically represent glazing or other plain cladding, such as 
stone or concrete.

If you want to specify the 
distance between . . .

Then . . .

the start point of the curtain wall 
baseline and the start of the first cell in 
a horizontal grid

enter a value for Start Offset.

the end point of the curtain wall 
baseline and the end of the last cell in a 
horizontal grid

enter a value for End Offset.

the floor line of the curtain wall and 
the start of the first cell in a vertical 
grid

enter a value for Bottom Offset.

the roof line of the curtain wall and the 
end of the top cell in a vertical grid

enter a value for Top Offset.
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Curtain wall units cannot contain object infills like doors or windows. If you 
want to create a subunit for a curtain wall that contains a combination of 
windows, doors, and panels, you must create a door/window assembly. For 
information on door/window assemblies see “Door/Window Assemblies” on 
page 1089.

NOTE Nested grids and no infill are options you select when assigning an infill 
to cell. These options do not require infill definitions. For information, see “Cre-
ating a Nested Grid in a Curtain Wall Unit” on page 947 and “Removing an Infill 
Definition from a Curtain Wall Unit Style” on page 932.

You can define as many infills as you need, and then use cell assignments to 
specify the cells that use each infill. You can modify, a default infill that is 
used for all unassigned cells.

NOTE Create infill definitions for a specific curtain wall unit style. Those defi-
nitions can be assigned only to grid cells in curtain wall units of that style. 

Materials
Styles use the materials of the object style assigned to each panel. For exam-
ple, if you specify an infill to use the Standard door/window assembly style, 
the materials of that infill are those designated in the door/window assembly 
style. Simple panels need material assigned in the curtain wall style.

If you do not use materials to control the display properties of infills, you can 
specify their display properties in the curtain wall unit style. The layer, color, 
linetype, and other display properties of the default infill are applied to all 
infills unless you create a custom display component for each infill defini-
tion. You can then control the display of each infill definition indepen-
dently. For more information, see “Specifying the Display of Curtain Wall 
Units” on page 962.

Related Procedures

� Creating a Panel Infill for a Curtain Wall Unit

� Specifying an Alignment for a Curtain Wall Unit Infill

� Specifying an Offset for a Curtain Wall Unit Infill

� Removing an Infill Definition from a Curtain Wall Unit Style
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Creating a Panel Infill for a Curtain Wall Unit
Use this procedure to create a simple panel infill to represent basic cladding 
materials in the curtain wall, such as a stone wall panel, concrete panel, 
metal panel, or glazing infill.

Because curtain wall units can contain multiple infills, it is helpful to use a 
naming convention for panel infills that indicates the infill location or pur-
pose within the curtain wall unit. For example, L3-FL1- Stone Panel can iden-
tify a stone panel in a third-level grid on Floor 1. 

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Click New Infill.

7 Enter a descriptive name for the infill.

8 Specify an alignment for the infill. 

For more information, see “Specifying an Alignment for a Curtain Wall 
Unit Infill” on page 930.

9 Specify an offset for the infill. 

For more information, see “Specifying an Offset for a Curtain Wall Unit 
Infill” on page 930.

10 Specify a thickness for the panel.

Specifying infill panel thickness

11 Click OK twice.
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After you create an infill definition, you can assign it to any cell in a curtain 
wall unit grid. For more information, see “Assigning Infills to Curtain Wall 
Unit Cells” on page 946.

Specifying an Alignment for a Curtain Wall Unit Infill
Use this procedure to align an infill so that it is centered with the baseline of 
the curtain wall unit, in front of the baseline, or behind the baseline. In Plan 
view, the front of a curtain wall unit (drawn from left to right) is below the 
baseline and the back is above the baseline.

NOTE To move the infill away from the baseline, see “Specifying an Offset for 
a Curtain Wall Unit Infill” on page 930.

Specifying infill alignments

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select an infill, or create a new one.

7 Select an alignment: front, center, or back.

8 Click OK twice.

Specifying an Offset for a Curtain Wall Unit Infill
Use this procedure to specify an offset for a curtain wall unit infill. By default, 
infills are centered on the curtain wall unit baseline. If your design requires 
that the infill be aligned with frame edges or some other part of the curtain 
wall unit, you can specify an offset for the infill.
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Specifying panel infill offsets

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select an infill, or create a new one.

7 Enter an offset distance. 

In Plan view, positive numbers offset the infill above the baseline and neg-
ative numbers offset the infill below the baseline. The offset is also 
affected by the selected alignment for the infill.

8 Click OK twice.
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Removing an Infill Definition from a Curtain Wall Unit Style
Use this procedure to delete an infill definition that you no longer need from 
the Infills definitions list. You cannot remove an infill definition when it is 
currently assigned to a cell. In addition, you cannot remove the default infill 
definition, but you can modify it.

NOTE For information about removing an infill from a cell, see “Removing an 
Infill from a Curtain Wall Unit Cell” on page 949.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select the unneeded infill definition from the list.

7 Click Remove Infill.

8 Click OK twice.

Defining Curtain Wall Unit Frames

All curtain wall unit grids, including the primary grid, can have frame defi-
nitions. The frame of the primary grid defines the outer edges of the curtain 
wall unit. The overall frame size is determined by the length and height of 
the primary curtain wall unit grid or a nested curtain wall unit grid. You can 
define a frame by specifying a width and depth or by selecting a profile.
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Specifying default and profile-based frames

You create frame definitions for a specific curtain wall unit style. Those defi-

nitions can be assigned only to frames in curtain wall units of that style. You 
can create as many frame definitions as you want, and then assign the defi-
nitions to the frames. If you have nested grids, each grid has its own frame. 
There is a default frame definition that you can modify and assign as needed. 
Unassigned frames are not displayed. For more information, see “Assigning 
Definitions to Curtain Wall Unit Frames” on page 952.

TIP You can copy a mullion definition and use it as a frame definition. Select 
the mullion definition and drag it to Frames in the tree on the left side of the 
dialog box.

Materials and Display Properties for Frames
If you do not use materials to control the display properties of frames, you 
can specify their display properties in the curtain wall style. The layer, color, 
linetype, and other display properties of the default frame are applied to all 
frames unless you create a custom display component for each definition. 
You can then control the display of each frame definition independently. For 
more information, see “Specifying the Display of Curtain Wall Units” on 
page 962.
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Related Procedures

� Defining a Curtain Wall Unit Frame by Width and Depth

� Creating a Profile for a Curtain Wall Unit Frame

� Defining a Curtain Wall Unit Frame Using a Profile

� Specifying Offsets for a Curtain Wall Unit Frame

� Removing a Frame Definition from a Curtain Wall Unit Style

Defining a Curtain Wall Unit Frame by Width and Depth
You can define a frame by specifying its width and depth. The overall frame 
size is determined by the length and height of the curtain wall unit grid.

Specifying frame width and depth

Because curtain wall units can contain multiple nested grids with different 
frames, it is helpful to use a naming convention for grid frames that indicates 
the grid location or purpose within the curtain wall unit. For example, L3-
FL1- Metal Frame can identify a metal frame for a third-level grid on Floor 1. 

TIP To remove the frame edge and have the infill adjust to fill the space occu-
pied by the frame, create a frame definition with both width and depth set to 
zero. Then, assign that definition to the frame edge that you want to remove. 
This is necessary for the infill to be mitered as it would be for a butt-glazed con-
dition. For more information, see “Removing a Frame Edge from a Curtain Wall 
Unit” on page 954.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.
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6 Click the New Frame icon to create a new frame definition.

7 Enter a descriptive name for the frame.

8 Specify a width and depth for the frame.

9 Specify any offsets. 

For more information, see “Specifying Offsets for a Curtain Wall Unit 
Frame” on page 937.

10 Click OK twice.

After you create a frame definition, you can assign it to any frame in a curtain 
wall unit. For more information, see “Assigning Definitions to Curtain Wall 
Unit Frames” on page 952.

Creating a Profile for a Curtain Wall Unit Frame
Use this procedure to create a profile that you can use to define the shape of 
a curtain wall unit frame. You can then extrude the profile to create a curtain 
wall unit frame. 

The height and the width of the polyline you use to create the profile define 
the default height and width of the curtain wall unit frame. The insertion 
point of the profile is aligned with the centroid of the frame. 

1 Draw a closed polyline of the height and the depth needed for the result-
ing curtain wall unit frame.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Enter c (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the frame. 

4 Enter a name for the profile, and click OK.

You can now use the profile as a curtain wall frame. For more information, 
see “Defining a Curtain Wall Unit Frame Using a Profile” on page 935.

Defining a Curtain Wall Unit Frame Using a Profile
Use this procedure to create a frame element definition from a profile. If you 
do not want a straight edge to your frame, you can use a profile to define 
edges with curves, jags, or any other shape.
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Two profile-based frame examples

NOTE The insertion point of the profile is aligned with the centroid of the 
frame. 

1 Create the profile for the frame. 

For information on creating profiles for curtain wall unit frames, see “Cre-
ating a Profile for a Curtain Wall Unit Frame” on page 935.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

4 Select a curtain wall unit style, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Frames under Element Definitions.

7 Click New Frame.

8 Enter a descriptive name for the frame.

9 Specify a width and depth for the frame edge. 

These dimensions are used to calculate the center point of the edge for 
aligning the profile and also to specify a boundary for the adjacent infill.

10 Select Use Profile.

NOTE The Profile options are available only if you have profiles in the cur-
rent drawing.

11 Select a profile from the list.

By default, the profile is inserted using the same width and depth with 
which it was created. 
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12 To adjust the size of the profile to fit within the width or depth dimension 
of the frame edge, select Auto-Adjust Profile Width or Depth.

13 To mirror the profile, select X or Y for Mirror In.

14 To rotate the profile, specify an angle for Rotation.

15 Specify any offsets. 

For more information, see “Specifying Offsets for a Curtain Wall Unit 
Frame” on page 937.

16 Click OK twice.

After you create a frame definition, you can assign it to any frame in a curtain 
wall unit. For more information, see “Assigning Definitions to Curtain Wall 
Unit Frames” on page 952.

Specifying Offsets for a Curtain Wall Unit Frame
Use this procedure to define the distance that a curtain wall unit frame is 
from the floor line, roof line, or baseline. By default, the outside edges of the 
frame align with start and end of the floor line and the start and end of the 
roof line. When you adjust the width of the frame, the frame expands 
inward. However, you can use offsets to expand or contract the frame away 
from these default limits or to shift the frame away from the baseline in 
either the X or Y direction. 

Offset Description 

X Positive X offset moves the frame edge outward 
beyond the end of the curtain wall unit, while a 
negative X offset moves the frame edge inward 
toward the center of the curtain wall unit.

Y In Plan view, a positive Y offset moves the frame 
edge above the baseline, while a negative Y offset 
moves the frame below the baseline.

Start Negative Start offset lengthens the frame beyond 
the start point, while a positive Start offset shortens 
the frame. The start point for vertical edges is the 
baseline and, for horizontal edges (drawn left to 
right), it is the left side.

End Negative End offset lengthens the frame beyond 
the end point, while a positive End offset shortens 
the frame. The end point for vertical edges is the 
base height and, for horizontal edges (drawn left 
to right), it is the right side.
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Specifying frame offsets

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Select a frame definition from the list.

7 Specify an offset distance for the frame edge X, Y, Start, or End.

8 Click OK twice.

Removing a Frame Definition from a Curtain Wall Unit Style
Use this procedure to remove a frame definition from the Frame definitions 
list. You cannot remove a frame definition if it is currently assigned to a 
frame edge, but you can remove it if it is assigned as an override to a frame 
edge. In addition, you cannot remove the default frame definition, but you 
can modify it.

NOTE For information about removing a frame edge, see “Removing a Frame 
Edge from a Curtain Wall Unit” on page 954.

1 On the Format menu, click Style Manager.
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2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Select the unneeded frame definition from the list.

7 Click the Remove Frame icon.

8 Click OK twice.

Defining Curtain Wall Unit Mullions

The mullions of a curtain wall unit are the edges between the grid cells. You 
can define the mullions by specifying a width and depth or by selecting a 
profile from which the mullion is extruded.

Because curtain wall units can contain multiple nested grids with different 
mullions, it is helpful to use a naming convention for grid mullions that indi-
cates the grid location or purpose within the curtain wall unit. For example, 
L3-FL1- Panel Decorative Mullion can identify a mullion for a panel in a 
third-level grid on Floor 1. 

Specifying default and profile-based mullions
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You create mullion definitions for a specific curtain wall unit style and those 
definitions can be assigned only to mullions in curtain wall units of that 
style. You can create as many mullion definitions as you want, and then 
assign the definitions to mullions as needed. If you have nested grids, each 
grid has its own mullions. There is a default mullion definition that you can 
modify as needed that is used for any unassigned mullions. For more infor-
mation, see “Assigning Definitions to the Mullions of a Curtain Wall Unit” 
on page 956.

TIP You can copy a frame definition and use it as a mullion definition. Select 
the frame definition and drag it to Mullions in the left pane of the dialog box.

Materials and Display Properties for Mullions
If you do not use materials to control the display properties of mullions, you 
can specify their display properties in the curtain wall unit style. The layer, 
color, linetype, and other display properties of the default mullion are 
applied to all mullions unless you create a custom display component for 
each definition. You can then control the display of each mullion definition 
independently. For more information, see “Specifying the Display of Curtain 
Wall Units” on page 962.

Related Procedures

� Defining Curtain Wall Unit Mullions by Width and Depth

� Creating a Profile for Curtain Wall Unit Mullions

� Defining the Mullions of a Curtain Wall Unit Using a Profile

� Specifying Offsets for the Mullions of a Curtain Wall Unit 

� Removing a Mullion Definition from a Curtain Wall Unit Style

Defining Curtain Wall Unit Mullions by Width and Depth
You can define mullions by specifying a width and a depth. 
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Specifying mullion width and depth

TIP To remove mullions for butt glazing, create a definition with both width 
and depth set to zero. Then, assign that definition to the mullions that you want 
to remove. For more information, see “Removing Mullions from a Curtain Wall 
Unit Grid” on page 959.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Click New Mullion.

7 Enter a descriptive name for the mullion.

8 Specify a width and depth for the mullion.

9 Specify the offsets you want. 

For more information, see “Specifying Offsets for the Mullions of a Cur-
tain Wall Unit” on page 943.

10 Click OK twice.

After you create a mullion definition, you can assign it to any mullion in a 
curtain wall unit. For more information, see “Assigning Definitions to the 
Mullions of a Curtain Wall Unit” on page 956.

Creating a Profile for Curtain Wall Unit Mullions

Use this procedure to create a profile that you can use to define the shape of 
a curtain wall unit mullion definition. You can then extrude the profile to 
create mullions from it. 



942 | Chapter 14 Curtain Walls

The height and the width of the polyline you use to create the profile define 
the default height and width of the curtain wall unit mullion. The insertion 
point of the profile is aligned with the centroid of the mullion.

1 Draw a closed polyline of the height and the depth needed for the result-
ing curtain wall unit mullion.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Enter C (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the mul-
lion.

4 Enter a name for the profile, and click OK.

You can now use the profile as a curtain wall unit mullion. For more infor-
mation, see “Defining the Mullions of a Curtain Wall Unit Using a Profile” 
on page 942.

Defining the Mullions of a Curtain Wall Unit Using a Profile
Use this procedure to create a mullion element definition from a profile. If 
you do not want a straight edge to your mullions, you can use a profile to 
define mullions with curves, jags, or any other shape.

NOTE The insertion point of the profile is aligned with the centroid of the 
mullion.

Infill alignments with default and profile-based mullions

1 Create the profile to use for the mullion. 

For information, see “Creating a Profile for Curtain Wall Unit Mullions” 
on page 941.
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2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

4 Select a curtain wall unit style, right-click, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Mullions under Element Definitions.

7 Click the New Mullion icon to create a new mullion definition.

8 Enter a descriptive name for the mullion.

9 Specify a width and depth for the mullion. 

These dimensions are used to calculate the center point of the mullion for 
aligning the profile and also to specify a boundary for the adjacent infill.

10 Select Use Profile. 

NOTE The Profile options are available only if you have profiles in the cur-
rent drawing.

11 Select a profile from the list.

By default, the profile is inserted using the same width and depth with 
which it was created.

12 To adjust the size of the profile to fit within the width or depth dimension 
of the mullion, select Auto-Adjust Profile Width or Depth.

13 To mirror the profile, select X or Y for Mirror In.

14 To rotate the profile, specify a rotation angle for Rotation.

15 Specify any offsets. 

For more information, see “Specifying Offsets for the Mullions of a Cur-
tain Wall Unit” on page 943.

16 Click OK twice.

After you create a mullion definition, you can assign it to any mullion in a 
curtain wall unit. For more information, see “Assigning Definitions to the 
Mullions of a Curtain Wall Unit” on page 956.

Specifying Offsets for the Mullions of a Curtain Wall Unit
Use this procedure to define mullions that are offset from the start or end of 
the curtain wall unit to lengthen or shorten the edge or offset in the X or Y 
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direction to shift the edge. For example, you might want to represent butt 
glazing by offsetting the mullions to be behind glass panel infills.

Specifying mullion offsets

1 On the Format menu, click Style Manager.

Offset Description

X For vertical mullions, a positive X offset moves the 
mullions toward the end of the curtain wall unit, while a 
negative X offset moves the mullions toward the start of 
the curtain wall unit. For horizontal mullions, a positive 
X offset moves the mullions toward the top of the 
curtain wall unit, while a negative X offset moves the 
mullions toward the bottom of the curtain wall unit.

Y In Plan view, a positive Y offset moves the mullions 
above the baseline, while a negative Y offset moves the 
mullions below the baseline.

Start Negative Start offset lengthens the mullions beyond the 
start point, while a positive Start offset shortens the 
mullions.

End Negative End offset lengthens the mullions beyond the 
end point, while a positive End offset shortens the 
mullions.
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2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Select a mullion definition from the list.

7 Specify an offset distance for the X, Y, Start, or End.

8 Click OK twice.

Removing a Mullion Definition from a Curtain Wall Unit Style
Use this procedure to remove a mullion definition from the Mullions defini-
tions list. You cannot remove a mullion definition if it is assigned to a mul-
lion. In addition, you cannot remove the default mullion definition, but you 
can modify it as needed.

NOTE For information about removing mullions from between cells, see 
“Removing Mullions from a Curtain Wall Unit Grid” on page 959.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Select the unneeded mullion definition from the list.

7 Click the Remove Mullion icon to remove the mullion definition.

8 Click OK twice.

Assigning a Division to a Curtain Wall Unit Grid

Use this procedure to assign a division to a curtain wall unit grid. A division 
defines the grid orientation (whether the direction of the grid cells and mul-
lions is horizontal or vertical) and the division type (number and size of 
cells).

After you define a division, you can assign it to the primary grid or to nested 
grids. Nested grids are created by selecting Nested Grid as the cell assignment. 
For more information, see “Working with Nested Grids in Curtain Walls” on 
page 834.
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1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid you want to assign a division to. The name 
of the grid you select is displayed in the table under the Division Assign-
ment row.

TIP To rename a grid, select it, and click Rename, and enter a new name. 

6 Click the Element column for that grid and select a division definition 
from the list. 

7 Click OK twice.

Assigning Infills to Curtain Wall Unit Cells

An infill defines the contents of a curtain wall unit cell. A curtain wall unit 
cell can be empty (none), can contain a grid (nested grid), or can contain a 
panel. 

NOTE Curtain wall units cannot contain object infills like doors or windows. If 
you want to create a subunit for a curtain wall that contains a combination of 
windows, doors and panels, you must create a door/window assembly. For infor-
mation on door/window assemblies see “Door/Window Assemblies” on 
page 1089.

Cell Assignments
A cell assignment defines the infill definition used for the cells. You can use 
one cell assignment to assign the same infill to all cells, or you can create 
multiple cell assignments to assign different infills to different cells.
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Cell assignments

Do not assign multiple definitions to the same cell because only the last def-
inition assigned to the cell is used. 

Default Cell Assignment
The default cell assignment is used by all unassigned cells. You can modify 
the default assignment to be any type of infill, but you cannot delete the 
default cell assignment.

You may want to modify the default cell assignment to use the infill defini-
tion that occurs most frequently in your design. Any cells not assigned to 
other infills then use this infill definition.

Materials and Display Properties of Infills 
The layer, color, linetype, and other display properties of the default infill are 
applied to all infills unless you assign materials to the infills you created or 
you create a custom display component for each definition. You can then 
control the display of each infill definition independently. For more infor-
mation, see “Specifying the Display of Curtain Wall Units” on page 962.

Related Procedures

� Creating a Nested Grid in a Curtain Wall Unit

� Filling a Curtain Wall Unit Cell with a Simple Panel

� Removing an Infill from a Curtain Wall Unit Cell

� Specifying Which Curtain Wall Unit Cells Use a Cell Assignment

� Removing an Assignment from a Curtain Wall Unit Style

Creating a Nested Grid in a Curtain Wall Unit 
Use this procedure to create a nested grid in a curtain wall unit. A nested grid 
is a grid within a grid. Each nested grid has its own division, cell assignments, 
frame, and mullions. By default, the frame is turned off for nested grids.

For more information, see “Working with Nested Grids in Curtain Walls” on 
page 834.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.
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5 In the left pane, select the grid in which you want to create a nested grid. 

6 Click the New Cell Assignment icon.

A new cell assignment is displayed in the list of cell assignments.

7 Click New Cell Assignment, and enter a descriptive name for the assign-
ment.

8 Select Nested Grid in the Element column.

A new grid is added to the list of grids in the tree view to the left of the 
dialog box. If you are editing the primary grid, the new grid is added at the 
secondary level. If you are editing a grid at the secondary level, the addi-
tional grid is placed at the tertiary level, and so on.

Creating a nested grid 

New nested grid in tree

NOTE To rename a grid, select it in the right pane, right-click and click 
Rename, and enter a new name.

9 Specify the cells to contain this nested grid. 

For more information, see “Specifying Which Curtain Wall Unit Cells Use 
a Cell Assignment” on page 950.

10 Click OK twice.
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Filling a Curtain Wall Unit Cell with a Simple Panel
Use this procedure to fill a curtain wall unit cell with a simple panel. Simple 
panels are generally used to represent basic cladding materials in the curtain 
wall, such as a stone wall panel or a concrete panel.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to put a simple panel 
infill. 

6 Click the New Cell Assignment icon.

A new cell assignment is displayed in the list of cell assignments.

7 Click New Cell Assignment, and enter a descriptive name for the assign-
ment.

8 Under Element, select an infill that defines a simple panel. 

If you do not have a simple panel infill defined, select New Infill and 
define one. For more information, see “Creating a Panel Infill for a Cur-
tain Wall Unit” on page 929.

9 Specify the cells to contain this simple panel. 

For more information, see “Specifying Which Curtain Wall Unit Cells Use 
a Cell Assignment” on page 950.

10 Click OK twice.

Removing an Infill from a Curtain Wall Unit Cell
Use this procedure to remove the infill of a cell and leave the cell empty. To 
do this, use None as the element definition. Using None also removes any 
frame edges that border the cell, but it does not affect the mullions.

Removing an infill assignment from a cell
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1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid that contains the cells you want to assign 
to None.

6 Create a new cell assignment or select an existing cell assignment.

7 Select None under the Element column.

8 Specify the cells to contain the None infill. 

For more information, see “Specifying Which Curtain Wall Unit Cells Use 
a Cell Assignment” on page 950.

9 Click OK twice.

Specifying Which Curtain Wall Unit Cells Use a Cell 
Assignment
When you create a cell assignment you need to specify the cells in the grid 
to use that assignment. There are two options for selecting cells:

� Use Location to insert the infill into the start, middle, or end cells of a ver-
tical grid or into the bottom, middle, or top cells of a horizontal grid. If 
there is an even number of cells (four or more), Middle refers to the two 
cells in the middle of the grid. If there is an odd number of cells (three or 
more), Middle refers to one cell in the middle of the grid.
Specifying cell assignments by location

� Use Index to insert the infill into specific cells based on cell numbers. Cells 
are numbered from start to end or bottom to top. For example, typing 1, 
3, 5 would place the infill in the first, third, and fifth cells.
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Specifying cell assignment by index

Any cells that are not assigned a specific cell assignment use the default infill.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Under the Type column, select Location or Index.

7 Select a cell assignment:

NOTE Do not assign multiple definitions to a cell because the last definition 
assigned to the cell is used. 

8 Click OK twice.

If you selected . . . Then . . .

Location click the Used In column, and click the button 
at the far right of the row. Select the cells you 
want to use this assignment, and click OK.

Index enter the cell numbers separated by commas 
in the Used In column. For vertical grids, cells 
are numbered from start to end and for 
horizontal grids, cells are numbered from 
bottom to top.
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Removing an Assignment from a Curtain Wall Unit Style
Use this procedure to remove cell assignments, frame assignments, and mul-
lion assignments from a curtain wall unit style. You cannot remove default 
assignments, but you can modify them to suit your needs.

NOTE Each grid requires one division assignment. Therefore, you cannot 
remove the division assignment, although you can change the division element 
used for the division assignment.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid from which you want to remove an assign-
ment.

6 Select a cell assignment, frame assignment, or a mullion assignment.

7 Click the Remove Assignment icon.

8 Click OK twice.

Assigning Definitions to Curtain Wall Unit 
Frames

The curtain wall unit frame is represented by the outer edges of the primary 
grid. Each nested grid has its own frame that is defined separately from the 
primary grid frame. By default, the frames of nested grids are turned off. For 
more information about nested grids, see “Working with Nested Grids in 
Curtain Walls” on page 834.

Frame Assignments
A frame assignment defines the frame definition that is used by each frame 
edge. You can use one frame assignment to assign the same definition to all 
four edges of the frame, or you can create multiple frame assignments to 
assign different definitions to different edges of the frame. Unassigned edges 
are not displayed. 

Do not assign multiple definitions to the frame edge because the last defini-
tion assigned to the edge is used. 
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Default Frame Assignment
There is a default frame assignment, and you can select the frame edges it 
applies to. You can modify the default assignment to use any frame defini-
tion, but you cannot delete the default frame assignment.

Materials and Display Properties of Frames
The layer, color, linetype, and other display properties of the default frame 
are applied to all frame edges unless you assign materials to the frame defini-
tion or you create a custom display component for each definition. You can 
then control the display of each frame definition independently. For more 
information, see “Specifying the Display of Curtain Wall Units” on page 962.

Related Procedures

� Adding a New Frame Assignment to a Curtain Wall Unit 

� Removing a Frame Edge from a Curtain Wall Unit

� Specifying Which Curtain Wall Unit Edges Use a Frame Assignment

Adding a New Frame Assignment to a Curtain Wall Unit
Use this procedure to add a frame assignment to a curtain wall unit. To assign 
different definitions to different frame edges, you need multiple frame 
assignments.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a new frame 
assignment. 

6 Click the New Frame Assignment icon.

A new frame assignment is displayed in the list of frame assignments.

New frame definition

7 Click New Frame Assignment and enter a descriptive name for the 
assignment.

8 Select a frame definition from the Element column.

9 Specify the sides of the frame to use this frame assignment. 



954 | Chapter 14 Curtain Walls

For more information, see “Specifying Which Curtain Wall Unit Edges Use 
a Frame Assignment” on page 955.

10 Click OK twice.

Removing a Frame Edge from a Curtain Wall Unit
Use this procedure to remove a frame edge from a curtain wall unit. There are 
three ways to remove a frame edge: 

� Set the width and depth of the edge to zero
� Leave the edge unassigned
� Specify None as an override to the edge assignment

The first two methods remove the frame edge and expand the adjacent infills 
into the space occupied by the edge.

Specifying a frame width and depth of zero

By specifying None as an override, the frame edge is not displayed, but the 
adjacent infill is not expanded into the space the edge occupied. 

Overriding a frame edge definition
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For information about setting the width and depth to zero, see “Defining a 
Curtain Wall Unit Frame by Width and Depth” on page 934.

For information about leaving the edge unassigned, see “Specifying Which 
Curtain Wall Unit Edges Use a Frame Assignment” on page 955.

Specifying Which Curtain Wall Unit Edges Use a Frame 
Assignment
Use this procedure to specify edges that use a frame assignment. When you 
create a frame assignment, you need to specify the edges of the frame to use 
that assignment.

Frame edges that are not assigned a frame definition are not displayed.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Select a frame assignment.

Location is the only way to specify the frame edges.

7 Click the Used In column, and then click the [...] button at the far right of 
the row.

Specifying frame location

8 Select the edges that you want to use this assignment - Left, Right, Top, or 
Bottom - and click OK.



956 | Chapter 14 Curtain Walls

Assigning frames to nested grids

Do not assign multiple definitions to the same frame edge because only 
the last definition assigned to the edge is used.

9 Click OK twice.

Assigning Definitions to the Mullions of a Curtain 
Wall Unit 

The mullions of a curtain wall unit are the edges between the grid cells. The 
primary grid and each nested grid have mullions that are defined separately 
from the other grids. For more information about nested grids, see “Working 
with Nested Grids in Curtain Walls” on page 834.

Assign mullions to a nested grid

Mullion Assignments
A mullion assignment defines the definition used by each mullion. You can 
use one assignment to define all mullions, or you can create multiple assign-
ments and assign different definitions to different mullions in any grid.
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Do not assign multiple definitions to the same mullion because only the last 
definition assigned to the mullion is used. 

Default Mullion Assignment
There is a default mullion assignment used by all unassigned mullions. You 
can modify the default assignment to be any mullion definition, but you 
cannot delete the default mullion assignment.

Related Procedures

� Adding a New Mullion Assignment to a Curtain Wall Unit Style

� Removing Mullions from a Curtain Wall Unit Grid

� Specifying Which Curtain Wall Unit Mullions Use an Assignment

Adding a New Mullion Assignment to a Curtain Wall Unit Style
Use this procedure to add a new mullion assignment to a curtain wall unit 
style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a new mullion 
assignment. 

6 Click New Mullion Assignment.

A new mullion assignment is displayed in the list of mullion assignments.

New mullion assignment

7 Select the mullion assignment, right-click and click Rename, and then 
enter a descriptive name.

8 Select a mullion definition from the Element column.

9 Specify the mullions to use this assignment. 

For more information, see “Specifying Which Curtain Wall Unit Mullions 
Use an Assignment” on page 958.

10 Click OK twice.
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Specifying Which Curtain Wall Unit Mullions Use an 
Assignment
When you create a mullion assignment you need to specify the mullions in 
the grid to use that assignment. There are two options for selecting 
mullions:

� Use Location to assign a definition to the start, middle, or end mullions of 
a vertical grid or the bottom, middle, or top mullions of a horizontal grid. 
If there is an even number of mullions (four or more), Middle refers to the 
two mullions in the middle of the grid. If there is an odd number of mul-
lions (three or more), Middle refers to the one mullion in the middle of 
the grid.

� Use Index to assign a definition to specific mullions based on mullion 
numbers. Mullions are numbered from start to end or bottom to top. For 
example, entering 1, 2, 3 would assign the definition to the first, second, 
and third mullions.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Create a new mullion assignment or select an existing assignment.

7 Select Location or Index for Type.

8 Select a cell assignment.

NOTE Do not assign multiple definitions to the same mullion because only 
the last definition assigned to the mullion is used. 

9 Click OK twice.

If you selected . . . Then . . .

Location click the Used In column, and click the button at the 
far right of the row. Select the cells you want to use 
this assignment, and click OK.

Index enter the mullion numbers separated by commas in 
the Used In column. For vertical grids, mullions are 
numbered start to end and for horizontal grids, 
mullions are numbered from bottom to top.
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Any mullions that are not assigned a specific mullion assignment use the 
default mullion definition.

Removing Mullions from a Curtain Wall Unit Grid
 Use this procedure to remove a mullion from the curtain wall unit. You can 
create a mullion definition whose edge width and depth are zero. Adjacent 
infills expand to fill in the space that was occupied by the mullion. This is an 
effective way to represent butt glazing.

Removing mullions from a curtain wall unit grid

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select a curtain wall unit style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to remove a mullion. 

6 Create a new mullion assignment and enter 0 (zero) for the width and 
depth. 

For more information, see “Defining Curtain Wall Unit Mullions by 
Width and Depth” on page 940.

7 Under Mullion Assignments, select the mullion definition you created for 
any cell edges of any mullion assignment where you want to remove the 
mullions. 

For more information, see “Specifying Which Curtain Wall Unit Mullions 
Use an Assignment” on page 958.

8 Click OK twice.
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Specifying the Materials of a Curtain Wall Unit 
Style

A curtain wall unit consists of a number of components whose display prop-
erties can be determined by the materials assigned to each component.

When you assign materials to a curtain wall unit style, you assign one mate-
rial to each display component of the curtain wall unit. For example, you 
assign a wood material to the frame and a glass material to the glass inset. 
You assign materials to components in each display representation where 
you want the materials to be used.

If you want to use the display properties of the curtain wall unit style, instead 
of using material display properties, you can turn off the material assign-
ments in the display properties of the curtain wall unit style.

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Curtain Wall Unit Materials and Display Components

� Assigning Materials to a Curtain Wall Unit Style

Curtain Wall Unit Materials and Display Components
The following table identifies the material component that corresponds to 
each curtain wall unit component in the specified views.

Curtain Wall Unit 
Component

Material Component

Plan, Plan High Detail, Plan Low Detail, Screened, Reflected Plan

Frame Definitions Linework

Mullion Definitions Linework

Infill Definitions Linework

Frame Definitions Hatch Linework

Mullion Definitions Hatch Linework

Infill Definitions Hatch Linework
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Assigning Materials to a Curtain Wall Unit Style
Use this procedure to assign materials to the individual components of a cur-
tain wall unit style. When you assign a material to a curtain wall unit com-
ponent, the component uses the display properties of the material instead of 
the style display properties.

You can assign a material to any physical component of the curtain wall unit. 
Custom components and components that are only symbolic graphics do 
not use materials for their display properties. For example, the frame, mul-
lion, and infill are physical components of a curtain wall unit. The cell 
marker is a symbolic component.

NOTE If a material assignment does not determine the display properties of a 
curtain wall unit component, you can change the display properties of the cur-
tain wall unit style as described in “Specifying the Display of Curtain Wall Units” 
on page 962.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

Model

Frame 3D Body

Mullion 3D Body

Infill 3D Body

Curtain Wall Unit 
Component

Material Component
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10 Select the component you want to change, select the value for Material 
Definition, and select a different material definition.

You can select any material definition in the current drawing, or click 

 to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display of Curtain Wall Units

The display of a curtain wall unit depends on the direction from which you 
view the curtain wall unit. In Plan view, the curtain wall unit is displayed as 
parallel lines with vertices marking the grid lines, as an architect would typ-
ically draw a curtain wall unit. In 3D isometric views, the curtain wall unit is 
displayed as it would appear in the real world, with surfaces showing length, 
thickness, and height. You control what you want to display in each partic-
ular view.

Element Definitions and Custom Display Components
By default, the display of all infills, frames, and mullions are controlled by 
the display properties of the default infill, default frame, and default mul-
lions. However, you can add individual element definitions as components 
with separate display properties. For example, if you define two infills called 
stone panel and acetylene panel, by default they are both controlled by the 
same default infill display properties. However, you can add each definition 
as a new display component and control the display properties separately.

NOTE The component name in the Custom Display Component dialog box 
must match the name of element definition in the Design Rules tab. Otherwise 
the element definition does not display properly.

For more information about the display system, see “Display System” on 
page 435.

Materials and Display Properties
You can use materials to control the display of both default and custom 
infills, frames, and mullions. When you assign materials to the element def-
initions you create, you do not need to define these definitions as custom dis-
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play components. For more information, see “Specifying the Materials of a 
Curtain Wall Unit Style” on page 960.

Related Procedures

� Adding Curtain Wall Unit Element Definitions as Display Components

� Specifying the Layer, Color, and Linetype of a Curtain Wall Unit Style

� Specifying the Hatching for Components of a Curtain Wall Unit Style

� Adding Custom Graphics as a Display Component of a Curtain Wall Unit

� Creating Cut Planes for a Curtain Wall Unit

Adding Curtain Wall Unit Element Definitions as Display 
Components
Use this procedure to add curtain wall unit element definitions. Before you 
can control the display properties of curtain wall unit elements according to 
the definition assigned to the element, you must create display components 
for each element definition.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Select the curtain wall unit style that you want to change, and click Edit.

4 Click the Display Properties tab. 

5 Select Model as the display representation.

6 Click . 

The default list of components includes only the three basic elements and 
cell markers.

Default Model display components for curtain wall units

7 Click the Other tab, and then click Add.

8 Select Infill, Frame, or Mullion for Component Type.

9 Enter a name for Component Name, or click Select Element and select an 
element from the list.

10 Click OK.

11 Click the Layer/Color/Linetype tab.
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The element definition that you added is displayed in the list of compo-
nents.

12 Click the Other tab to continue adding element definitions, or click OK 
three times.

Specifying the Layer, Color, and Linetype of a Curtain Wall 
Unit Style
Use this procedure to change the following display properties of the compo-
nents of a curtain wall unit style: 

� Visibility (component is on or off)
� By Material
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Right-click the curtain wall unit style that you want to change, and click 
Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear.

6 Click Style Override.

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK three times.

Specifying the Hatching for Components of a Curtain Wall 
Unit Style
Use this procedure to specify the hatching of the components of a curtain 
wall unit style. Curtain wall hatching is displayed only in display representa-
tions, such as Plan, that are used in Top view (Plan view) of a drawing.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Right-click the curtain wall unit style that you want to change, and click 
Edit.

4 Click the Display Properties tab.
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5 Select the display representation where you want the changes to appear, 
and click Style Override.

6 Click the Hatching tab.

7 Select a component, and click the setting for Pattern.

8 Specify the hatching for the component:

9 Click OK.

10 Click the setting for Scale/Spacing, and enter a value that determines how 
the selected pattern is repeated.

11 Click the setting for Angle, and enter the angle for the selected pattern.

12 Click the setting for Orientation, and specify how the hatching is ori-
ented:

13 Click OK three times.

If you want to select . . . Then . . .

a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

single hatching select User-defined for Type, and clear Double 
Hatch.

double hatching select User-defined for Type, and select 
Double Hatch.

solid fill select Solid Fill for Type.

If you want to orient the 
hatching . . .

Then . . .

to the object, regardless of the 
object rotation

select Object.

to the World Coordinate System select Global.
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Adding Custom Graphics as a Display Component of a Curtain 
Wall Unit
There may be instances where an infill, frame, or mullion requires a custom 
two-dimensional (2D) or three-dimensional (3D) graphic. For example, you 
might need a highly detailed three-dimensional truss as the mullions or a 
decorative light fixture applied to an infill. In cases like these, you can create 
a custom block, add a display component with the block attached, and asso-
ciate that component with an element definition. When you assign that def-
inition to an element, the block is also displayed.

1 Draw your custom component and save it as a block.

2 Select a curtain wall unit, right-click, and click Edit Curtain Wall Unit 
Style. 

3 Click the Display Properties tab.

4 Click .

5 Click the Custom Plan Components tab.

If Model is the current display representation, the tab is called Other.

6 Click Add.

7 Select Infill, Frame, or Mullion for Component Type.

8 Select the specific element from the list.

9 Select Draw Custom Graphics.

10 Specify the display of the component:

11 Click Select Block, and select the custom block that you created.

12 Click OK.

If you want to . . . Then . . .

display the block instead of the 
associated curtain wall unit 
element

select Replace Graphics.

superimpose the block over the 
curtain wall unit element so that 
both are displayed

clear Replace Graphics. 
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13 Specify further settings for the custom display block: 

14 Click OK three times.

Creating Cut Planes for a Curtain Wall Unit
Use this procedure to specify the properties of one or more cut planes for a 
curtain wall unit style. Cut plane display properties apply only to display rep-
resentations, such as Plan, that are used in Top view (Plan view) of a drawing.

To better visualize the elements of a curtain wall unit in Plan view, you can 
create cut planes. The main cut plane is where the shrinkwrap and hatching 
are applied. The plan display shows the components and objects in the wall 
as they are displayed at the height of each cut plane.

1 Select a curtain wall unit, right-click, and click Edit Curtain Wall Unit 
Style. 

2 Click the Display Properties tab.

3 Select Plan, and click .

NOTE The Cut Plane tab is displayed only in some display representations, 
such as Plan. 

4 Click the Cut Plane tab to set the cut plane to be displayed in each display 
representation for the curtain wall unit style.

5 Enter a value for Cut Plane Height to specify the cut plane at which hatch-
ing takes effect.

If you want to . . . Then . . .

scale the block to fit a particular 
dimension

select Width, Height, or Depth. To prevent 
the block from losing its proportions, select 
Lock XY Ratio.

specify how the block is inserted 
into the grid in the X, Y, and Z 
directions

specify an insertion point on the X, Y, and Z 
planes.

mirror the block determine if it should mirror in the X, Y, or Z 
direction.

offset the block from the grid specify the offset in the X, Y, or Z direction.
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6 To specifically define a cut plane, click Add, and enter the height of the 
new cut plane:

Below and Above components

You can click Remove to delete a cut plane that you added.

7 Click OK to exit all dialog boxes.

Attaching Notes and Files to a Curtain Wall Unit 
Style

Use this procedure to enter notes and attach reference files to a curtain wall 
unit style. You can also edit notes and edit or detach reference files from a 
curtain wall unit style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Curtain Wall Unit Styles.

3 Right-click the curtain wall unit style you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the curtain wall unit style, enter the description 
for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

If you add a cut plane . . . Then . . .

at a height that is lower than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Below Cut Plane component 
on the Layer/Color/Linetype tab.

at a height that is higher than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Above Cut Plane component 
on the Layer/Color/Linetype tab.
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8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

Using Overrides in Curtain Wall Units

Curtain wall units are subunits of geometrically complex curtain walls, 
which often have a large number of different elements, like frames, panels, 
and infills. Most of these settings are defined in the style. However, there are 
cases when modifying a curtain wall unit directly on screen is more suitable:

� You want to add custom frame or mullion edges to a curtain wall unit and 
need direct visual feedback. 

� You want to create an override, like a merged infill or nested grid, in only 
one specific place in the curtain wall unit. 

� You want to experiment with different visuals without having to change 
the curtain wall unit style for each idea immediately.

When you have finished your onscreen edits, you can decide if you want to 

� Apply the overrides to the curtain wall unit you have edited.
� Save the overrides to the current curtain wall unit style.
� Create a new style for the overrides.

Overrides you can set include assigning a different definition to a selected 
cell, frame, or mullion, and assigning a profile to a frame or mullion edge. 
Note that the definition or profile must already exist in the current drawing 
before you can use it as an override. 

Overrides do not affect the Design Rules for the curtain wall unit style. How-
ever, you can transfer overrides to a curtain wall unit style if you want all cur-
tain wall units of that style to have the same overrides. 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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You can view a list of overrides that are currently assigned to a curtain wall 
unit from the Overrides tab of the Curtain Wall Unit Properties dialog box. 
For more information, see “Removing Curtain Wall Unit Overrides” on 
page 988.

NOTE Overrides are also listed on the Overrides tab in the Curtain Wall Unit 
Style Properties dialog box.

Related Topics

� Overriding Curtain Wall Unit Infills

� Overriding Curtain Wall Unit Frames and Mullions

� Overriding Curtain Wall Unit Divisions

� Removing Curtain Wall Unit Overrides

Overriding Curtain Wall Unit Infills

The cell infills of a curtain wall unit are set in the curtain wall unit style. You 
can however, create overrides for these infill overrides in cells. For example, 
you might want a row of normal rectangular panel infills for a first floor 
facade. In one specific position, however, you want a decorative nested grid. 
In this case, you would set the row of concrete panels in the curtain wall unit 
style, and then override the panel at one specific place with the nested grid.

Curtain wall unit infills can consist of simple panels or nested grids. You can 
change one infill for another, merge cells, or remove frames from an infill 
altogether. 

Related Procedures

� Turning on Cell Markers for Curtain Wall Units

� Merging Curtain Wall Unit Cells

� Creating a Curtain Wall Unit Infill Override

Turning on Cell Markers for Curtain Wall Units
Use this procedure to turn on the cell markers for each grid cell in a curtain 
wall unit. The cell markers must be on in order to select individual cells and 
make changes to them.
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Viewing Cell Markers

1 Select the curtain wall unit for which you want to create an infill override. 

2 Right-click, and click Infill ➤ Show Markers. 

Merging Curtain Wall Unit Cells
Use this procedure to merge two curtain wall unit cells.

NOTE To merge curtain wall unit cells, the cell markers need to be visible. For 
information on turning on cell markers, see “Turning on Cell Markers for Curtain 
Wall Units” on page 970.

You can only merge cells that are adjacent to each other.

In most cases, you merge cells with the same infill type. The merged cell is 
then of the same type as the original cells. For example, if you merge two 
solid panel infills, the resulting merged cell also has a solid panel infill. In 
some cases, however, you might want to merge two cells that have different 
infill types. In that case, the infill type of the first selected cell is used for the 
merged cell. For example, if you want to merge a cell with a simple panel 
infill and a cell with a nested grid, and you select the cell with the simple 
panel first during the merge command, the merged cell contains a simple 
panel infill, and not a nested grid. If you select the two cells in the opposite 
order, the merged cell contains a nested grid and no simple panel infill. 
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Merging two cells

1 Select the curtain wall unit on which you want to merge two cells.

2 Right-click, and click Infill ➤ Merge.

3 Select the first cell to be merged.

4 Select the second cell to be merged.

The cells are merged into one. 

5 Specify where you want to save the curtain wall unit override.

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall unit

no further steps are necessary. The override is saved 
to the curtain wall unit. For information about how 
to remove an override from a curtain wall unit, see 
“Removing Curtain Wall Unit Overrides” on 
page 988.

to a curtain wall unit style select the curtain wall unit, right-click, and select 
Design Rules ➤ Transfer to Object. 
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6 If you have chosen to save the override to a curtain wall unit style, select 
the curtain wall unit again, right-click and click Design Rules ➤ Save to 
Style and decide to which curtain wall unit style you want to save the 
override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the curtain wall unit, where they can be removed as described 
in “Removing Curtain Wall Unit Overrides” on page 988, but they are not 
saved back to a curtain wall unit style.

Creating a Curtain Wall Unit Infill Override
Use this procedure to override the infill of a curtain wall unit cell.

For example, you might have a row of simple concrete panels in your curtain 
wall unit, but want in one location a nested grid instead of the concrete 
panel. In that case, it might be simpler to use an infill override, instead of cre-
ating a complex curtain wall unit style setting. 

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
unit style

select Transfer Merge Operations to Style, and 
click OK. 

NOTE If you have created only a cell merge, 
only the Transfer Merge Operations to Style 
checkbox is active. If you have also created other 
overrides, such as a new cell assignment or a 
frame or mullion edge override, these 
checkboxes are available as well. If you also want 
to save these overrides to the style, select their 
checkboxes too. 

to a new curtain wall unit 
style

select Transfer Merge Operations to Style, and 
click New. Enter a name for the new curtain wall 
unit style, and click OK.

NOTE If you have created only a cell merge, 
only the Transfer Merge Operations to Style 
checkbox is active. If you have also created other 
overrides, such as a new cell assignment or a 
frame or mullion edge override, these 
checkboxes are available as well. If you also want 
to save these overrides to the style, select their 
checkboxes too. 
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NOTE To override an infill assignment, the cell markers need to be visible. For 
information on turning on cell markers, see “Turning on Cell Markers for Curtain 
Wall Units” on page 970.

To exchange an infill definition, the new infill definition must already be 
defined in the curtain wall unit style. For information on creating infill def-
initions, see “Defining Infills for Curtain Wall Unit Cells” on page 927.

Overriding a curtain wall unit cell definition

1 Select the curtain wall unit on which you want to override an infill.

2 Right-click, and click Infill ➤ Override Assignments. 

3 Select the marker of the cell where you want to create an override. 
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4 Create the override:

5 Click OK.

6 Specify where you want to save the curtain wall unit override.

7 If you have chosen to save the override to a curtain wall unit style, select 
the curtain wall unit again, right-click and click Design Rules ➤ Save to 

If you want to . . . Then . . .

exchange the existing 
infill for another

select a new infill definition from the list. 

NOTE To exchange an infill definition, the new infill 
definition must already be defined in the curtain wall 
unit style. 

remove one or more of 
the frames around the 
infill

select the frame component to be removed.

remove the complete 
infill and its frame

select Remove Infill and Frames. 

NOTE This works only for infills that are bordering 
the exterior of the curtain wall unit.

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall unit

no further steps are necessary. The override is saved 
to the curtain wall unit. For information about how 
to remove an override from a curtain wall unit, see 
“Removing Curtain Wall Unit Overrides” on 
page 988.

to a curtain wall unit style select the curtain wall unit, right-click, and select 
Design Rules ➤ Transfer to Object. 
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Style and decide to which curtain wall unit style you want to save the 
override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the curtain wall unit, where they can be removed as described 
in “Removing Curtain Wall Unit Overrides” on page 988, but they are not 
saved back to a curtain wall unit style.

Overriding Curtain Wall Unit Frames and 
Mullions

You can change a selected frame edge or mullion edge by using an edge 
assignment override.

NOTE To exchange a frame edge or mullion edge, the new edge definition 
must already be defined in the curtain wall unit style.

Removing the edge does not affect the width of the cell. To remove the edge 
and have the adjacent cell resize, create an edge definition with a width and 

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
unit style

select Transfer Cell Overrides to Style, and click 
OK. 

NOTE If you have created only an infill override, 
only the Transfer Cell Overrides to Style checkbox 
is active. If you have also created other overrides, 
such as a cell merge or a frame or mullion edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too.

to a new curtain wall unit 
style

select Transfer Cell Overrides to Style, and click 
New. Enter a name for the new curtain wall unit 
style, and click OK.

NOTE If you have created only an infill override, 
only the Transfer Cell Overrides to Style checkbox 
is active. If you have also created other overrides, 
such as a cell merge or a frame or mullion edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too.
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depth of zero. For more information, see “Defining a Curtain Wall Unit 
Frame by Width and Depth” on page 934 or “Defining Curtain Wall Unit 
Mullions by Width and Depth” on page 940.

You can also create a new edge profile by drawing a polyline or using an exist-
ing profile in the drawing. This edge profile can be interactively edited 
onscreen using in-place editing.

Related Procedures

� Creating a Curtain Wall Unit Frame or Mullion Override

� Creating a Curtain Wall Unit Frame or Mullion Edge from a Polyline or 
Profile

� In-Place Editing of Edge Profiles for Curtain Wall Units

Creating a Curtain Wall Unit Frame or Mullion Override
Use this procedure to override an individual frame or mullion in a curtain 
wall unit. 

To exchange a frame or mullion, the new definition must already be defined 
in the curtain wall unit style. For information on creating frames and mul-
lions, see “Defining Curtain Wall Unit Frames” on page 932 and “Defining 
Curtain Wall Unit Mullions” on page 939

1 Select the curtain wall unit on which you want to override an edge.

2 Right-click, and click Frame/Mullion ➤ Override Assignment. 

3 Select the frame or mullion edge you want to override.
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4 Create the override:

5 Click OK.

6 Specify where you want to save the curtain wall unit override.

7 If you have chosen to save the override to a curtain wall unit style, select 
the curtain wall unit again, right-click and click Design Rules ➤ Save to 
Style and decide to which curtain wall unit style you want to save the 
override. 

If you want to . . . Then . . .

exchange the existing 
edge for another

select a new edge definition from the list. 

NOTE To exchange an edge definition, the new 
edge definition must already be defined in the 
curtain wall unit style.

remove the frame or 
mullion edge

select Remove Edge.

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall unit

no further steps are necessary. The override is saved 
to the curtain wall unit. For information about how 
to remove an override from a curtain wall unit, see 
“Removing Curtain Wall Unit Overrides” on 
page 988.

to a curtain wall unit style select the curtain wall unit, right-click, and select 
Design Rules ➤ Transfer to Object. 

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
unit style

select Transfer Edge Overrides to Style, and click 
OK. 

NOTE If you have created only a frame or 
mullion edge override, only the Transfer Edge 
Overrides to Style checkbox is active. If you have 
also created other overrides, such as a cell merge 
or a division override, these checkboxes are 
available as well. If you also want to save these 
overrides to the style, select their checkboxes too.
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NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the curtain wall unit, where they can be removed as described 
in “Removing Curtain Wall Unit Overrides” on page 988, but they are not 
saved back to a curtain wall unit style.

Creating a Curtain Wall Unit Frame or Mullion Edge from a 
Polyline or Profile
You can assign a profile to any vertical edge of a frame or mullion. The profile 
can be any profile or any closed polyline that you specify. You can use a pro-
file edge to create a unique corner in situations where a simple miter is not 
sufficient. 

NOTE Adjacent infills are not trimmed or expanded to accommodate the new 
edge. To adjust the infill, change the width of the frame edge. For more infor-
mation, see “Defining a Curtain Wall Unit Frame by Width and Depth” on 
page 934.

Overriding edge profile

to a new curtain wall unit 
style

select Transfer Edge Overrides to Style, and click 
New. Then, enter a name for the new curtain wall 
style, and click OK.

NOTE If you have created only a frame or 
mullion edge override, only the Transfer Edge 
Overrides to Style checkbox is active. If you have 
also created other overrides, such as a cell merge 
or a division override, these checkboxes are 
available as well. If you also want to save these 
overrides to the style, select their checkboxes too.

If you want to save 
the override . . .

Then . . .
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1 Draw a closed polyline in the location where you want it to display in the 
curtain wall unit. 

NOTE For best results, it is recommended that you draw the polyline in 
Plan view. 

2 Select the curtain wall for which you want to create a frame or mullion 
edge profile override.

3 Right-click, and click Frame/Mullion ➤ Add Profile. 

4 Select a vertical frame or mullion edge.

5 Select a profile for the override:

6 Specify where you want to save the curtain wall unit override.

7 If you have chosen to save the override to a curtain wall unit style, select 
the curtain wall unit again, right-click and click Design Rules ➤ Save to 

If you want to create 
the edge profile . . .

Then . . .

from the polyline drawn in 
step 1

select it in the drawing, and enter a name for it. 
Click OK.

from an existing profile in 
the drawing

press ENTER, select the  profile, and click OK. 

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall unit

no further steps are necessary. The override is saved 
to the curtain wall unit. For information about how 
to remove an override from a curtain wall unit, see 
“Removing Curtain Wall Unit Overrides” on 
page 988.

to a curtain wall unit style select the curtain wall unit, right-click, and select 
Design Rules ➤ Transfer to Object. 
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Style and decide to which curtain wall unit style you want to save the 
override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the curtain wall unit, where they can be removed as described 
in “Removing Curtain Wall Unit Overrides” on page 988, but they are not 
saved back to a curtain wall unit style.

In-Place Editing of Edge Profiles for Curtain Wall Units
Use this procedure to edit profile edges with in-place editing.

With in-place editing, you can edit the profile directly and interactively on 
screen, and later save the changes to the profile definition.

1 Select a curtain wall unit that has the edge profile you want to edit 
onscreen with in-place editing. 

2 Right-click, and click Frame/Mullion ➤ Edit Profile In Place. 

This command is only available if you have profile-based edges in the cur-
tain wall unit.

If you want to . . . Then . . .

to the current curtain wall 
unit style

select Transfer Edge Profile Overrides to Style, 
and click OK. 

NOTE If you have created only a profile edge 
override, only the Transfer Edge Profile Overrides 
to Style checkbox is active. If you have also 
created other overrides, such as a cell merge or a 
division override, these checkboxes are available 
as well. If you also want to save these overrides to 
the style, select their checkboxes too.

to a new curtain wall unit 
style

select Transfer Edge Overrides to Style, and click 
New. Enter a name for the new curtain wall unit 
style, and click OK.

NOTE If you have created only a profile edge 
override, only the Transfer Edge Profile Overrides 
to Style checkbox is active. If you have also 
created other overrides, such as a cell merge or a 
division override, these checkboxes are available 
as well. If you also want to save these overrides to 
the style, select their checkboxes too.
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NOTE If the profile is not drawn to size, it must be converted in order for 
you to begin the in-place editing session. Click Yes if prompted to convert the 
profile to its actual size.

3 Select the edge you want to edit. 

NOTE You have entered the in-place editing session now. You can see this 
from the magenta colored grips and light blue hatch of the temporary in-
place editing profile, as well as the faded color of all other objects in the draw-
ing. Note that while you are in the in-place editing session, you have only lim-
ited editing access to other commands in the drawing. Before working on 
other objects, you should first end the in-place editing session.

4 Edit the profile:

If you want to . . . Then . . .

use grips to edit the 
profile

move the grips as needed.

add a vertex to the 
profile

select the profile, right-click and click Add Vertex. Add 
new vertices as needed. Press ENTER. 

remove a vertex from 
the profile

select the profile, right-click and click Remove Vertex. 
Remove vertices as needed. Press ENTER. 

add a ring to the profile select the profile, right-click and click Add Ring. Select 
a closed polyline, spline, ellipse, or circle for an 
additional ring. Specify if you want to erase the source 
linework, and press ENTER. 

remove a ring from a 
profile

select the profile, right-click and click Remove Ring. 
Select the ring you want to remove. 

NOTE You cannot remove the last ring from a profile.

replace a ring on a 
profile

select the profile, right-click and click Replace Ring. 
Select a closed polyline, spline, ellipse, or circle for the 
replaced ring. Specify if you want to erase the source 
linework, and press ENTER. 
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5 Save the changes to the profile.

Overriding Curtain Wall Unit Divisions

The grid of a curtain wall unit is made up of one or more divisions that define 
how the curtain wall unit is partitioned. Divisions can be horizontal or ver-
tical and can be nested in each other. For detailed information on curtain 
wall unit divisions, see “Defining Divisions for Curtain Wall Unit Grids” on 
page 918.

You can override a division in a curtain wall unit, thereby changing the grid 
of the curtain wall unit.

Overriding number of Curtain Wall Unit cells

Related Topics

� Creating a Curtain Wall Unit Division Override

If you want to . . . Then . . .

change the existing profile 
definition to reflect the 
new shape

select the profile, right-click, and click Save. The in-
place edit session is exited and the profile definition 
is updated.

create a new profile 
definition with the shape 
you have created

select the profile, right-click, and click Save As New 
Profile. Enter a name for the new profile and click 
OK. The in-place edit session is exited and the new 
profile definition is available in the Style Manager.

discard all changes on the 
profile and revert back to 
the previous shape

select the profile, right-click, and click Discard all 
Changes. The in-place edit session is exited and all 
changes you have made to the profile are purged.
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� In-Place Editing of Curtain Wall Unit Divisions

Creating a Curtain Wall Unit Division Override
Use this procedure to create a division override on a curtain wall unit.

NOTE To exchange a curtain wall unit division, the new division definition 
must already be defined in the curtain wall unit style. For information on curtain 
wall unit divisions, see “Defining Divisions for Curtain Wall Unit Grids” on 
page 918. 

1 Select the curtain wall unit for which you want to create a division over-
ride.

2 Right-click, and click Division ➤ Override Assignment.

3 Select an edge of the curtain wall unit to determine if a horizontal or ver-
tical division is overridden. 

For example, if you want to override the primary horizontal division, you 
could select the bottom horizontal frame of the curtain wall unit. 

TIP The Division Assignment Override dialog box shows you which grid 
type and which grid division you have selected, e.g., Selected Nested Grid: 
Secondary Grid, Division Element Definitions: Vertical 3 Cells. If you acciden-
tally selected the wrong division, click Cancel and reselect the correct grid.

4  Select the appropriate division override, and click OK.

5 Specify where you want to save the curtain wall unit override.

6 If you have chosen to save the override to a curtain wall unit style, select 
the curtain wall unit again, right-click and click Design Rules ➤ Save to 

If you want to save 
the override . . .

Then . . .

only on this specific 
curtain wall unit

no further steps are necessary. The override is saved 
to the curtain wall unit. For information about how 
to remove an override from a curtain wall unit, see 
“Removing Curtain Wall Unit Overrides” on 
page 988.

to a curtain wall unit style select the curtain wall unit, right-click, and select 
Design Rules ➤ Transfer to Object. 
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Style and decide to which curtain wall unit style you want to save the 
override. 

NOTE If you do not want to save the override back to a style at all, right-
click and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the curtain wall unit, where they can be removed as described 
in “Removing Curtain Wall Unit Overrides” on page 988, but they are not 
saved back to a curtain wall unit style.

In-Place Editing of Curtain Wall Unit Divisions 
Use this procedure to edit divisions using in-place editing.

With in-place editing, you can edit the curtain wall unit directly and interac-
tively on screen, and later save the changes to the curtain wall unit or curtain 
wall unit style.

1 Select a curtain wall unit on which you want to edit divisions onscreen 
with in-place editing. 

If you want to save 
the override . . .

Then . . .

to the current curtain wall 
unit style

select Transfer Division Overrides to Style, and 
click OK. 

NOTE If you have created only a profile edge 
override, only the Transfer Division Overrides to 
Style checkbox is active. If you have also created 
other overrides, such as a cell merge or a edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too.

to a new curtain wall unit 
style

select Transfer Division Overrides to Style, and 
click New. Enter a name for the new curtain wall 
unit style, and click OK.

NOTE If you have created only a profile edge 
override, only the Transfer Division Overrides to 
Style checkbox is active. If you have also created 
other overrides, such as a cell merge or a edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too.
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2 Specify the mode in which to edit the curtain wall unit:

3 Click the Edit Grid grip.

4 Select an edge on the division you want to edit. 

For example, if you want to edit the primary grid, select an edge on the 
outer curtain wall unit frame. 

Viewing Curtain Wall Unit primary division edit in-place grips

NOTE You have entered the in-place editing session now. You can see this 
from the faded color of all objects in the drawing, as well as from the different 
grips at your disposal. Note that while you are in the in-place editing session, 
you have only limited editing access to other commands in the drawing. 
Before working on other objects, you should first end the in-place editing ses-
sion.

If you want to edit . . . Then . . .

this instance of the curtain wall unit right-click, and click Design 
Rules ➤ Transfer to Object.

the curtain wall unit style right-click, and click Design 
Rules ➤ Revert to Style Design Rules.
If this option is not available, the 
design rules are already style-based for 
the curtain wall unit.
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Viewing Curtain Wall Unit edit in-place grips for adding and removing bays

5 Edit the division:

If you want to . . . Then . . .

add a bay to the grid click the Add Bay grip.

remove a bay from the 
grid

click the Remove Bay grip.

change the start offset 
of the grid

select the Start Offset grip and move it to the  
position.

change the end offset of 
the grid

select the End Offset grip and move it to the  position.

change the spacing of 
bays

click the Auto Grid Bay Spacing grip and move it to 
the  position.

manually edit the grid right-click and click Convert To Manual.
You can manually add and remove gridlines, change 
the offsets, and change the position of individual 
gridlines.

use a worksheet to edit 
the cell dimensions

click the Set Fixed Cell Dimension Rules command 
grip, and edit the values in the worksheet.
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6 Save or discard changes to the curtain wall unit grid:

7 In the Save Changes dialog box, specify to which division to save the 
changes:

Removing Curtain Wall Unit Overrides

Use this procedure to remove curtain wall unit overrides either from the cur-
tain wall unit or the curtain wall unit style.

If you want to exit the in-
place editing session . . .

Then . . .

without saving your changes

click  on the In-Place Edit 
toolbar.

after saving your changes

click  on the In-Place Edit 
toolbar.
If you edited the grid by instance, the 
changes are saved to the design rules 
for the individual grid. If you edited the 
curtain wall unit style, the Save 
Changes dialog box is displayed.

If you want to . . . Then . . .

save the changes to the style in the 
current curtain wall unit division

verify the current division is selected 
for Save Changes to Existing Division, 
and click Save.
The changes are made in the style and 
affect all curtain wall units of that style 
in the drawing.

create an override to the style by 
saving the changes in a new curtain 
wall unit division

click New, enter a name for the new 
division override, and click OK. Click 
Save.
The changes are saved as an override 
to the style, and affect only the curtain 
wall units to which the override is 
applied.
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1 Select the curtain wall unit:

2 Select an override from the list and click Remove.

3 Click OK.

Editing Curtain Wall Units

Most relevant settings for a curtain wall unit are defined in the curtain wall 
unit style. These include divisions, infills, frames, and mullions. For informa-
tion on modifying a curtain wall unit style, see “Curtain Wall Unit Styles” on 
page 915.

You can make other changes directly to individual curtain wall units. These 
changes affect only the curtain wall unit you select:

� Dimensions of a curtain wall unit
� Roof and floor line settings
� Interference conditions
� Cleanup settings

Methods of Editing Curtain Wall Units
Autodesk Architectural Desktop offers several methods for editing curtain 
wall units:

� You can directly edit curtain wall units using grips for dimensions and 
other physical characteristics.

� You can change curtain wall unit settings on the Properties palette.
� You can select editing commands from the context menu for a selected 

curtain wall unit.

Related Procedures

� Using Grips to Edit Curtain Wall Units

If you want to 
remove an 
override . . .

Then . . .

from a curtain wall unit select the curtain wall unit, right-click and click 
Curtain Wall Unit Properties. Click the Overrides 
tab.

from the curtain wall unit 
style

select the curtain wall unit, right-click, and click Edit 
Curtain Wall Style. Click the Overrides tab.
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� Selecting a Different Curtain Wall Unit Style

� Changing the Dimensions of a Curtain Wall Unit

� Specifying a Miter Angle for a Curtain Wall Unit Adjacent to Another 
Object

� Changing the Location of a Freestanding Curtain Wall Unit

� Modifying the Position of Anchored Curtain Wall Units

� Attaching Hyperlinks, Notes, or Files to a Curtain Wall Unit

Using Grips to Edit Curtain Wall Units

Refer to the illustrations and steps in this topic to use curtain wall unit grips 
to edit curtain wall units.

Editing Curtain Wall Unit Dimensions

1 Select the curtain wall unit.

2 Select the grip for the dimension you want to change.

You can modify the dimensions of the base height and length for a curtain 
wall.
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Viewing Curtain Wall Unit Lengthen and Base Height grips

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Changing the Location or Position of a Curtain Wall Unit

1 Select the curtain wall unit.

2 Move the appropriate grip to change the location of the curtain wall unit, 
its start point, or its end point.
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Viewing Curtain Wall Start, End, Location, and Reverse Direction Grips

Changing the Base Height of a Curtain Wall Unit

Use this procedure to change the base height of a curtain wall unit. You can 
also change the base height on the Properties palette.

1 Select the curtain wall unit.

2 Select the Base Height grip, move the grip until the height value you want 
is displayed, and click once.

As you move the grip, the original base height value is displayed in addi-
tion to the new base height and the difference between the two values.
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After selecting the grip, you can also enter a new value for the base height 
of the curtain wall.

Changing the Length of a Curtain Wall Unit

Use this procedure to change the length of a curtain wall unit. You can also 
change the length on the Properties palette. For more information, see 
“Changing the Dimensions of a Curtain Wall Unit” on page 995.

1 Select the curtain wall unit.

2 Select the Lengthen grip, move the grip until the length value you want is 
displayed, and click once.

As you move the grip, the original length value is displayed in addition to 
the new length and the difference between the two values.

After selecting the grip, you can also enter a new value for the length of 
the curtain wall.
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Selecting a Different Curtain Wall Unit Style

Use this procedure to select a different style for the curtain wall unit.

1 Select the curtain wall unit for which you want to change the style.

You can select multiple curtain wall units and change the style for all at 
the same time.

2 On the Properties Palette, scroll to the General subcategory.

3 Select a different style.

Matching the Properties of an Existing Curtain 
Wall Unit

Use this procedure to apply the properties of a curtain wall unit tool to one 
or more existing curtain wall units. The properties include the curtain wall 
unit style and any other settings specified in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a curtain wall unit tool, and click Apply Tool Properties 
to ➤ Curtain Wall Unit.

3 Select the curtain wall units, and press ENTER.

The properties of the selected curtain wall units match the properties of 
the curtain wall unit tool.
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Changing the Dimensions of a Curtain Wall Unit 

Use this procedure to change the dimensions of a curtain wall.

1 Select a curtain wall unit.

2 Expand Dimensions.

3 Change the dimension.

Specifying a Miter Angle for a Curtain Wall Unit 
Adjacent to Another Object

Use this procedure to manually create a mitered corner between a curtain 
wall unit and another object, such as a standard wall or a mass element. For 
example, if your curtain wall unit connects with a standard wall that is at 60-
degree angle from the curtain wall unit, you would specify the miter angle as 
30.

The miter angle applies to all infills and horizontal edges that are adjacent to 
the corner. Vertical edges are not affected.

TIP To quickly identify the start and end of a curtain wall unit, select the curtain 
wall unit. The Reverse Direction grip points toward the end of the curtain wall 
unit.

1 Select a curtain wall unit.

2 Expand Dimensions.

Dimension Description

Height Height of the curtain wall unit from the baseline 

Length Length of a straight curtain wall unit from the start grip 
on the baseline to the end grip

Start Miter Angle of all infills and horizontal edges (frame or 
mullion) at the start of the curtain wall unit. For more 
information about miter angles, see “Mitering Curtain 
Walls” on page 889.

End Miter Angle of all infills and horizontal edges (frame or 
mullion) at the end of the curtain wall unit. For more 
information about miter angles, see “Mitering Curtain 
Walls” on page 889.
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3 Miter the curtain wall unit on the start or the end point:

Changing the Location of a Freestanding Curtain 
Wall Unit

Use this procedure to relocate a freestanding curtain wall unit by changing 
the coordinate values of its insertion point. The curtain wall unit also has an 
orientation with respect to the WCS or the current UCS. For example, if the 
top and bottom of the curtain wall unit are parallel to the XY plane, its nor-
mal is parallel to the Z axis. You can change the orientation of the curtain 
wall unit by aligning its normal with another axis. You can also rotate the 
curtain wall unit on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Double-click the curtain wall unit you want to change.

2 Expand Location.

3 Click Additional information.

4 Specify the location of the curtain wall unit:

If you want to miter 
the curtain wall 
unit . . .

Then . . .

at its start point enter an angle for Start Miter Angle, and press 
ENTER.

at its end point enter an angle for End Miter Angle, and press 
ENTER.

If you want to . . . Then . . .

relocate the curtain wall 
unit

enter new coordinate values under Insertion Point.

locate the curtain wall unit 
on the XY plane

make the normal of the wall parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the curtain wall unit 
on the YZ plane

make the normal of the curtain wall unit parallel to 
the X axis: under Normal, enter 1 for X and enter 0 
for Y and Z. 
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5 Click OK.

Modifying the Position of Anchored Curtain Wall 
Units

When you use a curtain wall unit as an infill for a curtain wall or a door/win-
dow assembly, the curtain wall unit is anchored to the other object. While 
anchored, the curtain wall unit moves when you move the curtain wall and 
is erased when you erase the curtain wall.

You can change the orientation, alignment, or offset of the curtain wall unit 
without affecting the anchor. 

NOTE For information about releasing the curtain wall unit anchor so that it 
moves and erases independently from the curtain wall, see “Releasing an Object 
Anchored in a Curtain Wall” on page 908.

Related Procedures

� Changing the Orientation of an Anchored Curtain Wall Unit

� Changing the Alignment of an Anchored Curtain Wall Unit

� Changing the Offset of an Anchored Curtain Wall Unit

Changing the Orientation of an Anchored Curtain Wall Unit
Use this procedure to change the orientation of an anchored curtain wall 
unit using grips.

1 Click the anchored curtain wall unit for which you want to change the 
orientation.

2 Click the appropriate Flip grip to change the X or Y direction of the object. 

You can also change the orientation of an object, including the Z direc-
tion, using the Anchor worksheet found on the object’s Properties palette.

locate the curtain wall unit 
on the XZ plane

make the normal of the curtain wall parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
curtain wall unit

enter a new value for Rotation Angle.

If you want to . . . Then . . .
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Changing the Alignment of an Anchored Curtain Wall Unit
Use this procedure to change the alignment of a curtain wall unit anchored 
into a curtain wall. 

1 Double-click the anchored curtain wall unit.

2 Expand Location, and click Anchor.

3  Click Allow Variation from Infill Element Definition.

4 Select a new alignment for the curtain wall unit. 

For more information, see “Specifying an Alignment for a Curtain Wall 
Unit Infill” on page 930.

5 Click OK.

Changing the Offset of an Anchored Curtain Wall Unit
Use this procedure to change the offset of an anchored curtain wall unit.

1 Double-click the anchored curtain wall unit.

2 Expand Location, and click Anchor.

3 Click Allow Variation from Infill Element Definition.

4 Specify a new offset for the curtain wall unit. 

For more information, see “Specifying an Offset for a Curtain Wall Unit 
Infill” on page 930.

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a 
Curtain Wall Unit

Use this procedure to enter notes and attach reference files to a curtain wall 
unit. You can also edit notes and edit or detach reference files from a curtain 
wall unit.

1 Double-click the curtain wall unit.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add a note, click the setting for Notes, and enter the text.

5 Click OK.
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6 Click under Reference documents, and attach, edit, or detach a reference 
file:

7 Click OK twice.

Facet Deviation
The smoothness (tesselation) of curved curtain wall edges is controlled by the 
FACETDEV variable. Specify the facet deviation to set the number of facets to 
display on curved objects. This must be set before converting a polyline to a 
curtain wall.

The facet deviation is available only on the command line by typing 
AecFacetDev.

The number you set as the facet deviation defines the maximum distance 
from the chord to the arc, the chord being an edge that is created from 
faceting the curve, to the true mathematical arc. The facet deviation has a 
range of greater than zero (0) and no upper limit.

The minimum number of facets is 8. For example, when you create a cylinder 
mass element with a 1' radius, and specify a FACETDEV value of 1', the cyl-
inder has 8 faces.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click the description. Enter the 
new text, and press ENTER.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Doors

A door is an AEC object that interacts with walls and 

space boundaries. You can also create freestanding doors 

for door-type drawings.

In this chapter

� Using Door Tools to Create 
Doors

� Creating a Door

� Creating a Door with User-
specified Settings

� Creating a Door Tool

� Editing Doors

� Door Styles

15
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Creating Doors
You can create doors using the typical design parameters for style, standard 
size, width and height, threshold height, and head height. You can choose 
styles with glass shapes that receive standard muntins patterns, and create 
your own custom glass shapes from profiles. 

Doors Styles
Autodesk® Architectural Desktop provides ready-to-use door styles. The 
design rules of a door style determine the default dimensions of doors and 
the door shape and type

� The door shape determines the geometry of the door panel, such as rect-
angular, half-round, and arch. You can also create custom door shapes 
from profiles.

� The door type determines the number of panels and the method of open-
ing the door, such as single, double, bifold, pocket, revolving, and over-
head.

You can define standard sizes in a door style and then select the size you want 
to use when you place the door in a drawing.

Anchoring Doors
After a door is placed in a wall or space boundary, the door is constrained to 
the object and cannot move outside it. 

Doors can also be anchored to specific locations in walls or space boundaries, 
so that when the wall or space boundary moves or changes size, the location 
of the door in that object remains constant. 

Door Dimensions
Some door dimensions depend on the shape and type specified in the door 
style.

Rise is the height from the top of the rectangular portion of a door to the 
peak of the door opening for Gothic, Arch, and Peak Pentagon door shapes. 

Leaf specifies the door size for pairs of Uneven, Uneven-Dhung, and Uneven 
Opposing door types. For more information about leaf, see “Changing the 
Door Leaf” on page 1020.

Vertical Alignment of Doors
You use vertical alignment settings to control the placement of the door in 
the wall, the location of the working point vertically in the wall, and how the 
door responds to modifications in height. To determine the working point 
on the door, use the threshold and head height settings. You can place the 
working point at the sill or at the head. For example, if you specify the verti-
cal alignment as 0'' and the door height as 7'–0'', the door opening height is 
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7’–0''. If you next specify the height of the door as 6'–8'', the door threshold 
remains at 0'' and the door opening height becomes 6’–8''.

For the door head working point, if you specify the vertical alignment as 
7'–0'' and the door height as 7'–0'', the door opening height is 7–0''. If you 
specify the door height as 6'–8'', the door head remains at 7'–0'' and the door 
threshold becomes 4''.

Materials in Doors
You can assign materials to a door. Materials are displayed in wireframe and 

working shade views, or when linked in VIZ® Render. Materials have specific 
settings for individual components of a door, such as the panel, the stop, the 
frame, or a glass inset.

Doors in 2D wireframe and rendered views

Autodesk Architectural Desktop provides predefined materials for common 
design purposes, which contain settings for doors. You can use the pre-
defined materials “as is,” or modify them for your special designs. You can 
also create your own materials. Styles provided with the software have appro-
priate materials already assigned to them. For more information, see “About 
Door Display Components and Materials” on page 1043.

Related Topics and Procedures

� Using Door Tools to Create Doors

� Editing Doors

� Door Styles
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Using Door Tools to Create Doors

Door tools provided with Autodesk® Architectural Desktop let you quickly 
place doors. A door tool has a specific style and other predefined proper-
ties.You can also use door tools to apply properties to existing doors.

The following palettes contain one or more door tools:

Door tools are also included in the Autodesk Architectural Desktop Stock 
Tool catalog supplied with the Content Browser. For information about using 
the Content Browser, see “Content Browser.”

You can use the default settings of a door tool, or you can change settings for 
any door properties that are not controlled by the style.

Related Procedures

� Creating a Door

� Creating a Door with User-specified Settings

� Creating a Door Tool

Creating a Door

Use this procedure to add a door that has the properties specified in the door 
tool that you select. To specify settings when you add a door, see “Creating a 
Door with User-specified Settings” on page 1005.

1 Open the tool palette that you want to use, and select a door tool.

If necessary, scroll the palette to display the tool that you want to use.

Palette Tools

Design Contains a door tool for the Standard door 
style and default settings for other door 
properties

Doors Contains door tools for sample door styles, 
with default properties appropriate for each 
door style

Custom tool palettes created 
by your CAD manager

Contain door tools with styles and properties 
customized for your projects or office 
standards
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2 Select a wall or space boundary in which to insert the door, or press ENTER 
to add a freestanding door.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the insertion point of the door.

4 Continue adding doors, and press ENTER.

Creating a Door with User-specified Settings

Use this procedure to create any of the following, with settings that you spec-
ify:

� Freestanding doors
� Doors in walls
� Doors in space boundaries
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Adding a door to a wall

1 Open the tool palette that you want to use, and select a Door tool.

If necessary, scroll the tool palette to display the tool you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a door style.

4 Expand Dimensions.

5 Specify a door size: 

If you want to . . . Then . . .

use a standard door size click Standard Sizes, and then select a 
door size.

use a custom door size enter values for Width and Height.
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6 Enter values for rise and leaf.

These values depend on the selected style and door type.

7 Enter a value for swing angle or opening percent.

Zero indicates a closed door.

8 Expand Location.

9 If you are placing the door in a wall or a space boundary, specify the door 
position:

10 Specify whether you want the door to be aligned vertically by threshold 
height or by head height:

11 Specify the insertion point for a door in a wall or space boundary, or for a 
freestanding door:

If you want to . . . Then . . .

position the door at a specific 
distance between the edge of 
the opening and the end of a 
wall segment or space 
boundary

Select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.

center the door on a wall 
segment or space boundary

Select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall segment or space boundary.

position the door anywhere 
along the wall or space 
boundary

click Position along wall, and select 
Unconstrained.

If you want to . . . Then . . .

align the door by threshold 
height

select Threshold for Vertical alignment, 
and enter a value for Threshold height.

align the door by head height select Head for Vertical alignment, and 
enter a value for Head height.

If you want to . . . Then . . .

insert a door in a wall select the wall and specify an insertion 
point along the wall.
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12 Continue to place doors, and press ENTER when you are finished.

Creating a Door Tool

Use this procedure to create a door tool and add it to a tool palette. You may 
want to create your own door tools if you are placing multiple doors of spe-
cific styles that have the same properties.

For example, you are creating an office floor plan that contains two custom 
door styles: single solid doors for offices, and solid double doors for confer-
ence rooms. To work efficiently, you can create a door tool for each style. You 
can then select the appropriate tool to place doors in offices and conference 
rooms.

You can use any of the following methods to create a door tool:

� Drag a door that has the properties you want to a tool palette.
� Drag a door style from the Style Manager to a tool palette, and then cus-

tomize the properties of the new tool.
� Copy an existing tool, and then customize the properties of the new tool.
� Drag a tool from a tool catalog in the Content Browser, and then custom-

ize the properties of the tool.

For information about using the Content Browser to create a tool, see 
“Using Tool Catalog Items in Autodesk Architectural Desktop” on 
page 199.

1 Open the tool palette on which to create the tool.

2 Create the tool:

insert a door in a space 
boundary

select the space boundary and specify an 
insertion point in the space boundary.

insert a freestanding door press ENTER, and specify an insertion 
point and a rotation angle for the door.

If you want to . . . Then . . .

create a tool from a door in the 
drawing

select the door and drag it to the tool palette.

If you want to . . . Then . . .
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

6 Expand Basic and expand General.

7 Enter a description of the tool.

8 If you do not want to use the default layer key for doors, select a layer key.

9 If you want to override the default layer name for doors, select a layer 
override.

10 Select a door style.

11 For Style location, select the drawing file containing the style used for this 
door, or select Browse and use a standard file selection dialog box to select 
the file.

12 Expand Dimensions.

13 Specify a door size: 

create a tool from a door style in 
the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current 
palette

right-click the tool, click Copy, and click Paste.

copy a tool from another 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.

If you want to . . . Then . . .

use a standard door size click Standard Sizes, and then select a 
door size.

use a custom door size enter values for Width and Height.

If you want to . . . Then . . .
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14 Specify how the door width and height are measured: 

15 Enter a value for swing angle or opening percent.

Zero indicates a closed door.

16 Expand Location.

17 Specify the door’s position in a wall or a space boundary:

18 Enter a value for head height.

19 Enter a value for threshold height.

20 Click OK.

Editing Doors

After you create a door, you can change the size, height, width, rise, leaf, and 
opening. You can also move the door within the wall, flip the hinge or swing, 
and change the swing opening.

If you want to . . . Then . . .

measure to the outside of the 
door frame

Select Outside of frame for Measure to.

measure to the inside of the 
door frame

Select Inside of frame for Measure to.

If you want to . . . Then . . .

position the door at a specific 
distance between the edge of 
the opening and the end of a 
wall segment or space 
boundary

Select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.

center the door in a wall 
segment or space boundary

Select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall or space boundary.

freely position the door 
anywhere in the wall or space 
boundary

click Position along wall, and select 
Unconstrained.
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You can change the properties of doors by changing the door style or the 
dimensions of the door, moving the anchor location of the door, or specify-
ing the endcap conditions of the door. 

Autodesk® Architectural Desktop offers several methods for editing doors:

� Edit doors directly using grips for dimensions and other physical charac-
teristics.

� Change door settings on the Properties palette.
� Select editing commands from the shortcut menu for a selected door.

Related Procedures

� Using Grips to Edit Doors

� Changing the Door Style

� Changing the Door Leaf

� Changing the Vertical Alignment of a Door

� Changing How Door Width is Measured

� Changing the Door Swing Angle or Opening Percent

� Moving a Door Along a Wall or Space Boundary

� Moving a Door Within a Wall or Space Boundary

� Using Anchors to Change the Horizontal Position of a Door

� Using Anchors to Change the Vertical Position of a Door

� Using Anchors to Change the Position of a Door Within a Wall or Space 
Boundary

� Changing the Orientation of a Door to a Wall or Space Boundary

� Moving a Door to a Different Wall

� Releasing a Door from a Wall

� Changing the Opening Endcap Assigned to a Door

� Changing the Location of a Freestanding Door

� Attaching Hyperlinks, Notes, and Files to a Door

Using Grips to Edit Doors

You can use grips to modify the following door properties:

� Dimensions (width and height)

For overhead doors, the width determines the opening cut in the wall. The 
width dimensions extend beyond the frame opening because the door 
rides behind the opening.

� Location in a wall or space boundary 
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� Hinge side (left or right)
� Swing direction
� Rise

Rise applies to Peak Pentagon, Arch, and Gothic door shapes. For more 
information, see “Specifying the Design Rules of a Door Style” on 
page 1039.

Refer to the illustrations and steps in this topic to use door grips to edit doors.

Editing the Dimensions of a Door That Has Standard Sizes

1 Select the door.

Door dimension grips

2 Select the grip for the dimension you want to change.

The grip initially is set to constrain the sizing to one of the standard values 
defined for the door’s style. For example, if you select the width grip, the 
grip is set to constrain the width to one of the standard values defined for 
the door’s style.
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Standard height door with width grip selected

The CTRL key acts as a toggle between standard and custom sizing. 

A series of tick marks indicates the standard sizes for the selected dimen-
sion. As you move the grip, it snaps to each tick mark and displays the 
measurement at that mark. 

The size and color of the grip tick marks indicate whether setting a stan-
dard value for the dimension will result in a standard door size. For exam-
ple, if the height of the door is set to a non-standard value, then even if 
you set the door width to a standard value for that door’s style, the door 
is still not a standard size. Long grey tick marks indicate that a standard 
size is possible; short red marks indicate that another dimension is already 
set to a non-standard value.

3 Resize the dimension as necessary:

If you want to . . . Then . . .

change the dimension using a 
standard size

move the grip until the value you want is 
displayed, and click once.

change the dimension using a 
non-standard size 

press CTRL, and either move the grip until 
the value you want is displayed and then 
click once, or enter a value.
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Changing a door width
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Changing a door height

Editing the Dimensions of a Door That Does Not Have Standard Sizes

1 Select the door.

2 Select the grip for the dimension you want to change.

3 Either move the grip until the dimension value you want is displayed and 
then click once, or enter a value.
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Moving a Door Anchored to a Wall or Space Boundary

1 Select the door.

2 Select the Location grip.

Door location and flip grips

3 With the grip selected, press the CTRL key to switch the direction of move-
ment. You can move along the wall, within the wall, and vertically.

4 Move the grip until the door is in the desired location, and click once.

Moving a Freestanding Door

1 Select the door.

2 Select the Location grip.

3 Move the door to the desired location, and click once.

Changing the Hinge Side of a Door

1 Select the door.

2 Select the Flip grip to reverse the side of the door where hinges are located.
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Flipping a door hinge

Changing the Swing Direction of a Door

1 Select the door.

2 Select the Flip grip to reverse the swing direction of the door.
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Flipping a door swing

Changing the Rise of a Door

1 Select the door.

2 Select the Rise grip.
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Changing a door rise

3 Move the grip until the rise value you want is displayed and click once, or 
enter a value.

Changing the Door Style

Use this procedure to change the style for a door or group of doors.

1 Select one or more doors, and double-click one of them.

2 Select a door style.



1020 | Chapter 15 Doors

Changing the Door Leaf

Use this procedure to change the leaf value for a door or group of doors.

Leaf applies to Uneven, Uneven-Dhung, and Uneven Opposing door types. 
For more information, see “Specifying the Design Rules of a Door Style” on 
page 1039.

1 Select the doors you want to change, and double-click one of them.

2 Expand Basic, and expand Dimensions.

3 Enter a value for Leaf Width, or click Leaf Width and then click  to pick 
points on the screen to specify the width.

Changing a door leaf

Changing How Door Width is Measured

Use this procedure to change how the width of doors is measured.

Changing how a door width is measured also affects the dimensions of the 
opening.

1 Select the doors you want to change, and double-click one of them.
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Specifying door frame measurements

2 Expand Basic, and expand Dimensions.

3 Specify the location to which door width is measured:

Changing the Door Swing Angle or Opening 
Percent

Use this procedure to change the swing angle or opening percent of a door 
or group of doors.

A door with a swing angle of zero is closed. The swing angle for overhead 
doors moves the door panel vertically, with graphics above the door head dis-
appearing. The swing display moves with the panel.

If you want to . . . Then . . .

size the doors to the inside 
frame

select Inside of frame for Measure to.

size the doors to the outside 
frame

select Outside of frame for Measure to.
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NOTE Defining the opening percent in display properties overrides this set-
ting.

1 Select the doors you want to change, and double-click one of them.

2 Expand Basic, and expand Dimensions.

3 Enter a value for Swing angle or Opening percent.

Changing a door swing angle

Changing the Vertical Alignment of a Door

Use this procedure to change the vertical alignment of a door or group of 
doors. 

1 Select the doors you want to change, and double-click one of them.

2 Expand Basic, and expand Location.
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3 Specify whether you want the door to be aligned vertically by threshold 
height or by head height:

Moving a Door Along a Wall or Space Boundary

Use this procedure to change the location of one or more doors along a wall 
or space boundary by offsetting the doors from a reference location. 

This feature is useful when you want to position a door at a specified distance 
from another object. For example, you may want to specify an exact distance 
between a series of doors along a wall.

1 Select the doors you want to move, right-click, and click Reposition Along 
Wall.

A marker indicates the current location within the opening: left jamb, 
center of door, or right jamb.

If you want to . . . Then . . .

align the doors by threshold 
height

select Threshold for Vertical alignment, 
and enter a value for Threshold height.

align the doors by head height select Head for Vertical alignment, and 
enter a value for Head height.
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Repositioning a door along a wall
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2 Specify how to measure the offset:

3 Select a point to measure to (the reference point).

You can select a point along the wall.

4 Specify the distance between the points you selected:

Moving a Door Within a Wall or Space Boundary

Use this procedure to move one or more doors within a wall or space bound-
ary by offsetting the doors from a reference location.

This feature allows you to align doors within the thickness of a wall or space 
boundary. You can set an offset distance from any point within a wall, or cen-
ter the doors between the faces of a wall or space boundary. You can select 
doors, windows, or openings, and reposition them at the same time. If you 
select more than one object, you can select only one side to offset. 

1 Select the doors you want to move, right-click, and click Reposition 
Within Wall.

If you want to . . . Then . . .

measure the offset from the 
center of the door

select a point near the center of the door.

measure the offset from the left 
or right jamb

select a point on the jamb of the door you 
want to measure from.

If you want to . . . Then . . .

move the door to the reference 
point

enter 0.

move the door a specified 
distance from the reference 
point

enter a value for the offset distance.

specify the distance as a 
measurement between two 
points, such as the distance 
between the centers of two 
doors that are correctly 
positioned

select the two points measuring the 
distance.
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A marker indicates the current location within the opening. This may be 
the center of the frame, the interior face of the frame, or the exterior face 
of the frame.

Repositioning a door within a wall

2 Specify how to measure the offset:

If you want to . . . Then . . .

center the doors between the 
faces of the wall or space 
boundary

select a point near the center of the door 
jamb.



Editing Doors | 1027

3 Select a point to measure to.

4 Specify the offset distance from the selected point:

Using Anchors to Change the Horizontal Position 
of a Door

Use this procedure to change the horizontal position of doors along a wall or 
space boundary to which the doors are anchored.

offset the doors from the 
interior or exterior face

select a point on the side of the face you 
want to measure from.

If you want to . . . Then . . .

center the doors between the 
faces of the wall or space 
boundary

use the Midpoint osnap to select the 
midpoint of the end of the wall.

move the doors to the reference 
point

enter 0.

move the doors a specified 
distance 

enter a value for the offset distance.

specify the distance as a 
measurement between two 
points

select the two points measuring the 
distance.

If you want to . . . Then . . .
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Door position along the X axis parameters

1 Select the doors you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

For space boundaries, expand Location on space boundary.

3 Click Anchor.

4 Select the reference point for the anchor along the X axis: 

If you want to . . . Then . . .

use the start of the wall or space 
boundary as your reference 
point

under Position Along (X), select Start of 
wall (curve) for From.

use the midpoint of the wall or 
space boundary as your 
reference point

under Position Along (X), select Midpoint 
of wall (curve) for From.

use the end of the wall or space 
boundary as your reference 
point

under Position Along (X), select End of 
Wall (curve) for From.
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5 Enter the distance from the reference point at which to place the doors.

Use a negative value to measure from endpoint to start point.

6  Select the position of the doors to measure to: 

7 Click OK.

Using Anchors to Change the Vertical Position of 
a Door

Use this procedure to change the vertical position of doors in a wall or space 
boundary to which the doors are anchored.

If you want to . . . Then . . .

measure to the start edge of the 
doors

select Start Edge of object for To.

measure to the center of the 
doors

select Center of object for To.

measure to the end edge of the 
doors

select End Edge of object for To.
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Door position along the Z axis parameters

1 Select the doors you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4  Select the reference point for the anchor along the Z axis: 

If you want to . . . Then . . .

use the bottom of the wall or 
space boundary height as your 
reference point

select Bottom of wall (curve) height for 
From.

use the center of the wall or 
space boundary height as your 
reference point

Select Center of wall (curve) height for 
From.

use the top of the wall or space 
boundary height as your 
reference point

Select Top of wall (curve) height for From.
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5 Enter the distance from the reference point at which to place the doors.

Use a negative value to measure from endpoint to start point.

6  Select the position of the doors to measure to: 

7 Click OK.

Using Anchors to Change the Position of a Door 
Within a Wall or Space Boundary

Use this procedure to change the position of doors horizontally within a wall 
or space boundary to which the doors are anchored.

Door position along the Y axis parameters

1 Select the doors you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

If you want to . . . Then . . .

measure to the bottom of the 
doors

select Threshold (Bottom) of object for To.

measure to the center of the 
doors

select Center of object for To.

measure to the top of the doors select Head (Top) of object for To.
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4  Select the reference point for the anchor along the Y axis: 

5 Enter the distance from the reference point at which to place the doors.

Use a negative value to measure from endpoint to start point.

6  Select the position of the doors to measure to: 

7 Click OK.

Changing the Orientation of a Door to a Wall or 
Space Boundary

Use this procedure to change the vertical orientation of doors in a wall or 
space boundary to which the doors are anchored.

1 Select the doors you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4 Enter the X and Z rotation angles of the doors.

If you want to . . . Then . . .

use the left edge of the wall or 
space boundary as your 
reference point

select Left edge of wall (curve) width for 
From.

use the center of the wall or 
space boundary as your 
reference point

select Center of wall (curve) width for 
From.

use the right edge of the wall or 
space boundary as your 
reference point

select Right edge of wall (curve) width for 
From.

If you want to . . . Then . . .

measure to the front of the 
doors

select Front for To.

measure to the center of the 
doors

select Center for To.

measure to the back of the 
doors

select Back for To.
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5 Indicate if you want to reverse the flip direction of the doors in the X, Y, 
and Z axes: 

6 Click OK.

Moving a Door to a Different Wall

Use this procedure to move a door from one wall to another.

1 Select the door you want to move, right-click, and click Wall 
Anchor ➤ Set Wall.

2 Select the wall to move the door to.

Releasing a Door from a Wall

Use this procedure to release doors from the wall they are anchored to.

� Select the doors you want to release, right-click, and click 
Wall Anchor ➤ Release.

Changing the Opening Endcap Assigned to a 
Door

Use this procedure to change the opening endcap style assigned to doors. 

NOTE Each opening endcap style generally is created for use with a specific 
wall style. Changing the opening endcap style used for individual doors may 
cause the wall to display a defect marker.

For more information, see “Opening Endcap Styles.”

If you want to . . . Then . . .

reverse the direction the doors 
open to

select Flip X.

reverse the side of the wall the 
doors open to

select Flip Y.

reverse the top and bottom of 
the doors

select Flip Z.
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1 Select the doors whose endcaps you want to change, and double-click one 
of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Expand Endcaps.

4 Select the opening endcap style.

Changing the Location of a Freestanding Door

Use this procedure to relocate a freestanding door by changing the coordi-
nate values of its insertion point. The door also has an orientation with 
respect to the WCS or the current UCS. For example, if the top and bottom 
of the door are parallel to the XY plane, its normal is parallel to the Z axis. 
You can change the orientation of the door by aligning its normal with 
another axis. You can also rotate the door on its plane by changing the rota-
tion angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see ““Use Coordinates and Coordinate Systems” in the 
online AutoCAD User’s Guide.

1 Double-click the door you want to move.

2 On the Properties palette, expand Basic, then expand Location and click 
Additional Information.

3 In the Location dialog box, specify the door’s location:

4 Click OK.

If you want to . . . Then . . .

relocate the door enter new coordinate values under Insertion Point.

locate the door on the XY 
plane

make the normal of the door parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the door on the YZ 
plane

make the normal of the door parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the door on the XZ 
plane

make the normal of the door parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
door

enter a new value for Rotation Angle.
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Attaching Hyperlinks, Notes, and Files to a Door

Use this procedure to enter notes and attach reference files to a door. You can 
also edit notes and edit or detach reference files from a door.

1 Double-click the door to which to attach notes or files.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD Com-
mand Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

5 To attach, detach, or edit a reference file, click  next to Reference doc-
uments, and then do any of the following:

6 Click OK.

Door Styles

A door style is a group of properties assigned to a door that determines the 
appearance and characteristics of the door.

You can use door styles to represent standard door types for specific jobs and 
drawings or for your office standards. When you create or modify a door 
style, the doors using the style have the settings and characteristics of the 

style. Templates provided with Autodesk® Architectural Desktop contain 
door styles for many typical doors. You can create a style using default style 

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .



1036 | Chapter 15 Doors

properties or by copying an existing style. After you create the style, you edit 
the style properties to customize the characteristics of the style. 

Creating Tools from Door Styles
To create a door tool from any door style, you drag the style from the Style 
Manager onto a tool palette. You can then specify default settings for doors 
created with that tool. For more information, see “Using Door Tools to Create 
Doors” on page 1004.

Managing Door Styles
To create, edit, copy, or purge door styles, you access the Style Manager. The 
Style Manager provides a central location in Autodesk Architectural Desktop 
in which to work with styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Style Manager.”

Related Topics and Procedures

� Creating a Door Style

� Specifying the Dimensions of a Door Style

� Specifying the Design Rules of a Door Style

� Specifying the Standard Sizes of a Door Style

� Creating a Custom Door Shape

� Replacing the Door Shape in a Door Style

� Editing the Geometry of a Door Style

� About Door Display Components and Materials

� Assigning Materials to a Door Style

� Adding Classifications to a Door Style

� Specifying the Display Properties of a Door Style

� Creating Muntins in a Door Style

Creating a Door Style

Use this procedure to create a door style.

You can create a style with default style properties, or you can create a style 
by copying an existing one. After you create the style, you edit its properties 
to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door Styles.
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3 Create a door style:

4 Enter a name for the new door style, and press ENTER.

5 To edit the properties of your new door style, right-click the style, and 
click Edit:

If you want to . . . Then . . .

create a style with default 
properties

right-click Door Styles, and click New.

create a style from an 
existing style

right-click the door style you want to copy, and click 
Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of 
the style

click the General tab, and enter a description.

change dimension 
properties of the style

see “Specifying the Dimensions of a Door Style” on 
page 1038.

change design rules of 
the style

see “Specifying the Design Rules of a Door Style” on 
page 1039.

change the standard 
door sizes of the style

see “Specifying the Standard Sizes of a Door Style” 
on page 1040.

assign materials to the 
components of the 
door style

see “Assigning Materials to a Door Style” on 
page 1045 and “Turning on Materials for a Door 
Style” on page 1048.

add classifications to a 
door style

see “Adding Classifications to a Door Style” on 
page 1046.

specify the display 
properties of the style

see “Specifying the Display Properties of a Door 
Style” on page 1046.

change the appearance 
of the display 
components of the 
style

see “Changing the Layer, Color, and Linetype of 
Door Components” on page 1047.

add components to the 
style

see “Adding Components to a Door Style” on 
page 1049.

remove components 
from the style

see “Removing Custom Components from a Door 
Style” on page 1051.
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6 If you want to assign the style to a door tool, drag the style from the Style 
Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Door Tool” on page 1008.

7 Click OK. 

Specifying the Dimensions of a Door Style

Use this procedure to change the default dimensions of a door style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Dimensions tab.

turn off components in 
the style

see “Turning Off Custom Components in a Door 
Style” on page 1051.

display a straight door 
swing from the style

see “Displaying a Straight Door Swing” on 
page 1052.

override the opening 
percentage in the style

see “Specifying the Opening Percentage for Display 
Representations in a Door” on page 1052.

change the threshold 
in the style

see “Changing the Door Threshold in a Door Style” 
on page 1053.

add muntins to the 
style

see “Creating Muntins in a Door Style” on 
page 1055. 

add notes, files, or 
documents to the style

see “Attaching Notes and Files to a Door Style” on 
page 1054.

If you want to . . . Then . . .
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Changing door style dimensions

5 Change dimension values:

6 Click OK twice.

Specifying the Design Rules of a Door Style

Use this procedure to specify the shape and the type of door for a door style. 

Door shapes are named geometrical descriptions of a door. You can select pre-
defined and custom door shapes, or create your own shape from profiles. For 
more information, see “Creating a Custom Door Shape” on page 1041.

The door type describes the type of opening for the door, such as bifold or 
pocket. 

1 Open a tool palette that has a door tool.

If you want to . . . Then . . .

change the frame width 
and depth

under Frame, enter values for Width and Depth.

set the frame width to the 
wall thickness

under Frame, select Auto-Adjust to Width of Wall.

change the stop 
dimensions

under Stop, enter values for Width and Depth.

change the door thickness enter a value for Door Thickness.

change the glass thickness enter a value for Glass Thickness.
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2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Design Rules tab. 

5 Select a door shape:

6 Select a door type.

7 Click OK twice.

Specifying the Standard Sizes of a Door Style

Use this procedure to create standard door sizes in a door style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Standard Sizes tab, and add, change, or remove door-size values:

The description can be used to identify standard door sizes in door sched-
ules. For example, you can specify a manufacturer’s size or model code for 
Description.

Rise is available for Arch, Gothic, and Peak Pentagon door shapes. Leaf 
controls the width of Uneven, Uneven-Dhung, and Uneven-Opposing 
door types. For more information on door types and shapes, see “Specify-
ing the Design Rules of a Door Style” on page 1039.

If you want to . . . Then . . .

use a predefined door 
shape

under Shape, click Predefined, and select a shape.

use a custom door shape under Shape, click Use Profile, and select a profile.

If you want to . . . Then . . .

create standard sizes click Add. Under Standard Sizes, enter values for 
Description, Width, Height, Rise, and Leaf.

change a size select the size, and click Edit. Enter new values for 
Width, Height, Rise, and Leaf.

delete a size select a size, and click Remove.
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5 Click OK.

Creating a Custom Door Shape

Use this procedure to create a profile that you can use to define a custom door 
shape in a door style. To create a custom door shape that includes glazing, see 
“Creating a Void for Door Muntins” on page 1057.

1 Draw a closed polyline in the shape you want.

2 Select the polyline, right-click, and click Convert To ➤ Profile Defini-
tion.

3 Specify the insertion point of the profile.

The insertion point is not used for doors.

4 Enter n (New).

5 Enter a name for the profile, and click OK.

Replacing the Door Shape in a Door Style

Use this procedure to replace a predefined shape in a door style with a custom 
shape created from a profile.

1 Select a door that uses the style you want to modify, right-click, and click 
Add Profile.

2 Specify the profile to use for the custom shape:

If you want to . . . Then . . .

use a predefined door 
shape

select a profile for Profile Definition, and click OK. 
For information about creating a profile, see 
“Creating a Custom Door Shape” on page 1041.

use a predefined door 
shape, but modify it

select a profile for Profile Definition, select Continue 
Editing, and click OK. For information about 
modifying the shape, see “Editing the Geometry of a 
Door Style” on page 1042.

create a custom shape select Start from scratch for Profile Definition, enter 
a name for the new profile, and click OK. For 
information about modifying the default shape, see 
“Editing the Geometry of a Door Style” on 
page 1042.
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Editing the Geometry of a Door Style

Use this procedure to edit the geometry of the profile used to define a door 
style. You can also add a profile to a door style that does not currently use a 
profile to define its shape.

1 Add a door that has the style you want to change.

2 Add or edit a profile:

3 If you receive a message that the profile is not drawn to size, click Yes.

The area of the door defined by the profile is selected and hatched in the 
drawing.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select the 
profile, and right-click to display the shortcut menu.

4 Edit the profile as necessary:

If you want to . . . Then . . .

add an existing profile to the 
style

select the door, right-click, and click Add 
Profile. Select the name of the profile, and 
click OK.

create a profile and add it to the 
style

select the door, right-click, and click Add 
Profile. Select Start from scratch for Profile 
Definition, enter a name for the new profile, 
and click OK. A rectangular profile is created 
for you to edit to define the required 
geometry.

edit the existing profile for the 
style

select the door, right-click, and click Edit 
Profile in Place.

If you want to . . . Then . . .

change the shape of the 
perimeter of the profile or its 
rings

select the profile, and use grips to adjust the 
shape.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.
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5 Save or discard the changes:

About Door Display Components and Materials

A door object consists of a number of components whose display properties 
can be determined by the materials assigned to each component. 

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace an existing ring of the 
profile with new geometry

select the profile, right-click, and click Replace 
Ring. Select the ring to replace, and select the 
new geometry. Press ENTER to keep the 
geometry, or enter n (No) to erase it.

add a ring to the profile select the profile, right-click, and click Add 
Ring. Select the geometry to define the ring. 
Press ENTER to keep the geometry, or enter n 
(No) to erase it.

remove a ring from the profile select the profile, right-click, and click Remove 
Ring. Select the ring to remove, and press 
ENTER.

If you want to . . . Then . . .

restore the profile to its original 
shape

select the profile and click .

save the changes to the current 
profile

select the profile, and click .
The door style uses the edited profile to define 
its geometry. Any other objects or styles that 
use this profile are also updated with the 
edited geometry.

save the changes to a new 
profile definition

select the profile, right-click, and click Save as 
New Profile. Enter a name for the new profile 
definition, and click OK.
The door uses the new profile to define its 
geometry. Any doors of this style are updated 
with the new geometry. Other styles or objects 
that use the original profile are not affected.

If you want to . . . Then . . .
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You assign one material to each display component of the door. For example, 
you assign a wood material to the frame and a glass material to the glass inset. 
You assign materials to door components in each display representation in 
which the materials are to be used.

To use the display properties of the door object or the door style, instead of 
using material display properties, you can turn off the material assignments 
in the display properties of the door or the door style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in 3D model views and elevations.

For a complete list of material components and their descriptions, see “Mate-
rial Components and Display Properties” on page 498.

The following table lists door components that can be displayed using mate-
rials assigned to them, and identifies the material component of each.

Door Component Material Component

Plan, Plan High Detail, Reflected

Door Panel LInework

Frame LInework

Stop Linework

Plan Low Detail

Panel Linework

Model

Door Panel 3D Body

Frame 3D Body

Stop 3D Body

Glass 3D Body

Elevation

Door Panel 2D Section/Elevation Linework

Frame 2D Section/Elevation Linework
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Assigning Materials to a Door Style

Use this procedure to assign materials to the individual components of a 
door style. Components use the display properties of the material. For more 
information, see “About Door Display Components and Materials” on 
page 1043.

You can specify the materials used to display the following components of a 
door style:

� Frame
� Stop
� Panel
� Glass
� Muntin

NOTE If a material assignment does not determine the display properties of a 
door component, you can change the display properties of the door style as 
described in “Specifying the Display Properties of a Door Style” on page 1046.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

Stop 2D Section/Elevation Linework

Glass 2D Section/Elevation Linework

Door Component Material Component
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10 Click the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click 

to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make apply to all objects that are assigned the material.

11 Click OK twice.

Adding Classifications to a Door Style

Use this procedure to specify classifications for definitions applied to a door 
style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

The default setting for classification definitions is Unspecified. If no clas-
sification definitions are listed, none are applied to door styles.

5 For each classification definition, select the classification you want to 
apply to the current door style.

6 Click OK twice.

Specifying the Display Properties of a Door Style

In most cases, you want the appearance of doors that belong to the same 
style to be consistent throughout a drawing. To achieve this, you specify the 
following display properties of the doors in each door style:

� The layer, color, and linetype of door components
� The hatching used with each component
� The cut plane height and the display of components relative to the cut 

plane
� Other specific door display information, such as the shape of the door 

swing
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You can also use materials to control the display properties of the physical 
components of a door. Symbolic components, such as the door swing, are 
not controlled by materials. For more information about using materials in 
doors, see “About Door Display Components and Materials” on page 1043.

Related Procedures

� Changing the Layer, Color, and Linetype of Door Components

� Turning on Materials for a Door Style

� Using Custom Blocks to Create Door Components

� Adding Components to a Door Style

� Turning Off Custom Components in a Door Style

� Removing Custom Components from a Door Style

� Displaying a Straight Door Swing

� Specifying the Opening Percentage for Display Representations in a Door

� Changing the Door Threshold in a Door Style

� Changing the Door Threshold Symbol in a Door Style

� Attaching Notes and Files to a Door Style

Changing the Layer, Color, and Linetype of Door Components
Use this procedure to change the properties of the display components of a 
door style: 

� Visibility (display component is on or off)
� By material (material assigned to the display component determines its 

layer properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the properties of components in 
the door style, you can change the properties of the display component by clear-
ing By Material or by overriding the material assignment with a different mate-
rial. For more information, see “Assigning Materials to a Door Style” on 
page 1045.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.
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4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK.

Turning on Materials for a Door Style
Use this procedure to turn on material assignments for individual display 
representations in a door style.

For more information about using materials to control the display of door 
components, see “About Door Display Components and Materials” on 
page 1043.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for each component to be controlled by the material. 
The By Material checkbox is unavailable for components that cannot be 
assigned a material.

When you select By Material for a display component, all other settings in 
the dialog are unavailable. Since the display properties are now taken from 
the material definition, you can no longer set them directly in the display 
properties of the door style. 

9 Click OK twice.

Using Custom Blocks to Create Door Components
You can add custom blocks for components, such as door hardware, to the 
display components, or to replace the default display components. For exam-
ple, you can replace a simple door leaf with a custom six-panel door leaf in 
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which the custom component is to appear. You can have a different custom 
block for each display representation.

When you add a custom block, you can specify rules for positioning and scal-
ing the new component. Each custom block also appears in the display prop-
erties component list so that you can control its layer, color, and linetype. For 
more information on adding custom blocks, see “Adding Components to a 
Door Style” on page 1049.

If you create a custom block from mass elements, you can use the material 
assignments of the mass elements to determine the display properties of the 
custom block.

Be sure to set the properties of objects used to create your custom blocks to 
ByBlock. Otherwise, you cannot control these objects through the display 
properties. For more information about ByBlock, see “Work with Layers” in 

the online AutoCAD® User’s Guide. 

Adding Components to a Door Style
Use this procedure to add or edit custom block components in the display 
representation of door styles. 

1 Create a block for the component to add to the door style. 

Create the block in the same plane as the door that you use to represent 
the style. For more information about custom blocks, see “Using Custom 
Blocks to Create Door Components” on page 1048.

2 Open a tool palette that has a door tool.

3 Right-click a door tool, and click Door Styles.

4 Right-click the style you want to edit, and click Edit.

5 Click the Display Properties tab.

6 Select the display representation in which to display the changes, and 
select Style Override.

7 If necessary, click .

8 Click the Other tab.

9 Specify whether to add or edit a block component:

If you want to . . . Then . . .

add a new block 
component

click Add.



1050 | Chapter 15 Doors

10 Click Select Block.

11 Select the block to use, and click OK.

12 Specify whether to scale to fit the block component to the object by 
width, depth, or height, or to lock the XY ratio:

13 Specify whether to mirror the block in the X,Y, or Z direction:

14 Specify the X, Y, and Z location of the insertion point.

15 Specify an insertion offset of the block in the X, Y, and Z directions.

edit an existing block 
component

select the component to edit, and click Edit. Proceed 
to step 11.

If you want to . . . Then . . .

set the block scale to the 
width of the object

select Width.

set the block scale to the 
depth of the object

select Depth.

set the block scale to the 
height of the object

select Height.

scale the whole block 
equally, so that one 
direction is scaled to fit 
another of the scale 
criteria

select Lock to XY Ratio.

scale the block to its 
original size

clear all options under Scale to Fit.

If you want to . . . Then . . .

create a mirror of the 
block in the X direction

select Mirror X.

create a mirror of the 
block in the Y direction

select Mirror Y.

create a mirror of the 
block in the Z direction

select Mirror Z.

If you want to . . . Then . . .
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16 Specify whether the component is for the door frame, leaf or glass:

Leaf and glass components are not available in some display representa-
tions.

17 Click OK four times.

Turning Off Custom Components in a Door Style
Use this procedure to turn off custom blocks in a door style.

You can turn off the display of component blocks without removing them 
from the style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to turn off the display of the 
door component, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Disable Custom Blocks.

9 Click OK twice.

Removing Custom Components from a Door Style
Use this procedure to remove components from a door style.

If you want to . . . Then . . .

add the block to the 
inside or outside of the 
frame

click Frame Component, and click either Outside or 
Inside.

add the block to all leaf 
components or to a single 
leaf component

click Leaf Component, and click either All or Single. 
If you select Single, enter the component number.

add the block to all glass 
components or to a single 
glass component

click Glass Component, and click either All or Single. 
If you select Single, enter the component number.

NOTE If you specified Depth for Scale to Fit, the 
depth will be scaled to the glass thickness. You can 
scale to the door panel thickness instead by 
selecting Scale Depth to Panel Thickness.
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Removing component blocks from a door style deletes them from the style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation from which to remove the door compo-
nent, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select the component to remove, and click Remove.

9 Click OK twice.

Displaying a Straight Door Swing
Use this procedure to display the door swing as a straight line in a door style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display a straight door swing, 
and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Straight Swing.

9 Click OK twice.

Specifying the Opening Percentage for Display 
Representations in a Door
Use this procedure to override the opening percentage in the display repre-
sentation of a door style. For example, you can specify that a door is dis-
played closed in model and elevation representations, but open in plan rep-
resentations.

NOTE This setting overrides other door opening percent settings. If the open-
ing percent is specified here, the opening percent entered on the Properties pal-
ette when you add or modify doors is ignored. 
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1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to override the opening per-
cent, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Override Open Percent.

9 Enter a value for the opening percent.

10 Click OK twice.

Changing the Door Threshold in a Door Style

Use this procedure to display a door threshold and change its dimensions in 
threshold display representations.

You can turn on threshold display representations in addition to door display 
representations.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select Threshold Plan, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Under Threshold Dimensions, enter the threshold extension and depth 
dimensions.

Component A is the swing side of the door. Component B is the other 
side.

9 Click the Layer/Color/Linetype tab.

10 Under Visible, click the icons to turn on visibility. 

11 Click OK twice.

Changing the Door Threshold Symbol in a Door Style
Use this procedure to specify the symbol indicating a threshold that appears 
in a door opening for the door style.
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1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select Threshold Symbol Plan, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select the type of symbol you want to display in the door opening.

9 Click the Layer/Color/Linetype tab.

10 Under Visible, click the icon to turn on visibility. 

11 Click OK twice.

Attaching Notes and Files to a Door Style

Use this procedure to enter notes and attach reference files to a door style. 
You can also edit reference files attached to the style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the door, enter the description under Description.

6 Click Notes.

7 To add or edit a note, click the Notes tab, and enter the note.

8 To attach, edit, or detach a reference file, click the Reference Docs tab:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you finish editing.

detach a reference file select the file name, click Delete, and click OK.
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Creating Muntins in a Door Style

Door muntins are secondary framing members that hold multiple lights in 

door glass. Autodesk® Architectural Desktop provides an easy way to create 
muntins with different layout patterns.

Door muntins are available in the following patterns that you can customize 
into different styles:

� Rectangular
� Diamond
� Prairie 9 Lights
� Prairie 12 Lights
� Starburst
� Sunburst

Starburst and Sunburst patterns are a combined-rectangular pattern with a 
half-round or quarter-round spoked top. They can be used for half- and quar-
ter-round door glass as well as rectangular door glass. The other patterns are 
primarily rectangular but fit into half-round glass. You can make up custom 
glass shapes by creating profiles from polylines and adding them to a new 
door style.

Door muntin components

Related Topics and Procedures

� Process Overview: Creating Door Muntins
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� Creating a Void for Door Muntins

� Adding Glass to a Door Style

� Adding Rectangular or Diamond Muntins to a Door Style

� Adding Prairie-Lights Muntins to a Door Style

� Adding Starburst Muntins to a Door Style

� Adding Sunburst Muntins to a Door Style

� Editing a Door Muntins Block in a Door Style

� Turning Off the Display of Muntins in a Door Style

� Removing a Door Muntins Block from a Door Style

Process Overview: Creating Door Muntins
You must have a void for the glass in the door in order to add muntins. Sam-
ple content provided with the software includes several door styles that 
already have glass and can receive muntins. The door style description indi-
cates whether the style has glass. You can create door styles with a glazing 
void to receive muntins. 

The process of creating a door style with door glass and muntins has three 
steps:

Step 1: Create a void for door glass and muntins. 

You create a profile from two concentric polylines that define the door 
shape and the door glass.

Concentric closed polylines for a door profile

Step 2: Add glass to a door style. 

You apply the profile with a void to a door style so that the style has glass 
for doors to receive muntins.
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Door style created from a profile

Step 3: Add muntins to the door style.

Door glass with muntins

Creating a Void for Door Muntins
Use this procedure to create a profile of a door with a void for glass to receive 
muntins. This is the first step for adding muntins to door styles that do not 
have glass.

The profile is made up of concentric, closed polylines. The outer polyline, or 
ring, becomes the door shape, and the inner polyline becomes the void for 
the glass. You can create multiple voids by adding more inner polylines. 
Voids for glazing must be entirely within the polyline representing the door 
shape. The polylines are proportional in size and shape to each other and also 
to the individual doors created from the door style. 

You can draw these polylines anywhere in the drawing and use any conve-
nient scale relative to your final door and glass size. One method for sizing 
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the polylines relative to the door is to draw them by snapping to an existing 
door, and then move them to the side.

Concentric closed polylines for a door profile

1 Draw concentric, closed polylines representing the door and the glass that 
receives the muntin pattern. 

2 Select the polylines, right-click, and click Convert To ➤ Profile Defini-
tion. 

3 Select the outermost polyline.

4 Enter a (Add ring).

5 Select an inner polyline.

6 Repeat steps 3 and 4 as needed to add more voids to the profile.

7 Specify the insertion point of the profile.

8 Enter n (New), enter a name for the profile, and click OK.

To add the profile to a door style, see “Adding Glass to a Door Style” on 
page 1058.

Adding Glass to a Door Style
Use this procedure to create a door style with glass for doors to accept muntin 
patterns.

The drawing must contain a profile that defines the door style and the void 
for the door glass. For more information about creating such a profile, see 
“Creating a Void for Door Muntins” on page 1057.
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Door profile with a void for glass

Door style created from the profile

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door Styles.

3 Create a door style:

4 Select the new door style, right-click, and click Rename.

If you want to . . . Then . . .

create a style with default 
properties

right-click Door Styles, and click New.

create a style from an 
existing style

right-click the Door style you want to copy, and 
click Copy. Right-click, and click Paste.
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5 Enter a name for the new door style, and press ENTER.

6 Right-click the new door style, and click Edit. 

7 Click the Design Rules tab.

8 Under Shape, select Use Profile, and select a profile that defines a door 
style containing a void for door glass. 

9 Click the Standard Sizes tab.

10 Add new sizes to the style. 

For more information about adding standard sizes to a door style, see 
“Specifying the Standard Sizes of a Door Style” on page 1040.

11 Click OK twice.

The door style now contains glass. You can now add muntins to a door style.

Adding Rectangular or Diamond Muntins to a Door Style
Use this procedure to add rectangular or diamond muntins to a door style 
that contains glass.

You add muntins by editing the display properties of the door style for a dis-
play representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and apply 
them to all display representations of that door style. You add the muntins 
block to glass components of the door style in display properties. Each 
muntins block becomes a display component of the door style.

Rectangular door glass with rectangular muntins
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Gothic door glass with diamond muntins

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

NOTE A door style must contain glass to receive muntins. For more infor-
mation about adding glass to a door style, see “Adding Glass to a Door Style” 
on page 1058.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the door style contains multiple glass components, specify whether you 
want to apply muntins to all glass components or to one glass component 
in the door: 

If you want to . . . Then . . .

attach muntins to all glass 
components

under Glass Component, select All.
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Muntins applied to all or one glass component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

Specifying muntin width and depth

apply muntins to an individual 
glass component

under Glass Component, select Single, and 
specify the index number. Lights are indexed 
counterclockwise, starting from the lower-left 
corner.

If you want to . . . Then . . .
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13 Clean up the muntin intersections:

Specifying muntin cleanup joints

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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Converting muntins to a body

14 Under Lights, select a pattern: 

15 Enter a value for Lights High to specify the number of light rows in the 
vertical direction.

16 Enter a value for Lights Wide to specify the number of light columns in 
the horizontal direction. 

If you want to . . . Then . . .

use a rectangular pattern select Rectangular for pattern.

use a diamond pattern select Diamond for pattern.
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Values for lights high and lights wide

17 Click OK.

18 Add other muntins:

19 When you finish adding muntins to the door style, click OK four times.

After you add a muntins block to a door style, you can assign a material, such 
as wood sash, and specify the display properties, such as color and linetype. 
For more information, see “Assigning Materials to a Door Style” on 
page 1045 and “Changing the Layer, Color, and Linetype of Door Compo-
nents” on page 1047.

Adding Prairie-Lights Muntins to a Door Style
Use this procedure to add prairie-9-lights or prairie-12-lights muntins to a 
door style that contains glass.

If you want to . . . Then . . .

add muntins to another glass 
component in the door style

repeat this procedure from step 8.

add muntins to another display 
representation

click OK, and repeat this procedure from step 
5.

add muntins to all display 
representations of the selected 
door style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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You add muntins by editing the display properties of the door style for a dis-
play representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and apply 
them to all display representations of that door style. You add the muntins 
block to glass components of the door style in display properties. Each 
muntins block becomes a display component of the door style.

Rectangular door glass with prairie-9-lights muntins 

Rectangular door glass with prairie-12-lights muntins

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

NOTE A door style must contain glass to receive muntins. For more infor-
mation about adding glass to a door style, see “Adding Glass to a Door Style” 
on page 1058.
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4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the door style contains multiple glass components, specify whether you 
want to apply muntins to all glass components or to one glass component 
in the door: 

Muntins applied to all or one glass component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

If you want to . . . Then . . .

attach muntins to all glass 
components

under Glass Component, select All.

apply muntins to an individual 
glass component

under Glass Component, select Single, and 
specify the index number. Lights are indexed 
counterclockwise, starting from the lower-left 
corner.
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Specifying muntin width and depth

13 Clean up the muntin intersections:

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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Specifying muntin cleanup joints

Converting muntins to a body
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14 Under Lights, select a pattern:

15 Enter a value for Edge X Offset to specify the horizontal distance of the 
muntins from the edges of the glass.

16 Enter a value for Edge Y Offset to specify the vertical distance of the 
muntins from the edges of the glass. 

Specifying edge X and Y offsets

17 Click OK.

18 Add other muntins:

If you want to . . . Then . . .

use a nine-light prairie pattern select Prairie-9-Lights for Pattern.

use a twelve-light prairie pattern select Prairie-12-Lights for Pattern.

If you want to . . . Then . . .

add muntins to another glass 
component in the door style

repeat this procedure from step 8.

add muntins to another display 
representation

click OK, and repeat this procedure from step 
5.

add muntins to all display 
representations of the selected 
door style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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19 When you finish adding muntins to the door style, click OK four times.

After you add a muntins block to a door style, you can assign a material, such 
as wood sash, and specify the display properties, such as color and linetype. 
For more information, see “Assigning Materials to a Door Style” on 
page 1045 and “Changing the Layer, Color, and Linetype of Door Compo-
nents” on page 1047.

Adding Starburst Muntins to a Door Style
Use this procedure to add starburst muntins to a door style that contains 
glass.

You add muntins by editing the display properties of the door style for a dis-
play representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and apply 
them to all display representations of that door style. You add the muntins 
block to glass components of the door style in display properties. Each 
muntins block becomes a display component of the door style.

 Half-round door glass with starburst muntins

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

NOTE A door style must contain glass to receive muntins. For more infor-
mation about adding glass to a door style, see “Adding Glass to a Door Style” 
on page 1058.

4 Click the Display Properties tab.
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5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the door style contains multiple glass components, specify whether you 
want to apply muntins to all glass components or to one glass component 
in the door: 

Muntins applied to all or one glass component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

If you want to . . . Then . . .

attach muntins to all glass 
components

under Glass Component, select All.

apply muntins to an individual 
glass component

under Glass Component, select Single, and 
specify the index number. Lights are indexed 
counterclockwise, starting from the lower-left 
corner.



Door Styles | 1073

Specifying muntin width and depth

13 Clean up the muntin intersections:

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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Specifying muntin cleanup joints

Converting muntins to a body

14 Under Lights, select Starburst for pattern.

15 Under Shape, select Half Round or Quarter Round.
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16 Enter a value for Lights High to specify the number of light rows in the 
vertical direction, exclusive of the spoked lights.

17 Enter a value for Lights Wide to specify the number of light columns in 
the horizontal direction. 

Count the columns as though they continue around the hub. For a half-
round starburst, five apparent columns are counted as three. For a quarter-
round starburst, three apparent columns are also counted as three.

18 Enter a value for Spokes to specify the number of radial muntin spokes.

Specifying the number of radial muntin spokes

19 Specify where to place the hub: 

If you want to . . . Then . . .

place the hub at the bottom of 
a half-round shape

under Hub Center, select Bottom Center.

place the hub at the top of a 
half-round shape

under Hub Center, select Top Center.

place the hub at the bottom left 
of a quarter-round shape

under Hub Center, select Bottom Left.

place the hub at the bottom 
right of a quarter-round shape

under Hub Center, select Bottom Right.

place the hub at the top left of a 
quarter-round shape

under Hub Center, select Top Left.

place the hub at the top right of 
a quarter-round shape

under Hub Center, select Top Right.
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Specifying hub placement of half-round shape

Specifying hub placement of quarter-round shape
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20 Click OK. 

21 Add other muntins:

22 When you finish adding muntins to the door style, click OK four times.

After you add a muntins block to a door style, you can assign a material, such 
as wood sash, and specify the display properties, such as color and linetype. 
For more information, see “Assigning Materials to a Door Style” on 
page 1045 and “Changing the Layer, Color, and Linetype of Door Compo-

nents” on page 1047.

Adding Sunburst Muntins to a Door Style
Use this procedure to add sunburst muntins to a door style that contains 
glass.

You add muntins by editing the display properties of the door style for a dis-
play representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and apply 
them to all display representations of that door style. You add the muntins 
block to glass components of the door style in display properties. Each 
muntins block becomes a display component of the door style.

If you want to . . . Then . . .

add muntins to another glass 
component in the door style

repeat this procedure from step 8.

add muntins to another display 
representation

click OK, and repeat this procedure from step 
5.

add muntins to all display 
representations of the selected 
door style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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Quarter-round door glass with sunburst muntins and closed hub

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

NOTE A door style must contain glass to receive muntins. For more infor-
mation about adding glass to a door style, see “Adding Glass to a Door Style” 
on page 1058.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the door style contains multiple glass components, specify whether you 
want to apply muntins to all glass components or to one glass component 
in the door: 

If you want to . . . Then . . .

attach muntins to all glass 
components

under Glass Component, select All.
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Muntins applied to all or one glass component

11 Under Shape, select Half Round or Quarter Round.

12 Enter a value for the width of all muntins. 

13 Enter a value for the depth of all muntins. 

Specifying muntin width and depth

apply muntins to an individual 
glass component

under Glass Component, select Single, and 
specify the index number. Lights are indexed 
counterclockwise, starting from the lower-left 
corner.

If you want to . . . Then . . .
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14 Clean up the muntin intersections:

Specifying muntin cleanup joints 

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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Converting muntins to a body

15 Under Lights, select Sunburst for pattern.

16 Enter a value for Lights High to specify the number of light rows in the 
vertical direction, exclusive of the spoked lights.

17 Enter a value for Lights Wide to specify the number of light columns in 
the horizontal direction. 

Count the columns as though they continue around the hub. For a half-
round sunburst, five apparent columns are counted as two. For a quarter-
round sunburst, three apparent columns are also counted as two.

18 Enter a value for Spokes to specify the number of radial muntin spokes.
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Specifying the number of radial muntin spokes

19 Under Hub Style, select Closed for no hub light, or select Open for a hub 
light.

Specifying closed and open hubs

20 Enter a value for Radius to specify the radius for the hub.

Specifying hub radius
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21 Specify where to place the hub: 

If you want to . . . Then . . .

place the hub at the bottom of 
a half-round shape

under Hub Center, select Bottom Center.

place the hub at the top of a 
half-round shape

under Hub Center, select Top Center.

place the hub at the bottom left 
of a quarter-round shape

under Hub Center, select Bottom Left.

place the hub at the bottom 
right of a quarter-round shape

under Hub Center, select Bottom Right.

place the hub at the top left of a 
quarter-round shape

under Hub Center, select Top Left.

place the hub at the top right of 
a quarter-round shape

under Hub Center, select Top Right.
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Specifying hub placement of quarter-round shape

22 Click OK. 

23 Add other muntins:

24 When you finish adding muntins to the door style, click OK four times.

If you want to . . . Then . . .

add muntins to another glass 
component in the door style

repeat this procedure from step 8.

add muntins to another display 
representation

click OK, and repeat this procedure from step 
5.

add muntins to all display 
representations of the selected 
door style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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After you add a muntins block to a door style, you can assign a material, such 
as wood sash, and specify the display properties, such as color and linetype. 
For more information, see “Assigning Materials to a Door Style” on 
page 1045 and “Changing the Layer, Color, and Linetype of Door Compo-
nents” on page 1047.

Editing a Door Muntins Block in a Door Style
Use this procedure to edit the muntins settings for a door style.

After you create a muntins block, you can change its settings by editing the 
display properties of the door style for each display representation, such as 
Model or Elevation. You can edit the muntins for display representations 
individually. You can also edit the muntins for a single display representation 
and apply the changes to all display representations of that door style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 

click .

6 Click the Muntins tab.

7 Select the muntins block to edit.

8 Click Edit.

9 Edit any of the settings. 

For more information on settings, refer to the door muntins type in “Cre-
ating Muntins in a Door Style” on page 1055.

10 Select Automatically Apply to Other Display Representations and Object 
Overrides to apply edits to all display representations of the selected door 
style.

Clear this setting to apply edits to only the selected display representation.

11 When you finish editing the door muntins block in the door style, click 
OK four times. 

You can edit the display properties, such as color and linetype, for the 
muntins block. For more information, see “Changing the Layer, Color, and 
Linetype of Door Components” on page 1047.

You can also edit the material applied to the muntins. For more information, 
see “Assigning Materials to a Door Style” on page 1045.
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Turning Off the Display of Muntins in a Door Style
Use this procedure to turn off the display of muntins in a door style. You can 
turn off the display of door muntins without removing them from the style.

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Display Properties tab.

5 Select the display representation in which to turn off the display of door 

muntins, and click .

6 Click the Muntins tab.

7 Select Disable Muntins Blocks.

8 Select Automatically Apply to Other Display Representations and Object 
Overrides to turn off muntins block(s) for all display representations of 
the selected door style.

Clear this setting to turn off muntins block(s) for only the selected display 
representation.

9 Click OK three times.

Removing a Door Muntins Block from a Door Style
Use this procedure to remove muntins from a door style.

When you remove muntins blocks from a door style, they are deleted. To 
turn off muntins without deleting them, see “Turning Off the Display of 
Muntins in a Door Style” on page 1086

1 Open a tool palette that has a door tool.

2 Right-click a door tool, and click Door Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Display Properties tab.

5 Select the display representation for which to remove door muntins, and 

click .

6 Click the Muntins tab.

7 Select the muntins block to remove.

8 Click Remove.

9 Repeat steps 7 and 8 to remove multiple muntins blocks.
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10 Select Automatically Apply to Other Display Representations and Object 
Overrides to remove muntins block(s) from all display representations of 
the selected door style.

Clear this setting to remove muntins block(s) from only the selected dis-
play representation.

11 When you finish removing muntins blocks from the door style, click OK 
three times. 
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Door/Window 
Assemblies

Door/window assemblies provide a grid or 
framework for inserting objects such as win-
dows and doors. With this framework, you can 
create complex window and door assemblies 
and insert them in standard walls or use them 
as repeated elements in a curtain wall.

Like curtain walls, door/window assemblies are 
made up of one or more grids.

Adding Door/Wndow Assemblies to walls and curtain 
walls

In this chapter

� Door/Window Assembly Grids

� Creating Door/Window 
Assemblies Using Door/
Window Assembly Tools

� Door/Window Assembly Styles

� Using Overrides in Door/
Window Assemblies

� Modifying Element Definitions 
for Door/Window Assembly 
Styles

� Editing Door/Window 
Assemblies

� Editing Objects Anchored in 
Door/Window Assemblies

16
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Door/Window Assembly Grids

Like curtain walls, door/window assemblies are made up of one or more 
grids. Each grid has either a horizontal division or a vertical division, but you 
can nest the grids to create a variety of patterns from simple to complex.

Door/Window Assembly grid division examples

TIP Using a door/window assembly in a curtain wall can help you avoid the 
complexities of too many nested grids in the curtain wall.

Elements of Grids
Grids are the foundation of curtain walls, curtain wall units, and door/win-
dow assemblies. Every grid has four element types:

� Divisions:  Define the direction of the grid (horizontal or vertical) and the 
number of cells

� Cell Infills: Contain another grid, a panel infill, or an object such as a win-
dow or a door

� Frames: Define the edge around the outside of the primary grid and 
nested grids

� Mullions: Define the edges between the cells
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NOTE Division is an abstract element, in contrast to the other three element 
types that represent physical elements of the door/window assembly.

Each element type is assigned a default definition that describes what ele-
ments of that type look like.

Identifying Door/Window Assembly componets

You can create new element definitions and assign those definitions within 
the door/window assembly. For example, you can create multiple infill defi-
nitions and then assign different infills to specific cells in the grid. Likewise, 
you can create multiple frame definitions and then assign a different defini-
tion to each frame edge (top, bottom, left, right). This is also true for mullion 
definitions.

Element type Default definitions

Divisions Vertical divisions with a fixed cell dimension of 3'

Cell Infills Cells containing simple panels with a 2" thickness

Frames Outer edges of grid 3" wide and 3" deep

Mullions Edges between cells 1" wide and 3" deep
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Assigning different infills and frames to door/window assembly cells

Experimenting with Door/Window Assembly Designs
The templates provided with Autodesk® Architectural Desktop offer door/
window assembly styles. Looking at these styles and experimenting with 
them makes it easier to understand door/window assembly behavior and cre-
ate your own door/window assembly designs. 

Related Procedures

� Creating Door/Window Assemblies Using Door/Window Assembly Tools

� Door/Window Assembly Styles

� Using Overrides in Door/Window Assemblies

� Modifying Element Definitions for Door/Window Assembly Styles

� Editing Door/Window Assemblies

� Editing Objects Anchored in Door/Window Assemblies

For more information about element definitions and assignments, see “Cre-
ating Element Definitions for a Door/Window Assembly Style” on page 1105 
and “Assigning Definitions to Door/Window Assembly Elements” on 
page 1139.

Creating Door/Window Assemblies Using 
Door/Window Assembly Tools

Door/window assemblies are like standard windows in that they are planar 
and defined by an insertion point, as opposed to curtain walls that have a 
baseline that can be curved or straight. You can create a door/window assem-
bly based on a 2D layout grid or a combination of lines, arcs, and circles.
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To create a door/window assembly for use in a standard wall, draw the wall 
first. You can insert the door/window assembly and modify the door/window 
assembly elements as needed.

To create a door/window assembly for use in a curtain wall, insert the door/
window assembly in space. Modify the element definitions and assignments 
as needed. Save your changes as a new door/window assembly style, and then 
assign that style to cells in your curtain wall grid. For more information, see 
“Assigning Infills to Door/Window Assembly Cells” on page 1140.

Tool palettes provided with Autodesk Architectural Desktop let you quickly 
place door/window assemblies by selecting a door/window assembly tool 
with a specific door/window assembly style and other predefined properties. 
When you place door/window assemblies using door/window assembly 
tools, you can use the default settings of the tool, or you can change settings 
for the door/window assembly properties. You can also use door/window 
assembly tools to convert linework to door/window assemblies and to apply 
the settings of a door/window assembly tool to existing door/window assem-
blies.

Tool palettes containing window assembly tools



1094 | Chapter 16 Door/Window Assemblies

The following palettes contain one or more door/window assembly tools:

When you place door/window assemblies using door/window assembly 
tools, you can use the default settings of the tool, or you can change settings 
for any door/window assembly properties that are not controlled by the 
style.

Related Procedures

� Creating a Door/Window Assembly

� Creating a Door/Window Assembly with User-Specified Settings

� Converting a Layout Grid to a Door/Window Assembly

� Creating a Door/Window Assembly from an Elevation Sketch

� Creating a Door/Window Assembly Tool

Creating a Door/Window Assembly

Use this procedure to add a new door/window assembly that has the proper-
ties specified in the door/window assembly tool that you select. To specify 
settings when you add a door/window assembly, see “Creating a Door/Win-
dow Assembly with User-Specified Settings” on page 1095.

1 Open the tool palette that you want to use, and select a door/window 
assembly tool.

If necessary, scroll to display the tool that you want to use.

2 Select a wall, or press ENTER and then specify the insertion point of the 
door/window assembly.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Continue adding door/window assemblies, and then press ENTER.

Tool Palette Door/Window Assembly Tools

General Building Object palette 
in the Design Tools palette set

Standard door/window assembly style and 
default settings for other door/window 
assembly properties

custom tool palettes created by 
your CAD manager

door/window assembly styles and properties 
that your CAD manager customized for your 
projects or office standards
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Creating a Door/Window Assembly with User-
Specified Settings

Use this procedure to add a door/window assembly with settings that you 
specify.

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a door/window 
assembly tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Expand Dimensions.

5 Modify the dimensions of the door/window assembly:

6 Expand Location.

7 Modify the location properties of the door/window assembly:

If you want to specify . . . Then . . .

the length of the door/window 
assembly

enter a value for Length.

the base height of the door/
window assembly

enter a value for Base Height.

the rise of the door/window 
assembly

enter a value for Rise.

start and end miters enter miter values for Start Miter and End 
Miter.

If you want to specify . . . Then . . .

the position of the door/window 
assembly

select Unconstrained or Offset/Centered for 
Position along the wall.

the vertical alignment of the door/
window assembly

select Head or Threshold for Vertical 
Alignment.
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Vertical Alignment controls how you place the door/window assembly in 
the wall and how the door/window assembly responds to modifications 
in height. The Sill Height and Head Height options allow you to deter-
mine the working point on the door/window assembly. You can place the 
working point at the sill or at the head. The Vertical Alignment value 
determines the location of the working point vertically in the wall.

Modifications to the door/window assembly height respect the working 
point. For example, if you specify the working point of the window as sill, 
the vertical alignment as 0'' and the door/window assembly height as 
7'–0'', the height in the wall where the top of the door/window assembly 
is placed is 7–0''. If you modify the height of the window to 6'–8'', the win-
dow sill remains at 0'' and the top of the door/window assembly becomes 
6–8''. The sill working point is maintained. 

If you specify the working point as the door/window assembly head, the 
Vertical Alignment value as 7'–0'' and the door/window assembly height 
as 7'–0'', the height in the wall where the top of the door/window assem-
bly is placed is 7–0''. If you modify the height of this door/window assem-
bly to 6'–8'', the door/window assembly head remains at 7'–0'' and the 
window sill becomes 4''. The head working point is maintained.

the head height of the door/
window assembly

enter a value for Head height.

the sill height of the door/window 
assembly

enter a values for Sill height.

the rotation reference angle of the 
door/window assembly

enter a value for Rotation.

If you want to specify . . . Then . . .



Creating Door/Window Assemblies Using Door/Window Assembly

Specifying door/window assembly head sill heights

8 In the drawing area, select a wall, or press ENTER and then specify the 
insertion point of the door/window assembly.

You can move or hide the Properties palette to expose more of the drawing 
area.

9 Continue adding door/window assemblies, and press ENTER.

Converting a Layout Grid to a Door/Window 
Assembly

Use this procedure to create a door/window assembly that is based on a 2D 
layout grid. If you already have 2D layout grids in a drawing, you can easily 
convert them to door/window assemblies. Or, if you are already familiar with 
layout grids, it is an efficient way to create a door/window assembly and then 
experiment with the door/window assembly commands to learn more about 
them.

When you create a door/window assembly from a 2D layout grid, you also 
create a new door/window assembly style. The divisions in the new door/
window assembly style are taken from the divisions in the layout grid.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a door/window assembly tool, and click Apply Tool Properties 
to ➤ Layout Grid.

3 Select the layout grid to convert.
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4 When prompted to erase the original geometry, press ENTER to keep the 
layout grid, or enter y (Yes) to erase it.

5 Press ENTER to specify horizontal as the orientation for the primary divi-
sion, or enter v to specify vertical.

6 Enter a name for the door/window assembly style, and click OK.

7 If necessary, edit the properties of the door/window assembly in the Prop-
erties palette.

Creating a Door/Window Assembly from an 
Elevation Sketch

Use this procedure to create a sketch of a custom grid with lines, arcs, and 
circles, and then convert that linework into a door/window assembly.

NOTE You cannot modify the division definition of a custom grid created from 
lines, arcs, and circles. You can, however, assign a different division definition to 
it. For more information, see “Assigning a Division to a Door/Window Assembly 
Grid” on page 1140.

NOTE Door/window assembly grids are either horizontal or vertical. To create 
a grid pattern with horizontal and vertical cells, nested grids are used. For more 
information about nested grids, see “Working with Nested Grids in Door/Win-
dow Assemblies” on page 1142.

1 Use lines, arcs, and circles to draw a grid in the world coordinate system 
(WCS).

2 Right-click a door/window assembly tool, and click Apply Properties 
to ➤ Elevation Sketch.

3 Select the linework of your sketch, and press ENTER.

4 Select one of the grid lines as the baseline for the door/window assembly, 
or press ENTER to use the line along the X axis as the default baseline.
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Converting linework to a Door/Window Assembly using the default baseline 
option

TIP If you draw your linework in the XY plane (in Plan view) and accept the 
default baseline, the resulting door/window assembly is displayed from the 
Z direction. 

5 To erase the lines, enter y (Yes). To have the lines remain after the door/
window assembly is created, enter n (No).

If there is a style applied to the curtain wall tool, the new custom style is 
based on the existing style. The infill, mullion, and frame definitions are 
those of the existing style. You can modify the style without having to cre-
ate one from scratch. For more information, see “Assigning Definitions to 
Door/Window Assembly Elements” on page 1139. 

Converting linework to a door/window assembly using the specified baseline 
option

6 Select the resulting custom door/window assembly, right-click, and click 
Design Rules ➤ Save to Style.
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7 Click New to create a new door/window assembly style.

8 Enter a name for the new door/window assembly style.

9 Click OK twice.

Creating a Door/Window Assembly Tool

Use this procedure to create a door/window assembly tool and add it to a tool 
palette. You may want to create your own door/window assembly tools if you 
are placing multiple door/window assemblies of specific styles with addi-
tional door/window assembly properties that you want to be the same each 
time you add a door/window assembly of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the door/window 
assembly created from this tool, and click OK.

If you want to . . . Then . . .

create a tool from a door/
window assembly in the 
drawing

select the door/window assembly, and drag it 
to the tool palette.

create a tool from a door/
window assembly style in the 
Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a style.

10 Select the drawing file containing the style used for this door/window 
assembly.

11 Expand Dimensions.

12 Modify the dimensions of the door/window assembly:

13 Expand Location.

14 Modify the location properties of the door/window assembly:

15 Click OK.

If you want to . . . Then . . .

specify the length of 
the door/window 
assembly

enter a value for Length.

specify the base height 
of the door/window 
assembly

enter a value for Base Height.

specify the rise of the 
door/window assembly

enter a value for Rise.

specify start and end 
miter angles

enter miter values for Start Miter and End Miter.

If you want to . . . Then . . .

specify the position of 
the door/window 
assembly

select Unconstrained or Offset/Center for Position 
along the wall.

specify the head height 
of the door/window 
assembly

enter a value for Head height.

specify the sill height of 
the door/window 
assembly

enter a values for Sill height.
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Door/Window Assembly Styles

Door/window assemblies are style-based, meaning there are preset character-
istics assigned to each door/window assembly that determine its appearance 
and function. By changing from one style of door/window assembly to 
another, you can quickly study several different design options. And any 
changes you make to the style are reflected throughout your building, updat-
ing all door/window assemblies of that particular style. You can also apply 
overrides to a single door/window assembly, without changing other door/
window assemblies of the same style. 

A door/window assembly style controls the following properties of a door/
window assembly:

� Element definitions
� Definition assignments for each element
� Materials for each element
� Display properties for each element
� Default dimensions
� Notes about the style and any associated reference files

To create, edit, copy, or purge styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop 
where you can work with styles from multiple drawings and templates. For 
more information about using the Style Manager, see “Getting Started with 
the Style Manager” on page 533.

Related Procedures

� Process Overview: Creating a Door/Window Assembly Style

� Tips for Working Efficiently with Door/Window Assembly Styles

� Creating Element Definitions for a Door/Window Assembly Style

� Creating a Door/Window Assembly Style

� Defining Divisions for Door/Window Assembly Grids

� Defining Infills for Door/Window Assembly Cells

� Defining Door/Window Assembly Frames

� Defining Door/Window Assembly Mullions

� Assigning Definitions to Door/Window Assembly Elements

� Assigning a Division to a Door/Window Assembly Grid

� Assigning Infills to Door/Window Assembly Cells

� Assigning Definitions to Door/Window Assembly Frames

� Assigning Definitions to the Mullions of a Door/Window Assembly
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� Specifying the Materials of a Door/Window Assembly Style

� Specifying the Display of Door/Window Assemblies

� Attaching Notes and Files to a Door/Window Assembly Style

Process Overview: Creating a Door/Window 
Assembly Style

When you create a door/window assembly style, you assign characteristics to 
any or all elements of a door/window assembly and save them as a named 
style. In this way, you standardize the appearance of all door/window assem-
blies that use the style. When you modify a style, all door/window assemblies 
in your drawing that use the style are updated to reflect the changes. There 
are eight general steps for creating a door/window assembly style:

Step 1: Define divisions for the door/window assembly grid.

For information on defining door/window assembly grid definitions, see 
“Defining Divisions for Door/Window Assembly Grids” on page 1108.

Step 2: Define the infill for the cells of the door/window assembly.

For information on creating infills, see “Defining Infills for Door/Window 
Assembly Cells” on page 1117.

Step 3: Define the door/window assembly frame, including using profiles 
and specifying offsets.

For information on defining a frame for a door/window assembly, see 
“Defining Door/Window Assembly Frames” on page 1125.

Step 4: Define the mullions for the door/window assembly, including using 
profiles and specifying offsets.

For information on ways to define mullions, see “Defining Door/Window 
Assembly Mullions” on page 1132.

Step 5: Assign the element definitions you created:

If you want to assign . . . Then see . . .

a division to a door/window assembly 
grid

“Assigning a Division to a Door/
Window Assembly Grid” on 
page 1140.

infills to door/window assembly cells “Assigning Infills to Door/Window 
Assembly Cells” on page 1140.
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Step 6: Specify the materials of the door/window assembly style.

For information on specifying materials, see “Specifying the Materials of 
a Door/Window Assembly Style” on page 1157.

Step 7: Specify the display properties of the door/window assembly, includ-
ing layer, color, linetype, and hatching.

For information on specifying the display properties of a door/window 
assembly, see “Specifying the Display of Door/Window Assemblies” on 
page 1160.

Step 8: Attach notes and reference documents to the door/window assembly 
style.

For information on attaching notes and files, see “Attaching Notes and 
Files to a Door/Window Assembly Style” on page 1166.

Tips for Working Efficiently with Door/Window 
Assembly Styles

Use these suggestions to work with door/window assembly styles efficiently 
and productively.

� Name grids and elements very clearly to identify where they are used and 
what they are. For example, use the name L3-FL1-H to represent a third-
level grid used on the first floor and that is horizontally divided. Incorpo-
rating this suggestion makes it easier to ensure that you are using elements 
correctly.

� Use the element definition that is applied most often as the default ele-
ment definition. For example, if most cells are stone panels, define the 
default infill as the stone panel. This panel is then used in every cell that 
is not specifically assigned to another infill. Apply this rule to the default 
frame, mullion, and division.

� Name the styles for doors, windows, curtain wall units, AEC polygons, and 
curtain walls to indicate where they are used and what they are.

definitions to door/window assembly 
frames

“Assigning Definitions to Door/
Window Assembly Frames” on 
page 1151.

definitions to door/window assembly 
mullions

“Assigning Definitions to the Mullions 
of a Door/Window Assembly” on 
page 1154.

If you want to assign . . . Then see . . .
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� Remember that you can use cell and edge overrides to define special con-
ditions not accounted for in the door/window assembly style.

Creating Element Definitions for a Door/Window 
Assembly Style

Element definitions determine the appearance of the four basic door/win-
dow assembly elements. There is a different definition type for each element.

Identifying Door/Window Assembly components

Each type of element can have multiple definitions. For example, you can 
define the divisions to create a horizontal grid or a vertical grid and you can 
define the cells to contain a nested grid or a door/window assembly. To make 
reuse easier, you can save the element definitions and then assign them to 
grids, cells, frames, or mullions as needed. 

Element definitions are style-specific. When you create element definitions 
for a specific door/window assembly style, those definitions are available 
only for door/window assemblies of that style. For example, if you define a 
door/window assembly infill for one door/window assembly style, that infill 

Definition Sample definitions

Divisions Horizontal grid with six cells

Cell Infills Cells contain windows

Frames Outer edge of grid is 6" wide

Mullions Edges between cells are 4" wide
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is not available as an option when you edit a door/window assembly of a dif-
ferent style.

Creating a Door/Window Assembly Style

Use this procedure to create a door/window assembly style. You can create a 
style using default style properties or by copying an existing style. After you 
create the style, you edit the style properties to customize the characteristics 
of the style. You can also create a door/window assembly tool based on the 
newly created door/window assembly style. When you use the tool to add 
door/window assemblies, each door/window assembly has the style specific 
to the tool.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Create a new door/window assembly style:

4 Enter a name for the new door/window assembly style, and press ENTER.

5 To edit the new door/window assembly style, right-click the style, and 
click Edit:

If you want to . . . Then . . .

create a style with default 
properties

right-click Door/Window Assembly Styles, and click 
New.

create a style from an 
existing style

right-click the door/window assembly style you 
want to copy, and click Copy. Right-click, and click 
Paste.

create a style from a 
curtain wall, curtain wall 
unit, or door/window 
assembly in the drawing

right-click Door/Window Assembly Styles, and click 
New. Right-click the new style, click Set From, and 
then pick a curtain wall, a curtain wall unit, or a 
door/window assembly.

If you want to . . . Then . . .

define the elements of a 
door/window assembly 
style

see “Defining Divisions for Door/Window Assembly 
Grids” on page 1108, “Defining Infills for Door/
Window Assembly Cells” on page 1117, “Defining 
Door/Window Assembly Frames” on page 1125, 
and “Defining Door/Window Assembly Mullions” 
on page 1132.
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6 When you finish specifying the properties of the door/window assembly 
style, click OK.

7 If you want to assign the style to a door/window assembly tool, drag the 
style from the Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Door/Window Assembly Tool” on page 1100.

8 Click OK.

assign element definitions 
to the door/window 
assembly style

see “Assigning Definitions to Door/Window 
Assembly Elements” on page 1139, “Assigning a 
Division to a Door/Window Assembly Grid” on 
page 1140, “Assigning Infills to Door/Window 
Assembly Cells” on page 1140, “Assigning 
Definitions to Door/Window Assembly Frames” on 
page 1151, and “Assigning Definitions to the 
Mullions of a Door/Window Assembly” on 
page 1154.

add door/window 
assembly element 
definitions as display 
components

see “Adding Door/Window Assembly Element 
Definitions as Display Components” on page 1161.

specify layer, color and 
linetype settings for the 
display components of a 
door/window assembly

see “Specifying the Layer, Color, and Linetype of a 
Door/Window Assembly Style” on page 1162.

specify door/window 
assembly hatching

see “Specifying the Hatching for Components of a 
Door/Window Assembly Style” on page 1162.

add custom graphics as 
display components of a 
door/window assembly 
style

see “Adding Custom Graphics as a Display 
Component of a Door/Window Assembly” on 
page 1163.

create individual cut planes 
for door/window assembly 
styles

see “Creating Cut Planes for a Door/Window 
Assembly” on page 1165.

specify the materials of the 
door/window assembly 
style

see “Specifying the Materials of a Door/Window 
Assembly Style” on page 1157.

add notes and files to the 
style

see “Attaching Notes and Files to a Door/Window 
Assembly Style” on page 1166.

If you want to . . . Then . . .
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Defining Divisions for Door/Window Assembly 
Grids

The divisions of a grid define the orientation that determines the direction 
of the grid cells and mullions and they define a division type that determines 
the number and size of cells.

NOTE Creating a nested grid is not a division rule. To create a nested grid, add 
a cell assignment. For more information, see “Creating a Nested Grid for a Door/
Window Assembly” on page 1145 and “Working with Nested Grids in Door/
Window Assemblies” on page 1142.

You can create a variety of division definitions under different names and 
then assign different divisions to each grid in your door/window assembly. 
Although you can create multiple definitions, there can be only one division 
assignment per grid. You create division definitions for a specific door/win-
dow assembly style and those definitions can be assigned only to grids in 
door/window assemblies of that style. For more information about assigning 
divisions to a particular grid, see “Assigning a Division to a Door/Window 
Assembly Grid” on page 1140.

Related Procedures

� Division of Door/Window Assembly Grids

� Creating a Division Definition for a Door/Window Assembly

� Specifying a Fixed Size for Cells in a Door/Window Assembly Grid

� Using the Auto-Adjust Cells Option

� Specifying a Fixed Number of Cells for a Door/Window Assembly Grid

� Manually Defining the Number and Size of Cells in a Door/Window 
Assembly Grid

� Specifying an Offset for a Door/Window Assembly Grid

� Removing a Division Definition from a Door/Window Assembly Style

� Assigning a Division to a Door/Window Assembly Grid

Division of Door/Window Assembly Grids
A door/window assembly consists of one or more grids, which are the frame-
work for placing design elements in the door/window assembly. The highest-
level grid is the primary grid, which is also the outside edge of the door/win-
dow assembly. 
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Each grid in a door/window assembly has one division assignment that 
determines whether the grid is divided horizontally or vertically. The divi-
sion also determines the number of cells, their size, and their placement.

Within the primary grid, you can define multiple levels of grids. These grids 
within the primary grid are called nested grids. Each subdivision of a grid is 
called a cell. 

Creating a Division Definition for a Door/Window Assembly
Use this procedure to create divisions for a door/window assembly grid.

Because door/window assemblies can contain multiple nested grids, it is 
helpful to use a naming convention for grids that indicates the level of each 
grid and the grid location or the purpose within the door/window assembly. 
For example, L3-FL1-Stone Panels identifies a third level grid that provides a 
row of stone panels on Floor 1.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Click New Division.

7 Enter a name for this division definition.

8 Select either Vertical orientation  or Horizontal orientation .

9 Select one of the following division types and specify offsets if needed:

Division Type Description

Fixed Cell Dimension Creates a grid where the size of the individual cells is 
predetermined. For more information, see 
“Specifying a Fixed Size for Cells in a Door/Window 
Assembly Grid” on page 1110.

Fixed Number of Cells Creates a grid where the number of grid cells is 
predetermined. For more information, see 
“Specifying a Fixed Number of Cells for a Door/
Window Assembly Grid” on page 1113.
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After you create a division definition, you can assign the definition to a 
specific grid in a door/window assembly. For more information, see 
“Assigning a Division to a Door/Window Assembly Grid” on page 1140.

10 When you are finished creating division definitions, click OK.

Specifying a Fixed Size for Cells in a Door/Window Assembly 
Grid
Use this procedure to define a specific size for the cells in a grid. In this case, 
the number of cells is determined by the length or height of the grid, depend-
ing on how the grid is divided.

When you specify a fixed cell size in a grid, you can control how the cells of 
the grid adjust to accommodate any leftover space. This space occurs if the 
length (or the height) of the door/window assembly cannot be evenly 
divided by the fixed size of the cell. For more information, see “Using the 
Auto-Adjust Cells Option” on page 1112.

Specifying a fixed cell size for Door/Window Assembly grids

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

Manual Creates a grid where the size and number of 
individual cells is manually determined by the user. 
For more information, see “Manually Defining the 
Number and Size of Cells in a Door/Window 
Assembly Grid” on page 1114.

Division Type Description
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6 Select a Division definition or create a new one.

7 Select Fixed Cell Dimension for Division Type.

8 Specify a size for the cells in Cell Dimension.

 If you are defining a vertical grid, the cell dimension is the length of the 
cell from mullion to mullion. If you are defining a horizontal grid, the cell 
dimension is the height of the cell.

9 To specify an offset for the grid, specify an offset distance in Bottom Offset 
or Top Offset. 

TIP The frame width is calculated as part of the cell size. Therefore, cells 
adjacent to the frame can appear to be a different size than the other cells. If 
you do not want the frame width included in the cell size, specify an offset for 
the grid that is equal to the frame width. 

When you draw a door/window assembly using a fixed cell dimension, 
there is often extra space between the last full-size cell and the end of the 
door/window assembly.

For more information about grid offsets, see “Specifying an Offset for a 
Door/Window Assembly Grid” on page 1115.

10 Adjust the cells to accommodate this extra space:

If you want to . . . Then . . .

add the space to grid 
cells

select Auto-Adjust Cells, select Grow for Cell 
Adjustment, and select the specific cells where the 
space is to be added.
You can select any combination of Specific Cells.
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11 Click OK.

For information about assigning the division definition to a specific grid 
in your door/window assembly, see “Assigning a Division to a Door/Win-
dow Assembly Grid” on page 1140.

Using the Auto-Adjust Cells Option
Use this procedure to automatically resize cells in a grid when the result of 
dividing the grid by the specified cell dimension is not a whole number.

For example, if a vertical primary grid in a door/window assembly style is 17 
feet in length and you specify a fixed cell dimension of 3 feet, the grid has 
five cells of 3 feet each with 2 feet remaining. Using the Auto-Adjust Cells 
option, you can specify how the grid distributes the remaining quantity.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Divisions definition or create a new one.

7 Select Fixed Cell Dimension as the division type.

8 Select Auto-Adjust Cells, and specify the cell adjustment:

remove the space from 
grid cells

select Auto-Adjust Cells, select Shrink for Cell 
Adjustment, and select the specific cells where the 
space is to be removed.
You can select any combination of Specific Cells.

If you want to . . . Then . . .

add the remaining space to grid cells select Grow, and select the specific 
cells to which you want the space 
added.

remove the remaining space from grid 
cells

select Shrink, and select the specific 
cells from which you want the space 
removed. You can then select Maintain 
at least half of cell dimension in order 
to control the cell shrinkage.

If you want to . . . Then . . .
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The cells that you do not select maintain the fixed value you specified for 
Cell Dimension.

Specifying a Fixed Number of Cells for a Door/Window 
Assembly Grid

Use this procedure to define a specific number of cells in a grid. In this case, 
the size of the cells is determined by the length or height of the grid, depend-
ing on how the grid is divided.

Specifying a fixed number of cells for Door/Window Assembly grids

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Fixed Number of Cells for Division Type.

8 Enter the desired number of cells in Number of Cells.

9 Specify an offset distance for Start Offset or End Offset. 

For more information, see “Specifying an Offset for a Door/Window 
Assembly Grid” on page 1115.

TIP The frame width is calculated as part of the cell size. Therefore, cells 
adjacent to the frame can appear to be a different size than the other cells. If 
you do not want the frame width included in the cell size, specify an offset for 
the grid that is equal to the frame width.
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For information about assigning the division definition to a specific grid in 
your door/window assembly, see “Assigning a Division to a Door/Window 
Assembly Grid” on page 1140.

Manually Defining the Number and Size of Cells in a Door/
Window Assembly Grid
Use this procedure to manually add gridlines and specify an offset for each 
one when you need to create a unique grid that does not fit into any of the 
other division types. You can also start with a fixed cell dimension grid or a 
fixed number of cells grid and then manually adjust the gridlines to suit your 
needs.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Select Manual for Division Type.

8 Click Add Gridline to insert a gridline.

Insert as many grid lines as you need. If you need to remove a grid line, 
select it from the table, and then click Remove Gridline.

9 Under Offset in the grid line table, specify an offset distance for each grid 
line.

10 Under From in the grid line table, select the grid location from which the 
grid line is offset. 

11 Specify an offset distance in Bottom Offset or Top Offset. 
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For more information, see “Specifying an Offset for a Door/Window 
Assembly Grid” on page 1115.

12 Click OK.

For information about assigning the division definition to a specific grid 
in your door/window assembly, see “Assigning a Division to a Door/Win-
dow Assembly Grid” on page 1140.

Specifying an Offset for a Door/Window Assembly Grid
By default, grids cells are measured from the start and end points of the door/
window assembly baseline (for horizontal divisions) or in the baseline to the 
base height (for vertical divisions). The width of the grid frame is not consid-
ered in calculating the size of the cell. For example, if you draw a door/win-
dow assembly with a 14 ft. baseline and a 1 ft. frame on the left and right, 
and you specify a fixed number of vertical cells, the cells do not appear equal 
in size. The first and last cells appear smaller because they include the frame. 
To make the cells equal in size, offset the start and end of the grid by the 
width of the frame. 

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select a Division definition or create a new one.

7 Specify an offset for the grid. 
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8 Click OK twice.

If you want to specify the 
distance between . . .

Then . . .

the start point of the door/window 
assembly baseline and the start of the 
first cell in a horizontal grid

enter a value for Start Offset.

the end point of the door/window 
assembly baseline and the end of the 
last cell in a horizontal grid

enter a value for End Offset.

the baseline of the door/window 
assembly and the start of the bottom 
cell in a vertical grid

enter a value for Bottom Offset.

the base height of the door/window 
assembly and the end of the top cell in 
a vertical grid

enter a value for Top Offset.
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Removing a Division Definition from a Door/Window 
Assembly Style
Use this procedure to remove a division definition that you no longer need. 
You cannot remove a division definition that is currently assigned to a grid. 
In addition, you cannot remove the default division definition, but you can 
modify it.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Divisions under Element Definitions.

6 Select the division definition that you want to remove.

7 Right-click and click Remove, or click .

8 Click OK twice.

Defining Infills for Door/Window Assembly Cells

An infill defines the contents of a door/window assembly cell. A door/win-
dow assembly cell can be empty (no infill), it can contain a grid (nested grid), 
or it can contain one of two infills: a panel or a style. Use the style infill for 
inserting doors, windows, and other objects into a door/window assembly. 
Panels typically represent glazing or other plain cladding, such as stone or 
concrete.
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Specifying Door/Window Assembly Infill definitions

NOTE Nested grids and no infill are options you select when assigning an infill 
to a cell. They do not require infill definitions. For more information, see “Creat-
ing a Nested Grid for a Door/Window Assembly” on page 1145 and “Removing 
an Infill from a Door/Window Assembly” on page 1148.

You can define as many infills as you need and then use cell assignments to 
specify the cells that use each infill. A default infill, which you can modify, 
is used for all unassigned cells. For more information about cell assignments, 
see “Assigning Definitions to Door/Window Assembly Elements” on 
page 1139.

NOTE Create infill definitions for a specific door/window assembly style. 
Those definitions can be assigned only to grid cells in door/window assemblies 
of that style. 

Materials
Styles use the materials of the object style assigned to each panel. For exam-
ple, if you specify an infill to use the Standard door style, the materials of that 
infill are those designated in the door style.

Simple panels need materials assigned in the door/window assembly style.
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Door/Window Assembly with assigned materials example detail

If you do not use materials to control the display properties of infills, you can 
specify their display properties in the door/window assembly style. The layer, 
color, linetype, and other display properties of the Default Infill are applied 
to all infills unless you create a custom display component for each infill def-
inition. Then you can control the display of each infill definition indepen-
dently. For more information, see “Specifying the Display of Door/Window 
Assemblies” on page 1160.

Related Procedures

� Creating a Panel Infill for a Door/Window Assembly

� Creating an Infill for Inserting an Object into a Door/Window Assembly

� Specifying an Alignment for a Door/Window Assembly Infill

� Specifying an Offset for a Door/Window Assembly Infill

� Removing an Infill Definition from a Door/Window Assembly Style

� Assigning Infills to Door/Window Assembly Cells

Creating a Panel Infill for a Door/Window Assembly
Use this procedure to create a simple panel infill to represent basic cladding 
materials in the door/window assembly, such as a stone wall panel, concrete 
panel, metal panel, or glazing infill.

Because door/window assemblies can contain multiple infills, it is helpful to 
use a naming convention for panel infills that indicates the infill location or 
purpose within the door/window assembly. For example, L3-FL1- Stone Panel 
identifies a stone panel in a third-level grid on Floor 1.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.
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3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Click New Infill.

7 Enter a descriptive name for the infill.

8 Select Simple Panel for Infill Type.

9 Select an alignment for the infill. 

For more information, see “Specifying an Alignment for a Door/Window 
Assembly Infill” on page 1121.

10 Specify an offset for the infill. 

For more information, see “Specifying an Offset for a Door/Window 
Assembly Infill” on page 1122.

11 Specify a thickness for the panel.

12 Click OK twice.

After you create an infill definition, you can assign it to any cell in a door/
window assembly grid. For more information, see “Assigning Infills to Door/
Window Assembly Cells” on page 1140.

Creating an Infill for Inserting an Object into a Door/Window 
Assembly
Use this procedure to create a style infill to insert objects into a door/window 
assembly. You can insert doors, windows, curtain wall units, and AEC poly-
gons by defining a specific style of that object as an infill.

TIP After you insert an object in a cell, you can select that object independent 
of the grid and access editing options for the object.

Because door/window assemblies can contain multiple infills, it is helpful to 
use a naming convention for panel infills that indicates the infill location or 
purpose within the door/window assembly. For example, L3-FL1-Stone Panel 
identifies a stone panel in a third-level grid on Floor 1.

NOTE The object styles you use in infills must exist in the current drawing to 
be added to an infill definition.

1 On the Format menu, click Style Manager.
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2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Click New Infill.

7 Enter a descriptive name for the infill.

8 Select Style for Infill Type.

The right side of the dialog box changes to display a tree view of the object 
styles available for insertion into a door/window assembly.

9 Select an object style. 

There is a unique icon for each type of style. For example, the door style 

icon  and the curtain wall unit icon . These icons also are displayed 
next to the infill name at the top of the dialog box to help you identify 
the type of infill.

10 Select an alignment for the infill. 

For more information, see “Specifying an Alignment for a Door/Window 
Assembly Infill” on page 1121.

11 Specify an offset for the infill. 

For more information, see “Specifying an Offset for a Door/Window 
Assembly Infill” on page 1122.

12 Click OK twice.

After you create an infill definition, you can assign it to any cell in a door/
window assembly grid. For more information, see “Assigning Infills to Door/
Window Assembly Cells” on page 1140.

Specifying an Alignment for a Door/Window Assembly Infill
Use this procedure to align an infill so that it is centered with the baseline of 
the door/window assembly, in front of the baseline, or behind the baseline. 
In Plan view, the front of a door/window assembly (drawn from left to right) 
is below the baseline and the back is above the baseline.
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Specifying Door/Window Assembly panel infill alignments

NOTE To move the infill away from the baseline, see “Specifying an Offset for 
a Door/Window Assembly Infill” on page 1122.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select an infill or create a new one.

7 Select an alignment: front, center, or back.

8 Click OK twice.

Specifying an Offset for a Door/Window Assembly Infill
Use this procedure to specify an offset for a door/window assembly infill. By 
default, infills are centered on the door/window assembly baseline. If your 
design requires that the infill be aligned with frame edges or some other part 
of the door/window assembly, you can specify an offset for the infill.

You can also edit individual style-based infills directly in the drawing. The 
selected infill has Flip grips in both the X and Y directions so that you can 
change the orientation of the infill.
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Specify Door/Window Assembly infill panel offsets

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select an infill or create a new one.

7 Enter an offset distance.

In plan view, positive numbers offset the infill above the baseline and neg-
ative numbers offset the infill below the baseline. The offset is also 
affected by the selected alignment for the infill.
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8 Click OK twice.

Removing an Infill Definition from a Door/Window Assembly 
Style
Use this procedure to delete an infill definition that you no longer need. 
However, you cannot remove an infill definition that is currently assigned to 
a cell in the primary grid or any nested grid. Also, you cannot remove the 
default infill definition, but you can modify it as needed.

NOTE For information about removing an infill from a cell, see “Removing an 
Infill from a Door/Window Assembly” on page 1148.

Removing panel infill from a Door/Window Assembly

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Infills under Element Definitions.

6 Select the unneeded infill definition, and click Remove Infill.
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7 Click OK twice.

Defining Door/Window Assembly Frames

All door/window assembly grids, including the primary grid, can have frame 
definitions. The door/window assembly frame is represented by the outer 
edges of a grid. The overall frame size is determined by the length and height 
of the door/window assembly grid. You can define a frame by specifying a 
width and depth or by selecting a profile.

Specifying Door/Window Assembly frame width and depth

You create frame definitions for a specific door/window assembly style. 
Those definitions can be assigned only to frames in door/window assemblies 
of that style. You can create as many frame definitions as you want and then 
assign the definitions to the frame edges as needed. If you have nested grids, 
each grid has its own frame. There is a default frame definition that you can 
modify and assign as needed. Unassigned frame edges are not displayed. For 
more information, see “Assigning Definitions to Door/Window Assembly 
Frames” on page 1151.
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TIP Using Style Manager, you can copy a mullion definition and use it as a 
frame definition. Select the mullion definition and drag it to Frames in the left 
pane.

Materials and Display Properties for Frames
If you do not use materials to control the display properties of frames, you 
can specify their display properties in the door/window assembly style. The 
layer, color, linetype, and other display properties of the default frame are 
applied to all frames unless you create a custom display component for each 
definition. You can then control the display of each frame definition inde-
pendently. For more information, see Specifying the Display of Door/Win-
dow Assemblies.

NOTE You create frame definitions for a specific door/window assembly style 
and those definitions can be assigned only to frames in door/window assemblies 
of that style. 

Related Procedures

� Defining a Door/Window Assembly Frame by Width and Depth

� Defining a Door/Window Assembly Frame Using a Profile

� Specifying Offsets for a Door/Window Assembly Frame

� Removing a Frame Definition from a Door/Window Assembly Style

� Assigning Definitions to Door/Window Assembly Frames

Defining a Door/Window Assembly Frame by Width and 
Depth

Use this procedure to define a frame by specifying its width and depth. The 
overall frame size is determined by the length and height of the door/win-
dow assembly grid.

Because door/window assemblies can contain multiple styles with different 
frames, it is helpful to use a naming convention for grid frames that indicates 
the grid location or purpose within the door/window assembly. For example, 
L3-FL1- Metal Frame identifies a metal frame in a third-level grid on Floor 1.

TIP To remove the frame edge and have the infill adjust to fill the space occu-
pied by the frame, create a frame definition with both width and depth set to 
zero. Then assign that definition to the frame edge that you want to remove. 
This is necessary for the infill to be mitered as it would be for a butt-glazed con-
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dition. For more information, see “Removing a Frame Edge from a Door/Win-
dow Assembly” on page 1153.

Specifying a Door/Window Assembly frame width and depth of zero

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Click  to create a new frame definition.

7 Enter a descriptive name for the frame.

8 Specify a width and depth for the frame.

9 Specify any offsets.

For more information, see “Specifying Offsets for a Door/Window Assem-
bly Frame” on page 1130.

10 Click OK twice.

After you create a frame definition, you can assign it to any frame in a door/
window assembly. For more information, see “Assigning Definitions to Door/
Window Assembly Frames” on page 1151.

Creating a Profile for a Door/Window Assembly Frame

Use this procedure to create a profile that you can use to define the shape of 
a door/window assembly frame. You can then extrude the profile to create a 
door/window assembly frame.
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The height and the width of the polyline you use to create the profile define 
the default height and width of the door/window assembly frame. The inser-
tion point of the profile is aligned with the centroid of the frame.

1 Draw a closed polyline of the height and the depth needed for the result-
ing door/window assembly frame.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Enter c (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the frame. 

4 Enter a name for the profile, and click OK.

You can now use the profile as a door/window assembly frame. For more 
information, see “Defining a Door/Window Assembly Frame Using a Pro-
file” on page 1128.

Defining a Door/Window Assembly Frame Using a Profile
Use this procedure to create a frame element definition from a profile. If you 
do not want a straight edge to your frame, you can use a profile to define 
edges with curves, jags, or any other shape you require.

You can also use an edit in-place routine to create a frame from a profile. For 
more information, see “Creating a Frame or Mullion Edge from a Polyline or 
Profile using In-Place Editing” on page 1176.

It is helpful to use a naming convention for profiles that indicates the grid 
location or purpose within the door/window assembly. For example, L3-FL1- 
Metal Frame identifies a metal frame in a third-level grid on Floor 1.
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Specifying default and profile-based Door/Window Assembly frames

NOTE The insertion point of the profile is aligned with the centroid of the 
frame. 

1 Create the profile to use for the frame.

For more information, see “Creating a Profile for a Door/Window Assem-
bly Frame” on page 1127.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

4 Select a door/window assembly style, right-click, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Frames under Element Definitions.

7 Create a new frame definition.

8 Enter a descriptive name for the frame.

9 Specify a width and depth for the frame edge. 

These dimensions are used to calculate the center point of the edge for 
aligning the profile and also to specify a boundary for the adjacent infill.
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10 Select Use Profile.

NOTE The Profile options are available only when you have profiles in the 
current drawing. 

11 Select a profile from the list.

By default, the profile is inserted using the same width and depth with 
which it was created.

12 To adjust the size of the profile to fit within the width or depth dimension 
of the frame edge, select Auto-Adjust Profile Width or Depth.

13 To mirror the profile along the X or Y axis, select X or Y for Mirror In.

14 To rotate the profile, specify a rotation angle.

15 Specify any offsets. 

For more information, see the next section “Specifying Offsets for a Door/
Window Assembly Frame” on page 1130.

16 Click OK twice.

After you create a frame definition, you can assign it to any frame in a door/
window assembly. For more information, see “Assigning Definitions to Door/
Window Assembly Frames” on page 1151.

Specifying Offsets for a Door/Window Assembly Frame
Use this procedure to define the distance that a door/window assembly frame 
is from the floor line, roof line, or baseline. By default, the outside edges of 
the frame align with start and end of the baseline and the start and end of 
the base height. When you adjust the width of the frame, the frame expands 
inward. However, you can use offsets to expand or contract the frame away 
from these default limits or to shift the frame away from the baseline in 
either the X or Y direction. 

Offset Description 

X Positive X offset moves the frame edge outward 
beyond the end of the door/window assembly, 
while a negative X offset moves the frame edge 
inward toward the center of the door/window 
assembly.

Y In Plan view, a positive Y offset moves the frame 
edge above the baseline, while a negative Y offset 
moves the frame below the baseline.
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TIP To quickly identify the start and end of a door/window assembly, select the 
door/window assembly. The Reverse Direction grip is displayed near the center 
of the door/window assembly and points toward the end of the door/window 
assembly.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Select a frame definition from the list.

7 Specify an offset distance for the frame edge: X, Y, Start, or End.

8 Click OK twice.

Removing a Frame Definition from a Door/Window Assembly 
Style
Use this procedure to remove a frame definition that you no longer need. You 
cannot remove a frame definition if it is currently assigned to a frame edge, 
but you can remove it if it is assigned as an override to a frame edge. Also, 
you cannot remove the default frame definition, but you can modify it as 
needed.

NOTE For information about removing a frame edge, see “Removing a Frame 
Edge from a Door/Window Assembly” on page 1153.

Start Negative Start offset lengthens the frame beyond 
the start point, while a positive Start offset 
shortens the frame. The start point for vertical 
edges is the baseline, and the start point for 
horizontal edges (drawn left to right) is the left 
side.

End Negative End offset lengthens the frame beyond 
the end point, while a positive End offset shortens 
the frame. The end point for vertical edges is the 
base height, and the end point for horizontal 
edges (drawn left to right) is the right side.

Offset Description 
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1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Frames under Element Definitions.

6 Select the unneeded frame definition from the list.

7 Click Remove Frame.

8 Click OK twice.

Defining Door/Window Assembly Mullions

All door/window assembly grids, including the primary grid, can have mul-
lion definitions. The mullions of a door/window assembly are the edges 
between the grid cells. You can define the mullions by specifying a width and 
depth or by selecting a profile from which the mullion is extruded.

Because door/window assemblies can contain multiple nested grids with dif-
ferent mullions, it is helpful to use a naming convention for grid mullions 
that indicates the grid location or purpose within the door/window assem-
bly. For example, L3-FL1- Window Mullion identifies a mullion for a window 
in a third-level grid on Floor 1.
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Specifying default and profile-based Door/Window Assembly mullions

You create mullion definitions for a specific door/window assembly style and 
those definitions can be assigned only to mullions in door/window assem-
blies of that style. You can create as many mullion definitions as you want 
and then assign the definitions to mullions as needed. If you have nested 
grids, each grid has its own mullions. A default mullion definition, which 
you can modify and assign as needed, is used for any unassigned mullions. 
For more information, see “Assigning Definitions to the Mullions of a Door/
Window Assembly” on page 1154.

TIP Using Style Manager, you can copy a frame definition and use it as a mul-
lion definition. Select the frame definition and drag it to Mullions in the left pane.

Materials and Display Properties for Mullions
If you do not use materials to control the display properties of mullions, you 
can specify their display properties in the door/window assembly style. The 
layer, color, linetype, and other display properties of the default mullion are 
applied to all mullions unless you create a custom display component for 
each definition. You can then control the display of each mullion definition 
independently. For more information, see “Specifying the Display of Door/
Window Assemblies” on page 1160.
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Related Procedures

� Defining Door/Window Assembly Mullions by Width and Depth

� Defining the Mullions of a Door/Window Assembly Using a Profile

� Specifying Offsets for the Mullions of a Door/Window Assembly 

� Removing a Mullion Definition from a Door/Window Assembly Style

� Assigning Definitions to the Mullions of a Door/Window Assembly 

Defining Door/Window Assembly Mullions by Width and 
Depth
Use this procedure to define mullions by specifying a width and a depth. 

Because door/window assemblies can contain multiple nested grids with dif-
ferent mullions, it is helpful to use a naming convention for grid mullions 
that indicates the grid location or purpose within the door/window assem-
bly. For example, L3-FL1- Window Mullion identifies a mullion for a window 
in a third-level grid on Floor 1.

Specifying Door/Window Assembly mullion width and depth

TIP To remove mullions for butt glazing, create a definition with both width 
and depth set to zero. Then assign that definition to the mullions that you want 
to remove. For more information, see “Removing Mullions from a Door/Window 
Assembly Grid” on page 1156.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.
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6 Click New Mullion.

7 Enter a descriptive name for the mullion definition.

8 Specify a width and depth for the mullion definition.

9 Specify any offsets. 

For more information, see “Specifying Offsets for the Mullions of a Door/
Window Assembly” on page 1137.

10 Click OK twice.

After you create a mullion definition, you can assign it to any mullion in a 
door/window assembly. For more information, see “Assigning Definitions to 
the Mullions of a Door/Window Assembly” on page 1154.

Creating a Profile for Door/Window Assembly Mullions
Use this procedure to create a profile that you can use to define the shape of 
a door/window assembly mullion definition. You can then extrude the pro-
file to create mullions from it. 

The height and the width of the polyline you use to create the profile define 
the default height and width of the door/window assembly mullion. The 
insertion point of the profile is aligned with the centroid of the mullion.

1 Draw a closed polyline of the height and the depth needed for the result-
ing door/window assembly mullion.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Enter c (Centroid) for the insertion point of the profile.

The insertion point of the profile is aligned with the centroid of the mul-
lion. 

4 Enter a name for the profile, and click OK.
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You can now use the profile as a door/window assembly mullion. For more 
information, see “Defining the Mullions of a Door/Window Assembly 
Using a Profile” on page 1136.

Defining the Mullions of a Door/Window Assembly Using a 
Profile
Use this procedure to create a mullion element definition from a profile. If 
you do not want a straight edge to your mullions, you can use a profile to 
define mullions with curves, jags, or any other shape.

You can also use an edit in-place routine to create a mullion from a profile. 
For more information, see “Creating a Frame or Mullion Edge from a Polyline 
or Profile using In-Place Editing” on page 1176.

Because door/window assemblies can contain multiple nested grids with dif-
ferent mullions, it is helpful to use a naming convention for grid mullions 
that indicates the grid location or purpose within the door/window assem-
bly. For example, L3-FL1- Window Mullion identifies a mullion for a window 
in a third-level grid on Floor 1.

NOTE The insertion point of the profile is aligned with the centroid of the 
mullion.

1 Create the profile to use for the mullion.

For more information, see “Creating a Profile for Door/Window Assembly 
Mullions” on page 1135.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

4 Select a door/window assembly style, right-click, and click Edit.

5 Click the Design Rules tab.

6 In the left pane, select Mullions under Element Definitions.

7 Click New Mullion.

8 Enter a descriptive name for the mullion definition.

9 Specify a width and depth for the mullion definition. 

These dimensions are used to calculate the center point of the mullion for 
aligning the profile, and also to specify a boundary for the adjacent infill.

10 Select Use Profile.
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NOTE The Profile options are available only when you have profiles in the 
current drawing.

11 Select a profile from the list.

By default, the profile is inserted using the same width and depth with 
which it was created.

12 To adjust the size of the profile to fit within the width or depth dimension 
of the mullion, select Auto-Adjust Profile Width or Depth.

13 To mirror the profile along the X or Y axis, select X or Y for Mirror In.

14 To rotate the profile, specify a rotation angle.

15 Specify any offsets. 

For more information, see “Specifying Offsets for the Mullions of a Door/
Window Assembly.”

16 Click OK twice.

After you create a mullion definition, you can assign it to any mullion in a 
door/window assembly. For more information, see “Assigning Definitions to 
the Mullions of a Door/Window Assembly” on page 1154.

Specifying Offsets for the Mullions of a Door/Window 
Assembly
Use this procedure to define mullions that are offset from the start or end of 
the door/window assembly to lengthen or shorten the edge or offset in the 
X or Y direction to shift the edge. For example, you might want to represent 
butt glazing by offsetting the mullions to be behind glass panel infills.

Offset Description

X For vertical mullions, a positive X offset moves the 
mullions toward the end of the door/window assembly, 
while a negative X offset moves the mullions toward 
the start of the door/window assembly. For horizontal 
mullions, a positive X offset moves the mullions toward 
the top of the door/window assembly, while a negative 
X offset moves the mullions toward the bottom of the 
door/window assembly.

Y In Plan view, a positive Y offset moves the mullions 
above the baseline, while a negative Y offset moves the 
mullions below the baseline.
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TIP To quickly identify the start and end of a door/window assembly, select the 
door/window assembly. The Reverse Direction grip is displayed near the center 
of the door/window assembly and points toward the end of the door/window 
assembly.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Select a mullion definition from the list.

7 Specify an offset distance for the X, Y, Start, or End.

8 Click OK twice.

Removing a Mullion Definition from a Door/Window Assembly 
Style
Use this procedure to remove a mullion definition that you no longer need. 
You cannot remove a mullion definition if it is assigned to a mullion, but you 
can remove it if it is assigned as an override to a mullion. Also, you cannot 
remove the Default Mullion definition, but you can modify it as needed.

NOTE For information about removing mullions from between cells, see 
“Removing Mullions from a Door/Window Assembly Grid” on page 1156.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

Start Negative Start offset lengthens the mullions beyond 
the start point, while a positive Start offset shortens the 
mullions.

End Negative End offset lengthens the mullions beyond the 
end point, while a positive End offset shortens the 
mullions.

Offset Description
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4 Click the Design Rules tab.

5 In the left pane, select Mullions under Element Definitions.

6 Select the unneeded mullion definition from the list.

7 Click Remove Mullion.

8 Click OK twice.

Assigning Definitions to Door/Window Assembly 
Elements

After you’ve created element definitions for a door/window assembly style, 
you can assign those definitions to each of the door/window assembly ele-
ment types: divisions, cell infills, frames, and mullions. 

By default, one definition is assigned to all elements of a particular type. 
However, you can assign definitions to individual elements as well. For 
example, all cells in the grid are assigned the default infill. But you can create 
a new cell assignment, select a different infill, and then specify the cells to 
use that infill.

Assignment list
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For more information about element definitions, see “Creating Element Def-
initions for a Door/Window Assembly Style” on page 1105.

Assigning a Division to a Door/Window Assembly 
Grid

Divisions define the grid orientation (whether the direction of the grid cells 
and mullions is horizontal or vertical) and the division type (number and size 
of cells).

After you define a division, you can assign it to the primary grid or to nested 
grids. Nested grids are created by selecting Nested Grid as the cell assignment. 
For more information, see “Working with Nested Grids in Door/Window 
Assemblies” on page 1142.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid you want to assign rules to. 

The name of the grid you select is displayed in the table under the Divi-
sion Assignment row.

TIP To rename a grid, select it, click Rename, and enter a new name. 

6 Click the Element column for that grid and select a division definition 
from the list.

7 Click OK twice.

Assigning Infills to Door/Window Assembly Cells

An infill defines the contents of a door/window assembly cell. A door/win-
dow assembly cell can be empty (none), can contain a grid (nested grid), or 



Door/Window Assembly Styles | 1141

can contain one of two infills: a panel or a style. The style infill is for inserting 
doors, windows, and other objects into a door/window assembly.

Specifying Door/Window Assembly infill definitions

Cell Assignments
A cell assignment defines the infill definition used for cells. You can use one 
cell assignment to assign the same infill to all cells, or you can create multiple 
cell assignments to assign different infills to different cells.

Do not assign multiple definitions to the same cell. If you do, the last defini-
tion assigned to the cell is used. 

Default Cell Assignment
The default cell assignment used by all unassigned cells. You can modify the 
default assignment to be any type of infill, but you cannot delete the default 
cell assignment.
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You may want to modify the default cell assignment to use the infill defini-
tion that occurs most frequently in your design. Any cells not assigned to 
other infills then use this infill definition.

Materials and Display Properties of Infills
The layer, color, linetype, and other display properties of the default infill are 
applied to all infills unless you assign materials to the infills you created or 
you create a custom display component for each definition. Then you can 
control the display of each infill definition independently. For more infor-
mation, see “Specifying the Display of Door/Window Assemblies” on 
page 1160.

Related Procedures

� Working with Nested Grids in Door/Window Assemblies 

� Creating a Nested Grid for a Door/Window Assembly

� Filling a Door/Window Assembly Cell with a Simple Panel

� Inserting an Object into a Door/Window Assembly Cell 

� Removing an Infill from a Door/Window Assembly

� Specifying Which Door/Window Assembly Cells Use a Cell Assignment

� Removing an Assignment from a Door/Window Assembly Style

Working with Nested Grids in Door/Window Assemblies
Each door/window assembly grid is one dimensional with either a horizontal 
or vertical division. By nesting grids in the door/window assembly style, you 
can create a variety of patterns from simple to complex. 

Specifying Door/Window Assembly nested grid locations

Simple Primary Grids
When you nest grids, you start with one primary grid. Then each cell in the 
primary grid can be filled with another grid. For example, the following illus-
tration has a horizontal primary grid with four cells. You can nest a vertical 
grid in each horizontal cell to create a simple 2D grid. 
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Specifying Door/Window Assembly cell divisions 1

The previous illustration shows all cells in the grid with the same cell assign-
ment—a vertical division. But each cell in a grid is independent and can have 
a separate assignment. For example, the following illustration shows one cell 
in the primary grid that contains another horizontal grid, the next cell con-
tains a vertical grid with three divisions, and the next cell contains a vertical 
grid with six divisions.

Specifying Door/Window Assembly cell divisions 2

Multiple Nested Grids
You can continue to nest grids to create multiple levels. For example, the fol-
lowing illustrations show the Standard door/window assembly style grid, the 
same grid with a nested grid in one cell of the secondary grid, and the same 
grid again with nested grids in all cells of the secondary grid.
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Specifying a nested grid in a door/window assembly

Defining Nested Grids
You can define nested grids on the Design Rules tab of the Door/Window 
Assembly Style Properties dialog box. The tree on the left side of the tab lists 
the grids. There is always one primary grid. The primary grid can have one or 
more secondary grids. Each secondary grid can have one or more tertiary 
grids and so on.

TIP To quickly create nested grids in all cells, change the default cell assign-
ment to Nested Grid. If you want multiple levels of nesting, be sure to change 
the default cell assignment for each grid. For more information, see “Creating a 
Nested Grid for a Door/Window Assembly” on page 1145.

Each grid has its own cell assignments. You assign cells to contain another 
grid, a panel infill, or an object such as a door or window. For more informa-
tion, see “Assigning Infills to Door/Window Assembly Cells” on page 1140.
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Creating a Nested Grid for a Door/Window Assembly
Use this procedure to create a nested grid, which is a grid within a grid. Each 
nested grid has its own division rules, cell assignments, frame, and mullions. 
By default, the frame is off for nested grids.

For more information, see “Working with Nested Grids in Door/Window 
Assemblies” on page 1142.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a nested grid.

6 In the left pane, select the grid in which you want to create a new cell 
assignment.

7 Click New Cell Assignment.

A new cell assignment is displayed in the list of cell assignments.

8 Right-click the default name, click Rename, and enter a descriptive name 
for the assignment.

9 Select Nested Grid in the Element column.

A new grid is added to the list of grids in the left pane of the dialog box. 
If you are editing the primary grid, the new grid is added at the secondary 
level. If you are editing a grid at the secondary level, the additional grid is 
placed at the tertiary level, and so on.
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Creating a nested grid

New nested grid in tree

NOTE To rename a grid, select it in the right pane, right-click, and click 
Rename, and enter a new name.

10 Specify the cells to contain this nested grid. 

For more information, see “Specifying Which Door/Window Assembly 
Cells Use a Cell Assignment” on page 1148.

11 Click OK twice.

Filling a Door/Window Assembly Cell with a Simple Panel
Use this procedure to fill a door/window assembly cell with a simple panel. 
Simple panels are generally used to represent basic cladding materials in the 
door/window assembly, such as a stone wall panel or a concrete panel.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to assign a simple panel. 

6 Click New Cell Assignment.
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A new cell assignment is displayed in the list of cell assignments.

7 Right-click the default name, click Rename, and enter a descriptive name 
for the assignment.

8 Select an infill that defines a simple panel. 

9 Specify the cells to contain this simple panel. 

For more information, see “Specifying Which Door/Window Assembly 
Cells Use a Cell Assignment” on page 1148.

10 Click OK twice.

Inserting an Object into a Door/Window Assembly Cell
Use this procedure to insert objects, such as doors, windows, curtain wall 
units, and AEC Polygons, into a door/window assembly cell. Door/window 
assembly cells can contain these objects when you create infill definitions 
that use them. For more information, see “Creating an Infill for Inserting an 
Object into a Door/Window Assembly” on page 1120.

TIP After you insert an object in a cell, you can select that object independent 
of the grid, and access editing options for the object. For more information, see 
“Editing Objects Anchored in Door/Window Assemblies” on page 1197.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to insert objects. 

6 Click New Cell Assignment.

A new cell assignment is displayed in the list of cell assignments.

7 Right-click the default name, click Rename, and then enter a descriptive 
name for the assignment.

8 Select an infill that uses an object style.

9 Specify the cells to contain this object. 

For more information, see “Specifying Which Door/Window Assembly 
Cells Use a Cell Assignment” on page 1148.

10 Click OK twice.
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Removing an Infill from a Door/Window Assembly
Use this procedure to remove the infill of a cell and leave the cell empty. To 
do this, use None as the element definition. Using None also removes any 
frame edges that border the cell, but it does not affect the mullions.

Removing infill from a Door/Window Assembly cell

To remove the infill of a cell

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid that contains the cells you want to assign 
to None.

6 Select an existing cell assignment or create a new one.

7 Select None under the Element column.

8 Specify the cells to contain the None infill. 

For more information, see “Specifying Which Door/Window Assembly 
Cells Use a Cell Assignment” on page 1148.

9 Click OK twice.

Specifying Which Door/Window Assembly Cells Use a Cell 
Assignment
When you create a cell assignment you need to specify the cells in the grid 
to use that assignment. There are two options for selecting cells:

� Use Location to insert the infill into the start, middle, or end cells of a ver-
tical grid or into the bottom, middle, or top cells of a horizontal grid. If 
there is an even number of cells (four or more), Middle refers to the two 
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cells in the middle of the grid. If there is an odd number of cells (three or 
more), Middle refers to one cell in the middle of the grid.
Specifying Door/Window Assembly infill by location

� Use Index to insert the infill into specific cells based on cell numbers. Cells 
are numbered from start to end or bottom to top. For example, typing 1, 
2, 3 would place the infill in the first, second and third cells.

Specifying Door/Window Assembly infill by index

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.
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6 Select a cell assignment:

NOTE Do not assign multiple definitions to a cell. If you do, the last defini-
tion assigned to the cell is used. 

7 Click OK twice.

Any cells that are not assigned a specific cell assignment use the default 
infill.

Removing an Assignment from a Door/Window Assembly 
Style
Use this procedure to remove cell assignments, frame assignments, and mul-
lion assignments from a door/window assembly style. You cannot remove 
default assignments, but you can modify them to suit your needs.

NOTE Each grid requires one division assignment, therefore you cannot 
remove the division assignment. You can change the division element used for 
the division assignment.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid from which you want to remove an assign-
ment.

6 Select a cell assignment, frame assignment, or a mullion assignment.

7 Click Remove Assignment.

If you selected . . . Then . . .

Location click the Used In column, and click the button 
at the far right of the row. Select the cells you 
want to use this assignment, and click OK.

Index enter the cell numbers separated by commas 
in the Used In column. For vertical grids, cells 
are numbered from start to end and for 
horizontal grids, cells are numbered from 
bottom to top.
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8 Click OK twice.

Assigning Definitions to Door/Window Assembly 
Frames

The door/window assembly frame is represented by the outer edges of the 
primary grid. Each nested grid has its own frame that is defined separately 
from the primary grid frame. By default, the frames of nested grid are turned 
off. For more information about nested grids, see “Working with Nested 
Grids in Door/Window Assemblies” on page 1142.

Frame Assignments
A frame assignment defines the frame definition used by each frame edge. 
You can use one frame assignment to assign the same definition to all four 
edges of the frame, or you can create multiple frame assignments to assign 
different definitions to different edges of the frame. Unassigned edges are not 
displayed.

Default Frame Assignment
Do not assign multiple definitions to the frame edge. If you do, the last def-
inition assigned to the edge is used. 

There is a default frame assignment and you can select the frame edges it 
applies to. You can modify the default assignment to use any frame defini-
tion, but you cannot delete the default frame assignment.

Materials and Display Properties of Frames
The layer, color, linetype, and other display properties of the default frame 
are applied to all frame edges unless you assign materials to the frame defini-
tion or create a custom display component for each definition. Then you can 
control the display of each frame definition independently. For more infor-
mation, see “Specifying the Display of Door/Window Assemblies” on 
page 1160.

Related Procedures

� Adding a New Frame Assignment to a Door/Window Assembly Grid 

� Specifying Which Door/Window Assembly Edges Use a Frame Assignment

� Removing a Frame Edge from a Door/Window Assembly

Adding a New Frame Assignment to a Door/Window 
Assembly Grid
Use this procedure to add a frame assignment to a door/window assembly. To 
assign different definitions to different frame edges, you need multiple frame 
assignments.
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1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a new frame 
assignment.

6 Click New Frame Assignment.

A new frame assignment is displayed in the list of frame assignments.

7 Right-click the default name, click Rename, and then enter a descriptive 
name.

8 Under Element, select a frame definition.

9 Specify the sides of the frame to use this frame assignment. 

For more information, see “Specifying Which Door/Window Assembly 
Edges Use a Frame Assignment” on page 1152.

10 Click OK twice.

Specifying Which Door/Window Assembly Edges Use a Frame 
Assignment
When you create a frame assignment, you need to specify the edges of the 
frame to use that assignment.

Frame edges that are not assigned a frame definition are not displayed.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Select a frame assignment.

Location is the only way to specify the frame edges.

7 Click the Used In column, and then click the [...] button at the far right of 
the row.
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8 Select the edges that you want to use this assignment - Left, Right, Top, or 
Bottom - and click OK.

Specifying different Door/Window Assemblies frame definitions

NOTE Do not assign multiple definitions to the same frame edge because 
only the last definition assigned to the edge is used.

9 Click OK twice.

Removing a Frame Edge from a Door/Window Assembly 
Use this procedure to remove a frame edge from a door/window assembly. 
There are three ways to remove a frame edge:

� Set the width and depth of the edge to zero.
� Leave the edge unassigned.
� Specify None as an override to the edge assignment.

The first two methods remove the frame edge and expand the adjacent infills 
into the space occupied by the edge.

By specifying None as an override, the frame edge is not displayed, but the 
adjacent infill is not expanded into the space the edge occupied.

For information about setting the width and depth to zero, see “Defining a 
Door/Window Assembly Frame by Width and Depth” on page 1126.
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For information about leaving the edge unassigned, see “Specifying Which 
Door/Window Assembly Edges Use a Frame Assignment” on page 1152.

For information about overriding the edge, see “Creating a Frame or Mullion 
Override” on page 1174.

Assigning Definitions to the Mullions of a Door/
Window Assembly

The mullions of a door/window assembly are the edges between the grid 
cells. The primary grid and each nested grid have mullions that are defined 
separately from the other grids. For more information about nested grids, see 
“Working with Nested Grids in Door/Window Assemblies” on page 1142.

Specifying mullions for Door/Window Assembly nested grids

Mullion Assignments
A mullion assignment defines the definition used by each mullion. You can 
use one assignment to define all mullions, or you can create multiple assign-
ments and assign different definitions to different mullions in any grid.

Do not assign multiple definitions to the same mullion because only the last 
definition assigned to the mullion is used. 

Default Mullion Assignment
There is a default mullion assignment used by all unassigned mullions. You 
can modify the default assignment to be any mullion definition, but you 
cannot delete the default mullion assignment.

Related Procedures

� Adding a New Mullion Assignment to a Door/Window Assembly Style 

� Removing Mullions from a Door/Window Assembly Grid
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� Specifying Which Door/Window Assembly Mullions Use an Assignment

� Removing an Assignment from a Door/Window Assembly Style

Adding a New Mullion Assignment to a Door/Window 
Assembly Style
Use this procedure to add a new mullion assignment to a door/window 
assembly style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to create a new mullion 
assignment.

6 Click New Mullion Assignment.

A new mullion assignment is displayed in the list of mullion assignments.

7 Right-click the default name, click Rename, and then enter a descriptive 
name.

8 Under Element, select a mullion definition.

9 Specify the mullions to use this assignment. 

For more information, see “Specifying Which Door/Window Assembly 
Mullions Use an Assignment” on page 1155.

10 Click OK twice.

Specifying Which Door/Window Assembly Mullions Use an 
Assignment
When you create a mullion assignment you need to specify the mullions in 
the grid to use that assignment. There are two options for selecting mullions:

� Use Location to assign a definition to the start, middle, or end mullions of 
a vertical grid or the bottom, middle, or top mullions of a horizontal grid. 
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If there is an even number of mullions (four or more), Middle refers to the 
two mullions in the middle of the grid. If there is an odd number of mul-
lions (three or more), Middle refers to the one mullion in the middle of 
the grid.

� Use Index to assign a definition to specific mullions based on mullion 
numbers. Mullions are numbered from left to right or bottom to top. For 
example, typing 1, 2, 3 would assign the definition to the first, second, 
and third mullions.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select a grid.

6 Select an existing mullion assignment or create a new one.

7 Select a mullion assignment:

NOTE Do not assign multiple definitions to the same mullion because only 
the last definition assigned to the mullion is used. 

8 Click OK twice.

Any mullions that are not assigned a specific mullion assignment use the 
default mullion definition.

Removing Mullions from a Door/Window Assembly Grid
Use this procedure to remove a mullion from the door/window assembly. 
You can create a mullion definition whose edge width and depth are zero. 
Adjacent infills expand to fill in the space that was occupied by the mullion. 
This is an effective way to represent butt glazing.

If you selected . . . Then . . .

Location click the Used In column, and click the button at the 
far right of the row. Select the mullions you want to 
use this assignment, and click OK.

Index enter the mullion numbers separated by commas in 
the Used In column. For vertical grids, mullions are 
numbered from start to end and, for horizontal 
grids, mullions are numbered from bottom to top.
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Removing a mullion from Door/Window Assembly grid

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the Design Rules tab.

5 In the left pane, select the grid in which you want to remove a mullion.

6 Create a new mullion assignment, and enter 0 (zero) for the width and 
depth. 

For more information, see “Defining Door/Window Assembly Mullions by 
Width and Depth” on page 1134.

7 Under Mullion Assignments, select the mullion definition you created for 
mullion edges of any mullion assignment where you want to remove the 
mullions. 

For more information, see “Specifying Which Door/Window Assembly 
Mullions Use an Assignment” on page 1155.

8 Click OK twice.

Specifying the Materials of a Door/Window 
Assembly Style

A door/window assembly consists of a number of components whose display 
properties can be determined by the materials assigned to each component.

When you assign materials to a door/window assembly style, you assign one 
material to each display component of the door/window assembly. For exam-
ple, you assign a wood material to the frame and a glass material to the glass 
inset. You assign materials to components in each display representation 
where you want the materials to be used.
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If you want to use the display properties of the door/window assembly style, 
instead of using material display properties, you can turn off the material 
assignments in the display properties of the door/window assembly style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Door/Window Assembly Materials and Display Components

� Assigning Materials to a Door/Window Assembly Style

Door/Window Assembly Materials and Display Components
The following table identifies the material component that corresponds to 
each door/window assembly component in the specified views.

Door/Window 
Assembly 
Component

Material Component

Plan, Plan High Detail, Plan Low Detail, Screened, Reflected Plan

Default Infill Linework

Default Frame Linework

Default Mullion Linework

Default Infill Hatch Linework

Default Frame Hatch Linework

Default Mullion Hatch Linework

Model

Default Infill 3D Body

Default Frame 3D Body

Default Mullion 3D Body
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Assigning Materials to a Door/Window Assembly Style
Use this procedure to assign materials to the individual components of a 
door/window assembly style. When you assign a material to a door/window 
assembly component, the component uses the display properties of the 
material instead of the style display properties.

You can assign a material to any physical component of the door/window 
assembly. Custom components and components that are only symbolic 
graphics do not use materials for their display properties. For example, the 
frame, mullion, and infill are physical components of a door/window assem-
bly. The cell marker is a symbolic component.

NOTE If a material assignment does not determine the display properties of a 
door/window assembly component, you can change the display properties of 
the door/window assembly style as described in “Specifying the Display of Door/
Window Assemblies” on page 1160.

1 Open a tool palette that has a door/window assembly tool.

2 Right-click a door/window assembly tool, and click Door/Window Assem-
bly Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, select the value for Material 
Definition, and select a different material definition.

You can select any material definition in the current drawing, or click 

 to create a new material definition and assign it to a component.
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WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display of Door/Window 
Assemblies

The display of a door/window assembly depends on the direction from 
which you view the door/window assembly. In plan view, the door/window 
assembly object is displayed as parallel lines with vertices marking the grid 
lines, as an architect would typically draw a door/window assembly. In 3D 
view, the door/window assembly object is displayed as it would appear in the 
real world, with surfaces showing length, thickness, and height. You control 
what you want to display in each particular view.

Element Definitions and Custom Display Components
By default, the display of all infills, frames, and mullions is controlled by the 
display properties of the default infill, default frame, and default mullion. 
However, you can add individual element definitions as components with 
separate display properties. For example, if you define two infills called stone 
panel and glass panel, by default they are both controlled by the default infill 
display properties. But you can add each definition as a new display compo-
nent and then control the display properties separately.

NOTE The component name in the Custom Display Component dialog box 
must match the name of element definition in the Design Rules tab. Otherwise, 
the element definition does not display properly.

For more information about the display system, see “Display System” on 
page 435.

Materials and Display Properties
You can use materials to control the display of both default and custom 
infills, frames, and mullions. When you assign materials to the element def-
initions you create, you do not need to define these definitions as custom dis-
play components. For more information, see “Specifying the Materials of a 
Door/Window Assembly Style” on page 1157.
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Related Procedures

� Adding Door/Window Assembly Element Definitions as Display Compo-
nents

� Specifying the Layer, Color, and Linetype of a Door/Window Assembly 
Style

� Specifying the Hatching for Components of a Door/Window Assembly 
Style

� Adding Custom Graphics as a Display Component of a Door/Window 
Assembly

� Creating Cut Planes for a Door/Window Assembly

Adding Door/Window Assembly Element Definitions as 
Display Components
Use this procedure to add door/window assembly element definitions. Before 
you can control the display properties of door/window assembly elements 
according to the definition assigned to the element, you must create display 
components for each element definition.

1 Select a door/window assembly, and click Edit Door/Window Assembly 
Style.

2 In the Door/Window Assembly Style Properties dialog box, click the Dis-
play Properties tab.

3 Click Edit Display Properties.

4 Click the Other tab, and then click Add.

NOTE If you click the Custom Plan Component tab, the Custom Display 
Component dialog box is similar, except that you do not specify the Z inser-
tion point and Z offset for the custom graphic.

5 Select Infill, Frame, or Mullion for Component Type.

6 Enter a name for Component Name, or click Select Element and select an 
element from the list.

7 Click OK.

8 Click the Layer/Color/Linetype tab.

The element definition that you added is displayed in the list of compo-
nents.

9 Click the Other tab to continue adding element definitions, or click OK 
twice.



1162 | Chapter 16 Door/Window Assemblies

Specifying the Layer, Color, and Linetype of a Door/Window 
Assembly Style
Use this procedure to change the following display properties of the compo-
nents of an individual door/window assembly: 

� Visibility (component is on or off)
� By Material
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the door/window assembly you want to change, right-click, and 
click Edit Door/Window Assembly Style.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and click Style Override.

4 Click the Layer/Color/Linetype tab.

5 Select the component to change, and select a different setting for the 
property.

6 Click OK twice.

Specifying the Hatching for Components of a Door/Window 
Assembly Style
Use this procedure to specify the hatching of the components of an individ-
ual door/window assembly. Door/window assembly hatching is displayed 
only in display representations, such as Plan, that are used in the Top view 
(Plan view) of a drawing.

1 Select the door/window assembly you want to change, right-click, and 
click Edit Door/Window Assembly Style.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and click Style Override.

4 Click the Hatching tab.

5 Select a component, and click the setting for Pattern.
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6 Select the hatching for the component:

7 Click OK.

8 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

9 Click Angle, and enter the angle for the selected pattern.

10 Click Orientation, and specify how the hatching is oriented:

11 Click OK twice.

Adding Custom Graphics as a Display Component of a Door/
Window Assembly
There may be instances where an infill, frame, or mullion requires a custom 
2D or 3D graphic. For example, you might need a highly detailed three-
dimensional truss as the mullions or a decorative light fixture applied to an 
infill. In cases like these, you can create a custom block, add a display com-
ponent with the block attached, and associate that component with an ele-
ment definition. When you assign that definition to an element, the block is 
also displayed.

If you want to select . . . Then . . .

a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

single hatching select User-defined for Type, and clear Double 
Hatch.

double hatching select User-defined for Type, and select 
Double Hatch.

solid fill select Solid Fill for Type.

If you want to orient the hatching . . . Then . . .

to the object, regardless of the object rotation select Object.

to the World Coordinate System select Global.
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1 Draw your custom component, and save it as a block.

2 Select a door/window assembly, right-click, and click Edit Door/Window 
Assembly Style.

3 Click the Display Properties tab.

4 Click .

5 Click the Custom Plan Components tab.

If Model, Sill Plan, or Sill Plan Screened is the current display representa-
tion, the tab is called Other.

6 Click Add.

7 Select Infill, Frame, or Mullion as the element type.

8 Select the specific element from the list.

9 Select Draw Custom Graphics.

10 Specify the display of the element: 

11 Click Select Block and select the custom block that you created.

12 Click OK.

13 Specify further settings for the custom display block: 

If you want to . . . Then . . .

display the block instead of the 
associated door/window assembly 
element

select Replace Graphics.

superimpose the block over the 
door/window assembly element so 
that both are displayed

clear Replace Graphics. 

If you want to . . . Then . . .

scale the block to fit a particular 
dimension

select Width, Height, or Depth. To prevent 
the block from losing its proportions, select 
Lock XY Ratio.

mirror the block determine if it should mirror in the X, Y, or Z 
direction.

specify how the block is inserted 
into the grid in the X, Y, and Z 
directions

specify an insertion point on the X, Y, and Z 
planes.
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14 Click OK three times.

Creating Cut Planes for a Door/Window Assembly
Use this procedure to specify the properties of one or more cut planes for a 
door/window assembly style. Cut plane display properties apply only to dis-
play representations, such as Plan, that are used in Top view (Plan view) of a 
drawing.

To better visualize the elements of a door/window assembly in plan view, you 
can create cut planes. The main cut plane is where the shrinkwrap and hatch-
ing are applied. The plan display shows the components of the door/window 
assembly as they are displayed at the height of each cut plane.

1 Select a door/window assembly, right-click, and click Edit Door/Window 
Assembly Style.

2 Click the Display Properties tab.

3 Select Plan, and click .

NOTE The Cut Plane tab is displayed only in some display representations, 
such as Plan. 

4 Click the Cut Plane tab to set the cut plane to be displayed in each display 
representation for the door/window assembly style.

5 Enter a value for Cut Plane Height to specify the cut plane at which hatch-
ing takes effect.

6 To specifically define a cut plane, click Add, and enter the height of the 
new cut plane:

offset the block from the grid specify the offset in the X, Y, or Z direction.

If you add a cut plane . . . Then . . .

at a height that is lower than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Below Cut Plane component 
on the Layer/Color/Linetype tab.

at a height that is higher than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Above Cut Plane component 
on the Layer/Color/Linetype tab.

If you want to . . . Then . . .
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7 Click OK twice.

Attaching Notes and Files to a Door/Window 
Assembly Style

Use this procedure to enter notes and attach reference files to a door/window 
assembly. You can also edit notes and edit or detach reference files from a 
door/window assembly.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Door/Window Assembly 
Styles.

3 Select a door/window assembly style, right-click, and click Edit.

4 Click the General tab.

5 To add a description to the door/window assembly, enter it for Descrip-
tion.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Using Overrides in Door/Window Assemblies

Door/window assemblies are geometrically complex objects that often have 
a large number of different elements, such as frames, panels, and window 
infills. The settings for these elements are defined in the door/window assem-
bly style and can be modified using Style Manager. However, there are cases 
when modifying a door/window assembly directly on screen is more suitable:

� You want to add custom frame or mullion edges to a door/window assem-
bly and need direct visual feedback. 

� You want to create an override, like a merged infill or an irregular panel 
shape in only one specific place in the door/window assembly.

� You want to experiment with different visuals without having to change 
the door/window assembly style for each idea immediately.

When you have finished your onscreen edits, you can decide if you want to 

� apply the overrides to the door/window assembly you have edited.
� save the overrides to the current door/window assembly style.
� create a new style for the overrides.

NOTE You cannot modify a definition using the Override method. For infor-
mation about modifying definitions, see “Modifying Element Definitions for 
Door/Window Assembly Styles” on page 1185.

Overrides do not affect the door/window assembly design rules. However, 
you can transfer overrides to a door/window assembly style when you want 
all door/window assemblies of that style to have the same overrides.

You can view a list of overrides that are currently assigned to a door/window 
assembly from the Overrides tab of the Door/Window Assembly Properties 
dialog box. For more information, see “Creating a Division Override” on 
page 1180.

NOTE Overrides are also listed on the Overrides tab in the Door/Window 
Assembly Style Properties dialog box.

Related Topics

� Overriding Door/Window Assembly Infills

� Overriding Door/Window Assembly Frames and Mullions

� Creating a Division Override
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Overriding Door/Window Assembly Infills

The cell infills of a door/window assembly are set in the door/window assem-
bly style. You can, however, create overrides for these infills in cells. For 
example, you might want a row of glider windows for a first floor facade. In 
one specific position, however, you want a frosted glass window. In this case, 
you would set the row of glider windows in the door/window assembly style, 
and then override the infill style in one specific cell with a frosted glass win-
dow. 

Door/window assembly infills can consist of simple panels, objects like win-
dows or doors, or nested grids. You can change one infill for another, merge 
cells, or remove the frame from an infill altogether. This would be useful if 
you add a door into a grid cell and want to remove the bottom frame from 
that cell.

Related Procedures

� Turning on Cell Markers

� Merging Door/Window Assembly Cells

� Creating a Door/Window Assembly Infill Override

� Creating a Division Override 

Turning on Cell Markers

Use this procedure to turn on the cell markers for each grid cell in a door/
window assembly. The cell markers must be on in order to select individual 
cells and make changes to them. 

Viewing Door/Window Assembly cell markers

1 Select the door/window assembly for which you want to create an infill 
override.

2 Right-click, and click Infill ➤ Show Markers.
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Merging Door/Window Assembly Cells
Use this procedure to merge two door/window assembly cells.

NOTE To merge door/window assembly cells, the cell markers need to be vis-
ible. For information on turning on cell markers, see “Turning on Cell Markers” 
on page 1168.

You can only merge cells that are adjacent to each other.

In most cases, you merge cells with the same infill type. The merged cell is 
then of the same type as the original cells. For example, if you merge two 
solid panel infills, the resulting merged cell also has a solid panel infill. In 
some cases however, you might want to merge two cells that have different 
infill types. In that case, the infill type of the first selected cell is used for the 
merged cell. For example, if you want to merge a cell with a simple panel 
infill and a cell with a window infill, and you select the cell with the simple 
panel first during the merge command, the merged cell contains a simple 
panel infill, not a window. If you select the two cells in the opposite order, 
the merged cell contains a window and no simple panel infill. 

Merging two Door/Window Assembly cells

1 Select the door/window assembly on which you want to merge two cells.
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2 Right-click, and click Infill ➤ Merge.

3 Select the first cell to be merged.

4 Select the second cell to be merged.

The cells are merged into one.

5 Specify where you want to save the door/window assembly override:

6 If you chose to save the override to a door/window assembly style, select 
the door/window assembly again, right-click, and click Design 
Rules ➤ Save to Style. Then choose the door/window assembly style in 
which to save the override. 

If you want to save 
the override . . .

Then . . .

only on this specific door/
window assembly

no further steps are necessary. The override is saved 
to the door/window assembly. For information 
about how to remove an override from a door/
window assembly, see “Creating a Division 
Override” on page 1180.

save the override to a 
door/window assembly 
style

select the door/window assembly, right-click, and 
select Design Rules ➤ Transfer to Object.

If you want to . . . Then . . .

save the override to the 
current door/window 
assembly style

select Transfer Merge Operations to Style, and 
click OK.

NOTE If you have created only a cell merge, 
only the Transfer Merge Operations to Style 
checkbox is active. If you have also created other 
overrides, such as a new cell assignment or a 
frame or mullion edge override, these 
checkboxes are available as well. If you also want 
to save these overrides to the style, select their 
checkboxes too. 
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NOTE If you do not want to save the override back to a style at all, right-
click, and click Design Rules ➤ Revert to Style Design Rules. The overrides 
still remain on the door/window assembly, where they can be removed as 
described in “Creating a Division Override” on page 1180, but they are not 
saved back to a door/window assembly style.

Creating a Door/Window Assembly Infill Override
Use this procedure to override the infill of a door/window assembly cell. 

For example, you might have a row of simple concrete panels in your door/
window assembly, but want in one location a round window instead of the 
concrete panel. In that case, it might be simpler to use an infill override, 
instead of creating complex door/window assembly definitions.

NOTE To override an infill assignment, the cell markers must be visible. For 
information on turning on cell markers, see “Turning on Cell Markers” on 
page 1168.

To exchange an infill definition, the new infill definition must already be 
defined in the curtain wall style. For information on creating infill defini-
tions, see “Defining Infills for Door/Window Assembly Cells” on page 1117.

1 Select the door/window assembly on which you want to override an infill.

2 Right-click, and click Infill ➤ Override Assignment.

3 Select the marker of the cell(s) where you want to create an override, and 
press ENTER.

save the override to a new 
door/window assembly style

select Transfer Merge Operations to Style, and 
click New. Then, enter a name for the new door/
window assembly style, and click OK.

NOTE If you have created only a cell merge, 
only the Transfer Merge Operations to Style 
checkbox is active. If you have also created other 
overrides, such as a new cell assignment or a 
frame or mullion edge override, these 
checkboxes are available as well. If you also want 
to save these overrides to the style, select their 
checkboxes too. 

If you want to . . . Then . . .
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4 Create the override: 

5 Click OK.

6 Specify where you want to save the door/window assembly override:

7 If you have chosen to save the override to a door/window assembly style, 
select the door/window assembly again, right-click, and click Design 

If you want to . . . Then . . .

exchange the existing 
infill for another

select a new infill definition from the list.

remove one or more of 
the frames around the 
infill

select the frame component to be removed. You 
could, for example, override a cell to contain a door 
infill instead of a panel infill; in this case, you would 
want to remove the bottom frame of the cell.

remove the complete 
infill and its frame

select Remove Infill and Frames.

NOTE This works only for infills that border the 
exterior of the door/window assembly.

If you want to . . . Then . . .

save the override only on 
this specific door/window 
assembly

no further steps are necessary. The override is saved 
to the door/window assembly. For information 
about how to remove an override from a door/
window assembly, see “Creating a Division 
Override” on page 1180.

save the override to a 
door/window assembly 
style

select the door/window assembly, right-click, and 
select Design Rules ➤ Transfer to Object. 
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Rules ➤ Save to Style and decide to which door/window assembly style 
you want to save the override. 

NOTE If you do not want to save the override back to a style at all, right-
click, and click Design Rules ➤ Revert to Style Design Rules. The overrides 
remain on the door/window assembly, where they can be removed as 
described in “Creating a Division Override” on page 1180, but they are not 
saved back to a door/window assembly style.

Overriding Door/Window Assembly Frames and 
Mullions

You can change a selected frame edge or mullion edge by using an edge 
assignment override.

NOTE To exchange a frame edge or mullion edge, the new edge definition 
must already be defined in the door/window assembly style.

Removing the edge does not affect the width of the cell. To remove the edge 
and have the adjacent cell resize, create an edge definition with a width and 
depth of zero. For more information, see “Defining a Door/Window Assem-

If you want to . . . Then . . .

save the override to the 
current door/window 
assembly style

select Transfer Cell Overrides to Style, and click 
OK.

NOTE If you have created only an infill override, 
only the Transfer Cell Overrides to Style checkbox 
is active. If you have also created other overrides, 
such as a cell merge or a frame or mullion edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too. 

save the override to a new 
door/window assembly style

select Transfer Cell Overrides to Style, and click 
New. Then, enter a name for the new door/
window assembly style, and click OK.

NOTE If you have created only an infill override, 
only the Transfer Cell Overrides to Style checkbox 
is active. If you have also created other overrides, 
such as a cell merge or a frame or mullion edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too.
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bly Frame by Width and Depth” on page 1126 or “Defining Door/Window 
Assembly Mullions by Width and Depth” on page 1134.

You can also create a new edge profile by drawing a polyline or using an exist-
ing profile in the drawing. This edge profile can be interactively edited 
onscreen by in-place editing.

Related Topics

� Creating a Frame or Mullion Override

� Creating a Frame or Mullion Edge from a Polyline or Profile using In-Place 
Editing

� In-Place Editing of Edge Profiles

Creating a Frame or Mullion Override
Use this procedure to select a different element definition for a selected frame 
edge or mullion by using an edge assignment override.

To exchange a frame or mullion, the new definition must already be defined 
in the door/window assembly style. For information on creating frames and 
mullions, see “Defining Door/Window Assembly Frames” on page 1125 and 
“Defining Door/Window Assembly Mullions” on page 1132.

Overriding a Door/Window Assembly frame definition

1 Select the door/window assembly on which you want to override an edge.

2 Right-click, and click Frame/Mullion ➤ Override Assignment.

3 Select the frame or mullion edge you want to override.
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4 Create the override:

5 Click OK.

6 Specify where you want to save the door/window assembly override:

7 If you have chosen to save the override to a door/window assembly style, 
select the door/window assembly again, right-click, and click Design 
Rules ➤ Save to Style and decide to which door/window assembly style 
you want to save the override. 

If you want to . . . Then . . .

exchange the existing 
edge for another

select a new edge definition from the list.

remove the frame or 
mullion edge

select Remove.

If you want to . . . Then . . .

save the override only on 
this specific door/window 
assembly

no further steps are necessary. The override is saved 
to the door/window assembly. For information 
about how to remove an override from a door/
window assembly, see “Creating a Division 
Override” on page 1180.

save the override to a 
door/window assembly 
style

select the door/window assembly, right-click, and 
select Design Rules ➤ Transfer to Object. 

If you want to . . . Then . . .

save the override to the 
current door/window 
assembly style

select Transfer Edge Overrides to Style, and click 
OK. 

NOTE If you have created only a frame or 
mullion edge override, only the Transfer Edge 
Overrides to Style checkbox is active. If you have 
also created other overrides, such as a cell merge 
or a division override, these checkboxes are 
available as well. If you also want to save these 
overrides to the style, select their checkboxes too. 
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NOTE If you do not want to save the override back to a style at all, right-
click, and click Design Rules ➤ Revert to Style Design Rules. The overrides 
remain on the door/window assembly, where they can be removed as 
described in “Creating a Division Override” on page 1180, but they are not 
saved back to a door/window assembly style.

Creating a Frame or Mullion Edge from a Polyline or Profile 
using In-Place Editing
Use this procedure to assign a profile to a vertical edge of a frame or mullion. 
The profile can be any profile or any closed polyline that you specify. You can 
use a profile edge to create a unique corner in situations where a simple miter 
is not sufficient. 

NOTE Adjacent infills are not trimmed or expanded to accommodate the new 
edge. To adjust the infill, change the width of the frame edge. For more infor-
mation, see “Defining a Door/Window Assembly Frame by Width and Depth” on 
page 1126.

1 Draw a closed polyline in the location where you want it to display in the 
door/window assembly.

NOTE For best results, it is recommended to draw the polyline in Plan view. 

2 Select the door/window assembly for which you want to create a frame or 
mullion edge profile override.

3 Right-click, and click Frame/Mullion ➤ Add Profile.

save the override to a new 
door/window assembly style

select Transfer Edge Overrides to Style, and click 
New. Then, enter a name for the new door/
window assembly style, and click OK.

NOTE If you have created only a frame or 
mullion edge override, only the Transfer Edge 
Overrides to Style checkbox is active. If you have 
also created other overrides, such as a cell merge 
or a division override, these checkboxes are 
available as well. If you also want to save these 
overrides to the style, select their checkboxes too. 

If you want to . . . Then . . .
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4 Specify the mode in which to edit the door/window assembly:

5 Right-click, and click Frame/Mullion ➤ Add Profile. 

6 Select a vertical frame or a mullion edge.

7 Select a profile for the override:

8 Select whether to apply the profile to the shared edge element definition 
or as an edge profile override.

9 Click OK.

You are now in in-place edit mode, and can edit the profile.

10 On the In-Place Edit toolbar, click  to zoom to the profile.

11 Select the profile and edit it using Edge and Vertex grips, or by using the 
right-click shortcut menu.

If you want to edit . . . Then . . .

this instance of the door/window 
assembly

right-click, and click Design 
Rules ➤ Transfer to Object.

the door/window assembly style right-click, and click Design 
Rules ➤ Revert to Style Design 
Rules.
If this option is not available, the 
design rules are already style-based for 
the door/window assembly.

If you want to create the 
edge profile from . . .

Then . . .

the polyline drawn in step 1 select Start from scratch for Profile Definition, 
and enter a name for New Profile Name.

an existing profile in the 
drawing

select the existing profile for Profile Definition.
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12 Save or discard changes to the door/window assembly grid:

In-Place Editing of Edge Profiles
Use this procedure to edit profile edges using in-place editing.

With in-place editing, you can edit the profile directly and interactively on 
screen, and later save the changes to the profile definition.

1 Select the door/window assembly that has the edge profile you want to 
edit onscreen with in-place editing.

2 Right-click, and click Frame/Mullion ➤ Edit Profile in Place.

This command is only available if you have profile-based edges in the 
door/window assembly.

NOTE If the profile is not drawn to size, it must be converted in order for 
you to begin the in-place editing session. Click Yes if prompted to convert the 
profile to its actual size.

3 Select the edge you want to edit. 

NOTE You have entered the in-place editing session now. You can see this 
from the magenta-colored grips and light blue hatch of the temporary in-
place editing profile, as well as the faded color of all other objects in the draw-
ing. Note that while you are in the in-place editing session, you have only lim-
ited editing access to other commands in the drawing. Before working on 
other objects, you should first end the in-place editing session.

If you want to exit the in-place 
editing session . . .

Then . . .

without saving your changes

click  on the In-Place Edit 
toolbar.

after saving your changes

click  on the In-Place Edit 
toolbar.
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4 Edit the profile: 

5 Save the changes to the profile:

If you want to . . . Then . . .

use grips to edit the 
profile

move the grips as needed.

add a vertex to the 
profile

select the profile, right-click, and click Add Vertex. 
Then, add new vertices as needed. Press ENTER. 

remove a vertex from 
the profile

select the profile, right-click, and click Remove Vertex. 
Then, remove vertices as needed. Press ENTER. 

add a ring to the profile select the profile, right-click, and click Add Ring. Then, 
select a closed polyline, spline, ellipse, or circle for an 
additional ring. Specify if you want to erase the source 
linework, and press ENTER. 

remove a ring from a 
profile

select the profile, right-click, and click Remove Ring. 
Then select the ring you want to remove.

NOTE You cannot remove the last ring from a profile. 

replace a ring on a 
profile

select the profile, right-click, and click Replace Ring. 
Then, select a closed polyline, spline, ellipse, or circle 
for the replaced ring. Specify if you want to erase the 
source linework, and press ENTER. 

If you want to . . . Then . . .

change the existing profile 
definition to reflect the 
new shape

select the profile, right-click, and click Save. The in-
place edit session is exited and the profile definition 
is updated.

create a new profile 
definition with the shape 
you have created

select the profile, right-click, and click Save As New 
Profile. Then, enter a name for the new profile and 
click OK. The in-place edit session is exited and the 
new profile definition is available in the Style 
Manager.

discard all changes on the 
profile and revert back to 
the previous shape

select the profile, right-click, and click Discard all 
Changes. The in-place edit session is exited and all 
changes you have made to the profile are purged.
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Overriding Door/Window Assembly Divisions

The grid of a door/window assembly is made up of one or more divisions that 
define how the door/window assembly is partitioned. Divisions can be hori-
zontal or vertical, and can be nested in each other. For detailed information 
on door/window assembly divisions, see “Defining Divisions for Door/Win-
dow Assembly Grids” on page 1108.

You can override a division in a door/window assembly, thereby changing 
the grid of the door/window assembly.

Overriding a Door/Window Assembly cell division definition

Related Topics

� Creating a Division Override

� In-Place Editing of Door/Window Assembly Divisions

Creating a Division Override

Use this procedure to create a division override on a door/window assembly.

NOTE To exchange a door/window assembly division, the new division defi-
nition must already be defined in the door/window assembly style. For informa-
tion on door/window assembly divisions, see “Defining Divisions for Door/Win-
dow Assembly Grids” on page 1108. 

1 Select the door/window assembly for which you want to create a division 
override.

2 Right-click, and click Division ➤ Override Assignment.

3 Select an edge of the door/window assembly to determine if a horizontal 
or vertical division is overridden. 



Using Overrides in Door/Window Assemblies | 1181

For example, if you want to override the primary horizontal division, you 
could select the bottom horizontal frame of the door/window assembly.

TIP The Division Assignment Override dialog box shows you which grid 
type and which grid division you have selected, e.g. Selected Nested Grid: 
Secondary Grid, Division Element Definition: Vertical 3 Cells. If you have acci-
dentally selected the wrong division, click Cancel and reselect the correct 
grid.

4 Select the division to override, and click OK.

5 Specify where you want to save the door/window assembly override:

6 If you have chosen to save the override to a door/window assembly style, 
select the door/window assembly again, right-click, and click Design 
Rules ➤ Save to Style and decide to which door/window assembly style 
you want to save the override. 

If you want to save 
the override . . .

Then . . .

only on this specific door/
window assembly

no further steps are necessary. The override is saved 
to the door/window assembly. For information 
about how to remove an override from a door/
window assembly, see “Removing Door/Window 
Assembly Overrides” on page 1185.

to a door/window 
assembly style

select the door/window assembly, right-click, and 
select Design Rules ➤ Transfer to Object. 

If you want to . . . Then . . .

save the override to the 
current door/window 
assembly style

select Transfer Division Overrides to Style, and 
click OK. 

NOTE If you have created only a profile edge 
override, only the Transfer Division Overrides to 
Style checkbox is active. If you have also created 
other overrides, such as a cell merge or a edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too. 
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NOTE If you do not want to save the override back to a style at all, right-
click, and click Design Rules ➤ Revert to Style Design Rules. The overrides 
remain on the door/window assembly, where they can be removed as 
described in “Removing Door/Window Assembly Overrides” on page 1185, 
but they are not saved back to a door/window assembly style.

In-Place Editing of Door/Window Assembly Divisions 
Use this procedure to edit divisions using in-place editing.

With in-place editing, you can edit the door/window assembly directly and 
interactively on screen, and later save the changes to the door/window 
assembly or door/window assembly style.

1 Select a door/window assembly on which you want to edit divisions 
onscreen with in-place editing. 

2 Specify the mode in which to edit the door/window assembly:

3 Click the Edit Grid grip.

save the override to a new 
door/window assembly style

select Transfer Division Overrides to Style, and 
click New. Then, enter a name for the new door/
window assembly style, and click OK.

NOTE If you have created only a profile edge 
override, only the Transfer Division Overrides to 
Style checkbox is active. If you have also created 
other overrides, such as a cell merge or a edge 
override, these checkboxes are available as well. If 
you also want to save these overrides to the style, 
select their checkboxes too. 

If you want to . . . Then . . .

edit this instance of the door/window 
assembly

right-click, and click Design 
Rules ➤ Transfer to Object.

edit the door/window assembly style right-click, and click Design 
Rules ➤ Revert to Style Design Rules.
If this option is not available, the 
design rules are already style-based for 
the door/window assembly.

If you want to . . . Then . . .
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Viewing the Edit Grid grip

4 Select an edge on the division you want to edit. 

For example, if you want to edit the primary grid, select an edge on the 
outer door/window assembly frame. 

NOTE You have entered the in-place editing session now. You can see this 
from the faded color of all objects in the drawing, as well as from the different 
grips at your disposal. Note that while you are in the in-place editing session, 
you have only limited editing access to other commands in the drawing. 
Before working on other objects, you should first end the in-place editing ses-
sion.

Viewing Edit In Place grips

5 Edit the division: 

If you want to . . . Then . . .

add a bay to the grid click the Add Bay grip.

remove a bay from the 
grid

click the Remove Bay grip.

change the start offset 
of the grid

select the Start Offset grip and move it to the 
appropriate position.
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6 Save or discard changes to the door/window assembly grid:

7 In the Save Changes dialog box, specify to which division to save the 
changes:

change the end offset of 
the grid

select the End Offset grip and move it to the 
appropriate position.

change the spacing of 
bays

click the Auto Grid Bay Spacing grip and move it to 
the appropriate position.

manually edit the grid right-click, and click Convert To Manual.
You can manually add and remove gridlines, change 
the offsets, and change the position of individual 
gridlines.

use a worksheet to edit 
the cell dimensions

click the Set Fixed Cell Dimension Rules command 
grip, and edit the values in the worksheet.

If you want to . . . Then . . .

exit the in-place editing session 
without saving your changes

click  on the In-Place Edit 
toolbar.

exit the in-place editing session after 
saving your changes

click  on the In-Place Edit 
toolbar.
If you edited the grid by instance, the 
changes are saved to the design rules 
for the individual grid. If you edited the 
door/window assembly style, the Save 
Changes dialog box is displayed.

If you want to . . . Then . . .

save the changes to the style in the 
current door/window assembly 
division

verify the current division is selected 
for Save Changes to Existing Division, 
and click Save.
The changes are made in the style and 
affect all door/window assemblies of 
that style in the drawing.

If you want to . . . Then . . .
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Removing Door/Window Assembly Overrides

Use this procedure to remove door/window assembly overrides either from 
the door/window assembly or the door/window assembly style.

1 Select the door/window assembly:

2 Select an override from the list and click Remove.

3 Click OK.

Modifying Element Definitions for Door/
Window Assembly Styles

You can modify element definitions using the Design Rules tab of the Door/
Window Assembly Style Properties dialog box. You can access these 
definitions from the assignments list and from the definitions list:

� From the assignments list: Select a grid from the tree view to display the 
assignments list. Then select an assignment that uses that definition. 
Make your changes below the assignment list.

create an override to the style by 
saving the changes in a new door/
window assembly division

click New, enter a name for the new 
division override, and click OK. Click 
Save.
The changes are saved as an override 
to the style, and affect only the door/
window assemblies to which the 
override is applied.

If you want to . . . Then . . .

remove an override from a 
door/window assembly

select the door/window assembly, expand 
Advanced in the Properties palette, and click 
Overrides.

remove an override from 
the door/window 
assembly style

select the door/window assembly, right-click, and 
click Edit Door/Window Assembly Style. Then click 
the Overrides tab.

If you want to . . . Then . . .
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� From the definitions list: Select an element type from the tree view to dis-
play all definitions for that element type. Select a definition and make 
your changes below the definitions list.

Any changes you make, including changes to the definition name, overwrite 
the existing definition. To create a new definition from the assignments list, 
select New from the Element list. To create a new definition from the defini-
tions list, click the New Division icon, the New Infill icon, the New Frame 
icon, or the New Mullion icon.

Editing Door/Window Assemblies

Most relevant settings for a door/window assembly are defined in the door/
window assembly style. These settings include divisions, infills, frames, and 
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mullions. For information on modifying a door/window assembly style, see 
“Door/Window Assembly Styles” on page 1102.

You can make other changes directly to individual door/window assemblies, 
which affect only the door/window assembly you select:

� The dimensions of a door/window assembly
� Interference conditions
� Cleanup settings

Methods of Editing Door/Window Assemblies
Autodesk Architectural Desktop offers several methods for editing door/win-
dow assemblies:

� You can directly edit door/window assemblies using grips for dimensions 
and other physical characteristics.

� You can change door/window assembly settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

door/window assembly.

NOTE For information about changing the elements within a door/window 
assembly, see “Using Overrides in Door/Window Assemblies” on page 1167. For 
information about changing the display of the door/window assemblies, see 
“Specifying the Display of Door/Window Assemblies” on page 1160.

Related Procedures

� Using Grips to Edit Door/Window Assemblies

� Changing the Width of a Door/Window Assembly

� Changing the Height of a Door/Window Assembly

� Changing the Location Properties of a Door/Window Assembly

� Selecting a Different Door/Window Assembly Style

� Matching the Properties of an Existing Door/Window Assembly

� Changing the Door/Window Assembly Dimensions

� Changing the Shape of a Door/Window Assembly

� Changing the Location of a Freestanding Door/Window Assembly

� Adding an Interference Condition to a Door/Window Assembly

� Removing an Interference Condition from a Door/Window Assembly

� Mitering Door/Window Assemblies

� Specifying a Miter Angle for a Door/Window Assembly Adjacent to 
Another Object

� Attaching Hyperlinks, Notes, or Files to a Door/Window Assembly
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Using Grips to Edit Door/Window Assemblies

Refer to the illustrations and steps in this topic to use door/window assembly 
grips to edit door/window assemblies.

Editing Door/Window Assembly Dimensions

1 Select the door/window assembly.

2 Select the grip for the dimension you want to change.

You can modify the dimensions of the base height and width for a door/
window assembly.

Viewing Door/Window Assembly Grips

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Changing the Location of a Door/Window Assembly

1 Select the door/window assembly.

2 Select and hold the Location grip:

If you want to move the door/
window assembly . . .

Then . . .

along the length of the wall drag the cursor to the new 
location.

within the width of the wall press CTRL, and drag the 
cursor to the new location.
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Changing the Width of a Door/Window 
Assembly

Use this procedure to change the width of a door/window assembly. You can 
also change the width on the Properties palette.

1 Select the door/window assembly.

2 Select the Width grip, move the grip until the width value you want is dis-
played, and click once.

NOTE As you move the grip, the original width value is displayed in addi-
tion to the new width and the difference between the two values.

Using grips the change the width of a Door/Window Assembly

vertically press CTRL twice, and drag the 
cursor to the new location.

If you want to move the door/
window assembly . . .

Then . . .
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After selecting the grip, you can also enter a value to be added to or sub-
tracted from the width of the door/window assembly, depending on the 
direction in which you move the grip.

Changing the Height of a Door/Window 
Assembly

Use this procedure to change the height of a door/window assembly. You can 
also change the height on the Properties palette.

1 Select the door/window assembly.

2 Select the Height grip, move the grip until the height value you want is 
displayed, and click once.

NOTE As you move the grip, the original height value is displayed in addi-
tion to the new height and the difference between the two values.

Using grips to change the height of a Door/Window Assembly

After selecting the grip, you can also enter a value to be added to or sub-
tracted from the height of the door/window assembly, depending on the 
direction in which you move the grip.
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Changing the Location Properties of a Door/
Window Assembly

Use this procedure to change the location properties of a door/window 
assembly. Location properties include vertical alignment, head height, sill 
height, and rotation.

1 Double-click the door/window assembly.

2 Expand Location.

3 Change the location properties.

4 Select Additional information to display the Location worksheet, where 
you can change additional location properties, such as coordinate system, 
insertion point, and normal.

Selecting a Different Door/Window Assembly 
Style

Use this procedure to select a different style for a door/window assembly.

1 Double-click the door/window assembly for which you want to change 
the styles.

You can select multiple door/window assemblies and change the style for 
all at the same time.

2 Expand General.

3 Select a different style.

Location Property Description

Vertical alignment Specifies whether to measure the vertical height of 
the window to the sill or head

Head height The head height of the window

Sill height The sill height of the window

Rotation Reference angle for the object
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Matching the Properties of an Existing Door/
Window Assembly

Use this procedure to apply the properties of a door/window assembly tool 
to one or more existing door/window assemblies. The properties include the 
door/window assembly style and any other settings specified in the tool you 
select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a door/window assembly tool, and click Apply Tool Properties 
to ➤ Door/Window Assembly.

3 Select the door/window assemblies, and press ENTER.

The properties of the selected door/window assemblies match the proper-
ties of the door/window assembly tool.

Changing the Door/Window Assembly Dimensions
Use this procedure to change the dimensions of a door/window assembly.

1 Double-click a door/window assembly.

2 Expand Dimensions.
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3 Change the dimensions:

Changing the Shape of a Door/Window Assembly

Use this procedure to change the shape of a door/window assembly. There 
are several predefined shapes for door/window assemblies. You can use any 
of these shapes or use an AEC profile as the shape. For more information 
about profiles, see “Creating a Profile for a Door/Window Assembly Frame”. 

1 Select a door/window assembly, right-click, and click Edit Door/Window 
Assembly Style.

2 Click the Shape tab.

3 Select a shape from the Predefined list or select Use Profile, and select an 
existing AEC Profile as the shape.

4 Click OK.

Changing the Location of a Freestanding Door/
Window Assembly

You can relocate an existing door/window assembly by changing the coordi-
nate values of its insertion point. The door/window assembly also has an ori-
entation with respect to the world coordinate system (WCS) or the current 
user coordinate system (UCS). For example, if the top and bottom of the 
door/window assembly are parallel to the XY plane, its normal is parallel to 
the Z axis. You can change the orientation of the door/window assembly by 

Dimension Description

Length The distance from the start point to the end point of the 
door/window assembly baseline

Height The distance from the baseline to the top of the door/
window assembly, including any rise

Rise The distance from the base height to the top of the 
door/window assembly

Start Miter Angle of all infills and horizontal edges (frame or 
mullion) at the start of the door/window assembly. For 
more information about miter angles, see “Mitering 
Door/Window Assemblies” on page 1195

End Miter Angle of all infills and horizontal edges (frame or 
mullion) at the end of the door/window assembly
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aligning its normal with another axis. You can also rotate the door/window 
assembly on its plane by changing the rotation angle.

For more information about the world coordinate system, see “Use Coordi-
nates and Coordinate Systems” in the online AutoCAD 2004 User’s Guide.

1 Double-click the door/window assembly.

2 Expand Location.

3 Click Additional information.

4 Specify the location of the curtain wall:

5 Click OK.

Adding an Interference Condition to a Door/
Window Assembly

Use this procedure to add an interference condition to a door/window assem-
bly. Interference conditions use the geometry of 3D objects to create custom 
openings or cutouts in door/window assemblies. You can specify how the 
interference condition is applied to the door/window assembly: added to the 
door/window assembly, subtracted from the door/window assembly, or 
ignored.

1 Place the object in the location where you want to specify the interference 
condition.

If you want to . . . Then . . .

relocate the door/window 
assembly

enter new coordinate values under Insertion Point.

locate the door/window 
assembly on the XY plane

make the normal of the door/window assembly 
parallel to the Z axis: under Normal, enter 1 for Z, 
and enter 0 for X and Y. 

locate the door/window 
assembly on the YZ plane

make the normal of the door/window assembly 
parallel to the X axis: under Normal, enter 1 for X, 
and enter 0 for Y and Z. 

locate the door/window 
assembly on the XZ plane

make the normal of the door/window assembly 
parallel to the Y axis: under Normal, enter 1 for Y, 
and enter 0 for X and Z.

change the rotation of the 
door/window assembly

enter a new value for Rotation Angle.
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2 Select the door/window assembly to which you want to add an interfer-
ence condition, right-click, and click Interference ➤ Add.

3 Select the object intersecting the door/window assembly, and press ENTER.

4 Specify to which door/window assembly component the interference 
should be added:

5 Press ENTER.

Removing an Interference Condition from a 
Door/Window Assembly

Use this procedure to remove an object, such as a mass element, from a door/
window assembly that the object was added to as an interference condition. 

1 Select the door/window assembly from which you want to remove an 
interference object, right-click, and click Interference ➤ Remove.

2 Select the object intersecting the door/window assembly, and press ENTER.

Mitering Door/Window Assemblies
Use this procedure to miter the corners where door/window assemblies meet. 
The corner where adjacent door/window assemblies meet is not mitered by 
default. However, you can automatically determine the necessary angles.

The miter angle applies to all infills and horizontal edges (frame or mullion) 
that are adjacent to the corner. Vertical edges are not affected.

TIP If you want to create a custom corner condition between two door/win-
dow assemblies, you can replace the edge of one door/window assembly with 
an AEC profile and remove the edge of the other door/window assembly by 
using the frame override Remove Edge option. 
For more information, see “Overriding Door/Window Assembly Frames and Mul-

If you want to add the 
interference condition . . .

Then . . .

to the infill enter y (Yes) when prompted for the infill 
component.

to the frame enter y (Yes) when prompted for the frame 
component.

to the mullion enter y (Yes) when prompted for the 
mullion component.
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lions” on page 1173 and “Defining Door/Window Assembly Frames” on 
page 1125. 

1 Select one of the door/window assemblies, right-click, and click Set Miter 
Angles.

2 Select the other door/window assembly.

If you change the angle of either door/window assembly, use Set Miter 
Angles again to recalculate the angles.

Specifying a Miter Angle for a Door/Window 
Assembly Adjacent to Another Object

Use this procedure to manually create a mitered corner between a door/win-
dow assembly and another object, such as a standard wall or a mass element. 
For example, if your door/window assembly connects with a standard wall 
that is at a 60-degree angle from the door/window assembly, you would set 
the miter angle to 30.

The miter angle is applied to all infills and horizontal edges that are adjacent 
to the corner. Vertical edges are not affected.

1 Double-click the door/window assembly.

2 Expand Dimensions.

3 Miter the door/window assembly on the start or the end point:

Attaching Hyperlinks, Notes, or Files to a Door/
Window Assembly

Use this procedure to enter notes and attach reference files to a door/window 
assembly. You can also edit notes and edit or detach reference files from a 
door/window assembly.

1 Double-click the door/window assembly.

If you want to miter the 
door/window assembly . . .

Then . . .

at its start point enter an angle for Start Miter, and press 
ENTER.

at its end point enter an angle for End Miter, and press 
ENTER.
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2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add a note, click the setting for Notes, and enter the text.

5 Click OK.

6 To attach a reference file, click under Reference documents, and attach, 
edit, or detach a reference file:

7 Click OK twice.

Editing Objects Anchored in Door/Window 
Assemblies

When you fill a door/window assembly cell with an infill that contains an 
object, such as a door or window, you can edit that object independently 
from the door/window assembly. For example, you can select a door from a 
door/window assembly and edit its properties. You can edit the anchor set-
tings for the door to change the orientation of the door and the alignment 
or offset of the door in relation to the door/window assembly. 

You can also move objects from one cell to another or release the object 
anchor so that the object moves independently of the door/window assem-
bly.

When you move or release an object or edit its properties, you are creating a 
variation from the infill cell assignment for the door/window assembly style. 
By default, these variations (except release) are allowed to persist in the draw-
ing when you reapply the style to a door/window assembly. However, if you 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click the description. Enter the 
new text, and press ENTER.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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want these variations to be overridden when you reapply a door/window 
assembly style, turn off the Allow Variation from Infill Element Definition 
option on the Anchor worksheet of the object’s Properties palette. This 
option is set on a per object basis.

Related Procedures

� Changing the Orientation of an Object Anchored in a Door/Window 
Assembly

� Changing the Alignment of an Object Anchored in a Door/Window 
Assembly

� Changing the Offset of an Object Anchored in a Door/Window Assembly

� Swapping Two Objects Anchored in a Door/Window Assembly

� Releasing an Object Anchored in a Door/Window Assembly

Changing the Orientation of an Object Anchored 
in a Door/Window Assembly

Use this procedure to change the orientation of an object anchored in a door/
window assembly using grips.

1 Click the object in the door/window assembly for which you want to 
change the orientation.

2 Click the appropriate Flip grip to change the X or Y direction of the object. 

You can also change the orientation of an object, including the Z direc-
tion, using the Anchor worksheet found on the object’s Properties palette.

Changing the Alignment of an Object Anchored 
in a Door/Window Assembly

Use this procedure to modify the alignment of an object that is anchored in 
a door/window assembly.

1 Double-click the object in the door/window assembly.

2 Expand Location, and click Anchor.

3  Click Allow Variation from Infill Element Definition.

4 Select a new alignment for the object. 

For more information, see “Specifying an Alignment for a Door/Window 
Assembly Infill” on page 1121.

5 Click OK.
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Changing the Offset of an Object Anchored in a 
Door/Window Assembly

Use this procedure to change the offset of an object anchored in a door/win-
dow assembly.

1 Double-click the object in the door/window assembly.

2 Expand Location, and click Anchor.

3 Click Allow Variation from Infill Element Definition.

4 Specify a new offset for the object. 

For more information, see “Specifying an Offset for a Door/Window 
Assembly Infill” on page 1122.

5 Click OK.

Swapping Two Objects Anchored in a Door/
Window Assembly

When you fill a door/window assembly cell with an object, such as a door or 
window, you can swap that object with another object in the door/window 
assembly.

1 Select one of the objects from the door/window assembly and click Infill 
Anchor ➤ Swap Objects.

2 Select the object you want to swap with.

Releasing an Object Anchored in a Door/Window 
Assembly

When you fill a door/window assembly cell with an object, such as a door or 
window, that object is anchored to the door/window assembly. While the 
anchor is in place, the object moves when you move the door/window 
assembly and is removed when you erase the door/window assembly. If you 
want to move or erase an object independently from the door/window 
assembly, you can release the anchor.

NOTE You can also move or erase the object by changing the element defini-
tion for the cell that contains the object. For more information, see “Defining 
Infills for Door/Window Assembly Cells” on page 1117.

� Select one of the objects from the door/window assembly and click Infill 
Anchor ➤ Release.
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Grids

Grids are AEC objects on which you can anchor 
other objects, such as columns, and constrain 
their locations.

Grids are useful in the design and documenta-
tion phases of the planning.

Types of grids
There are several types of grid, each with its 
own purpose. You can use layout grids to help 
lay out a building. For information on layout 
grids, see “Layout Curves and Grids” on 
page 1245. Column grids are layout grids to 
which you can specify a column to be placed at 
each intersection of the grid as you add it to 
your drawing. For information on columns, see 
“Creating a Freestanding Column” on 
page 1572 or “Creating a Column Anchored to 
a Grid” on page 1576. Column grids are unique 
also in that they have automatic labelling tools.

Ceiling grids are a specialized layout grid to rep-
resent suspended ceiling systems or cassette 
ceilings. They can be anchored to a space object 
at ceiling height.

Regardless of the type, all grids share some com-
mon features.

Layout Modes for Grids
A grid can have one of three different spacing 
modes for the lines which comprise it. These 
modes are specified separately for the X and Y 
planes. 

� In Manual mode, you specify the position of 
each line on the layout grid.

In this chapter

� Using Column Grid Tools to 
Create Column Grids

� Working with Column Grids

� Editing Column Grids

� Using Ceiling Grid Tools to 
Create Ceiling Grids

� Editing Ceiling Grids

17
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� In Fixed Baysize mode, you specify equidistant spacing between lines on 
the layout grid. The number of lines is determined by the size of the grid. 
As the size of the grid changes, lines are added or subtracted accordingly. 
The distance between the lines remains fixed.

� In Space Lines Evenly mode, you specify the number of lines on the grid. 
The space between the lines is determined by the size of the layout grid. 
As the size of the grid changes, the spacing between the lines is length-
ened or shortened accordingly. The number of lines remains fixed.

NOTE As a default, grids are inserted with evenly spaced lines.

Anchoring Objects to Grids
Grids can be used to anchor other objects. This is most visible in column 
grids, where special functionality allows you to anchor columns to the grid 
during insertion. However, after the grid is finished, you can add other 
objects to it, as well. 

There are two anchoring mechanisms for grids:

� Anchoring objects to a grid cell (Cell Anchor)
� Anchoring objects to a grid intersection (Node Anchor)

For information on anchoring objects, see “Anchors” on page 753.

Related Procedures

� Using Column Grid Tools to Create Column Grids

� Working with Column Grids

� Dimensioning Column Grids

� Editing Column Grids

� Attaching Clipping Profiles to Column Grids

� Changing the Display of Column Grids

� Using Ceiling Grid Tools to Create Ceiling Grids

� Editing Ceiling Grids

� Changing the Dimensions of a Ceiling Grid

� Changing the Lines of a Ceiling Grid

� Attaching Clipping Profiles to Ceiling Grids

� Changing the Display of Ceiling Grids
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Using Column Grid Tools to Create Column 
Grids

Tools provided with Autodesk® Architectural Desktop let you quickly place 
column grids by selecting a structural column grid tool with specific pre-
defined properties. When you place column grids using structural column 
grid tools, you can use the default settings of the tool, or you can change set-
tings for the column grid properties. You can also use structural column grid 
tools to convert linework to column grids and to apply the settings of a struc-
tural column grid tool to existing column grids.

Tool palettes containing structural column grid tools

The default tool palettes in the workspace contain sample structural column 
grid tools that you can use and customize as needed. In addition, the follow-
ing catalogs provided with the software contain structural column grid tools 
that you can add to your tool palettes:

� Autodesk Architectural Desktop Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� My Tool catalog
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Custom palettes created by your CAD manager or other users may also con-
tain structural column grid tools with column grid properties that are cus-
tomized for your projects or office standards.

Related Procedures

� Creating a Column Grid

� Creating a Column Grid with User-Specified Settings

� Creating a Column Grid from a Layout Grid

� Creating a Column Grid from Linework

� Creating a Column Grid Dynamically

� Creating a Structural Column Grid Tool

Creating a Column Grid

Use this procedure to add a new column grid that has the properties specified 
in the structural column grid tool that you select. To specify settings when 
you add a column grid, see “Creating a Column Grid with User-Specified Set-
tings” on page 1204

1 Open the tool palette that you want to use, and select a structural column 
grid tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the column grid.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the rotation of the column grid.

4 Continue adding column grids, and press ENTER.

Creating a Column Grid with User-Specified 
Settings

Use this procedure to add a column grid with settings that you specify. Col-
umn grids can be either rectangular or radial.
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Rectangular grid 

Radial grid

1 Open the tool palette that you want to use, and select a structural column 
grid tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a shape, either Rectangular or Radial.

4 Expand Dimensions.

5 If you have selected a rectangular grid shape, specify the settings:

If you want to . . . Then . . .

define the width of the grid expand Dimensions, and enter a value 
for X - Width.

define the depth of the grid expand Dimensions, and enter a value 
for Y - Depth.
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6 If you have selected a radial grid shape, specify the settings:

lay out the grid with evenly spaced 
bays along the X direction

expand X Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

lay out the grid with a fixed bay size 
along the X direction

expand X Axis, select Repeat for Layout 
type, and enter a value for Bay size.

specify the offset distance from the 
start point along the X direction of the 
grid

expand X Axis, and enter a value for 
Start offset.
The offset distance may be used to 
reduce the effective grid size.

specify the offset distance from the 
end point along the X direction of the 
grid

expand X Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

lay out the grid with evenly spaced 
bays along the Y direction

expand Y Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

lay out the grid with a fixed bay size 
along the Y direction

expand Y Axis, select Repeat for Layout 
type, and enter a value for Bay size.

specify the offset distance from the 
start point along the Y direction of the 
grid

expand Y Axis, and enter a value for 
Start offset.
The offset distance may be used to 
reduce the effective grid size.

specify the offset distance from the 
end point along the Y direction of the 
grid

expand Y Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

If you want to . . . Then . . .

define the width of the grid expand Dimensions, and enter a value 
for X - Width.

define the angle of the grid expand Dimensions, and enter a value 
for A - Angle.

lay out the grid with evenly spaced 
bays along the X direction

expand X Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

If you want to . . . Then . . .
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7 To add columns to the grid intersection during insertion, expand Column, 
and specify a style for the structural member.

If you choose to add columns, you can specify the dimensions of the col-
umn:

� Start offset
� End offset
� Logical length
� Justify
� Justify using overall extents

8 In the drawing area, specify the insertion point of the column grid.

You can move or hide the Properties palette to expose more of the drawing 
area.

9 Specify the rotation angle of the grid.

10 Continue adding column grids, and press ENTER.

lay out the grid with a fixed bay size 
along the X direction

expand X Axis, select Repeat for Layout 
type, and enter a value for Bay size.

specify the inside radius of the grid expand X Axis, and enter a value for 
Inside radius.

specify the offset distance from the 
end point along the X direction of the 
grid

expand X Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

lay out the grid with evenly spaced 
bays along the Y direction

expand Y Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

lay out the grid with a fixed bay angle 
along the Y direction

expand Y Axis, select Repeat for Layout 
type, and enter a value for Bay angle.

specify the offset angle from the start 
angle along the X direction grid curve

expand Y Axis, and enter a value for 
Start angle offset.
The offset angle may be used to 
reduce the grid size.

specify the offset angle from the end 
angle along the X direction grid curve

expand Y Axis, and enter a value for 
End angle offset.
The offset distance may be used to 
reduce the grid size.

If you want to . . . Then . . .
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Creating a Column Grid from a Layout Grid

Use this procedure to convert a two-dimensional (2D) layout grid to a col-
umn grid that has the properties of the structural column grid tool you select. 
You can edit these properties after creating the column grid.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a structural column grid tool, and click Apply Tool Properties 
to ➤ Layout Grid 2D.

3 Select the layout grid to convert, and press ENTER.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the column grid in the Properties palette, if needed.

Creating a Column Grid from Linework

Use this procedure to convert custom linework to a column grid that has the 
properties of the structural column grid tool you select. You can edit these 
properties after creating the column grid.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a structural column grid tool, and click Apply Tool Properties 
to ➤ Linework.

3 Select the linework to convert, and press ENTER.

4 When prompted to erase the original linework, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the column grid in the Properties palette, if needed.

Creating a Column Grid Dynamically

Use this procedure to create column grids dynamically by specifying their 
dimensions on screen as you draw them. 

1 Open the tool palette that you want to use, and select a structural column 
grid tool.

If necessary, scroll to display the tool that you want to use.

2 In the Properties palette, expand Dimensions and select Yes for Specify on 
screen.
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3 To add columns to the grid during insertion, expand Column and select 
the desired column style.

4 Specify the insertion point for the grid in the drawing.

5 Specify the overall size of the grid by dragging the cursor to the desired 
size and clicking once. 

6 Drag the crosshairs inside the resulting shape vertically and horizontally 
to define the correct the number of bays in the column grid. 

NOTE The closer the crosshairs go to the left and bottom of the grid, the 
more spaces are created.

7 Click once to confirm the number of vertical and horizontal bays.

8 Specify the rotation angle of the grid.

9 Press ENTER.

The column grid is inserted into the drawing according to your on-screen 
specifications.

Creating a Structural Column Grid Tool

Use this procedure to create a structural column grid tool and add it to a tool 
palette. You may want to create your own structural column grid tools if you 
are placing multiple column grids with specific column grid properties that 
you want to be the same each time you add a column grid of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from a column grid 
in the drawing

select the object, and drag it to the tool 
palette.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the column grid 
created from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a column grid shape.

10 Specify the settings for the dimensions of the grid.

For more information, see “Creating a Column Grid with User-Specified 
Settings” on page 1204.

11 Click OK.

Working with Column Grids

After you have created column grids in your drawing, you can work with 
them to customize them for your project. You can add labels, extend grid 
lines, and add dimensions to the grids.

Related procedures

� Labeling Column Grids

� Extending Column Grid Lines beyond the Grid Boundary or Limits

� Dimensioning Column Grids

Labeling Column Grids

You can label existing column grids in the X direction and the Y direction.

1 Select the column grid you want to label, right-click, and click Label.

2 Specify the grid location for labels:

If you want to . . . Then . . .

add labels to the X-axis of the grid click the X - Labeling tab.

add labels to the Y-axis of the grid click the Y - Labeling tab.
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3 Enter a starting number or letter for the label under Number in the table.

Each grid line in the X direction or the Y direction is listed in the table. If 
Automatically Calculate Values for Labels is selected, numbers or letters 
for the remaining grid lines are filled in consecutively, either in ascending 
or descending order, depending upon which is selected for Ordering. 

NOTE To renumber a grid, enter a new value in the first location. The rest 
of the values are updated automatically if Automatically Calculate Values for 
Labels is selected.

4 If there are characters that you do not want to use in the sequence, select 
Never Use Characters, and enter the characters, separated by commas.

5 To change the label symbol, click Bubble. 

6 Select a new label symbol from the MvBlockDef Select dialog box and click 
OK.

Any multi-view block currently defined in the drawing can be used.

7 Click Generate New Bubbles On Exit to update the bubbles.

8 Specify the location of bubbles:

9 Enter a value for Extension. 

Extension is the length of the bubble lines from the grid to the bubble. 

10 Click OK.

If you want to . . . Then . . .

place bubbles in the X direction of the 
grid

select Top and/or Bottom.

place bubbles in the Y direction of the 
grid

select Left and/or Right.
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Labeling a column grid

Extending Column Grid Lines beyond the Grid 
Boundary or Limits

Use this procedure to label two sides of a column grid and have the lines of 
the other two sides extend beyond the edge of the column grid rectangle.

1 Label the sides of the column grid you need labeled. 

For more information, see “Labeling Column Grids” on page 1210.

2 Create a multi-view block definition that has no view blocks. 

For more information, see Creating a New Multi-View Block Definition.

3 Select the column grid, right-click, and click Label.

4 Click the Labeling tab for the axis you wish to extend.

5 Select the Bubble Parameter that has not been labeled (Left or Right, or 
Top or Bottom), but do not deselect the sides already labeled, or the bub-
bles will be removed from those sides.

6 Click Bubble, select the new multi-view block you created, and then click 
OK.

7 Clear Generate New Bubbles On Exit.

8 Click OK. 
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Dimensioning Column Grids

Use this procedure to dimension column grids and set the distance the 
dimensions are from the grid. For this, you can use the automatic AEC 
Dimension.

Related Procedures

� Dimensioning Column Grids with Automatic AEC Dimension

Dimensioning Column Grids with Automatic AEC Dimension
When you dimension your column grid with an automatic AEC dimension, 
your resulting dimension is associative. When you update the grid, the 
dimension is updated accordingly. Also, you can choose an AEC dimension 
style. For information on AEC Dimensions, see “AEC Dimensions” on 
page 2357.

With an AEC dimension, you cannot display angle dimensions or edit indi-
vidual dimension chains.

1 Select the column grid you want to dimension.

2 Right-click, and click AEC Dimension.

3 On the Properties palette, expand Basic, and expand General.

4 Select a style.

NOTE Be sure to select an AEC dimension style that contains dimensioning 
points for grids. For more information on AEC dimension contents, see “Log-
ical Dimension Points of AEC and AutoCAD Objects” on page 2363.

5 Click to specify the position of the AEC dimension. 

The dimension can, for example, be placed above or below the column 
grid. 

� Drag the mouse to set the direction of the dimension. The extension 
lines are drawn in the opposite direction.

� If you want to align the dimension, enter aon the command line, and 
select the geometry to align to.

� If you want a user-defined angle for the dimension, enter r and enter 
the rotation angle on the command line.

NOTE The angle you specify here is calculated in relation to the UCS, not 
to the dimensioned grid.
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Editing Column Grids

You can change column grids by modifying the overall dimensions of the 
grid, the number and position of grid lines, as well as the location of the grid 
within the drawing. You can also set a clipping boundary for the grid and use 
that to mask the grid or insert a hole into the grid.

NOTE You cannot change the shape of an existing column grid. You cannot 
change a radial grid to a rectangular grid, or vice versa.

Related Procedures

� Changing the Dimensions of a Column Grid

� Changing the Lines of a Column Grid

� Attaching Clipping Profiles to Column Grids

� Attaching Hyperlinks, Notes, or Files to a Column Grid

� Changing the Location of Column Grids

� Changing the Display of Column Grids

Changing the Dimensions of a Column Grid

Use this procedure to change the overall dimensions of a column grid. A rect-
angular grid is defined by its width and depth. A radial grid is defined by its 
radius, angle, and optionally, its inner radius.

1 Double-click the column grid to which you want to make changes.

2 Expand General, and expand Dimensions.

3 Modify the desired settings:

If you want to . . . Then . . .

change the dimensions of a 
rectangular column grid

enter new values for X - Width and Y - 
Depth.

change the dimensions of a radial 
column grid

enter new values for X - Width and A - 
Angle.
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TIP You can also change the size of a grid by dragging its grip points. 
Note that when you have a manual grid, you are dragging the individual lines, 
not the grid.

Changing the Lines of a Column Grid

Apart from the overall dimensions of the grid, you can also change the num-
ber and position of grid lines on the X-axis and the Y-axis. 

To do this, it is necessary to understand the different modes in which grids 
can be designed. Each of these modes can be set separately for the X-axis and 
the Y-axis. 

� Manual: You specify the position of each line on the layout grid.
� Repeat: You specify equidistant spacing between lines on the layout grid. 

The number of lines is determined by the size of the grid. As the size of the 
grid changes, lines are added or subtracted accordingly. The distance 
between the lines remains fixed.

� Space Evenly: You specify the number of lines on the grid. The space 
between the lines is determined by the size of the layout grid. As the size 
of the grid changes, the spacing between the lines is lengthened or short-
ened accordingly. The number of lines remains fixed.

NOTE As a default, grids are inserted with evenly spaced lines.

Related Procedures

� Adding Lines to a Column Grid

� Removing Lines from a Column Grid

� Changing the Position of Column Grid Lines

Adding Lines to a Column Grid
In some cases, you need to add lines to an existing grid. Depending on the 
grid mode, you do this in different ways.

Related Procedures

� Adding Lines to a Column Grid with Evenly Spaced Lines

� Adding Grid Lines to a Manual Column Grid

� Adding Grid Lines to a Column Grid with Fixed Bay Size
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Adding Lines to a Column Grid with Evenly Spaced Lines
Use this procedure to add lines to a grid with evenly spaced lines. The lines 
will always be distributed evenly along the grid axis. If you need non-regular 
lines with different spacing between them, you need to convert your grid to 
a manual grid. 

1 Double-click the column grid to which you want to add lines.

2 Expand Dimensions.

3 Add grid lines:

Adding Grid Lines to a Manual Column Grid
Use this procedure to add lines to manual grids. A manual grid allows you the 
maximum control over your grid, but requires that you define the exact line 
number and line position of each grid line.

1 Double-click the column grid to which you want to add lines.

2 Expand Dimensions.

3 Add grid lines:

If you want to . . . Then . . .

add grid lines to the X axis of the grid expand X Axis, and enter a value for 
Number of bays.
The number of grid lines increases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.

add grid lines to the Y axis of the grid expand Y Axis, and enter a value for 
Number of bays.
The number of grid lines increases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.

If you want to . . . Then . . .

add grid lines to the X axis of the grid expand X Axis, select Manual for 
Layout type, and click on the value for 
Bays.

add grid lines to the Y axis of the grid expand Y Axis, select Manual for 
Layout type, and click on the value for 
Bays.



Editing Column Grids | 1217

The Bays worksheets list all of the bays currently on the respective axis, 
their distance from the start point of the grid, and the spacing between the 
grid lines that define the bays.

4 To add a line, click under the last number in the Bays list.

A new line is inserted automatically, with default values for distance and 
spacing. You can edit these values by clicking on them and entering new 
values.

NOTE Note that you cannot enter a line number for the new line. The line 
number is given automatically by the application after you close the work-
sheet. 

5 Click OK.

Adding Grid Lines to a Column Grid with Fixed Bay Size
Use this procedure to add lines to a grid with fixed bays. Normally in a grid 
with fixed bays, the distance between the grid lines is the important factor, 
not the number of grid lines. 

To add lines to a grid with a fixed baysize, you have two options:

� Enlarging the overall grid size

For information on how to do this, see “Changing the Dimensions of a 
Column Grid” on page 1214.

� Decreasing the size of the bays

TIP In cases where the number of lines is important for the grid, you would 
change the layout mode of the grid from fixed bays to an evenly spaced or man-
ual grid. 

1 Double-click the column grid to which you want to add lines.

2 Expand Dimensions.

3 Add grid lines:

If you want to . . . Then . . .

add grid lines to the X axis of the grid expand X Axis, and enter a value for 
Bay size.

add grid lines to the Y axis of the grid expand Y Axis, and enter a value for 
Bay size.
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If you enter a value that reduces the size of the bays, the number of grid 
lines increases as the extra bays are added to the grid.

Removing Lines from a Column Grid
You can remove individual grid lines from column grids. The method used 
will depend on the layout type of the specific column grid.

Removing Lines from a Column Grid with Evenly Spaced Lines
Use this procedure to remove lines from a grid with evenly spaced lines. The 
lines will always be distributed evenly along the grid axis. To remove one par-
ticular line and have all the other lines stay in their original place, you need 
to convert your grid to a manual grid.

1 Double-click the column grid from which you want to remove lines.

2 Expand Dimensions.

3 Remove grid lines:

Removing Grid Lines from a Manual Column Grid
Use this procedure to remove grid lines from a manual grid. On a manual 
grid, you can remove every line individually.

1 Double-click the column grid from which you want to remove lines.

2 Expand Dimensions.

If you want to . . . Then . . .

remove grid lines from the X axis of 
the grid

expand X Axis, and enter a smaller 
value for Number of bays.
The number of grid lines decreases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.

remove grid lines from the Y axis of the 
grid

expand Y Axis, and enter a smaller 
value for Number of bays.
The number of grid lines decreases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.
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3 Remove grid lines:

The Bays worksheets list all of the bays currently on the respective axis, 
their distance from the start point of the grid, and the spacing between the 
grid lines that define the bays.

4 To remove a line, click on the bay number in the Bays list, and click 
Remove.

5 Click OK. 

The bay is deleted from the grid, and the grid size is reduced accordingly.

Removing Lines from a Column Grid with Fixed Bay Size
Use this procedure to remove lines from a grid with fixed bays. Normally in 
a grid with fixed bays, the distance between the grid lines is the important 
factor, not the number of grid lines.

To remove lines from a grid with a fixed bay size, you have two options:

� Decreasing the overall grid size

For information on how to do this, see “Changing the Dimensions of a 
Column Grid” on page 1214.

� Increasing the size of the bays

TIP In most cases where the number of lines is important for the grid, you 
would change the layout mode of the grid from fixed bays to an evenly 
spaced or manual grid. 

1 Double-click the column grid from which you want to remove lines.

2 Expand Dimensions.

If you want to . . . Then . . .

remove grid lines from the X axis of 
the grid

expand X Axis, select Manual for 
Layout type, and click on the value for 
Bays.

remove grid lines from the Y axis of the 
grid

expand Y Axis, select Manual for 
Layout type, and click on the value for 
Bays.
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3 Remove grid lines:

If you enter a value that increases the size of the bays, the number of grid 
lines decreases as the extra bays are removed from the grid.

Changing the Position of Column Grid Lines
You can change the position of individual grid lines. This functionality is 
available only for manual grids. Grids with automatic spacing use their own 
parameters - the number of bays or the size of the grid bays - to calculate their 
line positions. 

A manual grids has grip points for every line. You can use either the grip 
points or the Bays worksheet to change the position of a grid line.

Using Grip Points to Move Column Grid Lines
Use this procedure to move a column grid line by dragging the grip points of 
the line. Manual grids have a pair of grip points for the start and end points 
of each line.

1 Select the grid where you want to move grid lines. 

For each line in the grid, a pair of grip points (start point and end point) 
are displayed.

TIP If your grid displays only four lines for the corners of the grid, the grid 
is not in manual mode. For information on how to check the grid mode and 
convert it, see “Changing the Lines of a Column Grid” on page 1215.

2 Use the grip points to drag the lines in either horizontal or vertical direc-
tion. 

� If you move a grid line beyond the grid border, the grid is enlarged 
accordingly. 

� If you move one of the border lines of the grid to the inside of the grid, 
the grid is decreased accordingly.

If you want to . . . Then . . .

remove grid lines from the X axis of 
the grid

expand X Axis, and enter a value for 
Bay size.

remove grid lines from the Y axis of the 
grid

expand Y Axis, and enter a value for 
Bay size.
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Changing the Position of Column Grid Lines by Editing Grid Bays
Use this procedure to reposition grid lines by editing the number and spacing 
of grid bays using the Bays worksheet.

1 Double-click the column grid where you want to move lines.

2 Expand Dimensions.

3 Edit grid bays:

The Bays worksheet lists all currently existing bays on the respective axis, 
their distance from the start point of the grid, and the spacing of each bay.

4 To change a bay, click on one of its measuring values in the list and edit 
the value.

5 Click OK.

The line positions have changed according to your specifications.

Attaching Clipping Profiles to Column Grids

You can attach a clipping profile to define a mask around a column grid or 
to make a hole in a column grid. You could, for example, create a mask to 
define a column grid for an irregularly shaped room, or exclude parts of a 
room from the column grid.

NOTE To attach a clipping profile, you must first draw a closed polyline with 
the desired boundary or hole shape.

Related Procedures

� Masking Column Grids

� Creating Holes in Column Grids

� Removing Holes from Column Grids

If you want to . . . Then . . .

edit grid bays along the X axis expand X Axis, and click the value for 
Bays.

edit grid bays along the Y axis expand Y Axis, and click the value for 
Bays.
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Masking Column Grids
Use this procedure to mask a column grid. A mask is a polyline shape which 
defines the boundaries of a column grid. Those parts of the grid which are 
outside of the boundary are not displayed.

1 Draw a closed polyline with the boundary or hole shape you want.

2 Select the grid you want to mask.

3 On the Properties palette, expand General.

4 Choose Select object for Boundary.

5 Select the closed polyline you want to use as a mask.

6 Right-click and click Deselect All to turn off the grid grips.

The parts of the column grid that are outside of the masking polyline are no 
longer displayed. 

TIP If there are columns connected to the invisible part of the grid, they are 
still displayed after masking. If necessary, you can delete them.

TIP If you want to restore the original grid shape, select None for Boundary in 
the Properties palette.

Creating Holes in Column Grids
Use this procedure to “cut” a hole into an existing column grid. The parts of 
the grid that are inside the hole are not displayed.

1 Select the grid you want to mask, right-click, and click Clip.

2 Enter a (Add Hole), and press ENTER.

3 Select the desired column grid, and press ENTER. 

4 Select a closed polyline for the hole, and press ENTER. 

A hole is cut in the column grid.

TIP If there are columns connected to the hole in the grid, they are still dis-
played. If necessary, you can delete them. 

Removing Holes from Column Grids
Use this procedure to remove holes you have created in column grids.

1 Select the grid you want to mask, right-click, and click Clip.
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2 Enter r (Remove Hole) and press ENTER.

3 Select the desired column grid, and press ENTER. 

4 Select the closed polyline of the hole.

The hole is removed from the layout grid. The polyline, however, remains in 
the drawing. If necessary, you can delete it manually.

Attaching Hyperlinks, Notes, or Files to a 
Column Grid

Use this procedure to attach hyperlinks, notes, or files to a column grid. You 
can also edit hyperlinks and notes, and edit or detach reference files from a 
column grid.

1 Select the column grid you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Changing the Location of Column Grids

Use this procedure to change the location of column grids. You can relocate 
a column grid by changing the coordinate values of its insertion point. The 
column grid also has an orientation with respect to the world coordinate sys-
tem (WCS) or the current user coordinate system (UCS). For example, if the 
top and bottom of the column grid are parallel to the XY plane, its normal is 
parallel to the Z axis. You can change the orientation of the column grid by 
aligning its normal with another axis. You can also rotate the column grid on 
its plane by changing the rotation angle.

For information about the world coordinate system, see “Use Coordinates 
and Coordinate Systems” in the online AutoCAD 2004 User’s Guide.

1 Select the column grid that you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the column grid:

5 Click OK.

Changing the Display of Column Grids

Use this procedure to change the properties of the display components of an 
individual column grid. Display components that can be changed include 
grid lines and node and cell markers. 

If you want to . . . Then . . .

relocate the column grid enter new coordinate values under Insertion Point.

locate the column grid on 
the XY plane

make the normal of the column grid parallel to the 
Z axis: under Normal, enter 1 for Z, and enter 0 for 
X and Y. 

locate the column grid on 
the YZ plane

make the normal of the column grid parallel to the 
X axis: under Normal, enter 1 for X and enter 0 for 
Y and Z. 

locate the column grid on 
the XZ plane

make the normal of the column grid parallel to the 
Y axis: under Normal, enter 1 for Y, and enter 0 for 
X and Z.

change the rotation of the 
column grid

enter a new value for Rotation Angle.
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� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the column grid you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Using Ceiling Grid Tools to Create Ceiling 
Grids

Tools provided with Autodesk® Architectural Desktop let you quickly place 
ceiling grids by selecting a ceiling grid tool with a specific ceiling grid style 
and other predefined properties. When you place ceiling grids using ceiling 
grid tools, you can use the default settings of the tool, or you can change set-
tings for the ceiling grid properties. You can also use ceiling grid tools to con-
vert linework to ceiling grids and to apply the settings of a ceiling grid tool 
to existing ceiling grids.
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Tool palettes containing ceiling grid tools

The default tool palettes in the workspace contain sample ceiling grid tools 
that you can use and customize as needed. In addition, the following catalogs 
provided with the software contain ceiling grid tools that you can add to 
your tool palettes:

� Autodesk Architectural Desktop Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� My Tool catalog

Custom palettes created by your CAD manager or other users may also con-
tain ceiling grid tools with ceiling grid properties that are customized for 
your projects or office standards.

Related Procedures

� Creating a Ceiling Grid

� Creating a Ceiling Grid with User-Specified Settings

� Creating a Ceiling Grid from a Layout Grid

� Creating a Ceiling Grid from Linework

� Creating a Ceiling Grid Dynamically

� Creating a Ceiling Grid with a Clipping Boundary
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� Creating a Ceiling Grid Tool

Creating a Ceiling Grid

Use this procedure to add a new ceiling grid that has the properties specified 
in the ceiling grid tool that you select. To specify settings when you add a 
ceiling grid, see “Creating a Column Grid with User-Specified Settings” on 
page 1204.

1 Open the tool palette that you want to use, and select a ceiling grid tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the ceiling grid.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the rotation of the ceiling grid.

4 Continue adding ceiling grids, and press ENTER.

Creating a Ceiling Grid with User-Specified 
Settings

Use this procedure to add a ceiling grid with settings that you specify.

1 Open the tool palette that you want to use, and select a ceiling grid tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a boundary.

4 Expand Dimensions.

5 Specify the settings:

If you want to . . . Then . . .

define the width of the grid expand Dimensions, and enter a value 
for X - Width.

define the depth of the grid expand Dimensions, and enter a value 
for Y - Depth.

lay out the grid with evenly spaced 
bays along the X direction

expand X Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.
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6 In the drawing area, specify the insertion point of the ceiling grid.

You can move or hide the Properties palette to expose more of the drawing 
area.

7 Specify the rotation angle of the grid.

8 Continue adding ceiling grids, and press ENTER.

Creating a Ceiling Grid from a Layout Grid

Use this procedure to convert a two-dimensional (2D) layout grid to a ceiling 
grid that has the properties of the ceiling grid tool you select. You can edit 
these properties after creating the ceiling grid.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

lay out the grid with a fixed bay size 
along the X direction

expand X Axis, select Repeat for Layout 
type, and enter a value for Bay size.

specify the offset distance from the 
start point along the X direction of the 
grid

expand X Axis, and enter a value for 
Start offset.
The offset distance may be used to 
reduce the effective grid size.

specify the offset distance from the 
end point along the X direction of the 
grid

expand X Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

lay out the grid with evenly spaced 
bays along the Y direction

expand Y Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

lay out the grid with a fixed bay size 
along the Y direction

expand Y Axis, select Repeat for Layout 
type, and enter a value for Bay size.

specify the offset distance from the 
start point along the Y direction of the 
grid

expand Y Axis, and enter a value for 
Start offset.
The offset distance may be used to 
reduce the effective grid size.

specify the offset distance from the 
end point along the Y direction of the 
grid

expand Y Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

If you want to . . . Then . . .
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2 Right-click a ceiling grid tool, and click Apply Tool Properties 
to ➤ Layout Grids.

3 Select the layout grid to convert, and press ENTER.

4 When prompted to erase the original geometry, press ENTER to erase the 
linework, or enter n (No) to keep it.

5 Edit the properties of the ceiling grid in the Properties palette, if needed.

Creating a Ceiling Grid from Linework

Use this procedure to convert custom linework to a ceiling grid that has the 
properties of the ceiling grid tool you select. You can edit these properties 
after creating the ceiling grid.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a ceiling grid tool, and click Apply Tool Properties 
to ➤ Linework.

3 Select the linework to convert, and press ENTER.

4 When prompted to erase the original linework, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the ceiling grid in the Properties palette, if needed.

Creating a Ceiling Grid Dynamically

Use this procedure to create ceiling grids dynamically by specifying their 
dimensions on screen as you draw them.

1 Open the tool palette that you want to use, and select a ceiling grid tool.

If necessary, scroll to display the tool that you want to use.

2 In the Properties palette, expand Dimensions, and expand X Axis and Y 
Axis:

If you want to . . . Then . . .

lay out the grid with evenly spaced 
bays along the X direction

expand X Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

lay out the grid with a fixed bay size 
along the X direction

expand X Axis, select Repeat for Layout 
type, and enter a value for Bay size.



1230 | Chapter 17 Grids

3 Under Dimensions, select Yes for Specify on screen.

4 Specify an insertion point in the drawing. 

5 Specify the overall size of the grid by dragging the cursor to the desired 
size and clicking once.

6 Specify the rotation angle for the grid.

7 Press ENTER.

Creating a Ceiling Grid with a Clipping Boundary

Use this procedure to create a ceiling grid within a polyline or a space object. 
If the ceiling grid is within a space, the grid is automatically created at the 
ceiling height of the space.

1 Open the tool palette that you want to use, and select a ceiling grid tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Click the setting for Boundary.

specify the offset distance from the 
start point along the X direction of the 
grid

expand X Axis, and enter a value for 
Start offset.
The offset distance may be used to 
reduce the effective grid size.

specify the offset distance from the 
end point along the X direction of the 
grid

expand X Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

lay out the grid with evenly spaced 
bays along the Y direction

expand Y Axis, select Space evenly for 
Layout type, and enter a value for 
Number of bays.

lay out the grid with a fixed bay size 
along the Y direction

expand Y Axis, select Repeat for Layout 
type, and enter a value for Bay size.

specify the offset distance from the 
start point along the Y direction of the 
grid

expand Y Axis, and enter a value for 
Start offset.
The offset distance may be used to 
reduce the effective grid size.

specify the offset distance from the 
end point along the Y direction of the 
grid

expand Y Axis, and enter a value for 
End offset.
The offset distance may be used to 
reduce the effective grid size.

If you want to . . . Then . . .
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4 Click Select object, and then select an existing space or a closed polyline 
in the drawing.

5 Specify an insertion point in the drawing.

NOTE Note that the insertion point of the ceiling grid is the lower left cor-
ner of the ceiling grid if the rotation is set to 0 degrees.

6 Specify the overall size of the grid by dragging the cursor to the desired 
size and clicking once.

Drag the cursor along the X axis to specify the number of bays along the 
X direction, and drag the cursor along the Y axis to specify the number of 
bays along the Y direction.

7 Specify the rotation angle of the grid.

8 Press ENTER.

The grid is displayed only within the space or closed polyline.

Creating a ceiling grid from a polyline

NOTE In some templates, the ceiling grid object is turned off in a number of 
plan views. It is displayed in most model views, however, so if you cannot see 
your grid in top view, you can switch to a model view to make sure that it is 
there. For information on turning on the display of ceiling grids in plan view, see 
“Display System” on page 435.

Creating a Ceiling Grid Tool

Use this procedure to create a ceiling grid tool and add it to a tool palette. You 
may want to create your own ceiling grid tools if you are placing multiple 
ceiling grids with specific ceiling grid properties that you want to be the same 
each time you add a ceiling grid of that type.

1 Open the tool palette where you want to create a tool.
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2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the ceiling grid cre-
ated from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Specify the settings for the dimensions of the grid.

For more information, see “Creating a Ceiling Grid with User-Specified 
Settings” on page 1227.

10 Click OK.

Editing Ceiling Grids

You can change existing ceiling grids in different ways. You can change the 
overall dimensions of the grid, number and position of grid lines, and the 
location of the grid within the drawing. You can also specify a clipping 
boundary for the grid and use that to mask the grid or insert a hole into the 
grid.

If you want to . . . Then . . .

create a tool from a ceiling grid 
in the drawing

select the object, and drag it to the tool 
palette.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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Related Procedures

� Changing the Dimensions of a Ceiling Grid

� Changing the Lines of a Ceiling Grid

� Attaching Clipping Profiles to Ceiling Grids

� Attaching Hyperlinks, Notes, or Files to a Ceiling Grid

� Changing the Location of Ceiling Grids

� Changing the Display of Ceiling Grids

Changing the Dimensions of a Ceiling Grid

Use this procedure to change the overall dimensions of a ceiling grid. A ceil-
ing grid is defined by its width and depth.

1 Double-click the ceiling grid to which you want to make changes.

2 Expand General, and expand Dimensions.

3 Modify the values for X - Width or Y - Depth.

TIP You can also change the size of a grid by dragging its grip points. Note that 
when you have a manual grid, you are dragging the individual lines, not the 
grid.

Changing the Lines of a Ceiling Grid

Apart from the overall dimensions of the ceiling grid, you can also change 
the number and position of grid lines on the X-axis and the Y-axis. 

To do this, it is necessary to understand the different modes in which grids 
can be designed. Each of these modes can be specified separately for the X-
axis and the Y-axis. 

� Manual: You specify the position of each line on the ceiling grid.
� Repeat: You specify equidistant spacing between lines on the ceiling grid. 

The number of lines is determined by the size of the grid. As the size of the 
grid changes, lines are added or subtracted accordingly. The distance 
between the lines remains fixed.

� Space Evenly: You specify the number of lines on the grid. The space 
between the lines is determined by the size of the ceiling grid. As the size 
of the grid changes, the spacing between the lines is lengthened or short-
ened accordingly. The number of lines remains fixed.
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NOTE As a default, grids are inserted with evenly spaced lines.

Related Procedures

� Adding Lines to a Ceiling Grid

� Removing Lines from a Ceiling Grid

� Changing the Position of Ceiling Grid Lines

Adding Lines to a Ceiling Grid
In some cases, you need to add lines to an existing grid. Depending on the 
grid mode, you do this in different ways.

Adding Lines to a Ceiling Grid with Evenly Spaced Lines
Use this procedure to add lines to a grid with evenly spaced lines. The lines 
will always be distributed evenly along the grid axis. If you need non-regular 
lines with different spacing between them, you need to convert your grid to 
a manual grid.

1 Double-click the ceiling grid to which you want to add lines.

2 Expand Dimensions.

3 Add grid lines:

Your grid has been updated accordingly, with the new number of grid lines 
distributed evenly along the grid axis. 

TIP To add lines to the ceiling grid, you can also use the ceiling grid context 
menu. Right-click on the grid and select X Axis/Y Axis ➤ Add Grid Line. 

If you want to . . . Then . . .

add grid lines to the X axis of the grid expand X Axis, and enter a value for 
Number of bays.
The number of grid lines increases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.

add grid lines to the Y axis of the grid expand Y Axis, and enter a value for 
Number of bays.
The number of grid lines increases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.
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Adding Lines to a Manual Ceiling Grid
Use this procedure to add lines to a manual grid. A manual grid allows you 
the maximum control over your grid, but requires that you specify the exact 
line number and line position. 

1 Double-click the ceiling grid to which you want to add lines.

2 On the Properties palette, expand Dimensions.

3 Add grid lines:

The Bays worksheet lists all of the bays currently on the respective axis, 
their distance from the start point of the grid, and the spacing between the 
grid lines that define the bays.

4 To add a line, click under the last number in the Bays list.

A new line is inserted automatically, with default values for distance and 
spacing. You can edit these values by clicking on them and entering new 
values.

NOTE Note that you cannot enter a line number for the new line. The line 
number is given automatically by the application after you close the work-
sheet. 

5 Click OK.

TIP To add lines to the ceiling grid, you can also use the ceiling grid context 
menu. Right-click on the grid and select X Axis/Y Axis ➤ Add Grid Line. 

Adding Lines to a Ceiling Grid with Fixed Bay Size
Use this procedure to add lines to a grid with fixed bays. Normally in a grid 
with fixed bays, the distance between the grid lines is the important factor, 
not the number of grid lines. 

To add lines to a grid with a fixed baysize, you have two options:

If you want to . . . Then . . .

add grid lines to the X axis of the grid expand X Axis, select Manual for 
Layout type, and click on the value for 
Bays.

add grid lines to the Y axis of the grid expand Y Axis, select Manual for 
Layout type, and click on the value for 
Bays.
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� Enlarging the overall grid size

For information on how to do this, see “Changing the Dimensions of a 
Ceiling Grid” on page 1233.

� Decreasing the size of the bays

TIP In most cases, where the number of lines is important for the grid, you 
would change the layout mode of the grid from fixed bays to an evenly 
spaced or manual grid. 

1 Double-click the ceiling grid to which you want to add lines.

2 Expand Dimensions.

3 Add grid lines:

If you enter a value that reduces the size of the bays, the number of grid 
lines increases as the extra bays are added to the grid.

A number of new lines have been added by decreasing the size of the individ-
ual bays.

Removing Lines from a Ceiling Grid
In the same way that lines can be added to a ceiling grid, they can also be 
removed.

Removing Lines from a Ceiling Grid with Evenly Spaced Lines
Use this procedure to remove lines from a grid with evenly spaced lines. The 
lines will always be distributed evenly along the grid axis. To remove one par-
ticular line and have all the other lines stay in their original place, you need 
to convert your grid to a manual grid.

1 Double-click the ceiling grid from which you want to remove lines.

2 Expand Dimensions.

If you want to . . . Then . . .

add grid lines to the X axis of the grid expand X Axis, and enter a value for 
Bay size.

add grid lines to the Y axis of the grid expand Y Axis, and enter a value for 
Bay size.
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3 Remove grid lines:

Your grid has been updated accordingly, with the new number of grid lines 
distributed evenly along the grid axis.

TIP To remove lines from a ceiling grid, you can also use the ceiling grid con-
text menu. Right-click on the grid and select X Axis/Y Axis ➤ Remove Grid 
Line.

Removing Lines from a Manual Ceiling Grid
Use this procedure to remove grid lines from a manual grid. On a manual 
grid, you can remove every line individually.

1 Double-click the ceiling grid from which you want to remove lines.

2 Expand Dimensions.

3 Remove grid lines:

If you want to . . . Then . . .

remove grid lines from the X axis of 
the grid

expand X Axis, and enter a smaller 
value for Number of bays.
The number of grid lines decreases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.

remove grid lines from the Y axis of the 
grid

expand Y Axis, and enter a smaller 
value for Number of bays.
The number of grid lines decreases to 
create the specified number of bays, 
while the overall size of the grid 
remains the same.

If you want to . . . Then . . .

remove grid lines from the X axis of 
the grid

expand X Axis, select Manual for 
Layout type, and click on the value for 
Bays.

remove grid lines from the Y axis of the 
grid

expand Y Axis, select Manual for 
Layout type, and click on the value for 
Bays.
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The Bays worksheets list all of the bays currently on the respective axis, 
their distance from the start point of the grid, and the spacing between the 
grid lines that define the bays.

4 To remove a line, click on the bay number in the Bays list, and click 
Remove.

5 Click OK. 

The bay is deleted from the grid, and the grid size is reduced accordingly.

TIP To remove lines from a ceiling grid, you can also use the ceiling grid con-
text menu. Right-click on the grid and select X Axis/Y Axis ➤ Remove Grid 
Line.

Removing Lines from a Ceiling Grid with Fixed Bay Size
Use this procedure to remove lines from a grid with fixed bays. Normally in 
a grid with fixed bays, the distance between the grid lines is the important 
factor, not the number of grid lines.

To remove lines from a grid with a fixed baysize, you have two options:

� Decreasing the overall grid size

For information on how to do this, see “Changing the Dimensions of a 
Ceiling Grid” on page 1233.

� Increasing the size of the bays

TIP In most cases where the number of lines is important for the grid, you 
would change the layout mode of the grid from fixed bays to an evenly 
spaced or manual grid. 

1 Double-click the ceiling grid from which you want to remove lines.

2 Expand Dimensions.

3 Remove grid lines:

If you want to . . . Then . . .

remove grid lines from the X axis of 
the grid

expand X Axis, and enter a value for 
Bay size.

remove grid lines from the Y axis of the 
grid

expand Y Axis, and enter a value for 
Bay size.
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If you enter a value that increases the size of the bays, the number of grid 
lines decreases as the extra bays are removed from the grid.

A number of lines have been removed by increasing the size of the indi-
vidual bays.

Changing the Position of Ceiling Grid Lines
You can change the position of individual grid lines. This functionality is 
available only for manual grids. Grids with automatic spacing use their own 
parameters - the number of lines or the size of the grid bays - to calculate their 
line positions. 

A manual grid has grip points for every single line. You can use either these 
grip points or the Bays worksheet to change the position of a grid line.

Using Grip Points to Move Ceiling Grid Lines
Use this procedure to move a ceiling grid line by dragging the grip points of 
the line. Manual grids have a pair of grip points for the start and end points 
of each line.

1 Select the grid where you want to move grid lines. 

For each line in the grid, a pair of grip points (start point and end point) 
is displayed.

TIP If your grid displays only four lines for the corners of the grid, the grid 
is not in manual mode. For information on how to check the grid mode and 
convert it, see “Changing the Lines of a Ceiling Grid” on page 1233.

2 Use the grip points to drag the lines in either horizontal or vertical direc-
tion. 

� If you move a grid line beyond the grid border, the grid is enlarged 
accordingly. 

� If you move one of the border lines of the grid to the inside of the grid, 
the grid is decreased accordingly.

Changing the Position of Ceiling Grid Lines by Editing Grid Bays
Use this procedure to reposition grid lines by editing the number and spacing 
of grid bays using the Bays worksheet.

1 Double-click the ceiling grid where you want to move lines.

2 On the Properties palette, expand Dimensions.
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3 Edit grid bays:

The Bays worksheet lists all currently existing bays on the respective axis, 
their distance from the start point of the grid, and the spacing of each bay.

4 To change a bay, click on one of its measuring values in the list and edit 
the value.

5 Click OK.

The line positions have changed according to your settings.

Attaching Clipping Profiles to Ceiling Grids

You can attach a clipping profile to define a mask around a ceiling grid or to 
make a hole in a ceiling grid. You could, for example, create a mask to define 
a ceiling grid for an irregularly shaped room, or exclude parts of a room from 
the ceiling grid.

For a mask, you can use closed polylines and spaces. For more information, 
see “Creating a Ceiling Grid with a Clipping Boundary” on page 1230.

NOTE To attach a clipping profile, you must first draw a closed polyline or 
space with the desired boundary or hole shape.

Related Procedures

� Masking Ceiling Grids

� Creating Holes in Ceiling Grids

� Removing Holes from Ceiling Grids

Masking Ceiling Grids
Use this procedure to mask a ceiling grid. A mask is a polyline shape or space 
that defines the boundaries of a ceiling grid. Those parts of the grid which 
are outside of the boundary are not displayed.

If you want to . . . Then . . .

edit grid bays along the X axis expand X Axis, and click the value for 
Bays.

edit grid bays along the Y axis expand Y Axis, and click the value for 
Bays.
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1 Draw a closed polyline with the boundary or hole shape you want.

2 Select the grid you want to mask.

3 On the Properties palette, expand General.

4 Choose Select object for Boundary.

5 Select the closed polyline or space you want to use as a mask.

6 Right-click and click Deselect All to turn off the grid grips.

The parts of the ceiling grid that are outside of the masking polyline or space 
are no longer displayed. 

TIP If you want to restore the original grid shape, select None for Boundary on 
the Properties palette.

Creating Holes in Ceiling Grids
Use this procedure to “cut” a hole into an existing ceiling grid. The parts of 
the grid that are inside the hole are not displayed.

1 Select the grid in which you want to create holes, right-click, and click 
Clip.

2 Enter a (Add Hole), and press ENTER.

3 Select the layout grid, and press ENTER.

4 Select a closed polyline or AEC object for the hole. 

5 Press ENTER.

A hole is cut in the ceiling grid.

Adding a hole to a ceiling grid

Removing Holes from Ceiling Grids
Use this procedure to remove holes you have created in ceiling grids.

1 Select the grid from which you want to remove holes, right-click, and click 
Clip.

2 Enter r (Remove Hole) and press ENTER.
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3 Select the desired ceiling grid, and press ENTER. 

4 Select the closed polyline of the hole.

The hole is removed from the ceiling grid. The polyline, however, remains in 
the drawing. If necessary, you can delete it manually.

Removing a hole from a ceiling grid

Attaching Hyperlinks, Notes, or Files to a Ceiling 
Grid

Use this procedure to attach hyperlinks, notes, or files to a ceiling grid. You 
can also edit hyperlinks and notes, and edit or detach reference files from a 
ceiling grid.

1 Select the ceiling grid you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.
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8 Click OK twice.

Changing the Location of Ceiling Grids

Use this procedure to change the location of ceiling grids. You can relocate 
an existing ceiling grid by changing the coordinate values of its insertion 
point. The ceiling grid also has an orientation with respect to the world coor-
dinate system (WCS) or the current user coordinate system (UCS). For exam-
ple, if the top and bottom of the ceiling grid are parallel to the XY plane, its 
normal is parallel to the Z axis. You can change the orientation of the ceiling 
grid by aligning its normal with another axis. You can also rotate the ceiling 
grid on its plane by changing the rotation angle.

For information about the world coordinate system, see “Use Coordinates 
and Coordinate Systems” in the online AutoCAD 2004 User’s Guide.

1 Select the ceiling grid that you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the ceiling grid:

5 Click OK.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .

relocate the ceiling grid enter new coordinate values under Insertion Point.

locate the ceiling grid on 
the XY plane

make the normal of the ceiling grid parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the ceiling grid on 
the YZ plane

make the normal of the ceiling grid parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the ceiling grid on 
the XZ plane

make the normal of the ceiling grid parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
ceiling grid

enter a new value for Rotation Angle.

If you want to . . . Then . . .
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Changing the Display of Ceiling Grids

Use this procedure to change the properties of the display components of an 
individual column grid. Display components that can be changed include 
grid lines and node and cell markers. 

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the ceiling grid you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.
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Layout Curves and Grids

Three types of layout objects help you to posi-
tion objects relative to each other: layout 
curves, two-dimensional (2D) layout grids, and 
three-dimensional (3D) layout volumes (also 
called volume grids). Each type of layout object 
has anchors to which you can attach objects. All 
use nodes as anchor points. Layout grids and 
layout volumes also provide cells as anchoring 
points for cell anchors and volume anchors. For 
more information, see “Anchors” on page 753.

Layout Curve
A layout curve attaches nodes to objects. You 
can layout curves to position objects along a 
path. Anchoring objects to a layout curve might 
be useful for positioning wash basins along a 
wall or joists along a roof. 

Layout Grid
A layout grid is an arrangement of rectangular 
or radial spaces, called bays, that are delineated 
with parallel or radial lines. Use a two-dimen-
sional (2D) layout grid to position objects in a 
grid pattern. Anchoring objects to layout grids 
might help you to position planters in a side-
walk grid, or tile accents in a floor tile grid. 

Layout Volume
A layout volume (also called a volume grid) is a 
three-dimensional (3D) arrangement of rectan-
gular spaces. Use three-dimensional (3D) layout 
volumes to position objects on a multilevel 
grid. Changing the size of a layout volume 
changes the spacing of objects attached to that 
grid and can also change the size and height of 
objects attached to that grid.

In this chapter

� Using Layout Curves

� Using Layout Grids

� Layout Volumes

� Changing the Location of 
Layout Volumes

� Attaching Hyperlinks, Notes, or 
Files to a Layout Volume

18
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Related Topics

� Using Layout Curves

� Using Layout Grids

� Layout Volumes

Using Layout Curves

Use a layout curve to anchor objects along a path. You can define the follow-
ing objects as layout curves: 

� Walls
� Curtain walls
� Window assemblies
� Spaces
� Mass elements
� Roofs
� Lines
� Arcs
� Circles
� Ellipses
� Polygons
� Polylines
� Splines

Layout curves are best suited for objects with linear geometry, such as 
polylines, walls or splines. If you need nodes on a two-dimensional (2D) 
object, consider using a layout grid instead.

Related Procedures

� Creating a Layout Curve Tool

� Adding Layout Curves

� Adding Nodes to Layout Curves

� Removing Nodes from Layout Curves

� Changing the Spacing Mode of Layout Curves

� Switching Layout Curves

� Changing the Display Properties of Layout Curves

� Attaching Hyperlinks, Notes, or Files to a Layout Curve
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Creating a Layout Curve Tool

Use this procedure to create a layout curve tool and add it to a tool palette. 
You may want to create your own layout curve tools if you are placing mul-
tiple layout curves of a specific style and they have the same properties.

You can use any of the following methods to create a layout curve tool:

� Drag a layout curve that has the desired properties to a tool palette.
� Drag a copy of a tool from another palette to the current palette, and then 

customize the properties of the new tool.
� Copy an existing tool in the current palette, and then customize the prop-

erties of the new tool.
� Drag a tool from the Content Browser to a tool palette, and then custom-

ize the properties of the new tool.

1 Open the tool palette on which to create the tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Expand Basic, and expand General.

6 Click the setting for Description, enter a description of the tool, and click 
OK.

7 Click the setting for Layer key, select a layer key, and click OK.

8 Click the setting for Layer overrides, select a layer key override, and click 
OK.

If you want to . . . Then . . .

create a tool from a layout curve 
in the drawing

select the object, and drag it to the tool 
palette.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.
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9 Expand Dimensions. 

10 Specify a Layout type.

11 Specify number of nodes, or enter a spacing value.

12 Click OK.

Adding Layout Curves

Use this procedure to define an object as a layout curve. The spacing between 
anchor nodes determines the spacing between objects that you attach to the 
layout curve, even if you change the geometry of the layout curve. 

The following spacing options are available: 

� Manual: You specify the position of each node along the layout curve. 

Manually placing nodes on a layout curve

� Repeat: You specify equidistant spacing between nodes along the layout 
curve. The number of anchor nodes is determined by the length of the lay-
out curve. As the length of the curve changes, nodes are added or sub-
tracted accordingly. The spacing of the nodes remains fixed. 

Placing nodes at repeat spacing on a layout curve

� Space Evenly: You specify the number of nodes along the curve. The space 
between nodes is determined by the length of the layout curve. As the 
length of the curve changes, the spacing between nodes is lengthened or 
shortened accordingly. The number of nodes remains fixed. 
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Placing nodes at even spacing on a layout curve

1 Open the tool palette that you want to use, and select a layout curve tool.

If necessary, scroll to display the tool that you want to use.

A layout curve tool is located in the Stock Tool catalog in General Purpose 
Tools, under Parametric Layout and Anchoring. You can add this tool to 
any tool palette. For more information, see “Content Browser” on 
page 171.

2 Select the object to define as a layout curve:

Adding Nodes to Layout Curves

Use this procedure to add nodes to layout curves. 

You can add nodes to only those layout curves that have manually spaced or 
evenly spaced nodes. Layout curves with nodes at fixed repeated spacing can-
not be changed without changing the length of the curve. For more informa-
tion, see “Changing the Spacing Mode of Layout Curves” on page 1250.

1 Select the layout curve by selecting one of the node anchors.

2 Right-click, and click Add Node.

If you want to... Then...

Place nodes at locations that you 
specify

press ENTER. Enter the number of 
nodes, and specify the locations of 
nodes by selecting them or by 
entering distances from the start 
point of the curve.

Repeat nodes at fixed intervals along 
the curve

enter r (Repeat). Specify the start 
and end offsets of the first and last 
nodes, and specify the spacing 
between nodes.

Space a fixed number of nodes along 
the curve

enter s (Space evenly). Specify the 
start and end offsets of the first 
and last nodes, and specify the 
number of nodes.



1250 | Chapter 18 Layout Curves and Grids

3 Specify the distance of the new layout node from the start of the curve. 

� If you have added a node to a layout curve with manually spaced 
nodes, the new node is inserted at the specified position. The position 
of the other nodes remains unchanged.

� If you have added a node to a layout curve with evenly spaced nodes, 
the new node is inserted at the specified position and the remaining 
nodes are recalculated, so that they are evenly spaced again.

Removing Nodes from Layout Curves

Use this procedure to remove nodes from layout curves. 

You can remove nodes from only those layout curves that have manually 
spaced or evenly spaced nodes. Layout curves with nodes at fixed repeated 
spacing cannot be changed without changing the length of the curve. For 
information about spacing options, see “Adding Layout Curves” on 
page 1248.

1 Select the layout curve by selecting one of the node anchors.

2 Right-click, and click Remove Node.

3 Specify the distance of the layout node to be removed from the start of the 
curve. 

� If you have removed a node from a layout curve with manual nodes, 
the node is removed from the specified position. The position of the 
other nodes remains unchanged.

� If you have removed a node from a layout curve with evenly spaced 
nodes, the node is removed from the specified position and the remain-
ing nodes are recalculated, so that they are evenly spaced again.

Changing the Spacing Mode of Layout Curves

Use this procedure to change how modes are positioned along a layout curve. 
For more information, see “Adding Layout Curves” on page 1248.

For example, you can change the mode so that a curve with manually spaced 
nodes becomes a curve with evenly spaced nodes. If you want to add nodes 
to a layout curve with a fixed number of nodes, you must first convert the 
layout curve to manually spaced or evenly spaced mode.

You can also change the layout mode on the Properties palette.

1 Select the layout curve by selecting one of the node anchors.

2 Right-click, and click Layout Mode.
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3 Select the desired mode, and press ENTER. 

� If you are changing a layout curve with manually spaced nodes to a 
curve with nodes at fixed repeated spacing, you are prompted to type 
start and end offsets, and the distance between nodes. If there are too 
few nodes on the curve to fill it, new nodes are created at the specified 
distance. 

� If you are changing a layout curve with manually spaced nodes to a 
curve with evenly spaced nodes, you are prompted to type start and 
end offsets for the curve. The existing nodes are distributed evenly on 
the curve.

� If you are changing a curve with nodes placed at a fixed repeated spac-
ing value to a curve with manually spaced nodes, there is no visible 
change. The nodes have, however, been converted to manual nodes, so 
that you now can add nodes to and remove nodes from the curve.

� If you are changing a curve with nodes placed at a fixed repeated spac-
ing value to a curve with evenly spaced nodes, you are prompted for a 
start offset and an end offset. The existing nodes are then recalculated 
and distributed evenly. You can now add nodes to and remove nodes 
from the curve.

� If you are changing a curve with evenly spaced nodes to a curve with 
manually spaced nodes, there is no visible change. If you change the 
curve, however, the nodes remain fixed and are no longer redistributed 
evenly.

� If you are changing a curve with evenly spaced nodes to a curve with 
nodes placed at fixed repeated spacing, you are prompted to type start 
and end offsets, and the distance between nodes. If there are too few 
nodes on the curve to fill it, new nodes are created at the specified dis-
tance. 

Switching Layout Curves

Use this procedure to move a layout curve from one object to another object. 
The layout mode is retained in this action. If the layout curve was inserted 
originally with evenly spaced nodes, the nodes remain spaced evenly on the 
new object. 

If you switch the curve to an object that already contains a layout curve, the 
two curves are not merged. They are still separate objects and can be edited 
separately.

1 Select the layout curve by selecting one of the node anchors.

2 Right-click, and click Switch Curve.

3 Select the object to which to attach the layout curve. 
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The layout curve is moved to the new object.

Changing the Display Properties of Layout 
Curves

You can change the display properties of the nodes on a layout curve. Display 
properties you can change include layer, color and linetype information, and 
the node size.

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the layout curve that you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Attaching Hyperlinks, Notes, or Files to a Layout 
Curve

Use this procedure to attach hyperlinks, notes, or files to a layout curve. You 
can also edit hyperlinks and notes, and edit or detach reference files from a 
layout curve.

1 Select the layout curve you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
User’s Guide.
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4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK.

Using Layout Grids

Use a layout grid to arrange objects in a 2D grid pattern. You can create a 
radial or rectangular layout grid. You can anchor objects to the intersection 
of the grid lines (node anchors) or to the center of the grid bays (cell 
anchors). 

NOTE By default, the markers for node anchors and cell anchors are not dis-
played when you insert a grid. To display them, turn these components on in the 
Entity Display. For information about turning on display components, see 
“Changing the Display Properties of Layout Curves” on page 1252.

Changing the size of a grid changes the spacing of objects anchored to that 
grid and can also change the size of objects anchored to that grid. You can 
use a clipping profile to define a boundary around a layout grid or to make a 
hole in a layout grid. The layout grid is not displayed outside a boundary or 
inside a hole. Use closed polylines to define the boundary or hole. For exam-
ple, you can use a clipping profile to cut a hole in a reflected ceiling grid.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, enter the description, and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Related Procedures

� Creating a Layout Grid Tool

� Adding Radial Layout Grids

� Changing Radial Layout Grids

� Adding Rectangular Layout Grids

� Changing Rectangular Layout Grids

� Adding Grid Lines to Layout Grids

� Removing Grid Lines from Layout Grids

� Changing the Spacing Mode of Layout Grids

� Changing the Display Properties of Layout Grids

� Creating and Removing Boundaries for Layout Grids

� Creating Holes in Layout Grids

� Removing Holes from Layout Grids

� Changing the Location of Layout Grids

� Attaching Hyperlinks, Notes, or Files to a Layout Grid

Creating a Layout Grid Tool

Use this procedure to create a 2D layout grid tool and add it to a tool palette. 
You may want to create your own layout grid tools if you are placing multiple 
layout grids of a specific style and they all have the same properties.

You can use any of the following methods to create a layout curve tool:

� Drag a layout curve that has the properties you want to a tool palette.
� Drag a copy of a tool from another palette to the current palette, and then 

customize the properties of the new tool.
� Copy an existing tool in the current palette, and then customize the prop-

erties of the new tool.
� Drag a tool from the Content Browser to a tool palette, and then custom-

ize the properties of the new tool.

1 Open the tool palette on which to create the tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from a layout grid 
in the drawing

select the object, and drag it to the tool 
palette.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Expand Basic, and expand General.

6 Click the setting for Description, enter a description of the tool, and click 
OK.

7 Click the setting for Layer key, select a layer key, and click OK.

8 Click the setting for Layer overrides, select a layer key override, and click 
OK.

9 Expand Dimensions. 

10 Click Yes to specify the dimension of the grid on the drawing screen as you 
are creating it.

11 Click No to specify numerical values for the Width, Depth, and Height of 
the grid.

12 Expand X Axis, and specify a Layout type, Bay size, and a Start and End 
offset. 

13 Expand Y Axis, and specify a Layout type, Bay size, and a Start and End 
offset. 

14 Click OK.

Adding Radial Layout Grids

Use this procedure to create a 2D radial layout grid.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.

If you want to . . . Then . . .
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Creating a radial layout grid

1 Open the tool palette that you want to use, and select a layout grid 2D 
tool.

If necessary, scroll to display the tool that you want to use.

A layout grid 2D tool is located in the Stock Tool catalog, General Purpose 
Tools, under Parametric Layout and Anchoring. You can add this tool to 
any tool palette. For more information, see “Content Browser” on 
page 171.

2 Select the layout grid 2D tool.

3 In the Properties palette, expand Basic, and expand General.

4 Click the setting for Description, enter a description of the grid, and click 
OK.

5 Select Radial for Shape.

6 Specify the boundary object attached to the grid.

7 Expand Dimensions.

8 Select Yes to specify dimensions on the drawing screen.

9 Select No to specify dimensions on the Properties palette.

� Enter the width of the grid.
� Enter the angular dimension of the grid.

10 Expand X Axis.

11 Select Space evenly for Layout type and enter a value for Number of bays.

12 Select Repeat for Layout type and enter a value for Bay size.

13 Enter a value for Inside radius.

14 Enter a value for End offset. 

15 Expand Y Axis.

16 Select Space evenly for Layout type and enter a value for Number of bays.
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17 Select Repeat for Layout type and enter a value for Bay angle.

18 Enter a value for Start angle offset. 

19 Enter a value for End angle offset. 

20 Specify an insertion point in the drawing for the center of the radial lay-
out grid.

21 Specify the rotation of the radial grid about the insertion point.

Changing Radial Layout Grids

Use this procedure to change the angle or size of a radial layout grid. You can 
also change the number and size of the grid bays.

If you use grips to stretch a radial layout grid, the behavior of the radial lay-
out grid depends on the spacing type of each axis. The overall size of the grid 
“jumps” in directions that are specified to use a specific bay size with repeat 
spacing because the exact bay size is maintained. The overall size changes in 
directions that are specified to be evenly spaced or manually spaced. 

1 Select one or more 2D layout grids, right-click, and click Modify Layout 
Grid (2D).

2 In the Properties palette, expand Basic, and expand General.

3 Enter a new value for the radius, angle, and inside radius.

4 Enter a new value for the X bay size.

5 Change the repeat spacing value, or enter a new value for the bay angle.

Adding Rectangular Layout Grids

Use this procedure to add rectangular layout grids.

Creating a rectangular layout grid
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1 Open the tool palette that you want to use, and select a layout grid 2D 
tool.

If necessary, scroll to display the tool that you want to use.

A layout grid 2D tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Select the layout grid 2D tool.

3 In the Properties palette, expand Basic, and expand General.

4 Select Rectangular for Shape.

5 Enter a value for the X width and the Y depth.

6 Select the repeat spacing option and enter a value, or enter a value for the 
X and Y bay size.

7 Specify an insertion point in the drawing for the lower-left corner of the 
rectangular layout grid.

8 Specify the rotation of the rectangular grid about the insertion point.

Changing Rectangular Layout Grids

Use this procedure to change the angle or size of a rectangular layout grid. 
You can also change the number and size of the grid bays.

If you use grips to stretch a rectangular layout grid, the behavior of the rect-
angular layout grid depends on the spacing type of each axis. The overall size 
of the grid “jumps” in directions that are specified to use a specific bay size 
with repeat spacing because the exact bay size is maintained. The overall size 
changes in directions that are specified to be evenly spaced or manually 
spaced. 

1 Select one or more 2D layout grids, right-click, and click Modify Layout 
Grid (2D).

2 In the Properties palette, expand Basic, and expand General.

3 Enter a new X width and Y depth value.

4 Select the repeat spacing option and enter a value, or enter a new X and Y 
bay size value.

Adding Grid Lines to Layout Grids

Use this procedure to manually add grid lines to a grid. You can separately 
add grid lines on the X plane and on the Y plane.
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NOTE You can add lines only to grids inserted with manually spaced lines or 
evenly spaced lines. Layout grids with lines placed at a fixed repeated spacing 
value cannot be changed manually. For information about grid modes, see 
“Changing the Spacing Mode of Layout Grids” on page 1260.

1 Select the layout grid, right-click, and add a grid line:

2 Specify the distance of the new grid line from the start of the grid. 

� If you have added a line to a layout grid with manually spaced lines, 
the new line is inserted on the specified position. The position of the 
other lines remains unchanged. The grid size changes accordingly.

� If you have added a line to a layout grid with evenly spaced lines, the 
new line is inserted and all lines are recalculated, so that they are 
evenly distributed again. The grid size remains unchanged.

Removing Grid Lines from Layout Grids

Use this procedure to manually remove individual grid lines from a grid. You 
can separately remove grid lines from the X plane and the Y plane.

NOTE You can remove lines only from grids which have been inserted with 
manually spaced lines or evenly spaced lines. Layout grids with lines placed at a 
fixed repeated spacing value cannot be changed manually. For information 
about grid modes, see “Changing the Spacing Mode of Layout Grids” on 
page 1260.

1 Select the layout grid, right-click and remove a grid line:

If you want to add. . . Then . . .

a grid line to the X plane of 
the grid 

select X-axis on the shortcut menu, and then 
click Add Grid Line. 

a grid line to the Y plane of 
the grid

select Y-axis on the shortcut menu, and then 
click Add Grid Line. 

If you want to remove. . . Then . . .

a grid line from the X plane of the 
grid 

select X-axis on the shortcut menu, and 
then click Remove Grid Line. 
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2 Click the grid line to be removed from the grid.

� If you have removed a line from a layout grid with manually spaced 
lines, the specified line is removed from the grid. The position of the 
other lines remains unchanged.

� If you have removed a line from a layout grid with evenly spaced lines, 
the specified line is removed from the grid. All remaining lines are 
recalculated, so that they are evenly distributed again. 

Changing the Spacing Mode of Layout Grids

Use this procedure to change the spacing mode of a radius or rectangular lay-
out grid. Layout grids can have three different spacing modes. These modes 
are set separately for the X and Y planes:

� Manual: You specify the position of each line on the layout grid.
� Repeat: You specify equidistant spacing between lines on the layout grid. 

The number of lines is determined by the size of the layout grid. As the 
size of the grid changes, lines are added or subtracted accordingly. The dis-
tance between the lines remains fixed.

� Space Evenly: You specify the number of lines on the grid. The space 
between the lines is determined by the size of the layout grid. As the size 
of the grid changes, the spacing between the lines is lengthened or short-
ened accordingly. The number of lines remains fixed.

By default, layout grids are inserted with evenly spaced lines.

1 Select the layout grid, right-click, and specify a spacing mode:

2 Select the desired mode, and press ENTER.

a grid line from the Y plane of the 
grid 

select Y-axis on the shortcut menu, and 
then click Remove Grid Line. 

If you want to change. . . Then . . .

the spacing mode of the X plane 
of the grid 

select X-axis on the shortcut menu, and 
then click Layout Mode. 

the spacing mode of the Y plane 
of the grid 

select Y-axis on the shortcut menu, and then 
click Layout Mode. 

If you want to remove. . . Then . . .
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� If you are changing a layout grid with manually spaced lines to a a grid 
with lines placed at a fixed repeated spacing value, you are prompted 
to type start and end offsets, and the distance between the lines. If 
there are too few lines on the grid to fill it according to your specifica-
tions, new lines are created. 

� If you are changing a layout grid with manually spaced lines to a grid 
with evenly spaced lines, you are prompted to type start and end offsets 
for the grid. The existing lines are distributed evenly on the grid.

� If you are changing a layout grid with lines placed at a fixed repeated 
spacing value to a grid with manually spaced lines, there is no visible 
change, but the lines have been converted to manual lines, so that you 
now can add lines to and remove lines from the grid.

� If you are changing a layout grid with lines placed at a fixed repeated 
spacing value to a grid with evenly spaced lines, you are prompted for 
a start offset and an end offset. The existing lines are than recalculated 
and distributed evenly. You can now add lines to and remove lines from 
the grid.

� If you are changing a grid with evenly spaced lines to a grid with man-
ually spaced lines, there is no visible change. If you change the grid 
however, the lines now remain fixed and are not distributed evenly 
anymore.

� If you are changing a grid with evenly spaced lines to a grid with lines 
placed at a fixed repeated spacing value, you are prompted to type start 
and end offsets, and the distance between the lines. If there are too few 
lines on the grid to fill the grid according to your specifications, new 
lines are created. 

Changing the Display Properties of Layout Grids

You can change the display properties of the nodes on a layout grid. Display 
properties you can change include layer, color and linetype information, and 
the node size.

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the layout grid that you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.
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3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Creating and Removing Boundaries for Layout 
Grids

Use this procedure to create a boundary around a 2D layout grid. Areas of the 
grid outside of the boundary are not shown. However, objects anchored to 
the grid outside the boundary are still displayed. Boundaries are useful when 
you need to create a grid in an irregularly shaped area.

You can also remove a boundary to re-display the entire grid.

1 Draw a closed polyline to define the grid boundary.

2 Select a layout grid, right-click, and click Clip.

3 Enter s (Set boundary), and select the layout grid and press ENTER. 

4 Select the closed polyline for the boundary of the layout grid and press 
ENTER.

5 To remove a grid boundary, erase the polyline that defines the boundary.

Creating Holes in Layout Grids

Use this procedure to create a hole in a layout grid. The area of the grid 
within the hole is not displayed.

1 Draw a closed polyline to define the hole.

2 Select a layout grid, right-click, and click Clip.

3 Enter a (Add hole), and select the layout grid, and press ENTER.

4 Select the closed polyline for the hole and press ENTER.

A hole is cut in the layout grid.
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Removing Holes from Layout Grids

Use this procedure to remove holes that you have created in layout grids. 

1 Select a layout grid, right-click, and click Clip.

2 Enter r (Remove hole), and select a layout grid, and press ENTER.

3 Select the closed polyline of the hole.

Changing the Location of Layout Grids

Use this procedure to change the location of layout grids. You can relocate a 
layout grid by changing the coordinate values of its insertion point. The lay-
out grid also has an orientation with respect to the world coordinate system 
(WCS) or the current user coordinate system (UCS). For example, if the top 
and bottom of the layout grid are parallel to the XY plane, its normal is par-
allel to the Z axis. You can change the orientation of the layout grid by align-
ing its normal with another axis. You can also rotate the layout grid on its 
plane by changing the rotation angle. 

For information about WCS and UCS, see “Use Coordinates and Coordinate 

Systems” in the AutoCAD® 2004 User’s Guide.

1 Select the layout grid that you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the layout grid:

If you want to . . . Then . . .

relocate the layout grid enter new coordinate values under Insertion Point.

locate the layout grid on 
the XY plane

make the normal of the layout curve parallel to the 
Z axis: under Normal, enter 1 for Z, and enter 0 for 
X and Y. 

locate the layout grid on 
the YZ plane

make the normal of the layout grid parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the layout grid on 
the XZ plane

make the normal of the layout grid parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
layout grid

enter a new value for Rotation Angle.
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5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Layout 
Grid

Use this procedure to attach hyperlinks, notes, or files to a layout grid. You 
can also edit hyperlinks and notes, and edit or detach reference files from a 
layout grid.

1 Select the layout grid to which to attach information.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
User’s Guide.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK.

Layout Volumes

Use a layout volume to arrange objects in a 3D grid. Changing the size of a 
layout volume changes the spacing of objects attached to that volume and 
can also change the size and height of objects attached to that volume.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, enter the description, and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.



Layout Volumes | 1265

Related Procedures

� Creating a Layout Volume Tool

� Adding Layout Volumes

� Changing Layout Volumes

� Adding Grid Lines to Layout Volumes

� Removing Grid Lines from Layout Volumes

� Changing the Spacing Mode of Layout Volumes

� Changing the Display Properties of Layout Volumes

� Changing the Location of Layout Volumes

� Attaching Hyperlinks, Notes, or Files to a Layout Volume

Creating a Layout Volume Tool

Use this procedure to create a layout volume tool and add it to a tool palette. 
You may want to create your own layout volume tools if you are placing mul-
tiple layout volumes of a specific style and they all have the same properties.

You can use any of the following methods to create a layout volume tool:

� Drag a layout volume that has the properties you want to a tool palette.
� Drag a copy of a tool from another palette to the current palette, and then 

customize the properties of the new tool.
� Copy an existing tool in the current palette, and then customize the prop-

erties of the new tool.
� Drag a tool from the Content Browser to a tool palette, and then custom-

ize the properties of the new tool.

1 Open the tool palette on which to create the tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from a layout 
volume in the drawing

select the object, and drag it to the tool 
palette.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Expand Basic, and expand General.

6 Click the setting for Description, enter a description of the tool, and click 
OK.

7 Click the setting for Layer key, select a layer key, and click OK.

8 Click the setting for Layer overrides, select a layer key override, and click 
OK.

9 Expand Dimensions. 

10 Click Yes to specify the dimension of the grid on the drawing screen as you 
are creating it.

11 Click No to specify numerical values on the Properties palette, and enter 
values for Width, Depth, and Height 

12 Expand X Axis.

13 Select Space evenly for Layout type and enter a value for Number of bays.

14 Select Repeat for Layout type and enter a value for Bay size.

15 Enter a value for Start offset.

16 Enter a value for End offset. 

17 Expand Y Axis.

18 Select Space evenly for Layout type and enter a value for Number of bays.

19 Select Repeat for Layout type and enter a value for Bay angle.

20 Enter a value for Start offset.

21 Enter a value for End offset. 

22 Expand Z Axis.

23 Select Space evenly or Repeat for Layout type.

24 Enter a value for Start offset.

25 Enter a value for End offset. 

26 Click OK.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.

If you want to . . . Then . . .
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Adding Layout Volumes

Use this procedure to add a layout volume, which is a three-dimensional lay-
out grid.

Creating a layout grid volume

1 Open the tool palette that you want to use, and select a volume layout 
tool.

If necessary, scroll to display the tool that you want to use.

A volume layout tool is located within the General Purpose Tools under 
Parametric Layout and Anchoring in the Stock Tool catalog. You can add 
this tool to any tool palette. For more information, see “Content Browser” 
on page 171.

2 Select the volume layout tool.

3 In the Properties palette, expand Basic, and expand General.

4 Enter a value for the X width, Y depth and the Z height.

5 Select the repeat spacing option and enter a value, or enter a value for the 
X, Y, and Z bay size.

6 Specify an insertion point in the drawing for the lower-left corner of the 
rectangular layout grid.

7 Specify the rotation of the rectangular grid about the insertion point.
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Changing Layout Volumes

Use this procedure to change the angle or size of three-dimensional (3D) lay-
out volumes. You can also change the number and size of the grid bays. 

If you use grips to stretch a layout volume, the behavior of the layout volume 
depends on the spacing type of each axis. The overall size of the grid “jumps” 
in directions that are specified to use a specific bay size with repeat spacing 
because the exact bay size is maintained. The overall size changes in direc-
tions that are specified to be evenly spaced or manually spaced.

1 Select one or more 3D volume grids, right-click, and click Modify Layout 
Volume (3D).

2 In the Properties palette, expand Basic, and expand General.

3 Enter a new X width, Y depth, and Z height value.

4 Select the repeat spacing option and enter a value, or enter a new X, Y, and 
Z bay size value.

Adding Grid Lines to Layout Volumes

Use this procedure to manually add grid lines to a layout volume. You can 
separately add grid lines on the X, Y plane and on the Z plane.

NOTE You can add lines only to volumes inserted with manually spaced lines 
or evenly spaced lines. Layout volumes with lines placed at a fixed repeated spac-
ing value cannot be changed manually. For information about grid modes, see 
“Changing the Spacing Mode of Layout Grids” on page 1260.

1 Select the layout volume, right-click, and add a grid line:

2 Specify the distance of the new grid line from the start of the grid. 

If you want to add. . . Then . . .

a grid line to the X plane of 
the volume 

select X axis on the shortcut menu, and then 
click Add Grid Line. 

a grid line to the Y plane of 
the volume

select Y axis on the shortcut menu, and then 
click Add Grid Line. 

a grid line to the Z plane of 
the volume

select Z axis on the shortcut menu, and then 
click Add Grid Line. 
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� If you have added a line to a layout volume with manually spaced lines, 
the new line is inserted at the specified position. The position of the 
other lines remains unchanged. The grid size changes accordingly.

� If you have added a line to a layout volume with evenly spaced lines, 
the new line is inserted and all lines are recalculated, so that they are 
evenly distributed again. The grid size remains unchanged.

Removing Grid Lines from Layout Volumes

Use this procedure to manually remove individual grid lines from a volume. 
You can separately remove grid lines from the X, Y plane and the Z plane.

NOTE You can remove lines only from volumes which have been inserted with 
manually spaced lines or evenly spaced lines. Layout volumes with lines placed 
at a fixed repeated spacing value cannot be changed manually. For information 
about grid modes, see “Changing the Spacing Mode of Layout Grids” on 
page 1260.

1 Select the layout volume, right-click and remove a grid line:

2 Click on the grid line to be removed from the volume.

� If you have removed a line from a layout volume with manually spaced 
lines, the specified line is removed from the volume. The position of 
the other lines remains unchanged.

� If you have removed a line from a layout volume with evenly spaced 
lines, the specified line is removed from the volume. All remaining 
lines are recalculated, so that they are evenly distributed again. 

If you want to remove. . . Then . . .

a grid line from the X plane of the 
volume 

select X axis on the shortcut menu, and 
then Remove Grid Line. 

a grid line from the Y plane of the 
volume 

select Y axis on the shortcut menu, and 
then Remove Grid Line. 

a grid line from the Z plane of the 
volume 

select Z axis on the shortcut menu, and 
then Remove Grid Line. 
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Changing the Spacing Mode of Layout Volumes

Use this procedure to change how modes are positioned along a layout vol-
ume. For more information, see “Adding Layout Volumes” on page 1267.

For example, you can change the mode so that a volume with manually 
spaced nodes becomes a volume with evenly spaced nodes. If you want to 
add nodes to a layout volume with a fixed number of nodes, you must first 
convert the layout volume to the manually spaced or evenly spaced mode.

You can also change the layout mode on the Properties palette.

1 Select the layout volume by selecting one of the node anchors.

2 Right-click, and click Layout Mode.

3 Select the desired mode, and press ENTER. 

� If you are changing a layout volume with manually spaced nodes to a 
volume with nodes placed at a fixed repeated spacing value, you are 
prompted to type start and end offsets, and the distance between the 
nodes. If there are too few nodes on the curve to fill it, new nodes are 
created at the specified distance. 

� If you are changing a layout volume with manually spaced nodes to a 
volume with evenly spaced nodes, you are prompted to type start and 
end offsets for the volume. The existing nodes are distributed evenly on 
the volume.

� If you are changing a volume with nodes placed at a fixed repeated 
spacing value to a volume with manually spaced nodes, there is no vis-
ible change. The nodes have, however, been converted to manual 
nodes, so that you now can add nodes to and remove nodes from the 
volume.

� If you are changing a volume with nodes placed at a fixed repeated 
spacing value to a volume with evenly spaced nodes, you are prompted 
for a start offset and an end offset. The existing nodes are than recalcu-
lated and distributed evenly. You can now add nodes to and remove 
nodes from the volume.

� If you are changing a volume with evenly spaced nodes to a volume 
with manually spaced nodes, there is no visible change. If you change 
the volume, however, the nodes remain fixed and are no longer redis-
tributed evenly.

� If you are changing a volume with evenly spaced nodes to a volume 
with nodes placed at a fixed repeated spacing value, you are prompted 
to type start and end offsets, and the distance between the nodes. If 
there are too few nodes on the curve to fill it, new nodes are created at 
the specified distance. 
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Changing the Display Properties of Layout 
Volumes

You can change the display properties of the nodes on a layout volume. Dis-
play properties you can change include layer, color and linetype informa-
tion, and the node size.

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the layout volume that you want to change, right-click, and click 
Edit Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Changing the Location of Layout Volumes

Use this procedure to change the location of layout volumes. You can relo-
cate a layout volume by changing the coordinate values of its insertion point. 
The layout volume also has an orientation with respect to the world coordi-
nate system (WCS) or the current user coordinate system (UCS). For example, 
if the top and bottom of the layout volume are parallel to the XY plane, its 
normal is parallel to the Z axis. You can change the orientation of the layout 
volume by aligning its normal with another axis. You can also rotate the lay-
out volume on its plane by changing the rotation angle. 

For information about WCS and UCS, see “Use Coordinates and Coordinate 

Systems” in the AutoCAD® 2004 User’s Guide.
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1 Select the layout volume that you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the layout volume:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a 
Layout Volume

Use this procedure to attach hyperlinks, notes, or files to a layout volume. 
You can also edit hyperlinks and notes, and edit or detach reference files from 
a layout volume.

1 Select the layout volume to which to attach information.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
User’s Guide.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

If you want to . . . Then . . .

relocate the layout volume enter new coordinate values under Insertion Point.

locate the layout volume 
on the XY plane

make the normal of the layout volume parallel to 
the Z axis: under Normal, enter 1 for Z, and enter 0 
for X and Y. 

locate the layout volume 
on the YZ plane

make the normal of the layout volume parallel to 
the X axis: under Normal, enter 1 for X and enter 0 
for Y and Z. 

locate the layout volume 
on the XZ plane

make the normal of the layout volume parallel to 
the Y axis: under Normal, enter 1 for Y, and enter 0 
for X and Z.

change the rotation of the 
layout volume

enter a new value for Rotation Angle.
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6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, enter the description, and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Openings

An opening is an AEC object that interacts with 
walls and space boundaries to represent an 
opening of any size at any elevation. You can 
also add openings as freestanding objects.

Opening Shapes
When you add an opening to a drawing, you 
can select from a number of predefined shapes, 
such as rectangular, half-round, oval, or arch. 
You can also create openings with custom 
shapes using profiles to define the geometry of 
the opening.

Examples of predefined shapes for openings

Anchoring Openings
After you place an opening in a wall or space 
boundary, the opening is constrained to the 
object and cannot move outside it. 

Openings can also be anchored to specific loca-
tions in walls or space boundaries, so that when 

In this chapter

� Using Opening Tools to Create 
Openings

� Creating an Opening

� Creating an Opening with User-
specified Settings

� Creating and Editing Custom 
Openings

� Creating an Opening Tool

� Editing Openings

� Changing the Display 
Properties of Openings

19
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the wall or space boundary moves or changes size, the location of the open-
ing in that object remains constant. 

Opening Dimensions
All openings have height and width. The rise dimension depends on the 
opening shape. Rise is the height from the top of the rectangular portion of 
an opening to the peak of the opening for gothic, arch, peak pentagon, and 
trapezoid shapes.

Vertical Alignment of Openings
Use the vertical alignment settings to control how to place an opening in the 
wall, the location of the working point vertically in the wall, and how the 
opening responds to modifications in height. Use the sill and head height 
settings to determine the working point on the opening. You can place the 
working point at the sill or at the head. For example, if you specify the verti-
cal alignment as 0'' and the opening height as 7'–0'', the opening height is 
7’–0''. If you next specify the height of the opening as 6'–8'', the sill remains 
at 0'' and the opening height becomes 6’–8''.

For the opening head working point, if you specify the vertical alignment as 
7'–0'' and the opening height as 7'–0'', the opening height is 7–0''. If you spec-
ify the opening height as 6'–8'', the head remains at 7'–0'' and the sill becomes 
4''.

Related Topics and Procedures

� Using Opening Tools to Create Openings

� Creating an Opening

� Creating an Opening with User-specified Settings

� Creating and Editing Custom Openings

� Editing Openings

� Changing the Display Properties of Openings

Using Opening Tools to Create Openings

Tools provided with Autodesk® Architectural Desktop let you quickly place 
openings by selecting an opening tool with predefined properties. You can 
use the default settings of the tool as is, or you can change them to suit your 
needs. You can also apply the settings of an opening tool to existing open-
ings.

The default tool palettes in the workspace contain a sample opening tool that 
you can use and customize as needed. In addition, the following catalogs pro-
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vided with the software contain opening tools that you can add to your tool 
palettes:

� Autodesk Architectural Desktop Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog

Custom palettes created by your CAD manager or other users may also con-
tain opening tools with properties that are customized for your projects or 
office standards.

Related Procedures

� Creating an Opening

� Creating an Opening with User-specified Settings

� Creating and Editing Custom Openings

� Creating an Opening Tool

Creating an Opening

Use this procedure to add an opening that has the properties specified in the 
opening tool that you select. To specify settings when you add an opening, 
see “Creating an Opening with User-specified Settings” on page 1278.
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Adding an opening to a wall

1 Open the tool palette that you want to use, and select an opening tool.

If necessary, scroll to display the desired tool.

2 Select a wall or space boundary in which to insert the opening, or press 
ENTER to add a freestanding opening.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the insertion point of the opening.

If you are adding a freestanding opening, specify the rotation of the open-
ing after you specify the insertion point.

4 Continue adding openings, and press ENTER.

Creating an Opening with User-specified 
Settings

Use this procedure to create an opening with settings that you specify.



Creating an Opening with User-specified Settings | 1279

Adding an opening to a wall

1 Open the tool palette that you want to use, and select an opening tool.

If necessary, scroll to display the desired tool.

2 On the Properties palette, expand Basic, and expand General.

3 Select a shape for the opening.

To specify a custom shape, select Custom for Shape, and select the profile 
that provides the geometry of the shape for Profile.

4 Expand Dimensions.

5 Enter values for Width, Height, and Rise.

Rise is available only for arch, gothic, peak pentagon, and trapezoid 
shapes.

6 Expand Location.
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7 If you are placing the opening in a wall or a space boundary, specify the 
opening position:

8 Specify whether you want the opening to be aligned vertically by sill 
height or by head height:

9 Specify the insertion point for an opening in a wall or space boundary, or 
for a freestanding opening:

10 Continue to place openings, and press ENTER.

If you want to . . . Then . . .

position the edge of the 
opening at a specific distance 
from the end of a wall segment 
or space boundary

select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.

center the opening on a wall 
segment or space boundary

select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall segment or space boundary.

position the opening anywhere 
along the wall or space 
boundary

select Unconstrained for Position along 
wall.

If you want to . . . Then . . .

align the opening by sill height select Sill for Vertical alignment, and enter 
a value for Sill height.

align the opening by head 
height

select Head for Vertical alignment, and 
enter a value for Head height.

If you want to . . . Then . . .

place an opening in a wall select the wall, and specify an insertion 
point along the wall.

place an opening in a space 
boundary

select the space boundary, and specify an 
insertion point in the space boundary.

place a freestanding opening press ENTER, and specify an insertion 
point and rotation angle for the opening.
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Creating and Editing Custom Openings

In addition to using predefined shapes for openings, you can create openings 
with custom shapes. You create a profile from a closed polyline to define the 
two-dimensional (2D) geometry of the shape. The profile is then extruded 
when it is applied to an opening. You can edit the profile to change the shape 
of the opening. You can then save the changes to the current profile or to a 
new profile. You can apply the profiles you create to any openings.

Related Procedures

� Creating a Profile for a Custom Opening

� Creating an Opening with a Custom Shape

� Editing the Geometry of a Custom Opening

Creating a Profile for a Custom Opening

Use this procedure to create a profile that provides the geometry for an open-
ing with a custom shape.

You can create the profile as you add it to an opening. However, if the shape 
you need is elaborate and has curved segments, you may find it easier to cre-
ate the profile from a polyline first. You can then add the profile to the open-
ing.

1 Draw concentric, closed polylines representing the opening and any 
insets. 

2 Select the polylines, right-click, and click Convert to ➤ Profile Defini-
tion. 

3 Select the outermost polyline.

4 Enter a (Add ring).

5 Select an inner polyline.

6 Repeat steps 4 and 5 as needed to add more rings to the profile.

7 Specify the insertion point of the profile.

8 Enter n (New), enter a name for the profile, and click OK.

Creating an Opening with a Custom Shape

Use this procedure to create an opening with a custom shape and other set-
tings that you specify.
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Adding an opening with a custom shape

1 Open the tool palette that you want to use, and select an opening tool.

If necessary, scroll to display the desired tool.

2 On the Properties palette, expand Basic, and expand General.

3 Select Custom for Shape.

4 Select the profile that provides the geometry of the shape for Profile.

5 Expand Dimensions.

6 Enter values for Width and Height.

7 Expand Location.

8 If you are placing the opening in a wall or a space boundary, specify the 
opening position:

If you want to . . . Then . . .

position the edge of the 
opening at a specific distance 
from the end of a wall segment 
or space boundary

select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.
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9 Specify whether you want the opening to be aligned vertically by sill 
height or by head height:

10 Specify the insertion point for an opening in a wall or space boundary, or 
for a freestanding opening:

11 Continue to place openings, and press ENTER.

Editing the Geometry of a Custom Opening

Use this procedure to edit the geometry of a profile that determines the shape 
of a custom opening. You can save the changes to the existing profile or to a 
new profile.

center the opening on a wall 
segment or space boundary

select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall segment or space boundary.

position the opening anywhere 
along the wall or space 
boundary

select Unconstrained for Position along 
wall.

If you want to . . . Then . . .

align the opening by sill height select Sill for Vertical alignment, and enter 
a value for Sill height.

align the opening by head 
height

select Head for Vertical alignment, and 
enter a value for Head height.

If you want to . . . Then . . .

place an opening in a wall select the wall, and specify an insertion 
point along the wall.

place an opening in a space 
boundary

select the space boundary, and specify an 
insertion point in the space boundary.

place a freestanding opening press ENTER, and specify an insertion 
point and a rotation angle for the 
opening.

If you want to . . . Then . . .
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1 Select the opening that has the shape you want to change, right-click, and 
click Edit Profile In Place.

A temporary profile is created for you to edit the geometry of the custom 
opening.

A temporary profile for editing a custom opening

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select the 
profile, and right-click to display the shortcut menu.

2 Edit the profile:

If you want to . . . Then . . .

change the shape of the 
perimeter of the profile or its 
rings

select the profile, and use grips to adjust the 
shape.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace an existing ring of the 
profile with new geometry

select the profile, right-click, and click Replace 
Ring. Select the ring to replace, and select the 
new geometry. Press ENTER to keep the 
geometry, or enter y (Yes) to erase it.
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Profile for custom opening after editing

3 Save or discard the changes:

add a ring to the profile draw the linework in place on the temporary 
profile. Select the profile, right-click, and click 
Add Ring. Select the geometry to define the 
ring. Press ENTER to keep the geometry, or 
enter y (Yes) to erase it.

remove a ring from the profile select the profile, right-click, and click Remove 
Ring. Select the ring to remove, and press 
ENTER. This option does not appear if the 
profile has only one ring.

If you want to . . . Then . . .

restore the opening to its 
original shape

click .

save the changes to the current 
profile

click .
The opening uses the edited profile to define 
its geometry. Any other objects or styles that 
use this profile are also updated with the 
edited geometry.

save the changes to a new 
profile

select the profile, right-click, and click Save as 
New Profile. Enter a name for the new profile, 
and click OK.
The opening uses the new profile to define its 
geometry. Other styles or objects that use the 
original profile are not affected.

If you want to . . . Then . . .
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Creating an Opening Tool

Use this procedure to create an opening tool and add it to a tool palette. You 
may want to create your own opening tools if you are placing multiple open-
ings that have the same properties.

For example, you are creating a restaurant floor plan that contains openings 
of various sizes. To work efficiently, you can create an opening tool for each 
size. You can then select the appropriate tool to place openings in the floor 
plan.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tooltip on the tool palette, and to describe 
the tool if it is stored in a tool catalog.

6 Expand Basic, and expand General.

7 Enter a description of the opening that you can create using this opening 
tool.

8 If you do not want to use the default layer key for openings, select a layer 
key.

If you want to . . . Then . . .

create a tool from an opening in 
the drawing

select the opening, and drag it to the tool 
palette.

copy a tool in the current 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.

copy a tool from a tool catalog open the tool catalog in the Content Browser, 
and locate the tool you want to copy. Position 
the cursor over the i-drop handle, and drag 
the tool to the tool palette.
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9 If you want to override the default layer name for openings, select a layer 
override.

10 Select a shape for the opening.

To specify a custom shape, select Custom for Shape, and select the profile 
that provides the geometry of the shape for Profile.

11 Expand Dimensions.

12 Enter values for Width, Height, and Rise.

Rise is available only for arch, gothic, peak pentagon, and trapezoid 
shapes.

13 Expand Location.

14 If you are placing the opening in a wall or a space boundary, specify the 
opening position:

15 Specify whether you want the opening to be aligned vertically by sill 
height or by head height:

16 Click OK.

If you want to . . . Then . . .

position the edge of the 
opening at a specific distance 
from the end of a wall segment 
or space boundary

select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.

center the opening on a wall 
segment or space boundary

select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall segment or space boundary.

position the opening anywhere 
along the wall or space 
boundary

select Unconstrained for Position along 
wall.

If you want to . . . Then . . .

align the opening by sill height select Sill for Vertical alignment, and enter 
a value for Sill height.

align the opening by head 
height

select Head for Vertical alignment, and 
enter a value for Head height.
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Editing Openings

After you create an opening, you can change the height, width, and rise. You 
can also change the endcap conditions applied to the opening. You can move 
the opening within the wall or space boundary.

Autodesk® Architectural Desktop offers several methods for editing openings:

� Edit openings directly using grips for dimensions and other physical char-
acteristics.

� Change settings on the Properties palette.
� Select editing commands from the shortcut menu for a selected opening.

Related Procedures

� Using Grips to Edit Openings

� Changing the Shape and Dimensions of an Opening

� Flipping an Opening along the X or Y Axis

� Changing Endcap Style for an Opening

� Applying Tool Properties to an Existing Opening

� Repositioning an Opening

� Using Anchors to Change the Horizontal Position of an Opening

� Using Anchors to Change the Vertical Position of an Opening

� Changing the Position of an Opening Within a Wall or Space Boundary

� Changing the Orientation of an Opening to a Wall or Space Boundary

� Specifying the Display of Sills for an Opening

� Changing the Location of an Opening

� Attaching Hyperlinks, Notes, and Files to an Opening

Using Grips to Edit Openings

Refer to the illustrations and steps in this topic to use opening grips to edit 
an opening.

Editing Opening Dimensions

1 Select the opening.

2 Select the grip for the dimension you want to change.
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Opening dimension grips

3 Move the grip until the desired dimension value is displayed and click 
once, or enter a value.

Changing the Location of an Opening

1 Select the opening.

2 Move the Location grip to change the location of the opening.

Press CTRL to select the direction of movement: along the wall or space 
boundary, within the wall or boundary, or vertically within the wall or 
boundary.
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Opening location grip

Changing the Shape and Dimensions of an 
Opening

Use this procedure to change the shape and size of an opening.

1 Double-click the opening you want to change. 

2 On the Properties palette, expand Basic, and expand General.

3 Select a shape.

To specify a custom shape, select Custom for Shape, and select the profile 
that provides the geometry of the shape for Profile.

4 Expand Dimensions.

5 Change the width, height, or rise for the opening.

Flipping an Opening along the X or Y Axis

Use this procedure to reorient an opening along its X or Y axis.

TIP You can also flip an opening along its X axis using the Flip grip that is dis-
played when you select an opening.
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1 To flip an opening along the X axis, select the openings you want to 
change, right-click, and click Wall Anchor ➤ Flip X.

Opening in original position, and flipped along its X axis

2 To flip an opening along the Y axis, select the openings, right-click, and 
click Wall Anchor ➤ Flip Y.

Opening in original position, and flipped along its Y axis

Changing Endcap Style for an Opening

Use this procedure to change the opening endcap style used at each side of 
an opening. An endcap is a user-definable condition for the edges of an open-
ing. For more information about opening endcap styles, see “Opening End-
cap Styles” on page 1894.

1 Double-click the opening you want to change.
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2 On the Properties palette, expand Basic, expand Location, and expand 
Endcaps.

3 Select an opening endcap style.

Applying Tool Properties to an Existing Opening

Use this procedure to apply the properties of an opening tool to one or more 
openings.

1 Open the tool palette that you want to use.

If necessary, scroll to display the desired tool.

2 Right-click an opening tool, and click Apply Tool Properties to Opening.

3 Select the openings, and press ENTER.

4 Edit the properties of the openings in the Properties palette, if necessary.

Repositioning an Opening

Use this procedure to change the location of an opening along the wall or 
space boundary by offsetting the opening from a reference location. 

This feature is useful when you want to position an opening at a specified dis-
tance from another object. For example, you may want to specify an exact 
distance between a series of openings along a wall.
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Repositioning an opening by offsetting points

1 Select the opening you want to move, right-click, and click Reposition 
Along Wall.

A marker indicates the current location within the opening: left jamb, 
center of opening, or right jamb.

2 Specify how to measure the offset:

If you want to . . . Then . . .

measure the offset from the 
center of the opening

select a point near the center of the 
opening.

measure the offset from the left 
or right jamb

select a point on the jamb of the opening 
from which you want to measure.
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Selecting the center of the opening for measuring the offset

3 Select a point to measure to (the reference point).

You can select a point along the wall.

Specifying a reference point

4 Specify the distance between the points you selected:

Opening repositioned along the wall

If you want to . . . Then . . .

move the opening to the 
reference point

enter 0 (zero).

move the opening a specified 
distance from the reference 
point

enter a value for the offset distance.

specify the distance as a 
measurement between two 
points, such as the distance 
between the centers of two 
openings that are correctly 
positioned

specify the two points measuring the 
distance.
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Using Anchors to Change the Horizontal Position 
of an Opening

Use this procedure to change the horizontal position of openings along a 
wall or space boundary to which the openings are anchored.

You can also change the horizontal position of the opening using the Loca-
tion grip. For more information, see “Using Grips to Edit Openings” on 
page 1288.

Positioning an opening horizontally

1 Select the openings you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.
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4 Select the reference point for the anchor along the X axis: 

5 Enter the distance from the reference point at which to place the open-
ings.

Use a negative value to measure from endpoint to start point.

6  Select the position of the openings to measure to: 

7 Click OK.

Using Anchors to Change the Vertical Position of 
an Opening

Use this procedure to change the vertical position of openings in a wall or 
space boundary to which the openings are anchored.

If you want to . . . Then . . .

use the start of the wall as the 
reference point

under Position Along (X), select Start of 
wall for From.

use the start of the space 
boundary as the reference point

under Position Along (X), select Start of 
curve for From.

use the midpoint of the wall as 
the reference point

under Position Along (X), select Midpoint 
of wall for From.

use the midpoint of the space 
boundary as the reference point

under Position Along (X), select Midpoint 
of curve for From.

use the end of the wall as the 
reference point

under Position Along (X), select End of 
wall for From.

use the end of the space 
boundary as the reference point

under Position Along (X), select End of 
curve for From.

If you want to measure . . . Then . . .

to the start edge of the opening select Start edge of object for To.

to the center of the opening select Center of object for To.

to the end edge of the opening select End edge of object for To.
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You can also change the vertical position of the opening using the Location 
grip. For more information, see “Using Grips to Edit Openings” on 
page 1288.

Changing the vertical position of an opening

1 Select the openings you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4 Select the reference point for the anchor along the Z axis: 

If you want to . . . Then . . .

use the bottom of the wall height as 
the reference point

under Position Along (Z), select Bottom 
of wall height for From.

use the bottom of the space boundary 
height as the reference point

under Position Along (Z), select Bottom 
of curve height for From.
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5 Enter the distance from the reference point at which to place the open-
ings.

Use a negative value to measure from endpoint to start point.

6  Select the position of the openings to measure to: 

7 Click OK.

use the center of the wall height as the 
reference point

under Position Along (Z), select Center 
of wall height for From.

use the center of the space boundary 
height as the reference point

under Position Along (Z), select Center 
of curve height for From.

use the top of the wall height as the 
reference point

under Position Along (Z), select Top of 
wall height for From.

use the top of the space boundary 
height as the reference point

under Position Along (Z), select Top of 
curve height for From.

If you want to . . . Then . . .

measure to the bottom of the 
openings in wall

select Sill of object for To.

measure to the bottom of the 
openings in space boundaries

select Bottom of object for To.

measure to the center of the 
openings in walls

select Center of object for To.

measure to the center of the 
openings in space boundaries

select Center of object for To.

measure to the top of the openings 
in walls

select Head of object for To.

measure to the top of the openings 
in space boundaries

select Top of object for To.

If you want to . . . Then . . .
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Changing the Position of an Opening Within a 
Wall or Space Boundary

Use this procedure to change the horizontal position of openings within a 
wall or space boundary to which the openings are anchored.

You can also change the position of the opening within a wall or space 
boundary using the Location grip. For more information, see “Using Grips to 
Edit Openings” on page 1288.

Changing the position of an opening within a wall

1 Select the openings you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4  Select the reference point for the anchor along the Y axis: 

If you want to . . . Then . . .

use the left edge of the wall as 
your reference point

select Left edge of wall width for From.

use the left edge of the space 
boundary as your reference point

select Left edge of curve width for From.

use the center of the wall as your 
reference point

select Center of wall width for From.

use the center of the space 
boundary as your reference point

select Center of curve width for From.
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5 Enter the distance from the reference point at which to place the open-
ings.

Use a negative value to measure from endpoint to start point.

6  Select the position of the openings to measure to: 

7 Click OK.

Changing the Orientation of an Opening to a 
Wall or Space Boundary

Use this procedure to change the vertical orientation of an opening in a wall 
or space boundary to which the openings are anchored.

1 Select the openings you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4 Enter the X and Z rotation angles of the openings.

use the right edge of the wall as 
your reference point

select Right edge of wall width for From.

use the right edge of the space 
boundary as your reference point

select Right edge of curve width for From.

If you want to . . . Then . . .

measure to the front of the 
opening

select Front of object for To.

measure to the center of the 
opening

select Center of object for To.

measure to the back of the 
opening

select Back of object for To.

If you want to . . . Then . . .
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5 Indicate if you want to reverse the flip direction of the opening in the X 
and Z axes: 

6 Click OK.

Specifying the Display of Sills for an Opening

Use this procedure to change the sill dimensions for an opening in the Sill 
Plan display representation. 

You must use a display representation for an opening that has a sill. You can 
turn on the Sill Plan display representation in addition to the Plan display 
representation.

1 Right-click an existing opening, and click Edit Object Display.

2 Click the Display Properties tab.

3 Select Sill Plan for Display Representations, and select Style Override.

4 If necessary, click .

5 Click the Other tab.

Opening Sill Dimensions

6 Under Sill Dimensions, enter the sill extension and depth dimensions.

If you want to . . . Then . . .

reverse the direction of the 
opening

select Flip X.

reverse the top and bottom of 
the opening

select Flip Z.

reverse the position of the 
opening in the side of the wall

select Flip Y.
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Sill components A and B are for the outside of the opening. Sill compo-
nents C and D are for the interior side.

7 Click the Layer/Color/Linetype tab.

8 Under Visible, click the icons to turn on visibility. 

9 Click OK three times.

Changing the Location of an Opening

Use this procedure to relocate a freestanding opening by changing the coor-
dinate values of its insertion point. The opening also has an orientation with 
respect to the world coordinate system (WCS) or the current user coordinate 
system (UCS). For example, if the top and bottom of the opening are parallel 
to the XY plane, its normal is parallel to the Z axis. You can change the ori-
entation of the opening by aligning its normal with another axis. You can 
also rotate the opening on its plane by changing the rotation angle. 

1 Double-click the opening.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information.

4 Specify a new location, orientation, or rotation angle:

5 Click OK.

If you want to . . . Then . . .

relocate the opening enter new coordinate values under Insertion Point.

locate the opening on the 
XY plane

make the normal of the opening parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the opening on the 
YZ plane

make the normal of the opening parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the opening on the 
XZ plane

make the normal of the opening parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
opening

enter a new value for Rotation Angle.
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Attaching Hyperlinks, Notes, and Files to an 
Opening

Use this procedure to enter notes and attach hyperlinks or reference files to 
an opening. You can also edit reference files attached to the style.

1 Double-click the opening to which you want to attach information.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD®  2004 
Command Reference.

4 To add a note, click the setting for Notes, enter the note, and click OK.

5 Click the setting for Reference Docs.

6 Attach, edit, or detach a reference file:

7 Click OK.

Changing the Display Properties of Openings

You use the display properties of openings to control their appearance in a 
drawing. In addition, you can create custom components for openings by 
adding custom blocks to any display representation where you want the 
components to appear.

Related Topics and Procedures

� Specifying the Display Properties of an Opening

If you want to . . . Then . . .

attach a reference file
click , select a file, and click OPEN.

edit the description of a 
reference file

select the description of the file, and edit the 
description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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� Specifying the Hatching of an Opening

� Adding Components to an Opening

� Turning Off Custom Components in an Opening

� Removing Custom Components from an Opening

Specifying the Display Properties of an Opening

Use this procedure to change the properties of the following display compo-
nents of an individual opening:

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE Openings do not have material assignments.

1 Select the opening you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation in which to display changes, and select 
Object Override.

The display representation in bold is the current one.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Specifying the Hatching of an Opening

Use this procedure to specify the hatching of the components of an opening. 
Hatching is displayed only in display representations used in the Top view 
(plan view) of a drawing.

1 Select the opening you want to change, right-click, and click Edit Object 
Display.
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2 Click the Display Properties tab.

3 Select the display representation in which to display the changes.

4 Specify whether changes apply to all openings, or only to the selected 
opening:

The display representation in bold is the current one.

5 Click the Layer/Color/Linetype tab.

6 Verify that the Hatch display component is turned on.

7 Click the Hatching tab.

8 Click the setting for Pattern.

9 Select the hatching:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

If you want to . . . Then . . .

apply the hatching to all 
openings in the drawing

verify that Object Override is cleared, and click 

.

apply the hatching only to the 
selected opening select Object Override. If necessary, click .

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-Defined for Type, and clear Double 
Hatch.

select double hatching select User-Defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.
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12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is oriented:

14 Click the Fill type tab.

15 Select a graphic representation to use for hatching the opening.

Specifying hatching graphics for openings

16 Click OK twice.

Using Custom Blocks to Create Opening 
Components

You can add custom blocks for components, such as hardware, to the display 
components or to replace the default display components. You can have a 
different custom block for each display representation.

You can specify several rules for positioning and scaling the new component. 
Each custom block also appears in the display properties component list so 
that you can control its layer, color, and linetype. 

If you create a custom block from mass elements, you can use the material 
assignments of the mass elements to determine the display properties of the 
custom block.

If you want to . . . Then . . .

orient the hatching to the 
object regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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Be sure to set the properties of the objects used to create your custom blocks 
to ByBlock. Otherwise, you cannot control these objects through the display 
properties. For more information about ByBlock, see “Working with Layers 

and Properties” in the online AutoCAD® 2004 User’s Guide. 

Adding Components to an Opening

Use this procedure to add or edit custom block components in the display 
representation of openings.

1 Create a block for the component to add to the opening. 

Create the block in the same plane as the opening.

2 Select the opening you want to change, right-click, and click Edit Object 
Display.

3 Click the Display Properties tab.

4 Select the display representation in which to display the changes, and 
select Object Override.

5 If necessary, click .

6 Click the Other tab.

7 Specify whether to add or edit a block component:

8 Click Select Block.

9 Select the block to use, and click OK.

10 Specify whether you want to scale to fit the block component to the object 
by width, depth, and height, or to lock the XY ratio:

If you want to . . . Then . . .

add a new block 
component

click Add.

edit an existing block 
component

select the component to edit, and click Edit. Proceed 
to step 10.

If you want to . . . Then . . .

set the block scale to the 
width of the object

select Width.
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11 Specify whether to mirror the block in the X,Y, or Z direction:

12 Specify the X, Y, and Z location of the insertion point.

13 Specify an insertion offset of the block in the X, Y, and Z directions.

14 Click OK three times.

Turning Off Custom Components in an Opening

Use this procedure to turn off custom blocks in an opening.

You can turn off the display of component blocks without removing them 
from the opening.

1 Select the opening you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation in which to turn off the display of the 
custom component, and select Object Override.

set the block scale to the 
depth of the object

select Depth.

set the block scale to the 
height of the object

select Height.

scale the whole block 
equally, so that one 
direction is scaled to fit 
another of the scale 
criteria

select Lock XY Ratio.

scale the block to its 
original size

clear all options under Scale to Fit.

If you want to . . . Then . . .

create a mirror of the 
block in the X direction

select Mirror X.

create a mirror of the 
block in the Y direction

select Mirror Y.

create a mirror of the 
block in the Z direction

select Mirror Z.

If you want to . . . Then . . .
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4 If necessary, click .

5 Click the Other tab.

6 Select Disable Custom Blocks.

7 Click OK twice.

Removing Custom Components from an 
Opening

Use this procedure to remove components from an opening.

Removing custom blocks deletes them from the opening.

1 Select the opening you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation in which to remove the component, and 
select Object Override.

4 If necessary, click .

5 Click the Other tab.

6 Select the component to remove, and click Remove.

7 Click OK twice.
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Roofs

Roofs are AEC objects that model an entire roof 
surface. You can create roofs “on the fly” or 
select a polyline shape and place a roof on that 
shape. You can also select closed walls and place 
a roof on the walls, change the slope of a roof, 
and edit its edges and faces. 

To customize a roof, you convert it to individual 
roof slabs, offering tight control of the detail of 
the roof edges. You can customize the soffit and 
fascia of the roof slab edge as well as the angle 
and overhang of the edge.

Roof Slabs
A roof slab models a single face of a roof. Roof 
slab objects differ from roof objects because 
each slab is a separate entity with no direct con-
nection to other entities. You can use multiple 
roof slabs to model an entire roof surface, but 
the combined topology (3D geometry) of the 
roof is not calculated automatically. For this rea-
son, it is recommended that when you design 
complex roofs, you initially use the roof object. 
When the design is substantially complete, but 
more flexibility and detail are needed in the 
model, you can convert the roof to individual 
roof slabs.

While roof slabs do not dynamically interact 
with each other, they do allow significant con-
trol over the roof geometry. For example, you 
can trim roof slabs individually, extend them, 
and miter them with other slabs. You can cut 
holes in them, add or subtract mass elements, 
and apply detailed fascia and soffit profiles to 
any edge at any angle and orientation. Roof 

In this chapter

� Using Roof Tools to Create a 
Roof

� Creating a Slope Roof

� Creating a Gable Roof

� Creating a Roof from Walls or a 
Polyline

� Creating a Slope Roof with 
User-specified Settings

� Creating a Gable Roof with 
User-specified Settings

� Creating a Roof Tool

� Editing Roofs

� Creating Roof Slabs

� Using Roof Slab Tools to Create 
a Roof Slab

� Creating a Roof Slab

� Creating a Roof Slab with User-
Specified Settings

� Creating a Roof Slab Tool

� Editing Roof Slabs

� Roof Slab Styles

� Roof Slab Edge Styles

20
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slabs are also style-based, so you can apply design changes globally.

Materials in Roofs
You can assign materials to a roof. Materials are displayed in wireframe and 

working shade views, or when linked into Autodesk VIZ® Render. Materials 
have specific settings for the physical components of a roof, such as slab. For 
more information see, “Material Components and Display Properties” on 
page 498.

Viewing roofs in 2D wireframe and rendered views

Autodesk® Architectural Desktop provides predefined materials for common 
design purposes. These materials contain settings for roof components. You 
can use the predefined materials “as is,” or modify them for your designs. You 
can also create your own materials. Object styles provided with the software 
have appropriate materials already assigned to them. For more information, 
see “Roof Slab Materials and Display Components” on page 1386 and “Mate-
rial Components and Display Properties” on page 498.

Related Procedures

� Using Roof Tools to Create a Roof

� Creating a Slope Roof

� Creating a Gable Roof
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� Creating a Roof from Walls

� Creating a Roof from a Polyline

� Creating a Slope Roof with User-specified Settings

� Creating a Gable Roof with User-specified Settings

� Creating a Roof Tool

� Editing Roofs

� Creating Roof Slabs

� Roof Slab Styles

� Roof Slab Edge Styles

Using Roof Tools to Create a Roof

Tools provided with Autodesk® Architectural Desktop let you quickly place 
roofs. You can use the default settings of the tool, or you can change the set-
tings for roof properties. You can create roofs with single or double slopes and 
gable roofs. You can also use roof tools to convert linework and walls to roofs, 
and to apply the settings of a roof tool to existing roofs.

Tool palette containing roof tools
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The default tool palettes in the workspace contain sample roof tools that you 
can use and customize as necessary. In addition, the following catalogs pro-
vided with the software contain roof tools that you can add to your tool pal-
ettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� My Tool catalog

Custom palettes created by your CAD manager or other users may also con-
tain roof tools with properties customized for your projects or office stan-
dards.

Related Procedures

� Creating a Slope Roof

� Creating a Gable Roof

� Creating a Roof from Walls

� Creating a Roof from a Polyline

� Creating a Slope Roof with User-specified Settings

� Creating a Gable Roof with User-specified Settings

� Creating a Roof Tool

Creating a Slope Roof

Use this procedure to add a slope roof that has the properties specified in the 
roof tool that you select. You can create a single slope or a double slope roof 
object. To specify settings when you add a roof, see “Creating a Slope Roof 
with User-specified Settings” on page 1319.

NOTE To add additional slopes to a roof face, right-click a roof object and click 
Edit Edges/Faces.
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Creating a single slope roof

Creating a double slope roof

1 Open the tool palette that you want to use, and select a roof tool.

If necessary, scroll to display the tool that you want to use.

A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

2 On the Properties palette, select Single slope or Double slope for Shape.

3 In the drawing area, specify points for the corners of the roof.

You can move or hide the Properties palette to expose more of the drawing 
area.

4 When you are finished specifying points, press ENTER.
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Creating a Gable Roof

Use this procedure to add a gable roof that has the properties specified in the 
roof tool that you select. You can create a single sloped roof and set each edge 
to gable as needed. You can specify a slope for the gable ends to create a hip. 
To specify settings when you add a roof, see “Creating a Gable Roof with 
User-specified Settings” on page 1320.

Viewing a gable roof end

NOTE You can create a gable on an existing roof by gripping any ridge line 
point and stretching it past the roof edge.

1 Open the tool palette that you want to use, and select a roof tool.

If necessary, scroll to display the tool that you want to use.

A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

2 On the Properties palette, select Single slope for Shape.

3 In the drawing area, specify the first point for the first roof edge.

You can move or hide the Properties palette to expose more of the drawing 
area.

4 Specify the second point to complete the first sloped roof edge.

5 On the Properties palette, select Gable for Shape.

6 In the drawing area, specify the next point to create a gable roof edge.

7 Select Single slope for Shape.

8 Specify the next point to create a sloped roof edge.

9 Select Gable slope for Shape.
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10 Specify additional points as needed to define the roof, and press ENTER.

Creating a Roof from Walls

Use this procedure to convert walls or a roof that has the properties of the 
roof tool that you select. You can edit these properties after creating the roof. 
The roof takes its plate height from the top of each wall segment.

NOTE If your walls are not properly “cleaned up,” the roof conversion is 
unpredictable. For more information, see “Cleanup Group Definitions” on 
page 1826.

Creating a roof from walls

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

2 Right-click a roof tool, and click Apply Tool Properties to ➤  Linework 
and Walls.

3 Select the walls to convert, and press ENTER.
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NOTE If the walls you select are not closed, a roof is added to the top of 
each wall segment.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the roof on the Properties palette, if needed. 

Creating a Roof from a Polyline

Use this procedure to convert a two-dimensional (2D) polyline to a roof that 
has the properties of the roof tool you select. You can edit these properties 
after creating the roof.

Creating a roof from a polyline

1 Draw a closed 2D polyline in the shape of the intended roof, in the loca-

tion where you want to place the roof.

2 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

3 Right-click a roof tool, and click Apply Tool Properties to ➤  Linework 
and Walls.

4 Select the polyline to convert, and press ENTER.
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5 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

6 Edit the properties of the roof on the Properties palette, if needed. 

Creating a Slope Roof with User-specified 
Settings

Use this procedure to add a slope roof with settings that you specify. You can 
create a single slope or a double slope roof object.

Creating a single slope roof

Creating a double slope roof

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a roof tool.
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If necessary, scroll to display the tool that you want to use.

A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

2 On the Properties palette, expand Basic, and expand Next Edge.

3 Select Single slope or Double slope for Shape.

4 Enter a value for Overhang.

5 Expand Lower Slope, and enter values for Plate Height, Rise, and Slope.

Plate height is the height of the bottom surface of the roof at its lowest 
edge (where the overhang begins). This is usually the height of the top 
plate of the wall that the roof sits on.

6 For a double slope roof, expand Upper Slope, and enter values for Upper 
Height, Rise, and Slope.

7 In the drawing area, specify points for the corners of the roof.

You can move or hide the Properties palette to expose more of the draw-
ing.

8 When you are finished specifying points, press ENTER.

Creating a Gable Roof with User-specified 
Settings

Use this procedure to add a gable roof with settings that you specify. You cre-
ate a single sloped roof and set each edge to gable as needed. You can specify 
a slope for the gable ends to create a hip.
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TIP You can create a gable on an existing roof by gripping any ridge line point 
and stretching it past the roof edge.

Viewing a gable roof end

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a roof tool.

If necessary, scroll to display the tool that you want to use.

A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

2 On the Properties palette, expand Basic, and expand Next Edge.

3 Select Single slope for Shape.

4 In the drawing area, specify the first point for the first roof edge.

You can move or hide the Properties palette to expose more of the drawing 
area.

5 Specify the second point to complete the first sloped roof edge.

6 On the Properties palette, select Gable for Shape.

7 In the drawing area, specify the next point to create a gable roof edge.

8 Select Single slope for Shape.

9 Specify the next point to create a sloped roof edge.

10 Select Gable slope for Shape.

11 Specify additional points as needed to define the roof, and press ENTER.
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Creating a Roof Tool

Use this procedure to create a roof tool and add it to a tool palette. You may 
want to create your own roof tools if you are placing multiple roofs that have 
the same properties.

For example, you are creating an office building that has a multi-peaked roof. 
Although the entire roof is single sloped, each peak has a different slope. To 
work efficiently, you can create a roof tool for each slope, and select the 
appropriate tool to place the roofs with the correct slope on each area of the 
building.

1 Open the tool palette on which to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the roof created 
from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

If you want to . . . Then . . .

create a tool from a roof in the drawing select the object, and drag it to the tool 
palette.

copy a tool in the current tool palette right-click the tool, and click Copy. 
Right-click, and click Paste.

copy a tool from another tool palette open the other tool palette. Press 
CTRL, and drag the tool you want to 
copy to the tool palette.

copy a tool from the Content Browser open the Content Browser and locate 
the tool you want to copy. Position the 
cursor over the i-drop handle, and drag 
the tool to the tool palette.
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9 Specify roof settings:

10 Click OK.

Editing Roofs

After placing roofs, you can edit any characteristics of the roof that you spec-
ified when you drew the roof. You can change the basic geometry of a roof, 
apply a different roof shape, and change the roof edge or overhang condi-
tions. 

Autodesk® Architectural Desktop offers several methods for editing roofs:

� Edit roofs directly using grips for dimensions and other physical charac-
teristics.

� Change roof settings on the Properties palette.
� Select editing commands from the shortcut menu for a selected roof.

Related Procedures

� Using Grips to Edit Roofs

If you want to . . . Then . . .

change the thickness value expand Dimensions, and enter a value 
for Thickness.

change the type of edge expand Dimensions, and select a new 
setting for Edge cut.

change the roof shape expand Next Edge, and select a new 
setting for Shape.

add or remove the overhang, or 
change the overhang value

expand Next Edge, and enter a value 
for Overhang.

change the plate height expand Lower Slope, and enter a value 
for Plate Height.

change the upper height for a double 
slope roof

expand Upper Slope, and enter a value 
for Upper Height.

change the rise or slope angle for each 
slope

expand Lower Slope, or Upper Slope for 
a double slope roof, and enter a value 
for Rise or Slope.
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� Applying Tool Properties to an Existing Roof

� Changing the Dimensions of a Roof

� Changing the Edges and Faces of a Roof

� Converting a Roof to Roof Slabs

� Specifying the Material of a Roof

� Specifying the Display Properties of a Roof

� Specifying the Hatching of a Roof

� Changing the Location of a Roof

� Attaching Hyperlinks, Notes, or Files to a Roof

Using Grips to Edit Roofs

Refer to the illustrations and steps in this topic to use roof grips to edit roofs.

Editing Roof Dimensions

1 Select the roof.

2 Select the grip for the dimension you want to change.

Roof grips

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Applying Tool Properties to an Existing Roof

Use this procedure to apply the properties of a roof tool to one or more roofs. 
The properties include any settings specified in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.
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A roof tool is located within the Architectural Object Tools Catalog. You 
can add this tool to any tool palette. For more information, see “Content 
Browser” on page 171.

2 Right-click a roof tool, and click Apply Tool Properties to ➤ Roof.

3 Select the roof, and press ENTER.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the roof on the Properties palette, if necessary.

Changing the Dimensions of a Roof

Use this procedure to change the dimensions of a roof, including the plate 
height, the upper height for a double slope (gambrel) roof, the slope, and the 
depth of the overhang. You can also change the thickness of the roof slabs 
and the type of roof edge.

NOTE You can create a gable end on a roof by gripping any ridge line point 
and stretching it past the roof edge.

1 Select the roof.

2 On the Properties palette, specify roof settings:

If you want to . . . Then . . .

change the thickness value under Dimensions, enter a value for 
Thickness.

change the type of edge under Dimensions, select a new setting 
for Edge cut.

change the number of slopes under Dimensions, select a new setting 
for Shape.

add or remove the overhang, or 
change the overhang value

under Dimensions, enter a value for 
Overhang.

change the plate height under Lower Slope, enter a value for 
Plate Height.

change the upper height for a double 
slope roof

under Upper Slope, enter a value for 
Upper Height.
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Changing the Edges and Faces of a Roof

Use this procedure to edit the edges and faces of a roof. You can edit:

� the height and overhang of individual edges
� the number of segments and the radius for curved segments
� the height and slope of individual roof faces

1 Select the roof you want to change, right-click, and click Edit Edges/Faces.

2 Select roof edges that you want to change and press ENTER.

As you select edges, they are numbered consecutively, beginning with 
zero, for display in the dialog box.

3 Specify new values for each roof edge:

change the rise or slope angle for each 
slope

under Lower Slope, or Upper Slope for a 
double slope roof, enter a value for Rise 
or Slope.

If you want to . . . Then . . .

change the height of a roof 
edge

select Height for the roof edge, and enter the height 
value.

If you want to . . . Then . . .
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4 Specify new dimensions for the roof faces of the selected edges:

5 Click OK.

Converting a Roof to Roof Slabs

Use this procedure to convert a roof to roof slabs. Roof slabs are beneficial 
when you need additional flexibility and detail. Roof slab objects differ from 
roof objects because each slab is a separate entity, defined by its perimeter, 
edge conditions, and style. Roof slabs are also style based, so you can apply 
design changes globally.

For more information about working with roof slabs, see “Creating Roof 
Slabs” on page 1332.

1 Select the roof you want to convert, right-click, and click Convert to Roof 
Slabs.

2 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

change the overhang of a 
roof edge

select Overhang for the roof edge, and enter the 
overhang value.

change the number of 
segments in a curved roof 
for a roof edge

select Segments for the roof edge, and enter the 
number of segments.

change the radius of the 
curved roof edge

select Radius for the roof edge, and enter the radius.

If you want to . . . Then . . .

change the height of a roof 
face

select Height for the roof face, and enter the height 
value.

change the slope of a roof 
face

select Slope for the roof face, and enter the slope 
value.

add a face to the selected 
edge

click the blank space under the last number in the 
Face column, and enter values for Height and Slope.

remove a roof face select the Face column number, and press DELETE.

If you want to . . . Then . . .



1328 | Chapter 20 Roofs

3 When prompted to specify a roof slab style name, press ENTER to specify 
the Standard style, or enter a style name.

Enter ? for a list of defined roof slab styles in the drawing.

4 Edit the properties of the roof on the Properties palette, if necessary.

Specifying the Material of a Roof

Use this procedure to select a different material for the components of an 
individual roof.

NOTE If a material assignment does not determine the display properties of 
the roof component, you can change the properties of the display component 
as described in “Specifying the Display Properties of a Roof” on page 1328.

1 Select the roof you want to change, right-click, and click Edit Object Dis-
play.

2 To verify that the material assignment determines the display properties 
of the component, click the Display Properties tab, select the display rep-

resentation in which to display the changes, and click .

3 Click the Layer/Color/Linetype tab, verify that By Material is selected for 
the component, and click OK.

4 Click the Materials tab.

5 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, 

or click  to create a new one and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make apply to all objects that are assigned the material.

6 Click OK.

Specifying the Display Properties of a Roof

Use this procedure to change the following properties of the display compo-
nents of an individual roof:

� Visibility (display component is on or off)
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� By material (material assigned to the display component determines its 
display properties)

� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the properties of a roof display 
component, you can change the properties of the display component by clear-
ing By Material or by overriding the material assignment with a different mate-
rial. For more information, see “Specifying the Material of a Roof” on page 1328.

1 Select the roof you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation in which to display the changes, and 
select Object Override.

The display representation in bold is the current one.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Specifying the Hatching of a Roof 

Use this procedure to specify the hatching of the components of an individ-
ual roof. Hatching is displayed only in the section display representation.

NOTE If a material assignment determines the hatching properties of a roof 
display component, you can change the hatching of the display component by 
clearing By Material or by overriding the material assignment with a different 
material. For more information, see “Specifying the Material of a Roof” on 
page 1328.

1 Select the roof you want to change, right-click, and click Edit Object Dis-
play.
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2 Click the Display Properties tab.

3 Select the Section display representation, and select Style Override.

4 If necessary, click .

5 Click the Hatching tab.

6 Select the display component, and click the setting for Pattern.

7 Select the hatching for the display component:

8 Click OK.

9 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

10 Click Angle, and enter the angle for the selected pattern.

11 Click Orientation, and specify how the hatching is oriented:

12 Click X Offset and Y Offset, and enter offset values.

13 Click OK twice.

If you want to . . . Then . . .

specify a hatching pattern that 
is available in the software

select Predefined for Type, and select a 
pattern.

specify a custom pattern select Custom for Type, and enter the name of 
the custom pattern. If necessary, click Browse, 
and navigate to the folder that contains the 
custom pattern file.

specify single hatching select User-Defined for Type, and clear Double 
Hatch.

specify double hatching select User-Defined for Type, and select 
Double Hatch.

specify solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the roof 
slab, regardless of the roof slab 
rotation

select Object.

orient the hatching to the world 
coordinate system

select Global.
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Changing the Location of a Roof

Use this procedure to relocate a roof by changing the coordinate values of its 
insertion point. The roof also has an orientation with respect to the world 
coordinate system (WCS) or the current user coordinate system (UCS). For 
example, if the top and bottom of the roof are parallel to the XY plane, its 
normal is parallel to the Z axis. You can change the orientation of the roof 
by aligning its normal with another axis. You can also rotate the roof on its 
plane by changing the rotation angle.

For information about the WCS and UCS, see “Use Coordinates and Coordi-
nate Systems” in the online AutoCAD 2004 User’s Guide.

1 Select the roof you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the roof:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Roof

Use this procedure to attach hyperlinks, notes, or files to a roof. You can also 
edit hyperlinks and notes, and edit or detach reference files from a roof.

1 Select the roof to which you want to attach information.

2 On the Properties palette, click the Extended Data tab.

If you want to . . . Then . . .

relocate the roof enter new coordinate values under Insertion Point.

locate the roof on the XY 
plane

make the normal of the roof parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the roof on the YZ 
plane

make the normal of the roof parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the roof on the XZ 
plane

make the normal of the roof parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
roof

enter a new value for Rotation Angle.



1332 | Chapter 20 Roofs

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK twice.

Creating Roof Slabs

A roof slab models a single face of a roof. A slab is a three-dimensional (3D) 
body, bounded by a planar polygon (perimeter), of any shape, and with mul-
tiple edges. Each roof slab is defined by its perimeter, edge conditions, and 
style.

Roof slab objects differ from roof objects because each slab is a separate entity 
with no direct connection to other entities. You can use multiple roof slabs 
to model an entire roof surface, but the combined topology (3D geometry) of 
the roof is not calculated automatically. For this reason, it is recommended 
that when you design complex roofs, you initially use the roof object. When 
the design is substantially complete, but more flexibility and detail are 
needed in the model, you can convert the roof to individual roof slabs.

While roof slabs do not dynamically interact with each other, they do allow 
significant control over the roof geometry. For example, you can trim roof 
slabs individually, extend them, and miter them with other slabs. You can cut 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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holes in them, add or subtract mass elements, and apply detailed fascia and 
soffit profiles to any edge at any angle and orientation. Roof slabs are also 
style based, so you can apply design changes globally.

Methods of Creating Roof Slabs
You can create roof slabs independently, convert them from existing roofs, or 
create them from existing objects such as walls and polylines. Roof slabs cre-
ated from roofs do not maintain a link to the original roof object, but roof 
slabs give you greater control over their geometry and detail.

Pitched roofs are usually designed by specifying a plate line and a slope angle. 
Roof slabs are designed so that you can use the same approach in laying them 
out. To add a roof slab, you simply specify two points and an angle.

If you have a traditionally designed roof created from a two-dimensional 
(2D) plan showing ridge, hip, and valley lines, you can simply “trace” over 
that plan with roof slabs, specifying the desired height and slope. From these 
values and the specified points, the software creates the correct three-dimen-
sional (3D) model.

Roof Slab Body
The body of a roof slab is an extrusion perpendicular to the plane of the 
perimeter and is defined by the following geometry:

� The perimeter of a roof slab is a planar polygon defined by the X,Y,Z coor-
dinates of its vertices. 

� A roof slab has three or more vertices, with the ability to add or remove ver-
tices. Each pair of vertices defines an edge. 

� The thickness of a roof slab extrusion is specified either in the roof slab 
style, when it has a fixed thickness, or for each roof slab. 

� The position of the slab bottom, relative to its perimeter plane, is con-
trolled by the thickness offset value in the roof slab style. 

� The baseline of a roof slab is defined by the first two points you select when 
defining the roof slab vertices.

� The roof slab insertion point, by default, is the first point on the baseline. 
You can offset the baseline either horizontally or vertically from the inser-
tion point to allow for precise alignment with walls or structural elements.

� A roof slab has a slope (pitch), which you can specify either as an angle or 
as a rise-to-run ratio. If you change the slope, the roof slab rotates around 
the slope pivot point. 

� The pivot point is initially the first vertex of the baseline, but you can move 
it to any other point, either on or off the slab. A small pyramid-shaped 
marker represents the pivot point.

� An imaginary line passing through a roof slab at the perimeter line (in sec-
tion) is called the slopeline. The slopeline aligns the roof slab with the wall 
base height. The slopeline is the position of the roof slab baseline relative 
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to its bottom face. The value you enter for the thickness offset in the roof 
slab style determines the distance between the roof slab baseline and the 
bottom face of the slab.

The following illustration shows a roof slab.

Geometry of a roof slab 

Roof Slab Edge
The following parameters define a roof slab edge:

� orientation (plumb or square)
� angle (relative to the orientation)
� edge style (fascia and soffit)
� overhang (defines the point at which the fascia begins)

You apply fascia and soffits to roof slab edges through roof slab edge styles:
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� The fascia is defined by a profile, with its insertion point located at the top 
of the roof slab edge. The local Y axis of the profile polyline aligns with 
the roof slab edge angle.

� The soffit is also defined by a profile, with its insertion point positioned at 
the X and Y offsets from the fascia insertion point.

Viewing roof slab fascia and soffit components

Edge Control
You can customize each roof slab edge individually, applying styles and mak-
ing other adjustments as required by your design. A roof slab edge style 
defines the fascia and soffit design from profiles that you create for these 
components. You can specify whether the style uses a fascia, a soffit, both, or 
neither. You also specify how the fascia and soffit are positioned relative to 
the roof slab.

Roof Slab Styles
Roof slabs are style based. Use roof slab styles to create default properties for 
dimensions, edge styles for fascias and soffits, and entity properties for layer, 
color, and linetype. Roof slab styles allow you to use a different style for each 
edge of the roof and to apply design changes globally. For example, you can 
update all roof edges of the same style with a different fascia.

Materials in Roof Slabs
You can assign materials to a roof slab. Materials are displayed in wireframe 

and working shade views, or when linked into VIZ® Render. Materials have 
specific settings for the physical components of a roof slab, such as fascia and 
soffits.
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Viewing roof slab in 2D wireframe and rendered views

Autodesk® Architectural Desktop provides predefined materials for common 
design purposes. These materials contain settings for roof slab components. 
You can use the predefined materials “as is”, or modify them for your designs. 
You can also create your own materials. Object styles provided with the soft-
ware have appropriate materials already assigned to them. For more informa-
tion, see “Roof Slab Materials and Display Components” on page 1386 and 
“Roof Slab Edge Materials and Display Components” on page 1405.

Editing Roof Slabs
In addition to the control that roof slab styles and roof edge styles provide, 
roof slab tools let you edit roof slabs to fit unique conditions. You can add 
holes to roof slabs for structures such as chimneys and vent pipes. You can 
also use roof slabs to create dormers. 

Related Procedures

� Using Roof Slab Tools to Create a Roof Slab

� Creating a Roof Slab

� Creating a Roof Slab from a Roof

� Creating a Roof Slab from Walls

� Creating a Roof Slab from a Polyline

� Creating a Roof Slab with User-Specified Settings

� Creating a Roof Slab Tool

� Editing Roof Slabs

� Roof Slab Styles

� Roof Slab Edge Styles
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Using Roof Slab Tools to Create a Roof Slab

Tools provided with Autodesk® Architectural Desktop let you quickly place 
roof slabs. You can use the default settings of the tool, or you can change the 
settings for roof slab properties. You can also use roof slab tools to convert 
linework, walls, and roofs to roof slabs, and to apply the settings of a roof slab 
tool to existing roof slabs.

Tool palette containing roof slab tools

The default tool palettes in the workspace contain sample roof slab tools that 
you can use and customize as necessary. In addition, the following catalogs 
provided with the software contain roof tools that you can add to your tool 
palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� My Tool catalog

Custom palettes created by your CAD manager or other users may also con-
tain roof slab tools with styles and properties customized for your projects or 
office standards.
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Related Procedures

� Using Roof Slab Tools to Create a Roof Slab

� Creating a Roof Slab

� Creating a Roof Slab from a Roof

� Creating a Roof Slab from Walls

� Creating a Roof Slab from a Polyline

� Creating a Roof Slab with User-Specified Settings

� Creating a Roof Slab Tool

Creating a Roof Slab

Use this procedure to add a roof slab that has the properties specified in the 
roof slab tool that you select. To specify settings when you add a roof slab, 
see “Creating a Roof Slab with User-Specified Settings” on page 1345.

You add the roof slab by specifying points to define the perimeter of a roof 
slab 

� The first point determines the insertion point of the slab and locates the 
default pivot point.

� The second point determines the endpoint of the roof slab baseline. 
� Subsequent points establish the vertices of the roof slab perimeter. 

The baseline is always the first edge of the slab perimeter.
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Creating a roof slab

1 Open the tool palette that you want to use, and select a roof slab tool.

If necessary, scroll to display the tool that you want to use.

A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

2 Specify points to define the perimeter of the roof slab.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 When you have finished specifying points, press ENTER.

Creating a Roof Slab from a Roof

Use this procedure to convert a roof to individual roof slabs that have the 
properties of the roof slab tool you select. You can edit these properties after 
creating the roof slabs. You can also edit the edges of the slabs to add a fascia 
and soffit.
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When you convert a roof, multiple roof slabs are created. These slabs repro-
duce the original roof as closely as possible, using the properties of the roof 
slab tool you select.

Converting a roof to roof slabs

TIP To create roof slabs with the same overhang as the roof, use a roof slab tool 
defined with a roof slab edge style that has the same default overhang as the 
roof.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

2 Right-click a roof slab tool, and click Apply Tool Properties 
to ➤ Linework, Walls and Roof.

3 Select the roof to convert, and press ENTER.

4 When prompted to erase the original geometry, press ENTER to keep the 
existing roof, or enter y (Yes) to erase it.

5 Edit the properties of the roof slabs on the Properties palette, if needed.

Creating a Roof Slab from Walls

Use this procedure to convert one or more walls to a roof slab that has the 
properties of the roof slab tool you select. You can edit these properties after 
creating the roof slab.
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When creating a roof slab from a single wall, the baseline edge of the roof 
slab is defined as the base height of the wall. When creating a roof slab from 
multiple walls, the baseline edge is defined by the top of the first selected 
wall. 

TIP Use this conversion command to place roof slabs on top of existing walls. 
The Convert to Roof Slabs command, accessed by right-clicking an existing roof 
object, is useful when you want a specific alignment between the slab baseline 
and the wall baseline.

Creating a roof slab from a wall

NOTE When selecting multiple walls, if your walls are not properly “cleaned 
up,” the roof slab conversion is unpredictable. For more information, see 
“Cleanup Group Definitions” on page 1826.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

2 Right-click a roof slab tool, and click Apply Tool Properties 
to ➤ Linework, Walls and Roof.

3 Select the walls you want to convert, and press ENTER.
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NOTE When selecting multiple walls, if the walls are not closed, a roof slab 
is added to the top of each wall segment.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Specify a justification method:

NOTE This justification is used only for the insertion of a roof slab. It is not 
retained as a setting of the roof slab object.

The slopeline is the position of the slab baseline relative to its bottom face. 
The thickness offset in the slab style determines the distance between the 
slab baseline and the bottom face of the slab.

6 Specify the justification for edge alignment:

If you want to . . . Then . . .

align the top of the slab with the wall base 
height

enter t (Top), and press ENTER.

align the center of the slab with the wall 
base height

enter c (Center), and press 
ENTER.

align the bottom of the slab with the wall 
base height

enter b (Bottom), and press 
ENTER.

align the slopeline of the slab with the wall 
base height

enter s (Slopeline), and press 
ENTER.

If you want to . . . Then . . .

align the baseline edge of the roof slab to 
the left side of the wall, based on the 
direction the wall was drawn

enter l (Left), and press ENTER.

align the baseline edge of the roof slab to 
the center of the wall

enter c (Center), and press 
ENTER.

align the baseline edge of the roof slab to 
the right side of the wall, based on the 
direction the wall was drawn

enter r (Right), and press ENTER.
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7 When prompted to specify the slope direction, press ENTER for left, or 
enter r (Right) for right.

This is based on the direction the wall was drawn.

8 Edit the properties of the roof slabs on the Properties palette, if necessary.

Creating a Roof Slab from a Polyline

Use this procedure to convert a two-dimensional (2D) polyline to a roof slab 
that has the properties of the roof slab tool you select. You can edit these 
properties after creating the roof slab. The first line drawn in the polyline 
becomes the baseline edge of the roof slab. 

Converting a polyline to a roof slab is useful when you need to create a com-
plex roof slab, or a roof slab with curved edges.

The smoothness (tessellation) of curved edges is controlled by the FACET-
DEV variable. For more information about FACETDEV, see “AEC Facet Devi-
ation” on page 1409.

1 Draw a closed 2D polyline in the shape of the intended roof slab, in the 
location where you want to place the roof slab.

2 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

3 Right-click a roof slab tool, and click Apply Tool Properties 
to ➤ Linework, Walls and Roof.

4 Select the polyline you want to convert, and press ENTER.

5 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

6 Specify a mode:

If you enter d (Direct), the polyline vertices become the vertices of the roof 
slab perimeter. Any slope value for the roof slab is ignored.

align the baseline edge of the roof slab to 
the baseline of the wall

enter b (Baseline), and press 
ENTER.

If you want to . . . Then . . .
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Converting a polyline to a roof slab using direct mode

If you enter p (Projected), you are prompted for the base height of the roof 
slab. The X,Y coordinates of the first polyline vertex are projected to a Z 
value of the base height. This establishes the insertion point. The offset 
values determine the start point of the baseline.

Converting a polyline to a roof slab using projected mode

7 Enter a value for Base Height. 

This is available only if you selected Projected mode.
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8 Specify a justification method:

NOTE This justification is used only for the insertion of a roof slab. It is not 
retained as a parameter of the roof slab object.

The slopeline is the position of the slab baseline relative to its bottom face. 
The thickness offset in the slab style determines the distance between the 
slab baseline and the bottom face of the slab.

9 Edit the properties of the roof slab on the Properties palette, if necessary.

Creating a Roof Slab with User-Specified 
Settings

Use this procedure to add a roof slab with settings that you specify. You can 
create a flat roof slab that follows the outline of multiple walls by specifying 
a zero slope. If you select multiple walls and a non-zero slope, multiple roof 
slabs are created.

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a roof slab tool.

If necessary, scroll to display the tool that you want to use.

If you want to . . . Then . . .

align the slab top with the polyline (or 
base height, when using projected mode)

enter t (Top), and press ENTER.

align the slab center with the polyline (or 
base height, when using projected mode)

enter c (Center), and press ENTER.

align the slab bottom with the polyline 
(or base height, when using projected 
mode)

enter b (Bottom), and press ENTER.

align the slab slopeline with the polyline 
(or base height, when using projected 
mode)

enter s (Slopeline), and press ENTER.
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A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

2 On the Properties palette, expand Basic, and expand General.

3 Select a roof slab style.

4 Select Projected or Direct for Mode.

If you select Projected, the X,Y coordinates of the first point are projected 
to a Z value of the current base height. This establishes the insertion point. 
The second point establishes the baseline. All subsequent points are pro-
jected to a plane established by the baseline and the specified slope angle. 
This mode is provided for architects who wish to lay out a roof by tracing 
over a plan drawing.

If you select Direct, the points specified become the vertices of the roof 
slab perimeter.

Adding a roof slab using direct mode

5 Expand Dimensions.

6 Enter a value for Thickness.

7 Enter a value for the vertical offset distance from the insertion point for 
Vertical Offset.

8 Enter a value for the horizontal offset distance from the insertion point for 
Horizontal Offset.

9 Select the justification:

If you want to . . . Then . . .

align the top of the added roof slab with 
the first specified point

select Top.
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NOTE This justification is used only for inserting a roof slab. It is not 
retained as a setting of the roof slab. Justification is intended primarily for 
Direct mode.

The slopeline is the position of the roof slab baseline relative to its bottom 
face. The thickness offset in the slab style determines the distance between 
the slab baseline and the bottom face of the slab.

10 Enter a value for the height of the roof slab insertion point for Base 
Height. 

This is available only when you select Projected mode.

11 Select a direction to specify how the slab is drawn relative to the baseline.

12 Enter a value for the depth of the overhang for Overhang.

13 Select a style for Baseline edge.

14 Select a style for Perimeter edge.

15 Expand Slope, and enter values for Rise, Run, and Angle.

This is available only when you select Projected mode.

16 In the drawing area, specify a point for the start point of the roof slab.

You can move or hide the Properties palette to expose more of the drawing 
area.

17 Specify a second point for the first edge (baseline) of the roof slab.

align the center of the added roof slab with 
the first specified point 

select Center.

align the bottom of the added roof slab 
with the first specified point

select Bottom.

align the slopeline of the added roof slab 
with the first specified point

select Slopeline.

If you want to . . . Then . . .
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18 Specify further points to define the roof slab:

For more information, see “Ortho Close and Close” on page 1408.

19 Continue adding roof slabs, and press ENTER.

Creating a Roof Slab Tool

Use this procedure to create a roof slab tool and add it to a tool palette. You 
may want to create your own roof slab tools if you are placing multiple roof 
slabs of specific styles that have the same properties.

For example, you are creating an office building that has a complex roof sys-
tem. Although all sections of pitched roof use the same roof slab and edge 
style, each roof slab has a different slope. To work efficiently, you can create 
a roof slab tool for each slope, and select the appropriate tool to place the 
roof slabs with the correct slope for each section of the roof.

1 Open the tool palette on which to create a tool.

2 Create the tool:

If you want to . . . Then . . .

close the roof slab by 
drawing two edges that 
meet at a right angle

click Ortho Close, and then specify a point in the 
direction you want the roof slab to close. The edge is 
extended until it meets a roof slab edge 
perpendicular to the first roof slab edge.

close the slab by adding 
an edge from the 
previous point to the 
start point of the slab

enter Close.

If you want to . . . Then . . .

create a tool from a roof slab in the 
drawing

select the object, and drag it to the tool 
palette.

copy a tool from a roof slab style in the 
Style Manager

on the Format menu, click Style 
Manager. Locate the style you want to 
copy, and drag it to the tool palette. 
Click OK to close the Style Manager.

copy a tool in the current tool palette right-click the tool, and click Copy. 
Right-click, and click Paste.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the roof slab cre-
ated from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a roof slab style.

10 Select the drawing file containing the style used for this roof slab.

11 Select Projected or Direct for Mode.

If you select Projected, the X,Y coordinates of the first point are projected 
to a Z value of the current base height. This establishes the insertion point. 
The second point establishes the baseline. All subsequent points are pro-
jected to a plane established by the baseline and the specified slope angle. 
This mode is provided for architects who wish to lay out a roof by tracing 
over a plan drawing.

If you select Direct, the points specified become the vertices of the roof 
slab perimeter.

12 Expand Dimensions, and specify roof slab settings:

copy a tool from another tool palette right-click the tool, and click Copy. 
Open the other palette, and click Paste. 

copy a tool from a tool catalog open the catalog in the Content 
Browser and locate the tool you want to 
copy. Position the cursor over the i-drop 
handle, and drag the tool to the tool 
palette.

If you want to . . . Then . . .

change the thickness value enter a value for Thickness.

change the offset in the vertical 
direction

enter a value for Vertical offset.

change the offset in the horizontal 
direction

enter a value for Horizontal offset.

If you want to . . . Then . . .
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13 Click OK.

Editing Roof Slabs

After placing roof slabs, you can edit any characteristics of the roof slab that 
you specified when you drew the roof slab. You can trim, extend, miter, and 
cut roof slabs into the shape you need. You can use other editing functions, 
such as adding a vertex, adding a hole, adding a dormer, or adding objects to 
the roof slab. You can change the style, dimensions, edge properties and loca-
tion of the roof slab. You can also edit each roof slab edge individually.

Autodesk® Architectural Desktop offers several methods for editing roof slabs:

� Edit roof slabs directly using grips for dimensions and other physical char-
acteristics.

� Change roof slab settings on the Properties palette.

change the justification method select a method for Justify.

Justification is intended primarily for 
Direct Mode.

change the height of the roof slab 
insertion point

enter a value for Base height.

This is available only when you select 
Projected mode.

change the direction that the slab is 
drawn relative to the baseline

select Left or Right for Direction.

add or remove the overhang, or 
change the overhang value

enter a value for the depth of the 
overhang for Overhang.

change the baseline edge style select a style for Baseline edge.

change the perimeter edge style select a style for Perimeter edge.

change the location of the edge style select a drawing that contains the edge 
style.

change the slope enter values for Rise, Run, or Angle.

These values are available only when 
you select Projected mode.

If you want to . . . Then . . .
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� Select editing commands from the shortcut menu for a selected roof slab.

Related Procedures

� Using Grips to Edit Roof Slabs

� Applying Tool Properties to an Existing Roof Slab

� Changing the Thickness and Offsets of a Roof Slab

� Changing the Slope of a Roof Slab

� Changing the Style of a Roof Slab

� Changing the Edges of a Roof Slab

� Trimming a Roof Slab

� Extending a Roof Slab

� Mitering Roof Slabs by Intersection

� Mitering Roof Slabs Using Edges

� Cutting a Roof Slab

� Adding a Vertex to a Roof Slab

� Deleting a Vertex from a Roof Slab

� Adding a Hole to a Roof Slab

� Removing a Hole from a Roof Slab

� Creating a Clipped Gable Roof

� Adding Objects to a Roof Slab (Boolean)

� Subtracting Objects from a Roof Slab (Boolean)

� Removing Objects from a Roof Slab (Boolean)

� Creating a Dormer in a Roof Slab

� Specifying the Material of a Roof Slab

� Specifying the Display Properties of a Roof Slab

� Specifying the Hatching of a Roof Slab

� Specifying the Cut Plane Height of a Roof Slab

� Changing the Location of a Roof Slab

� Attaching Hyperlinks, Notes, or Files to a Roof Slab

Using Grips to Edit Roof Slabs

Refer to the illustrations and steps in this topic to use roof slab grips to edit 
roof slabs. Additional grips are available depending on the view direction. For 
example, in a three-dimensional (3D) isometric view, grips are available for 
editing the roof angle, vertical and horizontal offsets, and the roof thickness.

Normal grip editing of roof slabs maintains the slope angle of the slab regard-
less of the Z value of the specified point.
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NOTE The pivot point is unaffected by editing the roof slab edges with grips.

Editing Roof Slab Dimensions

1 Select the roof slab.

2 Select an Edge grip for the dimension you want to change.

Viewing Roof Slab Edge and Vertex Grips

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

When you select and grip edit an edge grip of a roof slab, moving the grip 
point maintains the plane and the angles of the adjacent sides of the roof 
slab.

Changing the Location or Position of a Roof Slab

1 Select the roof slab.

2 Press SHIFT and select two or more Vertex grips.
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3 Select a highlighted grips, move the grip to change the location of the roof 
slab, and click once.

After selecting a grip, you can also enter a value for the total distance to 
move the roof slab.

Changing the Location or Position of the Pivot Point

1 Select the roof slab.

2 Select the Pivot Point grip.

Viewing Roof Slab Pivot point, Horizontal and Vertical Offset, and Angle grips

3 Move the grip to change the location, or enter X, Y, and Z values.

If you specified Yes for Hold Fascia Elevation on the Properties palette, the 
pivot point is ignored. 

Creating Roof Slab Edges

1 Select the roof slab.

2 Press CTRL and select an Edge grip.
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 Editing a Roof Slab with its Edge grip

3 Move the grip to accommodate the new edges, and click once, or enter a 
value.

Changing the Overhang of Roof Slab Edges

1 Select the roof slab.
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Viewing Roof Slab Edge Overhang grips

2 Select an Edge Overhang grip for the edge you want to change.



1356 | Chapter 20 Roofs

Editing a Roof Slab with its Edge Overhang grips

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Changing the Slope of a Roof Slab

1 Select the roof slab.

IMPORTANT The Angle grip is available only when you select a roof slab 
in a 3D isometric view.

2 Select the Angle grip you want to change.
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Editing a Roof Slab slope with its Angle grip

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.
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Changing the Vertical or Horizontal Offset of a Roof Slab

1 Select the roof slab.

IMPORTANT The Vertical Offset and Horizontal Offset grips are available 
only when you select a roof slab in a 3D isometric view.

2 Select the Vertical Offset or Horizontal Offset grip you want to change.

Editing a Roof Slab with its Horizontal Offset grip
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Editing a Roof Slab with its Vertical Offset grip

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Changing the Thickness of a Roof Slab

1 Select the roof slab.

IMPORTANT The Thickness grip is available only when you select a roof 
slab in a 3D isometric view.

2 Select the Thickness grip you want to change.



1360 | Chapter 20 Roofs

Editing a Roof Slab with its Thickness grip

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Applying Tool Properties to an Existing Roof Slab

Use this procedure to apply the properties of a roof slab tool to one or more 
roof slabs. The properties include the roof slab style and any other settings 
specified in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.
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2 Right-click a roof slab tool, and click Apply Tool Properties to ➤ Roof 
Slab.

3 Select the roof slab, and press ENTER.

4 Edit the properties of the roof slab on the Properties palette, if necessary.

Changing the Thickness and Offsets of a Roof 
Slab

Use this procedure to change the thickness and the vertical and horizontal 
offsets of a roof slab. The offsets are the vertical and horizontal distances 
from the insertion point of the roof slab. 

1 Select the roof slab you want to change.

2 On the Properties palette, expand Basic, and expand Dimensions.

3 Specify the thickness and offsets of the roof slab:

Changing the Slope of a Roof Slab

Use this procedure to change the slope of a roof slab by changing the rise, 
run, or angle values. You can control the alignment of the fascia and the loca-
tion of the pivot point when changing the slope of a roof slab.

1 Select the roof slab you want to change.

2 On the Properties palette, expand Basic, and expand Dimensions.

3 Enter values for Rise, Run, or Angle to define the slope.

If you want to . . . Then . . .

change the thickness of the 
roof slab

enter a value for Thickness.

change the vertical distance 
from the roof slab insertion 
point

enter a value for Vertical Offset.

change the horizontal distance 
from the roof slab insertion 
point

enter a value for Horizontal Offset.
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4 Specify a fascia elevation:

5 Specify a pivot point location:

Changing the Style of a Roof Slab

Use this procedure to change the style of a roof slab.

1 Select a roof slab.

2 On the Properties palette, expand Basic, and expand General.

3 Select a new style.

If you select multiple roof slabs that have different styles, *VARIES* is 
selected. When you select a new roof slab style, all selected roof slabs are 
assigned that style.

Changing the Edges of a Roof Slab

Use this procedure to edit an individual edge of a roof slab. You can change 
the overhang, edge style, edge orientation, and the angle for the edge. A 
viewer shows you which edge of the selected slab you are editing.

1 Select a roof slab.

2 On the Properties palette, expand Basic, and expand Dimensions.

3 Click Edges.

4 Select the edge you want to edit. 

If you want to . . . Then . . .

change the slope to force the 
fascia to align with other slab 
fascias

select Yes for Hold fascia elevation.

ignore the fascia elevation select No for Hold fascia elevation.

If you want to . . . Then . . .

change the X coordinate value enter a value for Pivot Point X.

change the Y coordinate value enter a value for Pivot Point Y.

change the Z coordinate value enter a value for Pivot Point Z.
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The edge is highlighted in the viewer. You can select multiple edges by 
using SHIFT or CTRL.

5 Enter a value for Overhang.

6 Select a roof slab edge style for Edge Style.

7 Specify Square or Plumb for Edge Cut.

8 Enter a value for Angle relative to the orientation.

NOTE To reset Angle to the roof slab style defaults, right-click an edge 
number and click Reset to Style Defaults. (Reset to Style Defaults is available 
only if an edge style has been assigned and the value for Angle is different 
than the default.)

9 Click OK.

Trimming a Roof Slab

Use this procedure to trim a roof slab using a polyline, wall, roof slab or slab 
that defines a trim plane through the roof slab. The trimming object does not 
need to intersect the slab, as long as it provides an intersection in the current 
user coordinate system (UCS). However, the trim line must intersect the slab 
perimeter line. You cannot trim only the overhang.

Any fascia or soffit profile that intersects the trim plane is trimmed at the 
same angle as the roof slab. 

If the trimming object is a wall or slab, the trim plane is at the closest surface. 
The new slab edge at the trim plane has its edge angle defined by the trim 
plane.
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Trimming a roof slab to a wall

1 Select the roof slab you want to trim, right-click, and select Trim.

2 Select a wall, another roof slab, a slab, or a polyline for the trimming 
object.

3 Specify the side of the slab to be trimmed.

Extending a Roof Slab

Use this procedure to extend a roof slab to another roof slab or to a wall. The 
object the roof slab projects to does not need to intersect the plane of the roof 
slab, as long as it projects an intersection in the current user coordinate sys-
tem (UCS).
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Because multiple edges may need to move in an extend operation, you are 
prompted to select the adjacent edges to lengthen, rather than the specific 
edges to move. These selected edges retain their current vector (angle) and 
are stretched until they intersect the plane of the target object.

If multiple edges exist between the selected edges, they are joined to form a 
single edge. The new edge is set to the angle of the target surface.

Any fascia or soffit profile on the adjacent edges is extended to the target sur-
face and trimmed to its angle. 
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Extending a roof slab to a wall

1 Select the roof slab you want to extend, right-click, and click Extend.

2 Select a wall or another roof slab for the object to extend to.

3 Select the first edge to lengthen.

4 Select the second edge to lengthen.
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Mitering Roof Slabs by Intersection

Use this procedure to miter two intersecting roof slabs. Both roof slabs are 
trimmed along the intersection of their perimeter lines. Vertices are added or 
removed as required. The new edges of the roof slabs are set to angles 
required for a true miter cut. If the slab thicknesses of the two edges are dif-
ferent, the angles are different.

Mitering roof slabs by intersection

1 Select one of the two roof slabs you want to miter, right-click, and click 
Miter.

2 Enter i (Intersection) to miter at the intersection of the two roof slabs.

3 Select the first roof slab at the side of that slab to keep. 
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The opposite side is trimmed.

4 Select the second roof slab at the side of that slab to keep. 

The opposite side is trimmed.

If the new mitered edges do not intersect, you can miter them by edges. For 
more information, see “Mitering Roof Slabs Using Edges” on page 1368.

Mitering Roof Slabs Using Edges

Use this procedure to miter two roof slabs that do not intersect. You can 
select particular edges to miter. You can miter edges of overlapping roof slabs 
without trimming the entire slab. To accomplish this, however, you may 
need to insert additional vertices. Only one edge of each roof slab is mitered.

If you need to miter multiple edges of a roof slab, stretch them to overlap the 
other roof slab and then miter them at their intersection. For more informa-
tion, see “Mitering Roof Slabs by Intersection” on page 1367.



Editing Roof Slabs | 1369

Mitering roof slabs by edge

1 Select one of the two roof slabs you want to miter, right-click, and click 
Miter.

2 Enter e (Edges) to miter selected edges of the roof slabs.

3 Select one edge on the first roof slab.

4 Select one edge on the second roof slab. 

Cutting a Roof Slab

Use this procedure to cut a roof slab into two or more roof slabs. You can use 
any three-dimensional (3D) object or polyline to define the cutting geome-
try. If you use a 3D body, such as a wall, slab, mass element, or closed 
polyline, the roof slab is cut along the intersection lines of the surfaces. 
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The roof slab is cut when the 3D body or closed polyline intersects the perim-
eter line of the roof slab. If you use an open polyline, the roof slab is cut along 
the projection to the roof slab surface. 

In either case, when the intersection line crosses the roof slab multiple times, 
multiple roof slabs are created. If the intersection line has multiple edges, 
multiple edges are added to the new roof slabs.

The smoothness (tessellation) of curved edges is controlled by the FACET-
DEV variable. For more information about FACETDEV, see “AEC Facet Devi-
ation” on page 1409.

1 Draw an object or polyline for defining the cutting geometry.

2 Select the roof slab you want to cut, right-click, and click Cut.

3 Select the object or polyline that represents the cutting geometry, and 
press ENTER. 

Adding a Vertex to a Roof Slab

Use this procedure to add a vertex to a roof slab edge. Adding a vertex creates 
two roof slab edges from one edge.

Adding a vertex to the side of a roof slab

1 Select the roof slab to which to add the vertex, right-click, and click Add 
Vertex.

2 Specify a point for the new vertex. 
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To place a new vertex at a precise intersection point, use Intersection or 
Apparent Intersection object snaps.

The new vertex is added to the nearest roof slab edge, perpendicular to the 
specified point. If there is no point perpendicular to the roof, no vertex is 
added.

3 To see the new vertex, select the roof slab. 

A new grip point is displayed where you specified the new vertex, and 
additional grips are displayed for the additional roof edge created.

Deleting a Vertex from a Roof Slab

Use this procedure to delete vertices from roof slabs. After deleting a vertex, 
the two adjacent vertices connect in a straight line.

Removing a vertex from the side of a roof slab

1 Select the roof slab from which to delete the vertex, right-click, and click 
Remove Vertex.

2 Specify a point on the vertex that you want to delete.

Adding a Hole to a Roof Slab

Use this procedure to add a hole to a roof slab. The hole adds new vertices 
and edges to the slab that you can edit as you do any other vertex or edge.
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You can use polylines or three-dimensional (3D) objects, such as walls and 
mass elements, to create holes in a roof slab

� Holes generated by a closed polyline are projected from the polyline to the 
roof slab, using the current user coordinate system (UCS).

� 3D objects must intersect the roof slab without any projection.

If the objects contain an interior void, you are prompted to use the inside or 
outside surface to create the hole. For example, if you create a chimney using 
four wall objects, you can cut the hole at the inside or outside of the chim-
ney. The new hole faces are aligned with the surfaces of the cutting bodies, 
and are not necessarily parallel to each other. 

The smoothness (tessellation) of curved edges is controlled by the FACET-
DEV variable. For more information about FACETDEV, see “AEC Facet Devi-
ation” on page 1409.

Adding a hole to a roof slab

1 Draw a closed polyline in the shape and location for the hole, or add an 
object in the location for the hole.

2 Select the roof slab to which to add the hole, right-click, and click 
Hole ➤ Add.

3 Select the closed polyline or object to define the hole, and press ENTER.

4 When prompted to erase the layout geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 If you select 3D objects, you are prompted to create the hole at the inside 
or outside surface of the cutting objects. Press ENTER to use the outside of 
the object to define the hole, or enter i (Inside) to use the inside or void of 
the object to define the hole.
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This prompt is displayed even when the bodies do not contain an inner 
void, in which case the Inside option does not create a hole.

NOTE If you create a hole that is outside or which overlaps the roof slab base-
line or perimeter line at a roof slab overhang, the body of the slab is cut but the 
fascia and soffit remain. In this case, it is better to create a hole by cutting the 
slab. For more information, see “Cutting a Roof Slab” on page 1369.

Removing a Hole from a Roof Slab

Use this procedure to remove a hole from a roof slab.

1 Select the roof slab from which to remove the hole, right-click, and click 
Hole ➤ Remove.

2 Select an edge of the hole to remove in the roof slab.

Creating a Clipped Gable Roof

Use this procedure to modify two roof slabs to add a third slab, creating a 
clipped gable roof.

1 Create a gable roof with two roof slabs.

2 In an isometric view, draw a 3D polyline in the shape and location of the 
clipped roof slab.

3 Enter roofslab.

4 Enter e (Edit).

5 Enter x (Xcut).

6 Select the two roof slabs and press ENTER.

7 Select the 3D polyline and press ENTER twice.
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Creating a clipped gable roof

NOTE You can edit the outside edge of the new roof slab to change it from 
square to plumb. For more information, see “Changing the Edges of a Roof 
Slab” on page 1362.

Adding Objects to a Roof Slab (Boolean)

Use this procedure to add to a roof slab three-dimensional (3D) geometry 
(such as rib joists, curbs, or cornice returns) that cannot be defined by the 
perimeter, style, or edge profiles.

This procedure fuses 3D geometry of selected objects with the roof slab, so 
that a section cut through the roof slab is displayed as a single outline. Typ-
ically, after adding objects to a roof slab, you freeze the layer on which the 
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objects are placed. If you move or edit the objects, the roof slab is updated 
accordingly.

NOTE The object added to the roof slab is not included for Area in the LIST 
command or in a Schedule Query result.

Adding an object to a roof slab

1 Create an object to add to the roof slab in its actual location.

2 Select the roof slab on which to add the object, right-click, and click 
Boolean ➤ Add.

3 Select the object to add to the roof slab, and press ENTER.

Subtracting Objects from a Roof Slab (Boolean)

Use this procedure to subtract from a roof slab three-dimensional (3D) geom-
etry that cannot be defined by the perimeter, style, or edge profiles. For 
example, a pitch-pocket shape that does not fully penetrate the roof slab can 
be subtracted from the slab.

This procedure carves out the body of the roof slab using the geometry of the 
selected objects, such that a section cut through the roof slab produces a sin-
gle outline. Typically, after subtracting objects from a roof slab, you freeze the 
layer on which the objects are placed. If you move or edit the objects, the 
roof slab is updated accordingly.

NOTE The object subtracted from the roof slab is not included for Area in the 
LIST command or in a Schedule Query result.
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Subtracting an object from a roof slab

1 Create an object that defines the shape to subtract from a roof slab in its 
actual location.

2 Select the roof slab from which to subtract the object, right-click, and click 
Boolean ➤ Subtract.

3 Select the object to subtract from the roof slab, and press ENTER.

Removing Objects from a Roof Slab (Boolean)

Use this procedure to remove Boolean geometry from roof slabs. The objects 
are detached from the roof slab, but are not removed from the drawing.

1 Select the roof slab from which to remove the object, right-click, and click 
Boolean ➤ Detach.

2 Select the object to remove from the roof slab, and press ENTER.

Creating a Dormer in a Roof Slab

Use this procedure to add a dormer to a roof slab. You must first create the 
roof slabs, walls, and all other parts of the dormer, so that an appropriate hole 
can be cut in the roof slab. The walls you create for the dormer must include 
a back segment, so that a complete hole for the dormer can be cut in the roof 
slab.
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Adding a dormer to a roof slab

1 Create the walls for the dormer, including a closing rear wall.

2 Right-click a roof slab tool, and click Apply Tool Properties 
to ➤ Linework, Walls and Roof.

A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

3 Select the walls, and press ENTER.

4 Miter the roof slab edges as required.
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5 Move the structure so that the walls and roof slabs of the dormer fully 
penetrate the existing roof slab in the correct position.

6 Select the roof slab to add the dormer to, right-click, and click Roof Dor-
mer.

7 Select the objects that form the dormer, and press ENTER.

8 When prompted to slice the walls with the roof slab, press ENTER to slice 
the walls, or enter n (No) to leave the walls as they are. 

9 Erase the wall at the rear of the dormer.

Specifying the Material of a Roof Slab

Use this procedure to select a different material for components of an indi-
vidual roof slab.

To change the materials assigned to all roof slabs of the same roof slab style, 
see “Specifying the Materials of a Roof Slab Style” on page 1385.

NOTE If a material assignment does not determine the display properties of 
the roof slab component, you can change the properties of the display compo-
nent as described in “Specifying the Display Properties of a Roof Slab” on 
page 1379.

1 Select the roof slab you want to change, right-click, and click Edit Object 
Display.

2 To verify that the material assignment determines the display properties 
of the component, click the Display Properties tab, select the display rep-

resentation on which to display the changes, and click .

3 Click the Layer/Color/Linetype tab, verify that By Material is selected for 
the component, and click OK.

4 Click the Materials tab.

5 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, 

or click  to create a new material definition and assign it to a compo-
nent.
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WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

6 Click OK.

Specifying the Display Properties of a Roof Slab

Use this procedure to change the following properties of the display compo-
nents of an individual roof slab:

� Visibility (display component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

To change these display properties for all roof slabs of the same style, see 
“Specifying the Display Properties of a Roof Slab Style” on page 1388.

NOTE If a material assignment determines the properties of a roof display 
component, you can change the properties of the display component by clear-
ing By Material or by overriding the material assignment with a different mate-
rial. For more information, see “Specifying the Material of a Roof” on page 1328.

1 Select the roof slab you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation on which to display the changes, and 
select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.
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Specifying the Hatching of a Roof Slab

Use this procedure to specify the hatching of the components of an individ-
ual roof slab. Hatching is displayed only in display representations that are 
used in the Top view (plan view) of a drawing.

To change the hatching for all roof slabs of the same roof slab style, see “Spec-
ifying the Hatching of a Roof Slab Style” on page 1389.

NOTE If a material assignment determines the hatching properties of a roof 
slab display component, you can change the hatching of the display component 
by clearing By Material or by overriding the material assignment with a different 
material. For more information, see “Specifying the Material of a Roof Slab” on 
page 1378.

1 Select the roof slab you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation on which to display the changes, and 
select Style Override.

4 If necessary, click .

5 Click the Hatching tab.

6 Select the display component, and click the setting for Pattern.

7 Select the hatching for the display component:

If you want to . . . Then . . .

specify a hatching pattern that 
is available in the software

select Predefined for Type, and select a 
pattern.

specify a custom pattern select Custom for Type, and enter the name of 
the custom pattern. If necessary, click Browse, 
and navigate to the folder where the custom 
pattern file is located.

specify single hatching select User-Defined for Type, and clear Double 
Hatch.

specify double hatching select User-Defined for Type, and select 
Double Hatch.

specify solid fill select Solid Fill for Type.
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8 Click OK.

9 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

10 Click Angle, and enter the angle for the selected pattern.

11 Click Orientation, and specify how the hatching is oriented:

12 Click X Offset and Y Offset, and enter offset values.

13 Click OK twice.

Specifying the Cut Plane Height of a Roof Slab

Use this procedure to specify the cut plane height of a roof slab.

If you specify a value for the cut plane height greater than zero, you must 
specify the layer, color, and, linetype for the elements above and below the 
cut plane height. This is especially important if you add or subtract roof Bool-
ean objects that change the thickness of the slab.

To change the cut plane height for all roof slabs of the same roof slab style, 
see “Specifying the Cut Plane Height of a Roof Slab Style” on page 1391.

1 Select the roof slab you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation on which to display the changes, and 
select Style Override.

4 If necessary, click .

5 Click the Other tab.

6 Select Override Display Configuration Cut Plane, and enter a value for Cut 
Plane Height.

7 Click OK twice.

If you want to . . . Then . . .

orient the hatching to the roof 
slab, regardless of the roof slab 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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Changing the Location of a Roof Slab

Use this procedure to relocate a roof slab by changing the coordinate values 
of its insertion point. The roof slab also has an orientation with respect to the 
world coordinate system (WCS) or the current user coordinate system (UCS). 
For example, if the top and bottom of the roof slab are parallel to the XY 
plane, its normal is parallel to the Z axis. You can change the orientation of 
the roof slab by aligning its normal with another axis. You can also rotate the 
roof slab on its plane by changing the rotation angle.

For information about the WCS and UCS, see “Use Coordinates and Coordi-
nate Systems” in the online AutoCAD 2004 User’s Guide.

1 Select the roof slab you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Select Additional Information.

4 Specify the location of the roof slab:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Roof 
Slab

Use this procedure to attach hyperlinks, notes, or files to a roof slab. You can 
also edit hyperlinks and notes, and edit or detach reference files from a roof 
slab.

If you want to . . . Then . . .

relocate the roof slab enter new coordinate values under Insertion Point.

locate the roof slab on the 
XY plane

make the normal of the roof slab parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the roof slab on the 
YZ plane

make the normal of the roof slab parallel to the X 
axis: under Normal, enter 1 for X, and enter 0 for Y 
and Z. 

locate the roof slab on the 
XZ plane

make the normal of the roof slab parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
roof slab

enter a new value for Rotation Angle.
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1 Select the roof slab.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK twice.

Roof Slab Styles

Roof slab styles control the appearance of roof slab objects. Using roof slab 
styles, you can specify dimensions, components, edge conditions, materials, 
and other characteristics to create new types of roof slabs, such as custom 
roof slabs with unique fascias and soffits.

Using Materials in Roof Slab Styles
You can use materials to control how roof slabs of each style are displayed in 
a drawing. You assign materials to the roof slab components in the style. The 
components are then displayed using the display properties of the assigned 
materials. For more information see, “Material Components and Display 
Properties” on page 498.

Autodesk® Architectural Desktop provides predefined materials for common 
design purposes. You can use the predefined materials “as is,” modify them 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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for your project requirements, or define new materials. For more information 
about materials and how to define them, see “Specifying the Material of a 
Roof Slab” on page 1378and “Creating and Editing Materials” on page 517.

Creating Tools from Roof Slab Styles
You can create a roof slab tool from any roof slab style. You can drag the style 
from the Style Manager onto a tool palette. You can then specify default set-
tings for any roof slab created with that tool. For more information, see 
“Using Roof Slab Tools to Create a Roof Slab” on page 1337.

Managing Roof Slab Styles
When you create, copy, or edit styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop 
where you can work with styles from multiple drawings and templates. For 
more information about using the Style Manager, see “Getting Started with 
the Style Manager” on page 533.

Related Procedures

� Creating a Roof Slab Style

� Specifying the Fixed Thickness of a Roof Slab Style

� Specifying the Materials of a Roof Slab Style

� Specifying the Display Properties of a Roof Slab Style

� Specifying the Hatching of a Roof Slab Style

� Specifying the Cut Plane Height of a Roof Slab Style

� Adding Classifications to a Roof Slab Style

� Attaching Notes or Files to a Roof Slab Style

Creating a Roof Slab Style

Use this procedure to create a roof slab style. You can create a style using 
default style properties, or by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 
style.

Specifying the Fixed Thickness of a Roof Slab 
Style

Use this procedure to specify a fixed thickness and thickness offset of a roof 
slab style. If you specify a fixed thickness in the roof slab style, you cannot 
specify a thickness when you add or modify roof slabs of this style.

1 Open a tool palette that has a roof slab tool.
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A roof slab tool is located within the Architectural Object Tools Catalog. 
You can add this tool to any tool palette. For more information, see “Con-
tent Browser” on page 171.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Design Rules tab.

5 Select Has Fixed Thickness, and enter a value for Thickness.

6 Enter a value for Thickness Offset. 

A negative value drops the roof slab bottom below the baseline.

7 Click OK twice.

Specifying the Materials of a Roof Slab Style

A roof slab consists of a number of components whose display properties can 
be determined by the material assigned to each component.

You assign one material to each physical component of a roof slab. For exam-
ple, you can assign a shingles material to the slab. You assign materials to 
components in each display representation in which the material is to be 
used. 

If you want to use the display properties of the roof slab style, instead of 
using material display properties, you can turn off the material assignments 
in the display properties of the roof slab style.

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface hatch component of a mate-
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rial is used to hatch all object surfaces in three-dimensional (3D) model views 
and in elevations. For more information see, “Material Components and Dis-
play Properties” on page 498.

Roof Slabs with assigned materials

Related Topics and Procedures

� Roof Slab Materials and Display Components

� Assigning Materials to a Roof Slab Style

Roof Slab Materials and Display Components
A roof slab object consists of a number of display components that can be 
determined by materials. 

The following table identifies the material component that corresponds to 
each roof slab component.

Roof Slab Component Material Component

Plan, Plan High Detail, Plan Low Detail, Reflected Plan, Screened

Below Cut Plane Body No Material

Above Cut Plane Body No Material

Below Cut Plane Outline No Material

Above Cut Plane Outline No Material

Cut Line Linework
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Assigning Materials to a Roof Slab Style
Use this procedure to assign materials to individual components of a roof 
slab style. Components use the display properties of the material instead of 
the style display properties.

You can assign a material to any physical component of the roof slab. Cus-
tom components and components that are only symbolic graphics do not 

Hatch No Material

Baseline No Material

Fascia LInework

Soffit Linework

Pivot Point No Material

Warning No Material

Model, Model ByBlock, Model Monochrome

Warning No Material

Baseline No Material

Slab 3D Body

Fascia 3D Body

Soffit 3D Body

Pivot Point No Material

Section

Boundary No Material

Hatch No Material

Inside Cutting Body No Material

Inside Full Body No Material

Outside Cutting Body No Material

Outside Full Body No Material

Roof Slab Component Material Component
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use materials for their display properties. For example, roofs may be shingled 
and have metal fascias and soffits. 

NOTE If a material assignment does not determine the display properties of a 
roof slab component, you can change the display properties of the roof slab style 
as described in “Specifying the Display Properties of a Roof Slab Style” on 
page 1388.

1 Open a tool palette that has a roof slab tool.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation on which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which to assign a material, and 
click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make apply to all objects that are assigned the material.

11 Click OK twice.

Specifying the Display Properties of a Roof Slab 
Style

Use this procedure to change the properties of the following display compo-
nents of a roof slab style:
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� Visibility (display component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the display properties of compo-
nents on the roof slab style, you can change the properties of the display com-
ponents by clearing By Material or by overriding the material assignment with a 
different material. For more information, see “Specifying the Materials of a Roof 
Slab Style” on page 1385.

1 Open a tool palette that has a roof slab tool.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation on which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying the Hatching of a Roof Slab Style

Use this procedure to specify the hatching of a roof slab style. Hatching is dis-
played only in display representations that are used in the Top view (plan 
view) of a drawing.

1 Open a tool palette that has a roof slab tool.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation on which to display the changes, and 
select Style Override.
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6 If necessary, click .

7 Click the Hatching tab.

8 Click the setting for Pattern.

9 Select the hatching pattern:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is oriented:

14 Click X Offset and Y Offset, and enter offset values.

15 Click OK twice.

If you want to . . . Then . . .

specify a hatching pattern that 
is available in the software

select Predefined for Type, and select a 
pattern.

specify a custom pattern select Custom for Type, and enter the name of 
the custom pattern. If necessary, click Browse, 
and navigate to the folder where the custom 
pattern file is located.

specify single hatching select User-Defined for Type, and clear Double 
Hatch.

specify double hatching select User-Defined for Type, and select 
Double Hatch.

specify solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the roof 
slab, regardless of the roof slab 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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Specifying the Cut Plane Height of a Roof Slab 
Style

Use this procedure to specify the cut plane height of a roof slab style. 

If you specify a value for the cut plane height greater than zero, you must 
specify the layer, color, and, linetype for the elements above and below the 
cut plane height. This is especially important if you add or subtract roof Bool-
ean objects that change the thickness of the slab.

1 Open a tool palette that has a roof slab tool.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation on which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Override Display Configuration Cut Plane, and enter a value for Cut 
Plane Height.

9 Click OK twice.

Adding Classifications to a Roof Slab Style

Use this procedure to specify classifications for any classification definition 
applied to a roof slab style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a roof slab tool.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to roof slab 
styles.

5 For each classification definition, select the classification you want to 
apply to the current roof slab style.

6 Click OK twice.
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Attaching Notes or Files to a Roof Slab Style

Use this procedure to enter notes and attach reference files to a roof slab 
style. You can also edit notes and edit or detach reference files from a roof 
slab style.

1 Open a tool palette that has a roof slab tool.

2 Right-click a roof slab tool, and click Roof Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the roof slab, enter it for Description.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

Roof Slab Edge Styles

Roof slab edge styles control the appearance of the edges of roof slab objects. 
Using roof slab edge styles, you can specify dimensions, such as the overhang 
length, and the orientation and angle of the edges. You can also specify a fas-
cia and soffit for the edge style.

Components of Roof Slab Edge Styles
The roof slab edge style defines the appearance of roof slab edges. Each style 
consists of two optional components a fascia and a soffit. 

A fascia is a shape applied to the outside face of a slab edge. A soffit is a shape 
applied to the underside of an edge overhang.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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You can create fascia and soffit components by defining profiles that provide 
the two-dimensional (2D) geometry of the component whose shape is then 
extruded along the slab edge.

The fascia component follows the orientation of the roof slab edge, plumb, 
or square cut. The soffit component, however, is always oriented to the 
horizontal. Either component can have a positive or negative angle, relative 
to its base orientation.

The +/- directions for the edge component angles remain the same regardless 
of their orientation in the XY plane. They always follow the roof slab slope, 
so that, for example, a +30° soffit and a +30° slab would be parallel. Similarly, 
a +10° (plumb cut) fascia and a -10° soffit would meet at a right angle. Mir-
roring a roof slab maintains the same angle signs for all components.

Controlling the Placement of Fascia and Soffits on Roof Slab Edges
The fascia profile is drawn at actual size, except when you select Auto-Adjust. 
If the roof slab edge is sloped relative to the ground plane, the length is mea-
sured parallel to that slope, and not plumb with the ground. When you select 
Auto-Adjust to Edge Height, the fascia profile is scaled about its insertion 
point so that its lowest Y axis point aligns with the bottom of the roof slab 
edge.

NOTE Slope offsets are measured relative to the roof slab edge angle from the 
ground plane, and not from the world UCS.

The soffit profile is drawn at actual size, except when you select Auto-Adjust. 
The soffit angle is measured about its insertion point, using the local X axis 
of the profile.

When you select Auto-Adjust to Overhang Depth, the soffit profile is scaled 
about the insertion point, so that the furthest X axis point aligns with a 
plumb line from the roof slab baseline or perimeter line. Auto-Adjust scaling 
is adjusted by the horizontal offset from the roof slab baseline dimension.

Using Materials in Roof Slab Edge Styles
You can use materials to control how roof slab edges of each style are dis-
played in a drawing. You assign materials to the roof slab edge components 
in the style. The components are then displayed using the display properties 
of the assigned materials.

Autodesk® Architectural Desktop provides predefined materials for common 
design purposes. You can use the materials “as is,” modify them for your 
project requirements, or define new materials. For more information about 
materials and how to define them, see “Materials” on page 491.
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Managing Roof Slab Edge Styles
When you create, copy, or edit styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop 
where you can work with styles from multiple drawings and templates. For 
more information about using the Style Manager, see “Getting Started with 
the Style Manager” on page 533.

Related Procedures

� Creating a Roof Slab Edge Style

� Creating Profiles for Fascia and Soffits

� Editing the Geometry of Fascia and Soffits

� Specifying the Overhang, Orientation, and Angle of a Roof Slab Edge Style

� Specifying a Fascia and Soffit for a Roof Slab Edge Style

� Specifying the Materials of a Roof Slab Edge Style

� Attaching Notes or Files to a Roof Slab Edge Style

Creating a Roof Slab Edge Style

Use this procedure to create a roof slab edge style. You can create a style using 
default style properties, or by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects.

If necessary, expand Roof Slab Edge Styles.

3 Create a new roof slab edge style:

4 Enter a name for the new roof slab edge style, and press ENTER.

If you want to . . . Then . . .

create a style with default 
properties

right-click Roof Slab Edge Styles, and click New.

create a style from an 
existing style

right-click the roof slab edge style you want to copy, 
and click Copy. Right-click, and click Paste.
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5 To edit the new roof slab edge style, right-click the style, and click Edit:

6 When you finish changing the roof slab edge style properties, click OK 
twice.

Creating Profiles for Fascia and Soffits

You create profiles for fascia and soffits from two-dimensional (2D) polylines. 
You can create a profile from a single polyline to represent solid fascia or sof-
fits, such as a wood fascia. You can also create a profile from concentric 
polylines that can include one or more voids to represent fascia or soffits that 
are extruded, such as aluminum soffits.

You can draw these polylines anywhere in the drawing and use any scale rel-
ative to your final fascia or soffit size. To ensure the fascia or soffit is of a rel-
ative size, draw the polyline by snapping to an existing fascia or soffit, and 
then move the polyline into a clean area of the drawing to create the profile.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

specify the overhang, 
orientation, and angle for 
the style

see “Specifying the Overhang, Orientation, and 
Angle of a Roof Slab Edge Style” on page 1401.

specify soffits and fascias 
for the style

see “Specifying a Fascia and Soffit for a Roof Slab 
Edge Style” on page 1402.

assign materials to the 
components of the roof 
slab edge style

see “Assigning Materials to a Roof Slab Edge Style” 
on page 1406.

add notes and files to the 
style

see “Attaching Notes or Files to a Roof Slab Edge 
Style” on page 1407.
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Assigning a profile as a fascia

Assigning a profile as a soffit

Related Procedures

� Creating a Profile from a Single Polyline

� Creating a Profile from Concentric Polylines

� Controlling Profile Edges and Extrusion

Creating a Profile from a Single Polyline
Use this procedure to convert a single polyline to a profile.

1 Draw closed or open polylines representing the fascia or soffit. 

2 On the Desktop menu, click Profiles ➤ Profile Definitions. 

3 Select Profiles, right-click, and click New.

4 Enter a name for the new profile, and press ENTER.
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5 Select the profile name, right-click, and click Set From.

6 Select the polyline for the profile.

7 When prompted to add another ring, enter y (Yes), and press ENTER.

8 Select an inner or additional polyline, and press ENTER.

9 When prompted to specify whether the inner ring is a void area, enter y 
(Yes), and press ENTER.

10 When prompted to add another ring, enter n (No), and press ENTER.

11 Specify the insertion point for the fascia or soffit. 

The insertion point is typically the lower-left corner.

12 Click OK.

Creating a Profile from Concentric Polylines
Use this procedure to convert multiple concentric polylines to a profile.

1 Draw closed or open polylines representing the fascia or soffit. 

2 On the Desktop menu, click Profiles ➤ Profile Definitions. 

3 Select Profiles, right-click, and click New.

4 Enter a name for the new profile, and press ENTER.

5 Select the profile name, right-click, and click Set From.

6 Select the polyline for the profile.

7 When prompted to add another ring, enter y (Yes), and press ENTER.

8 Select an inner or additional polyline, and press ENTER.

9 When prompted to specify whether the inner ring is a void area, enter y 
(Yes), and press ENTER.

10 When prompted to add another ring, enter n (No), and press ENTER.

11 Specify the insertion point for the fascia or soffit. 

The insertion point is typically the lower-left corner.

12 Click OK.

Controlling Profile Edges and Extrusion
Use this procedure to specify the following parameters for a profile:

� the position of each edge in a profile (left, right, back, discard, none)
� the axis along which an object is extruded from the shape of a profile

These settings determine how surface hatching is applied to objects created 
from the profile and how the objects are extruded from the two-dimensional 
(2D) profile.
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NOTE The shape of any objects already created from the profile changes when 
you change profile edges or the axis of extrusion.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Profile Definition.

3 Right-click the profile you want to change, and click Edit.

4 Click the Profile Edges tab.

5 Select an edge, and specify its position:

6 Specify the axis of extrusion based on the type of object created from the 
profile:

7 Click OK twice.

Editing the Geometry of Fascia and Soffits

Use this procedure to edit the geometry of the profile used to define the fascia 
and soffit of a roof slab edge style. You can also add a profile to the fascia or 

If you want to . . . Then . . .

let the software determine the position 
of edges

click Calculate Default Edge Positions. 
You can then override the position of 
individual edges, if necessary.

select a position for an edge select the setting for Edge, and select a 
new position.

exclude an edge from surface hatching select the setting for Edge, and select 
None.

discard an edge select the setting for Edge, and select 
Discard.

If you want to . . . Then . . .

create a roof slab or slab fascia select X for Extrusion Direction.

create a slab soffit select Y for Extrusion Direction.

extrude mass elements select Z for Extrusion Direction.
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soffit of a roof slab edge style that does not currently use a profile to define 
its shape.

NOTE If you want to replace the geometry of the profile with newly drawn 
polylines, draw them before you start this procedure.

1 Add a roof slab object that has the style you want to change.

2 Add or edit a profile:

NOTE If you are prompted about the selected edge not having an edge 
style and overhang, click Yes.

3 If you receive a message that the profile is not drawn to size, click Yes.

The area of the roof slab edge defined by the profile is selected and 
hatched in the drawing.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select the 
profile, and right-click to display the shortcut menu.

If you want to . . . Then . . .

add an existing profile to the style select the roof slab, right-click, and 
click Add Edge Profiles. Select an edge. 
Select the name of the profile for the 
fascia or soffit, and click OK.

create a profile and add it to the style select the roof slab, right-click, and 
click Add Edge Profiles. Select an edge. 
Select Start from scratch for Fascia or 
Soffit Profile Definition, enter a name 
for the new profile, and click OK. A 
rectangle profile is created for you to 
edit.

edit the existing profile for the style select the roof slab, right-click, and 
click Edit Edge Profile in Place.
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4 Edit the profile as necessary:

5 Save or discard the changes:

If you want to . . . Then . . .

change the shape of the perimeter of 
the profile or its rings

select the profile, and use grips to 
adjust the shape.

add vertices to the profile select the profile, right-click, and click 
Add Vertex. Select a point for each new 
vertex, and press ENTER.

remove vertices from the profile select the profile, right-click, and click 
Remove Vertex. Select each vertex to 
remove, and press ENTER.

replace an existing ring of the profile 
with new geometry

select the profile, right-click, and click 
Replace Ring. Select the ring to replace, 
and select the new geometry. Press 
ENTER to keep the geometry, or enter 
n (No) to erase it.

If you want to . . . Then . . .

restore the profile to its original 
shape select the profile, and click .

save the changes to the current 
profile select the profile, and click .

The roof slab style uses the edited profile to 
define its geometry. Any other objects or styles 
that use this profile are also updated with the 
edited geometry.

save the changes to a new 
profile definition

select the profile, right-click, and click Save as 
New Profile. Enter a name for the new profile 
definition, and click OK.
The roof slab uses the new profile to define its 
geometry. Any roof slabs of this style are 
updated with the new geometry. Other styles 
or objects that use the original profile are not 
affected.
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Specifying the Overhang, Orientation, and Angle 
of a Roof Slab Edge Style

Use this procedure to specify the default overhang depth, type of orientation, 
and angle of a roof slab edge style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Roof Slab Edge Styles.

3 Right-click the roof slab edge style that you want to change, and click Edit.

4 Click the Defaults tab.

5 Specify the overhang, orientation, and angle of the roof slab edge:

If you want to . . . Then . . .

specify the overhang of the 
roof slab

select Overhang, and enter a value.

specify the orientation of the 
roof slab edge

select Edge Cut, and select a setting:
� Select Square to cut the edge 90 degrees 

with the plane of the slab.
� Select Plumb to cut the edge perpendicular 

with the ground.
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Specifying square and plumb edges

6 Click OK twice.

Specifying a Fascia and Soffit for a Roof Slab Edge 
Style

Use this procedure to specify a fascia and soffit for a roof slab edge style. The 
drawing must contain profiles for the fascia and soffits in order to specify 
them. For more information, see “Creating Profiles for Fascia and Soffits” on 
page 1395. 

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Roof Slab Edge Styles.

3 Right-click the roof slab edge style that you want to change, and click Edit.

4 Click the Design Rules tab.

specify the angle of the roof 
slab edge

select Angle, and enter a value.

A positive value moves the bottom of the edge 
out and a negative value moves the bottom of the 
edge in.

If you want to . . . Then . . .
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5 Select Fascia, and select a profile that defines the geometry of the fascia.

If you select *NONE*, display component settings apply to the slab edge 
line or plane where the fascia is located.

6 Specify how the fascia is to be scaled on the roof slab edge:

7 Select Soffit, and select a profile that defines the geometry of the soffit.

If you select *NONE*, display component settings apply to the slab edge 
line or plane where the soffit is located.

If you want to . . . Then . . .

scale the fascia to fit the 
height of the roof slab edge

select Auto-Adjust to Edge Height.

use the fascia at its drawn 
size

clear Auto-Adjust to Edge Height.
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8 Specify how the soffit is to be scaled on the roof slab overhang:

9 Specify the placement of the soffit:

10 Click OK twice.

Specifying the Materials of a Roof Slab Edge Style

A roof slab edge consists of a number of components whose display proper-
ties can be determined by the material assigned to the component.

You assign one material to each component of the roof slab edge. For exam-
ple, you assign a metal material to the fascia and a wood material to the soffit. 
You assign materials to components in each display representation in which 
the material is to be used.

If you want to use the display properties of the roof slab edge style, instead 
of using material display properties, you can turn off the material assign-
ments in the display properties of the style you want to change.

If you want to . . . Then . . .

scale the soffit to fit the 
depth of the overhang

select Auto-Adjust to Overhang Depth.

use the soffit at its drawn size clear Auto-Adjust to Overhang Depth.

If you want to . . . Then . . .

specify the soffit angle of the 
roof slab edge

enter a value for Angle, with zero being 
horizontal.

A positive value slopes the soffit up from the 
insertion point, and a negative value slopes the 
soffit down.

specify the horizontal offset 
from the roof slab baseline or 
perimeter line for the roof 
slab edge

enter a value for Horizontal Offset from Slab 
Baseline.

This option is available only if you select Auto-
Adjust to Overhang Depth.

specify the soffit offsets from 
the insertion point of the 
fascia

enter values for Y Direction and X direction.
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Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the linework component of a material 
is used for all linework in plan view. The Surface hatch component of a mate-
rial is used to hatch all object surfaces in three-dimensional (3D) model views 
and in elevations. For more information see, “Material Components and Dis-
play Properties” on page 498.

Related Topics and Procedures

� Roof Slab Edge Materials and Display Components

� Assigning Materials to a Roof Slab Edge Style

Roof Slab Edge Materials and Display Components
The edge of a roof slab object consists of a number of display components 
that can be determined by materials. 

The following table lists roof slab edge components and the material compo-
nents that determine them. 

Roof Slab Component Material Component

Plan, Plan High Detail, Plan Low Detail, Reflected Plan, Screened

Below Cut Plane Body No Material

Above Cut Plane Body No Material

Below Cut Plane Outline No Material

Above Cut Plane Outline No Material

Cut Line Linework

Hatch No Material

Baseline No Material

Fascia Linework

Soffit Linework

Pivot Point No Material

Warning No Material

Model, Model ByBlock, Model Monochrome

Warning No Material
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Assigning Materials to a Roof Slab Edge Style
Use this procedure to assign materials to individual components of a roof 
slab edge style. Component use the display properties of the material instead 
of the style display properties.

NOTE The display properties of roof slab edge styles are controlled by the roof 
slab styles that use them. Therefore, to edit the display properties of roof slab 
edge style components, you must edit the roof slab style that uses the roof slab 
edge style you want to change. For more information, see “Specifying the Dis-
play Properties of a Roof Slab Style” on page 1388.

You can assign a material to any physical component of the roof slab edge. 
Custom components and components that are only symbolic graphics do 
not use materials for their display properties. For example, roofs may have 
metal fascias and soffits.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Roof Slab Edge Styles.

Baseline No Material

Slab 3D Body

Fascia 3D Body

Soffit 3D Body

Pivot Point No Material

Section

Boundary No Material

Hatch No Material

Inside Cutting Body No Material

Inside Full Body No Material

Outside Cutting Body No Material

Outside Full Body No Material

Roof Slab Component Material Component
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3 Right-click the roof slab edge style to which to assign materials, and click 
Edit. 

4 Click the Materials tab. 

5 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make apply to all objects that are assigned the material.

6 Click OK twice.

7 To assign the material that uses the roof slab edge style you changed, see 
“Assigning Materials to a Roof Slab Style” on page 1387.

Attaching Notes or Files to a Roof Slab Edge 
Style

Use this procedure to enter notes and attach reference files to a roof slab edge 
style. You can also edit notes and edit or detach reference files from a roof 
slab edge style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Roof Slab Edge Styles.

3 Right-click the roof slab edge style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the roof slab, enter it for Description.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.
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9 Click OK twice.

Ortho Close and Close
You can use Ortho Close and Close to create a closed roof slab.

Using ortho close with two and three specified points

Ortho Close
Use Ortho Close to square off the last edge of the roof slab with the first edge.

This option closes the roof slab by using the first line and the selected direc-
tion, and draws a square roof slab based on the current settings for adding a 
roof slab. The direction is extended until it meets a line perpendicular to the 
initial edge of the roof slab.

 Close
This option closes the roof slab by creating a slab segment from the last point 
specified to the first point specified.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .
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After you have specified three or more points, click Close to connect the last 
point of the roof slab to the first point. 

AEC Facet Deviation
The smoothness (tessellation) of curved edges is controlled by the FACET-
DEV variable. This variable sets the number of facets to display on curved 
AEC objects, and must be set before converting the polyline to slabs.

The facet deviation is available only on the command line by entering 
AecFacetDev.

The number you set as the facet deviation defines the maximum distance 
from the chord to the arc, the chord being an edge created from faceting the 
curve to the true mathematical arc. The facet deviation has a range of greater 
than zero (0) and no upper limit.

The minimum number of facets is eight. For example, create a cylinder mass 
element to have a 1' radius, and set the aecfacetdev to 1’. The cylinder has 
eight faces.
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Stairs

Stairs are AEC objects that use flights of treads 
and risers to accommodate vertical circulation. 
Stairs also interact with railing objects. You can 
control the style of the stair, the shape of the 
landing, whether the stairs have open or closed 
treads, and the height and width of the stair 
run.

Stair Shapes
While strictly rectangular stairs are predomi-
nant in modern buildings, there are many cases 
when the edges of a flight are not parallel, or 
follow some curved shape. Landings can also 
have non-rectangular shapes. Stairs allow the 
use of nearly arbitrary profiles for the edges of 
flights and landings. In addition, railings and 
stringers can be anchored to stairs and can fol-
low the edges of flights and landings.

Landings and Turns
Stairs are created at a specified overall height 
that requires a total length based on the tread 
length. Within that length, you can place land-
ings or turns. When you begin to create a stair-
way, a rectangular box is displayed that repre-
sents the width and length of the stair as if it 
were a straight stairway. As you select consecu-
tive points, depending upon the shape of the 
stair selected, landings and turns are created.

Materials in Stairs
In Autodesk Architectural Desktop, you can 
assign materials to a stair. These materials are 
displayed in wireframe and working shade 
views, or when linked into VIZ Render. Materi-
als have specific settings for the physical com-

In this chapter

� Specifying AEC Options for 
Stairs

� Using Stair Tools to Create 
Stairs

� Creating a Stair

� Creating a Straight Stair with 
User-Specified Settings

� Creating a Multi-landing Stair 
with User-Specified Settings

� Creating an L-Shaped Stair with 
45 Degree Tread

� Creating a U-shaped Stair with 
User-Specified Settings

� Creating a Spiral Stair with 
User-Specified Settings

� Creating a Ramp

� Creating a Stair Tool

� Editing Stairs

� Stair Styles

� Stair Winder Styles

21
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ponents of a stair, such as risers, nosing, and treads.

Stair in wireframe model (left) and shaded view (right)

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for stair com-
ponents. You can use these predefined materials, or modify them for your 
designs. You can also create your own materials. Object styles provided with 
the software have appropriate materials already assigned to them. For more 
information, see “Stair Materials and Display Components” on page 1527.

Related Topics and Procedures

� Specifying AEC Options for Stairs

� Using Stair Tools to Create Stairs

� Editing Stairs

� Stair Styles

� Stair Winder Styles

Specifying AEC Options for Stairs

Use this procedure to specify some parameters and options for stairs that are 
not specified in the stair styles or display properties. The options are on the 
AEC Object Settings tab of the Options dialog box:

� Presentation format
� Node Osnaps
� Flight height measurement

1 On the Format menu, click Options.

2 Click the AEC Object Settings tab.
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3 Specify the stair defaults:

4 Click OK.

Using Stair Tools to Create Stairs

Tools provided with Autodesk® Architectural Desktop let you quickly place 
stairs by selecting a stair tool with a specific stair style and other predefined 
properties. 

The following catalogs provided with the software contain stair tools that 
you can add to your tool palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

Custom palettes created by your CAD manager or other users may also con-
tain stair tools with stair styles and properties that are customized for your 
projects or office standards.

If you want to . . . Then . . .

display the stair with 
no cut lines or path

select Presentation Format (No Cut Lines or Path).

use Node Osnap to 
select the corners of 
the stairs and landings

select Flight and Landing Corners for Node Osnap.

specify the stair height 
distance above the 
start of the stair and 
below the end of the 
stair as the position for 
the Node Osnap

select Vertical Alignment for Node Osnap.

include top and 
bottom offsets in the 
stair height 
measurement

select Finished Floor to Floor for Measure Stair 
Height.

ignore top and bottom 
offsets in the stair 
height measurement

select Rough Floor to Floor for Measure Stair Height.
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When you place stairs using stair tools, you can use the default settings of the 
tool, or you can change settings for any stair properties that are not con-
trolled by the style.

Related Procedures

� Creating a Stair

� Creating a Straight Stair with User-Specified Settings

� Creating a Multi-landing Stair with User-Specified Settings

� Creating a U-shaped Stair with User-Specified Settings

� Creating a Spiral Stair with User-Specified Settings

� Creating a Ramp

� Creating a Stair Tool

Creating a Stair

Use this procedure to add a new stair that has the properties specified in the 
stair tool that you select. To specify settings when you add a stair, see “Creat-
ing a Straight Stair with User-Specified Settings” on page 1414.

1 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the stair.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the direction point of the stair.

The stair is created at the length necessary to accommodate the values 
used.

4 Continue adding stairs, and press ENTER.

Creating a Straight Stair with User-Specified 
Settings

Use this procedure to add a straight stair with settings that you specify.
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Creating a straight stair

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 In Shape, select Straight.
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5 Specify the vertical orientation of the stair:

6 Expand Dimensions.

7 Specify stair dimensions:

If you want to . . . Then . . .

draw the stair from this 
floor to the floor above

select Up for Vertical Orientation.

draw the stair from this 
floor to the floor below

select Down for Vertical Orientation.

If you want to . . . Then . . .

specify the width of the 
stair

enter a value for Width. 

specify the height of 
the stair 

enter a value for Height.

specify the justification 
of the stair

enter a value for Justify. 
The Justify value you select controls the insertion point 
when you place the stair; left, center, or right at the 
beginning of the stair run.

end the stair run with a 
riser

select Riser for Terminate with.

Stairs which end with a riser will have an overall height 
that is one tread thickness less than the floor-to-floor 
height specified. 

end the stair run with a 
tread

select Tread for Terminate with.
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end the stair run with a 
landing

select Landing for Terminate with.

specify the overall 
linear length of the stair

select Calculation rules, and then enter a value for 
Straight Length.

� When Straight Length is set to automatic (the icon 

is ), the value is calculated based on the tread 
size and riser count.

� When Straight Length is user-defined (the icon is 

), the stair length is equal to the dimension 
entered, and the other three values are adjusted 
within the code limits.

� When Riser Count is user-defined, the tread depth 
is increased or decreased to accommodate the 
stair.

specify the total 
number of stair risers

select Calculation rules, and then enter a value for Riser 
Count.

� When Riser Count is set to automatic (the icon is 

), the number of risers is based on the overall 
length and overall height of the stair and the code 
limits specified on the Design Rules tab.
The Straight Length value of the stair is adjusted 
automatically.

� When Riser Count is user-defined (the icon is 

), you can specify a value that is used to 
calculate the tread depth and riser height.
If these values fall outside the stair limits, an error 
message is displayed.

specify the height of 
each riser in the stair 
flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon to Riser to 

change it to  and enter a value for Riser.

If you want to . . . Then . . .
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NOTE If a value is set to user-defined on the Calculation rules worksheet, it 
can be modified directly in the Property palette.

NOTE If  is displayed next to a field in the Calculation Rules dialog box, 
that field can’t be changed until another field is changed from user-defined 

 to automatic .

8 In the drawing area, specify the insertion point of the stair.

You can move or hide the Properties palette to expose more of the drawing 
area.

9 Specify the end point of the stair.

10 Continue adding stairs, and press ENTER.

Creating a Multi-landing Stair with User-
Specified Settings

Use this procedure to create a multi-landing stair. You can use multi-landing 
stair shapes to define both straight and angled stair runs. You can insert quar-
ter-landings, half-landings, and turns.

This type of stair is constrained by the design rules on the stair and the floor 
to floor height. For more information about stair design rules, see Specifying 
the Design Rules of a Stair Style. 

If you are drawing the risers or flights of a stair, lines for each tread are shown. 
If you are drawing a flat landing, no tread lines are shown. If you are drawing 
a turn type landing, angled tread lines are shown through the turn. These 
temporary lines do not necessarily represent the actual locations of tread 
lines in the final stair. In addition, the number of risers currently added to 
the stair is displayed (to the left of the stair), along with the total number of 
risers required for the stair, for example “10/18”.

NOTE To create a straight stair with user-specified landings, use the multi-
landing shape with half landings. Select all the points in a straight line to define 
the flight starts and flight end points.
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Creating a multi-landing stair with 1/4 landings

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.



1420 | Chapter 21 Stairs

3 Select a style.

4 In Shape, select Multi-landing.

5 Specify the turn type:

6 Specify the vertical orientation of the stair:

7 Expand Dimensions.

8 Specify stair dimensions:

If you want to . . . Then . . .

create a flat landing 
with a user-defined 
length where the stair 
run turns

select 1/2 landing for Turn type.

create stairs with a user-
defined length where 
the stair run turns with 
treads through the turn

select 1/2 turn for Turn type.

NOTE These stairs must have at least three segments 
and each corner must turn in the same direction.

create a flat landing 
where the stair turns, 
with the length of the 
landing equal to the 
width of the stair

select 1/4 landing for Turn type.

NOTE These stairs typically have two or more flights 
joined by square landings.

create stairs having 
treads along the entire 
length, with one or 
more turns in any 
direction 

select 1/4 turn for Turn type.

NOTE These stairs may have two or more segments, 
and corners may turn in either direction.

If you want to . . . Then . . .

draw the stair from this 
floor to the floor above

select Up for Vertical Orientation.

draw the stair from this 
floor to the floor below

select Down for Vertical Orientation.

If you want to . . . Then . . .

specify the width of the 
stair

enter a value for Width. 
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specify the height of 
the stair 

enter a value for Height.

specify the justification 
of the stair

enter a value for Justify. 
The Justify value you select controls the insertion point 
when you place the stair; left, center, or right at the 
beginning of the stair run.

end the stair run with a 
riser

select Riser for Terminate with.

Stairs which end with a riser will have an overall height 
that is one tread thickness less than the floor-to-floor 
height specified. 

end the stair run with a 
tread

select Tread for Terminate with.

end the stair run with a 
landing

select Landing for Terminate with.

If you want to . . . Then . . .
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specify the overall 
linear length of the stair

select Calculation rules, and then enter a value for 
Straight Length.

� When Straight Length is set to automatic (the icon 

is ), the value is calculated based on the tread 
size and riser count.

� When Straight Length is user-defined (the icon is 

), the stair length is equal to the dimension 
entered, and the other three values are adjusted 
within the code limits.

� When Riser Count is user-defined, the tread depth 
is increased or decreased to accommodate the 
stair.

specify the total 
number of stair risers

select Calculation rules, and then enter a value for Riser 
Count.

� When Riser Count is set to automatic (the icon is 

), the number of risers is based on the overall 
length and overall height of the stair and the code 
limits specified on the Design Rules tab.
The Straight Length value of the stair is adjusted 
automatically.

� When Riser Count is user-defined (the icon is 

), you can specify a value that is used to 
calculate the tread depth and riser height.
If these values fall outside the stair limits, an error 
message is displayed.

specify the height of 
each riser in the stair 
flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon to Riser to 

change it to  and enter a value for Riser.

specify the tread depth 
for each tread in the 
stair flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon next to Tread to 

change it to  and enter a value for Tread. 

You can also specify the Riser count when you set the 
tread depth.

If you want to . . . Then . . .
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NOTE If a value is set to user-defined on the Calculation rules worksheet, it 
can be modified directly in the Property palette.

NOTE If  is displayed next to a field in the Calculation Rules dialog box, 
that field can’t be changed until another field is changed from user-defined 

 to automatic .

9 Expand Advanced.

10 Specify the Floor Settings:

11 Set the minimum or maximum height or amount of risers in a stair flight:

12 In the drawing area, specify the insertion point of the stair.

You can move or hide the Properties palette to expose more of the drawing 
area.

13 Specify the point of the first turn or landing for the stair.

14 Continue specifying points for the stair. 

NOTE If you specified Landing for Terminate with, the last point for the 
stair beyond the final riser defines the end of the landing.

If you want to . . . Then . . .

change the thickness of 
the floor finish material 
at the top of the stair

enter a value for Top offset.

change the depth of 
the structure at the top 
of the stair

enter a value for Top depth.

change the thickness of 
the floor finish material 
at the bottom of the 
stair

enter a value for Bottom offset.

change the depth of 
the structure at the 
bottom of the stair

enter a value for Bottom depth.
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Specifying terminal landing length for multi-landing stair

15 Continue adding stairs, and press ENTER.

Creating an L-Shaped Stair with 45 Degree 
Tread

Use this procedure to add an l-shaped stair with a 45 degree turn in the 
winder. 

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Stair Winder Styles.

3 Right-click, select New, and enter Single Point – 2 Tread as the style name.

4 Right-click and click Edit.

5 On the Settings tab, confirm that Use Riser Line is not selected.

6 Specify Single Point for Winder Type.

7 Select Adjust Winder Turn and enter 2 for Number of Treads in T urn.

8 Click OK twice.

9 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

10 On the Properties palette, expand Basic, and expand General.
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11 In Shape, select Multi-landing.

12 In Turn type, select 1/4 turn.

13 Right-click, click Flight length and enter t for Tread length.

NOTE If the stair style has Extend Landings to Prevent Risers and Treads Sit-
ting under Landings turned on, the flight will not be pivoted exactly around 
the end of the stair.

14 In Winder Style, select Single Point – 2 Tread.

15 Draw a stair with one 90 degree turn and press ENTER.

16 Select the stair, enter winderturnadjust at the command line and press 
ENTER twice.

NOTE The winderturnadjust command changes the number of treads in a 
turn zone for a stair using a Single Point winder style. The default number of 
treads is specified in the Settings tab of the Stair Winder Styles. You can 
change the amount of treads on the command line while running the wind-
erturnadjust command.

When you change the amount of treads in the turn zone, the Construction 
Line changes location across the stair because the tread length must remain 
constant along the stair. Changing the winder treads changes the width, so 
the line moves. The Construction Line can be edited with grips. If you move 
the Construction Line, the winder treads are affected.

Creating a U-shaped Stair with User-
Specified Settings

Use this procedure to add a u-shaped stair with settings that you specify. U-
shaped stairs have two equal-length runs joined by a half-landing. The justi-
fication setting controls where the points you specify to define the stair fall 
within its width.

When drawing the stair, the flights are shown with lines for each tread. Flat 
landings have no tread lines, while turn type landings show tread lines 
through the entire turn. For turn type stairs, these temporary lines do not 
necessarily represent the actual locations of tread lines in the final stair.
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Creating a U-shaped stair

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 In Shape, select U-shaped.
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5 Specify the turn type:

6 Specify the horizontal orientation of the stair:

If you want to . . . Then . . .

create a flat landing 
where the stair run 
turns back in the 
opposite direction

select 1/2 landing for Turn type.

create stairs where the 
stair run turns back in 
the opposite direction 
with treads throughout 
the run

select 1/2 turn for Turn type.

If you want to . . . Then . . .

draw the u-shaped stair 
so that the right is the 
outer edge of the stair 
and left is the inner 
edge

select Counterclockwise for Horizontal Orientation.

draw the u-shaped stair 
so that the left is the 
outer edge of the stair 
and right is the inner 
edge

select Clockwise for Horizontal Orientation.
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Specifying the horizontal direction for U-shaped stairs

7 Specify the vertical orientation of the stair:

8 Expand Dimensions.

9 Specify stair dimensions:

If you want to . . . Then . . .

draw the stair from this 
floor to the floor above

select Up for Vertical Orientation.

draw the stair from this 
floor to the floor below

select Down for Vertical Orientation.

If you want to . . . Then . . .

specify the width of the 
stair

enter a value for Width. 

specify the floor-to-
floor height of the stair 

enter a value for Height.
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specify the justification 
of the stair

enter a value for Justify. 
The Justify value you select controls the insertion point 
when you place the stair; left, center, or right at the 
beginning of the stair run.

end the stair run with a 
riser

select Riser for Terminate with.

Stairs which end with a riser will have an overall height 
that is one tread thickness less than the floor-to-floor 
height specified. 

end the stair run with a 
tread

select Tread for Terminate with.

end the stair run with a 
landing

select Landing for Terminate with.

If you want to . . . Then . . .
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specify the overall 
linear length of the stair

select Calculation rules, and then enter a value for 
Straight Length.

� When Straight Length is set to automatic (the icon 

is ), the value is calculated based on the tread 
size and riser count.

� When Straight Length is user-defined (the icon is 

), the stair length is equal to the dimension 
entered, and the other three values are adjusted 
within the code limits.

� When Riser Count is user-defined, the tread depth 
is increased or decreased to accommodate the 
stair.

specify the total 
number of stair risers

select Calculation rules, and then enter a value for Riser 
Count.

� When Riser Count is set to automatic (the icon is 

), the number of risers is based on the overall 
length and overall height of the stair and the code 
limits specified on the Design Rules tab.
The Straight Length value of the stair is adjusted 
automatically.

� When Riser Count is user-defined (the icon is 

), you can specify a value that is used to 
calculate the tread depth and riser height.
If these values fall outside the stair limits, an error 
message is displayed.

specify the height of 
each riser in the stair 
flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon to Riser to 

change it to  and enter a value for Riser.

specify the tread depth 
for each tread in the 
stair flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon next to Tread to 

change it to  and enter a value for Tread. 

You can also specify the Riser count when you set the 
tread depth.

If you want to . . . Then . . .
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NOTE If a value is set to user-defined on the Calculation rules worksheet, it 
can be modified directly in the Property palette.

NOTE If  is displayed next to a field in the Calculation Rules dialog box, 
that field can’t be changed until another field is changed from user-defined 

 to automatic .

10 Expand Advanced.

11 Specify the Constraints:

12 Specify a value for Alignment offset.

When you select Tread to tread, Tread to riser, or Riser to riser, you can 
specify an offset value. A positive offset value means that the down flight 
tread location is closer to landing than the up flight tread location.

Specifying tread to riser alignment offsets

If you want to . . . Then . . .

place the treads and risers with the minimum 
landing extension

select Free for 
Alignment.

align the tread of the up flight to the tread of the 
down flight

select Tread to tread for 
Alignment.

align the tread of the up flight to the riser of the 
down flight

select Tread to riser for 
Alignment.

align the riser of the up flight to the riser of the 
down flight

select Riser to riser for 
Alignment.
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13 Specify a value for the Extend alignment.

14 Specify a value for Uneven tread on which specifies which flight will be 
longer if the total number of treads is uneven. Select Upper flight to place 
the Uneven tread on the upper flight. Select Lower flight to place the 
uneven tread on the lower flight.

15 Specify the Floor Settings:

16 Set the minimum or maximum height or number of risers in a stair flight:

17 In the drawing area, specify the insertion point of the stair.

You can move or hide the Properties palette to expose more of the drawing 
area.

18 Specify the end point of the stair.

19 Continue adding stairs, and press ENTER.

Creating a Spiral Stair with User-Specified 
Settings

Use this procedure to create a circular sweeping and spiral stair. A spiral stair 
revolves about a common center point from bottom to top.

You can specify a radius either directly or on the screen only when the arc 
constraint is free. Otherwise, the radius is determined from the specified 

If you want to . . . Then . . .

change the thickness of 
the floor finish material 
at the top of the stair

enter a value for Top offset.

change the depth of 
the structure at the top 
of the stair

enter a value for Top depth.

change the thickness of 
the floor finish material 
at the bottom of the 
stair

enter a value for Bottom offset.

change the depth of 
the structure at the 
bottom of the stair

enter a value for Bottom depth.
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tread length and arc constraint. In that case, you need to adjust the tread 
length to achieve a desired radius.

Creating a spiral stair

To create a spiral stair with the specified tread depth (T) that occurs at a 
specified distance from the inner edge, first construct the stair with a width 
equal to twice the required distance (A). Next, use Customized Edges to offset 
the outer edge to the desired total width B. The offset distance is equal to B - 
2A.
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Creating a spiral stair with a specified tread depth at a specified distance

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 In Shape, select Spiral.

5 Specify the horizontal orientation of the stair:

If you want to . . . Then . . .

draw the spiral stair in a 
counterclockwise 
direction

select Counterclockwise for Horizontal Orientation.

draw the spiral stair in a 
clockwise direction

select Clockwise for Horizontal Orientation.
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Specifying the horizontal orientation for a spiral stair

6 Specify the vertical orientation of the stair:

NOTE If Terminate with is set to Landing, the vertical orientation is up and 
cannot be changed.

7 Expand Dimensions.

8 Specify stair dimensions:

If you want to . . . Then . . .

draw the stair from this 
floor to the floor above

select Up for Vertical Orientation.

draw the stair from this 
floor to the floor below

select Down for Vertical Orientation.

If you want to . . . Then . . .

specify the width of the 
stair

enter a value for Width. 
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specify the floor-to-
floor height of the stair 

enter a value for Height.

specify the justification 
of the stair

enter a value for Justify. 
The Justify value you select controls the insertion point 
when you place the stair; left, center, or right at the 
beginning of the stair run.

end the stair run with a 
riser

select Riser for Terminate with.

NOTE Stairs which end with a riser will have an overall 
height that is one tread thickness less than the floor-to-
floor height specified. 

NOTE If the vertical orientation is set to Down, 
Terminate with is set to Riser and cannot be changed.

end the stair run with a 
tread

select Tread for Terminate with.

end the stair run with a 
landing

select Landing for Terminate with.

specify the exact radius 
for the spiral stair

select No for Specify On Screen and enter a value for 
Radius.

define the radius for the 
stair dynamically

select Yes for Specify On Screen.

If you want to . . . Then . . .
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specify the overall 
linear length of the stair

select Calculation rules, and then enter a value for 
Straight Length.

� When Straight Length is set to automatic (the icon 

is ), the value is calculated based on the tread 
size and riser count.

� When Straight Length is user-defined (the icon is 

), the stair length is equal to the dimension 
entered, and the other three values are adjusted 
within the code limits.

� When Riser Count is user-defined, the tread depth 
is increased or decreased to accommodate the 
stair.

specify the total 
number of stair risers

select Calculation rules, and then enter a value for Riser 
Count.

� When Riser Count is set to automatic (the icon is 

), the number of risers is based on the overall 
length and overall height of the stair and the code 
limits specified on the Design Rules tab.
The Straight Length value of the stair is adjusted 
automatically.

� When Riser Count is user-defined (the icon is 

), you can specify a value that is used to 
calculate the tread depth and riser height.
If these values fall outside the stair limits, an error 
message is displayed.

specify the height of 
each riser in the stair 
flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon to Riser to 

change it to  and enter a value for Riser.

specify the tread depth 
for each tread in the 
stair flight

� select Calculation rules, set all fields to automatic 

(the icons are ), click the icon next to Tread to 

change it to  and enter a value for Tread. 

You can also specify the Riser count when you set the 
tread depth.

If you want to . . . Then . . .
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NOTE If a value is set to user-defined on the Calculation rules worksheet, it 
can be modified directly in the Property palette.

NOTE If  is displayed next to a field in the Calculation Rules dialog box, 
that field can’t be changed until another field is changed from user-defined 

 to automatic .

9 Select the type of arc constraint to use when creating the spiral stair:

10 Expand Advanced.

11 Specify the Floor Settings:

12 Set the minimum or maximum height or amount of risers in a stair flight.

If you want to . . . Then . . .

create a spiral stair run with no 
constraints

select Free for Arc constraint.

create a spiral stair with a 
specific number of degrees for 
the stair flight

select Total Degrees for Arc constraint and 
enter a value for Arc angle. This includes the 
terminal landing or tread.

create a spiral stair with a 
specific degree for each tread 
in the stair

select Degrees per Tread for Arc constraint 
and enter a value for Arc angle.

If you want to . . . Then . . .

change the thickness of 
the floor finish material 
at the top of the stair

enter a value for Top offset.

change the depth of 
the structure at the top 
of the stair

enter a value for Top depth.

change the thickness of 
the floor finish material 
at the bottom of the 
stair

enter a value for Bottom offset.
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13 Specify the center point for the spiral stair.

14 Specify the location of the stair.

15 Continue adding stairs, and press ENTER.

Creating a Ramp

Use this procedure to create a ramp using stairs. The Ramp-Concrete style (in 
the Stair Styles drawing) includes the correct settings for creating a ramp.

The ramp stringer type should be used for creating ramps. The stringer facets 
display component provide the landing lines for ramps, and an End with 
tread setting makes it so that the connection to the next level works correctly 
instead of having one riser height between the ramp and the surface it should 
meet.

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Import the ramp style from the Stair Styles drawing.

For information about copying styles into your drawing, see “Copying 
Styles between Drawings” on page 545.

2 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

3 On the Properties palette, expand Basic, and expand General.

4 Select the Ramp-Concrete style.

5 Specify the location of the stair.

6 Continue adding stairs, and press ENTER.
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Creating a U-shaped concrete ramp

Creating a Stair Tool

Use this procedure to create a stair tool and add it to a tool palette. You may 
want to create your own stair tools if you are placing multiple stair of specific 
styles with additional stair properties that you want to be the same each time 
you add a stair of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from a stair in the 
drawing

select the stair, and drag it to the tool palette.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the stair created 
from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a stair style.

NOTE If a multi-landing or u-shaped stair is selected, the turn type can be 
set. If the turn type is 1/2 or 1/4 turn, the winder style can be set.

10 Select the drawing file containing the style used for this stair.

11 Click OK.

Editing Stairs

You can edit stairs by changing the style of the stair, the width and height of 
the stair, the size of the tread, and the justification. You can also change con-
straints, components, landing extensions, and location, in addition to the 
style and dimensions.

create a tool from a stair style in 
the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.

If you want to . . . Then . . .
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Autodesk® Architectural Desktop offers several methods for editing stairs:

� You can directly edit stairs using grips for dimensions and other physical 
characteristics.

� You can change stair settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

stair.

Related Procedures

� Using Grips to Edit Stairs

� Changing the Width of a Flight

� Changing the Shape of a Flight

� Changing the Shape of a Landing

� Changing the Side of a Stair

� Changing the Height of a Stair

� Changing the Justification of a Stair

� Changing the Style of a Stair

� Changing the Horizontal Direction of a Spiral or U-shaped Stair

� Changing the Constraints of a Spiral Stair

� Changing the Constraints of a Spiral Stair

� Changing the Outside Edge of a Spiral Stair

� Changing the Dimensions of a Stair

� Changing the Floor Settings of a Stair

� Changing the Length Limits of a Flight

� Anchoring a Stair to a Landing

� Releasing Anchored Stairs

� Editing Winders

� Stair Interference Conditions

� Changing the Alignment of a U-shaped Stair

� Changing the Constraints of a Spiral Stair

� Changing the Components of a Flight

� Changing the Components of a Landing

� Changing the Extension of a Landing

� Changing the Display of an Overlapping Stair

� Applying Tool Properties to an Existing Stair

� Changing the Location of a Stair

� Specifying the Materials of a Stair

� Changing the Display Properties of Individual Stairs
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� Attaching Hyperlinks, Notes, or Files to a Stair

Using Grips to Edit Stairs

When you use grips to edit stairs, the stairway continues to be constrained 
by the design limits and length specified when the stair was created if Auto-
matic Length is set to No. This is the case for all stairs in previous version 
drawings. If you move beyond those limits, a warning symbol is displayed.

Viewing the stairs warning symbol

You can use grips to create multi-landing stairs that have skewed landings 
and angled stair runs. Changing the configuration of a landing may result in 
changes to the stair run.

You can increase or decrease the overall width of the stair run for U-shaped 
stairs. 

The radius and start point can be changed for spiral stairs. You can use grips 
to increase or decrease the overall width of the stair run for spiral stairs. If you 
change the width of the stair after grip editing a side, the changes are lost. 

NOTE You cannot use any of the plan representation grips to alter the floor-
to-floor height. Select the stair in a view direction other than TOP to use a grip 
to change the floor-to-floor height.

Each stair shape has different grips associated with it. 

Relates Procedures

� Using Grips to Edit Straight Stairs

� Using Grips to Edit Multi-Landing Stairs

� Using Grips to Edit U-Shaped Stairs

� Using Grips to Edit Spiral Stairs
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Using Grips to Edit Straight Stairs
Refer to the illustrations and steps in this topic to use straight stair grips to 
edit stairs.

Editing Stair Dimensions

1 Select the straight stair.

2 Select the grip for the dimension you want to change.

Straight Stair Dimension Grips

NOTE The lengthen grips move a straight stair unless it ends with a land-
ing.

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.

Changing the Location or Position of a Straight Stair

1 Select the straight stair.

2 Move the appropriate grip to change the location of the stair, its start 
point, construction line, graphics path, or its endpoint.
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Straight Stair Location Grips

Changing the Height of a Straight Stair

1 Select the straight stair.

2 Move the Height grip to change the height of the stair.

NOTE This grip only displays in 3D views of the stair.
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Straight Stair Height Grip

Using Grips to Edit Multi-Landing Stairs
Refer to the illustrations and steps in this topic to use multi-landing stair 
grips to edit stairs.

Editing Multi-Landing Stair Dimensions

1 Select the multi-landing stair.

2 Select the grip for the dimension you want to change.
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Multi-Landing Stair Dimension Grips

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.

Changing the Location or Position of a Multi-Landing Stair

1 Select the multi-landing stair.

2 Move the appropriate grip to change the location of the stair, its start 
point, construction line, graphics path, or its endpoint.
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Multi-Landing Stair Location Grips

Changing the Shape of Landings for Multi-Landing Stair

1 Select the multi-landing stair.

2 Move the appropriate grip to change the shape of the landing of the stair.
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Multi-Landing Stair Landing Editing Grips

NOTE Once a landing edge has been customized by moving any of the ver-
tex or edge grips, the landing width grips are no longer displayed.

Changing the Location of a Landing for a Multi-Landing Stair

1 Select the multi-landing stair.

2 Move the appropriate grip to change the location of the landing by chang-
ing the location of the turn point for each side of the landing or by mov-
ing the entire landing.
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Multi-Landing Stair Landing Movement Grips

Changing the Construction Line or Graphics Path of a Multi-Landing Stair

1 Select the multi-landing stair.

2 Move the Construction Line or Graphics Path grip.

NOTE Only one of the Construction Line or Graphics Path can be displayed 
at a time. This is controlled on the Other tab of the current plan display rep-
resentation. For information about his setting, see “Specifying the Display of 
Other Characteristics of a Stair” on page 1512.
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Multi-Landing Stair Construction Line and Graphics Path Grips

Changing the Height of a Multi-Landing Stair

1 Select the multi-landing stair.

2 Move the Height grip to change the height of the stair.

NOTE This grip only displays in 3D views of the stair.
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Multi-Landing Stair Height Grip

Using Grips to Edit U-Shaped Stairs
Refer to the illustrations and steps in this topic to use u-shaped stair grips to 
edit stairs.

Editing U-Shaped Stair Dimensions

1 Select the u-shaped stair.

2 Select the grip for the dimension you want to change.
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U-Shaped Stair Dimension Grips

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.

Changing the Location or Position of a U-Shaped Stair

1 Select the u-shaped stair.

2 Move the appropriate grip to change the location of the stair, its start 
point, construction line, graphics path, or its endpoint.
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U-Shaped Stair Location Grips

Changing the Shape of Landings for U-Shaped Stair

1 Select the u-shaped stair.

2 Move the appropriate grip to change the shape of the landing of the stair.

U-Shaped Stair Landing Editing Grips
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Changing the Construction Line or Graphics Path of a U-Shaped Stair

1 Select the u-shaped stair.

2 Move the Construction Line or Graphics Path grip.

NOTE Only one of the Construction Line or Graphics Path can be displayed 
at a time.

3 Move the appropriate Flip grip to flip the stair landing from one side of 
the flight start grip to the other or to switch the two flights.

Multi-Landing Stair Construction Line and Graphics Path Grips

Changing the Height of a U-Shaped Stair

1 Select the u-shaped stair.

2 Move the Height grip to change the height of the stair.

NOTE This grip only displays in 3D views of the stair.
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U-Shaped Stair Height Grip

Using Grips to Edit Spiral Stairs
Refer to the illustrations and steps in this topic to use spiral stair grips to edit 
stairs.

Editing Spiral Stair Dimensions

1 Select the spiral stair.

2 Select the grip for the dimension you want to change.
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Spiral Stair Dimension Grips

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.

Changing the Location or Position of a Spiral Stair

1 Select the spiral stair.

2 Move the appropriate grip to change the location of the stair, its start 
point, construction line, graphics path, or its endpoint. You can also flip 
the stair around the start point, 

Spiral Stair Location Grips

Changing the Height of a Spiral Stair

1 Select the spiral stair.

2 Move the Height grip to change the height of the stair.
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NOTE This grip only displays in 3D views of the stair.

Spiral Stair Height Grip

Changing the Width of a Flight

Use this procedure to change width of a stair flight. You can also change the 
stair width on the Properties palette.

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

NOTE If you change the width of the stair after grip editing a side, the grip 
changes are lost.

1 Select the stair.
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2 Select a Flight Width grip, move the grip until the width value you want 
is displayed, and click once.

After selecting a grip, you can also enter a precise value to increase or 
decrease the width of the stair.

The entire edge of the flight moves to the selected location. The flight 
entry width also changes to fit the new stair width.
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Using grips to change stair flight width

Changing the Shape of a Flight

Use this procedure to change the top and bottom width of a single flight on 
U-shaped, multi-landing, or spiral shape stairs. Each side of a flight can be 
tapered independently using grip points. 
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For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

NOTE If you change the width of the stair after grip editing a side, the grip 
changes are lost.

1 Select the stair to modify.

2 Select the Flight Taper grip on the stair flight, and move the grip away 
from stair path to new location. 

The flight changes to the new shape.
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Using grips to change stair flight taper
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Changing the Shape of a Landing

Use this procedure to change the angles and positions of landing edges on U-
shaped and multi-landing stairs. Each edge of a landing can be tapered or 
moved independently using grip points.

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

NOTE If you change the width of the stair after grip editing a side, the grip 
changes are lost.

1 Select the stair to modify.

2 Select a Vertex grip on the landing, and move the grip away from the stair 
path to a new location.

The landing changes to the new shape. If the vertex grip is shared between 
a landing and flight, the flight moves with the landing.

3 Select an Edge grip on the landing, and move the grip perpendicular to the 
stair path to new location. 

The entire edge of the landing moves to the selected location.
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Using grips to change a stair landing width by adding an edge

4 Select an Edge grip on the side of a landing, press CTRL then move the grip 
away from the stair path.

An adjacent edge of the landing is created.

Changing the Side of a Stair

You can determine the shape of one edge of a stair run that includes flights 
and landings, for straight, U-shaped, multi-landing, or spiral stairs. 
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The size of the landing must be adjusted to prevent overlapping treads when 
the inner edge of a stair is projected to a profile that lies outside of the origi-
nal stair. The initial size of the landing is determined by projecting the 
diagonal of the original landing to the profile.

Using grips to change a stair landing width

Pushing one tread into the landing with its grip results in forcing the landing 
to lengthen in the other direction. Pulling one tread away from the landing 
does not affect the other end of the landing. The stair is automatically 
lengthened at its top, to accommodate the larger landing. You can modify 
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the length with the top and bottom grips, at the end of the stair walking 
path.

Related Topics and Procedures

� About Projecting the Side of a Stair

� Projecting the Side of a Stair

� Offsetting the Side of a Stair

� Generating a Polyline from the Edge of a Stair

� Removing Changes from the Side of a Stair

About Projecting the Side of a Stair
You can project the edge of a stair to most AEC objects (such as walls or mass 
elements, but excluding multi-view blocks).

Projecting a stair edge to an object

NOTE In the case of projection of an edge of a stair that has an inner corner, 
it is clear how to project the outer edge of the stair to the selected object, but 
projection of the inner corner is ambiguous. Rather than attempting to guess the 
correct solution, these cases are not projected, and a dialog box is displayed with 
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an explanation that edges of stairs with interior corners can be projected only to 
objects that extend beyond both ends of the stair.

The stair length is extended at its original width when the object (or 
polyline) does not extend far enough for the stair to project completely.

Projecting the Side of a Stair
Use this procedure to project the side of a stair to an existing polyline, wall, 
other AEC object, or solid. Objects to project to must extend the full length 
of the stair for an interior corner to project properly.

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

Projecting stair edges to a curved polyline
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NOTE If you change the width of the stair after projecting a side, the changes 
to the projected edge are lost. 

1 Select a stair, right-click, and click Customize Edge ➤ Project.

2 Select the edge of a stair to change.

3 Select a polyline, object or profile to project to, and press ENTER. 
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Treads are extended using the line of the current front and back edge.

NOTE If edges intersect, which can happen with only spiral and winding 
shapes, a defect marker is displayed.

Offsetting the Side of a Stair
Use this procedure to offset the side of a stair flight by a specified value.

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

NOTE If you change the width of the stair after offsetting a side, the offset 
changes are lost. 

1 Select a stair, right-click, and click Customize Edge ➤ Offset.

2 Select the edge of a stair to be offset.

3 Enter the distance to offset, where positive is out and negative is in and 
press ENTER. 

Treads are extended using the line of the current front and back edge.
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Offsetting the edge of a stair

NOTE If edges intersect, which can happen with only spiral and winding 
shapes, a defect marker is displayed.

Generating a Polyline from the Edge of a Stair
Use this procedure to generate a polyline from the edge of a stair. The 
polyline is generated at the stair bottom elevation. 

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

You can keep some sample polylines in the drawing, and use the final choice 
to project to. That way, you can project the stair edge, edit the stair, then gen-
erate the polyline, change the stair again, generate another polyline, change 
the stair some more, and finally project to the best version you created.

Generating a polyline from a stair edge

1 Select a stair, right-click, and click Customize Edge ➤ Generate Poly-
line.

2 Select the edge of a stair.

3 Press ENTER.

A polyline is created at the stair bottom elevation along the length of the stair 
run.
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Removing Changes from the Side of a Stair
Use this procedure to return the selected edge of the stair to its default profile. 
If the stair is back to its original condition, the Width is restored to the orig-
inal value, rather than *VARIES*. This change affects the treads, risers, and 
stringers. 

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

Removing changes made to the side of a stair

1 Select a stair, right-click, and click Customize Edge ➤ Remove Custom-
ization.

2 Select the edge of a stair.

3 Press ENTER.

Changing the Height of a Stair

Use this procedure to change the height of a stair. You can also change the 
stair height on the Properties palette.

For more information about stair grips, see “Using Grips to Edit Stairs” on 
page 1443.

1 Select the stair in an isometric view.

2 Select the Height grip, move the grip until the value you want is displayed, 
and click once.

After selecting a grip, you can also enter a precise value to increase or 
decrease the height of the stair.

NOTE If you edit the height of a stair with landings, so that a landing would 
be below the new height, the landing is not displayed. If you edit the height 
again, and move it to a location above the previous landing, the landing is no 
longer there. To retain the stair path which includes the landing, use the Aec-
StairFit command to set Automatic Landings to No.
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Changing the Justification of a Stair

Use this procedure to change the justification of an individual stair. The stair 
remains in the same location, but changes in the width keep the new justifi-
cation point constant.

For example, a stair that has right justification changes the left edge when 
the width is changed.

1 Select the stair you want to change, and double-click it.

2 On the Properties palette, expand Basic, and expand General.

3 Select Left, Center, or Right for Justify.

This does not change the location of the stair, but changing this value 
specifies the point from which changes to the width are calculated from 
this point forward.

Changing the Style of a Stair

Use this procedure to select a different stair style for one or more stairs.

1 Select the stairs to change, and double-click one of them.

2 Expand Basic, and expand General.

3 Select a different style.

Changing the Horizontal Direction of a Spiral or 
U-shaped Stair

Use this procedure to change the orientation of a spiral stair.

1 Select a spiral or u-shaped stair.

2 Specify the horizontal orientation of the stair:

If you want to . . . Then . . .

draw the spiral or u-
shaped stair in a 
counterclockwise 
direction

select Counterclockwise for Horizontal Orientation.

draw the spiral or u-
shaped stair in a 
clockwise direction

select Clockwise for Horizontal Orientation.
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NOTE This is equivalent to selecting the flip grip that mirrors the stair 
around its start point.

Changing the Constraints of a Spiral Stair

Use this procedure to control what constrains the spiral stair by specifying a 
total degree amount or how many degrees per tread to use. These fields are 
available only when you select a spiral-shaped stair to modify.

1 Select a spiral stair.

2 Specify the arc constraint:

3 Specify the Radius of the stair.

The radius is measured from the center point of the spiral stair to the 
selected justification point. 

If you want to . . . Then . . .

display the spiral stair 
with no constraint

select Free for Arc Constraint.

specify the total 
degrees for the stair 
flight

select Total Degrees for Arc Constraint, and enter a 
value for Arc Angle.

specify the specific 
degree for each tread 
in the stair

select Degrees per Tread for Arc Constraint, and enter 
a value for Arc Angle.
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4 Click OK.

Changing the Outside Edge of a Spiral Stair

Use this procedure to change the outside edge of a spiral stair. You can change 
the edge in two ways:

� When you use the Flight Width grip point, you uniformly change the 
width of the stair along the entire arc. The endpoints of the outer edges of 
the stair move. This changes the size of the stair.

� When you click the Flight Width grip point and press CTRL, you maintain 
the center of the stair and the outside grip points. This changes the shape 
of the stair.

1 Select a spiral stair.
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2 Change a spiral stair:

3 Move the grip to change the size or shape of the stair. 

If you want to . . . Then . . .

uniformly change the width of a spiral 
stair along the entire arc

click the Flight Width grip of the spiral 
stair.

maintain the center and outside grip 
points while changing the shape of a 
spiral stair

click the Flight Width grip of the spiral 
stair and press CTRL.
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Using grips to change the flight width of a spiral stair run
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Using grips to change the flight width of a spiral stair run by adding an edge

Changing the Dimensions of a Stair

Use this procedure to control the various dimensions associated with calcu-
lating the stair.

Some of the interacting dimensions can be user-defined and some are auto-
matic, depending upon the combination of fields that are selected. Only log-
ical combinations are available when the rule based calculator is in effect. 
When the rule-based calculator is not in effect, either tread or straight length 
can be user-defined and either riser count or riser height can be user-defined. 

1 Select the stair.
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2 On the Properties palette, expand Basic, and expand Dimensions.

3 Change any of the dimensions of the stair:

4 Select Calculation rules:

If you want to . . . Then . . .

specify the width of the 
stair run

enter a value for Width.

NOTE If you change the width of the stair after grip 
or otherwise customizing an edge, the changes are 
lost.

specify the floor-to-
floor height for the 
stair

enter a value for Height.

specify the justification 
of the stair

select Left, Center, or Right for Justify.
This does not change the location of the stair, but 
changing this value determines the point from which 
the width is calculated if it is subsequently changed.
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If you want to . . . Then . . .

specify the overall 
linear length of the 
stair

enter a value for Straight Length.

� When Straight Length is set to automatic (the 

icon is ), the value is calculated based on 
the tread size and riser count.

� When Straight Length is user-defined (the icon is 

), the stair length is equal to the dimension 
entered, and the other three values are adjusted 
within the code limits.
If these values fall outside the stair limits, an error 
message is displayed.

� When Riser Count is user-defined, the tread 
depth is increased or decreased to 
accommodate the stair.

specify the total 
number of stair risers

enter a value for Riser Count.

� When Riser Count is set to automatic (the icon is 

), the number of risers is based on the 
overall length and overall height of the stair and 
the code limits specified on the Design Rules tab.
The Straight Length value of the stair is adjusted 
automatically.

� When Riser Count is user-defined (the icon is 

), you can specify a value that is used to 
calculate the tread depth and riser height.

� If these values fall outside the stair limits, an error 
message is displayed.
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NOTE If  is displayed next to a field in the Calculation Rules dialog box, 
that field can’t be changed until another field is changed from user-defined 

 to automatic .

Changing the Floor Settings of a Stair

Use this procedure to control how the stair interacts with the floor at the 
beginning and end of the stair run.

1 Select a stair.

2 On the Properties palette, expand Advanced, and expand Floor Settings.

specify the height of 
each riser in the stair 
flight

� set all fields to automatic (the icons are ), 

click the icon to Riser to change it to  and 
enter a value for Riser height.

specify the tread depth 
for each tread in the 
stair flight

� set all fields to automatic (the icons are ), 

click the icon next to Tread to change it to  
and enter a value for Tread depth. 

You can also specify the Riser count when you set the 
tread depth.

If you want to . . . Then . . .
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3 Change settings for how the stair meets the top and bottom floors:

NOTE The Top and Bottom Depth settings currently have no effect on the 
stair or stringers. In addition, the top offset has no visible effect on the stair. 
Bottom offset extends or truncates any attached stringers. Both offset values 
affect the rough floor-to-floor height, if it is displayed. 

Changing the Length Limits of a Flight

Use this procedure to change the limits for the flight of a stair. A flight can 
have no limits, or limits that are constrained by a minimum number of risers, 
minimum height, maximum number of risers, or a maximum height.

Use these settings to create automatic landings in a stair flight. For example, 
if a stair flight has 18 treads and you set the maximum treads to 15, the stair 
will have two flights with one landing in the middle, keeping under the 15 
maximum risers on wither side of the landing.

If you want to . . . Then . . .

specify the thickness of 
the floor finish material 
at the top floor of the 
stair

enter a value for Top Offset.

specify the depth of 
the structure at the top 
floor

enter a value for Top Depth.

specify the thickness of 
the floor finish material 
at the bottom floor of 
the stair

enter a value for Bottom Offset.

specify the depth of 
the structure at the 
bottom floor

enter a value for Bottom Depth.
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Specifying flight height limits for a stair run

1 Select a stair.

2 On the Properties palette, expand Advanced, and expand Flight Height.

Flight Height with Risers Limit Type

3 Specify the constraints for flight length:

If you want to . . . Then . . .

specify no limits on the 
flight

select None for Minimum Limit type and None for 
Maximum Limit type.

specify a minimum 
number of risers per 
flight

select Risers for Minimum Limit type, and enter a 
value for Minimum risers.

specify a minimum 
height for the flight

select Height for Minimum Limit type, and enter a 
value for Minimum height.

specify a maximum 
number of risers per 
flight

select Risers for Maximum Limit type, and enter a 
value for Maximum risers.

specify a maximum 
height for the flight

select Height for Maximum Limit type, and enter a 
value for Maximum height.
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Anchoring a Stair to a Landing

Use this procedure to anchor a landing to an existing landing.

1 Draw a stair with a landing and a second stair to attach to the landing. See 
“Using Stair Tools to Create Stairs” on page 1413 for more information 
about creating stairs.

2 Select the stair to anchor to a landing.

3 Select the stair to anchor to a landing, right-click, and click Stair Landing 
Anchor ➤ Anchor to Landing.

4 Select a location on the landing to anchor the center of the start of the 
stair run. The flight will be perpendicular to the landing edge.
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Anchoring a stair run to a landing

NOTE Stairs created with a Vertical Orientation of Up go up from the land-
ing while stairs created with a Vertical Orientation of Down go down from the 
landing.
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This is a good situation in which to use the renumber riser numbering fea-
ture. See “Specifying the Riser Numbering Display for Individual Stairs” on 

page 1514.

Releasing Anchored Stairs

Use this procedure to release stairs anchored to landings.

� Select the stair to anchored to the landing, right-click, and click Stair 
Landing Anchor ➤ Release.

NOTE The stair remains in the same location, but is no longer anchored to 
the landing.

Editing Winders

There are three different winder types which give you different levels of con-
trol for 1/2 turn and 1/4 turn stairs.

For information about creating new winder styles, see “Creating a Stair 
Winder Style” on page 1535.

Balanced Winder Style
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Single Point Winder Style

Related Procedures

� Editing Winders with the Single Point Winder Style

� Editing Winders with the Manual Winder Style

Editing Winders with the Single Point Winder Style
Use this procedure to change the winders defined by the Single Point winder 
style. With Single Point in a 1/4 turn stair, a turn zone is defined by project-
ing two lines perpendicular to the stair flight’s construction line from the 
Turn Center grip. With Single Point in a 1/2 turn stair, the turn zone by pro-
jecting two lines perpendicular to the stair flight’s construction line if it is 
possible. 

The winders within the turn zone are set to an angle converging on the Turn 
Center grip.

1 Select a 1/2 turn or 1/4 turn stair.

2 If the Winder Style is balanced, select the circular Edit Turns trigger grip. 
The Select Winder styles dialog box displays.

NOTE Only the winder styles present in the drawing are displayed.
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3 Select a Single Point style from the list and click OK.

NOTE To select the style from the Properties palette, expand Basic, expand 
General and select Single Point for Winder Style.

4 Select the Edit Turns trigger grip.
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NOTE To have the converging point on the edge of the stair, you must 
uncheck the Use Riser Lines setting. See “Specifying the Stair Winder Style 
Settings” on page 1536. for more information about this setting.

5 Click and drag the Turn Center grip to change the winders in the turn 
zone.
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Editing Winders with the Manual Winder Style
Use this procedure to change individual winders. Each winder is moved 
based on its intersection with the stair’s Construction Line.

The grips are placed at the end of the riser or tread line, based on the Use Riser 
Line setting in the Stair Winder Style dialog box. For more information, see 
“Specifying the Stair Winder Style Settings” on page 1536.

1 Select a 1/2 turn or 1/4 turn stair.

2 If the Winder Style is balanced, select the circular Edit Turns trigger grip. 
The Select Winder styles dialog box displays.

3 Select a Manual style from the list and click OK.

NOTE To select the style from the Properties palette, expand Basic, expand 
General and select Manual for Winder Style.

4 Select the Edit Turns trigger grip.
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NOTE Because the tread depth must be the same for each tread, the tread 
line will pivot around the construction line.

5 Click a Tread End or Riser End grip and drag it. The individual tread or riser 
changes to the selected angle.

Stair Interference Conditions

You can control the height and width of a stair’s interference condition with 
walls, slabs, spaces, curtain walls, and door and window assemblies. When 
you add an interference condition between a stair and one of the valid 
objects, a box is cut out around the stair based on the specified headroom 
height and side clearance.

Related Procedures

� Creating an Interference Condition in a Wall
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� Removing a Stair Interference Condition from a Wall

� Creating an Interference Condition in a Slab

� Removing a Stair Interference Condition from a Slab

� Creating an Interference Condition in a Space

� Removing a Stair Interference Condition from a Space

� Creating an Interference Condition in a Curtain Wall

� Removing a Stair Interference Condition from a Curtain Wall

� Creating an Interference Condition in a Door/Window Assembly

� Removing a Stair Interference Condition from a Door/Window Assembly

� Changing the Interference Size of a Stair

Creating an Interference Condition in a Wall
Use this procedure to create a stair interference area in a wall. When you add 
an interference condition between a stair and a wall, an opening is created in 
the wall around the stair based on the stair’s specified headroom height and 
side clearance.

1 Create a stair that intersects with a wall. See “Using Stair Tools to Create 
Stairs” on page 1413for information about creating stairs.

2 On the Properties palette, expand Advanced, and expand Interference.

3 Set the size of the interference condition.

4 Click in the drawing to deselect the stair.

5 Select the wall to intersect, right-click, and click Interference 
Condition ➤ Add.

6 Select the stair.

7 Select the shrinkwrap effect and press ENTER. See “Working with Interfer-
ence Conditions” on page 1861for more information about shrinkwrap-
ping.

If you want to . . . Then . . .

specify the height above the treads for the 
interference condition

enter a value for 
Headroom height.

specify the width of the interference condition on 
all sides of a stair run, other than where you stop on 
and off at the first and last treads

enter a value for Side 
clearance.
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NOTE The size of the intersection with the wall automatically changes if 
you change the Interference values of the stair.

Removing a Stair Interference Condition from a Wall
Use this procedure to remove a stair interference from a wall.

1 Click in the drawing to deselect the stair.

2 Select the wall to remove the interference from, right-click, and click 
Interference Condition ➤ Remove.

3 Select the stair and press ENTER.

Creating an Interference Condition in a Slab
Use this procedure to create a stair interference area in a slab. When you add 
an interference condition between a stair and a slab, a box is cut out around 
the stair from the slab based on the specified headroom height and side clear-
ance.

1 Create a stair that intersects with a slab. See “Using Stair Tools to Create 
Stairs” on page 1413for information about creating stairs.

2 On the Properties palette, expand Advanced, and expand Interference.

3 Set the size of the interference condition.

4 Click in the drawing to deselect the stair.

5 Select the slab to intersect, right-click, and click Boolean ➤ Subtract.

6 Select the stair and press ENTER.

If you want to . . . Then . . .

specify the height above the treads for the 
interference condition

enter a value for 
Headroom height.

specify the width of the interference condition on 
all sides of a stair run, other than where you stop on 
and off at the first and last treads

enter a value for Side 
clearance.
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Creating a slab and stair interference condition

NOTE The size of the intersection with the slab automatically changes if 
you change the Interference values of the stair.

Removing a Stair Interference Condition from a Slab
Use this procedure to remove a stair interference from a slab.

1 Select the slab to remove the interference from, right-click, and click Bool-
ean ➤ Detach.

2 Select the stair and press ENTER.
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Creating a wall and stair interference condition
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Creating an Interference Condition in a Space
Use this procedure to create a stair interference area in a space. When you add 
an interference condition between a stair and a space, a box is cut out around 
the stair from the space based on the specified headroom height and side 
clearance.

1 Create a stair that intersects with a space. See “Using Stair Tools to Create 
Stairs” on page 1413 for information about creating stairs.

2 On the Properties palette, expand Advanced, and expand Interference.

3 Set the size of the interference condition.

4 Click in the drawing to deselect the stair.

5 Select the space to intersect, right-click, and click Interference Condition.

6 Enter a (Add), select the space, and press ENTER.

7 Select the stair and press ENTER twice.

NOTE The size of the intersection with the space automatically changes if 
you change the Interference values of the stair.

Removing a Stair Interference Condition from a Space
Use this procedure to remove a stair interference from a space.

1 Select the space to remove the interference from, right-click, and click 
Interference Condition.

2 Enter r (Remove), select the space, and press ENTER.

3 Select the stair and press ENTER twice.

If you want to . . . Then . . .

specify the height above the treads for the 
interference condition

enter a value for 
Headroom height.

specify the width of the interference condition on 
all sides of a stair run, other than where you stop on 
and off at the first and last treads

enter a value for Side 
clearance.
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Creating an Interference Condition in a Curtain Wall
Use this procedure to create a stair interference area in a curtain wall. When 
you add an interference condition between a stair and a curtain wall, a box 
is cut out around the stair from the wall based on the specified headroom 
height and side clearance. You have the option of cutting the infills, frames 
and mullions of the curtain wall.

1 Create a stair that intersects with a curtain wall. See “Using Stair Tools to 
Create Stairs” on page 1413for information about creating stairs.

2 On the Properties palette, expand Advanced, and expand Interference.

3 Set the size of the interference condition.

4 Click in the drawing to deselect the stair.

5 Select the curtain wall to intersect, right-click, and click Interference 
Condition ➤ Add.

6 Select the stair.

7 Specify whether to apply the interference condition to the infill of the cur-
tain wall.

8 Specify whether to apply the interference condition to the frames of the 
curtain wall.

9 Specify whether to apply the interference condition to the mullions of the 
curtain wall.

Removing a Stair Interference Condition from a Curtain Wall
Use this procedure to remove a stair interference from a curtain wall.

1 Click in the drawing to deselect the stair.

2 Select the curtain wall to remove the interference from, right-click, and 
click Interference Condition ➤ Remove.

If you want to . . . Then . . .

specify the height above the treads for the 
interference condition

enter a value for 
Headroom height.

specify the width of the interference condition on 
all sides of a stair run, other than where you stop on 
and off at the first and last treads

enter a value for Side 
clearance.
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3 Select the stair and press ENTER.

Creating an Interference Condition in a Door/Window 
Assembly
Use this procedure to create a stair interference area in a door/window assem-
bly. When you add an interference condition between a stair and a door/win-
dow assembly, a box is cut out around the stair from the door/window assem-
bly based on the specified headroom height and side clearance. You have the 
option of cutting the infills, frames and mullions of the door/window assem-
bly.

1 Create a stair that intersects with a door/window assembly. See “Using 
Stair Tools to Create Stairs” on page 1413for information about creating 
stairs.

2 On the Properties palette, expand Advanced, and expand Interference.

3 Set the size of the interference condition.

4 Click in the drawing to deselect the stair.

5 Select the door/window assembly to intersect, right-click, and click Inter-
ference Condition ➤ Add.

6 Select the stair.

7 Specify whether to apply the interference condition to the infill of the 
door/window assembly.

8 Specify whether to apply the interference condition to the frames of the 
door/window assembly.

9 Specify whether to apply the interference condition to the mullions of the 
door/window assembly.

If you want to . . . Then . . .

specify the height above the treads for the 
interference condition

enter a value for 
Headroom height.

specify the width of the interference condition on 
all sides of a stair run, other than where you stop on 
and off at the first and last treads

enter a value for Side 
clearance.
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Removing a Stair Interference Condition from a Door/Window 
Assembly
Use this procedure to remove a stair interference from a door/window assem-
bly.

1 Click in the drawing to deselect the stair.

2 Select the door/window assembly to remove the interference from, right-
click, and click Interference Condition ➤ Remove.

3 Select the stair and press ENTER.

Changing the Interference Size of a Stair
Use this procedure to control the size of the stair interference area. 

Specifying headroom height and side clearance for a stair and a space object

1 Select the stair.

2 On the Properties palette, expand Advanced, and expand Interference.
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3 Change the values for stair interference:

Changing the Alignment of a U-shaped Stair

Use this procedure to change the alignment and the alignment offset of a U-
shaped stair. These fields are available only when you select a U-shaped stair 
to modify.

1 Select a u-shaped stair.

2 On the Properties palette, expand Advanced, and expand Constraints.

3 Specify the alignment of a U-shaped stair:

4 Specify a value for Alignment offset.

When you select Tread to Tread, Tread to Riser, or Riser to Riser, you can 
specify an offset value. A positive offset value means that the down flight 
tread location is closer to landing than the up flight tread location.

If you want to . . . Then . . .

specify the height above the treads for the 
interference condition

enter a value for 
Headroom height.

specify the width of the interference condition on 
all sides of a stair run, other than where you stop on 
and off at the first and last treads

enter a value for Side 
clearance.

If you want to . . . Then . . .

place the treads and risers where necessary to 
complete the stair

select Free for 
Alignment.

align the tread of the up flight to the tread of the 
down flight

select Tread to Tread for 
Alignment.

align the tread of the up flight to the riser of the 
down flight

select Tread to Riser for 
Alignment.

align the riser of the up flight to the riser of the 
down flight

select Riser to Riser for 
Alignment.
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Specifying tread to riser alignment offsets

5 Specify a value for Extend alignment.

6 Specify a value for Uneven tread on which specifies which flight will be 
longer if the total number of treads is uneven. Select Upper flight to place 
the Uneven tread on the upper flight. Select Lower flight to place the 
uneven tread on the lower flight.

Changing the Components of a Flight

Use this procedure to change the tread, riser thickness, and nosing length for 
each stair. You can also turn on or off the display of the tread and riser.

NOTE If component settings are unavailable, they are controlled by the stair 
style, and you cannot change them for individual stairs.

1 Select the stair.

2 On the Properties palette, expand Advanced, expand Worksheets, and 
click in Components.
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3 Under Flight Dimensions, select or clear the display of treads and risers.

When the tread or riser display is off, the corresponding thickness 
becomes unavailable.

4 Specify the flight dimensions:

5 Click OK.

Changing the Components of a Landing

Use this procedure to change the landing thickness and specify additional 
width for stair landings.

If you want to . . . Then . . .

specify the thickness of 
each tread

select Tread, and enter a value for Tread Thickness.

specify the thickness of 
the riser

select Riser, and enter a value for Riser Thickness.

specify the length of 
the edge of a stair 
tread that projects over 
the riser

enter a value for Nosing Length.

specify sloping risers select Sloping Riser.
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NOTE If component settings are unavailable, they are controlled by the stair 
style, and you cannot change them for individual stairs.

1 Select the stair.

2 On the Properties palette, expand Advanced, expand Worksheets, and 
click in Components.

3 Enter a value for Landing Thickness.

4 Enter a value for Additional Width.

The type of landing and the justification of the stair determine where the 
additional width is added to the landing.

Adding width to a quarter landing
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Adding width to a half landing

5 Click OK.

About the Dimensions of Landing Components

Landing components are specified as part of style, but apply only to multi-
landing and U-shaped stairs. Stringer dimensions are specified for the flight 
and landing in a single table. The flight stringer type (slab, housed, or sad-
dled) controls what is available for the landing (total depth only for housed 
and ramp, waist depth for all types). If the flight has no stringers, the landing 
has none.

All landings of a single stair initially use the same dimensions. You can then 
customize each one separately by grip stretching or projection. Horizontal 
positions and the widths of stringers are identical between flights and 
landings. 

Landing extension values apply only to U-shaped and multi-landing stairs 
with flat landings. Landing specific dimensions are ignored for turn landings. 
The default values for styles in the Stair Styles drawing are specified in accor-
dance with the most common situation for stairs.

If the option to resolve the meeting of flight and landing stringers is left off, 
the flight stringer terminates at the landing.

Changing the Extension of a Landing

Use this procedure to change the distances between landings and treads and 
the stringer resolution for stairs. You can differentiate the size of landing 
components from those used for the stair flights. 
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NOTE If settings for landing extensions are unavailable, they are controlled by 
the stair style, and you cannot change them for individual stairs.

1 Select the stair.

2 On the Properties palette, expand Advanced, expand Worksheets, and 
click in Landing extensions.

3 Specify the extension distances:

For more information about landing extensions and stringer resolution, 
see “About the Dimensions of Landing Components” on page 1503.

4 Under Stringer Resolution, select Extend Landings to Merge Flight String-
ers with Landing Stringers to automatically merge the flight stringers with 
the landing stringers. 

If you want to . . . Then . . .

add to the distance to 
the first tread on the 
down side of the 
landing

enter a value for Distance to First Tread DOWN.
To extend the landing down by a single tread, select 
Add Tread Depth.

add to the distance to 
the first tread on the 
up side of the landing

enter a value for Distance to First Tread UP.
To extend the landing up by a single tread, select 
Add Tread Depth.
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This provides additional landing extension, if necessary, to make the 
flight stringers meet the landing stringers without any discontinuity.

NOTE Automatic landing settings are always controlled by the stair style.

5 Click OK.

Stairs created in previous versions of Autodesk Architectural Desktop have 
the setting for Extend Landings to Prevent Risers and Treads Sitting Under 
Landings turned on. This should be turned off to achieve flush or rectangular 
landings, but it will change the position of the top or bottom of the stair, 
which may require adjusting other building objects.

Changing the Display of an Overlapping Stair

Use this procedure to create an overlapping stair and set the display proper-
ties to view the overlapped section correctly.

To set the stair display, the Plan Overlapping display rep needs to be turned 
on and specific components need to be set. For the overlapping stairs, in 
addition to the usual up and down groups there are 4 other groups of display 
components only available in Plan Overlapping.

1 Open the tool palette that you want to use, and select a stair tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

Display rep group Definition

“components” up (above overlap) These are the stair components below the 
cut height that are above the overlap 
section.

“components” down (above overlap) These are the stair components above the 
cut height that are above the overlap 
section.

“components” up (below overlap) These are the stair components below the 
cut height that are below the overlap 
section.

“components” down (below overlap) These are the stair components above the 
cut height that are below the overlap 
section.
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3 Select a style.

4 In Shape, select Multi-landing.

5 Specify the1/2 landing for turn type.

6 Draw a multi-landing stair that overlaps itself.

Viewing an overlapping stair condition

7 On the Format menu, click Display Manager.

8 Expand Sets and select whichever display set is current (in bold).

9 Click the Display Representation Control tab. Scroll to the Stair object.

10 Turn on Plan Overlapping in addition to the current display representa-
tion, and click OK.

11 For this example, we are going to display all components of the stair above 
the overlap section outlined in red. Select the stair, right-click, and click 
Edit Object Display.

12 Click the Display Properties tab. 

13 Click Object Override for Plan, Plan Low Detail, or Plan High Detail, 
whichever is displayed in the current display set. Select all the compo-
nents and turn the visibility off, and click OK.

14 Click Object Override for Plan Overlapping. Select the desired compo-
nents and turn the visibility on. For this example, turn the visibility on for 
Riser up, Nosing up, Path up, Outline up, Riser down, Nosing down, Path 
down, Outline down, Riser down (above overlap), Nosing down (above 
overlap), Path down (above overlap), Outline down (above overlap), Riser 
down (below overlap), Nosing down (below overlap), Path down (below 
overlap), and Outline down (below overlap).

15 Select Riser down (above overlap), Nosing down (above overlap), Path 
down (above overlap), and Outline down (above overlap). Select any of 
the colors from the selected components, select red in the Select Color dia-
log box and click OK twice.
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NOTE If the stair style includes stringers, they should be added to the set 
of components.

16 Click OK twice.

Applying Tool Properties to an Existing Stair

Use this procedure to apply the properties of a stair tool to one or more exist-
ing stairs. The properties include the stair style and any other settings speci-
fied in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a stair tool, and click Apply Tool Properties to Stair.

3 Select the stairs, and press ENTER.

4 Edit the properties of the stairs in the Properties palette, if needed.

NOTE Some tool properties cannot be applied to existing stairs. For example, 
stair shape and turn type will not change. In addition, some properties may be 
incompatible with existing stairs. For example, a stair that has a vertical orienta-
tion of Down cannot terminate with a landing.

Changing the Location of a Stair

Use this procedure to relocate a stair by changing the coordinate values of its 
insertion point. The stair also has an orientation with respect to the WCS or 
the current UCS. For example, if the top and bottom of the stair are parallel 
to the XY plane, its normal is parallel to the Z axis. You can change the ori-
entation of the stair by aligning its normal with another axis. You can also 
rotate the stair on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2002 User’s Guide.

1 Double-click the stair you want to change.

2 In the Properties palette, expand Basic, and expand Location.

3 Select Additional information.
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4 Specify the location of the stair:

5 Click OK.

Specifying the Materials of a Stair

Use this procedure to select a different material for components of an indi-
vidual stair.

To change the materials assigned to all stairs of the same stair style, see 
“Assigning Materials to a Stair Style” on page 1527.

NOTE If a material assignment does not determine the display properties of a 
stair component, you can change the properties of the display component as 
described in “Specifying the Display Properties of a Stair Style” on page 1528.

1 Select the stair you want to change, right-click, and click Edit Object Dis-
play.

2 To verify that the material assignment determines the display properties 
of the component, click the Display Properties tab, select the display rep-

resentation where you want the changes to appear, and click .

NOTE Only the Model display representation supports properties By Mate-
rial.

If you want to . . . Then . . .

relocate the stair enter new coordinate values under Insertion Point.

locate the stair on the XY 
plane

make the normal of the stair parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the stair on the YZ 
plane

make the normal of the stair parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the stair on the XZ 
plane

make the normal of the stair parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
stair

enter a new value for Rotation Angle.
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3 Click the Layer/Color/Linetype tab, verify that By Material is selected for 
the component, and click OK.

4 Click the Materials tab.

5 Select the component you want to change, select Object Override, and 
select a different material definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

6 Click OK.

Changing the Display Properties of Individual 
Stairs

In most cases, you want the appearance of stairs that belong to the same style 
to be consistent throughout a drawing. However, in certain instances, you 
may need to override a display property for an individual stair to achieve a 
specific result. All the display properties that you can specify in stair styles 
are available for individual stairs:

� Whether the display properties of stair components are determined by 
material assignments

� The layer, color, and linetype of the display components of the stair
� The cut plane height and the display of components relative to the cut 

plane
� Other specific stair display information, such as riser numbering

When you change the display properties of an individual stair, the changes 
apply only to that stair. Other stairs of the same style are not affected. To 
change the display properties of all stairs of a specific stair style, see “Stair 
Styles” on page 1516.

Related Procedures

� Specifying the Layer, Color, and Linetype of a Stair

� Specifying the Cut Plane Display of a Stair

� Specifying the Display of Other Characteristics of a Stair

� Specifying the Riser Numbering Display for Individual Stairs



1510 | Chapter 21 Stairs

Specifying the Layer, Color, and Linetype of a Stair
Use this procedure to change the following display properties of the compo-
nents of an individual stair: 

� Visibility (component is on or off)
� By material (a material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

To change these display properties for all stairs of the same stair style, see 
“Specifying the Display Properties of a Stair Style” on page 1528.

NOTE If a material assignment determines the properties of a stair display 
component, you can change the properties of the display component by clear-
ing By Material or by overriding the material assignment with a different mate-
rial. For more information, see “Specifying the Materials of a Stair” on 
page 1508.

1 Select the stair you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Specifying the Cut Plane Display of a Stair
Use this procedure to specify the properties of one or more cut planes for an 
individual stair. Cut plane display properties apply only to display represen-
tations, such as Plan, that are used in the Top view (plan view) of a drawing.
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To change the cut plane display properties for all stairs of the same stair style, 
see “Specifying the Display of Other Characteristics of a Stair Style” on 
page 1530.

1 Select the stair you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Other tab.

6 Click Override Display Configuration Cut Plane to change the elevation 
of the Display Configuration cut plane for the stair.

NOTE When the Display Configuration Cut Plane is used, stairs display only 
from the current floor elevation up to the cut height, and from the current 
floor elevation down to the appropriate cut height of the level below.

7 Enter a value for Elevation.

8 Enter a value for Distance to change the space between the two cut plane 
lines.
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9 Enter a value for Angle to change the angle of the stair cut lines.

10 Click OK twice.

Specifying the Display of Other Characteristics of a Stair
Use this procedure to specify other display properties for an individual stair, 
such as how to display the arrow in the path, which Display Path to show, 
and what type of break mark to use in the stair display. These display prop-
erties apply only to display representations, such as Plan, that are used in the 
Top view (plan view) of a drawing.

To change these display properties for all stairs of the same stair style, see 
“Specifying the Display Properties of a Stair Style” on page 1528.

1 Select the stair you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Other tab.
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6 Select the display properties for the stair:

If you want to . . . Then . . .

change the display size of the 
arrow and break mark

enter a value for Size.

change the offset location of the 
arrow display

enter a value for Offset.

change the dimension style 
used for the arrow display

select a style from Dim Style.

NOTE If a dimension style other than 
Standard is used for the arrow, and you want 
the arrow size to be controlled by the 
dimension style only, check this option. This is 
the default for all previous version drawings. If 
this is unchecked, the size of the arrow is 
multiplied by the arrow size setting.

change the shape of the stair 
line

select a value for shape. Curved adds an arc 
when the stair line changes. Straight displays 
an angle when the stair line changes.

display the arrow at the end of 
each cut plane pointing in the 
same direction throughout the 
length of the stair

select Cut Plane - Parallel for Apply to and 
make sure that Draw for Each Flight is not 
selected.

display the arrow at the end of 
each cut plane and at the end of 
each flight pointing in the same 
direction 

select Cut Plane - Parallel for Apply to and 
make sure that Draw for Each Flight is 
selected.

display the arrow at the end of 
the entire stair

select Entire Stair for Apply to and make sure 
that Draw for Each Flight is not selected.

display the arrow at the end of 
each flight pointing in the same 
direction

select Entire Stair for Apply to and make sure 
that Draw for Each Flight is selected.

display the arrow on each side 
of the cut plane

select Cut Plane - Opposite for Apply to.

change which stair line is 
displayed

select a value for Display Path. 

change the type of break mark 
that is displayed at the cut plane

under Break Mark, select a mark for Type.

specify a custom break mark to 
display at the cut plane

select Custom Shape for Type, and then select 
a block from Block.
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7 Click OK twice.

Specifying the Riser Numbering Display for Individual Stairs
Use this procedure to define and display riser numbers for individual stairs.

To change these display properties for all stairs of the same stair style, see 
“Specifying the Riser Numbering Display of a Stair Style” on page 1532.

1 Select the stair you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Riser Numbering tab.

6 Select the riser numbering display properties for the stair:

If you want to . . . Then . . .

change the text style of the riser 
numbers select a style for Text Style, or click  to edit 

the text style.
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7 Click OK twice.

Attaching Hyperlinks, Notes, or Files to a Stair

Use this procedure to attach hyperlinks, notes, or files to a stair. You can also 
edit hyperlinks and notes, and edit or detach reference files from a roof.

1 Select the stair you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click OK.

5 To add a note, click the setting for Notes, and enter the note.

6 Click OK.

change the alignment of the 
riser numbers

select an alignment for Text Alignment.

change the orientation of the 
riser numbers

select an orientation for Text Orientation.

change the text height of the 
riser numbers

enter a value for Text Height.

change the location where the 
numbers are justified to

select Left, Center or Right for Justify to.

change the location of the 
numbers along the length of 
the stair flight

enter a value for X Offset. This is relative to the 
selected position of the riser. 

change the location of the 
numbers to the left or right

enter a value for Y Offset. This is relative to the 
selected position of the riser. 

set the first number for the riser 
numbering

enter a value for First Riser Number.

number the last riser in the stair select Number Final Riser.

If you want to . . . Then . . .
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7 To add a reference file, click the setting for Reference documents, and 
attach, edit, or detach a reference file:

8 Click OK.

Stair Styles

A stair style is a group of properties assigned to a stair that determines the 
appearance and other characteristics of the stair.

You can use a stair style to control properties for all stairs that use that style, 
rather than changing properties for each individual stair in the drawing. Var-
ious styles exist in the templates for common stair configurations, such as 
steel-pan, ramp - concrete, and wood-housed. Within the stair style, you can 
specify the dimensions, landing extensions, components, and display prop-
erties of the stair. 

Stair Components and Design Rules
In a stair style, you specify the properties of stair components:

� risers and treads
� stringers
� landings
� landing extensions

Design rules determine the code limits for maximum, optimum, and mini-
mum slopes for the stair style.

If you want to . . . Then . . .

attach a reference file

click , select a file, and click OK.

edit the description of a 
reference file

click in the document’s Description field. Enter the 
description, and click OK.

edit a reference file double-click the reference file name to start its 
application.

NOTE If the referenced file is an AutoCAD drawing, 
you must click OK in the Reference Docs dialog 
before the drawing is displayed.

detach a reference file

select the file name, and click .
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Display Components of Stairs
Display components determine the graphical characteristics, such as color 
and linetype, of stair components. Other display properties you can change 
for a stair style include cut plane, stair line, arrow properties, and the break 
mark.

Using Materials in Stair Styles
You can use materials to control how stairs of each style are displayed in a 
drawing. You assign materials to the stair components in the style. The com-
ponents are then displayed using the display properties of the assigned mate-
rials.

Creating Tools from Stair Styles
You can create a stair tool from any stair style. You can drag the style from 
the Style Manager onto a tool palette. You can then specify default settings 
for any stair created from the tool. For more information, see “Creating a 
Stair Tool” on page 1440.

Managing Stair Styles

To create, copy, or purge styles, you access the Style Manager. The Style Man-

ager provides a central location in Autodesk® Architectural Desktop, where 
you can work with styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Getting Started with the 
Style Manager” on page 533.

Related Procedures

� Creating a Stair Style

� Specifying the Design Rules of a Stair Style

� Specifying the Stringers of a Stair Style

� Specifying the Components of a Stair Style

� Specifying the Landing Extension of a Stair Style

� Stair Materials and Display Components

� Specifying the Layer/Color/Linetype of a Stair Style

� Specifying the Display of Other Characteristics of a Stair Style

� Specifying the Riser Numbering Display of a Stair Style

� Specifying Classifications for a Stair Style

� Adding Notes and Files to a Stair Style
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Creating a Stair Style

Use this procedure to create a stair style. You can create a style using default 
style properties, by copying an existing style. After you create the style, you 
edit the style properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Stair Styles.

3 Create a stair style:

4 Enter a name for the new stair style, and press ENTER.

5 To edit the new stair style, right-click the style, and click Edit:

If you want to . . . Then . . .

create a style with default 
properties

right-click Stair Styles, and click New.

create a style from an 
existing style

right-click the stair style you want to copy, and click 
Copy. Right-click, and click Paste.

If you want to . . . Then . . .

specify design rules for the 
style

see “Specifying the Design Rules of a Stair Style” on 
page 1519.

specify the stringer 
properties for the style

see “Specifying the Stringers of a Stair Style” on 
page 1520.

specify the thicknesses and 
widths of treads, risers, and 
landings for the style

see “Specifying the Components of a Stair Style” on 
page 1523.

specify the landing 
extension properties of the 
style

see “Specifying the Landing Extension of a Stair 
Style” on page 1524.

specify display properties, 
such as layer, color, and 
linetype, for the 
components of the style

see “Specifying the Layer/Color/Linetype of a Stair 
Style” on page 1529.
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6 When you finish specifying the properties of the stair style, click OK.

7 If you want to assign the style to a stair tool, drag the style from the Style 
Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Stair Tool” on page 1440.

8 Click OK.

Specifying the Design Rules of a Stair Style

Use this procedure to specify the minimum, maximum, and optimal code 
limits for the riser height and tread depth and specify the stair calculator 
rules.

Specifying stair design rules

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style you want to change, and click Edit.

4 Click the Design Rules tab.

specify cut plane 
properties, arrow 
properties, and other 
display properties of the 
style

see “Specifying the Display of Other Characteristics 
of a Stair Style” on page 1530.

add notes and files to the 
style

see “Adding Notes and Files to a Stair Style” on 
page 1534.

If you want to . . . Then . . .
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5 Specify the default Riser Height and Tread Depth for the Minimum Slope, 
Optimum Slope, and Maximum Slope. 

NOTE Use values that represent the actual dimensions of the tread and riser 
components that you want to create, not just the ratios of these dimensions. 

Subject to the constraints of the calculator rules and the fact that the tread 
heights must be an even divisor of the floor-to-floor height, the software 
gets as close as possible to the selected optimal tread length and riser 
height.

6 To change the default stair calculator, select Use Rule Based Calculator. 

The fields in the Calculator Rule section become available for editing.

7 When you finish changing the properties of the stair style, click OK twice.

Specifying the Stringers of a Stair Style

Use this procedure to include stringers with the stair style. A stair style can 
have one or more stringers. You can specify the properties of each stringer. If 
the style uses stringers, you can specify the depth of the waist at flights and 
landings. For Ramp or Housed type stringers, you can also specify the total 
depth at flights and landings.
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1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style you want to change, and click Edit.

4 Click the Stringers tab.

If the style does not use stringers, proceed to step 6.

5 Add or remove stringers:

If you want to . . . Then . . .

add a stringer to the stair style click Add.

add an identical stringer to the list select the stringer you 
want to duplicate, and 
click Copy.

delete a stringer from the list select the stringer, and 
click Remove.
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6 Specify the properties of each stringer:

7 Click Slab for Type to edit the slab settings:

8 When you finish changing the properties of the stair style, click OK twice.

If you want to . . . Then . . .

specify the name of a stringer select the current name, and enter a 
new name.

specify the type of stringer click the current Type, and select 
Saddled or Housed.

specify the alignment of a stringer click the current alignment, and select 
Align Left, Align Right, Center, or Full 
Width.

specify the width of a stringer enter a value for Width.

specify the offset of a stringer enter a value for Offset.

specify the flight waist under Flight, enter a value for Waist.

specify the flight total under Flight, enter a value for Total.

specify the landing waist under Landing, enter a value for Waist.

specify the landing total under Landing, enter a value for Total.

stop the stringer at a landing select Truncate for Cleanup.

allow the stringer to continue under a 
landing

select Cleanup for Cleanup.

If you want to . . . Then . . .

specify the thickness of 
the slab at flights

under Flight, enter a value for Waist.

specify the thickness of 
the slab at landings

under Landings, enter a value for Waist.
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Specifying the Components of a Stair Style

Use this procedure to specify the display of treads and risers and edit the 
thicknesses and widths of treads, risers, and landings. Also, you can specify 
whether these properties of the style are allowed to vary with individual 
stairs.

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style you want to change, and click Edit.

4 Click the Components tab.

5 Specify whether stairs of this style can vary:

If you want to . . . Then . . .

specify flight dimensions, such as tread 
thickness, riser thickness, and nosing 
length, when you add or modify stairs

select Allow Each Stair to Vary.

require all stairs of this style to use the 
flight dimension settings of the style

clear Allow Each Stair to Vary.
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NOTE If Allow Each Stair to Vary is checked, changes on this tab do not 
affect existing stairs. To make these stairs match the style settings, select the 
stair, display its properties, display the Components worksheet and click Reset 
to Style Values.

6 Turn the display of treads and risers on or off. 

If tread is off, the tread thickness and landing thickness become unavail-
able.

7 Specify the flight dimensions:

8 Specify the landing dimensions:

9 When you finish changing the properties of the stair style, click OK twice.

Specifying the Landing Extension of a Stair Style

Use this procedure to change the distances between landings and treads and 
the stringer resolution of stairs. You can differentiate the size of landing com-
ponents from those used for the stair flights. 

If you want to . . . Then . . .

specify the thickness of 
treads

enter a value for Tread Thickness.

specify the thickness of 
risers

enter a value for Riser Thickness.

specify the length of 
the edge of a stair 
tread that projects over 
the riser

enter a value for Nosing Length.

specify sloping risers select Sloping Riser.

If you want to . . . Then . . .

specify the thickness of 
landings

enter a value for Landing Thickness.

specify additional 
width for landings

enter a value for Additional Width.
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1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style you want to change, and click Edit.

4 Click the Landing Extensions tab.

5 Specify whether stairs of this style can vary:

If you want to . . . Then . . .

specify stringer resolution, and 
extension dimensions, such as distance 
to first tread up, and distance to first 
tread down, when you add or modify 
stairs

select Allow Each Stair to Vary.

require all stairs of this style to use the 
extension dimension settings of the 
style

clear Allow Each Stair to Vary.
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6 Specify extension distances:

7 Select Extend Landings to Merge Flight Stringers with Landing Stringers.

This option extends the landing to merge the flight stringers with the 
landing stringers.

8 Select Extend Landings to Prevent Risers and Treads Sitting Under Land-
ings.

This option is on by default for all stairs from previous version drawings. 
Uncheck it to allow the creation of flush rectangular landings.

9 When landings get placed automatically, the length and location of these 
landings are specified in Landing Length and Landing Location.

10 When you finish changing the properties of the stair style, click OK twice.

Assigning Materials to Components in a Stair 
Style

A stair consists of a number of components whose display properties can be 
determined by the materials assigned to each component. When you assign 
materials to a stair style, you assign one material to each physical component 
of the stair. For example, you assign a wood or metal material to treads, con-
crete to a concrete component, and so on. You assign materials to compo-

If you want to . . . Then . . .

add to the distance to 
the first tread on the 
down side of the 
landing

enter a value for Distance to First Tread DOWN.
To extend the landing down by a single tread, select 
Add Tread Depth.

add to the distance to 
the first tread on the 
up side of the landing

enter a value for Distance to First Tread UP.
To extend the landing up by a single tread, select 
Add Tread Depth.

If you want to . . . Then . . .

set the size of 
automatic landings

enter a value for Landing Length.

set the placement of 
automatic landings

select Top, Middle, or Bottom for Landing Location.
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nents in each display representation where you want the materials to be 
used.

If you want to use the display properties of the stair style, instead of using 
material display properties, you can turn off the material assignments in the 
display properties of the stair style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the 3D body component of a material 
is used for all linework in model views. 

Related Topics and Procedure

� Stair Materials and Display Components

� Assigning Materials to a Stair Style

Stair Materials and Display Components
The following table identifies the material component that corresponds to 

each stair component.

Assigning Materials to a Stair Style
Use this procedure to assign materials to the individual components of a stair 
style. When you assign a material to a stair component and By Material is 
selected for that component, the component uses the display properties of 
the material instead of the style display properties.

You can assign a material to any physical component of the stair. Custom 
components and components that are only symbolic graphics do not use 
materials for their display properties. For example, a riser is a physical com-
ponent that you can assign material to while the graphics path is a symbol, 
and you cannot assign a material to it.

Stair Component Material Component

Model

Stringer 3D Body

Tread 3D Body

Landing 3D Body

Riser 3D Body
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NOTE If a material assignment does not determine the display properties of a 
stair component, you can change the display properties of the stair style as 
described in “Specifying the Display Properties of a Stair Style” on page 1528.

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

NOTE Only the Model display representation uses materials.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click 

 to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display Properties of a Stair Style

In most cases, you can assign materials to stair components so that the 
appearance of stairs that belong to the same style to is consistent throughout 
a drawing and with other stairs and objects that use the same materials.
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If a component cannot be assigned a material, or if you do not want to use 
materials but still want consistency among stairs of the same style, you can 
specify the display properties of the stair components in the stair style:

� The layer, color, and linetype of stair components
� The cut plane height and the display of components relative to the cut 

plane
� Other specific stair display information, such as riser numbering

Related Procedures

� Specifying the Layer/Color/Linetype of a Stair Style

� Specifying the Display of Other Characteristics of a Stair Style

� Specifying the Riser Numbering Display of a Stair Style

Specifying the Layer/Color/Linetype of a Stair Style
Use this procedure to specify how the various components of the stair are dis-
played in a particular view. You can change the following display properties 
of the components of a stair style:

� Visibility (on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale
� Plot style, if the drawing uses style-based plotting rather than color-based

Plan views of stairs include stringers, risers, nosing, path symbols, and stair 
outlines. You can specify the visibility of these components for above and 
below the cut plane of the stair. Isometric (model) views of stairs include 
stringers, tread, and risers.

To change these display properties for an individual stair, see “Changing the 
Display Properties of Individual Stairs” on page 1509.

NOTE If a material assignment determines the display properties of compo-
nents in the stair style, you can change the properties of the display component 
by clearing By Material. You can also override the material assignment with a dif-
ferent material. For more information, see “Assigning Materials to a Stair Style” 
on page 1527.

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.
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3 Right-click the stair style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying the Display of Other Characteristics of a Stair Style
Use this procedure to specify settings for the cut plane and related symbols.

Plan views of stairs includes stringers, risers, nosing, path symbols, and stair 
outlines. You can specify the visibility of these components for above and 
below the cut plane of the stair. 

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click Edit Display Props.

8 Click the Other tab.

9 Click Override Display Configuration Cut Plane to change the elevation 
of the Display Configuration cut plane for the stair.

NOTE When the Display Configuration Cut Plane is used, stairs display only 
from the current floor elevation up to the cut height, and from the current 
floor elevation down to the appropriate cut height of the level below.

10 Enter a value for Elevation.

11 Enter a value for Distance to change the space between the two cut plane 
lines.

12 Enter a value for Angle to change the angle of the stair cut lines.
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13 Specify the display of the cut plane:

14 Specify the display of the arrow and the stair line:

If you want to . . . Then . . .

specify the height of 
the cut plane measured 
from the beginning of 
the stair

enter a value for Elevation.
The space for the cut plane is centered on the closest 
tread.

specify the width of the 
cut plane

enter a value for Distance.

specify the angle of the 
cut plane

enter a value for Angle.

If you want to . . . Then . . .

change the display size of the 
arrow

enter a value for Size.

change the offset location of the 
arrow display

enter a value for Offset.

change the dimension style 
used for the arrow display

select a style from Dim Style.

NOTE If a dimension style other than 
Standard is used for the arrow, and you want 
the arrow size to be controlled by the 
dimension style only, check this option. This is 
the default for all previous version drawings. If 
this is unchecked, the size of the arrow is 
multiplied by the arrow size setting.

change the shape of the stair 
line

select a value for shape. Curved adds an arc 
when the stair line changes. Straight displays 
an angle when the stair line changes.

display the arrow at the end of 
each cut plane pointing in the 
same direction throughout the 
length of the stair

select Cut Plane - Parallel for Apply to and 
make sure that Draw for Each Flight is not 
selected.

display the arrow at the end of 
each cut plane and at the end of 
each flight pointing in the same 
direction 

select Cut Plane - Parallel for Apply to and 
make sure that Draw for Each Flight is 
selected.
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15 Specify the display of the break mark:

16 Click OK twice.

Specifying the Riser Numbering Display of a Stair 
Style

Use this procedure to define the display of riser numbers for a stair style.

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

display the arrow at the end of 
the entire stair

select Entire Stair for Apply to and make sure 
that Draw for Each Flight is not selected.

display the arrow at the end of 
each flight pointing in the same 
direction

select Entire Stair for Apply to and make sure 
that Draw for Each Flight is selected.

display the arrow on each side 
of the cut plane

select Cut Plane - Opposite for Apply to.

change which stair line is 
displayed

select a value for Display Path. 

change the type of break mark 
that is displayed at the cut plane

under Break Mark, select a mark for Type.

specify a custom break mark to 
display at the cut plane

select Custom Shape for Type, and then select 
a block from Block.

If you want to . . . Then . . .

change the style of the 
break mark

select an option for Type.
The available options are None, Curved, Zigzag, and 
Custom Shape.

specify a custom shape 
for the break mark

select Custom Shape for Type, and select the desired 
name for Block.

If you want to . . . Then . . .
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6 If necessary, click .

7 Click Edit Display Props.

8 Click the Riser Numbering tab.

9 Select the riser numbering display properties for the stair style:

10 Click OK twice.

Specifying Classifications for a Stair Style

Use this procedure to specify classifications for any classification definition 
applied to a stair style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a stair tool.

If you want to . . . Then . . .

change the text style of the riser 
numbers select a style for Text Style, or click  to edit 

the text style.

change the alignment of the 
riser numbers

select an alignment for Text Alignment.

change the orientation of the 
riser numbers

select an orientation for Text Orientation.

change the text height of the 
riser numbers

enter a value for Text Height.

change the location where the 
numbers are justified to

select Left, Center or Right for Justify to.

change the location of the 
numbers along the length of 
the stair flight

enter a value for X Offset. This is relative to the 
selected position of the riser. 

change the location of the 
numbers to the left or right

enter a value for Y Offset. This is relative to the 
selected position of the riser. 

set the first number for the riser 
numbering

enter a value for First Riser Number.

number the last riser in the stair select Number Final Riser.
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2 Right-click a stair tool, and click Stair Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to stair 
styles.

5 For each classification definition, select the classification you want to 
apply to the current stair style.

6 Click OK twice.

Adding Notes and Files to a Stair Style

Use this procedure to enter notes and attach reference files to a stair style. 
You can also edit notes and edit or detach reference files attached to the style.

1 Open a tool palette that has a stair tool.

2 Right-click a stair tool, and click Stair Styles.

3 Right-click the stair style that you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the stair style, enter it for Description.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of 
a reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Stair Winder Styles

A stair winder style is a group of properties assigned to a stair winder that 
determines the type of winder used in stairs that contain 1/4 turn or 1/2 
turns.

To create, copy, or purge styles, you access the Style Manager. The Style Man-

ager provides a central location in Autodesk® Architectural Desktop, where 
you can work with styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Getting Started with the 
Style Manager” on page 533.

Related Procedures

� Creating a Stair Winder Style

� Specifying the Stair Winder Style Settings

� Adding Notes and Files to a Stair Winder Style

Creating a Stair Winder Style

Use this procedure to create a stair winder style. You can create a style using 
default style properties, by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Stair Winder Styles.

3 Create a stair winder style:

4 Enter a name for the new stair winder style, and press ENTER.

If you want to . . . Then . . .

create a style with default 
properties

right-click Stair Winder Styles, and click New.

create a style from an 
existing style

right-click the stair winder style you want to copy, 
and click Copy. Right-click, and click Paste.
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5 To edit the new stair winder style, right-click the style, and click Edit:

6 When you finish specifying the properties of the stair winder style, click 
OK twice.

Specifying the Stair Winder Style Settings

Use this procedure to determine which type of winder is defined for the 
selected winder style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Stair Winder Styles.

3 Select a Stair Winder Style, right click and click Edit.

4 Click the Settings tab.

If you want to . . . Then . . .

specify settings for the 
style

see “Specifying the Stair Winder Style Settings” on 
page 1536.
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5 Specify the stair winder settings:

NOTE When using the single point type, it is important to uncheck Use 
Riser Line if the turn point will be on the edge or corner of the stair. Otherwise 
the treads will overlap and the stair will be defective.

6 When you finish specifying the properties of the stair winder style, click 
OK twice.

Adding Notes and Files to a Stair Winder Style

Use this procedure to enter notes and attach reference files to a stair winder 
style. You can also edit notes and edit or detach reference files attached to the 
style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Stair Winder Styles.

3 Select a Stair Winder Style, right click and click Edit.

If you want to . . . Then . . .

use the riser lines to adjust 
the winders

select Use Riser Line.

use the tread lines to adjust 
the winders

make sure Use Riser Line is not selected.

have the treads turn 
continuously along the 
length of the stair

select Balanced for Winder Type.

NOTE This is the type used by all previous version 
stairs with 1/2 or 1/4 turns.

adjust each winder 
separately

select Manual for Winder Type.

adjust winders based on a 
single point and a turn 
zone

select Single Point for Winder Type.

set an amount of winders 
to use when Single Point is 
selected for Winder Type

select Adjust Winder Turn and enter a value for 
Number of Treads in Turn.
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4 Click the General tab.

5 To add a description to the stair style, enter it for Description.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of 
a reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Structural Members

A structural member is an object that can represent a 

beam, brace, or column in a drawing. All the beams, 

braces, and columns that you create are sub-types of a 

single structural member object.

In this chapter

� Process Overview: Creating 
Structural Members with the 
Structural Member Catalog or 
Structural Member Style 
Wizard

� Creating Structural Member 
Styles in the Structural Member 
Catalog

� Creating a Structural Member 
Style with the Structural 
Member Style Wizard

� Creating Structural Member 
Tools

� Creating Structural Members 
Using Structural Member Tools

� Editing Structural Members

� Structural Member Styles

� Creating Custom Structural 
Members

22
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Creating Structural Members
You create a structural member in Autodesk Architectural Desktop by extrud-
ing a structural shape along a path. The style that you use to create the struc-
tural member provides the shape. The shape, similar to a profile, is a 2-
dimensional cross-section of a structural member. You define the extrusion 
path (axis) of the member when you specify start and end points for the 
member or when you convert linework to a member.

Creating a structural member

Creating Styles with the Structural Member Catalog and Structural 
Member Style Wizard
To create styles for most standard beams, braces, and columns, you can use 
the Structural Member Catalog included in Autodesk Architectural Desktop. 
The catalog contains specifications for industry-standard concrete, steel, and 

timber structural shapes organized in a Windows® Explorer-like tree view. 
You can browse the catalog, select a shape, and create a style.
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Structural Member Catalog

If you know the type, shape, and shape dimensions of the member that you 
want to create, you can quickly enter the information in the Structural Mem-
ber Style wizard to create a style. You can create a structural member shape 
within a style that is based on any of the nineteen different member shapes 
in the catalog.
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Structural Member Style Wizard

After you create structural member styles, you can drag them from the Style 
Manager onto tool palettes to create structural member tools.

Adding Graphics to Structural Members
You can add blocks to the display of structural members as components in 
display representations. For example, you can create blocks that represent 
stiffener plates and add them to beams or create blocks that represent clip 
angles and add them to members.

Adding stiffener plates to a beam
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Trimming Structural Members
You can use trim planes to trim structural members in your drawings. A trim 
plane is a cutting plane that trims a structural member to a location that you 
define on the structural member. You can use trim planes to clean up joints 
between multiple structural members. For example, use multiple trim planes 
to angle both ends of a brace in a diagonally braced frame.

Trimming a structural member with a trim plane

Creating Column Grids
When you create a column, you can attach it to a grid. You can also create a 
column grid with the structural column grid tool that is included in 
Autodesk Architectural Desktop. The tool creates a grid with columns pre-
anchored to nodes on the grid. For more information, see “Creating Column 
Grids” on page 1089.

Materials in Structural Members
In Autodesk® Architectural Desktop, you can assign materials to a structural 
member. These materials are displayed in wireframe and working shade 
views, or when linked into VIZ Render. Materials have specific settings for the 
physical components of a structural member.

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for structural 
members. You can use these predefined materials, or modify them to your 
special designs. You can also create your own materials from scratch.

For more information, see “Specifying the Materials of a Structural Member 
Style” on page 1601.
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Creating Custom Structural Members
You can use the styles from the Structural Member Catalog and Structural 
Style wizard to create structural members for most of your design needs. 
However, your project requirements may require you to create structural 
members that cannot be created from a shape in the catalog or created with 
the wizard. For example, you may want to create:

� a column with a shape that tapers from start to end
� a composite column created from a steel shape encased in a concrete 

shape
� a rigid frame created from multiple tapering shapes extruded along the 

path of the frame
� a structural member with a custom shape that cannot be created in the 

catalog or with the wizard

To create custom structural members, you use the design rules within a struc-
tural member style to extrude one or more shapes along the path of the mem-
ber. You can use shapes created in the catalog or with the wizard, or you can 
create your own custom shapes.

Predefined Custom Structural Member Styles
You can access predefined styles for custom structural members from the 
Member Styles and Bar Joists Styles drawings located in the \Documents and Set-
tings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial or Metric folder. If you are running Windows 

NT®, these drawings are located in the \winnt\Profiles\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 2004\R16.0\enu\Styles\Impe-
rial or Metric folder.

Related Topics and Procedures

� Process Overview: Creating Structural Members with the Structural Mem-
ber Catalog or Structural Member Style Wizard

� Creating Structural Member Styles in the Structural Member Catalog

� Creating a Structural Member Style with the Structural Member Style Wiz-
ard

� Creating Structural Member Tools

� Creating Structural Members Using Structural Member Tools

� Editing Structural Members

� Structural Member Styles

� Creating Custom Structural Members



Process Overview: Creating Structural Members with the Structural Member

Process Overview: Creating Structural 
Members with the Structural Member 
Catalog or Structural Member Style Wizard

This process overview describes how you can create structural members with 
styles that you create in the Structural Member Catalog or with the Structural 
Member Style wizard. This overview assumes that you need to create your 
own structural member styles and tools to create structural members. If you 
have a tool palette of structural member tools, see “Creating Structural Mem-
bers Using Structural Member Tools” on page 1562.

The process of creating a structural member from the catalog or with the wiz-
ard has three steps:

Step 1: Create a structural member style in the Structural Member Catalog or 
with the Structural Member Style wizard.

If you know the type, shape, and shape dimensions of the member that 
you want to create, you can quickly enter the information in the Struc-
tural Member Style wizard to create a style.

Alternatively, browse the Structural Member Catalog and select a shape to 
create a style.

Step 2: Drag the style from the Style Manager onto a tool palette to create a 
structural member tool.

Step 3: Create a structural member or convert linework to a structural mem-
ber with the tool that you created in step 2.

Related Topics and Procedures

� Creating Structural Member Styles in the Structural Member Catalog

� Creating a Structural Member Style with the Structural Member Style Wiz-
ard

� Creating Structural Member Tools

� Creating Structural Members Using Structural Member Tools
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Creating Structural Member Styles in the 
Structural Member Catalog

The Structural Member Catalog contains specifications for different types 
and sizes of standard structural shapes. You can browse the catalog, select a 
shape, and create a structural member style that contains the selected shape. 
When you create a structural member with the style, the style provides the 
shape of the member.

Organization of the Structural Member Catalog
The left pane of the Structural Member Catalog contains standard structural 

shapes organized in a Windows® Explorer-like tree view. Several industry 
standard specifications are organized in the tree, first by imperial or metric 
units, and then by material.

Structural Member Catalog

Browsing the Catalog
You can open all the levels in the tree pane under a unit and material to view 
the different structural shape types available in the catalog. When you select 
a shape type in the tree view, a preview image of the shape with its dimen-
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sions displays in the upper right pane. All the available sizes of the shape type 
display in the lower right pane.

If you have a structural member in a drawing with a style created in the cat-
alog, you can locate the catalog shape contained in that style from the mem-
ber. 

Creating Structural Member Styles from Catalog Shapes
When you create a structural member style in the catalog, the dimensions of 
the catalog shape that you select define and store the shape in the style.

For example, the dimensions of the steel beam selected in the previous illus-
tration include its depth (d), flange width (bf), flange thickness (tf), and web 
thickness (tw). When you create a style, these dimensions create the follow-
ing shape that is stored in the style.

A shape from the Structural Member Catalog

When you create a beam in your drawing with this style, the style provides 
the shape of the beam. You determine the length, start and end offsets, jus-
tification, and roll of the beam when you create the beam.

Contents of the Structural Member Catalog
When you display the Structural Member Catalog, a default catalog file, 
AecStructural.apc, provides the catalog content. This file is located in: C:\\Pro-
gram Files\Autodesk Architectural Desktop 2004\Catalogs\Structural.

In the future, additional catalog files that you can open in the catalog may 
become available on the Autodesk web site, or you may create your own cat-
alog files.
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Related Procedures

� Opening the Structural Member Catalog

� Creating a Style from a Shape in the Structural Member Catalog

� Locating a Shape in the Structural Member Catalog from a Structural 
Member in a Drawing

� Opening a Catalog File in the Structural Member Catalog

Opening the Structural Member Catalog

Use this procedure to open the Structural Member Catalog.

1 On the Format menu, click Structural Member Catalog.

Opening the Structural Member Catalog

2 Move and resize the Structural Member Catalog, or resize the left and right 
panes within the catalog as needed to view catalog information.

3 Click  to close the Structural Member Catalog.
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Creating a Style from a Shape in the Structural 
Member Catalog

Use this procedure to create a structural member style from a shape that you 
select in the Structural Member Catalog. 

1 On the Format menu, click Structural Member Catalog.

A tree view in the left pane of the catalog lists the available shapes.

2 Expand Imperial or Metric in the tree view.

3 Expand the type of material (Concrete, Steel, or Timber) for the structural 
shape that you want to create with the style.

4 Expand the shape that you want to create. 

Depending on the member, you may need to expand one or more levels 
in the tree.

5 Select the shape type of the member that you want to create.

In the top right pane, a preview of the shape displays. 

In the bottom right pane, a list of the available sizes of the selected shape 
display. The following shapes may take a significant amount to time to 
display:

� Imperial ➤ Steel ➤ AISC ➤ HSS and Pipes ➤ HSS, Small 
Hollow Structural Sections

� Metric ➤ Steel ➤ CISC ➤ Angles ➤ L, Angle Shapes
� Metric ➤ Steel ➤ CISC ➤ I-Shaped ➤ W, Wide Flange 

Shapes
� Metric ➤ Steel ➤ CISC ➤ I-Shaped ➤ WWF, Welded Wide 

Flange Shapes
� Metric ➤ Steel ➤ CISC ➤ Structural Tees ➤ WT, Tee Shapes

6 Under Shape Designation in the bottom right pane, select the shape size 
that you want to use to create your style, right-click, and click Generate 
Member Style.

7 Enter a style name, if necessary, and click OK.

The name of the shape is used as the default style name. Special characters 
in the shape name, such as quotation marks, are substituted with under-
scores. If you change the default style name, you cannot use any of the 
following special characters in your style name:

� Less-than and greater-than symbols (< >)
� Forward slashes and backslashes (/ \) 
� Quotation marks (") 
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� Colons (:) 
� Semicolons (;)
� Question marks (?)
� Commas (,) 
� Asterisks (*) 
� Vertical bars (|)
� Equal signs (=)
� Back quotes (`)

8 Continue creating structural member styles, or click  to close the 
Structural Member Catalog.

You can access the style that you created in the Style Manager, create a new 
structural member tool from the style, modify an existing tool to use that 
style, or apply the style to an existing member.

Locating a Shape in the Structural Member 
Catalog from a Structural Member in a Drawing

Use this procedure to locate a shape in the Structural Member catalog from a 
shape contained in the style of a structural member in a drawing. You may 
find this command useful if you created a style from a shape in the catalog 
and did not name it with the same name as the catalog shape.

1 On the Format menu, click Structural Member Catalog.

2 On the Tools menu in the Structural Member Catalog, click Locate.

3 Select the structural member in the drawing that you want to select in the 
catalog.

The shape that you located from the existing member is selected in the Struc-
tural Member Catalog.

Opening a Catalog File in the Structural Member 
Catalog

Use this procedure to open a new catalog file in the Structural Member Cat-
alog. 

1 On the Format menu, click Structural Member Catalog.



Creating a Structural Member Style with the Structural Member Style

2 Specify the location of the new catalog file:

Creating a Structural Member Style with the 
Structural Member Style Wizard

Use this procedure to create a structural member style with the Structural 
Member Style wizard. You can create a structural member shape within the 
style that is based on any of the nineteen different shape types in the Struc-
tural Member Catalog. The current drawing units determine the units of the 
style that you create.

1 On the Format menu, click Structural Member Style Wizard.

2 Select the type of structural member shape that you want to create, and 
click Next.

If you . . . Then . . .

know the location and name of 
the catalog file

enter the full path and name of the catalog file 
in the Catalog bar under the Structural 
Member Catalog toolbar.

want to browse your hard disk 
or server for a catalog 

on the File menu in the Structural Member 
Catalog, click Open. Select a new catalog file, 
and click Open. 
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Selecting a structural member shape type

3 Enter dimensions for the shape, and click Next.

Entering the structural member dimensions

4 Enter a name for the structural member style, and click Finish.
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Entering a structural member style name

You cannot use the following special characters in your style names:

� Less-than and greater-than symbols (< >)
� Forward slashes and backslashes (/ \) 
� Quotation marks (") 
� Colons (:) 
� Semicolons (;)
� Question marks (?)
� Commas (,) 
� Asterisks (*) 
� Vertical bars (|)
� Equal signs (=)
� Back quotes (`)

You can access the style that you created in the Style Manager, create a new 
structural member tool from the style, modify an existing tool to use that 
style, or apply the style to an existing member.

Creating Structural Member Tools

You can create structural member tools and add them to tool palettes. Tool 
palettes in Autodesk® Architectural Desktop let you quickly place beams, 
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braces, and columns by selecting a structural member tool with a specific 
style and other predefined properties.

If you created structural member styles in the Structural Member Catalog or 
with the Structural Member Style wizard, you can drag the styles from the 
Style Manager to tool palettes and then customize the properties of the new 
tools.

You can also use any of the following methods to create structural member 
tools:

� Drag a structural member that has the properties you want to a tool pal-
ette.

� Copy an existing tool in the current palette, paste it onto the current pal-
ette or a different palette, and then customize the properties of the new 
tool.

� Drag a tool from the Content Browser to a tool palette and then customize 
the properties of the new tool.

Related Procedures

� Creating a Beam Tool

� Creating a Brace Tool

� Creating a Column Tool

Creating a Beam Tool

Use this procedure to create a structural beam tool and add it to a tool palette. 

1 Open the tool palette where you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from a structural 
member style in the Style 
Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

create a tool from a beam in the 
drawing

select the beam, and drag it to the tool 
palette.

copy a tool in the current 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool, and click Copy. Open the 
other palette, and click Paste.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

The description displays in the tooltip when you select the tool from the 
tool palette and describes the tool if you store it in a tool catalog in the 
Content Browser. 

6 Expand Basic, and expand General.

7 Enter a description of the beams that you can create using this beam tool.

8 If you do not want to use the layer assignments specified in the layer key 
style used in the drawing, specify a layer key and any layer key overrides.

9 Select a structural member style, and select a style location, if not the cur-
rent drawing.

The style provides the shape of the beam.

10 Expand Dimensions.

11 Specify offsets:

12 Enter a value for Roll. 

The roll specifies the rotation of the beam around its extruded axis. A pos-
itive value for roll rotates the beam counter-clockwise when viewed from 
the end to the start of the member.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.

If you want to . . . Then . . .

offset the beam on its 
extruded axis at the 
start point of the beam

enter a value for Start offset. A positive value shortens 
the beam on its axis, while a negative value lengthens 
the beam.

offset the beam on its 
extruded axis at the 
endpoint of the beam

enter a value for End offset. A positive value lengthens 
the beam on its axis, while a negative value shortens 
the beam on its axis.

If you want to . . . Then . . .
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13 Specify the beam justification, which positions the beam shape in relation 
to its extruded axis when you draw the beam:

Justification options for a beam

14 To specify the justification of members with multiple shapes and seg-
ments created with this tool, select a setting for Justify using overall 
extents:

If you want to . . . Then . . .

position the axis of the 
beam along the 
centroid of the beam 
shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
beam along one of nine 
positions on the beam 
shape

select one of the nine positions for Justify.

NOTE These positions are defined at a roll of zero, 
viewing the beam from the end to the start.

If you want to . . . Then . . .

justify the member 
based on the largest 
cross-sectional extents 
of the member

select Yes. The justification is applied to all shape 
definitions at each node of the member.
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For more information about members with multiple shapes and segments, 
see “Creating Custom Structural Members” on page 1615.

15 Click OK.

Creating a Brace Tool

Use this procedure to create a structural brace tool and add it to a tool palette. 

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

justify the member 
based on the priorities 
of the shapes assigned 
in the design rules of 
the member style

select No. The justification is calculated based on the 
cross-sectional extents at each node and applied to the 
shape or shapes with the lowest priority at each node.

If you want to . . . Then . . .

create a tool from a structural 
member style in the Style 
Manager.

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

create a tool from a brace in the 
drawing

select the brace, and drag it to the tool 
palette.

copy a tool in the current 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool, and click Copy. Open the 
other palette, and click Paste.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.

If you want to . . . Then . . .
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The description displays in the tooltip when you select the tool from the 
tool palette and describes the tool if you store it in a tool catalog in the 
Content Browser. 

6 Expand Basic, and expand General.

7 Enter a description of the braces that you can create using this brace tool.

8 If you do not want to use the layer assignments specified in the layer key 
style used in the drawing, specify a layer key and any layer key overrides.

9 Select a structural member style, and select a style location, if not the cur-
rent drawing.

The style provides the shape of the brace.

10 Expand Dimensions.

11 Specify offsets:

12 Enter a value for Roll. 

The roll specifies the rotation of the brace around its extruded axis. A pos-
itive value for roll rotates the brace counter-clockwise when viewed from 
the end to the start of the brace.

13 Specify the rise, which is the vertical distance between the start and end-
point of the brace:

If you want to . . . Then . . .

offset the brace on its 
extruded axis at the 
start point of the brace

enter a value for Start offset. A positive value shortens 
the brace on its axis, while a negative value lengthens 
the brace.

offset the brace on its 
extruded axis at the 
endpoint of the brace

enter a value for End offset. A positive value lengthens 
the brace on its axis, while a negative value shortens 
the brace on its axis.

If you want to . . . Then . . .

specify the rise of the 
brace before you draw 
it

select No for Specify on Screen, and enter a value for 
Rise.

specify the rise of the 
brace by specifying a 
3D endpoint for the 
end of the brace

select Yes for Specify on Screen.
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14 Specify the brace justification, which positions the brace shape in relation 
to its extruded axis when you draw the brace:

Justification options for a brace

15 To specify the justification of members with multiple shapes and seg-
ments created with this tool, select a setting for Justify using overall 
extents:

If you want to . . . Then . . .

position the axis of the 
brace along the 
centroid of the brace 
shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
brace along one of nine 
positions on the brace 
shape

select one of the nine positions for Justify.

NOTE These positions are defined at a roll of zero, 
viewing the beam from the end to the start.

If you want to . . . Then . . .

justify the member 
based on the largest 
cross-sectional extents 
of the member

select Yes. The justification is applied to all shape 
definitions at each node (vertex) of the member.
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For more information about members with multiple shapes and segments, 
see “Creating Custom Structural Members” on page 1615.

16 Click OK.

Creating a Column Tool

Use this procedure to create a structural column tool and add it to a tool pal-
ette. 

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

justify the member 
based on the priorities 
of the shapes assigned 
in the design rules of 
the member style

select No. The justification is calculated based on the 
cross-sectional extents at each node and applied to the 
shape or shapes with the lowest priority at each node.

If you want to . . . Then . . .

create a tool from a structural 
member style in the Style 
Manager.

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

create a tool from a column in 
the drawing

select the column, and drag it to the tool 
palette.

copy a tool in the current 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool, and click Copy. Open the 
other palette, and click Paste.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.

If you want to . . . Then . . .
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The description displays in the tooltip when you select the tool from the 
tool palette and describes the tool if you store it in a tool catalog in the 
Content Browser. 

6 Expand Basic, and expand General.

7 Enter a description of the columns that you can create using this column 
tool.

8 If you do not want to use the layer assignments specified in the layer key 
style used in the drawing, specify a layer key and any layer key overrides.

9 Select a structural member style, and select a style location, if not the cur-
rent drawing.

The style provides the shape of the column.

10 Expand Dimensions.

11 Specify offsets:

12 Specify the roll, or rotation of the column around its extruded axis:

A positive value for roll rotates the column counter-clockwise when 
viewed from the end (top) to the start (bottom) of the column.

If you want to . . . Then . . .

offset the column on its 
extruded axis at the 
start point of the 
column

enter a value for Start offset. A positive value shortens 
the column on its axis, while a negative value lengthens 
the column on its axis.

offset the column on its 
extruded axis at the 
endpoint of the column

enter a value for End offset. A positive value lengthens 
the column on its axis, while a negative value shortens 
the column on its axis.

If you want to . . . Then . . .

specify the roll of the 
column before you 
insert it

select No for Specify on Screen, and enter a value for 
Roll.

specify the roll of the 
column by rotating it in 
your drawing after you 
insert it

select Yes for Specify on Screen.
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13 Specify the column justification, which positions the column shape in 
relation to its extruded axis when you draw the column:

14 To specify the justification of members with multiple shapes and seg-
ments created with this tool, select a setting for Justify using overall 
extents:

For more information about members with multiple shapes and segments, 
see “Creating Custom Structural Members” on page 1615.

15 Click OK.

Creating Structural Members Using 
Structural Member Tools

Tool palettes in Autodesk® Architectural Desktop let you quickly place beams, 
braces, and columns by selecting a structural member tool with a specific 
style and other predefined properties. You can also use structural member 

If you want to . . . Then . . .

position the axis of the 
column along the 
centroid of the column 
shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
column along one of 
nine positions on the 
column shape

select one of the nine positions for Justify. 

NOTE These positions are defined at a roll of zero, 
viewing the column from the top to the bottom.

If you want to . . . Then . . .

justify the member 
based on the largest 
cross-sectional extents 
of the member

select Yes. The justification is applied to all shape 
definitions at each node of the member.

justify the member 
based on the priorities 
of the shapes assigned 
in the design rules of 
the member style

select No. The justification is calculated based on the 
cross-sectional extents at each node and applied to the 
shape or shapes with the lowest priority at each node.
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tools to convert linework to structural members and to apply the settings of 
a structural member tool to existing structural members.

Custom palettes created by you or your CAD manager may contain structural 
member tools from styles created in the Structural Member Catalog or Struc-
tural Member Style wizard. These palettes may be customized for your 
projects or office standards.

The default tool palettes in the workspace contain sample structural member 
tools that you can use and customize as needed. In addition, the following 
catalogs provided with the software contain structural member tools that 
you can add to your tool palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

When you create structural members using structural member tools, you can 
use the default settings of the tool, or you can specify settings for any struc-
tural member properties that are not controlled by the style.

Related Procedures

� Creating a Beam

� Creating a Beam with User-Specified Settings

� Creating a Brace

� Creating a Brace with User-Specified Settings

� Creating a Freestanding Column

� Creating a Freestanding Column with User-Specified Settings

� Creating a Column Anchored to a Grid

� Creating a Column Anchored to a Grid with User-Specified Settings

� Creating a Structural Member from Linework

Creating a Beam

Use this procedure to add a new beam that has the properties specified in the 
structural beam tool that you select. The style specified in the tool provides 
its shape. You specify the start point and endpoint of the beam to define an 
extrusion path for the shape.

To specify settings when you add a beam, see “Creating a Beam with User-
Specified Settings” on page 1564.
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Creating a beam

1 Open the tool palette that you want to use, and select a structural beam 
tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the start point of the beam.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the endpoint of the beam:

Creating a Beam with User-Specified Settings

Use this procedure to add a new beam with settings that you specify. The 
style that you use to create the brace provides its shape. You specify the start 
point and endpoint of the beam to define an extrusion path for the shape.

If you want to . . . Then . . .

create a single beam specify the endpoint of the beam, 
and press ENTER.

create additional beams, 
using the endpoint of the 
previous beam as the start 
point of each new beam

specify additional endpoints, and 
press ENTER.
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Creating a beam

Optionally, offset the beam from its start or endpoint.

Offsetting a beam

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a structural beam 
tool.

 If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a structural member style.

The style provides the shape of the beam.

4 Expand Dimensions.
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5 Specify offsets:

6 Enter a value for Roll. 

The roll specifies the rotation of the beam around its extruded axis. A pos-
itive value for roll rotates the beam counter-clockwise when viewed from 
the end to the start of the member.

7 Specify the beam justification, which positions the beam shape in relation 
to its extruded axis when you draw the beam:

If you want to . . . Then . . .

offset the beam on its 
extruded axis at the 
start point of the beam

enter a value for Start offset. A positive value shortens 
the beam on its axis, while a negative value lengthens 
the beam.

offset the beam on its 
extruded axis at the 
endpoint of the beam

enter a value for End offset. A positive value lengthens 
the beam on its axis, while a negative value shortens 
the beam on its axis.

If you want to . . . Then . . .

position the axis of the 
beam along the 
centroid of the beam 
shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
beam along one of nine 
positions on the beam 
shape

select one of the nine positions for Justify.

NOTE These positions are defined at a roll of zero, 
viewing the beam from the end to the start.
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Justification options for a beam

8 In the drawing area, specify the start point of the beam.

You can move or hide the Properties palette to expose more of the drawing 
area.

9 Specify an endpoint:

Creating a Brace

Use this procedure to add a new brace that has the properties specified in the 
structural brace tool that you select. The style specified in the tool provides 
its shape. You specify the start point and endpoint of the brace to define an 
extrusion path for the shape.

To specify settings when you add a brace, see “Creating a Brace with User-
Specified Settings” on page 1568.

If you want to . . . Then . . .

create a single beam specify the endpoint of the beam, 
and press ENTER.

create additional beams, 
using the endpoint of the 
previous beam as the start 
point of each new beam

specify additional endpoints, and 
press ENTER.
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Creating a brace

1 Open the tool palette that you want to use, and select a structural brace 
tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the start point of the brace.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify an endpoint:

Creating a Brace with User-Specified Settings

Use this procedure to add a new brace with settings that you specify. The style 
that you use to create the brace provides its shape. You specify the start point 
and endpoint of the brace to define an extrusion path for the shape.

If you want to . . . Then . . .

create a single brace specify the endpoint of the brace, 
and press ENTER.

create additional braces continue to specify brace start and 
endpoints, and press ENTER.
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Creating a brace

Optionally, offset the brace from its start or endpoint.

Offsetting a brace

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a structural brace 
tool.

 If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a structural member style.

The style provides the shape of the brace.

4 Expand Dimensions.
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5 Specify offsets:

6 Enter a value for Roll. 

The roll specifies the rotation of the brace around its extruded axis. A pos-
itive value for roll rotates the brace counter-clockwise when viewed from 
the end to the start of the brace.

7 Specify the brace justification, which positions the brace shape in relation 
to its extruded axis when you draw the brace:

If you want to . . . Then . . .

offset the brace on its 
extruded axis at the 
start point of the brace

enter a value for Start offset. A positive value shortens 
the brace on its axis, while a negative value lengthens 
the brace.

offset the brace on its 
extruded axis at the 
endpoint of the brace

enter a value for End offset. A positive value lengthens 
the brace on its axis, while a negative value shortens 
the brace on its axis.

If you want to . . . Then . . .

position the axis of the 
brace along the 
centroid of the brace 
shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
brace along one of nine 
positions on the brace 
shape

select one of the nine positions for Justify.

NOTE These positions are defined at a roll of zero, 
viewing the beam from the end to the start.
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Justification options for a brace

8 Specify the rise, which is the vertical distance between the start and end-
point of the brace:

9 In the drawing area, specify the start point of the brace.

You can move or hide the Properties palette to expose more of the drawing 
area.

10 Specify an endpoint for the brace:

� If you entered a value for Rise in step 8, then the endpoint of the brace 
is the X and Y coordinates of the endpoint that you selected. The Z 
coordinate equals the Z coordinate of the start point plus the value for 
the rise.

� If you selected Specify on Screen in step 8, the endpoint of the brace is 
the 3D point that you selected.

11 Continue adding braces, and press ENTER.

If you want to . . . Then . . .

specify the rise of the 
brace before you draw 
it

select No for Specify Rise on Screen, and enter a value 
for Rise.

specify the rise of the 
brace by specifying a 
3D endpoint for the 
end of the brace.

select Yes for Specify Rise on Screen.
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Creating a Freestanding Column

Use this procedure to add a new column that has the properties specified in 
the structural column tool that you select. The style specified in the tool pro-
vides its shape. Unlike beams and braces, columns are created with their 
length (X-axis) positioned in a positive direction along the current UCS Z-
axis. The length of the column defines the extrusion path for the column 
shape.

To specify settings when you add a column, see “Creating a Freestanding Col-
umn with User-Specified Settings” on page 1573.

Creating a column

1 Open the tool palette that you want to use, and select a structural column 
tool.

If necessary, scroll to display the tool that you want to use.

2 Press ENTER to create a freestanding column.

3 Specify the insert point of the column.

You can move or hide the Properties palette to expose more of the drawing 
area.

4 Specify the roll, or rotation of the column around its extruded axis:

A positive value for roll rotates the column counter-clockwise when 
viewed from the end (top) to the start (bottom) of the column.

If you want to . . . Then . . .

specify the roll of the 
column before you 
insert it

select No for Specify Roll on Screen, and enter a value 
for the column in the property palette.
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5 Continue adding columns, and press ENTER.

Creating a Freestanding Column with User-
Specified Settings

Use this procedure to create a free-standing column, with settings that you 
specify. The structural member style that you use to create the column pro-
vides its shape. Unlike beams and braces, you create columns with their 
length (X-axis) positioned in a positive direction along the current UCS Z-
axis. You specify the length of the column to define an extrusion path for the 
shape.

Creating a free-standing column

Optionally, offset the column from its start or endpoint. 

specify the roll of the 
column by rotating it in 
your drawing after you 
insert it

select Yes for Specify Roll on Screen, and specify a point 
in your drawing or enter a value.

If you want to . . . Then . . .
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Offsetting a column

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a Structural Column 
tool.

 If necessary, scroll to display the tool that you want to use.

2 Press ENTER to create a free-standing column.

3 On the Properties palette, expand Basic, and expand General.

4 Select a structural column style.

The style of the column provides its shape.

5 Expand Dimensions.

6 Specify offsets:

If you want to . . . Then . . .

offset the column on its 
extruded axis at the 
start point of the 
column

enter a value for Start offset. A positive value shortens 
the column on its axis, while a negative value lengthens 
the column.

offset the column on its 
extruded axis at the 
endpoint of the column

enter a value for End offset. A negative value lengthens 
the column on its axis, while a positive value shortens 
the column.
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7 Enter a value for Logical length.

The logical length of the column is the length (height) of the column 
before offsets are applied.

8 Specify the roll, or rotation of the column around its extruded axis:

A positive value for roll rotates the column counter-clockwise when 
viewed from the end (top) to the start (bottom) of the column.

9 Specify the column justification, which positions the column shape in 
relation to its extruded axis when you draw the column:

10 In the drawing area, specify the insert point of the column.

You can move or hide the Properties palette to expose more of the drawing 
area.

11 If you selected Specify on Screen for the roll of the column, select a point 
in your drawing.

12 Continue adding columns, and press ENTER.

If you want to . . . Then . . .

specify the roll of the 
column before you 
insert it

select No for Specify Roll on Screen, and enter a value 
for Roll.

specify the roll of the 
column by rotating it 
your drawing after you 
insert it

select Yes for Specify Roll on Screen.

If you want to . . . Then . . .

position the extruded 
axis of the column at 
the centroid of the 
column shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the extruded 
axis of the column 
along one of nine 
positions on the 
column shape

select one of the nine positions for Justify. 

NOTE These positions are defined at a roll of zero, 
viewing the column from the top to the bottom.
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Creating a Column Anchored to a Grid

Use this procedure to anchor a column that has the properties specified in 
the structural column tool that you select to a grid. The style specified in the 
tool provides its shape. Unlike beams and braces, columns are created with 
their length (X-axis) positioned in a positive direction along the current UCS 
Z-axis. The length of the column defines the extrusion path for the column 
shape. You select the position to anchor the column to on the grid.

To specify settings when you anchor a column to a grid, see “Creating a Col-
umn Anchored to a Grid with User-Specified Settings” on page 1577.

To create a column grid with pre-anchored columns, see “Creating a Column 
Grid” on page 1204.

Creating a column

1 Open the tool palette that you want to use, and select a structural column 
tool.

If necessary, scroll to display the tool that you want to use.

2 Select the grid.

3 Specify the insert point of the column on the grid.

You can move or hide the Properties palette to expose more of the drawing 
area.

4 Continue adding columns to the grid, and press ENTER.

IMPORTANT Columns grids that have numerous columns attached to them 
can take longer than expected to display on screen. This is because structural 
members carry additional information that may be used for structural analysis.
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Creating a Column Anchored to a Grid with 
User-Specified Settings

Use this procedure to anchor a column to a grid as you create it, with settings 
that you specify. The structural member style that you use to create the col-
umn provides its shape. Unlike beams and braces, columns are created with 
their length (X-axis) positioned in a positive direction along the current UCS 
Z-axis. The length of the column defines the extrusion path for the column 
shape. You select the position to anchor the column to on the grid.

To create a column grid with pre-anchored columns, see “Creating a Column 
Grid” on page 1204.

Creating anchored columns
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Creating a column

Optionally, offset the column from its start or endpoint. 

Offsetting a column

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a Structural Column 
tool.

 If necessary, scroll to display the tool that you want to use.

2 Select the grid.

3 On the Properties palette, expand Basic, and expand General.

4 Select a structural column style.

The style of the column provides its shape.
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5 Expand Dimensions.

6 Specify offsets:

7 Enter a value for Logical length. 

The logical length of the column is the length (height) of the column 
before offsets are applied.

8 Specify the column justification, which positions the column shape in 
relation to its extruded axis when you draw the column:

9 Specify the insert point of the column on the grid.

10 Continue adding columns to the grid, and press ENTER.

IMPORTANT Columns grids that have numerous columns attached to 
them can take longer than expected to display on screen. This is because 
structural members carry additional information that may be used for struc-
tural analysis.

If you want to . . . Then . . .

offset the column on its 
extruded axis at the 
start point of the 
column

enter a value for Start offset. A positive value shortens 
the column on its axis, while a negative value lengthens 
the column.

offset the column on its 
extruded axis at the 
endpoint of the column

enter a value for End offset. A negative value lengthens 
the column on its axis, while a positive value shortens 
the column.

If you want to . . . Then . . .

position the axis of the 
column along the 
centroid of the column 
shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
column along one of 
nine positions on the 
column shape

select one of the nine positions for Justify.
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Creating a Structural Member from Linework

Use this procedure to convert any of the following objects to structural mem-
bers with structural member tools:

� Arcs
� Lines
� Open polylines
� Open polylines with arc segments

When you use a tool to convert linework to a structural member, the style 
specified in the tool provides the shape of the member. The linework defines 
the extrusion path for the shape. You can convert multiple lines to create 
multiple members, convert curved lines to create curved members, and con-
vert multi-segmented lines to create multi-segmented members.

NOTE Converting an arc to a structural member is the only method of creat-
ing a curved structural member. For more information about curved structural 
members, see “About Curved Structural Members” on page 1590.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a structural member tool, and click Apply Tool Properties to 
Linework.

3 Select the linework to convert, and press ENTER.

WARNING! You cannot convert a closed polyline (a polyline with a start 
node that coincides with its end node) to a structural member.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the structural member in the Properties palette, if 
necessary.

6 If you 

created a structural member by converting a polyline, the initial orienta-
tion of the structural member is set to the UCS that was current when you 
drew the polyline. You can change the orientation by adjusting the roll of 
the member.
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Editing Structural Members

After you create a structural member, you can change any properties of the 
member that you specified when you created it and make additional modifi-
cations. You can change the start and end offsets of a member, or add or 
remove them. You can change the length, justification, and location of a 
member. For a curved structural member, you can change the radius.

You can change the geometry of a structural member by trimming it. By 
changing the structural member type, you can change a brace to beam, or a 
column to a brace. By changing the style of a structural member, you can 
change its shape.

Autodesk® Architectural Desktop offers several methods for editing structural 
members:

� You can directly edit structural members using grips for dimensions and 
other physical characteristics.

� You can change structural member settings on the Properties palette.
� You can select editing commands from the context menu for a selected 

structural member.

Related Topics and Procedures

� Using Grips to Edit Structural Members

� Changing the Structural Member Length

� Changing the Structural Member Start and End Offsets

� Changing the Radius of a Curved Structural Member

� Changing the Structural Member Justification

� Changing the Structural Member Type

� Trimming Structural Members

� Changing the Style of a Structural Member

� Changing the Location of a Structural Member

� Applying Tool Properties to a Structural Member

� Attaching Hyperlinks, Notes, and Files to a Structural Member

Using Grips to Edit Structural Members

Refer to the illustrations and steps in this topic to use grips to edit structural 
members.
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Editing Structural Member Dimensions

1 Select the structural member.

2 Select the grip for the dimension you want to change.

Grips for length, start offset, and end offset of a straight beam or brace

Grips for length, start offset, and end offset of a straight column
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Grips for start and end angles, radius, and start and end offsets of a curved beam 
or brace

Grips for start and end angles, radius, and start and end offsets of a curved column

3 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.

Changing the Location or Position of a Structural Member

1 Select the structural member.

Move the appropriate grip to change the location of the structural mem-
ber, or its roll (the rotation of the member around its extruded axis).



1584 | Chapter 22 Structural Members

Location and roll grips for a straight beam or brace

Location and roll grips for a straight column
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Location and roll grips for a curved beam or brace

Location and roll grips for a curved column

2 Move the grip until the dimension value you want is displayed, and click 
once, or enter a value.
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Changing the Structural Member Length

Use this procedure change the length of a structural member. You can also 
change the structural member length on the Properties palette.

1 Select the structural member.

2 Select a Lengthen grip, move the grip until the length value you want dis-
plays, and click once.

Grips for length of a straight beam or brace

Grips for length (height) of a straight column

After selecting a grip, you can also enter a value to increase or decrease the 
length of the structural member.
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Changing the Structural Member Start and End 
Offsets

Use this procedure to offset a structural member from the start or endpoint 
of its path. You can remove or change existing offsets, or add new offsets to 
the start point or endpoint of a structural member. You can also change the 
structural member start and end offsets on the Properties palette.

1 Select the structural member.

2 Select a Start Offset grip, move the grip until the start offset value you 
want displays, and click once.

A positive start offset value shortens the member on its axis (path), while 
a negative start offset value lengthens the member. 

Grips for start and end offsets of a straight beam or brace
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Grips for start and end offsets of a straight column

Grips for start and end angles, radius, and start and end offsets of a curved beam 
or brace
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Grips for start and end angles, radius, and start and end offsets of a curved column

3 Select an End Offset grip, move the grip until the end offset value you 
want displays, and click once.

A positive end offset lengthens the member on its axis, while a negative 
end offset shortens the member.

After selecting a grip, you can also enter a value to increase or decrease the 
the start or end offset of the structural member.

Changing the Radius of a Curved Structural 
Member

Use this procedure to change the radius of a curved structural member. You 
can also change the structural member radius on the Properties palette. For 
more information about curved structural members, see “About Curved 
Structural Members” on page 1590.

1 Select the structural member.

2 Select a Curve Radius grip, move the grip until the radius value you want 
displays, and click once.
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Grips for start and end angles, radius, and start and end offsets of a curved beam 
or brace

Grips for start and end angles, radius, and start and end offsets of a curved column

About Curved Structural Members
The smoothness (tesselation) of curved edges is controlled by the FACETDEV 
variable. This variable sets the number of facets to display on curved AEC 
objects. The default value is 1/2” for drawings created from imperial tem-
plates and is 12.7 mm for drawings created from metric templates.

The number you specify for facet deviation defines the maximum distance 
from the chord to the arc, the chord being an edge that is created from 
faceting the curve, to the true mathematical arc. The facet deviation has a 
range of greater than zero (0) and no upper limit.

The minimum number of facets is 8. For example, if you create a cylinder 
mass element to have a 1’ radius, and specify 1’ for facetdev, the cylinder has 
8 faces.
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The plan representation of individual curved components of columns uses 
the true curved representation of the member shapes. The above and below 
cut components will always be faceted.

The maximum number of facets is controlled by the FACETMAX variable. 
This variable can be set from 100 to 10,000. Note that using a small value for 
FACETDEV and a large value for FACETMAX will adversely affect drawing 
performance.

To specify the facet deviation values for the current drawing, see “Specifying 
the Display Resolution of Objects with Facets” on page 564. The settings 
apply to all curved objects in the drawing, including curved structural mem-
bers.

Changing the Structural Member Justification

Use this procedure to change the justification of a structural member. Justifi-
cation positions the shape of a structural member in relation to its extruded 
axis. Changing the justification of an existing member moves the member 
and can affect how the member relates to other objects, such as how a col-
umn is positioned in relation to a column grid when it is anchored to the 
grid.

Justification options for a beam 

You can also specify the justification of structural members with multiple 
shapes and segments. For more information about these members, see“Cre-
ating Custom Structural Members” on page 1615.

1 Select the structural member to change, and double-click it.

2 On the Properties palette, expand Basic, and expand Dimensions.
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3 Select a setting for Justification:

4 To specify the justification of members with multiple shapes and seg-
ments created with this tool, select a setting for Justify using overall 
extents:

Changing the Structural Member Type

Use this procedure to change the type of one or more structural members. 
Because beams, braces, and columns are sub-types of a single structural mem-
ber object, you can change a beam to a brace, a column to beam, or a brace 
to a beam.

1 Select the structural members to change, and double-click one of them.

2 On the Properties palette, expand Basic and expand General.

3 Select a setting for Member type: Beam, Brace, or Column.

If you want to . . . Then . . .

position the axis of the 
member along the 
centroid of the 
member shape

select Baseline for Justify.

NOTE This applies to members created with styles 
from the Structural Member Catalog only.

position the axis of the 
member along one of 
nine positions on the 
member shape

select one of the nine positions for Justify.

If you want to . . . Then . . .

justify the member 
based on the largest 
cross-sectional extents 
of the member

select Yes. The justification is applied to all shape 
definitions at each node (vertex) of the member.

justify the member 
based on the priorities 
of the shapes assigned 
in the design rules of 
the member style

select No. The justification is calculated based on the 
cross-sectional extents at each node and applied to the 
shape or shapes with the lowest priority at each node.
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Trimming Structural Members

You can use trim planes to trim structural members in your drawings. A trim 
plane is a cutting plane that trims a structural member to a location that you 
define on the structural member.

Trimming a structural member with a trim plane

You can use trim planes to clean up joints between multiple structural 
members. For example, use multiple trim planes to angle both ends of a brace 
in a diagonally braced frame.

NOTE Because trim planes are infinite planes, you cannot use them to notch, 
cope, or cut holes in structural members.

You can add one or more trim planes to a structural member, change trim 
planes, and remove trim planes from a structural member to restore it to its 
original dimensions.

Related Procedures

� Adding a Trim Plane to a Structural Member

� Changing a Structural Member Trim Plane

� Removing a Trim Plane from a Structural Member
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Adding a Trim Plane to a Structural Member
You can add any number of trim planes to a structural member. When you 
add a trim plane to one or more structural members, you define the position 
of the trim plane relative to the structural member that you are trimming.

When defining trim planes, you can:

� Define the position of the trim plane relative to the start or end of the 
extruded axis of the member.

� Offset the trim plane in the X direction to move the origin of the trim 
plane along the extruded axis of the member.

Offsetting a trim plane

� Offset the trim plane in the Y and Z direction to move the origin of the 
trim plane perpendicular to the extruded axis of the member in the Y and/
or Z directions.

� Rotate the trim plane around its Y or Z axis to angle the cutting plane.
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Rotating a trim plane

1 Select the structural member you want to change, and double-click.

2 On the Properties palette, expand Advanced.

3 Click the setting for Trim planes.

4 Click .

5 Specify settings to position the trim plane:

If you want to . . . Then . . .

offset the trim plane from 
the start point or endpoint 
of the member

select Start or End under Offset. 

offset the trim plane in the 
X direction along the 
extruded axis of the 
member

enter an X value for Offset.

offset the trim plane in the 
Y and Z directions to 
position the trim plane 
perpendicular to the 
extruded axis of the 
member

enter Y and Z values for Offset.

rotate the trim plane 
around its Y or Z axis

enter Y and Z values for Rotation.
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6 To copy a trim plane, select the trim plane, and click Copy.

7 Continue adding trim planes, and click OK.

Changing a Structural Member Trim Plane
After you add one or more trim planes to a structural member, you can 
change the orientation of the trim planes. You can also grip-edit trim planes 
to move and rotate them. 

1 Select the structural member you want to change, and double-click. 

2 On the Properties palette, expand Advanced.

3 Click the setting for Trim planes.

4 Change any of the trim plane settings:

NOTE If you rotate a trim plane between 90 and 270 degrees, the opposite 
end of the structural member is completely removed.

5 Click OK.

Removing a Trim Plane from a Structural Member
You can remove a trim plane from a structural member. When you remove 
all trim planes from a structural member, the structural member is restored 
to its original dimensions.

If you want to . . . Then . . .

change the start or end 
offset of the trim plane

select Start or End under Offset. 

change the trim plane 
offset in the X direction 
along the extruded axis of 
the member

change the X value for Offset.

change the trim plane 
offset in the Y and Z 
directions to position the 
trim plane perpendicular 
to the extruded axis of the 
member

change the Y and Z values for Offset.

change the rotation of the 
trim plane around the Y or 
Z axis

change Y and Z values for Rotation.
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1 Select the structural member you want to change, and double-click. 

2 On the Properties palette, expand Advanced.

3 Click the setting for Trim planes.

4 Select the trim plane that you want to remove.

5 Click Remove.

6 Click OK.

Changing the Style of a Structural Member

Use this procedure to select a different structural member style for one or 
more structural members. The style of a structural member provides its 
shape, so changing the style of a member changes its shape.

1 Select the structural members to change, double-click one of them.

2 Expand Basic, and expand General.

3 Select a different style.

Changing the Location of a Structural Member

Use this procedure to relocate a structural member by changing the coordi-
nate values of its insert point. The structural member also has an orientation 
with respect to the WCS or the current UCS. For example, if the top and bot-
tom of the structural member are parallel to the XY plane, its normal is par-
allel to the Z axis. You can change the orientation of the structural member 
by aligning its normal with another axis. You can also rotate the structural 
member on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Double-click the structural member that you want to change.

2 In the Properties palette, expand Basic, and expand Location.

3 Enter new coordinate values for the start and end points of the structural 
member.

Applying Tool Properties to a Structural Member

Use this procedure to apply the properties of a structural member tool to one 
or more members in a drawing. The properties include any settings specified 
in the tool you select.

1 Open the tool palette that you want to use.
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If necessary, scroll to display the tool that you want to use.

2 Right-click a structural member tool, and click Apply Tool Properties to 
➤ Beam, Brace, or Column.

3 Select the structural members, and press ENTER.

4 Edit the properties of the structural member on the Properties palette, if 
necessary.

Attaching Hyperlinks, Notes, and Files to a 
Structural Member

Use this procedure to enter notes and attach hyperlinks and reference files to 
a structural member. You can also edit notes and edit or detach reference files 
from a structural member.

1 Double-click the structural member.

2 In the Properties palette, click the Extended Data tab.

3 Click the setting for Hyperlink.

4 Specify the link, and click OK. 

5 Click the setting for Notes.

6 Enter the note, and click OK. 

7 Click the setting for Reference documents, and attach, edit, or detach a 
reference file:

8 Click OK.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter your comments under Description for the 
document you are describing

edit a reference file double-click the reference file name to start the 
application needed to edit it.

detach a reference file select the file name, and click Delete.
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Structural Member Styles

A structural member style is a group of properties assigned to a structural 
member that determines the shape and other characteristics of the structural 
member. You can use structural member styles to represent standard struc-
tural member types for specific jobs and drawings or for office stan-
dards.When you create or modify a structural member style, the structural 
members using the style have the settings and characteristics of the style.

 Usually you create structural member styles from the Structural Member Cat-
alog or with the Structural Member wizard and drag them from the Style 
Manager onto a tool palette. You can also create your own structural member 
styles for custom structural members that you cannot create from the catalog 
or with the wizard. For more information, see “Creating Custom Structural 
Members” on page 1615.

Creating Tools from Structural Member Styles
You can create a structural member tool from any structural member style. 
Usually, you want to create structural members tools from styles that you cre-
ate in the Structural Member Catalog or with the Structural Member Style 
wizard. However, you can also create a structural member tool from a style 
that you create in the Style Manager. You can save the style to a drawing file 
and create a structural member tool with the style. You can then specify 
default settings for any structural member created with that tool. For more 
information, see “Creating Structural Member Tools” on page 1553.

Managing Structural Member Styles
To create, edit, copy, or purge structural member styles, you access the Style 
Manager. The Style Manager provides a central location in Autodesk Archi-
tectural Desktop where you can work with styles from multiple drawings and 
templates. For more information about using the Style Manager, see “Style 
Manager.”

Related Topics and Procedures

� Creating a Structural Member Style in the Style Manager

� Specifying the Materials of a Structural Member Style

� Specifying the Display Properties of a Structural Member Style

� Specifying Classifications for a Structural Member Style

� Attaching Notes and Files to a Structural Member Style
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Creating a Structural Member Style in the Style 
Manager

Use this procedure to create a structural member style in the Style Manager. 
You can create a style using default style properties, by copying an existing 
style. After you create the style, you edit the style properties to customize the 
characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Structural Member Styles.

3 Create a structural member style:

4 Enter a name for the new structural member style, and press ENTER.

5 To edit the new structural member style, right-click the style, and click 
Edit:

If you want to . . . Then . . .

create a style with default 
properties

right-click Structural Member Styles, and click New.

create a style from an 
existing style

right-click the structural member style you want to 
copy, and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

change the design rules of 
the style to create a 
custom structural member

see “Creating Custom Structural Members” on 
page 1615.

specify materials for the 
components of the style

see “Specifying the Materials of a Structural 
Member Style” on page 1601.

specify hatching, cut plane 
properties, and other 
display properties of the 
style

see “Specifying the Display Properties of a Structural 
Member Style” on page 1603.

add classifications to a 
structural member style

see “Specifying Classifications for a Structural 
Member Style” on page 1613.
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6 Click OK.

7 If you want to assign the style to a structural member tool, drag the style 
from the Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating Structural Member Tools” on page 1553.

8 Click OK.

Specifying the Materials of a Structural Member 
Style

A structural member consists of a number of components whose display 
properties can be determined by the materials assigned to each component. 
When you assign materials to a structural member style, you assign one 
material to each physical component of the structural member. You assign 
materials to components in each display representation where you want the 
materials to be used.

If you want to use the display properties of the structural member style, 
instead of using material display properties, you can turn off the material 
assignments in the display properties of the structural member style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Structural Member Materials and Display Components

� Assigning Materials to a Structural Member Style

add notes and files to the 
style

see “Attaching Notes and Files to a Structural 
Member Style” on page 1614.

If you want to . . . Then . . .
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Structural Member Materials and Display Components
The following table identifies the material component that corresponds to 
each structural member component: 

Assigning Materials to a Structural Member Style
Use this procedure to assign materials to the individual components of a 
structural member style. When you assign a material to a structural member 
component, the component uses the display properties of the material 
instead of the style display properties.

You can assign a material to any physical component of the structural mem-
ber. Custom components and components that are only symbolic graphics 
do not use materials for their display properties. For example, all structural 
member components are physical components that you can assign materials. 
The connection marker and axis are symbols, and you cannot assign materi-
als to them.

NOTE If a material assignment does not determine the display properties of a 
structural member component, you can change the display properties of the 
structural member style as described in “Specifying the Display Properties of a 
Structural Member Style” on page 1603.

1 Open a tool palette that has a structural member tool.

Structural Member 
Component

Material Component

Elevation, Elevation High Detail

Visible Comp 1-10 Plan Linework

Model, Model High Detail, Model Low Detail

Component 1 - 10 3D Body 

Plan, Plan Low Detail, Plan High Detail, Plan Presentation, Plan 
Screened

Visible Comp 1-10 Plan Linework

Hatch 1 - 20 Plan Hatch

Reflected, Reflected Screened

Visible Comp 1-10 Plan Linework
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2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display Properties of a Structural 
Member Style

In most cases, you can assign materials to structural member components so 
that the appearance of structural members that belong to the same style is 
consistent throughout a drawing and with other structural members and 
objects that use the same materials.

If a component cannot be assigned a material, or if you do not want to use 
materials but still want consistency among structural members of the same 
style, you can specify the display properties of the structural member com-
ponents in the structural member style:

� Layer, color, and linetype of structural member components
� Hatching used with each component
� Cut plane height and the display of components relative to the cut plane
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� Other specific structural member display information, such as whether 
custom blocks are added to the display of the structural member

Related Procedures

� About Structural Member Display Representations

� Specifying the Layer, Color, and Linetype of a Structural Member Style

� Specifying the Hatching for Components of a Structural Member Style

� Specifying the Cut Plane Elevation of a Structural Member Style

� Using Custom Blocks to Add Graphics to a Structural Member Style

� Adding Custom Blocks as a Display Component in a Structural Member 
Style

� Turning Off Custom Blocks in a Structural Member Style

� Removing Custom Blocks from a Structural Member Style

About Structural Member Display Representations
Structural member geometry is created by a shape contained in the style of 
the structural member that is extruded along the axis of the member. Each 
shape can have different levels of detail in its geometry, allowing different 
displays of the structural member that the shape is defining. If you look at 
the display representations of a structural member, you see that there may be 
more than one of the same representation. Each representation displays the 
structural shape in a different level of detail.

For example, you can use the Plan, Plan High Detail, and Plan Low Detail 
structural member representations to display a plan view of a structural 
member. 
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Displaying a structural member with the Plan High Detail, Plan Low Detail, and Plan 
display representations

The Plan Low Detail display representation displays the member with simple 
lines and arcs. You can use display representation to create a top view fram-
ing plan where you want a single line representation of a column. The Plan 
Low Detail display representation includes two display components, Beam 
Sketch and Brace Sketch. You can change the display properties of these com-
ponents, such as layer, color, and linetype, to differentiate the display of 
beams and braces. You can also add offsets between members in this repre-
sentation to display them as you typically would in a top view framing plan.

The Plan and Plan High Detail display representations display the previous 
column using closed polylines. Both representations display the column 
geometry, but the Plan High Detail representation is more detailed, including 
fillets in the column display. Use the Plan representation to improve perfor-
mance while modeling, and the Plan High Detail representation to display 
an added level of detail for detail drawings.

The following table lists the structural member display representations and 
their uses:

Use this display 
representation . . .

To . . .

Elevation display an elevation view of a structural member 
with simplified geometry for better performance 
when modeling.
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Elevation High Detail display an elevation view of a structural member 
in full detail.

Logical display the extruded axis of a structural member 
and connections between members. Connections 
are automatically established between members 
when they touch endpoint to endpoint or 
endpoint to a point on the extruded axis of 
another member.

Model display a 3D structural member with simplified 
geometry for better performance when modeling.

Model High Detail display a 3D structural member in full detail for 
large scale details.

Plan display a 2D structural member in less detail than 
the Plan High Detail representation to improve 
performance. Members display as closed 
polylines, rather than lines and arcs as in the Plan 
Low Detail representation.

Plan High Detail display a 2D structural member in full detail.

Plan Low Detail display a 2D structural member with simple lines 
and arcs to create a top view framing plan. 
Includes a Beam Sketch and Brace Sketch display 
component to differentiate beams and braces in 
plan view. 

Plan Presentation display a 2D structural member with solid 
hatching (poche) for plan view presentation 
drawings.

Plan Screened display a 2D structural member in the screened 
portion of a screened floor plan, with components 
and hatching visibly lighter than some other 
objects.

Reflected display a 2D structural member in a reflected 
ceiling plan. 

Reflected Screened display a 2D structural member in the screened 
portion of a screened reflected ceiling plan with 
components and hatching visibly lighter than 
some other objects. 

Use this display 
representation . . .

To . . .
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Specifying the Layer, Color, and Linetype of a Structural 
Member Style
Use this procedure to change the following display properties of the compo-
nents of a structural member style: 

� Visibility (component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the display properties of compo-
nents in the structural member style, you can change the properties of the dis-
play component by clearing By Material. You can also override the material 
assignment with a different material. For more information, see “Assigning 
Materials to a Structural Member Style” on page 1602.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the structural member style that you want to change, and click 
Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

NOTE For multi-component structural members, hidden lines are calculated 
one component at a time.
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Specifying the Hatching for Components of a Structural 
Member Style
Use this procedure to specify the hatching of the components of a structural 
member style. Structural member hatching is displayed only in display rep-
resentations, such as Plan, that are used in the Top view (plan view) of a 
drawing.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the structural member style that you want to change, and click 
Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Hatching tab.

8 Select a component, and click the setting for Pattern.

9 Select the hatching for the component:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.
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13 Click Orientation, and specify how the hatching is oriented:

14 Click OK twice.

Specifying the Cut Plane Elevation of a Structural Member 
Style
Use this procedure to specify the cut plane elevation of a structural member 
style. The cut plane settings you specify in the structural member style over-
ride the cut plane settings in any display configuration applied to a viewport.

NOTE If the cut plane does not intersect the structural member, all visible and 
hidden components display. If the cut plane does intersect the member, only the 
cross section of the components of the structural member displays. These are the 
actual member shapes unless you select Do True Cut.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the structural member style that you want to change, and click 
Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Cut Plane tab.

8 Select Override Display Configuration Cut Plane.

9 Enter a value for Cut Plane Elevation.

10 Click OK twice.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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Using Custom Blocks to Add Graphics to a Structural Member 
Style
You can add custom blocks to the display of a structural member as a com-
ponent in a display representation. For example, you can add stiffener plates 
to beams as a custom blocks or add clip angles to members as a custom 
blocks.

Creating a stiffener plate custom block

Adding the custom block to the display of a structural member

Custom blocks can be either 2D or 3D. When you add a custom block, you 
can specify several rules for positioning and scaling the new component. 
Each custom block also appears in the display properties component list so 
that you can control its layer, color, and linetype. For more information, see 
“Adding Custom Blocks as a Display Component in a Structural Member 
Style” on page 1611.

Be sure to set the properties of the objects used to create your custom blocks 
to ByBlock. Otherwise, you cannot control these objects through the display 
properties. For more information about ByBlock, see “Working with Layers 
and Properties” in the online AutoCAD 2004 User’s Guide.

To change these display properties for all structural members of the same 
structural member style, see “Specifying the Display Properties of a Structural 
Member Style” on page 1603.
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Adding Custom Blocks as a Display Component in a Structural 
Member Style
Use this procedure to add or edit custom block components in the display 
representation of a structural member style. 

1 Create a 2D or 3D block for the component that you want to add to the 
structural member.

Create the block in the same plane as the structural member that you use 
to represent structural member. For more information about custom 
blocks, see “Using Custom Blocks to Add Graphics to a Structural Member 
Style” on page 1610

2 Open a tool palette that has a structural member tool.

3 Right-click a structural member tool, and click Structural Member Styles.

4 Right-click the structural member style that you want to change, and click 
Edit.

5 Click the Display Properties tab.

The display representation in bold is the current display representation.

6 Select the display representation where you want the changes to appear, 
and select Object Override.

7 If necessary, click .

8 Click the Other tab.

9 Under Custom Block Display, click Add.

10 Click Select Block and select the block you created.

11 Select a setting for Position Along (x) to position the block in a location 
along the X-axis of the member.

12 Specify an insertion offset of the block in the X, Y, and Z directions.

13 Specify whether you want repeat the block display along the X-axis of the 
member:

If you want to . . . Then . . .

repeat the display of the 
block along the X-axis of 
the member

select Repeat Block Display.

offset the repeated blocks 
from the start or endpoint 
of the member 

enter values for Start Offset and End Offset.
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14 Specify whether to mirror the block in the X,Y, or Z direction:

15 Click OK three times.

Turning Off Custom Blocks in a Structural Member Style
Use this procedure to turn off the display of custom blocks without removing 
them from the structural member style.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the structural member style that you want to change, and click 
Edit.

4 Click the Display Properties tab.

The display representation in bold is the current display representation.

5 Select the display representation where you want to turn off custom 
blocks, and select Object Override.

specify the space between 
the repeated blocks

enter a value for space between.

increase the spacing 
between repeated blocks 
so the insertion point of 
the last block is at the end 
offset distance from the 
end of the member

select Fit, and select Space Evenly.

scale the block so the 
extents of all the blocks fit 
between the start and end 
offset distances

select Fit, and select Scale to Fit.

If you want to . . . Then . . .

create a mirror of the 
block in the X direction

select Mirror X.

create a mirror of the 
block in the Y direction

select Mirror Y.

create a mirror of the 
block in the Z direction

select Mirror Z.

If you want to . . . Then . . .



Structural Member Styles | 1613

6 If necessary, click .

7 Click the Other tab.

8 Under Custom Block Display, select Disable Custom Blocks.

9 Click OK twice.

Removing Custom Blocks from a Structural Member Style
Use this procedure to remove custom blocks from the display of a structural 
member.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the structural member style that you want to change, and click 
Edit.

4 Click the Display Properties tab.

The display representation in bold is the current display representation.

5 Select the display representation where you want to turn off custom 
blocks, and select Object Override.

6 If necessary, click .

7 Click the Other tab.

8 Under Custom Block Display, select the block and click Remove.

9 Click OK twice.

Specifying Classifications for a Structural 
Member Style

Use this procedure to specify classifications for any classification definition 
applied to a structural member style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to struc-
tural member styles.
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5 For each classification definition, select the classification you want to 
apply to the current structural member style.

6 Click OK twice.

Attaching Notes and Files to a Structural 
Member Style

Use this procedure to enter notes and attach reference files to a structural 
member style. You can also edit notes and edit or detach reference files from 
a structural member style.

1 Open a tool palette that has a structural member tool.

2 Right-click a structural member tool, and click Structural Member Styles.

3 Right-click the structural member style you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the structural member style, enter it for Descrip-
tion.

6 Click Notes.

7 To add a note, click the Text Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Creating Custom Structural Members

You can specify design rules within a structural member style to a create cus-
tom structural member. The design rules allow you to specify one or more 
shapes to extrude along the path (axis) of a structural member. You can assign 
and position a start and end shape for each segment of a structural member.

Creating Single-Segmented Custom Structural Members
 A single-segment member can start and end with the same shape, or you can 
specify different start and end shapes, resulting in a member that starts with 
one shape and ends with another. For example, you can create a tapered col-
umn by assigning different start and end shapes to a single-segment column.

Creating a tapered column

You can also assign different shapes to the same single-segment member by 
adding a component to the member. By adding a component in the design 
rules and assigning different shapes to the same segment, you can create a 
structural member with overlapping shapes. For example, you can create a 
concrete encased steel column by adding a component with a steel column 
shape to a concrete column.
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Creating a composite steel and concrete column

Creating Multi-Segmented Custom Structural Members
For multi-segmented structural members, you can assign different shapes to 
each segment of the member as components of the member. A series of nodes 
(starting at 0 at the start point of the member) correspond to each vertex of 
the member path. By assigning different shapes to segments between nodes 
on the member path, you can create a structural member that transforms 
from one shape to different shapes along the member path. For example, you 
can use this method to create a rigid frame.

Creating the rigid frame

Creating Custom Shapes for Structural Members
When you create custom structural members, you can use the shapes 
contained in styles that you create from the Structural Member Catalog or 
Structural Member Style wizard, or you can create your own custom shapes. 
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When you create a custom shape, you can only add it to a structural members 
in the design rules of the structural member style.

Related Topics and Procedures

� Understanding the Design Rules of a Structural Member

� Changing the Shape in the Style of a Structural Member

� Adding a Shape to a Structural Member

� Creating a Single-Component Structural Member: Tapered Column

� Creating a Multi-Component Structural Member: Composite Column

� Creating a Multi-Component Structural Member Using Multiple Seg-
ments: Rigid Frame

� Creating Custom Shapes for Structural Members

Understanding the Design Rules of a Structural 
Member

Use this procedure to access and understand the options in the design rules 
of a structural member.

1 Select a structural member, right-click, and click Edit Member Style.

2 Click Design Rules.

3 On the Design Rules tab, click Show Details. 

You can use the following options in the design rules to create custom 
members:

This option . . . Allows you to . . .

Component add multiple components to a structural member. 
Each component includes a name and can include a 
start and end shape and a priority. You can remove 
and copy the components of a structural member.

Start Shape and End 
Shape

select a shape and a set of parameters to the start 
and end of a structural member component. The 
component shapes can be the same shape or a 
different shape. If End Shape is using the Start 
Shape, an asterisk (*) displays next to the end shape. 
To transform the shape of the member along the 
member path, the end shape must be explicitly set.
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Priority assign a priority to a component. Components that 
start and end at a common node are mitered based 
on their priorities. Components with the same 
priority are factored into the miter angle between 
the components. Components with different 
priorities are not factored into the miter angle. 
Components with the lowest priority will affect the 
justification of the member when Justify Overall 
Extents is cleared on the Dimensions tab in the 
properties of the member.

Name select shapes that you assign to the start and end of 
the member or member segment. You can select 
shapes contained in structural member styles, or 
custom shapes that you create.

Relative to define the position of the shape relative to the start 
or end of the member.

Node place shapes on the member path relative to the 
start or end of the member. To place shapes on the 
member path, assign them to nodes on the member 
path. A single segment member has two nodes; the 
start point and the endpoint of the member. Multi-
segmented members have additional nodes located 
at each vertex of the member path, allowing you to 
assign different shapes to the start and end of each 
segment of the member. If you place shapes on the 
member path relative to the start of the member, 
then the start point of the member path is Node 0. 
The first vertex on the member path is Node 1, and 
so on until the endpoint of the member path is 
defined as the final node. If you place shapes on the 
member path relative to the end of the member, 
then the endpoint of the member is Node 0.

Scale scale the shape.

Mirror mirror the shape.

Rotation rotate the shape.

X offset the shape in the X direction along the 
member path.

Y offset the shape in the Y direction perpendicular to 
the member path.

Z offset the shape in the Z direction perpendicular to 
the member path.

This option . . . Allows you to . . .
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4 Click Add to add a component to a structural member.

A component with the same values as the preceding component is added 
to the design rules.

5 Click Copy to copy a component.

6 Click Remove to remove a component.

7 Click OK.

Changing the Shape in the Style of a Structural 
Member

Use this procedure to change the shape that is extruded along the axis of a 
structural member created from a single shape. You can create a new shape 
for the structural member by creating a custom shape, or by creating a new 
style from the Structural Member Catalog that contains a shape.

1 Create a structural member with a single shape. 

For more information, see “Creating Structural Members Using Structural 
Member Tools” on page 1562.

2 Create a new shape for the structural member:

3 Select the structural member, right-click, and click Edit Member Style.

4 Click Design Rules.

5 In the Name list under Start Shape, select the shape that you created in 
step 2.

If you created a custom shape in step 2, the name of the shape displays in 
the Name list. If you created a style from the Structural Member Catalog, 
the shape displays in the Name list with the name of the shape that you 
selected in the catalog to create the style, not with the style name that you 
created.

If you want to 
create . . .

Then . . .

a custom shape for the 
member

create a custom shape. See “Creating a Custom 
Shape for a Structural Member” on page 1635.

a shape from the 
Structural Member 
Catalog

create a structural member style in the Structural 
Member Catalog that contains the shape. See 
“Creating a Style from a Shape in the Structural 
Member Catalog” on page 1549.
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6 Click OK.

Adding a Shape to a Structural Member

Use this procedure to add one or more shapes to a structural member in the 
design rules of the structural member style. You can create a new shape to add 
to the structural member by creating a custom shape, or by creating a new 
style from the Structural Member Catalog that contains a shape.

1 Create a structural member with a single shape. 

For more information, see “Creating Structural Members Using Structural 
Member Tools” on page 1562.

2 Create a new shape to add to the structural member:

3 Select the structural member, right-click, and click Edit Member Style.

4 Click Design Rules.

5 Click Add.

A new component is added to the structural member.

6 Type a name for each component under Component.

7 For the new component, from the Name list under Start Shape, select the 
shape that you created in step 2.

If you created a custom shape in step 2, the name of the shape is displayed 
in the Name list. If you created a style from the Structural Member Cata-
log, the shape is displayed in the Name list with the name of the shape 
that you selected in the catalog to create the style, not with the style name 
that you typed.

8 Click OK.

The structural member is redrawn with the new shape added to its geometry. 

If you want to . . . Then . . .

create a custom shape for 
the member

create a custom shape. See Creating a Custom 
Shape for a Structural Member.

create a shape from the 
Structural Member 
Catalog

create a structural member style in the Structural 
Member Catalog that contains the shape. See 
Creating a Style from a Shape in the Structural 
Member Catalog
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Creating a Single-Component Structural 
Member: Tapered Column

Use this example to create a tapered column, a single-component structural 
member that starts with one shape and ends with another.

Creating a tapered column

The process of creating this tapered column has four steps:

Step 1: Create two structural member styles in the Structural Member Cata-
log that contain the start and end shapes to taper over the length (height) of 
the column.

Step 2: Create a Tapered Column tool.

Step 3: Create a column with the tapered column style.

Step 4:  Specify design rules in the tapered column style to add the start and 
end shapes in the styles that you created in step 1 to the tapered column.

Related Procedures

� Step 1: Creating Start and End Shapes for the Tapered Column

� Step 2: Creating the Tapered Column Tool

� Step 3: Creating a Column with the Tapered Column Tool

� Step 4: Adding the Start and End Shapes to the Tapered Column
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Step 1: Creating Start and End Shapes for the Tapered Column
Use this procedure to create two styles that contain the start and end shapes 
for the tapered column. The first style contains the start shape for the col-
umn and the second style contains the end shape for the column.

1 On the Format menu, click Structural Member Catalog.

2 Expand Imperial in the tree view in the left pane of the Structural Member 
Catalog.

3 Expand Steel, AISC, and then I-Shaped.

4 Select Wn, Wide-Flange Shapes.

5 Right-click W8X31 in the lower right pane of the Structural Member Cat-
alog, and click Generate Member Style.

6 Enter W8X31, and click OK.

7 Select W1n, Wide-Flange Shapes in the tree view in the left pane.

8  Right-click W14X43 in the lower right pane of the Structural Member 
Catalog, and click Generate Member Style.

9 Enter W14X43 and click OK.

10  Click  to close the Structural Member Catalog.

Step 2: Creating the Tapered Column Tool
Use this procedure to create a tapered column tool. Save the style for the 
tapered column in the Member Styles (Imperial).dwg located in \Documents and 
Settings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial.

1 On the Format menu, click Style Manager.

2 On the File menu, click Open drawing.

3 Open Member Styles (Imperial).dwg located in \Documents and Settings\All 
Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial.

4 Expand Architectural Objects, right-click Structural Member Styles, and 
click New.

5 Enter Tapered Column for the name, and press ENTER.

6 Click OK to close the Style Manager.

7 Click OK to save changes to the Member Styles (Imperial).dwg.

8 In the title bar of the tool palettes set, click , and then click New Palette.

9 Enter Structural, and press ENTER.
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10 Open the Design palette, select the Structural Column tool, right-click, 
and click Copy.

11 Open the Structural palette, right-click, and click Paste.

12 Select the new tool, right-click, and click Properties.

13 Enter Tapered Column for the Name.

14 Click the setting for Description.

15 Enter Creates a tapered column, and click OK.

16 Expand Basic, and expand General.

17 Click Style location.

18 Select Browse, select the Member Styles.dwg located in \Documents and Set-
tings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial, and click Open. 

19 Click Style and select Tapered Column.

20 Click OK.

Step 3: Creating a Column with the Tapered Column Tool
Use this procedure to create a column with the tapered column tool that you 
created.

1 Select the Tapered Column tool from the tool palette.

2 Press ENTER to create a column that is not anchored to a grid. 

3 Specify the insert point of the column.

4 Specify the roll, which is the rotation around the extruded axis of the col-
umn, and press ENTER.

Step 4: Adding the Start and End Shapes to the Tapered 
Column
Use this procedure to add the start and end shapes to the tapered column and 
transform them along the member path.

1 Select the column, right-click, and click Edit Member Style.

2 Click Design Rules.

3 Click Show Details.

4 Select Unnamed under Component, and enter Component 1.

5 Under Start Shape, select W8X31 from the Name list.

6 Scroll to the end of the Design Rules dialog box to display the End Shape 
parameters.

7 Under End Shape, select W14X43 from the Name list.

8 Click OK.
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The complete tapered column displays in your drawing.

Creating a Multi-Component Structural 
Member: Composite Column

Use this example to create a steel column encased in concrete, a multi-com-
ponent structural member with a single segment. The steel column shape is 
one component of the member, the concrete column shape another.

Creating a composite steel and concrete column

The process of creating this composite column has four steps:

Step 1: Create two structural member styles: one that contains the shape for 
the concrete column and one that contains the shape for the steel column.

Step 2: Create a Composite Column tool. 

Step 3: Create a column with the composite column style.

Step 4: Specify design rules in the composite column style to add the con-
crete and steel shapes to the column.

Steps to Create the Composite Column:

� Step 1: Creating the Steel and Concrete Shapes for the Composite Column

� Step 2: Creating the Composite Column Tool

� Step 3: Creating a Column with the Composite Column Tool

� Step 4: Adding the Steel and Concrete Shapes to the Composite Column

Step 1: Creating the Steel and Concrete Shapes for the 
Composite Column
Use this procedure to create two styles: one that contains the steel shape and 
one that contains the concrete shape.
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1 On the Format menu, click Structural Member Catalog.

2 Expand Imperial in the tree view in the left pane of the Structural Member 
Catalog.

3 Expand Steel, AISC, and then I-Shaped.

4 Select Wn, Wide-Flange Shapes.

5  Right-click W8X31 in the lower right pane of the Structural Member Cat-
alog, and click Generate Member Style.

6 Enter W8X31, and click OK.

7 Expand Concrete, and then Pre-Cast.

8 Select Rectangular Columns.

9 Right-click 16X16 in the lower right pane of the Structural Member Cata-
log, and click Generate Member Style.

10 Enter 16X16 and click OK.

11  Click  to close the Structural Member Catalog.

Step 2: Creating the Composite Column Tool
Use this procedure to create a composite column tool. Save the style for the 
composite column in the Member Styles (Imperial).dwg located in \Documents 
and Settings\All Users\Application Data\Autodesk\Autodesk Architectural Desk-
top 2004\R16.0\enu\Styles\Imperial.

1 On the Format menu, click Style Manager.

2 On the File menu, click Open drawing.

3 Open Member Styles (Imperial).dwg located in \Documents and Settings\All 
Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial.

4 Expand Architectural Objects, right-click Structural Member Styles, and 
click New.

5 Enter Composite Column for the name, and press ENTER.

6 Click OK to close the Style Manager.

7 Click OK to save changes to the Member Styles (Imperial).dwg.

8 In the title bar of the tool palettes set, click , and then click New Palette.

9 Enter Structural, and press ENTER.

10 Open the Design palette, select the Structural Column tool, right-click, 
and click Copy.

11 Open the Structural palette, right-click, and click Paste.

12 Select the new tool, right-click, and click Properties.
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13 Enter Composite Column for the Name.

14 Click the setting for Description.

15 Enter Creates a composite column, and click OK.

16 Expand Basic, and expand General.

17 Click Style location.

18 Select Browse, select the Member Styles.dwg located in \Documents and Set-
tings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial, and click Open. 

19 Click Style and select Composite Column.

20 Click OK.

Step 3: Creating a Column with the Composite Column Tool
Use this procedure to create a column with the composite column tool that 
you created.

1 Select the Composite Column tool from the tool palette.

2 Press ENTER to create a column that is not anchored to a grid. 

3 Specify the insertion point of the column.

4 Specify the roll, or rotation around the extruded axis of the column, and 
press ENTER.

Step 4: Adding the Steel and Concrete Shapes to the 
Composite Column
Use this procedure to add the steel and concrete shapes to the composite col-
umn.

1 Select the column, right-click, and click Edit Member Style.

2 Click Design Rules.

3 Click Show Details.

4 Select Unnamed under Component, and enter Component 1.

5 Under Start Shape, select 16X16 from the Name list.

6 Click Add.

A new component is added to the design rules of the column. By default, 
the start and end shapes are the same as the preceding component.

7 Select Unnamed under Component, and enter Component 2.

8 Under Start Shape for Component 2, select W8X31 from the Name list.

Do not change the other Start Shape parameters.
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9 Click OK.

The composite column displays in your drawing.

Creating a Multi-Component Structural Member 
Using Multiple Segments: Rigid Frame

Use this example to create a rigid frame, a multi-segmented structural mem-
ber created from multiple shapes that transform at each vertex of the struc-
tural member path.

To create the rigid frame, you convert a multi-segmented polyline to a struc-
tural member and assign different start and end shapes to each segment of 
the member as components in the design rules of the rigid frame style. A 
series of nodes correspond to the start point, vertices, and the endpoint of 
the member path. By assigning different shapes to segments between nodes 
on the member path, the rigid frame transforms from one shape to several 
shapes along its path.

Assign shapes to the rigid frame member relative to the start of the member. 
The start point is defined as Node 0. The first vertex of the member is defined 
as Node 1, the next vertex is Node 2, and so on until the endpoint of the 

member, which is defined as the end node. 

NOTE If you assign shapes relative to the end of the member, the endpoint of 
the member is defined as Node 0.

Identifying nodes on the member path
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Creating the rigid frame

The process of creating this rigid frame has seven steps:

Step 1: Create two styles in the Structural Member Catalog that contain the 
shapes that transform over the path of the rigid frame.

Step 2: Create a rigid frame style and tool.

Step 3: Draw a multi-segmented polyline path for the rigid frame and use the 
rigid frame tool to convert the path to a structural member.

Step 4: Create the first leg of the rigid frame by assigning start and end shapes 
to the first segment of the frame.

Step 5: Create the first rafter of the rigid frame by assigning start and end 
shapes to the second segment of the frame.

Step 6: Create the second rafter of the rigid frame by assigning start and end 
shapes to the third segment of the frame.

Step 7: Create the second leg of the rigid frame by assigning start and end 
shapes to the fourth segment of the frame.

Related Procedures

� Step 1: Creating Shapes for the Rigid Frame

� Step 2: Creating the Rigid Frame Tool

� Step 3: Drawing the Rigid Frame Path and Converting it to a Structural 
Member

� Step 4: Creating the First Leg of the Rigid Frame

� Step 5: Creating the First Rafter of the Rigid Frame

� Step 6: Creating the Second Rafter of the Rigid Frame

� Step 7: Creating the Second Leg of the Rigid Frame
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Step 1: Creating Shapes for the Rigid Frame
Use this procedure to create two styles that contain the two shapes that trans-
form over the path of the rigid frame.

1 On the Format menu, click Structural Member Catalog.

2 Expand Imperial in the tree view in the left pane of the Structural Member 
Catalog.

3 Expand Steel, AISC, and then I-Shaped.

4 Select Wn, Wide-Flange Shapes.

5 Right-click W8X31 in the lower right pane of the Structural Member Cat-
alog, and click Generate Member Style.

6 Enter W8X31, and click OK.

7 Select W1n, Wide-Flange Shapes in the tree view in the left pane.

8  Right-click W14X43 in the lower right pane of the Structural Member 
Catalog, and click Generate Member Style.

9 Enter W14X43 and click OK.

10  Click  to close the Structural Member Catalog.

Step 2: Creating the Rigid Frame Tool
Use this procedure to create a rigid frame tool. Save the style for the rigid 
frame in the Member Styles (Imperial).dwg located in \Documents and Set-
tings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial.

1 On the Format menu, click Style Manager.

2 On the File menu, click Open drawing.

3 Open Member Styles (Imperial).dwg located in \Documents and Settings\All 
Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial.

4 Expand Architectural Objects, right-click Structural Member Styles, and 
click New.

5 Enter Rigid Frame for the name, and press ENTER.

6 Click OK to close the Style Manager.

7 Click OK to save changes to the Member Styles (Imperial).dwg.

8 In the title bar of the tool palettes set, click , and then click New Palette.

9 Enter Structural, and press ENTER.

10 Open the Design palette, select the Structural Column tool, right-click, 
and click Copy.
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11 Open the Structural palette, right-click, and click Paste.

12 Select the new tool, right-click, and click Properties.

13 Enter Rigid Frame for the Name.

14 Click the setting for Description.

15 Enter Creates a rigid frame, and click OK.

16 Expand Basic, and expand General.

17 Click Style location.

18 Select Browse, select the Member Styles.dwg located in \Documents and Set-
tings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles\Imperial, and click Open. 

19 Click Style and select Rigid Frame.

20 Click OK.

Step 3: Drawing the Rigid Frame Path and Converting it to a 
Structural Member
Use this procedure to draw a polyline path in the shape of the rigid frame, 
and then convert it with the Rigid Frame tool you created in Step 2. 

1 In plan view, draw a polyline path for the rigid frame. 

Drawing the rigid frame path

2 On the Structural palette, select the Rigid Frame tool.

3 Right-click, select Apply Tool Properties to, and select Linework.

4 Select the polyline that you created in step 1.

5 Enter y (Yes) to leave the original polyline in the drawing and press ENTER.
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Step 4: Creating the First Leg of the Rigid Frame
Use this procedure to create the first leg of the rigid frame by assigning a dif-
ferent start and end shape to the first segment of the rigid frame member. 

Creating the first leg of the rigid frame

1 Select the rigid frame, right-click, and click Edit Member Style. 

2 Click Design Rules.

3 Click Show Details.

4 Select Unnamed under Component, and enter Leg 1. 

5 Under Start Shape, in the Name list, select W8X31.

6 Select Start for Relative to.

7 Enter 0 for Node.

Node 0 is relative to the start point of the member path.

8 Enter 90 for Rotation.

9 Scroll to the end of the Design Rules dialog box to display the End Shape 
parameters for Leg 1.

10 Under End Shape, in the Name list, select W14X43.

11 Select Start for Relative to.

12 Enter 1 for Node.

Node 1 corresponds to the vertex formed by the endpoint of the first seg-
ment of the member path and the start point of the second segment of the 
member path.
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Step 5: Creating the First Rafter of the Rigid Frame
Use this procedure to create the first rafter of the rigid frame by assigning a 
different start and end shape to the second segment of the rigid frame mem-
ber.

Creating the first rafter of the rigid frame

1 Click Add to add a second component to the structural member.

2 Select Unnamed under Component, and enter Rafter 1. 

3 Under Start Shape, in the Name list, select W14X43.

4 Select Start for Relative to.

5 Enter 1 for Node.

6 Scroll to the end of the Design Rules dialog box to display the End Shape 
parameters for Rafter 1.

7 Under End Shape, in the Name list, select W8X31.

8 Select Start for Relative to.

9 Enter 2 for Node.

Step 6: Creating the Second Rafter of the Rigid Frame
Use this procedure to create the second rafter of the rigid frame by assigning 
a different start and end shape to the third segment of the rigid frame mem-
ber.
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Creating the second rafter of the rigid frame

1 Click Add to add a third component to the structural member.

2 Select Unnamed under Component, and enter Rafter 2.

3 Under Start Shape, in the Name list, select W8X31.

4 Select Start for Relative to.

5 Enter 2 for Node.

6 Scroll to the end of the Design Rules dialog box to display the End Shape 
parameters for Rafter 2.

7 Under End Shape, in the Name list, select W14X43.

8 Select Start for Relative to.

9 Enter 3 for Node.

Step 7: Creating the Second Leg of the Rigid Frame
Use this procedure to create the second leg of the rigid frame by assigning a 
different start and end shape to the final segment of the rigid frame member.

Creating the second leg of the rigid frame
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1 Click Add to add a fourth component to the structural member.

2 Select Unnamed under Component, and enter Leg 2. 

3 Under Start Shape, in the Name list, select W14X43.

4 Select Start for Relative to.

5 Enter 3 for Node.

6 Scroll to the end of the Design Rules dialog box to display the End Shape 
parameters for Leg 2.

7 Under End Shape, in the Name list, select W8X31.

8 Select Start for Relative to.

9 Enter 4 for Node.

10 Click OK.

The complete rigid frame displays in your drawing.

Creating Custom Shapes for Structural Members

If you want to design a member with one or more shapes that you cannot 
create in a style in the Structural Member Catalog, you can create a custom 
shape.

Creating a structural member with a custom shape

When you create a custom shape, you define the shape that you want to use. 
To accommodate the different levels of detail in the Plan, Plan Low Detail, 
and Plan High Detail display representations, you may define three separate 
geometries for each representation. You can create the Plan Low Detail shape 



Creating Custom Structural Members | 1635

from simple lines, arcs and polylines, and the Plan High Detail and Plan 
shapes from closed polylines that do not intersect each other. 

After you have created a custom shape, you can assign the shape as a compo-
nent of a structural member in the design rules of the structural member 
style. You can edit, copy, and purge member styles after you create them.

Related Procedures

� Creating a Custom Shape for a Structural Member

� Copying a Custom Shape

� Editing a Custom Shape

� Purging Custom Shapes

Creating a Custom Shape for a Structural Member
Use this procedure to create a custom shape for a structural member.

1 Create three geometries to define the Plan Low Detail, Plan, and Plan High 
Detail display of the shape. 

Use lines and arcs to create your Plan Low Detail shape, and use closed 
polylines that do not intersect to create your Plan and Plan Detail shapes.

2 On the Format menu, click Define Custom Member Shape. 

The following prompt displays:

Shape [New/Copy/Edit/Purge/?]:

3 Enter n (New) to create a new shape. 

The following prompt displays:

New style name or [?]:

4 Enter a new name for the shape, and press ENTER.

The following prompt displays:

Shape definition [Name/Description/Graphics]:

5 Enter g (Graphics) to define the Plan Low Detail, Plan, and Plan High 
Detail representations of the shape.

NOTE If you do not want to create more than one representation for the 
shape, skip to step 9 and define a Plan representation to use as the default 
representation. 

6 Enter l (Plan Low Detail) to define the Plan Low Detail representation of 
the shape. 
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7 Select a base point for the Plan Low Detail representation, and press 
ENTER.

8 Select arcs and lines to define the Plan Low Detail representation of the 
shape, and press ENTER.

9 To define both the Plan and Plan High Detail representations of the shape, 
enter p (Plan) or h (Plan High Detail).

The following prompt displays:

Erase polyline? [Yes/No] <N>:

10 Enter y (Yes) to erase the geometry, press enter to keep the geometry.

11 Select the first closed polylines that you want to use to create the represen-
tation.

The following prompt displays:

Add another ring? [Yes/No] <N>:

12 Complete the shape representation definition:

� Press ENTER to create the shape definition from a single polyline.
� Enter y (Yes) to select additional polylines to add to the shape 

definition. Polylines that are within other rings can be specified as void 
areas that become holes in the shape These polylines must be entirely 
within or outside each other; they cannot overlap or touch.

The following prompt displays:

Insertion Point or <Centroid>:

13 Select an insertion point for the shape, or press ENTER to use the centroid.

14 Press ENTER three times to exit the command.

Copying a Custom Shape
Use this procedure to copy a custom shape.

1 On the Format menu, click Define Custom Member Shape. 

The following prompt displays:

Shape [New/Copy/Edit/Purge/?]:

2 Enter c (Copy) to copy a shape. 

The following prompt displays:

Shape name to copy or [?]:

3 Enter the name of the shape that you want to copy, or enter ? to select a 
shape to copy.

4 Enter a new shape name.
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Editing a Custom Shape
Use this procedure to edit a custom shape.

1 On the Format menu, click Define Custom Member Shape. 

The following prompt displays:

Shape [New/Copy/Edit/Purge/?]:

2 Enter e (Edit), and press ENTER. 

The following prompt displays:

Shape name to edit or [?]:

3 Enter the name of the shape that you want to copy, or enter ? to select a 
shape to copy.

The following prompt displays:

Shape definition [Name/Description/Graphics]:

4 To rename the shape, do the following:

� Enter n (Name), and press ENTER.
� Enter a new name for the shape, and press ENTER.

5 To add or change a description of the shape, do the following:

� Enter d (Description), and press ENTER.
� Enter a new description for the shape, and press ENTER.

6 To change the Plan Low Detail, Plan, or Plan High Detail representation of 
the shape, do the following:

� Enter g (Graphics), and press ENTER.
� Specify new geometry for the Plan Low Detail, Plan, or Plan High Detail 

representations.

NOTE When you edit a representation (Plan Low Detail, Plan, or Plan High 
Detail), you remove the existing shape from the representation. You cannot 
edit the geometry of the shape in the representation. Create new shape 
geometry to redefine the selected representation. You can use the Insert 
option of the -MemberShape command to create lines, arcs, and polylines 
from existing member shapes that you can modify for new member shapes.

7 When you finish editing the shape, press ENTER three times to exit the 
command.
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Purging Custom Shapes
Use this procedure to purge custom shapes. 

1 On the Format menu, click Define Custom Member Shape. 

The following prompt displays:

Shape [New/Copy/Edit/Purge/?]:

2 Enter p (Purge) to purge one or more shapes. 

The following prompt displays:

Shapes to purge <*>:

3 To purge a single shape, do the following:

� Enter the name of the shape, and press ENTER.
� Enter n (No) to not verify the shape to purge, and press ENTER.

The shape is purged.

4 To purge multiple shapes, do the following:

� To purge multiple shapes, enter * (asterisk), and press ENTER.
� To purge all the existing shapes, enter n (No), and press ENTER. To 

choose shapes to purge, enter y (Yes), press ENTER, and select the shapes 
that you want to purge.

5 When you finish purging custom shapes, press ENTER to end the com-
mand.
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Railings

Railings are objects that interact with stairs and other 

objects. You can add railings to existing stairs, or you 

can create freestanding railings.

Railing Components
Railings can have guardrails, handrails, posts, 
balusters, and one or more bottom rails. Addi-
tionally, you can add custom blocks to a railing.

Railing components

Railing Shapes
You can attach railings to one or both sides of a 
stair, and you can wrap them around a landing. 
You can also attach railings to any other type of 
AEC object, like for example a massing element. 
You can create a custom railing by converting a 

In this chapter

� Using Railing Tools to Create 
Railings

� Creating a Railing

� Creating an Attached Railing 
with User-Specified Settings

� Creating a Freestanding Railing 
with User-Specified Settings

� Creating a Railing from a 
Polyline

� Creating a Railing Tool

� Editing Railings

� Railing Styles

� Adding Custom Railing Blocks 
and Profiles to a Railing Style

23
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polyline. Therefore, railings can be a variety of shapes and can be anchored 
to a straight stair, a multi-landing stair, a U-shaped stair, or a spiral stair.

Custom Railings
You can create custom railings by specifying custom blocks and profiles to be 
used for individual railing components. You can assign profiles to railing 
components by style so that you can reuse the custom portion to create 
detailed railings.

Railing Styles and Their Properties
You can use a railing style to control properties for all railings that use that 
style, rather than changing properties for each individual railing in the draw-
ing. Various styles exist in the templates for common railing configurations, 
such as guardrail - pipe, handrail - grip, and handrail - round. Within the rail-
ing style, you can specify the rail locations and height, post locations and 
intervals, components and profiles, extensions, material assignments, and 
display properties of the railing. 

Materials in Railings
In Autodesk® Architectural Desktop, you can assign materials to a railing. 
These materials are displayed in wireframe and working shade views, or 
when linked into VIZ Render. Materials have specific settings for the physical 
components of a railing, such as the various types of rails and posts, and the 
baluster. You could for example, create a wooden railing with a stainless steel 
handrail and bottomrail. 

Railing in 2D wireframe model and rendered views

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for railings. You 
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can use these predefined materials, or modify them to your special designs. 
You can also create your own materials from scratch entirely.

For more information, see “Specifying the Materials of a Railing Style” on 
page 1684.

Related Procedures

� Using Railing Tools to Create Railings

� Creating a Railing

� Creating an Attached Railing with User-Specified Settings

� Creating a Freestanding Railing with User-Specified Settings

� Creating a Railing from a Polyline

� Creating a Railing Tool

� Editing Railings

� Railing Styles

� Adding Custom Railing Blocks and Profiles to a Railing Style

Using Railing Tools to Create Railings

Tools provided with Autodesk® Architectural Desktop let you quickly place 
railings by selecting a railing tool with a specific railing style and other pre-
defined properties. When you place railings using railing tools, you can use 
the default settings of the tool, or you can change settings for the railing 
properties. You can also use railing tools to convert linework to railings and 
to apply the settings of a railing tool to existing railings.
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Tool palettes containing railing tools

The default tool palettes in the workspace contain sample railing tools that 
you can use and customize as needed. In addition, the following catalogs pro-
vided with the software contain railing tools that you can add to your tool 
palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

Custom palettes created by your CAD manager or other users may also con-
tain railing tools with railing styles and properties that are customized for 
your projects or office standards.

Related Procedures

� Creating a Railing

� Creating an Attached Railing with User-Specified Settings

� Creating a Freestanding Railing with User-Specified Settings

� Creating a Railing from a Polyline

� Creating a Railing Tool
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Creating a Railing

Use this procedure to add a new railing that has the properties specified in 
the railing tool that you select. To specify settings when you add a railing, see 
“Creating an Attached Railing with User-Specified Settings” on page 1643 
and “Creating a Freestanding Railing with User-Specified Settings” on 
page 1647.

1 Open the tool palette that you want to use, and select a railing tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the start point of the railing.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the end point of the railing.

4 Continue adding railings, and press ENTER.

Creating an Attached Railing with User-
Specified Settings

Use this procedure to create a railing that is attached to a stair and that has 
the settings that you specify.
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Creating a railing attached to a stair

1 Open the tool palette that you want to use, and select a railing tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Expand Dimensions.

5 Click the setting for Rail locations.

NOTE If the settings in the Rail Locations worksheet are read-only, the rail 
locations have been set in the style, and can not be overridden here. For more 
information, see “Specifying the Upper Rails of a Railing Style” on page 1675 
and “Specifying the Bottom Rails of a Railing Style” on page 1677.

6 Specify the parameters for the guardrail or the handrail: 

If you want to . . . Then . . .

specify the height of the guardrail or 
the handrail

enter a value for Horizontal Height.

specify the height for of guardrail or 
the handrail while it is on a stair flight

enter a value for Sloping Height.
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Auto is useful only for railings attached to the edges of stairs. A positive 
value is toward the center of the stair, while a negative value is toward the 
outside edge. Side for Offset for handrails also has a selection of Both, so 
you can specify a handrail on both sides of the railing. 

If you select Auto, and the railing is not attached to or is along the center 
of a stair, the offset is to the right. 

7 Specify the settings for bottom rails: 

8 If you want to revert back to the rail settings defined in the style, click 
Reset To Style Values.

9 Click OK to return to the Property palette. 

10 Click the setting for Post locations. 

specify the distance that the guardrail 
or the handrail is offset from the posts

enter a value for Offset from Post.

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.

If you want to . . . Then . . .

specify the height of the lowest rail 
when it is horizontal

enter a value for Horizontal.

specify the height of the lowest rail 
when it is on a stair flight

enter a value for Sloping.

specify the distance that the bottomrail 
is offset from the posts

enter a value for Offset from Post.

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.

designate more than one bottom rail enter a value for Number of Rails.
When you designate multiple bottom 
rails, you can enter a value for Spacing 
of Rails.

If you want to . . . Then . . .
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NOTE If the settings in the Post Locations worksheet are read-only, the post 
locations have been set in the style, and can not be overridden here. For more 
information, see “Specifying Posts of a Railing Style” on page 1678.

11 Specify the post locations:

12 If you want to revert back to the post settings defined in the style, click 
Reset To Style Values.

13 Click OK to return to the Property palette.

14 Expand Location.

15 For Attached to, select Stair or Stair Flight. 

16 To offset the railing in or out from the side of the stair, enter an offset 
value. 

If you want to . . . Then . . .

include fixed posts at the beginning 
and end of the railing

select Fixed Posts.

specify the distance above or below 
the top rail for all posts

enter a value for Extension of ALL Posts 
from Top Railing.

specify the height of all posts from the 
floor

enter a value for Extension of ALL Posts 
from Floor Level.

include fixed posts at the corners of 
the railing

select Fixed Posts at Railing Corners.

include dynamic posts with the railing select Dynamic Posts.
You can then enter a value for 
Maximum Center to Center Spacing.

include balusters with the railing select Balusters.

specify the height of all balusters from 
the floor

enter a value for Extension of Balusters 
from Floor Level.

specify the maximum distance 
between the balusters

enter the appropriate value for 
Maximum Center to Center Spacing.

override the number of balusters on 
each stair tread

select Stair Tread Length Override.
You can then enter a value for Number 
per Tread. This applies only to railings 
that are attached to stairs.
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Positive values are in toward the center of the stair and negative values are 
out from the center of the stair. If the railing is center justified, a positive 
value is to the right and a negative value is to the left.

17 To attach the railing automatically to the full length of the stair or the stair 
flight, select Yes for Automatic Placement.

NOTE This option is available only if you have selected to attach the railing 
to a whole stair. If you are attaching the railing to a stair flight, it is always 
attached to the full length of the stair flight.

18 Select the stair or stair flight in the drawing to which you want to attach 
the new railing. 

19 Select a side of a stair or a stair flight to place the railing.

20 If you have selected no automatic placement for the stair, define the con-
tour of the desired railing by selecting points in the drawing. Then, press 
ENTER. 

Creating a Freestanding Railing with User-
Specified Settings

Use this procedure to create a freestanding railing in the drawing.

Creating a freestanding railing

1 Open the tool palette that you want to use, and select a railing tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Expand Dimensions.
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5 Click the setting for Rail locations.

NOTE If the settings in the Rail Locations worksheet are read-only, the rail 
locations have been set in the style, and can not be overridden here. For more 
information, see “Specifying the Upper Rails of a Railing Style” on page 1675 
and “Specifying the Bottom Rails of a Railing Style” on page 1677.

6 Specify the parameters for the guardrail or the handrail: 

Auto is useful only for railings attached to the edges of stairs. A positive 
value is toward the center of the stair, while a negative value is toward the 
outside edge. Side for Offset for handrails also has a selection of Both, so 
you can specify a handrail on both sides of the railing. 

If you select Auto, and the railing is not attached to or is along the center 
of a stair, the offset is to the right. 

7 Specify the settings for bottom rails: 

If you want to . . . Then . . .

specify the height of the guardrail or 
the handrail

enter a value for Horizontal Height.

specify the height for of guardrail or 
the handrail while it is on a stair flight

enter a value for Sloping Height.

specify the distance that the guardrail 
or the handrail is offset from the posts

enter a value for Offset from Post.

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.

If you want to . . . Then . . .

specify the height of the lowest rail 
when it is horizontal

enter a value for Horizontal.

specify the height of the lowest rail 
when it is on a stair flight

enter a value for Sloping.

specify the distance that the bottomrail 
is offset from the posts

enter a value for Offset from Post.
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8 If you want to revert back to the rail settings defined in the style, click 
Reset To Style Values.

9 Click OK to return to the Property palette. 

10 Click the setting for Post locations. 

NOTE If the settings in the Post Locations worksheet are read-only, the post 
locations have been set in the style, and can not be overridden here. For more 
information, see “Specifying Posts of a Railing Style” on page 1678.

11 Specify the post locations:

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.

designate more than one bottom rail enter a value for Number of Rails.
When you designate multiple bottom 
rails, you can enter a value for Spacing 
of Rails.

If you want to . . . Then . . .

include fixed posts at the beginning 
and end of the railing

select Fixed Posts.

specify the distance above or below 
the top rail for all posts

enter a value for Extension of ALL Posts 
from Top Railing.

specify the height of all posts from the 
floor

enter a value for Extension of ALL Posts 
from Floor Level.

include fixed posts at the corners of 
the railing

select Fixed Posts at Railing Corners.

include dynamic posts with the railing select Dynamic Posts.
You can then enter a value for 
Maximum Center to Center Spacing.

include balusters with the railing select Balusters.

specify the height of all balusters from 
the floor

enter a value for Extension of Balusters 
from Floor Level.

If you want to . . . Then . . .
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12 If you want to revert back to the post settings defined in the style, click 
Reset To Style Values.

13 Click OK to return to the Property palette.

14 Expand Location.

15 For Attached to, select NONE.

16 Specify the start point of the railing. 

17 Specify further points for the railing. 

18 Press ENTER.

Creating a Railing from a Polyline

Use this procedure to convert a polyline to a railing that has the properties 
of the railing tool you select. You can edit these properties after creating the 
railing.

Converting a polyline to a railing

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

specify the maximum distance 
between the balusters

enter the appropriate value for 
Maximum Center to Center Spacing.

override the number of balusters on 
each stair tread

select Stair Tread Length Override.
You can then enter a value for Number 
per Tread. This applies only to railings 
that are attached to stairs.

If you want to . . . Then . . .
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2 Right-click a railing tool, and click Apply Tool Properties ➤  Polyline.

3 Select the polyline to convert, and press ENTER.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the railing in the Properties palette, if needed.

Creating a Railing Tool

Use this procedure to create a railing tool and add it to a tool palette. You may 
want to create your own railing tools if you are placing multiple railings of 
specific styles with additional railing properties that you want to be the same 
each time you add a railing of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

If you want to . . . Then . . .

create a tool from a railing in 
the drawing

select the railing, and drag it to the tool 
palette.

create a tool from a railing style 
in the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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7 Click the setting for Description, enter a description of the railing created 
from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a railing style.

10 Select the drawing file containing the style used for this railing.

11 Select if the railings created from this tool should be attached to a stair, a 
stair flight or be freestanding railings.

12 Click OK.

Editing Railings

You can edit railings by changing the style of the railing, the inclusion and 
location of various rails and posts, and the insertion point. You can also spec-
ify the height and offset of guardrails and handrails, and the extension and 
spacing of posts.

Methods of Editing Railings
Autodesk® Architectural Desktop offers several methods for editing railings:

� You can directly edit railings using grips for dimensions and other physi-
cal characteristics.

� You can change railing settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

railing.

Related Procedures

� Using Grips to Edit Railings

� Adding a Post to a Railing

� Removing a Post from a Railing

� Redistributing Posts on a Railing

� Hiding Posts

� Showing Hidden Posts

� Reversing the Direction of the Railing

� Anchoring an Existing Railing to a Stair

� Anchoring an Existing Railing to an Object

� Releasing an Anchored Railing

� Adding a Custom Profile to a Railing Component

� Editing a Custom Profile of a Railing Component
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� Changing the Style of a Railing

� Changing the Upper Rails

� Changing the Bottom Rails

� Changing the Posts

� Changing the Railing Extensions at Floor Levels

� Changing the Railing Extensions at Landings

� Changing the Anchor Properties of a Railing

� Changing the Location of a Railing

� Applying Tool Properties to an Existing Railing

� Attaching Hyperlinks, Notes, and Files to a Railing

Using Grips to Edit Railings

Refer to the illustrations and steps in this topic to use railing grips to edit rail-
ings.

Editing Railing Dimensions

1 Select the railing.

2 Select the grip for the dimension you want to change.

Viewing Railing Start, End, Location, and Reverse Direction Grips

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.
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Viewing Railing Fixed Post Position and Lengthen grips

Changing the Location or Position of a railing

1 Select the railing.

2 Move the appropriate grip to change the location of the railing, its start 
point, or its endpoint.

Reversing the direction of the Railing

1 Select the railing.

2 Click the direction grip (arrow grip). 

Adding a Post to a Railing

Use this procedure to add a post to a railing. The post is placed at a selected 
point on the railing.

Adding a post to a railing
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1 Select a railing.

2 Right-click, and click Post Placement ➤ Add.

3 Select a location for a new post.

4 Press ENTER.

Removing a Post from a Railing

Use this procedure to remove posts you have added to railings. The manu-
ally-added post closest to the selected point is removed from the railing. If 
two posts are equidistant to the selected point, the post closer to the starting 
point of the railing is removed.

Removing a post from a railing

1 Select a railing.

2 Right-click, and click Post Placement ➤ Remove.

Redistributing Posts on a Railing

Use this procedure to reposition dynamic posts to account for posts that have 
been added or removed. You cannot redistribute displayed posts to account 
for hidden posts.

You may also want to redistribute posts after dragging the endpoints (start 
and end offset) of a railing attached to a stair. If posts are lost after trimming 
a railing, use the Redistribute Posts command to restore the posts.

If you have created a railing that is so short that only one post can be created, 
grip-editing and dragging the railing does not create another post. You must 
use the Redistribute Posts command to add another post to the end of the 
railing.
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Redistributing posts on an existing railing

1 Select an existing railing.

2 Right-click, and click Redistribute Posts.

Hiding Posts

Use this procedure to hide posts in a railing. It is useful to hide posts in plan 
view so that the railing is visible as a solid component. These posts are not 
deleted, only hidden from view. You cannot hide dynamic posts.

Hiding a post on a railing

1 Select a railing.

2 Right-click, and click Post Placement ➤ Hide.
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Showing Hidden Posts

Use this procedure to show hidden posts.

1 Select a railing.

2 Right-click, and click Post Placement ➤ Show.

Reversing the Direction of the Railing

Use this procedure to reverse the direction of the railing to change the loca-
tion of railing components. The direction in which the railing is drawn 
affects the behavior of the railing and its components.

NOTE You can also reverse the direction of a railing by clicking its direction 
grip (arrow grip).

1 Select a railing.

2 Right-click, and click Reverse.

Anchoring an Existing Railing to a Stair

Use this procedure to anchor an existing railing to a stair. Once attached, the 
railing stays where it is located in the drawing, but it moves when the attach-
ing stair is moved. This allows you to create free-form paths for a railing 
along a stair. For example, if you want to create a curved railing in the middle 
of a straight stair.

Railings attached to stairs respect the stair’s cut plane. Also the height of the 
railing follows the slope of the stair, no matter where the posts are placed on 
the treads.
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Attaching a railing to a stair

Railings that are attached to a stair or to a stair flight when created are 
anchored automatically to the stair, at either side of the stairs or at the cen-
terline.

1 Select a railing.

2 Right-click, and click Railing Anchor ➤ Anchor To Stair.

3 Select a stair object, and press ENTER. 
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Anchoring an Existing Railing to an Object 

Use this procedure to anchor an existing railing to an AEC object other than 
a stair. Once attached, the railing stays where it is located in the drawing, but 
it moves when the attaching object is moved. This allows you to create free-
form paths for a railing along a stair or other object.

Railings attached to objects other than stairs follow the height of the center-
line of each post.

Attaching a railing to an AEC object

1 Select a railing.

2 Right-click, and click Railing Anchor ➤ Anchor To Object.

3 Select an AEC object other than a stair, and press ENTER. 

4 If you want to clean up the railing posts with the surface of the object it is 
attached to, enter Y (Yes) on the command line. 
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5 Define the contour of the railing. 

Releasing an Anchored Railing

Use this procedure to release an anchored railing from a stair. After the railing 
is released, it is independent from the stair. The railing and the stair can then 
be moved separately.

NOTE When a railing that is anchored to a stair is released, any changes to the 
railing (such as grip editing or changing properties) may cause the railing to lose 
its slope. Be sure to correct the appearance of the railing before releasing it from 
the stair.

1 Select a railing.

2 Right-click, and click Railing Anchor ➤ Release.

The railing is no longer anchored to the stair.

Adding a Custom Profile to a Railing Component

Use this procedure to add a custom profile to a railing component. 

Guardrails, handrails, bottom rails, and fixed and dynamic posts can be 
defined by a custom profile. You can add a profile to a railing component 
either in the railing style, as described in “Specifying the Components of a 
Railing Style” on page 1680, or directly on screen. When you add a custom 
profile on screen, the new profile is automatically saved back to the railing 
style. 

1 Create the necessary profile definition, as described in “Creating a Profile 
for a Custom Railing Component” on page 1681.

2 Select the railing to which you want to add a custom profile, right-click, 
and click Add Profile.

If you want to . . . Then . . .

adapt only the posts to the surface 
of the attached object, and have 
straight segments between the 
posts,

for Calculate Height, select At Post 
Locations Only.

adapt the whole railing to the 
surface of the attached object, 

for Calculate Height, select Follow Surface.
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3 Select the railing component to which you want to add a profile. 

You can select guard rails, hand rails, bottom rails, fixed posts, and 
dynamic posts. 

NOTE If you have difficulties selecting the correct component, switch to 
another view that makes the selection easier. For example, to select a bottom 
rail, you would switch to a Model view. 

Adding a custom profile to a railing post

4 Select the profile for the railing component. 

5 Decide if you want to save the custom profile immediately back to the rail-
ing style, or if you want to proceed with editing the profile.

Editing a Custom Profile of a Railing Component

Use this procedure to edit a custom profile of a railing component. 

1 Select a railing with a custom profile you want to edit. 

2 Right-click, and click Edit Profile In Place. 

This command is only available if you have profile-based components in 
the railing.

3 Select the component you want to edit. 

If you want to . . . Then . . .

save the new profile back to 
the railing style

click OK.

edit the new profile click Continue Editing, and then click OK. For 
information on editing a custom profile, see 
“Editing a Custom Profile of a Railing 
Component” on page 1661.
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NOTE If you have difficulties selecting the correct component, switch to 
another view that makes the selection easier. For example, to select a bottom 
rail, you would switch to a Model view. 

You have entered the in-place editing session now. You can see this from 
the magenta-colored grips and light blue hatch of the temporary in-place 
editing profile, as well as the faded color of all other objects in the draw-
ing. Note that while you are in the in-place editing session, you have only 
limited editing access to other commands in the drawing. Before working 
on other objects, you should first end the in-place editing session.

4 Edit the profile: 

If you want to . . . Then . . .

use grips to edit the 
profile

move the grips as needed.

add a vertex to the 
profile

select the profile, right-click, and click Add Vertex. 
Then, add new vertices as needed. End adding new 
vertices by pressing ENTER. 

remove a vertex from 
the profile

select the profile, right-click, and click Remove Vertex. 
Then, remove vertices as needed. End removing 
vertices by pressing ENTER. 

add a ring to the profile select the profile, right-click, and click Add Ring. Then, 
select a closed polyline, spline, ellipse, or circle for an 
additional ring. Specify if you want to erase the source 
linework, and press ENTER. 

remove a ring from a 
profile

select the profile, right-click, and click Remove Ring. 
Then select the ring you want to remove.

NOTE You cannot remove the last ring from a profile. 

replace a ring on a 
profile

select the profile, right-click, and click Replace Ring. 
Then, select a closed polyline, spline, ellipse, or circle 
for the replaced ring. Specify if you want to erase the 
source linework, and press ENTER. 
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5 Save the changes to the profile.

Changing the Style of a Railing

Use this procedure to change the style associated with existing railings.

1 Select the railings for which you want to change the style, and double-
click one of them.

2 Expand Basic, and expand General.

3 Select a different style.

4 Click OK twice.

Changing the Upper Rails

Use this procedure to change the following settings for an individual railing:

� guardrails
� handrails
� height
� sloping height
� offset from posts
� side for offset

NOTE If these settings are unavailable, they are controlled by the railing style. 
You cannot modify them for individual railings.

1 Double-click the railing for which you want to change the upper rails. 

2 Expand Basic, and expand Dimensions.

If you want to . . . Then . . .

change the existing profile 
definition to reflect the 
new shape

select the profile, right-click, and click Save 
Changes. The in-place edit session is exited and the 
profile definition is updated.

create a new profile 
definition with the shape 
you have created

select the profile, right-click, and click Save As New 
Profile. Then, enter a name for the new profile and 
click OK. The in-place edit session is exited and the 
new profile definition is available in the Style 
Manager.

discard all changes on the 
profile and revert back to 
the previous shape

select the profile, right-click, and click Discard all 
Changes. The in-place edit session is exited and all 
changes you have made to the profile are purged.



1664 | Chapter 23 Railings

3 Click the setting for Rail locations.

4 Select whether to include guardrails and handrails. 

NOTE A railing must have a guardrail or a handrail. Both cannot be turned 
off.

5 Specify the parameters for the guardrail or the handrail: 

Auto is useful only for railings attached to the edges of stairs. A positive 
value is toward the center of the stair, while a negative value is toward the 
outside edge. Side for Offset for handrails also has a selection of Both, so 
you can specify a handrail on both sides of the railing. 

If you select Auto, and the railing is not attached to or is along the center 
of a stair, the offset is to the right. 

6 If you want to undo your changes and revert back to the values set in the 
railing style, click Reset to Style Values.

7 Click OK. 

Changing the Bottom Rails

Use this procedure to change the following settings for the bottom rails of an 
individual railing:

� whether to use bottom rails
� number of bottom rails
� distance between rails
� height of lowest rail

If you want to . . . Then . . .

specify the height of the guardrail or 
the handrail

enter a value for Horizontal Height.

specify the height for of guardrail or 
the handrail while it is on a stair flight

enter a value for Sloping Height.

specify the distance that the guardrail 
or the handrail is offset from the posts

enter a value for Offset from Post.

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.
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NOTE If these settings are unavailable, they are controlled by the railing style. 
You cannot modify them for individual railings.

1 Double-click the railing for which you want to change the bottom rails. 

2 Expand Basic, and expand Dimensions.

3 Click the setting for Rail Locations.

4 Select Bottomrail to add bottom rails to the railing. 

5 Specify the settings for bottom rails: 

6 If you want to undo your changes and revert back to the values set in the 
railing style, click Reset to Style Values.

7 Click OK.

Changing the Posts

Use this procedure to change the following settings for the posts of an indi-
vidual railing:

� type of posts
� amount of posts that extend above the railing
� maximum center to center spacing between posts 
� maximum center to center spacing between balusters

If you want to . . . Then . . .

specify the height of the lowest rail 
when it is horizontal

enter a value for Horizontal.

specify the height of the lowest rail 
when it is on a stair flight

enter a value for Sloping.

specify the distance that the bottomrail 
is offset from the posts

enter a value for Offset from Post.

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.

designate more than one bottom rail enter a value for Number of Rails.
When you designate multiple bottom 
rails, you can enter a value for Spacing 
of Rails.
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� number of balusters per tread for railings that are attached to stairs

NOTE If these settings are unavailable, they are controlled by the railing style. 
You cannot modify them for individual railings.

1 Double-click the railing for which you want to change the post locations.

2 Expand Basic, and expand Dimensions.

3 Click the setting for Post locations.

4 Specify the post locations:

If you want to . . . Then . . .

include fixed posts at the beginning 
and end of the railing

select Fixed Posts.

specify the distance above or below 
the top rail for all posts

enter a value for Extension of ALL Posts 
from Top Railing.

specify the height of all posts from the 
floor

enter a value for Extension of ALL Posts 
from Floor Level.

include fixed posts at the corners of 
the railing

select Fixed Posts at Railing Corners.
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5 If you want to undo your changes and revert back to the values set in the 
railing style, click Reset to Style Values.

6 Click OK. 

Changing the Railing Extensions at Floor Levels

Use this procedure to control the length of the handrail and guardrail exten-
sions at the top and bottom of stair flights. If a bottom rail exists, it extends 
as far as the other railing it is below.

NOTE If these settings are unavailable, they are controlled by the railing style. 
You cannot modify them for individual railings.

1 Double-click the railing for which you want to change the extensions. 

2 Expand Basic, and expand Dimensions.

3 Click the setting for Railing Extensions.

4 Specify the railing extension properties:

include dynamic posts with the railing select Dynamic Posts.
You can then enter a value for 
Maximum Center to Center Spacing.

include balusters with the railing select Balusters.

specify the height of all balusters from 
the floor

enter a value for Extension of Balusters 
from Floor Level.

specify the maximum distance 
between the balusters

enter the appropriate value for 
Maximum Center to Center Spacing.

override the number of balusters on 
each stair tread

select Stair Tread Length Override.
You can then enter a value for Number 
per Tread. This applies only to railings 
that are attached to stairs.

If you want to . . . Then . . .

use values in this dialog box to specify 
extensions

clear Use Stair Landing Extension.

If you want to . . . Then . . .
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5 If you want to undo your changes and revert back to the values set in the 
railing style, click Reset to Style Values.

6 Click OK.

Changing the Railing Extensions at Landings

Use this procedure to control the length of the handrail and guardrail exten-
sions at landings. If a bottom rail exists, it extends as far as the other railing 
it is below.

NOTE If these settings are unavailable, they are controlled by the railing style. 
You cannot modify them for individual railings.

1 Double-click the railing for which you want to change the extensions. 

2 Expand Basic, and expand Dimensions.

3 Click the setting for Railing Extensions.

4 Specify the railing extension properties:

5 If you want to undo your changes and revert back to the values set in the 
railing style, click Reset to Style Values.

specify the length of the handrail and 
guardrail at the top of an entire stair

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

specify the length of the handrail and 
guardrail at the bottom of an entire 
stair

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

If you want to . . . Then . . .

use values in this dialog box to specify 
extensions

clear Use Stair Landing Extension 
under At Landings.

specify the length of the handrail and 
guardrail at the top of a flight

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

specify the length of the handrail and 
guardrail at the bottom of a flight

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

If you want to . . . Then . . .
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6 Click OK.

Changing the Anchor Properties of a Railing

Use this procedure to change the justification of a railing and the side, start, 
and end offsets. These properties apply only to railings attached to stairs.

1 Double-click the railing for which you want to change the anchor proper-
ties. 

2 Expand Basic, and expand Location.

3 Click Anchor.

4 Change the justification of the railing.

5 Change the side offset from the stair:

� A value of zero places the start and end fixed posts exactly at the ends 
of the stair.

� Positive values move the start/end onto the stair.
� Negative values extend the railing beyond the stair bounds.

NOTE If Automatic is selected, the start and end offset options are not 
available.

6 Change the start offset from the top of the stair.

7 Change the ending offset at the bottom of the stair.

8 Click Redistribute Posts to change the existing posts.
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NOTE If you edit a railing using grips so that the railing does not end at end 
on a post, you can use Redistribute Posts to move a post to the end of the 
edited railing. 

9 Click OK.

Changing the Location of a Railing

Use this procedure to relocate a railing by changing the coordinate values of 
its insertion point. The railing also has an orientation with respect to the 
WCS or the current UCS. For example, if the top and bottom of the railing 
are parallel to the XY plane, its normal is parallel to the Z axis. You can 
change the orientation of the railing by aligning its normal with another 
axis. You can also rotate the railing on its plane by changing the rotation 
angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004User’s Guide.

NOTE You can change only the location of a freestanding railing. The location 
of a railing attached to a stair is defined by the stair.

1 Select the railings you want to relocate, and double-click one of them.

2 Expand Basic, and expand Location.

3 Enter a value for Rotation.

4 Enter a value for Elevation.

5 Click Additional Information for further location properties: 

If you want to . . . Then . . .

relocate the railing enter new coordinate values under Insertion Point.

locate the railing on the XY 
plane

make the normal of the railing parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the railing on the YZ 
plane

make the normal of the railing parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 
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6 Click OK.

Applying Tool Properties to an Existing Railing

Use this procedure to apply the properties of a railing tool to one or more 
existing railings. The properties include the railing style and any other set-
tings specified in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a railing tool, and click Apply Tool Properties to ➤ Railing.

3 Select the railings, and press ENTER.

4 Edit the properties of the railing in the Properties palette, if needed.

Attaching Hyperlinks, Notes, and Files to a 
Railing

Use this procedure to attach hyperlinks, text notes, and files to a railing. 

1 Double-click the railing you want to attach information to.

2 Click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD 2004 
Command Reference.

4 Click the setting for Notes, and add a note. Then, click OK.

5 Click the setting for Reference Documents.

6 Attach or detach reference files:

locate the railing on the XZ 
plane

make the normal of the railing parallel to the Y axis: 
enter 1 for Y and enter 0 for X and Z.

change the rotation of the 
railing

enter a new value for Rotation Angle.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

If you want to . . . Then . . .
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7 Click OK. 

Railing Styles

A railing style is a group of properties assigned to a railing that determines 
the appearance and other characteristics of the railing.

Railing Components 
In a railing style, you specify the properties of railing components:

� guardrails
� handrails
� bottom rails
� fixed posts
� dynamic posts
� balusters

You can specify the height of rails and posts, the spacing between posts, the 
spacing between rails, and the width and depth of components. You can also 
create custom railing components by assigning custom profiles to replace 
standard railing components.

Custom Railing Components and Special Conditions
To create custom extruded components (railings, posts, or balusters) in a rail-
ing style, you define a profile and select it to replace a component on the 
Components tab. The resulting component is displayed appropriately in all 
views and does not have to be added to the display properties.

You can create a custom block to represent a complex design for a compo-
nent that cannot be created from a profile, such as an elaborate wrought iron 
design in place of balusters, or an unusually shaped component. That block 
is used to represent the component in Model views. You can create a profile 
to represent the custom component in Plan views.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If you want to . . . Then . . .
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You can also use the custom blocks and profiles features of the display prop-
erties to represent additional railing components other than posts, rails, and 
balusters. In such cases, the component is added to the component rather 
than replacing it. For example, you can create a custom block for Model 
views and a profile for Plan views of a curved return piece for a railing that 
ends by attaching to a wall. You can then add the block or profile to the rail 
components.

Using Materials in Railing Styles
You can use materials to control how railings of each style are displayed in a 
drawing. You assign materials to the railing components in the style. The 
components are then displayed using the display properties of the assigned 
materials.

Autodesk Architectural Desktop® provides a large number of predefined 
materials for common design purposes. You can use these materials, modify 
them for your project requirements, and define new materials. For more 
information about materials and how to define them, see “Materials” on 
page 491.

Creating Tools from Railing Styles
You can create a railing tool from any railing style. You can drag the style 
from the Style Manager onto a tool palette. You can then specify default set-
tings for any railing created from the tool. For more information, see “Creat-
ing a Railing Tool” on page 1651.

Managing Railing Styles
To create, copy, or purge styles, you access the Style Manager. The Style Man-
ager provides a central location in Autodesk Architectural Desktop, where 
you can work with styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Getting Started with the 
Style Manager” on page 533.

Related Procedures

� Creating a Railing Style

� Specifying the Upper Rails of a Railing Style

� Specifying the Bottom Rails of a Railing Style

� Specifying Posts of a Railing Style

� Specifying the Components of a Railing Style

� Specifying the Railing Extensions of a Railing Style

� Assigning Materials to a Railing Style

� Specifying the Display Components of a Railing Style

� Attaching Notes and Files to a Railing Style
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Creating a Railing Style

Use this procedure to create a railing style. You can create a style using default 
style properties or by copying an existing style. After you create the style, you 
edit the style properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Railing Styles. 

3 Create a railing style:

4 Enter a name for the new railing style, and press ENTER.

5 To edit the new railing style, right-click the style, and click Edit:

If you want to . . . Then . . .

create a style with default 
properties

right-click Railing Styles, and click New.

create a style from an 
existing style

right-click the railing style you want to copy, and 
click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

specify default dimensions 
and offsets for upper rails 
of the style

see “Specifying the Upper Rails of a Railing Style” on 
page 1675.

specify default dimensions 
and offsets for bottom rails 
of the style

see “Specifying the Bottom Rails of a Railing Style” 
on page 1677.

specify the location and 
interval of posts and 
balusters for the style

see “Specifying Posts of a Railing Style” on 
page 1678.

specify the structural 
components of the style

see “Specifying the Components of a Railing Style” 
on page 1680.

specify railing extensions at 
floor levels and at landings

see “Specifying the Railing Extensions of a Railing 
Style” on page 1682

assign materials to the 
components of the railing 
style

see “Assigning Materials to a Railing Style” on 
page 1685.

add classifications to a 
railing style

see “Specifying Classifications for a Railing Style” on 
page 1687.
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6 If you want to assign the style to a railing tool, drag the style from the Style 
Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Railing Tool” on page 1651.

7 Click OK.

Specifying the Upper Rails of a Railing Style

Use this procedure to change the following settings for guardrails and hand-
rails in a railing style:

� sloping height
� offset from posts
� side for offsets

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Rail Locations tab.

specify display 
components of the style

see “Specifying the Display Components of a Railing 
Style” on page 1686.

add notes and files to the 
style

see “Attaching Notes and Files to a Railing Style” on 
page 1688.

If you want to . . . Then . . .
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5 Specify whether upper rail properties of this railing style can be overrid-
den for individual railing objects:

NOTE Changes to guardrails and handrails do not affect existing railings of 
this style unless Allow Each Railing to Vary is clear.

6 Select whether to include guardrails and handrails. 

A railing must have a guardrail or handrail. Both cannot be turned off.

7 Specify the following parameters for the guardrail or the handrail: 

Auto is useful only for railings attached to the edges of stairs. A positive 
value is toward the center of the stair, while a negative value is toward the 
outside edge. Side for Offset for handrails also has a selection of Both, so 
you can specify a handrail on both sides of the railing. 

If you select Auto, and the railing is not attached to a stair or is along the 
center of a stair, the offset is to the right. 

If you want to . . . Then . . .

specify guardrail and handrail 
properties, such as horizontal height, 
sloping height, and offset distance, 
when you add or modify railings

select Allow Each Railing to Vary.

require all railings of this style to use 
the upper rail settings of the style

clear Allow Each Railing to Vary.

If you want to . . . Then . . .

specify the height for the guardrail or 
the handrail

enter a value for Horizontal Height.

specify the height for the guardrail or 
the handrail while it is on a stair flight

enter a value for Sloping Height.

specify the distance that the guardrail 
or the handrail is offset from the posts

enter a value for Offset from Post.

specify the side of the post for the 
offset, based on the direction the stair 
(or railing) was drawn

select Center, Left, Right, or Auto for 
Side for Offset.
Side for Offset is available only when 
there is an offset value.
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8 Click OK twice.

Specifying the Bottom Rails of a Railing Style

Use this procedure to change the following settings for bottom rails in a rail-
ing style:

� number of bottom rails
� distance between rails
� height of lowest rail

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Rail Locations tab.

5 Specify whether bottom rail properties of this railing style can be overrid-
den for individual railing objects:

6 Select Bottomrail to add bottom rails to the railing. 

NOTE Changes to bottom rails do not affect existing railings of this style 
unless Allow Each Railing to Vary is clear.

If you want to . . . Then . . .

specify bottom rail properties, such as 
horizontal height, sloping height, and 
number of rails, when you add or 
modify railings

select Allow Each Railing to Vary.

require all railings of this style to use 
the bottom rail settings of the style

clear Allow Each Railing to Vary.
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7 Specify the parameters for bottom rails: 

8 Click OK twice. 

Specifying Posts of a Railing Style

Use this procedure to change the following settings for posts in a railing style:

� type of posts (fixed, dynamic, and balusters)
� amount the posts extend above railings
� maximum spacing between posts and balusters
� number of balusters for each tread for railings that are attached to stairs

Fixed posts are attached at the beginning and end of each railing. Dynamic 
posts are added to the railing between the fixed posts. Balusters are closely 
spaced supports for a railing. You can specify the spacing between dynamic 
posts and between balusters.

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Post Locations tab.

If you want to . . . Then . . .

specify the height of the lowest rail 
when it is horizontal

enter a value for Horizontal.

specify the height of the lowest rail 
when it is on a stair flight

enter a value for Sloping.

designate more than one bottom rail enter a value for Number of Rails.
When you designate multiple bottom 
rails, you can enter a value for Spacing 
of Rails.
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5 Specify whether the post properties of this railing style can be overridden 
for individual railing objects:

NOTE Changes to posts do not affect existing railings of this style unless 
Allow Each Railing to Vary is clear.

6 Specify the post locations:

If you want to . . . Then . . .

specify post properties, such as fixed 
posts, dynamic posts, and balusters, 
when you add or modify railings

select Allow Each Railing to Vary.

require all railings of this style to use 
the post settings of the style

clear Allow Each Railing to Vary.

If you want to . . . Then . . .

include fixed posts at the beginning 
and end of the railing

select Fixed Posts.

specify the distance above or below 
the top rail for all posts

enter a value for Extension of ALL Posts 
from Top Railing.

specify the height of all posts from the 
floor

enter a value for Extension of ALL Posts 
from Floor Level.
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7 Click OK.

Specifying the Components of a Railing Style

Use this procedure to specify the shape of the railing components, and the 
width, depth, and rotation of each component for each railing style. 

You can use profiles to create railing components with custom shapes. The 
custom profile replaces a component on the Components tab of the Railing 
Styles dialog box. For more information, see “Creating a Profile for a Custom 
Railing Component” on page 1681.

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Components tab.

include fixed posts at the corners of 
the railing

select Fixed Posts at Railing Corners.

include dynamic posts with the railing select Dynamic Posts.
You can then enter a value for 
Maximum Center to Center Spacing.

include balusters with the railing select Balusters.
You can then enter a value for 
Maximum Center to Center Spacing.

override the number of balusters on 
each stair tread

select Stair Tread Length Override.
You can then enter a value for Number 
per Tread. This applies only to railings 
that are attached to stairs.

If you want to . . . Then . . .
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5 Select the component to change. 

6 Select the profile you want to use for the selected component. 

The default profiles are circular and rectangular. Any profiles in the cur-
rent drawing are also displayed.

7 Click Width, and enter a width for the selected component.

8 Click Depth, and enter a depth for the selected component. 

Depth is not available for the default circular profile.

9 Click Rotation, and enter a rotation for the selected component. 

Rotation is not available for rail components, or when the default circular 
profile is used for posts.

10 Click OK twice.

Creating a Profile for a Custom Railing 
Component

Use this procedure to create a profile from a closed polyline. You can then use 
the profile to define a custom railing component. The custom shape is 
extruded from the profile along the length of the component.

The height and the width of the polyline you use to create the profile define 
the height and the width of the railing component. You can change the scale 
and dimensions of the profile as you add it. 
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1 Draw a closed polyline of the height and the depth needed for the result-
ing railing component.

2 On the Format menu, click Style Manager. 

3 Expand Multi-Purpose Objects, and expand Profiles.

4 Right-click, and click New.

5 Enter a name for the profile.

6 Right-click the new profile, and click Set From.

7 Select the profile in the drawing area.

8 When prompted to add another ring, press ENTER.

9 Press ENTER to accept Centroid as the insertion point of the profile.

10 Click OK.

You can now use the profile to replace a railing component. For more 
information, see “Adding Custom Railing Blocks and Profiles to a Railing 
Style” on page 1689.

Specifying the Railing Extensions of a Railing 
Style

Use this procedure to control the length of the handrail and guardrail exten-
sions at the top and bottom of stair flights. If a bottom rail exists, it extends 
as far as the other railing it is below. If railing extensions are not allowed to 
vary, the endpoint cannot be grip edited. 

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Extensions tab.
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5 Specify whether railing extensions of this railing style can be overridden 
for individual railing objects:

NOTE Changes to railing extensions do not affect existing railings of this 
style unless Allow Each Railing to Vary is clear.

6 Specify the properties of railing extensions:

If you want to . . . Then . . .

specify railing extension properties, 
such as handrails and guardrails at the 
top and bottom of entire stairs, when 
you add or modify railings

select Allow Each Railing to Vary.

require all railings of this style to use 
the extension settings of the style

clear Allow Each Railing to Vary.

If you want to . . . Then . . .

use values in this dialog box to specify 
extensions

clear Use Stair Landing Extension 
under At Floor Levels.

specify the length of the handrail and 
guardrail at the top of an entire stair

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.
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7 Click OK twice. 

Specifying the Materials of a Railing Style

A railing consists of a number of components whose display properties can 
be determined by the materials assigned to each component. 

When you assign materials to a railing style, you assign one material to each 
physical component of the railing. For example, you assign a wood material 
to the balusters of a railing and a stainless steel material to the handrail and 
bottomrail. You assign materials to components in each display representa-
tion where you want the materials to be used.

If you want to use the display properties of the railing style, instead of using 
material display properties, you can turn off the material assignments in the 
display properties of the railing style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Railing Materials and Display Components

� Assigning Materials to a Railing Style

specify the length of the handrail and 
guardrail at the bottom of an entire 
stair

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

use values in this dialog box to specify 
extensions

clear Use Stair Landing Extension 
under At Landings.

specify the length of the handrail and 
guardrail at the top of a flight

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

specify the length of the handrail and 
guardrail at the bottom of a flight

enter values for Handrail and Guardrail.
Select + T next to the value to add the 
tread length to the extension value.

If you want to . . . Then . . .
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Railing Materials and Display Components
The following table identifies the material component that corresponds to 
each railing component. 

Assigning Materials to a Railing Style
Use this procedure to assign materials to the individual components of a rail-
ing style. When you assign a material to a railing component, the compo-
nent uses the display properties of the material instead of the style display 
properties.

You can assign a material to any physical component of the railing. Custom 
components and components that are only symbolic graphics do not use 
materials for their display properties. 

Railing Component Material Component

Plan, Plan Screened, Plan High Detail

Posts Linework

Guardrail Linework

Handrail Linework

Bottomrail Linework

Plan Low Detail

Posts Linework

Guardrail Linework

Handrail Linework

Model, Model ByBlock, Model Monochrome

Baluster 3D Body

Posts 3D Body

Guardrail 3D Body

Handrail 3D Body

Bottomrail 3D Body
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NOTE If a material assignment does not determine the display properties of a 
railing component, you can change the display properties of the railing style as 
described in “Specifying the Display Components of a Railing Style” on 
page 1686.

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display Components of a Railing 
Style

Use this procedure to change the properties of the display components of a 
railing style:

� Visibility (display component is on or off)
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� By material (material assigned to the display component determines its 
display properties)

� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the display properties of compo-
nents in the railing style, you can change the properties of the display compo-
nent by clearing By Material. You can also override the material assignment with 
a different material. For more information, see “Specifying the Materials of a Rail-
ing Style” on page 1684.

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying Classifications for a Railing Style

Use this procedure to specify classifications for any classification definition 
applied to an railing style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has an railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.
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By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to area 
styles.

5 For each classification definition, select the classification you want to 
apply to the current railing style.

6 Click OK twice.

Attaching Notes and Files to a Railing Style

Use this procedure to enter notes and attach reference files to a railing style. 
You can also edit notes and edit or detach reference files from a railing style.

1 Open a tool palette that has an railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the railing style, enter the description under 
Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are done editing.

detach a reference file select the file name, click Delete, and click OK.
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Adding Custom Railing Blocks and Profiles to 
a Railing Style

You can specify custom blocks and profiles that are added to or replace indi-
vidual railing components. Posts, dynamic posts, and balusters can be added 
to or replaced. Other railing components can be added to, but not replaced.

When you add a custom block and profile, you can specify several rules for 
positioning and scaling the new component. Each custom block or profile is 
also added to the display properties so that you can control its layer, color, 
and linetype. Be sure that the objects used to create the custom blocks are cre-
ated with their properties designated as ByBlock. Otherwise, they cannot be 
controlled through the display properties. For more information about 
ByBlock, see “Control the Color and Linetype Properties in Blocks” in the 

online AutoCAD® 2004 User’s Guide.

After you create custom blocks and profiles, you can attach them to railing 
styles. Using custom blocks and profiles, railing styles can provide a much 
richer and more flexible set of railing graphics. 

Related Procedures

� Adding a Custom Block to a Railing Style

� Adding a Custom Profile to a Railing Style

� Turning off a Custom Block or Custom Profile in a Railing Style

� Removing a Custom Block from a Railing Style

Adding a Custom Block to a Railing Style

Use this procedure to add a custom block to a railing style. The block can 
replace a railing component, such as a baluster, or be added to a component. 
You attach the block in display representations, such as Model, that show the 
railing in three dimensions.
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Assigning a custom block as a baluster component to a railing

You can use a block to replace a component on the Components tab of the 
Railing Styles dialog box, or you can use a block to represent additional rail-
ing components in the display of railings. You add a block to the display 
components of a style; a component that you replace on the Components 
tab is already a part of the display properties.

1 Create a block to represent the component to add to the railing.

Create the block in the same plane as the railing you are going to attach 
it to. Be sure that the objects used to create the custom blocks are created 
with their properties designated as ByBlock. Otherwise, they cannot be 
controlled through the display properties.

2 Open a tool palette that has a railing tool.

3 Right-click a railing tool, and click Railing Styles.

4 Right-click the style you want to edit, and click Edit.

5 Click the Display Properties tab.

6 Select the display representation where you want the changes to appear, 
and select Style Override.

NOTE You can add a custom block to a railing only in Model-based display 
representations.
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7 If necessary, click .

8 Click the Other tab.

9 Click Add.

10 In the Custom Block dialog box, click Select Block.

11 Select the block to use, and click OK.

12 Specify the scale of the custom block:

13 Specify the Mirror In direction, if necessary:

If you want to . . . Then . . .

use the block at its drawn size clear all options under Scale to Fit.

scale the custom block to the width of 
the object it is attached to

select Width.

scale the custom block to the depth of 
the object it is attached to

select Depth.

scale the custom block to the height of 
the object it is attached to

select Height.

lock the XY shape of the object select Lock Ratio.
If the object is scaled in one direction 
to fit another criterion for Scale to Fit, 
the whole custom block is scaled 
equally.

add the selected block to the railings 
between the selected components

select Between Comp.
Baluster, Main Post, and Dynamic Posts 
are the only valid component 
selections.

If you want to . . . Then . . .

create a mirror of the component in 
the X direction, along the length of the 
railing

select Mirror X.

create a mirror of the component in 
the Y direction, across the width of the 
railing

select Mirror Y.

create a mirror of the component in 
the Z direction

select Mirror Z.
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14 Specify the location of the insertion point in relation to the object:

15 Specify the insertion offset for the component in the X, Y, and Z direc-
tions.

16 Specify the type of railing component that the block represents: 

The two groups of components are mutually exclusive, so selecting an 
object from one column makes the other unavailable. You can select more 
than one object in each column to apply the block to each selected com-
ponent. For example, you can use the same block for the main posts and 
dynamic posts.

If you want to . . . Then . . .

specify the location of 
the X insertion point

select Left, Center, or Right for X.

specify the location of 
the Y insertion point

select Front, Center, or Back for Y.

specify the location of 
the Z insertion point

select Bottom, Middle, or Top for Z.

If you want to . . . Then . . .

represent balusters with the block select Baluster for Component.

represent main posts with the block select Main Post for Component.

represent dynamic posts with the block select Dynamic Post for Component.

replace the current baluster, main post, 
or dynamic post with the block

select Replace.

represent a guardrail with the block select Guardrail for Component.

represent a handrail with the block select Handrail for Component.

represent a bottom rail with the block select Bottomrail for Component.
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17 Specify where the block is applied to the components:

18 Click OK three times.

After adding the block to the style, you can specify the layer, color, and 
linetype of the block. For more information, see “Specifying the Display 
Components of a Railing Style” on page 1686.

Adding a Custom Profile to a Railing Style

Use this procedure to add a custom profile to a railing style in the Plan dis-
play representation. You can replace one or more railing components with a 
custom profile, or you can assign different custom profiles to different railing 
components.

You can use a profile to replace a component on the Components tab of the 
Railing Styles dialog box, or you can use a profile to represent additional rail-
ing components in the display of railings. You add a profile to the display 
properties of a style; a component that you replace on the Components tab 
is already a part of the display properties.

For more information about creating profiles for railing components, see 
“Creating a Profile for a Custom Railing Component” on page 1681.

If you want to . . . Then . . .

apply the block to all instances of the 
selected components

select All for Attach to.

apply the block to the first instance of 
the selected component, based on the 
direction the railing was drawn

select First for Attach to.

apply the block to the last instance of 
the selected component, based on the 
direction the railing was drawn

select Last for Attach to.

apply the block to a selected number 
of components

select Selection for Attach to.
The components are numbered in the 
order the railing was drawn, beginning 
with 1.
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Assigning a profile to a baluster in a railing

1 Create a profile to represent the component to add to the railing. Create 
the profile in the XY plane.

2 Open a tool palette that has a railing tool.

3 Right-click a railing tool, and click Railing Styles.

4 Right-click the style you want to edit, and click Edit.

5 Click the Display Properties tab.

6 Select the display representation where you want the changes to appear, 
and select Style Override.

NOTE You can add a custom profile to a railing only in Plan-based display 
representations.

7 If necessary, click .

8 Click the Other tab.

9 Click Add.

10 In the Custom Profile dialog box, click Select Profile.

11 Select the profile, and click OK.
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12 Specify the scale of the custom profile:

13 Specify the Mirror In direction, if necessary:

14 Specify the angle to rotate the component in the Z direction, if necessary.

15 Specify the location of the insertion point in relation to the object:

If you want to . . . Then . . .

use the block at its drawn size clear all options under Scale to Fit.

scale the custom profile to the width of 
the object it is attached to

select Width.

scale the custom profile to the depth 
of the object it is attached to

select Depth.

scale the custom profile to the height 
of the object it is attached to

select Height.

lock the XY shape of the object select Lock Ratio.
If the object is scaled in one direction 
to fit another criterion for Scale to Fit, 
the whole custom profile is scaled 
equally.

add the selected profile to the railings 
between the selected components

select Between Comp.
Baluster, Main Post, and Dynamic Posts 
are the only valid component 
selections.

If you want to . . . Then . . .

create a mirror of the component in 
the X direction, along the length of the 
railing

select Mirror X.

create a mirror of the component in 
the Y direction, across the width of the 
railing

select Mirror Y.

If you want to . . . Then . . .

specify the location of 
the X insertion point

select Left, Center, or Right for X.



1696 | Chapter 23 Railings

16 Specify the insertion offset for the component in the X andY directions.

17 Specify the type of railing component that the profile represents: 

The two groups of components are mutually exclusive, so selecting an 
object from one column makes the other unavailable. You can select more 
than one object in each column, to apply the profile to each selected com-
ponent. For example, you can use the same profile for the main posts and 
dynamic posts.

18 Specify where the profile is applied to the components:

specify the location of 
the Y insertion point

select Front, Center, or Back for Y.

If you want to . . . Then . . .

represent balusters with the selected 
profile

select Baluster for Component.

represent main posts with the selected 
profile

select Main Post for Component.

represent dynamic posts with the 
selected profile

select Dynamic Post for Component.

replace the current baluster, main post, 
or dynamic post with the selected 
profile

select Replace.

add a guardrail to the selected profile select Guardrail for Component.

add a handrail to the selected profile select Handrail for Component.

add a bottom rail to the selected 
profile

select Bottomrail for Component.

If you want to . . . Then . . .

apply the profile to all instances of the 
selected components

select All for Attach to.

apply the profile to the first instance of 
the selected component, based on the 
direction the railing was drawn

select First for Attach to.

If you want to . . . Then . . .



Adding Custom Railing Blocks and Profiles to a Railing Style | 1697

19 Click OK three times.

Turning off a Custom Block or Custom Profile in 
a Railing Style

Use this procedure to turn off the display of all custom blocks or profiles 
without actually removing them from the railing style.

You can selectively turn off the visibility of individual display blocks on the 
Layer/Color/Linetype tab. This is one way to switch between alternate 
blocks. For more information, see “Specifying the Display Components of a 
Railing Style” on page 1686.

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

NOTE Custom blocks are added and turned off in Model-based display rep-
resentations; Custom profiles are added and turned off in Plan-based display 
representations.

6 If necessary, click .

7 Click the Other tab.

8 Disable the custom component: 

apply the profile to the last instance of 
the selected component, based on the 
direction the railing was drawn

select Last for Attach to.

apply the profile to a selected number 
of components.

select Selection for Attach to.
The components are numbered in the 
order the railing was drawn.

If you want to . . . Then . . .

turn off a custom block click Disable Custom Blocks.

If you want to . . . Then . . .
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9 Click OK twice.

Removing a Custom Block from a Railing Style

Use this procedure to delete custom components from a railing style.

1 Open a tool palette that has a railing tool.

2 Right-click a railing tool, and click Railing Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

NOTE Custom blocks are added and removed in Model-based display rep-
resentations; Custom profiles are added and removed in Plan-based display 
representations.

6 If necessary, click .

7 Click the Other tab.

8 Select the component to remove, and click Remove.

9 Click OK twice.

turn off a custom profile click Disable Custom Profile

If you want to . . . Then . . .
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Slabs

A slab is a three-dimensional (3D) body, 
bounded by a planar polygon (perimeter) of any 
shape, and with multiple edges. A slab is 
defined by its perimeter, edge conditions, and 
style. You can use slabs to draw floors and other 
objects that require a flat surface and edge con-
ditions. 

Methods of Creating Slabs
You can create slabs independently, or you can 
create them from existing objects, such as walls 
and polylines. Slabs created from objects do not 
maintain a link to the original object, but they 
give you greater control over their geometry 
and detail.

Slab Body
The body of a slab is an extrusion perpendicular 
to the plane of the perimeter and is defined by 
the following geometry:

� The perimeter of a slab is a planar polygon 
defined by the X,Y,Z coordinates of its verti-
ces. 

� A slab has three or more vertices, with the 
ability to add or remove vertices. Each pair of 
vertices defines an edge. 

� The thickness of a slab extrusion is specified 
either in the slab style (when it has a fixed 
thickness) or for each slab. 

� The position of the slab bottom, relative to 
its perimeter plane, is controlled by the 
thickness offset value in the slab style. 

� The baseline of a slab is defined by the first 
two points you select when defining the slab 
vertices.

In this chapter

� Using Slab Tools to Create Slabs

� Creating a Slab

� Creating a Slab with User-
specified Settings

� Creating a Slab Tool

� Creating a Slab from Walls

� Creating a Slab from a Polyline

� Editing Slabs

� Slab Styles

� Slab Edge Styles

24
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� The slab insertion point, by default, is the first point on the baseline. You 
can offset the baseline either horizontally or vertically from the insertion 
point to allow for precise alignment with walls or structural elements.

� A slab has a slope (pitch), which you can specify either as an angle or as a 
rise-to-run ratio. If you change the slope, the slab rotates around the slope 
pivot point. 

� The pivot point is initially the first vertex of the baseline, but you can 
move it to any other point, either on or off the slab. A small pyramid-
shaped marker represents the pivot point.

The following illustration shows a slab.

Geometry of a slab

� An imaginary line passing through a slab at the perimeter line (in section) 
is called the slopeline. The slopeline aligns the slab with the wall base 
height. The slopeline is the position of the slab baseline relative to its bot-
tom face. The value you enter for the thickness offset in the slab style 
determines the distance between the slab baseline and the bottom face of 
the slab.

Slab Edge
The following parameters define a slab edge:

� orientation (plumb or square)
� angle (relative to the orientation)
� edge style (fascia and soffit)
� overhang (defines the point at which the fascia begins)

You apply a fascia and soffit to slab edges with styles that define edge condi-
tions
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� The fascia is defined by a profile, with its insertion point located at the top 
of the slab edge. The local Y axis of the profile polyline aligns with the slab 
edge angle.

� The soffit is also defined by a profile, with its insertion point positioned 
at the X and Y offsets from the fascia insertion point.

Viewing Slab fascia and soffit components

Edge Control
You can customize each slab edge individually, applying styles and making 
other adjustments as required by your design.

You can control the edge conditions of each slab edge. A slab edge style 
defines the fascia and soffit design from profiles that you create for these 
components. You can specify whether the style uses a fascia, a soffit, both, or 
neither. You also specify how the fascia and soffit are positioned relative to 
the slab.

Slab Styles
Use slab styles to create default properties for dimensions, edge styles for the 
fascia and soffit, and entity properties for layer, color, and linetype. Slab 
styles allow you to use a different style for each edge of the slab.

Materials in Slabs
You can assign materials to a slab. For example, a floor slab can be assigned 
a material representing tiles with concrete edges. These materials are dis-
played in wireframe or rendered views. Materials have specific settings for 
individual components of slabs, such as the body, fascia and soffit.
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Viewing Slabs in 2D wireframe and rendered views

Tiled floor slab with concrete edges

Autodesk® Architectural Desktop provides predefined materials for common 
design purposes. These materials contain settings for slabs that you can use 
“as is” or modify for special designs. You can also create materials from 
scratch. If you create a material to use only for slabs, name it accordingly; for 
example, Slab—Ceramic Tile or Slab Edge—Concrete. This will help in orga-
nizing your material definitions. For more information, see “Specifying the 
Materials of a Slab Style” on page 1735.

Editing Slabs
In addition to the control provided by slab styles and edge styles, slab tools 
let you edit slabs to fit unique conditions. You can add holes to slabs for 
structures such as chimneys and vent pipes. You can also use slabs to create 
dormers. 

Related Topics and Procedures

� Using Slab Tools to Create Slabs

� Creating a Slab

� Creating a Slab with User-specified Settings

� Creating a Slab Tool

� Creating a Slab from Walls

� Creating a Slab from a Polyline

� Editing Slabs

� Slab Styles

� Slab Edge Styles
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Using Slab Tools to Create Slabs

Tools provided with Autodesk® Architectural Desktop let you quickly place 
slabs. Each tool has a specific slab style and other predefined properties. You 
can use the default settings of the tool, or you can change the settings for slab 
properties. You can also use slab tools to convert linework to slabs and to 
apply the settings of a slab tool to existing slabs.

The Design tool palette contains a sample slab tool that you can use and cus-
tomize as needed. Custom palettes created by your CAD manager or other 
users may also contain slab tools with slab styles and properties that are cus-
tomized for your projects or office standards.

A slab tool is also included in the Autodesk Architectural Desktop Stock Tool 
catalog supplied with the Content Browser. For information about using the 
Content Browser, see “Content Browser.”

Related Procedures

� Creating a Slab

� Creating a Slab with User-specified Settings

� Creating a Slab Tool

Creating a Slab

Use this procedure to add a new slab that has the properties specified in the 
slab tool. To specify settings when you add a slab, see “Creating a Slab with 
User-specified Settings” on page 1704.

This procedure creates the slab by specifying points to define the perimeter

� The first point determines the insertion point of the slab and the start of 
the baseline. This point also locates the default pivot point of the slab.

� The second point determines the end point of the slab baseline.
� Subsequent points establish the vertices of the slab perimeter.

1 Open the Design tool palette, and select the Slab tool.

If necessary, scroll the palette to display the tool.

2 Specify the start point of the slab.

3 Specify a second point to define the first edge (baseline) of the slab.
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4 Specify further points to define the slab:

5 Press ENTER.

Creating a Slab with User-specified Settings

Use this procedure to create a slab with settings that you specify.

1 Open the Design palette, and select the Slab tool.

If necessary, scroll the tool palette to display the tool you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a slab style.

4 Select Projected or Direct for Mode.

If you select Projected, the X,Y coordinates of the first point you specify 
are projected to a Z value of the current base height. This establishes the 
insertion point. The second point establishes the baseline. All subsequent 
points are projected onto a plane established by the baseline and the spec-
ified slope angle. This mode is provided for architects who wish to lay out 
a slab by tracing over a plan drawing.

If you select Direct, the points you specify become the vertices of the slab 
perimeter.

5 Expand Dimensions.

6 Enter a value for Thickness.

7 Enter a value for the vertical offset distance from the insertion point for 
Vertical Offset.

8 Enter a value for the horizontal offset distance from the insertion point for 
Horizontal Offset.

If you want to . . . Then . . .

close the slab by drawing 
two edges that meet at a 
right angle

specify a point in the direction in which the slab is to 
close; then enter Ortho. 

The edge is extended until it meets a slab edge 
perpendicular to the first slab edge.

close the slab by adding 
an edge from the 
previous point to the 
start point of the slab

enter Close.
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9 Select the justification:

NOTE This justification is used only for inserting a slab and is not retained 
as a parameter of the slab. Justification is intended primarily for Direct mode.

The slopeline is the position of the slab baseline relative to its bottom face. 
The thickness offset in the slab style determines the distance between the 
slab baseline and the bottom face of the slab.

10 Enter a value for the height of the slab insertion point for Base Height. 

This is available only when you select Projected mode.

11 Select a direction, or define how the slab is drawn relative to the baseline.

12 Enter a value for the depth of the overhang for Overhang.

13 Select a style for Perimeter edge.

14 Expand Slope, and enter values for Rise, Run, or Angle to define the slope 
of the slab.

This is available only when you select Projected mode.

15 Specify the start point of the slab.

The start point determines the insertion point of the slab and the start of 
the baseline. This point also locates the default pivot point of the slab.

16 Specify a second point to define the first edge (baseline) of the slab.

If you want to . . . Then . . .

align the top of the added slab with the 
first specified point

select Top.

align the center of the added slab with the 
first specified point 

select Center.

align the bottom of the added slab with 
the first specified point

select Bottom.

align the slopeline of the added slab with 
the first specified point

select Slopeline.
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17 Specify further points to establish the vertices of the slab perimeter:.

18 Continue to place slabs, and press ENTER when finished.

Creating a Slab Tool

Use this procedure to create a slab tool and add it to a tool palette. You may 
want to create your own slab tools if you are placing multiple slabs of specific 
styles that have the same properties.

You can use any of the following methods to create a slab tool:

� Drag a slab that has the properties you want to a tool palette.
� Drag a slab style from the Style Manager to a tool palette, and then cus-

tomize the properties of the new tool.
� Copy an existing slab tool, and then customize the properties of the new 

tool.
� Drag a slab tool from a tool catalog in the Content Browser, and then cus-

tomize the properties of the tool.

1 Open the tool palette on which you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

close the slab by drawing 
two edges that meet at a 
right angle

specify a point in the direction in which the slab is to 
close; then enter Ortho. 

The edge is extended until it meets a slab edge 
perpendicular to the first slab edge.

close the slab by adding 
an edge from the 
previous point to the 
start point of the slab

enter Close.

If you want to . . . Then . . .

create a tool from a slab in the 
drawing

select the slab, and drag it to the tool palette. 

TIP Select the slab, not a slab grip, to drag it 
to the tool palette.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

6 Expand Basic, and expand General.

7 Enter a description of the tool.

8 If you do not want to use the default layer key for slabs, select a layer key.

9 If you want to override the default layer name for slabs, select a layer over-
ride.

10 Select a slab style.

11 For Style location, select the drawing file containing the style used for this 
slab, or select Browse and use a standard file selection dialog box to select 
the file.

12 Select Projected or Direct for Mode.

13 Expand Dimensions.

14 Enter a value for Thickness.

15 Enter a value for the vertical offset distance from the insertion point for 
Vertical Offset.

16 Enter a value for the horizontal offset distance from the insertion point for 
Horizontal Offset.

create a tool from a slab style in 
the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current 
palette

right-click the tool, click Copy, and click Paste.

copy a tool from another 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.

If you want to . . . Then . . .
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17 Select the justification:

NOTE This justification is used only when inserting the slab and is not 
retained as a parameter of the slab. Justification is intended primarily for 
Direct mode.

The slopeline is the position of the slab baseline relative to its bottom face. 
The thickness offset in the slab style determines the distance between the 
slab baseline and the bottom face of the slab.

18 Select a direction, or define how the slab is drawn relative to the baseline.

19 Enter a value for the depth of the overhang for Overhang.

20 Select a style for Perimeter edge.

21 For Edge style location, select the drawing file containing the edge style 
used for this slab, or select Browse and use a standard file selection dialog 
box to select the file.

22 Click OK.

Creating a Slab from Walls 

Use this procedure to create a rectangular slab from one or more walls. This 
is useful when you want a specific alignment between the slab baseline and 
the wall baseline. When creating a slab from a single wall, the base height of 
the wall defines the baseline edge of the slab. When creating a slab from mul-
tiple walls, the top of the first selected wall defines the baseline edge of the 
slab.

If you want to . . . Then . . .

align the top of the added slab with the 
first specified point

select Top.

align the center of the added slab with the 
first specified point 

select Center.

align the bottom of the added slab with 
the first specified point

select Bottom.

align the slopeline of the added slab with 
the first specified point

select Slopeline.
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You can create a flat slab that follows the outline of multiple walls by speci-
fying a zero slope. If you select multiple walls and a non-zero slope, multiple 
slabs are created.

If the closed polyline intersects one of the selected walls, the slab is invalid 
and you must select the walls again.

1 Open the Design palette, right-click the Slab tool, and click Apply Tool 
Properties to ➤ Linework and Walls.

2 Select one or more walls, and press ENTER.

3 Enter y (Yes) to erase the walls, or n (No) to keep the walls in the drawing.

4 Specify a justification method:

NOTE This justification is used only for the insertion of a slab. It is not 
retained as a parameter of the slab object.

The slopeline is the position of the slab baseline relative to its bottom face. 
The thickness offset in the slab style determines the distance between the 
slab baseline and the bottom face of the slab.

5 Specify the justification for edge alignment:

If you want to . . . Then . . .

align the top of the slab with the wall base 
height

enter t (Top).

align the center of slab with the wall base 
height

enter c (Center).

align the bottom of slab with the wall base 
height

enter b (Bottom).

align the slopeline of slab with the wall 
base height

enter s (Slopeline).

If you want to . . . Then . . .

align the baseline edge of the slab to the 
left side of the wall, based on the direction 
the wall was drawn

enter l (Left).

align the baseline edge of the slab to the 
center of the wall

enter c (Center).
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6 To specify the slope direction, enter l (Left) or r (Right).

This is based on the direction the wall was drawn.

Creating a Slab from a Polyline

Use this procedure to create a single slab from a closed polyline. The first line 
drawn in the polyline becomes the baseline edge of the slab.

Creating slabs from polylines is useful when you need to create a complex 
slab shape or a slab with curved edges. The smoothness (tessellation) of 
curved edges is controlled by the FACETDEV variable. For more information, 
see “AEC Facet Deviation” on page 1409.

Converting a polyline to a slab

1 Open the Design palette, right-click the Slab tool, and click Apply Tool 
Properties to ➤ Linework and Walls.

2 Select a closed polyline, and press ENTER.

3 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing.

4 Enter p (Projected) or d (Direct) for Mode.

If you specify Projected, the X,Y coordinates of the first point are projected 
onto a Z value of the current base height. This establishes the insertion 

align the baseline edge of the slab to the 
right side of the wall, based on the 
direction the wall was drawn

enter r (Right).

align the baseline edge of the slab to the 
baseline of the wall

enter b (Baseline).

If you want to . . . Then . . .
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point. The second point establishes the baseline. All subsequent points are 
projected to a plane established by the baseline and the specified slope 
angle. This mode is provided for architects who wish to create a sloped 
floor slab.

If you specify Direct, the points specified become the vertices of the slab 
perimeter.

5 Enter a value for Base Height. 

(This is available only if you specified Projected mode.)

6 Specify a justification method:

NOTE This justification is used only for the insertion of a slab. It is not 
retained as a parameter of the slab object.

Editing Slabs

You can change the style, dimensions, edge properties, and location of a slab. 
You can use other editing functions, such as adding a vertex to a slab, adding 
a hole, or adding objects to a slab. You can also edit each slab edge individu-
ally. Through the slab tools, you can trim, extend, miter and cut slabs into 
the shape you need.

Autodesk® Architectural Desktop offers several methods for editing slabs:

� Edit slabs directly using grips for dimensions and other physical character-
istics

� Change slab settings on the Properties palette

If you want to . . . Then . . .

align the slab top with the polyline (or base 
height, when using projected mode)

enter t (Top).

align the slab center with the polyline (or 
base height, when using projected mode)

enter c (Center).

align the slab bottom with the polyline (or 
base height, when using projected mode)

enter b (Bottom).

align the slab slopeline with the polyline (or 
base height, when using projected mode)

enter s (Slopeline).
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� Select editing commands from the shortcut menu for a selected slab

Related Topics and Procedures

� Using Grips to Edit Slabs

� Changing the Slab Style

� Changing the Perimeter of a Slab

� Changing the Thickness of a Slab

� Changing the Offsets of a Slab

� Changing the Overhang of a Slab Edge

� Changing the Slope of a Slab

� Changing the Pivot Point of a Slab

� Changing the Edges of a Slab

� Applying Tool Properties to an Existing Slab

� Trimming a Slab

� Extending a Slab

� Cutting a Slab

� Adding a Vertex to a Slab

� Deleting a Vertex from a Slab

� Adding a Hole to a Slab

� Removing a Hole from a Slab

� Adding Objects to a Slab (Boolean)

� Subtracting Objects from a Slab (Boolean)

� Removing Objects from a Slab (Boolean)

� Changing the Location of a Slab

� Attaching Hyperlinks, Notes, or Files to a Slab

Using Grips to Edit Slabs

Refer to the illustrations and steps in this topic to use slab grips to edit slabs.

Editing Slab Dimensions

1 Select the slab.

2 Select the grip for the dimension you want to change.
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Viewing Slab Vertex and Edge grips

Viewing Slab Edge Overhang and Pivot point grips
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Viewing Slab Angle, Thickness, Horizontal Offset, and Vertical Offset grips

3 Either move the grip until the dimension value you want is displayed and 
then click once, or else enter a value.

Changing the Slab Style

Use this procedure to change the style for a slab or group of slabs.

1 Select one or more slabs, and double-click one of them.

2 Select a slab style.

Changing the Perimeter of a Slab

Use this procedure to change the perimeter boundaries of a slab. (You can 
also add two new edges to the slab as you change its perimeter.)

The perimeter of the slab is a planer polygon defined by the X,Y,Z coordi-
nates of its vertices.

1 Select the slab.

2 Select an Edge grip and resize the perimeter as desired:
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Using grips to edit Slab edge

3 Click Once.

Changing the Thickness of a Slab

Use this procedure to change the thickness of a slab. (You can also use the 
Properties palette to change the thickness of a slab or group of slabs.)

If you want to . . . Then . . .

maintain the plane and the 
angles of the adjacent sides of 
the slab

move the grip until the perimeter is the 
desired size.

create two new slab edges 
when you extend the perimeter

press and hold CTRL, and then move the grip 
until the new perimeter edge is the desired 
size.
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1 Select the slab.

2 Select the Thickness grip, and either move the grip until the thickness 
value you want is displayed, or enter a value.

Using grips to edit Slab thickness

3 Click Once.

Changing the Offsets of a Slab

Use this procedure to change the vertical and horizontal offsets of a slab. (You 
can also use the Properties palette to change the thickness of a slab or group 
of slabs.) 

The offsets are the vertical and horizontal distances from the insertion point 
of the slab.

1 Select the slab.

2 Select the Vertical Offset or Horizontal Offset grip, as needed, and either 
move the grip until the offset value you want is displayed, or enter a value.
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Using grips to edit Slab horizontal offset
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Using grips to edit Slab vertical offset

3 Click Once.

Changing the Overhang of a Slab Edge

Use this procedure to change the overhang of a slab edge. (You can also spec-
ify the overhang of slab edges in the Edit Edges worksheet. For more infor-
mation, see “Changing the Edges of a Slab” on page 1722.)

1 Select the slab.

2 Select an Edge Overhang grip, and either move the grip until the length 
value you want is displayed, or enter a value.
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Using grips to edit Slab edge overhang

3 Click Once.

Changing the Slope of a Slab

Use this procedure to change the slope of a slab by changing the rise or angle 
value. (You can also use the Properties palette to adjust the slope and control 
the automatic alignment of the fascia. For more information, see “Changing 
Slab Slope Settings” on page 1720.)

1 Select the slab.

2 Select the Angle grip.
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Using grips to edit Slab angle

3 Adjust the slope:

4 Click once.

Changing Slab Slope Settings

Use this procedure to change the slope settings of a slab, and to specify 
whether the fascia is to be aligned when the slope is changed. 

If you want to . . . Then . . .

adjust the slope by changing 
the angle of the slab

move the grip until the desired angle is 
displayed, or enter a value.

adjust the slope by changing 
the rise of the slab

press TAB until the rise value is highlighted, 
and then either move the grip until the 
desired rise is displayed, or enter a value.
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You can also control the adjustment of the overhang or baseline height of the 
slab. This constraint applies only to the baseline edge, and it works only 
when the baseline is horizontal.

1 Double-click the slab you want to change.

2 Expand Dimensions, and expand Slope.

3 Enter a value for Rise, Run, or Angle to define the slope.

4 Select options for fascia alignment when changing the slope:

Changing the Pivot Point of a Slab

Use this procedure to change the pivot point of the slab. (You can also use 
the Properties palette to change the X, Y, and Z values of the pivot point.)

By default, the pivot point is the first vertex of the baseline. However, you 
can move the pivot point to any other point, either on or off the slab.

NOTE If a Hold fascia elevation constraint was set for the slab, the pivot point 
is ignored. For information about setting this option, see “Changing Slab Slope 
Settings” on page 1720.

1 Select the slab.

2 Select the Pivot Point grip, and move the grip until the pivot point is in 
the desired location.

3 Click once.

If you want to . . . Then . . .

force the fascia to align with 
other slab fascias, regardless of 
style, by adjusting the slab 
overhang

select By adjusting overhang for Hold fascia 
elevation.

force the fascia to align with 
other slab fascias, regardless of 
style, by adjusting the roof slab 
baseline height

select By adjusting baseline height for Hold 
fascia elevation.

ignore fascia alignment select No for Hold fascia elevation.
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Changing the Edges of a Slab

Use this procedure to edit an individual edge of a slab. You can change the 
overhang, edge style, edge orientation, and the angle for the edge. A viewer 
box shows you which edge of the slab you are editing.

1 Select the slab to be modified, right-click, and click Edit Slab Edges.

2 Select the edges to be modified, and press ENTER.

3 In the list of slab edges, select the edge to edit. To modify multiple edges 
using the same values, press and hold CTRL while selecting each edge.

The selected edges are highlighted in the viewer in the right pane of the 
Edit Slab Edges dialog box.

4 Enter a value for Overhang.

5 Select a slab edge style.

6 Select Square or Plumb for Edge Cut.

7 Enter a value for Angle.

To reset the angle to the slab style defaults, right-click the edge number 
and click Reset to Style Defaults. Reset to Style Defaults is available only if 
an edge style has been assigned and the value for Angle is different than 
the default.

8 To modify additional edges, continue from step 3.

9 Click OK.

Applying Tool Properties to an Existing Slab

Use this procedure to apply the properties of a slab tool to one or more exist-
ing slabs. The properties include the slab style and any other settings speci-
fied in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a slab tool, and click Apply Tool Properties to ➤ Slab.

3 Select the slabs, and press ENTER.

4 Edit the properties of the slabs in the Properties palette, if necessary.

Trimming a Slab

Use this procedure to trim a slab using a polyline, wall, roof slab, or slab that 
defines a trim plane through the slab. The trimming object does not need to 
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intersect the slab, as long as it provides an intersection in the current user 
coordinate system (UCS).

Any fascia or soffit profile that intersects the trim plane is trimmed at the 
same angle as the slab. 

If the trimming object is a wall or a slab, the trim plane is at the closest sur-
face. The new slab edge at the trim plane has its edge angle defined by the 
trim plane.

The trim line must intersect the slab perimeter line. You cannot trim only the 
overhang.

Trimming a slab to a wall

1 Select the slab to be trimmed, right-click, and click Trim.

2 Select a wall, another slab, or a polyline for the trimming object.

3 Select the side of the slab to be trimmed.
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Extending a Slab

Use this procedure to extend a slab to another slab or to a wall. The object to 
which the slab projects does not need to intersect the plane of the slab, as 
long as it projects an intersection in the current user coordinate system 
(UCS).

Because multiple edges may need to move in an extend operation, you are 
prompted to select the adjacent edges to lengthen, rather than the specific 
edges to move. These selected edges retain their current vector (angle) and 
are stretched until they intersect the plane of the target object.

If multiple edges exist between the selected edges, they are joined to form a 
single edge. The new edge is set to the angle of the target surface.

Any fascia or soffit profile on the adjacent edges is extended to the target sur-
face and trimmed to its angle. 
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Extending a slab to a wall

1 Select the slab to be extended, right-click, and click Extend.

2 Select the wall or slab to extend to.

3 Select the slab to be extended.

4 Select the first edge to lengthen.

5 Select the second edge to lengthen.

Cutting a Slab

Use this procedure to cut a slab into two or more slabs. You can use any 3D 
object or polyline to define the cutting geometry. If you use a 3D body, such 
as a wall, slab, mass element, or closed polyline, the slab is cut along the 
intersection lines of the surfaces. 
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The slab is cut only when the 3D body or closed polyline intersects the 
perimeter line of the slab. If you use an open polyline, the slab is cut along 
the projection to the slab surface. 

In either case, when the intersection line crosses the slab multiple times, 
multiple slabs are created. If the intersection line has multiple edges, multi-
ple edges are added to the new slabs.

The smoothness (tessellation) of curved edges is controlled by the FACET-
DEV variable. For more information, see “AEC Facet Deviation” on 
page 1409.

1 Draw an object or polyline for defining the cutting geometry.

2 Select the slab to be cut, right-click, and click Cut.

3 Select the objects or polylines that represent the cutting geometry, and 
press ENTER.

4 Enter n (No) to keep the geometry, or enter y (Yes) to erase the geometry.

Adding a Vertex to a Slab

Use this procedure to add a vertex to a slab edge. Adding a vertex creates two 
slab edges from one edge.

1 Select a slab, right-click, and click Add Vertex.

2 Specify a point for the new vertex. 

To place a new vertex at a precise intersection point, use Intersection or 
Apparent Intersection object snaps.

The new vertex is added to the nearest slab edge, perpendicular to the 
specified point. If there is no point perpendicular to the slab, no vertex is 
added.
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Adding a vertex to a Slab

3 To see the new vertex, select the slab.

A new grip point is displayed where you specified a new vertex.

Deleting a Vertex from a Slab

Use this procedure to delete a vertex from a slab. After deleting a vertex, the 
two adjacent vertices connect in a straight line.

1 Select the slab, right-click, and click Remove Vertex.

2 Select the vertex to remove.

Adding a Hole to a Slab

Use this procedure to add a hole to a slab. The hole adds new vertices and 
edges to the slab that you can edit as you do other slab vertices and edges.
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You can use polylines or three-dimensional (3D) objects, such as walls and 
mass elements, to create holes in a slab 

� Holes generated by a closed polyline are projected from the polyline to the 
slab, using the current user coordinate system (UCS).

� 3D objects must intersect the slab without any projection.

If the objects contain an interior void, you are prompted to use the inside or 
outside surface to create the hole. For example, if you create a chimney using 
four wall objects, you can cut the hole at the inside or outside of the chim-
ney. The new hole faces are aligned with the surfaces of the cutting bodies, 
and are not necessarily parallel to each other. 

The smoothness (tessellation) of curved edges is controlled by the FACET-
DEV variable. For more information, see “AEC Facet Deviation” on 
page 1409.

Adding a hole to a slab

1 Draw a closed polyline in the shape and location for the hole, or add an 
object in the location for the hole.

2 Select the slab, right-click, and click Hole ➤ Add.

3 Select the closed polyline or the connected objects that define the hole, 
and press ENTER.

4 Enter n (No) to keep the geometry, or enter y (Yes) to erase the geometry.

5 If you select 3D objects, you are prompted to create the hole at the inside 
or outside surface of the cutting objects. This prompt is displayed even if 
the bodies do not contain an inner void, in which case the Inside option 
does not create a hole.

NOTE If you create a hole that is outside or which overlaps the slab baseline 
or perimeter line at a slab overhang, the body of the slab is cut but the fascia and 
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soffit remain. In this case, it is better to create a hole by cutting the slab. For more 
information, see “Cutting a Slab” on page 1725.

Removing a Hole from a Slab

Use this procedure to remove a hole from a slab.

Removing a hole from a slab

1 Select the slab, right-click, and click Hole ➤ Remove.

2 Select any edge of the hole to remove.

Adding Objects to a Slab (Boolean)

Use this procedure to add three-dimensional (3D) geometry (such as rib 
joists, curbs, or cornice returns) that cannot be defined by the perimeter, 
style, or edge profiles. This procedure fuses 3D geometry of selected objects 
with the slab, so that a section cut through the slab is displayed as a single 
outline. Typically, after adding objects to a slab, you freeze the layer where 
the objects are placed. If you move or edit the objects, the slab updates 
accordingly.

NOTE The object added to the slab is not included for the Area in the LIST 
command or in a Schedule Query result.
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Adding an object to a slab

1 Create one or more objects to add to a slab in its actual location.

2 Select the slab, right-click, and click Boolean ➤ Add.

3 Select the objects to add to the slab, and press ENTER.

Subtracting Objects from a Slab (Boolean)

Use this procedure to subtract three-dimensional (3D) geometry that cannot 
be defined by the perimeter, style, or edge profiles. This procedure carves out 
the body of the slab using the geometry of the selected objects, so that a sec-
tion cut through the slab produces a single outline. For example, you can cre-
ate a curb cut in a slab by subtracting the shape of a freeform mass element 
from the slab. Typically, after subtracting objects from a slab, you freeze the 
layer on which the objects are placed. If you move or edit the objects, the slab 
updates accordingly.

NOTE The object subtracted from the slab is not included for the Area in the 
LIST command or in a Schedule Query result.

1 Create one or more objects to subtract from a slab in its actual location.

2 Select the slab, right-click, and click Boolean ➤ Subtract.

3 Select the objects to subtract from the slab, and press ENTER.

Removing Objects from a Slab (Boolean)

Use this procedure to remove Boolean geometry from a slab. The objects are 
detached from the slab but are not removed from the drawing.

1 Select the slab, right-click, and click Boolean ➤ Detach.

2 Select the objects to remove from the slab, and press ENTER.
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Changing the Location of a Slab

Use this procedure to relocate a slab by changing the coordinate values of its 
insertion point. The slab also has an orientation with respect to the WCS or 
the current UCS. For example, if the top and bottom of the slab are parallel 
to the XY plane, its normal is parallel to the Z axis. You can change the ori-
entation of the slab by aligning its normal with another axis. You can also 
rotate the slab on its plane by changing the rotation angle. 

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Double-click the slab you want to move.

2 Expand Basic, and expand Location.

3 Click Additional Information.

4 Specify the location of the slab:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Slab

Use this procedure to attach hyperlinks, enter notes, or attach reference files 
to a slab. You can also edit notes and edit or detach reference files from a slab.

1 Double-click the slab to which to attach information.

2 On the Properties palette, click the Extended Data tab.

If you want to . . . Then . . .

relocate the slab enter new coordinate values under Insertion Point.

locate the slab on the XY 
plane

make the normal of the slab parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the slab on the YZ 
plane

make the normal of the slab parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the slab on the XZ 
plane

make the normal of the slab parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
slab

enter a new value for Rotation Angle.
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3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add or edit a note, click  next to Notes, enter text, and click OK.

5 To attach, detach, or edit a reference file, click  next to Reference doc-
uments, and then do any of the following:

6 Click OK.

Slab Styles

A slab style is a group of properties assigned to a slab that determines the 
appearance and other characteristics of the slab. Slab styles control the fol-
lowing parameters:

� default dimensions, including slab thickness
� default edge conditions, including fascia and soffit styles
� default display properties, including fascia and soffit
� materials assigned to slabs

Creating Tools from Slab Styles
You can create a slab tool from any slab style. You can drag the style from the 
Style Manager onto a tool palette and then specify default settings for the 
slabs created with that tool. For more information, see “Using Slab Tools to 
Create Slabs” on page 1703.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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Managing Slab Styles
To create, copy, or edit styles, you access the Style Manager. The Style Man-
ager provides a central location in Autodesk® Architectural Desktop where 
you can work with styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Style Manager.”

Related Topics and Procedures

� Creating a Slab Style

� Specifying the Fixed Thickness of a Slab Style

� Specifying the Materials of a Slab Style

� Specifying the Display Properties of a Slab Style

� Attaching Notes and Files to a Slab Style

� Adding Classifications to a Slab Style

Creating a Slab Style

Use this procedure to create a slab style. You can create a style using default 
style properties or by copying an existing style. You then edit the style prop-
erties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Slab Styles.

3 Create a slab style:

4 Enter a name for the new slab style, and press ENTER.

5 To edit the style properties of the new slab style, right-click the style, and 
click Edit:

If you want to . . . Then . . .

create a style with default 
properties

right-click Slab Styles, and click New.

create a style from an 
existing style

right-click the slab style you want to copy, and click 
Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.
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6 If you want to assign the style to a slab tool, drag the style from the Style 
Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Slab Tool” on page 1706.

7 Click OK.

Specifying the Fixed Thickness of a Slab Style

Use this procedure to specify a fixed thickness and thickness offset of a slab 
style. If you specify a fixed thickness in the slab style, you cannot specify a 
thickness when you add or modify slabs of this style.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Select the slab style, right-click, and click Edit.

4 Click the Design Rules tab.

5 Select Has Fixed Thickness, and enter a value for Thickness.

6 Enter a value for Thickness Offset.

A negative value drops the slab bottom below the baseline.

7 Click OK twice.

specify default fixed 
thickness for the style

see “Specifying the Fixed Thickness of a Slab Style” 
on page 1734.

assign materials to the 
components of the slab 
style

see “Assigning Materials to a Slab Style” on 
page 1736 and “Turning on Materials for a Slab 
Style” on page 1739.

add classifications to a slab 
style

see “Adding Classifications to a Slab Style” on 
page 1742.

specify slab hatching, cut 
plane properties, and other 
display properties of the 
style

see “Specifying the Display Properties of a Slab 
Style” on page 1737.

add notes and files to the 
style

see “Attaching Notes and Files to a Slab Style” on 
page 1742.

If you want to . . . Then . . .
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Specifying the Materials of a Slab Style

A slab object consists of a number of components whose display properties 
can be determined by the materials assigned to each component.

You assign one material to each display component of a slab. For example, 
you assign a floor tile material to the slab body and a concrete material to a 
slab edge. 

If you want to use the display properties of a slab object or slab style, instead 
of using material display properties, you can turn off the material assign-
ments in the display properties of the slab or the slab style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in Plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in 3D model views and elevations. 

For a complete list of material components and their description, see “Mate-
rial Components and Display Properties” on page 498.

Related Topics and Procedures

� Slab Materials and Display Components

� Assigning Materials to a Slab Style

Slab Materials and Display Components
The following table identifies the material component that corresponds to 
each slab component. 

 Slab Component Material Component

Plan, Plan High Detail, Plan Low Detail, Reflected Plan, Screened

Below Cut Plane Body No Material

Above Cut Plane Body No Material

Below Cut Plane Outline No Material

Above Cut Plane Outline No Material

Cut Line Linework

Hatch No Material

Baseline No Material
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Assigning Materials to a Slab Style
Use this procedure to assign materials to the individual components of a slab 
style. The components will then use the display properties of the materials 
instead of the style display properties.

You can assign a material to any physical component of the slab. Custom 
components and components that are only symbolic do not use materials for 
their display properties. For example, the slab body is a physical component, 
while the pivot point is a symbolic component.

NOTE Although fascias and soffits are physical components of slabs, they are 
defined in the slab edge style, and not in the slab style. For information on 
assigning materials to slab edge styles, see “Assigning Materials to a Slab Edge 
Style” on page 1752.

NOTE If a material assignment does not determine the display properties of a 
slab component, you can change the display properties of the slab style as 
described in “Specifying the Display Properties of a Slab Style” on page 1737.

1 Open a tool palette that has a slab tool.

Fascia LInework

Soffit Linework

Pivot Point No Material

Warning No Material

Model

Warning No Material

Baseline No Material

Slab 3D Body

Fascia 3D Body

Soffit 3D Body

Pivot Point No Material

 Slab Component Material Component
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2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which to assign a material, and 
click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Click the component you want to change, click its current material defi-
nition, and select a different material definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display Properties of a Slab Style

In most cases, you want the appearance of slabs that use the same style to be 
consistent throughout a drawing. To achieve this, you specify the following 
display properties in each slab style:

� The layer, color, and linetype of slab components
� The hatching used for the surface of the slab in plan views
� The cut plane height

Slab components with display properties include dimensions for slab thick-
ness, edge conditions for the fascia and soffit, line work, cut planes, cut lines, 
3D shading factors, and a warning, baseline, slab, and pivot point. The dis-
play properties of the fascia and soffit are also controlled by slab style, 



1738 | Chapter 24 Slabs

although the geometry of these components is controlled through slab edge 
styles.

You can also use materials to control the display properties of the physical 
components of a slab. Symbolic components, such as the slab pivot point, 
are not controlled by materials. For more information about using materials 
in slabs, see “Specifying the Materials of a Slab Style” on page 1735.

Related Procedures

� Specifying the Layer, Color, and Linetype of a Slab Style

� Turning on Materials for a Slab Style

� Specifying the Hatching of a Slab Style

� Specifying the Cut Plane Height of a Slab Style

Specifying the Layer, Color, and Linetype of a Slab Style
Use this procedure to change the following display properties of the compo-
nents including the fascia and soffit of a slab style:

� Visibility (component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype Scale

NOTE If a material assignment determines the properties of components in 
the slab style, you can change the properties of the display component by clear-
ing By Material or by overriding the material assignment with a different mate-
rial. For more information, see “Assigning Materials to a Slab Style” on 
page 1736.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .
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7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Turning on Materials for a Slab Style
Use this procedure to turn on material assignments for individual display 
representations in a slab style.

For more information about using materials to control the display of slab 
components, see “Specifying the Materials of a Slab Style” on page 1735.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for each component to be controlled by the material. 
The By Material check box is unavailable for components that cannot be 
assigned a material.

When you select By Material for a display component, all other settings in 
the dialog box are unavailable. Since the display properties are now taken 
from the material definition, you can no longer set them directly in the 
display properties of the slab style. 

9 Click OK twice.

Specifying the Hatching of a Slab Style
Use this procedure to specify the hatching of a slab style. Slab hatching is dis-
played only in display representations, such as Plan, that are used in the Top 
view (plan view) of a drawing.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.
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5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Hatching tab.

8 Click the setting for Pattern.

9 Select the hatching pattern:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is to be oriented:

14 Click OK three times.

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and then clear 
Double Hatch.

select double hatching select User-defined for Type, and then select 
Double Hatch.

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the slab, 
regardless of the slab rotation

select object.

orient the hatching to the World 
Coordinate System

select global.
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Specifying the Cut Plane Height of a Slab Style
Use this procedure to specify the cut plane height of a slab style. 

If you specify a value greater than zero, you must specify the layer, color, and, 
linetype for the elements above and below the cut plane height. This is espe-
cially important if you added or subtracted Boolean objects that changed the 
thickness of the slab.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Override Display Configuration Cut Plane, and enter a value for Cut 
Plan Height.

9 Click OK three times.

Adding Classifications to a Slab Style

Use this procedure to specify classifications for any classification definition 
applied to a slab style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to slab 
styles.

5 For each classification definition, select the classification you want to 
apply to the current slab style.

6 Click OK twice.
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Attaching Notes and Files to a Slab Style

Use this procedure to enter notes and attach reference files to a slab style. You 
can also edit notes and edit or detach reference files from a slab style.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the slab, enter it under Description.

6 Click Notes.

7 To add or edit a note, click the Notes tab, and enter the note.

8 To attach, edit, or detach a reference file, click the Reference Docs tab:

9 Click OK twice.

Adding Classifications to a Slab Style

Use this procedure to specify classifications for any classification definition 
applied to a slab style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a slab tool.

2 Right-click a slab tool, and click Slab Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are finished editing.

detach a reference file select the file name, click Delete, and click OK.
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By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to slab 
styles.

5 For each classification definition, select the classification you want to 
apply to the current slab style.

6 Click OK twice.

Slab Edge Styles

A roof slab edge style can be applied to edges of roof slabs. You can set the 
overhang length, orientation, and angle of the orientation, and add a fascia 
and soffit for each edge style.

Components of Slab Edge Styles
The slab edge style defines the appearance of slab edges. Each style consists 
of two optional components: a fascia and a soffit.

A fascia is a shape applied to the outside face of a slab edge. A soffit is a shape 
applied to the underside of an edge overhang.

You can create fascia and soffit components by defining profiles that provide 
the two-dimensional (2D) geometry of the component whose shape is then 
extruded along the slab edge.

The fascia component follows the orientation of the slab edge, plumb, or 
square cut. The soffit component, however, is always oriented to the 
horizontal. Either component can have a positive or negative angle, relative 
to its base orientation.

The +/- directions for edge component angles remain the same regardless of 
their orientation in the XY plane. They always follow the slab slope, so that, 
for example, a +30° soffit and a +30° slab would be parallel to each other. Sim-
ilarly, a +10° (plumb cut) fascia and a -10° soffit would meet at a right angle. 
Mirroring a slab maintains the same angle signs for all components.

Controlling the Placement of the Fascia and Soffit on Slab Edges
The fascia profile is drawn at actual size, except when you select Auto-Adjust. 
If the slab edge is sloped relative to the ground plane, then the length is mea-
sured parallel to that slope, and not plumb with the ground. When you select 
Auto-Adjust to Edge Height, the fascia profile is scaled about its insertion 
point so that its lowest Y axis point aligns with the bottom of the slab edge.
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NOTE Slope offsets are measured relative to the slab edge angle from the 
ground plane, and not relative to the world UCS.

The soffit profile is drawn at actual size, except when you select Auto-Adjust. 
The soffit angle is measured about its insertion point, using the local X axis 
of the profile.

When you select Auto-Adjust to Overhang Depth, the soffit profile is scaled 
about the insertion point, so that the furthest X axis point aligns with a 
plumb line from the slab baseline or perimeter line. Auto-Adjust scaling is 
adjusted by the horizontal offset from the slab baseline dimension.

Display Properties of the Fascia and Soffit
In most cases, you want the appearance of the fascia or soffit that use the 
same style to be consistent throughout a drawing. To achieve this, you spec-
ify the following display properties in each slab edge style:

� The layer, color, and linetype of slab edge components
� The hatching used for the surface of slab edges in plan views
� The cut plane height

Slab edge components with display properties include dimensions for slab 
thickness, fascia and soffit, vertical and horizontal offsets, line work, cut 
planes, cut lines, 3D shading factors, and a warning, baseline, slab, and pivot 
point. The display properties of the fascia and soffit are also controlled by 
slab style, although the geometry of these components is controlled through 
slab edge styles. 

Materials in Slab Edges
You can assign materials to a roof slab edge. These materials are then dis-
played in wireframe or rendered views. Materials have specific settings for 
individual components of a roof slab edge, such as the fascia and soffit.

 Viewing Slab Edge detail in 2D wireframe and rendered views
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Autodesk® Architectural Desktop provides predefined materials for common 
design purposes. These materials contain settings for slabs and slab edges 
that you can use “as is” or modify for special designs. You can also create 
materials from scratch. For more information, see “Specifying the Materials 
of a Slab Style” on page 1735.

Managing Slab Edge Styles
When you create, import, export, or edit styles, you access the Style Manager. 
The Style Manager provides a central location where you can work with styles 
from multiple drawings and templates. For more information about using 
the Style Manager, see “Style Manager.”

Related Procedures

� Creating a Slab Edge Style

� Specifying the Overhang, Edge Cut, and Angle of a Slab Edge Style

� Creating Profiles for the Fascia and Soffit

� Specifying a Fascia and a Soffit for a Slab Edge Style

� Assigning Materials to a Slab Edge Style

� Turning on Materials for a Slab Edge Style

� Attaching Notes and Files to a Slab Edge Style

Creating a Slab Edge Style

Use this procedure to create a new slab edge style. You can create a style using 
default style properties or by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Slab Edge Styles.

3 Create a slab edge style:

4 Enter a name for the new slab edge style, and press ENTER.

If you want to . . . Then . . .

create a style with default 
properties

right-click Slab Edge Styles, and click New.

create a style from an 
existing style

right-click the slab edge style you want to copy, and 
click Copy. Right-click, and click Paste.
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5 To edit the new slab edge style, right-click the style, and click Edit:

6 When you finish specifying the properties of the slab edge style, click OK 
twice.

Specifying the Overhang, Edge Cut, and Angle of 
a Slab Edge Style

Use this procedure to specify the default overhang depth, edge cut, and edge 
angle for slab edges using this edge style.

1 Select a slab, right-click, and click Edit Slab Edge Style.

2 Select an edge of the slab.

3 Click the Defaults tab.

4 Specify the overhang, edge cut, and angle of the slab:

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

specify the overhang, edge 
cut, and angle for the style

see “Specifying the Overhang, Edge Cut, and Angle 
of a Slab Edge Style” on page 1746.

specify soffits and fascias 
for the style

see “Specifying a Fascia and a Soffit for a Slab Edge 
Style” on page 1749.

assign materials to slab 
edge styles

see “Assigning Materials to a Slab Edge Style” on 
page 1752.

turn on materials for a slab 
edge style

see “Turning on Materials for a Slab Edge Style” on 
page 1753.

add notes and files to the 
style

see “Attaching Notes and Files to a Slab Edge Style” 
on page 1753.

If you want to . . . Then . . .

specify the overhang of the 
slab

enter a value for Overhang.

specify the edge cut of the 
slab

select a setting for Edge Cut:
� Select Square to cut the edge 90 degrees 

with the plane of the slab.
� Select Plumb to cut the edge perpendicular 

with the ground.
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5 Click OK.

Creating Profiles for the Fascia and Soffit

Use this procedure to create a profile for the fascia and soffit.

The profile is made up of closed polylines. These polylines can be concentric 
to show voids, for example, for aluminum extrusions. The outer polyline, or 
ring, becomes the exposed shape, and the inner polyline, if used, becomes 
the void. You can create multiple voids by adding more inner closed 
polylines. The polylines are proportional in size and shape to each other and 
to the slab. 

You can draw these polylines anywhere in the drawing and use any conve-
nient scale relative to your final fascia or soffit size. One method for sizing 
the polylines relative to the slab edge is to draw them by snapping to an exist-
ing fascia, and then move your completed polylines to the side.

The options for creating the profiles are as follows:

� Use one or more polylines.
� Use open or closed polylines, or a combination of open and closed 

polylines.
� Orient the polylines in the same plane as the fascia or soffit sectional view.
� Create the polylines at the actual size for the fascia or soffit size. 
� Provide an insertion point for each profile. 
� Scale the fascia or soffit profile about the insertion point (Auto-Adjust to 

edge height or overhang depth).

specify the angle of the slab enter a value for Angle.

A positive value moves the bottom of the edge 
out and a negative value moves the bottom of the 
edge in.

If you want to . . . Then . . .
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Assigning a profile as a fascia

1 Draw closed or open polylines representing the fascia or soffit. 

2 Select the polylines, right-click, and click Convert to ➤ Profile Definition.

3 Select the outermost polyline.

4 Enter a (Add ring) as needed.

5 Select an inner polyline as needed.

6 Repeat steps 3 and 4 as needed to add more voids to the profile.

7 Specify the insertion point for the fascia or soffit. (The insertion point is 
typically the lower-left corner.)

8 Enter n (New), enter a name for the profile, and click OK.
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Specifying a Fascia and a Soffit for a Slab Edge 
Style

Use this procedure to specify a fascia and a soffit for a slab edge style. The 
drawing must contain profiles for the fascia and soffit. For more information, 
see “Creating Profiles for the Fascia and Soffit” on page 1747.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Slab Edge Styles.

3 Right-click the slab edge style that you want to change, and click Edit.

4 Click the Design Rules tab.

5 Select Fascia, and select a profile that defines the geometry of the fascia.

If you select *NONE*, display component settings apply to the slab edge 
line or plane where the fascia is located.

6 Specify how the fascia is to be scaled on the slab edge:

7 Select Soffit, and select a profile that defines the geometry of the soffit.

If you select *NONE*, display component settings apply to the slab edge 
line or plane where the soffit is located.

8 Specify how the soffit is to be scaled on the slab overhang:

If you want to . . . Then . . .

scale the fascia to fit the 
height of the slab edge

select Auto-Adjust to Edge Height to scale the 
fascia to edge height.

use the fascia at its drawn 
size

clear Auto-Adjust to Edge Height.

If you want to . . . Then . . .

scale the soffit to fit the 
depth of the overhang

select Auto-Adjust to Overhang Depth.

use the soffit at its drawn size clear Auto-Adjust to Overhang Depth.
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9 Specify the placement of the soffit:

10 Click OK twice.

Editing the Geometry of Fascia and Soffits

Use this procedure to edit the geometry of the profile used to define the fascia 
and soffit of a slab edge style. You can also add a profile to the fascia or soffit 
of a slab edge style that does not currently use a profile to define its shape.

NOTE If you want to replace the geometry of the profile with newly drawn 
polylines, draw them before you start this procedure.

1 Add a slab object that has the style you want to change.

2 Add or edit a profile:

If you want to . . . Then . . .

specify the soffit angle of the 
slab edge

enter a value for the Angle, with zero being 
horizontal. A positive value slopes the soffit up 
from the insertion point, and a negative value 
slopes the soffit down.

specify the horizontal offset 
from the slab baseline or 
perimeter line for the slab 
edge

enter a value for Horizontal Offset from Slab 
Baseline. (This option is available only if you select 
Auto-Adjust to Overhang Depth.)

specify the soffit offsets from 
the insertion point of the 
fascia

enter a value for “X” Direction and “Y” Direction.

If you want to . . . Then . . .

add an existing profile to the style select the slab, right-click, and click 
Add Edge Profiles. Select an edge. 
Select the name of the profile for the 
fascia or soffit, and click OK.

create a profile and add it to the style select the slab, right-click, and click 
Add Edge Profiles. Select an edge. 
Select Start from scratch for Fascia or 
Soffit Profile Definition, enter a name 
for the new profile, and click OK. A 
rectangle profile is created for you to 
edit.
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NOTE If you are prompted about the selected edge not having an edge 
style and overhang, click Yes.

3 If you receive a message that the profile is not drawn to size, click Yes.

The area of the slab edge defined by the profile is selected and hatched in 
the drawing.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select the 
profile, and right-click to display the shortcut menu.

4 Edit the profile as necessary:

edit the existing profile for the style select the slab, right-click, and click Edit 
Edge Profile in Place.

If you want to . . . Then . . .

change the shape of the perimeter of 
the profile or its rings

select the profile, and use grips to 
adjust the shape.

add vertices to the profile select the profile, right-click, and click 
Add Vertex. Select a point for each new 
vertex, and press ENTER.

remove vertices from the profile select the profile, right-click, and click 
Remove Vertex. Select each vertex to 
remove, and press ENTER.

replace an existing ring of the profile 
with new geometry

select the profile, right-click, and click 
Replace Ring. Select the ring to replace, 
and select the new geometry. Press 
ENTER to keep the geometry, or enter 
n (No) to erase it.

If you want to . . . Then . . .
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5 Save or discard the changes:

Assigning Materials to a Slab Edge Style

Use this procedure to assign materials to individual components of a slab 
edge style. 

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Slab Edge Styles.

3 Right-click the style to which to assign materials, and click Edit.

4 Click the Materials tab.

5 Select the slab edge component to which to assign a material, and click its 
current material definition. 

6 Select a material definition from the list. 

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make apply to all objects that are assigned the material.

7 Click OK twice.

If you want to . . . Then . . .

restore the profile to its original 
shape select the profile, and click .

save the changes to the current 
profile select the profile, and click .

The slab style uses the edited profile to define 
its geometry. Any other objects or styles that 
use this profile are also updated with the 
edited geometry.

save the changes to a new 
profile definition

select the profile, right-click, and click Save as 
New Profile. Enter a name for the new profile 
definition, and click OK.
The slab uses the new profile to define its 
geometry. Any roof slabs of this style are 
updated with the new geometry. Other styles 
or objects that use the original profile are not 
affected.
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Turning on Materials for a Slab Edge Style

Use this procedure to turn on material assignments for individual display 
representations in a slab edge style. Display components for slab edges are 
not turned on in the slab edge style, but rather in the slab style that uses 
them. 

For information on creating and assigning materials, see “Specifying the 
Materials of a Slab Style” on page 1735.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Slab Styles.

3 Select the slab style that contains the slab edges you want to turn on, 
right-click, and click Edit. 

4 Click the Display Properties tab.

5 Select the display representation in which to display the changes, and 
select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for each component to be controlled by the material.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click OK three times.

Attaching Notes and Files to a Slab Edge Style

Use this procedure to enter notes and attach reference files to a slab edge 
style. You can also edit notes and edit or detach reference files from a slab 
edge style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Slab Edge Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the slab edge style, enter it under Description.

6 Click Notes.

7 To add or edit a note, click the Notes tab, and enter the note.
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8 To attach, edit, or detach a reference file, click the Reference Docs tab:

9 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are finished editing.

detach a reference file select the file name, click Delete, and click OK.
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Walls

A wall is an AEC object that represents the real-world 

features of an interior or exterior wall. The wall object 

contains all the geometry needed to represent a wall in 

two-dimensional (2D) and three-dimensional (3D) 

views.

Understanding Wall Components and 
Wall Styles
A wall has one or more components, which are 
the materials used to construct the wall. Com-
ponents include brick, CMU, concrete, studs, 
air gaps, and insulation. The components of 
walls can also have modifiers, which change the 
shape of the component or its surface. 

Wall styles control the appearance of wall 
objects. Using wall styles, you can specify com-
ponents, endcaps, materials, and other charac-
teristics to create new types of walls, such as 
concrete walls, masonry walls, and brick cavity 

walls. Catalogs provided with Autodesk® Archi-
tectural Desktop include sample wall styles for 
common wall types, such as concrete walls with 
footings or furring, CMU and brick cavity walls, 
and various stud partition walls.

In this chapter

� Specifying Drawing Defaults for 
Walls

� Creating Walls Using Wall 
Tools

� Creating a Wall

� Creating a Wall with User-
Specified Settings

� Creating a Wall from Linework

� Creating a Wall from a 3D 
Object

� Creating a Wall Tool

� Editing Walls

� Specifying the Cleanup of Walls

� Adding Objects to Walls

� Creating Special Conditions 
and Customized Wall Surfaces

� Wall Styles

� Wall Endcap Styles

� Opening Endcap Styles

25
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Wall styles that use various components

Placing Walls
When you add a wall to a drawing, you select a wall tool and then specify the 
points that define each wall segment. A wall can have both straight and 
curved segments.

Straight and curved wall segments

Determining Wall Direction
Wall direction is significant for some modifications to walls. Sample wall 
styles provided with Autodesk Architectural Desktop were created with the 
intent that you place perimeter walls in clockwise fashion. After placing a 
wall, you can determine the wall direction by selecting the wall. The wall 
direction grip indicates the wall direction. You can also reverse the direction 
of a wall.
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Determining wall direction

Cleaning up Wall Intersections
You can specify that specific walls intersect and clean up only with certain 
other walls by assigning the walls to a cleanup group. Walls that belong to 
the same group clean up where they intersect. Walls that belong to different 
cleanup groups do not clean up where they intersect. You can also specify 
how walls in xref drawings clean up with walls in the host drawing.

Wall segments that do and do not clean up

Adding Doors, Windows, and Other Objects to Walls
When you add doors, windows, door/window assemblies, and openings to a 
wall, the wall automatically adjusts to accommodate the object and adds 
endcaps where needed. By default, these objects are anchored to the wall. 
The objects remain with the wall if you move it. If you remove an object from 
a wall, the wall repairs itself in the space where the object was located.

Related Topics and Procedures

� Specifying Drawing Defaults for Walls

� Creating a Wall

� Creating a Wall with User-Specified Settings



1758 | Chapter 25 Walls

� Creating a Wall from Linework

� Creating a Wall from a 3D Object

� Creating a Wall Tool

� Editing Walls

� Specifying the Cleanup of Walls

� Adding Objects to Walls

� Creating Special Conditions and Customized Wall Surfaces

� Wall Styles

� Wall Endcap Styles

� Opening Endcap Styles

Specifying Drawing Defaults for Walls

Use this procedure to specify the default settings in the current drawing for 
dimensioning walls and for wall cleanup. The cleanup settings apply only to 
new walls that you add to the drawing and do not affect existing walls.

1 On the Format menu, click Options.

2 Click the AEC Object Settings tab.

3 Under Wall Settings, select an option for wall dimensions: Dimension to 
Center of Opening or Dimension to Outer Frame of Opening.

4 To force the endpoint of a new wall that is drawn within the Autosnap 
Radius of the baseline of an existing wall to snap to that baseline, select 
Autosnap New Wall Baselines.

5 To force the endpoint of a wall that you grip edit within the Autosnap 
Radius of the baseline of an existing wall to snap to that baseline, select 
Autosnap Grip Edited Wall Baselines.

6 Enter a value for Autosnap Radius.

7 Select Do Not Display Opening Endcap Styles if you want to suppress the 
display of endcaps applied to openings in walls.

Selecting this option speeds drawing performance when the drawing con-
tains many complex endcaps.

8 Click OK.
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Creating Walls Using Wall Tools

Tools provided with Autodesk Architectural Desktop let you quickly place 
walls by selecting a wall tool with a specific wall style and other predefined 
properties. You can also use wall tools to convert linework to walls and to 
apply the settings of a wall tool to existing walls.

The default tool palettes in the workspace contain sample wall tools that you 
can use and customize as needed. In addition, the following catalogs pro-
vided with the software contain wall tools that you can add to your tool pal-
ettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� My Tool catalog

Custom palettes created by your CAD manager or other users may also con-
tain wall tools with wall styles and properties that are customized for your 
projects or office standards.

When you place walls using wall tools, you can use the default settings of the 
tool, or you can change settings for any wall properties that are not con-
trolled by the style.

Related Procedures

� Creating a Wall

� Creating a Wall with User-Specified Settings

� Creating a Wall from Linework

� Creating a Wall from a 3D Object

� Creating a Wall Tool

Creating a Wall

Use this procedure to add a new wall that has the properties specified in the 
wall tool that you select. To specify settings when you add a wall, see “Creat-
ing a Wall with User-Specified Settings” on page 1760.

1 Open the tool palette that you want to use, and select a wall tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the wall.
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You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the endpoint of the wall segment.

4 Continue adding wall segments.

5 Specify the endpoint of the wall:

For more information about Ortho Close and Close, see “Using Ortho 
Close and Close with Walls” on page 1897.

Creating a Wall with User-Specified Settings

Use this procedure to create a wall with straight segments, curved segments, 
or both with settings that you specify.

Straight segments have a start point and an endpoint. For more information 
about straight wall segments, see “About Wall Lengths” on page 1897.

If you want to . . . Then . . .

close the wall by drawing 
two wall segments that 
meet the start point at a 
right angle

enter or (Ortho Close), and then specify a point in 
the direction you want the wall to close. The wall 
segment is extended until it meets a wall segment 
perpendicular to the first wall segment.

close the wall by adding 
a wall segment from the 
previous point to the 
start point of the wall

enter c (Close).

complete the wall 
segment at a point that 
you specify

specify the endpoint of the wall, and press ENTER.



Creating a Wall with User-Specified Settings | 1761

Drawing a straight wall segment

Curved segments have a start point, a midpoint, and an endpoint. For more 
information about curved wall segments, see “About Curved Walls” on 
page 1898.

Drawing a curved wall segment
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1 Open the tool palette that you want to use, and select a wall tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Select Yes for Cleanup Automatically if you want the wall to clean up with 
other walls, and select a cleanup group.

5 Expand Dimensions.

6 Specify wall dimensions:

7 Specify the wall justification, which places the wall in relation to the 
points you specify and the direction in which you draw the wall:

If you want to . . . Then . . .

specify the thickness of 
the wall

enter a value for Width. 
If Width is not available, the wall style you selected 
determines the width of the wall.

specify the height of 
the wall from the floor 
to the ceiling

enter a value for Base height.

specify the length of 
the wall from the start 
and end points

enter a value for Length.

If you want to . . . Then . . .

specify points that 
define the left side of 
the wall

select Left for Justify.

specify points that 
define the right side of 
the wall

select Right for Justify.

specify points that 
define the center line of 
the wall

select Center for Justify.

select points that define 
the baseline of the wall

select Baseline for Justify.
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8 Specify offsets:

9 Draw a wall segment:

You can move or hide the Properties palette to expose more of the drawing 
area.

10 Continue adding wall segments. 

You can enter u (Undo) to undo any point except the start point.

11 Specify the endpoint of the wall:

If you want to . . . Then . . .

offset the location of 
the wall from the 
points you specify

enter a value for Baseline offset.

offset the roof line from 
the specified base 
height

enter a value for Roof line offset from base height.

offset the floor line 
from the baseline

enter a value for Floor line offset from baseline.

If you want to . . . Then . . .

draw a straight segment select Line. In the drawing area, specify the start point 
and the endpoint of the straight segment.

draw a curved segment select Arc. In the drawing area, specify the start point, 
the midpoint, and the endpoint of the curved 
segment.

If you want to . . . Then . . .

close the wall by drawing 
two wall segments that 
meet the start point at a 
right angle

enter or (Ortho Close), and then specify a point in 
the direction you want the wall to close. The wall 
segment is extended until it meets a wall segment 
perpendicular to the first wall segment.

close the wall by adding 
a wall segment from the 
previous point to the 
start point of the wall

enter c (Close).
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For more information about Ortho Close and Close, see “Using Ortho 
Close and Close with Walls” on page 1897.

Creating a Wall from Linework

Use this procedure to convert any of the following objects to walls:

� Polylines
� Lines
� Arcs
� Circles

For example, you can create line diagrams or sketches of walls using lines, 
arcs, circles, and polylines to create the building exterior and rooms, and con-
vert these objects to walls. You can edit the wall properties after creating the 
wall.

Creating a wall from a polyline

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

complete the wall 
segment at a point that 
you specify

specify the endpoint of the wall, and press ENTER.

If you want to . . . Then . . .
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2 Right-click a wall tool, and click Apply Tool Properties to ➤ Linework.

3 Select the linework to convert, and press ENTER.

4 When prompted to erase the original geometry, press ENTER to keep the 
linework, or enter y (Yes) to erase it.

5 Edit the properties of the new walls in the Properties palette, if needed.

Creating a Wall from a 3D Object

Use this procedure to convert a three-dimensional (3D) object, such as a mass 

element, or an AutoCAD® ACIS solid into a single-component wall.

Converting a 3D object to a wall

1 Select the object you want to convert to a wall, right-click, and click Con-
vert to Wall.
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2 Enter y (Yes) to erase the original object, or enter n (No) to retain the 
object.

3 Specify the baseline of the wall:

NOTE Specifying a baseline away from the object you are converting to a 
wall affects the insertion of anchored objects, such as doors, windows, and 
openings. Anchored objects are inserted in a wall relative to the baseline of 
the wall.

4 Select a wall style.

The wall style you select must be a single-component style.

5 Click OK.

Creating a Wall Tool

Use this procedure to create a wall tool and add it to a tool palette. You may 
want to create your own wall tools if you are placing multiple walls of specific 
styles with additional properties that you want to be the same each time you 
add a wall of each type.

For example, you are creating an office floor plan with partition walls for 
cubicles. Although all partition walls use the same wall style in your floor 
plan, the walls in administrative areas are lower than the walls in office areas. 
To work efficiently, you can quickly create a wall tool for each wall height. 
You can then select the appropriate tool to place the walls with the correct 
height in each area of the floor plan.

1 Open the tool palette where you want to create a tool.

If you want to . . . Then . . .

specify the baseline of the wall 
by specifying the start point and 
the endpoint of the wall

specify the start point, and then specify the 
endpoint when prompted.

specify the baseline of the wall 
from an existing line or arc in 
the drawing

enter p (Pick), and select the line or the arc 
you want to define for the baseline.
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2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Enter a description of the walls that you can create using this wall tool.

8 Specify a layer key and any layer key overrides, if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select a wall style, and select a style location, if not the current drawing.

10 Select Yes for Cleanup Automatically if you want the wall to clean up with 
other walls, and select a cleanup group.

11 Expand Dimensions.

12 Specify wall dimensions:

If you want to . . . Then . . .

create a tool from a wall in the 
drawing

select the wall, and drag it to the tool palette.

create a tool from a wall style in 
the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool, and click Copy; open the 
other palette, and click Paste.

copy a tool from a tool catalog open the tool catalog in the Content Browser, 
and locate the tool you want to copy. Position 
the cursor over the i-drop handle, and drag 
the tool to the tool palette.

If you want to . . . Then . . .

specify the thickness of 
the wall

enter a value for Width. 
If Width is not available, the wall style you selected 
determines the width of the wall.
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13 Specify the wall justification, which places the wall in relation to the 
points you specify and the direction in which you draw the wall:

14 Specify offsets:

15 Expand Advanced.

specify the height of 
the wall from the floor 
to the ceiling

enter a value for Base height.

If you want to . . . Then . . .

specify points that 
define the left side of 
the wall

select Left for Justify.

specify points that 
define the right side of 
the wall

select Right for Justify.

specify points that 
define the center line of 
the wall

select Center for Justify.

specify points that 
define the baseline of 
the wall

select Baseline for Justify.

If you want to . . . Then . . .

offset the location of 
the wall from the 
points you specify

enter a value for Baseline offset.

offset the roof line from 
the specified base 
height

enter a value for Roof line offset from base height.

offset the floor line 
from the baseline

enter a value for Floor line offset from baseline.

If you want to . . . Then . . .
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16 Expand Cleanups, and specify cleanup options:

17 Expand Style Overrides, and select a wall endcap style to override the style 
currently assigned to the start or the end of the wall.

NOTE Each wall endcap style is generally created for use with a specific wall 
style. Overriding the wall endcap style for an individual wall may cause a 
defect marker to display on the wall.

18 Click OK.

Editing Walls

After placing walls, you can edit any characteristics of the wall that you spec-
ified when you drew the wall and make additional modifications. You can 
change the shape of a wall, the basic geometry of a wall, apply a different wall 
style, and override the component priorities and the endcap styles of the 
wall. You can also move a wall, merge or join walls, and reverse the direction 
of a wall. In addition, you can change the shape of the roof line and the floor 
line of a wall.

Autodesk® Architectural Desktop offers several methods for editing walls:

� You can directly edit walls using grips for dimensions and other physical 
characteristics.

� You can change wall settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

wall.

If you want to . . . Then . . .

specify the line that the 
Graph display 
representation uses for 
the wall graphline

select Wall Justification Line, or select Wall Center Line.

specify a cleanup radius enter a value for Cleanup radius.

override the default 
cleanup radius at the 
start or the end of the 
wall

expand Cleanup Radius Overrides, and a value for 
Override start cleanup radius or Override end cleanup 
radius.



1770 | Chapter 25 Walls

Related Procedures

� Using Grips to Edit Walls

� Changing the Shape of a Wall

� Changing the Wall Width

� Changing the Wall Base Height

� Changing the Wall Justification

� Moving a Wall

� Offsetting New Walls from Existing Walls

� Applying Tool Properties to an Existing Wall

� Changing the Style of a Wall

� Overriding Individual Wall Endcaps

� Offsetting New Walls from Existing Walls

� Repositioning a Wall

� Adjusting the Position of Wall

� Changing the Location of a Wall

� Merging Walls

� Removing Individual Merge Conditions

� Removing All Merged Walls

� Joining Walls

� Filleting Walls

� Chamfering Walls

� Trimming Walls at L and T Intersections

� Using AutoCAD Commands to Edit Walls

� Reversing the Direction of a Wall

� Changing the Roof Line and the Floor Line of a Wall

� Specifying the Materials of Individual Walls

� Changing the Display Properties of Individual Walls

� Attaching Notes and Files to a Wall

Using Grips to Edit Walls

Refer to the illustrations and steps in this topic to use wall grips to edit walls.

Editing Wall Dimensions

1 Select the wall.

2 Select the grip for the dimension you want to change.
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Wall grips for length, width, and base height of a straight wall
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Wall grips for start and end angles, radius, width, and base height of a curved wall

3 Move the grip until the dimension value you want is displayed and click 
once, or enter a value.

If no Width grip is displayed, the width is controlled by the wall style, and 
you cannot change it for individual walls.

Changing the Location or Position of a Wall

1 Select the wall.

2 Move the appropriate grip to change the location of the wall, its start 
point, its endpoint, or its direction.



Editing Walls | 1773

Wall location and direction grips for a straight wall
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Wall location and direction grips for a curved wall

Changing the Height of the Roof Line Start and Endpoints

1 Select the wall.

2 Move the Roof Line Start grip or the Roof Line End grip until the dimen-
sion value you want is displayed and click once, or enter a value.
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Grips for the start and end of a roof line and floor line for a straight wall

Grips for the start and end of a roof line for a curved wall

Changing the Shape of a Wall

Use this procedure to change a straight wall to a curved wall, or to change a 
curved wall to a straight wall:

� When you change a straight wall to a curved wall, the software adds a 
curve second point at the midpoint of the of the wall segment. You can 
use grips to change the shape of the arc. For more information about 
curved walls, see “About Curved Walls” on page 1898.
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� When you change a curved wall to a straight wall, the software creates a 
straight segment between the start and endpoints of the curve. You can 
use grips to adjust the length and location of the wall.

1 Select the walls you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand General.

3 Select Arc or Line for Segment type.

Changing the Wall Width

Use this procedure to change the thickness of a wall. You can also change the 
wall width on the Properties palette.

If the wall width is defined in the wall style applied to the wall, you cannot 
change the thickness of an individual wall. 

For more information about wall grips, see “Using Grips to Edit Walls” on 
page 1770.

1 Select the wall.

2 Select a Width grip, move the grip until the width value you want is dis-
played, and click once.

After selecting a grip, you can also enter a precise value to increase or 
decrease the width of the wall. For center and baseline justified walls, you 
can press CTRL to maintain the baseline or the width of the opposite face 
of the wall when you change the wall width.

Changing the Wall Base Height

Use this procedure to change the base height of one or more walls. The base 
height is the height of the wall from floor to ceiling. You can also change the 
base height on the Properties palette.

For more information about wall grips, see “Using Grips to Edit Walls” on 
page 1770.

1 Select the wall.

2 Select the Base Height grip, move the grip until the height value you want 
is displayed, and click once.

After selecting the grip, you can also enter a precise value to increase or 
decrease the base height of the wall. 
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Changing the Wall Length

Use this procedure to change the length of one or more walls. You can also 
change the length on the Properties palette.

For more information about wall grips, see “Using Grips to Edit Walls” on 
page 1770.

1 Select the wall.

2 Select a Lengthen grip, move the grip until the length value you want is 
displayed, and click once.

After selecting the grip, you can also enter a precise value to increase or 
decrease the length of the wall. 

Changing the Wall Justification

Use this procedure to change the justification of a wall. You can also change 
the justification on the Properties palette.

Justification options

Justification determines the location of the wall in relation to the direction 
in which the wall was drawn and the points used to draw the wall. Changing 
the justification of an existing wall moves the wall and can affect how the 
wall cleans up with other walls.

For more information about wall grips, see “Using Grips to Edit Walls” on 
page 1770.
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1 Select the wall, right-click, and click Edit Justification.

Four grips appear, indicating the justification options: Left Right, Center, 
and Baseline. The gray grip identifies the current justification.

Wall justification grips

2 Select the grip that corresponds to the justification you want.

Moving a Wall

Use this procedure to move a wall. You can also move a wall by changing its 
coordinates. For more information, see “Changing the Location of a Wall” on 
page 1783.

For more information about wall grips, see “Using Grips to Edit Walls” on 
page 1770.

1 Select the wall you want to move.

2 Select the Location grip, and move the wall to a new location.

Offsetting New Walls from Existing Walls

Use this procedure to add copies of an existing wall that are offset from a 
component of the wall at a distance that you specify.

This offset command enables you to copy walls by offsetting them a clear dis-
tance from the face or center of a specific wall component, such as the stud 
or the wall finish.

1 Select the wall you want to copy or move, right-click, and click 
Offset ➤ Copy.

TIP A tooltip is displayed to help you identify the position of the cursor on 
each wall component.
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2 Specify the location of the offset point:

Specifying the center of a wall component to offset new walls

3 Specify the offset distance.

4 Continue adding walls, each new wall offset from the face or center of the 
wall you added before it.

You can specify a different offset distance each time you add another wall.

New walls placed by offsetting from the center of the stud component

5 Press ENTER.

If you want to . . . Then . . .

offset the wall from the 
face of a wall component

move the cursor over the wall until the face of the 
component you want is highlighted with a red line, 
and click once.

offset the wall from the 
center of a wall 
component

press CTRL, and move the cursor over the wall until 
the center of the component you want is 
highlighted. Click once.
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Repositioning a Wall

Use this procedure to move a wall by offsetting the wall from the center or 
face of a wall component to a point or distance that you specify.

1 Select the wall you want to move, right-click, and click Offset ➤ Move.

TIP A tooltip is displayed to help you identify the position of the cursor on 
each wall component.

2 Specify the location of the offset point:

Specifying the center of a wall component to move the wall

3 Specify the distance from the component face or center to its new posi-
tion.

If you want to . . . Then . . .

offset the wall from the 
face of a wall component

move the cursor over the wall until the face of the 
component you want is highlighted with a red line, 
and click once.

offset the wall from the 
center of a wall 
component

press CTRL, and move the cursor over the wall until 
the center of the component you want is 
highlighted. Click once.
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Wall moved a specified distance from the center of the stud

Adjusting the Position of Wall

Use this procedure to adjust the position of a wall by aligning or offsetting 
the center or face of a wall component from a reference point that you spec-
ify. For example, you can adjust the placement of a stud partition wall by 
defining the distance from stud to stud on center.

1 Select the wall you want to move, right-click, and click Offset ➤ Set 
From.

TIP A tooltip is displayed to help you identify the position of the cursor on 
each wall component.

2 Specify the location of the offset point:

Specifying the face of wall finish component for the offset point

If you want to . . . Then . . .

offset the wall from the 
face of a wall component

move the cursor over the wall until the face of the 
component you want is highlighted with a red line, 
and click once.

offset the wall from the 
center of a wall 
component

press CTRL, and move the cursor over the wall until 
the center of the component you want is 
highlighted. Click once.
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3 Specify the reference point you want to measure to.

For example, if you want to move a wall so that its exterior face is aligned 
with the exterior face of another wall, specify a point on the face of the 
other wall.

Specifying the reference point

4 Specify the new distance from the wall component face or center to the 
reference point.

Enter 0 (zero) to align the selected wall with the reference point.

Component face aligned with the face of another wall

Applying Tool Properties to an Existing Wall

Use this procedure to apply the properties of a wall tool to one or more exist-
ing walls. The properties include the wall style and any other settings speci-
fied in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a wall tool, and click Apply Tool Properties to ➤ Wall.

3 Select the walls, and press ENTER.

4 Edit the properties of the walls in the Properties palette, if needed.

Changing the Style of a Wall

Use this procedure to select a different wall style for one or more walls.

1 Select the walls to change, and double-click one of them.

2 Expand Basic, and expand General.

3 Select a different style.
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Overriding Individual Wall Endcaps

Use this procedure to select a different wall endcap style for each end of an 
individual wall. By default, a wall uses the endcap styles specified in the wall 
style. You can also override wall endcaps on the Properties palette.

To modify the current endcap style or to create a new endcap style from the 
current style, see “Wall Endcap Styles” on page 1886.

NOTE Each wall endcap style is generally created for use with a specific wall 
style. Overriding the endcap style for an individual wall may create defect mark-
ers in the wall.

1 Select a wall, right-click, and click Endcaps ➤ Override Endcap Style.

2 Select a point close to the wall end where you want assign a different end-
cap.

3 Select an endcap style, and click OK.

Changing the Location of a Wall

Use this procedure to relocate a wall by changing the coordinate values of its 
insertion point. The wall also has an orientation with respect to the WCS or 
the current UCS. For example, if the top and bottom of the wall are parallel 
to the XY plane, its normal is parallel to the Z axis. You can change the ori-
entation of the wall by aligning its normal with another axis. You can also 
rotate the wall on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Double-click the wall you want to change.

2 In the Properties palette, expand Basic, and expand Location.

3 Select Additional information.

4 Specify the location of the wall:

If you want to . . . Then . . .

relocate the wall enter new coordinate values under Insertion Point.

locate the wall on the XY 
plane

make the normal of the wall parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 
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5 Click OK.

Merging Walls

Use this procedure to merge the profile of selected walls. This does not pro-
vide automatic wall cleanup, but merging walls is useful in tight situations 
that involve short wall segments.

locate the wall on the YZ 
plane

make the normal of the wall parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the wall on the XZ 
plane

make the normal of the wall parallel to the Y axis: 
under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
wall

enter a new value for Rotation Angle.

If you want to . . . Then . . .
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Merging wall segments

1 Select a wall to merge, right-click, and click Cleanups ➤ Add Wall 
Merge Condition.

2 Select other walls to merge with the first wall, and press ENTER.

TIP To identify merged walls, turn on the Graph display representation. 
Select a wall, right-click, and click Cleanups ➤ Toggle Wall Graph Display. 
Select the wall to which you added merge conditions. An arc connects the 
original wall to each wall it is merged with.
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Removing Individual Merge Conditions

Use this procedure to selectively remove merge conditions from a wall.

1 Select a wall, right-click, and click Cleanups ➤ Toggle Wall Graph Dis-
play.

2 Select the wall that was selected first when the walls were merged.

An arc connects the wall to each wall merged with it.

Wall with two merge conditions applied to it

3 Select the Remove Wall Merge Condition grip for the wall you want to 
remove from the original wall.

The arc and grip are removed to indicate that a merge condition with the 
wall no longer exists.

One of two merge conditions removed from a wall

Removing All Merged Walls

Use this procedure to remove all merged wall conditions from a group of 
merged walls.

TIP To identify merged walls, turn on the Graph display representation. 
Select a wall, right-click, and click Cleanups ➤ Toggle Wall Graph Display. 
Select the wall to which you added merge conditions. An arc connects the 
original wall to each wall it is merged with.

� Select the wall that was selected first when the walls were merged, right-
click, and click Cleanups ➤ Remove All Wall Merge Conditions.
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If a message at the command line indicates that no merge conditions were 
removed, the wall you selected was not the first wall when the merge con-
dition was created. You can press ENTER to repeat the command, and then 
select a different wall.

Joining Walls

Use this procedure to combine the baselines of two walls to create one wall 
segment. Walls that you join must meet the following requirements:

� Linear walls must have colinear baselines and be touching at one 
endpoint. 

� Arc walls must have the same center, radius, and be touching at one end.
� Walls must have the same style and width. 
� Walls must belong the same cleanup group.

Joining walls also transfers all sub-objects and anchored objects from one 
wall to the other. Sub-objects include roofline, floorline, anchors, wall mod-
ifiers, wall style overrides, and interference conditions. Anchored objects 
include doors, windows, and openings anchored to the walls.

1 Select the first wall, right-click, and click Join.

2 Select the second wall.

Filleting Walls

Use this procedure to fillet two walls. Filleting walls creates a curved wall seg-
ment with a specified radius that is tangent to the baselines of the selected 
walls. 

If you specify zero for the fillet radius, the walls are trimmed or extended 
until they intersect, but no curved wall segment is created. Using a radius of 
zero enables you to force odd-angled walls to meet. If you select parallel wall 
segments, the fillet radius is ignored, and a curved wall segment is created 
that is tangent to the baselines of the selected walls.
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Filleting wall segments using zero radius

Trim mode options enable you to specify whether the walls are trimmed or 
extended to the new segment (trim option) or whether their endpoints 
remain unchanged (no trim option). If you select no trim, the fillet radius 
must be greater than zero.

Filleting wall segments using a radius greater than zero

Before filleting walls, ensure that the following conditions exist:

� The walls have the same style and baseline justification.
� The fillet radius is not a negative value.

Defect symbols can appear when you fillet the walls if these conditions are 
not met.
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1 Open a tool palette that contains the Fillet tool.

The Fillet tool is located with the Basic Drafting Tools in the Stock Tool 
Catalog. You can add this tool to any tool palette, and then use the tool 
to fillet walls and other objects.

2 Select the Fillet tool.

3 Verify trim mode and radius settings:

4 Select the first wall.

5 Select the second wall.

Chamfering Walls

Use this procedure to chamfer two walls. Chamfering walls creates a new wall 
segment between two walls that are not parallel. Chamfering is useful when 
you are working with unique wall angles or architectural details.

You can chamfer walls by specifying distance or angle:

� Using the distance option, you specify the length that each wall should be 
trimmed or extended until it meets the new wall segment or the other 
wall. If both chamfer distances are zero, the walls are extended until they 
intersect, but a new wall segment is not created.

If you want to . . . Then . . .

trim or extend wall segments to 
meet each other or to meet the 
endpoints of the resulting 
curved wall segment

enter t (Trim), and then enter t (Trim).

keep the endpoints of the wall 
segments in their original 
locations and fit the curved wall 
segment between them

enter t (Trim), and then enter n (No trim).

specify a new fillet radius enter r (Radius), and then enter a value for the 
radius. Enter 0 for the radius if you want the 
wall segments to meet each other without 
creating a curved wall segment.

fillet multiple walls enter u (Multiple).
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Chamfering walls using the distance option

� Using the angle option, you specify the length of the chamfer and the 
angle it forms with the first wall.

Chamfering walls using the angle option

Trim mode options enable you to specify whether the walls are trimmed or 
extended to the new wall segment (trim option) or whether their endpoints 
remain unchanged (no trim option). If you select no trim, chamfer distances 
must be greater than zero.
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Before chamfering walls, ensure that the walls have the same style and base-
line justification. Defect symbols can appear when you chamfer the walls if 
these settings are not the same for each wall.

1 Open a tool palette that contains the Chamfer tool.

The Chamfer tool is located with the Basic Drafting Tools in the Stock Tool 
Catalog. You can add this tool to any tool palette, and then use the tool 
to chamfer walls and other objects.

2 Select the Chamfer tool.

3 Specify default settings for chamfering walls:

4 Select the first wall.

5 Select the second wall.

If you want to . . . Then . . .

trim or extend wall segments to 
meet each other or to meet the 
endpoints of the new wall 
segment

enter t (Trim), and then enter t (Trim).

keep the endpoints of the wall 
segments in their original 
locations and fit the new wall 
segment between them

enter t (Trim), and then enter n (No trim).

specify the default length and 
angle values for the angle 
option

enter a (Angle). Enter the distance from the 
endpoint to the point on the wall where you 
want the chamfer to begin. Enter the angle of 
the chamfer.

specify the default distances for 
the distance option

enter d (Distance). Enter values for Distance 1 
and Distance 2. Enter 0 for both distances if 
you want the walls to meet without creating a 
new wall segment.

specify the distance option as 
the default option for 
chamfering walls

enter m (Method), and then enter d 
(Distance). 

specify the angle option as the 
default option for chamfering 
walls

enter m (Method), and then enter a (Angle). 

chamfer multiple walls enter u (Multiple).
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Trimming Walls at L and T Intersections

Use this procedure to trim or extend walls so that they meet and clean up at 
T-shaped or L-shaped intersections. If walls do not belong to the same 
cleanup group, they are trimmed but do not clean up with each other. 

When you create an L-shaped intersection, the wall endpoints that are clos-
est to each other extend or trim so that their wall graphlines meet exactly.

L-shaped cleanup, before and after

When you create a T-shaped intersection, the walls you select are extended 
or trimmed to a boundary wall that you specify.

T-shaped cleanup, before and after

1 Select the cleanup method you want to use:

If you want to . . . Then . . .

create an L-shaped intersection 
between two walls

select the walls, right-click, and click 
Cleanups ➤ Apply L Cleanup.

create a T-shaped intersection 
between two walls

select the walls to be extended or trimmed to 
a boundary wall, right-click, and click 
Cleanups ➤ Apply T Cleanup. Select the 
boundary wall.
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Reversing the Direction of a Wall

Use this procedure to change the direction in which a wall is drawn by revers-
ing the start point and the endpoint of the wall. Walls are drawn from the 
first specified point to the last point. Some commands and properties are 
affected by that order. For example, you can add wall modifiers to the left or 
right side of a wall. Left and right sides are west and east, respectively, when 
a wall is drawn from south to north, regardless of how the wall is displayed 
in the current view.

To determine the direction in which a wall was drawn, select the wall. The 
Reverse Direction grip shows the orientation of the wall. For more informa-
tion about wall grips, see “Using Grips to Edit Walls” on page 1770.

1 Select the wall.

2 Click the Reverse Direction grip.

The outside faces of the wall remain in place, and the baseline shifts, if 
necessary. Press CTRL when you select the grip to maintain the baseline 
when reversing direction.

TIP To reverse the direction of multiple walls, select the walls, right-click, 
and click Reverse. The wall baselines are maintained.

Using AutoCAD Commands to Edit Walls

You can use the following standard AutoCAD® commands to edit walls:

� BREAK
� EXTEND
� TRIM

For more information about these commands, see the AutoCAD 2004 Com-
mand Reference.

Changing the Roof Line and the Floor Line of a 
Wall

You can modify the roof and floor lines of a wall to create a nonrectangular 
wall. 

� You edit vertex locations on the roof line to create steps, gables, and other 
roof conditions.
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Modifying the roof line of a wall

� You edit vertex locations on the floor lines to create steps and other floor 
conditions. 

Modifying the floor line of a wall

You can also create nonrectangular roof and floor conditions by projecting 
to polylines.

Autodesk Architectural Desktop offers multiple methods of editing roof lines 
and floor lines. You may want to begin by graphically creating a custom roof 
line or floor line condition. You can then fine-tune that condition by speci-
fying precise values in the Roof/Floor Line worksheet on the Properties pal-
ette.

Related Procedures

� Offsetting or Projecting the Roof Line of a Wall

� Offsetting or Projecting the Floor Line of the Wall

� Adding a Gable to the Roof Line of a Wall

� Adding a Step to the Roof Line or Floor Line of a Wall

� Editing the Roof Line or the Floor Line of a Wall

� Reversing the Roof Line or Floor Line of a Wall

� Changing Vertices in the Roof Line or Floor Line of a Wall

Offsetting or Projecting the Roof Line of a Wall
Use this procedure to change the height or the shape of the roof line of a wall:
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� Offset the roof line from the current height of the wall.
� Project the roof line of the wall to a polyline.
� Project the roof line of the wall to another object, such as a roof or stairs.

You can also create a polyline that represents the current roof line of the 
selected walls. You can then use this polyline to change the roof line of other 
walls.

NOTE To project the roof line to a polyline, draw the polyline first in elevation 
view. For best results, the polyline should be parallel to the wall. The polyline 
does not need to be in the same plane as the wall.

1 Select a wall, right-click, and click Roof/Floor Line ➤ Modify Roof Line.

2 Change the roof line of the wall:

3 Press ENTER.

Offsetting or Projecting the Floor Line of the Wall
Use this procedure to change the height or the shape of the floor line of 
a wall:

� Offset the floor line from the current baseline of the wall.
� Project the floor line of the wall to a polyline.

If you want to . . . Then . . .

offset the roof line from the 
current height of the wall

enter o (Offset), and enter an offset distance. 
Enter a negative value to project the roof line 
below the current wall height.

project the roof line to a 
polyline

enter p (Project), and select the polyline.

project the roof line to another 
object, such as a roof or stairs

enter a (Auto-project), and select the object to 
project to.
When projecting to stairs, make sure that the 
bottom riser or the stringer does not create a 
zero-height segment of wall.

generate a polyline of the 
current roof line

enter g (Generate), and select the walls for the 
polyline to be created from.

remove any changes to the roof 
line

enter r (Reset), and select the walls to change.
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� Project the floor line of the wall to another object, such as a floor slab or 
stairs.

 You can also create a polyline that represents the current floor line of the 
selected walls. You can then use this polyline to change the floor line of other 
walls.

NOTE To project the floor line to a polyline, draw the polyline first in elevation 
view. For best results, the polyline should be parallel to the wall. The polyline 
does not need to be in the same plane as the wall.

1 Select a wall, right-click, and click Roof/Floor Line ➤ Modify Floor 
Line.

2 Change the floor line of the wall:

3 Press ENTER.

Adding a Gable to the Roof Line of a Wall
Use this procedure to add a gable to the roof line of a wall. You can also add 
a gable on the Roof/Floor Line worksheet on the Properties palette.

NOTE This option is available only if the roof line has not been edited. After 
the roof line changes, you cannot add a gable using this option. To add a gable 

If you want to . . . Then . . .

offset the roof line from the 
current height of the wall

enter o (Offset), and enter an offset distance. 
Enter a negative value to project the roof line 
below the current wall height.

project the roof line to a 
polyline

enter p (Project), and select the polyline.

project the roof line to another 
object, such as a roof or stairs

enter a (Auto-project), and select the object to 
project to.
When projecting to stairs, make sure that the 
bottom riser or the stringer does not create a 
zero-height segment of wall.

generate a polyline of the 
current roof line

enter g (Generate), and select the walls for the 
polyline to be created from.

remove any changes to the roof 
line

enter r (Reset), and select the walls to change.
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to a roof line that has been edited, see “Changing Vertices in the Roof Line or 
Floor Line of a Wall” on page 1802.

1 Select the wall, right-click, and click Roof/Floor Line ➤ Edit in Place.

A temporary profile is created for you to edit the geometry of the Roof 
line.

2 Right-click, and click Add Gable.

If Add Gable is not listed on the menu, the roof line was previously edited.

3 Select the roof line.

Modifying a wall roof line by adding a gable

A third vertex is added to the roof line halfway between the two ends of 
the roof line and eight feet up from the roof line.

4 Continue editing the roof line or the floor line, if needed.

For more information, see “Editing the Roof Line or the Floor Line of a 
Wall” on page 1799.

5 Save or discard the changes:

If you want to . . . Then . . .

restore the roof line to its 
previous shape

click .

save the changes to the roof line

click .
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Adding a Step to the Roof Line or Floor Line of a Wall
Use this procedure to add a step to the roof line or the floor line of a wall. 
You can also add a step on the Roof/Floor Line worksheet on the Properties 
palette.

NOTE This option is available only when the roof line or the floor line has not 
been edited. After the line has been changed, you cannot automatically add a 
step using this option. To add a step to a roof line or a floor line that has been 
edited, see “Changing Vertices in the Roof Line or Floor Line of a Wall” on 
page 1802.

1 Select the wall, right-click, and click Roof/Floor Line ➤ Edit in Place.

A temporary profile is created for you to edit the geometry of the roof line 
or the floor line.

2 Right-click, and click Add Step.

If Add Step is not listed on the menu, the roof line or the floor line was 
previously edited.

3 Select the roof line or the floor line.

Modifying a wall floor line by adding a step

A third vertex is added to the line halfway between the two ends of the 
line and four feet from the line. A step is created from the selected vertex 
to the second vertex.

4 Continue editing the roof line or the floor line, if needed.

For more information, see “Editing the Roof Line or the Floor Line of a 
Wall” on page 1799.
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5 Save or discard the changes:

Editing the Roof Line or the Floor Line of a Wall
Use this procedure to edit the geometry of the roof line or the floor line of a 
wall:

� Add, modify, or remove gables.
� Add, modify, or remove steps.
� Project the roof line or the floor line to a polyline or to other objects, such 

as roofs, roof slabs, slabs, and stairs.
� Create custom roof line or floor line conditions by adding and adjusting 

vertices and edges.
� Reverse the roof line or the floor line of the wall without reversing the wall 

itself.
� Remove all changes to the roof line or the floor line of a wall.

You can also edit the roof line and the floor line on the Roof/Floor Line work-
sheet on the Properties palette. For more information, see “Changing Verti-
ces in the Roof Line or Floor Line of a Wall” on page 1802.

NOTE If you want to project the roof line or the floor line to a polyline, draw 
the polyline before you start this procedure. 

1 Select the wall that has the roof line or floor line you want to change, 
right-click, and click Roof/Floor Line ➤ Edit in Place.

A temporary profile is created for you to edit the geometry of the roof line 
and floor line.

If you want to . . . Then . . .

restore the roof line or the floor 
line to its previous shape

click .

save the changes to the roof line 
or the floor line

click .
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Profile of the roof line and floor line of a wall

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the menu, select the profile, 
and right-click to display the shortcut menu.

2 Edit the profile:

If you want to . . . Then . . .

add a gable to the roof line or 
the floor line

select the profile, right-click, and click Add 
Gable. Select the roof line or the floor line.

add a step to the roof line or the 
floor line

select the profile, right-click, and click Add 
Step. Select the roof line or the floor line.

change the shape of the roof 
line or the floor line

select the profile, and use Move Roof Line, 
Move Floor Line, Vertex, and Edge grips to 
adjust the shape.

add vertices to the roof line or 
the floor line

select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the roof 
line or the floor line

select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.
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NOTE To add a gable or a step to a roof line or a floor line that has been 
edited, first use the Remove option on the shortcut menu to remove an exist-
ing roof line or floor line condition.

3 Save or discard the changes:

Reversing the Roof Line or Floor Line of a Wall
Use this procedure to reverse the conditions applied to the roof line or the 
floor line of a wall. Reversing the roof line or the floor line does not reverse 
the start point and endpoint of the wall.

project the roof line or the floor 
line to a polyline

select the profile, right-click, and click Project 
to Polyline. Select the roof line or the floor 
line, and select the polyline. Press ENTER to 
keep the geometry, or enter y (Yes) to erase it.

project the roof line or the floor 
line to another object, such as a 
stair or a roof

select the profile, right-click, and click Auto 
Project. Select the roof line or the floor line, 
and select the object. 

reverse the roof line or the floor 
line

select the profile, right-click, and click Reverse. 
Select the roof line or the floor line.

restore the roof line to the base 
height of the wall, or restore the 
floor line to the baseline of the 
wall

select the profile, right-click, and click 
Remove. Select the roof line or the floor line.

If you want to . . . Then . . .

restore the roof line and the 
floor line to their shape before 
editing click .

save the changes

click . The wall uses the edited profile 
to define its geometry. 

If you want to . . . Then . . .



1802 | Chapter 25 Walls

Reversing the roof line of a wall

1 Select the wall that has the roof line or floor line you want to change, 
right-click, and click Roof/Floor Line ➤ Edit in Place.

A temporary profile is created for you to edit the geometry of the roof line 
or the floor line.

2 Select the profile, right-click, and click Reverse.

3 Select the roof line or the floor line.

The selected line is reversed; the condition is applied to the opposite end 
of the line. 

4 Save or discard the changes:

Changing Vertices in the Roof Line or Floor Line of a Wall
Use this procedure to perform the following tasks on the Roof/Floor Line 
worksheet on the Properties palette:

� Add, move, or remove vertices in the roof line or the floor line of a wall.
� Add gables or steps to a roof line or steps to a floor line that was previously 

edited by adding vertices that define these conditions.

You can also edit the roof line and the floor line graphically. For more infor-
mation, see “Editing the Roof Line or the Floor Line of a Wall” on page 1799.

1 Double-click the wall you want to change.

If you want to . . . Then . . .

restore the roof line and the 
floor line to their shape before 
editing click .

save the changes

click . The wall uses the edited profile 
to define its geometry. 
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2 Expand Advanced, and expand Worksheets.

3 Select Roof/Floor Line.

4 Select Edit Roof Line, or select Edit Floor Line.

Changing the vertices of a roof line

The active vertex in the illustration changes when you select a different 
line to edit. Any changes you make to the wall are reflected in the illustra-
tion.

5 To add a vertex, click Insert Vertex. Specify the horizontal offset and ver-
tical offset for the new vertex and each offset distance, and click OK.

For more information about specifying the location of a vertex, see “Spec-
ifying Offsets for Roof Line and Floor Line Vertices” on page 1898.

Modifying a roof line of a wall by adding a vertex

6 To move a vertex, select the vertex from the table or the illustration, and 
click Edit Vertex. Specify the horizontal offset and vertical offset for the 
new vertex and each offset distance, and click OK.

For more information about specifying the location of a vertex, see “Spec-
ifying Offsets for Roof Line and Floor Line Vertices” on page 1898.

7 To delete a vertex, select a vertex, and click Delete Vertex.

The selected vertex is deleted, and the line automatically connects the two 
adjacent vertices.
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8 To reverse the roof line or the floor line, click Reverse.

9 Click OK.

Specifying the Materials of Individual Walls

Use this procedure to select a different material for components of an indi-
vidual wall.

To change the materials assigned to all walls of the same wall style, see “Spec-
ifying the Materials of a Wall Style” on page 1876.

NOTE If a material assignment does not determine the display properties of a 
wall component, you can change the properties of the display component as 
described in “Changing the Display Properties of Individual Walls” on 
page 1805.

1 Select the wall you want to change, right-click, and click Edit Object Dis-
play.

2 To verify that the material assignment determines the display properties 
of the component, click the Display Properties tab, select the display rep-

resentation where you want the changes to appear, and click .

3 Click the Layer/Color/Linetype tab, verify that By Material is selected for 
the component, and click OK.

4 Click the Materials tab.

5 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

6 Click OK.
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Changing the Display Properties of Individual 
Walls

In most cases, you want the appearance of walls that belong to the same style 
to be consistent throughout a drawing. To achieve this, you specify the mate-
rial assigned to each wall component or you specify the display properties of 
the walls in each wall style. However, in certain instances, you may need to 
override a display property for an individual wall to achieve a specific result. 
All the display properties that you can specify in wall styles are available for 
individual walls:

� Whether the display properties of wall components are determined by 
material assignments

� The layer, color, and linetype of the display components of the wall
� The hatching used with each component
� The cut plane height and the display of components relative to the cut 

plane
� Other specific wall display information, such as whether complex endcaps 

are displayed and whether the wall is cut around door and window frames

When you change the display properties of an individual wall, the changes 
apply only to that wall. Other walls of the same style are not affected. To 
change the display properties of all walls of a specific wall style, see “Wall 
Styles” on page 1865.

Related Procedures

� Specifying the Layer, Color, and Linetype of a Wall

� Specifying the Hatching for Components of a Wall

� Specifying the Cut Plane Display of a Wall

� Specifying the Display of Other Characteristics of a Wall

Specifying the Layer, Color, and Linetype of a Wall
Use this procedure to change the following display properties of the compo-
nents of an individual wall: 

� Visibility (component is on or off)
� By material (a material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale
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To change these display properties for all walls of the same wall style, see 
“Specifying the Display Properties of a Wall Style” on page 1879.

NOTE If a material assignment determines the properties of a wall display 
component, you can change the properties of the display component by clear-
ing By Material or by overriding the material assignment with a different mate-
rial. For more information, see “Specifying the Materials of Individual Walls” on 
page 1804.

1 Select the wall you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Specifying the Hatching for Components of a Wall
Use this procedure to specify the hatching of the components of an individ-
ual wall. Wall hatching is displayed only in display representations, such as 
Plan, that are used in the Top view (plan view) of a drawing.

To change the hatching for all walls of the same wall style, see “Specifying 
the Hatching for Components of a Wall Style” on page 1881.

NOTE If a material assignment determines the hatching properties of a wall 
component, you can change the hatching of the component by clearing By 
Material or by overriding the material assignment with a different material. For 
more information, see “Specifying the Materials of Individual Walls” on 
page 1804.

1 Select the wall you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.
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3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Hatching tab.

6 Select a component, and click the setting for Pattern.

7 Select the hatching for the component:

8 Click OK.

9 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

10 Click Angle, and enter the angle for the selected pattern.

11 Click Orientation, and specify how the hatching is oriented:

12 Click OK twice.

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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Specifying the Cut Plane Display of a Wall

Use this procedure to specify the properties of one or more cut planes for an 
individual wall. Cut plane display properties apply only to display represen-
tations, such as Plan, that are used in the Top view (plan view) of a drawing.

To better visualize the elements of a wall in plan view, you can create cut 
planes. The main cut plane is where the shrinkwrap and hatching are 
applied. The plan display shows the components and objects in the wall as 
they are displayed at the height of each cut plane.

To change the cut plane display properties for all walls of the same wall style, 
see “Specifying the Hatching for Components of a Wall Style” on page 1881.

1 Select the wall you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Cut Plane tab.

6 To specify the cut plane where shrinkwrap, component boundaries, and 
hatching take effect, enter a value for Cut Plane Height.

7 To show the components above and below the cut plane height, select 
Automatically Choose Above and Below Cut Plane Heights.

8 To specifically define a cut plane, select Manual Above and Below Cut 
Plane Heights, click Add, and enter the height of the new cut plane.

You can click Remove to delete a cut plane that you added.

9 Click OK twice.

If you add a cut plane . . . Then . . .

at a height that is lower than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Below Cut Plane component 
on the Layer/Color/Linetype tab.

at a height that is higher than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Above Cut Plane component 
on the Layer/Color/Linetype tab.
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Specifying the Display of Other Characteristics of a Wall
Use this procedure to specify other display properties for an individual wall, 
such as whether to display complex endcaps, to show door and window 
frames, or whether to show the miter of specific wall components. These dis-
play properties apply only to display representations, such as Plan, that are 
used in the Top view (plan view) of a drawing.

To change these display properties for all walls of the same wall style, see 
“Specifying the Display Properties of a Wall Style” on page 1879.

1 Select the wall you want to change, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Other tab.

6 Select the display properties for the wall:

If you want to . . . Then . . .

display the component lines 
within the wall above the cut 
plane (for example, through a 
window or door in the wall)

select Display Inner Lines Above. Clear this 
option if you do not want to display these 
lines.

display the component lines 
within the wall below the cut 
plane (for example, through a 
window or door in the wall)

select Display Inner Lines Below. Clear this 
option if you do not want to display these 
lines.

turn off lines above a window, 
door, or opening at the cut 
plane

select Hide Lines Below Openings Above Cut 
Plane. Clear this option if you want to display 
the lines.

turn off lines beneath a window 
or an opening at the cut plane

select Hide Lines Below Openings at Cut 
Plane. Clear this option if you want to display 
the lines.

display complex endcaps select Display Endcaps. Clear this option to 
display complex endcaps as a single line.
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7 Click OK twice.

Attaching Notes and Files to a Wall

Use this procedure to enter notes and attach reference files to a wall. You can 
also edit notes and edit or detach reference files from a wall.

1 Double-click the wall.

2 On the Properties palette, click the Extended Data tab.

3 Click the setting for Notes.

4 Enter the note, and click OK.

5 Click the setting for Reference documents, and attach, edit, or detach a 
reference file:

display door openings cutting 
the wall at the outer edge of the 
door frame

select Cut Door Frames. Clear this option if 
you want door openings to cut the wall at the 
inside of the door frame.

display window openings 
cutting the wall at the outer 
edge of the window frame

select Cut Window Frames. Clear this option if 
you want window openings to cut the wall at 
the inside of the window frame.

draw wall components by their 
priority number to control the 
display of a component over 
another component

select Component Draw Order by Priority. 
Clear this option if you want to draw the 
components in the order that they were 
created.

perform a slice of the actual 
three-dimensional (3D) model 
at each cut plane to obtain 
more accurate views of walls 
with sweeps or body modifiers

select Do True Cut. Clear this option if the wall 
does not have sweeps or body modifiers, or if 
they do not change along the height of the 
wall.

display miter lines at wall 
corners for selected wall 
components

select Draw Miter for Components, and select 
each component whose miter lines you want 
to display. 

If you want to . . . Then . . .

attach a reference file
click , select a file, and click OK.

edit the description of a 
reference file

select the file, and click the description. Edit the 
description.

If you want to . . . Then . . .
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6 Click OK twice.

Specifying the Cleanup of Walls

You can control how walls join and clean up with other walls by using 
cleanup groups. Walls must be in the same cleanup group to clean up prop-
erly. By default, walls belong to the Standard cleanup group. You can create 
new wall cleanup groups for specific sets of walls. You can assign walls to a 
cleanup group when you create the walls or after you create the walls. 

Within the same cleanup group, the priority of each wall component deter-
mines how the wall cleans up with the components of the intersecting wall. 
You can control wall cleanup with several features designed for this purpose:

� Specifying a cleanup group and cleanup radius in wall tools for adding 
new walls to a drawing

� Specifying a cleanup group and the cleanup radius for individual walls
� Specifying the priority of each wall component in wall styles or for indi-

vidual walls
� Specifying cleanup settings that apply to the entire drawing to specify 

how close together walls must be to join and clean up (Autosnap radius 
and Cleanup radius)

Related Topics and Procedures

� Cleanup Circles and Wall Graphlines

� Wall Cleanups and Priorities

� Guidelines for Successful Wall Cleanup

� Troubleshooting Wall Cleanups

� Assigning a Different Wall Cleanup Group Definition to Existing Walls

� Specifying Cleanup for Individual Walls

� Overriding the Wall Cleanup Radius

� Overriding Component Priorities

� Cleanup Group Definitions

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If you want to . . . Then . . .
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Cleanup Circles and Wall Graphlines

Cleanup circles and wall graphlines are features of wall objects that are the 

basis for how Autodesk® Architectural Desktop calculates wall cleanup. These 
features appear for walls only in the Graph display representation.

Displaying Cleanup Circles and Wall Graphlines
The Graph display representation shows the cleanup radius and the graph-
line of walls to help you troubleshoot wall cleanup. 

Select a wall, right-click, and click Cleanups ➤ Toggle Wall Graph Display. 

Cleanup circles and graphlines appear on all walls in the drawing. In addi-
tion, when you select the wall, Cleanup Radius grips are displayed at each 
cleanup circle. You can move the grip to increase or decrease the cleanup 
radius. Cleanup circles do not appear if the cleanup radius for the wall is zero.

Graph display representation adds cleanup circles and the wall graphline to the 
display of walls

Cleanup Circles and Wall Graphline
A cleanup circle is located at the start point and the endpoint of each wall 
segment. The center point of each cleanup circle is the start or endpoint of 
the wall graphline.

Cleanup circles and wall graphline

The cleanup radius determines the size of the cleanup circle. You can specify 
a cleanup radius in the wall tools you use to add walls to a drawing. If needed, 
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you can override the default cleanup radius at each end of a wall segment. 
This enables you to adjust the cleanup radius for particular wall styles and for 
individual situations. If the cleanup radius is zero, the cleanup circle is not 
displayed, and walls must touch to cleanup. 

A wall graphline is coincident with the center line of the wall or the wall jus-
tification, depending on the cleanup settings specified for the wall. 

Wall Cleanup Conditions
Walls in the same cleanup group cleanup when one of the following condi-
tions applies:

� The cleanup circle of one wall overlaps the center point of the cleanup cir-
cle of another wall.

� The cleanup circle of one wall overlaps the wall graphline of another wall.
� The wall graphline of one wall intersects the wall graphline of another 

wall.
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Wall cleanup conditions

When walls intersect and clean up properly, a new wall joint is created at the 
intersection of the wall graphlines. The exact location of the wall joint 
depends on the location of the new wall segment endpoint. In many cases, 
the wall joint location does not coincide with the existing wall segment cen-
ter line. The location of the wall joint is based on a weighted average distance 
between wall segment endpoints, as well as the thickness of the wall 
segments.
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Wall joints and wall graphlines at wall intersections

Wall Cleanups and Priorities

Walls with multiple components clean up based on the priority assigned to 
each component and the location of each component within the wall. 
Matching component edges with the same priority are extended or trimmed 
to their intersection points. Components with a higher priority (a low prior-
ity number) cut through components with a lower priority (a high priority 
number).
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Wall cleanup priorities

To identify the default cleanup priorities for the components used in the 
sample wall styles provided with Autodesk Architectural Desktop, see 
“Default Cleanup Priorities of Wall Components” on page 1871.

The software calculates and performs wall cleanups in the following 
sequence:

1 Component information is gathered from the wall graph:

� Endcaps are calculated. Endcaps that do not fit in the section may also 
produce a defect marker. 

� Sides of components are combined with endcaps to produce a compo-
nent profile (like a two-dimensional region).

� When this profile is self-intersecting, the red defect marker is displayed.

2 Adjacent higher priority components are gathered from the wall graph 
from neighboring wall segments.

3 Higher-priority component profiles are subtracted from the lower-priority 
component profiles.

4 Doors, windows, openings, and interferences are cut and/or applied.

5 Shrinkwrap may be calculated and hatching applied. 

A failed shrinkwrap calculation may also result in the defect marker.

6 Graphics are drawn to an output device (for example, the AutoCAD® 
screen, Object Viewer, Osnap stream, explode stream, and a plotter).

7 Solutions are cached for subsequent draw requests until the wall is modi-
fied again.
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Guidelines for Successful Wall Cleanup

Red circles that appear in a drawing when using wall cleanups are defect sym-
bols that indicate that cleanup settings or placement of a wall segment are 
preventing correct cleanup. Here are some recommendations for actions you 
can take to achieve successful wall cleanup:

� Review the wall cleanup radius settings for each wall segment. A good 
starting point is to set the wall cleanup radius equal to half of the wall 
width. However, this may not apply to every situation and you may need 
to adjust the value to achieve the desired effect. 

NOTE A wall segment must be longer than its cleanup radius.

� Use a smaller cleanup radius. A small cleanup radius also makes the graph 
display more readable. The length of the cleanup circle radius should be a 
value that is between one-half the wall width and the wall width.

� Look for very short wall segments. You can find these short segments by 
turning on the Graph display representation. You can fix them by adjust-
ing the baselines or by increasing the cleanup radius.

� Draw walls with center justification on and use an offset to simulate right 
or left justification. Using this method, you can draw very short segments 
and tight wall jogs, provided the appropriate cleanup radius is used.

� Be precise with baselines.

Use the following procedure to verify that the wall segments are inserted at 
a common Z elevation:

1 Freeze all layers except for the designated wall layer.

2 Select all the walls, and double-click one of them.

3 On the Properties palette, expand Basic, and expand Location.

4 Click Additional information.

5 Under Insertion Point, verify that the Z value is consistent.

If *VARIES* is displayed, at least one of the walls is inserted at a different 
Z elevation than the other walls. Change this value to the desired eleva-
tion, and click OK. 

6 Under Normal, verify that the Z value is consistent.

If walls do not clean up properly, even though the Z value for the insertion 
point is the same for all walls on the Location tab, a wall may be at an 
angle. This can occur when the normal Z value varies. You can use the 
Properties window to see both the start and endpoint Z values of the 
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selected walls. In the Properties window, an entry is left blank when the 
values vary.

Assigning a Different Wall Cleanup Group 
Definition to Existing Walls

Use this procedure to change the wall cleanup group assigned to existing 
walls. Assigning different cleanup groups is useful when you want to prevent 
two walls from cleaning up with each other. To create a new cleanup group, 
see “Cleanup Group Definitions” on page 1826.

1 Select the walls to change, and double-click one of them.

2 Expand Basic, and expand General.

3 Select a cleanup group for Cleanup group definition.

Specifying Cleanup for Individual Walls

Use this procedure to specify the following cleanup settings for one or more 
walls:

� Whether the wall cleans up with other walls
� The cleanup group for the wall
� Whether the graphline position corresponds to the center line of the wall 

or to the wall justification
� The cleanup radius for both ends of the wall, or separate values for the 

start and endpoints of the wall

1 Select the walls you want to change, and double-click one of them.

2 Expand Basic, and expand General.

3 Turn wall cleanup on or off:

4 Select a cleanup group definition.

The walls will clean up with other walls that also belong to the cleanup 
group definition that you select.

If you want to . . . Then . . .

turn off wall cleanup so that the 
walls do not clean up with any 
other walls

select No for Cleanup automatically.
If you select this option, you do not need to 
specify other settings.

turn on wall cleanup and specify 
cleanup settings

select Yes for Cleanup automatically, and 
proceed to step 4.
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5 Expand Advanced, expand Cleanups, and expand Cleanup Radius Over-
rides.

6 For Graphline position, select the line that the Graph display representa-
tion uses to represent the graphline of the walls: the center line of the wall 
or the wall justification.

7 Specify the cleanup radius for the walls:

Start and End are based on the direction the wall was drawn. If you enter 
zero for any cleanup radius, the wall graphlines need to touch for the walls 
to clean up with other walls.

Changing the Position of the Wall Graphline

Use this procedure to specify the line used to represent the wall graphline for 
wall cleanups: the center line of the wall or the wall justification. The wall 
graphline appears only when the Graph display representation is turned on. 
The graphline you select does not affect the justification of the wall. How-
ever, it does affect how the wall cleans up with other walls.

1 If the wall graphline is not displayed, select a wall, right-click, and click 
Cleanups ➤ Toggle Wall Graph Display.

2 Select the wall you want to change, right-click, and click Edit Graphline 
Position.

Displaying the Graphline Position grip

3 Select the grip that corresponds to the graphline you want.

If you want to . . . Then . . .

specify the same cleanup radius 
for the start and endpoints of 
the walls

enter a value for Cleanup radius, and verify 
that No is selected for Override start cleanup 
radius and Override end cleanup radius.

specify a cleanup radius for the 
start point of the walls

select Yes for Override start cleanup radius, 
and enter a value for Start cleanup radius.

specify a cleanup radius for the 
endpoint of the walls

select Yes for Override end cleanup radius, and 
enter a value for End cleanup radius.
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Changing the wall graphline to the center line

Overriding the Wall Cleanup Radius

Use this procedure to override the default wall cleanup radius at one end of 
a wall. You can also override the cleanup radius on the Properties palette and 
using the shortcut menu for the selected wall.

1 If the wall graphline is not displayed, select a wall, right-click, and click 
Cleanups ➤ Toggle Wall Graph Display.

Cleanup radius grip

2 Select a cleanup radius grip, and move the grip until the dimension you 
want is displayed.

Changing the cleanup radius at one end of a wall

Overriding Component Priorities

Use this procedure to change the priority of a wall component so that when 
it intersects with another wall, it has higher or lower priority than its coun-
terpart on the other wall. The lower the priority number you enter, the 
higher the priority of the component when the wall intersects with another 
wall.

For the list of default priorities of the wall components used in sample wall 
styles provided with Autodesk® Architectural Desktop, see “Default Cleanup 
Priorities of Wall Components” on page 1871.
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1 Double-click the wall you want to change.

2 Expand Advanced, and expand Style Overrides.

3 Click the setting for Priority overrides.

4 Add or edit a priority override for a wall component:

5 Specify the override settings:

6 Click OK.

Troubleshooting Wall Cleanups

This topic answers common questions associated with wall cleanups.

� Why do some short walls display the defect marker?

� Why do some walls that are close together display the defect marker?

� While using small cleanup radii, wall joints clean up incorrectly or not at 
all. How can I fix this?

� When I try to copy or move doors, windows, and openings from one wall 
to another, the command doesn’t always work. Why?

If you want to . . . Then . . .

add a new priority override
click , and proceed to step 5.

edit a priority override proceed to step 5.

delete a priority override select the priority override you want to delete, 

and click .

If you want to . . . Then . . .

change the component to 
which you assigned the override

select a different component.

specify a priority override at the 
start of the wall

select the component, select At start of wall, 
and enter a value for Priority.

specify a priority override at the 
end of the wall

select the component, select At end of wall, 
and enter a value for Priority.

change the priority of an 
existing override

select the value for Priority, and enter a new 
value.
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� When I closed my drawing, all the wall cleanups looked fine. Now when 
I open the drawing, there are defect markers in the drawing. What causes 
this, and how can I fix it?

� When I work with drawings that were created Release 1 or Release 2 of 
Autodesk® Architectural Desktop, some walls no longer clean up correctly. 
Why?

� How can I get walls to clean up with walls in xref drawings?

� My xref drawing contains copies of walls that are in my host drawing. 
How did this happen?

� I added a wall in an xref drawing and then added a door to the wall. The 
door does not center correctly. What causes this, and how I can correct it?

Why do some short walls display the defect marker?
The cleanup radius is too large. Reduce the cleanup radius of all walls at the 
wall graph joint, or adjust the baselines so that the ends of all graphlines fall 
within the wall graph joint radii.

NOTE This situation can also occur if a door, window, opening, or door/win-
dow assembly is placed too close to the end of the wall and the wall or the 
objects in it use elaborate endcaps. In such cases, there may not be enough 
room for these conditions to be drawn correctly.

Varying wall circle cleanup radii
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Why do some walls that are close together display the defect 
marker?
The cleanup radius is too large. Reduce the cleanup radius of all walls at the 
wall graph joint, or adjust the baselines so that the ends of all graphlines fall 
within the wall graph joint radii.

Adjusting wall segment lengths for correct clean up

While using small cleanup radii, wall joints clean up incorrectly 
or not at all. How can I fix this?
Turn on the Graph display representation and adjust the baselines or increase 
the cleanup radii until the problem is fixed. Also, make sure that there are no 
short wall segments in the wall. These can occur where center lines intersect, 
or when a segment is too short to produce a full profile. Delete the short wall 
segment to fix the cleanup problem.

Adjusting wall cleanup circle radii for correct clean up
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When I try to copy or move doors, windows, and openings from 
one wall to another, the command doesn’t always work. Why?
This situation can occur if the cleanup group for the destination wall does 
not allow objects from walls assigned to other cleanup groups to be copied 
to this wall. This design rule is intended to prevent placing objects in walls, 
such as cubicle partitions, that should not have objects added to them.

You can address this situation in two ways:

� Turn off this design rule in the cleanup group definition. For more infor-
mation, see “Creating a Wall Cleanup Group Definition” on page 1827.

�  Temporarily assign the walls to the same cleanup group, copy or move the 
objects, and then reassign the walls to their correct cleanup groups.

When I closed my drawing, all the wall cleanups looked fine. 
Now when I open the drawing, there are defect markers in the 
drawing. What causes this, and how can I fix it?
Under some circumstances, the order in which walls are cleaned up affects 
the display.

When troubleshooting this condition, select the walls in question, and dou-
ble-click one of them. In the Properties palette, select No for Cleanup auto-
matically, and then select Yes. Try this on different walls to see whether you 
can locate the unstable wall. Usually, adjusting the baseline of the unstable 
wall fixes this problem. For more information about verifying baselines, see 
“Guidelines for Successful Wall Cleanup” on page 1817.

When I work with drawings that were created Release 1 or 
Release 2 of Autodesk® Architectural Desktop, some walls no 
longer clean up correctly. Why?
This situation can occur because walls in earlier releases of the software 
always used the center line as the wall graphline while in the current release, 
you can use the center line or the wall justification for the wall graphline. If 
the cleanup radius for walls is zero, walls that are not center-justified may not 
clean up correctly.

You can correct this situation by changing the wall graphline so that all walls 
use the same graphline. For more information, see “Changing the Position of 
the Wall Graphline” on page 1819.

How can I get walls to clean up with walls in xref drawings?
There are several actions you can take to improve wall cleanup when you 
work with xref drawings that contain walls:
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� Verify the design rules of the cleanup groups used in the xref drawings. If 
the cleanup group in the xref drawing does not allow cleanup with the 
walls in the host drawing, walls in the two drawings do not clean up, even 
when their cleanup groups have the same name. For more information 
about the design rules of cleanup groups, see “Creating a Wall Cleanup 
Group Definition” on page 1827.

� When adding new walls during a RefEdit session, add the existing walls to 
the current working set. Select the Xref cleanup group of the existing walls 
for the walls you are adding. Otherwise, the new walls do not clean up 
with the existing walls until you save changes to the drawings.

� Use the Regenall (Regenerate All) and ObjRelUpdate (Object Relationship 
Update) commands to update the relationships among walls in the draw-
ing, especially if you move or transform walls involving xref drawings, or 
if you undo edits to walls in an xref drawing.

� For more information about xref drawings and wall cleanup, see addi-
tional troubleshooting topics in “Troubleshooting Wall Cleanups” on 
page 1821.

My xref drawing contains copies of walls that are in my host 
drawing. How did this happen?
If you added objects, such as doors or windows, to a wall in the host drawing 
while you had a Refedit session open for an xref drawing, a copy of the 
selected wall is added to the xref drawing. This occurs because any objects 
added during a Refedit session are always added to the xref drawing and not 
to the host drawing. Because the object you added was anchored to a wall, 
the wall is also added to the xref drawing. 

To correct the drawings, review both the host drawing and the xref drawing 
for duplicate objects. Remove the duplicates from the incorrect drawing files. 
Allowing the duplicates to remain can create problems with the cutting of 
walls around doors, windows, door/window assemblies, and openings. Hid-
den line and shaded views are also affected.

To avoid creating duplicate objects in xref drawings, do not add or edit 
objects in the host drawing when a Refedit session is open for an xref draw-
ing. Also, instead of opening a Refedit session, you can open the xref itself, 
and make edits directly. You can then save the xref drawing, and reload the 
updated drawing in the host drawing.

I added a wall in an xref drawing and then added a door to the 
wall. The door does not center correctly. What causes this, and 
how I can correct it?
Some changes that you make during Refedit sessions of xref drawings do not 
take effect until you save the changes to the xref drawing. When you add 
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doors, windows, door/window assemblies, and openings to a new wall in an 
xref drawing, their placement is affected by whether the new wall cleans up 
with other walls in the drawing. Clean up does not occur between walls in 
xref and host drawings until you save the changes in the Refedit session.

For best results, if you add walls during a Refedit session, save and close the 
session before adding objects to those walls. Open a new Refedit session (or 
open the xref drawing directly, outside of the host drawing), verify that the 
walls clean up as you intend them to, and then add objects to the walls.

Cleanup Group Definitions

A wall cleanup group definition is a designation that you can assign to wall 
styles and individual walls to control how intersecting walls clean up. Walls 
that belong to the same cleanup group clean up where they intersect accord-
ing to the priority assigned to each component in each wall. Walls that 
belong to different cleanup groups do not clean up when they meet at cor-
ners or intersections.

Walls that do and do not clean up

Controlling Wall Cleanup through Design Rules
You use the design rules of a cleanup group definition to determine how 
walls assigned that cleanup group cleanup when you Xref them in other 
drawings. The setting for this design rule in the cleanup group definition in 
the xref drawing controls whether those walls clean up with walls in the host 
drawing.

Design rules also determine whether you can move or copy objects from 
walls assigned to other groups to walls assigned to the current cleanup group. 
Preventing copying or moving objects to walls in a certain cleanup group 
helps you avoid inadvertently placing objects in walls that should not con-
tain them.
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Managing Cleanup Group Definitions
To create, edit, copy, or purge cleanup group definitions, you access the Style 
Manager. The Style Manager provides a central location in Autodesk® Archi-
tectural Desktop where you can work with definitions and styles from multi-
ple drawings and templates. For more information about using the Style 
Manager, see “Style Manager”.

Related Procedures

� Creating a Wall Cleanup Group Definition

� Attaching Notes and Files to a Wall Cleanup Group Definition

Creating a Wall Cleanup Group Definition
Use this procedure to create a wall cleanup group definition. A cleanup group 
definition must exist in the drawing before you can assign walls and wall 
styles to the cleanup group.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Wall Cleanup Group Defini-
tions.

3 Create a cleanup group definition:

4 Enter a name for the new cleanup group definition, and press ENTER.

5 Right-click the new cleanup group definition, and click Edit.

6 Click the General tab, and enter a description of the cleanup group.

7 Click the Design Rules tab.

If you want to . . . Then . . .

create a cleanup group 
definition with default 
properties

right-click Wall Cleanup Group Definitions, and click 
New.

create a cleanup group 
definition from an existing 
definition

right-click the cleanup group definition you want to 
copy, and click Copy. Right-click, and click Paste.
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8 Specify the design rules:

9 Click OK twice.

If you want to add notes, files, or documents to a cleanup group defini-
tion, see “Attaching Notes and Files to a Wall Cleanup Group Definition” 
on page 1828.

Attaching Notes and Files to a Wall Cleanup Group Definition
Use this procedure to enter notes and attach reference files to a cleanup 
group definition. You can also edit notes and edit or detach reference files 
attached to the definition.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Wall Cleanup Group Defini-
tions.

3 Select the cleanup group definition that you want to change, right-click, 
and click Edit.

4 Click the General tab.

5 To add a description to the cleanup group definition, enter it for Descrip-
tion.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

If you want to . . . Then . . .

allow walls assigned to this 
cleanup group to clean up 
with walls in a host 
drawing when the current 
drawing is inserted as an 
Xref

Select Allow wall cleanup between host and xref 
drawings. Clear this option if you do not want the 
walls to cleanup with walls in the host drawing.

NOTE The cleanup group definition in the xref 
drawing controls cleanup with walls in the host 
drawing.

allow objects anchored to 
walls assigned to other 
cleanup groups to be 
moved or copied to walls 
assigned to this cleanup 
group

Select Allow objects anchored to walls in other 
cleanup groups to be moved or copied to walls in 
this cleanup group. Clear this option if you do not 
want objects anchored to walls in other cleanup 
groups to be moved or copied to walls assigned to 
this cleanup group.



Adding Objects to Walls | 1829

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

Adding Objects to Walls

When you add doors, windows, window assemblies, and openings to a wall, 
the wall automatically adjusts to accommodate the object and adds endcaps 
where needed. By default, these objects are anchored to the wall. The objects 
remain with the wall if you move it. If you remove an object from a wall, the 
wall repairs itself in the space where the object was located. You can control 
how the objects are anchored to the start or the end of a wall, within the wall 
width, and vertically.

Related Procedures

� Adding a Window to a Wall

� Adding an Opening to a Wall

� Adding a Door to a Wall

� Adding a Door/Window Assembly to a Wall

� Removing Windows, Openings, Doors, or Door/Window Assemblies from 
a Wall

� Anchoring an Object to a Wall

� Detaching Objects from a Wall

Adding a Window to a Wall

Use this procedure to place one or more windows in a wall.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Inserting a window in a wall

1 Select a wall, right-click, and click Insert ➤ Window.

2 Specify the settings for the window.

For more information about adding windows, see “Creating a Window 
with User-Specified Settings” on page 1905.

3 Specify an insertion point along the wall.

4 Continue to place windows in the wall, and press ENTER.

Adding an Opening to a Wall

Use this procedure to place one or more openings in a wall.

Inserting an opening in a wall

1 Select a wall, right-click, and click Insert ➤ Opening.

2 Specify the settings for the opening.

For more information about adding openings, see “Creating an Opening 
with User-specified Settings” on page 1278.
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3 Specify an insertion point along the wall.

4 Continue to place openings in the wall, and press ENTER.

Adding a Door to a Wall

Use this procedure to place one or more doors in a wall.

Inserting a door in a wall

1 Select a wall, right-click, and click Insert ➤ Door.

2 Specify the settings for the door.

For more information about adding doors, see “Creating a Door” on 
page 1004.

3 Specify an insertion point along the wall.

4 Continue to place doors in the wall, and press ENTER.

Adding a Door/Window Assembly to a Wall

Use this procedure to place one or more door/window assemblies in a wall.



1832 | Chapter 25 Walls

Inserting a door/window assembly in a wall

1 Select a wall, right-click, and click Insert ➤ Door/Window Assembly.

2 Specify the settings for the door/window assembly.

3 Specify an insertion point along the wall.

4 Continue to place door/window assemblies in the wall, and press ENTER.

Removing Windows, Openings, Doors, or Door/
Window Assemblies from a Wall

Select the objects you want remove from the wall, and press DELETE. The wall 
repairs itself where the objects were located.

Anchoring an Object to a Wall

Use this procedure to move objects to a different wall by anchoring the 
objects.

 An anchored object is constrained by the wall. You can move the object 
along the wall, but the object does not move from the wall unless you detach 
the object. Objects anchored to walls follow connected wall segments.

The center of the bottom face of the object is anchored to the insertion point 
on the bottom face of the wall, which is midway in the wall width.

NOTE By default, doors, openings, windows, and window assemblies are 
anchored to the walls these objects are added to. 

1 Select the object to attach to the wall, right-click, and click Wall 
Anchor ➤ Set Wall.

2 Select the wall to attach the object to.
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Detaching Objects from a Wall

Use this procedure to detach an object that is anchored to a wall. When you 
detach an object, the object is no longer constrained by the wall and can be 
moved off the wall.

� Select the object to release from the wall, right-click, and click Wall 
Anchor ➤ Release.

The object remains in place but is no longer constrained to the wall. The 
wall no longer cleans up around the object.

Creating Special Conditions and Customized 
Wall Surfaces

Wall sweeps, wall (plan) modifiers, body modifiers, and interference condi-
tions are features that you can use to create special conditions, such as 
chases, and to customize wall surfaces.

Wall Sweeps Created from Profiles
A wall sweep is a wall or a wall component whose shape is extruded horizon-
tally from a profile that was created from a closed polyline. The profile 
“sweeps” along the length of the wall to define the shape of the wall or the 
wall component.

Profile and resulting wall sweep

Wall (Plan) Modifiers Created from Polylines
Wall modifiers use the two-dimensional (2D) geometry of an open polyline 
to customize the shape of a wall or a wall component. To use wall modifiers, 
you draw a polyline in the shape you need and create a wall modifier style 
from the polyline. You can then add wall modifiers of that style to any wall.



1834 | Chapter 25 Walls

Polyline and resulting wall modifier

Body Modifiers Created from 3D Objects
Body modifiers use the three-dimensional (3D) geometry of an object, such 
as a mass element or a mass group, to add to, subtract from, or completely 
replace one component in a wall. If the wall has only one component, the 
body modifier applies to the entire wall. If the wall has multiple components, 
the modifier applies only to the component that you specify. 

Barrel Vault mass element and resulting body modifier subtracted from a wall

Interference Conditions Created from 3D Objects
Interference conditions use the geometry of 3D objects to create custom 
openings or cutouts in walls. You can specify how the interference condition 
is applied to the wall: added to the wall, subtracted to the wall, or ignored.

Interference conditions apply to all wall components that the interfering 
object touches. The wall stops at the interference condition. The way in 
which you apply the interference condition to the wall determines how the 
shrinkwrapping of the wall is affected by the condition in plan view. In 
model views, the interference condition is always subtractive, regardless of 
the shrinkwrapping option you selected.

When you edit the object that acts as the interference condition, the wall 
changes to accommodate the changes to the geometry of the object. For 
example, you can move the interfering object to change its location on the 
wall. 
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A Cylinder mass element added as an additive interference condition

Related Topics

� Working with Wall Sweeps

� Working with Wall Modifiers

� Working with Body Modifiers

� Working with Interference Conditions

Working with Wall Sweeps

A wall sweep is a wall or a wall component whose shape is extruded horizon-
tally from a profile that was created from a closed polyline. The profile 
“sweeps” along the length of the wall to define the shape of the wall.

The height and the width of the polyline you use to create the profile define 
the height and the width of the wall component.The profile is not scaled 
when swept on the wall. The insertion point of the profile becomes the 
lower-left corner of the wall component. 

After you create wall sweeps, you can miter wall sweeps that meet at a corner. 
You can also change how the sweep is applied to the wall:

� You can edit the geometry that defines a sweep.
� You can assign a sweep profile to a different wall component.
� You can adjust the miter angles at each end of a wall that has a 

sweep profile.
� You can remove a sweep profile from a wall or a wall component.

Related Procedures

� Creating a Profile for a Wall Sweep

� Adding a Sweep to a Wall

� Editing the Geometry of a Wall Sweep

� Mitering Walls with Sweeps

� Managing Wall Sweeps
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Creating a Profile for a Wall Sweep
Use this procedure to create a profile from a closed polyline. You can then 
sweep the profile along the length of a wall or a wall component to create a 
wall with a custom shape.

The height and the width of the polyline you use to create the profile define 
the height and the width of the wall component. The profile is not scaled 
when swept on the wall. The insertion point of the profile becomes the 
lower-left corner of the wall component. 

You can also define the shape of a wall sweep as you add it to a wall, using 
the Start from Scratch option. You may find that option easier to use because 
you can define the shape in place on the wall. You may want to separately 
create a profile as described in this procedure if the shape is highly complex 
or contains many arcs.

1 Draw a closed polyline of the shape needed for the resulting wall compo-
nent.

2 Select the polyline, right-click, and click Convert to ➤ Profile Defini-
tion.

3 Specify the insertion point of the profile.

The point you specify becomes the lower-left corner of the wall compo-
nent.

4 Press ENTER.

5 Enter a name for the profile, and click OK.

You can now use the profile as a wall sweep to replace a wall component. 
For more information, see “Adding a Sweep to a Wall” on page 1836.

Adding a Sweep to a Wall
Use this procedure to create a custom wall or a wall component by defining 
its shape from a profile.

You can create the profile as you add it to a wall. However, if the shape you 
need is elaborate and has curved segments, you may find it easier to create 
the profile from a polyline first. You can then add the profile to the wall. For 
more information, see “Creating a Profile for a Wall Sweep” on page 1836.
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Adding a sweep profile to a wall

1 Select the walls to sweep, right-click, and click Sweeps ➤ Add.

2 Select the component to which to apply the sweep.

3 Select the profile to use for the sweep.

If you want to define the sweep after you apply it to the component, select 
Start from scratch, and enter a name for the profile.

Specifying settings for a wall sweep

4 Specify how the sweep is applied to the wall:

If you want to . . . Then . . .

apply existing roof line or floor 
line conditions to the sweep

select Apply Roof/Floor Lines to Sweeps.
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5 Click OK.

TIP To create additional walls with the same sweep condition, select the 
wall with the sweep, right-click, and click Add Selected. Add walls with the 
sweep condition where you need them in the drawing.

Editing the Geometry of a Wall Sweep
Use this procedure to change the shape of a wall component that was defined 
with a wall sweep. You can select a different profile to change the appearance 
of the sweep, or you can edit the current profile. 

If you want to remove a wall sweep, apply the sweep to a different wall com-
ponent, or change how the sweep cleans up with intersecting walls, see 
“Managing Wall Sweeps” on page 1840.

1 Select the wall that has the sweep you want to change, right-click, and 
click Sweeps ➤ Edit Profile in Place.

2 Select a location on the wall where the shape of the sweep will be conve-
nient to edit.

A temporary profile is created for you to edit the geometry of the sweep.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 

use the geometry of the sweep 
to define the roof line and the 
floor line

clear Apply Roof/Floor Lines to Sweeps.

miter the intersection of the 
wall containing the sweep and 
other walls 

select Miter Selected Walls.

prevent mitering the 
intersection of the wall 
containing the sweep and other 
walls

clear Miter Selected Walls. You can miter the 
walls later, if needed. You can also adjust the 
miter angles.

change the geometry of the 
sweep when it is applied to the 
wall

select Continue Editing. For more information 
about editing the profile, see “Editing the 
Geometry of a Wall Sweep” on page 1838.

use the existing geometry of the 
profile to define the sweep

clear Continue Editing.

If you want to . . . Then . . .
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see the editing commands that you expect on the shortcut menu, select the 
profile, and right-click to display the shortcut menu.

3 Edit the profile:

4 Save or discard the changes:

If you want to . . . Then . . .

change the location of the 
sweep

select the Insertion Point grip, and move it to 
the desired position.

change the shape of the 
perimeter of the profile or its 
rings

select the profile, and use grips to adjust the 
shape.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace an existing ring of the 
profile with new geometry

select the profile, right-click, and click Replace 
Ring. Select the ring to replace, and select the 
new geometry. Press ENTER to keep the 
geometry, or enter n (No) to erase it.

add a ring to the profile to 
subtract an area from the profile

draw the linework in place on the temporary 
profile. Select the profile, right-click, and click 
Add Ring. Select the geometry to define the 
ring. Press ENTER to keep the geometry, or 
enter y (Yes) to erase it.

remove a ring from the profile select the profile, right-click, and click Remove 
Ring. Select the ring to remove, and press 
ENTER. This option does not appear if the 
profile has only one ring.

If you want to . . . Then . . .

restore the sweep to its original 
shape

click .
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Mitering Walls with Sweeps
Use this procedure to miter intersecting walls whose shape is defined by a 
wall sweep.

NOTE If you miter the end of walls, no endcaps are drawn.

1 Select a wall with a sweep that you want to miter, right-click, and click 
Sweeps ➤ Miter.

2 Select the second wall.

To adjust the angles of the mitered walls, see “Managing Wall Sweeps” on 
page 1840.

Managing Wall Sweeps
Use this procedure to edit or remove a wall sweep from an individual wall. 
You can change the component the sweep is applied to. You can also change 
the miter angles at each end of the sweep and the offsets in the wall.

1 Double-click the wall you want to change.

2 On the Properties palette, expand Advanced, and expand Worksheets.

3 Select the setting for Sweeps.

save the changes to the current 
profile

click .
The sweep uses the edited profile to define its 
geometry. Any other objects or styles that use 
this profile are also updated with the edited 
geometry.

save the changes to a new 
profile

select the profile, right-click, and click Save as 
New Profile. Enter a name for the new profile, 
and click OK.
The sweep uses the new profile to define its 
geometry. Other styles or objects that use the 
original profile are not affected.

If you want to . . . Then . . .
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4 Select a wall sweep, and change its settings:

5 Click OK.

Working with Wall Modifiers

Wall modifiers (also called plan modifiers) use the two-dimensional (2D) 
geometry of an open polyline to customize the shape of a wall or a wall com-
ponent. To use wall modifiers, you draw a polyline in the shape you need and 
create a wall modifier style from the polyline. You can then add wall modifi-
ers of that style to any wall. A wall can have more than one wall modifier 
attached to it.

Placing a Wall Modifier on a Wall
You specify the placement of a wall modifier, including its vertical and hori-
zontal position and its depth. The wall modifier can be added at the drawn 
size of the polyline or scaled to a specific size. The wall modifier is then 
extruded vertically along the wall surface. 

You can add the wall modifier to one or both sides of the wall. When you 
select the face, you can also offset the wall modifier from the opposite face 
to create a bump-out, such as for pipe chases or interior columns.

If you want to . . . Then . . .

change the profile used to 
define the geometry of the 
sweep

select a different profile for Profile.

apply the sweep to a different 
wall component

select a different component for Component.

change the miter angles at each 
end of the wall

enter different values for Start Miter and End 
Miter.

offset the sweep within the wall enter a value for Offset Within.

vertically offset the sweep enter a value for Offset Vertical.

delete the sweep from the wall 
component click .
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Applying wall modifiers to a wall

Editing a Wall Modifier
After placing a wall modifier, you can adjust its placement, or assign the 
modifier to a different wall component. You can also edit the geometry of the 
wall modifier, and save the changes to the current wall modifier style or to a 
new style.

Display Properties and Materials for Wall Modifiers
Wall modifiers take on the material assignment and the display properties of 
the wall component they are assigned to. This enables you to use the same 
wall modifier on different types of walls.

Wall Modifier Styles
You save the geometry of a wall modifier as a wall modifier style. You can cre-
ate the style when you add the wall modifier to a wall. You can also create a 
wall modifier first and then apply it to walls as needed.

To create, edit, copy, or purge wall modifier styles, you access the Style Man-

ager. The Style Manager provides a central location in Autodesk® Architec-
tural Desktop to work with styles from multiple drawings and templates. For 
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more information about using the Style Manager, see “Style Manager” on 
page 531.

Related Topics and Procedures

� Converting a Polyline to a Wall Modifier

� Adding an Existing Wall Modifier to a Wall

� Editing the Geometry of a Wall Modifier

� Changing the Horizontal and Vertical Offsets of a Wall Modifier

� Adjusting the Placement of a Wall Modifier

� Removing Wall Modifiers

� Creating a Wall Modifier Style

� Attaching Notes or Files to a Wall Modifier Style

Converting a Polyline to a Wall Modifier
Use this procedure to create a wall modifier from an open polyline. You can 
draw the polyline in the location for the wall modifier, or you can project the 
modifier you create to the wall. The polyline cannot be closed.

The wall modifier you create is added to the selected wall and is also saved as 
a wall modifier style that you can apply to other walls.

Converting a polyline to a wall modifier
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1 Draw the polyline in the shape of the wall modifier.

2 Select a wall to which you want to apply a wall modifier, right-click, and 
click Plan Modifiers ➤ Convert Polyline to Wall Modifier.

3 Select the polyline.

4 Enter y (Yes) to erase the selected polyline, or enter n (No) to keep the 
polyline in the drawing.

5 Enter a name for the wall modifier style created from the polyline, and 
click OK.

6 Select the wall component to which the wall modifier applies.

7 To offset the opposite face of the selected component in the shape of the 
wall modifier, select Offset Opposite Face.

8 Specify the vertical position of the modifier on the wall component:

Enter a negative offset value to specify a location toward the ground.

If you want to . . . Then . . .

specify the beginning height of 
the wall modifier

enter a value for Start Elevation Offset, and 
specify whether the offset occurs from the wall 
top, the wall base height, the wall baseline, or 
the wall bottom.

specifying the ending height of 
the wall modifier

enter a value for End Elevation Offset, and 
specify whether the offset occurs from the wall 
top, the wall base height, the wall baseline, or 
the wall bottom.
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Placing a wall modifier offset from the wall start point, the wall bottom, and the 
wall top

9 Click OK.

Adding an Existing Wall Modifier to a Wall

Use this procedure to add a wall modifier of an existing wall modifier style to 
a wall. You can apply the modifier to one or both sides of the wall or the com-
ponent. The left and right sides of the wall are determined from the start and 
endpoints of the wall. 
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Placing a wall modifier offset from the wall start point, the wall bottom, and the wall 
top

1 Select the wall to which you want to apply a wall modifier, right-click, and 
click Plan Modifiers ➤ Add.

2 Select the start point for the wall modifier. 

After you select the first point, a temporary line is displayed to show you 
the length of the modifier.

3 Select the endpoint for the modifier.

4 Select the side of the wall to draw the modifier.

5 Enter the depth for the wall modifier.

6 Select the wall modifier style.

7 Select the name of the component to apply the modifier to.

8 To offset the opposite face of the selected component in the shape of the 
wall modifier, select Offset Opposite Face.
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Offsetting a wall modifier from the opposite face of a wall component

9 Specify the vertical position of the modifier on the wall component:

Enter a negative offset value to specify a location toward the ground.

10 Click OK.

After you add a wall modifier, you can edit its geometry or adjust its place-
ment.

Editing the Geometry of a Wall Modifier
Use this procedure to edit the geometry of a wall modifier that is applied to 
a wall. You can edit the vertices and edges of the wall modifier or replace the 
geometry with that of another polyline. You can save the changes to the cur-
rent wall modifier style or to a new style.

To move a wall modifier horizontally or change the vertical offsets of a wall 
modifier, see “Changing the Horizontal and Vertical Offsets of a Wall Modi-
fier” on page 1849.

1 Select the wall that has the wall modifier you want to change, right-click, 
and click Plan Modifiers ➤ Edit in Place.

2 If prompted that the modifier is not drawn to size, click Yes.

A temporary profile is created for you to edit the geometry of the wall 
modifier. If the wall contains multiple wall modifiers, a profile is created 
for each wall modifier.

If you want to . . . Then . . .

specify the beginning height of 
the wall modifier

enter a value for Start Elevation Offset, and 
specify whether the offset occurs from the wall 
top, the wall base height, the wall baseline, or 
the wall bottom. 

specifying the ending height of 
the wall modifier

enter a value for End Elevation Offset, and 
specify whether the offset occurs from the wall 
top, the wall base height, the wall baseline, or 
the wall bottom.
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NOTE After you perform an editing task from the shortcut menu, you may 
need to select a profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select a 
profile, and right-click to display the shortcut menu.

3 Edit the profile:

If you want to . . . Then . . .

change the shape of the 
perimeter of the profile

select the profile, and use grips to adjust the 
shape.

hide one or more edges of the 
profile (plan view only)

select the profile, right-click, and click Hide 
Edges. Select the edges you want to hide, and 
press ENTER.

display an edge that you hid select the profile, right-click, and click Show 
Edges. Select the edges you want to show, and 
press ENTER.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace a profile with new 
geometry

select the profile, right-click, and click Replace 
Modifier. Select the modifier to replace, and 
select a polyline to define the new geometry. 
Press ENTER to keep the polyline in the 
drawing, or enter y (Yes) to erase it. The start 
and endpoints of the new polyline must be the 
same as those for the original wall modifier.

remove a wall modifier select the profile, right-click, and click Remove 
Modifier. If the wall has multiple wall 
modifiers, select the wall modifier to remove, 
and press ENTER. 



Creating Special Conditions and Customized Wall Surfaces | 1849

4 Save or discard the changes:

Changing the Horizontal and Vertical Offsets of a Wall 
Modifier
Use this procedure to change the horizontal position of a wall modifier 
applied to a wall, or to change its vertical position on a wall.

1 Select the wall that has the wall modifier you want to change, right-click, 
and click Plan Modifiers ➤ Edit in Place.

2 If prompted that the modifier is not drawn to size, click Yes.

A temporary profile is created for you to edit the geometry of the wall 
modifier. If the wall contains multiple wall modifiers, a profile is created 
for each wall modifier.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select a profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select a 
profile, and right-click to display the shortcut menu.

If you want to . . . Then . . .

restore the wall modifier to its 
original shape

select the profile, and click .

save the changes to the current 
wall modifier style

select the profile, and click .
The wall modifier and the wall modifier style 
use the edited profile to define its geometry. 
Any other walls that use this wall modifier style 
are also updated with the edited geometry.

save the changes to a new wall 
modifier style

select the profile, right-click, and click Save as 
New Wall Modifier Style. Enter a name for the 
new wall modifier, and click OK.
The wall modifier uses the new style to define 
its geometry. Other walls that use the original 
style are not affected.
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3 Change the placement of the wall modifier:

4 If necessary, continue editing the wall modifier as described in “Editing 
the Geometry of a Wall Modifier” on page 1847.

5 Save or discard the changes:

If you want to . . . Then . . .

move the wall modifier 
horizontally along the wall

select the Move grip, and move the grip to 
reposition the wall modifier. After you select 
the grip, you can also enter a value to move 
the wall modifier a specified distance.

position the wall modifier 
relative to the top of the wall

select an isometric view. Select the Offset from 
top of wall grip, and move the grip to 
reposition the wall modifier. After you select 
the grip, you can also enter a value to move 
the wall modifier a specified distance from the 
top of the wall.

position the wall modifier 
relative to the bottom of the 
wall

select an isometric view. Select the Offset from 
bottom of wall grip, and move the grip to 
reposition the wall modifier. After you select 
the grip, you can also enter a value to move 
the wall modifier a specified distance from the 
bottom of the wall.

If you want to . . . Then . . .

restore the wall modifier to its 
original position

select the profile, and click .

save the changes to the current 
wall modifier style

select the profile, and click 
The wall modifier and the wall modifier style 
use the edited profile to define its geometry. 
Any other walls that use this wall modifier style 
are also updated with the edited geometry.

save the changes to a new wall 
modifier style

select the profile, right-click, and click Save as 
New Wall Modifier Style. Enter a name for the 
new wall modifier, and click OK.
The wall modifier uses the new style to define 
its geometry. Other walls that use the original 
style are not affected.
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Adjusting the Placement of a Wall Modifier
Use this procedure to adjust the placement of a wall modifier that you added 
to a wall. You can also add or remove wall modifiers using this procedure. You 
can also graphically adjust the placement of a wall modifier. For more infor-
mation, see “Changing the Horizontal and Vertical Offsets of a Wall Modi-
fier” on page 1849.

To edit the shape of a wall modifier, see “Editing the Geometry of a Wall 
Modifier” on page 1847.

Placing a wall modifier offset from the wall start point, the wall bottom, and the wall 
top 

1 Double-click the wall that has the modifier you want to change.

2 On the Properties palette, expand Advanced, and expand Worksheets.

3 Select the setting for Plan Modifiers.

4 Under Style, select the wall modifier you want to change.

5 If needed, select a different modifier style or component name, and spec-
ify which sides to apply the modifier to. 

6 Enter a value for Start Position Offset and specify whether the offset occurs 
from the wall start point, the wall endpoint, or the midpoint of the wall.



1852 | Chapter 25 Walls

These settings specify the start point of the modifier along the length of 
the wall. You can enter a negative value to specify an offset in the reverse 
wall direction.

7 Edit the vertical position of the modifier on the wall component:

Enter a negative offset value to specify a location toward the ground.

8 Edit settings to control the size and placement of the modifier:

9 To remove a modifier, select the modifier, and click .

10 Click OK.

If you want to . . . Then . . .

specify the beginning height of 
the wall modifier

enter a value for Start Elevation Offset, and 
specify whether the offset occurs from the wall 
top, the wall base height, the wall baseline, or 
the wall bottom.

specifying the ending height of 
the wall modifier

enter a value for End Elevation Offset, and 
specify whether the offset occurs from the wall 
top, the wall base height, the wall baseline, or 
the wall bottom.

If you want to . . . Then . . .

place the modifier at the size it 
was defined in the modifier style

select Use Drawn Size.

specify the length and the 
depth of the modifier on the 
wall

clear Use Drawn Size, and enter values for 
Length and Depth.

mirror the modifier in the X 
direction

select Mirror X.

mirror the modifier in the Y 
direction

select Mirror Y.

measure the modifier to the 
center of the wall

select Measure to Center.
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Removing Wall Modifiers
Use this procedure to remove a wall modifier from an individual wall or a 
wall component.

NOTE If you offset the modifier to the opposite face of the wall or the wall 
component when you applied the modifier, you must remove the wall modifier 
from each face.

1 Select the wall that has the wall modifier you want to remove, right-click, 
and click Plan Modifiers ➤ Remove.

2 Select the modifier.

3 Enter y (Yes) to create a polyline in the shape of the modifier, or enter n if 
you do not want to create a polyline.

Creating a Wall Modifier Style
Use this procedure to create a wall modifier style from a polyline. The shape 
of the polyline defines the shape of the wall modifier. After you create the 
style, you can add it to a wall or a component of a wall. To create a wall mod-
ifier style and apply it to a wall at the same time, see “Converting a Polyline 
to a Wall Modifier” on page 1843.

To edit a wall modifier style, add the wall modifier to a wall, and then edit 
the geometry of the wall modifier. For more information, see “Adding an 
Existing Wall Modifier to a Wall” on page 1845 and “Editing the Geometry 
of a Wall Modifier” on page 1847.

1 Draw an open polyline in the shape you want to use for the wall modifier. 

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects.

4 Right-click Wall Modifier Styles, and click New.

5 Enter a name for the new style.

6 Right-click the new style, and click Set From.

7 Select the polyline.

8 Click OK.

Attaching Notes or Files to a Wall Modifier Style
Use this procedure to enter notes and attach reference files to a wall modifier 
style. You can also edit notes and edit or detach reference files attached to the 
style.

1 On the Format menu, click Style Manager.
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2 Expand Architectural Objects, and expand Wall Modifier Styles.

3 Right-click the wall modifier style that you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

Working with Body Modifiers

Body modifiers use the three-dimensional (3D) geometry of an object, such 
as a mass element or a mass group, to add to, subtract from, or completely 
replace one component in a wall. If the wall has only one component, the 
body modifier applies to the entire wall. If the wall has multiple components, 
the modifier applies only to the component that you specify. 

If you add the body modifier to a wall component, or use a body modifier to 
replace the component, the body modifier uses the material assignment and 
display properties of the wall component.

After you create a body modifier from an object, you can delete the original 
object. However, if you have created a complex object, such as a mass group 
comprising many mass elements, you may want to retain the object in the 
drawing until you are sure you have the results you want for the wall.

Related Procedures

� Adding a Body Modifier to a Wall

� Subtracting a Body Modifier from a Wall

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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� Replacing a Wall with a Body Modifier

� Managing Body Modifiers

� Restoring a Body Modifier to a Mass Element

Adding a Body Modifier to a Wall
Use this procedure to create a body modifier and add it to a wall. You can 
apply the modifier to a single-component wall, or to a component in a multi-
component wall.

You can create a three-dimensional (3D) body modifier from a mass element, 
a mass group, or any other AEC object with mass. You can also create body 
modifiers from ACIS solids or blocks that form 3D bodies. You must place the 
object in the location you want in the drawing before defining the object as 
a body modifier.

Adding a body modifier to a wall component

1 Place the object in the location where you want to add the body modifier 
to the wall.

2 Select the wall to which you want to add the body modifier, right-click, 
and click Body Modifiers ➤ Add.

3 Select the object to add to the wall.

4 Select the wall component to add the object to.
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5 Select Additive or Additive - Cut Openings for Operation.

6 Enter a description for the body modifier.

7 Select Erase Selected Object(s) if you do not want to keep the original 
object, or clear this option to keep the object in the drawing.

8 Click OK.

Subtracting a Body Modifier from a Wall
Use this procedure to create a three-dimensional (3D) body modifier and sub-
tract it from a wall. You can apply the modifier to a single-component wall, 
or to a component in a multi-component wall.

You can create a body modifier from a mass element, a mass group, or any 
other AEC object with mass. You must place the object in the location you 
want in the drawing before defining the object as a body modifier.

Subtracting a body modifier from a wall component

1 Place the object in the location where you want to subtract the body mod-
ifier from the wall.

2 Select the wall to which you want to add the body modifier, right-click, 
and click Body Modifiers ➤ Add.

3 Select the object to subtract from the wall.

4 Select the wall component to subtract the object from.
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5 Select Subtractive for Operation.

6 Enter a description for the body modifier.

7 Select Erase Selected Object(s) if you do not want to keep the original 
object, or clear this option to keep the object in the drawing.

8 Click OK.

Replacing a Wall with a Body Modifier
Use this procedure to create a three-dimensional (3D) body modifier and 
replace a wall or a wall component with the modifier. You can apply the 
modifier to a single-component wall, or to a selected component in a multi-
component wall.

You can create a 3D body modifier from a mass element, a mass group, or any 
other AEC object with mass. You must place the object in the location you 
want in the drawing before defining the object as a body modifier.

Replacing a wall component with a body modifier

1 Place the object in the location where you want to replace the wall with 
the body modifier.

2 Select the wall to which you want to replace with the body modifier, right-
click, and click Body Modifiers ➤ Add.

3 Select the object to replace the wall or wall component.



1858 | Chapter 25 Walls

4 Select the wall component you want the object to replace.

5 Select Replace for Operation.

6 Enter a description for the body modifier.

7 Select Erase Selected Object(s) if you do not want to keep the original 
object, or clear this option to keep the object in the drawing.

8 Click OK.

Editing the Geometry of a Body Modifier
Use this procedure to edit the shape of a body modifier that is attached to a 
wall. You can edit the body using grips to edit faces, using Boolean com-
mands to add or remove other objects from the body modifier, and other 
editing commands to change its shape.

1 Select the wall that has the body modifier you want to change, right-click, 
and click Body Modifiers ➤ Edit in Place.

A temporary mass element is created for you to edit the geometry of the 
body modifier. If the wall contains multiple body modifiers, a mass ele-
ment is created for each body modifier. If object was not originally a mass 
element (for example, if you used a slab as a body modifier), the object 
becomes a temporary Free Form mass element with faces that you can 
edit.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select a profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select a 
profile, and right-click to display the shortcut menu.

2 Edit the body modifier:

If you want to . . . Then . . .

change the shape of a body 
modifier that is a Free Form 
mass element

select the body modifier. Select a Face grip to 
activate edge grips for the face. Move the 
grips to the desired locations. Continue 
editing other faces in the same manner.

change the shape of a body 
modifier that is a conventional 
mass element

select the body modifier. Select grips and 
move them to change the shape of the body 
modifier. The grips that are available depend 
on the type of mass element used as a body 
modifier and the current view direction.



Creating Special Conditions and Customized Wall Surfaces | 1859

3 Save or discard the changes:

add an object to a body 
modifier

place the object in the location where it is 
needed. Select the body modifier, right-click, 
and click Boolean ➤ Union. Select the object, 
and press ENTER. Enter y (Yes) to keep the 
object in the drawing, or press ENTER to erase 
it.

subtract an object from a body 
modifier

place the object in the location where it is 
needed. Select the body modifier, right-click, 
and click Boolean ➤ Subtract. Select the 
object, and press ENTER. Enter y (Yes) to keep 
the object in the drawing, or press ENTER to 
erase it.

create a body modifier that is 
the intersection of the original 
body modifier with another 
object

place the object in the location where it is 
needed. Select the body modifier, right-click, 
and click Boolean ➤ Intersect. Select the 
object, and press ENTER. Enter y (Yes) to keep 
the object in the drawing, or press ENTER to 
erase it.

trim a body modifier select the body modifier, right-click, and click 
Trim. Specify the points that define the trim 
plane, and select the side of the body modifier 
to be trimmed. The trimmed body modifier is 
converted to a Free Form mass element.

divide the face of a body 
modifier into two faces

select the body modifier, right-click, and click 
Split Face. Specify the points that define the 
edge created by splitting the faces.

join two faces that are on the 
same plane into a single face

select the body modifier, right-click, and click 
Join Faces. Select the edge that separates the 
coplanar faces.

remove a body modifier select the object that forms the body modifier, 
and press DELETE.

If you want to . . . Then . . .

restore the body modifier to its 
original shape

select the body modifier, and click .

If you want to . . . Then . . .
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Managing Body Modifiers
Use this procedure to edit or remove three-dimensional (3D) body modifiers 
from an individual wall. You can change the component the body modifier 
is added to and select a different operation. You can also enter or edit the 
descriptions of body modifiers.

NOTE To remove a body modifier from a wall component and restore the 
modifier as a mass element that you can edit or apply to other walls, see “Restor-
ing a Body Modifier to a Mass Element” on page 1861.

1 Double-click the wall you want to change.

2 Expand Advanced, and expand Worksheets.

3 Click the setting for Body modifiers.

4 Select a body modifier, and change its settings:

save the changes to the body 
modifier

select the body modifier, and click . The 
body modifier uses the edited mass element to 
define its geometry. 

If you want to . . . Then . . .

apply the body modifier to a 
different wall component

select a different component for Component.

change the operation used to 
apply the body modifier to the 
wall

select a different operation for Operation:
� Select Additive or Additive - Cut Openings 

to add the body modifier to the wall 
component.

� Select Subtract to subtract the shape of 
the body modifier from the wall 
component.

� Select Replace to replace the wall 
component with the body modifier.

delete the body modifier from 
the wall component select the body modifier, and click .

enter a description of the body 
modifier

click Description, enter text, and press ENTER.

If you want to . . . Then . . .
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5 Click OK.

Restoring a Body Modifier to a Mass Element
Use this procedure to remove a body modifier from a wall and add it to the 
drawing as a mass element. Restoring a body modifier to a mass element 
enables you to modify the shape as a mass element and then add it to the 
wall again as a body modifier. You can also restore the body modifier to a 
mass element while leaving the body modifier still applied to the wall. This 
is useful if you want to create other walls with the same shape.

If the object used to create the body modifier was a conventional mass ele-
ment, it is restored to that mass element. For example, a Gable mass element 
is restored as a Gable mass element. However, if the body modifier was cre-
ated from another object, such as a slab, or was edited using Boolean opera-
tions or face editing commands, the body modifier is restored as a Free Form 
mass element.

1 Select the walls you want to change, right-click, and click Body 
Modifiers ➤ Restore.

NOTE This procedure restores all body modifiers attached to a wall.

2 Create mass elements from the body modifiers:

Working with Interference Conditions

Interference conditions use the geometry of three-dimensional (3D) objects 
to create custom openings or cutouts in walls. You can specify how the inter-
ference condition is applied to the shrinkwrapping of a wall: added to the 
wall, subtracted to the wall, or ignored.

If you want to . . . Then . . .

create mass elements from the 
body modifiers while keeping 
the body modifiers attached to 
the wall

press ENTER.

remove all body modifiers from 
the wall, and create mass 
elements from their shapes

enter y (Yes), and press ENTER.
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How Interference Conditions Affect the Display of Walls
Unlike wall modifiers and body modifiers, which apply to a selected wall 
component, interference conditions apply to all wall components that the 
interfering object touches. The wall stops at the interference condition. The 
way in which you apply the interference condition to the wall determines 
how the shrinkwrapping of the wall is affected by the condition in plan view:

� Add the interference condition to include the condition in the shrink-
wrapping.

� Subtract the interference condition to exclude the object from the shrink-
wrapping.

� Ignore the interference condition to draw the shrinkwrapping as if the 
object were not there. You also use the ignore option to add interference 
conditions applied to one wall to subsequent walls.

In model views, the interference condition is always subtractive, regardless 
of the shrinkwrapping option you selected.

Editing Interference Conditions
When you edit the object that acts as the interference condition, the wall 
changes to accommodate the changes to the geometry of the object. For 
example, you can move the interfering object to change its location on the 
wall. Moving the object off the wall does not remove the interference condi-
tion for the object. 
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You can also change how interference conditions are applied to a wall, and 
you can delete interference conditions.

Related Procedures

� Adding an Interference Condition

� Removing an Interference Condition

� Managing Wall Interference Conditions

Adding an Interference Condition
Use this procedure to place objects, such as mass elements, in walls to create 
custom openings or cutouts in the wall. An example is a column grid struc-
ture where columns are connected by walls.

When you define the interference condition, you specify how the wall 
shrinkwrapping in plan views is affected by the interfering object. You can 
specify that the object be added to the wall, subtracted from it, or ignored. 
The option you select affects the wall only in plan views. In model display 
representations, interference is always subtracted from a wall, regardless of 
the option you select in this procedure.

NOTE If you want to apply the same object as the interference condition for 
multiple walls, such as walls that meet at a corner, use the ignore option for sub-
sequent walls after the first wall. In plan views, the effect is additive for all the 
walls to which you apply the interference condition.

The shrinkwrap display component must be turned on in the display prop-
erties of the wall or the wall style for interference to be visible. In most sam-

ple wall styles provided with Autodesk® Architectural Desktop, shrinkwrap is 
turned on in plan display representations. For more information about spec-
ifying shrinkwrapping for a wall style, see “Specifying the Display Properties 
of a Wall Style” on page 1879.

1 Place the object in the location where you want to specify the interference 
condition.

2 Select the wall you want to change, right-click, and click Interference 
Condition ➤ Add.

3 Select walls affected by the interference condition, and press ENTER.

4 Select the object intersecting the wall, and press ENTER.
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5 Specify how shrinkwrapping in plan view is applied to the interference 
condition:

Removing an Interference Condition
Use this procedure to remove an object that was added to a wall as an inter-
ference condition. 

1 Select the walls you want to change, right-click, and click Interference 
Condition ➤ Remove.

2 Select one or more objects to remove, and press ENTER.

3 Enter r (Remove) to continue removing interference conditions from 
other walls, or press ENTER to end the command.

Managing Wall Interference Conditions
Use this procedure to change the shrinkwrap effect for an interference con-
dition, or to remove an interference condition from a wall.

1 Double-click a wall with interference conditions.

2 On the Properties palette, expand Advanced, and expand Worksheets.

3 Click the setting for Interference conditions.

4 Select an interference condition.

5 In the Shrinkwrap Effect column, specify the way shrinkwrap is applied to 
the interference object:

If you want to . . . Then . . .

add the interference 
condition to the 
shrinkwrapping

enter a (Additive).

take the object shape out 
of the shrinkwrapping

enter s (Subtractive).

ignore the object when 
shrinkwrapping is applied

enter i (Ignore).

If you want to . . . Then . . .

add the interference 
condition to the 
shrinkwrapping

select Add.
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6 To delete the interference condition, select the condition, and click .

7 Click OK.

Wall Styles

Wall styles control the appearance of wall objects. Using wall styles, you can 
specify dimensions, components, endcaps, materials, and other characteris-
tics to create new types of walls, such as concrete walls, masonry walls, and 

brick cavity walls. Catalogs provided with Autodesk® Architectural Desktop 
include sample wall styles for common wall types, such as concrete walls 
with footings or furring, CMU and brick cavity walls, and various stud parti-
tion walls.

Wall styles that use various components

Using Materials in Wall Styles
You can use materials to control how walls of each style are displayed in a 
drawing. You assign materials to the wall components in the style. The com-
ponents are then displayed using the display properties of the assigned mate-
rials.

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for common design purposes. You can use these materials, modify them 

take the object shape out 
of the shrinkwrapping

select Subtract.

ignore the object when 
shrinkwrapping is applied

select Ignore.

If you want to . . . Then . . .
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for your project requirements, and define new materials. For more informa-
tion about materials and how to define them, see “Materials” on page 491.

Creating Tools from Wall Styles
You can create a wall tool from any wall style. You can drag the style from the 
Style Manager onto a tool palette. You can then specify default settings for 
any walls created from the tool. For more information, see “Creating a Wall 
Tool” on page 1766.

Managing Wall Styles
To create, edit, copy, or purge styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop 
where you can work with styles from multiple drawings and templates. For 
more information about using the Style Manager, see “Style Manager” on 
page 531.

Related Topics and Procedures

� Creating a Wall Style

� Specifying the Endcap Styles Used in a Wall Style

� Specifying the Components of a Wall Style

� Specifying the Materials of a Wall Style

� Specifying the Display Properties of a Wall Style

� Adding Classifications to a Wall Style

� Attaching Notes and Files to a Wall Style

Creating a Wall Style

Use this procedure to create a wall style. By copying an existing style, you can 
create a style using default style properties. After you create the style, you edit 
the style properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and expand Wall Styles.

3 Create a wall style:

If you want to . . . Then . . .

create a style with default 
properties

right-click Wall Styles, and click New.
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4 Enter a name for the new wall style, and press ENTER.

5 To edit the new wall style, right-click the style, and click Edit:

6 When you finish specifying the properties of the wall style, click OK.

7 If you want to assign the style to a wall tool, drag the style from the Style 
Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Wall Tool” on page 1766.

8 Click OK.

create a style from an 
existing style

right-click the wall style you want to copy, and click 
Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

specify the endcap styles 
used for wall openings and 
the ends of walls of the 
style

see “Specifying the Endcap Styles Used in a Wall 
Style” on page 1868.

specify the structural 
components of the style

see “Specifying the Components of a Wall Style” on 
page 1868.

specify materials for the 
components of the style

see “Specifying the Materials of a Wall Style” on 
page 1876.

specify wall hatching, cut 
plane properties, and other 
display properties of the 
style

see “Specifying the Display Properties of a Wall 
Style” on page 1879.

add classifications to a wall 
style

see “Adding Classifications to a Wall Style” on 
page 1884.

add notes and files to the 
style

see “Attaching Notes and Files to a Wall Style” on 
page 1885.

If you want to . . . Then . . .
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Specifying the Endcap Styles Used in a Wall Style

Use this procedure to specify the endcap styles used in a wall style. You can 
select one wall endcap style that is applied to the start and end of walls of this 
wall style. You can specify opening endcap styles that are applied separately 
to doors, openings, windows, and door/window assemblies that are added to 
walls of this wall style.

For more information about creating wall endcap styles and opening endcap 
styles, see “Wall Endcap Styles” on page 1886 and “Opening Endcap Styles” 
on page 1894. 

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style you want to change, and click Edit.

4 Click the Endcaps/Opening Endcaps tab.

5 Select an endcap style to apply to the ends of the walls for Wall Endcap 
Style.

6 Select opening endcap styles to apply to each of the following objects: 
doors, openings, windows, and door/window assemblies.

7 Click OK twice.

Specifying the Components of a Wall Style

Wall components are the physical structures of a components of a wall, such 
as concrete, CMU, studs, GWB, insulation, and air gaps.

Wall Components and Their Properties
Each component in a wall style corresponds to a structural component of a 
wall or a wall material, including air gaps in cavity walls. When you create a 
wall component, you specify the following characteristics of the component:

� The component name, which usually identifies the material used, such as 
brick, concrete, CMU, or insulation

� The component cleanup priority, which determines how the component 
cleans up with the components of intersecting walls

� The width (thickness) of the component
� The vertical offset of the component at the bottom and the top of the wall
� The position of the component within the wall, relative to the baseline of 

the wall and adjacent wall components

Using Components from Other Wall Styles
In addition to creating a wall component by specifying its individual proper-
ties, you can also copy components from other wall styles into a wall style. 
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The Wall Component Browser is a utility that lets you view the components 
of other wall styles and copy components into the wall style you are editing.

Related Topics and Procedures

� Components Tab

� Wall Style Components Browser

� Default Cleanup Priorities of Wall Components

� Creating or Editing a Component in a Wall Style

� Adding a Component from Another Wall Style

� Removing a Component from a Wall Style

Components Tab
The Components tab of the Wall Styles dialog box lets you view wall compo-
nents as you specify them. 

Specifying the properties of wall components

Use the features of the Components tab for the following tasks:

� Add, remove, and edit the properties of wall components for wall style.
� View the components as you specify them.
� Change the order of components relative to other components in the wall 

style.
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� Access the Wall Style Components Browser, which lets you view and copy 
components from other wall styles in the current drawing and in other 
drawings.

For more information about the components browser, see “Wall Style Com-
ponents Browser” on page 1870.

Wall Style Components Browser
The Wall Style Components Browser is a utility that lets you view and copy 
wall components from wall styles in the current drawing and in other draw-
ings. You can copy components from these styles to the current wall style. 
After you add them to the wall style, you can change their properties as 
needed for the style you are editing.

Viewing wall components from multiple styles and drawings

The Wall Style Components Browser has the following features:

Use this feature . . . To . . .

icons open other drawings, copy wall components, 
and change the view options for the right pane 
of the browser.
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Default Cleanup Priorities of Wall Components
The component priority determines how each wall component cleans up 
with the components of an intersecting wall. The lower the component 
index number, the higher the priority of the component when it intersects 
other walls.

Wall cleanup priorities

The following table lists the default cleanup priority for each component 

used in sample wall styles provided in Autodesk® Architectural Desktop cata-
logs. You can assign different priorities to wall components in wall styles and 
individual walls to control cleanup with other walls.

tree structure in the left pane of 
the browser

expand wall styles to view the list of components 
in the style. Select a wall style in the left pane to 
view the properties of its components and see 
the wall style in the right pane. You can use the 
shortcut menu to copy an individual component 
or all components of a selected style. You can 
then paste the component(s) in the style you are 
editing.

right pane of the browser view the component properties of a selected 
style, and preview the style in the viewer area of 
the pane.

Component Index

Air Gap 700

Use this feature . . . To . . .
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Creating or Editing a Component in a Wall Style
Use this procedure to create a wall component, or to edit existing wall com-
ponents in a wall style.

You can also add components to a wall style by copying them from other wall 
styles. For more information, see “Adding a Component from Another Wall 
Style” on page 1875.

Air Gap (Brick/Brick) 805

Air Gap (CMU/CMU) 305

Air Gap (Stud/Stud) 505

Brick 800

Brick Veneer 810

Bulkhead 1800

Casework - Backsplash 2030

Casework - Base 2010

Casework - Counter 2020

Casework - Upper 2000

CMU 300

CMU Veneer 350

Concrete 200

Concrete (Footing) 200

Glass 1200

GWB 1200

GWB (X) 1200,1210,1220,1230

Insulation (CMU/Brick, Stud/Brick) 600 

Metal Panel 1000

Precast Panel 400

Rigid Insulation (Brick) 404

Siding 900

Stucco 1100

Stud 500

Toilet Partition 3000

Component Index
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NOTE Only the first 20 components of a wall style are controlled by the dis-
play system. Although you can specify more than 20 components in a wall style, 
it is suggested that you limit the number of components to 20. Components 21 
and higher are controlled by material assignment only.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Components tab.

5 Click .

6 Enter a name for the new component.

7 Enter the cleanup priority for the component when walls intersect.

The lower the priority number, the higher the priority of the component 
when it intersects with the components of other walls. For more informa-
tion, see “Default Cleanup Priorities of Wall Components” on page 1871.

8 Specify the width of the component:

Adding the first wall component

If you want to . . . Then . . .

specify a fixed width that 
cannot be edited when 
you add or edit walls of 
this style

enter a value for Width.

specify a variable width 
that can be edited when 
you add or edit walls of 
this style

select the setting for Width. Enter a formula that 
defines how the component width is calculated. For 
more information, see “Specifying the Width and 
Edge Offset of a Wall Component” on page 1899.
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9 Specify the edge offset, which is the offset of the exterior edge of the com-
ponent from the baseline:

10 To specify the top elevation offset or bottom elevation offset, enter a new 
value, and select from where the distance is to be measured: Wall Top, 
Base Height, Baseline, or Wall Bottom.

NOTE Do not define wall components with elevation offsets that are above 
Wall Top or below Wall Bottom. Walls that have components that are defined 
this way do not clean up correctly and may not be displayed correctly if you 
edit their roof line or floor line. To avoid cleanup and display problems, you 
can define wall components with elevation offsets that are above Base Height 
or below Baseline.

11 Repeat steps 5 through 10 to add more components to the wall style.

Adding the second wall component

If you want to . . . Then . . .

graphically specify the 
offset select the component, select  or  to offset 

the component by an increment that you specify. 
The viewer shows the position of the wall 
component as you click the icons. The selected 
component is highlighted in green.

let the software calculate 
the offset

select Auto Calculate Edge Offset.

specify a fixed offset enter a value for Edge Offset.

specify a variable offset 
that is calculated from 
values that you specify

select the setting for Edge Offset. Enter a formula 
that defines how the edge offset is calculated for 
this component. For more information, see 
“Specifying the Width and Edge Offset of a Wall 
Component” on page 1899.
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12 To change the order of components in the wall style, select a wall compo-

nent, and click  or  to move the component to the desired posi-
tion relative to the other wall components.

13 Click OK.

Adding a Component from Another Wall Style
Use this procedure to copy one or more wall components from another wall 
style into the wall style you are editing.

NOTE Only the first 20 components of a wall style are controlled by the dis-
play system. Although you can specify more than 20 components in a wall style, 
it is suggested that you limit the number of components to 20. Components 21 
and higher are controlled by material assignment only.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Components tab.

5 Click .

The Wall Style Components Browser lists the wall styles and their compo-
nents in the current drawing.

6 Locate the wall components you want to copy:

For more information about the information shown in the Wall Styles 
Component Browser, see “Wall Style Components Browser” on page 1870.

If you want to . . . Then . . .

view the wall components 
for wall styles in the 
current drawing

in the left pane, select a wall style. The right pane 
lists the components and their properties and 
displays the style in the viewer.

view the wall components 
in wall styles in other 
drawings

click . Navigate to the drawing you want, and 
click Open. In the left pane, select a wall style.

close a drawing that you 
opened in the browser

select the drawing name, right-click, and click 
Close. You cannot close the current drawing.
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7 Copy wall components, and add them to the wall style you are editing:

8 Click  to close the Wall Style Components Browser.

9 After you copy wall components to the current wall style, you can edit or 
delete the new components as needed.

For more information, see “Creating or Editing a Component in a Wall 
Style” on page 1872.

10 Click OK.

Removing a Component from a Wall Style
Use this procedure to delete a component from a wall style. When you 
remove a component from a wall style, the component is also removed from 
all existing walls that use this style.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Components tab.

5 Select the wall component you want to remove, and click .

6 Click OK.

Specifying the Materials of a Wall Style

A wall consists of a number of components whose display properties can be 
determined by the materials assigned to each component. When you assign 
materials to a wall style, you assign one material to each physical component 
of the wall. For example, you assign a wood or metal material to studs, con-
crete to a concrete component, and so on. You assign materials to compo-

If you want to . . . Then . . .

copy all components in a 
wall style

select the wall style, and drag the style to the list of 
components in the Wall Styles Properties dialog 
box. All the components are added to the wall style.

copy an individual wall 
component

select the wall component, and drag the 
component to the list of components in the Wall 
Styles Properties dialog box. The component you 
selected is added to the wall style.
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nents in each display representation where you want the materials to be 
used.

If you want to use the display properties of the wall style, instead of using 
material display properties, you can turn off the material assignments in the 
display properties of the wall style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in three dimensional (3D) model views 
and in elevations.

Related Topics and Procedure

� Wall Materials and Display Components

� Assigning Materials to a Wall Style

Wall Materials and Display Components
The following table identifies the material component that corresponds to 
each wall component. 

Wall Component Material Component

Plan, Plan Low Detail, Plan High Detail, Plan Presentation, Plan 
Screened

Below Cut Plane No Material

Above Cut Plane No Material

Shrink Wrap 2D Linework

Shrink Wrap Hatch Plan Hatch

Defect Warning No Material

Boundary 1 - 20 Plan Linework

Hatch 1 - 20 Plan Hatch

Reflected, Reflected Screened

Below Cut Plane No Material

Above Cut Plane No Material

Shrink Wrap 2D Linework
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Assigning Materials to a Wall Style

Use this procedure to assign materials to the individual components of a wall 
style. When you assign a material to a wall component, the component uses 
the display properties of the material instead of the style display properties.

You can assign a material to any physical component of the wall. Custom 
components and components that are only symbolic graphics do not use 
materials for their display properties. For example, all structural components, 
such as brick and other masonry, studs, insulation, and air gaps, are physical 
components that you can assign materials. The defect marker is a symbol, 
and you cannot assign a material to it.

NOTE If a material assignment does not determine the display properties of a 
wall component, you can change the display properties of the wall style as 
described in “Specifying the Display Properties of a Wall Style” on page 1879.

Shrink Wrap Hatch Plan Hatch

Defect Warning No Material

Boundary 1 - 20 Plan Linework

Hatch 1 - 20 Plan Hatch

Model, Model High Detail, Model Low Detail

Defect Warning No Material

Shrinkwrap Body 3D Body

Boundary 1 - 20 3D Body

Sketch

Baseline No Material

Marker No Material

Center Line No Material

Graph

Radius No Material

Edge No Material

Wall Component Material Component
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1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Select the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Specifying the Display Properties of a Wall Style

In most cases, you can assign materials to wall components so that the 
appearance of walls that belong to the same style is consistent throughout a 
drawing and with other walls and objects that use the same materials.

If a component cannot be assigned a material, or if you do not want to use 
materials but still want consistency among walls of the same style, you can 
specify the display properties of the wall components in the wall style:

� The layer, color, and linetype of wall components
� The hatching used with each component
� The cut plane height and the display of components relative to the cut 

plane
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� Other specific wall display information, such as whether complex endcaps 
are displayed and whether the wall is cut around door and window frames

Related Procedures

� Specifying the Layer, Color, and Linetype of a Wall Style

� Specifying the Hatching for Components of a Wall Style

� Specifying the Cut Plane Display of a Wall Style

� Specifying the Display of Other Characteristics of a Wall Style

Specifying the Layer, Color, and Linetype of a Wall Style
Use this procedure to change the following display properties of the compo-
nents of a wall style: 

� Visibility (component is on or off)
� By material (material assigned to the display component determines its 

display properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

To change these display properties for an individual wall, see “Changing the 
Display Properties of Individual Walls” on page 1805.

NOTE If a material assignment determines the display properties of compo-
nents in the wall style, you can change the properties of the display component 
by clearing By Material. You can also override the material assignment with a dif-
ferent material. For more information, see “Assigning Materials to a Wall Style” 
on page 1878.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.
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8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

Specifying the Hatching for Components of a Wall Style
Use this procedure to specify the hatching of the components of a wall style. 
Wall hatching is displayed only in display representations, such as Plan, that 
are used in the Top view (plan view) of a drawing.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Hatching tab.

8 Select a component, and click the setting for Pattern.

9 Select the hatching for the component:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.
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13 Click Orientation, and specify how the hatching is oriented:

14 Click OK twice.

Specifying the Cut Plane Display of a Wall Style
Use this procedure to specify the properties of one or more cut planes for a 
wall style. Cut plane display properties apply only to display representations, 
such as Plan, that are used in the Top view (plan view) of a drawing. 

To better visualize the elements of a wall in plan view, you can create cut 
planes. The main cut plane is where the shrinkwrap and hatching are 
applied. The plan display shows the components and objects in the wall as 
they are displayed at the height of each cut plane.

The cut plane settings you specify in the wall style override the cut plane set-
tings in any display configuration applied to a viewport. When you add 
doors, windows, openings, or door/window assemblies to a wall, you can 
specify in the display properties of those objects or their styles whether they 
respect the cut plane of the wall or of the display configuration.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Cut Plane tab.

8 Select Override Display Configuration Cut Plane.

9 To specify the cut plane where shrinkwrap, component boundaries, and 
hatching take effect, enter a value for Cut Plane Height.

10 Select Automatically Choose Above and Below Cut Plane Heights to show 
the components above and below the cut plane height.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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11 To specifically define a cut plane, select Manual Above and Below Cut 
Plane Heights, click Add, and enter the height of the new cut plane.

You can click Remove to delete a cut plane that you added.

12 Click OK twice.

Specifying the Display of Other Characteristics of a Wall Style
Use this procedure to specify other display properties for the wall style, such 
as whether to display complex endcaps, to show door and window frames, or 
whether to show the miter of specific wall components. These display prop-
erties apply only to display representations, such as Plan, that are used in the 
Top view (plan view) of a drawing.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style that you want to change, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select the display properties for the wall style:

If you add a cut plane . . . Then . . .

at a height that is lower than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Below Cut Plane component 
on the Layer/Color/Linetype tab.

at a height that is higher than 
the value for Cut Plane Height

objects are displayed using the properties 
specified for the Above Cut Plane component 
on the Layer/Color/Linetype tab.

If you want to . . . Then . . .

display the component lines 
within the wall above the cut 
plane (for example, through a 
window or door in the wall)

select Display Inner Lines Above. Clear this 
option if you do not want to display these 
lines.
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9 Click OK twice.

Adding Classifications to a Wall Style

Use this procedure to specify classifications for any classification definition 
applied to a wall style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

display the component lines 
within the wall below the cut 
plane (for example, through a 
window or door in the wall)

select Display Inner Lines Below. Clear this 
option if you do not want to display these 
lines.

turn off lines below a window, 
door or opening at the cut 
plane

select Hide Lines Below Openings at Cut 
Plane. Clear this option if you want to display 
the lines.

turn off lines below a window, 
door or opening above the cut 
plane

select Hide Lines Below Openings Above Cut 
Plane. Clear this option if you want to display 
the lines.

display complex wall and 
opening endcaps

select Display Endcaps. Clear this option to 
display complex endcaps as a single line.

display door openings cutting 
the wall at the outer edge of the 
door frame

select Cut Door Frames. Clear this option if 
you want door openings to cut the wall at the 
inside of the door frame.

display window openings 
cutting the wall at the outer 
edge of the window frame

select Cut Window Frames. Clear this option if 
you want window openings to cut the wall at 
the inside of the window frame.

draw wall components by their 
priority number to control the 
display of a component over 
another component

select Component Draw Order by Priority. 
Clear this option if you want to draw the 
components in the order that they were 
created.

perform a slice of the actual 
three-dimensional (3D) model 
at each cut plane to obtain 
more accurate views of walls 
with sweeps or body modifiers

select Do True Cut. Clear this option if the wall 
does not have sweeps or body modifiers, or if 
they do not change along the height of the 
wall.

display miter lines at wall 
corners for selected wall 
components

under Draw Miter for Components, select 
each component whose miter lines you want 
to display. 

If you want to . . . Then . . .
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1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to wall 
styles.

5 For each classification definition, select the classification you want to 
apply to the current wall style.

6 Click OK twice.

Attaching Notes and Files to a Wall Style

Use this procedure to enter notes and attach reference files to a wall style. You 
can also edit notes and edit or detach reference files from a wall style.

1 Open a tool palette that has a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Right-click the wall style you want to change, and click Edit.

4 Click the General tab.

5 To add a description to the wall style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Wall Endcap Styles

You can define different wall endcap styles to control the shape, the width 
and the depth of starting and ending wall segments. Generally, you create a 
wall endcap style to use with a specific wall style. You create a wall endcap 
style from one or more open polylines that each correspond to the end con-
dition of a component in the wall style. 

When necessary, you can override the wall endcap style assigned in a wall 
style. When you override the assigned endcap style, you can select a different 
endcap style for one or both ends of a wall segment.

Wall Endcap Styles and Opening Endcap Styles
Wall endcap styles are also used as a basis to define wall opening endcap 
styles. When a wall has an opening, such as a window or a door, the shape of 
the wall endcap at each edge of the opening needs to be defined. You use 
opening endcap styles to specify the wall endcap style applied to each edge. 
For more information about opening endcap styles, see “Opening Endcap 
Styles” on page 1894.

NOTE When you change a wall endcap style, all opening endcap styles based 
on the wall endcap style are modified, too. 

Managing Wall Endcap Styles
To create, edit, copy, or purge styles, you access the Style Manager. The Style 

Manager provides a central location in Autodesk® Architectural Desktop to 
work with styles from multiple drawings and templates. For more informa-
tion about using the Style Manager, see “Style Manager” on page 531.

Related Topics and Procedures

� About Polylines Used in Wall Endcap Styles

� Creating and Applying a Wall Endcap Style

� Creating a Wall Endcap Style

� About Editing Wall Endcap Styles

� Editing the Geometry of a Wall Endcap Style

� Attaching Notes and Files to a Wall Endcap Style

About Polylines Used in Wall Endcap Styles

When you draw polylines to use in wall endcap styles, each polyline corre-
sponds to the shape of the endcap for one wall component. Each polyline is 
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scaled to fit its assigned component. You can assign the same polyline to wall 
components that you want to have the same endcap condition.

Here are some guidelines for drawing polylines to use in endcap styles:

� Use only two-dimensional (2D) open polylines.
� Draw the polylines in plan view. You may want to draw the polylines on 

top of a wall of the wall style you are creating the endcaps for. This helps 
you visualize how the endcap should appear for each component of the 
wall.

� Draw each polyline counterclockwise.
� Ensure that the X value of the start point and the X value of the endpoint 

of a polyline are the same. If the X values are different, the endcap will be 
skewed.

Creating and Applying a Wall Endcap Style

Use this procedure to convert one or more polylines into an endcap, and 
simultaneously create or modify an endcap style. You place these endcaps on 
walls by modifying the wall style or applying a wall style override. 

When you create and apply endcaps as described in this procedure, the wall 
segment is trimmed or extended to the shape of the endcap and defines a 
new wall start point. When openings, such as doors and windows, exist in a 
wall to which you apply an endcap, the end of the wall is trimmed or 
extended to the endcap without moving the openings.

Creating an endcap for a single-component wall

You can use a crossing window to select multiple polylines to create an end-
cap for a multi-component wall.
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Creating an endcap for a multi-component wall

NOTE When creating an endcap for multiple component walls that contain 
components at different elevations, this method of creating and applying end-
caps may produce undesirable results. It is based on the cut plane height of the 
wall and does not respond to manual above or below cut plane heights.

1 In plan view, draw open polylines on top of or near the end of a wall seg-
ment to define the shape of the end condition for each wall component.

The location of the polyline determines how the wall is extended or 
trimmed when the endcap is added or modified. For more information 
about drawing polylines for endcaps, see “About Polylines Used in Wall 
Endcap Styles” on page 1886.

2 Select the wall, right-click, and click Endcaps ➤ Calculate Automati-
cally.

3 Select the polyline(s) to define the shape of the endcap, and press ENTER.

4 Enter y (Yes) to erase the polyline(s), or enter n (No) to keep the 
polyline(s).

If the current wall endcap style is not the Standard style, you are prompted 
to modify the current style.

5 Specify the wall endcap style to modify and apply to the wall:

If you want to . . . Then . . .

modify the wall endcap style 
that is currently assigned to the 
wall

press ENTER.
The selected wall and any other walls in the 
drawing that use the wall endcap style are 
updated with the new geometry.

create a different endcap style enter n (No). 
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6 If you created a style from the polylines, specify how to apply the new 
endcap style to the selected wall:

7 Enter a name for the new wall endcap style, and click OK.

Creating a Wall Endcap Style

Use this procedure to create a wall endcap style from one or more polylines. 
For more information about drawing polylines for wall endcap styles for sin-
gle- and multi-component walls, see “About Polylines Used in Wall Endcap 
Styles” on page 1886.

1 Draw polyline(s) in the shape of the wall endcap you want to create.

2 On the Format menu, click Style Manager.

3 Expand Architectural Objects.

4 Right-click Wall Endcap Styles, and click New.

5 Enter a name for the new wall endcap style, and press ENTER.

6 Right-click the new style, and click Set From.

7 Select a polyline, and enter the index number for the wall component to 
which the polyline applies.

Wall components are numbered from exterior to interior. Component 
index 1 corresponds to the outermost exterior component.

8 When prompted, enter y (Yes) to specify the endcap condition of the next 
component, or enter n (No) if there are no more components.

9 When you finish specifying endcap conditions for wall components, 
enter the return offset for the endcap.

A positive value offsets the endcap from the wall start point in the positive 
X direction.

If you want to . . . Then . . .

apply the new wall endcap style 
as an override to the current 
wall style

enter o (Override).
The new wall endcap style is applied only to 
the selected end of the wall.

apply the new wall endcap style 
as the default wall endcap style 
for the current wall style

press ENTER.
The same wall style is updated with the new 
wall endcap style. Any walls in the drawing of 
the same wall style are also updated with the 
new wall endcap style.
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Specifying the return offset for an endcap

10 Click OK.

After you create a wall endcap style, you can apply it to a wall style, an 
opening endcap style, or to individual walls.

About Editing Wall Endcap Styles

After you assign a wall endcap style to a wall, you can edit the endcap 
directly. You can save the changes to the current wall endcap style, or to a 
new wall endcap style. You can also discard changes. 

Editing the Standard Wall Endcap Style
The Standard wall endcap style is a special case. While you can use the Stan-
dard style as a starting point for creating a new wall endcap style, the Stan-
dard style itself cannot be changed. The Standard style is used when no other 
endcap style is specified for a wall. It is also used when you remove all com-
ponents from a wall endcap style.

The Wall Endcap Profile
When you edit a wall endcap, a temporary profile with grips for vertices and 
edges is created for each component of the endcap. You can edit this profile 
in both plan and model views. In model views, the profile is inserted at the 
mid-height of the wall. If the wall has components that do not extend to that 
height, such as a footing, additional profiles are created at the vertical mid-
point of these components. Use model views to edit wall endcaps that lie in 
different planes.
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Editing endcaps for wall components in different planes

Use the location grip on the temporary profile to move the profile away from 
the wall, if needed. You may want to do this if the profile is very complex or 
is obscured by the linework of other objects. Changes to the profile are saved 
at its original location.

Editing the Geometry of a Wall Endcap Style

Use this procedure to edit the geometry of a wall endcap style that is applied 
to a wall. You can edit the vertices and edges of the wall endcap or replace 
the geometry with that of other polylines. You can save the changes to the 
current wall endcap style or to a new style.

1 Select the wall that has the wall endcap style you want to change, right-
click, and click Endcaps ➤ Edit in Place.

2 Select a point near the endcap.

A temporary profile is created for you to edit the geometry of the wall end-
cap. If the wall contains multiple components, a profile is created for each 
wall component.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select a profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select a 
profile, and right-click to display the shortcut menu.
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3 Edit the profile:

4 Save or discard the changes:

If you want to . . . Then . . .

change the shape of the 
perimeter of the profile

select the profile, and use grips to adjust the 
shape. If the profile has no grips, the Standard 
style, which you cannot edit, is the current 
endcap style.

hide one or more edges of the 
profile (plan view only)

select the profile, right-click, and click Hide 
Edge. Select the edges you want to hide, and 
press ENTER.

display an edge that you hid select the profile, right-click, and click Show 
Edge. Select the edges you want to show, and 
press ENTER.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace the geometry of an 
endcap component with new 
polyline that lies on the end of 
the wall exclusive of existing 
endcaps

select the profile for the component you want 
to replace, right-click, and click Replace 
Endcap. Select the endcap component to 
replace, and select a polyline to define the 
new geometry. Press ENTER to keep the 
polyline in the drawing, or enter y (Yes) to 
erase it.

remove an endcap component select the profile for the component you want 
to remove, right-click, and click Remove 
Endcap.

If you want to . . . Then . . .

restore the wall endcap to its 
original shape

click .
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Attaching Notes and Files to a Wall Endcap Style

Use this procedure to enter notes and attach reference files to a wall endcap 
style. You can also edit notes and edit or detach reference files from a wall 
endcap style.

1 Open a tool palette that contains a wall tool.

2 Right-click a wall tool, and click Wall Styles.

3 Select the wall style you want to change, right-click, and click Edit.

4 Click the General tab.

5 To add a description to the endcap style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

save the changes to the current 
wall endcap style

click .
The wall endcap and the wall endcap style use 
the edited profile(s) to define its geometry. 
Any other walls or opening endcap styles that 
use this wall endcap style are also updated 
with the edited geometry.

save the changes to a new wall 
endcap style

select the profile, right-click, and click Save as 
New Endcap Style. Enter a name for the new 
wall endcap style, and click OK.
The wall endcap uses the new style to define 
its geometry. Other walls, wall styles, or 
opening endcap styles that use the original 
style are not affected.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .
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9 Click OK.

Opening Endcap Styles

Opening endcaps styles define the end conditions of walls into which doors, 
windows, openings, or door/window assemblies have been added. Opening 
endcap styles let you specify which wall endcap style is applied to each edge 
of an opening.

Opening Endcap Styles and Wall Endcap Styles
Wall endcap styles are typically created for specific wall styles. When you cre-
ate an opening endcap style, you can select the wall endcap style that is 
appropriate for each edge of the opening. You can therefore create an open-
ing endcap style for each type of object that you can add to a wall of a specific 
wall style. 

NOTE When you change a wall endcap style, all opening endcap styles based 
on the wall endcap style are modified, too. 

Applying Opening Endcap Styles
After you create the opening endcap styles you want to use with a particular 
wall style, you edit the wall style to specify which opening endcap style is 
used with the following objects: doors, windows, openings, and door/win-
dow assemblies. For more information, see “Specifying the Endcap Styles 
Used in a Wall Style” on page 1868.

When necessary, you can override the opening endcap style assigned in a 
wall style. When you override the assigned opening endcap style, you can 
select a different endcap style for the start and the end of the object, such as 
a door, on the Properties palette.

Managing Opening Endcap Styles
To create, edit, copy, or purge styles, you access the Style Manager. The Style 

Manager provides a central location in Autodesk® Architectural Desktop to 
work with styles from multiple drawings and templates. For more informa-
tion about using the Style Manager, see “Style Manager” on page 531.

Related Procedures

� Creating and Applying Opening Endcap Styles

� Creating and Editing an Opening Endcap Style

� Attaching Notes and Files to an Opening Endcap Style
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Creating and Applying Opening Endcap Styles

Use this procedure to create an opening endcap style and immediately apply 
it to an opening in a selected wall.

1 Draw the polylines for the new endcap.

2 Select the wall where you want to create the new endcap, right-click, and 
click Endcaps ➤ Calculate Automatically.

3 Select the linework to define the new endcap, and press ENTER.

4 Press ENTER to keep the polyline(s) in the drawing, or enter y (Yes) to erase 
them.

5 When prompted, specify whether you want to modify the current open-
ing endcap style, or to create a new style.

6 If you create a new style, specify the edges where the endcap you created 
is applied.

Specifying the edges where new endcaps are applied

7 Click OK.

The new endcaps are applied to the edges of the current opening as you 
specified.

Creating and Editing an Opening Endcap Style

Use this procedure to create an opening endcap style. You can create a style 
using default style properties, by copying an existing style. After you create 
the style, you edit the style properties to customize the characteristics of the 
style.
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The wall endcap styles you use in the opening endcap style must exist in the 
drawing before you can add them to the style. For more information, see 
“Opening Endcap Styles” on page 1894.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Wall Opening Endcap Styles.

3 Create an opening endcap style:

4 Enter a name for the new opening endcap style, and press ENTER.

5 To edit the new wall style, right-click the style, and click Edit.

6 Click the Design Rules tab.

7 Select a wall endcap style for each edge of the opening: jamb start, jamb 
end, head, and sill.

Select the Standard wall endcap style for an edge that does not require an 
endcap, such as the sill for a door.

8 Click OK twice.

Attaching Notes and Files to an Opening Endcap 
Style

Use this procedure to enter notes and attach reference files to an opening 
endcap style. You can also edit notes and edit or detach reference files from 
an opening endcap style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Wall Opening Endcap Styles.

3 Select the opening endcap style you want to change, right-click, and click 
Edit.

4 Click the General tab.

5 To add a description to the endcap style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

If you want to . . . Then . . .

create a style with default 
properties

right-click Wall Opening Endcap Styles, and click 
New.

create a style from an 
existing style

right-click the opening endcap style you want to 
copy, and click Copy. Right-click, and click Paste.
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8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK.

Using Ortho Close and Close with Walls
Ortho Close and Close are command-line options that let you efficiently cre-
ate a closed space when you add walls.

Ortho Close
This option closes the space by drawing two walls based on the direction you 
specify. The direction is extended until it meets a line perpendicular to the 
initial edge of either the wall. You enter or (Ortho) at the command line to 
use this option when placing walls.

Closing walls with Ortho Close

Close
This option closes the wall by creating a wall segment from the last point 
specified for the walls to the first point specified in this group of walls. You 
enter c (Close) at the command line to use this option when placing walls.

About Wall Lengths
When you draw a wall, the “true” length of the wall is the distance between 
the two end grips. The wall can appear to have a different length when it 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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cleans up with other walls; the difference can be twice the cleanup radius 
longer or shorter than the “true” length. The “true” length is the length 
reported by properties and schedules. To get the most accurate information 
about wall length in schedules, always make sure that walls that clean up 
with each other have end grips that coincide.

About Curved Walls
The smoothness (tesselation) of curved edges is controlled by the FACETDEV 
variable. This variable sets the number of facets to display on curved AEC 
objects. The default value is 1/2” for drawings created from imperial tem-
plates and is 12.7 mm for drawings created from metric templates.

The number you specify for facet deviation defines the maximum distance 
from the chord to the arc, the chord being an edge that is created from 
faceting the curve, to the true mathematical arc. The facet deviation has a 
range of greater than zero (0) and no upper limit.

The minimum number of facets is 8. For example, if you create a cylinder 
mass element to have a 1’ radius, and specify 1’ for facetdev, the cylinder has 
8 faces.

To specify the facet deviation values for the current drawing, see “Specifying 
the Display Resolution of Objects with Facets” on page 564. The settings 
apply to all curved objects in the drawing, including curved walls.

Specifying Offsets for Roof Line and Floor Line Vertices
When you add or move a vertex on the roof line or the floor line of a wall, 
you specify the horizontal and vertical offset of the vertex. You can specify 
the offset relative to other vertices or to the base height or the baseline of the 
wall. The following table identifies the locations you can specify for the hor-
izontal offset of a vertex. The offset distance is measured in the direction the 
wall was drawn. 

This setting . . . Defines the horizontal offset from . . .

From Wall Start the wall start point.

From Wall End the wall end point.

From Wall Midpoint the midpoint of the wall.

From Previous Point the vertex that is one position closer to the wall 
start point than the vertex you are adding or 
moving.
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The following table identifies the locations you can specify for the vertical 
offset of a vertex. You can enter a negative distance for the vertical offset to 
position a vertex toward the ground.

Specifying the Width and Edge Offset of a Wall Component
You can specify the width and edge offset of a wall component by entering 
values, creating a component with a fixed width and offset. You can also 
specify a formula for determining these values. The formula can include a 
value for Base Width. By including the Base Width variable in the formula, 
you can specify the width of the wall when you add or edit walls of this style 
to a drawing.

Specifying a formula to determine component width or edge offset

To calculate the edge offset or the width based on the base width, select Base 
Width and select an operator and an operand:

� If you select Base Width for any component, you can enter a width for 
walls of this style when you add or modify them in a drawing. 

From Next Point the vertex that is one position closer to the wall 
endpoint than the vertex you are adding or 
moving.

From Midpoint of Neighbors the midpoint of the distance between the current 
vertex and the vertex that is one position closer to 
the wall endpoint.

This setting . . . Defines the vertical offset from . . .

From Wall Base Height the base height of the wall.

From Next Point. the vertex that is one position closer to the wall 
endpoint than the vertex you are adding or 
moving.

From Previous Point the vertex that is one position closer to the wall 
start point than the vertex you are adding or 
moving.

From Baseline the baseline of the wall.

This setting . . . Defines the horizontal offset from . . .



1900 | Chapter 25 Walls

� If all components in the wall style use absolute values, you cannot change 
the width of individual walls of this style when you add or modify them.

Wall component baseline offset parameters
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Windows

A window is an AEC object that interacts with walls and 

space boundaries. After a window is placed in a wall or 

space boundary, the window is constrained to the object 

and cannot move outside it. Windows can be anchored 

to specific locations in walls or space boundaries; when 

the wall or space boundary moves or changes size, the 

location of the window in that object stays constant. 

Windows can also be freestanding objects.

In this chapter

� Using Window Tools to Create 
Windows

� Creating a Window

� Creating a Window with User-
Specified Settings

� Creating a Window Tool

� Editing Windows

� Window Styles

26
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Creating Windows
You can create windows using all of the typical design parameters for style, 
standard size, width and height, threshold height, head height, and vertical 
alignment. You can choose styles with glass shapes that receive standard 
muntins patterns, and create your own custom glass shapes from profiles. 

Working with Window Styles
Templates provided with Autodesk® Architectural Desktop contain ready-to-
use window styles. The design rules of a window style determine the default 
dimensions of windows created from the style. The window style also deter-
mines the window shape and the window type:

� The window shape determines the geometry of the window frame, such 
as rectangular, half round, and arch. You can also create custom window 
shapes from profiles.

� The window type determines the number of panels and the method of 
opening the window, such as glider, pass-through, hopper, or picture. 

You can also define standard sizes in a window style and then select the size 
you want to use when you place the window in a drawing.

Anchoring Windows
After a window is placed in a wall or space boundary, the window is con-
strained to the object and cannot move outside it. 

Windows can also be anchored to specific locations in walls or space bound-
aries, so that when the wall or space boundary moves or changes size, the 
location of the window in that object stays constant. 

Window Dimensions
Some window dimensions depend on the window shape and type specified 
in the window style.

Rise is the height from the top of the rectangular portion of a window to the 
peak of the window opening for Gothic, Arch, and Peak Pentagon window 
shapes.

Vertical Alignment of Windows
To control how you place the window in the wall, the location of the working 
point vertically in the wall, and how the window responds to modifications 
in height, use the vertical alignment settings. To determine the working 
point on the window, use the threshold and head height settings. You can 
place the working point at the sill or at the head.

The threshold height is maintained. For example, if you specify the vertical 
alignment as 0'' and the window height as 7'–0'', the window opening height 
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is 7’–0''. If you next specify the height of the window as 6'–8'', the window 
threshold remains at 0'' and the window opening height becomes 6’–8''. 

The window head work point is maintained. For example, if you specify the 
vertical alignment as 7'–0'' and the window height as 7'–0'', the window 
opening height is 7–0''. If you specify the window height as 6'–8'', the win-
dow head remains at 7'–0'' and the window threshold becomes 4''.

Materials in Windows
In Autodesk Architectural Desktop, you can assign materials to a window. 
These materials then are displayed in wireframe or rendered views. Materials 
have specific settings for individual components of a window, such as the 
frame, the sash, or the muntins. For more information, see “Material Com-
ponents and Display Properties” on page 498.

Window in 2D wireframe and rendered views

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes, which contain settings for windows. 
You can use these predefined materials, or modify them to your special 
designs. You can also create your own materials. If you create a material that 
should specifically be used only for windows, it is recommended that you 
name it accordingly; for example, Window - Wood Frame or Window Sill - 
Marble. For more information, see “Creating and Editing Materials” on 
page 517.

Related Topics and Procedures

� Using Window Tools to Create Windows

� Creating a Window

� Creating a Window with User-Specified Settings

� Creating a Window Tool

� Editing Windows

� Window Styles



1904 | Chapter 26 Windows

Using Window Tools to Create Windows

Tool palettes provided with Autodesk Architectural Desktop let you quickly 
place windows by selecting a window tool with a specific window style and 
other predefined properties. You can also use window tools to apply the set-
tings of a window tool to existing windows. The following table lists the tool 
palettes containing one or more window tools:

When you place windows using windows tools, you can use the default set-
tings of the tool, or you can change settings for any windows properties that 
are not controlled by the style.

Related Procedures

� Creating a Window with User-Specified Settings

Creating a Window

Use this procedure to add a new window that has the properties specified in 
the window tool that you select. To specify settings when you add a window, 
see “Creating a Window with User-Specified Settings” on page 1905.

1 Open the tool palette that you want to use, and select a window tool.

If necessary, scroll the palette to display the tool that you want to use.

2 Select a wall or space boundary in which to insert the window, or press 
ENTER to add a freestanding window.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Specify the insertion point of the window.

Tool palette . . . Contains . . .

Design a window tool for the Standard window style and 
default settings for other window properties

Windows a window tool for sample window styles, with default 
properties appropriate for each window style

Custom tool palettes created 
by your CAD manager

window tools with window styles and properties that 
are customized for your projects or office standards
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4 Continue adding windows, and press ENTER.

Creating a Window with User-Specified 
Settings

Use this procedure to create any of the following, with settings that you spec-
ify:

� Freestanding windows
� Windows in walls
� Windows in space boundaries

Adding a window to a wall
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TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a Window tool.

If necessary, scroll the tool palette to display the tool you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a window style.

4 Expand Dimensions.

5 Specify a window size: 

6 Enter a value for Rise, if applicable to the selected style and window type.

7 Specify where the window width and height are measured to: 

8 Enter a value for Opening percent or Swing angle.

Zero indicates a closed window.

9 Expand Location.

10 If you are placing the window in a wall or a space boundary, specify the 
position of the window:

If you want to . . . Then . . .

use a standard window size click Standard Sizes, and then select a 
window size.

use a custom window size enter values for Width and Height.

If you want to measure to . . . Then . . .

the outside of the window frame Select Outside of frame for Measure to.

the inside of the window frame Select Inside of frame for Measure to.

If you want to . . . Then . . .

position the window at a 
specific distance between the 
edge of the opening and the 
end of a wall segment or space 
boundary

select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.
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11 Specify whether you want the window aligned vertically by sill height or 
by head height:

12 Specify the insertion point for a freestanding window or a window in a 
wall or space boundary:

13 Continue to place windows by selecting window styles and specifying 
insertion points, or press ENTER to end the command.

Creating a Window Tool

Use this procedure to create a window tool and add it to a tool palette. You 
may want to create your own window tools if you are placing multiple win-

center the window on a wall 
segment or space boundary

select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall segment or space boundary.

position the window anywhere 
along the wall or space 
boundary

click Position along wall, and select 
Unconstrained.

If you want to align the 
window . . .

Then . . .

by sill height select Sill for Vertical alignment, and enter 
a value for Sill height.

by head height select Head for Vertical alignment, and 
enter a value for Head height.

If you want to insert . . . Then . . .

a freestanding window press ENTER, and specify an insertion 
point and a rotation angle for the window.

the window in a wall select the wall and specify an insertion 
point along the wall.

the window in a space 
boundary

select the space boundary and specify an 
insertion point in the space boundary.

If you want to . . . Then . . .
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dows of specific styles with additional properties that you want to be the 
same each time you add a window of each type.

For example, you are creating an office floor plan that contains two custom 
window styles: fixed casement for conference rooms and operable casement 
for offices. To work efficiently, you can create a window tool for each style. 
You can then select the appropriate tool to place windows in offices and con-
ference rooms.

You can use any of the following methods to create a window tool:

� Drag a window that has the properties you want to a tool palette.
� Drag a window style from the Style Manager to a tool palette, and then 

customize the properties of the new tool.
� Copy an existing tool, and then customize the properties of the new tool.
� Drag a tool from a tool catalog in the Content Browser, and then custom-

ize the properties of the tool.

For information about using the Content Browser to create a tool, see 
“Using Tool Catalog Items in Autodesk Architectural Desktop” on 
page 199.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

If you want to . . . Then . . .

create a tool from a window in 
the drawing

select the object, and drag it to the tool 
palette.

create a tool from a window 
style in the Style Manager.

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK.

copy a tool in the current 
palette

right-click the tool, click Copy, and click Paste.

copy a tool from another 
palette

right-click the tool and click Copy; open the 
other palette, and click Paste.
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This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

6 Expand Basic, and expand General.

7 Enter a description of the tool.

8 If you do not want to use the default layer key for windows, select a layer 
key.

9 If you want to override the default layer name for windows, select a layer 
override.

10 Select a window style.

11 For Style location, select the drawing file containing the style used for this 
window, or select Browse and use a standard file selection dialog box to 
select the file.

12 Expand Dimensions.

13 Specify a window size: 

14 Specify where the window width and height are measured to: 

15 Enter a value for Rise, if applicable to the selected style and window type.

16 Enter a value for the Opening percent or Swing angle.

Zero indicates a closed window.

NOTE Defining the opening percent in display properties overrides this set-
ting on the Tool Properties palette. For more information, see “Specifying the 
Display Properties of a Window Style” on page 1946.

17 Expand Location.

If you want to . . . Then . . .

use a standard window size click Standard Sizes, and then select a 
window size.

use a custom window size enter values for Width and Height.

If you want to measure to . . . Then . . .

the outside of the window frame Select Outside of frame for Measure to.

the inside of the window frame Select Inside of frame for Measure to.



1910 | Chapter 26 Windows

18 Specify the position of the window when it is placed in a wall or a space 
boundary:

19 Enter a value for the head height.

20 Enter a value for the sill height.

21 Click OK.

Editing Windows

After you create a window, you can change the size, height, width, rise, and 
opening. You can also move the window within the wall, flip the hinge or 
swing, and change the swing opening.

You can change the properties of existing windows in your drawing by 
changing the window style, changing the dimensions of the window, mov-
ing the anchor location of the window, and specifying the endcap conditions 
of the window. 

Autodesk® Architectural Desktop offers several methods for editing windows:

� You can directly edit windows using grips for dimensions and other phys-
ical characteristics.

� You can change window settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

window.

If you want to . . . Then . . .

position the window at a 
specific distance between the 
edge of the opening and the 
end of a wall segment or space 
boundary

select Offset/Center for Position along 
wall, and enter a value for Automatic 
offset.

center the window on a wall 
segment or space boundary

select Offset/Center for Position along 
wall, and specify a point near the center of 
the wall segment or space boundary.

position the window anywhere 
along the wall or space 
boundary

click Position along wall, and select 
Unconstrained.
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Related Procedures

� Using Grips to Edit Windows

� Changing the Window Style

� Changing How Window Width is Measured

� Changing the Window Swing Angle or Opening Percent

� Changing the Vertical Alignment of a Window

� Moving a Window Along a Wall or Space Boundary

� Moving a Window Within a Wall or Space Boundary

� Using Anchors to Change the Horizontal Position of a Window

� Using Anchors to Change the Vertical Position of a Window

� Using Anchors to Change the Position of a Window Within a Wall or 
Space Boundary

� Changing the Orientation of a Window to a Wall or Space Boundary

� Changing the Opening Endcap Assigned to a Window

� Changing the Location of a Freestanding Window

� Attaching Hyperlinks, Notes, and Files to a Window

Using Grips to Edit Windows

You can use grips to modify the following window properties:

� Dimensions (width and height)
� Location in a wall or space boundary
� Hinge side (left- or right-hand)
� Swing direction
� Rise

Rise applies to Peak Pentagon, Arch, and Gothic window shapes. For more 
information, see “Specifying the Design Rules of a Window Style” on 
page 1940.

Refer to the illustrations and steps in this topic to use window grips to edit 
windows.

Editing the Dimensions of a Window That Has Standard Sizes

1 Select the window.
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Window Dimension Grips

2 Select the grip for the dimension you want to change.

The grip is initially set to constrain the sizing to one of the standard values 
defined for the style of window. For example, if you select the width grip, 
the grip is set to constrain the width to one of the standard values defined 
for that style of window.

Standard height window with width grip selected

The CTRL key acts as a toggle between standard and custom sizing. 

A series of tick marks indicates the standard sizes for the selected dimen-
sion. As you move the grip, it snaps to each tick mark and displays the 
measurement at that mark. 



Editing Windows | 1913

The size and color of the grip tick marks indicate whether setting a stan-
dard value for the dimension results in a standard window size. For exam-
ple, if the height of the window is set to a non-standard value, the window 
is still not a standard size even if you set the window width to one of the 
standard width values for that window style. Long grey tick marks indicate 
that a standard size is possible; short red marks indicate that another 
dimension is already set to a non-standard value.

3 Resize the dimension:

If you want to change 
the dimension . . .

Then . . .

using a standard size move the grip until the value you want is 
displayed, and click once.

using a non-standard size press CTRL, and either move the grip until 
the value you want is displayed and then 
click once, or else enter a value.
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Changing a window width
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Changing a window height
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Editing the Dimensions of a Window That Does Not Have Standard Sizes

1 Select the window.

2 Select the grip for the dimension you want to change.

3 Either move the grip until the dimension value you want is displayed and 
then click once, or else enter a value.

Moving a Window Anchored to a Wall or Space Boundary

1 Select the window.

2 Select the Location grip.

Window Location and Flip Grips

3 With the grip selected, press the CTRL key to switch the direction of move-
ment. 

You can move along the wall, within the wall, and vertically. 

4 Move the grip until the window is in the desired location, and click once.

Moving a Freestanding Window

1 Select the window.

2 Select the Location grip.

3 Move the window to the appropriate location, and click once.
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Changing the Hinge Side of a Window

1 Select the window.

2 Select the Flip grip to reverse the side of the window that hinges are 
located on.

Flipping a window hinge

Changing the Swing Direction of a Window

1 Select the window.

2 Select the Flip grip to reverse the swing direction of the window.
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Flipping a window swing

Changing the Rise of a Window

1 Select the window.

2 Select the Rise grip.
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Changing a window rise

3 Move the grip until the rise value you want is displayed and click once, or 
enter a value.

Changing the Window Style

Use this procedure to change the style for a window or group of windows.

1 Select one or more windows, and double-click one of them.

2 On the Properties palette, expand Basic, and expand General.

3 Select a window style.
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Changing How Window Width is Measured

Use this procedure to change how the width of a window or windows is mea-
sured.

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Dimensions.

Specifying window frame measurement

3 Specify the location to which window width is measured:

Changing the Window Swing Angle or Opening 
Percent

Use this procedure to change the swing angle or opening percent of a win-
dow or group of windows. 

A window with an opening percent of zero is closed.

If you want to size the 
windows . . .

Then . . .

to the inside frame select Inside of frame for Measure to.

to the outside frame select Outside of frame for Measure to.
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NOTE Defining the opening percent in display properties overrides this setting 
on the Properties palette. For more information, see “Specifying the Display 
Properties of a Window Style” on page 1946.

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Dimensions.

3 Enter a value for Swing angle or Opening percent.

Changing a window swing angle

Changing the Vertical Alignment of a Window

Use this procedure to change the vertical alignment of a window or group of 
windows. 

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.
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3 Specify whether you want the window aligned vertically by sill height or 
by head height:

Moving a Window Along a Wall or Space 
Boundary

Use this procedure to change the location of one or more windows along a 
wall or space boundary by offsetting the windows from a reference location. 

This feature is useful when you want to position a window at a specified dis-
tance from another object. For example, you may want to specify an exact 
distance between a series of windows along a wall.

NOTE If the defect marker appears in the wall after you move a window, the 
window is too close to other objects in the wall or to the end of the wall for the 
endcaps to fit. Adjust the position of the window until the defect marker disap-
pears.

1 Select the window you want to move, right-click, and click Reposition 
Along Wall.

A marker indicates the current location within the opening.

2 Specify where to measure the offset from:

3 Select a point to measure to (the reference point).

If you want to align the 
windows . . .

Then . . .

by sill height select Sill for Vertical alignment, and enter 
a value for Sill height.

by head height select Head for Vertical alignment, and 
enter a value for Head height.

If you want to measure 
the offset . . .

Then . . .

from the center of the window select a point near the center of the 
window.

from an end of the window select a point on the end of the window 
you want to measure from.
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You can select a point along the wall.

4 Specify the distance between the points you selected:

If you want to . . . Then . . .

move the window to the 
reference point

enter 0.

move the window a specified 
distance from the reference 
point

enter a value for the offset distance.

specify the distance as a 
measurement between two 
points, such as the distance 
between the centers of two 
windows that are correctly 
positioned

select the two points measuring the 
distance.
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Repositioning a window along a wall
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Moving a Window Within a Wall or Space 
Boundary

Use this procedure to move one or more windows within a wall or space 
boundary by offsetting the windows from a reference location.

This feature allows you to align windows within the thickness of a wall or 
space boundary. You can set an offset distance from any point within a wall, 
or center the windows between the faces of a wall or space boundary. You can 
select doors, windows, and openings and reposition them at the same time. 
If you select more than one object, you can select only one side to offset. 

1 Select the windows you want to move, right-click, and click Reposition 
Within Wall.

A marker indicates the current location within the opening. This may be 
the center of the frame, the interior face of the frame, or the exterior face 
of the frame.

2 Specify where to measure the offset from:

3 Select a point to measure to.

4 Specify the offset distance from the selected point:

If you want to . . . Then . . .

center the windows between 
the faces of the wall or space 
boundary

select a point near the center of the 
window.

offset the windows from the 
interior or exterior face

select a point on the side of the face you 
want to measure from.

If you want to . . . Then . . .

center the windows between 
the faces of the wall or space 
boundary

use the Midpoint osnap to select the 
midpoint of the end of the wall.

move the windows to the 
reference point

enter 0.

move the windows a specified 
distance 

enter a value for the offset distance.
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Repositioning a window within a wall

Using Anchors to Change the Horizontal Position 
of a Window

Use this procedure to change the horizontal position of windows along a wall 
or space boundary to which the windows are anchored.

specify the distance as a 
measurement between two 
points

select the two points measuring the 
distance.

If you want to . . . Then . . .
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Window position along the X axis parameters

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

For space boundaries, expand Location on space boundary.

3 Click Anchor.

4 Select the reference point for the anchor along the X axis: 

If you want to . . . Then . . .

use the start of the wall as the 
reference point

under Position Along (X), select Start of 
wall for From.

use the start of the space 
boundary as the reference point

under Position Along (X), select Start of 
curve for From.

use the midpoint of the wall as 
the reference point

under Position Along (X), select Midpoint 
of wall for From.

use the midpoint of the space 
boundary as the reference point

under Position Along (X), select Midpoint 
of curve for From.
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5 Enter the distance from the reference point at which to place the win-
dows.

Use a negative value to measure from endpoint to start point.

6  Select the position of the windows to measure to: 

7 Click OK.

Using Anchors to Change the Vertical Position of 
a Window

Use this procedure to change the vertical position of windows in a wall or 
space boundary to which the windows are anchored.

use the end of the wall as the 
reference point

under Position Along (X), select End of 
wall for From.

use the end of the space 
boundary as the reference point

under Position Along (X), select End of 
curve for From.

If you want to measure to . . . Then . . .

the start edge of the windows select Start Edge of object for To.

the center of the windows select Center of object for To.

the end edge of the windows select End Edge of object for To.

If you want to . . . Then . . .
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Window position along the Z axis parameters

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4 Select the reference point for the anchor along the Z axis: 

If you want to . . . Then . . .

use the bottom of the wall height as 
the reference point

under Position Along (Z), select Bottom 
of wall height for From.

use the bottom of the space boundary 
height as the reference point

under Position Along (Z), select Bottom 
of curve height for From.

use the center of the wall height as the 
reference point

under Position Along (Z), select Center 
of wall height for From.
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5 Enter the distance from the reference point at which to place the win-
dows.

Use a negative value to measure from endpoint to start point.

6  Select the position of the windows to measure to: 

7 Click OK.

Using Anchors to Change the Position of a 
Window Within a Wall or Space Boundary

Use this procedure to change the position of windows horizontally within a 
wall or space boundary to which the windows are anchored.

use the center of the space boundary 
height as the reference point

under Position Along (Z), select Center 
of curve height for From.

use the top of the wall height as the 
reference point

under Position Along (Z), select Top of 
wall height for From.

use the top of the space boundary 
height as the reference point

under Position Along (Z), select Top of 
curve height for From.

If you want to measure to . . . Then . . .

the bottom of the windows select Sill (Bottom) of object for To.

the center of the windows select Center of object for To.

the top of the windows select Head (Top) of object for To.

If you want to . . . Then . . .
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Window position along the Y axis parameters

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Anchor.

4  Select the reference point for the anchor along the Y axis: 

5 Enter the distance from the reference point at which to place the win-
dows.

Use a negative value to measure from endpoint to start point.

If you want to . . . Then . . .

use the left edge of the wall as 
your reference point

select Left edge of wall width for From.

use the left edge of the space 
boundary as your reference point

select Left edge of curve width for From.

use the center of the wall as your 
reference point

select Center of wall width for From.

use the center of the space 
boundary as your reference point

select Center of curve width for From.

use the right edge of the wall as 
your reference point

select Right edge of wall width for From.

use the right edge of the space 
boundary as your reference point

select Right edge of curve width for From.
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6  Select the position of the windows to measure to: 

7 Click OK.

Changing the Orientation of a Window to a Wall 
or Space Boundary

Use this procedure to change the vertical orientation of windows in a wall or 
space boundary to which the windows are anchored.

1 Select the windows you want to change, and double-click one of them.

2 On the Properties palette, expand Basic, and expand Location.

3  Click Anchor.

4 Enter the X and Z rotation angles of the windows.

5 Indicate if you want to reverse the flip direction of the windows in the X, 
Y, and Z axes: 

6 Click OK.

Changing the Opening Endcap Assigned to a 
Window

Use this procedure to change the opening endcap style assigned to windows.

If you want to measure to . . . Then . . .

the front of the windows select Front of object for To.

the center of the windows select Center of object for To.

the back of the windows select Back of object for To.

If you want to reverse . . . Then . . .

the direction the windows open to select Flip X.

the side of the wall the windows 
open to

select Flip Y.

the top and bottom of the 
windows

select Flip Z.
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NOTE Each opening endcap style is generally created for use with a specific 
wall style. Changing the opening endcap style used for individual windows may 
cause the wall to display a defect marker.

For more information, see “Opening Endcap Styles.”

1 Select the windows whose endcaps you want to change, and double-click 
one of them.

2 On the Properties palette, expand Basic, and expand Location.

3 Expand Endcaps.

4 Select the opening endcap style.

Changing the Location of a Freestanding Window

Use this procedure to relocate a freestanding window by changing the coor-
dinate values of its insertion point. The window also has an orientation with 
respect to the WCS or the current UCS. For example, if the top and bottom 
of the window are parallel to the XY plane, its normal is parallel to the Z axis. 
You can change the orientation of the window by aligning its normal with 
another axis. You can also rotate the window on its plane by changing the 
rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD User’s Guide.

1 Double-click the window you want to move.

2 On the Properties palette, expand Basic, expand Location, and click Addi-
tional Information.

3 In the Location dialog box, specify the window location:

If you want to . . . Then . . .

relocate the window enter new coordinate values under Insertion Point.

locate the window on the 
XY plane

make the normal of the window parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the window on the 
YZ plane

make the normal of the window parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 
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4 Click OK.

Attaching Hyperlinks, Notes, and Files to a 
Window

Use this procedure to enter notes and attach reference files to a window. You 
can also edit notes and edit or detach reference files from a window.

1 Double-click the window you want to attach notes or files to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD Com-
mand Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

5 Click  next to Reference documents, and then attach, detach, or edit a 
reference file:

6 Click OK.

locate the window on the 
XZ plane

make the normal of the window parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
window

enter a new value for Rotation Angle.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If you want to . . . Then . . .
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Window Styles

A window style is a group of properties assigned to a window that determines 
the appearance and other characteristics of the window.

You can use window styles to represent standard window types for specific 
jobs and drawings or for office standards. When you create or modify a win-
dow style, the windows using the style have the settings and characteristics 
of the style. Templates provided with Autodesk Architectural Desktop con-
tain window styles for many standard windows. You can create your own 
window styles and window types for custom windows.

Each window you create has a window style associated with it. The window 
style controls window properties such as dimensions, design rules, and stan-
dard sizes for windows. Style control means that when you change a window 
style, the windows in the current drawing that use that style change globally. 

The design rules are window-style properties that determine the predefined 
or custom shape and window type. Window shapes such as Arch, Gothic, 
Rectangular, and Round are the geometric configurations of the window. 
Custom shapes, such as Hinged-Single-Full Lite, are available for particular 
window types, for example a Single Casement window type. Window types, 
such as Awning, Pass Through, or Casement, describe window opening char-
acteristics of closure, swing, and hinging.

You can create a style using default style properties or by copying an existing 
style. After you create the style, you edit the style properties to customize the 
characteristics of the style. 

Creating Tools from Window Styles
You can create a window tool from any window style. You can drag the style 
from the Style Manager onto a tool palette. You can then specify default set-
tings for any window created with that tool. For more information, see 
“Using Window Tools to Create Windows” on page 1904.

Related Topics and Procedures

� Creating a Window Style

� Specifying the Dimensions of a Window Style

� Specifying the Standard Sizes of a Window Style

� Creating a Custom Window Shape

� Specifying the Design Rules of a Window Style

� Editing the Geometry of a Window Style

� About Window Display Components and Materials
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� Assigning Materials to a Window Style

� Adding Classifications to a Window Style

� Specifying the Display Properties of a Window Style

� Attaching Notes and Files to a Window Style

� Creating Muntins in a Window Style

Creating a Window Style

Use this procedure to create a window style. 

You can create a new style with default style properties, or you can create a 
new style by copying an existing style. After you create the style, you edit the 
style properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Architectural Objects, and expand Window Styles.

3 Create a window style:

4 Enter a name for the new window style, and press ENTER.

5 To edit the style properties of your new window style, right-click the style, 
and click Edit:

If you want to create 
a new style . . .

Then . . .

with default properties right-click Window Styles, and click New.

from an existing style right-click the window style you want to copy, and 
click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

change dimension 
properties of the style

see “Specifying the Dimensions of a Window Style” 
on page 1937.

change the design rules of 
the style

see “Specifying the Design Rules of a Window Style” 
on page 1940.

change the standard 
window sizes of the style

see “Specifying the Standard Sizes of a Window 
Style” on page 1938.
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6 If you want to assign the style to a window tool, drag the style from the 
Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating a Window Tool” on page 1907.

7 Click OK. 

Specifying the Dimensions of a Window Style

Use this procedure to change the default dimensions of a window style.

1 Open a tool palette that has a window tool.

assign materials to the 
components of the 
window style,

see “Assigning Materials to a Window Style” on 
page 1944 and “Turning on Materials for a Window 
Style” on page 1947.

add classifications to a 
window style

see “Adding Classifications to a Window Style” on 
page 1945.

specify the display 
properties of the style

see “Specifying the Display Properties of a Window 
Style” on page 1946.

change the appearance of 
the display components in 
the style

see “Changing the Layer, Color, and Linetype of 
Window Components” on page 1946.

add custom block 
components to the style

see “Adding Components to a Window Style” on 
page 1948.

turn off components in the 
style

see “Turning Off Components in a Window Style” 
on page 1950.

remove components from 
the style

see “Removing Components from a Window Style” 
on page 1951.

override the opening 
percentage from the style

see “Specifying the Opening Percentage for a 
Window Style” on page 1951.

change the sill from the 
style

see “Specifying the Display of Window Sills in a 
Window Style” on page 1952.

add muntins to the style see “Creating Muntins in a Window Style” on 
page 1953. 

add notes, files, or 
documents to the style

see “Attaching Notes and Files to a Window Style” 
on page 1953.

If you want to . . . Then . . .
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2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit. 

4 Click the Dimensions tab.

5 Change dimension values:

6 Click OK twice.

Specifying the Standard Sizes of a Window Style

Use this procedure to create the standard window sizes in a window style.

Standard sizes ensure consistency by allowing designers to select sizes from a 
predefined list specific to the window style. You can also enter custom sizes 
when you add or modify individual windows.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the window style you want to edit, and click Edit. 

If you want to . . . Then . . .

change the frame width 
and depth

under Frame, enter values for Width and Depth.

set the frame width to the 
wall thickness

under Frame, select Auto-Adjust to Width of Wall.

change the sash 
dimensions

under Sash, enter values for Width and Depth.

change the window 
thickness

enter a value for Glass Thickness.
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4 Click the Standard Sizes tab, and add, change, or remove window-size val-
ues:

Description can be used to identify standard window sizes in window 
schedules. For example, you can specify a manufacturer’s size or model 
code for Description.

Rise applies to Arch, Gothic, and Peak Pentagon window shapes. Bottom 
Sash applies to Uneven Single Hung and Uneven Double Hung windows. 
For more information on window types and shapes, see “Specifying the 
Design Rules of a Window Style” on page 1940

5 Click OK twice.

Creating a Custom Window Shape

Use this procedure to create a profile for a custom window shape. You can 
make custom shapes for windows and apply them to window styles.

The profile is made up of two concentric, closed polylines. The outer 
polyline, or ring, becomes the window shape, and the inner polyline creates 
a void for the inside shape of the window frame. You can create multiple 
voids by adding more inner polylines. The inner polyline must be entirely 
within the polyline representing the outer shape of the window frame. The 
polylines are proportional in size and shape to each other and also to the 
windows created from the window style. 

You can draw these polylines anywhere in the drawing and use any conve-
nient scale relative to your final window frame size. One method for sizing 
the polylines relative to the window is to draw them by snapping to an exist-
ing window, and then moving the completed polylines to the side.

If you want to . . . Then . . .

create standard sizes click Add. Under Standard Sizes, enter values for 
Description, Width and Height; if applicable, enter 
values for Rise and Bottom Sash.

change a size select the size, and click Edit. Enter new values as 
needed.

delete a size select a size, and click Remove.
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Adding a profile-based window to a wall

1 Draw concentric, closed polylines representing the outer and inner lines 
of the window frame. 

2 Select the outer polyline, right-click, and click Convert To ➤ Profile 
Definition.

3 Enter a (Add ring).

4 Select the inner polyline.

5 Specify the insertion point of the profile.

The insertion point is typically the lower-left corner.

6 Enter a name for the profile, and click OK.

To add the profile to a window style, see “Specifying the Design Rules of a 
Window Style” on page 1940.

Specifying the Design Rules of a Window Style

Use this procedure to specify the shape and the type of window for a window 
style. 
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Window shapes are named geometrical descriptions of a window. You can 
select predefined and custom window shapes, or create your own shape from 
profiles. For more information, see “Creating a Custom Window Shape” on 
page 1939.

The window type describes the method for opening the window. For exam-
ple, you can use the Rectangular or Half Round predefined shapes for the 
Double Casement or Single Hopper window types. Or, you can use a custom 
Hinged-Single-Full Lite shape for a Single Casement with Muntins.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the window style you want to edit, and click Edit.

4 Click the Design Rules tab. 

5 Select a window shape:

6 Select a window type.

7 Click OK twice.

Editing the Geometry of a Window Style

Use this procedure to edit the geometry of the profile used to define a win-
dow style. You can also add a profile to a window style that does not cur-
rently use a profile to define its shape.

1 Add a window that has the style you want to change.

2 Add or edit a profile:

If you want to . . . Then . . .

use a predefined window 
shape

under Shape, click Predefined, and select a shape.

use a custom window 
shape

under Shape, click Use Profile, and select a profile.

If you want to . . . Then . . .

add an existing profile to the 
style

select the window, right-click, and click Add 
Profile. Select the name of the profile, and 
click OK.
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3 If prompted that the profile is not drawn to size, click Yes.

The area of the window defined by the profile is selected and hatched in 
the drawing.

NOTE After you perform an editing task from the shortcut menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the shortcut menu, select the 
profile, and right-click to display the shortcut menu.

4 Edit the profile:

create a profile and add it to the 
style

select the window, right-click, and click Add 
Profile. Select Start from scratch for Profile 
Definition, enter a name for new profile, and 
click OK. A rectangular profile is created for 
you to edit to define the required geometry.

edit the existing profile for the 
style

select the window, right-click, and click Edit 
Profile in Place.

If you want to . . . Then . . .

change the shape of the 
perimeter of the profile or its 
ring

select the profile, and use grips to adjust the 
shape.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace an existing ring of the 
profile with new geometry

select the profile, right-click, and click Replace 
Ring. Select the ring to replace, and select the 
new geometry. Press ENTER to keep the 
geometry, or enter n (No) to erase it.

If you want to . . . Then . . .
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5 Save or discard the changes:

About Window Display Components and 
Materials

A window object consists of a number of components whose display proper-
ties can be determined by a material assigned to each component. 

When you assign materials to a window, you assign one material to each dis-
play component of the window. For example, you assign a wood material to 
the frame and a glass material to the window glass. 

If you want to use the display properties of the window object or window 
style instead of using material display properties, you can turn off the mate-
rial assignments in the display properties of the window or the window style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
is used for all linework in Plan view. The Surface Hatch component of a mate-
rial is used to hatch all object surfaces in 3D model views and elevations. 

For a complete list of material components and their description, see “Mate-
rial Components and Display Properties” on page 498.

If you want to . . . Then . . .

restore the profile to its original 
shape select the profile and click .

save the changes to the current 
profile select the profile, and click .

The window style uses the edited profile to 
define its geometry. Any other objects or styles 
that use this profile are also updated with the 
edited geometry.

save the changes to a new 
profile definition

select the profile, right-click, and click Save as 
New Profile. Enter a name for the new profile 
definition, and click OK.
The window uses the new profile to define its 
geometry. Any windows of this style are 
updated with the new geometry. Other styles 
or objects that use the original profile are not 
affected.
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The following table lists all window components that can be displayed using 
materials assigned to them, and identifies the material component of each 
window component. 

Assigning Materials to a Window Style

Use this procedure to assign materials to the individual components of a win-
dow style. When you assign materials to window components, the compo-
nents use the display properties of the material. For more information, see 
“About Window Display Components and Materials” on page 1943.

You can specify the materials used to display the following components of a 
window style:

� Frame
� Sash
� Glass

Window 
Component

Material Component

Plan, Plan High Detail, Reflected 

Frame LInework

Sash LInework

Glass Linework

Plan Low Detail

Window Linework

Model

Frame 3D Body

Sash 3D Body

Glass 3D Body

Elevation

Frame 2D Section/Elevation Linework

Sash 2D Section/Elevation Linework

Glass 2D Section/Elevation Linework
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� Muntin

NOTE If a material assignment does not determine the display properties of a 
window component, you can change the display properties of the window style 
as described in “Specifying the Display Properties of a Window Style” on 
page 1946.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which you want changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for any component to which you want to assign a mate-
rial, and click OK.

If the setting for By Material is not available, the display of this compo-
nent cannot be determined by a material.

9 Click the Materials tab.

10 Click the component you want to change, and select a different material 
definition.

You can select any material definition in the current drawing, or click  
to create a new material definition and assign it to a component.

WARNING! Although you can edit a material definition from this dialog 
box, any changes you make to the material definition apply to all objects that 
are assigned the material.

11 Click OK twice.

Adding Classifications to a Window Style

Use this procedure to specify classifications for any classification definition 
applied to a window style.
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For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to window 
styles.

5 For each classification definition, select the classification you want to 
apply to the current window style.

6 Click OK twice.

Specifying the Display Properties of a Window 
Style

In most cases, you want the appearance of windows that belong to the same 
style to be consistent throughout a drawing. To achieve this, you specify the 
display properties of the windows in each window style:

� The layer, color, and linetype of window components
� The hatching used with each component
� The cut plane height and the display of components relative to the cut 

plane
� Other specific window display information, such as window rise

Related Procedures

� Changing the Layer, Color, and Linetype of Window Components

� Turning on Materials for a Window Style

� Using Custom Blocks to Create Window Components

� Adding Components to a Window Style

� Turning Off Components in a Window Style

� Removing Components from a Window Style

� Specifying the Opening Percentage for a Window Style

� Specifying the Display of Window Sills in a Window Style

Changing the Layer, Color, and Linetype of Window 
Components
Use this procedure to change the display properties of the window style:
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� Visibility (display component is on or off)
� By material (material assigned to the display component determines its 

layer properties)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE If a material assignment determines the properties of components in 
the window style, you can change the properties of the display component by 
clearing By Material or by overriding the material assignment with a different 
material. For more information, see “Assigning Materials to a Window Style” on 
page 1944.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which you want changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK.

Turning on Materials for a Window Style
Use this procedure to turn on material assignments for individual display 
representations in a window style.

For information on creating and assigning materials, see “About Window 
Display Components and Materials” on page 1943.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which you want changes to appear, 
and select Style Override.



1948 | Chapter 26 Windows

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select By Material for each component you want to be controlled by the 
material. The ByMaterial checkbox is unavailable for components that 
cannot be assigned a material.

When you select By Material for a display component, all other settings in 
the dialog are greyed out. The display properties are now taken from the 
material definition, so you can no longer set them directly in the display 
properties of the window style. 

9 Click OK twice.

Using Custom Blocks to Create Window Components
You can add custom blocks for components, such as window hardware, to 
the display components or to replace the default display components. For 
example, you can replace a simple window frame with a custom window 
frame containing shutters in which you want the custom component to 
appear. You can have a different custom block for each display representa-
tion.

When you add a custom block, you can specify several rules for positioning 
and scaling the new component. Each custom block also appears in the dis-
play properties component list so that you can control its layer, color, and 
linetype. For more information on adding custom blocks, see “Adding Com-
ponents to a Window Style” on page 1948.

If you create a custom block from mass elements, you can use the material 
assignments of the mass elements to determine the display properties of the 
custom block.

Be sure to set the properties of the objects used to create your custom blocks 
to ByBlock. Otherwise, you cannot control these objects through the display 
properties. For more information about ByBlock, see “Work with Layers” in 

the online AutoCAD® User’s Guide.

Adding Components to a Window Style
Use this procedure to add or edit custom block components in the display 
representation of window styles. 

1 Create a block for the component to add to the window style. 

Create the block in the same plane as the window that you use to repre-
sent the style. For more information about custom blocks, see “Using Cus-
tom Blocks to Create Window Components” on page 1948.
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2 Open a tool palette that has a window tool.

3 Right-click a window tool, and click Window Styles.

4 Right-click the style you want to edit, and click Edit.

5 Click the Display Properties tab.

6 Select the display representation in which you want changes to appear, 
and select Style Override.

7 If necessary, click .

8 Click the Other tab.

9 Specify whether to add or edit a block component:

10 Select the block to use, and click OK.

11 Specify whether you want to scale to fit the block component to the object 
by width, depth, and height, or to lock the XY ratio:

If you want to . . . Then . . .

add a new block 
component

click Add, and then click Select Block.

edit an existing block 
component

select the component to edit, and click Edit.

If you want to . . . Then . . .

set the block scale to the 
width of the object

select Width.

set the block scale to the 
depth of the object

select Depth.

set the block scale to the 
height of the object

select Height.

scale the whole block 
equally, so that one 
direction is scaled to fit 
another of the scale 
criteria

select Lock to XY Ratio.

scale the block to its 
original size

clear all options under Scale to Fit.
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12 Specify whether to mirror the block in the X,Y, or Z direction:

13 Specify the X, Y, and Z location of the insertion point.

14 Specify an insertion offset of the block in the X, Y, and Z directions.

15 Specify whether the component is for the window frame or window glass 
component:

Frame and Glass components are not available in some display represen-
tations.

16 Click OK four times.

Turning Off Components in a Window Style
Use this procedure to turn off custom blocks in a window style.

You can turn off the display of component blocks without removing them 
from the style.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

If you want to create a 
mirror of the block . . .

Then . . .

in the X direction select Mirror X.

in the Y direction select Mirror Y.

in the Z direction select Mirror Z.

If you want to add 
the block . . .

Then . . .

to the inside or outside of 
the frame

click Frame Component, and click either Outside or 
Inside.

to all window glass 
components or a single 
window glass component

click Window Component, and click either All or 
Single. If you select Single, enter the component 
number.

NOTE If you specified Depth for Scale to Fit, the 
depth is scaled to the glass thickness. You can scale 
to the window panel thickness instead by selecting 
Scale Depth to Panel Thickness
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4 Click the Display Properties tab.

5 Select the display representation in which you want to turn off the display 
of the window component, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Disable Custom Blocks.

9 Click OK twice.

Removing Components from a Window Style
Use this procedure to remove components from a window style.

Removing component blocks from a window style deletes them from the 
style.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation in which you want to remove the win-
dow component, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select the component to remove, and click Remove.

9 Click OK twice.

Specifying the Opening Percentage for a Window Style
Use this procedure to override the opening percentage in the display repre-
sentation of a window style. For example, you can specify that a window is 
displayed closed in model and elevation representations, but open in plan 
representations.

NOTE This setting overrides other window opening percent settings. If the 
opening percent is specified here, the opening percent entered on the Properties 
palette when you add or modify windows is ignored. 

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.
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4 Click the Display Properties tab.

5 Select the display representation in which you want to override the open-
ing percent, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Select Override Open Percent.

9 Enter a value for the opening percent.

10 Click OK twice.

Specifying the Display of Window Sills in a Window Style
Use this procedure to change the window sill dimensions in the Sill Plan dis-
play representation. 

You must use a display representation for a window that has a sill. You can 
turn on the Sill Plan display representation in addition to the Plan display 
representation.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select Sill Plan for Display Representations, and select Style Override.

6 If necessary, click .

7 Click the Other tab.

Window Sill Dimensions

8 Under Sill Dimensions, enter the sill extension and depth dimensions.

Sill components A and B are for the swing or outside of the window. Sill 
components C and D are for the interior side.
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9 If you want to use the cut plane of the wall for anchored windows, instead 
of using the cut plane of the window, select Respect Cut Plane of Con-
tainer Object when Anchored.

10 Click the Layer/Color/Linetype tab.

11 Under Visible, click the icons to turn on visibility. 

12 Click OK three times.

Attaching Notes and Files to a Window Style

Use this procedure to enter notes and attach reference files to a window style. 
You can also edit reference files attached to the style.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the window, enter the description under Descrip-
tion.

6 Click Notes.

7 To add or edit a note, click the Notes tab, and enter the note.

8 To attach, edit, or detach a reference file, click the Reference Docs tab:

9 Click OK twice.

Creating Muntins in a Window Style

Window muntins are secondary framing members that hold multiple panes 
of glass in a window sash. Autodesk® Architectural Desktop provides an easy 
way to create muntins with different layout patterns.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK.

detach a reference file select the file name, click Delete, and click OK.
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Window muntins are available in several patterns that you can customize 
into many different styles:

� Rectangular
� Diamond
� Prairie 9 Lights
� Prairie 12 Lights
� Starburst
� Sunburst
� Gothic

Starburst and Sunburst patterns are a combined-rectangular pattern with a 
half-round or quarter-round spoked top and can be used for half- and quar-
ter-round as well as rectangular muntins. Gothic is similar but has a gothic 
muntin pattern. The other patterns are primarily rectangular but fit into half-
round window sash. 

You can make custom shapes for window muntins by creating profiles from 
polylines and adding them to a new window style. For information about 
creating profiles and adding them to a window style, see “Creating a Custom 
Window Shape” on page 1939.

Window muntin components

Related Procedures

� Adding Rectangular Muntins to a Window Style

� Adding Diamond Muntins to a Window Style

� Adding Prairie-9 Lights Muntins to a Window Style

� Adding Prairie-12 Lights Muntins to a Window Style

� Adding Starburst Muntins to a Window Style

� Adding Sunburst Pattern Muntins to a Window Style

� Adding Gothic Muntins to a Window Style

� Editing a Window Muntins Block in a Window Style
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� Turning Off the Display of Muntins in a Window Style

� Removing a Window Muntins Block from a Window Style

Adding Rectangular Muntins to a Window Style
Use this procedure to add rectangular muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can apply the rectangular pattern to all window shapes and window 
types except Pass Through.

Specifying rectangular pattern muntins

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.
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10 If the window style contains multiple sash, specify whether you want 
muntins applied to the Top, All, or a Single sash component in the win-
dow: 

Specifying rectangular muntins for top sash

If you want to attach 
muntins to . . .

Then . . .

the top sash only under Window Pane, select Top. Top also 
applies to single sash.

all sash under Window Pane, select Other, and
select All.

an individual sash component under Window Pane, select Other. Select 
Single, and specify the index number for 
window sash.
Sash is indexed counterclockwise, starting 
from the lower left corner.
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Specifying rectangular muntins for an individual sash component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

13 Clean up the muntin intersections:

Specifying rectangular muntin cleanup joints

If you want to convert . . . Then . . .

the muntin intersections to 
corners

under Muntin, select Clean Up Joints.

all the muntins to one body with 
the joints cleaned up

under Muntin, select Convert to Body.
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14 Under Lights, select Rectangular for Pattern. 

15 Enter a value for Lights High to specify the number of light rows in the 
vertical direction.

16 Enter a value for Lights Wide to specify the number of light columns in 
the horizontal direction. 

17 Click OK.

18 Add additional muntins:

19 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

Adding Diamond Muntins to a Window Style
Use this procedure to add diamond muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can apply the diamond pattern to all window shapes and window types 
except Pass Through.

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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Specifying diamond pattern muntins

1 Open a tool palette that has a window tool. 

2 Right-click a window tool, and click Window Styles. 

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the window style contains multiple sash, specify whether you want 
muntins applied to the Top, All, or a Single sash component in the win-
dow: 

If you want to attach 
muntins to . . .

Then . . .

the top sash only under Window Pane, select Top. Top also 
applies to single sash.

all sash under Window Pane, select Other, and
select All.

an individual sash component under Window Pane, select Other. Select 
Single, and specify the index number for 
window sash.
Sash is indexed counterclockwise, starting 
from the lower left corner.
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Specifying diamond muntins for top sash

Specifying diamond muntins to an individual sash component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 
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13 Clean up the muntin intersections:

Specifying diamond muntin cleanup joints

14 Under Lights, select Diamond for Pattern. 

15 Enter a value for Lights High to specify the number of light rows in the 
vertical direction.

16 Enter a value for Lights Wide to specify the number of light columns in 
the horizontal direction. 

17 Click OK.

18 Add additional muntins:

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.
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19 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

Adding Prairie-9 Lights Muntins to a Window Style
Use this procedure to add prairie-9 lights muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can apply the prairie-9 lights pattern to all window shapes and window 
types except Pass Through.

Specifying prairie-9 lights pattern muntins

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.

If you want to add 
muntins to . . .

Then . . .
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3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the window style contains multiple sash, specify whether you want 
muntins applied to the Top, All, or a Single sash component in the win-
dow: 

If you want to attach 
muntins to . . .

Then . . .

the top sash only under Window Pane, select Top. Top also 
applies to single sash.

all sash under Window Pane, select Other, and
select All.

an individual sash component under Window Pane, select Other. Select 
Single, and specify the index number for 
window sash.
Sash is indexed counterclockwise, starting 
from the lower left corner.
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Specifying prairie-9 lights muntins for top sash

Specifying prairie-9 lights muntins to an individual sash component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 
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13 Clean up the muntin intersections:

Specifying prairie-9 lights muntin cleanup joints

14 Under Lights, select Prairie-9 Lights for Pattern. 

15 Enter a value for Edge X Offset to specify the horizontal distance of the 
muntins from the edges of the pane.

16 Enter a value for Edge Y Offset to specify the vertical distance of the 
muntins from the edges of the pane. 

Specifying prairie-9 lights pattern muntin edge X and Y offsets

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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17 Click OK.

18 Add additional muntins:

19 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

Adding Prairie-12 Lights Muntins to a Window Style
Use this procedure to add prairie-12 lights muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can apply the prairie-12 lights pattern to all window shapes and window 
types except Pass Through.

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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Specifying prairie-12 lights pattern muntins

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 If the window style contains multiple sash, specify whether you want 
muntins applied to the Top, All, or a Single sash component in the win-
dow: 

If you want to attach 
muntins to . . .

Then . . .

the top sash only under Window Pane, select Top. Top also 
applies to single sash.

all sash under Window Pane, select Other, and
select All.

an individual sash component under Window Pane, select Other. Select 
Single, and specify the index number for 
window sash.
Sash is indexed counterclockwise, starting 
from the lower left corner.
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Specifying prairie-12 lights muntins for top sash

Specifying muntins to an individual sash component

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 
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13 Clean up the muntin intersections:

Specifying muntin cleanup joints

14 Under Lights, select Prairie-12 Lights for Pattern. 

15 Enter a value for Edge X Offset to specify the horizontal distance of the 
muntins from the edges of the pane.

16 Enter a value for Edge Y Offset to specify the vertical distance of the 
muntins from the edges of the pane. 

Specifying prairie-12 lights pattern muntin edge X and Y offsets

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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17 Click OK.

18 Add additional muntins:

19 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

Adding Starburst Muntins to a Window Style
Use this procedure to add starburst muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can add the starburst pattern only to the top window sash. You can apply 
the starburst pattern to window shapes with a round, half round, or quarter 
round top. 

You can apply the starburst pattern to the following window types:  awning, 
single hopper, single transom, vertical pivot, horizontal pivot, double hung, 
glider, single hung, single casement, and picture. 

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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Specifying starburst pattern muntins

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 Under Window Pane, select Top. 

NOTE The Starburst pattern is available only when Top is selected for Win-
dow Pane.

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

13 Clean up the muntin intersections:

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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Specifying starburst muntin cleanup joints

14 Under Lights, select Starburst for pattern. 

15 Enter a value for Lights High to specify the number of light rows in a ver-
tical direction.

16 Enter a value for Lights Wide to specify the number of panes in the radial 
direction. 

17 Enter a value for Spokes to specify the number of radial muntin spokes.

Specifying number of spokes for starburst muntins

18 Click OK.
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19 Add additional muntins:

20 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

Adding Sunburst Pattern Muntins to a Window Style
Use this procedure to add sunburst muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can add the sunburst pattern only to the top window sash. You can apply 
the sunburst pattern to window shapes with a round, half round, or quarter 
round top. 

You can apply the sunburst pattern to the following window types:  awning, 
single hopper, single transom, vertical pivot, horizontal pivot, double hung, 
glider, single hung, single casement, and picture. 

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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Specifying sunburst pattern muntins

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 Under Window Pane, select Top. 

NOTE The Sunburst pattern is available only when Top is selected for Win-
dow Pane.

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

13 Clean up the muntin intersections:

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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Specifying sunburst muntin cleanup joints

14 Under Lights, select Sunburst for Pattern. 

15 Enter a value for Lights High to specify the number of light rows in a ver-
tical direction.

16 Enter a value for Lights Wide to specify the number of panes in the radial 
direction. 

17 Enter a value for Spokes to specify the number of radial muntin spokes. 

Specifying number of spokes for sunburst muntins

18 Under Hub Style, select Closed for no hub pane, or select Open for a hub 
pane.
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Specifying sunburst muntin open and closed hubs

19 Enter a value for Radius to specify the radius for the hub. 

Specifying sunburst muntin hub radius

20 Click OK. 

21 Add additional muntins:

22 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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Adding Gothic Muntins to a Window Style
Use this procedure to add gothic muntins to a window style.

You add the muntins by editing the display properties of the window style 
for a display representation, such as Model or Elevation, where you want the 
muntins to appear. You can add muntins to display representations individ-
ually. You can also add muntins to a single display representation and auto-
matically apply the muntins to all display representations of that window 
style. You add the muntins block to the window style in the display proper-
ties. Each muntins block becomes a display component of the window style.

You can add the gothic pattern only to the top window sash. You can apply 
the gothic pattern to the following window shapes: round, half round, 
gothic, peak pentagon, or arch. 

You can apply the gothic pattern to the following window types:  awning, 
single hopper, single transom, vertical pivot, horizontal pivot, double hung, 
glider, single hung, single casement, and picture. 

Specifying gothic pattern muntins

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Muntins tab.

8 Click Add.

9 Enter a name for the muntins block.

10 Under Window Pane, select Top. 
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NOTE The Gothic pattern is available only when Top is selected for Window 
Pane.

11 Enter a value for the width of all muntins. 

12 Enter a value for the depth of all muntins. 

13 Clean up the muntin intersections:

Specifying gothic muntin cleanup joints

14 Under Lights, select Gothic for Pattern.

15 Enter a value for Lights High to specify the number of light rows in the 
vertical direction.

16 Enter a value for Lights Wide to specify the number of panes in the hori-
zontal direction. 

Count the panes across the bottom row.

If you want to . . . Then . . .

convert the muntin 
intersections to corners

under Muntin, select Clean Up Joints.

convert all the muntins to one 
body with the joints cleaned up

under Muntin, select Convert to Body.
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17 Click OK.

18 Add additional muntins:

19 Click OK four times.

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517.

Editing a Window Muntins Block in a Window Style
Use this procedure to edit the muntins settings for a window style.

After you create a muntins block, you can change any of its settings by edit-
ing the display properties of the window style for each display representa-
tion, such as Model or Elevation. You can edit the muntins for display repre-
sentations individually. You can also edit the muntins for a single display 
representation and automatically apply the changes to all display represen-
tations of that window style.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 

and click .

6 Click the Muntins tab.

7 Select the muntins block to edit.

If you want to add 
muntins to . . .

Then . . .

another window sash in the 
window style

repeat this procedure from step 8.

another display representation click OK, and repeat this procedure from
step 5.

all display representations of the 
selected window style

select Automatically Apply to Other Display 
Representations and Object Overrides.
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8 Click Edit.

9 Edit any of the settings. 

For more information on the settings, see the window muntins type in 
“Creating Muntins in a Window Style” on page 1953.

10 Select Automatically Apply to Other Display Representations and Object 
Overrides to apply the changes to all display representations of the 
selected window style.

Clear this setting to apply the changes to only the selected display repre-
sentation.

11 When you finish editing the window muntins block in the window style, 
click OK four times. 

After you add a muntins block to a window style, you can assign a material, 
such as wood, and specify display properties, such as color and linetype, for 
the muntins. For more information, see “About Window Display Compo-
nents and Materials” on page 1943, “Specifying the Display Properties of a 
Window Style” on page 1946, and “Creating and Editing Materials” on 
page 517 respectively.

Turning Off the Display of Muntins in a Window Style
Use this procedure to turn off the display of muntins in a window style. You 
can turn off the display of window muntins without removing them from 
the window.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want to turn off the display of 

window muntins, and click .

6 Click the Muntins tab.

7 Select Disable Muntins Blocks.

8 Select Automatically Apply to Other Display Representations and Object 
Overrides to apply the changes to all display representations of the 
selected window style.

Clear this setting to apply the changes to only the selected display repre-
sentation.

9 Click OK three times.



Window Styles | 1981

Removing a Window Muntins Block from a Window Style
Use this procedure to remove muntins from a window style. When you 
remove existing muntins blocks from the window style, they are deleted.

To turn off muntins without deleting them, see “Turning Off the Display of 
Muntins in a Window Style” on page 1980.

1 Open a tool palette that has a window tool.

2 Right-click a window tool, and click Window Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Props tab.

5 Select the display representation where you want to remove window 

muntins, and click .

6 Click the Muntins tab.

7 Select the muntins block to remove.

8 Click Remove.

9 Repeat steps 7 and 8 to remove multiple muntins blocks.

10 Select Automatically Apply to Other Display Representations and Object 
Overrides to apply the changes to all display representations of the 
selected window style.

Clear this setting to apply the changes to only the selected display repre-
sentation.

11 When you finish removing muntins blocks from the window style, click 
OK three times. 
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Producing Construction 
Documents

Topics in Part 5

� Area Evaluation

� Sections

� Elevations

� Schedules

� Annotation

� Design Content

� Custom Content

� AEC Dimensions

� Dimension Labels

� Elevation Labels

� Mask Blocks

� Multi-View Blocks

� Cameras

� Napkin Sketch

V
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Area Evaluation

The Area feature allows you to define the areas in your 

drawing, group them, and then calculate the entire 

building according to various norms. You can use the 

Area feature for purposes such as delivering plans for 

government approval, providing cost estimates, and 

carrying out facilities management activities.

Related Topics

� Areas

� Area Groups

� Area Evaluation

In this chapter

� Creating an Area

� Creating an Area Tool

� Editing Areas

� Attaching Areas to Area 
Groups

� Detaching Areas from Area 
Groups

� Area Styles

� Calculation Modifier Styles

� Area Decomposition

� Area Groups

� Creating an Area Group

� Creating an Area Group Tool

� Attaching Area Groups to 
Other Groups

� Detaching Area Groups from 
Other Groups

� Editing Area Groups

� Area Group Styles

� Area Name Definitions

� Area Group Templates

� Area Evaluation

27
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Areas

You create areas either freehand or by deriving them from existing walls and 
building objects. You can add and subtract areas from each other, define area 
calculation modifier styles, and attach areas to area groups.

Areas and Area Groups
An area is an architectural object describing a two-dimensional room. In 

Autodesk® Architectural Desktop, it is used to calculate the areas in the floor 
plan. After designing a floor plan, you create areas from the rooms, construc-
tion areas, and other areas, grouping them into functional and hierarchical 
structures. You then use these group structures to create an area evaluation 
of the floor plan. 

To calculate areas correctly for purposes such as building approval, cost 
estimates, or rent calculation, you may need to modify their values. 

To do this, you attach calculation modifier styles to areas or area groups, 
which change the calculation result. Calculation modifier styles contain for-
mulas. You can, for example, calculate plaster deductions, subtract areas for 
columns, or calculate the tiling in a bathroom.

Areas can be grouped into structures. You could, for example, create an area 
group named Apartment Building, which contains the subgroups First Floor 
and Second Floor. For information about area groups, see “Area Groups” on 
page 2034.

Area Evaluation
After creating areas and area groups in the drawing, you can create an area 
evaluation of the building and export the results into an external document. 
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The area evaluation is a documentation feature that calculates and evaluates 
the area information of your finished floor plan. This information is dis-

played in a separate file that you export from Autodesk® Architectural 
Desktop to a spreadsheet or a word processing application. 

Area evaluation templates ensure that the information is displayed in a con-
sistent, structured way. 

Architects can use the area evaluation feature for submitting floor plans to 
building authorities and customers. This feature can also be used for perform-
ing cost estimates, assigning jobs to contractors, or organizing the facility 
management of buildings.

Uses of Area Evaluations
Following are a number of typical scenarios in which the area evaluation fea-
ture can be used. For more detailed examples, see “Examples for Creating 
Areas” on page 1998.

� As an architect, you have created a plan for a building and want to prepare 
it for approval by the building administration. This includes the decom-
position of areas into area subdivisions, the relation between floor area 
and site area, and values for the base and calculated areas, construction 
areas, traffic areas, floor areas, and functional areas of the plan. 

� You want to rent an apartment. For this, you need to calculate all balcony 
and terrace areas—according to national regulations—with 50 percent of 
their actual value. You also need to calculate the areas under the roof cor-
rectly at the 2 m line and the 1 m line.

� You need to determine different zones in an office landscape, such as 
office cubicles, recreation areas, and walking areas.

� As a facility manager, you need to determine different area types in an 
office building, such as office rooms, restrooms, or sick rooms. 

� You need to categorize of the floor plan into areas that need to be cleaned 
every week to obtain a cost estimation from a building cleaning service. 

� You need an overview of hardware equipment rooms in order to calculate 
the costs for special ventilation systems.

� As a carpeting contractor, you need the perimeter values of all rooms to 
make a cost estimate for baseboard material. 

Flexible Design Process
The flexible and powerful design of the area evaluation feature gives you 
optimal freedom to shape the design process according to your needs. To 
make your workflow as effective as possible, consider the order in which to 
perform the work before you start. 
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You can use a workflow similar to the one you use when creating a drawing 
from a template: first, design the necessary styles, definitions, group tem-
plates and modifier styles; then, create areas and area groups. 

You can also use a workflow similar to the one you use when starting a new 
drawing from scratch: first, create the areas and area groups; then, add styles 
and other definitions as necessary.

Or, you can use a combination of the two methods, creating a number of def-
initions beforehand, such as, group templates and name definitions, and 
defining other settings, such as calculation modifier styles, when you need 
them. 

Related Topics and Procedures

� Process Overview: Designing from Definition to Object

� Process Overview: Designing from Object to Definition

� Using Area Tools to Create Areas

� Creating an Area

� Creating an Area with User-Specified Settings

� Creating Areas from Linework and Object Outlines

� Creating Areas from Closed Boundaries

� Creating an Area Tool

� Examples for Creating Areas

� Process Overview: Creating User-Defined Area Tags

� Editing Areas

� Attaching Areas to Area Groups

� Detaching Areas from Area Groups

� Area Styles

� Calculation Modifier Styles

� Area Decomposition

Process Overview: Designing from Definition 
to Object

This process overview describes a design workflow in which you first create 
the necessary definition elements such as area styles, area group templates, 
name definitions, and calculation modifier styles. Then you create a group 
structure and, finally, you create the areas and attach them to the groups.
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The advantage of this approach is that you work in a well-structured environ-
ment and can use templates. The drawback is that you have a longer plan-
ning phase in the beginning. 

NOTE It is good idea to save your calculation modifier styles, area name defi-
nitions, and area group templates into a drawing template, so that you can reuse 
them later.

Step 1: Create the necessary calculation modifier styles. 

For example, you might define a plaster deduction of 3 percent for an inte-
rior room.

Step 2: Create the necessary area name definitions. 

For example, you could create a name definition list according to the 
names in DIN 277.

Step 3: Create the desired area group structure with an area group template. 

For example, you could define an area group template conforming to the 
structure in DIN 277. 

Step 4: Create area groups from the group templates.

Step 5: Create areas and attach them to the area groups.

Step 6: Start the area evaluation.

Related Procedures

� Creating a Calculation Modifier Style

� Creating an Area Name Definition

� Creating Area Groups with User-Specified Settings

� Creating Area Groups from a Group Template

� Creating an Area with User-Specified Settings

� Attaching Areas to Area Groups

� Creating the Area Evaluation Document
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Process Overview: Designing from Object to 
Definition

This process overview describes a design workflow in which you first create 
your areas and area groups. The necessary structure, styles, and definitions 
are created “on the fly” as you need them. 

The advantage of this approach is that you can start quickly and make deci-
sions in the real project environment. The disadvantage is that the workflow 
is interrupted more frequently because you need to create not only areas and 
area groups, but also the logical structures around them, piece by piece. 

Step 1: Create areas.

Step 2: Create, groups, group templates, calculation modifier styles, and 
name definitions as you need them.

Step 3: Start the area evaluation.

Related Procedures

� Creating an Area with User-Specified Settings

� Creating Area Groups with User-Specified Settings

� Attaching Areas to Area Groups

� Creating the Area Evaluation Document

Using Area Tools to Create Areas

Tools provided with Autodesk® Architectural Desktop let you quickly place 
areas by selecting an area tool with a specific style and other predefined prop-
erties. You can use the default settings of the tool, or you can change settings 
for the area properties. You can also use area tools to convert linework to 
areas and to apply the settings of an area tool to existing areas.
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Tool palettes containing area tools

The default tool palettes in the workspace contain sample area tools that you 
can use and customize as needed. In addition, the following catalogs pro-
vided with the software contain area tools that you can add to your tool pal-
ettes:

� Autodesk Architectural Desktop Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette Catalog
� My Tool Catalog

Custom palettes created by your CAD manager or other users may also con-
tain area tools with styles and properties customized for your projects or 
office standards.

Related Procedures

� Creating an Area

� Creating an Area with User-Specified Settings

� Creating Areas from Linework and Object Outlines

� Creating Areas from Closed Boundaries

� Creating an Area Tool



1992 | Chapter 27 Area Evaluation

Creating an Area

Use this procedure to add a new area that has the properties specified in the 
area tool that you select. To specify settings when you add an area, see “Cre-
ating an Area with User-Specified Settings” on page 1992.

1 Open the tool palette that you want to use, and select an area tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the starting point of the first area line segment in the drawing. 

3 Specify further points to define the area.

4 Press ENTER.

Creating an Area with User-Specified 
Settings

Use this procedure to add an area with settings that you specify.

1 Open the tool palette that you want to use, and select an area tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 Select a tag for the area. 

NOTE If no area tags are contained in the list, you can drag a tag into the 

drawing from the AutoCAD® DesignCenter. You can also create your own area 
tags from multi-view blocks. For information about creating your own area 
tags, see “Process Overview: Creating User-Defined Area Tags” on 
page 2000.

5 To add a calculation modifier style to the area, click the setting for Calcu-
lation Modifiers, and select one or more calculation modifiers to the area. 

For information about calculation modifier styles, see “Calculation Mod-
ifier Styles” on page 2023.

6 To attach the area to an area group, click the setting for Area Groups, and 
attach the area to one or more area groups.
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Attaching an area to an area group

If you are unsure about whether the area should be attached to an area 
group, or if area groups have not been created yet, you can omit this step 
and attach the area to a group later.

For information about area groups, see “Area Groups” on page 2034.

7 Specify the start point of the first area line segment in the drawing. 

8 Specify further points to define the area.

Creating an area by specifying points

After you specify the third vertex for the area boundary, the Ortho and 
Close options become available on the shortcut menu.
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Ortho closes the area by drawing two line segments based on the direction 
you specify. The direction is extended until it meets a line perpendicular 
to the initial edge of the area boundary.

 Close closes the area by creating an area line segment from the last point 
specified for the area to the first point specified in this area boundary. 

9 Press ENTER.

Creating Areas from Linework and Object 
Outlines

Use this procedure to create new areas by using the outlines of existing 
objects. This can be useful for defining construction areas that usually consist 
of walls, columns, stairs, and other building objects. 

You can use the following objects as area outlines:

� Walls/Curtain Walls
� Columns/Braces/Beams/Slabs
� Doors/Windows/Window Assemblies
� Roofs/Roof Slabs
� Stairs/Railings
� Mass Elements/Mass Groups
� Spaces/Space Boundaries
� AEC Polygons
� Profiles
� Closed AutoCAD® polylines

Creating an area from a stair object



Creating Areas from Closed Boundaries | 1995

Creating an area from a mass group object

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click an area tool, and click Apply Tool Properties to ➤ Linework 
and AEC Objects.

3 Select the objects and closed polylines to convert, and press ENTER.

4 Enter the height at which the construction area is to be calculated, and 
press ENTER. 

5 Press ENTER to finish the command.

6 Edit the properties of the areas in the Properties palette, if necessary.

Creating Areas from Closed Boundaries

Use this procedure to create areas by selecting the inside of a boundary 
enclosed by building objects. The boundary can be made up of walls, curtain 
walls, window assemblies, or any combination of them. Any structural mem-
bers and mass elements inside the boundary are subtracted from the resulting 
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area. This is useful for determining the areas of a room. 

Area from closed walls with columns subtracted

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click an area tool, and click Apply Tool Properties to ➤ Auto-
Detection.

3 Click the drawing and select the closed walls, curtain walls, or window 
assemblies from which to create an area. 

NOTE If your selection set is very large, this method of creating areas can 
slow performance considerably. If you experience performance problems, try 
using a smaller selection set next time.

4 Press ENTER. 

5 Click inside the selected boundaries.

6 Press ENTER.

7 Press ENTER to finish the command.

8 Edit the properties of the areas in the Properties palette, if necessary.

Creating an Area Tool

Use this procedure to create an area tool and add it to a tool palette. You may 
want to create your own area tools if you are placing multiple areas of specific 
styles that have the same properties.

For example, you are creating an office floor plan with different functional 
types of areas. To work efficiently, you can create an area tool for each area 
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type. You can then select the appropriate tool to add areas with the correct 
type to the floor plan.

1 Open the tool palette on which to create a tool.

2 Create the tool:

3 Right-click the new area tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the area created 
from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select an area style.

10 Select the drawing file containing the style used for this area.

11 Select a tag for the area tool.

12 Select the drawing file containing the tag used for this area.

13 Click OK.

If you want to . . . Then . . .

create a tool from an area in the 
drawing

select the area, and drag it to the tool palette.

create a tool from an area style 
in the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool and click Copy; open the 
other palette, and click Paste.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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Examples for Creating Areas

This topic contains the following examples for creating areas:

� Defining Construction Areas in a Ground Plan

� Measuring an Area from the Axis of the Wall

Defining Construction Areas in a Ground Plan

Use this procedure to define the construction areas in a building.

Construction areas in a floor plan

1 Create the floor plan to be calculated.

2 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

3 Right-click an area tool, and click Apply Tool Properties to ➤ Linework 
and AEC Objects.

4 Select the objects you want to define as construction areas. For example, 
you can choose all walls, columns and mass elements in a floor plan. Mass 
elements are often used to represent construction elements such as heat-
ers or other machines.

NOTE Selecting objects in a large floor plan can be a complex task. Here 
are tips for simplifying this:

Draw a selection marquee around the plan and then SHIFT-click to deselect 
the objects not included in the construction areas.
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Use the Quick Select command to filter for objects included in construction 
areas (for example, walls, columns).

5 Press ENTER.

6 Enter the height at which the construction area is to be calculated, and 
press ENTER.

7 You now have in your drawing a number of areas for every object you 
selected in step 5. To merge them, do one of the following:

� To retain the single area objects but calculate them together as con-
struction area, create an area group named, for example, “Construction 
Area,” and attach all areas to it.

For information about attaching areas to area groups, see “Attaching 
Areas to Area Groups” on page 2017.

� To merge the single area objects into one area object, use the Join com-
mand. 

For information about the Join command, see “Joining Areas” on 
page 2009.

Measuring an Area from the Axis of the Wall

Use this procedure to measure an area from the wall axis. When you create 
areas from the boundaries of walls, the resulting area is, by default, measured 
from the inside of the walls.

Expand the area with grips

For certain calculation standards, however, you must measure rooms from 
the axis of the enclosing walls. You can do this by stretching the area grips to 
the correct position.

1 Create an area from closed boundaries as described in “Creating Areas 
from Closed Boundaries” on page 1995.
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2 Use the grips of the area to drag it to the desired size.

Process Overview: Creating User-Defined 
Area Tags

Autodesk® Architectural Desktop templates offer you a number of predefined 
area tags. You may, however, want to create specific tags that are not included 
in the templates.

The process of creating area tags follows these basic steps:

Step 1: Determine the location of the property set definition of the area tag.

Step 2: If necessary, create a new property set definition to use in the area 
tag.

Step 3: Add attributes from the property set definition to the drawing. 

Step 4: Create a block from the attributes.

Step 5: Create a multi-view block from the block.

Step 6: Add the area tag to the AutoCAD® DesignCenter.

Related Procedures

� Determining the Location of Property Set Definitions

� Adding Attributes

� Creating a Block

� Creating a Multi-View Block

� Adding an Area Tag to the AutoCAD® DesignCenter

Determining the Location of Property Set 
Definitions

Use this procedure to determine the source drawing of the area tag property 
set definition.

When you create an area tag for the DesignCenter, you must save the used 
property set definition in a drawing file that the tag can access when it is 
inserted. There are two possible locations for the source drawing:

� The Autodesk® Architectural Desktop PropertySetDefs.dwg. All existing 
DesignCenter blocks use this default drawing as the container for their 
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property set definitions. If you have a small number of custom tags, this 
is the recommended drawing in which to save them.

� Your own property set definition drawing: You can create a property set 
definition drawing when you have a large number of custom blocks, or if 
you want to have separate drawings for different tag types; for example, 
PropertySetDefsAreas.dwg or PropertySetDefsAreaGroup.dwg, etc. 

NOTE The drawing containing the property set definitions for your tags must 
be located one folder level above the tag drawing. Otherwise, the software can-
not find the associated property set definitions. For example, if your tag resides 
in //Content/Schedules/UserDefined Tags/, then the associated property set defi-
nitions drawing needs to be in //Content/Schedules/.

1 Either open the Autodesk Architectural Desktop PropertySetDefs.dwg, or 
create a new property set definitions drawing. 

NOTE For information on the location of support files, see “Styles and Sup-
port Files” on page 167.

2 If necessary, create a property set definition for the user-defined tag. 

3 Proceed as described in “Adding Attributes” on page 2001.

Adding Attributes

Use this procedure to create attributes for an area tag. An area tag usually con-
tains attributes that display base and calculated area and perimeter values; 
the number, name, and description of the area; as well as any calculation 
modifier styles.

Area attributes come from a property set definition. Predefined attributes are 
available when you either start with a template or start from scratch and drag 
a predefined area tag from the AutoCAD® DesignCenter into the drawing.

If you want to use different attributes for area tags, create your own property 
set definition for areas. For more information, see “Property Set Definitions” 
on page 2241.

Area tag attributes

Attribute/Tag Description

AREA:NUMBER Number for the area
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1 On the command line, enter ddattdef.

2 In the Tag field, enter one of the attributes described above. For example, 
if you want to add an attribute for the base perimeter of the area, enter 
AREA:BASEPERIMETER here. 

3 Proceed to adding the attribute as described in “Working with Attributes” 
in the AutoCAD 2004 User’s Guide. 

4 Repeat steps 1–3 for each attribute you want to add to the area tag.

Creating a Block

Use this procedure to combine area attributes into a block.

1 On the Format menu, click Block ➤ Block Definition.

2 Enter the name of the block.

3 Click Select Objects and select the attributes you want to include in the 
area tag.

4 Select Unitless for Insert Units. 

5 Proceed to creating the block as described in “Defining Blocks” in the 
online AutoCAD 2004 User’s Guide. 

AREA:NAME Name of the area

AREA:DESCRIPTION Description of the area

AREA:BASEAREA Base area value without taking into account 
calculation modifier styles 

AREA:CALCULATEDAREA Calculated area value that results from the base area 
value, plus any calculation modifier styles added to the 
area

AREA:BASEPERIMETER Base perimeter value without taking into account 
calculation modifier styles 

AREA:CALCULATED
PERIMETER

Calculated perimeter value that results from the base 
perimeter value, plus any calculation modifier styles 
added to the area

AREA:CALCULATION
MODIFIERSTYLE

Calculation modifier styles attached to the area

Area tag attributes (continued)

Attribute/Tag Description



Process Overview: Creating User-Defined Area Tags | 2003

Creating a Multi-View Block

Use this procedure to create a multi-view block for the area tag.

For detailed information about multi-view blocks, see “Multi-View Blocks” 
on page 2481.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Multi-View Block Definitions.

3 Right-click Multi-View Block Definitions, and click New.

4 Enter a name for the new multi-view block definition, and press ENTER.

5 Select the new multi-view block definition, right-click, and click Edit.

6 Click the View Blocks tab.

7 Select a display representation for the elevation label.

8 Click Add.

9 Select the block you defined in “Creating a Block” on page 2002, and click 
OK.

10 Select the view directions for the block.

11 Repeat steps 6–9 for each display representation in which to display the 
area tag.

12 Click OK twice.

Adding an Area Tag to the AutoCAD® 
DesignCenter

Use this procedure to add an area tag to the AutoCAD DesignCenter. To do 
this, you need to create a *.dwg file using the AEC Content Wizard.

 For a detailed description of the AEC Content Wizard, see “Custom Con-
tent” on page 2343.

1 On the Format menu, click AEC Content Wizard.

2 Select Custom Command.

3 Select the multi-view block you created in “Creating a Multi-View Block” 
on page 2003, and click Add to add it to the Content File. 

4 On the command line, enter AecAnnoScheduleTagAdd, a space, and the 
name of the multi-view block and its parameters. The command is built 
up as follows: 

_AecAnnoScheduleTagAdd <Name of the drawing containing the prop-
erty set definition>.dwg _SYMBOL <name of the multi-view block cre-
ated>_LEADER _None _DIMSTYLE Current
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In our example, the custom command could look like this: 

_AecAnnoScheduleTagAdd AreaPropertySetDefs.dwg _SYMBOL AreaTag-
MVBlock _LEADER _None _DIMSTYLE Current

5 Click Next. 

6 Select Enable AEC Unit Scaling.

7 Select a layer key for the tag.

NOTE The default layer key for area tags is ROOMNO.

8 Click Next.

9 Enter a file name and directory for the tag. 

NOTE Save the custom tag in a folder one level below the used property 
set definition drawing. For example, if the property set definition drawing is 
saved in //Autodesk Architectural Desktop/Content/Schedules/, then the custom 
tag could be saved in //Autodesk Architectural Desktop/Content/Schedules/Area 
Tags. 

10 Click Finish to exit the AEC Content Wizard.

The new area tag appears in the AutoCAD DesignCenter, at the location you 
specified in the AEC Content Wizard. From here, you can drag it into your 
drawing.

Editing Areas

After you have created an area, you can change properties such as calculation 
modifier styles or the area style. You can also perform geometric operations, 
such as joining areas, subtracting areas from each other, or adding and 
removing vertex points from the area profile.

Autodesk® Architectural Desktop offers several methods for editing areas:

� Edit areas directly using grips for dimensions and other physical charac-
teristics.

� Change area settings on the Properties palette.
� Select editing commands from the shortcut menu for a selected area.
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Related Procedures

� Grip Editing Areas

� Changing the Area Style

� Attaching and Detaching Calculation Modifier Styles

� Assigning an Area to a Different Area Group

� Changing the Location of an Area

� Joining Areas

� Creating Holes in Areas

� Creating Areas from the Intersection of Other Areas

� Adding Vertices

� Removing Vertices

� Trimming Areas

� Dividing Areas

� Removing Rings from Areas

� Reversing Area Rings

� Reversing All Rings in an Area

� Creating Polylines from Areas

� Attaching Hyperlinks, Notes, or Files to an Area

Grip Editing Areas

Areas behave like closed AutoCAD® polylines; however, they have additional 
grip points at the midpoints of each segment for editing. 

Editing Area Dimensions

1 Select the area.

2 Select the grip for the edge or vertex you want to change.

3 Move the grip until the dimension value you want is displayed, and click 
once; or, enter a value.

When you create an area consisting of multiple area rings, each area ring has 
its own grip points. Be careful when editing these areas. For example, if you 
have created an area with a hole in it, and you drag the hole boundary over 
the area’s outer boundary, the result is a faulty area. You can see error symbols 
at positions where the hole boundary crosses the outer boundary. To remove 
those error symbols, drag the hole boundary back inside the outer boundary.
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Grip points of negative boundary dragged incorrectly (bottom) 

Changing the Area Style

Use this procedure to change the area style associated with an area. Area 
styles contain information about the display of the area. For information 
about how to define area styles, see “Creating an Area Style” on page 2018.

1 Select one or more areas and double-click one of them.

2 Expand Basic, and expand General.

3 Select an area style.

Attaching and Detaching Calculation Modifier 
Styles

Use this procedure to attach calculation modifier styles to areas, sort them, 
and detach them.

For information about creating calculation modifier styles, see“Calculation 
Modifier Styles” on page 2023.

1 Select the areas you want to change, and double-click one of them.

2 Expand Basic, and expand General.

3 Click the setting for Calculation Modifiers.
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NOTE This setting can be edited for multiple areas only when these areas 
have the same modifier styles attached in exactly the same order. 

4 Attach or detach calculation modifier styles:

5 Click OK.

Assigning an Area to a Different Area Group

Use this procedure to attach an area to an area group, change the hierarchical 
position of an area, or detach an area from a group.

For more information about area groups, see “Area Groups” on page 2034.

1 Double-click the area to assign to a different group.

2 Expand Basic, and expand General.

3 Click the setting for Area Groups.

NOTE If this setting appears as read-only, no area groups have been added 
to the drawing yet.

If you want to . . . Then . . .

attach a calculation 
modifier style

under Available Calculation Modifiers, select the desired 

calculation modifier style, and click .

detach a calculation 
modifier style

under Name, select the desired calculation modifier style, 

and click .

rearrange the order of 
attached calculation 
modifier styles

under Name, select the calculation modifier style you want 

to move to a different position. Click  to move the 

calculation modifier style up in the list, or click  to 
move the calculation modifier style down in the list.

NOTE Calculation modifier styles are processed top-
down, so that the topmost calculation modifier style is 
calculated first, then the one below it, and so on until you 
reach the bottom of the list. 
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Attaching an area to an area group

4 Attach or detach areas to or from a group:

NOTE A black check mark means that you have selected this group directly. 
You can clear the group directly.

A gray check mark means that you have selected a subgroup of the gray-
marked group and, by implication, have added the area to all supergroups of 
the selected group. You cannot clear a gray mark directly; you need to clear 
the black-marked subgroup to remove it.

5 Click OK. 

Changing the Location of an Area

Use this procedure to relocate an area by changing the coordinate values of 
its insertion point. The area also has an orientation with respect to the WCS 
or the current UCS. For example, if the top and bottom of the area are parallel 
to the XY plane, its normal is parallel to the Z axis. You can change the ori-

If you want to . . . Then . . .

attach an area to a group select the area group’s check box. 

detach an area from a 
group

clear the area group’s check box.



Editing Areas | 2009

entation of the area by aligning its normal with another axis. You can also 
rotate the area on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Select the areas you want to relocate, and double-click one of them.

2 Expand Basic, and expand Location.

3 Enter a value for Rotation.

4 Enter a value for Elevation.

5 Click Additional Information for further location properties: 

6 Click OK.

Joining Areas

Use this procedure to join two or more areas in a drawing. You can join areas 
that overlap, or areas that do not touch each other. 

If you want to . . . Then . . .

relocate the area enter new coordinate values under Insertion Point.

locate the area on the XY 
plane

make the normal of the area parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the area on the YZ 
plane

make the normal of the area parallel to the X axis: 
under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the area on the XZ 
plane

make the normal of the area parallel to the Y axis: 
enter 1 for Y and enter 0 for X and Z.
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Joining two areas 

When you join two areas that overlap, their common boundary is combined 
to form the boundary of the joined area. 

When you join two areas that do not overlap, both area rings retain their 
geometry, but act as one single area. You could do this in a drawing of a shop-
ping mall, where one shop might consist of several rooms. 

NOTE When you join two areas, the second area no longer exists as an entity. 
Thus, you can no longer select or edit it separately. Also, area properties, display 
properties and attached calculation modifier styles of the second area are 
deleted and replaced with the corresponding properties of the first area. 

1 Select one of the areas to be joined, right-click, and click 
Operation ➤ Join.

NOTE You can join only those areas that lie on the same Z-plane. Two areas 
with different Z-positions in the same coordinate system cannot be joined.

2 Select the areas you want to join.

3 Press ENTER.

� If the areas overlap, the individual area boundaries are joined into one. 
� If the areas do not overlap, the individual area boundaries are retained 

but act now as different rings of the same area. 

Creating Holes in Areas

Use this procedure to subtract areas from each other in order to create a hole 
in an area. This is useful, for example, when you want to calculate the area 
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of a room without columns and chimney chases. 

Subtracting one area from another

To perform a subtraction operation, you need to select areas that intersect 
somewhere. If you choose areas that do not intersect, all areas you have 
marked for subtraction are deleted from the drawing.

Subtracted areas no longer exist as entities after the subtraction. Thus, you 
can no longer select or edit them separately. Also, area properties, display 
properties and attached calculation modifier styles of the subtracted areas are 
deleted and replaced with the corresponding properties of the first area. 

1 Select the area from which to subtract other areas, right-click, and click 
Operation ➤ Subtract.

2 Select the areas you want to subtract.

3 Press ENTER.

The resulting area has now been reduced by the amount of the areas 
subtracted from it.

Creating Areas from the Intersection of Other 
Areas

Use this procedure to create a new area from the overlapping portion of two 
intersecting areas. The source areas are deleted in the process.
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Intersecting two areas

To perform an intersection operation, you need to select areas that overlap 
somewhere. If you choose areas that do not intersect, all areas you have 
marked for intersecting with the first area are deleted from the drawing.

1 Select the first area for the intersection, right-click, and click 
Operation ➤ Intersect.

2 Select the next intersecting areas.

3 Press ENTER.

The source areas are removed. The overlapping part is converted to a new 
area. 

Adding Vertices

Use this procedure to add vertices to an area. This can help you to fine-tune 
the area outline, especially when you have created the area from an existing 
object or a wall boundary.

Adding a vertex to an area

1 Select the area to which to add vertices, right-click, and click Edit Vertices. 

2 Click your drawing to specify any vertex points you want to add.
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3 Press ENTER.

Removing Vertices

Use this procedure to remove vertices from an area.

Removing a vertex from an area

1 Select the area from which to remove vertices, right-click, and click Edit 
Vertices. 

2 Select the vertex points to remove by clicking near them while holding 
down SHIFT.

3 Press ENTER.

Trimming Areas

Use this procedure to trim areas along a trim line you have defined. Trim-
ming means to cut away part of the area along a defined line.

Trimming an area

1 Select the area from which to trim a part, right-click, and click Operation 
➤ Trim.

2 Click to specify the start point of the trim line.

3 Click to specify the endpoint of the trim line.

4 Click the side of the area to be removed after trimming.
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Dividing Areas

Use this procedure to divide areas along a divide line you define. 

Dividing an area

1 Select the area you want to divide, right-click, and click Operation 
➤ Divide.

2 Click to specify the start point of the divide line.

3 Click to specify the endpoint of the divide line.

You now have two areas next to each other. You can select each area sep-
arately to modify it. 

NOTE If you attached an area tag from DesignCenter to this area before 
dividing it, you must specify which area is connected to the existing tag. 
Specify the start point and endpoint of the dividing line, and the area on the 
left side in this direction will have the tag attached. To tag both resulting 
areas, attach a tag to the area on the right side of the division line as well. 

Removing Rings from Areas

Use this procedure to remove individual rings from an area with multiple 
rings.

You cannot remove a ring from an area that has only one ring; and you can-
not remove the last ring from an area.

1 Select an area with multiple rings, right-click, and click Edit 
Rings ➤ Remove Ring.

2 Select the area ring you want to remove from the area.

The area ring is removed.

3 Press ENTER. 
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Reversing Area Rings

Use this procedure to reverse the value of an individual area ring, so that a 
positive ring (area) can be transformed into a negative ring (hole), and a neg-
ative ring back into a positive ring.

1 Select an area of which you want to reverse a ring, right-click, and click 
Edit Rings ➤ Reverse Ring.

2 Select the area ring you want to reverse.

Reversing All Rings in an Area

Use this procedure to reverse all rings of an area in one step. 

When you reverse the area rings, all positive rings are transformed into neg-
ative rings and all negative rings are transformed into positive rings.

1 Select the area you want to reverse, right-click, and click Edit 
Rings ➤ Reverse Ring.

2 Select further areas for reversing.

3 Press ENTER to end your selection. 

Creating Polylines from Areas

Use this procedure to create polylines from an area you have created.

Creating a polyline from an area boundary

After converting areas to polylines, you can also reconvert them to areas.

This is useful in these cases:

� You want to export the floor plan to an application that can process only 
polylines.

� You want to remove a hole from an area.
� You want to create walls or spaces from areas
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1 Select the area from which you want to create a polyline, right-click, and 
click Create Polyline.

Standard AutoCAD®  polylines are created on top of your areas. You can 
edit them as any other polyline. 

TIP When polylines lie above areas, it can be difficult to select the area without 
the polyline. Try one of the following:

� CTRL-click the boundary. Then click until the area boundary is highlighted.
� If the area hatch is displayed, click the hatch.
� Click Quick Select on the Properties palette.

Attaching Hyperlinks, Notes, or Files to an Area

Use this procedure to attach hyperlinks, text notes, or files to an area. 

1 Double-click the area you want to attach information to.

2 Click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD 2004 
Command Reference.

4 Click the setting for Notes, and add a note. Then, click OK.

5 Click the setting for Reference Documents.

6 Attach or detach reference files:

7 Click OK. 

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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Attaching Areas to Area Groups

Use this procedure to attach areas to area groups in the drawing.

For information about creating area groups, see “Creating Area Groups with 
User-Specified Settings” on page 2041. 

1 Select an area which you want to attach to a group, right-click, and click 
Attach to Group.

2 Select the area group to which you want to attach your area, and press 
ENTER. 

Detaching Areas from Area Groups

Use this procedure to detach areas from area groups.

1 Select an area which you want to detach from a group, right-click, and 
click Detach from Group.

TIP When you have attached an area to a group it can be difficult to select 
the area without the area group. Try one of the following:

� CTRL-click the desired area boundary. Then click until the desired area is 
highlighted.
� If the area hatch is displayed, click the hatch.
� If area decomposition is displayed, click one of the decomposition lines.
� Drag a selection window around the areas you want to detach.
� Click Quick Select on the Properties palette.

2 Select the area group from which you want to detach your area, and press 
ENTER. 

Area Styles

A style is a collection of display and decomposition properties for an area. 
Decomposition is a method of geometrically dividing an existing area in tri-
angular or trapezoid subparts. In some countries, such as Germany and 
Japan, the visual decomposition of areas into subdivisions is an important 
part of the area evaluation. It is needed for the area proof that must be pre-
sented to the building administration for approval. 
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When you apply the style to one or more areas, the settings defined in it are 
applied automatically.

You can use area styles for differentiating between areas:

� Different area types: You can draw construction areas, calculated areas, 
base areas, and traffic areas, or areas with different display properties. For 
example, you might draw all construction areas in green and hatched, and 
the traffic areas in blue with a solid fill.

� Different decomposition methods: You might create a style for trapezoid 
decomposition and one for triangular decomposition. For information 
about area decomposition, see “Area Decomposition” on page 2028.

� Different calculation standards: You might create area styles for areas 
according to DIN277, areas that are rented, or demolition areas.

You can create an area tool from any area style. You can drag the style from 
the Style Manager onto a tool palette. You can then specify default settings 
for any areas created from the tool. For more information, see “Creating an 
Area Tool” on page 1996.

You can create new area styles, edit area styles, import and export area styles 
between drawings, and purge area styles that are not in use. The Style Man-

ager provides a central location in Autodesk® Architectural Desktop, where 
you can work with styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Style Manager” on 
page 531.

Related Topics and Procedures

� Creating an Area Style

� Changing the Area Display Components

� Specifying the Hatching for Components of an Area Style

� Specifying Classifications for an Area Style

� Attaching Notes or Files to an Area Style

Creating an Area Style

Use this procedure to create an area style. You can create a new style with 
default style properties, or you can create a new style by copying an existing 
style. After you create the style, you edit the style properties to customize the 
characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Area Styles.
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3 Create a new area style:

4 Enter a name for the new area style, and press ENTER.

5 To edit the style properties of your new area style, right-click the style, and 
click Edit:

6 If you want to assign the style to an area tool, drag the style from the Style 
Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating an Area Tool” on page 1996.

7 Click OK.

Changing the Area Display Components

Use this procedure to change the properties of display components of an area 
style:

� Visibility (display component is on or off)
� Layer

If you want to . . . Then . . .

create a new style with 
default properties

right-click Area Styles, and click New.

create a new style from an 
existing style

right-click the area style you want to copy, and click 
Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

add classifications to an 
area style

see “Specifying Classifications for an Area Style” on 
page 2022.

change the Layer, Color, 
and Linetype properties 

see “Changing the Area Display Components” on 
page 2019.

change the area style 
hatching

see “Specifying the Hatching for Components of an 
Area Style” on page 2021.

add notes, files, or 
documents to the style

see “Attaching Notes or Files to an Area Style” on 
page 2022.



2020 | Chapter 27 Area Evaluation

� Color
� Linetype
� Lineweight
� Linetype scale

Display components of an area

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK three times.

Display components in plan views

Component Description

Additive Boundary Boundary of an area with a positive value, for 
example, a room area

Subtractive Boundary Boundary of an area with a negative value (a hole)

Additive Hatch Hatch of an area with a positive value

Subtractive Hatch Hatch of an area with a negative value (a hole) 

Defect marker Error symbol that appears when a display component 
cannot be displayed
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Specifying the Hatching for Components of an 
Area Style

Use this procedure to specify the hatching of the components of an area 
style. Area hatching is displayed only in display representations, used in the 
Top view of a drawing, such as Plan High Detail or Plan Low Detail.

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Hatching tab.

8 Select a component, and click the setting for Pattern.

9 Select the hatching for the component:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.
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13 Click Orientation, and specify how the hatching is oriented:

14 Click OK three times.

Specifying Classifications for an Area Style

Use this procedure to specify classifications for any classification definition 
applied to an area style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to area 
styles.

5 For each classification definition, select the classification you want to 
apply to the current area style.

6 Click OK twice.

Attaching Notes or Files to an Area Style

Use this procedure to attach text notes and files to an area style.

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the area style, enter the description under Descrip-
tion.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

Calculation Modifier Styles

A calculation modifier style is a formula that you can apply to an area to 
change the calculated result of its associated area or perimeter value. Calcu-
lation modifier styles can also be applied to area groups, where they change 
the calculated results of all areas attached to that group. You can create cal-
culation modifier styles for a number of purposes; for example, to calculate 
plaster deductions or the tiling in a bathroom.

Calculation modifier styles work in an accumulating structure. When you 
apply several different styles to an area or area group, they are all applied to 
it. Therefore, it is important to define the order in which they are used. 

Example: You have an area of 25 square meters. You want to apply two dif-
ferent calculation modifier styles to it. Calculation modifier style A deducts 
a standard value of 0.3 square meters for a column. Calculation modifier style 
B divides the area by 2 (in some international calculation schemes, this is 
used for calculating balconies).

� If you apply the plaster deduction first and the division second, you get 
the following result:

Calculation Modifier Style A: 25 m2 - 0.3 m2 = 24.7 m2

Calculation Modifier Style B: 24.7 m2 / 2 = 12.35 m2

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Close the application when you are 
done editing.

detach a reference file select the file name, click Delete, and click OK.
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� If you apply the division first and the plaster deduction second, you get 
the following result:

Calculation Modifier Style B: 25 m2 / 2 = 12.5 m2

Calculation Modifier Style A: 12.5 m2 - 0.3 m2 = 12.2 m2

The results differ depending on the order in which you apply the calculation 
modifier styles.

You can set the order of calculation modifier styles in the properties of the 
area. For information about attaching and ordering calculation modifier 
styles, see “Attaching and Detaching Calculation Modifier Styles” on 
page 2006.

Related Topics and Procedures

� Creating a Calculation Modifier Style

� Defining the Calculation Type of the Modifier Style

� Defining the Formula of the Modifier Style

� Attaching Notes and Files to a Calculation Modifier Style

Creating a Calculation Modifier Style

Use this procedure to create a calculation modifier style. You can create a new 
style with default style properties, or you can create a new style by copying 
an existing style. After you create the style, you edit the style properties to 
customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Calculation Modifier Styles.

3 Create a new calculation modifier style:

4 Enter a name for the new calculation modifier style, and press ENTER.

If you want to . . . Then . . .

create a new style with 
default properties

right-click Calculation Modifier Styles, and click 
New.

create a new style from an 
existing style

right-click the calculation modifier style you want to 
copy, and click Copy. Right-click, and click Paste.
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5 To edit the style properties of your new calculation modifier style, right-
click the style, and click Edit:

6 Click OK twice.

Defining the Calculation Type of the Modifier 
Style

Use this procedure to define the calculation type of the modifier style. An 
AEC area contains two values, Area and Perimeter, to use for applying a cal-
culation modifier style. Depending on the value you choose for the style, it 
is either for the calculation type Area or the calculation type Perimeter.

NOTE A calculation modifier style can also have both calculation types and 
can be applied to both the Perimeter and the Area value.

An example of a modifier style of the calculation type Area would be one that 
calculates an area only with 50 percent of its square meters. (This is obliga-
tory for several area types in various international architectural standards.) 

An example of a modifier style of the calculation type Perimeter would be 
one that deducts length from the perimeter of a room for openings and stairs. 
This would be helpful in calculating the baseboard material you need for this 
room.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Calculation Modifier Styles.

3 Select the modifier style for which you want to set the calculation type, 
right-click, and click Edit.

4 Click the Apply To tab. 

If you want to . . . Then . . .

define the calculation type 
of the modifier style

see “Defining the Calculation Type of the Modifier 
Style” on page 2025.

define the formula of the 
modifier style

see “Defining the Formula of the Modifier Style” on 
page 2026.

add notes, files, or 
documents to the modifier 
style 

see “Attaching Notes and Files to a Calculation 
Modifier Style” on page 2027.
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5 Select whether you want to apply the modifier style to the area or perim-
eter value. You can also select both values here.

6 Click OK twice.

Defining the Formula of the Modifier Style

Use this procedure to define the formula of the calculation modifier style. 
You define the rules used to calculate the area and perimeter.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Calculation Modifier Styles.

3 Select the modifier style for which you want to define a formula, right-
click, and click Edit.

4 Click the Definition tab. 

5 You can add a variable to the calculation modifier style. 

A variable consists of the variable name and its value. For example, to cre-
ate a plaster deduction of 3 percent, click Add, and enter 
Plaster_Deduction for Variable and 0.97 for Value. 

You can use a descriptive name as a variable name and thereby add trans-
parency to your formulas.

To set up formulas, you do not need to work with variables. To set up your 
formulas, you can enter direct mathematical values. 

The following characters and words are not allowed:

� Special characters such as ?()*- You may, however use an underscore (_).
� Spaces
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� Accent marks such as ä, ö, ü, ê, è, å
� Key words from Visual Basic®.

For information about Visual Basic key words, refer to the Visual Basic 
Reference. 

6 The Data field displays the value you chose in the Apply To tab for calcu-
lation:

� AreaValue = area
� PerimeterValue = perimeter
� Value = area and perimeter

You cannot edit this value; if you want to change the area data, click the 
Apply To tab and choose different data there.

7 Enter the formula for calculating the modifier style under Expression. 

You can enter direct mathematical values and operators, variables you 
have created, and Visual Basic key words, such as Mod, Exp, or Log.

NOTE It is important to enter the values AreaValue and PerimeterValue 
exactly as they are displayed in the Area Data field. Alternative spellings, such 
as “Area Value” or “perimetervalue,” are not recognized. 

For example, you want to set up a plaster deduction of 3 percent, and you 
have defined a variable called Plaster_Deduction with a value of 0.97, 
enter AreaValue * Plaster_Deduction.

8 To test your formula, enter an exemplary area value for Input, press ENTER, 
and check the result under Output. 

9 Click OK twice.

Attaching Notes and Files to a Calculation 
Modifier Style

Use this procedure to enter notes and attach reference files to a calculation 
modifier style. You can also edit reference files attached to the style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Calculation Modifier Styles.

3 Select the modifier style to which you want to attach notes or files, right-
click and click Edit.

4 Click the General tab.
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5 To add a description to the modifier style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

Area Decomposition

In some countries, such as Germany and Japan, an important part of area 
evaluation is the visual decomposition of areas into subdivisions. Area 
decomposition is needed for the area proof that must be presented to the 
building administration for approval. 

Because decomposition is a part of the display properties of the area object, 
the best way to organize it is with styles. 

With styles, you can control how the decomposition is displayed, the decom-
position method used, color settings for decomposition components, and 
tags. The decomposition view of an area is an additional display representa-
tion. 

For information about area styles, see “Area Styles” on page 2017. 

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Close the application when you are 
done editing.

detach a reference file select the file name, and click Delete.
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Trapezoid and triangulated area decomposition 

Related Topics and Procedures

� Displaying the Area Decomposition

� Specifying Layer/Color/Linetype Settings of the Area Decomposition

� Specifying the Method of Area Decomposition

� Specifying Text Settings for Area Decomposition

Displaying the Area Decomposition

Use this procedure to display the area decomposition view.

An area decomposition is a view in which the areas are displayed as triangles 
or trapezoids, depending on the decomposition method. Additionally, the 
decomposition view shows height lines, and edge and height dimensions. 
Architects need area decomposition for calculation proof, for efforts such as 
presenting building proposals to building authorities.

The decomposition view is an additional display representation of the area 
object that you can turn on and off. 
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In the Plan High Detail and Plan Low Detail display configurations, the area 
decomposition is not displayed by default, but you can turn it on. For infor-
mation about changing display configurations, see “Display System” on 
page 435.

An easier way to display the area decomposition is to turn on the Proof of 
Areas display configuration. 

In the Proof of Areas view, only the area decomposition is visible. You can not 
see architectural objects such as doors, walls, or windows. If you want to dis-
play those objects with the decomposition, switch them on in the Proof of 
Areas display representation set. For information about display representa-
tion sets, see “Display Sets” on page 443.

NOTE To display the Proof of Areas display configuration, you must work with 
a template that contains this configuration, for example, Architectural Building 
Model and View (D A CH - ctb).dwt.

1 In the Autodesk® Architectural Desktop status bar, click the list of available 
display configurations.

2 Select Proof of Areas.

Specifying Layer/Color/Linetype Settings of the 
Area Decomposition

Use this procedure to change the properties of the display components of an 
area decomposition: 

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale
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The following decomposition components are available:

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style that has the decomposition settings you want to 
change, and click Edit.

4 Click the Display Properties tab.

5 Select the Decomposed display representation, and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK three times.

Display components in decomposed view

Component Description

Additive Edge Decomposition lines of an area with a positive value, 
such as a room area

Subtractive Edge Decomposition lines of an area with a negative value, 
or a hole

Additive Label Label for an area subdivision with a positive value

Subtractive Label Label for an area subdivision with a negative value

Additive Height Height lines of an area subdivision with a positive 
value

Subtractive Height Height lines of an area subdivision with a negative 
value

Edge Dimension Text Label for an area edge displaying its length 

Height Dimensions Label for a height line displaying its length

Defect Marker Marker that appears when a display component 
cannot be displayed. 
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Specifying the Method of Area Decomposition

Use this procedure to specify the method of decomposing areas. 

In the Decomposition tab, you can set the decomposition method you prefer.

Trapezoid and triangulated area decomposition 

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style that has the decomposition settings you want to 
change, and click Edit.

4 Click the Display Properties tab.

5 Select the Decomposed display representation, and select Style Override.

6 If necessary, click .

7 Click the Decomposition tab.
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8 Select a decomposition method for Type:

9 Choose an explosion mode: 

10 Click OK three times.

Specifying Text Settings for Area Decomposition

Use this procedure to further modify the numbers of the area subdivisions as 
well as to the edge and height annotations. 

1 Open a tool palette that has an area tool.

2 Right-click an area tool, and click Area Styles.

3 Right-click the style that has the decomposition settings you want to 
change, and click Edit.

4 Click the Display Properties tab.

5 Select the Decomposed display representation, and select Style Override.

6 If necessary, click .

7 Click the Proof tab.

If you want to . . . Then . . .

display a trapezoid 
decomposition

select Trapezoid.

display a triangular 
decomposition without 
overlapping triangles

select Triangle.

display a triangular 
decomposition with overlapping 
triangles

select Triangle (overlap).

If you want to . . . Then . . .

change the decomposed 
area into single lines after 
exploding

select Lines.

change the decomposed 
area into closed polylines 
for each decomposed part

select Faces.
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8 Define the prefix settings:

9 Define the edge dimension settings:

10 Click OK three times.

Area Groups

Area groups are an important part of area evaluation. You can attach areas to 
groups and then detach them. You can also create area group templates and 
area name definitions. 

About Area Group Components
An area group is a container for areas and area groups. Area groups are nec-
essary if you want to create an evaluation of your floor plan. With area 
groups, you structure areas into various groups, according to different 
schemes. For example, you can have functional groups, for example, con-

If you want to . . . Then . . .

display a prefix for the numbers 
of the area subparts 

enter a prefix.

change the style of the numbers 
of the area subparts

either select a text style from the 
list or click Edit Text Style (...) and 
create a new text style. For 
information about the Text Style 
dialog box, see the online AutoCAD 
2004 User’s Guide.

change the height of the 
numbers in the area subparts

enter a value for Height.

If you want to . . . Then . . .

change the style of the edge 
dimensions

either select a text style from the list 
or click Edit Text Style (...) and create 
a new text style. For information 
about the Text Style dialog box, see 
the online AutoCAD 2004 User’s 
Guide.

change the height of the edge 
dimensions

enter a value for Height.
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struction areas, or traffic areas. You can also have groups named 
“Apartment 1 Ground Floor,” “apartment 2 Ground Floor,” and so 
on. Another way to organize areas in area groups can be by special calcula-
tion rules, such as reducing the gross area by 50 percent. (According to some 
international standards, certain types of rooms are allowed to be calculated 
with only 50 percent of their actual area when you rent them to tenants. 
These include balconies, porches, or rooms under the roof with a room 
height of less than two meters). 

Areas can be attached to more than one area group. You can, for example, 
attach a balcony area to both the groups “50 percent” and “Apartment 1 
Ground Floor.”

Areas attached to area groups

An area group can be connected to an area name definition, a list of names 
to choose from when creating an area that is attached to the group. This is a 
good way to ensure consistency in naming areas.

Area groups and area group templates can also have calculation modifier 
styles. A calculation modifier style is a formula applied to an area group that 
changes the calculated result of the area group value. You can create calcula-
tion modifier styles for purposes such as calculating plaster deductions, sub-
tracting areas for construction, or calculating the height of the tiling in a 
bathroom.

Area Groups in the Area Evaluation
When you create an area evaluation of the floor plan, you can choose groups 
to include in it and groups to exclude. 
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Area Evaluation Manager 

You might create an area evaluation for a single apartment in a building to 
determine square meters and set the rent accordingly. To do this, you only 
select the area group named “Apartment 1.” Within the same drawing you 
might also create an evaluation that contains only bathrooms, to determine 
how many tiles to order from a sanitary products supplier. To do this, you 
select only the area group named “Bathrooms.” Note that the bathroom from 
Apartment 1 appears in both groups and is calculated in both evaluations.

For information about area evaluations of the floor plan, see “Area Evalua-
tion” on page 2074.

Area Group Templates
Area groups can be connected and nested into complex structures. An area 
group for a complete building, for example, would have one top-level group 
named “Building.” Directly below that group would a be a number of groups 
for apartments—“Apartment 1,” “Apartment 2,” and so on. The individual 
apartment groups can contain other area groups like “Construction Areas,” 
“50% Deduction,” “Living Room,” Bedroom,” and so on. 
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Area group according to the German DIN277 area group template 

When working with a complex group structure, you can create an area group 
template that contains the necessary groups and subgroups. When you draw 
a new building, you can insert an area group based on the group template 
“Building,” and the area group “Building” with its subgroups is inserted in 

the drawing. Autodesk® Architectural Desktop templates contain a number of 
predefined area group templates. 

Related Topics and Procedures

� Process Overview: Creating Area Groups from Scratch

� Process Overview: Creating Area Groups from Templates

� Using Area Group Tools to Create Area Groups

� Creating an Area Group

� Creating Area Groups with User-Specified Settings

� Creating Area Groups from a Group Template

� Creating an Area Group Tool

� Editing Area Groups

� Area Group Styles

� Area Name Definitions

� Area Group Templates



2038 | Chapter 27 Area Evaluation

Process Overview: Creating Area Groups 
from Scratch

Area groups are often placed into groups, and are later used for the area eval-
uation of a floor plan. 

Area groups with attached areas

You can create area group structures “on the fly” while you insert groups in 
a drawing. This method is best suited for groups you won’t need to reuse 
later. 

Step 1: Create the areas you want to place in an area group. 

Step 2: Create the individual area groups you need for your areas. 

Step 3: Attach the areas to the area groups.

Step 4: Attach the individual area groups to each other, to create the desired 
structure.

Step 5: Add more areas and area groups to the drawing, according to your 
needs. 

Related Topics and Procedures

� Creating an Area with User-Specified Settings

� Creating Area Groups with User-Specified Settings

� Attaching Areas to Area Groups

� Attaching Area Groups to Other Groups



Process Overview: Creating Area Groups from Templates | 2039

Process Overview: Creating Area Groups 
from Templates

To create an area group structure, you can use a predefined template struc-
ture. This method is well suited if you will need the same group structure 
again, for a number of identical apartments or buildings. This method is also 
well suited if you have a basic structure, but need variations for different 
purposes. In this case, you would define the basic structure as an area group 
template and make the variations directly in the groups created from the 
template. 

Area group according to the German DIN277 area group template 

Step 1: Outline the groups and subgroups you need for your group structure.

Step 2: Outline the hierarchical and logical structure the groups are to have 
with each other.

Step 3: Create an area group template that contains these groups and their 
structure. 

Step 4: Insert an area group based on that template in the drawing. 

Step 5: Attach areas to that group.

Related Procedures

� Creating a Calculation Modifier Style

� Creating Area Groups from a Group Template
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� Attaching Areas to Area Groups

Using Area Group Tools to Create Area 
Groups

Tools provided with Autodesk® Architectural Desktop let you quickly place 
area groups by selecting an area group tool with a specific area group style 
and other predefined properties. When you place area groups using area 
group tools, you can use the default settings of the tool, or you can change 
settings for the area group properties. You can also use area group tools to 
convert linework to area groups and to apply the settings of an area group 
tool to existing area groups.

Tool palettes containing area group tools

The default tool palettes in the workspace contain sample area group tools 
that you can use and customize as needed. In addition, the following catalogs 
provided with the software contain area group tools that you can add to your 
tool palettes:

� Autodesk Architectural Desktop Stock Tool Catalog
� Autodesk Architectural Desktop Sample Palette Catalog
� My Tool Catalog
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Custom palettes created by your CAD manager or other users may also con-
tain area group tools with area group styles and properties that are custom-
ized for your projects or office standards.

Related Procedures

� Creating an Area Group

� Creating Area Groups with User-Specified Settings

� Creating Area Groups from a Group Template

� Creating an Area Tool

Creating an Area Group

Use this procedure to add a new area group that has the properties specified 
in the area group tool that you select. To specify settings when you add an 
area group, see “Creating Area Groups with User-Specified Settings” on 
page 2041 and “Creating Area Groups from a Group Template” on 
page 2044.

1 Open the tool palette that you want to use, and select an area group tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the area group.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Continue adding area groups, and press ENTER.

Creating Area Groups with User-Specified 
Settings 

Use this procedure to add an area group from scratch with settings that you 
specify.

1 Open the tool palette that you want to use, and select an area group tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Enter a name for the area group.
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4 Select a style.

5 Select a tag for the area group.

NOTE If no area tags are contained in the list, you can drag a tag into the 
drawing from AutoCAD® DesignCenter. You can also create your own area 
tags from multi-view blocks. For information about creating your own area 
tags, see “Process Overview: Creating User-Defined Area Tags” on 
page 2000.

6 To add a calculation modifier style to the area group, click the setting for 
Calculation Modifiers, and select one or more calculation modifiers for 
the area group. 

For information about calculation modifier styles, see “Calculation Mod-
ifier Styles” on page 2023.

7 To attach other area groups subordinate to the area group, click the setting 
for Area Groups, and attach one or more area groups. 

Attaching subordinated groups to an area group

If you are unsure whether the area group should have subordinate groups 
attached, or if area groups have not been created yet, you can omit this 
step and attach area groups later.

For information about area groups, see “Area Groups” on page 2034.

8 Expand Calculation.
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9 Define the calculation type of the area group:

For information about area evaluations, see “Area Evaluation” on 
page 2074.

For information on calculation types, see “About the Calculation Type of 
an Area Group” on page 2050.

10 Expand Content.

11 Define the content allowed in the area group:

For information about area group content, see “Changing the Content 
Rules of the Area Group” on page 2049.

12 If you want to assign an area name definition to the area group, select one. 

For information on area name definitions, see “Area Name Definitions” 
on page 2065.

13 In the drawing area, specify the insertion point of the area group.

You can move or hide the Properties palette to expose more of the drawing 
area.

If you want to . . . Then . . .

calculate the area values of 
attached areas

select Yes for Calculate Area. 

calculate the perimeter 
values of attached areas

select Yes for Calculate Perimeter. 

calculate both area and 
perimeter values of 
attached areas

select Yes for Calculate Area and Calculate 
Perimeter

If you want to . . . Then . . .

allow only areas to be 
attached to the area group

select Yes for Can Contain Areas. 

allow only area groups to be 
attached to the area group

select Yes for Can Contain Area Groups. 

allow both areas and area 
groups to be attached to 
the area group

select Yes for Can Contain Areas and Can Contain 
Area Groups. 
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14 Continue adding area groups, and press ENTER.

Creating Area Groups from a Group 
Template

Use this procedure to create area groups based on a group template. 

When you use the same group structure frequently, it is most efficient to cre-
ate an area group template and use it to create groups in the drawing. 

Area group structure according to the German DIN277 area group template 

For information about creating area group templates, see “Area Group Tem-
plates” on page 2069. 

1 Open the tool palette that you want to use, and select an Area Group from 
Template tool.

2 On the Properties palette, expand Basic, and expand General.

3 Select the area group template you want to create a group from.
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4 Define the offsets between individual subgroups in the group:

5 In the drawing area, specify the insertion point of the area group.

You can move or hide the Properties palette to expose more of the drawing 
area.

6 Continue adding area groups from a template, and press ENTER.

Creating an Area Group Tool

Use this procedure to create an area group tool and add it to a tool palette. 
You may want to create your own area group tools if you are placing multiple 
area groups of specific templates with additional area group properties that 
you want to be the same each time you add an area group of that type.

For example, you are creating an office floor plan with different calculation 
types for area groups. To work efficiently, you can quickly create an area 
group tool for each calculation type. You can then select the appropriate tool 
to add the area group with the correct calculation type in the floor plan.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

define the offset between 
rows of the area group 
structure

enter a value for Row Offset.

define the offset between 
columns of the area group 
structure

enter a value for Column Offset.

If you want to . . . Then . . .

create a tool from an area group 
in the drawing

select the area group, and drag it to the tool 
palette.

create a tool from an area group 
style in the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.
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3 Right-click the new area group tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the area group cre-
ated from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select an area group style.

10 Select the drawing file containing the style used for this area group tool.

11 Select a tag for the area group.

12 Select the drawing file containing the tag used for this area group tool.

13 Expand Calculation.

14 Define the calculation type of the area group tool:

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another 
palette

right-click the tool and click Copy; open the 
other palette, and click Paste.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.

If you want to . . . Then . . .

calculate the area values of 
attached areas

select Yes for Calculate Area. 

calculate the perimeter 
values of attached areas

select Yes for Calculate Perimeter. 

calculate both area and 
perimeter values of 
attached areas

select Yes for Calculate Area and Calculate 
Perimeter.

If you want to . . . Then . . .
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For information about area evaluations, see “Area Evaluation” on 
page 2074.

For information on calculation types, see “About the Calculation Type of 
an Area Group” on page 2050

15 Expand Content.

16 Define the allowed content in the area group tool:

For information about area group content, see “Changing the Content 
Rules of the Area Group” on page 2049.

17 If you want to assign an area name definition to the area group, select one. 

For information on area name definitions, see “Area Name Definitions” 
on page 2065.

18 Select the drawing file containing the area name definition used for this 
area group tool.

19 Click OK.

Attaching Area Groups to Other Groups

Use this procedure to attach area groups to other area groups. 

Area group connections are not unique. You can attach one area group to any 
number of other area groups. 

� A higher-level group can have any number of subgroups attached.
� A subgroup can be attached to any number of higher-level groups. 

You build a group structure from the top down. You select the top-level group 
and attach the first level of subgroups to it. Then you select the first-level sub-

If you want to . . . Then . . .

allow only areas to be 
attached to the area group

select Yes for Can contain areas. 

allow only area groups to be 
attached to the area group

select Yes for Can contain area groups. 

allow both areas and area 
groups to be attached to 
the area group

select Yes for Can contain areas and Can contain 
area groups. 
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groups and attach the second-level subgroups to them. Finally, you attach 
areas to the groups.

Group structure with areas attached

1 Select an area group to which you want to attach a subgroup, right-click, 
and click Attach Areas / Area Groups.

2 Select the area group which you want to attach as a subgroup, and press 
ENTER. 

Detaching Area Groups from Other Groups

Use this procedure to detach area groups from other area groups.

You can detach only the direct subgroups of a selected area group. 

1 Select the area group from which you want to detach a subgroup, right-
click, and click Detach Areas / Area Groups.

2 Select the subgroup you want to detach from the area group, and press 
ENTER. 
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Editing Area Groups

You can change the properties of an area group. Area group properties 
include the hierarchical position of the area group, the style, and the loca-
tion. 

Autodesk® Architectural Desktop offers several methods for editing area 
groups:

� You can change area group settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

area group.

Related Topics and Procedures

� Changing the Area Group Style

� Changing the Content Rules of the Area Group

� About the Calculation Type of an Area Group

� Changing the Calculation Type of the Area Group

� Attaching One Area Group to Another

� Changing the Location of an Area Group

� Ordering Area Group Structures

� Creating Polylines from Area Groups

� Attaching Hyperlinks, Notes, or Files to an Area Group

Changing the Area Group Style

Use this procedure to change the style associated with an area group. Area 
group styles contain information about the display of the area group and the 
display of its attached subgroups and areas. You can also add classifications 
here. For information about how to define area group styles, see “Area Group 
Styles” on page 2056.

1 Select one or more area groups, and double-click one of them.

2 Expand Basic, and expand General.

3 Select an area group style.

Changing the Content Rules of the Area Group

Use this procedure to add a name definition to an area group and restrict the 
allowed content of the area group.
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When you create an area group from a template, name definitions and con-
tent rules are predefined in the group template. You can, however, change 
them later.

1 Select one or more area groups, and double-click one of them.

2 Expand Content.

3 To associate an area group with an area name definition, select a name set 
for Use Name Definition. When you later attach an area to this group, the 
list of names from the definition is available for the area. 

For information about creating area name definitions, see “Area Name 
Definitions” on page 2065.

4 Define the allowed content in the area group:

About the Calculation Type of an Area Group

An area group contains two values that you can calculate in the evaluation 
of the floor plan: the perimeter value of its associated areas and the area value 
of its associated areas. Depending on the value you choose for the group, this 
value is calculated later. This is also the value that calculation modifier styles 
are applied to.

For information about calculation modifier styles, see “Attaching and 
Detaching Calculation Modifier Styles” on page 2006.

You would use the calculation type area to measure the square meters of an 
apartment. 

You would use the calculation type perimeter to determine how many meters 
of baseboard material you need. 

In many cases, both calculation types area activated to allow for a variety of 

possible evaluations. 

If you want to . . . Then . . .

allow only areas to be 
attached to the area group

select Yes for Can Contain Areas. 

allow only area groups to be 
attached to the area group

select Yes for Can Contain Area Groups. 

allow both areas and area 
groups to be attached to 
the area group

select Yes for Can Contain Areas and Can Contain 
Area Groups. 
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Changing the Calculation Type of the Area Group

Use this procedure to change the calculation type of an area group.

When you create an area group from a template, the calculation type is pre-
defined in the group template. You can, however, change it later.

1 Select one or more area groups, and double-click one of them.

2 Expand Calculation.

3 Define the calculation type of the area group:

For information about area evaluations, see “Area Evaluation” on 
page 2074.

For information on calculation types, see “About the Calculation Type of 
an Area Group” on page 2050.

4 Click Close.

Attaching and Detaching Calculation Modifier 
Styles

Use this procedure to attach calculation modifier styles to area groups, sort 
them, and detach them.

For information about creating calculation modifier styles, see “Calculation 
Modifier Styles” on page 2023.

1 Select the area groups you want to change, and double-click one of them.

2 Expand Basic, and expand General.

3 Click the setting for Calculation modifiers.

If you want to . . . Then . . .

calculate the area values of 
attached areas

select Yes for Calculate Area. 

calculate the perimeter 
values of attached areas

select Yes for Calculate Perimeter. 

calculate both area and 
perimeter values of 
attached areas

select Yes for Calculate Area and Calculate 
Perimeter.
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NOTE This setting can be edited for multiple area groups only when these 
area groups have the same modifier styles attached in the same order. 

4 Attach or detach calculation modifier styles:

5 Click OK.

Attaching One Area Group to Another

Use this procedure to attach one area group to another, change the hierarchi-
cal position of the group, or detach one area group from another.

1 Double-click the area group that you want to assign to another area group.

2 Expand Basic, and expand General.

3 Click the setting for Area Groups.

NOTE If this setting appears as read-only, no area groups have been added 
to the drawing yet.

4 Attach or detach areas to a group:

If you want to . . . Then . . .

attach a calculation 
modifier style

under Available, select the desired calculation modifier 

style, and click .

detach a calculation 
modifier style

under Attached, select the desired calculation modifier 

style, and click .

rearrange the order of 
attached calculation 
modifier styles

under Attached, select the calculation modifier style to 

move to a different position. Click  to move the 

calculation modifier style up in the list, or click  to 
move the calculation modifier style down in the list.

If you want to . . . Then . . .

attach one area group to 
another

select the area group’s check box. 
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NOTE There are different colors for the check marks.

A black check mark means that you have selected this group directly. You can 
clear this group directly.

A gray check mark means that you have selected a subgroup of the gray-
marked group and have, by implication, added the area group to all super-
groups of the selected group. You cannot clear a gray mark directly; you 
need to clear the black-marked subgroup to remove it.

5 Click OK. 

Changing the Location of an Area Group

Use this procedure to relocate an existing area group by changing the coor-
dinate values of its insertion point. The area group also has an orientation 
with respect to the WCS or the current UCS. For example, if the top and bot-
tom of the area group are parallel to the XY plane, its normal is parallel to the 
Z axis. You can change the orientation of the area group by aligning its nor-
mal with another axis. You can also rotate the area group on its plane by 
changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD 2004 User’s Guide.

1 Select the area groups you want to relocate, and double-click one of them.

2 Expand Basic, and expand Location.

3 Enter a value for Rotation.

4 Enter a value for Elevation.

5 Click Additional Information for further location properties: 

detach one area group from 
another,

clear the area group’s check box.

If you want to . . . Then . . .

relocate the area group enter new coordinate values under Insertion Point.

If you want to . . . Then . . .
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6 Click OK.

Ordering Area Group Structures

Use this procedure to order area group structures. When you have a complex 
area group structure with many levels, it can be difficult to recognize the 
hierarchy of the groups. To sort the group nodes according to their hierarchi-

cal positions, Autodesk® Architectural Desktop offers you an easy-to-use com-
mand.

Ordering area group structures

1 Select the main node of the area group structure you want to sort, right-
click, and click Area Group Layout.

2 Specify the row and column distance between the entries in the group 
structure, and press ENTER. 

locate the area group on 
the XY plane

make the normal of the area group parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the area group on 
the YZ plane

make the normal of the area group parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the area group on 
the XZ plane

make the normal of the area group parallel to the Y 
axis: enter 1 for Y and enter 0 for X and Z.

If you want to . . . Then . . .
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Creating Polylines from Area Groups

Use this procedure to create polylines from an area group.

This is useful, for example, in these cases:

� You want to export the floor plan to an application that can process only 
polylines.

� You want to create walls or spaces from areas.

Creating polylines from area groups

After converting areas to polylines, you can also reconvert them to areas.

1 Select the area group from which you want to create a polyline, right-click, 
and click Create Polyline.

Standard AutoCAD® polylines are created on top of your area groups. You 
can edit them as any other polyline. 

TIP When polylines lie above area groups, it can be difficult to select the area 
without the polyline. Try one of the following:

� Press CTRL, and click the boundary. Then click until the area group boundary 
is highlighted.
� If the area hatch is displayed, click the hatch.
� Click Quick Select on the Properties palette.
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Attaching Hyperlinks, Notes, or Files to an Area 
Group

Use this procedure to attach hyperlinks, text notes, or files to an area group. 

1 Double-click the area group you want to attach information to.

2 Click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click the setting for Notes, and add a note. Then, click OK.

5 Click the setting for Reference Documents.

6 Attach or detach reference files:

7 Click OK. 

Area Group Styles

A style is a collection of display properties for an area group. Display proper-
ties are applied to the area group as well as to areas attached to the group.

You can use area group styles for these purposes:

� Different area group types: You can create groups for construction areas, 
calculated areas, base areas, traffic areas, or other areas with different dis-
play properties. For example, you might draw and hatch all areas in the 

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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construction group, create the traffic area group in blue with a solid fill, 
and so on.
Living rooms and construction areas with different styles

� Different calculation standards: You can create area group styles for area 
groups according to national calculation standards (like the German DIN 
277), groups for areas that are rented, or groups for demolition areas.

When you create an area evaluation, you can select area groups to include in 
it and area groups to exclude. 

Related Topics and Procedures

� Creating an Area Style

� Changing the Area Group Display Components

� Specifying the Hatching for Components of an Area Group Style

� About Setting Display Properties of Attached Areas

� Setting Display Properties of Attached Areas

� Specifying Classifications for an Area Group Style

� Attaching Notes or Files to an Area Group Style

Creating an Area Group Style

Use this procedure to create an area group style. You can create a new style 
with default style properties, or you can create a new style by copying an 
existing style. After you create the style, you edit the style properties to cus-
tomize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Area Group Styles.
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3 Create a new area group style:

4 Enter a name for the new area group style, and press ENTER.

5 To edit the style properties of your new area group style, right-click the 
style, and click Edit:

6 If you want to assign the style to an area group tool, drag the style from 
the Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating an Area Group Tool” on page 2045.

7 Click OK.

If you want to . . . Then . . .

create a new style with 
default properties

right-click Area Group Styles, and click New.

create a new style from an 
existing style

right-click the area group style you want to copy, 
and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
style

click the General tab, and enter a description.

add classifications to an 
area group style

see “Specifying Classifications for an Area Style” on 
page 2022.

change the Layer, Color, 
and Linetype properties 

see “Changing the Area Group Display 
Components” on page 2059.

change the area group 
style hatching

see “Specifying the Hatching for Components of an 
Area Group Style” on page 2060.

set the display of the 
associated areas and the 
area group marker

see “Setting Display Properties of Attached Areas” 
on page 2062.

add notes, files, or 
documents to the style

see “Attaching Notes or Files to an Area Group 
Style” on page 2064.
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Changing the Area Group Display Components

Use this procedure to change the Layer/Color/Linetype properties of any dis-
play component of an area group. 

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

In addition to components belonging directly to the area group, the area 
group style can include components of areas connected to the group. Area 
group display settings control the boundary and the hatch of connected 
areas as well. 

Display components of an area group

Display components in plan views

Component Description

Entity Entity boundaries of any area directly connected to that area 
group. Settings in the area group overwrite any settings 
defined for the area. 

Hatch Hatch component of the area group symbol as well as that of 
any area directly connected to the area group.Settings in the 
area group overwrite any settings defined for the area.

Name Area group name

Marker Area group symbol
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1 Open a tool palette that has an area group tool.

2 Right-click an area group tool, and click Area Group Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK three times.

Specifying the Hatching for Components of an 
Area Group Style

Use this procedure to specify the hatching settings of an area group style. 
This is the hatch of the area group symbol and the areas connected to the 
group. In this way, you can easily detect the structure in your drawing if you 
have many areas and groups. The hatch is also important if you want to cre-
ate a coding legend from the area groups.

1 Open a tool palette that has an area group tool.

2 Right-click an area group tool, and click Area Group Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Hatching tab.

Group Connection 
Line

Connecting line between the group and any connected 
subgroups

Area Connection 
Line

Connecting line between the group and any connected areas

Display components in plan views (continued)

Component Description
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8 Select a component, and click the setting for Pattern.

9 Select the hatching for the component:

10 Click OK.

11 Click Scale/Spacing, and enter a value that determines how the selected 
pattern is repeated.

12 Click Angle, and enter the angle for the selected pattern.

13 Click Orientation, and specify how the hatching is oriented:

14 Click OK three times.

About Setting Display Properties of Attached 
Areas

Area groups contain a number of display properties that do not influence the 
group itself, but the areas attached to it. These are the entity boundary of the 
area and the hatch of the area. 

If you want to . . . Then . . .

select a hatching pattern that is 
available in the software

select Predefined for Type, and then select a 
pattern.

select a custom pattern select Custom for Type, and then enter the 
name of the custom pattern. If necessary, click 
Browse, and navigate to the folder where the 
custom pattern file is located.

select single hatching select User-defined for Type, and clear Double 
Hatch.

select double hatching select User-defined for Type, and select 
Double Hatch.

select solid fill select Solid Fill for Type.

If you want to . . . Then . . .

orient the hatching to the 
object, regardless of the object 
rotation

select Object.

orient the hatching to the World 
Coordinate System

select Global.
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You can decide whether these display properties are passed on only to the 
next lower level of attached areas or to all subsequent levels.

Draw all areas selected (top) and not selected (bottom)

For example, if you are interested in seeing all areas connected to a complete 
building, you can set the area group style to “Building” so that it passes its 
display properties to all attached areas, regardless of their relative position in 
the building hierarchy. If you want an area group to control the display of 
only its directly attached areas, you can set it accordingly. 

For information on how to set the display behavior of an area group, see “Set-
ting Display Properties of Attached Areas” on page 2062.

Setting Display Properties of Attached Areas

Use this procedure to specify the behavior of area groups as well as the area 
group marker size and text settings. 

1 Open a tool palette that has an area group tool.

2 Right-click an area group tool, and click Area Group Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.
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5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 Change the width and height of the area group symbol by selecting User 
Defined Scaling and then entering a width and height.

To display the area group marker in 1/50 of the screen size, clear User 
Defined Scaling.

9 Define whether the area group display properties are used only for the 
next level of areas, or for all attached areas, regardless of their relative posi-
tion in the group hierarchy:

10 Change the appearance of the area group name.

11 Click OK three times.

Specifying Classifications for an Area Group Style

Use this procedure to specify classifications for any classification definition 
applied to an area group style.

If you want to . . . Then . . .

use the display properties of 
the area group only for areas 
directly attached to it

 clear Draw All.

use the display properties of 
the area group for all areas 
attached to it 

select Draw All.

If you want to . . . Then . . .

change the height of the area 
group name

enter a new height. 

change the text style of the area 
group name

either select a text style from the list, or click 
Edit Text Style (...) and create a new text 
style. For information about the Text Style 
dialog box, see the online AutoCAD 2004 
User’s Guide.
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For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has an area group tool.

2 Right-click an area group tool, and click Area Group Styles.

3 Right-click the style that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to area 
group styles.

5 For each classification definition, select the classification you want to 
apply to the current area group style.

6 Click OK twice.

Attaching Notes or Files to an Area Group Style

Use this procedure to attach text notes and files to an area group style. 

1 Open a tool palette that has an area group tool.

2 Right-click an area group tool, and click Area Group Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the area group style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Close the application when you are 
done editing.

detach a reference file select the file name, and click Delete.
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Area Name Definitions

An area name definition is a list of names for a new area. It is displayed when 
you create an area associated with a group that has the name definition 
attached.

A list of names for an area 

Area name definitions can be attached to area groups either directly in the 
properties of the group, or when creating an area group based on a template. 
When you attach a new area to the area group, you have access to the asso-
ciated area name definition.
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Area name definition list

For information about creating an area group based on a template, see “Cre-
ating Area Groups from a Group Template” on page 2044.

Area name definitions are useful when you are working with a standard 
group template. In such cases, area names often must follow certain stan-
dards. 

Related Topics and Procedures

� Process Overview: Using an Area Name Definition

� Creating an Area Name Definition

� Edit the Name List of the Area Name Definition

� Attaching Notes and Files to a Calculation Modifier Style

Process Overview: Using an Area Name 
Definition

To use an area name definition you need to perform these steps:

Step 1: Create an area name definition. 

Step 2: Connect that area name definition to an area group or an area group 
template. 

Step 3: Create a new area that is connected to a group with an area name 
definition. 

Step 4: Select a name from the name definition list for the area.

Related Procedures

� Creating an Area Name Definition
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� Changing the Content Rules of the Area Group

� Creating a Calculation Modifier Style

� Creating an Area with User-Specified Settings

Creating an Area Name Definition

Use this procedure to create an area name definition. You can create a new 
definition with default properties, or you can create a new definition by 
copying an existing definition. After you create the definition, you edit the 
properties to customize the characteristics of the definition.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Name Definitions.

3 Create a new area name definition:

4 Enter a name for the new area name definition, and press ENTER.

5 To edit the properties of your new name definition, right-click the defini-
tion, and click Edit:

6 Click OK twice.

Edit the Name List of the Area Name Definition

Use this procedure to edit the name list of the area name definition. 

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Name Definitions.

If you want to . . . Then . . .

create a new definition 
with default properties

right-click Name Definitions, and click New.

create a new definition 
from an existing definition

right-click the area name definition you want to 
copy, and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

edit the name list see “Edit the Name List of the Area Name 
Definition” on page 2067.

add notes or files to the 
definition

see “Attaching Notes and Files to an Area Name 
Definition” on page 2068.
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3 Select the definition you want to edit, right-click, and click Edit.

4 Click the Content tab. 

5 Add, delete, or rename entries in the name list: 

6 Click OK three times.

Attaching Notes and Files to an Area Name 
Definition

Use this procedure to attach text notes and files to an area name definition.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Name Definitions.

3 Select the definition for which you want to add a note or file, right-click 
and click Edit.

4 Click the General tab.

5 To add a description to the area name definition, enter the description 
under Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

If you want to . . . Then . . .

add a new entry to the list click New, and enter the name of the entry.

delete an entry from the 
list

select the entry, and click Delete.

rename an entry in the list select the entry, click Rename, and enter the new 
name.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Close the application when you are 
done editing.
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9 Click OK twice.

Area Group Templates

An area group template is a structure definition for area groups with multiple 
hierarchical levels. You define the group template as a hierarchy with certain 
properties, and use it to create the group structure in the drawing.

 Area group structure according to the German DIN277 template

You use an area group template only to insert a group structure. Later 
changes to the area group template are not copied to existing groups based 
on this group template. For example, if you have a group template named 
“Apartment Building,” which contains the subgroups “First floor” and “Sec-
ond floor,” and you create a group from it, this group contains the subgroups 
“First floor” and “Second floor.“ If you change the group template to contain 
another subgroup named “Third floor” the existing group is not updated 
accordingly. Only groups created after the change have the new subgroup 
“Third floor.”

Similarly, when you change a group that is based on a group template, those 
changes do not flow back into the template.

detach a reference file select the file name, click Delete, and click OK.

If you want to . . . Then . . .
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You should create area group templates for structures you need frequently, 

and provide them through Autodesk® Architectural Desktop style drawings. 

Related Procedures

� Creating a Calculation Modifier Style

� Specifying the Content of an Area Group Template

� Attaching Notes and Files to an Area Group Template

Creating an Area Group Template

Use this procedure to create an area group template. You can create a new 
template with default properties, or you can create a new template by copy-
ing an existing template. After you create the template, you edit the proper-
ties to customize the characteristics of the template.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Group Templates.

3 Create a new area group template:

4 Enter a name for the new area group template, and press ENTER.

5 To edit the style properties of your new area group template, right-click 
the template, and click Edit:

6 Click OK twice.

If you want to . . . Then . . .

create a new template with 
default properties

right-click Group Templates, and click New.

create a new template 
from an existing template

right-click the template you want to copy, and click 
Copy. Right-click, and click Paste.

If you want to . . . Then . . .

define the content of the 
area group template 

see “Specifying the Content of an Area Group 
Template” on page 2071.

add notes or files to the 
group template

see “Attaching Notes and Files to an Area Group 
Template” on page 2073.
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Specifying the Content of an Area Group 
Template

When you create an area group template, you set the structure as well as 
properties like calculation types, modifier styles, and name definitions. Every 
group you create from this set has the same structure and properties. For 
information about creating area groups from a group template, see “Creating 
Area Groups from a Group Template” on page 2044.

Defining an area group template

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Group Templates.

3 Select the template you want to edit, right-click, and click Edit.

4 Click the Content tab.

In the left pane of the Content tab, a tree structure displays the structure 
of the area group template with all groups and subgroups. If you are 
creating a new area group template, only the top level group node is 
present. All other subgroups are yet to be inserted.

You can navigate in this tree structure as you would in Microsoft® 
Windows® Explorer. 

� A (+) sign in front of a group signifies that this group has more sub-
groups. 
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� A (-) sign in front of a group signifies that all subgroups are already 
displayed. 

� When there is no sign in front of a group, the group has no more sub-
groups.

5 Add the desired subgroups to your group template. 

The tree has a shortcut menu with the following commands:

NOTE To rearrange groups within the structure, use standard Microsoft® 

Windows® navigation features. 

6 Enter a description for the group node.

7 Select an area group style for the group node. For information about area 
group styles, see “Area Group Styles” on page 2056.

8 If desired, attach a name definition set to the group node. For information 
about area name definitions, see “Area Name Definitions” on page 2065.

9 Define what object types can be attached to the group node. You can 
choose areas, area groups, or both.

10 Select the calculation type used for that group node in the calculation of 
the floor plan. 

Example: You have two area group nodes: one to calculate how many 
square meters of carpet you need (group “Carpet”) and another to calcu-
late how many meters of baseboard you need (group “Baseboard”). For the 
Carpet group node, you need to calculate the area; therefore you select the 

Area group template shortcut menu

Shortcut menu 
command

Description

New Creates a new subgroup under the group you have 
selected.

Rename Lets you rename the group selected in the left pane.
You can also rename a group in the General area in the 
right pane of the Definition tab, or click F2. 

Delete Deletes the group selected from the group structure. 
Its subgroups are deleted with it. 
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area calculation type. For the Baseboard group node, you need to calculate 
the perimeter; therefore, you use the perimeter calculation type. 

You can select both calculation types here if you want both values to 
appear in the evaluation.

11 Select one or more calculation modifier styles to apply to the group node. 

For example, if you have a group node named “Balconies” you can attach 
a calculation modifier style that calculates all area values in this group 
with only 50 percent. 

NOTE Calculation modifier styles accumulate. If you attach a 50-percent 
calculation modifier style to the area directly, and then attach the area to a 
group that also has a 50 percent calculation modifier style, the resulting area 
value is 25 percent, because both calculation modifier styles are applied.

NOTE Calculation modifier styles are processed top-down, with the first 
style in the list processed first, the second style after that, and so on. Depend-
ing on your calculation formulas, you can receive different result values. To 
change the order of calculation modifier styles, drag them to the correct posi-
tions within the list. For an example of how the order of calculation modifier 
styles can affect the calculation results, see “Calculation Modifier Styles” on 
page 2023.

12 Click Attach.

13 In the Select an Area Calculation Modifier Style worksheet, select a calcu-
lation modifier style to attach to the group node, and click OK.

The templates contain a number of commonly used calculation modifier 
styles.

14 To detach a calculation modifier style, select it, and click Detach.

15 Click OK twice.

Attaching Notes and Files to an Area Group 
Template

Use this procedure to attach text notes and files to an area group template.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Group Templates.
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3 Select the template for which you want to add a note or file, right-click, 
and click Edit.

4 Click the General tab.

5 To add a description to the area group template, enter the description 
under Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK three times.

Area Evaluation

The area evaluation feature allows you to create detailed documents listing 
all aspects of your floor plan. You can include and exclude information and 
choose between different output formats. 

About Area Evaluation
The area evaluation is a documentation feature that calculates and evaluates 
the area information of your finished floor plan. This information is dis-

played in a separate file that you export from Autodesk® Architectural 
Desktop to a spreadsheet or word processing application. Evaluation tem-
plates ensure that the information is displayed in a consistent, structured 
way. 

Examples for Using the Area Evaluation
Architects need the area evaluation feature for submitting floor plans to the 
building authorities and customers. Area evaluation can also be used for per-

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click Open.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Close the application when you are 
done editing.

detach a reference file select the file name, click Delete, and click OK.
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forming cost estimates, assigning jobs to contractors, or organizing the facil-
ity management of buildings.

You can create evaluations for

� Selected areas and area groups in the current drawing
� Selected areas and area groups from multiple open drawings
� All areas and area groups in a drawing
� All areas and area groups from all open drawings
� External references from all open drawings

Related Topics and Procedures

� Preparing the Area Evaluation

� Creating an XLS Evaluation Document

� Creating a TXT Evaluation Document

� Creating XLT Templates

Preparing the Area Evaluation

Before you create an evaluation file, you select the areas and area groups to 
include, and you set a number of options that control the exported output. 

Related Procedures

� Selecting Areas for Evaluation

� Evaluation Content

� Image Display Properties

� Data Format Style Properties

� Setting the Default Templates

Selecting Areas for Evaluation

Use this procedure to select areas and area groups to include in the evalua-
tion.

1 Open the Documentation tool palette, and select the Area Evaluation tool.

If necessary, scroll to display the tool.
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Selecting areas and groups for an evaluation

In the left pane, all open drawings are displayed with areas and area 
groups in a tree structure.

When you highlight one of the areas or groups, the following information 
is displayed on the right side:

� Name and description 
� Base and calculated area
� Base and calculated perimeter
� Calculation type 
� Modifiers attached 

2 To display areas and area groups from external references in your open 

drawings, click . 

NOTE Areas and area groups from external references are displayed with 
the External References icon. You can select them in the same way as other 
areas and area groups. 

3 Select the areas and area groups you want to include in the evaluation of 
the floor plan:

� To include an area or area group in the evaluation, select the area or 
area group.

� To exclude an area or area group from the evaluation, clear the area or 
area group. 
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NOTE There are different colors for the check marks.
A black check mark means that you have selected this area or group directly for 
evaluation. You can clear that mark directly.
A gray check mark means that you have selected a subgroup or attached area of 
the gray-marked area group. This does not mean that the gray-marked super-
group is included in the evaluation; if you want to include it, select it directly. 
A blue check mark means that you have selected a supergroup of the blue-
marked group or area. The blue-marked subgroup is added to the evaluation 
because it is a subgroup or attached area of a group already selected.

Evaluation Content

Use this procedure to define the values and categories to include in the eval-
uation file.

For areas, you can choose these components:

Evaluation content for areas

Component Description

Name Name of the area, for example: 
“Living Room”

Description Description of the area, for example: 
“Main Living Room, Ground Floor”

Overview Image Graphic image of the area evaluated in bitmap format

Base Area Label Fixed prefix showing the type of the numbers, for 
example: 
“Base Area 50 m2”

Base Area Result Value of the area without calculation modifier styles 
taken into account, for example:
“Base Area 50 m2”

Calculated Area Label Fixed prefix showing the type of the numbers, for 
example:
“Calculated Area 48.5 m2”

Calculated Area Result Value of the area with calculation modifier styles taken 
into account, for example:
“Calculated Area 48.5 m2”
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Modifier Label Prefix showing the name of the modifiers, for 
example:
“Plaster deduction 50 * 0.97 = 48.5 m2”

Modifier Expression Formula of calculation modifier styles applied to areas, 
for example:
“Plaster deduction 50 * 0.97 = 48.5 m2”

Modifier Result Resulting value of applied area calculation modifier 
styles, for example:
“Plaster deduction 50 * 0.97 = 48.5 m2”

Proof Label Number of the area subdivisions plus any prefixes you 
may have set, for example:
“TF 1 (I): 0.5 * 7.591 * 4.156 = 15.772”

Proof Expression Formula of the decomposition method applied to the 
area, for example:
“TF 1 (I): 0.5 * 7.591 * 4.156 = 15.772”

Proof Result Result of the area decomposition, for example:
“TF 1 (I): 0.5 * 7.591 * 4.156 = 15.772”

Decomposed Image Graphic image of the area decomposition

Base Perimeter Label Fixed prefix showing the type of the numbers, for 
example:
“Base Perimeter 30 m”

Base Perimeter Result Value of the perimeter without calculation modifier 
styles taken into account, for example:
“Base perimeter 30 m”

Calculated Perimeter 
Label

Fixed prefix showing the type of the numbers, for 
example: 
“Calculated Perimeter 29.1 m”

Calculated Perimeter 
Result

Value of the perimeter with calculation modifier styles 
taken into account, for example:
“Calculated Perimeter 29.1 m”

Modifier Label Prefix showing the name of the modifier, for example:
“Plaster deduction: 30 * 0.97 = 29.1 m”

Modifier Expression Formula of calculation modifier styles applied to 
perimeters, for example:
“Plaster deduction: 30 * 0.97 = 29.1 m”

Evaluation content for areas (continued)

Component Description
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For area groups, you can choose these components:

Modifier Result Resulting value of any applied perimeter calculation 
modifier styles, for example:
“Plaster deduction: 30 * 0.97 = 29.1 m”

Evaluation content for area groups

Component Description

Name Name of the area group

Description Description of the area group

Overview Image Graphic image of the area group and its associated 
area boundaries

Base Area Label Fixed prefix showing the type of the numbers, for 
example:
“Base Area 75 m2”

Base Area Result Value of the area group’s total area without 
calculation modifier styles taken into account, for 
example:
“Base Area 75 m2”

Calculated Area Label Fixed prefix showing the type of the numbers, for 
example:
“Calculated Area 72.75 m2”

Calculated Area Result Value of the area group’s total area with calculation 
modifier styles taken into account, for example:
“Calculated Area 72.75 m2”

Modifier Label Prefix showing the name of the modifier style 
attached to the area group, for example:
“Group deduction 75 * 0.97 = 72.75 m2”

Modifier Expression Formula of calculation modifier styles applied to the 
area group, for example:
“Group deduction 75 * 0.97 = 72.75 m2”

Modifier Result Resulting value of any applied area group calculation 
modifier styles, for example:
“Group deduction 75 * 0.97 = 72.75 m2”

Evaluation content for areas (continued)

Component Description
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1 Open the Documentation tool palette, and select the Area Evaluation tool.

2 Click Evaluation Options.

3 Click the Evaluation tab. 

4 For Select, select Area or Area Group. 

5 In the list displayed, select the values you want to appear in the evaluation 
file. For a description of the individual values, see the table above. 

6 If desired, repeat Step 4–5 for area groups.

7 Click OK.

Image Display Properties

Use this procedure to define display settings for images included in your eval-
uation document. If you do not include images in your evaluation docu-

Base Perimeter Label Fixed prefix showing the type of the numbers, for 
example:
“Base Perimeter 50 m”

Base Perimeter Result Value of the area group’s total perimeters without 
calculation modifier styles taken into account, for 
example:
“Base Perimeter 50 m”

Calculated Perimeter 
Label

Fixed prefix showing the type of the numbers, for 
example:
“Calculated Perimeter 48.5 m”

Calculated Perimeter 
Result

Value of the area group’s total perimeters with 
calculation modifier styles taken into account, for 
example:
“Calculated Perimeter 48.5 m”

Modifier Label Prefix showing the name of the modifier attached to 
the area group perimeter, for example:
“Group deduction 50 * 0.97 = 48 m2”

Modifier Expression Formula of calculation modifier styles applied to the 
area group perimeter, for example:
“Group deduction 50 * 0.97 = 48.5 m”

Modifier Result Resulting value of any applied group calculation 
modifier styles, for example:
“Group deduction 50 * 0.97 = 48.5 m2”

Evaluation content for area groups (continued)

Component Description
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ment, you do not need to make any settings here. 

1 Open the Documentation tool palette, and select the Area Evaluation tool.

2 Click Evaluation Options.

3 Click the Image Display tab. 

Image display for area evaluation document

4 Select the drawing for which you want to set image properties. 

NOTE If you want to create an evaluation document including several open 
drawings, you need to set the image properties for each open drawing sepa-
rately. 

5 Choose the desired color depth for the images in the evaluation file. 
Choosing a high resolution enhances the quality of the images and also 
enlarges the file size. If you are not sure about the correct resolution, 
experiment with different settings until you have found the optimal one. 

6 Select the following settings for area boundaries, area groups, and decom-
posed areas:

� Select the display configuration of the chosen element (area, area 
group, or decomposed area) in the exported evaluation file. For exam-
ple, if you want to see your exported areas in Plan Low Detail, select 
Plan Low Detail. 

NOTE In the list, you will see only those display configurations in which 
display representations for areas, area groups, and decomposed areas are 
turned on.
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� Select the width and height of exported images of the areas, decom-
posed areas, and area groups.

7 Click OK.

Data Format Style Properties

You can set different data format styles for different elements of the 
evaluation file. 

� Area Result and Perimeter Result: The format of the resulting area and 
perimeter values in the evaluation file.

If you are using a data format style based on meters, and rounded off after 
three decimals, your area and perimeter results could look like this:

Calculated Perimeter = 33.778 m

Calculated Area = 88.532 m2

When you select Area Results or Perimeter Results in the left pane, an 
additional check box, Additional Exact Value, is displayed in the right 
pane. When you select this box, the area or perimeter value displays with 
the precision set in the data format style and, in an extra column, with 
their exact precision without rounding.

Example:

� Area and Perimeter Calculation Modifier Style Expressions: This formats 
the formula used for calculation modifier styles, for example:

Plaster Deduction = 88.832 - 0.3

� Area Proof: This formats the values of an area decomposition, for 
example:

1 (I): 4.035 m2

2 (I): 27.141 m2

3 (I): 36.41 m2

Calculated Perimeter = 
33.778 m

Exact Calculated Perimeter = 33.777692 m

Calculated Area = 
88.532 m2

Exact Calculated Area = 88.5321423 m2
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NOTE For information about creating data format styles, see “Property Data 
Formats” on page 2284.

1 Open the Documentation tool palette, and select the Area Evaluation tool.

2 Click Evaluation Options.

3 Click the Data Format Styles tab.

Setting data format styles

4 In the Apply To window, select the element to which you want to assign 
a data format style. You can choose from these elements:

� Area results
� Area calculation modifier expressions
� Area proof
� Perimeter results
� Perimeter calculation modifier expressions

5 For Area Result and Perimeter Result, you can select the exact, unrounded 
values as additional information in the evaluation file. To display these 
values, select Additional Exact Value. 

6 Select the drawing from which you want to take a data format style. 

7 Select the desired data format style. 

8 Click OK.
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Setting the Default Templates

An evaluation document is saved as a spreadsheet (XLS) file or as an ASCII 
text format (TXT) file. To create an XLS file, you need an XLT template and 
to create a TXT document, you need a TXT template.

Autodesk® Architectural Desktop includes a number of preset templates. You 
can use those templates “as-is” or modify them according to your needs.

You can also create your own XLT and TXT templates in Microsoft® Excel or 

any word processor, like NotePad or Microsoft® Word.

After a default template is set, it is used for all evaluations until you change 
the default settings again. If you set no default template, you are prompted 
for a template with every evaluation you create.

1 Open the Documentation tool palette, and select the Area Evaluation tool.

2 Click Evaluation Options.

3 Click the Templates tab.

4 Set a default template for evaluations:

TIP You can use the Browse buttons to navigate to the desired template file. 

5 Click OK. 

Creating the Area Evaluation Document

When you create the area evaluation document, you receive a separate file 
that contains the area information from one or several drawing files. This file 
is saved as an XLS file or a TXT file, depending on your settings. 

Related Procedures

� Creating an XLS Evaluation Document

If you want to . . . Then . . .

set a default template for XLS 
evaluation files

enter a file name and directory path for Excel 
Template File.

To set a default template for 
TXT evaluation files

enter a file name and directory path for Text 
Template File. 
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� Creating a TXT Evaluation Document

� Creating XLT Templates

Creating an XLS Evaluation Document

Use this procedure to export an area evaluation to an Excel spreadsheet.

One of the most frequently used formats for area evaluation documents is 

XLS, the native file format of Microsoft® Excel. It is a powerful spreadsheet 
file format with numerous calculation and formatting abilities. You can 
easily export data from Excel to formats like HTML, XML, CSV (comma-
delimited) or DBF (dBase). 

You can export text (results, modifier expressions, and labels) and images 
(bitmap previews of areas and groups). For a detailed list of elements that can 
be exported, see “Evaluation Content” on page 2077.

You can create your own XLT templates into which the evaluation is inte-
grated. For more information, see “Creating XLT Templates” on page 2086.

1 Open the Documentation tool palette, and select the Area Evaluation tool.

2 Prepare the area evaluation as described in “Preparing the Area Evalua-
tion” on page 2075.

3 Click .

4 Select the export template:

� If you did not select a default XLT template in the Evaluation Properties 
dialog box, you are prompted to select a template now.

� If you selected a default template in the Evaluation Properties dialog 
box, proceed to step 5. 

For information about setting default templates, see “Setting the Default 
Templates” on page 2084.

5 Select a file directory and enter a name for the XLS evaluation file.

6 Click Save. 

7 Click Close.

The area evaluation file is saved to the specified file directory and named as 
an XLS file. You can open it with Microsoft Excel or any other spreadsheet 
application that can read XLS.
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Creating a TXT Evaluation Document

Use this procedure to export an area evaluation to a text file. 

NOTE In TXT format, you can export text (results, modifier expressions, and 
labels), but not images. If you need to export images in the evaluation, use XLS 
format instead. 

You can create your own TXT templates into which the evaluation is then 
integrated. 

1 Open the Documentation tool palette, and select the Area Evaluation tool.

2 Prepare the evaluation as described in “Preparing the Area Evaluation” on 
page 2075.

3 Click .

4 Select the export template:

� If you did not select a default TXT template in the Evaluation Properties 
dialog box, you are prompted to select a template now.

� If you selected a default template in the Evaluation Properties dialog 
box, proceed to step 5.

For information about setting default templates, see “Setting the Default 
Templates” on page 2084.

5 Select a file directory and enter a name for the area evaluation file.

6 Click Save. 

7 Click Close.

The area evaluation file is saved to the specified file directory and named as 
a TXT file. You can open it with any word processor. 

Creating XLT Templates

Use this procedure to create a template for exporting an area evaluation to an 
Excel spreadsheet. 

To export an evaluation into an Excel file, you use an XLT template file.
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You can use a number of predefined field settings to format your XLT tem-
plates:

1 Open Microsoft Excel.

2 Select the table cell in which you want to place a special type of informa-
tion, such as pictures or results. 

3 Click the name box in the upper left corner of the Excel sheet and enter 
the desired field definition.

4 Repeat steps 2 and 3 for all information types you want to place.

5 Define additional settings for your template. Settings in an XLT file 
include

� Header and footer information
� Company logos
� Company fonts 
� Special cell formatting (borders, colors)

6 Save the resulting file with the extension XLT (Excel Template) to the 
default directory you are using for templates.

7 The next time you create an area evaluation in Autodesk Architectural 
Desktop, select this template. 

Excel field definition

Field name Description

AREA_EVALUATION_BEGIN The row in which your evaluation begins

AREA_COLUMN_IMAGE The column in which your exported images 
are placed

AREA_COLUMN_LABEL The column in which your labels and 
descriptions are placed

AREA_COLUMN_EXPRESSION The column in which your decomposition 
expressions and modifier formulas are 
placed

AREA_COLUMN_RESULT The column in which all results are placed

AREA_COLUMN_EXACT_VALUE The column in which the unrounded results 
are placed
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Sections

A section represents a building model as if the model 

were cut vertically to show interior detail. You can create 

two-dimensional (2D) or three-dimensional (3D) sec-

tion objects, or a live section view of the model. You can 

control the size and shape of the section you generate 

and assign materials to the section for an optimal visual 

representation of the sectioned objects. Section objects 

remain linked to the building model that you used to 

create them, unless you explode the section. Because of 

this link between the section and the building model, 

any changes to the building model can be reflected in 

the section as well.

In this chapter

� Process Overview: Creating a 
2D or 3D Section

� Process Overview: Creating a 
Live Section View

� Drawing and Editing Section 
Lines

� Creating a 2D or 3D Section

� Creating and Editing a Live 
Section View

� Editing a 2D or 3D Section

� Updating a 2D or 3D Section

� 2D Section Styles

28
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Section Line and Marks
The section line defines the extents of the section that you extract from the 
building model. Sections lines can be straight or jogged. You can also specify 
the length and the height of the area defined by the section line. Section 
marks, which typically contain a letter or number and indicate the direction 
of the section, appear at each end of the section line.

After you draw the section line, you can create a section object or a live sec-
tion view from the line.

Section line through a building model in plan view

2D Sections
2D sections are created by cutting a number of objects with a section line and 
then creating a 2D section object from them. The section object is drawn 
without hidden and overlapping lines. You can edit a 2D section by changing 
its object display properties or its style display properties. The 2D section 
style lets you add display components to the display representation of the 
section and create rules that assign different parts of the section to different 
display components. You can control the visibility, layer, color, linetype, lin-
eweight, and linetype scale of each component. You can also choose whether 
materials, such as brick or concrete hatches, are used to display individual 
components of the section object or the 2D section style. Furthermore, you 
can use linework editing commands to assign individual lines in a 2D section 
to different display components, and merge geometry into a 2D section. You 
can dimension 2D sections.
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2D section with surface and shrinkwrap hatch detail

3D Sections
3D sections are created by cutting a number of objects with a section line and 
then creating a 3D isometric section object from them. 3D sections do not 
use styles. However, you can control the display of subdivisions within 3D 
sections. Using the Hidden Line Projection command, you can create 2D hid-
den line projections of any view of the 3D section that you can explode and 
edit or hatch. For more information about using this command, see “Creat-
ing a Hidden Line Projection” on page 2540.

3D section in 3D view
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Section Subdivisions
A 2D or 3D section object can have a number of subdivisions partitioning the 
section object. This feature is useful when you want to create a view of the 
object in which the parts that are closer to the viewer are drawn with darker 
and stronger lines, and parts that are farther off are drawn lighter. 

3D section with subdivisions and assigned colors in perspective view

Live Section View 
A live section view is a special view of a 3D section where the objects that are 
sectioned are not converted to a 3D section object. Instead, the existing 
model objects are displayed as a 3D section. The parts of the objects within 
the bounding box of the section line keep their individual display compo-
nents while the parts of the objects outside of the section line can optionally 
be displayed or hidden. To control the appearance of the object parts outside 
of the section line, you need to assign a material to the sectioned objects. 

When you render a live section, you can show the outside part as a half-trans-
parent addition, for example. 

For more information, see “Creating and Editing a Live Section View” on 
page 2110.
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Rendered live section view with transparent body component

Materials in Sections
In Autodesk® Architectural Desktop, you can assign materials to different 
components of an object. These materials are displayed when you create a 2D 
or 3D section object or a live section view. Materials have specific settings for 
sections, such a as a 2D section hatch setting and a sectioned boundary for 
live section views. In a 2D or 3D section object, you can specify whether to 
use the display properties of the materials or the display properties of the sec-
tion object.
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2D section with different surface hatches 

Autodesk® Architectural Desktop provides a large number of predefined 
materials for all common design purposes. You can use these predefined 
materials, or modify them to your special designs. You can also create your 
own materials from scratch. For more information, see “About 2D and 3D 
Section Display Components and Materials” on page 2132.

Subdivisions in 2D Section Styles and Materials
When you create subdivisions in your style, you usually want the objects in 
them to be visually distinct from other subdivisions. When you assign mate-
rials to the objects, you can set the 2D section style so that it uses the hatch 
pattern from the material, but uses the color and linetype from the subdivi-
sion display properties. 

3D section with subdivisions and assigned colors in 3D view
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For more information see “Use Subdivision Properties and Materials in 2D 
Section Styles” on page 2139.

Material Boundaries in 2D Sections
Material boundaries allow you to erase or limit portions of a 2D section or 
elevation. For example, you might do the following:

� Limit the amount of hatching to produce cleaner CDs.
� Highlight a region in an elevation or section.

2D section with highlighted hatching region detail

� Mask out a portion of a section so that more detail can be drawn.
2D section with hatch masked

� Crop an irregular-shaped portion of a section or elevation.
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2D section with cropped material display detail

For more information, see “Creating a Material Boundary in a 2D Section” on 
page 2118.

Related Topics and Procedures

� Process Overview: Creating a 2D or 3D Section

� Process Overview: Creating a Live Section View

� Drawing and Editing Section Lines

� Creating a 2D or 3D Section

� Creating and Editing a Live Section View

� Editing a 2D or 3D Section

� Updating a 2D or 3D Section

� 2D Section Styles

Process Overview: Creating a 2D or 3D 
Section

Creating a 2D or 3D section from a building model entails the following 
steps:

Step 1: Draw a section line and mark.

The section line defines the extents of the section (its width, height, and 
length) to extract from the building model. The section line also deter-
mines other characteristics of the section. You can also use the section line 
to define graphic subdivisions, in order to add levels of depth to the sec-
tion object created from the section line.
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A section line with graphic subdivisions

Step 2: Create a 2D or 3D section.

You select the section line, right-click, and click Generate Section to create 
a 2D or 3D section object. At this time, you select the objects to include in 
the section. You also select the display representation for the selected 
objects, and the insertion point of the section in the drawing. If you create 
a 2D section, you also select a 2D section style, which determines the 
visual characteristics of the section.

2D section created from the section line shown above

Step 3: Edit the section or the building model.

You can edit the section line and the section object to refine the appear-
ance of the section by doing the following:

� Edit the section line to change the area defined by the section and to 
add, remove, or modify graphic subdivisions.

� Edit the 2D section style, which determines how the linework in a 2D 
section is displayed.
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� Edit existing material assignments, such as hatch patterns. 
� Add a material boundary, so that only selected parts of the section are 

displayed with materials. This can improve performance and make the 
drawing clearer. 

� Edit a 2D section object to change the display of selected linework or 
to add linework and detail that are not part of the building model.

You can continue to modify the building model as needed.

Step 4: Update the section.

You update a section to apply changes you made to the section line, the 
section object (including style changes to a 2D section), and the building 
model. When you update a section, you can also make any of the follow-
ing changes:

� Select a different style for a 2D section.
� Select different objects to include and exclude from the section.
� Select a different display representation.
� Replace the existing section or add a new section showing the changes 

you made.

You can also refresh one or more sections to quickly apply changes you 
made to the section line, the section object, or the model.

Related Topics and Procedures

� Drawing and Editing Section Lines

� Creating a 2D or 3D Section

� Editing a 2D or 3D Section

� Updating a 2D or 3D Section

Process Overview: Creating a Live Section 
View

Creating a live section view of a building model entails the following:

Step 1: Draw a section line. 

For more information, see “Drawing a Section Line and Marks” on 
page 2101.

Step 2: Switch into a 3D model view.
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Step 3: Enable the live section view.

Related Topics and Procedures

� Drawing a Section Line and Marks

� Creating and Editing a Live Section View

Drawing and Editing Section Lines

The first step in creating a section is to draw a section line through the build-
ing model. The section line defines the extents of the section to extract from 
the building model. 

Creating a Section Object from a Section Line
When you generate a section from a section line, you specify the type of sec-
tion object that is created.

Creating a Live Section View from a Section Line
When you create a live section view from a section line, you do not create a 
new section object but instead switch to a special view of the 3D building 
model. You do not select objects to include in the section; the live section 
view includes all objects in the drawing. The section line controls how 
objects are displayed in a live section view. Objects or parts of objects that are 
within the bounding box of the section line retain their original display 
properties. Objects or parts of objects that are outside of the section line are 
either not displayed at all or displayed with a special display component for 
the sectioned body.

Viewing the Section Line 
In plan view, the section line is displayed as you would expect on a 
construction document. The section marks point in the direction that the 
section is cut.

When you create . . . The result is . . .

a 2D section object an orthographic projection from the building 
model.

a 3D section object or a live 
section

the area of the building model defined in the 
section line.
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Viewing the section line and mark in plan view

In an isometric view, the same section line is displayed with a boundary that 
defines the extents of the section.

Viewing a section line in isometric view

Changing the Section Line 
You can change the section line to control the section that you create. Within 
the section line, you can change the height and shape of the section. You can 
also add a lower extension to the section and create section subdivisions.

You can change section line properties before or after you create a section. 
After changing section line properties, you can apply the changes to a section 
that you previously created with the section line. For information about 
updating existing sections, see “Updating a 2D or 3D Section” on page 2126.
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For information about updating existing live section views, see “Updating a 
Live Section View” on page 2112.

Using Subdivisions in Sections
You can set up graphic subdivisions in section line properties. These subdivi-
sions are added to the 2D or 3D section you create. Subdivisions are specified 
at distances from the cutting plane of the section line. You can control the 
lineweight and other display properties of subdivisions to add levels of depth 
to sections. For example, you can display one subdivision with a heavy line-
weight and another subdivision with a lighter lineweight to suggest that the 
first subdivision is in front of the second subdivision.

You can use the display properties of a subdivision together with the display 
properties of a material. For more information, see “Use Subdivision Proper-
ties and Materials in 2D Section Styles” on page 2139.

Related Procedures

� Drawing a Section Line and Marks

� Changing the Dimensions of a Section

� Creating Graphic Subdivisions for 2D and 3D Sections

� Changing Section Mark Attributes

� Changing the Location of a Section Line

� Attaching Hyperlinks, Notes, and Files to a Section Line

Drawing a Section Line and Marks

Use this procedure to draw a section line with a section mark at each end. You 
draw a section line by specifying a start point, an endpoint, a length, and a 
height for the section. You can specify additional points between the start 
point and the endpoint to create jogs in the section. The section line acts as 
a cutting plane, slicing a section from the building model.

NOTE If you are working with a drawing set where several xrefs are linked to 
a main drawing, draw the section line in the main drawing.

1 On the default tool palette set, click the Design tab, and then click the Sec-
tion Line tool.

If necessary, scroll the palette to display the tool that you need.

2 Specify the start point of the section line.

3 Continue to specify points to define the section line, if needed. 
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You can create jogs in the section line to cut through portions of the build-
ing model that you want to show in the section, but which are not along 
a single straight path.

4 Specify the endpoint of the section line, and press ENTER.

Specifying section line start and end points in 3D view

5 Specify the length of the section, or press ENTER to accept the length taken 
from the endpoints of the line.

The section line is displayed in the drawing. Depending on the direction 
in which you drew the section line, the section marks point in the direc-
tion of the section.
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The section marks are multi-view blocks, anchored to the section line. You 
can edit the section marks to change the information displayed in the bub-
bles. For more information, see “Changing Section Mark Attributes” on 
page 2106.

The height of the section line is set to the extents of the selected objects. You 
can change the properties of the line to change the height and depth of the 
section, add a lower extension, or add subdivisions. For more information, 
see “Changing the Dimensions of a Section” on page 2103.

Changing the Dimensions of a Section

Use this procedure to change the height and the length of any section con-
nected to the section line, or to add a lower extension to the section line. You 
can change the dimensions of the section line before or after you create a 
connected section. If you change the dimensions after creating the section, 
you need to update the section to show the changes.

The depth of a section (its length) can also be defined using grips to edit the 
section line boundary in the drawing.

1 Double-click the section line you want to change.

2 On the Properties palette, expand Basic, and expand Dimensions.

3 Specify new dimensions:

If you want to . . . Then . . .

use the height of the 
objects in the section to 
define the section height

select Yes for Use Model Extents for Height.
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4 Expand Component Dimensions.

5 Specify the length of the lines that define the depth of the section by 
entering values for Side 1 and Side 2.

Side 1 starts from the first point specified for the section line. Side 2 starts 
from the endpoint of the section line.

Specifying section height, lower extension, and side parameters

6 Specify values for Angle 1 and Angle 2. 

These values define the angles of the two sides from the section line to cre-
ate the section box. The apex of Angle 1 is the start point of the section 
line. The apex of Angle 2 is the endpoint of the section line. Values for 
these angles must be between 0 and 90 degrees.

define the height of the 
box to create a section 
from a Z value measured 
from the XY plane of the 
world coordinate system 
(WCS) or the current user 
coordinate system (UCS)

select No for Use Model Extents for Height, and 
enter a value for Height. 
The objects are cut at this height when you create 
or update a section.

define the lower limit of 
the section box as a Z 
value measured from the 
XY plane of the WCS or the 
current UCS

select No for Use Model Extents for Height, and 
enter a value for Lower Extension. 
By default, the lower section is 1 foot below the XY 
plane unless Use Model Extents for Height is 
selected.

If you want to . . . Then . . .
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Specifying section angle parameters

7 Click OK.

To update a 2D or 3D section created from this section line, see “Updating a 
2D or 3D Section” on page 2126.

Creating Graphic Subdivisions for 2D and 3D 
Sections

Use this procedure to define subdivisions that are created when you generate 
a section. Each subdivision is specified as a distance from the cutting plane 
of the section line.

You can view the location of a subdivision by viewing the section line with 
its boundary in an isometric view. In this view, you can use grips to relocate 
a subdivision.

You can control the lineweight and other display properties of the subdivi-
sions to add different levels of depth to sections.

You can use the display properties of a subdivision together with the display 
properties of a material. For more information, see “Process Overview: Creat-
ing a 2D or 3D Section” on page 2096 and “Use Subdivision Properties and 
Materials in 2D Section Styles” on page 2139.

1 Double-click the section line you want to change.

2 On the Properties palette, expand Basic, and expand Dimensions.
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3 Click the setting for Subdivisions, and then add or modify subdivisions:

4 Click OK. 

Changing Section Mark Attributes

Use this procedure to change the information displayed in the section mark. 
The section mark is a multi-view block.

1 Double-click the section mark you want to change.

2 On the Properties palette, expand Advanced.

3 Click Attributes.

4 Select the existing attribute under Value, and enter the new information 
to include in the bubble.

5 Click OK.

Changing the Location of a Section Line

Use this procedure to relocate a section line by changing the coordinate val-
ues of its insertion point. The section line also has an orientation with 
respect to the WCS or the current UCS. For example, if the top and bottom 
of the section line are parallel to the XY plane, its normal is parallel to the Z 
axis. You can change the orientation of the section line by aligning its nor-
mal with another axis. You can also rotate the section line on its plane by 
changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 

online AutoCAD® User’s Guide.

If you want to . . . Then . . .

create a subdivision
click .

To change the default distance from the section 
line, select the subdivision, then click the value and 
enter a new one.

change the length of a 
subdivision

select the subdivision, then click its value and enter 
a new one.

delete a subdivision
select the subdivision, and click .
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1 Double-click the section line you want to relocate.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional Information.

4 Specify the location of the section line:

5 Click OK.

To update an existing section created from this section line, see “Updating a 
2D or 3D Section” on page 2126.

Attaching Hyperlinks, Notes, and Files to a 
Section Line

Use this procedure to add hyperlinks, enter notes, and attach reference files 
to a section line. You can also edit notes and edit or detach reference files 
from a section line.

1 Double-click the section line you want to attach notes or files to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® Com-
mand Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

If you want to . . . Then . . .

relocate the section line enter new coordinate values under Insertion Point.

locate the section line on 
the XY plane

make the normal of the section line parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the section line on 
the YZ plane

make the normal of the section line parallel to the X 
axis: under Normal, enter 1 for X, and enter 0 for Y 
and Z. 

locate the section line on 
the XZ plane

make the normal of the section line parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
section line

enter a new value for Rotation Angle.
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5 To attach, detach, or edit a reference file, click  next to Reference doc-
uments, and then do any of the following:

6 Click OK.

Creating a 2D or 3D Section

Use this procedure to create a 2D or 3D section. After you draw a section line, 
you extract a section from the section line and the objects you select in the 
building model.

TIP Before you create a section, thaw and turn on all layers containing objects 
that you want to include in the section. Objects on layers that are off or frozen 
cannot be part of the selection set for the section. To enhance performance, turn 
off the layers of the objects that you do not need to include in the section.

1 Draw a section line in the drawing. 

For more information, see “Drawing a Section Line and Marks” on 
page 2101.

2 Select the section line, right-click, and click Generate Section.

3 Select the type of section object you want to create:

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If you want to create . . . Then . . .

a 2D section select 2D Section/Elevation Object with 
Hidden Line Removal.
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4 For Style to Generate, select a style for a 2D section. 

If you want to use a particular style, select it from Style to Generate. Oth-
erwise, use the Standard style. For more information, see “2D Section 
Styles” on page 2128.

3D sections do not use styles.

5 Under Selection Set, click  (Select Objects), and select the objects that 
you want to include in the section. Press ENTER when you finish selecting 
objects.

NOTE If you select an object that you do not want to include in the section, 
hold down SHIFT and select the object again to remove it from the selection 
set.

6 Under Display Set, select a display set for the section object.

The display set controls the representation of the section.

7 Under Placement, select New Object, and specify where to place the sec-
tion:

8 Click OK.

A 2D or 3D section is created from the section line properties and the 
selected objects in the building model. The section is linked to the build-
ing model. If you make changes to the building model after you create the 
section, you can update the section to reflect the changes. For more infor-
mation, see “Updating a 2D or 3D Section” on page 2126.

a 3D section select 3D Section/Elevation Object.

If you want to . . . Then . . .

specify a location 
graphically click  (Pick Point), and specify the location for 

the new section object in the drawing.

specify the coordinates of 
the insertion point for the 
section

enter X, Y, and Z coordinates for the location of the 
new section object.

If you want to create . . . Then . . .
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You can edit certain characteristics of the section to control its placement 
and appearance. For more information, see “Editing a 2D or 3D Section” on 
page 2114.

You can also use a 2D section style to control the display of selected objects 
in a 2D section, and you can control the display of individual lines in a 2D 
section. For more information, see “2D Section Styles” on page 2128 and 
“Editing and Merging Linework in a 2D Section” on page 2123.

Creating and Editing a Live Section View

A live section view is a special view of a 3D model section. 

A live section view is always applied to all objects in the drawing. Unlike a 
2D or 3D section, you do not choose a selection set of objects to be contained 
in the section. All objects are contained in the live section view. Their display 
properties are determined by whether or not they are situated within the 
bounding box of the section line.

The objects contained in the live section view are not converted into a sec-
tion object, but are retained as objects in the drawing. They keep all of their 
properties and display components, and can be edited. The area of objects 
that lie outside of the section line, or objects that lie completely outside of 
the section line, can be displayed or hidden. The appearance of these objects, 
and of parts of objects outside of the section line, is controlled by the Sec-
tioned Body component. When you render a live section, you can show the 
outside part as a half-transparent addition, for example. 

The live section view can be turned on and off in a drawing.
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Rendered live section view with transparent sectioned body

Related Topics and Procedures

� Creating a Live Section View

� Updating a Live Section View

� Displaying the Sectioned Body in a Live Section View

� Removing a Live Section View

Creating a Live Section View

Use this procedure to create a live section view of your building model.

1 Draw a section line through the building model. 

NOTE You do not need to select objects for the live section view. The live 
section view is created from the whole drawing. 

2 Switch to a 3D view, such as SW Isometric. 

3 Select the section line, right-click, and click Enable Live Section.
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Updating a Live Section View

When you create a live section view, the sectioned objects are not converted 
into a section object. Instead, the objects remain in the drawing. The objects 
and object areas which are inside the section line retain their previous dis-
play properties. A brick wall inside a section line retains its brick pattern and 
its dark red linework. The objects and object areas outside of the section line 
change their display properties, since they are now placed on the Sectioned 
Body display component and use its display properties.

The live section updates interactively when you change the objects associ-
ated with it. If you drag a wall outside of the section line, the wall uses the 
display properties of the Sectioned Body component. If you drag a wall inside 
of the section line, the wall uses its own display properties.

When you change the material assignment of an object in a live section view, 
the new material is automatically used in the live section.

NOTE  If you change from a material in which the Sectioned Boundary and 
Sectioned Body components are turned on, to a material in which these compo-
nents are turned off, it might look as if objects outside of the section line disap-
pear. You can edit the current material definition to display objects outside of the 
section line, as described in “Displaying the Sectioned Body in a Live Section 
View” on page 2112.

Displaying the Sectioned Body in a Live Section 
View

Use this procedure to display the parts of the drawing in a live section view 
that are outside the section.

Whether objects and areas of objects outside the section line are displayed in 
the live section view depends on the material settings for each object and 
object style. The sectioned objects inside the section are displayed with their 
regular display components and material assignments. For example, a brick 
wall inside a section displays its regular brick surface hatch. 

Objects or object parts that are outside of the section are displayed differ-
ently. You can either hide them completely, or display them on the Sectioned 
Body display component. The Sectioned Body display component is speci-
fied in the material assigned to the object. 

The sectioned body is often displayed in a lighter, half-transparent color, or 
as dotted linework.
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Live section view with sectioned body displayed as light blue linework

In a material definition, the Sectioned Body and Sectioned Boundary display 
components influence the display of the live section view. The Sectioned 
Body includes the objects or object parts outside of the section line. The Sec-
tioned Boundary is the cut line created by the section line.

1 Select the object for which you want to display the sectioned body, right-
click and click Edit Object Display. 

2 Click the Materials tab. 

3 Select the material definition you want to change, and click .

4 Select the display representation of the material, and click .

5 Click the Layer/Color/Linetype tab. 

6 Change the display of the sectioned body and sectioned boundary: 

7 Click OK three times.

NOTE When the Sectioned Body component is set to visible and the material 
display component is on, you can turn the display of the sectioned body on and 
off by right-clicking the section line and clicking Toggle Sectioned Body Display.

If you want to . . . Then . . .

hide the sectioned body set Visible off for the Sectioned Body and 
Sectioned Boundary components.

display the sectioned body set Visible on for the Sectioned Body and 
Sectioned Boundary components, and assign them 
display properties as needed.
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Removing a Live Section View

Use this procedure to turn off a live section view. You can also remove the 
live section view by deleting the section line that was used to create it.

1 Select the section line that was used to create the live section view. 

2 Right-click, and click Disable Live Section. 

After turning off the live section view, you see the regular 3D building 
model again. You can turn live section view on and off as long as the sec-
tion line remains in the drawing.

Editing a 2D or 3D Section

After you create a 2D or 3D section, you can edit the section line and the sec-
tion object to refine the appearance of the section:

� Add, remove, or modify graphic subdivisions.
� Reverse the section to display a different area of the building.
� Relocate the section.
� Add notes or reference files.
� Select a different style. A section style determines how the linework in a 

2D section is displayed.
� Change the display properties of selected linework
� Add linework and details that are not part of the building model.

In addition, you can continue to modify the building model and then update 
the section to incorporate the changes.

You can also create and edit material boundaries for 2D sections. For more 
information, see “Creating a Material Boundary in a 2D Section” on 
page 2118.

Related Topics and Procedures

� Changing the Display of Graphic Subdivisions in a 2D Section

� Changing the Display of Graphic Subdivisions in a 3D Section

� Reversing a 2D or 3D Section

� Changing the Style of a 2D Section

� Creating a Material Boundary in a 2D Section

� Editing a Material Boundary

� Editing and Merging Linework in a 2D Section

� Changing the Location of a 2D or 3D Section
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� Attaching Hyperlinks, Notes, and Files to a 2D or 3D Section

Changing the Display of Graphic Subdivisions in a 
2D Section

Use this procedure to change the display of subdivisions in a 2D section by 
changing its display properties. 

You create subdivisions by adding them to the section line. You can then 
change their length using grips or by editing the values in the section line 
properties. For more information, see “Creating Graphic Subdivisions for 2D 
and 3D Sections” on page 2105.

Each subdivision in a 2D section is assigned to a numbered subdivision dis-
play component in the display properties of the section or the 2D section 
style. You can control the visibility, layer, color, linetype, lineweight, and 
linetype scale of each subdivision by changing the display properties of each 
component. You can apply these changes to the selected section, to the cur-
rent 2D section/elevation style, or to all 2D sections and elevations in the 
drawing that do not have a style override.

1 Select the 2D section in the drawing, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the property source to edit:

4 If necessary, click .

5 Click the Layer/Color/Linetype tab to list all the components that contrib-
ute to the display of the object. 

If you want to edit graphic 
subdivisions for . . .

Then . . .

 all 2D sections and elevations in the 
current drawing (except those that have 
a 2D Section/Elevation Style override), 

select Drawing Default.

 all 2D sections and elevations that use 
the current style,

select 2D Section/Elevation Style, and 
click Object Override.

 the selected 2D section Select 2D Section/Elevation, and click 
Object Override.
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The defining line represents the cutting plane of the section line. The 
numbered subdivision components correspond to subdivisions added to 
the section line. For example, the display component Subdivision 1 corre-
sponds to the subdivision closest to, but not on, the cutting plane of the 
section line.

6 Turn the visibility on or off, and change the layer, color, linetype, line-
weight, or linetype scale as needed for each subdivision component. 

7 Click the Hatching tab to change the shrinkwrap hatch pattern of the s

8 Click the Other tab to add a custom display component to the display of 
the 2D section. 

For more information about adding custom display components, see 
“Adding a Display Component to a 2D Section Style” on page 2131.

9 Click OK twice.

Changing the Display of Graphic Subdivisions in a 
3D Section

Use this procedure to change the display of subdivisions in a 3D section by 
changing its display properties. 

You create the subdivisions by adding them to the section line. You can then 
change their length using grips or by editing the values in the section line 
properties. For more information, see “Creating Graphic Subdivisions for 2D 
and 3D Sections” on page 2105.

Each subdivision in a 3D section is assigned to a numbered subdivision dis-
play component in the display properties of the 3D section. You can control 
the visibility, layer, color, linetype, lineweight, and linetype scale of each sub-
division by changing the display properties of each component. You can 
apply these changes to the selected 3D section or to all 3D sections in the 
drawing.

1 Select the 3D section in the drawing, right-click, and click Edit Object Dis-
play.

2 Click the Display Properties tab.

3 Select the Sub-divisions display representation.
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4 Select the property source to edit:

5 If necessary, click .

6 Click the Layer/Color/Linetype tab to list all the components that contrib-
ute to the display of the object.

The defining line represents the cutting plane of the section line. The 
numbered subdivision components correspond to subdivisions added to 
the section line. For example, the display component Subdivision 1 corre-
sponds to the subdivision closest to, but not on, the cutting plane of the 
section line.

7 Turn the visibility on or off, and change the layer, color, linetype, line-
weight, or lineweight scale as needed for each subdivision component.

8 Click OK twice.

Reversing a 2D or 3D Section

Use this procedure to reverse the direction of a section by reversing the sec-
tion line and refreshing the section.

The direction of the section is determined by the direction in which you 
drew the section line. You can select the section line in plan view to see the 
bounding box that defines the area of the model included in the section. If 
the box does not include the area of the model that you intended, you can 
reverse the section line. If you have already created a section from the section 
line, update the section after reversing the section line.

1 Select the section line that you used to create the section, right-click, and 
click Reverse.

The section line is mirrored about its own axis, as is the bounding box 
with its original parameters.

2 Select the existing section, right-click, and click Regenerate.

If you want to edit 
graphic subdivisions 
for . . .

Then . . .

all 3D sections in the current 
drawing 

select Drawing Default.

the selected 3D section select Bldg Section, and click object Override.
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NOTE If you do not need to respecify the objects to include in the section, 
you can click Refresh instead of Regenerate. This immediately updates the 
section.

3 If you want to include different objects in the updated section, click  
(Reselect Objects), and select the objects. Press ENTER when you finish 
selecting objects.

4 Click OK.

Changing the Style of a 2D Section

Use this procedure to select a different style for a 2D section. A 2D section/
elevation style controls the appearance of any 2D section object to which the 
style is applied.

1 Double-click the section you want to change.

2 On the Properties palette, expand Basic, and expand General.

3 Select a new style for the section.

Creating a Material Boundary in a 2D Section

Use this procedure to create a material boundary in a 2D section. For more 
information, see “Material Components and Display Properties” on 
page 498.

1 Draw a polyline around the area in the section that you want to mask or 
to highlight.

2 Select the section, right-click, and click Material Boundary ➤ Add.

3 Select the polyline. 

4 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing. 

5 Specify the settings of the material boundary: 

If you want to . . . Then . . .

highlight the area inside the 
polyline

select Limit for Purpose.

mask (erase) the area inside the 
polyline

select Erase for Purpose.
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6 Click OK.

Editing a Material Boundary

You can edit existing material boundaries in a number of different ways:

� Change the content within the material boundary. For example, you can 
determine if you want to see only surface hatching, or both surface and 
section hatching. 

� Change the shape of the material boundary. For example, you can make 
the boundary bigger or smaller, or add additional rings and vertex points 
to it. 

For more information, see “Material Components and Display Properties” on 
page 498.

Related Procedures

� Editing the Content of a Material Boundary

� Adding a Vertex to a Material Boundary

� Removing a Vertex from a Material Boundary

� Adding a Ring to a Material Boundary

apply the highlight or mask only 
to specific parts of the section 

select the appropriate parts for Apply to. You 
can choose Surface and Section Hatching, 
Section Hatching Only, Surface Hatching 
Only, Edge Linework Only, and All Linework.

apply the material boundary to 
all materials used in the section

select All Materials for Material Selection.

apply the material boundary only 
to selected materials

select Specific Materials for Material 
Selection and then select the desired 
materials in the list below. 

apply the highlighting or 
masking within the polyline to 
the shrinkwrap linework

select Apply to Section Shrinkwrap 
Linework. For information on section 
shrinkwrap, see “Shrinkwrap” on 
page 2135, and “Shrinkwrap Hatch” on 
page 2136.

apply the highlighting or 
masking within the polyline to 
the shrinkwrap hatching

select Apply to Section Shrinkwrap 
Hatching. For information on section 
shrinkwrap, see “Shrinkwrap” on 
page 2135, and “Shrinkwrap Hatch” on 
page 2136.

If you want to . . . Then . . .
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� Removing a Ring from a Material Boundary

� Replacing a Ring from a Material Boundary with Another

Editing the Content of a Material Boundary
Use this procedure to change the content of a material boundary. The con-
tent includes such settings as materials displayed, hatch types, and boundary 
type.

1 Select the 2D section with the material boundary, right-click, and click 
Material Boundary ➤ Edit In Place. 

You are now in in-place edit mode. The material boundary is highlighted, 
and the grips are displayed.

2 Right-click, and click Edit Material Boundary. 

3 Specify the content of the material boundary: 

4 Click OK.

5 Select the material boundary, right-click, and click Save Changes to save 
the changes you made, or click Discard All Changes to undo the changes 
to the material boundary. 

Adding a Vertex to a Material Boundary
Use this procedure to add a vertex to a material boundary.

1 Select the 2D section with the material boundary to change, right-click, 
and click Material Boundary ➤ Edit In Place. 

If you want to . . . Then . . .

highlight the area inside the 
boundary

select Limit for Purpose.

mask (erase) the area inside the 
boundary

select Erase for Purpose.

apply the highlight or mask only 
to specific parts of the section 

select the appropriate parts for Apply to. You 
can choose Surface and Section Hatching, 
Section Hatching Only, Surface Hatching 
Only, Edge Linework Only, and All Linework.

apply the material boundary to 
all materials used in the section

select All Materials for Material Selection.

apply the material boundary only 
to selected materials

select Specific Materials for Material 
Selection, and then select the desired 
materials from the list below. 
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You are now in in-place edit mode. The material boundary is highlighted, 
and the grips are displayed.

2 Right-click, and click Add Vertex. 

3 Specify the point at which to add a vertex.

4 Specify additional vertex points as needed.

5 Press ENTER. 

6 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary. 

Removing a Vertex from a Material Boundary
Use this procedure to remove a vertex from a material boundary.

1 Select the 2D section with the material boundary to change, right-click, 
and click Material Boundary ➤ Edit In Place. 

You are now in in-place edit mode. The material boundary is highlighted, 
and the grips are displayed.

2 Right-click, and click Remove Vertex. 

3 Specify the vertex points to remove. 

4 Press ENTER. 

5 Select the material boundary, right-click, and click Save Changes to save 
the changes you made, or click Discard All Changes to undo the changes 
to the material boundary.

Adding a Ring to a Material Boundary
Use this procedure to add a ring to a material boundary.

A material boundary can consist of more than one closed polyline. For exam-
ple, you could use one polyline to highlight a wall detail and another 
polyline to highlight a window detail in another location. 

1 Draw a polyline for the new material boundary ring. 

2 Select the material boundary to add a new ring to, right-click, and click 
Material Boundary ➤ Edit In Place. 

You are now in in-place edit mode. The material boundary is highlighted, 
and the grips are displayed.

3 Right-click, and click Add Ring.

4 Select the polyline you drew in Step 1. 
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5 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing.

6 Select the material boundary, right-click, and click Save Changes to save 
the changes you made, or click Discard All Changes to undo the changes 
to the material boundary.

Removing a Ring from a Material Boundary
Use this procedure to remove a ring from a material boundary.

A material boundary can consist of more than one closed ring. You can 
remove each ring individually. 

NOTE You cannot remove the last ring from a material boundary.

1 Select the 2D section with the material boundary to change, right-click, 
and click Material Boundary ➤ Edit In Place. 

You are now in in-place edit mode. The material boundary is highlighted 
and the grips are displayed.

2 Right-click, and click Remove Ring.

3 Select the ring you want to remove. 

4 Select the material boundary, right-click, and click Save Changes to save 
the changes you made, or click Discard All Changes to undo the changes 
to the material boundary. 

Replacing a Ring from a Material Boundary with Another
Use this procedure to replace a ring from a material boundary with a different 
ring.

1 Draw the polyline to replace one of the existing material boundary rings.

2 Select the 2D section with the material boundary to change, right-click, 
and click Material Boundary ➤ Edit In Place. 

You are now in in-place edit mode. The material boundary is highlighted 
and the grips are displayed.

3 Right-click, and click Replace Ring.

4 Select the ring to be replaced.

5 Select the closed polyline you drew in Step 1.

6 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing.
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7 Select the material boundary, right-click, and click Save Changes to save 
the changes you made, or click Discard All Changes to undo the changes 
to the material boundary. 

Editing and Merging Linework in a 2D Section

After you create a 2D section, you can edit the display of individual lines that 
make up the section. For example, you may want to assign linework for small 
details to a display component with a lighter lineweight, so that the details 
are not obscured when plotted.

You can also merge existing geometry into the section.

Related Procedures

� Editing Linework in a 2D Section

� Merging Linework into a 2D Section

Editing Linework in a 2D Section
Use this procedure to edit individual lines in a 2D section by assigning them 
to display components in the section. 

You can assign selected linework to fixed display components that determine 
the display of every section that you generate, or you can assign linework to 
display components that you have defined. For information about adding 
custom display components, see “Adding a Display Component to a 2D Sec-
tion Style” on page 2131. After you assign linework to display components, 
you can change the display properties (visibility, color, layer, lineweight, 
linetype, and linetype scale) to change the display of lines.

1 Select the section to be changed, right-click, and click Linework ➤ Edit.

2 Select the lines that you want to assign to a display component, right-
click, and click Modify Component.

A list of available display components is displayed. 

3 Select the component on which to put the lines.

For example, to make the lines invisible, select Erased Vectors for Line-
work Component.

You can also click  (Match existing linework) and select linework in the 
section whose display component you want to match.

4 Click OK.

5 To finish the linework editing process, select any line in the section, right-
click, and click Edit in Place ➤ Save Changes to save the changes you 
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made, or click Edit in Place ➤ Discard Changes to undo your linework 
changes. 

Merging Linework into a 2D Section
Use this procedure to merge geometry into a 2D section. When you merge 
linework into a section, you assign additional linework to a display compo-
nent of a section. Use this feature to add detail, or to add linework that you 
did not model.

1 Draw the geometry that you want to merge into a 2D section.

2 Select the 2D section to be changed, right-click, and click 
Linework ➤ Merge.

3 Select the geometry to merge into the section, and press ENTER.

4 Select the display component to assign the linework to.

You can also click  (Match existing linework) and select linework in the 
section whose display component you want to match.

5 Click OK.

The linework is merged into the 2D section. When you select the section, 
the linework is selected with it.

Changing the Location of a 2D or 3D Section

You can relocate a section by changing the coordinate values of its insertion 
point. The section also has an orientation with respect to the WCS or the cur-
rent UCS. For example, if the top and bottom of the section are parallel to 
the XY plane, its normal is parallel to the Z axis. You can change the orien-
tation of the section by aligning its normal with another axis. You can also 
rotate the section on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 

online AutoCAD® User’s Guide.

1 Double-click the section you want to move.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information.

4 Specify a new location or rotation:

If you want to . . . Then . . .

relocate the section enter new coordinate values under Insertion Point.



Editing a 2D or 3D Section | 2125

5 Click OK.

Attaching Hyperlinks, Notes, and Files to a 2D or 
3D Section

Use this procedure to add hyperlinks, enter notes, and attach reference files 
to a 2D or 3D section. You can also edit notes and edit or detach reference 
files from a 2D or 3D section.

1 Double-click the 2D or 3D section you want to attach notes or files to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click  next to Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® Com-
mand Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

5 To attach, detach, or edit a reference file, click  next to Reference doc-
uments, and then do any of the following:

locate the section on the 
XY plane

make the normal of the section parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the section on the 
YZ plane

make the normal of the section parallel to the X 
axis: under Normal, enter 1 for X, and enter 0 for Y 
and Z. 

locate the section on the 
XZ plane

make the normal of the section parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
section 

enter a new value for Rotation Angle.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

If you want to . . . Then . . .
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6 Click OK.

Updating a 2D or 3D Section

Use this procedure to update a 2D or 3D section to reflect changes you have 
made to the building model or to section line properties. For 2D sections, you 
also update the section to show changes made to the 2D section style. You 
can update a 2D or 3D section if you have not exploded the section, which 
destroys the link between the section and the building model.

When you update a section, you can add or remove objects from the section, 
change the location of the section in the drawing, and change the display set 
of the section. 

If you do not need to change the section definition in any way, you can skip 
the following procedure. Instead, right-click the section you want to update, 
and click Refresh.

1 Select the section you want to update, right-click, and click Regenerate.

2 Select a result type:

3 To change the style of a 2D section, select a new style for Style to Generate.

4 If you edited linework in the 2D section, select a style in which to save the 
changes you made that cannot be reapplied. Choose a style that will dis-
tinguish the unapplied changes in the section.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If the section is . . . Then . . .

a 2D section object select 2D Section/Elevation Object with Hidden Line 
Removal.

a 3D section object select 3D Section/Elevation Object.

If you want to . . . Then . . .
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5 Under Selection Set, specify the objects that you want to include in the 
section:

NOTE If you select an object that you do not want to include in the section, 
hold down SHIFT, and select the object again to remove it from the selection 
set.

6 Under Display Set, select a display set for the section.

7 Under Placement, locate the section in the drawing:

8 Click OK.

If you want to . . . Then . . .

use the objects in the 
selection set you specified 
when you created the 
section or when you 
previously updated it

proceed to the next step.

add new objects to the 
selection set that you 
specified when you created 
the original section

click Select Additional Objects, select the new 
objects in the drawing, and press ENTER.

select a new selection set 
of objects for the section

click Reselect Objects, select a new selection set of 
objects for the section, and press ENTER.

If you want to . . . Then . . .

create a new section object 
without overwriting the 
original object

select New Object, and either click to specify an 
insertion point in the drawing area, or enter X, Y, 
and Z coordinates for the new section.

replace the original section 
with the updated section

select Replace Existing.
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2D Section Styles

A 2D section/elevation style is a group of properties assigned to a 2D section 
or to an elevation that determines the appearance and other characteristics 
of that object. 

Using 2D Section Styles
A 2D section/elevation style controls the linework in a section, using design 
rules that determine how different parts of the section are displayed. You can 
apply the style to one or more sections to control their appearance. You can 
also change the display of individual lines in the section, and save the 
changes in a 2D section/elevation style.

Display Components and Design Rules
Display components determine the graphical characteristics, such as color 
and linetype, of linework assigned to each display component. Design rules 
determine how the linework in a section is assigned to display components.

When you create a design rule, you specify the part of the 2D section to con-
trol based on the color of those objects in the building model and their con-
text in the section. You then select the display component to use for linework 
that meets the criteria you specified. You can assign the linework to a default 
display component or to a custom display component that you have added 
to the style. For example, you might define a rule that assigns all objects that 
are color 150 in the model and that are located along the section line (the 
defining line) to a custom display component named Darker that you created 
in the style. Or you might hide a staircase behind a wall using a rule that 
assigns all blue linework to the Hidden display component.

Managing 2D Section Styles
To create, edit, copy, or purge styles, you access the Style Manager. The Style 

Manager provides a central location in Autodesk® Architectural Desktop 
where you can work with styles from multiple drawings and templates. For 
more information about using the Style Manager, see “Style Manager.”

Materials and 2D Section Styles
You can use 2D section styles to specify which section components will have 
their display controlled by materials and which will not. Custom compo-
nents cannot use materials.

Subdivisions in 2D Section Styles and Materials
When you are creating subdivisions in your style, you usually want the 
objects in them to be visually distinct from other subdivisions. When you 
assign materials to the objects, you can set the 2D section style so that it uses 
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the hatch pattern from the material, but the color and linetype from the sub-
division display properties. 

Section subdivison surface hatching with color assignments

Related Procedures

� Creating a 2D Section Style

� Adding a Display Component to a 2D Section Style

� Removing a Display Component from a 2D Section Style

� About 2D and 3D Section Display Components and Materials

� Use Subdivision Properties and Materials in 2D Section Styles

� Use the 3D Body Component of a Material for the 2D Section Linework

� Adding a Design Rule to a 2D Section Style

� Changing a Design Rule in a 2D Section Style

� Removing a Design Rule from a 2D Section Style

� Adding Classifications to a 2D Section Style

� Changing the Layer, Color, and Linetype of a 2D Section Style

� Attaching Notes and Files to a 2D Section Style
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Creating a 2D Section Style

Use this procedure to create a 2D section style. You can create a style using 
default style properties or by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand 2D Section/Elevation Styles.

3 Create a 2D section style:

4 Enter a name for the new 2D section style, and press ENTER.

5 To edit the 2D section style, right-click the style, and click Edit:

If you want to . . . Then . . .

create a style using default 
properties

right-click 2D Section/Elevation Styles, and click 
New.

create a style from an 
existing style

right-click the 2D section style you want to copy, 
and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

add display components to 
the style

see “Adding a Display Component to a 2D Section 
Style” on page 2131.

remove display 
components from the 
style,

see “Removing a Display Component from a 2D 
Section Style” on page 2132.

use the subdivision 
properties of the section 
for the display,

see “Use Subdivision Properties and Materials in 2D 
Section Styles” on page 2139.

use the 3D Body 
component of the material 
for the section linework,

see “Use the 3D Body Component of a Material for 
the 2D Section Linework” on page 2140.

add design rules to the 
style

see “Adding a Design Rule to a 2D Section Style” on 
page 2141.

change design rules in the 
style

see “Changing a Design Rule in a 2D Section Style” 
on page 2142.
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6 Click OK.

Adding a Display Component to a 2D Section 
Style

Use this procedure to add a custom display component to a 2D section style. 
After you add a component, you assign linework in the section to the new 
component. To apply these style changes to existing 2D sections, you must 
update the section.

2D sections include the following default display components: Defining 
Line, Hidden, Erased, Unknown, and Subdivision.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Components tab.

3 Click Add.

4 Enter a name and a description for the new component.

To enter a name, click Unnamed and enter a new name. To enter a descrip-
tion, click in the Description column next to the name, and enter a 
description.

5 Click the Display Properties tab.

6 Select the display representation in which to display the changes, and 
select Style Override.

7 If necessary, click .

8 Click the Layer/Color/Linetype tab.

9 Specify the display properties of the new component.

10 Click OK twice.

add classifications to a style see “Adding Classifications to a 2D Section Style” 
on page 2143.

change the display 
properties of the display 
components in the style

see “Changing the Layer, Color, and Linetype of a 
2D Section Style” on page 2143.

add notes, files, or 
documents to the style

see “Attaching Notes and Files to a 2D Section 
Style” on page 2144.

If you want to . . . Then . . .
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To create a design rule that uses the new display component, see “Adding 
a Design Rule to a 2D Section Style” on page 2141. To manually assign lin-
ework to the display component, see “Editing Linework in a 2D Section” 
on page 2123.

Removing a Display Component from a 2D 
Section Style

Use this procedure to remove a custom display component from a 2D section 
style. Removing a display component also removes any design rules that use 
the component. You cannot remove the default display components.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Components tab.

3 Select the component that you want to remove, and click Remove. 

If the component is used in a design rule, a dialog box is displayed, warn-
ing you that the associated design rule is removed as well. 

4 Click OK.

5 Update the section to apply the style changes to the section.

For more information, see “Updating a 2D or 3D Section” on page 2126.

About 2D and 3D Section Display Components 
and Materials

2D and 3D section object consist of a number of display components which 
can be determined by materials. 

When you assign materials to an object, you assign one material to each dis-
play component of a object. For example, you assign a wood material to the 
frame of window and a glass component to the glass of a window. 

When you create a 2D or 3D section object from building objects, the mate-
rial assignments of the source objects are applied to the section. You do not 
assign a material directly to a 2D/3D section. The section takes its material 
assignments from the objects sectioned. For example if you create a section 
through a wall with a window, the section hatch you have defined in the 
glass, wood, and brick materials of the wall and the window are displayed in 
the section. 
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If you do not want to use the material display properties, but instead use 
those of the 2D or 3D section object, or the 2D section style, you can deacti-
vate the material assignments in the display properties of the section or the 
section style.

Material Component Assignments
Material definitions consist of display components which correspond to 
component types of objects. For example, the Linework component of a 
material is used for all linework of objects in Plan view. The Surface Hatch 
component of a material is used to hatch all object surfaces in 3D model 
views and elevations. 

For a complete list of material components and their description, see “Mate-
rial Components and Display Properties” on page 498.

The following table lists all section components plus information about the 
material components that determine them. 



2134 | Chapter 28 Sections

NOTE Keep in mind that materials are not assigned directly to 2D section 
objects, but that the assignment of materials happens indirectly via the sec-
tioned objects. For example, if a brick material has a surface hatch component 
with a red brick pattern, this surface hatch determines the display of the surface 
hatch in a brick wall. When you create a 2D section from that wall, the resulting 
section object will inherit the red brick pattern from the wall. When you change 
the material of the wall from brick to concrete, and then update the 2D section, 
it will now display with a grey concrete pattern.

Related Topics

� Defining Line

� Shrinkwrap

� Shrinkwrap Hatch

� Surface Hatch Linework

� Section Hatch Linework

� Hidden Component

2D Section 
Component

Material Component

Defining Line 2D Section/Elevation Linework or 3D Body. For 
information on switching between these material 
components, see “Use the 3D Body Component of a 
Material for the 2D Section Linework” on page 2140.

Outer Shrinkwrap No Material

Inner Shrinkwrap No Material

Shrinkwrap Hatch No Material

Surface Hatch Linework Surface Hatch

Section Hatch Linework Section Hatch

Hidden No Material

Erased No Material

Subdivision 1-10 2D Section/Elevation Linework or 3D Body. For 
information on switching between these material 
components, see “Use the 3D Body Component of a 
Material for the 2D Section Linework” on page 2140.
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� Erased Component

� Subdivision Components

Defining Line
The defining line determines where the section cuts the objects it contains. 
The material component which controls the display of the Defining Line is 
the Linework component. The defining line is a display component of both 
2D and 3D section objects.

For example, if you cut a brick wall that contains a window, you can specify 
one uniform color for the defining line, or use different colors where the sec-
tion line cuts the wall and where it cuts the window. If you want to use a uni-
form color for the Defining Line component, assign a color to it and do not 
use the properties of the material. If you want the color of the defining line 
to be influenced by the objects in the section, use the material properties. In 
the case of a section through a brick wall with a window, you might use a red 
defining line where the wall is cut and a blue defining line where the window 
is cut. 

Specifying cut line colors for different materials

Shrinkwrap
The shrinkwrap displays the union of all object faces cut by the section line. 
The Outer Shrinkwrap component represents the outline of solid, filled com-
ponents, such as a wall shrinkwrap. The Inner Shrinkwrap component repre-
sents the outline of holes which have been cut, such as a space. These com-
ponents are specific to 2D sections.

You can exclude individual objects from contributing to the shrinkwrap. For 
example, you might do this for glass components in windows. For informa-
tion on excluding objects from the 2D shrinkwrap, see “Excluding a Material 
from 2D Section Shrinkwrap” on page 528.
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2D section with red outer shrinkwrap

Window glass excluded from shrinkwrap

The Outer and Inner Shrinkwrap components cannot be defined by a mate-
rial component.

Shrinkwrap Hatch
The Shrinkwrap Hatch component hatches the union of all object faces cut 
by a section line. The Shrinkwrap Hatch is defined by either an outer or an 
inner shrinkwrap line component. This component is specific to 2D sections.

Shrinkwrap Hatch with glass excluded from shrinkwrap detail

The Shrinkwrap Hatch component cannot be defined by a material compo-
nent. 
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NOTE The Shrinkwrap Hatch and Section Hatch components overlap each 
other. This could result in two different hatches in the same location. To avoid a 
conflict, either assign a solid hatch for Shrinkwrap Hatch, or do not use the 
Shrinkwrap and Section Hatch components simultaneously.

Surface Hatch Linework
The Surface Hatch Linework component draws all linework coming from sur-
face hatches of the objects cut. Surface hatches appear in faces of the section 
object that are not cut by the section line. This component is specific to 2D 
sections.

NOTE Surface hatches that you have assigned to objects will display in a 3D 
section object. However, you cannot set them separately in a 3D section; you can 
do that only in a 2D section object.

The surface hatch linework component is controlled by the surface hatch 
component of the material. For information about the surface hatch compo-
nent of the material, see “Surface Hatch Material Component” on page 500.

2D section with roof surface hatch

Section Hatch Linework
The Section Hatch Linework component draws all linework coming from sec-
tion hatches. Section hatches appear on all faces that are cut by the section 
line. A section hatch is similar to a shrinkwrap hatch. The difference is that 
in a section hatch the sectioned faces are not merged into one shrinkwrap 
component. Use either a section hatch or a shrinkwrap hatch on a 2D sec-
tion. For information on shrinkwrap hatches see “Shrinkwrap Hatch” on 
page 2136.

The Section Hatch Linework display component is specific to 2D section.
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Section hatches on walls, roof and door

The Section Hatch Linework component is controlled by the Section Hatch 
component of the material. For information about the Section Hatch com-
ponent of the material, see “Section Hatch Material Component” on 
page 502.

Hidden Component
The Hidden component contains all linework that is hidden in the 2D pro-
jection because other components are in front of it. By default, this compo-
nent is turned off. You can use design rules to achieve special effects, such as 
a see-through effect, using the Hidden component. The Hidden component 
is specific to 2D sections.

The Hidden component cannot be defined by a material component. You 
can only set it in the display properties of the 2D section. For information on 
setting the display properties of a 2D section, see “Changing the Layer, Color, 
and Linetype of a 2D Section Style” on page 2143.

Erased Component
The Erased component contains linework in the section object that you do 
not want to see. For example, if you have a section of a multi-story building 
in which you want to hide the lines between each floor, you can edit the lin-
ework of the section and assign the floor lines to the Erased component. 
Since the Erased component is turned off by default, the floor lines do not 
display. For information on linework editing of a section, see “Editing Line-
work in a 2D Section” on page 2123.

The Erased component is specific to 2D sections.

The Erased component cannot be defined by a material component. 

Subdivision Components
The subdivision components partition a section object. They are useful to 
create perspective effects, where parts closer to the viewer are drawn with 
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darker, stronger lines and parts which are farther from the user are drawn 
with lighter, thinner lines. Subdivisions can have no individual material 
assignments. However the display properties of the subdivisions can be used 
for the surface hatching of the subdivisions by selecting “Use Subdivision 
Properties for Surface Hatching” in the Other tab of the 2D section display 
properties. For information on using the subdivision display properties to 
display the section divisions, see “Use Subdivision Properties and Materials 
in 2D Section Styles” on page 2139.

Subdivisions are a display component of both 2D and 3D section objects.

The subdivision components are either controlled by the 2D Section/Eleva-
tion Linework component of the material or by the 3D Body component of 
a material. For information how to switch between these component assign-
ments, see “Use the 3D Body Component of a Material for the 2D Section 
Linework” on page 2140.

Use Subdivision Properties and Materials in 2D 
Section Styles

Use this procedure to use the display properties of materials together with the 
display properties of section subdivisions.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Display Properties tab.

3 Select the display representation in which to display the changes, and 
select Style Override.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 To set a subdivision to use the surface hatch of the material, while using 
the layer, color, and linetype display properties of the subdivision, per-
form the following steps:

� Clear By Material. 
� Specify the layer, color and linetype settings of the subdivision as 

desired. For example, the first subdivision could have a darker color 
and stronger linetype the second subdivision. 

7 Click the Other tab.

8 Select Use Subdivison properties for surface hatching.

9 Click OK twice.
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For more information, see “Updating a 2D or 3D Section” on page 2126.

Use the 3D Body Component of a Material for 
the 2D Section Linework

Use this procedure to use the 3D Body component of a material for the line-
work in a 2D section.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Display Properties tab.

3 Select the display representation in which to display the changes, and 
select Style Override.

4 If necessary, click .

5 Click the Other tab.

6 Determine if the 3D body component of the selected material should con-
trol the display of the linework in the 2D section:

7 Click OK twice. 

For more information, see “Updating a 2D or 3D Section” on page 2126.

If you want to . . . Then . . .

control the display of the 2D 
section linework by the 3D Body 
component of the material,

select Use 3D Body display component 
for By Material linework.

control the display of the 2D 
section linework by the 2D Section/
Elevation Linework component of 
the material, 

clear Use 3D Body display component 
for By Material linework. This is the 
default behavior.
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Adding a Design Rule to a 2D Section Style

Use this procedure to add a design rule to a 2D section style. A design rule 
has four fields of information that identify lines in the section and determine 
how to display them:

For example, a design rule has the color 50, a context of Within Subdivision 
2, and a component of New. This rule assigns any lines in the section repre-
senting objects that have the color 50 in the building model and that are 
within subdivision 2 in the section to the user-defined display component, 
New.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Design Rules tab, and click Add.

A new design rule is created with default color, context, and component 
values.

3 Specify settings for the new design rule:

Field Description

Color Identifies the color of the objects in the building model 
represented by lines in the section.

Context Identifies the context of the lines in the 2D section, such as on 
the defining line (the cutting plane) or in a graphic 
subdivision.

Component Identifies the display component to which the lines are 
assigned.

Description Contains a description of the design rule.

If you want to . . . Then . . .

specify the color of 
objects in the building 
model that are affected 
by this rule

click the default color, select a new color, and click 
OK.

specify the context in 
which the linework for 
the objects appears in the 
section

click the default context, and select a new context.
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4 Click OK.

5 Update the section to apply the style changes to the section.

For more information, see “Updating a 2D or 3D Section” on page 2126.

Changing a Design Rule in a 2D Section Style

Use this procedure to change the settings in the fields that define a design 
rule.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Design Rules tab.

3 Specify settings for the design rule you want to change:

4 Click OK.

5 Update the section to apply the style changes to the section.

select the display 
component for the 
linework 

click the default component, and select a new 
component.

enter a description of the 
rule

click the Description field, enter a description, and 
press ENTER.

If you want to . . . Then . . .

specify the color of 
objects in the building 
model that are affected 
by this rule

click the current color, select a new color, and click 
OK.

specify the context in 
which the linework for 
the objects appears in the 
section

click the current context, and select a new context.

select the display 
component for the 
linework 

click the current component, and select a new 
component.

edit the description of the 
rule

click the description, edit the description, and press 
ENTER.

If you want to . . . Then . . .
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For more information, see “Updating a 2D or 3D Section” on page 2126.

Removing a Design Rule from a 2D Section Style

Use this procedure to remove a design rule from a 2D section style. 

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Design Rules tab.

3 Select the rule that you want to remove, and click Remove.

4 Click OK.

5 Update the section to apply the style changes to the section.

For more information, see “Updating a 2D or 3D Section” on page 2126.

Adding Classifications to a 2D Section Style

Use this procedure to specify classifications for any classification definition 
applied to a 2D section style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to 2D sec-
tion styles.

3 For each classification definition, select the classification you want to 
apply to the current 2D section style.

4 Click OK twice.

Changing the Layer, Color, and Linetype of a 2D 
Section Style

Use this procedure to change the following display properties of a 2D section 
style: 

� Visibility (component is on or off)
� Display properties by materials
� Layer
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� Color
� Linetype
� Lineweight
� Linetype scale

NOTE The custom display components in the display properties are identical 
to those listed on the Components tab of the 2D Section/Elevation Styles dialog 
box. For more information about custom display components, see “Adding a 
Display Component to a 2D Section Style” on page 2131.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the Display Properties tab.

3 Select the display representation in which to display the changes, and 
select Style Override.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Select By Material for any component that you want to use the display 
properties of the materials assigned to the sectioned objects.

NOTE Not all display components of a 2D section have an associated mate-
rial definition. For example, Hidden and Erased cannot be set by material. For 
a list of all display components and their associated material components, see 
“About 2D and 3D Section Display Components and Materials” on 
page 2132.

8 Click OK twice.

Attaching Notes and Files to a 2D Section Style

Use this procedure to enter notes and attach reference files to a 2D section 
style. You can also edit reference files attached to the style.

1 Select a section that has the style you want to change, right-click, and click 
Edit 2D Section/Elevation Style.

2 Click the General tab.
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3 To add a description to the 2D section, enter the description under 
Description.

4 Click Notes.

5 To add or edit a note, click the Notes tab, and enter the note.

6 To attach, edit, or detach a reference file, click the Reference Docs tab:

7 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are done editing.

detach a reference file select the file name, click Delete, and click OK.
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Elevations

You can create elevations of the building models in your 

drawings by first drawing an elevation line and mark, 

and then creating a 2D or 3D elevation based on that 

line. You can control the size and shape of any elevation 

that you create, and you can update an existing eleva-

tion when the objects included in the elevation are 

modified. 2D elevations are created with hidden and 

overlapping lines removed. You can control the appear-

ance of 2D elevations by applying rules that are con-

trolled by the style and display properties of the 

2D elevation. 

In this chapter

� Process Overview: Creating a 
2D or 3D Elevation

� Drawing and Editing Elevation 
Lines

� Creating a 2D or 3D Elevation

� Editing a 2D or 3D Elevation

� Updating a 2D or 3D Elevation

� 2D Elevation Styles

29
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Elevation Line and Marks
The elevation line defines the extents of the elevation view of your building 
model. Elevation lines can be straight or jogged. You can also specify the 
length and the height of the area defined by the elevation line. Elevation 
marks, which typically contain a letter or number and indicate the direction 
of the elevation, appear at each end of the elevation line.

After you draw the elevation line, you create an elevation object from the 
line.

Viewing the elevation line and mark

2D Elevations
2D elevations are created by drawing an elevation line in front of a number 
of objects and then creating a 2D elevation object from them. The elevation 
object is drawn without hidden and overlapping lines. You can edit a 2D ele-
vation by changing its object display properties or its style display properties. 
The 2D elevation style lets you add display components to the display repre-
sentation of the elevation and create rules that assign different parts of the 
elevation to different display components. You can control the visibility, 
layer, color, linetype, lineweight, and linetype scale of each component. You 
can also assign a material, such as a brick or concrete hatch, to individual 
components of the object or the style. Furthermore, you can use linework 
editing commands to assign individual lines in a 2D elevation to different 
display components, and merge geometry into a 2D elevation. You can 
dimension 2D elevations.
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2D building elevation

3D Elevations
3D elevations are created by drawing an elevation line in front of a number 
of objects and then creating a 3D isometric elevation object from them. 3D 
elevations do not use styles. However, you can control the display of subdi-
visions within 3D elevations. Using the Hidden Line Projection command, 
you can create 2D hidden line projections of any view of the 3D elevation 
that you can explode and edit or hatch. For more information about using 
this command, see “Creating a Hidden Line Projection” on page 2540.

3D elevation in 3D view

Elevation Subdivisions
A 2D or 3D elevation object can have a number of subdivisions partitioning 
the elevation object. This feature is useful when you want to create a perspec-
tive view of the object, in which the parts that are closer to the viewer are 
drawn with darker and stronger lines, and parts that are farther off are drawn 
lighter. 
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3D elevation with subdivisions in perspective view

Live Section View 
A live section view is a special view of a 3D section where the objects that are 
sectioned are not converted to a 3D section object, but remain in the drawing 
as objects. The parts of the objects within the bounding box of the section 
line keep their individual display components while the parts of the objects 
outside of the section line can be displayed or hidden. To control the appear-
ance of the object parts outside of the section line, you need to assign a mate-
rial to the sectioned objects. 

When you render a live section, you can show the outside part as a half-trans-
parent addition, for example. 

You can use the live section view in an elevation in order to clip out just the 
region you need momentarily and to focus on that specific area. This can 
accelerate performance and make working with the building model easier.

For information on creating live section views, see “Creating a Live Section 
View” on page 2111.
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Rendered live section view with transparent body component

Materials in Elevations
In Autodesk Architectural Desktop, you can assign materials to different 
components of an object. These materials are displayed when you create a 2D 
or 3D elevation object. You can specify whether to use the display properties 
of the materials or the display properties of the elevation object.
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2D elevation with different surface hatches

Autodesk Architectural Desktop provides a large number of predefined mate-
rials for all common design purposes. You can use these predefined materials 
or modify them to your special designs. You can also create your own mate-
rials. For more information, see “About 2D and 3D Elevation Display Com-
ponents and Materials” on page 2186.

Subdivisions in 2D Elevation Styles and Materials
When you are creating subdivisions in your style, you usually want the 
objects in them to be visually distinct from other subdivisions. When you 
have assigned materials to the objects, you can set the 2D elevation style so 
that it uses the hatch pattern from the material, but uses the color and line-
type from the subdivision display properties. 
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Elevation subdivisions with assigned surface hatching

For more information see “Use Subdivision Properties and Materials in 2D 
Elevation Styles” on page 2190.

Material Boundaries in 2D Elevations
Material boundaries allow you to erase or limit portions of a 2D elevation:

� Limit the amount of hatching to produce cleaner CDs.
� Highlight a region in an elevation.

� Mask out a portion of an elevation so that more detail can be drawn.
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� Crop an irregular-shaped portion of an elevation.

For more information, see “Creating a Material Boundary in a 2D Elevation” 
on page 2173.

Related Topics and Procedures

� Process Overview: Creating a 2D or 3D Elevation

� Drawing and Editing Elevation Lines

� Creating a 2D or 3D Elevation

� Editing a 2D or 3D Elevation

� Updating a 2D or 3D Elevation

� 2D Elevation Styles

Process Overview: Creating a 2D or 3D 
Elevation

Creating a 2D or 3D elevation from a building model involves the following 
steps:
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Step 1: Draw an elevation line and mark.

The elevation line defines the extents of the elevation (its width, height, 
and length) that you extract from the building model. The elevation line 
also determines other characteristics of the elevation. For example, you 
can define graphic subdivisions to add levels of depth to the elevation 
object created from the elevation line.

An elevation line with graphic subdivisions

Step 2: Create a 2D or 3D elevation.

You select the elevation line, right-click, and click Generate Elevation to 
create a 2D or 3D elevation object. At this time, you select the objects to 
include in the elevation. You also select the display representation for the 
elevation and the insertion point of the elevation in the drawing. If you 
create a 2D elevation, you also select a 2D elevation style, which deter-
mines the visual characteristics of the elevation.

2D elevation created from the elevation line shown above

Step 3: Edit the elevation or the building model.
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You can edit the elevation line and the elevation object to refine the 
appearance of the elevation:

� Edit the elevation line to change the area defined by the elevation and 
to add, remove, or modify graphic subdivisions.

� Edit the 2D elevation style, which determines how the linework in a 2D 
elevation is displayed.

� Edit existing material assignments, like hatch patterns. 
� Edit a 2D elevation object to change the display of selected linework or 

to add linework and detail that are not part of the building model.

You can continue to modify the building model as needed.

Step 4: Update the elevation.

You update an elevation to apply changes you made to the elevation line, 
the elevation object (including style changes to a 2D elevation), and the 
building model. When you update an elevation, you can also make any of 
the following changes:

� Select a different style for a 2D elevation.
� Select different objects to include and exclude from the elevation.
� Select a different display representation.
� Replace the existing elevation or add a new elevation showing the 

changes you made.

You can also refresh one or more elevations to quickly apply changes you 
made to the elevation line, the elevation object, or the model.
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Refreshing a 2D elevation after changes to the building model

Related Topics and Procedures

� Drawing and Editing Elevation Lines

� Creating a 2D or 3D Elevation

� Editing a 2D or 3D Elevation

� Updating a 2D or 3D Elevation

Drawing and Editing Elevation Lines

The first step in creating elevations is to draw an elevation line relative to 
your building model. The elevation line defines the extents of the elevation 
view of the building model.
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Creating an Elevation Object from an Elevation Line
When you generate an elevation from an elevation line, you specify the type 
of elevation object that is created.

Viewing the Elevation Line 
In plan view, the elevation line is displayed as you would expect on a 
construction document. 

Viewing the elevation line and mark in plan view

In an isometric view, the same elevation line is displayed with a boundary 
that defines the depth of elevation view.

When you create . . . The result is . . .

a 2D elevation object an orthographic projection from the building 
model.

a 3D elevation object the area of the building model defined in the 
elevation line.
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Drawing an elevation line in 3D view

Resulting elevation line in 3D view
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Changing the Elevation Line 
You can change the elevation line to control the elevation that you create. 
Within the elevation line, you can change the height and shape of the eleva-
tion. You can also add a lower extension to the elevation and create elevation 
subdivisions.

You can change elevation line properties before you create an elevation. You 
can also change elevation line properties and update an elevation that you 
have already created. For more information about updating existing eleva-
tions, see “Updating a 2D or 3D Elevation” on page 2180.

Using Subdivisions in Elevations
You can set up graphic subdivisions in elevation line properties. These subdi-
visions are then added to the 2D or 3D elevation you create. Subdivisions are 
specified at distances from the elevation line. You can control the lineweight 
and other display properties of subdivisions to add levels of depth to eleva-
tions. For example, you can display one subdivision with a heavy lineweight 
and another subdivision with a lighter lineweight to suggest that the first 
subdivision is in front of the second subdivision.

Related Procedures

� Drawing an Elevation Line and Mark

� Changing the Dimensions of an Elevation

� Creating Graphic Subdivisions for 2D and 3D Elevations

� Changing Elevation Mark Attributes

� Changing the Location of an Elevation Line

� Attaching Hyperlinks, Notes and Files to an Elevation Line

Drawing an Elevation Line and Mark

Use this procedure to draw an elevation line with an elevation mark at each 
end. You draw an elevation line by specifying a start point and an endpoint 
for the line in relation to your building model.

NOTE If you are working with a drawing set in which several xrefs are linked 
to a main drawing, draw your elevation line in the main drawing.

1 On the default tool palette set, click the Design tab, and then click the Ele-
vation Line Object tool.

If necessary, scroll the palette to display the tool that you need.

2 Specify the elevation line start point.
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NOTE Specify a start and endpoint for the elevation line that extends past 
the face or segment of your building model view to ensure that all objects are 
included in the elevation view.

3 Specify the elevation line endpoint.

The elevation line is displayed in your drawing with an elevation mark. 
The elevation line boundary is automatically drawn, using the elevation 
line as its left side and forming a box with the elevation line. This is the 
area that defines the elevation.

Drawing an elevation line in 3D view
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Depending on the direction in which you drew the elevation line, the ele-
vation mark points in the direction of the elevation view.

The elevation mark is a multi-view block, anchored to the elevation line. You 
can edit the elevation mark to change the information that is displayed in 
the bubble. For more information, see “Changing Elevation Mark Attributes” 
on page 2165.

Once you have an elevation line in your drawing, you can change the prop-
erties of the line to change the elevation. For more information, see “Chang-
ing the Dimensions of an Elevation” on page 2162.

Changing the Dimensions of an Elevation

Use this procedure to change the height and length of any elevation con-
nected to the elevation line, or to add a lower extension to the elevation line. 
You can change the dimensions of the elevation line before or after you cre-
ate a connected elevation. If you change the dimensions after creating the 
elevation, you need to update the elevation to show the changes.

The depth of an elevation (its length) can also be defined using grips to edit 
the elevation line boundary in the drawing.

1 Double-click the elevation line you want to change.

2 On the Properties palette, expand Basic, and expand Dimensions.
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3 Specify new dimensions:

4 Expand Component dimensions.

5 Specify the length of the lines that define the depth of the elevation by 
entering values for Side 1 and Side 2.

Side 1 starts from the first point specified for the elevation line. Side 2 
starts from the endpoint of the elevation line.

Specifying elevation height, lower extension, and side parameters

6 Specify values for Angle 1 and Angle 2. 

If you want to . . . Then . . .

use the height of the 
objects in the elevation to 
define the elevation height

select Yes for Use Model Extents for Height.

define the height of the 
box to create an elevation 
from a Z value measured 
from the XY plane of the 
world coordinate system 
(WCS) or the current user 
coordinate system (UCS)

select No for Use Model Extents for Height, and 
enter a value for Height. 
The objects are cut at this height when you create 
or update a elevation.

define the lower limit of 
the elevation box as a Z 
value measured from the 
XY plane of the WCS or the 
current UCS

select No for Use Model Extents for Height, and 
enter a value for Lower Extension. 
By default, the lower elevation is 1 foot below the 
XY plane unless Use Model Extents for Height is 
selected.
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These values define the angles of the two sides from the elevation line to 
create the elevation box. The apex of Angle 1 is the start point of the ele-
vation line. The apex of Angle 2 is the endpoint of the elevation line. Val-
ues for these angles must be between 0 and 90 degrees.

Specifying elevation angle parameters

To update an elevation created from this elevation line, see “Updating a 2D 
or 3D Elevation” on page 2180.

Creating Graphic Subdivisions for 2D and 3D 
Elevations

Use this procedure to define subdivisions that are created within the eleva-
tion when you generate it. Each subdivision is specified as a distance from 
elevation line.

You can view the location of a subdivision by viewing the elevation line with 
its boundary in an isometric view. In this view, you can use grips to relocate 
a subdivision.

You can control the lineweight and other display properties of the subdivi-
sions to add different levels of depth to elevation.

1 Double-click the elevation line you want to change.

2 On the Properties palette, expand Basic, and expand Dimensions.
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3 Click the setting for Subdivisions, and then add or modify subdivisions:

4 Click OK. 

Changing Elevation Mark Attributes

Use this procedure to change the information displayed in the elevation 
mark. The elevation mark is a multi-view block.

1 Double-click the elevation mark you want to change.

2 On the Properties palette, expand Advanced.

3 Click Attributes.

4 Select the existing attribute under Value, and enter the new information 
to include in the bubble.

5 Click OK.

Changing the Location of an Elevation Line

Use this procedure to relocate an elevation line by changing the coordinate 
values of its insertion point. The elevation line also has an orientation with 
respect to the WCS or the current UCS. For example, if the top and bottom 
of the elevation line are parallel to the XY plane, its normal is parallel to the 
Z axis. You can change the orientation of the elevation line by aligning its 
normal with another axis. You can also rotate the elevation line on its plane 
by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD User’s Guide.

If you want to . . . Then . . .

create a subdivision
click .

To change the default distance from the elevation 
line, select the subdivision, click the value, and enter 
a new value.

change the length of a 
subdivision

select the subdivision, click its value, and enter a 
new value.

delete a subdivision
select the subdivision, and click .



2166 | Chapter 29 Elevations

1 Double-click the elevation line you want to relocate.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional Information.

4 Specify the location of the elevation line:

5 Click OK.

To update an existing elevation created from this elevation line, see “Updat-
ing a 2D or 3D Elevation” on page 2180.

Attaching Hyperlinks, Notes and Files to an 
Elevation Line

Use this procedure to add hyperlinks, enter notes and attach reference files 
to an elevation line. You can also edit notes and edit or detach reference files 
from an elevation line.

1 Double-click the elevation line you want to attach notes or files to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD Com-
mand Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

If you want to . . . Then . . .

relocate the elevation line enter new coordinate values under Insertion Point.

locate the elevation line on 
the XY plane

make the normal of the elevation line parallel to the 
Z axis: under Normal, enter 1 for Z, and enter 0 for 
X and Y. 

locate the elevation line on 
the YZ plane

make the normal of the elevation line parallel to the 
X axis: under Normal, enter 1 for X, and enter 0 for 
Y and Z. 

locate the elevation line on 
the XZ plane

make the normal of the elevation line parallel to the 
Y axis: under Normal, enter 1 for Y, and enter 0 for 
X and Z.

change the rotation of the 
elevation line

enter a new value for Rotation Angle.
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5 Click  next to Reference documents, and then attach, detach, or edit a 
reference file:

6 Click OK.

Creating a 2D or 3D Elevation

Use this procedure to create a 2D or 3D elevation. After you draw an eleva-
tion line, you extract an elevation from the elevation line and the objects you 
select in the building model.

When you create a 2D elevation, the object that is created is a 2D Section/
Elevation object. Both 2D sections and elevations share the same object type 
and style.

TIP Before you create an elevation, thaw and turn on all layers of objects in the 
building model that you want to include in the elevation. Objects on layers that 
are off or frozen cannot be part of the selection set for the elevation. To speed 
performance, turn off the layers of the objects that you do not need to include 
in the elevation.

1 Draw an elevation line in the drawing. 

For more information, see “Drawing an Elevation Line and Mark” on 
page 2160.

2 Select the elevation line, right-click, and click Generate Elevation.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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3 Select the type of elevation object you want to create:

4 For Style to Generate, select a style for a 2D elevation. 

If you want to use a particular style, select it from Style to Generate. Oth-
erwise, use the Standard style. For more information, see “2D Elevation 
Styles” on page 2182.

3D elevations do not use styles.

5 Under Selection Set, click  (Select Objects), select the objects that you 
want to include in the elevation, and press ENTER.

NOTE If you select an object that you do not want to include in the eleva-
tion, press and hold SHIFT and select the object again to remove it from the 
selection set.

6 Under Display Set, select a display set for the elevation object.

The display set controls the representation of the elevation.

7 Under Placement, select New Object, and specify where to place the ele-
vation:

8 Click OK.

A 2D or 3D elevation is created from the elevation line properties and the 
selected objects in the building model. The elevation is linked to the 

If you want to create . . . Then . . .

a 2D elevation select 2D Section/Elevation Object with 
Hidden Line Removal.

a 3D elevation select 3D Section/Elevation Object.

If you want to . . . Then . . .

specify a location 
graphically click  (Pick Point), and specify the location for 

the new elevation object in the drawing.

specify the coordinates of 
the insertion point for the 
elevation

enter X, Y, and Z coordinates for the location of the 
new elevation object.
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building model. If you make changes to the building model after you cre-
ate the elevation, you can update the elevation to reflect the changes. For 
more information, see “Updating a 2D or 3D Elevation” on page 2180.

You can edit certain characteristics of the elevation to control its placement 
and appearance. For more information, see “Editing a 2D or 3D Elevation” 
on page 2169.

You can also use a 2D section/elevation style to control the display of selected 
objects in a 2D elevation, and you can control the display of individual lines 
in a 2D elevation. For more information, see “2D Elevation Styles” on 
page 2182 and “Editing and Merging Linework in a 2D Elevation” on 
page 2177.

Editing a 2D or 3D Elevation

After you create an elevation, you can edit the elevation line and the eleva-
tion object to refine the appearance of the elevation:

� Edit the elevation line to add, remove, or modify graphic subdivisions.
� Display a different area of the building model by reversing the elevation.
� Place the elevation in a different location in the drawing.
� Add notes or reference files to the elevation.
� Select a different style for 2D elevations. An elevation style determines 

how the linework in a 2D elevation is displayed.
� Edit a 2D elevation object to change the display properties of selected lin-

ework or to add linework and details that are not part of the building 
model.

In addition, you can continue to modify the building model and then update 
the elevation to incorporate the changes.

Related Topics and Procedures

� Changing the Display of Graphic Subdivisions in a 2D Elevation

� Changing the Display of Graphic Subdivisions in a 3D Elevation

� Reversing a 2D or 3D Elevation

� Changing the Style of a 2D Elevation

� Creating a Material Boundary in a 2D Elevation

� Editing a Material Boundary

� Editing and Merging Linework in a 2D Elevation

� Changing the Location of a 2D or 3D Elevation
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� Attaching Hyperlinks, Notes, and Files to a 2D or 3D Elevation

Changing the Display of Graphic Subdivisions in a 
2D Elevation

Use this procedure to change the display of subdivisions in a 2D elevation by 
changing its display properties. 

You create subdivisions by adding them to the elevation line. You can then 
change their length using grips or by editing the values in the elevation line 
properties. For more information, see “Creating Graphic Subdivisions for 2D 
and 3D Elevations” on page 2164.

Each subdivision in a 2D elevation is assigned to a numbered subdivision dis-
play component in the display properties of the elevation or the 2D elevation 
style. You can control the visibility, layer, color, linetype, lineweight, and 
linetype scale of each subdivision by changing the display properties of each 
component. You can apply these changes to the selected elevation, to the 
current 2D section/elevation style, or to all 2D sections and elevations in the 
drawing that do not have a style override.

You can use the display properties of a subdivision together with the display 
properties of a material. For more information, see “Use Subdivision Proper-
ties and Materials in 2D Elevation Styles” on page 2190.

1 Select the 2D elevation in the drawing, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the property source to edit:

If you want to edit 
graphic subdivisions . . .

Then . . .

for all 2D sections and 
elevations in the current 
drawing (except those that 
have a 2D Section/Elevation 
Style override)

select Drawing Default.

for all 2D sections and 
elevations that use the current 
style

select 2D Section/Elevation Style, and click 
Object Override.

for the selected 2D elevation Select 2D Section/Elevation, and click Object 
Override.
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4 If necessary, click .

5 Click the Layer/Color/Linetype tab to list all the components that contrib-
ute to the display of the object. 

6 Turn the visibility on or off, and change the layer, color, linetype, line-
weight, or linetype scale as needed for each subdivision component. 

7 Click the Other tab to add a custom display component to the display of 
the 2D elevation. 

For more information about adding custom display components, see 
“Adding a Display Component to a 2D Elevation Style” on page 2185.

8 Click OK twice.

Changing the Display of Graphic Subdivisions in a 
3D Elevation

Use this procedure to change the display of subdivisions in a 3D elevation by 
changing its display properties. 

You create the subdivisions by adding them to the elevation line. You can 
then change their length using grips or by editing the values in the elevation 
line properties. For more information, see “Creating Graphic Subdivisions for 
2D and 3D Elevations” on page 2164.

Each subdivision in a 3D elevation is assigned to a numbered subdivision dis-
play component in the display properties of the elevation. You can control 
the visibility, layer, color, linetype, lineweight, and linetype scale of each sub-
division by changing the display properties of each component. You can 
apply these changes to the selected 3D elevation or to all 3D elevations in the 
drawing.

1 Select the 3D elevation in the drawing, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the Subdivisions display representation.

4 Select the property source to edit:

If you want to edit 
graphic subdivisions . . .

Then . . .

for all 3D elevations in the current 
drawing 

select Drawing Default.
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5 If necessary, click .

6 Click the Layer/Color/Linetype tab to list all the components that contrib-
ute to the display of the object.

The defining line represents the cutting plane of the elevation line. The 
numbered subdivision components correspond to subdivisions added to 
the elevation line. For example, the display component Subdivision 1 cor-
responds to the subdivision closest to, but not on, the cutting plane of the 
elevation line.

7 Turn the visibility on or off, and change the layer, color, linetype, line-
weight, or lineweight scale as needed for each subdivision component.

8 Click OK twice.

Reversing a 2D or 3D Elevation

Use this procedure to reverse the direction of an elevation by reversing the 
elevation line and updating the elevation.

The direction of the elevation is determined by the direction in which you 
drew the elevation line. You can select the elevation line in plan view to see 
the bounding box that defines the area of the model included in the eleva-
tion. If the box does not include the area of the model that you intended, you 
can reverse the elevation line. If you have already created an elevation from 
the elevation line, update the elevation after reversing the elevation line.

1 Select the elevation line that you used to create the elevation, right-click, 
and click Reverse.

The elevation line is mirrored about its own axis, as is the bounding box 
with its original parameters.

2 Select the existing elevation, right-click, and click Regenerate.

NOTE If you do not need to respecify the objects to include in the eleva-
tion, you can click Refresh instead of Regenerate. This immediately updates 
the elevation.

for the selected 3D elevation select Bldg Section, and click Object 
Override.

If you want to edit 
graphic subdivisions . . .

Then . . .
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3 If you need to include different objects in the updated elevation, click  
(Reselect Objects), select the objects, and press ENTER.

4 Click OK.

Changing the Style of a 2D Elevation

Use this procedure to select a different style for a 2D elevation. A 2D section/
elevation style controls the appearance of any 2D elevation object to which 
the style is applied.

1 Double-click the elevation you want to change.

2 On the Properties palette, expand Basic, and expand General.

3 Select a new style for the elevation.

Creating a Material Boundary in a 2D Elevation

Use this procedure to create a material boundary in a 2D elevation.

1 Draw a polyline around the area in the elevation that you want to mask 
or to highlight.

2 Select the elevation, right-click, and click Material Boundary ➤ Add.

3 Select the polyline. 

4 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing. 

5 Specify the settings of the material boundary: 

If you want to . . . Then . . .

highlight the area inside the 
polyline

select Limit for Purpose.

mask (erase) the area inside the 
polyline

select Erase for Purpose.

apply the highlight or mask only 
to specific parts of the elevation 

select the appropriate parts for Apply to. You 
can choose Surface Hatch, Edge Linework, 
and All Linework.

apply the material boundary to 
all materials used in the elevation

select All Materials for Material Selection.

apply the material boundary only 
to selected materials

select Specific Materials for Material 
Selection and then select the appropriate 
materials in the list below. 
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6 Click OK.

Editing a Material Boundary

You can edit existing material boundaries in two ways:

� Change the content within the material boundary. For example, you can 
determine of you want to see only brick hatching, or both brick and glass 
hatching. 

� Change the shape of the material boundary. For example, you can make 
the boundary bigger or smaller, or add additional rings and vertex points 
to it. 

Related Procedures

� Editing the Content of a Material Boundary

� Adding a Vertex to a Material Boundary

� Removing a Vertex from a Material Boundary

� Adding a Ring to a Material Boundary

� Removing a Ring from a Material Boundary

� Replacing a Ring from a Material Boundary with Another

Editing the Content of a Material Boundary
Use this procedure to change the content of a material boundary. The con-
tent includes such settings as materials displayed, hatch types, and boundary 
type.

1 Select the material boundary to change, right-click, and click Material 
Boundary ➤ Edit In Place. 

You are now in the in-place edit mode. The selected boundary is high-
lighted and the grips are displayed.

2 Right-click, and click Edit Material Boundary. 

3 Specify the content of the material boundary: 

If you want to . . . Then . . .

highlight the area inside the 
boundary

select Limit for Purpose.

mask (erase) the area inside the 
boundary

select Erase for Purpose.
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4 Click OK.

5 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary.

Adding a Vertex to a Material Boundary
Use this procedure to add a vertex to a material boundary.

1 Select the material boundary to which you want to add a vertex, right-
click, and click Material Boundary ➤ Edit In Place. 

You are now in the in-place edit mode. The selected boundary is high-
lighted and the grips are displayed.

2 Right-click, and click Add Vertex. 

3 Specify the point at which to add a vertex. 

4 Specify additional vertex points. 

5 Press ENTER. 

6 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary.

Removing a Vertex from a Material Boundary
Use this procedure to remove a vertex from a material boundary.

1 Select the material boundary from which you want to remove a vertex 
point, right-click, and click Material Boundary ➤ Edit In Place.

You are now in the in-place edit mode. The selected boundary is high-
lighted and the grips are displayed.

2 Right-click, and click Remove Vertex. 

apply the highlight or mask only 
to specific parts of the elevation 

select the appropriate parts for Apply to. You 
can choose Surface Hatch, Edge Linework, 
and All Linework.

apply the material boundary to 
all materials used in the elevation

select All Materials for Material Selection.

apply the material boundary only 
to selected materials

select Specific Materials for Material 
Selection, and then select the appropriate 
materials from the list below. 

If you want to . . . Then . . .
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3 Specify the vertex points to remove. 

4 Remove additional vertex points as needed. 

5 Press ENTER. 

6 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary.

Adding a Ring to a Material Boundary
Use this procedure to add a ring to a material boundary.

A material boundary can consist of more than one closed polyline. For exam-
ple, you could use one polyline to highlight a wall detail, and another 
polyline to highlight a window detail in another location. 

1 Draw a polyline for the new material boundary ring. 

2 Select the material boundary to add a new ring to, right-click, and click 
Material Boundary ➤ Edit In Place. 

You are now in the in-place edit mode. The selected boundary is high-
lighted and the grips are displayed.

3 Right-click, and click Add Ring.

4 Select the polyline you drew in step 1.

5 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing.

6 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary.

Removing a Ring from a Material Boundary
Use this procedure to remove a ring from a material boundary.

A material boundary can consist of more than one closed ring. You can indi-
vidually remove each ring. 

NOTE You cannot remove the last ring from a material boundary.

1 Select the material boundary to change, right-click, and click Material 
Boundary ➤ Edit In Place. 

You are now in the in-place edit mode. The selected boundary is high-
lighted and the grips are displayed.
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2 Right-click, and click Remove Ring.

3 Select the ring you want to remove. 

4 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary.

Replacing a Ring from a Material Boundary with Another
Use this procedure to replace a ring from a material boundary with a different 
ring.

1 Draw the polyline to replace one of the existing material boundary rings.

2 Select the material boundary where you want to replace a ring, right-click, 
and click Material Boundary ➤ Edit In Place. 

You are in the in-place edit mode now. The selected boundary is high-
lighted and the grips are displayed.

3 Right-click, and click Replace Ring.

4 Select the ring to be replaced with another ring. 

5 Select the closed polyline you drew in step 1.

6 Enter y (Yes) to erase the polyline, or n (No) to keep the polyline in the 
drawing.

7 Select the material boundary again, right-click, and click Save Changes to 
save the changes you made, or click Discard All Changes to undo the 
changes to the material boundary.

Editing and Merging Linework in a 2D Elevation

After you create a 2D elevation, you can edit the display of individual lines 
that make up the elevation. For example, you may want to assign linework 
for small details to a display component with a lighter lineweight, so that the 
details are not obscured when plotted.

You can also merge existing geometry into the elevation.

Related Procedures

� Editing Linework in a 2D Elevation

� Merging Linework into a 2D Elevation

Editing Linework in a 2D Elevation
Use this procedure to edit individual lines in a 2D elevation by assigning 
them to display components in the elevation.
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You can assign selected linework to fixed display components that determine 
the display of every elevation that you generate, or you can assign linework 
to display components that you have defined. For information about adding 
custom display components, see “Adding a Display Component to a 2D Ele-
vation Style” on page 2185. After you assign linework to display compo-
nents, you can change the display properties (visibility, color, layer, line-
weight, linetype, and linetype scale) to change the display of lines.

1 Select the elevation to be changed, right-click, and click 
Linework ➤ Edit.

2 Select the lines that you want to assign to a display component, right-
click, and click Modify Component.

A list of available display components is displayed. 

3 Select the component you want to put the lines on. 

For example, if you want to make the lines invisible, select Erased Vectors 
for Linework Component.

You can also click  (Match existing linework), and select linework in 
the elevation whose display component you want to match.

4 Click OK.

5 To finish the linework editing process, select any line in the elevation, 
right-click, and select Edit in Place ➤ Save Changes to save the changes 
you made, or click Edit in Place ➤ Discard Changes to undo your line-
work changes.

Merging Linework into a 2D Elevation
Use this procedure to merge geometry into a 2D elevation. When you merge 
linework into an elevation, you assign additional linework to a display com-
ponent of an elevation. Use this feature when you want to add detail, or add 
linework that you did not model.

1 Draw the geometry that you want to merge into a 2D elevation.

2 Select the 2D elevation to be changed, right-click, and click 
Linework ➤ Merge.

3 Select the geometry to merge into the elevation, and press ENTER.

4 Select the display component to assign the linework to.

You can also click  (Match existing linework) and select linework in the 
elevation whose display component you want to match.

5 Click OK.
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The linework is merged into the 2D elevation. When you select the eleva-
tion, the linework is selected with it.

Changing the Location of a 2D or 3D Elevation

You can relocate an elevation by changing the coordinate values of its inser-
tion point. The elevation also has an orientation with respect to the WCS or 
the current UCS. For example, if the top and bottom of the elevation are par-
allel to the XY plane, its normal is parallel to the Z axis. You can change the 
orientation of the elevation by aligning its normal with another axis. You can 
also rotate the elevation on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Using Coordinates and Coordinate Systems” in the 
online AutoCAD User’s Guide.

1 Double-click the elevation you want to move.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional Information.

4 Specify a new location or rotation:

5 Click OK.

If you want to . . . Then . . .

relocate the elevation enter new coordinate values under Insertion Point.

locate the elevation on the 
XY plane

make the normal of the elevation parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the elevation on the 
YZ plane

make the normal of the elevation parallel to the X 
axis: under Normal, enter 1 for X, and enter 0 for Y 
and Z. 

locate the elevation on the 
XZ plane

make the normal of the elevation parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
elevation 

enter a new value for Rotation Angle.
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Attaching Hyperlinks, Notes, and Files to a 2D or 
3D Elevation

Use this procedure to add hyperlinks, enter notes, and attach reference files 
to a 2D or 3D elevation. You can also edit notes and edit or detach reference 
files from a 2D or 3D elevation.

1 Double-click the 2D or 3D elevation you want to attach notes or files to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD Com-
mand Reference.

4 To add a note, click  next to Notes, enter text, and click OK.

5 Click  next to Reference documents, and then attach, detach, or edit a 
reference file:

6 Click OK.

Updating a 2D or 3D Elevation

Use this procedure to regenerate a 2D or 3D elevation to reflect changes you 
have made to the building model or to elevation line properties. For 2D ele-
vations, you also update the elevation to show changes made to the 2D ele-
vation style. You can update a 2D or 3D elevation if you have not exploded 
the elevation, which destroys the link between the elevation and the build-
ing model.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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When you update an elevation, you can add or remove objects from the ele-
vation, change the location of the elevation in the drawing, and change the 
display set of the elevation. 

If you do not need to change the elevation definition in any way, you can 
skip the following procedure. Instead, right-click the elevation you want to 
update, and click Refresh.

1 Select the elevation you want to update, right-click, and click Regenerate.

2 Select a result type:

3 To change the style of a 2D elevation, select a new style for Style to Gen-
erate.

4 If you edited linework in the 2D elevation, select a style in which to save 
the changes you made that cannot be reapplied. 

Select a style that distinguishes the unapplied changes in the elevation.

5 Under Selection Set, specify the objects that you want to include in the 
elevation:

If the elevation is . . . Then . . .

a 2D elevation object select 2D Section/Elevation Object with Hidden Line 
Removal.

a 3D elevation object select 3D Section/Elevation Object.

If you want to . . . Then . . .

use the objects in the 
selection set you specified 
when you created the 
elevation or when you 
previously updated it

proceed to the next step.

add new objects to the 
selection set that you 
specified when you created 
the original elevation

click Select Additional Objects, select the new 
objects in the drawing, and press ENTER.

select a new selection set 
of objects for the elevation

click Reselect Objects, select a new selection set of 
objects for the elevation, and press ENTER.
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NOTE If you select an object that you do not want to include in the eleva-
tion, press and hold SHIFT and select the object again to remove it from the 
selection set.

6 Under Display Set, select a display set for the elevation.

7 Under Placement, locate the elevation in the drawing:

8 Click OK.

2D Elevation Styles

A 2D section/elevation style is a group of properties assigned to a 2D eleva-
tion that determines the appearance and other characteristics of that object. 

Using 2D Elevation Styles
A 2D section/elevation style controls the linework in an elevation, using 
design rules that determine how different parts of the elevation are dis-
played. You can apply the style to one or more elevations to control their 
appearance. You can also change the display of individual lines in the eleva-
tion, and save the changes in a 2D section/elevation style.

Display Components and Design Rules
Display components determine the graphical characteristics, such as color 
and linetype, of linework assigned to each display component. Design rules 
determine how the linework in an elevation is assigned to display compo-
nents.

When you create a design rule, you specify the part of the 2D elevation to 
control based on the color of those objects in the building model and their 
context in the elevation. You then select the display component to use for 
linework that meets the criteria you specified. You can assign the linework to 
a default display component or to a custom display component that you 

If you want to . . . Then . . .

create a new elevation 
object without overwriting 
the original object

select New Object, and either click to specify an 
insertion point in the drawing area, or enter X, Y, 
and Z coordinates for the new elevation.

replace the original 
elevation with the updated 
elevation

select Replace Existing.
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have added to the style. For example, you might define a rule that assigns all 
objects that are color 150 in the model and located along the elevation line 
to a custom display component named Darker that you created in the style. 
Or you might hide a staircase behind a wall using a rule that assigns all blue 
linework to the Hidden display component.

Managing 2D Elevation Styles
To create, edit, copy, or purge styles, you access the Style Manager. The Style 
Manager provides a central location in Autodesk Architectural Desktop to 
work with styles from multiple drawings and templates. For more informa-
tion about using the Style Manager, see “Style Manager.”

Materials and 2D Elevation Styles
Two-dimensional elevation styles offer an easy way to assign materials to 2D 
elevation objects. You can specify which section components should have its 
display controlled by materials and which do not. Custom components can-
not have any material assignments.

Subdivisions in 2D Elevation Styles and Materials
When you are creating subdivisions in your style, you usually want the 
objects in them to be visually distinct from other subdivisions. When you 
have assigned materials to the objects, you can set the 2D elevation style so 
that it uses the hatch pattern from the material, but the color and linetype 
from the subdivision display properties. 

Elevation subdivisions with assigned surface hatching
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Related Topics and Procedures

� Creating a 2D Elevation Style

� Adding a Display Component to a 2D Elevation Style

� Removing a Display Component from a 2D Elevation Style

� About 2D and 3D Elevation Display Components and Materials

� Use Subdivision Properties and Materials in 2D Elevation Styles

� Use the 3D Body Component of a Material for the 2D Elevation Linework

� Adding a Design Rule to a 2D Elevation Style

� Changing a Design Rule in a 2D Elevation Style

� Removing a Design Rule from a 2D Elevation Style

� Adding Classifications to a 2D Elevation Style

� Changing the Layer, Color, and Linetype of a 2D Elevation Style

� Attaching Notes and Files to a 2D Elevation Style

Creating a 2D Elevation Style

Use this procedure to create a 2D elevation style. You can create a style using 
default style properties or by copying an existing style. After you create the 
style, you edit the style properties to customize the characteristics of the 
style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand 2D Section/Elevation Styles.

3 Create a new 2D elevation style:

4 Enter a name for the new 2D elevation style, and press ENTER.

5 To edit the 2D elevation style, right-click the style, and click Edit:

If you want to create 
a style . . .

Then . . .

using default properties right-click 2D Section/Elevation Styles, and click 
New.

style from an existing style right-click the 2D elevation style you want to copy, 
and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

add display components to 
the style

see “Adding a Display Component to a 2D Elevation 
Style” on page 2185.
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6 Click OK twice.

You can click Apply instead of OK to save the changes and continue work-
ing in the Style Manager.

Adding a Display Component to a 2D Elevation 
Style

Use this procedure to add a custom display component to a 2D elevation 
style. After you add a component, you assign linework in the elevation to the 
new component. To apply these style changes to existing 2D elevations, you 
must update the elevation.

2D elevations include the following default display components: Defining 
Line, Hidden, Erased, Unknown, and Subdivision.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Components tab

remove display 
components from the style

see “Removing a Display Component from a 2D 
Elevation Style” on page 2186.

use the subdivision 
properties of the elevation 
for the display

see “Use Subdivision Properties and Materials in 2D 
Elevation Styles” on page 2190.

use the 3D Body 
component of the material 
for the elevation linework

see “Use the 3D Body Component of a Material for 
the 2D Elevation Linework” on page 2191.

add design rules to the 
style

see “Adding a Design Rule to a 2D Elevation Style” 
on page 2192.

change design rules in the 
style

see “Changing a Design Rule in a 2D Elevation 
Style” on page 2193.

add classifications to a style see “Adding Classifications to a 2D Elevation Style” 
on page 2194.

change the display 
properties of the display 
components in the style

see “Changing the Layer, Color, and Linetype of a 
2D Elevation Style” on page 2194.

add notes, files, or 
documents to the style

see “Attaching Notes and Files to a 2D Elevation 
Style” on page 2195.

If you want to . . . Then . . .
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3 Click Add.

4 Enter a name and a description for the new component.

To enter a name, click Unnamed and enter a new name. To enter a descrip-
tion, click in the Description column next to the name, and enter a 
description.

5 Click the Display Properties tab.

6 Select 2D Section/Elevation Style for the property source, and click .

7 Click the Layer/Color/Linetype tab.

8 Specify the display properties of the new component.

9 Click OK twice.

To create a design rule that uses the new display component, see “Adding 
a Design Rule to a 2D Elevation Style” on page 2192. To manually assign 
linework to the display component, see “Editing Linework in a 2D Eleva-
tion” on page 2177.

Removing a Display Component from a 2D 
Elevation Style

Use this procedure to remove a custom display component from a 2D eleva-
tion style. Removing a display component also removes any design rules that 
use the component. You cannot remove the default display components.

1 Select a elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Components tab.

3 Select the component that you want to remove, and click Remove. 

If the component is used in a design rule, the associated design rule is 
removed as well. 

4 Click OK.

5 Update the elevation to apply the style changes to the elevation.

For more information, see “Updating a 2D or 3D Elevation” on page 2180.

About 2D and 3D Elevation Display Components 
and Materials

A 2D and 3D elevation object consists of a number of display components 
that can be determined by materials. When you assign materials to an object, 
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you assign one material to each display component of the object. For exam-
ple, you assign a wood material to the frame of a window and a glass compo-
nent to the glass of a window.

When you create a 2D or 3D elevation object from building objects, the 
material assignments of the source objects are applied to the elevation. You 
do not assign a material directly to a 2D/3D elevation. The elevation takes its 
material assignments from the objects. For example, if you create an eleva-
tion of a wall with a window, the surface hatches you have defined in the 
glass, wood, and brick materials of the wall and the window are displayed in 
the elevation object. 

If you do not want to use the material display properties, but instead use 
those of the 2D or 3D elevation object or the 2D elevation style, you can 
deactivate the material assignments in the display properties of the elevation 
or the elevation style. 

Material definitions consist of display components that correspond to com-
ponent types of objects. For example, the Linework component of a material 
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is used for all linework of objects in Plan view. The Surface Hatch component 
of a material is used to hatch all object surfaces in 3D model views and ele-
vations. 

For a complete list of material components and their description, see “Mate-
rial Components and Display Properties” on page 498.

The following table lists elevation components plus information about the 
material components that determine them. 

NOTE An elevation is technically the same object as a section, and has the 
same display components as a section. The following topics describe the display 
components most relevant to elevations. For a complete list of all section and 
elevation components, see “About 2D and 3D Section Display Components and 
Materials” on page 2132.

Related Topics

� Surface Hatch Linework

� Hidden Component

� Erased Component

� Subdivision Components

Surface Hatch Linework
The Surface Hatch Linework component draws all linework coming from sur-
face hatches of the objects in the elevation. This component is specific to 2D 
elevations.

2D Elevation 
Component

Material Component

Surface Hatch Linework Surface Hatch

HIdden No Material

Erased No Material

Subdivision 1-10 2D Section/Elevation Linework or 3D Body. For 
information on switching between these material 
components, see “Use the 3D Body Component of a 
Material for the 2D Elevation Linework” on page 2191.



2D Elevation Styles | 2189

NOTE Surface hatches you have assigned to objects display in a 3D elevation 
object. However, you cannot set them separately in a 3D elevation; you can do 
that only in a 2D elevation object.

The surface hatch linework component is controlled by the surface hatch 
component of the material. For information about the surface hatch compo-
nent of the material, see “Surface Hatch Material Component” on page 500.

2D elevation with building roof, wall, and foundation surface hatching

Hidden Component
The Hidden component contains all linework that is hidden in the 2D pro-
jection because other components are in front of it. By default, this compo-
nent is turned off. You can use design rules to achieve special effects, such as 
a see-through effect, using the Hidden component. The Hidden component 
is specific to 2D elevations.

The Hidden component cannot be defined by a material component. You 
can only set it in the display properties of the 2D elevation. For information 
on setting the display properties of a 2D elevation, see “Changing the Layer, 
Color, and Linetype of a 2D Elevation Style” on page 2194.

Erased Component
The Erased component contains linework in the elevation object that you do 
not want to see. For example, if you have an elevation of a window front with 
three windows, but you want to display only one (for a higher level of 
abstraction), edit the linework of the elevation and assign the linework of the 
remaining two windows to the Erased component. Because the Erased com-
ponent is turned off by default, the two windows do not display. For infor-
mation on linework editing of an elevation, see “Editing Linework in a 2D 
Elevation” on page 2177.

The hidden component is specific to 2D elevations, and cannot be defined 
by a material component.



2190 | Chapter 29 Elevations

Subdivision Components
The subdivision components partition an elevation object. They are useful to 
create perspective effects, where parts closer to the viewer are drawn with 
darker, stronger lines and parts farther from the user are drawn with lighter, 
thinner lines. Subdivisions can have no individual material assignments. 
However the display properties of the subdivisions can be used for the surface 
hatching of the subdivisions by selecting Use Subdivision Properties for Sur-
face Hatching in the Other tab of the 2D elevation display properties. For 
information on using the subdivision display properties to display the eleva-
tion divisions, see “Use Subdivision Properties and Materials in 2D Elevation 
Styles” on page 2190.

Subdivisions are a display component of both 2D and 3D elevation objects.

The subdivision components are either controlled by the 2D Section/Eleva-
tion Linework component of the material or by the 3D Body component of 
a material. For information on how to switch between these component 
assignments, see “Use the 3D Body Component of a Material for the 2D Ele-
vation Linework” on page 2191.

Use Subdivision Properties and Materials in 2D 
Elevation Styles

Use this procedure to use the display properties of materials together with the 
display properties of elevation subdivisions.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Display Properties tab.

3 Select 2D Section/Elevation Style for the property source, and click Style 
Override.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 To set a subdivision to use the surface hatch of the material, while using 
the layer, color, and linetype display properties of the subdivision, clear By 
Material, and specify the layer, color and linetype settings of the subdivi-
sion.

For example, the first subdivision could have a darker color and stronger 
linetype the second subdivision. 

7 Click the Other tab.
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8 Select Use Subdivison Properties for Surface Hatching.

9 Click OK twice.

Use the 3D Body Component of a Material for 
the 2D Elevation Linework

Use this procedure to use the 3D Body component of a material for the line-
work in a 2D elevation.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Display Properties tab.

3 Select 2D Section/Elevation Style for the property source, and click Style 
Override.

4 If necessary, click .

5 Click the Other tab.

6 Determine if the 3D body component of the selected material should con-
trol the display of the linework in the 2D elevation:

7 Click OK twice.

If you want to control the 
display . . .

Then . . .

of the 2D elevation linework by the 
3D Body component of the 
material

select Use 3D Body Display Component 
for By Material Linework.

of the 2D elevation linework by the 
2D Section/Elevation Linework 
component of the material

deselect Use 3D Body Display 
Component for By Material Linework. 
This is the default behavior.
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Adding a Design Rule to a 2D Elevation Style

Use this procedure to add a design rule to a 2D elevation style. A design rule 
has four fields of information that identify lines in the elevation and deter-
mine how to display them:

For example, a design rule has the color 50, a context of Within Subdivision 
2, and a component of New. This rule assigns any lines in the elevation rep-
resenting objects that have the color 50 in the building model and that are 
within subdivision 2 in the elevation to the user-defined display component, 
New.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Design Rules tab, and click Add.

A new design rule is created with default color, context, and component 
values.

3 Specify settings for the new design rule:

Field Description

Color Identifies the color of the objects in the building model 
presented by the lines in the elevation

Context Identifies the context of the lines in the elevation, such as in a 
graphic subdivision

Component Identifies the display component to which the lines are 
assigned 

Description Contains a description of the design rule

If you want to . . . Then . . .

specify the color of 
objects in the building 
model that are affected 
by this rule

click the default color, select a new color, and click 
OK.

specify the context in 
which the linework for 
the objects appears in the 
elevation

click the default context, and select a new context.
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4 Click OK.

5 Update the elevation to apply the style changes to the elevation.

For more information, see “Updating a 2D or 3D Elevation” on page 2180.

Changing a Design Rule in a 2D Elevation Style

Use this procedure to change the settings in the fields that define a design 
rule.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Design Rules tab.

3 Specify settings for the design rule you want to change:

4 Click OK.

5 Update the elevation to apply the style changes to the elevation.

select the display 
component for the 
linework 

click the default component, and select a new 
component.

enter a description of the 
rule

click the Description field, enter a description, and 
press ENTER.

If you want to . . . Then . . .

specify the color of 
objects in the building 
model that are affected 
by this rule

click the current color, select a new color, and click 
OK.

specify the context in 
which the linework for 
the objects appears in the 
elevation

click the current context, and select a new context.

select the display 
component for the 
linework 

click the current component, and select a new 
component.

edit the description of the 
rule

click the description, edit the description, and press 
ENTER.

If you want to . . . Then . . .
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For more information, see “Updating a 2D or 3D Elevation” on page 2180.

Removing a Design Rule from a 2D Elevation 
Style

Use this procedure to remove a design rule from a 2D elevation style. 

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Design Rules tab.

3 Select the rule that you want to remove, and click Remove.

4 Click OK.

5 Update the elevation to apply the style changes to the elevation.

For more information, see “Updating a 2D or 3D Elevation” on page 2180.

Adding Classifications to a 2D Elevation Style

Use this procedure to specify classifications for any classification definition 
applied to a 2D elevation style.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to 2D ele-
vation styles.

3 For each classification definition, select the classification you want to 
apply to the current 2D elevation style.

4 Click OK twice.

Changing the Layer, Color, and Linetype of a 2D 
Elevation Style

Use this procedure to change the following display properties of a 2D eleva-
tion style: 

� Visibility (component is on or off)
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� Display properties by materials
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

NOTE The custom display components in the display properties are identical 
to those listed on the Components tab of the 2D Section/Elevation Styles dialog 
box. For more information about custom display components, see “Adding a 
Display Component to a 2D Elevation Style” on page 2185.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.

2 Click the Display Properties tab.

3 Select 2D Section/Elevation Style for the property source, and click Style 
Override.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Select By Material for any component that you want to use the display 
properties of the materials assigned to the elevation objects.

NOTE Not all display components of a 2D elevation have an associated 
material definition. For example, Hidden and Erased cannot be set by mate-
rial. For a list of all display components and their associated material compo-
nents, see “About 2D and 3D Elevation Display Components and Materials” 
on page 2186.

8 Click OK twice.

Attaching Notes and Files to a 2D Elevation Style

Use this procedure to enter notes and attach reference files to a 2D elevation 
style. You can also edit notes and edit or detach reference files attached to the 
style.

1 Select an elevation that has the style you want to change, right-click, and 
click Edit 2D Section/Elevation Style.
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2 Click the General tab.

3 To add a description to the 2D elevation, enter the description under 
Description.

4 Click Notes.

5 To add or edit a note, click the Notes tab, and enter the note.

6 To attach, edit, or detach a reference file, click the Reference Docs tab:

7 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are done editing.

detach a reference file select the file name, click Delete, and click OK.
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Schedules

Schedules are tables in your drawings that list 
information about selected components in your 
building model. You can create different types 

of schedules in Autodesk® Architectural Desktop 
by attaching property set data to objects and 
object styles, and then extracting and display-
ing the data in a schedule table.

Creating Schedules in Autodesk Architec-
tural Desktop
The following elements allow you to create 

schedules in Autodesk® Architectural Desktop:

� schedule tables and schedule table styles
� property set definitions
� property data formats 
� schedule tags

Updating Schedules
Because the property set data is attached to 
objects and styles, you can create and update 
schedules at any stage of a project. Rather than 
waiting until the end of a project to create 
schedules, you can create preliminary schedules 
and update them to reflect changes in your 
drawings.

Schedule Tables and Schedule Table Styles
A schedule table is an object that provides the 
tabular representation of the property data in 
your drawing. A schedule table style specifies the 
objects that can be included in a schedule table. 
The style also determines the object properties 
reported in the table and controls formatting 
such as text height and spacing, columns, and 
headers. The display properties of the schedule 

In this chapter

� Property Sets and Property Set 
Definitions

� Process Overview: Creating 
Schedules

� Process Overview: Including 
Classification Data in Schedules

� Adding and Editing Property Set 
Data

� Creating and Editing Schedule 
Tables

� Adding Schedule Tags

� Custom Tags

� Property Set Definitions

� Schedule Table Styles

� Property Data Formats

� Classification Definitions

� Troubleshooting Schedule 
Tables

� Troubleshooting Schedule Table 
Styles

� Troubleshooting Classification 

30
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table control visibility, layer, color, linetype, lineweight, and linetype scale of 
its components.

Options in schedule table styles let you create both regular and matrix sched-
ules. (Matrix schedules are sometimes called dot schedules.) You can also 
specify a matrix format for individual columns in a regular schedule.

Sample door schedule

Using Classifications in Scheduling
Classification definitions are groups of named properties or characteristics 
that you can assign to the objects of a particular style. Classifications enable 
you to track objects by construction status, project phase, building element, 
vendor, or other criteria.

Classification definitions applied to a door style

Related Topics and Procedures

� Process Overview: Creating Schedules

� Adding and Editing Property Set Data



Property Sets and Property Set Definitions | 2199

� Creating and Editing Schedule Tables

� Adding Schedule Tags

� Property Set Definitions

� Schedule Table Styles

� Property Data Formats

� Classification Definitions

� Troubleshooting Schedule Tables

� Troubleshooting Schedule Table Styles

� Troubleshooting Classification Definitions

 Property Sets and Property Set Definitions 

The data reported in a schedule table is collected from property sets that you 
attach to the objects or object styles you are scheduling. Properties contained 
in a property set are determined by the property set definition. A property set 
definition is a group of related properties of the objects and object styles to 
be reported in the schedule. Once attached to an object or its style, a property 
set becomes the container for the data associated with the object. Values for 
properties are obtained directly from the object or are entered manually for 
the object or the style.
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A property set definition for a door object

Automatic and Manual Properties
AEC objects and styles have two types of properties: 

� Automatic properties built into objects and styles when you create them. 
Examples are width, length, height, and data retrieved from other sources 
such as the project or the object’s material. 

� Manual properties are those that you enter explicitly, such as fire rating, 
manufacturer, or finish.

Automatic properties are available to include in your property set definitions. 
You must create manual properties and enter values for them when you 
attach the property set to the object or the style.

Applying Property Set Definitions to Objects and Styles
You create a property set definition for either objects or object styles. Manual 
properties that are likely to be different for each instance of an object belong 
in an object-based property set definition, while manual properties that will 
be the same for all instances of a style belong in a style-based property set def-
inition. 

Automatic properties are dynamically retrieved from the object. Most auto-
matic properties should be put in a style-based property set definition, even 
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if values may vary for each instance of the object. For example, the properties 
“Door Width” and “Door Height” are extracted automatically from door 
objects. Placing these properties in a style-based property set definition pro-
vides a value for each door object of that style, and is more efficient than put-
ting them in an object-based property set definition that you then attach to 
each door.

Defining a property set definition that applies to door objects

Property Data Formats
A property data format is applied to each definition within a property set def-
inition. Property data formats specify how the data for each property displays 
in a schedule table, schedule tag, or the property palette. For example, you 
can use property data formats to display a door that is three feet wide, with 
a raw value of 36 units in a drawing, with inch units as 3'-0", or 3', or 3 ft. 
Property set definitions and schedule table styles use property data formats 
to control the format of values for each property.

Schedule Tags and Property Set Data
You can use tags in your drawings to graphically display an object’s property 
data. You can report property data in the tag by linking it to a property in a 
property set. When you anchor the tag to an object to which the property set 
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is applied, the value of the property displays in the tag. The information in 
the tag is updated if the object or property changes.

NOTE Property data values are not contained in the schedule tag, but on the 
object itself. The schedule tag simply displays values retrieved directly from the 
object to which it is anchored.

Predefined Content for Creating Schedules
You can access default tags and property set definitions in drawings located 
in C:\Documents and Settings\All Users\Application Data\Autodesk\Autodesk 
Architectural Desktop 2004\R16.0\enu\AEC Content\Imperial or Metric\Docu-
mentation\Schedule Tags.

You can access schedule table styles in drawings located in C:\Documents and 
Settings\All Users\Application Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\Styles.

You can use this content to create typical schedules, such as door and win-
dow schedules, and room finish schedules. You can also use this content as 
the basis for custom schedules.

Related Topics and Procedures

� Process Overview: Creating Schedules

� Process Overview: Including Classification Data in Schedules

� Adding and Editing Property Set Data

� Creating and Editing Schedule Tables

� Adding Schedule Tags

� Property Set Definitions

� Schedule Table Styles

� Property Data Formats

� Troubleshooting Schedule Tables

� Troubleshooting Schedule Table Styles

Process Overview: Creating Schedules

If you create schedule tables from schedule table styles provided with 

Autodesk® Architectural Desktop, the property set definitions and property 
data formats used in the schedule table style are already created for you. You 
can begin the process of creating a schedule from Step 4.
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To create schedules, use the following steps:

Step 1: Create or modify property data formats. 

These styles determine how data is displayed in a schedule table.

Step 2: Create or modify property set definitions for objects or object styles. 

Property set definitions determine the data listed for each object.

Step 3: Create or modify schedule table styles.

Schedule table styles determine the kinds of objects listed in a schedule 
table, what data is displayed, and how the data is sorted.

Step 4: Attach property set data to the objects and object styles to be included 
in your schedule table.

 You can also attach schedule tags to these objects.

Step 5: Add a schedule table to the drawing. 

Step 6: Edit the schedule table as needed.

Changes you make to objects and styles are reflected in the schedule. You 
can also edit schedule tables directly in the following ways:

� Edit individual table cells to change values of manual properties
� Add, remove, reselect, and show relationships with items from the 

table
� Renumber property data

Step 7: Export the finished schedule table to an external file, if necessary.

Related Topics and Procedures

� Property Data Formats

� Property Set Definitions

� Schedule Table Styles

� Adding and Editing Property Set Data

� Creating and Editing Schedule Tables

� Adding Schedule Tags
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Process Overview: Including Classification 
Data in Schedules

The process of including classification data for objects in a schedule table has 
the following major steps:

Step 1: Create a classification definition, and specify the object styles in 
which it is used.

Step 2: Create and attach property sets to the classifications in the classifica-
tion definition.

Step 3: Specify the classification for each object style that you want to sched-
ule.

Step 4: Add the classification or its properties to a property set definition for 
the object style.

Step 5: Add the classification or its properties as columns in a schedule table 
style that uses the property set definition you edited in step 4.

Step 6: If necessary, specify filtering options for classifications in the sched-
ule table style.

Step 7: Create the schedule table.

The classification information for each object is included in the columns you 
added to the schedule table style.

Related Topics and Procedures

� Classification Definitions

� Property Set Definitions

� Adding a Classification Property Definition to a Property Set Definition

� Adding Columns to a Schedule Table Style

� Filtering Scheduled Objects by Classification in a Schedule Table Style

� Adding a Schedule Table

Adding and Editing Property Set Data

Objects to be included in schedule tables or linked to tags must have property 
set data attached to them. Schedule tables and tags do not store any data, but 
extract and display property set data from the included objects.
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Property set data is created from one or more property sets attached to an 
object or a style. Some property data comes from automatic properties that 
are obtained from the object or the object style and cannot be manually 
entered, such as dimensions. Other property data consists of manual proper-
ties for which you must enter values for each object or object style, such as 
manufacturer’s name.

If an entity or style containing a property set is copied from a source drawing 
into a target drawing that already contains a property set with the same 
name, the property set in the target drawing does not change. There is a 
potential for a loss of data in this case. An example of this is as follows:

� A drawing contains a property set that has a number of manual properties 
defined. This property set is attached to a door style with manual property 
values set. This door style is then copied into another drawing that con-
tains a duplicate property set that does not have the same manual proper-
ties defined. In the target drawing the door style will contain the target 
drawing’s property set, not the source drawing’s property set. Any data val-
ues associated with the source drawing’s manual properties will be lost.

Related Procedures

� Attaching Property Set Data to Objects

� Entering Manual Properties for Objects

� Removing Property Set Data from an Object

� Attaching Property Set Data to Styles and Definitions

� Entering Manual Properties for Styles and Definitions

� Removing Property Set Data from a Style or Definition

� Browsing Property Data

Attaching Property Set Data to Objects

Use this procedure to attach property set data to objects that you want to 
include in a schedule table or link to schedule tags.

You attach property set data to objects by attaching one or more property sets 
defined by a property set definition. After property sets are attached, the val-
ues for automatic properties are determined, and you can enter values for the 
manual properties.

To attach property set data to an object style, see “Attaching Property Set 
Data to Styles and Definitions” on page 2207.

1 Double-click the objects to which to attach property set data. 
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NOTE If you select more than one type of object, you can attach only the 
property set definitions that apply to all the selected objects. For example, if 
you select doors and windows, you can attach only those property sets that 
apply to both doors and windows. You cannot attach those that apply to 
doors only or to windows only.

2 On the Properties Palette, click the Extended Data tab.

3 Click .

4 Select the property sets to attach to the object, and click OK.

Entering Manual Properties for Objects

Use this procedure to enter values for manual properties for one or more 
objects. For example, to enter a remark that applies to several doors in a draw-
ing, you can select the doors and enter the remark as data for Notes. 

If the property you want to enter is not listed in a property set for the object, 
the property may be attached to the object style. To enter values for manual 
properties attached to styles and definitions, see “Entering Manual Properties 
for Styles and Definitions” on page 2207.

1 Double-click the objects for which to enter manual properties.

NOTE If no property set data appears, no property sets are attached to the 
objects. To attach property sets, see “Attaching Property Set Data to Objects” 
on page 2205.

2 On the Properties palette, click the Extended Data tab, and enter a value 
for a manual property.

If you selected multiple objects, the value applies to all the objects. 

Removing Property Set Data from an Object

Use this procedure to remove one or more property sets from an object. If an 
object is included in a schedule table, any data in the table obtained from the 
removed property set is removed from the table.

1 Double-click the objects from which to remove property set data. 

2 On the Properties Palette, click the Extended Data tab.
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3 Click .

4 Select property sets to remove, and clear any property sets to remain 
attached to the object.

5 Click OK.

Attaching Property Set Data to Styles and 
Definitions

Use this procedure to attach data directly to these object styles and defini-
tions, such as area styles, curtain wall styles, door styles, and multi-view 
block definitions.

You attach data to a style or a definition by attaching one or more property 
sets to it. Objects that use the style or definition inherit its property set data. 
The values for automatic properties, which may be different for each instance 
of the style, are determined, and you can enter values for manual properties. 
To attach property set data to individual objects, see “Attaching Property Set 
Data to Objects” on page 2205.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and locate the style or definition to which 
to attach property set data. 

3 Right-click the style or definition, and click Edit.

4 Click the General tab, and click Property Sets.

5 Click .

6 Select the property sets that you want to attach.

7 Click OK four times.

Entering Manual Properties for Styles and 
Definitions

Use this procedure to enter values for manual properties in the property set 
data for a style or definition. The values you enter apply to all instances of 
objects associated with the style or definition.

If the property you want to edit is not listed in the property set data for the 
style or definition, it may be in a property set attached to the objects. To enter 
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values for manual properties attached to objects, see “Entering Manual Prop-
erties for Objects” on page 2206.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and locate the style or definition for which 
to add manual properties. 

3 Right-click the style or definition, and click Edit.

4 Click the General tab, and click Property Sets.

NOTE If no data appears, no property sets are attached to the style or def-
inition. To attach property sets, see “Attaching Property Set Data to Styles and 
Definitions” on page 2207.

5 Enter a value for a manual property.

6 Click OK three times.

Removing Property Set Data from a Style or 
Definition

Use this procedure to remove one or more property sets from a style or defi-
nition. If objects using the style or definition are included in a schedule table, 
any data in the table obtained from the removed property set is also removed 
from the table.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Architectural Objects, and locate the style or definition from 
which to remove property set data. 

3 Right-click the style or definition, and click Edit.

4 Click the General tab, and click Property Sets.

5 Click .

6 Select property sets to remove, and clear any property sets that should 
remain attached.

7 Click OK four times.
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Browsing Property Data

Use this procedure to access and view the data for all property sets in a draw-
ing.

For more information about browsing property sets of objects scheduled 
from external references, or to override property sets for those objects, see 
“Attaching Property Sets to Objects from External References” on page 349.

1 Open the tool palette that you want to use, and select the Browse Property 
Data tool.

This tool is located with the Scheduling and Reporting Tools in the Stock 
Tool Catalog. You can add this tool to any tool palette. For more informa-
tion, see “Content Browser” on page 171.

2 Specify view options:

3 View property sets and the objects or styles to which they are assigned:

If you want to . . . Then . . .

allow an object to be highlighted in the drawing 
when you select a property set that is attached to 
the object or its style

select Highlight.

prevent an object from being highlighted in the 
drawing when you select a property set that is 
attached to the object or its style

clear Highlight.

display objects in the drawing with the property 
set definition selected in the left pane

clear Hide objects without 
property set definitions.

prevent objects in the drawing with the property 
set definition selected from displaying in the left 
pane

select Hide objects without 
property set definitions.

view the raw, unformatted data in the property set clear Format data.

If you want to . . . Then . . .

view the object or style type 
to which a property set 
applies

select the property set. The right pane lists the 
property values, if available, and the objects or 
the styles to which the property set can be 
attached.
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Viewing property values for objects with property sets attached

4 Edit property sets and values:

WARNING! If you detach a property set from an object or style, any man-
ually entered values are lost. If you mistakenly detach a property set, click OK, 
and then immediately click Edit ➤Undo to undo the remove action.

view the list of objects or 
styles to which a property set 
is attached

apply the object filter to the property set. The 
left pane shows objects by their unique 
identifiers, or styles by style name, to which the 
property set is attached. If Highlight is selected, 
any objects to which the property set is attached 
(directly or through a style) are highlighted in 
the drawing.

view the property values for a 
specific property set and a 
specific object or style

under the property set, select the object or style. 
The right pane shows the values for the selected 
object or style.

If you want to . . . Then . . .

edit property values for a 
property set and a object or 
style

select the object or style from the left pane. 
You can then edit manual values and add or 
remove property sets from the object or style. 
Click OK.

If you want to . . . Then . . .
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5 Remove property sets from objects or styles:

6 Click Zoom to to view the selected object in the drawing. 

7 Click OK.

Creating and Editing Schedule Tables

You can create schedule tables to graphically represent specific information 
about objects in your drawing. There are several elements of schedule tables.

Creating Schedule Tables Using Schedule Table Tools
Tool palettes provided with Autodesk® Architectural Desktop let you quickly 
place schedule tables by selecting a tool with a specific schedule table style 
and other predefined properties. You can also apply the settings of a schedule 
table tool to existing schedule tables.

If you want to . . . Then . . .

detach a property set from a 
object or style

clear the selection of the object or style.

add a property set to objects or 
styles

select the object or style.
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Tool palette containing schedule table tools

The following palettes contain one or more schedule table tools:

You can use the default settings of schedule table tools, or you can change 
settings for any schedule table properties that are not controlled by the style.

Using Schedule Table Styles
Schedule table styles control the content and appearance of schedule tables. 
A drawing must contain a schedule table style for the type of schedule table 
you want to create. When you copy a schedule table style into a drawing, 
property set definitions and data formats specified in the style are also cop-
ied. For more information, see “Schedule Table Styles” on page 2269.

Tool Palette Schedule Table Tools

Documentation palette in the 
Tool palette set

a schedule table tool for the Standard 
schedule table style and default settings for 
other schedule table properties

custom tool palettes created by 
your CAD manager

schedule table tools with schedule table styles 
and properties that your CAD manager 
customized for your projects or office 
standards
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Attaching Property Set Data
Before creating schedule tables, you attach the property sets referenced in the 
schedule table style to the objects and object styles. The attached property 
sets become the containers for data. For more information, see “Adding and 
Editing Property Set Data” on page 2204.

A schedule table extracts data from objects and displays the data in the table. 
No data is saved in the table itself.

Updating Property Set Data
When you add a schedule table to a drawing, you specify whether new 
objects are added to the table when they are added to the drawing. You can 
also specify whether the data in the schedule table is updated when objects 
or styles are modified. If you do not select these options for automatic updat-
ing, you can update a schedule at any time. 

You can also directly edit the data in individual cells and columns for any 
manual properties included in the table. In addition, after you add, remove, 
or change objects in a schedule, you can renumber the objects and their 
schedule tags.

Exporting Property Set Data
You can export data directly to external files in the following formats:

� Microsoft® Excel spreadsheet (XLS) files
� Comma-separated values (CSV) files
� Tab-delimited text (TXT) files

Related Procedures

� Creating a Schedule Table Tool

� Adding a Schedule Table

� Turning Off the Out-of-Date Schedule Table Marker

� Updating a Schedule Table

� Adding Objects to a Schedule Table

� Removing Objects from a Schedule Table

� Reselecting Objects for a Schedule Table

� Showing Objects in a Schedule Table

� Renumbering Property Set Data

� Exporting a Schedule Table

� Specifying the Display Properties of a Schedule Table

� Changing General Schedule Table Properties

� Changing the Selection Criteria of a Schedule Table

� Changing the Placement of a Schedule Table
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� Changing External Source Properties of a Schedule Table

� Adding Table Breaks to a Schedule Table

� Adding Documentation Information to a ScheduleTable

� Identifying and Editing Table Cell Data

� Adding Property Set Data to All Objects

Creating a Schedule Table Tool

Use this procedure to create a schedule table tool and add it to a tool palette. 
You may want to create your own schedule table tools if you are placing mul-
tiple schedule tables of specific styles that have the same properties.

You can use any of the following methods to create a schedule table tool:

� Drag a schedule table that has the properties you want to a tool palette.
� Drag a schedule table style from the Style Manager to a tool palette, and 

then customize the properties of the new tool.
� Copy a tool from another palette to the current palette, and then custom-

ize the properties of the new tool.
� Copy an existing tool in the current palette and then customize the prop-

erties of the new tool.

1 Open the tool palette on which you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

If you want to . . . Then . . .

create a tool from a schedule 
table in the drawing

select the object, and drag it to the tool 
palette.

create a tool from a schedule 
table style in the Style Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.
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5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand General.

7 Specify general properties for the schedule table:

NOTE Turning on the automatic update feature may slow drawing perfor-
mance, especially in large drawings. For information about updating sched-
ules manually, see “Updating a Schedule Table” on page 2218.

8 Expand Selection.

9 Specify how to add objects to the schedule table:

If you want to . . . Then . . .

add a description enter text for Description.

specify the layer key select Layer Key.

specify layer overrides select Layer Overrides.

specify the schedule table style select Style.

specify an external drawing file source 
for the style 

select Style Location or Browse to 
specify a location.

change the schedule table scale enter a value for Scale.

automatically update the schedule 
table when data in the drawing 
changes

select Yes for Update automatically.

manually update the schedule table 
when the drawing changes

select No for Update automatically.

If you want to . . . Then . . .

automatically add new objects to the 
schedule table as they are added to the 
drawing

select Yes for Add new objects 
automatically.

manually add new objects to the 
schedule table

select No for Add new objects 
automatically.
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NOTE When adding a schedule table that must scan xrefs or blocks, use a 
layer filter that includes both the name of the layer that contains the xref or 
block, and the name of the layer of the object inside the xref or block. You 
can separate multiple layer wild cards with a comma.

10 Click OK.

Adding a Schedule Table

Use this procedure to add a schedule table to a drawing sheet. You can specify 
schedule table properties on the Properties palette when you add a schedule 
table, or you can modify the schedule table later.

Before adding a schedule table, ensure that objects can be scheduled.

� The drawing contains a schedule table style for the objects you want to 
schedule. For more information, see “Schedule Table Styles” on 
page 2269.

� Property set data is attached to the objects and object styles. For more 
information, see “Adding and Editing Property Set Data” on page 2204.

1 Open the tool palette that you want to use, and select the Schedule Table 
tool.

A Schedule Table tool is located with the Scheduling and Reporting Tools 
in the Stock Tool Catalog. You can add this tool to any tool palette. For 
more information, see “Content Browser” on page 171.

2 Select the objects to include in the schedule table, or press ENTER to sched-
ule an external drawing.

include objects from xref drawings in 
the schedule table

select Yes for Scan xrefs.

exclude objects from xref drawings in 
the schedule table

select No for Scan xrefs.

include objects from block references 
in the schedule table

select Yes for Scan block references.

exclude objects from block references 
in the schedule table

select No for Scan block references.

apply a layer filter to the table specify a layer wild card.

If you want to . . . Then . . .
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For more information, see “Changing External Source Properties of a 
Schedule Table” on page 2226.

You can use a window or a crossing window to select the objects. Objects 
that are not of the type specified for the schedule table are filtered out.

3 In the drawing area, specify the insertion point for the upper-left corner 
of the schedule table.

4 Specify the lower-right corner of the table, or press ENTER to scale the 
schedule table to the current drawing scale.

� If the schedule table contains question marks in any cells, the property 
set containing that property is not attached to an object or style.

� Empty cells or dashes in cells indicate that the property set is attached, 
but data is not available or is not entered for that object or style.

For more information about attaching property sets for property set data, 
see “Adding and Editing Property Set Data” on page 2204.

Turning Off the Out-of-Date Schedule Table 
Marker

Use this procedure to turn off an out-of-date marker that appears when an 
object, object style, or attached property set data has changed but the sched-
ule table is not updated.

With the out-of-date display component on in the General schedule display 
representation of your drawing, a line is drawn through the schedule table to 
indicate that the information tracked by the schedule has changed. For 
example, a line is drawn through the schedule table if an object tracked in 
the schedule is moved or deleted, or if its dimensions are edited. The line is 
removed when you update the schedule table.

Displaying an out-of-date schedule
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NOTE Turning on this display component can slow drawing performance, 
especially in large drawings.

1 Select the schedule table, right-click, and click Edit Object Display.

2 Click the Display Properties tab.

3 Select the General display representation.

4 If necessary, click .

5 Scroll to display the Out-of-Date marker component, and click Visible. 

6 Click OK twice.

Updating a Schedule Table

Use this procedure to update the values in a schedule table when the auto-
matic update option is turned off. Always update schedule tables before plot-
ting the drawings that contain them.

When you update a table manually, changes to objects in the table or to 
property set data attached to objects or object styles are shown. Objects 
added to the drawing after creating the schedule table are not included in the 
table unless Add Objects Automatically is specified in the table properties. To 
add objects manually, see “Adding Objects to a Schedule Table” on 
page 2218. To update the numbering in a schedule table, see “Renumbering 
Property Set Data” on page 2220.

NOTE To ensure that the table contains accurate information, close and re-
open your drawing before plotting schedule tables. Certain changes to draw-
ings, such as reference editing, are reflected in schedule tables only when a 
drawing is reopened. 

� Select the schedule table, right-click, and click Update Schedule Table.

Adding Objects to a Schedule Table

Use this procedure to add objects to a schedule table.

1 Select the schedule table, right-click, and click Selection. 

2 Click Add.

3 In the drawing, select the objects to add to the table, and press ENTER
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Use a window or a crossing window to select multiple objects. Objects that 
are already in the table are not added.

NOTE You cannot add objects to a schedule table through RefEdit. Although 
the command appears to work during the RefEdit session, as soon as changes 
are saved back, the rows disappear from the schedule table. This is because you 
are actually selecting temporary copies of the objects in the file. In order to have 
objects that are in an xref or block display in a schedule table, select the xref. To 
include only selected objects from the xref or block, use a layer filter with the 
schedule table.

Removing Objects from a Schedule Table

Use this procedure to remove objects from a schedule table.

1 Select the schedule table, right-click, and click Selection. 

2 Click Remove.

3 In the drawing, select the objects to remove from the table, and press 
ENTER.

Reselecting Objects for a Schedule Table

Use this procedure to reselect objects to include in a schedule table. After 
reselection, the table contains only the objects that you selected.

1 Select the schedule table, right-click, and click Selection. 

2 Click Reselect.

3 In the drawing, select the objects to include in the table, and press ENTER.

Showing Objects in a Schedule Table

Use this procedure to highlight objects that are included in a schedule table.

1 Select the schedule table, right-click, click Selection, and click Show.

2 Select the border of the schedule table to show all the objects in the table, 
or select a specific cell to show only the object contained on that row.

The selected objects are highlighted in the drawing.



2220 | Chapter 30 Schedules

Renumbering Property Set Data

Use this procedure to renumber objects that are included in a schedule or 
linked to schedule tags. You may want to renumber objects if you moved 
them in the building model or if you have deleted objects. Only those prop-
erty definitions with a Type of Auto Increment—Integer or Auto Increment—
Character can be renumbered with this procedure. For more information, see 
“Adding Schedule Tags” on page 2231.

1 Open the tool palette that you want to use, and select the Renumber Data 
tool.

A Renumber Data tool is located with the Scheduling and Reporting Tools 
in the Stock Tool Catalog. You can add this tool to any tool palette. For 
more information, see “Content Browser” on page 171.

2 Select the property set to renumber.

You select the property set that contains the number property. For exam-
ple, if you renumber doors, you select the DoorObjects property set.

3 Select the start number.

4 Select an increment value.

Each number is increased by this amount in the drawing when the prop-
erty set data is renumbered. For example, if the start number is 1 and the 
increment is 3, the sequence would number 1, 4, 7, 10, and so on.

5 Select Attach New Property Set to add a new property set to the numbering 
sequence.

6 Click OK.

7 When prompted with a sequence number, select the object or schedule tag 
to assign that number.

8 Continue renumbering.

9 Press ENTER.

NOTE Under certain circumstances, such as after Renumber Data during 
RefEdit, you may see duplicate property set definition names. For example, the 
property set defintion name may be preceded by “$1$.” Modify these property 
set definitions by opening the attached drawing and making the changes.
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Exporting a Schedule Table

Use this procedure to export the contents of a schedule table to a separate 
file. You can export the data in the following file formats:

� Microsoft® Excel spreadsheet (XLS) files
� Comma-separated values (CSV) files
� Tab-delimited text (TXT) files

NOTE You must have Microsoft Excel installed to export a file to Excel format.

1 Select the schedule table, right-click, and click Export. 

2 Select a file type to Save As.

3 Specify the name of the file to export to, or click Browse to select a file.

4 Select Use Existing Table, and click OK.

NOTE Architectural format (6'-0") is not supported by Microsoft Excel. If 
you export to Microsoft Excel, you are prompted to convert the schedule val-
ues to decimal values or text format in the exported file. The format of values 
does not change in the drawing file.

5 Select the schedule table to export, and press ENTER.

If a file already exists with the name you specified, a warning is displayed 
with the option to overwrite the existing file, specify a unique name, or can-
cel the export command. 

Exporting Schedule Table Data for Selected 
Objects

Use this procedure to export selected property set data from a schedule table 
to a separate file. You can export the data in the following file formats:

� Microsoft® Excel spreadsheet (XLS) files
� Comma-separated values (CSV) files
� Tab-delimited text (TXT) files

NOTE You must have Microsoft Excel installed to export a file to Excel format.
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Using this procedure, you can create a file with property set data for selected 
objects even if the schedule table does not exist in the drawing. To export all 
the data in a schedule table, see “Exporting a Schedule Table” on page 2221.

1 Select the schedule table, right-click, and click Export. 

2 Select a file type to Save As.

3 Specify the name of the file to export to, or click Browse to select a file.

4 Clear Use Existing Table.

5 Select the table style to use in the exported file.

Columns included in the schedule table style determine the property set 
data that is exported for the objects. For more information, see “Creating 
a Schedule Table Style” on page 2271.

6 Select the layer wild card to use as a filter in the exported file.

7 Specify whether to scan for xrefs or block references. 

8 Click OK.

NOTE Architectural format (6'-0") is not supported by Microsoft Excel. If 
you export to Microsoft Excel, you are prompted to convert the schedule val-
ues to decimal values or text format in the exported file. The format of values 
does not change in the drawing file.

9 Select the objects to include in the exported table, and press ENTER.

If a file already exists with the name you specified, a warning is displayed 
with the option to overwrite the existing file, specify a unique name, or can-
cel the export command. 

Specifying the Display Properties of a Schedule 
Table

Use this procedure to change the properties of display components for a 
schedule table:

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale
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To change these display properties for all schedule tables of the same sched-
ule table style, and to see additional information about schedule table display 
components, see “Specifying the Display Properties of a Schedule Table Style” 
on page 2282.

1 Select the schedule table you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation on which to display the changes, and 
select Object Override.

The display representation in bold is the current one.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Changing General Schedule Table Properties

Use this procedure to change general properties of basic schedule table set-
tings on the Design tab of the Properties palette.

1 Double-click the schedule table you want to change.

2 On the Properties palette, expand Basic, and expand General.

3 Specify general properties for the schedule table:

If you want to . . . Then . . .

change the description enter text for Description.

change the layer select Layer.

change the schedule table style select Style.

change the schedule table scale enter a value for Scale.

automatically update the schedule 
table when data in the drawing 
changes

select Yes for Update automatically.

manually update the schedule table 
when the drawing changes

select No for Update automatically.
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NOTE Turning on the automatic update feature may slow drawing perfor-
mance, especially in large drawings. For information about updating sched-
ules manually, see “Updating a Schedule Table” on page 2218.

Changing the Selection Criteria of a Schedule 
Table

Use this procedure to change how objects are added to the schedule table.

1 Double-click the schedule table you want to change.

2 On the Properties palette, expand Basic, and expand Selection.

3 Change how objects are added to the schedule table:

NOTE When adding a schedule table that must scan xrefs or blocks, use a 
layer filter that includes both the name of the layer that contains the xref or 
block, and the name of the layer of the object inside the xref or block. You 
can separate multiple layer wild cards with a comma.

If you want to . . . Then . . .

automatically add new objects to the 
schedule table as they are added to the 
drawing

select Yes for Add new objects 
automatically.

manually add new objects to the 
schedule table

select No for Add new objects 
automatically.

include objects from xref drawings in 
the schedule table

select Yes for Scan xrefs.

exclude objects from xref drawings in 
the schedule table

select No for Scan xrefs.

include objects from block references 
in the schedule table

select Yes for Scan block references.

exclude objects from block references 
in the schedule table

select No for Scan block references.

apply a layer filter to the table specify a layer wild card.
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Changing the Placement of a Schedule Table

Use this procedure to change the rotation, elevation, and location of the 
schedule table.

You can relocate a schedule table by changing the coordinate values of its 
insertion point. The schedule table also has an orientation with respect to the 
WCS or the current UCS. For example, if the top and bottom of the schedule 
table are parallel to the XY plane, its normal is parallel to the Z axis. You can 
change the orientation of the schedule table by aligning its normal with 
another axis. You can also rotate the schedule table on its plane by changing 
the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 

AutoCAD® 2004 User’s Guide.

1 Double-click the schedule table you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Specify the placement of the schedule table:

4 Click Additional information to specify location of the schedule table:

If you want to . . . Then . . .

change the rotation enter a new value for Rotation Angle.

change the elevation enter a new value for Elevation.

If you want to . . . Then . . .

relocate the schedule table enter new coordinate values under Insertion Point.

locate the schedule table 
on the XY plane

make the normal of the schedule table parallel to 
the Z axis: under Normal, enter 1 for Z, and enter 0 
for X and Y. 

locate the schedule table 
on the YZ plane

make the normal of the schedule table parallel to 
the X axis: under Normal, enter 1 for X and enter 0 
for Y and Z. 

locate the schedule table 
on the XZ plane

make the normal of the schedule table parallel to 
the Y axis: under Normal, enter 1 for Y, and enter 0 
for X and Z.
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Changing External Source Properties of a 
Schedule Table

Use this procedure to create a schedule table that contains property data from 
an external drawing such as a project drawing. 

Schedule tables can contain information from external references and block 
references, which typically must exist in the same drawing as the schedule 
table. Optionally, schedule tables can specify an external drawing. The infor-
mation is scheduled as if it were an external reference in the same drawing as 
the table. The advantage is that the graphics of the external drawing do not 
need to be generated in order to fill out the data in the table.

1 Double-click the schedule table you want to change.

2 On the Properties palette, expand Advanced, and expand External Source.

3 Specify the external drawing you want to schedule:

The External drawing property is displayed with a drop-down list contain-
ing all drawings in the View directory of the current project. Each drawing 
corresponds to a View defined in the project. If no project is active, the list 
contains all drawings in the last directory browsed.

Adding Table Breaks to a Schedule Table

Use this procedure to split long tables into a series of shorter pages.

change the rotation of the 
schedule table

enter a new value for Rotation Angle.

If you want to . . . Then . . .

schedule an external drawing select Yes for Schedule external 
drawing. The external drawing 
property is displayed.

not schedule an external drawing select No for Schedule external 
drawing. The external drawing 
property is hidden.

specify the external drawing to 
schedule 

select the name of the drawing for 
External drawing.

If you want to . . . Then . . .
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1 Double-click the schedule table you want to change.

2 On the Properties palette, expand Advanced, and expand Table Breaks.

3 Specify how you want to display the pages of tables:

You can control the height of all pages by setting one value if Manual 
heights is set to No. If the table contains more than one object, select and 
drag the Maximum Page Height grip at the bottom of the table.

You can control the height of each page individually if Manual heights is 
set to Yes. If the table contains more than one object, it will have one 
Insert Page grip at the bottom of the last page and one Page Height grip at 
the bottom of all other pages. Select the Insert Page grip, and drag it up to 
insert a new page. Select a Page Height grip, and drag it up or down to set 
the height of that page. Continuing to drag a Page Height grip down 
reduces the height of the last page, and could possibly remove it.

If you want to . . . Then . . .

display pages horizontally to the right 
of one another

select Right for Direction.

display pages vertically below one 
another

select Down for Direction.

display the title on each page select Yes for Repeat title.

display the column headers on each 
page 

select Yes for Repeat Headers.

hide the column headers on each page select No for Repeat Headers.

control the height of each page 
individually

select Yes for Manual heights.

have all pages approximately the same 
height

select No for Manual heights.

specify the maximum height of each 
page when Manual heights is No

enter a value for Maximum height, or 
select and drag the Maximum Page 
Height grip at the bottom of the table.

specify the distance between each 
page

enter a value for Spacing.
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Adding Documentation Information to a 
ScheduleTable

Use this procedure to add hyperlinks, notes, and reference documents to the 
schedule table.

1 Double-click the schedule table to which to add documentation.

2 On the Properties palette, expand Documentation. 

3 Specify documentation information: 

Identifying and Editing Table Cell Data

Use this procedure to identify table cell data and edit manual property set 
data. Automatic property set data cannot be edited in a schedule table. You 
must edit the object, style, or other data to change the values of automatic 
property data. For more information about property set data, see “Adding 
and Editing Property Set Data” on page 2204.

You can use this procedure to troubleshoot problems between a table cell and 
a source object. If the object is not currently visible in your drawing area, 
press CTRL + SELECT (Zoom to) to display the source object. The changes you 

If you want to . . . Then . . .

add a hyperlink
click . Select the file, and click 
Open.

edit notes 
click , and enter text.

attach a reference document
click . Click Add, and select a file. 
Click Open, and click OK.

edit the reference document attached
click . Select the document, right-
click, and click Edit. Select a new 
document, click Open, and click OK.

edit the description of a reference file
click . Select the description, enter 
the new description, and click OK.

detach a reference file
click . Select the file name, and 
click Remove.
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make to the manual property set data in the table cell are saved with the 
object.

If you are working in a table that schedules a drawing from an external 
source, you cannot edit table cells.

If the schedule table cell references several objects in a quantity cell, Zoom to 
displays an area that includes all the source objects. Hovering over a quantity 
cell highlights the objects counted by that cell.

1 Select the schedule table, right-click, and click Edit Table Cell.

2 Position the cursor over the cell.

The source object is highlighted if it is visible. A tooltip is displayed regard-
less of whether or not the cell can be edited, what type of data is presented 
in the table cell, or any potential problems with the data in that cell. 

Displaying a table cell source object

An external reference icon is displayed if the cell data is from an object in 
an externally referenced drawing. If you edit this cell, the externally refer-
enced drawing is modified. If the drawing is locked by another user, you 
cannot edit it. 
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Displaying a table cell tooltip for externally referenced data

3 Identify the different views:

4 Edit the data in the schedule table:

NOTE Cells that display property set data attached to styles may affect multi-
ple objects. Editing one cell changes the value for all objects of that style in the 
schedule table.

If you want to . . . Then . . .

view all source objects associated with 
the schedule table cell

press CTRL, and select the data in the 
schedule table cell. The drawing 
changes to show the source objects 
associated with the cell.

restore the previous view click Zoom Previous. 

If you want to . . . Then . . .

edit the value in an individual table cell select the individual cell, and enter a 
new value.

edit the value for all instances of a 
property

select the border of the schedule table, 
and enter a value for the selected 
property.
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Adding Property Set Data to All Objects 

Use this procedure to add property set data to all objects in a schedule table 
that have a question mark (?) in a cell. If a table column requires property 
data from an object before it can add information to the cells, and the prop-
erty set containing that property data has not been attached to the object, a 
question mark (?) is typically shown in the cell. You can attach these property 
sets individually, as described in “Identifying and Editing Table Cell Data” on 
page 2228, or you can attach the property sets to all of the objects at once.

� Select the schedule table, right-click, and click Add All Property Sets.

NOTE If you are working in a table that schedules an external drawing, you 
cannot add property sets to those objects. For more information, see “Changing 
External Source Properties of a Schedule Table” on page 2226.

Adding Schedule Tags

Schedule tags are symbols that connect building model components with 
lines of data in a schedule. Schedule tags usually display data about the 
objects to which they are attached.

To add a tag, you anchor it to an object in your drawing. Each tag is a multi-
view block with attributes. Values from the property set data of the object can 
be transferred to the tag attributes if, when the tag is anchored, the tag 
attributes are named.

PropertySetDefName:PropertyDefName
For example:

DoorStyles:DoorHeight

NOTE Attribute definition tags cannot have extended names (names that con-
tain spaces). If you use extended names for your property set definitions or your 
property definitions, you are not able to display those objects automatically 
through the use of a tag anchor. 

Because tag attributes are linked to property set data, the tag attributes 
change when the property set data changes. For example, the number dis-
played in a door tag associated with a door is updated when the number 
property of the door is renumbered. To edit the information that displays in 
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the tag, edit the property set data. For more information, see “Entering Man-
ual Properties for Objects” on page 2206.

The software includes predefined tags, and you can also create your own tags. 
For more information, see “Custom Tags” on page 2237.

If you want to tag multiple objects, you can do that after you tag a single 
object. The placement of the first tag relative to the object you are tagging is 
used to determine the placement of subsequent tags. 

� For walls, the tag (or the end of its leader) is positioned relative to the mid-
point of the wall.

� For spaces, the tag (or the end of its leader) is positioned relative to the 
center of the geometric extents of the space. 

� For all other objects, a tag with a leader is placed with the end of the leader 
at the geometric center of the object. Tags without leaders are placed at the 
same distance and direction as the first tag, relative to the center of the 
object.

Select one object at a time when using the multiple tag option in order to 
control the numbering sequence of the tags. The sequence of auto-incre-
menting is undefined if you use a window or another multiple selection tool.

NOTE When you insert schedule tags into drawings, use the appropriate base 
units for the tag to match the drawing scale properly. 

Related Procedures

� Displaying Property Set Data When You Add a Tag

� Adding Door and Window Tags

� Adding Object Tags

� Adding Room Finish, Room, Space, and Wall Tags

� Anchoring a Tag to an Object

� Releasing an Anchored Tag

� Viewing the Relationship Between Schedule Tags and Objects

� Custom Tags

� Creating a Tag and Multi-View Block

� Adding a Custom Tag to the DesignCenter
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Displaying Property Set Data When You Add a 
Tag

Use this procedure to enter or edit property set data when you attach a sched-
ule tag to an object.

When you anchor a tag to an object, you can display the property set data 
that is attached to the object. Depending on the property set definitions that 
are attached to the object, you can immediately edit or enter property set 
data.

NOTE If you are adding tags that contain only automatic properties, it is more 
efficient to turn off this option.

1 At the command line, right-click, and click Options.

2 Click the AEC Content tab.

3 Select Display Edit Property Data Dialog During Tag Insertion.

4 Click OK.

Adding Door and Window Tags

Use this procedure to attach schedule tags to doors and windows. Autodesk® 
Architectural Desktop contains a number of predefined door and window 
tags.

1 Open the tool palette that you want to use, and select a door or window 
tag tool.

Door and window tag tools are located on the Custom tab in Design-
Center. You can add these tools to any tool palette. For more information, 
see “DesignCenter” in the AutoCAD® 2004 User’s Guide.

2 Change the tag symbol and add a leader, if necessary: 

If you want to . . . Then . . .

change the tag symbol enter s (Symbol).

add a leader to the symbol enter l (Leader).

change the dimension style used to 
create the leader

enter d (Dimension Style).
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3 Select the door or window to which to attach the tag.

4 Specify the location of the tag.

5 If prompted, enter or edit property set data for the door or window. 

If property set data is not yet attached to the object, and an appropriate 
property set is defined in the current drawing or in the PropertySetDefs.dwg 
file in C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 2004\R16.0\enu\AEC Con-
tent\Imperial or Metric\Documentation\Schedule Tags, you can attach that 
information to the door or window. For more information about property 
sets, see “Property Set Definitions” on page 2241.

6 Press m to add tags to multiple doors or windows.

7 Continue adding tags.

8 Press ENTER.

Adding Object Tags

Use this procedure to attach an object tag to a block reference or a multi-view 
block reference. The software contains a number of predefined object tags. 

1 Open the tool palette that you want to use, and select an object tag tool.

Object tag tools are located on the Custom tab in DesignCenter. You can 
add these tools to any tool palette. For more information, see “Design-
Center” in the AutoCAD® 2004 User’s Guide.

2 Change the tag symbol and add a leader, if necessary:

3 Select the object to which to attach the tag.

4 Specify the location of the tag.

NOTE Different object tags may have different prompts. The steps below 
may not correspond directly to those for the object tag you are placing.

If you want to . . . Then . . .

change the tag symbol enter s (Symbol).

add a leader to the symbol enter l (Leader).

change the dimension style used to 
create the leader

enter d (Dimension Style).
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5 If prompted, enter or edit property set data for the object.

If property set data is not yet attached to the object, and an appropriate 
property set is defined in the current drawing or in the PropertySetDefs.dwg 
file in C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 2004\R16.0\enu\AEC Con-
tent\Imperial or Metric\Documentation\Schedule Tags, you can attach that 
information to the object. For more information about property sets, see 
“Property Set Definitions” on page 2241.

6 Press m to add tags to multiple blocks or references.

7 Continue adding tags.

8 Press ENTER.

Adding Room Finish, Room, Space, and Wall Tags

Use this procedure to attach room finish, room, and space tags to spaces. The 
software contains a number of predefined tags. 

1 Open the tool palette that you want to use, and select an object tag tool.

Spacetag tools are located on the Custom tab in DesignCenter. You can 
add these tools to any tool palette. For more information, see “Design-
Center” in the AutoCAD® 2004 User’s Guide.

2 Change the tag symbol and add a leader, if necessary:

3 Select the space to which to attach the tag.

4 Specify the location of the tag.

NOTE Different tags may have different prompts. The steps below may not 
correspond directly to those for the tag you are placing.

5 If prompted, enter or edit property set data.

If you want to . . . Then . . .

change the tag symbol enter s (Symbol).

add a leader to the symbol enter l (Leader).

change the dimension style used to 
create the leader

enter d (Dimension Style).
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If property set data is not yet attached, and an appropriate property set is 
defined in the current drawing or in the PropertySetDefs.dwg file in C:\Doc-
uments and Settings\All Users\Application Data\Autodesk\Autodesk Architec-
tural Desktop 2004\R16.0\enu\AEC Content\Imperial or Metric\Documenta-
tion\Schedule Tags, you can attach that information to the space. For more 
information about property sets, see “Property Set Definitions” on 
page 2241.

6 Press m to add tags to multiple rooms or room finishes.

7 Continue adding tags.

8 Press ENTER.

Anchoring a Tag to an Object

Use this procedure to anchor an existing schedule tag to an object or re-
anchor a tag to a new object.

If you copy a tag from one object to another, the tag remains anchored to the 
original object. Use this procedure to re-anchor the tag to the new object. 

NOTE You can view the current relationship between schedule tags and 
objects. For more information, see “Viewing the Relationship Between Schedule 
Tags and Objects” on page 2236.

1 Select a tag, right-click, and click Tag Anchor. 

2 Click Set Object.

3 Select an object to which to anchor the tag.

Releasing an Anchored Tag

Use this procedure to release a tag that is anchored to an object. After you 
release the tag, you can re-anchor it to another object.

1 Select the anchored tag, right-click, and click Tag Anchor. 

2 Click Release.

Viewing the Relationship Between Schedule Tags 
and Objects

Use this procedure to turn on the General display representation for Anchor 
Tag To Entity in the current view. If you have many tags and are not sure of 
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their attachments, use this feature to view the current relationship between 
schedule tags and objects.

Viewing the relationship between a door tag and a door

1 On the Format menu, click the Display Manager.

2 Expand Sets.

3 Select the current display set. 

The current display set appears in bold in the list under Sets.

4 Click the Display Representation Control tab.

5 In the Objects list, locate Anchor Tag To Entity, and select the General dis-
play representation for this object.

6 Click OK.

7 Regenerate the drawing, if necessary. 

The schedule tag is connected to the object to which it is anchored by an 
arc. The tag and object are attached from insertion point to insertion 
point.

Custom Tags

You can create custom tags that display property set data about objects. 

First, you determine the object that you intend to tag, and the information 
to display inside the tag. Next, you create or identify a property set definition 
for the object. The property set definition must contain the property or prop-
erties for the information that displays in the tag. 

Then, you create the tag geometry and save it as a block with one or more 
attributes. You must assign each attribute a unique name, formed from a 
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combination of the name of the property set definition and the property def-
inition to which you will link the tag. The name looks like this:

PropertySetDefName:PropertyDefName
Use the tag block to create a multi-view block and add it to the DesignCenter 
using the AEC Content Wizard. When the tag is anchored to objects to which 
the property set definition applies, the tag displays the property value as the 
value of its tag attribute.

Creating a custom tag

For example, you have a property set definition named DoorProps, which 
contains a property definition named FireRating. The FireRating property 
contains fire rating information for door objects. To create a door tag that dis-
plays the fire rating of a door to which the tag is anchored, you must create 
a block definition that contains an attribute definition whose attribute tag is 
DoorProps:FireRating. You then create a multi-view block definition. 

Related Procedures

� Creating a Tag and Multi-View Block

� Adding a Custom Tag to the DesignCenter

Creating a Tag and Multi-View Block

Use this procedure to create a block for the custom tag and to create a multi-
view block from the tag block.
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NOTE Attribute definitions tags cannot have extended names (names that 
contain spaces). If you use extended names for property set definitions or prop-
erty definitions, you are not able to display those objects automatically through 
the use of a tag anchor.

1 Identify or create a property set definition with the property definitions 
that you want to display in the tag.

For more information, see “Property Set Definitions” on page 2241.

2 Save the property set definition in PropertySetDefs.dwg, located in C:\Doc-
uments and Settings\All Users\Application Data\Autodesk\Autodesk Architec-
tural Desktop 2004\R16.0\enu\AEC Content\Imperial or Metric\Documenta-
tion\Schedule Tags.

3 Start a new drawing, and create the tag geometry.

4 On the Format menu, click Blocks ➤ Define Attributes to define an 
attribute name for the tag.

5 Under Attribute, enter the property set definition and property definition 
that you want to display in the tag for Tag.

The tag must be defined in the format: 

PropertySetDefName:PropertyDefName
Defining an attribute for a custom tag

6 Specify values for the prompt, value, height, and justification, and click 
OK.

7 On the Format menu, click Blocks ➤ Block Definition.
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8 Enter a name for the block, and use the Select Objects button to define the 
objects in it. Click OK.

9 Create a multi-view block from the tag block. 

For more information, see “Creating Multi-View Block Definitions” on 
page 2483. 

10 Add the multi-view block to the DesignCenter. 

For more information, see “Adding a Custom Tag to the DesignCenter” on 
page 2240.

Adding a Custom Tag to the DesignCenter

Use this procedure to add to the DesignCenter a multi-view block defined for 
a custom tag. You can then use the tag in any of your drawings.

1 Create the custom tag as described in “Creating a Tag and Multi-View 
Block” on page 2238.

2 On the Format menu, click AEC Content Wizard.

3 Select Custom Command for Content Type.

4 Select the block and multi-view block under Current Drawing, and click 
Add.

5 Link the tag to a property set definition by entering the following for 
Command String: 

_AecAnnoScheduleTagAdd PropertySetDefsDwg_Symbol TagName
_LEADER None _DIMSTYLE Current

where TagName is replaced with the name of the multi-view block and 
PropertySetDefDwgName is the name of a drawing file containing the prop-
erty set definitions used in the tag. The search order for this drawing is as 
follows:

1. The directory in which the tag drawing is located

2. The parent directory of that directory

3. The current directory 

4. The directory that contains the current drawing file

5. The directories specified in Options: Files: Support File Search Path

6. The directory that contains the AutoCAD program files 

You can specify a leader then you insert the symbol and specify a different 
dimension style for the leader by changing the value listed after LEADER 
and DIMSTYLE in the command string.

6 Click Next, and specify the Insertion Options. 
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For more information, see “Creating an AEC Custom Command” on 
page 2353. 

7 Click Next, and click OK to exit the AEC Content Wizard.

You can now use the DesignCenter to add the custom tag to objects in 
your drawing.

Property Set Definitions

A property set definition specifies the characteristics of a group of properties 
that can be tracked with an object. For example, you could create a property 
set definition named DoorProps that contains property definitions for Door-
Number, DoorWidth, and FireRating. Each property has a name, description, 
data type, data format, and default value. 

Property Sets and Property Data
A property set is an object created from a property set definition. It contains 
a user-definable group of related object properties. When you attach a prop-
erty set to an object or a style, the property set becomes the container for the 
property data associated with the object.

Creating Property Set Definitions for Objects or Styles
When you create a property set definition, you specify whether the property 
set created from the definition can be attached to objects or to styles. The 
kinds of properties you want to track should determine whether the property 
set applies to objects or styles.

� Automatic properties generally belong in style-based definitions. Auto-
matic properties, even when attached to a style, can vary for each instance 
of the object. It is more efficient to include automatic properties in a style-
based definition because the properties are immediately associated with 
any object that uses the style.

� Manual properties can belong to either style-based or object-based defini-
tions. The value of a manual property associated with a style is the same 
for every object. For example, a Manufacturer property will probably be 
the same for every instance of a particular door style, so it should be in a 
style-based property. However, a Door Number property is different for 
each instance of a door, so it should be in an object-based property.

Automatic and Manual Properties Definitions
Property sets, whether attached to objects or to styles, can include both man-
ual and automatic properties.
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� Automatic properties cannot be edited directly, but are obtained directly 
from the object or other source. For example, the physical characteristics 
of an object, such as its dimensions, or the classification or material of an 
object, are automatic properties. To change the value of an automatic 
property, you must modify its source. The change then appears in the 
property set data for the object. 

� Manual properties must be edited directly in the property set data for the 
object or style. For example, the object number (for tagging) and notes or 
remarks are manual properties. The value entered for a manual property 
in an object-based property set is saved with the object. The value entered 
for a manual property in a style-based property set is saved with the style 
and is available to all objects using that style.

Using Property Data Formats in Property Set Definitions
Property data formats determine the format of numbers and text for property 
values. Both property set definitions and schedule table styles use property 
data formats. The drawing must contain the property data formats you want 
to use before you create a property set definition. For more information 
about creating property data formats, see “Property Data Formats” on 
page 2284.

Managing Property Set Definitions
To create, edit, copy, or purge property set definitions, you access the Style 
Manager. The Style Manager provides a central location where you can work 
with definitions and styles from multiple drawings and templates. For more 
information about using the Style Manager, see “Style Manager” on 
page 531.

WARNING! If you overwrite one property set definition with another, you 
may lose data. For example, a drawing might contain a property set definition 
with a number of manual properties. The property set is attached to doors with 
the manual properties entered, and is included in a schedule table. If you over-
write this property set definition with one that does not have the same proper-
ties, the values entered for the manual properties are lost. In addition, any col-
umns in the schedule table that reference these manual properties are flagged 
as invalid. Changes to the schedule table that result from changes to the prop-
erty set definition are displayed the next time the tables are updated manually 
or automatically.

Related Topics and Procedures

� Creating a Property Set Definition

� Attaching Notes or Reference Files to a Property Set Definition
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� Specifying How the Property Set Definition is Applied

� Adding a Manual Property Definition to a Property Set Definition

� Adding an Automatic Property Definition to a Property Set Definition

� Adding a Formula Property Definition to a Property Set Definition

� Adding a Location Property Definition to a Property Set Definition

� Adding a Classification Property Definition to a Property Set Definition

� Adding a Material Property Definition to a Property Set Definition

� Adding a Project Property Definition to a Property Set Definition

� Editing a Property Set Definition

� Removing All Property Sets from Objects and Styles

� Merging Property Set Definitions

Understanding Automatic Properties

The data in an automatic property is obtained from individual objects or 
their styles and is not entered manually. For example, a number of doors 
might have the same style but different widths. A Width automatic property 
may be different for each door. However, those doors have the same thick-
ness, because thickness is a property of the style. A Thickness automatic prop-
erty has the same value for all doors of the same style. For more information, 
see “Adding an Automatic Property Definition to a Property Set Definition” 
on page 2252.

More than a thousand automatic properties are available in Autodesk® Archi-
tectural Desktop. Most are self-explanatory, but a few need additional expla-
nation.

Related Topics

� Wall Area Properties

� Wall Volume Properties

� Wall Length Property

� Slab and Roof Slab Elevation Properties

� Door Size Properties

� Door Swing Direction Properties

� Structural Member Length Property

Wall Area Properties
Four automatic properties provide data for wall area calculations:

� Area—Right Gross
� Area—Right Net
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� Area—Left Gross
� Area—Left Net

The right and left sides of a wall are determined as if you were standing on 
the start point of the wall and facing the endpoint. Gross area is the area of 
one side without allowing for holes for openings such as doors and windows. 
Net Area is the area of one side of a wall after cutting holes for openings. 
Gross Area might be used to determine the quantity of gypsum board needed 
for a wall, while Net Area might be used to determine the quantity of brick.

WARNING! The area of a wall is determined by adding the union of the wall 
components (not including body modifiers or interferences) to the area of all 
faces that point to the right (for right areas) or the left (for left areas). If a partic-
ular wall style has multiple components with air space between them, the wall 
area is probably not reported as expected. For example, a wall typically used in 
construction has a brick exterior, an air space, and a CMU interior. A style defined 
for this wall might have a component for the brick and a component for the 
CMU, but no component for the air space. If the wall was drawn with the brick 
on the left side, the wall area computed for the right side would include the right 
face of the CMU as well as the right face of the brick. The area reported would 
be twice the actual area. To avoid this situation, create components for interior 
air spaces in wall styles, so that no interior faces exist when the wall components 
are unioned.

A wall can take a variety of shapes by adding or subtracting body modifiers, 
or by replacing the wall with body modifiers. Automatically calculating 
appropriate areas for every possible wall shape is next to impossible. Because 
of this, body modifiers and interferences are not currently included in wall 
area calculations. Wall areas for unusually shaped walls must be computed 
manually. 

Wall Volume Properties
Four automatic properties provide data for wall volume calculations:

� Volume—Gross
� Volume—Net
� Volume—Gross With Mods
� Volume—Net With Mods

Gross volume is the volume of wall components without allowing for holes 
for openings such as doors or windows. Net volume is the volume after cut-
ting holes for openings.

You can obtain the wall volume with or without wall body modifiers.
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� Gross and net show the volume of the wall components as if no body 
modifiers exist.

� Gross With Mods and Net With Mods include body modifiers.

Wall Length Property
A wall can take a variety of shapes by adding or subtracting body modifiers, 
or by replacing the wall with body modifiers. Automatically calculating the 
appropriate length for every possible wall shape is next to impossible. 
Because of this, the Wall Length property returns only the distance between 
the start point and endpoint of the wall. To get a more accurate report for the 
length of a wall, you may have to reposition the endpoint of the wall.

The visible length of a wall may be different than the distance between the 
endpoints due to wall cleanups.

Slab and Roof Slab Volume Properties
Volumes for slabs and roof slabs do not include the volumes of fascias or sof-
fits.

Slab and Roof Slab Elevation Properties
Two elevation properties exist for slabs and roof slabs:

� Elevation—High
� Elevation—Low

These properties provide the highest and lowest value of all slab and roof slab 
vertices, including fascias and soffits.

Door Size Properties
In addition to the separate dimension properties of Width, Height, and 
Thickness, these values can be combined in three additional properties. The 
table below shows how Door Size properties appear for a number of different 
doors, each with a width of 3'-0", a height of 6'-8", and a thickness of 2", but 
differing the in number and size of individual door panels.

Property Single 
Door

Double Door Uneven Door

Door Size - W x H 3'-0”x6'-8" 3'-0”x6'-8" 3'-0”x6'-8"

Door Size - 2 @ W x H 3'-0”x6'-8" 2@1'-6"x 6'-8" 2'-0"(1'-0")x6'-8"

Door Size - PR W x H 3'-0”x6'-8" PR 1'-6"x 6'-8" 2'-0"(1'-0")x6'-8"
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NOTE Try using a formula property definition if you need more control in for-
matting multiple door size properties. For more information, see “Adding a For-
mula Property Definition to a Property Set Definition” on page 2254.

Door Swing Direction Properties
Different countries have different conventions for specifying the swing direc-
tion of a door. For example, the door shown in the next illustration is con-
sidered a left-swinging door in the United States and Great Britain. It is con-
sidered a right-swinging door in Australia, Russia, and most of Europe. To 
accommodate these differences, a property called Swing Direction - Reverse 
has been added. You can select the door swing property you want to use 
when you create or modify a property set definition.

Determining the swing direction of a door 

Structural Member Length Property
The length of a structural member is its logical length—which is the length 
between its grip points. It is not the actual length, which can be difficult to 
compute. Structural members with offsets and cut planes give a visible length 
that is different from the logical length.

Evaluating Formulas

A property set using the property set definition that contains the formula is 
added to an object or style in the usual manner. When the value of the for-
mula property is needed by a schedule table or schedule tag, the process used 
to determine that value is as follows:

� The value of the property using each property definition in the formula is 
retrieved from the object or style. It is inserted into the formula in place 
of the property definition name and the brackets surrounding it. 
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NOTE Make sure that all property sets used in the formula have been 
applied to the object or style. Otherwise, a question mark (?) is displayed 
instead.

� If the formula string contains the word “RESULT,” it is evaluated as a 
VBScript function, and the value displayed for the property is the result of 
that evaluation.

� If the formula string  does not contain the word “RESULT,” it is evaluated 
as a mathematical expression.

For more information, see “Adding a Formula Property Definition to a 
Property Set Definition” on page 2254.

Creating a Property Set Definition

Use this procedure to create a property set definition. You can create a new 
empty property set definition by copying an existing definition. You then 
edit the definition properties to customize the characteristics of the defini-
tion. For more information, see “Editing a Property Set Definition” on 
page 2265.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Create a property set definition:

NOTE If this property set definition will be used with schedule tags, do not 
enter spaces in the name.

If you want to . . . Then . . .

create an empty property 
set definition with default 
properties

right-click the style or definition, and click New. 
Enter a name for the new property set definition, 
and press ENTER.

create a property set 
definition from an existing 
property set definition

right-click the property set definition to copy, and 
click Copy. Right-click, and click Paste. Right-click 
the new property set definition, and click Rename. 
Enter a name, and press ENTER.
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4 Click OK.

Attaching Notes or Reference Files to a Property 
Set Definition

Use this procedure to enter notes and attach reference files to a property set 
definition. You can also edit notes and edit or detach reference files from a 
property set definition.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition to which to attach notes or reference 
files, right-click, and click Edit.

4 Click the General tab.

5 To add a description to the property set definition, enter it for Description.

6 To add a note, click Notes, click the Notes tab, and enter the note.

7 Click Notes, click the Reference Docs tab, and attach, edit, or detach a ref-
erence file:

8 Click OK three times.

Specifying How the Property Set Definition is 
Applied

Use this procedure to specify whether a property set definition applies to 
objects or to styles and definitions. You also select the objects or the styles 
and definitions that can use the property sets created from this definition.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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If the property set that you define contains properties that are the same for 
all objects created using a specific style, select a style-based property set. This 
eliminates the need to attach data for each instance of the object that you 
create. Objects created using the style with the property set assigned have 
access to the associated style-based property set.

In general, use automatic properties only within property set definitions that 
are applied to styles or definitions.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition that you want to change, right-click, and 
click Edit.

4 Click the Applies To tab.

5 Specify how the property set definition is applied:

6 Select the objects or the styles and definitions to which the property set 
applies.

If you want to . . . Then . . .

apply the property set definition to 
objects

select Objects. The list of objects 
becomes available.

apply the property set definition to 
styles and definitions

select Styles and Definitions. The list of 
styles and definitions becomes 
available.

If you want to . . . Then . . .

define an object-based property set 
definition

select the objects from the list in the 
left pane.

define a style- or definition-based 
property set definition

select the styles or definitions from the 
list in the right pane.

select all objects or style and 
definitions 

click Select All.

clear the current selections click Clear All.
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By default, all object types are selected. If all the objects or none of the 
objects are selected, your property set definition can be added to any 
object type. The area above the list displays the objects that are currently 
selected.

7 To specify classification criteria, expand a classification definition, and 
select one or more classifications.

For example, you can select a construction status of New and two pre-
ferred vendors. To meet the criteria, the classification in the object style 
must be New for construction status and the Vendor classification must be 
one of the two vendors selected.

Specifying multiple classification criteria in a property set definition

All classification definitions that apply to the same objects to which the 
property set definition applies are displayed on the right with a list of their 
classifications. If classifications are selected, the property set definition 
can be applied only to those objects or styles and definitions selected on 
the left that have all the classifications selected on the right.

8 Click OK twice.
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Adding a Manual Property Definition to a 
Property Set Definition

Use this procedure to add a manual property definition to a property set def-
inition. Manual properties are those that must be entered rather than 
obtained directly from the object.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition for which to add a manual property, 
right-click, and click Edit.

4 Click the Definition tab.

5 Click .

6 Enter the Name for the property. 

NOTE If this property will be used with schedule tags, do not enter spaces 
in the property name.

7 To define a property by using existing properties, select a property from 
the Start With list.

8 Click OK.

9 Enter a short description of the property. 

The default description is the same as the property definition name. This 
text is for a column header in a schedule table that uses this property.

NOTE The description does not change if you edit the property name. You 
can edit the description.

10 Specify the type of data the property contains. 

Changing the data type of a definition for property data already stored in 
the drawing will set the data to the default value, possibly removing data 
previously edited.

For property definitions to be displayed in a matrix column in a schedule 
table, you can assign multiple values to the same property by using a text 
data type and separating the values with semicolons. Each value will be 
displayed in a separate matrix column. 



2252 | Chapter 30 Schedules

11 Enter a default value.

When a property set is attached to an object, manual properties are set to 
their default values. These values are used in the example fields and as 
example data for schedule table columns.

NOTE If you create a manual property, it is helpful to enter neutral charac-
ters, such as “--,” as the default value. When you create a schedule table, the 
characters fill the cells for which you have not entered values. You can edit 
the characters in each cell later. If you leave the default value blank in the 
property set definition, the corresponding cells are blank. You cannot select 
and edit blank cells.

12 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

13 Continue adding manual properties as necessary.

14 Click OK twice.

NOTE When you attach property set data to an xref drawing or block using 
RefEdit and the property set includes Auto Increment—Integer or Auto Incre-
ment—Character, then you must set the default value to the first number to be 
used in the xref or block to avoid creating duplicate numbers.

Adding an Automatic Property Definition to a 
Property Set Definition

Use this procedure to add an automatic property definition to a property set 
definition. The values for automatic properties are obtained directly from an 
object or its style. For general information about automatic properties and 
additional explanation about some properties for walls, slabs, roof slabs, 
doors, and structural members, see “Understanding Automatic Properties” 
on page 2243.
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NOTE Ensure that the property data formats you want to use are stored in the 
current drawing. For more information, see “Creating a Property Data Format” 
on page 2285.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition for which to change, right-click, and 
click Edit.

4 Click the Definition tab.

5 Click .

6 Select one property for each object to which the property set definition 
applies. 

For example, if the definition applies to windows and window assemblies, 
you can select the Width property for windows and the Width property 
for window assemblies. A warning is displayed if you select different prop-
erties from different object types. If a property is not selected for an object, 
a question mark (?) is displayed as the value for that object.

NOTE If the property set definition applies to only one object, you can cre-
ate multiple automatic property definitions at the same time by selecting 
multiple items in the list. If the property set definition applies to more than 
one object, you can only create one property definition at a time. Typically, 
you would like to select items with the same name for every object the prop-
erty set definition applies to. Selecting or clearing an item for one object 
selects or clears items with the same name for all other objects. You can con-
trol the selection of individual items by pressing CTRL.

7 Click OK. 

If you want to change the name of the property definition, select Name to 
make changes.

8 Enter a short description of the property definition. 

The default description is the same as the property definition name. It is 
the default text for a column header in a schedule table that uses this 
property.
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NOTE The description does not change if you edit the property name. You 
can edit the description.

9 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

10 Click OK twice.

NOTE If you double-click on a drawing to open it, and Autodesk Architectural 
Desktop is not running, you may not be successful. Drawings that include a 
schedule table which lists the hyperlink for an object will cause this effect. If 
Autodesk Architectural Desktop is running when you double-click, this will not 
occur.

Adding a Formula Property Definition to a 
Property Set Definition

Use this procedure to add a formula property definition to a property set def-
inition. Formula property values are computed based on the values of other 
property data. For more information about how a formula is evaluated, see 
“Evaluating Formulas” on page 2246.

For example, width and height are automatic door properties, which you can 
use to compute the perimeter of the door. Defining (2 * [Width]) + (2 * 
[Height]) as a formula for a 36" x 84" door results in a value of 240. A formula 
property definition is a type of automatic property, because the value it dis-
plays is determined automatically, based on its definition, and cannot be 
edited directly. 

Formulas can be simple mathematical expressions, such as 2+2. They can also 
contain variables, operators, and functions allowed in VBScript, as shown in 
these examples.

Statements

Call Statement For Each...Next 
Statement

Property Get 
Statement

Set Statement
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Class Statement For...Next 
Statement

Property Let 
Statement

Sub Statement

Const 
Statement

Funtion 
Statement

Property Set 
Statement

While...Wend 
Statement

Dim Statement If...Then...Else 
Statement

Public Statement Set Statement

Do...Loop 
Statement

On Error 
Statement

Randomize 
Statement

With Statement

Erase Statement Option Explicit 
Statement

ReDim 
Statement

Execute 
Statement

Private 
Statement

Select Case 
Statement

Functions

Abs Escape LBound ScriptEngineMinor
Version

Array Eval LCase Second

Asc Exp Left SetLocale

Atn Filter Len Sgn

CBool FormatCurren
cy

LoadPicture Sin

CByte FormatDateTi
me

Log Space

CCur FormatNumbe
r

LTrim Split

CDate FormatPercent Maths Sqr

CDbl GetLocale Mid StrComp

Chr GetObject Minute String

CInt GetRef Month Tan

CLng Hex MonthName Time

Statements
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More detailed information about VBScript is available at http://
msdn.microsoft.com.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition for which to change, right-click, and 
click Edit.

4 Click the Definition tab.

5 Click .

6 Enter a name for the formula property.

7 Clear Use formula for description if you do not want to use the formula as 
the description of the property.

Conversions Hour MsgBox Timer

Cos InputBox Now TimeSerial

CreateObject InStr Oct TimeValue

CSng InStrRev Replace Trim

Date Int, Fix RGB TypeName

DateAdd IsArray RTrim UBound

DateDiff IsDate Right UCase

DatePart IsEmpty Rnd Unescape

DateSerial IsNull Round VarType

DateValue IsNumeric ScriptEngine Weekday

Day IsObject ScriptEngineBuild
Version

WeekdayName

Derived 
Math

Join ScriptEngineMajor
Version

Year

Functions
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8 Enter the formula:

Select components of the formula from the property definitions listed.

The property definitions available for use in the formula can be applied to 
the same objects as the property set definition containing the formula.

The names of property definitions used in the formula are displayed in 
bold and within brackets, such as [Width]. If a property definition belongs 
to a property set definition other than the one containing the formula, 
that name is displayed as well, such as [DoorObjects:Height].

The formula property definition cannot be used in the formula it defines, 

as indicated by the  and the addition of [Self] after its name. Property 
definitions that end up using the value of the formula cannot be used in 

the formula, as indicated by the  and the addition of [Circular Refer-
ence] after their names.

NOTE Typing the name of a property definition directly in the formula 
string, or copying and pasting between formulas, does not work as expected. 
In these cases the property definition is displayed with normal text, not bold 
text. For property values to be inserted correctly, they must be selected from 
the list.

9 Click OK. 

If you want to . . . Then . . .

enter text click to select an insertion point and 
type.

enter one of the operators click one of the buttons under the edit 
box.

surround text with parentheses or 
quotes

select the text to be surrounded and 
click the () or ““ under the edit box.

use the value of another property 
definition in the formula

select the definition in the Property 
Definitions list.

evaluate the formula as a VBScript 
function

enter RESULT anywhere in the 
formula.
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To change the name of the property definition, click Name and double-
click the property definition in the table, or select Edit Formula. If Use for-
mula for description is not set, edit the description.

10 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

11 Click OK twice.

Adding a Location Property Definition to a 
Property Set Definition

Use this procedure to add a location property definition to a property set def-
inition. Location property values are obtained from property data on AEC 
polygons, areas, or spaces in or near an object. When a selected object has a 
property set that contains a location property, a Data Location grip is dis-
played along with its other grips. If the location property is defined to 
retrieve property data from an area object; for example, if the property data 
comes from the area underneath the grip, when the object is moved, the grip 
moves. If an MvBlock representing a piece of furniture is moved from one 
area to another, it has access to the area’s property data, which might include 
the occupant of a room.

A location property definition is a type of automatic property, because the 
value it displays is determined automatically, based on its definition, and 
cannot be edited directly. To create a location property definition, you select 
a property definition contained in a property set definition that can be 
applied to AEC polygon, area, or space objects.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition that you want to change, right-click, and 
click Edit.

4 Click the Definition tab.

5 Click .



Property Set Definitions | 2259

6 Enter a name for the location property.

7 Clear Use property name for description if you do not want to use the 
location property as the description of the property.

8 Expand AEC Polygon, Area, or Space.

9 Expand a property set definition.

10 Select the property data you wish to retrieve.

11 Click OK. 

To change the name of the property definition, click Name and double-
click the property definition in the table, or select Edit Location. If Use 
property name for description is not set, edit the description.

12 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

13 Click OK twice.

Adding a Classification Property Definition to a 
Property Set Definition

Use this procedure to add a classification or its properties to a property set 
definition. Including classifications or classification properties in a property 
set definition used for schedules enables you to report classification data for 
the objects in a schedule.

For example, if you have a classification definition for vendors, you can spec-
ify the vendor for different object styles. You can then include the vendor 
classification or its properties in a property set definition for those object 
styles. You can use the classification properties in a schedule table for the 
objects.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Property Set Definitions.

3 Right-click the property set definition that you want to change, and click 
Edit.

For example, if you want to include classifications in a door schedule, 
select a property set definition that applies to door styles.

4 Click the Definition tab.
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5 Click .

The Classification Property Definition dialog box is displayed. The pane 
on the left lists classification definitions that apply to the object style for 
the current property set definition. For example, if the current property set 
definition applies to door styles, the Classification Definition lists all the 
classification definitions that apply to door styles.

The pane on the right lists all the property sets that apply to classification 
definitions.

Example of the Classification Property Definition dialog box with default settings

6 Enter a name for the property.

The name identifies the property in the property set definition.

7 Clear Use classification name for description if you do not want to use the 
classification name for the description of the property.

By default, schedule table styles use the description for the column head-
ing. The default description for classification properties comprises the 
names of the classification definition, the property set definition, and the 
property (such as Vendor - Vendor Class - Delivery Date).
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8 Select the classification or the classification property to add to the prop-
erty set:

Selecting a classification property

9 Click OK. 

 To change the name of the property definition, click Name, and double-
click the property definition in the table, or select Edit Classification. If 
Use classification name for description is not set, edit the description.

10 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

11 Click OK twice.

If you want to . . . Then . . .

include the value specified 
for each object for a 
classification definition

in the left pane, select the classification definition.

include the value of a 
property that is attached 
to a classification

in the left pane, select the classification. In the right 
pane, select Classification Property, expand the 
property set, and select the property. 
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Adding a Material Property Definition to a 
Property Set Definition

Use this procedure to add a material property definition to a property set def-
inition. Material property values are obtained from an object’s component 
materials or from property data specified for an object’s component materi-
als.

A material property definition is a type of automatic property, because the 
value it displays is determined automatically, based on its definition, and 
cannot be edited directly.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition that you want to change, right-click, and 
click Edit.

4 Click the Definition tab.

5 Click .

6 Enter a name for the material property.

7 Clear Use material name for description if you do not want to use the 
material property as the description of the property.

8 Select a material:

9 Click OK. 

 To change the name of the property definition, click Name, and double-
click the property definition in the table, or select Edit Material. If Use 
material name for description is not set, edit the description.

If you want to . . . Then . . .

retrieve the name of a material 
specified for a component on an object 
or style

clear Material Property.

retrieve property data for the material 
specified for a component on an object 
or style

select Material Property.
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10 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

11 Click OK twice.

Adding a Project Property Definition to a 
Property Set Definition

Use this procedure to add a project property definition to a property set def-
inition. Project property values are obtained from the Drawing Management 
project in which an object is located.

A project property definition is a type of automatic property. The value it dis-
plays is determined automatically, based on its definition, and cannot be 
edited directly. In order for a project property definition to return correct 
project data, a drawing management project must be currently open, and the 
drawing containing the object must be part of that project. If either of these 
conditions are not met:

� the data in the Property palette extended data tab, and similar dialogs, is 
displayed as “No Project.”

� attributes of schedule tags that display project data are not updated. 
Attributes display data from the last time the tag was updated when the 
conditions were met and the drawing was saved. In this case, the data dis-
played may not be accurate.

� schedule tables that display project data in one or more cells are not 
updated. Schedule tables display data from the last time the table was 
updated when the conditions were met and the drawing was saved. In this 
case, the data displayed may not be accurate. 

These conditions allow drawings that contain project data to be viewed and 
plotted when drawing management is not available. 

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 Select the property set definition that you want to change, right-click, and 
click Edit.
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4 Click the Definition tab.

5 Click .

6 Enter a name for the project property.

7 Clear Use project information for description if you do not want to use the 
project property as the description of the property.

8 Select the project information to include in the property definition: 

9 Click OK. 

To change the name of the property definition, click Name and double-
click the property definition in the table, or select Edit Project. If Use 
project information for description is not set, edit the description.

Property Description

Name Name of the project

Description Description of the project

Number Number of the project

Location File location of the project on the hard disk or network drive

Number of Levels Total number of levels in your project

Level ID ID of the object’s level. For example, if you create a wall 
property set definition with this property and attach it to a 
wall on the first floor, the extended data will display “Level 
1.” If you attach the property set definition to a wall on the 
second floor, this property will be changed accordingly.

Level Elevation Elevation of the object’s level

Level Height Height of the object’s level

Number of Division Total number of divisions in your project

Division ID ID of the object’s division

Sheet Name Name of the sheet drawing that contains the object

Sheet Description Description of the sheet drawing that contains the object

Details Properties for all project details you created
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10 Select a property data format to specify the method used to display the 
data included in the definition.

The format you select becomes the default format of a column when this 
property is added to a schedule table style. It can be changed at any time. 
The example area shows how the default value is displayed using the 
selected format.

11 Click OK twice.

Editing a Property Set Definition

Use this procedure to edit a property set definition.

� You can change the objects or styles to which the property set can be 
attached.

� You can add and remove properties.
� You can change the name, description, and format of properties.
� You can change additional items for each type of property definition.

Changes are immediately applied to any objects or styles to which the prop-
erty set created from the definition is attached. If automatic update is speci-
fied for a schedule table, the changes also appear in the schedule table. If 
automatic update is not specified, you need to update the table. 

NOTE If you remove a property that is used in a schedule table, INVALID is dis-
played for value in the table. 

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Set Definitions.

3 To change how the property set is applied, click the Applies To tab, and 
specify objects or styles:

If you want to . . . Then . . .

apply the property set created 
from this definition to objects

select Objects, and select the objects to which 
the property set can be attached. For more 
information, see “Specifying How the Property 
Set Definition is Applied” on page 2248.
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4 Click the Definition tab.

5 Edit the properties that define each property definition: 

apply the property set created 
from this definition to styles or 
definitions

select Styles and Definitions, and select the 
styles and definitions to which the property set 
can be attached.

If you want to . . . Then . . .

edit a manual property 
definition

select the manual property definition, and change 
the name, description, type, default, or format. For 
more information, see “Adding a Manual Property 
Definition to a Property Set Definition” on 
page 2251.

edit an automatic property 
definition

select the automatic property definition, and 
change the name, description, and format. Double-
click the automatic property definition, or select it 
and click Edit Source. Select the automatic property 
source, and click OK. For more information, see 
“Adding an Automatic Property Definition to a 
Property Set Definition” on page 2252.

edit a formula property 
definition

select the formula property definition, and change 
the name, description, and format. Double-click the 
formula property definition, or select it and click 
Edit Formula. Change the name, clear or select Use 
formula for description, and modify the formula by 
typing in it or selecting property definitions. Click 
OK. For more information, see “Adding a Formula 
Property Definition to a Property Set Definition” on 
page 2254.

edit a location property 
definition

select the location property definition, and change 
the name, description, and format. Double-click the 
location property definition, and click Edit Location. 
Change the name, clear or select Use property 
name for description, and select property 
definitions. Click OK. For more information, see 
“Adding a Location Property Definition to a 
Property Set Definition” on page 2258.

If you want to . . . Then . . .
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6 Edit the property definition for manual property definitions:

edit a classification 
property definition

select the classification property definition, and 
change the name, description, and format. Double-
click the classification property definition, or select it 
and click Edit Classification. Change the name, and 
clear or select Use classification name for 
description. Select from the classifications available 
in the left pane. Select a property of the 
classification from the right pane with Classification 
Property selected, and click OK. For more 
information, see “Adding a Classification Property 
Definition to a Property Set Definition” on 
page 2259.

edit a material property 
definition

select the material property definition, and change 
the name, description, and format. Double-click the 
material property definition, or select it and click 
Edit Material. Change the name, and clear or select 
Use material name for description. Select from the 
materials available in the left pane for the property 
definition. Select a property of the material from the 
right pane with Material Property selected, and click 
OK. For more information, see “Adding a Material 
Property Definition to a Property Set Definition” on 
page 2262.

edit a project property 
definition

select the project property definition, and change 
the name, description, and format. Double-click the 
project property definition, or select it and click Edit 
Project. Change the name, clear or select Use 
project information name for description, and select 
the project information. Click OK. For more 
information, see “Adding a Project Property 
Definition to a Property Set Definition” on 
page 2263.

remove a property from 
the property set definition select a property, and click . For more 

information, see “Removing All Property Sets from 
Objects and Styles” on page 2268.

If you want to . . . Then . . .

change the name click Name. Enter a new name, and click OK.

change the description select the description, and enter new text.

If you want to . . . Then . . .
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7 Click OK twice.

NOTE Property data format styles, property set definitions, and schedule table 
styles cannot be changed through RefEdit. Changes seem to work, but will revert 
to the previous settings when saved back to the xref file. Open the xref drawing 
directly, and make the changes there. 

Removing All Property Sets from Objects and 
Styles

Use this procedure to remove a property set that no longer applies to the 
objects and object styles to which it is attached.

If you remove an object or style from the Applies To list in a property set def-
inition after the property set based on the definition is attached to the object, 
the property set is not automatically removed. This allows you to retrieve 
data that might have been entered for manual properties.

1 On the command line, enter PropertySetClean, and press ENTER.

2 Enter the name of the property set that you want to remove, or press 
ENTER to remove all the property sets from all objects or styles.

Merging Property Set Definitions

Use this procedure to replace one property set definition with another for all 
objects or object styles.

1 On the command line, enter PropertySetDefMerge, and press ENTER.

2 Enter the name of the property set definition that you want to keep, and 
press ENTER.

change the type of data select a data type for Type. You cannot change 
the data type of automatic properties.

change the default value specify a new default value. You cannot 
change the default value of automatic 
properties.

change the format of the data select a new setting for Format. The 
information in Example shows the default 
value in the format you select.

If you want to . . . Then . . .
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3 Enter the name of the property set definition that you want to merge, and 
press ENTER.

4 Specify whether to purge the merged property set definition:

If you keep the merged property set definition in the drawing, it is not 
attached to any objects.

5 Specify whether to remove property sets:

Schedule Table Styles

Schedule table styles determine the content and appearance of schedule 
tables that you add to drawings. 

Content and Format of Schedule Tables
Use schedule table styles to specify the following characteristics of schedule 
tables:

� Objects that can be included in the schedule table
� Property data to be tracked in the schedule table
� Sequence and format of columns
� Property data format of schedule values
� Format of table titles, column headers, and table cells
� Sorting sequence of rows
� Display properties of tables

If you want to . . . Then . . .

purge the property set definition that 
you merged

enter y (yes), and press ENTER.

keep the merged property set 
definition in the drawing

press ENTER.

If you want to . . . Then . . .

remove the property sets that do not 
apply after the merge

enter y (yes), and press ENTER.

keep the property sets attached to 
objects and styles even though they 
may not apply

press ENTER.
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Flagging Out-of-Date Schedules
In a schedule table style, you can specify whether a schedule table is updated 
when objects included in the schedule change. If you turn off the automatic 
update option, you can still determine whether data in the schedule reflects 
changes in the drawing. The display properties of the schedule style include 
an out-of-date marker. When this marker is turned on, a diagonal slash is 
drawn through the table when the schedule table has not been updated. 
Updating the table removes the out-of-date marker.

NOTE The out-of-date marker is not entirely reliable. You should always 
update your schedule tables before plotting.

What You Need to Create a Schedule Table Style
Your drawings must contain the following information to create a new 
schedule table style:

� Property set definitions for any property data to be included in the tables 
created from the style. Each column in a schedule table corresponds to 
one property in a property set for an object or an object style. For more 
information, see “Property Set Definitions” on page 2241.

� Property data formats to control the format of values in each column of a 
schedule table. Typically, you use the data format for values that the prop-
erty set definition uses. However, you can override those data formats in 
the schedule table style. For more information, see “Property Data For-
mats” on page 2284.

The content and tools included with Autodesk® Architectural Desktop 
include schedule table styles for typical schedules, such as door and window 
schedules or room finish schedules. You can customize these styles for your 
projects. 

Creating Styles for Matrix Schedules
A matrix schedule is a table that contains columns for schedule properties. A 
symbol, such as a dot or a cross, appears in the cells in each row for objects 
that have the property. Matrix schedules are also called dot schedules.

You can define schedule table styles to include matrix columns for specific 
properties. In addition, you can control the following characteristics of 
matrix schedules or matrix columns in regular schedules:

� The symbol used in each cell containing the property listed in the column 
header
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� The maximum number of columns for each matrix property. If the unique 
property values in the column exceed this maximum number, the column 
is displayed as a normal column

If the property data displayed in a matrix column is a string containing a 
semicolon-delimited list of values, each value in the list will be displayed sep-
arately. You can use this format to assign multiple values to the same prop-
erty, such as multiple floor materials in the same space.

Creating Tools from Schedule Table Styles
You can create a schedule table style tool from schedule table style. You can 
drag the style from the Style Manager onto a tool palette. You can then spec-
ify settings for schedule table style properties for the tool. For more informa-
tion, see “Creating a Schedule Table Tool” on page 2214.

Managing Schedule Table Styles
To create, edit, copy, or purge schedule table styles, you access the Style Man-
ager. The Style Manager provides a central location for working with styles 
from multiple drawings and templates. For more information about using 
the Style Manager, see “Style Manager” on page 531.

Related Procedures

� Creating a Schedule Table Style

� Specifying the Default Format of a Schedule Table Style

� Specifying Objects for a Schedule Table Style

� Filtering Scheduled Objects by Classification in a Schedule Table Style

� Adding Columns to a Schedule Table Style

� Adding a Heading Across Columns in a Schedule Table Style

� Editing Columns in a Schedule Table Style

� Specifying the Sort Order in a Schedule Table Style

� Specifying Title Formats in a Schedule Table Style

� Specifying the Display Properties of a Schedule Table Style

� Attaching Notes and Files to a Schedule Table Style

Creating a Schedule Table Style

Use this procedure to create a schedule table style. You can create a style 
using default style properties or by copying an existing style. You can then 
edit the style properties to customize the characteristics of the style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.
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2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Create a new schedule table style:

4 Enter a name for the new schedule table style, and press ENTER.

5 To edit the new schedule table style, right-click the style, and click Edit.

6 Edit the options for the schedule table style:

If you want to . . . Then . . .

create an empty schedule 
table style 

right-click Schedule Table Styles, and click New.

create a style from an 
existing style

right-click the schedule table style you want to 
copy, and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

specify default format for 
the style

see “Specifying the Default Format of a Schedule 
Table Style” on page 2273.

specify the objects for the 
schedule table style to 
track

see “Specifying Objects for a Schedule Table Style” 
on page 2274.

use classifications to 
specify objects included in 
a schedule table

see “Filtering Scheduled Objects by Classification in 
a Schedule Table Style” on page 2275.

add columns to represent 
properties reported in the 
schedule table style

see “Adding Columns to a Schedule Table Style” on 
page 2276.

add column headings to a 
schedule table style

see “Adding a Heading Across Columns in a 
Schedule Table Style” on page 2278.

edit column data and 
column placement in a 
schedule table style

see “Editing Columns in a Schedule Table Style” on 
page 2279.

specify the sort order of 
rows in a schedule table 
style

see “Specifying the Sort Order in a Schedule Table 
Style” on page 2280.

specify the formats of the 
table title, column 
headings, and matrix 
column headings

see “Specifying Title Formats in a Schedule Table 
Style” on page 2281.
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7 Click OK twice.

Specifying the Default Format of a Schedule 
Table Style

Use this procedure to specify the default text format and placement for table 
columns and their contents. You can also specify the default symbol used in 
matrix schedules and for true/false values in regular schedules. 

If necessary, you can override these settings for individual columns and for 
table titles.

NOTE Most schedule table styles provided by Autodesk® Architectural Desk-
top have overrrides applied to their titles and column headers. You can access 
these settings on the Layout tab in the Schedule Table Style Properties dialog 
box.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Select the schedule table style that you want to change, right-click, and 
click Edit.

4 Click the Default Format tab.

5 Select a text style.

The text style must be defined as an AutoCAD®  text style before you can 
apply it to a schedule table style. To use a different font in your schedule, 
you must first define an AutoCAD text style that uses the font.

6 Select a text alignment. 

specify visibility, layer, 
linetype, and other display 
properties of the schedule 
table style

see “Specifying the Display Properties of a Schedule 
Table Style” on page 2282.

add notes and files to the 
style

see “Attaching Notes and Files to a Schedule Table 
Style” on page 2283.

If you want to . . . Then . . .



2274 | Chapter 30 Schedules

For more information about aligning text using the Multiline Text Editor, 

see “Formatting Multiline Text” in the AutoCAD® 2004 User’s Guide.

NOTE Height, Fixed Width, and Gap are normally specified as the size you 
want to use when plotting the drawing containing the schedule table. 

7 Enter the prescaled text height for Height.

8 Enter the prescaled gap between the text and the schedule table lines for 
Gap.

9 Select the text orientation within the cell. 

For the table title and group titles, this option also controls the location 
of the cell relative to the rest of the table.

10 Select a matrix symbol.

The symbol is used in matrix columns and, optionally, for true/false val-
ues. Symbols include the following:

� Check 
� Dot 
� Cross 
� Slash 

11 Select or clear Use for True/False to control whether matrix symbols or the 
data format text is used for true/false values.

12 Enter a fixed width for all columns, or enter 0.0 for columns that adjust to 
fit the data within them.

Cell Size Height is a read-only field. Its value is calculated from the Height 
and Gap values.

13 Click OK twice. 

Specifying Objects for a Schedule Table Style

Use this procedure to specify the types of objects to track in tables created 
from a schedule table style.

You can include more than one object type in a schedule table style. For 
example, you can create a schedule table style for windows that tracks both 
individual windows and window assemblies.

The property sets from which you select data must apply to all object types 
specified in the style. For example, in a schedule table style for windows and 
window assemblies, the window assembly styles property set is not available 
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because it does not apply to windows. In addition, limiting the number of 
object types in a schedule table style improves drawing performance.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Select the schedule table style that you want to change, right-click, and 
click Edit.

4 Click the Applies To tab.

5 Select the objects that the schedule table style applies to. 

By default, all object types are selected. If all objects or none of the objects 
are selected, your schedule table style can include any object type. You can 
select all objects on the list, or clear all the selections. The area above the 
lists displays the objects that are currently selected.

All classification definitions that apply to the objects that the schedule 
table style applies to are displayed on the right, with a list of their classifi-
cations. Select any number of classifications in any number of classifica-
tion definitions. If classifications are selected, the schedule table style can 
include objects or styles and definitions selected on the left only if they 
have been classified with the classifications selected on the right.

6 Click OK twice.

Filtering Scheduled Objects by Classification in a 
Schedule Table Style

Use this procedure to specify the classification criteria that an object style 
must satisfy to be included in schedule tables created from this schedule table 
style. You can specify more than one classification criteria.

For example, if you want to schedule only door styles with a New construc-
tion status and a vendor with preferred status, you can specify those criteria 
in the schedule table style. Only doors with styles that meet both criteria can 
be included in the schedule table.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Right-click the schedule table style that you want to change, and click 
Edit.

4 Click the Applies to tab.
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5 Click Clear All, and then select the objects you want the schedule table 
style to apply to.

6 To specify classification criteria, expand a classification definition, and 
select one or more classifications.

For example, you can select a construction status of New and two pre-
ferred vendors. For objects to be included in schedules of this style, the 
classification in the object style must be New for construction status, and 
the classification for Vendor must be one of the two vendors selected.

Specifying multiple classification criteria in a schedule table style

7 Click OK twice.

Adding Columns to a Schedule Table Style

Use this procedure to add columns for each property to be reported in sched-
ule tables created from a schedule table style.

Each column contains the values for one property in a property set. The 
property set definitions for the properties you specify must exist in the draw-
ing before you can create columns for them.

You must also specify the objects that the schedule table style applies to 
before you add columns. For more information, see “Specifying Objects for a 
Schedule Table Style” on page 2274.

For more information about property set definitions, see “Property Set Defi-
nitions” on page 2241.
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1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Select the schedule table style that you want to change, right-click, and 
click Edit.

4 Click the Columns tab.

5 Select the existing column.

6 Click Add Column. 

The new column is inserted after the selected column.

7 Select the property to track in this column. 

Properties that are already used in a column are unavailable in the prop-
erties list in the Add Column dialog box.

8 Enter the heading for the column. 

The property description is the default text for a column header in a 
schedule table that uses this property.

9 Select the property data format, or use the default format from the prop-
erty set definition. 

10 Specify additional settings for the column:

NOTE Hiding a column does not affect the data displayed in it or any other 
column in the table. It only affects the display of the table.

If you want to . . . Then . . .

specify a different format and 
orientation for the cells in this column

click Override Cell Format, and specify 
format settings that apply only to data 
cells in this column.

use a matrix format for the values in 
the column

select Matrix, and enter the maximum 
number of columns used to report the 
values for the selected property.

report a total value from all the values 
in this column

select Total.

hide the column from view in the 
drawing

select Hide.
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When you edit property data to be displayed in a matrix column, you can 
assign multiple values by using a text data type and separating the values 
with semicolons. Exch value is displayed in a separate column in the 
matrix column.

11 Specify the placement of this column, relative to the location of existing 
columns.

The new column is inserted after the existing column selected above.

12 Click OK. 

13 To repeat the first column at the end of the table, select Repeat First Col-
umn.

14 To include a quantity column, select Include Quantity Column.

If you include a quantity column in a schedule table, the objects in the 
table with the same values in every column are displayed in one row, with 
the number of objects displayed in the Quantity column.

15 If you include a quantity column and want to add a product column, 
select Include Product Column.

The Product column multiplies the value in the Quantity column by the 
value in the Data column. For example, you can use a Product column to 
multiply a unit cost for an object by the number of objects to get a total 
cost. To specify the Data column, select the Product column, click Modify, 
and then select one of the schedule table columns in the Data column list. 

16 Click OK twice.

Adding a Heading Across Columns in a Schedule 
Table Style

Use this procedure to add a heading that spans multiple adjacent columns in 
a schedule table style. For example, you can create the heading “Hardware” 
to span the columns for hinges, handles, and locks in a door schedule.

You can also remove a heading that spans multiple columns.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Select the schedule table style that you want to change, right-click, and 
click Edit.
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4 Click the Columns tab.

5 Select the first column you want to include under a heading, and press 
CTRL while you select the other columns.

Columns must be adjacent.

6 Click Add Header.

7 Enter a title for the heading, and press ENTER.

8 To remove a heading, select it, and click Delete. In the Remove Columns/
Headings dialog box, click OK.

9 Click OK twice.

Editing Columns in a Schedule Table Style

Use this procedure to change the text of column headings, the format of col-
umn data, and the placement of a column in a schedule table style. You can 
also delete a column.

To change the format of column headings, see “Specifying Title Formats in a 
Schedule Table Style” on page 2281.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Select the schedule table style that you want to change, right-click, and 
click Edit.

4 Click the Columns tab.

5 Select a column, and click Modify.

6 Specify settings for the column:

If you want to . . . Then . . .

specify a different column heading enter the new column heading for 
Heading.

specify a different format and 
orientation for the cells in this column

click Override Cell Format, and specify 
format settings that apply only to data 
cells in this column.

use a matrix format for the values in 
this column

select Matrix, and enter the maximum 
number of columns used to report the 
values for the selected property.
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7 Click OK.

8 Change the order of columns:

9 To delete a column, select the column, and click Delete.

10 To use a different property in a column, delete the column, and add a new 
column with the property you want to use.

11 Click OK twice.

NOTE Property data format styles, property set definitions, and schedule table 
styles cannot be changed through RefEdit. Changes seem to work, but will revert 
to the previous settings when saved back to the xref file. Open the xref drawing 
directly, and make the changes there. 

Specifying the Sort Order in a Schedule Table 
Style

Use this procedure to specify the sort order of rows in a schedule table style. 
You can sort rows in ascending or descending order of the values in one or 
more columns.

report a total value from all the values 
in this column

select Total.

hide the column from view in the 
drawing

select Hide.

If you want to . . . Then . . .

move an individual column select the column heading, and drag 
the column to a new location.

move a group of columns that have a 
common heading that spans the 
columns

select the common heading, and drag 
the column group to a new location.

add or remove a column in a column 
group

select the heading for the column 
group, click Delete, and click OK. 
Select the columns to include in the 
column group, click Add Header, and 
enter the heading name.

If you want to . . . Then . . .
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1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Select the schedule table style that you want to change, right-click, and 
click Edit.

4 Click the Sorting tab.

5 Specify the sort order of the rows:

6 Click OK twice.

Specifying Title Formats in a Schedule Table 
Style

Use this procedure to enter the title of a schedule table, and to specify the 
formats of the table title, column headings, and matrix column headings. 
The formats that you specify in this procedure for regular and matrix column 
headings override the default format settings.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

If you want to . . . Then . . .

add a property to sort by click Add, select a property to sort by, 
and click OK.
The selections presented are the 
columns defined on the Columns tab 
that are not already selected for 
sorting.

select the sorting method for a 
property

select the property, and select 
Ascending or Descending for Sort 
Order.

remove a property from the sorting list select the property, and click Remove.

change the location of a property in 
the sort order

select the property, and click Move Up 
or Move Down.
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3 Select the schedule table style that you want to change, right-click, and 
click Edit.

4 Click the Layout tab.

5 Enter the title of the schedule table for Table Title.

6 Select Override Cell Format next to the type of title format you want to 
change.

7 Select a text style.

The text style must be defined as an AutoCAD® text style before you can 
apply it to a schedule table style. To use a different font in your schedule, 
you must first define an AutoCAD text style that uses the desired font.

8 Select a text alignment.

For more information about aligning the text using the Multiline Text Edi-
tor, see “Formatting Multiline Text” in the AutoCAD® 2004 User’s Guide.

9 Enter the prescaled text height for Height.

This height is scaled according to the drawing scale specified in the Draw-
ing Setup dialog box.

10 Enter the prescaled gap between the text and the schedule table lines for 
Gap.

Cell Size Height is a read-only field that is calculated by Height + 2 x Gap.

11 Select the text orientation within the cell. 

For the table title and group titles, this option also controls the location 
of the cell relative to the rest of the table.

12 Click OK.

13 To remove an override, clear the check box next to the title format you 
want to restore to the default format.

14 Click OK twice.

Specifying the Display Properties of a Schedule 
Table Style

Use this procedure to change the following properties of the display compo-
nents of a schedule table style: 

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
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� Lineweight
� Linetype scale

You can specify display properties for the table outer frame, lines between 
rows and columns, the table title, column headers, and the data in table cells.

Use Data Major Row Lines for every fifth row and Data Minor Row Lines for 
all other rows to control the display properties for lines separating each row 
of data. This is useful for long schedule tables.

You can also turn on an out-of-date marker that indicates when the data in a 
schedule table created from the schedule table style does not show the latest 
changes. This component is turned off by default. Turning it on can slow 
drawing performance, especially in large drawings.

1 Select the schedule table style you want to change, right-click, and click 
Edit Object Display.

2 Click the Display Properties tab.

3 Select the display representation on which to display the changes, and 
select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Attaching Notes and Files to a Schedule Table 
Style

Use this procedure to enter notes and attach reference files to a schedule table 
style. You can also edit notes and edit or detach reference files from a sched-
ule table style.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Schedule Table Styles.

3 Right-click the schedule table style that you want to change, and click 
Edit.

4 Click the General tab.
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5 To add a description to the schedule table style, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 When you finish making changes to the schedule table style, click OK.

Property Data Formats

Property data formats control how data is displayed in schedule tables, 
schedule tags, and the Edit Property Data dialog box. 

Data Formats
Each property data format contains settings to format the following data 
types:

� Text
� True/False values
� Integers
� Real numbers

When you apply a data format to schedule data, the value for the property is 
displayed using the appropriate settings for the property. For example, a 
dimension value uses the real number settings while a remark can use the set-
tings for text from the same schedule data format.

Applying Property Data Formats
Property data is retrieved from an object as raw, unformatted values. Property 
set definitions, schedule table styles, and schedule tags use data formats to 
display property data as formatted values. The Edit Property Data dialog box 
uses the data formats from property set definitions to format values.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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You typically apply the same data format to similar properties, such as width, 
height, and thickness of a door. You can select a data format that is appro-
priate for each property. For example, you may want to use architectural for-
mat to display real numbers for dimensions. However, real numbers for cost-
ing properties require a monetary format. You can create different property 
data formats for these situations.

The data formats available for property set definitions, schedule table styles, 
and tags are those stored in the current drawing. When you copy property 
set definitions or schedule table styles into a drawing, data formats used in 
the definitions and styles are also copied into the drawing.

If you modify a data format, the property data is affected in any property set, 
schedule table, or schedule tag that uses the format.

Using Different Data Formats
You can specify different data formats for the same property in property set 
definitions, schedule table styles, and schedule tags. This enables you to dis-
play the same value differently in different contexts. For example, you may 
want to use a data format with greater precision for real numbers in a prop-
erty set, and display fewer digits in a schedule table. 

Managing Data Formats
To create, edit, copy, or purge data formats, you access the Style Manager. The 
Style Manager provides a central location for working with data formats from 
multiple drawings and templates. For more information about using the 
Style Manager, see “Style Manager” on page 531.

Related Procedures

� Creating a Property Data Format

� Attaching Notes and Reference Files to a Property Data Format

Creating a Property Data Format

Use this procedure to create a property data format. You can create a format 
using default properties or by copying an existing data format. You can then 
edit the properties to customize the characteristics of the property data for-
mat.

NOTE Certain automatic properties cannot be formatted with property data 
formats because their values are formatted from within the automatic query.

1 On the Format menu, click Style Manager.
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The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Data Formats.

3 Right-click Property Data Formats, and click New.

4 Enter a name for the new property data format, and press ENTER.

5 Right-click the new property data format, and click Edit.

6 Click the Formatting tab.

7 Specify general formatting values:

8 Specify the case for the schedule text:

If you want to . . . Then . . .

specify a prefix enter a string to be placed in front of data for Prefix.
For example, tolerances might require a preceding 
plus/minus symbol; a tolerance of 10 could be 
displayed as +10. A currency string could be prefixed 
with a dollar sign. 

specify a suffix enter a string to be placed after data for Suffix.
For example, a door leaf thickness of 35 could have a 
millimeter suffix (35mm). 

specify text for a 
property that is 
undefined

enter a text string to be displayed when the 
requested property has not been attached to an 
object for Undefined. A typical undefined string is 
“?”.

specify text for a 
property that is not 
applicable 

enter a text string to be displayed when the 
requested property does not apply to an object for 
Undefined. For example, the rise property does not 
apply to a door with a rectangular opening, but it 
does apply to one with an arched opening. A typical 
“not applicable string” is “NA.”

If you want to . . . Then . . .

use no case formatting select As Is for Case.

convert all text to uppercase select Upper for Case.

convert all text to lowercase select Lower for Case.

capitalize the first letter of the first 
word 

select Sentence for Case.
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9 Enter the maximum number of digits, including leading zeroes, for inte-
gers.

Zero padding is the expansion of integer values to include leading zeros. 
The value entered specifies the maximum length of a numeric value after 
it has been padded with leading zeros. For example, with Zero Padding at 
3, the number 6 would become 006. This option primarily is intended for 
identity numbers, such as those used by door and window tags. For exam-
ple, to number doors as D01 through to D99, the raw value of the data 
would be saved as a simple integer, but the prefix would be D and Zero 
Padding would be 2. Entering zero for Zero Padding applies no zero pad-
ding. 

10 Enter the values for True and False.

For example, you can specify Yes for True and No for False.

11 Enter data to display a sample of your current settings for Result.

12 To use a dimension style to specify some formatting, click Set from 
Dimension Style, select a dimension style, and click OK.

Undefined, Not Applicable, Case, Zero Padding, and True/False are not 
defined by dimension styles.

13 Select the unit format, numerical precision, fraction format, and scale for 
real numbers. Definitions of these items are as follows:

� Unit Format: The AutoCAD® conversion units (Architectural, Scien-
tific, Decimal, Engineering, and Fractional) used when converting 
numeric values into strings. For example, a value of 14.25 is displayed 
as 1'–2-1/4" in Architectural units.

� Precision: The number of decimal places used to display floating point 
numbers (for example, 0, 0.0, 0.00, and so on).

� Fraction Format: If the unit format is Architectural or Fractional, set 
the format used to display fractions (Horizontal, Diagonal, or Not 
Stacked). Note that all fonts do not support all fraction formats.

� Scale: The value by which the real number is scaled before it is dis-
played. For example, if the current drawing units are inches, a scale of 
2.54 converts a dimension to centimeters.

capitalize the first letter of each word select Title for Case.

If you want to . . . Then . . .
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14 Select the Round Off value for real numbers:

If you enter a value of 0.25, all numeric values are rounded to the nearest 
0.25 unit. Similarly, if you enter a value of 1.0, all numeric values are 
rounded to the nearest integer. The number of digits displayed after the 
decimal point depends on the precision specified. No round-off occurs for 
a value of 0.0.

15 Specify the rules for suppression of leading and trailing zeros, and feet and 
inches of floating point numbers:

For more information, see “Suppressing Zeros in Dimension Units” in the 
AutoCAD® 2004 User’s Guide.

16 Select the decimal separator.

For more information about fraction format and decimal separators, see 
“Formatting Primary Dimension Units” in the AutoCAD® 2004 User’s 
Guide.

17 Select the whole number separator.

18 Click OK twice.

If you want to . . . Then . . .

round to the nearest value select Nearest.

round to the nearest greater value select Up.

round to the nearest lesser value select Down.

If you want to . . . Then . . .

suppress leading zeros in all decimal 
numeric values

select Leading for Zero Suppression.
For example, 0.5000 becomes .5000.

suppress trailing zeros in all decimal 
numeric values

select Trailing for Zero Suppression.
For example, 12.5000 becomes 12.5.

suppress the feet portion of a feet-and-
inches numeric value when the value is 
less than one foot

select 0 Feet for Zero Suppression.
For example, 0'–6 1/2" becomes 6 1/
2".

suppress the inches portion of a feet-
and-inches numeric value when the 
value is an integral number of feet

select 0Inches for Zero Suppression.
For example, 2'–0" becomes 2'.
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Attaching Notes and Reference Files to a 
Property Data Format

Use this procedure to enter notes and attach reference files to a property data 
format. You can also edit notes and edit or detach reference files from a prop-
erty data format.

1 On the Format menu, click Style Manager.

The Style Manager is displayed with the current drawing expanded in the 
tree view.

2 Expand Documentation Objects, and expand Property Data Formats.

3 Select the property data format that you want to change, right-click, and 
click Edit.

4 Click the General tab.

5 To add a description to the property data format, enter it for Description.

6 To add a note, click the Notes tab, and enter the note.

7 Click the Reference Docs tab, and attach, edit, or detach a reference file:

8 Click OK twice.

Classification Definitions

A classification definition is a group of named properties or characteristics 
that you can assign to the objects of a particular style. Classifications enable 
you to track objects by construction status, project phase, building element, 
vendor, or other criteria. A classification definition is applied to one or more 
object styles. The definition contains classification names and descriptions. 
Each classification can have property sets attached to it.

If you want to . . . Then . . .

attach a reference file click Add, select a file, click Open, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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Classifications and Schedules
Classifications provide additional control over the content of schedule 
tables.

� You can include only those objects that meet the classification criteria in 
the schedule table.

� You can include classification definitions as columns in a schedule table.
� You can create and attach property sets to individual classifications to 

track additional data with each classification; and you can include this 
information in schedule tables.

Uses for Classifications
Here are some examples of classification definitions:

� Classifications for multi-view blocks enable you to distinguish among 
blocks to use for furniture, appliances, fixtures, and equipment

� Classifications for project phases
� Classifications for door types let you filter partition doors in bathrooms 

from door schedules

Classifications and the Display System
You can modify display sets in a display configuration to show or hide 
objects based on their classification. For more information, see “Displaying 
Objects by their Classification” on page 471.

Managing Classification Definitions
To create, edit, copy, or purge classification definitions, you access the Style 
Manager. The Style Manager provides a central location for working with def-
initions and styles from multiple drawings and templates. For more informa-
tion about using the Style Manager, see “Style Manager” on page 531.

Related Topics and Procedures

� An Example of Classifications and their Use

� Specifying the Object Styles for a Classification Definition

� Entering Classifications in a Classification Definition

� Attaching Property Set Definitions to a Classification Definition

� Editing a Classification Definition

� Viewing the Classifications in a Classification Definition

� Attaching Notes and Files to a Classification
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An Example of Classifications and their Use

You can create a classification definition that contains a classification for 
each construction status, such as Existing, Demo, and New. 

Creating a classification definition for construction status

You also specify the object styles to which the classification definition 
applies.

Specifying object styles in a classification definition

The classification definition is listed on the Classifications tab in the object 
style properties. You select a classification, such as New, in the object style. 
For example, your drawing might contain certain door styles for existing 
doors, and different door styles for new construction. All doors created from 
these styles have the classification specified in their style. 
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Door style with a classification specified

When you are ready to schedule doors, you can specify in the schedule table 
style to include only those doors with the New classification. Any other 
doors included in the selection set are filtered from the table.

Specifying classification criteria in a schedule table style

You can also include classifications as a column in your schedule tables. You 
can create and attach property sets to individual classifications to track addi-
tional data, and you can include this data in schedule tables. In addition, you 
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can modify settings in the display system to filter the display of objects based 
on their classification.

Creating a Classification Definition

Use this procedure to create a classification definition. You can create a defi-
nition using default properties or by copying an existing definition.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.

3 Create a classification definition:

4 Enter a name for the new classification definition, and press ENTER.

5 To edit the new classification definition, right-click the definition, and 
click Edit.

6 Edit the classification definition:

If you want to . . . Then . . .

create a definition with 
default properties

right-click Classification Defnitions, and click New.

create a definition from an 
existing definition

right-click the classification definition you want to 
copy, and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

enter a description of the 
classification definition

click the General tab, and enter the description.

specify the objects to 
which the definition 
applies to

see “Specifying the Object Styles for a Classification 
Definition” on page 2294.

enter classifications see “Entering Classifications in a Classification 
Definition” on page 2295.

attach property sets to the 
individual classifications in 
the definition

see “Attaching Property Set Definitions to a 
Classification Definition” on page 2296.

add notes and files to the 
definition

see “Attaching Notes and Files to a Classification” 
on page 2300.
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7 Click OK twice.

Specifying the Object Styles for a Classification 
Definition

Use this procedure to specify the object styles to which a classification defi-
nition applies. You can specify that a classification definition apply to one or 
more styles. The classification will be listed on the Classification tab for all 
the object styles that you specify.

For example, if you specify that a classification definition applies to door 
styles and window styles, the classification is listed on the Classifications tab 
of all door and window styles in the drawing. You can then select an individ-
ual classification appropriate for each door style and window style. For more 
information about specifying a classification in an object style, see the style 
topics in the object chapters of the online Help.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.

3 Right-click the classification definition, and click Edit.

4 Click the Applies to tab.

5 Select the object styles to which the classification definition will apply.

Selecting object styles to which a classification definition applies

6 Click OK twice.
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Entering Classifications in a Classification 
Definition

Use this procedure to enter classifications for a classification definition. Clas-
sifications are individual entries within a classification definition. For exam-
ple, a classification definition for construction status may contain the classi-
fications existing, demo, and new. In the object styles to which the defini-
tions applies, you can select one classification for each style.

NOTE Be sure to specify the object styles to which the classification definition 
applies. The classifications are not available in object styles until you specify the 
object styles in the classification definition. For more information, see “Specify-
ing the Object Styles for a Classification Definition” on page 2294.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.

3 Right-click the classification definition, and click Edit.

4 Click the Classifications tab.

5 Click Add.

6 Select the new classification, and enter a name for it.

7 Select the description, and enter a description of the classification.

Adding classificatons to a classification definition

8 Continue adding classificaitons.

9 Click OK twice.
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Attaching Property Set Definitions to a 
Classification Definition

Use this procedure to add property set definitions to individual classifica-
tions in a classification definition. You can add property sets to each classifi-
cation to track additional information with that classification. 

For example, if you create a classification definition for vendors, you can 
attach a property set to each vendor classification. The property sets can con-
tain any properties that you specify. The properties are then associated with 
each object created from a style that is assigned the classification. These 
properties can be included in the schedule table when the objects are sched-
uled.

For more information about creating property sets, see “Property Set Defini-
tions” on page 2241. For more information about adding classification prop-
erty data to property set definitions, see “Adding a Classification Property 
Definition to a Property Set Definition” on page 2259.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.

3 Right-click the classification definition, and click Edit.

4 Click the Classifications tab.

5 Select one or more classifications, and click Property Sets.

Hold down SHIFT or CTRL to select multiple classifications to which you 
want to attach the same property sets.

Selecting a classification to which you attach property sets
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6 Click .

7 Clear property sets that you do not want to attach to the classificaton, and 
click OK.

Clearing property sets you do not want to attach to classifications

8 Enter values for the property data, and click OK.

You can enter or edit values later, if necessary.

Entering data for a property set attached to a classification

9 Continue attaching property sets to other classifications.

10 Click OK twice.

Editing a Classification Definition

Use this procedure to edit or remove classifications in a classification defini-
tion, to add or edit data in property sets attached to classifications, and to 
detach property sets from classifications.

NOTE You can remove only those classifications not currently assigned to an 
object style. You cannot delete classifications that are in use. 

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.
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3 Right-click the classification definition, and click Edit.

4 Click the Classifications tab.

5 Edit classifications:

6 To detach property sets from a classification, select the classification, and 
click Property Sets.

7 Click .

8 Clear the property sets you do not want to remove, and click OK.

Removing property sets from a classification

9 Click OK.

10 To remove a classification, select the classification, and click Remove.

If the Remove button is unavailable, you cannot delete the classification 
because it is currently assigned to an object style.

11 Click OK twice.

If you want to . . . Then . . .

edit the classification 
name

select the name, edit the text, and press ENTER.

edit the classification 
description

select the description, edit the text, and press 
ENTER.

add or edit property set 
data in property sets 
already attached to a 
classification

select the classification, and click Property Sets. 
Enter or edit property data, and click OK.
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Viewing the Classifications in a Classification 
Definition

Use this procedure to view a list of classifications and their descriptions for a 
classification definition in the current drawing.

Only the classifications, and not their descriptions, are listed on the Classifi-
cations tab in the style properties. If descriptions have been entered, you can 
view them in the Style Manager.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.

3 Select the classification definition whose classifications you want to view.

4 In the right pane, click the List tab.

Use the scroll bar to view the entire list of classifications.

Viewing classifications for a selected classification definition

5 Click Cancel.



2300 | Chapter 30 Schedules

Attaching Notes and Files to a Classification

Use this procedure to enter notes and attach reference files to a classification 
definition. You can also edit notes and edit or detach reference files from a 
definition.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Classification Definitions.

3 Right-click the classification definition that you want to change, and click 
Edit.

4 Click the General tab.

5 To add a description to the definition, enter it for Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 When you finish making changes to the classification definition, click 
OK.

Troubleshooting Schedule Tables

This topic provides answers to the following questions about schedule tables 
and their data:

� I added a schedule table, but all the cells contain question marks. Why did 
this happen?

� Why is an object I added to the drawing not listed in the schedule table?

� How do I know which property sets to attach to objects or styles to remove 
question marks from columns in a schedule table?

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.
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� Why doesn’t the data in the schedule table show the changes I made to 
objects in the drawing?

� After adding and removing objects, I updated the schedule table. Why are 
the object numbers still out of order?

� Is there an easy way to locate an object that is listed in a schedule table?

� Why can’t I select an empty cell in the schedule table to enter a value for 
a manual property?

� Why do all the cells of one column in a schedule table show a value of 
INVALID?

I added a schedule table, but all the cells contain question 
marks. Why did this happen?
Question marks appear in table cells when property sets are not attached to 
the objects included in the table, or to the object styles for objects in the 
table. When attached to an object or a style, a property set becomes the con-
tainer for the property data. The schedule table stores no data. For more 
information about attaching property sets to objects and styles, see “Adding 
and Editing Property Set Data” on page 2204.

To attach property sets to objects and styles individually, select the table, 
right-click, selecting Edit Table Cell, and selecting the cell. For more informa-
tion, see “Identifying and Editing Table Cell Data” on page 2228.

To attach property sets to all objects and styles that need them, select the 
table, right-click, and select Add All Property Sets. For more information, see 
“Adding Property Set Data to All Objects” on page 2231.

For more information about attaching property sets to objects and styles, see 
“Attaching Property Set Data to Objects” on page 2205 and “Attaching Prop-
erty Set Data to Styles and Definitions” on page 2207.

Why is an object I added to the drawing not listed in the 
schedule table?
Objects added to a drawing after you add a schedule table are not added to 
the drawing unless the Add New Objects Automatically option is selected in 
the table properties. However, you can manually add objects to a table sched-
ule. For more information, see “Adding Objects to a Schedule Table” on 
page 2218.

If the schedule table style uses classifications to filter objects, review the trou-
bleshooting information in “Troubleshooting Classification Definitions” on 
page 2305.
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How do I know which property sets to attach to objects or 
styles to remove question marks from columns in a schedule 
table?
You can find this information by viewing the column definitions in the 
schedule table style used to create the schedule table. Select the schedule 
table, right-click, and click Edit Table Style. Click the Columns tab. You can 
view the property assigned to each column and the property set from which 
the property is obtained. Click Cancel to return to the drawing.

Property sets provided with Autodesk® Architectural Desktop use the words 
Object and Style in their names to identify how the property set can be 
attached. For example, you can attach the DoorObjects property set to doors. 
You can attach the DoorStyles property set to any door style.

To attach property sets to objects and styles individually, select the table, 
right-click, select Edit Table Cell, and select the cell. For more information, 
see “Identifying and Editing Table Cell Data” on page 2228.

To attach property sets to all objects and styles that need them, select the 
table, right-click, and select Add All Property Sets. For more information, see 
“Adding Property Set Data to All Objects” on page 2231.

For more information about attaching property sets to objects and styles, see 
“Adding and Editing Property Set Data” on page 2204.

Why doesn’t the data in the schedule table show the changes I 
made to objects in the drawing?
Changes that you make to objects—whether through graphically modifying 
the object, editing the object properties or style, or editing property data—
automatically appear in a schedule table only when the Automatic Update 
option is specified in the schedule table properties. However, you can manu-
ally update a table to reflect the changes. For more information, see “Updat-
ing a Schedule Table” on page 2218.

After adding and removing objects, I updated the schedule 
table. Why are the object numbers still out of order?
Updating a schedule table does not change the numbers assigned to the 
objects. To renumber objects in a schedule table, see “Renumbering Property 
Set Data” on page 2220.
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Is there an easy way to locate an object that is listed in a 
schedule table?
Yes. You can select a row in the schedule table to highlight the object that 
corresponds to the row. For more information, see “Showing Objects in a 
Schedule Table” on page 2219.

Why can’t I select an empty cell in the schedule table to enter 
a value for a manual property?
A table cell must contain at least one character for you to be able to select an 
individual cell. If the property was defined without a default entry and no 
data for that property was entered before the table was created, the cell is 
blank.

You can enter the value by accessing the property data directly in the object 
or the object style, depending on where the property is attached. For more 
information, see “Adding and Editing Property Set Data” on page 2204.

Why do all the cells of one column in a schedule table show a 
value of INVALID?
A property value appears as invalid in a schedule table if the property was 
deleted from a property set that is used in the schedule table. To edit the 
schedule table style to remove the property from the table, see “Editing Col-
umns in a Schedule Table Style” on page 2279. To edit the property set defi-
nition to restore the property, see “Adding a Manual Property Definition to 
a Property Set Definition” on page 2251 or “Adding an Automatic Property 
Definition to a Property Set Definition” on page 2252.

Troubleshooting Schedule Table Styles

This topic provides answers to the following questions:

� Why is the Add Column button unavailable when I try to add columns to 
a schedule table style?

� Why are the property sets I want to use unavailable when I try to add a 
column?

� Why is the Quantity column in my schedule table style not totalling 
objects that are the same.

� Why does the Product column in my schedule table style show question 
marks in all the cells?

� Why does the matrix column I formatted for a property show data values 
instead of the matrix symbol?
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Why is the Add Column button unavailable when I try to add 
columns to a schedule table style?
This button is unavailable if the drawing does not contain any property sets 
that apply to the same objects or styles that the schedule table style is applied 
to. For more information, see “Specifying Objects for a Schedule Table Style” 
on page 2274 and “Adding Columns to a Schedule Table Style” on page 2276.

Why are the property sets I want to use unavailable when I try 
to add a column?
Property sets are listed only if property set definitions are stored in the cur-
rent drawing. Also, only property sets that apply to all the objects you 
selected on the Applies To tab are available to use in schedule table columns. 
A property set that applies only to some of the selected objects cannot be 
included in the schedule table. For example, a window schedule that applies 
to windows and window assemblies cannot contain columns for properties 
that apply only to window assemblies.

Why is the Quantity column in my schedule table style not 
totalling objects that are the same. 
Objects that are the same, such as all doors of a certain style with identical 
dimensions, are not grouped and totaled if values for any cell are different. 
For example, the objects are not totalled if the table contains object numbers 
or if some objects have remarks and some do not.

Why does the Product column in my schedule table style show 
question marks in all the cells?
The Product column shows the result of the value in the Quantity column 
multiplied by a data column that you specify. Question marks appear in the 
cells of the column if the data column that you selected is not a valid 
numeric property.

Why does the matrix column I formatted for a property show 
data values instead of the matrix symbol?
If the property specified in the column can have multiple values, you need 
to add columns to the matrix format to accommodate all possible values. For 
example, in a finish schedule in which walls may be assigned one of four fin-
ishes, you need to enter a number greater than three for Max Columns to cre-
ate a column for each finish. When you then create a table from the style, 
the matrix symbol appears in the finish column for the finish value entered 
in the property data for the walls of each space.
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Troubleshooting Classification Definitions

This topic answers the following questions about troubleshooting classifica-
tion definitions:

� Why does the Classifications tab in the style properties have nothing in it?

� My schedule table contains an extremely long title for a classification 
property. How can I fix this?

� Why are no classification property sets listed when I try to add a classifi-
cation property to a property set definition?

� I want to include classifications in a schedule table. Why do I not see an 
option for them in the schedule table style?

� Why were numerous objects in my drawing not included in a schedule 
table?

� I selected all the classifications for a classification definition in the sched-
ule table style, but many objects were not included in the schedule. Why 
did this happen?

Why does the Classifications tab in the style properties have 
nothing in it?
The Classifications tab in the object style properties contains no data if no 
classification definitions are defined for styles of that object type. For exam-
ple, if the drawing contains no classification definitons that apply to wall 
styles, the Classifications tab in the Wall Style Properties dialog box does not 
contain any classification information. You specify the object styles to which 
a classification definition applies when you create the definition. For more 
information, see “Specifying the Object Styles for a Classification Definition” 
on page 2294.

My schedule table contains an extremely long title for a 
classification property. How can I fix this?
The default column header in schedule table styles is the description of the 
property selected in the property set definition. The default description for 
classification properties comprises the names of the classification definition, 
the classification property set, and the classification. In the schedule table 
style, you can edit the column header to create a shorter header. For more 
information, see “Adding Columns to a Schedule Table Style” on page 2276.

If you clear Use classification name for description when you add or edit a 
classification property in the property set definition, you can enter a shorter 
description. For more information, see “Adding a Classification Property Def-
inition to a Property Set Definition” on page 2259.
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Why are no classification property sets listed when I try to add 
a classification property to a property set definition?
No classification property sets are listed if there are no classification property 
sets for the classification definitions that apply to the object or object style 
specified in the current property set definition.

I want to include classifications in a schedule table. Why do I 
not see an option for them in the schedule table style?
The schedule table style must use property sets that contain classification 
properties. The classification properties are then available to include in a 
schedule table style.

Why were numerous objects in my drawing not included in a 
schedule table?
If you use classification filters in the schedule table style, only objects of the 
specified type that meet all the classification criteria are included in the 
schedule table. For example, if you create a door schedule for doors that are 
classified new and exterior, only doors that meet both criteria are included in 
the schedule table. If an object meets only some of the classification criteria, 
it is not included in the schedule table. 

I selected all the classifications for a classification definition in 
the schedule table style, but many objects were not included in 
the schedule. Why did this happen?
If a classification was not selected in the object style for the classification def-
inition used in the schedule table style, objects of that style are not included 
in the schedule. The classification for such objects is Unspecified, and they 
are filtered from the schedule table. To include all objects in a schedule table, 
regardless of classification, do not select any classifications on the Applies to 
tab in the schedule table style.
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Annotation

You can add annotation symbols such as break 
marks, revision clouds, and title marks to your 
drawing.

If you are using a template for the drawing, 
setup options such as units and scale are preset, 
based on whether you installed a metric or an 
imperial version of the software. For more infor-
mation about setting up your drawing, see 
“About Templates” on page 550.

You can change the plot size of annotation, 
override the dimension scale of objects in your 
drawing, and save the settings as the default. 
For more information about the drawing scale, 
see “Setting up a Drawing” on page 553.

Locating Annotation Symbols
Basic annotation symbols are located on the 
default Annotation tool palette. You can also 
find annotation tools in the following catalogs: 

� Autodesk® Architectural Desktop Sample Pal-
ette Catalog

� Autodesk® Architectural Desktop Design Tool 
Catalog

� Autodesk® Architectural Desktop Document 
Tool Catalog

Annotation AEC content is located in Design-

CenterTM. For more information, see “Design-

Center” in the online AutoCAD® 2004 User’s 
Guide.

In this chapter

� Changing the Annotation Plot 
Size

� Turning Off the Dimension 
Scale Override

� Adding Annotation to a 
Drawing

� Creating Revision Clouds

� Creating Break Marks

� Creating Detail Marks

� Creating Elevation Marks

� Creating Angular Dimensions

� Creating Radial Dimensions

� Creating Section Marks

� Creating Title Marks

� Creating an Annotation Tool

� Annotation Symbols Default 
Information

31
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Related Procedures

� Changing the Annotation Plot Size

� Turning Off the Dimension Scale Override

Changing the Annotation Plot Size

Use this procedure to change the plotted size of annotation that can be 
scaled. Annotation plot size affects any annotation that includes an attribute. 
The attribute stores alphanumeric information for the annotation. The value 
that you enter for the annotation plot size, multiplied by the drawing scale 
factor, determines the height of plotted annotation text. For more informa-

tion about attributes, see “Overview of Block Attributes” in the AutoCAD® 
2004 User’s Guide. 

1 On the Format menu, click Drawing Setup, or on the Open drawing menu 
in the drawing window status bar, click Drawing Setup.

2 Click the Scale tab.

3 Enter a value for Annotation Plot Size. 

4 Select Save As Default if you want subsequent drawings to use these set-
tings, or clear Save As Default to save your settings in the current drawing 
only.

5 Click OK.

Turning Off the Dimension Scale Override

Use this procedure to prevent the software from applying an override to the 
dimension scale in the drawing. This control is on by default and creates a 
dimension scale override to the active dimension scale. With a dimension 
scale override, dimensions added to the drawing are scaled based on the cur-
rent drawing scale. For more information on the dimension scale, see “Draw 

to Scale” in the AutoCAD® 2004 User’s Guide.

If you want the software to automatically make your dimension scale match 
your drawing scale, leave Automatically Create Dimscale Override selected. 
The override applies a scale factor to the dimension style properties. To be 
able to adjust the dimension scale independently of the drawing scale, clear 
Automatically Create Dimscale Override.
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WARNING! Any time you close the Drawing Setup dialog box by selecting 
OK or Apply, an override is applied if Automatically Create Dimscale Override is 
selected, regardless of the tab that was originally opened.

AEC dimensions are not affected by the dimension scale override because an 
AEC dimension style depends on what display representation is active. For 
more information about AEC Dimensions, see “Dimension Types and Uses” 
on page 2359.

1 On the Format menu, click Drawing Setup.

2 Click the Scale tab.

3 Clear Automatically Create Dimscale Override.

When you clear this setting, you can adjust the dimension scale indepen-
dently of the drawing scale.

4 Select Save As Default if you want subsequent drawings to use these set-
tings, or clear Save As Default to save your settings in the current drawing 
only.

5 Click OK.

Adding Annotation to a Drawing

Tools provided with Autodesk® Architectural Desktop let you place annota-
tion by selecting an annotation tool with predefined properties. You can use 
the default settings of the tool, or change settings for annotation properties. 
The default metric and imperial versions are similar, differing only in their 
base units. 

The default Annotation tool palette in the workspace contains basic annota-
tion tools, such as object tags, cut lines, and dimensioning tools. This palette 
is stored in the Autodesk Architectural Desktop Sample Palette catalog. In 
addition, the Autodesk Architectural Desktop Design Tool Catalog and the 
Autodesk Architectural Desktop Documentation Tool Catalog contain anno-
tation AEC content tools found in DesignCenter. For more information, see 
“Exploring the Content Browser” on page 174.
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Tool palette containing annotation tools

Custom palettes created by your CAD manager or other users may also con-
tain annotation tools that are customized for your projects or office stan-
dards.

You can find additional annotation AEC content tools in DesignCenter, 
where you can manage and edit the AEC content, and then specify it in a 
tool. For more information, see “Using Design Content” on page 2321.

To create your own AEC content, you can use a wizard. You can create blocks, 
drawings, and commands from data in the current drawing. For more infor-
mation, see “Custom Content” on page 2343.

The annotation plot size controls the scaling of most symbols when plotted. 
Symbols are defined with attribute text sized at one unit (1.0) height for text 
to be plotted at the annotation plot size. Other text can be sized proportion-
ately larger or smaller. For more information, see “Changing the Annotation 
Plot Size” on page 2308.

Most annotation content is formatted to use the current text style for 
attribute text. For information about text styles, see “Work with Text Styles” 

in the online AutoCAD® 2004 User’s Guide.

Related Procedures

� Creating Revision Clouds
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� Creating Break Marks

� Creating Detail Marks

� Creating Elevation Marks

� Creating Angular Dimensions

� Creating Section Marks

� Creating Title Marks

� Creating an Annotation Tool

Creating Revision Clouds

Use this procedure to place revision clouds in your drawing. You can define 
the color, length, and width for the arcs of the revision cloud. The software 
contains the following predefined revision clouds as well as tags to annotate 
them:

� Small arcs
� Medium arcs
� Large arcs
� Small arcs and tag
� Medium arcs and tag
� Large arcs and tag

1 Select a revision cloud tool:

2 Specify the starting point for the cloud.

3 Do any of the following:

� To select a different symbol to use for the revision cloud annotation, 
enter s (Select).

� To change the color of the polyline used to draw the revision cloud, 
enter c (pline Color), and then specify a color.

� To specify the arc length for the cloud, enter a (Arc length).

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a revision 
cloud tool, and select the tool.

use a revision cloud from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the revision cloud you want to use, and 
double-click it.
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� To change the line width for the polyline used to draw the revision 
cloud, enter w (pline Width).

4 Move the cursor to draw the cloud. 

The cloud finishes when the cursor moves to the starting location of the 
cloud.

5 If the cloud has a tag associated with it, select the location for the center 
point of the tag.

6 Enter the revision number, and click OK. 

Creating Break Marks

Use this procedure to place break marks in your drawing. The break mark is 
a polyline that you either scale to fit between specified points, or stretch, 
based on the drawing scale, to fit specified points. The software contains the 
following predefined break marks:

� Bar
� Bar (Filled)
� Cut Line (1)
� Cut Line (2)
� Cut Line (Curved)
� Pipe
� Pipe (Filled)

1 Select a break mark tool:

2 Do either of the following:

� To change the symbol for the break mark, enter s (Symbol).
� To change the break mark symbol to either Stretched or Scaled, enter t 

(Type).

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a break 
mark tool, and select the break mark tool.

use a break mark from 
DesignCenter

open DesignCenter. On the Custom tab of 
DesignCenter, locate the break mark you want 
to use, and double-click it.
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3 Specify the first point for the break line.

4 Specify the second point for the break line.

5 Select an object to trim, or press ENTER.

Creating Detail Marks

Use this procedure to place detail marks in your drawing. You can place 
boundaries for details and place marks for detail references. The software 
contains the following predefined detail marks:

� Circular Detail Boundary
� Rectangular Detail Boundary
� Custom Detail Boundary
� Detail Mark A1
� Detail Mark A1T
� Detail Mark A2
� Detail Mark A2T

1 Select a detail mark tool:

2 Specify the first point for the detail line.

3 Specify the second point for the detail line.

4 Do any of the following:

� To place a break in the detail line, enter b (Break). Specify a new point 
to continue the detail line.

� To change the detail symbol, enter s (Symbol).
� To change the length and width of the detail line’s tail, enter t (Tail).

5 Continue specifying points for the detail line.

6 Press ENTER when the line is finished.

7 If you are adding a boundary detail, specify points for the leader line.

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a detail 
mark tool, and select the tool.

use a detail mark from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the detail mark you want to use, and 
double-click it.
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8 Press ENTER when the leader is finished.

9 Enter the section mark number and the sheet number.

10 Click OK.

11 If you are adding a detail mark with a tail, specify the side on which to 
place the tail.

The symbol is placed in the drawing at the same angle as the last section of 
the leader line.

Creating Elevation Marks

Use this procedure to place elevation marks in your drawing. You can place 
up to four separate elevations using the 4-way elevation mark. You can add 
elevation marks to existing elevation objects. For more information about 
elevation marks, see “Drawing an Elevation Line and Mark” on page 2160. 
The software contains a number of predefined elevation marks. 

1 Select an elevation mark tool:

2 Specify the location for the elevation tag.

NOTE Different elevation marks have different prompts. The steps below 
may not correspond exactly to those for the elevation mark you are placing.

3 Specify the direction for the elevation.

4 Do any of the following:

� To change the symbol block for the elevation mark, enter s (Symbol).
� To change the arrow block for the elevation mark, enter a (Arrow).
� To change between the single and 4-way arrow block, enter t (Type).

5 Enter the elevation number and the sheet number, and click OK.

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains an 
elevation mark tool, and select the tool.

use an elevation mark from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the elevation mark you want to use, and 
double-click it.
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6 Enter y (Yes) to add an AEC elevation object to the elevation mark, and 
enter the width of the elevation object; or, enter n (No) to end the com-
mand.

The width is also the default depth of the elevation object.

Creating Angular Dimensions 

Use this procedure to place angular dimensions in your drawing. This 

AutoCAD® dimension has a layer key assigned to it.

1 Select an angular dimension tool:

2 Select an arc, circle, or line, or press ENTER to specify a vertex. 

3 Select a second line or specify a second angle endpoint.

4 Do any of the following:

� To add multiline text to the dimension line, enter m (Mtext). For more 
information about multiline text, see “Overview of Multiline Text” in 
the online AutoCAD® 2004 User’s Guide.

� To add text to the dimension line, enter t (Text).
� To specify an angle for the dimension line text, enter a (Angle).

5 Specify the location for the dimension line.

Creating Radial Dimensions 

Use this procedure to place radial dimensions in your drawing. This 

AutoCAD® dimension has a layer key assigned to it.

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a 
dimension symbol tool, and select the tool.

use a dimension from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the dimension symbol you want to use, 
and double-click it.
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1 Select a radius dimension tool:

2 Select an arc or a circle.

3 Do any of the following:

� To add multiline text to the dimension line, enter m (Mtext). For more 
information about multiline text, see “Overview of Multiline Text” in 
the online AutoCAD® 2004 User’s Guide.

� To add text to the dimension line, enter t (Text).
� To specify an angle for the dimension line text, enter a (Angle).

4 Specify the location for the dimension line.

Creating Section Marks

Use this procedure to place a section line and section mark in your drawing. 
You can add section marks to existing section objects. The software contains 
a number of predefined section marks.

1 Select a section mark tool:

2 Specify the first point for the section line.

3 Continue specifying points for the section line.

4 Do any of the following: 

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a 
dimension symbol tool, and select the tool.

use a dimension from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the dimension symbol you want to use, 
and double-click it.

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a section 
mark tool, and select the section mark tool.

use a section mark from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the section mark you want to use, and 
double-click it.
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� To place a break in the section mark line, enter b (Break). Specify a new 
point to continue the section mark line.

� To change the symbol block for the section mark, enter s (Symbol).
� To change the arrow block for the section mark, enter a (Arrow).
� To change the tail length and width, enter t (Tail).

5 Continue specifying points for the section line. 

6 Press ENTER when the line is finished.

7 Enter the section mark number and the sheet number.

8 Click OK.

9 Specify the side for the section mark arrow.

10 Enter y (Yes) to add an AEC section object to the section mark line, or enter 
n (No).

If you add an AEC section object to the section mark, it is created as a square 
(if there is one line) in the direction of the section mark arrow.

Creating Title Marks

Use this procedure to place title marks a your drawing.

1 Select a title mark tool:

2 Do any of the following: 

� To change the symbol block, enter s (Symbol block).
� To change the text block, enter te (Text block).
� To change the width of the polyline, enter w (polyline Width).

3 Specify the insertion point for the title mark.

4 Enter the title mark number, and click OK.

5 Enter the scale and title, and click OK.

If you want to . . . Then . . .

use a tool from a tool palette open the tool palette that contains a title mark 
tool, and select the tool.

use a title mark from 
DesignCenter

open DesignCenter. On the Custom tab, 
locate the title mark you want to use, and 
double-click it.
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6 Specify the endpoint for the title mark line.

Creating an Annotation Tool

Use this procedure to create an AEC content tool that references the AEC 
content drawing file in DesignCenter. 

1 Open the tool palette on which to create the tool.

2 Open DesignCenter, and locate the piece of AEC content to place on a tool 
palette.

3 Drag the AEC content from the right pane of DesignCenter to the tool pal-
ette.

4 Right-click the new tool, and click Properties.

5 Specify properties for the tool: 

6 Click OK.

Annotation Symbols Default Information

 Annotation symbols are placed by custom commands launched from the 

Autodesk® Architectural Desktop view of the DesignCenter. Each symbol con-
tent file contains the data necessary to construct a specific type of drawing 
annotation, specifically

� All graphics used in the symbol, for example: blocks, multi-view blocks, 
and mask blocks

� All styles used by the command, for example: dimension styles, linetypes, 
and text styles

� A set of dictionary entries, which controls how the DesignCenter places 
the symbol, including the custom command string

� Icon, preview image, and description text displayed in the DesignCenter

If you want to . . . Then . . .

name the image on the tool 
palette

enter text for Name.

add a tooltip description to the 
image

enter text for Description.
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For more information, see “Creating an AEC Drawing” on page 2346.

Dictionary entries consist of two parts. Those marked Common are generally 
the same for all content of that type, and are set on the Insert Options page 
of the AEC Content Wizard. The other entries are set in the command string 
of the content. A typical command string begins with the command name, 
followed by a series of label and data pairs, as shown in the following exam-
ple:

_AecAnnoSectionMarkAdd _SYMBOL Anno_Section_A2 _ARROW 
Anno_Arrow_A2 _TAIL .1875,.0625
The label is shown in all capital letters, but entries are not case-specific. The 
underscore has been added for use with translated versions of the software. 
It is important to separate each word by a single space, because each space is 
interpreted as pressing ENTER on the command line. All numeric parameters 
are based on the current units of the content file and are scaled based on the 
other scale settings in the content.

NOTE These settings are provided as examples only. They are not necessarily 
those in the shipping version of the product. To see all the command string 
options, enter -CreateContent(with a leading dash), and step through the 
prompts.

To modify custom content after creating it, open the file as read-only, so that 
you can save it with the same name in the Create AEC Content wizard. 
Remember that any changes in the wizard are not made in the currently open 
drawing, but only in the saved drawing. To make additional changes, you 
must open the drawing file again. Changes to the drawing other than in the 
wizard (for example, symbol definitions and dimstyles) can be made using 

the normal AutoCAD® OPEN and SAVE commands. The DesignCenter pre-
view window always displays the current view direction and display config-
uration of the content file when it was last saved. It does, however, perform 
a Zoom Extents, regardless of the last saved view. 
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Design Content

In the AutoCAD® DesignCenter™ , you can 
locate AEC drawing data and drawings and drag 
them into your drawings. Using the AEC Con-
tent Wizard, you can also create AEC content 
using multi-view blocks, masking blocks, and 
profiles and drag them into your drawings.

Related Procedures

� Using Design Content

� Adding Autodesk Architectural Desktop 
Content

� Adding Imperial Content

� Fixture Layout Overview

Using Design Content

Content in Autodesk® Architectural Desktop, is 
accessed through Custom view in AutoCAD 
DesignCenter. In Custom view, the top-level 
for AEC content is named Architectural Desk-
top. You can drag and drop AEC content onto a 
tool palette to create custom tools. 

In this chapter

� Using Design Content

� Adding Autodesk Architectural 
Desktop Content

� Fixture Layout Overview

32
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For more information about the specific differences between AutoCAD 
DesignCenter and the enhanced AutoCAD DesignCenter used with AEC con-
tent, see “AutoCAD DesignCenter Custom View” on page 2322. For informa-
tion about AutoCAD DesignCenter other than the Custom view, see 
“AutoCAD DesignCenter” in the online AutoCAD 2004 User’s Guide.

Related Procedures

� AutoCAD DesignCenter Custom View

AutoCAD DesignCenter Custom View
When you are in Custom view in AutoCAD DesignCenter, Architectural 
Desktop is at the top, and the tree view displays the file system folders and 
file system shortcuts only. All other files stored in the directory structure are 
not displayed. In Custom view, drawing files do not function as containers 
as they do in the Folders view of AutoCAD DesignCenter. Instead, each draw-
ing file represents one piece of AEC content; therefore, drawing files are not 
displayed in Custom view.

You can navigate the file system using shortcuts within Custom view to 
customize content hierarchies for specific needs. In all other aspects, naviga-
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tion in the Custom view tree is identical to navigation in the Folders view of 
AutoCAD DesignCenter.

Like other AutoCAD DesignCenter views, the Custom view palette provides 
four different display options: Large Icons, Small Icons, List, and Details. 
Only Large Icons display an image of the content. All other options display 
the generic DWG icon. When the view displays the contents of a directory, 
it displays all directories, drawings, and shortcuts. You can drag drawings and 
shortcuts to drawings from the view into the drawing. You can also drag AEC 
content to a tool palette for direct access or to create a custom tool.

Each file displayed in Custom view in the AutoCAD DesignCenter is a .dwg 
file containing one piece of AEC content.

Note the following specific differences between AutoCAD DesignCenter and 
Custom view in AutoCAD DesignCenter used with AEC Content: 

� Drawings that represent AEC content are not displayed in the tree view as 
containers. Drawings are shown only in the palette.

� The Preview window displays a user-controllable higher-resolution image 
of the content. This can be a different image from the Large Icons image. 
The Large Icons image is a bitmap stored with the drawing file. The 
preview is the last saved view of the content drawing zoomed to the 
extents of the drawing. 

� Special icons indicate shortcuts.
� The root of Custom view is named Architectural Desktop.

The Preview window provides a higher-resolution preview of the content 
than is available in the Large Icons view. In the Custom view, the Preview 
window behaves exactly like the Object Viewer. For more information, see 
“Using the Object Viewer” on page 2542. The Object Viewer shortcut menu 
is available. Left-clicking rotates the contents dynamically.

Text in the Description pane provides more details about the currently 
selected content.

Adding Autodesk Architectural Desktop Content

You can place imperial and metric symbols through AutoCAD DesignCenter.

Related Procedures

� Adding Documentation Content

� Adding Imperial Content

� Adding Metric Design Content
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Adding Documentation Content
You can place imperial or metric documentation symbols, such as break 
marks or elevation labels, through AutoCAD DesignCenter. 

Adding Break Mark Content
Using AutoCAD DesignCenter, you can drag break marks, such as bars, cut 
lines, and pipes, into your drawing or onto a tool palette. These symbols are 
automatically scaled and are placed in your drawing using the current display 
configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Break Marks. 

5 Select a break mark symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block onto a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, then an Insert option is displayed. 

Adding Chase Content
Using AutoCAD DesignCenter, you can drag chases, such as return and sup-
ply chases, into your drawing or onto a tool palette. These symbols are auto-
matically scaled and are placed in your drawing using the current display 
configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Chases. 

5 Select a chase symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 
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6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. The 
Add Multi-View Block dialog box is displayed to place the block.

Adding Detail Mark Content
Using AutoCAD DesignCenter, you can drag detail marks into your drawing 
or onto a tool palette. These symbols are automatically scaled and are placed 
in your drawing using the current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Detail Marks. 

5 Select a detail mark symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. 

Adding Elevation Label Content
Using AutoCAD DesignCenter, you can drag elevation labels, such as 2D sec-
tion, model, and plan labels, into your drawing or onto a tool palette. These 
symbols are automatically scaled and are placed in your drawing using the 
current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.
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3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and expand Elevation Labels. 

5 Select a type of elevation label, such as 2D Section, Model, or Plan.

6 Select an elevation label symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. The 
Add Elevation Label dialog box is displayed to place the block.

Adding Elevation Mark Content
Using AutoCAD DesignCenter, you can drag elevation marks into your draw-
ing or onto a tool palette. These symbols are automatically scaled and are 
placed in your drawing using the current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Elevation Marks. 

5 Select an elevation mark symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. 
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Adding Leader Content
Using AutoCAD DesignCenter, you can drag leaders, such as spline and 
straight leaders, into your drawing or onto a tool palette. These symbols are 
automatically scaled and are placed in your drawing using the current display 
configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Leaders. 

5 Select a leader symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. 

Adding Miscellaneous Documentation Content
Using AutoCAD DesignCenter, you can drag miscellaneous documentation 
symbols, such as datum points, match lines, and north arrows, into your 
drawing or onto a tool palette. These symbols are automatically scaled and 
are placed in your drawing using the current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and expand Miscellaneous. 

5 Select a type of miscellaneous documentation symbol, such as Dimen-
sions, Fire Rating Lines, Match Lines, or North Arrows.

6 Select a miscellaneous documentation symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 
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7 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, then an Insert option is displayed. 

Adding Revision Cloud Content
Using AutoCAD DesignCenter, you can drag revision clouds into your draw-
ing or onto a tool palette. These symbols are automatically scaled and are 
placed in your drawing using the current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Revision Clouds. 

5 Select a revision cloud symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. 

Adding Schedule Tag Content
Using AutoCAD DesignCenter, you can drag schedule tags, such as door and 
window tags, into your drawing or onto a tool palette. These symbols are 
automatically scaled and are placed in your drawing using the current display 
configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.
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4 Expand Documentation, and expand Schedule Tags. 

5 Select a type of schedule tag, such as Area Tags, Door & Window Tags, 
Object Tags, Room & Finish Tags, or Wall Tags.

6 Select a schedule tag symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. For more informa-
tion, see “Displaying Property Set Data When You Add a Tag” on page 2233.

Adding Section Mark Content
Using AutoCAD DesignCenter, you can drag section marks into your drawing 
or onto a tool palette. These symbols are automatically scaled and are placed 
in your drawing using the current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Section Marks. 

5 Select a section mark symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. 
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Adding Title Mark Content
Using AutoCAD DesignCenter, you can drag title marks into your drawing or 
onto a tool palette. These symbols are automatically scaled and are placed in 
your drawing using the current display configuration. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Documentation, and select Title Marks. 

5 Select a title mark symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

6 Drag the block into your drawing, select a location for the insertion point, 
and follow the prompts to place the symbol in the drawing.

You can also drag the block on to a tool palette to create a tool.

The block is placed in your drawing using the current display configuration.

NOTE If you right-click to place the block, an Insert option is displayed. Enter 
information about the block in the Edit Attributes dialog box. 

Adding Imperial Content
You can place imperial symbols through AutoCAD DesignCenter. Imperial 
content is categorized by the standard CSI Master divisions.

Adding General Requirements Content
Using AutoCAD DesignCenter, you can drag CSI Division 1 General 
Requirements symbols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand General.

5 Select a type of symbol, such as People, People Elevation, or Scale Figure.

6 Select a general symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 
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You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Division 2 Site Construction Content
Using AutoCAD DesignCenter, you can drag CSI Division 2 Site Construction 
symbols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Site.

5 Select a type of symbol, such as Basic Site, Utility Services, Drainage, Park-
ing, or Planting.

6 Select a site symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Specialties Content
Using AutoCAD DesignCenter, you can drag CSI Division 10 Specialties sym-
bols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Specialties.
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5 Select a type of symbol, such as Fire Protection or Toilet & Bath Accesso-
ries.

6 Select a specialties symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Equipment Content
Using AutoCAD DesignCenter, you can drag CSI Division 11 Equipment 
symbols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Equipment.

5 Select a type of symbol, such as Vending, Food Service, Residential, Unit 
Kitchens, or Office.

6 Select an equipment symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Division 12 Furnishing Content
Using AutoCAD DesignCenter, you can drag CSI Division 12 Furnishing sym-
bols into your drawing. 
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1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Furnishings.

5 Select a type of symbol, such as Art, Casework, Accessories, Furniture, or 
Plants.

6 Select a furnishing symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Division 13 Special Construction Content
Using AutoCAD DesignCenter, you can drag CSI Division 13 Special 
Construction symbols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Special Constr.

5 Select a type of symbol, such as Detection and Alarm.

6 Select a special construction symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.
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8 Specify a rotation angle for the symbol, and press ENTER.

Adding Division 14 Conveying Systems Content
Using AutoCAD DesignCenter, you can drag CSI Division 14 Conveying 
Systems symbols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Conveying.

5 Select a type of symbol, such as Elevators or Ladders.

6 Select a conveying symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Division 15 Mechanical Content
Using AutoCAD DesignCenter, you can drag CSI Division 15 Mechanical 
symbols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Mechanical.

5 Select a type of symbol, such as Plumbing Fixtures, Air Distribution, or 
HVAC Controls.

6 Select a mechanical symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.
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NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Division 16 Electrical Content
Using AutoCAD DesignCenter, you can drag CSI Division 16 Electrical sym-
bols into your drawing. 

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial.

4 Expand Design, and expand Electrical.

5 Select a type of symbol, such as Power, Lighting, or Communications.

6 Select an electrical symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Metric Design Content
Using AutoCAD DesignCenter, you can add metric design symbols to your 
drawing.

Adding Bathroom Fixtures Content
Using AutoCAD DesignCenter, you can drag bathroom fixture symbols, such 
as basins, baths, and showers, into your drawing or onto a tool palette.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.
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4 Expand Design, and expand Bathroom.

5 Select a type of symbol, such as Basin, Shower, or Toilet.

6 Select a bath symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Domestic Furniture Content
Using AutoCAD DesignCenter, you can drag domestic furniture symbols, 
such as garden furniture and potted plants, into your drawing or onto a tool 
palette.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.

4 Expand Design, and expand Domestic Furniture.

5 Select a type of symbol, such as Bedroom, Garden, or Plants.

6 Select a furniture symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Electrical Services Content
Using AutoCAD DesignCenter, you can drag electrical service symbols, such 
as power outlets and switches, into your drawing or onto a tool palette.
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1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.

4 Expand Design, and expand Electrical Services.

5 Select a type of symbol, such as Communications, Power Outlets, or 
Switches.

6 Select an electrical service symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Kitchen Fittings Content
Using AutoCAD DesignCenter, you can drag kitchen fitting symbols, such as 
sinks and appliances, into your drawing or onto a tool palette.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.

4 Expand Design, and expand Kitchen Fittings.

5 Select a type of symbol, such as Appliances, Sinks, or Units.

6 Select a kitchen fitting symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.
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8 Specify a rotation angle for the symbol, and press ENTER.

Adding Office Furniture Content
Using AutoCAD DesignCenter, you can drag furniture symbols, such as con-
ference tables and filing cabinets, into your drawing or onto a tool palette.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.

4 Expand Design, and expand Office Furniture.

5 Select a type of symbol, such as Chairs, Desks, or Tables.

6 Select an office furniture symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Pipe and Duct Content
Using AutoCAD DesignCenter, you can drag pipe and duct symbols, such as 
pipe details and sanitary fittings, into your drawing or onto a tool palette.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.

4 Expand Design, and expand Piped and Ducted Services.

5 Select a type of symbol, such as Ceiling, Drainage, or Valves.

6 Select a pipe and duct symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.
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NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Adding Site Content
Using AutoCAD DesignCenter, you can drag site symbols, such as boats and 
trees, into your drawing or onto a tool palette.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Metric.

4 Expand Design, and expand Site.

5 Select a type of symbol, such as Boats, Trees, or Vehicles.

6 Select a site symbol from the right pane.

You can view the symbol in 2D and 3D in the Preview window. 

7 Drag the block into your drawing and place it at the location for the block. 

You can also drag the block onto a tool palette to create a tool.

NOTE If you right-click to place the block, an Insert option is displayed, and 
you can place multiple copies of the content. Use the Properties palette to 
specify the insertion point or edit attributes as you add the block.

8 Specify a rotation angle for the symbol, and press ENTER.

Fixture Layout Overview

Using DesignCenter, you can drag various pre-constructed fixture layouts 
into your drawings. Then, you can explode them into component parts. For 
example, after you drop a toilet stall into your drawing and explode it, the 
stall walls are wall objects, the door to the stall is a door object, and the toilet 
is a multi-view block. You can also drag the fixture layouts onto a tool palette 
to create custom tools.

See “Fixture Layout Notes and Hints” on page 2340 for more information 
about fixture layout content.
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DISCLAIMER: The intent of the fixture layouts is to provide samples from 
which to create your own office standards for restroom design. All of the 
components can be modified, as required, to meet project and code require-
ments, then added to the DesignCenter for access. The samples provided do 
not necessarily meet jurisdictional regulations or ADA (Americans with 
Disabilities Act) requirements.

Related Procedures

� Placing Fixture Layout Content 

Fixture Layout Notes and Hints
The following is a list of notes and hints for working with fixture layouts 
available through DesignCenter:

� The layout files are custom content set to Content Type: Drawing.
� The layout files have no layer key, because all objects have hard-coded lay-

ers within the file. You can change the layers, as required.
� The layout files are not set to Explode on Insert, because you can place 

them at only one rotation and orientation (not mirrored), and it is easier 
to reposition them as unexploded blocks.

� To set rotation and mirroring before insertion, double-click the icon 
instead of dragging the content to display the standard AutoCAD Insert 
dialog box.

� The rotation angle and scale (for mirroring) can be set in the Insert dialog 
box or on the command line. If you use the command line, you can see 
the result of each option before actually inserting the content. You can 
apply multiple settings on the command line, even though the prompt 
says “Specify insertion point:” after the first one. You can still type 
another X, Y, or R.

� Use X = -1 or Y = -1 to mirror the content.
� Use the NODe object snap to position individual stall and urinal layouts 

next to each other. The toilet partitions and screens are inserted with cen-
tered baselines, so the node snap places them correctly.

� After insertion, the stall layouts can be exploded in order to have the par-
tition objects clean up with each other. The layout can also be adjusted to 
extend partitions, or move doors, fixtures, or grab bars.

� Stall partitions are wall objects placed in the wall group “Toilet_Ptn.” They 
do not clean up with other walls. Urinal screens are in the “Standard” 
group, but set to “Do Not Cleanup.”

� Each lavatory layout consists of a counter, made of a wall object with the 
cleanup group “Toilet_Counter” with lavatory MV Blocks anchored as 
follows:

Lavs (1) Wall anchor; centered along curve
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Lavs (2) - (4) Layout Curve (on counter); even spacing (1’-6” start & end 
offset)

Lavs (5) Layout Curve (on counter); repeat @ 3’-0” (1’-6” start & end off-
set)

� Use the ENDpoint object snap to position a counter against a stall or uri-
nal screen.

� After exploding, the lav counters can be trimmed or extended to the rest 
room walls. The lavs adjust appropriately, depending on the anchoring 
mode.

� The rest room files are preconfigured assemblies of individual layouts, 
arranged as typical Men’s and Women’s rooms.

Placing Fixture Layout Content
Using AutoCAD DesignCenter, you can place fixture layouts into your draw-
ing. Then, you can explode the layout into its component parts that can be 
modified to your specifications.

NOTE After you create your custom fixture layout, save the layout as Custom 
Design Content for easy placement in future drawings.

See “Fixture Layout Notes and Hints” on page 2340for more information 
about fixture layout content.

1 Click  on the Navigation toolbar to open AutoCAD DesignCenter.

2 Click the Custom tab.

3 Under Custom Applications, expand Architectural Desktop, and expand 
Imperial or Metric.

4 Expand Design, and expand one of the following layouts:

� For imperial content, Mechanical\Plumbing Fixtures\Layouts
� For metric content, Bathroom\Layouts

5 Double-click a layout.

You can view the symbol in 2D and 3D in the Preview window. 

6 Use the Insert dialog box to control the placement of the layout, and click 
OK.

7 Specify a location for the fixture layout.

8 To modify the components of the layout, type explode.

9 Select the fixture layout, and press ENTER.
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The components can be edited separately.
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Custom Content

Autodesk® Architectural Desktop provides a wiz-
ard to help you create your own custom con-
tent. You can create blocks, drawings, and com-
mands from data existing in the current draw-
ing.

To create custom content, you first select the 
content type to be created. Next, you set 
options to be used when content is inserted into 
a drawing. The final step is to specify the output 
file and other parameters that control how the 

DesignCenterTM displays the content. 

When creating content in an existing AEC file 
(that is, a drawing generated from the Create 
AEC Content Wizard), the default values for 
each page of the wizard are set to the value used 
to create the drawing. This provides intelligent 
defaults so that it is easy for you to make small 
modifications to existing content files. 

Related Procedures

� Creating an AEC Block

� Creating an AEC Drawing

� Creating an AEC Multi-View Block

� Creating an AEC Masking Block

� Creating an AEC Custom Command

In this chapter

� Creating an AEC Block

� Creating an AEC Drawing

� Creating an AEC Multi-View 
Block

� Creating an AEC Masking Block

� Creating an AEC Custom 
Command

33
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Creating an AEC Block

Use this procedure to create a new AEC block that you can add to your draw-
ing using DesignCenter. You create a new block from an existing block in the 
current drawing. The block is saved in a new drawing that can be accessed 
from DesignCenter.

1 On the Format menu, click AEC Content Wizard.

2 Select Block for Content Type.

All of the defined blocks in the current drawing are displayed in Current 
Drawing.

3 Select a block for Current Drawing, and click Add.

Only one block can be selected at a time for Current Drawing and added 
to Content File.

4 Click Next.

5 Specify an insertion method for Insert Options:

6 Specify an insertion scale factor for Scale: 

If you want to . . . Then . . .

explode the AEC block when you add it 
to your drawing

select Explode on Insert.

have the AEC block remain a block 
when you add it to your drawing

clear Explode on Insert.

specify an elevation for the AEC block 
when adding it to your drawing

enter a value for Preset Elevation.

specify an anchor type to use when 
adding the AEC block to your drawing

select a type of anchor for Anchor Type.

If you want to . . . Then . . .

scale the AEC block instance using a 
coordinate (X, Y, Z) direction

enter values for X, Y, and Z for Scale.

apply no additional scaling method to 
the AEC block instance

select None for Additional Scaling.
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7 If there are attributes in the block, specify a text style for Attribute Text 
Style:

8 If there are attributes in the block, specify an angle for Attribute Text 
Angle:

9 Click Select Layer Key, select a layer key, and click OK. 

You can also enter a layer name for Layer Key.

10 Click Next.

scale the AEC block instance by the 
annotation scale of the drawing you 
are adding the block to

select Annotation for Additional Scaling.

scale the AEC block instance by the 
drawing units of the drawing you are 
adding the block to

select Drawing for Additional Scaling.

scale the AEC block definition by the 
drawing units of the drawing you are 
adding the block to

select Enable AEC Unit Scaling.

If you want to . . . Then . . .

assign the attribute the default text 
style of AEC content in the current 
drawing

select As Defined by Content.

assign the attribute the text style of the 
target drawing

select Target Drawing Text Style.

If you want to . . . Then . . .

assign the angle of the attribute text to 
be the same as the rotation angle of 
the AEC block

select As Inserted.

set the angle of the attribute text to 
zero

select Force Horizontal.

be able to read the attribute text from 
the right direction

select Right Reading.

If you want to . . . Then . . .
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11 Enter a name for File Name, or click Browse.

If you want to save the current drawing as the content file, select Current 
Drawing.

12 Select an image to represent the AEC block in DesignCenter for Icon:

13 Enter a description for Detailed Description.

14 If you want to save the drawing objects in the content file, select Save Pre-
view Graphics.

15 Click Finish.

Creating an AEC Drawing

Use this procedure to create a new AEC drawing that you can open using 
DesignCenter. An AEC drawing allows you to insert a drawing with all of its 
content, including styles, blocks, layers, and linetypes.

1 On the Format menu, click AEC Content Wizard.

2 Select Drawing for Content Type, and click Next.

3 Specify an insertion method for Insert Options:

If you want to . . . Then . . .

specify an existing bitmap image click New Icon, select an image, and 
click OK.

specify the default image of the AEC 
block itself

click Default Icon.

If you want to . . . Then . . .

specify an elevation enter a value for Preset Elevation.

specify an anchor type select a type of anchor for Anchor Type.
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4 Specify an insertion scale factor for Scale: 

5 Specify an angle for Attribute Text Angle:

6 Click Select Layer Key, select a layer key, and click OK. 

You can also enter a layer name for Layer Key.

7 Click Next.

8 Enter a name for File Name, or click Browse.

If you want to save the current drawing as the content file, select Current 
Drawing.

If you want to . . . Then . . .

scale the AEC drawing instance using a 
coordinate (X, Y, Z) direction

enter values for X, Y, and Z for Scale.

apply no additional scaling method to 
the AEC drawing instance

select None for Additional Scaling.

scale the AEC drawing instance by the 
annotation scale of the drawing you 
are adding the block to

select Annotation for Additional Scaling.

scale the AEC drawing instance by the 
drawing units of the drawing you are 
adding the block to

select Drawing for Additional Scaling.

scale the AEC drawing definition by the 
drawing units of the drawing you are 
adding the block to

select Enable AEC Unit Scaling.

If you want to . . . Then . . .

assign the angle of the attribute text to 
be the same as the rotation angle of 
the AEC drawing

select As Inserted.

set the angle of the attribute text to 
zero

select Force Horizontal.

be able to read the attribute text from 
the right direction

select Right Reading.
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9 Select an image to represent the AEC drawing in DesignCenter for Icon:

10 Enter a description for Detailed Description.

11 Click Finish.

Creating an AEC Multi-View Block

Use this procedure to create a new AEC multi-view block that you can add to 
your drawing using DesignCenter. You define a multi-view block from view 
blocks created in your drawing that represent different views of your custom 
object. The block is saved in a new drawing that can be accessed from Design-
Center. For more information, see “Creating View Blocks”.

1 On the Format menu, click AEC Content Wizard.

2 Select Multi-View Block for Content Type.

All of the defined blocks in the current drawing are displayed in Current 
Drawing.

3 Select a multi-view block for Current Drawing, and click Add.

Only one block can be selected at a time for Current Drawing and added 
to Content File.

4 Click Next.

5 Specify an insertion method for Insert Options:

If you want to . . . Then . . .

specify an existing bitmap image click New Icon, select an image, and 
click OK.

specify the default image of the AEC 
drawing itself

click Default Icon.

If you want to . . . Then . . .

explode the AEC multi-view block 
when you add it to your drawing

select Explode on Insert.

have the AEC multi-view block remain 
a block when you add it to your 
drawing

clear Explode on Insert.
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6 Specify an insertion scale factor for Scale: 

7 If there are attributes in the block, specify a text style for Attribute Text 
Style:

specify an elevation for the AEC multi-
view block when adding it to your 
drawing

enter a value for Preset Elevation.

specify an anchor type to use when 
adding the AEC multi-view block to 
your drawing

select a type of anchor for Anchor Type.

If you want to . . . Then . . .

scale the AEC multi-view block instance 
using a coordinate (X, Y, Z) direction

enter values for X, Y, and Z for Scale.

apply no additional scaling method to 
the AEC multi-view block instance

select None for Additional Scaling.

scale the AEC multi-view block instance 
by the annotation scale of the drawing 
you are adding the block to

select Annotation for Additional Scaling.

scale the AEC multi-view block instance 
by the drawing units of the drawing 
you are adding the block to

select Drawing for Additional Scaling.

scale the AEC multi-view block 
definition by the drawing units of the 
drawing you are adding the block to

select Enable AEC Unit Scaling.

If you want to . . . Then . . .

assign the attribute the default text 
style of AEC content in the current 
drawing

select As Defined by Content.

assign the attribute the text style of the 
target drawing

select Target Drawing Text Style.

If you want to . . . Then . . .
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8 If there are attributes in the block, specify an angle for Attribute Text 
Angle:

9 Click Select Layer Key, select a layer key, and click OK. 

You can also enter a layer name for Layer Key.

10 Click Next.

11 Enter a name for File Name, or click Browse.

If you want to save the current drawing as the content file, select Current 
Drawing.

12 Select an image to represent the AEC multi-view block in DesignCenter for 
Icon:

13 Enter a description for Detailed Description.

14 Click Finish.

Creating an AEC Masking Block

Use this procedure to create a custom AEC masking block that you can add 
to your drawing using DesignCenter. You create a new AEC masking block 
from an existing AEC masking block in the current drawing. The AEC mask-

If you want to . . . Then . . .

assign the angle of the attribute text to 
be the same as the rotation angle of 
the AEC multi-view block

select As Inserted.

set the angle of the attribute text to 
zero

select Force Horizontal.

be able to read the attribute text from 
the right direction

select Right Reading.

If you want to . . . Then . . .

specify an existing bitmap image click New Icon, select an image, and 
click OK.

specify the default image of the AEC 
multi-view block itself

click Default Icon.
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ing block is saved in a new drawing that can be accessed from DesignCenter. 
For more information about using masking blocks, see “Mask Blocks” on 
page 2459.

1 On the Format menu, click AEC Content Wizard.

2 Select Masking Block for Content Type.

All of the defined blocks in the current drawing are displayed in Current 
Drawing.

3 Select a masking block for Current Drawing, and click Add.

Only one block can be selected at a time for Current Drawing and added 
to Content File.

4 Click Next.

5 Specify an insertion method for Insert Options:

6 Specify an insertion scale factor for Scale: 

If you want to . . . Then . . .

specify an elevation enter a value for Preset Elevation.

specify an anchor type select a type of anchor for Anchor Type.

If you want to . . . Then . . .

scale the AEC masking block instance 
using a coordinate (X, Y, Z) direction

enter values for X, Y, and Z for Scale.

apply no additional scaling method to 
the AEC masking block instance

select None for Additional Scaling.

scale the AEC masking block instance 
by the annotation scale of the drawing 
you are adding the block to

select Annotation for Additional Scaling.

scale the AEC masking block instance 
by the drawing units of the drawing 
you are adding the block to

select Drawing for Additional Scaling.

scale the AEC masking block definition 
by the drawing units of the drawing 
you are adding the block to

select Enable AEC Unit Scaling.
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7 If there are attributes in the block, specify a text style for Attribute Text 
Style:

8 If there are attributes in the block, specify an angle for Attribute Text 
Angle:

9 Click Select Layer Key, select a layer key, and click OK. 

You can also enter a layer name for Layer Key.

10 Click Next.

11 Enter a name for File Name, or click Browse.

If you want to save the current drawing as the content file, select Current 
Drawing.

12 Select an image to represent the AEC drawing in DesignCenter for Icon:

If you want to . . . Then . . .

assign the attribute the default text 
style of AEC content in the current 
drawing

select As Defined by Content.

assign the attribute the text style of the 
target drawing

select Target Drawing Text Style.

If you want to . . . Then . . .

assign the angle of the attribute text to 
be the same as the rotation angle of 
the AEC masking block

select As Inserted.

set the angle of the attribute text to 
zero

select Force Horizontal.

be able to read the attribute text from 
the right direction

select Right Reading.

If you want to . . . Then . . .

specify an existing bitmap image click New Icon, select an image, and 
click OK.

specify the default image of the AEC 
drawing itself

click Default Icon.
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13 Enter a description for Detailed Description.

14 Click Finish.

Creating an AEC Custom Command

Use this procedure to create a custom command that you can add to your 
drawing environment using DesignCenter. You select one or more content 
blocks, specify a command string, and save a new drawing that contains all 
of the content in the current drawing. When the custom command is added 
to a target drawing from DesignCenter, the set of content blocks is copied 
into the target drawing and the command string is executed enabling the 
custom command.

The following is a detailed example of a custom command that you can cre-
ate. The following custom command string adds a schedule tag to a door 
symbol and automatically creates the leader and tag with the desired style.

_AecAnnoScheduleTagAdd PropertySetDefs.dwg_SYMBOL 
Aec3_Door_Tag_LEADER_None_DIMSTYLE_Current

The equivalent command line prompts to add a schedule tag to a door sym-
bol and add a leader and tag with the desired style and much longer and 
tedious.

Command: AnnoScheduleTagAdd
Property set definitions drawing <PropertySetDefs.dwg>: 
C:\Documents and Settings\All Users\Application 
Data\Autodesk\Autodesk Architectural Desktop 
2004\R16.0\enu\AEC Content\Imperial\Documentation\Schedule 
Tags\PropertySetDefs.dwg
Select object to tag [Symbol/Leader/Dimstyle/Edit]: Symbol
Enter tag symbol name <>: Aec3_Door_Tag
Select object to tag [Symbol/Leader/Dimstyle/Edit]: Leader
Enter leader type [None/STraight/SPline] <None>: None
Select object to tag [Symbol/Leader/Dimstyle/Edit]: Dimstyle
Enter leader dimstyle CURRENT <Aec-Arch-I-96>: Current
Select object to tag [Symbol/Leader/Dimstyle/Edit]:

1 On the Format menu, click AEC Content Wizard.

2 Select Custom Command for Content Type.

All of the defined blocks, regardless of type, are displayed in Current 
Drawing.

3 Select one or more blocks for Current Drawing, and click Add.

4 Enter the command string for Custom String. 
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You can also click Expand to display the Custom Command String dialog 
box, and enter the command string.

The command string is limited to 255 characters.

5 Click Next.

6 Specify an insertion method for Insert Options:

7 Specify an insertion scale factor for Scale: 

8 Specify an angle for Attribute Text Angle:

If you want to . . . Then . . .

specify an elevation enter a value for Preset Elevation.

specify an anchor type select a type of anchor for Anchor Type.

If you want to . . . Then . . .

scale the AEC drawing instance using a 
coordinate (X, Y, Z) direction

enter values for X, Y, and Z for Scale.

apply no additional scaling method to 
the AEC drawing instance

select None for Additional Scaling.

scale the AEC drawing instance by the 
annotation scale of the drawing you 
are adding the block to

select Annotation for Additional Scaling.

scale the AEC drawing instance by the 
drawing units of the drawing you are 
adding the block to

select Drawing for Additional Scaling.

scale the AEC drawing definition by the 
drawing units of the drawing you are 
adding the block to

select Enable AEC Unit Scaling.

If you want to . . . Then . . .

assign the angle of the attribute text to 
be the same as the rotation angle of 
the AEC drawing

select As Inserted.

set the angle of the attribute text to 
zero

select Force Horizontal.



Creating an AEC Custom Command | 2355

9 Click Select Layer Key, select a layer key, and click OK. 

You can also enter a layer name for Layer Key.

10 Click Next.

11 Enter a name for File Name, or click Browse.

If you want to save the current drawing as the content file, select Current 
Drawing.

12 Select an image to represent the AEC drawing in DesignCenter for Icon:

13 Enter a description for Detailed Description.

14 Click Finish.

be able to read the attribute text from 
the right direction

select Right Reading.

If you want to . . . Then . . .

specify an existing bitmap image click New Icon, select an image, and 
click OK.

specify the default image of the AEC 
drawing itself

click Default Icon.

If you want to . . . Then . . .
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AEC Dimensions

AEC dimensions are objects used to describe the rele-

vant measurements of a building object, like the width 

of a wall or the length of a beam. Dimension presenta-

tion can be different according to country and company 

standards and is defined by styles.

In this chapter

� Dimension Types and Uses

� Logical Dimension Points of 
AEC and AutoCAD Objects

� Specifying AEC Dimension 
Preferences

� Creating an AEC Dimension

� Creating an Automatic or 
Manual AEC Dimension with 
User-Specified Settings

� Creating an AEC Dimension 
from an AutoCAD Dimension

� Copying Properties of AEC 
Dimensions to AutoCAD 
Dimensions

� Creating an AEC Dimension 
Tool

� Attaching Objects to 
Dimensions

� Detaching Objects from 
Dimensions

� Adding Dimension Points

� Removing and Restoring 
Dimension Points

� Editing AEC Dimensions

� AEC Dimension Styles

34
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Autodesk® Architectural Desktop offers a number of ways to dimension dif-
ferent types of objects. Each method has special uses and features that make 
it suited to specific tasks. 

Dimensioning methods can be divided in two categories: AEC dimensions 

and AutoCAD® dimensions. Both have automatic (associative) and manual 
(non-associative) modes. For their main characteristics and features, see 
“Dimension Types and Uses” on page 2359.

You can use AEC dimensions and AutoCAD dimensions simultaneously in a 
single drawing. 

NOTE AEC dimension functionality contains specific modifications for Euro-
pean architecture. Illustrations showing AEC dimensions are displayed in metric, 
not imperial, measurements. You can dimension in imperial measurements as 
well, but some features like superscripting are not available for imperial units. 

Related Topics

� Dimension Types and Uses

� Logical Dimension Points of AEC and AutoCAD Objects

� Considerations for Choosing a Dimension Type

� Specifying AEC Dimension Preferences

� Creating AEC Dimensions Using AEC Dimension Tools

� Creating an AEC Dimension

� Creating an Automatic AEC Dimension with User-Specified Settings

� Creating a Manual AEC Dimension with User-Specified Settings

� Creating an AEC Dimension from an AutoCAD Dimension

� Copying Properties of AEC Dimensions to AutoCAD Dimensions

� Creating an AEC Dimension Tool

� Attaching Objects to Dimensions

� Detaching Objects from Dimensions

� Adding Dimension Points

� Removing and Restoring Dimension Points

� Editing AEC Dimensions

� AEC Dimension Styles

� Q and A for Working with AEC Dimensions



Dimension Types and Uses | 2359

Dimension Types and Uses

Four dimensioning methods are available. The following table lists the differ-
ences between them:

Related Topics 

� Associative AEC Dimensions

Associative 
AEC 
dimensions

Manual AEC 
dimensions

Associative 
AutoCAD® 
dimensions

Non-
associative 
AutoCAD 
dimensions

Logical dimension 
points taken from 
AEC or AutoCAD 
objects 

Manual 
dimension points 
taken from 
drawing

Logical 
dimension points 
from AutoCAD 
objects

Manual 
dimension 
points taken 
from drawing

Dimension AEC 
objects and 
AutoCAD objects 

Dimension 
specified points in 
drawing

Dimension 
AutoCAD objects 

Dimension 
specified points 
in drawing

Dimension 
external references

Do not dimension 
external 
references

Do not 
dimension 
external 
references

Do not 
dimension 
external 
references

Associative toward 
object 

Associative or 
non-associative 
toward points, 
depending on 
user settings

Associative 
toward object

Partly 
associative 
toward points

Dimension groups Dimension 
groups

Single 
dimensions

Single 
dimensions

Support 
superscripting; 
support fixed and 
variable extension 
lines 

Support 
superscripting; 
support fixed and 
variable extension 
lines 

Support no 
superscripting; 
support no fixed 
and variable 
extension lines 

Support no 
superscripting; 
support no 
fixed and 
variable 
extension lines 

Defined by AEC 
dimension style 
and AutoCAD 
dimension style

Defined by AEC 
dimension style 
and AutoCAD 
dimension style

Defined by 
AutoCAD 
dimension style

Defined by 
AutoCAD 
dimension style
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� Manual AEC Dimensions

� AutoCAD Dimensions

Associative AEC Dimensions

Associative AEC dimensions offer maximum functionality for dimensioning. 

Associative dimensioning of logical points

To create associative AEC dimensions, you select architectural objects or 

AutoCAD® linework and dimension their logical points. You can choose from 
a number of logical points for every object that can be dimensioned. Before 
you add the dimension, you decide which of those logical points are relevant 
for you. For example, you can dimension the following points in an auto-
matic AEC dimension for a wall: 

� Outer boundaries of the wall
� Wall lengths
� Width of wall components
� Wall intersections
� Openings in the wall

Logical dimension points react associatively toward building elements or 
linework. When the dimensioned object changes its measurements, the 
dimensioned points are updated accordingly. When the dimensioned object 
is moved, the dimension chains are moved accordingly. 
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Automatic AEC dimensions can take logical points from AEC objects and 
AutoCAD objects. 

For a complete list of available objects and dimension points, see “Logical 
Dimension Points of AEC and AutoCAD Objects” on page 2363.

You can define different dimension points for different views. For example, 
in Plan Low Detail, you might dimension the outer boundaries of a building, 
and in Plan High Detail dimension additionally wall lengths and openings.

AEC dimensions can be inserted as dimension groups. A dimension group 
consists of several dimension chains used to dimension the same object, but 
with different points to measure. When you dimension a house, for example, 
you can measure the outer boundaries of the dimensioned walls in one 
dimension chain, and the length of the dimensioned walls in another 
dimension chain. Dimension groups also have settings for superscripting 
and variable extension line length. 

Automatic AEC dimensions have the ability to dimension objects in external 
references, even when they are nested multiple levels deep. This is very useful 
for large drawing projects, where the parts of the building are distributed over 
various drawing files.

Process Overview: Creating Automatic AEC Dimensions
The general process for creating automatic AEC dimensions involves the fol-
lowing steps:

Step 1: Create an AEC dimension style that contains the following settings:

� number of dimension chains
� object types to be dimensioned (for example, walls or mass elements)
� logical points to be dimensioned (for example, wall components and 

wall intersections)
� look of the dimension (for example, arrow shapes, color, or linetypes)

TIP Before you create a new style, look through the templates to find an 
existing style that contains most of your desired settings. You can then modify 
it for your purposes. 

Step 2: Dimension an object in the drawing using the AEC dimension style 
you created or selected. 

Related Procedures

� Logical Dimension Points of AEC and AutoCAD Objects
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� Creating an AEC Dimension Style

� Creating an Automatic AEC Dimension with User-Specified Settings

Manual AEC Dimensions

Manual AEC dimensions are similar to automatic AEC dimensions, but do 
not contain logical dimension points. Therefore, you can dimension any 
point that you select in a drawing. The manual AEC dimension can react 
associatively to these points or remain fixed, depending on your settings. For 
more information about setting the behavior of manual AEC dimensions, see 
“Setting the Point Mode for Manual AEC Dimensions” on page 2378.

Like automatic AEC dimensions, manual AEC dimensions contain settings 
for superscripting, for defining fixed or variable extension lines, and for 
grouping dimension chains into groups.

You can also take non-associative AutoCAD® dimensions and convert them 
to manual AEC dimensions.

Manual AEC dimensions cannot dimension points in an external reference, 
but they can snap to points from the external reference when OSNAP is 
turned on.

Process Overview: Creating Manual AEC Dimensions
Creating manual AEC dimensions involves the following steps:

Step 1: Create an AEC dimension style that contains the following settings:

� number of dimension chains
� look of the dimension (for example, arrow shapes, color, or linetypes)

TIP Before you create a new style, look through the templates to find an 
existing style that contains most of your desired settings. You can then modify 
it for your purposes. 

Step 2: Specify the dimension point mode.

The dimension point mode determines whether the resulting dimensions 
are associative or non-associative to their dimensioned points.

Step 3: Create the dimension:

� To dimension points in the drawing, pick them and create a dimension.
� To convert an existing AutoCAD® dimension to a manual AEC dimen-

sion, select it and create a manual AEC dimension.
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Related Procedures

� Creating an AEC Dimension Style

� Setting the Point Mode for Manual AEC Dimensions

� Adding Manual AEC Dimensions

� Creating an AEC Dimension from an AutoCAD Dimension

AutoCAD Dimensions

Associative AutoCAD® dimensions are associative toward AutoCAD objects 
like polylines, or rectangles. They are not associative toward AEC objects. 

Associative AutoCAD dimensions are turned off by default in Autodesk® 
Architectural Desktop. To work with the associative AutoCAD dimension fea-
ture, set the system variable DIMASSOC to 2 (Associative Dimensions). To 
create non-associative AutoCAD dimensions, set DIMASSOC to 1 (Non-asso-
ciative Dimensions). 

Non-associative AutoCAD dimensions do not contain logical dimension 
points. That means that they can dimension any point specified in a draw-
ing.

Non-associative AutoCAD dimensions can’t be grouped into dimension 
groups. They do not have settings for superscripting and cannot have fixed 
extension lines. Also, AutoCAD dimensions cannot dimension objects in 
external references. 

For more information about AutoCAD dimensions, see “Dimensions and Tol-
erances” in the AutoCAD User’s Guide.

Logical Dimension Points of AEC and 
AutoCAD Objects

This section describes the AEC objects and AutoCAD® objects that you can 
dimension and the logical dimension points you can choose. 

Logical dimension points are defined in the display properties of the dimen-
sion or the dimension style. It is recommended that you create a separate 
style for each set of logical dimension points. For example, you can create an 
AEC dimension style for walls, which contains only logical points on walls. 
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For information about how to define dimension content in AEC dimension 
styles, see “Specifying Dimension Points in AEC Dimension Styles” on 
page 2405.

Related Topics 

� Walls

� Windows, Doors, and Openings in Walls

� Grids

� Other AEC Objects

� AutoCAD Objects

� External References

Walls

The following logical dimension points are available for walls:

Wall Dimension Points

Selection Description Examples

Overall Dimensions the two outer 
points of all dimensioned walls.

Length of Wall: Outer 
Boundaries

Dimensions the outer 
boundaries of every selected 
wall. When wall boundaries 
overlap, only those visible from 
the direction of the dimension 
are dimensioned.

Length of Wall: Wall 
Length

Dimensions the length of walls 
in the selection set.

Wall Width: Wall 
Width

Dimensions the overall 
thickness of a wall.

Wall Width: 
Components

Dimensions the thickness of all 
components in a wall.

Wall Intersections Dimensions the intersection 
points of walls that are 
connected to the selected 
walls.
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Windows, Doors, and Openings in Walls

The following logical dimension points are available for windows, doors, and 
openings within walls:

NOTE If you click Options on the Format menu, and then click AEC Object 
Settings, there are two options under Wall settings: Dimension to Center of 
Opening and Dimension to Outer Frame of Opening. These settings have no 
influence on how openings are dimensioned in AEC dimensions.

Grids

You can use automatic AEC dimensions to dimension the following grid 
types:

� Column grids
� Ceiling grids
� Layout grids

The following logical dimension points are available for grids:

Window, Door, and Opening Dimension Points

Selection Description Examples

Opening Max. Width Dimensions the maximum 
width of a window, door or 
opening in a wall. 

Opening Min. Width Dimensions the minimum 
width of a window, door, or 
opening in a wall.

Center of Opening Dimensions the center point of 
a window, door, or opening in 
a wall. 

Grid Dimension Points

Selection Description Examples

Overall Dimensions the two outermost 
grid lines of all selected grids
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Other AEC Objects

The following objects have dimension points that can be set individually:

� Mass elements
� Curtain walls
� Window assemblies
� Structural members (columns/braces/beams)
� Standalone windows/doors/openings

AEC objects not listed here can be dimensioned with automatic AEC dimen-
sions as well, but you cannot set their points individually. They are combined 
in a group named “Other” and you set dimension points for all of them 
there. For example, if you select Bounding Box for Others, then all stairs, rail-
ings, spaces, roofs, slabs, and areas dimensioned with that style will have 
dimension points for their bounding boxes. 

These objects are combined in the Other group:

� Stairs
� Railings
� Spaces
� Roofs/roof slabs/slabs
� Areas

The following dimension points are available for these objects:

Outer Grid Lines Dimensions the outer grid lines 
of selected grids

All Grid Lines Dimensions all grid lines in 
selected grids

Other Building Object Dimension Points

Selection Description Examples

Overall Dimensions the two outer 
points of dimensioned objects

Grid Dimension Points

Selection Description Examples
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AutoCAD Objects

You can dimension most AutoCAD linework objects with automatic AEC 
dimensions. 

Dimensioning line endpoints and midpoints example

Dimensioning polyline endpoints and midpoints example

Bounding Box Dimensions the bounding box 
of each object in the selection 
set

Edges: All Edges Dimensions all edges in an 
object

Edges: Facing Edges Dimensions the edges of the 
object that are visible from the 
direction of the dimension line

Center Dimensions the center point of 
an object

Other Building Object Dimension Points (continued)

Selection Description Examples
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Dimensioning circle centers and quadrants example

Use automatic AEC dimensions to dimension the following AutoCAD line-
work objects:

� Lines
� Arcs
� Circles
� Open and closed polylines 
� AutoCAD polygons
� Rectangles

The following dimension points are available for AutoCAD linework objects:

AutoCAD Linework Dimension Points

Selection Description Examples

Extents Dimensions the two overall outer 
points of selected objects.

Endpoints Dimensions the endpoints of 
selected objects. 
If you selected a polyline with 
multiple segments, the endpoints 
of each segment are measured.
Endpoints can be measured for all 
AutoCAD linework objects listed 
above except circles.

Midpoints Measures the midpoints of all 
segments of the selected object 
that are lying in the direction of 
the dimensions.
Midpoints can be measured for all 
AutoCAD linework objects listed 
above except circles.
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You cannot use automatic AEC dimensions to dimension the following 
AutoCAD linework objects:

� Multilines
� Splines
� Ellipses
� Blocks
� AutoCAD dimensions
� Leaders
� Text
� Surfaces
� Images
� OLE frames 
� Proxies
� Solids

 AutoCAD linework objects include line-based objects, such as lines and open 
polylines, as well as non-linear geometry, such as closed polylines and circles. 
The results of using AEC dimensions to dimension these objects can be quite 
different. For example, for a single line, the options Overall, Bounding Box, 
All Edges, and Facing Edges look exactly alike. Some objects, like circles, have 
no edges to dimension.

TIP The best way to handle the different contents for AutoCAD linework is to 
create a number of AEC dimension styles for the individual objects. For example, 
you can create a style named “Line,” which has only one dimension chain for 
dimensioning line edges, or a dimension style named “Circle,” which dimen-
sions only circle centers and circle quadrants. For more information on creating 
AEC dimension styles, see “AEC Dimension Styles” on page 2398.

Center Measures the center of the curve 
of circular objects. 
Centers can be measured for 
circles, arcs, and curved polyline 
segments.

Quadrant Measures the quadrants of circles, 
arcs, and curved polylines 
segments.

AutoCAD Linework Dimension Points (continued)

Selection Description Examples
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External References

You can dimension objects from external references with AEC dimensions in 
the following cases:

� Attach an external reference drawing to a host drawing, and dimension 
objects from the external reference in the host drawing.

� Attach an external reference drawing to a host drawing, and dimension 
objects from the external reference and the host drawing in the host draw-
ing.

� Attach a nested external reference drawing to a host drawing, and dimen-
sion objects from the external reference and its nested external references 
in the host drawing. 

� Attach a nested external reference drawing to a host drawing, and dimen-
sion objects from the external reference, its nested external reference and 
from the host drawing in the host drawing. 

Objects from external references are dimensioned in the same way and with 
the same dimension points as objects from the host drawing. 

You can create any level of nesting inside the external reference and still 
dimension all nested referenced objects. 

You will need the ability to dimension external references often when you 
are working in a project environment. For detailed information on using 
dimensions in a project, see “Annotating a Building Project” on page 341.

Considerations for Choosing a Dimension 
Type

To decide which dimensioning method is appropriate for you, consider the 
following points:

� Do you want to dimension mainly building objects like walls, mass ele-
ments and window assemblies? In this case, an automatic AEC dimension 
is the best choice.

� Do you require full associativity of the dimension toward building objects 
and AutoCAD® linework objects? Then you should select an automatic 
AEC dimension.

� Do you need the ability to dimension objects in external references? In 
that case, you will use an automatic AEC dimension which has advanced 
referencing capabilities.
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� Do you need specific European visuals, like superscripting for millimeters 
and fixed extension line lengths? In this case, you could use and auto-
matic AEC dimension or copy the properties of an AEC dimension style to 
an AutoCAD dimension.

� Do you want to dimension mainly arbitrary points in your drawing which 
are not connected to any building objects? In this case, you would select 
a manual AEC dimension.

� Do you want the dimension to update automatically when you make 
changes to the dimensioned object? In this case you could either select an 
automatic AEC dimension or a manual AEC dimension with transform-
able dimension points. 

� Do you have existing AutoCAD dimensions and want to convert them to 
AEC dimensions? In that case, you would convert the AutoCAD dimen-
sion to a manual AEC dimension.

� Do you need a continued dimension or an angular dimension? In this 
case, a non-associative AutoCAD dimension would be the best choice. 

� Do you want to keep an existing AutoCAD dimension, but give it the look 
and feel of your AEC dimensions? In that case, you can copy the proper-
ties of an AEC dimension style to an existing AutoCAD dimension. 

Related Procedures

� Specifying AEC Dimension Preferences

� Creating an Automatic AEC Dimension with User-Specified Settings

� Creating a Manual AEC Dimension with User-Specified Settings

� Creating an AEC Dimension from an AutoCAD Dimension

� Copying Properties of AEC Dimensions to AutoCAD Dimensions

Specifying AEC Dimension Preferences

Use this procedure to specify dimension preferences before you add AEC 
dimensions to your drawing.

Settings for AEC dimensions include the following: 

� Superscript for millimeters
� Dimension display unit 
� Automatic rescale of existing AutoCAD® dimension styles 
� Update behavior of points added or removed

1 On the Format menu, click Options.
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2 Click the AEC Dimension tab.

Settings for AEC dimensions 

3 Specify how dimension chains are updated when you remove or add 
dimension points:

For more information, see “Adding Dimension Points” on page 2386 and 
“Removing Dimension Points” on page 2387.

If you want to . . . Then . . .

update the display after every 
point you remove from or add 
to a dimension chain

select Update Added / Removed Points 
Immediately.

update the display only after 
you have finished removing or 
adding dimension points

Clear Update Added / Removed Points 
Immediately.
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4 Set the global behavior of manually overridden dimension values: 

For more information, see “Overriding Dimension Values and Hiding 
Dimension Segments” on page 2393.

5 Select the unit in which dimensions are to be displayed. 

This unit can differ from the drawing unit. For example, you can create a 
drawing in meters, but have the dimensions displayed in centimeters. 
This dimension notation is common in Austria.

6 If meters or centimeters are your drawing units, and you want to display 
the millimeters as superscripted text, select Use Superscript mm. 

Millimeters superscripted (left) and millimeters not superscripted (right)

7 If you do not want zeros at the end of superscripted numbers, select Trail-
ing Zeros Suppression for Superscript. 

You can select this option only if you have selected Use Superscript mm.

Trailing zeroes not suppressed (left) and suppressed (right)

8 Select the AutoCAD dimension styles to be rescaled under Automatic Scale 
of AutoCAD Dimstyles when you change the drawing units. 

If you want to . . . Then . . .

have an automatic underline 
for each manually overridden 
dimension value 

select Override Display of Underlined Text, and 
then select Underline All.

have no underline for any 
overridden dimension value 

select Override Display of Underlined Text, and 
then select Underline None.

set underlines for each 
overridden dimension value 
manually 

clear Override Display of Underlined Text. 
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Example: You change the drawing units from meters to millimeters. You 
have selected the AutoCAD dimension style “AEC-Dimension 1-100.” 

The following settings in the AutoCAD dimension style “AEC-Dimension 
1-100” are rescaled:

Creating AEC Dimensions Using AEC 
Dimension Tools

Tool palettes provided with Autodesk® Architectural Desktop let you quickly 
place AEC dimensions by selecting an AEC dimension tool with a specific 
AEC dimension style and other predefined properties. You can also use the 
AEC dimension tools to convert AutoCAD dimensions to AEC dimensions 
and to apply the settings of an AEC dimension tool to existing AEC dimen-
sions.

Description Variable AutoCAD Dimstyle

Meters Millimeters

Dimension line spacing DIMDLI 0.5000 50.0000

Dimension line 
extension

DIMDLE 0.1250 125

Extension line length DIMEXE 0.1250 125.0000

Text offset from 
dimension line

DIMGAP 0.1000 100.0000

Dimension text height DIMTXT 0.2000 200.0000
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Tool palettes containing AEC dimension tools

The default tool palettes in the workspace contain sample AEC dimension 
tools that you can use and customize as needed. In addition, the following 
catalogs provided with the software contain AEC dimension tools that you 
can add to your tool palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

Custom palettes created by your CAD manager or other users may also con-
tain AEC dimension tools with AEC dimension styles and properties that are 
customized for your projects or office standards.

Related Procedures

� Creating an AEC Dimension

� Creating an Automatic AEC Dimension with User-Specified Settings

� Creating a Manual AEC Dimension with User-Specified Settings

� Creating an AEC Dimension from an AutoCAD Dimension

� Copying Properties of AEC Dimensions to AutoCAD Dimensions

� Creating an AEC Dimension Tool
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Creating an AEC Dimension

Use this procedure to add a new AEC dimension that has the properties spec-
ified in the AEC dimension tool that you select. To specify settings when you 
add an AEC dimension, see “Creating an Automatic AEC Dimension with 
User-Specified Settings” on page 2376, “Creating a Manual AEC Dimension 
with User-Specified Settings” on page 2378, and “Creating an AEC Dimen-
sion from an AutoCAD Dimension” on page 2380.

1 Open the tool palette that you want to use, and select an AEC dimension 
tool.

If necessary, scroll to display the tool that you want to use.

2 Select the objects you want to dimension, and press ENTER.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Click where you want to insert the AEC dimension.

Creating an Automatic AEC Dimension with 
User-Specified Settings

Use this procedure to create an automatic AEC dimension with the settings 
that you specify. 

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

An automatic AEC dimension takes its dimension points from the object it 
dimensions. It updates when the object it dimensions changes.
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1 Open the tool palette that you want to use, and select an AEC dimension 
tool.

If necessary, scroll to display the tool that you want to use.

2 On the Properties palette, expand Basic, and expand General.

3 Select a style.

4 In the drawing area, select the objects you want to dimension.

You can move or hide the Properties palette to expose more of the drawing 
area.

5 Press ENTER.

6 Specify the position, rotation, and direction of the new dimension: 

If you want to . . . Then . . .

insert the AEC dimension 
parallel or perpendicular to 
the dimensioned object 

drag the cursor in the desired direction and 
click at the desired insertion point.

NOTE If your selection set contains objects 
with different directions, the direction of the 
first selected object defines the parallel and 
perpendicular directions.

insert the AEC dimension at 
a specified rotation

enter r (Rotation) on the command line, and 
press ENTER.Then, enter a rotation angle, either 
by clicking in the drawing or by entering it on 
the command line. Press ENTER, and click at the 
desired insertion point. Alternatively, pressing 
the SPACE bar rotates the dimension by 90°. 

NOTE If your selection set contains objects 
with different directions, the rotation is 
calculated with reference to the first selected 
object.
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Creating a Manual AEC Dimension with 
User-Specified Settings

Manual AEC dimensions take their points not from architectural objects like 
walls or windows, but from points you specify in your drawing. You can 
choose whether manual dimension points are associative and are updated 
every time the dimensioned point is updated, or whether they are static and 
remain at their absolute position in the drawing.

Related Procedures

� Setting the Point Mode for Manual AEC Dimensions

� Adding Manual AEC Dimensions

Setting the Point Mode for Manual AEC 
Dimensions

Use this procedure to define the update behavior of manual AEC dimensions.

When you select associative dimension points for your manual AEC dimen-

sions, at every point you specify in the drawing an AutoCAD® point is 
inserted. The dimension point is associative to this AutoCAD point. If you 
move the AutoCAD point, the dimension point is updated accordingly. 

NOTE If you chose associative dimension points but cannot see the inserted 
AutoCAD points, they are set at a very small size. To change their size and shape, 
enter ddptype on the command line, and edit them as desired. 

insert the AEC dimension 
parallel to an object other 
than the dimensioned 
object in the drawing

enter a (Align) on the command line, and press 
ENTER. Then, select the object to which to align 
the AEC dimension. Press ENTER, and click in 
the drawing at the desired insertion point.

NOTE The direction of the AEC dimension is 
dependent on the rotation of the chosen 
object. The drawing direction of the object has 
no influence on the AEC dimension direction. 

If you want to . . . Then . . .
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AEC dimension associative to AutoCAD points

If you chose static dimension points, no AutoCAD points are added to the 
drawing. The dimension point is simply added at the specified position, and 
is, from then on, fixed in the drawing.

Static dimension points

1 Enter DimPointMode on the command line.

2 Specify the point mode:

These settings remain valid for all subsequent manual dimensions until you 
change them again. 

After you have set the mode for dimension points, you can create manual 
AEC dimensions. 

If you want to . . . Then . . .

create dimension points that 
are associative toward 
AutoCAD points

enter t (Transformable).

create static dimension points 
that remain fixed in the 
drawing

enter s (Static).
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Adding Manual AEC Dimensions

Use this procedure to add a manual AEC dimension with the settings you 
specify. 

1 Open the tool palette that you want to use, and select a manual AEC 
dimension tool.

If necessary, scroll to display the tool that you want to use.

2 In the drawing area, specify the points you want to dimension. 

TIP Turn on Osnaps to specify points exactly.

3 Press ENTER.

The points you specified are marked with crosses. That way, you can check 
that all points are included in your selection set.

4 On the command line, enter st (Style) to select a style for your manual 
AEC dimension.

5 Specify the position of the AEC dimension by clicking the desired position 
in the drawing. 

For example, the AEC dimension can be placed above or below the 
selected points. 

6 Do any of the following:

� Drag the mouse to set the direction of the dimension. The extension 
lines are drawn into the opposite direction.

� To place the AEC dimension perpendicular to a point in the drawing, 
enter perp (Perpendicular) on the command line, and specify the point 
the dimension is perpendicular to.

Creating an AEC Dimension from an 
AutoCAD Dimension

Use this procedure to create a manual AEC dimension from an AutoCAD® 
dimension. The manual AEC dimension has the properties of the AEC 
dimension tool you select. You can edit these properties after creating the 
AEC dimension.
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For detailed information on properties and behavior of manual AEC dimen-
sions, see “Manual AEC Dimensions” on page 2362.

Converting an AutoCAD dimension to an AEC dimension 

1 Open the tool palette that you want to use. 

If necessary, scroll to display the tool that you want to use.

2 Right-click an AEC dimension tool, and click Apply Tool Properties 
to ➤  AutoCAD Dimension. 

3 Select the AutoCAD dimensions, and press ENTER.

4 Do one of the following:

� If you selected one AutoCAD dimension to convert, proceed to Step  7.
� If you selected multiple AutoCAD dimensions to convert, proceed to 

Step  5.

5 Specify the position of the AEC dimension by clicking the desired position 
in the drawing. The AEC dimension can, for example, be placed above or 
below the object. 

6 Do any of the following:

� Drag the mouse to set the direction of the dimension. The extension 
lines are drawn into the opposite direction.

� To place the AEC dimension perpendicular to a point in the drawing, 
enter perp (Perpendicular) on the command line, and specify the point 
the dimension is perpendicular to.

� To set a user-defined angle for the AEC dimension, enter the desired 
angle on the command line.

NOTE The angle you specify here is calculated in relation to the UCS, and 
not to the dimensioned object.

7 When prompted to erase the original AutoCAD dimension, press ENTER to 
keep the AutoCAD dimension, or enter y (Yes) to erase it. 
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The resulting AEC dimension is displayed as follows:

Copying Properties of AEC Dimensions to 
AutoCAD Dimensions

Use this procedure to copy the display properties of an AEC dimension to an 

AutoCAD® dimension without converting the AutoCAD dimension. In this 
case, a number of display attributes are changed while the functionality and 
behavior of the AutoCAD dimension are not changed.

NOTE When you copy the properties of an AEC dimension to an associative 
AutoCAD dimension (DIMASSOC = 2), the associativity of the resulting 
AutoCAD dimension is lost. Therefore, copy properties to an associative 
AutoCAD dimension only as the last step in your drawing process, or use tradi-
tional, non-associative AutoCAD dimensions (DIMASSOC = 1).

The following dimension display properties are copied from the AEC dimen-
sion to the AutoCAD dimension:

� AutoCAD dimension style: AEC dimensions have an underlying AutoCAD 
dimension style, defining settings for the dimension not explicitly set in 
the AEC dimension style. 

When you copy the properties of an AEC dimension to an AutoCAD 
dimension, the underlying AutoCAD dimension style of the AEC dimen-
sion is applied to the AutoCAD dimension.

For detailed information about the connection between AutoCAD dimen-
sion styles and AEC dimension styles, see “AEC Dimension Styles and 
AutoCAD Dimension Styles” on page 2399. 

If . . . Then . . .

you selected only one 
AutoCAD dimension

the new AEC dimension is inserted at the same 
position as the AutoCAD dimension. If you did 
not erase the original AutoCAD dimension, the 
AEC dimension is placed on top of it. 

you selected more than one 
AutoCAD dimension

the new AEC dimension is inserted according to 
your specifications from steps 6 and 7. If you did 
not erase the original AutoCAD dimensions, they 
remain in their original positions.
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� Superscript settings: If you have defined superscripted millimeters for 
AEC dimensions, this is applied to the AutoCAD dimension.

For more information about superscripts, see “Specifying AEC Dimension 
Preferences” on page 2371.

� Extension line length: The extension length you have defined for your 
AEC dimension is applied to the AutoCAD dimension.

When you copy the properties of an AEC dimension to an AutoCAD 
dimension that has a different extension line length, the definition points 
of the AutoCAD dimension are adjusted to the new length. 

The AutoCAD dimension style and length of the extension lines are view-
dependent settings. When you copy the properties of an AEC dimension to 
an AutoCAD dimension, the settings for the current view are applied.

NOTE Copying the properties of an AEC dimension to an AutoCAD dimension 
does not apply associative behavior to the AutoCAD dimension. When the 
AutoCAD dimension is moved, stretched, or otherwise manipulated, the dimen-
sion points do not react associatively to the dimensioned object.

1 On the command line, enter AecDimMatch.

2 Select the AEC dimension to copy properties from. 

3 Select the AutoCAD dimensions to copy properties to.

4 Press ENTER.

Creating an AEC Dimension Tool

Use this procedure to create an AEC dimension tool and add it to a tool pal-
ette. You may want to create your own AEC dimension tools if you are plac-
ing multiple AEC dimensions of specific styles with additional AEC dimen-
sion properties that you want to be the same each time you add an AEC 
dimension of that type.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

If you want to . . . Then . . .

create a tool from an AEC 
dimension in the drawing

select the object, and drag it to the tool 
palette.
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3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

6 Expand Basic, and expand General.

7 Click the setting for Description, enter a description of the AEC dimension 
created from this tool, and click OK.

8 Specify a layer key and any layer key overrides if you do not want to use 
the layer assignments specified in the layer key style used in the drawing.

9 Select an AEC dimension style.

10 Select the drawing file containing the style used for this AEC dimension 
tool.

11 Define whether to create an automatic or manual AEC dimension tool:

create a tool from an AEC 
dimension style in the Style 
Manager

on the Format menu, click Style Manager. 
Locate the style you want to copy, and drag it 
to the tool palette. Click OK to close the Style 
Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.

If you want to . . . Then . . .

create an automatic AEC 
dimension tool for 
dimensioning AEC objects and 
AutoCAD objects 

click the setting for Specify Using, and select 
Linework and Objects.

create a manual AEC dimension 
for dimensioning points in the 
drawing

click the Setting for Specify Using, and select 
Points.

If you want to . . . Then . . .
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12 Click OK.

Attaching Objects to Dimensions

Use this procedure to add new AEC objects to an automatic AEC dimension.

Adding objects to a dimension 

1 Select the AEC dimension to which to add objects to, right-click, and click 
Attach Objects.

2 Select the objects to add to the AEC dimension.

3 Press ENTER.

Dimension points for the added objects are inserted into the AEC dimension.

If you do not see any added dimension points, the group might not include 
points for the new object. For example, if you add a mass element to an AEC 
dimension that has no point settings selected for mass elements, you cannot 
see any points for the added mass element. To see the mass element points, 
change the style or the object display of the dimension so that dimension 
points for mass elements are displayed.

For information about dimension points, see “Logical Dimension Points of 
AEC and AutoCAD Objects” on page 2363 and “Specifying Dimension Points 
in AEC Dimension Styles” on page 2405.

Detaching Objects from Dimensions

Use this procedure to detach objects from automatic AEC dimensions. 
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Removing objects from a dimension 

1 Select the AEC dimension from which you want to detach objects, right-
click, and click Detach Objects.

2 Select the objects to detach from the AEC dimension.

3 Press ENTER.

The dimension points belonging to the object are removed from the AEC 
dimension.

Adding Dimension Points

Use this procedure to add additional dimension points to a manual or auto-
matic AEC dimension. These dimension points behave like the points in 
manual dimensions. They measure points you specify in the drawing and can 
be associative or static, depending on your point mode settings. 

For more information about setting the mode for manual dimension points, 
see “Setting the Point Mode for Manual AEC Dimensions” on page 2378. 
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Adding dimension points

1 Select the AEC dimension to which to add points, right-click, and click 
Add Dimension Points.

2 Specify the points to add to the dimension. 

The points you specify are marked with crosses. This makes it easy to 
check that all points are included in your selection set.

3 Press ENTER.

4 Select the dimension chain to which to add the points.

The specified points are added to the dimension chain.

Removing and Restoring Dimension Points

You can remove dimension points from an AEC dimension. When you 
remove a logical point from an AEC dimension, you can restore it later. 
When you remove manual point from an AEC dimension, the point is 
removed permanently. 

Related Procedures

� Removing Dimension Points

� Restoring Logical Dimension Points

Removing Dimension Points

Use this procedure to remove dimension points from dimension chains. 
Removed logical dimension points can be restored later. For more informa-
tion about restoring logical dimension points, see “Restoring Logical Dimen-
sion Points” on page 2389.
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Removing dimension points

1 Select the AEC dimension from which to remove points, right-click, and 
click Remove Dimension Points.

2 Select the points on the dimension chain to remove by clicking their 
extension lines.

� If you selected Update Added/Removed Points Immediately in the AEC 
dimension preferences, the removed points are deleted immediately.

� If you cleared Update Added/Removed Points Immediately in the AEC 
dimension preferences, the removed points are deleted after you end 
the command. 

For more information about the update options, see “Specifying AEC 
Dimension Preferences” on page 2371.

NOTE If the deleted points are still visible as a crossed circle, the display com-
ponent Removed Points Marker is turned on. If you do not want the removed 
points marker to appear, turn off the component. For more information about 
the Removed Points Marker, see “Restoring Logical Dimension Points” on 
page 2389.

WARNING! When you remove multiple points, some removed points may 
reappear. This can happen when you have selected the option Update Added/
Removed Points Immediately, and the entity display component Removed Points 
Marker is turned off. The reason for this behavior is that during your current 
removal operation, you accidentally selected an invisible removed point marker 
for a dimension point already removed. Removing an already removed point 
restores it. To avoid this effect, turn on the Removed Points Marker component 
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in the entity display. For more information about turning components on and 
off, see “Changing the AEC Dimension Display Components” on page 2402.

Restoring Logical Dimension Points

Use this procedure to restore removed logical dimension points. Logical 
dimension points belong to an object; therefore, information about type and 
position of the removed point are still present in the dimension chain. 

1) Select dimension points to remove. 2) Remove them. 3) Make removed points 
visible. 4) Restore them.

1 Select the dimension chain on which to restore a removed dimension 
point.

2 Verify that the removed point is visible:

3 Select the dimension, right-click, and click Object Display.

4 Click the Display Properties tab.

5 Select the display representation on which the changes should appear, 
and select Object Override.

If . . . Then . . .

the point removed is still visible as a 
crossed circle

proceed to step 9.

the point removed is not visible as a 
crossed circle

make it visible by following steps 3 
through 11.
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The display representation in bold is the current one.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the Removed Points Marker component, and turn on the setting for 
Visibility.

9 Click OK twice.

The removed dimension point on the dimension chain is now visible, dis-
played by a crossed circle.

10 Select the AEC dimension again, right-click, and click Remove Dimension 
Points.

11 Click the center of the circle for the dimension points to restore. 

� If you selected Update Added/Removed Points Immediately in the AEC 
dimension preferences, the restored points appear immediately.

� If you cleared Update Added/Removed Points Immediately in the AEC 
dimension preferences, the restored points appear after you end the 
command with ENTER. 

For more information about the update options, see “Specifying AEC Dimen-
sion Preferences” on page 2371.

Editing AEC Dimensions

You can change the attributes of an AEC dimension, such as the style 
assigned or the dimension properties. You can also move individual dimen-
sion text in crowded plans and override dimension values with “false” val-
ues.

Autodesk® Architectural Desktop offers several methods for editing AEC 
Dimensions:

� You can directly edit AEC dimensions using grips.
� You can change AEC dimensions settings on the Properties palette.
� You can select editing commands from the shortcut menu for a selected 

AEC dimension.

Related Procedures

� Using Grips to Reposition Dimension Texts, Extension Lines and Dimen-
sion Chains
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� Resetting Repositioned Dimension Texts, Extension Lines and Dimension 
Chains

� Changing the AEC Dimension Style

� Overriding Dimension Values and Hiding Dimension Segments

� Attaching Hyperlinks, Notes, and Files to an AEC Dimension

Using Grips to Reposition Dimension Texts, 
Extension Lines and Dimension Chains

Use this procedure to reposition individual dimension texts, extension lines 
and dimension chains in an AEC dimension. 

The length of extension lines and the distance between dimension chains are 
usually set in the AEC dimension style, and are identical for all chains and 
all extension lines in the dimension. In some cases, you need to override 
those settings, and display different extension lines or chain distances. Also, 
you might need to move individual dimension texts to a different location.

Viewing AEC Dimension Move All Chains and Edit in Place grips

AEC dimensions offer you the ability to change the display of a dimension 
with direct editing via grips. 

NOTE You can only display and move the in-place grips of an AEC dimension 
if the underlying AutoCAD dimension style has the correct text placement set-
tings. To ensure this, select the AEC dimension, right-click, and click AEC Dimen-
sion Style. Then, select the display representation where you want the changes 

to appear, and select Style Override. If necessary, click , and click the Other 
tab. Click Edit, and in the Dimension Style Manager click Modify. Click the Fit 
tab, and select Over the dimension line, without a leader for Text Placement.

1 Select the AEC dimension on which to reposition individual texts, exten-
sion lines or dimension chains, and click its Edit In Place grip. 

The dimension now displays grip points for 

� individual texts
� individual extension lines
� individual dimension chains
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Viewing AEC Dimension Edit In Place grips

2 Use the grips to reposition dimension texts, lengthen or shorten exten-
sion lines, and reposition dimension chains. 

NOTE Alternatively, you can select the AEC dimension, right-click, and click 
Edit In Place.

Resetting Repositioned Dimension Texts, 
Extension Lines and Dimension Chains

Use this procedure to reset repositioned dimension texts, extension lines and 
dimension chains. 

Overriding text in an AEC Dimension

NOTE You can only reset those dimension texts that you have manually 
moved to a different place. If dimension texts are offset from their positions 
because they do not, for example, fit on the appropriate dimension segment, 
you cannot automatically reset them here. To make sure that your dimension 
texts are always placed on the dimension segment, set this in the underlying 
AutoCAD dimension style. Select the AEC dimension, right-click, and click AEC 
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Dimension Style. Then, select the display representation where you want the 

changes to appear, and select Style Override. If necessary, click , and click 
the Other tab. Click Edit, and in the Dimension Style Manager click Modify. Click 
the Fit tab, and select Always keep text between ext lines under Fit Options. 

1 Select the AEC dimension with repositioned components to be reset.

2 Set the components to their original positions:

NOTE To reset the distance between dimension chains, set the distance 
between chains to the original value in the AEC dimension style. For informa-
tion, see “Selecting the AutoCAD Dimension Styles and Other Properties of 
AEC Dimension Styles” on page 2406.

Changing the AEC Dimension Style

Use this procedure to change the style associated to an AEC dimension. AEC 
dimension styles contain information about the display of the dimension. 
For information about how to define AEC dimension styles, see “AEC Dimen-
sion Styles” on page 2398.

1 Select one or more AEC dimensions and double-click one of them.

2 Expand Basic, and expand General.

3 Select an AEC dimension style.

Overriding Dimension Values and Hiding 
Dimension Segments

The dimension values in an AEC dimension are the real-life calculated values 
taken from the objects that are dimensioned. When the dimensioned object 
is updated, the dimension value is updated accordingly. In some cases you 
might want to override that value and exchange it for a manually inserted 
value. 

If you want to . . . Then . . .

set the extension lines to 
their style settings

Right-click, and click Remove Overrides ➤ Reset 
Extension Lines. 

set the text strings to 
their original position

Right-click, and click Remove Overrides ➤ Reset Text 
to Original Position. 
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Overriding dimension text with a new value

In other cases, you might want to retain the original value, but supplement 
it with a prefix or suffix. 

Overriding dimension text with a suffix

Sometimes, you need to hide a dimension text or a whole dimension seg-
ment. 

Overriding dimension text by hiding text

Overridden dimension values can be marked in different ways:
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� Each manually overridden value, hidden text, or prefixed/suffixed value, 
is marked by a short overline. For information on how to hide the over-
line, see “Hiding the Overline of Overridden Dimension Values” on 
page 2397.

� You can add an underline to each overridden value. For information, see 
“Overriding Dimension Values” on page 2395.

� You can specify in the drawing setup to underline each override automat-
ically. For information, see “Global Underline Options for Overrides” on 
page 2396.

When you manually override a dimension value, the correct automatic value 
still exists. You can remove the override, and restore the correct value again. 

Related Procedures

� Overriding Dimension Values

� Removing Overrides from Dimension Values

� Global Underline Options for Overrides

� Hiding the Overline of Overridden Dimension Values

Overriding Dimension Values
Use this procedure to exchange an automatic dimension value for a manu-
ally inserted one, to add prefixes and suffixes to dimension values, and to 
hide dimension texts and segments. 

1 Select the dimension on which to override a dimension value, right-click, 
and click Override Text & Lines.

2 Click the value to override.

3 Specify the value override:

If you want to . . . Then . . .

hide the selected 
dimension text

select Hide Text.

hide the selected 
dimension segment

select Hide Text and Lines.

override the dimension 
value

enter a value for Text. 

NOTE You can enter all alphanumeric characters 
here.

mark an overridden value 
with an underline

select Underline Text.
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4 Click OK.

Removing Overrides from Dimension Values
Use this procedure to remove overrides from dimension values.

The results of removing overrides are as follows:

� Overridden values are reset to their correct value.
� Underlines and overlines are removed.
� Prefixes and suffixes are removed.
� Hidden text and hidden segments are redisplayed.

1 Select the dimension from which to remove an override, right-click, and 
click Override Text & Lines.

2 Click the value or segment from which to remove an override.

3 Click Remove Override.

4 Click OK.

Global Underline Options for Overrides
Use this procedure to set the underlines of overridden dimension values glo-
bally in the drawing. 

Documentation guidelines of a company or regional office may require 
underlining all overridden dimension values. It would be cumbersome to 

underline each overridden value individually. Autodesk® Architectural Desk-
top offers you the ability to set underlining of overridden values as the 
default behavior. This means that whenever you override a dimension value, 
it is automatically underlined. 

Similarly, you might need a quick way to remove all underlines from a plan; 
for example, to create a preview sheet from a not-yet-finished plan. 

In this case, you can set global underlining instead of underlining or remov-
ing underlines from individual overrides. 

add a prefix to a 
dimension value

enter one for Prefix.

add a suffix to a 
dimension value

enter one for Suffix.

If you want to . . . Then . . .
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NOTE The global underline setting is applied to existing overrides and new 
overrides.

1 On the Format menu, click Options.

2 Click the AEC Dimension tab.

3 Select Override Display of Dimensioned Text. 

4 Set the global underline behavior:

Hiding the Overline of Overridden Dimension Values
Use this procedure to hide the overline of overridden dimension values. 

When you create an override for a dimension value—entering a different 
value, hiding a text or a segment, adding a prefix/suffix—the override is 
marked by a small overline above the changed value. The overline is useful 
for seeing at a glance which values have been overridden.It is also useful 
when you have hidden texts and segments, to select the hidden segment.

In some cases, however, you might want to hide the overline. The overline is 
placed on the DEFPOINTS layer, and by default is not plotted. If you want to 
hide it in the Autodesk Architectural Desktop session as well, you need to 
hide the DEFPOINTS layer.

1 In the Layer Properties toolbar, select the DEFPOINTS layer.

2 Click the light bulb icon to hide the layer. 

NOTE Alternatively, you can hide the DEFPOINTS layer in the Layer Manager.

Attaching Hyperlinks, Notes, and Files to an AEC 
Dimension

Use this procedure to attach hyperlinks, text notes, and files to an AEC 
dimension. 

If you want to . . . Then . . .

underline all overridden dimension values in the 
drawing, regardless of individual settings 

Select Underline All.

remove the underline from all overridden 
dimension values in the drawing, regardless of 
individual settings 

Select Underline None.



2398 | Chapter 34 AEC Dimensions

1 Double-click the AEC dimension to which to attach information.

2 Click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click the setting for Notes, and add a note. Then, click OK.

5 Click the setting for Reference Documents.

6 Attach or detach reference files:

7 Click OK. 

AEC Dimension Styles

An AEC dimension style is a group of properties assigned to an AEC dimen-
sion that determines the appearance and other characteristics of that object. 

You can create and edit AEC dimension styles, import and export AEC 
dimension styles between drawings, and purge AEC dimension styles that are 
not in use. When you create, purge, import, export, or edit styles, you access 
the Style Manager. The Style Manager provides a central location in 
Autodesk® Architectural Desktop where you can work with styles from mul-
tiple drawings and templates. For more information about using the Style 
Manager, see “Style Manager” on page 531.

You can create an AEC dimension tool from any AEC dimension style. You 
can drag the style from the Style Manager onto a tool palette. You can then 
specify default settings for any AEC dimensions created from the tool. For 
more information, see “Creating an AEC Dimension Tool” on page 2383.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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Related Topics

� AEC Dimension Styles and AutoCAD Dimension Styles

� The AEC Dimension Style Wizard

� Creating AutoCAD Dimension Styles

� Creating an AEC Dimension Style

� Changing the Number of Chains in an AEC Dimension Style

� Changing the AEC Dimension Display Components

� About Dimension Points in AEC Dimension Styles

� Specifying Dimension Points in AEC Dimension Styles

� Selecting the AutoCAD Dimension Styles and Other Properties of AEC 
Dimension Styles

� Changing Style Properties with the AEC Dimension Style Wizard

� Attaching Notes and Files to an AEC Dimension Style

AEC Dimension Styles and AutoCAD Dimension 
Styles

Every AEC dimension style has an underlying AutoCAD® dimension style, 
which controls settings that are not set directly in the AEC dimension style. 

The AutoCAD dimension style defines the following properties:

� Color of dimension lines and extension lines 
� Lineweight of dimension lines and extension lines
� Shape and size of dimension arrowheads
� Dimension text height and color
� Units, precision, and decimal separator symbol

The AEC dimension style defines the following properties:

� Number of dimension chains
� Contents of dimensions chains
� Distance between dimension chains
� Fixed or variable extension lines
� Display of opening height dimensions

The AEC Dimension Style Wizard

There are two ways of editing a dimension style:

� You can edit the dimension style in the Style Manager. The advantage of 
this method is that you can edit all AEC dimension style settings here.
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� You can edit the dimension style with the AEC Dimension Style Wizard. 
The advantage of this method is that you can edit the most important dis-
play settings of the style in a fast and uncomplicated way. However, you 
can not change all settings here; for example, chain and content settings 
can be edited only with the AEC Dimension Styles Properties dialog box. 
For more information about the AEC Dimension Style Wizard, see 
“Changing Style Properties with the AEC Dimension Style Wizard” on 
page 2408.

Creating AutoCAD Dimension Styles

You need to create an underlying AutoCAD® dimension style before you cre-
ate an AEC dimension style.

Autodesk® Architectural Desktop comes with a number of preset AutoCAD 
dimension styles specifically designed for use in AEC dimensions. To save 
time, look at these, to see if you can use them directly or with modifications. 

To create an AutoCAD dimension style for use with AEC dimension styles, be 
sure to specify the following settings:

� Dimension line and extension line settings
� Arrowhead settings
� Text display settings
� Unit settings

1 On the Dimension menu, click Style.

2 In the Dimension Style Manager, click New.

3 Follow the instructions for creating a new AutoCAD dimension style, as 
described in “Using Dimension Styles” in the AutoCAD 2004 User’s Guide.

For more information about connecting the AutoCAD dimension style to an 
AEC dimension style, see “Selecting the AutoCAD Dimension Styles and 
Other Properties of AEC Dimension Styles” on page 2406. 

Creating an AEC Dimension Style

Use this procedure to create an AEC dimension style. You can create a new 
style with default style properties, or you can create a new style by copying 
an existing style. After you create the style, you edit the style properties to 
customize the characteristics of the style.

1 On the Format menu, click Style Manager.

2 Expand Documentation Objects, and expand AEC Dimension Styles.
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3 Create a new AEC dimension style:

4 Enter a name for the new AEC dimension style, and press ENTER.

5 To edit the style properties of your new AEC dimension style, right-click 
the style, and click Edit:

6 When you have finished changing the AEC dimension style properties, 
click OK.

7 If you want to assign the style to an AEC dimension tool, drag the style 
from the Style Manager to a tool palette.

You can later rename the tool and specify other properties for it as 
described in “Creating an AEC Dimension Tool” on page 2383.

8 Click OK.

If you want to . . . Then . . .

create a new style with 
default properties

right-click AEC Dimension Styles, and click New.

create a new style from an 
existing style

right-click the AEC dimension style you want to 
copy, and click Copy. Right-click, and click Paste.

If you want to . . . Then . . .

change the Layer/Color/
Linetype properties

see “Changing the AEC Dimension Display 
Components” on page 2402.

change the number of 
chains in an AEC 
dimension style 

see “Changing the Number of Chains in an AEC 
Dimension Style” on page 2402.

specify dimension points 
and objects to dimension

see “Specifying Dimension Points in AEC Dimension 
Styles” on page 2405.

change the AutoCAD® 
dimension style and other 
settings

see “Selecting the AutoCAD Dimension Styles and 
Other Properties of AEC Dimension Styles” on 
page 2406.

change an existing AEC 
dimension style with the 
AEC Dimension Style 
Wizard

see “Changing Style Properties with the AEC 
Dimension Style Wizard” on page 2408.

add notes, files, or 
documents to the style

see “Attaching Notes and Files to an AEC Dimension 
Style” on page 2410.
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Changing the Number of Chains in an AEC 
Dimension Style

Use this procedure to change the number of dimension chains in an AEC 
dimension style. 

To set the contents of individual chains, see “Specifying Dimension Points in 
AEC Dimension Styles” on page 2405.

1 Open a tool palette that has an AEC dimension tool.

2 Right-click an AEC dimension tool, and click AEC Dimension Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Chains tab.

5 Enter the number of dimension chains to define for this dimension style.

6 Click OK twice.

Changing the AEC Dimension Display 
Components

Use this procedure to change the properties of the display components of an 
AEC dimension style.

The following AEC dimension display components are available:

1 Open a tool palette that has an AEC dimension tool.

2 Right-click an AEC dimension tool, and click AEC Dimension Styles.

Display components of AEC dimensions

Component Description

AEC Dimension Group Use this component only to turn the visibility of an 
AEC dimension on or off for a specific view. All the 
other settings, like color, linetype, and lineweight are 
defined in the underlying AutoCAD® dimension style; 
any changes you enter here are not displayed.

Removed Points Marker This component shows removed dimension points. 
Make it visible if you want to restore removed 
dimension points, as described in “Removing and 
Restoring Dimension Points” on page 2387.

AEC Dimension Group 
Marker

Marker of the dimension base point.
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3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Layer/Color/Linetype tab.

8 Select the component to change, and select a different setting for the 
property.

9 Click OK twice.

About Dimension Points in AEC Dimension 
Styles

The chains of an AEC dimension can contain a large number of logical, asso-

ciative dimension points for various AutoCAD® and AEC objects. 

For a complete list of logical dimension points and objects, see “Logical 
Dimension Points of AEC and AutoCAD Objects” on page 2363.

For conceptual information on dimension points, see “Associative AEC 
Dimensions” on page 2360.

Each AEC dimension can have from one to ten dimension chains. Each chain 
can contain dimension points for the objects in a drawing. For more infor-
mation, see “Changing the Number of Chains in an AEC Dimension Style” 
on page 2402.

Example 1: You create an AEC dimension style that contains only one chain. 
This chain contains wall lengths and wall intersections and the maximum 
opening width of openings within the wall. 

Single AEC Dimension chain example
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Example 2: You create an AEC dimension style designed exclusively to 
dimension walls, but the wall dimension points are distributed on four indi-
vidual chains:

� Chain 1 dimensions the wall lengths and the wall widths.
� Chain 2 dimensions the wall lengths, wall widths and wall intersections.
� Chain 3 dimensions only the wall lengths.
� Chain 4 dimensions the outer boundaries of all selected walls.

Four AEC Dimension chains example

Example 3: You create an AEC dimension style that dimensions the length of 
walls in a building on one chain, and a row of columns within the building 
on a second chain. 

Two AEC Dimension chains example

The following guidelines can help you to create AEC dimension styles:
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� Create a separate dimension style for each use. For example, create a style 
that dimensions window assemblies and curtain walls, and another one 
that dimensions walls and openings in walls.

� Do not include too many dimension points in one dimension chain.
� Do not include too many objects within one dimension style. 

Specifying Dimension Points in AEC Dimension 
Styles

Use this procedure to specify the objects and points to be dimensioned on an 
AEC dimension style.

1 Open a tool palette that has an AEC dimension tool.

2 Right-click an AEC dimension tool, and click AEC Dimension Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Contents tab.

Selecting the contents of dimension chains

Under Apply To, you find the list of objects that can be dimensioned. 
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The Other entry combines all AEC objects that are not listed individually. 
They include stairs, spaces, areas, roofs, and railings.

Below the Apply To list, you find the list of available chains in this AEC 
dimension style.

8 For Apply To, select the object you want to dimension. 

Example: In the first chain, you want to dimension the length of walls and 
wall intersections. For Apply To, you select Wall. 

9 Under Chains, select the chain on which the dimension points to appear. 

Example: In the first chain, you want to dimension the length of walls. In 
the previous step, you selected Wall. Now, you select Chain 1.

NOTE “Selecting” in this context means highlighting the desired chain, 
and not selecting the check mark. The check mark is set automatically 
depending on whether dimension points for this chain are selected. Example: 
If you clear all possible dimension points for a chain, its check is automatically 
cleared.

10 On the right side, select the points to include in the highlighted chain.

Example: In the first chain, you want to dimension the length of walls and 
wall intersections. In the previous steps, you selected Walls and high-
lighted Chain1. Now, you select the check box for Length of Wall and 
choose Wall Length. Then, you select the check mark for Wall Intersec-
tions.

11 Repeat steps 7–9 until your dimension contains all objects and points you 
want to dimension with this style.

12 Click OK twice.

Selecting the AutoCAD Dimension Styles and 
Other Properties of AEC Dimension Styles

Use this procedure to select the AutoCAD® dimension style underlying the 
AEC dimension style and these other settings that affect the appearance of 
the AEC dimension:

� Distance between dimension chains
� Length of extension lines
� Dimension layer
� Display of height of openings
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NOTE Activating the display of the opening height takes effect only if you 
select dimension points for openings in one or more chains of this dimension 
style. For information on selecting opening dimension points, see“Specifying 
Dimension Points in AEC Dimension Styles” on page 2405.

1 Open a tool palette that has an AEC dimension tool.

2 Right-click an AEC dimension tool, and click AEC Dimension Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the Display Properties tab.

5 Select the display representation where you want the changes to appear, 
and select Style Override.

6 If necessary, click .

7 Click the Other tab.

8 To change the underlying AutoCAD dimension style of the AEC dimen-
sion style, select an AutoCAD dimension style.

9 To edit the AutoCAD dimension style, click Edit.

For more information about AutoCAD dimension styles, see AEC Dimen-
sion Styles and AutoCAD Dimension Styles.

To return to the Other tab in the Entity Properties dialog box, click Close.

10 Specify the distance between the single dimension chains in the AEC 
dimension.

Different distances between dimension chains

11 Define whether you want or variable extension lines.

Fixed extension lines have the same length. Variable extension lines adapt 
to the outline of the object they dimension. AutoCAD dimensions use 
variable extension lines.
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Fixed extension lines (left) and variable extension lines (right)

12 If you select fixed extension lines, enter the length of the extension lines. 

Different lengths of extension lines

13 Specify whether to display the height of openings. 

NOTE This opening dimension is used specifically for European working 
plans, where you need a detailed description of measurements.

14 Click Layer to select the layer on which to place the AEC dimension. 

15 Click OK twice.

Changing Style Properties with the AEC 
Dimension Style Wizard

 Use this procedure to change a number of AEC dimension style properties 
with the help of a wizard. The AEC Dimension Style Wizard offers you a fast 
way of changing these properties of a style:

� Arrowhead shape and size
� Length and color of extension lines
� Color of dimension lines
� Distance between dimension chains
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� Dimension text style, size, and color
� Rounding-off value
� Layer assignment

1 On the Format menu, click AEC Dimension Style Wizard. 

2 Select the AEC dimension style to edit and click Next.

IMPORTANT If you choose a dimension style that has its property source 
set to System Default, you get a warning message. If you want to edit the 
style, close the Wizard, open the style in the Style Manager, and set the dis-
play property source to a style override. For more information about working 
with the Style Manager, see “Style Manager” on page 531.

3 Select the display representation to change. 

NOTE If the AEC dimension style you choose to edit is based on the same 
AutoCAD® dimension style for different display representations, the edits you 
make apply to all display representations. To avoid this, make sure that the 
AEC dimension style uses different AutoCAD dimension styles for different dis-
play representations. For more information about assigning AutoCAD dimen-
sion styles to AEC dimension styles, see Selecting the AutoCAD Dimension 
Styles and Other Properties of AEC Dimension Styles.
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4 Specify line and arrow settings:

� Select new arrowhead symbols.
� Change the size of the arrowheads.
� Define a new length for the extension lines.
� Define a new distance between the individual dimension chains.

5 Click Next.

6 Specify text settings:

� Select a new text style.
� Select a new text height.
� Define a new round-off precision for dimension values.

7 Click Next.

8 Specify Color and Layer settings:

� Select a new text color.
� Select a new dimension line color.
� Select a new extension line color.
� Select a new layer for the dimension.

9 Click Finish.

Attaching Notes and Files to an AEC Dimension 
Style

Use this procedure to attach text notes and files to an AEC dimension style.

1 Open a tool palette that has an AEC dimension tool.

2 Right-click an AEC dimension tool, and click AEC Dimension Styles.

3 Right-click the style you want to edit, and click Edit.

4 Click the General tab.

5 To add a description to the AEC dimension style, enter the description 
under Description.

6 Click Notes.

7 To add a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.
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9 Click OK twice.

Q and A for Working with AEC Dimensions

This topic contains questions and answers that can help you to achieve the 
results you want when working with AEC dimensions. 

How do I change the color, text size, and arrowheads of an AEC 
dimension?
Those settings are defined in the AutoCAD® dimension style that underlies 
the AEC dimension style. To access them easily, use the AEC Dimension Style 
Wizard. 

1 On the Format menu, click AEC Dimension Style Wizard. 

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are done editing.

detach a reference file select the file name, click Delete, and click OK.

If you want to . . . Then . . .
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2 Select the AEC dimension style to edit and click Next.

IMPORTANT If you choose a dimension style that has its property source 
set to System Default, you get a warning message. If you want to edit the 
style, close the Wizard, open the style in the Style Manager, and set the dis-
play property source to a style override. For more information about working 
with the Style Manager, see “Style Manager” on page 531.

3 Select the display representation to change.

NOTE If the AEC dimension style you choose to edit is based on the same 
AutoCAD® dimension style for different display representations, the edits you 
make apply to all display representations. To avoid this, make sure that the 
AEC dimension style uses different AutoCAD dimension styles for different dis-
play representations. For more information about assigning AutoCAD dimen-
sion styles to AEC dimension styles, see Selecting the AutoCAD Dimension 
Styles and Other Properties of AEC Dimension Styles.

4 Specify line and arrow settings:

� Select new arrowhead symbols.
� Change the size of the arrowheads.
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� Define a new length for the extension lines.
� Define a new distance between the individual dimension chains.

5 Click Next.

6 Specify text settings:

� Select a new text style.
� Select a new text height.
� Define a new round-off precision for dimension values.

7 Click Next.

8 Specify Color and Layer settings:

� Select a new text color.
� Select a new dimension line color.
� Select a new extension line color.
� Select a new layer for the dimension.

9 Click Finish.

How can I specify that AEC dimensions are updated only on demand? 
If you freeze the layer on which an AEC dimension is placed, the AEC dimen-
sion is updated only when the layer is thawed again or if you execute the 
REGEN command.

When you switch to another view, for example, a three-dimensional (3D) 
view, and then back to a Plan view, the AEC dimension is not updated. Freez-
ing the dimension layer can enhance drawing performance, especially for big 
drawings. 

You can add new AEC dimensions even when the layer is frozen. However, 
you can edit them only after the layer has been thawed again.

How can I change the text height of superscripted numbers in an 
AEC dimension?
By default, the text height of superscripted numbers in AEC dimensions is set 
to 50 percent of the text height of the underlying AutoCAD dimension style 
(DIMTXT). To change this default, you must change the corresponding value 
in the Registry file.

WARNING! Making changes in the Registry file can have far-reaching conse-
quences for the whole application. Before you change anything here, make sure 
that this is what you really want to do. If you are not sure, consult your CAD man-
ager or IT department. 
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1 Open the Windows Registry Editor.

2 Navigate to the entry HKEY_LOCAL_MACHINE\SOFT-
WARE\Autodesk\ObjectDBX\R16.0\AEC\4.0\AecArchDACH-
Base\ObjectDefaults\AEC Dimension\ SuperscriptScaleFactor. 

3 Enter the desired value. The value here is relative to the AutoCAD dimen-
sion text height (DIMTXT).

The AEC dimension for a wall 1 meter high is displayed only with an 
error symbol. How can I get a correct dimension display? 
The cut plane of the AEC dimension is taken from the cut plane of the 
dimensioned wall in the current display configuration. If the cut plane is set 
to a higher value, you must change it to include the lower wall into the 
dimension. For information on setting the wall cut plane, see “Specifying the 
Cut Plane Display of a Wall Style” on page 1882.

I am dimensioning the intersection points of walls and receive more 
dimension points than expected on the dimension. How can I check 
if this dimension is correct?
When you receive more wall intersection dimension points than you expect, 
it is possible that the walls you are dimensioning intersect with other walls 
that are not included in this dimension chain. To see if this is so, and if your 
dimension is correct, you can prolong the extension lines so that they actu-
ally meet the point they dimension. You can then verify that the dimension 
points on your chain are placed correctly. 

1 Select the dimension on which to prolong the extension lines, right-click, 
and click Edit Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Style Override.

4 If necessary, click .

5 Click the Other tab.

6 Clear Use Fixed Lengths Extension Lines. 

7 Click OK twice.

The extension lines of the dimension now reach to the point that they 
dimension. 
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Variable extension lines extend to the point they dimension
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Dimension Labels

Dimension labels are a quick way of adding 
measurement information to doors, windows, 
openings, and stairs.

 Dimension labels contain information about 
openings like sill height, head height, width, or 
the riser/tread ratio in a stair.

You can add any number of dimension labels to 
a single object.

In this chapter

� Standard Dimension Labels

� Specifying Preferences for 
Dimension Labels

� Specifying Advanced 
Preferences via the Registry 
Settings

� Using Dimension Label Tools to 
Create Dimension Labels

� Creating a Dimension Label

� Creating Dimension Labels with 
User-Specified Settings

� Creating a Dimension Label 
Tool

� Modifying Dimension Labels

� Dimension Label Behavior

� Process Overview: Creating 
User-Defined Dimension Labels

35
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Structure of Dimension Labels
A dimension label contains a number of attributes. Those attributes are val-
ues taken from the dimensioned object. You can, for example, have an 
attribute Sill Height for windows. This attribute is represented in the dimen-
sion label as a number with an optional prefix, like SH 2.5. 

Opening and stair labels

Updating Dimension Labels
The values contained in dimension labels are automatically updated when 
the object they refer to changes. For example, if you change the height of a 
window, the dimension label shows the modified height.

Dimension labels are associative. When the object they are dimensioning is 
moved to another position, the dimension label moves accordingly with it.

For detailed information, see “Dimension Label Behavior” on page 2433.

Related Topics

� Standard Dimension Labels

� Specifying Preferences for Dimension Labels

� Specifying Advanced Preferences via the Registry Settings

� Using Dimension Label Tools to Create Dimension Labels

� Creating a Dimension Label

� Creating Dimension Labels with User-Specified Settings

� Creating a Dimension Label Tool

� Modifying Dimension Labels

� Process Overview: Creating User-Defined Dimension Labels
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Standard Dimension Labels

When you install Autodesk® Architectural Desktop, a number of predefined 
standard dimension label definitions are already set for you. They have been 
designed to cater to the most frequent uses architects have for dimension 
labels. 

Because a number of these definitions are stored in templates, it is advised 
that you use templates when you are working extensively with dimension 
labels. If you start a drawing from scratch, a standard dimension label for 
each doors, window, openings, and stairs is provided for you.

Dimension labels are view-dependent, and therefore can have different dis-
play representations.

A display representation decides how a certain object – in this case the 
dimension label – is displayed in a display configuration. 

For information about views and display representations, see “Display Sys-
tem” on page 435.

A dimension label can look different and contain different information in 
Plan 1-100 than in Plan 1-50. 

The size of the standard dimension label text in Plan 1-100 view is 0.25m. In 
Plan 1-50 it is 0.15m, but will be plotted with 0.3m. The default font used is 
Romans.

Related Topics

� Standard Door/Window/Opening Labels

� Standard Stair Label

Standard Door/Window/Opening Labels

The default door dimension label that is present when you start a drawing 
from scratch, contains the head height of the door for all display representa-
tions.

The default window and opening dimension labels, which are present when 
you start a drawing from scratch, contain in Plan 1-100 view the sill height; 
in Plan 1-50 view, they contain also the measurement for the head height.
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Opening labels in Plan 1-100 and Plan 1-50

NOTE Dimension labels for doors, windows, and openings in a wall are 
inserted with a fixed distance to the wall boundary. The default set by the soft-
ware is 0.1 meters from the wall boundary. Because this value is stored in the reg-
istry, the CAD manager can change it there.

Dimension labels for standalone doors, windows, and openings are inserted with 
a fixed distance to the object midpoint.

Standard Stair Label

The default stair dimension label, that is present when you start a drawing 
from scratch, contains values for riser count, riser length, and tread length 
for all display representations.

Stair labels do not support superscripting. However, you can set them to sup-
press the decimal separator for values below one meter. For information 
about these settings, see “Specifying Preferences for Dimension Labels” on 
page 2421.



Specifying Preferences for Dimension Labels | 2421

Stair label in Plan 1-100 and Plan 1-50 (identical)

NOTE Dimension labels for stairs are inserted at the stair midpoint. 

Specifying Preferences for Dimension Labels

Use this procedure to specify general dimension label preferences and pre-
fixes. 

Important settings for dimension labels include the following: 

� superscripting for millimeters
� dimension display unit 
� prefixes and suffixes for the dimension values

1 On the Tools menu, click Options.

2 Click the AEC Dimension tab.
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Settings for dimension labels

3 If meters are your drawing unit, and you want the millimeters displayed 
as superscripted text, select Use Superscript mm. 

4 If you do not want zeros at the end of superscripted numbers, select Trail-
ing Zero Suppression for Superscript. 

You can select this option only if you have selected Use Superscript mm.

5 Select the unit in which AEC dimensions, dimension labels and elevation 
labels are to be displayed. 

This unit can differ from the drawing unit.

6 Define prefixes and suffixes for dimension labels: 

If you want to . . . Then . . .

add a prefix for a window 
dimension label, 

for Select Object Type, select Window, and then 
enter values for sill height, head height, height, 
width, rough height or rough width in the Window 
column. 

add a prefix for a door 
dimension label,

for Select Object Type, select Door, enter a value 
for sill height, head height, height, width, rough 
height or rough width in the Door column. 
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7 If you want dimension labels always to be measured in centimeters, no 
matter what the drawing unit or the dimension unit is set to, select Dis-
play <Object> Label in Centimeter. 

This dimension notation is common in Austria. 

If you do not select this setting, the dimension unit selected in step 5 is 
used.

8 Click OK.

Specifying Advanced Preferences via the 
Registry Settings

There are a number of advanced display settings you can define in the Regis-
try file of Autodesk Architectural Desktop. These settings fine-tune the 
appearance of dimension labels within Autodesk Architectural Desktop. 

NOTE Editing the Registry manually is an advanced task. If you ware not famil-
iar with the Registry, contact your CAD Manager for information.

Related Procedures

� Specifying the Offset of Superscripted Millimeters

� Specifying the Text Height of Dimension Labels

� Specify the Offset of Dimension Labels from the Wall

� Specifying the Placement of Dimension Labels Relative to the Opening 
Direction

add a prefix for an 
opening dimension label,

enter a value for sill height, head height, height, 
width, in the Opening column. 

add a suffix to a stair 
dimension label

enter a value for the stair suffix.

If you want to . . . Then . . .
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Specifying the Offset of Superscripted 
Millimeters

Use this procedure to specify the offset of superscripted millimeters in rela-
tion to the regular dimension label text. 

As a default, the superscript characters are offset by 10%. 

1 Open the Registry Editor on your computer. 

2 Navigate to the entry HKEY_LOCAL_MACHINE\SOFT-
WARE\Autodesk\Object-
DBX\R16.0\AEC\4.0\AECArchDACHBase40\ObjectDefaults\Dimen-
sion Label\SuperscriptYOffset.

3 Double-click the entry.

4 For Value Data, enter the desired offset value in Millimeters.

5 Click OK. 

Specifying the Text Height of Dimension Labels

Use this procedure to specify the text height of dimension labels for Plan 
1:100 and Plan 1:50 display representations.

As a default, the text height of a dimension label is 25 cm for the Plan 1:100 
display representation, and 10 cm for the Plan 1:50 display representation. 
You can change these values in the Registry. 

1 Open the Registry Editor on your computer. 

2 Navigate to the entry HKEY_LOCAL_MACHINE\SOFT-
WARE\Autodesk\Object-
DBX\R16.0\AEC\4.0\AECArchDACHBase40\ObjectDefaults\Dimen-
sion Label\Unit_MM\TextHeight100 
or
HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\Object-
DBX\R16.0\AEC\4.0\AECArchDACHBase40\ObjectDefaults\Dimen-
sion Label\Unit_MM\TextHeight50.

3 Double-click the entry.

4 For Value Data, enter the desired text height in Millimeters.

5 Click OK. 
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Specify the Offset of Dimension Labels from the 
Wall

Use this procedure to specify the offset of dimension labels to the wall the 
dimensioned object is anchored to.

Dimension labels are inserted with a fixed distance to the wall in which the 
dimensioned object is situated. 

1 Open the Registry Editor on your computer. 

2 Navigate to the entry HKEY_LOCAL_MACHINE\SOFT-
WARE\Autodesk\Object-
DBX\R16.0\AEC\4.0\AECArchDACHBase40\ObjectDefaults\Dimen-
sion Label\Unit_MM\WallOffset 
or
HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\Object-
DBX\R16.0\AEC\4.0\AECArchDACHBase40\ObjectDefaults\Dimen-
sion Label\Unit_IN\WallOffset.

3 Double-click the entry.

4 For Value Data, enter the desired offset in Millimeters.

5 Click OK. 

Specifying the Placement of Dimension Labels 
Relative to the Opening Direction

Use this procedure to specify the placement of dimension labels relative to 
the opening direction of the dimensioned object. 

You can place dimension labels at the side of the opening or on the opposite 
side.

1 Open the Registry Editor on your computer. 

2 Navigate to the entry HKEY_LOCAL_MACHINE\SOFT-
WARE\Autodesk\Object-
DBX\R16.0\AEC\4.0\AECArchDACHBase40\ObjectDefaults\Dimen-
sion Label\Insert Inside.

3 Double-click the entry.
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4 Specify the placement of dimension labels:

5 Click OK. 

Using Dimension Label Tools to Create 
Dimension Labels

Tools provided with Autodesk® Architectural Desktop let you quickly place 
dimension labels by selecting a dimension label tool with a specific multi-
view block definition and other predefined properties. When you place 
dimension labels using dimension label tools, you can use the default set-
tings of the tool, or you can change settings for the dimension label proper-
ties. 

If you want to . . . Then . . .

place all dimension labels on 
the side of the opening 
direction,

enter 1 for Value Data.

place all dimension labels on 
the opposite side of the 
opening direction,

enter 0 for Value Data.
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Tool palettes containing dimension label tools

The default tool palettes in the workspace contain sample dimension label 
tools that you can use and customize as needed. In addition, the following 
catalogs provided with the software contain dimension label tools that you 
can add to your tool palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

Custom palettes created by your CAD manager or other users may also con-
tain dimension label tools with multi-view block definitions and properties 
that are customized for your projects or office standards.

Related Procedures

� Creating a Dimension Label

� Creating Dimension Labels with User-Specified Settings

� Creating a Dimension Label Tool
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Creating a Dimension Label

Use this procedure to add a new dimension label that has the properties spec-
ified in the dimension label tool that you select. To specify settings when you 
add a dimension label, see “Creating Dimension Labels with User-Specified 
Settings” on page 2428.

1 Open the Annotation tool palette, and select a dimension label tool.

If necessary, scroll to display the tool that you want to use.

2 Select the object to which you want to attach the dimension label, and 
press ENTER. 

3 Click OK in the subsequent dialog box.

Creating Dimension Labels with User-
Specified Settings

Use this procedure to add a dimension label with settings that you specify.

1 Open the Annotation tool palette, and select a dimension label tool.

If necessary, scroll to display the tool that you want to use.

2 Select the object to which you want to attach the dimension label, and 
press ENTER. 

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Enter a different scale factor if necessary. 

4 Click OK.

Creating a Dimension Label Tool

Use this procedure to create a dimension label tool and add it to a tool pal-
ette. You may want to create your own dimension label tools if you are plac-
ing multiple dimension labels of specific definitions with additional dimen-
sion label properties that you want to be the same each time you add a 
dimension label of that type.
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Dimension labels consist of a multi-view block definition connected to a cus-
tom AEC command. Therefore, the process of creating a dimension label tool 
differs from the process of creating a regular object tool, like a door tool. 

To create a dimension label tool, you need first a multi-view block definition 
with a custom command that is placed in DesignCenter. A number of pre-
defined dimension labels are already in DesignCenter, so you would, as a first 
step, look there, and determine if the desired dimension label is already 
there. 

If you find no dimension label meeting your needs, you need to create one, 
as described in “Process Overview: Creating User-Defined Dimension Labels” 
on page 2434,and put that into DesignCenter.

From DesignCenter, you can easily and comfortably create a dimension label 
tool.

1 Open the DesignCenter and navigate to the folder containing the dimen-
sion label you want to create a tool from. 

2 Open the tool palette where you want to create the dimension label tool.

3 Create the tool:

4 Right-click the new tool, and click Properties.

5 Enter a name for the tool.

6 Click the setting for Description, enter a description of the tool, and click 
OK.

7 Click OK.

If you want to . . . Then . . .

create a tool from the 
DesignCenter

drag the desired dimension label from the 
DesignCenter to the tool palette. 

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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Modifying Dimension Labels

You can change the attributes of an dimension label, like the rotation or the 
scaling factor.

Related Procedures

� Changing the Associated Multi-View Block Definition

� Changing the Scale Factor of an Dimension Label

� Changing the Offset of a Dimension Label

� Display the View Blocks and Attributes of a Dimension Label

� Attaching Hyperlinks, Notes, or Files to a Dimension Label

Changing the Associated Multi-View Block 
Definition

Use this procedure to change the multi-view block associated to an dimen-
sion label. For information about how multi-view block definitions are an 
integral part of dimension labels, see “Process Overview: Creating User-
Defined Dimension Labels” on page 2434.

1 Select the dimension labels you want to change, and double-click one of 
them.

2 Expand Basic, and expand General.

3 Select a different multi-view block definition for Definition. 

Changing the Scale Factor of an Dimension Label

Use this procedure to change the scale factor of a dimension label.

1 Select the dimension labels you want to change, and double-click one of 
them.

2 Expand Basic, and expand Scale.

3 Change the scale factor of the dimension label. 

If you want to . . . Then . . .

change the X scale factor enter a new value for X.

change the Y scale factor enter a new value for Y.

change the Z scale factor enter a new value for Z.



Modifying Dimension Labels | 2431

Changing the Offset of a Dimension Label

Use this procedure to change the offset of the dimension label from its inser-
tion point.

When you first add a dimension label to a drawing, the offset value is set to 
0. You can change the position of the dimension label in the drawing by off-
setting it from its original insertion point.

1 Select the dimension labels you want to change, and double-click one of 
them.

2 Expand Advanced. 

3 Click Insertion Offsets.

4 Select the view block for the appropriate view. For example, if you want to 
change the offset in Plan 1:100, select a view block that indicates that it 
belongs to that view (for example, DoorLabel100). 

5 Change the offset of the dimension label from its insertion point. 

6 Click OK.

Display the View Blocks and Attributes of a 
Dimension Label

Use this procedure to display the blocks and attributes contained in a dimen-
sion label. 

A dimension label is created from a multi-view block definition which in 
turn is built from blocks and attributes. You can display the blocks and 
attributes to understand how the label is structured.

1 Double-click the dimension label for which you want to display the view 
blocks and attributes. 

2 Expand Advanced. 

If you want to . . . Then . . .

change the offset from the 
X insertion point

enter a new value for X offset.

change the offset from the 
Y insertion point

enter a new value for Y offset.

change the offset from the 
Z insertion point

enter a new value for Z offset.
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3 Click Attributes.

In the Multi-View Blocks Attributes worksheet, the blocks of which your 
dimension label is composed are displayed.

The list on the right lists the attributes the blocks are composed of and 
their current values.

For more information about multi-view blocks, blocks, and attributes, see 
“Process Overview: Creating User-Defined Dimension Labels” on 
page 2434.

NOTE Although you can edit the values in the list, those modifications are 
not applied; your modified values are overwritten by the actual values the 
dimension label gets from its coordinate system.

4 Click OK.

Attaching Hyperlinks, Notes, or Files to a 
Dimension Label

Use this procedure to attach hyperlinks, text notes and files to a dimension 
label. 

1 Double-click the dimension label you want to attach information to.

2 Click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click the setting for Notes, and add a note. Then, click OK.

5 Click the setting for Reference Documents.

6 Attach or detach reference files:

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.
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7 Click OK. 

Dimension Label Behavior

Dimension labels are associated with the object they dimension – a door, 
window, opening or stair. Therefore their behavior in the drawing is depen-
dent on that object. Dimension labels are subordinate to the dimensioned 
object, which means that the behavior of the object does influence their 
behavior, but not the other way around. If for example you move a door, the 
dimension label associated with it does move, too. If, however, you move the 
dimension label, the door does not move with it.

Below you can find a list of operations you can perform with objects and 
their associated dimension labels, and how they react with each other 

detach a reference file
select the file name, and click .

Selection Action Reaction

Dimensioned 
object…

…is moved Dimension label is moved, too.

…is rotated Dimension label is rotated too.

…is mirrored 
without deleting 
the source object

Dimension label stays connected with 
source object 

…is mirrored with 
deleting the source 
object

Dimension label is connected to 
mirrored object.

…is deleted Dimension label is deleted too.

…is copied Dimension label is not copied.

Dimension 
label

…is moved Dimensioned object is not moved.

…is rotated Dimensioned object is not rotated.

…is mirrored Dimension label is moved, not mirrored

If you want to . . . Then . . .
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Process Overview: Creating User-Defined 
Dimension Labels

The Autodesk® Architectural Desktop templates offer you a number of pre-
defined dimension labels.

However, you may want to create your own, specific labels that are not 
included in any of the templates.

In the following sections, you learn how to select attributes for your own 
dimension labels, combine them into blocks, and create dimension labels 
from them.

…is deleted Dimensioned object is not deleted.

…is copied Copied dimension label is attached to 
dimensioned object, too.

Dimension 
label and 
dimensioned 
object

…are moved Dimension label and dimensioned 
object move.

…are rotated Dimensioned object is rotated by the 
specified value in relation to ECS; 
Dimension label is rotated by the 
specified value in relation to 
dimensioned object.

…are mirrored 
without deleting 
source objects

Dimensioned object and dimension 
label are mirrored. 

NOTE Dimension label text can only be 
mirrored when the MIRRTEXT variable is 
set to 1. 

…are mirrored with 
deleting source 
objects

Dimension label is not mirrored, but is 
connected to mirrored object.

…are deleted Dimension label and dimensioned 
object are deleted.

…are copied Dimension label and dimensioned 
object are copied.

Selection Action Reaction
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The creation of a user-defined dimension label consists of these basic steps.

Step 1: Determine the location of the property set definition of the custom 
label.

Step 2: If necessary, create a new property set definition to use in the custom 
label.

Step 3: Add attributes from the property set definition to the drawing. 

Step 4: Create a block from the attributes.

Step 5: Create a multi-view block from the block.

Step 6: Add the dimension label to the AutoCAD® DesignCenter.

Related Procedures

� Determine the Location of the Property Set Definitions

� Adding Attributes

� Creating a Block

� Creating a Multi-View Block

� Adding the Dimension Label to the DesignCenter

Determine the Location of the Property Set 
Definitions

Use this procedure to determine the source drawing of the label’s property set 
definition.

When you create a user-defined label for the DesignCenter, you need to save 
the used property set definition in a drawing file the label can access when it 
is inserted from the DesignCenter. There are two different locations for the 
source drawing:

� The Autodesk Architectural Desktop PropertySetDefs.dwg: This is the 
default drawing file for DesignCenter blocks in the software. All existing 
DesignCenter parts use this drawing as the container for their property set 
definitions. If you only have a small number of custom tags, it is recom-
mended that you save them in this drawing. 

� Your own user-defined property set definition drawing: You can create 
your own property set definition drawing, when you have large number 
of custom blocks in your work environment, or want to have separate 
drawings for different tag types, e.g. PropertySetDefsDoors.dwg, Property-
SetDefsWindows.dwg, etc. 
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NOTE The drawing containing the property set definitions for your tags must 
be located one folder level above the actual tag drawing. Otherwise, the soft-
ware cannot find the associated property set definitions. For example, if your tag 
resides in //Content/Schedules/UserDefined Tags/, then the associated property 
set definitions drawing needs to be in //Content/Schedules/.

1 Either open the Autodesk Architectural Desktop PropertySetDefs.dwg, or 
create a new property set definitions drawing. 

NOTE The Autodesk Architectural Desktop PropertySetDefs.dwg is situated 
in //Autodesk Architectural Desktop/Content/<Metric Imperial Metric 
DACH>/Schedules/.

2 If necessary, create a property set definition for the user-defined label. 

3 Proceed as described in “Adding Attributes” on page 2436.

Adding Attributes

Use this procedure to add attributes to the drawing. 

Dimension label attributes are coming from a property set definition. A num-
ber of predefined automatic attributes are available if you start with a tem-
plate or if you have started from scratch and dragged a predefined dimension 

label from the AutoCAD® DesignCenter into the drawing.

If you want different attributes for your dimension labels, create your own 
property set definition for dimension labels. For information about creating 
property set definitions, see “Property Set Definitions” on page 2241.

Dimension Label Attributes 

Attribute Object Description

OPENING:SILLHEIGHT Window
, 
Openin
g 

Returns the sill height of a window or 
opening
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OPENING:SILLHEIGHT:MM Window
, 
Openin
g

Returns superscripted millimeters for the 
sill height of a window or opening

This value is only displayed if you have set 
the option Superscripted Millimeters in 
the AEC dimension preferences. For 
information, see “Specifying AEC 
Dimension Preferences” on page 2371.

OPENING:HEADHEIGHT Window
, 
Openin
g, Door

Returns the head height of a window, 
opening or door

OPENING:HEADHEIGHT:M
M

Window
, 
Openin
g, Door

Returns superscripted millimeters for the 
head height of a window, door or 
opening

This value is only displayed if you have set 
the option Superscripted Millimeters in 
the AEC dimension preferences. For 
information, see “Specifying AEC 
Dimension Preferences” on page 2371.

OPENING:HEIGHT Window
, 
Openin
g, Door

Returns the opening height of a window, 
opening or door

OPENING:HEIGHT:MM Window
, 
Openin
g, Door

Returns superscripted millimeters for the 
height of a window, door or opening

This value is only displayed if you have set 
the option Superscripted Millimeters in 
the AEC dimension preferences. For 
information, see “Specifying AEC 
Dimension Preferences” on page 2371.

OPENING: WIDTH Window
, 
Openin
g, Door

Returns the opening width of a window, 
opening or door

Dimension Label Attributes 

Attribute Object Description
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1 On the command line, enter ddattdef.

2 In the Tag field, enter one of the attributes described above. If you want, 
for example, create an attribute for the rough height of windows and 
doors, enter OPENING:ROUGHHEIGHT here. 

3 Proceed to adding the attribute as described in “Working with Attributes” 
in the AutoCAD 2004 User’s Guide. 

4 Repeat steps 1-3 for each attribute you want to add to the dimension label.

OPENING:WIDTH:MM Window
, 
Openin
g, Door

Returns superscripted millimeters for the 
width of a window, door or opening

This value is only displayed if you have set 
the option Superscripted Millimeters in 
the AEC dimension preferences. For 
information, see “Specifying AEC 
Dimension Preferences” on page 2371.

OPENING:ROUGHHEIGHT Window
, Door

Returns the rough height of a window or 
door (height without sash and frame)

OPENING:ROUGHHEIGHT:
MM

Window
, Door

Returns superscripted millimeters for the 
rough height of a window or door

This value is only displayed if you have set 
the option Superscripted Millimeters in 
the AEC dimension preferences. For 
information, see “Specifying AEC 
Dimension Preferences” on page 2371.

OPENING:ROUGHWIDTH Window
, Door

Returns the rough width of a window or 
door (width without sash or frame)

OPENING:ROUGHWIDTH:
MM

Window
, Door

Returns superscripted millimeters for the 
rough width of a window or door

This value is only displayed if you have set 
the option Superscripted Millimeters in 
the AEC dimension preferences. For 
information, see “Specifying AEC 
Dimension Preferences” on page 2371.

STAIR:RISERCOUNT Stair Returns the riser count of a stair

STAIR:TREADRISER Stair Returns the length of the stair riser and 
the length of the stair tread

Dimension Label Attributes 

Attribute Object Description
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As a result, you have a number of attributes in your drawing. For a user 
defined dimension label containing the rough height and rough width of a 
window with superscript settings it could look like this:

Attribute block for dimension label

Creating a Block

Use this procedure to create a block which contains the attributes added in 
the previous step.

1 On the Draw menu, click Block ➤ Make.

2 Enter a name for the block.

3 Click Select Objects, and select the attributes you want to include in the 
dimension label.

4 From the Insert units list, select Unitless.

5 Proceed to creating the block as described in “Defining Blocks” in the 
AutoCAD 2004 User’s Guide. 

Creating a Multi-View Block

Use this procedure to create a multi-view block from one or several blocks 
created in the previous step.

For detailed information about multi-view blocks, see “Multi-View Blocks” 
on page 2481.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects and expand Multi-View Block Definitions.

3 Right-click Multi-View Block Definitions, and click New.

4 Enter a name for the new multi-view block definition and press ENTER.

5 Select the new multi-view block definition, right-click and select Edit.

6 Click the View Blocks tab.

7 Select a display representation for the dimension label.

8 Click Add.

9 Select the block you have defined in “Creating a Block”, and click OK.
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10 Select the view directions for the block.

11 Repeat Steps 6-9 for each display representation in which you want the 
dimension label to appear.

12 Click OK twice.

Adding the Dimension Label to the 
DesignCenter

Use this procedure to add a dimension label to the AutoCAD® DesignCenter. 
To add the dimension label to the DesignCenter, you need to create a *.dwg 
file in the AEC Content Wizard. In this section you find a short description 
of how to add user-defined dimension labels to the DesignCenter. For a 
detailed description of the AEC Content Wizard, see “Custom Content” on 
page 2343.

1 On the Desktop menu, click Create AEC Content to open the Create AEC 
Content Wizard.

2 Select Custom Command.

3 Select the multi-view block you have created in “Creating a Multi-View 
Block” on page 2439, and click Add to add it to the Content File. 

4 On the command line, enter AecAnnoScheduleTagAdd, a space and then 
the name of the multi-view block, and its parameters. The command is 
built up as follows: 

_AecAnnoScheduleTagAdd <Name of the drawing containing the prop-
erty set definition>.dwg _SYMBOL <name of the multi-view block cre-
ated>_LEADER _None _DIMSTYLE Current

In our example, the custom command could look like this: 

_AecAnnoScheduleTagAdd DimLabelPropertySetDefs.dwg _SYMBOL 
DoorDimLabelMVBlock _LEADER _None _DIMSTYLE Current

5 Click Next. 

6 Select Enable AEC Unit Scaling.

7 Select a layer key for the label.

NOTE The default layer key for dimension labels is DIMLINE.

8 Click Next.

9 Enter a filename and a directory for the label. 
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NOTE Make sure to save the custom label in a folder one level below the 
used property set definition drawing. If the property set definition drawing is 
saved in //Autodesk Architectural Desktop/Content/Schedules/, then the cus-
tom label could be saved in //Autodesk Architectural Desktop/Content/
Schedules/Dimension Labels/. 

10 Click Finish to exit the Create AEC Content Wizard.

The new dimension label appears now in the DesignCenter at the location 
you have specified in the AEC Content Wizard. From here, you can drag it 

into your drawing.
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Elevation Labels

Elevation labels are used to dimension height values in 

plan and section views.

They are a component of the Autodesk® Architectural 

Desktop dimensioning features, which contains 

AEC dimensions, dimension labels and elevation labels. 

In this section, you learn how to add elevation labels to 

your drawing, change their values, and define your own 

elevation labels.

In this chapter

� Using Elevation Label Tools to 
Create Elevation Labels

� Creating an Elevation Label

� Creating Elevation Labels with 
User-Specified Settings

� Creating an Elevation Label 
Tool

� Modifying Elevation Labels

� Process Overview: Creating 
User-Defined Elevation Labels

36
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Elevation Labels and Coordinate Systems
Elevation labels are interactive multi-view blocks used for dimensioning 
heights in a drawing. They are anchored to either the world coordinate 
system (WCS) or a named user coordinate system (UCS). Elevation labels are 
used primarily for measuring the heights of building elements like walls or 
windows, but they can be used to measure every point in your drawing. You 
can add elevation labels in plan and section views. Autodesk® Architectural 
Desktop offers you a number of predefined blocks for commonly used eleva-
tion labels. You can also define your own elevation labels.

When elevation labels are moved along the Z-axis, their Z-values change 
accordingly. Elevation labels can, however, be anchored only to a named 
UCS or the WCS; not to any building object. If the object height is changed, 
the value of the elevation label is not updated automatically. 

An elevation label measures the height of a point with relation to the refer-
ence height. The reference height can be taken from the Z-coordinate of the 
WCS or the Z-coordinate of a named UCS. 

Frequently used elevation labels

Related Procedures

� Using Elevation Label Tools to Create Elevation Labels

� Creating an Elevation Label

� Creating Elevation Labels with User-Specified Settings

� Creating an Elevation Label Tool

� Modifying Elevation Labels

� Process Overview: Creating User-Defined Elevation Labels
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Using Elevation Label Tools to Create 
Elevation Labels

Tools provided with Autodesk® Architectural Desktop let you quickly place 
elevation labels by selecting an elevation label tool with a specific multi-view 
block definition and other predefined properties. When you place elevation 
labels using elevation label tools, you can use the default settings of the tool, 
or you can change settings for the elevation label properties. 

Tool palettes containing elevation label tools

The default tool palettes in the workspace contain sample elevation label 
tools that you can use and customize as needed. In addition, the following 
catalogs provided with the software contain elevation label tools that you 
can add to your tool palettes:

� Stock Tool catalog
� Autodesk Architectural Desktop Sample Palette catalog
� Mytool catalog

Custom palettes created by your CAD manager or other users may also con-
tain elevation label tools with multi-view block definitions and properties 
that are customized for your projects or office standards.



2446 | Chapter 36 Elevation Labels

Related Procedures

� Creating an Elevation Label

� Creating Elevation Labels with User-Specified Settings

� Creating an Elevation Label Tool

Creating an Elevation Label

Use this procedure to add a new elevation label that has the properties spec-
ified in the elevation label tool that you select. To specify settings when you 
add an elevation label, see “Creating Elevation Labels with User-Specified Set-
tings” on page 2446.

1 Open the Annotation tool palette, and select an elevation label tool.

If necessary, scroll to display the tool that you want to use.

2 Specify the insertion point of the elevation label.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Click OK in the subsequent dialog box.

Creating Elevation Labels with User-Specified 
Settings

Use this procedure to add an elevation label with settings that you specify.

1 Open the Annotation tool palette, and select an elevation label tool.

If necessary, scroll to display the tool that you want to use.

2 In the drawing area, specify the insertion point of the elevation label.

You can move or hide the Properties palette to expose more of the drawing 
area.

3 Select the coordinate system the elevation label is relative to.

If you want to . . . Then . . .

select an existing coordinate 
system from the drawing

under UCS, select the coordinate system 
from the list. 
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4 Enter the elevation value of your label.

The value you enter here is always calculated in relation to the coordinate 
system you have selected. When you redefine the coordinate system, the 
Z-value of the elevation label is recalculated accordingly. 

For example, you have a UCS named “First Floor” with its Z-origin at 3 m. 
When you insert an elevation label in WCS and set it to 2 m, and then 
change the coordinate system to “First Floor” the Z-value of the elevation 
label is changed to -1 m. 

5 If needed, enter a prefix and suffix for the elevation label.

6 Click OK.

Creating an Elevation Label Tool

Use this procedure to create an elevation label tool and add it to a tool pal-
ette. You may want to create your own elevation label tools if you are placing 
multiple elevation labels of specific definitions with additional elevation 
label properties that you want to be the same each time you add an elevation 
label of that type.

Elevation labels consist of a multi-view block definition connected to a cus-
tom AEC command. Therefore, the process of creating an elevation label tool 
differs from the process of creating a regular object tool, like a door tool. 

To create an elevation label tool, you need a multi-view block definition with 
a custom command that is placed in AutoCAD DesignCenter. Predefined ele-
vation labels are available in DesignCenter, so check to see if the desired ele-
vation label is already there. 

create a new named user 
coordinate system (UCS) click (Define UCS), and define the 

new UCS on screen. For information on 
creating user coordinate systems, see 
“Use Coordinates and Coordinate 
Systems” in the AutoCAD 2004 User 
Guide. 

use the UCS of an existing 
elevation label, click  (Match UCS) and select the 

elevation label on screen. 

If you want to . . . Then . . .
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If you find no elevation label meeting your needs, create one, as described in 
“Process Overview: Creating User-Defined Elevation Labels” on page 2452, 
and place that into AutoCAD DesignCenter.

From AutoCAD DesignCenter, you create an elevation label tool.

1 Open the AutoCAD DesignCenter and navigate to the folder containing 
the elevation label from which you want to create a tool. 

2 Open the tool palette where you want to create the elevation label tool.

3 Create the tool:

4 Right-click the new tool, and click Properties.

5 Enter a name for the tool.

6 Click the setting for Description, enter a description of the tool, and click 
OK.

7 Click OK.

Modifying Elevation Labels

You can change the attributes of an elevation label, such as the associated 
UCS or the scaling factor.

Autodesk® Architectural Desktop offers several methods for editing elevation 
labels:

� You can change elevation label settings on the Properties palette.

If you want to . . . Then . . .

create a tool from the AutoCAD 
DesignCenter

drag the desired elevation label from the 
AutoCAD DesignCenter to the tool palette. 

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from a tool catalog open the catalog in the Content Browser, and 
locate the tool you want to copy. Position the 
cursor over the i-drop handle, and drag the 
tool to the tool palette.
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� You can select editing commands from the shortcut menu for a selected 
elevation label.

Related Procedures

� Changing the Elevation of an Elevation Label

� Changing the Coordinate System of an Elevation Label

� Changing the Associated Multi-View Block Definition

� Changing the Scale Factor of an Elevation Label

� Changing the Offset of an Elevation Label

� Display the View Blocks and Attributes of an Elevation Label

� Attaching Hyperlinks, Notes, or Files to an Elevation Label

Changing the Elevation of an Elevation Label

Use this procedure to change the elevation value of an elevation label.

The value of an elevation label is always calculated in relation to the coordi-
nate system of the label. 

1 Select the elevation label of which you want to change the elevation, 
right-click, and click Elevation Label Modify.

2 Enter the new elevation value. 

3 Click OK.

Changing the Coordinate System of an Elevation 
Label

Use this procedure to change the coordinate system of an elevation label.

For more information on how elevation labels are dependent on coordinate 
systems, see “Elevation Labels” on page 2443.

1 Select the elevation label of which you want to change the coordinate sys-
tem, right-click, and click Elevation Label Modify.

2 Select a new coordinate system for the elevation label from the list.

3 Click OK.

Changing the Associated Multi-View Block 
Definition

Use this procedure to change the multi-view block definition associated to an 
elevation label. For information about multi-view block definitions and ele-
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vation labels, see “Process Overview: Creating User-Defined Elevation 
Labels” on page 2452.

1 Select the elevation labels you want to change, and double-click one of 
them.

2 Expand Basic, and expand General.

3 Select a different multi-view block definition for Definition. 

Changing the Scale Factor of an Elevation Label

Use this procedure to change the scale factor of an elevation label.

1 Select the elevation labels you want to change, and double-click one of 
them.

2 Expand Basic, and expand Scale.

3 Change the scale factor of the elevation label:

Changing the Offset of an Elevation Label

Use this procedure to change the offset of the elevation label from its inser-
tion point.

When you first add an elevation label to a drawing, the offset value is set to 
0. You can change the position of the elevation label in the drawing by off-
setting it from its original insertion point.

1 Double-click the elevation label for which you want to change the inser-
tion offset.

2 Expand Advanced. 

3 Click Insertion Offsets.

4 Select the view block for the appropriate view. For example, to change the 
offset in Plan 1:100, select a view block to indicate that it belongs to that 
view (for example, ElevationLabel100). 

If you want to . . . Then . . .

change the X scale factor enter a new value for X.

change the Y scale factor enter a new value for Y.

change the Z scale factor enter a new value for Z.
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5 Change the offset of the elevation label from its insertion point:

6 Click OK.

Display the View Blocks and Attributes of an 
Elevation Label

Use this procedure to display the blocks and attributes contained in an ele-
vation label. 

An elevation label is created from a multi-view block definition which, in 
turn, is built from blocks and attributes. You can display the blocks and 
attributes to understand how the label is structured.

1 Double-click the elevation label for which to display blocks and attributes. 

2 Expand Advanced. 

3 Click Attributes.

In the Multi-View Blocks Attributes worksheet, the blocks from which 
your elevation label is composed are displayed.

The list on the right shows the attributes of the blocks and their current 
values.

For more information about multi-view blocks, blocks, and attributes, see 
“Process Overview: Creating User-Defined Elevation Labels” on 
page 2452.

NOTE Although you can edit the values in the list, those modifications are 
not applied; your modified values are overwritten by the values the elevation 
label gets from its coordinate system.

4 Click OK.

If you want to . . . Then . . .

change the offset from the 
X insertion point

enter a new value for X offset.

change the offset from the Y 
insertion point

enter a new value for Y offset.

change the offset from the 
Z insertion point

enter a new value for Z offset.
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Attaching Hyperlinks, Notes, or Files to an 
Elevation Label

Use this procedure to attach hyperlinks, text notes and files to an elevation 
label. 

1 Double-click the elevation label you want to attach information to.

2 Click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 Click the setting for Notes, and add a note. Then, click OK.

5 Click the setting for Reference Documents.

6 Attach or detach reference files:

7 Click OK. 

Process Overview: Creating User-Defined 
Elevation Labels

The Autodesk® Architectural Desktop templates provide a number of pre-
defined elevation labels.You may, however, want to create specific labels that 
are not included in any of the templates.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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In the following sections, you can learn how to choose attributes for your 
own elevation labels, combine them into blocks, and create elevation labels 
from them.

Creating a user-defined elevation label consists of these basic steps.

Step 1: Determine the location of the property set definition of the custom 
label.

Step 2: If necessary, create a new property set definition to use in the custom 
label.

Step 3: Create a graphic symbol.

Step 4: Add attributes from the property set definition to the drawing. 

Step 5: Create a block from the attributes.

Step 6: Create a multi-view block from the block.

Step 7: Add the elevation label to AutoCAD® DesignCenter.

Related Procedures

� Determining the Location of the Property Set Definitions

� Creating a Graphic Symbol

� Adding Attributes

� Creating a Block

� Creating a Multi-View Block

� Adding the Elevation Label to the AutoCAD DesignCenter

Determining the Location of the Property Set 
Definitions

Use this procedure to determine the source drawing of the label’s property set 
definition.

When you create a user-defined label for the DesignCenter, you must save 
the used property set definition in a drawing file the label can access when it 
is inserted from the DesignCenter. There are two different locations for the 
source drawing:

� The Autodesk Architectural Desktop PropertySetDefs.dwg: This is the 
default drawing file for DesignCenter blocks in the software. All existing 
DesignCenter parts use this drawing as the container for their property set 
definitions. If you have only a small number of custom tags, it is recom-
mended that you save them in this drawing. 

� A user-defined property set definition drawing: You can create your own 
property set definition drawing when you have numerous custom blocks 
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in your work environment, or if you want to have separate drawings for 
different tag types, for example PropertySetDefsDoors.dwg, PropertySet-
DefsWindows.dwg, and so on. 

NOTE The drawing containing the property set definitions for your tags must 
be located one folder level above the actual tag drawing. Otherwise, the soft-
ware cannot find the associated property set definitions. For example, if your tag 
resides in //Content/Schedules/UserDefined Tags/, then the associated property 
set definitions drawing needs to be in //Content/Schedules/.

1 Open the Autodesk Architectural Desktop PropertySetDefs.dwg, or create a 
new property set definitions drawing. 

2 If necessary, create a property set definition for the user-defined label. 

For information on creating property set definitions, see “Creating a Prop-
erty Set Definition” on page 2247.

3 Proceed as described in “Creating a Graphic Symbol” on page 2454.

Creating a Graphic Symbol

Elevation labels usually consist of a graphic symbol and a number of 
attributes defining elevation height and other information.

You can create a graphic symbol with any of the drawing commands in 

AutoCAD®, as well as importing a symbol from another drawing or from a 
symbol library. 

For information about drawing objects in AutoCAD, see “Create and Insert 
Symbols (Blocks)” in the online AutoCAD 2004 User’s Guide.

Adding Attributes

An elevation label usually contains one or several attributes displaying the 
elevation, prefixes, and suffixes.

Elevation label attributes come from a property set definition. Predefined 
automatic attributes are available when you start with one of the templates, 
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or when you start from scratch and drag a predefined elevation label from 

AutoCAD® DesignCenter into the drawing.

To use different attributes in elevation labels, create your own Property Set 
Definition for elevation labels. For information about creating property set 
definitions, see “Property Set Definitions” on page 2241.

1 On the command line, enter ddattdef.

2 For Tag, enter one of the attributes from the table above. If you want, for 
example, to create an attribute for the height of the elevation, enter 
ELEVATION. 

3 Proceed with creating the attribute. For more information, see “Attach 
Data to Blocks” in the online AutoCAD 2004 User’s Guide. 

4 Repeat steps 1–3 for each attribute you want to add to the elevation label.

Creating a Block

Use this procedure to create a block from the attributes you have created.

1 On the Draw menu, click Block ➤ Make.

2 Enter a name for the block.

3 Click Select Objects and select the graphic symbol and the attributes to 
include in the elevation label.

4 For Insert Units, select Unitless.

Elevation label attributes

Attribute/Tag Description

ELEVATION Displays the height of an elevation label in relation to the 
coordinate system chosen

ELEVATION:MM Displays the millimeters of the elevation value in superscript.
You need this attribute only when working with metric 
units. 

PREFIX To to enter a prefix for the elevation label, you must add this 
attribute. For information about entering prefixes, see 
“Creating Elevation Labels with User-Specified Settings” on 
page 2446. 

SUFFIX To enter a suffix for the elevation label, you must add this 
attribute. For information about entering suffixes, see 
“Creating Elevation Labels with User-Specified Settings” on 
page 2446. 
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5 Proceed with creating the block as described in “Create Blocks” in the 
online AutoCAD 2004 User’s Guide. 

Creating a Multi-View Block

Use this procedure to create a multi-view block for the elevation label.

For detailed information about multi-view blocks, see “Multi-View Blocks” 
on page 2481.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Multi-View Block Definitions.

3 Right-click Multi-View Block Definitions, and click New.

4 Enter a name for the new multi-view block definition and press ENTER.

5 Select the new multi-view block definition, right-click and click Edit.

6 Click the View Blocks tab.

7 Select a display representation for the elevation label.

8 Click Add.

9 Select the block you defined in “Creating a Block” on page 2455, and click 
OK.

10 Select the view directions for the block.

11 Repeat steps 6–9 for each display representation where you want the ele-
vation label to display.

12 Click OK twice.

Adding the Elevation Label to the AutoCAD 
DesignCenter

To add the elevation label to AutoCAD® DesignCenter, you need to create a 
*.dwg file in the AEC Content Wizard. In this section is a short description of 
how to add user-defined elevation labels to AutoCAD DesignCenter. For a 
detailed description of the AEC Content Wizard, see “Custom Content” on 
page 2343.

1 On the Format menu, click Create AEC Content to open the Create AEC 
Content Wizard.

2 Select Custom Command.

3 Select the multi-view block you created in “Creating a Multi-View Block” 
on page 2456, and click Add to add it to the Content File. 
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4 On the command line, enter AecAnnoScheduleTagAdd, a space and then 
the name of the multi-view block, and its parameters. The command is 
built up as follows: 

_AecAnnoScheduleTagAdd <name of the drawing containing the prop-
erty set definition>.dwg _SYMBOL <name of the multi-view block cre-
ated>_LEADER _None _DIMSTYLE Current

In our example, the custom command could look like this: 

_AecAnnoScheduleTagAdd ElevationLabelPropertySetDefs.dwg _SYMBOL 
ElevationLabelMVBlock _LEADER _None _DIMSTYLE Current

5 Click Next. 

6 Select Enable AEC Unit Scaling.

7 Select a layer key for the label.

NOTE The default layer key for elevation labels is DIMLINE.

8 Click Next.

9 Enter a file name and a folder for the label. 

NOTE Be sure to save the custom label in a folder one level below the used 
property set definition drawing. If the property set definition drawing is saved 
in //Autodesk Architectural Desktop/Content/Schedules/, then the custom 
label could be saved in //Autodesk Architectural Desktop/Content/Schedules/
Elevation Labels/. 

10 Click Finish to exit the Create AEC Content Wizard.
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Mask Blocks

A mask block is a two-dimensional (2D) block 
that covers, or “masks,” part of the graphic dis-
play of an AEC object in a plan view. You can 
use mask blocks to clean up or correct objects in 
your drawings or to create custom 2D shapes 
from predefined drawing objects, such as walls 
or grids.

For example, attach a light fixture as a mask 
block to a ceiling grid in a plan view. If the light 
fixture is bigger than one or more of the ceiling 
grid bays, the light fixture masks, or covers, the 
ceiling grid lines that would visibly pass 
through the light fixture if it had been defined 

as a regular AutoCAD® block.

Before you can begin to mask objects in your 
plan view drawings, you must have an existing 
mask block or a mask block definition created 
in your drawing. You can find predefined mask 
blocks on the General Drafting tool palette and 
in the Autodesk Architectural Desktop Stock 
Tool catalog. You can also create a mask block 
with the AEC Content Wizard. For more infor-
mation about custom content, see “Creating an 
AEC Masking Block” on page 2350.

After you have selected a mask block, add it to 
your drawing in plan view. Adding the mask 
block to your drawing is like adding a regular 

AutoCAD® block: specify an insertion point or 
scale factors and a rotation angle. The mask 
block and the object that you want to mask 
must be coplanar, that is, on the same plane, for 
the mask object to cover the other object.

In this chapter

� Creating Mask Block 
Definitions

� Adding Mask Blocks Using Mask 
Block Tools

� Creating a Mask Block Tool

� Attaching Mask Blocks to 
Objects

� Detaching Mask Blocks from 
Objects

� Editing Mask Blocks

37
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After you insert a mask block in your drawing, attach the objects to be 
masked. The mask block clips the graphics of the objects that you are mask-
ing when the objects regenerate themselves in a plan view. Only the objects 
that you attach to the mask block are clipped. The masked objects are plotted 
as you see them on your screen.

If you change your drawing from a 2D view to a three-dimensional (3D) view, 
the mask block is still displayed, but it no longer masks the objects that are 
attached to it. You can detach the mask block from the objects at any time. 
You can also import and export mask block definitions. If you create a mask 
block definition that you decide not to use in your drawings, you can purge 
it.

Related Procedures

� Creating a Mask Block Definition from a Polyline

� Creating a Mask Block Definition from an Existing Mask Block Definition

Creating Mask Block Definitions

You can define a mask block by selecting a closed polyline in the drawing and 
defining it as a mask block, by copying and editing an existing mask block, 
or by using the AEC Content Wizard. 

Use the AEC Content Wizard to save mask blocks in content drawings for 
convenient reuse. For more information, see “Creating an AEC Masking 
Block.”

Managing Mask Block Definitions
To create, edit, copy, or purge mask block definitions, use the Style Manager. 

The Style Manager provides a central location in Autodesk® Architectural 
Desktop, where you can work with definitions and styles from multiple 
drawings and templates. For more information about using the Style Man-
ager, see “Style Manager”.

Related Procedures

� Creating a Mask Block Definition from a Polyline

� Creating a Mask Block Definition from an Existing Mask Block Definition

� Importing Mask Block Definitions

� Exporting Mask Block Definitions to a New Drawing

� Exporting Mask Block Definitions to an Existing Drawing

� Editing a Mask Block Definition
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� Attaching Hyperlinks, Notes, and Files to a Mask Block

� Purging Mask Block Definitions

Creating a Mask Block Definition from a Polyline

Use this procedure to create a mask block definition from one or more closed 
2D polylines. If you use more than one polyline to create your mask block 
definition, the polylines must be completely within or completely outside 
each other: they cannot overlap or touch. Polylines that are within each 
other can be specified as void areas that become holes when the mask block 
is created. After you create the definition, edit the definition properties to 
customize the characteristics of the definition.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 Expand Multi-Purpose Objects, right-click Mask Block Definitions, and 
click New.

3 Enter a name for the new mask block definition, and press ENTER.

4 Right-click the new mask block definition name, and click Set From.

5 Select the closed polyline that you want to use to create the mask block 
definition.

6 Do one of the following to complete the mask block definition:

� Press ENTER to create the mask block definition from a single polyline.
� Enter y (Yes) to select additional polylines to add to the mask block 

definition. These polylines must be entirely within or outside each 
other; they cannot overlap or touch. Polylines that are within other 
rings can be specified as void areas that become holes in the mask 
block.

7 Specify an insertion base point for the mask block.

8 Select additional graphics to include in the mask block definition, or press 
ENTER if you do not want to include any additional graphics.

NOTE You can select text or symbols to include in the mask block defini-
tion.

9 Click OK. 
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A mask block definition is created from the polyline or polylines that you 
selected. The new mask block definition is listed in the mask block definition 
tree and can be viewed in the graphics screen of Style Manager. The original 
polylines remain in the drawing.

Creating a Mask Block Definition from an 
Existing Mask Block Definition

Use this procedure to create a mask block definition from a mask block defi-
nition that already exists in a drawing. After you create the new definition, 
you edit the definition properties to customize the characteristics of the def-
inition.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 Expand Multi-Purpose Objects, and expand Mask Block Definitions.

3 Right-click the mask block definition you want to copy, and click Copy. 

4 Right-click, and click Paste. 

5 Right-click the new mask block definition, and click Rename. 

6 Enter a name, and press ENTER.

7 Click OK.

Importing Mask Block Definitions

Use this procedure to import a mask block definition from another drawing. 
After you create the definition, you edit the definition properties to custom-
ize the characteristics of the definition.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 On the File menu, click Open drawing to browse for the drawing that con-
tains the definition that you want to copy to your current drawing. 

3 Select the drawing with the definition that you want to copy, and click 
Open.

4 Expand Multi-Purpose Objects, and expand Mask Block Definitions.

5 Right-click the mask block definition you want to copy, and click Copy. 

6 Select the current drawing, and expand Multi-Purpose Objects.
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7 Right click Mask Block Definitions, and click Paste.

The definition is copied into the current drawing. If the current drawing 
already contains a definition with the same name, the duplicate names are 
displayed in the Import/Export - Duplicate Names Found dialog box.

8 To resolve any duplicate definition names, select one of the following 
options:

� To not replace the existing definition in the drawing with the new def-
inition of the same name, select Leave Existing, and click OK.

� To replace the existing definition in the drawing with the new defini-
tion, select Overwrite Existing, and click OK.

� To rename the new definition so both definitions exist in the drawing, 
select Rename to Unique, and click OK. New definition names are 
appended with a numeral in the Style Manager.

9 Click OK. 

Exporting Mask Block Definitions to a New 
Drawing

Use this procedure to copy mask block definitions from your current drawing 
to a new drawing. After you create the definition, you edit the definition 
properties to customize the characteristics of the definition.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 On the File menu, click New drawing to create the new drawing to copy 
the definition to.

3 Enter a name for the new drawing, and click Save.

The new drawing opens in the Style Manager.

4 In the current drawing, Expand Multi-Purpose Objects, and expand Mask 
Block Definitions.

5 Right-click the mask block definition you want to copy to the new draw-
ing, and click Copy. 

6 Select the new drawing, and expand Multi-Purpose Objects.

7 Right click Mask Block Definitions, and click Paste.

8 Click OK. 
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Exporting Mask Block Definitions to an Existing 
Drawing

Use this procedure to copy mask block definitions from your current drawing 
to another drawing. After you create the definition, you edit the definition 
properties to customize the characteristics of the definition.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 On the File menu, click Open drawing to browse for the existing drawing 
that you want to copy the definition to.

3 Select the drawing that you want to copy the definition to, and click 
Open.

The drawing opens in the Style Manager.

4 In the current drawing, Expand Multi-Purpose Objects, and expand Mask 
Block Definitions.

5 Right-click the mask block definition you want to copy to the second 
drawing, and click Copy. 

6 Select the second drawing, and expand Multi-Purpose Objects.

7 Right click Mask Block Definitions, and click Paste.

The definition is copied into the second drawing. If the drawing already 
contains a definition with the same name, the duplicate names are dis-
played in the Import/Export - Duplicate Names Found dialog box.

8 To resolve any duplicate definition names, select one of the following 
options:

� To not replace the existing definition in the drawing with the new def-
inition of the same name, click Leave Existing, and click OK.

� To replace the existing definition in the drawing with the new defini-
tion, click Overwrite Existing, and click OK.

� To rename the new definition so both definitions exist in the drawing, 
click Rename to Unique, and click OK. New definition names are 
appended with a numeral in the Style Manager

9 Click OK. 

Editing a Mask Block Definition

Use this procedure to edit a mask block definition:
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� You can change the objects or styles to which the mask block can be 
attached.

� You can add and remove properties.
� You can change the name, description, type, and format of properties.

Changes that you make to a mask block definition are immediately applied 
to any objects or styles to which the mask block created from the definition 
is attached.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 Expand Multi-Purpose Objects, and expand Mask Block Definitions.

3 Select the mask block definition, right-click, and click Edit.

4 Click the Classification tab.

5 Select a classification for the classification definition. 

For more information, see “Classification Definitions” on page 2289.

6 Click the Display Properties tab.

7 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

8 If necessary, click .

9 Click the Layer/Color/Linetype tab.

10 Select the component to change, and select a different setting.

11 Click OK.

12 Click the General tab.

13 Enter new text for Description.

14 Click Notes.

15 Click the Notes tab, and enter a note.

16 Click the Reference Docs tab, and attach, edit, or detach a reference file:

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Enter the description, 
and click OK.
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17 To attach or edit schedule data, click Property Sets. For more information, 
see “Attaching Property Set Data to Objects” and “Entering Manual Prop-
erties for Objects”.

18 Click OK twice.

Adding Classifications to a Mask Block Definition

Use this procedure to specify classifications for any classification definition 
applied to a mask block definition. Classifications enable you to track objects 
by construction status, vendor, or other criteria. For more information about 
creating and applying classification definitions, see “Classification Defini-
tions” on page 2289.

1 Open a tool palette that has a mask block definition tool.

2 Right-click a mask block definition tool, and click Mask Block Definitions.

3 Right-click the definition that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to mask 
block definitions.

5 For each classification definition, select the classification you want to 
apply to the current mask block definition.

6 Click OK twice.

Purging Mask Block Definitions

Use this procedure to purge mask block definitions from your drawing. You 
have the option to purge any mask block definition unless it is currently 
applied as a mask block in the drawing.

1 On the Format menu, click the Style Manager.

The Style Manager is displayed, with the current drawing expanded in the 
tree view.

2 Expand Multi-Purpose Objects, and expand Mask Block Definitions.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file select the file name, and click Delete.

If you want to . . . Then . . .
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3 Purge mask block definitions:

4 Click OK. 

Adding Mask Blocks Using Mask Block Tools

Tool palettes provided with Autodesk® Architectural Desktop let you place 
mask blocks by selecting a mask block tool with a specific mask block defini-
tion and other predefined properties. You can also use mask block tools to 
apply the settings of a mask block tool to existing mask blocks. 

Mask block tools may be found in the following locations:

NOTE The Standard mask block definition style is imported if you create your 
drawing with a template. It does not exist if you start your drawing from scratch. 
For more information, see “About Templates” on page 550.

When you place mask blocks using mask block tools, you can use the default 
settings of the tool, or you can change settings for any mask block properties 

If you want to . . . Then . . .

purge one unused mask 
block definition style

right-click the style you want to remove, and click 
Purge.

purge all unused mask 
block definition styles

right-click Mask Block Definitions, and click Purge.
When prompted, verify that the styles you want to 
purge are selected, and click OK.

Location Tool

General Drafting tool palette a mask block tool for the Standard mask block 
definition style and default settings for other mask 
block properties

Helper Tools category in the 
Autodesk Architectural 
Desktop Stock Tool catalog

a mask block tool for the Standard mask block 
definition style and default settings for other mask 
block properties

custom tool palettes created 
by your CAD manager

Mask block tools with mask block definition styles 
and properties customized for your projects or 
office standards
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that are not controlled by the mask block definition style. For more informa-
tion, see “Creating a Mask Block Tool” on page 2469.

Related Procedures

� Adding a Mask Block

� Adding a Mask Block with User-Specified Settings

� Creating a Mask Block Tool

� Attaching Mask Blocks to Objects

Adding a Mask Block

Use this procedure to add a new mask block that has the properties specified 
in the mask block tool that you select. To specify settings when you add a 
mask block, see “Adding a Mask Block with User-Specified Settings” on 
page 2469. You can add a mask block to a drawing if the drawing contains a 
mask block definition. For more information, see “Creating Mask Block Def-
initions” on page 2460.

TIP When you add mask blocks to your drawing, insert them on a separate 
layer. You can turn the layer off in 3D views, where the mask blocks no longer 
mask any objects. 

1 If a mask block does not already exist in the current drawing, then create 
or import a mask block definition. For more information, see “Importing 
Mask Block Definitions” on page 2462.

2 Open the tool palette that you want to use, and select a mask block tool. 

A mask block tool is located on the General Drafting tool palette and in 
the Helper Tools category in the Autodesk Architectural Desktop Stock 
Tool catalog. You can add this tool to any tool palette. For more informa-
tion, see “Content Browser” on page 171.

3 Specify the insertion point of the mask block. 

You can move or hide the Properties palette to expose more of the drawing 
area.

NOTE If you are using mask blocks to mask walls, the mask block must be 
located at the baseline of the wall (Z = 0). Even though the wall components 
are at different heights, the plan display representation draws them at the 
height of the baseline, as they would be drawn on paper.
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4 Continue adding mask blocks, and press ENTER . 

The mask block is displayed in the drawing at the insertion point you 
specified. To use the mask block to clean up or correct an object in the 
drawing, attach the object to the mask block.

Adding a Mask Block with User-Specified Settings

Use this procedure to add a mask block with settings that you specify.

TIP To ensure that the Properties palette is displayed before you select a tool, 
right-click in the drawing area, and click Properties.

1 Open the tool palette that you want to use, and select a mask block tool.

2 On the Properties palette, expand Basic, and expand General.

3 Select a definition.

4 Expand Scale.

5 Enter the X, Y, and Z scale of the mask block. The X, Y, and Z scales 
represent the distance from the insertion point. 

6 Alternately, expand Location, and select Yes for Specify scale on screen. 
Use your pointing device to designate the scale of the mask block.

7 In the drawing area, specify the insertion point of the mask block.

You can move or hide the Properties palette to expose more of the drawing 
area.

8 Continue adding mask blocks, and press ENTER. 

To use the mask block to clean up or correct an object in the drawing, 
attach the object to the mask block.

Creating a Mask Block Tool

Use this procedure to create a mask block tool and add it to a tool palette. You 
may want to create your own mask block tools if you are placing multiple 
mask blocks of specific definition styles with additional properties that you 
want to be the same each time.

You can use any of the following methods to create a mask block tool:

� Drag a mask block that has the properties you want to a tool palette.



2470 | Chapter 37 Mask Blocks

IMPORTANT Make sure that the mask block is in a drawing that has been 
saved and that will be available in the future.

� Drag a mask block definition from the Style Manager to a tool palette, and 
then customize the properties of the new tool.

� Drag a copy of a tool from another palette to the current palette, and then 
customize the properties of the new tool.

� Copy an existing tool in the current palette and then customize the prop-
erties of the new tool.

� Drag a tool from a tool palette in the Content Browser to a tool palette and 
then customize the properties of the new tool.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

If you want to . . . Then . . .

create a tool from a mask block 
in the drawing

select the mask block, and drag it to the tool 
palette.

create a tool from a mask block 
definition in the Style Manager

on the Format menu, click Style Manager. 
Locate the mask block definition you want to 
copy, and drag it to the tool palette. Click OK 
to close the Style Manager.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.

copy a tool from a tool palette 
in the Content Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.
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6 Expand Basic, and expand General.

7 Specify properties for the mask block created from the tool:

8 Expand Scale. 

9 Specify the scale for the mask block created from the tool:

10 Expand Location. 

11 Specify the rotation for the mask block created from the tool:

If you want to . . . Then . . .

enter a description of the mask 
block that you can create using 
this tool

click Description, enter a description of the 
tool, and click OK.

specify a unique layer key for 
the object type

click Layer Key, select a layer key, and click 
OK.

specify a layer override for the 
tool

click Layer Overrides, clear Do not specify 
Layer Overrides, specify the override, and 
click OK. 

specify a definition click Definition, select a mask block definition, 
and click OK.

specify a definition location click Definition location, select the file 
containing the mask block definition you 
want to use, click Open , and click OK. 

If you want to . . . Then . . .

use your pointing device to 
designate the scale for the 
mask block

click Yes for Specify scale on screen.

specify the scale of the mask 
block on the Properties palette

click No for Specify scale on screen, and enter 
the X, Y, and Z scale for the mask block.

If you want to . . . Then . . .

use your pointing device to 
designate the angle for the 
mask block

click Yes for Specify rotation on screen.
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12 Click OK.

Attaching Mask Blocks to Objects

Use this procedure to mask an object by attaching the mask block to the 
object after you have the mask block placed correctly. 

1 Select the mask block or blocks that you want to attach to an object, and 
right click.

2 Click Attach Objects.

3 Select the object that you want to mask.

4 Select a display representation from the list of current display representa-
tions, and click OK.

Attaching a mask block to an object

The object is now hidden by the mask block.

Mask blocks mask Autodesk® Architectural Desktop objects only and mask 
them only in plan views. Mask blocks are visible in 3D views but do not mask 
the objects that are attached to them.

specify the angle of the mask 
block on the Properties palette

click No for Specify rotation on screen, and 
enter the angle for Rotation.

If you want to . . . Then . . .



Detaching Mask Blocks from Objects | 2473

Detaching Mask Blocks from Objects

Use this procedure to unmask an object in plan view by detaching the object 
from the mask block.

1 Select the mask block that you want to detach from an object, right-click, 
and click Detach Objects.

2 Select the object that you want to detach from the mask block.

Detaching an object from a mask block

The object is detached from the mask block and is no longer hidden by the 
mask block.

Editing Mask Blocks

Autodesk® Architectural Desktop offers several methods for editing mask 
blocks:

� Change the location using grips.
� Change settings on the Properties palette.
� Edit the profile.
� Select commands from the context menu.
� Change how a mask block is displayed.



2474 | Chapter 37 Mask Blocks

Related Procedures

� Using Grips to Move Mask Blocks

� Changing the Location of a Mask Block

� Editing the Profile of a Mask Block

� Applying Tool Properties to a Mask Block

� Changing the Location of a Mask Block

� Attaching Hyperlinks, Notes, and Files to a Mask Block

Using Grips to Move Mask Blocks

Use this procedure to change the location of a mask block with grips.

1 Select the mask block.

2 Select the highlighted grip.

Viewing Mask Block Location grip

3 Move the grip until the door is in the desired location, and click once.

Changing the Location of a Mask Block

Use this procedure to change the rotation, elevation and location of the mask 
block on the Properties palette.

You can relocate a mask block by changing the coordinate values of its inser-
tion point. The mask block also has an orientation with respect to the WCS 
or the current UCS. For example, if the top and bottom of the mask block are 
parallel to the XY plane, its normal is parallel to the Z axis. You can change 
the orientation of the mask block by aligning its normal with another axis. 
You can also rotate the mask block on its plane by changing the rotation 
angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 

online AutoCAD® 2004 User’s Guide.

1 Double-click the mask block you want to change.

2 On the Properties palette, expand Basic, and expand Location.
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3 Specify the placement of the mask block:

4 Click Additional information to specify location of the mask block :

Editing the Profile of a Mask Block

Use this procedure to edit the geometry of a mask block.

NOTE If you want to replace the geometry of the mask block with newly 
drawn polylines, ellipses, or circles, draw them before you start this procedure. 

1 Select the mask block that you want to change, right-click, and click Edit 
Profile In Place.

2 If prompted that the profile is not drawn to size, click Yes.

A temporary profile is created for you to edit the geometry of the mask 
block.

If you want to . . . Then . . .

change the rotation enter a new value for Rotation Angle.

change the elevation enter a new value for Elevation.

If you want to . . . Then . . .

relocate the mask block enter new coordinate values under Insertion Point.

locate the mask block on 
the XY plane

make the normal of the mask block parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the mask block on 
the YZ plane

make the normal of the mask block parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 

locate the mask block on 
the XZ plane

make the normal of the mask block parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
mask block

enter a new value for Rotation Angle.
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NOTE After you perform an editing task from the context menu, you may 
need to select the profile again to perform another editing task. If you do not 
see the editing commands that you expect on the context menu, select the 
profile, and right-click to display the context menu.

3 Edit the profile:

4 Save or discard the changes:

If you want to . . . Then . . .

change the shape of the 
perimeter of the profile or its 
rings

select the profile, and use grips to adjust the 
shape.

add vertices to the profile select the profile, right-click, and click Add 
Vertex. Select a point for each new vertex, and 
press ENTER.

remove vertices from the profile select the profile, right-click, and click Remove 
Vertex. Select each vertex to remove, and 
press ENTER.

replace an existing ring of the 
profile with new geometry

select the profile, right-click, and click Replace 
Ring. Select the ring to replace, and select the 
new geometry. Press ENTER to keep the 
geometry, or enter n (No) to erase it.

add a ring to the profile select the profile, right-click, and click Add 
Ring. Select the geometry to define the ring. 
Press ENTER to keep the geometry, or enter n 
(No) to erase it.

remove a ring from the profile select the profile, right-click, and click Remove 
Ring. Select the ring to remove, and press 
ENTER.

If you want to . . . Then . . .

restore the mask block to its 
original shape select the profile, and click .
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Applying Tool Properties to a Mask Block

Use this procedure to apply the properties of a mask block tool to one or 
more existing mask blocks. The properties include the mask block definition 
and any other settings specified in the tool you select.

1 Open the tool palette that you want to use.

If necessary, scroll to display the tool that you want to use.

2 Right-click a mask block tool, and click Apply Tool Properties 
to ➤ Mask Block.

3 Select the mask blocks, and press ENTER.

4 Edit the properties of the mask blocks in the Properties palette, if needed.

Changing Display Properties of Mask Blocks

In most cases, you want the appearance of objects that belong to the same 
style to be consistent throughout a drawing. To achieve this, you specify the 
display properties of the mask blocks in each mask block definition style. 
However, in certain instances, you may need to override a display property 
for an individual mask block to achieve a specific result. All the display prop-
erties that you can specify in mask block definition styles are available for 
individual mask blocks:

� The visibility of mask block components
� The layer, color, and linetype of mask block components
� The lineweight, linetype scale, and plot style of mask block components

NOTE If the mask block is attached to a grid, you can change the anchor 
properties as well.

When you change the display properties of a mask block, the changes apply 
only to that mask block. Other mask blocks of the same definition style are 

save the changes to the current 
mask block select the profile, and click .

The mask block uses the edited profile to 
define its geometry. Any other objects or styles 
that use this profile are also updated with the 
edited geometry.

If you want to . . . Then . . .
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not affected. To change the display properties of all mask blocks of a specific 
definition style, see “Creating Mask Block Definitions” on page 2460.

Related Procedures

� Changing the Display Properties of a Mask Block

Changing the Display Properties of a Mask Block
Use this procedure to change the properties of the display components of an 
individual mask block:

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

To change these display properties for all mask blocks of the same mask block 
definition style, see “Creating Mask Block Definitions.”

1 Select the mask block you want to change, right-click, and click Edit 
Object Display.

2 Click the Display Properties tab.

3 Select the display representation where you want the changes to appear, 
and select Object Override.

The display representation in bold is the current display representation.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.

Attaching Hyperlinks, Notes, and Files to a Mask 
Block

Use this procedure to attach hyperlinks, enter notes, or attach reference files 
to a mask block in a drawing. You can also edit notes and edit or detach ref-
erence files from a mask block.

1 Double-click the mask block you want to attach information to.

2 On the Properties palette, click the Extended Data tab.
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3 To add a hyperlink, click  next to Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add or edit a note, click  next to Notes, enter text, and click OK.

5 Click  next to Reference documents, and attach, detach, or edit a ref-
erence file:

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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Multi-View Blocks

A multi-view block is an Autodesk ® Architectural Desk-

top object that can have different representations in dif-

ferent view directions. You create a multi-view block 

from AutoCAD blocks that represent the different views 

of the custom object that you are creating. 

In this chapter

� Creating Multi-View Block 
Definitions

� Adding Multi-View Blocks to a 
Drawing

� Modifying Multi-View Blocks

38
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Understanding Multi-View Blocks
A multi-view block can represent different types of objects in Autodesk Archi-
tectural Desktop. They are typically used to represent the following items: 

� Furniture and fixtures, such as tables and kitchen sinks
� Annotation components, such as revision clouds or fire rating signs
� Schedule tags, such as door numbers

Multi-view blocks can be displayed differently in each view direction and 
each display representation. For example, the top view of a multi-view block 
representing a kitchen sink shows the top of the sink; the bottom view shows 
the bottom of the sink; and there are representations for left, right, front, and 
back views. Additionally, you can define a different group of displays for each 
display representation, so that you can have one set of views for Plan view 
and another one for Reflected view.

You can use a multi-view block as a cutout in objects such as walls, slabs, and 
curtain walls. You create a view block to represent the cutting body. The 
block forms the body that will be subtracted from objects applying the multi-
view block as interference. For example, you can create a skylight as a multi-
view block and specify the block as a subtractive boolean in a slab.

Predefined Multi-View Blocks
The content folders of Autodesk Architectural Desktop contain a large num-
ber of predefined multi-view blocks for a number of design purposes. These 
contain multi-view blocks for furniture elements, electrical appliances, anno-
tation symbols, schedule tags, and other useful elements. You can access 
these multi-view blocks from DesignCenter™. For information on Design-
Center, see “Design Content” on page 2321

Related Topics

� Creating Multi-View Block Definitions
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� Adding Multi-View Blocks to a Drawing

� Modifying Multi-View Blocks

Creating Multi-View Block Definitions

Each multi-view block in a drawing is based on a multi-view block definition. 
The multi-view block definition specifies the display representations in 
which the block can be viewed, and the views available in each representa-
tion. From a multi-view block definition, you can create as many actual 
multi-view blocks as you need.

 Multi-view blocks typically represent 3D architectural objects. For example, 
you can create customized cabinetry by drawing plan, elevation, and model 
views, and saving each view as an individual AutoCAD block. You assign each 
block to a view when you create the multi-view block definition. The blocks 
(top, bottom, front, back, left, right, and model views) are used to define the 
custom object as a single multi-view block. By adding points to your views 
on the defpoints layer prior to defining the block, you can identify additional 
insertion points for the view block. You set the display representations and 
view directions in the process of defining the multi-view block.

You can see the individual blocks of your custom object in plan, elevation, 
and isometric views as one assembly after inserting them in the drawing as a 
multi-view block. For more information about working with blocks, see 
“Overview of Blocks” in the online AutoCAD User’s Guide. For more informa-
tion about display representations, see “Display Representations.”

Related Procedures

� Process Overview: Creating Multi-View Block Definitions

� Creating View Blocks

� Creating a New Multi-View Block Definition

� Connecting View Blocks to View Directions

� Attaching Notes and Files to a Multi-View Block Definition

� Adding Classifications to a Multi-View Block Definition

� Adding a Multi-View Block Definition to DesignCenter

� Creating a Multi-View Block Tool
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Process Overview: Creating Multi-View Block 
Definitions

There are four general steps for creating a multi-view block:

Step 1: Create a set of view blocks for each view direction in each display rep-
resentation you need. 

For example, if you need a multi-view block definition that displays in Model 
view and Reflected Plan view, create a set of views for each representation. 
You need to create views only for those view directions where you want a dif-
ferent result. For example, if the top and bottom views are supposed to look 
the same in the Reflected Plan display representation, you need to draw the 
view block only once and then assign it to both view directions. 

Step 2: Create a multi-view block definition where you assign the view blocks 
to view directions in individual display representations.

Step 3: If you want the new multi-view block definition to be available 
through DesignCenter, add the definition to DesignCenter.

Step 4: If you want the new multi-view block definition to be available from 
a tool palette, add it to a palette. 

Related Procedures

� Creating View Blocks

� Creating a New Multi-View Block Definition

� Connecting View Blocks to View Directions

� Adding a Multi-View Block Definition to DesignCenter

� Creating a Multi-View Block Tool

Creating View Blocks

Use this procedure to create the AutoCAD blocks to represent each view of 
the multi-view block definition in the needed display representations. 

1 Draw the views you need for a specific display representation: 

If you want to . . . Then . . .

create views for the front and 
back directions 

draw them on the XZ plane.

create views for the left and 
right directions 

draw them on the YZ plane.
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2 Specify additional insertion points on the defpoints layer through the 
AutoCAD point command if necessary.

NOTE The points added to view blocks are cumulative. For example, if you 
add one point to a view block used for the top view and two points to the 
view block used for the model view, you have a total of four points to cycle 
through. The fourth point is the regular basepoint defined during the cre-
ation of the block.

3 Select the World Coordinate System before making blocks from these indi-
vidual views. 

For more information about coordinate systems, see “Use Coordinates 
and Coordinate Systems” in the online AutoCAD User’s Guide.

4 Define each view as a block, and coordinate the location of the insertion 
base point as you define each block. 

For example, if you specify the insertion base point of the model view 
block as the midpoint of the bottom edge on the back side, the front and 
back view blocks have an insertion base point at the midpoint of the bot-
tom edge. Then, the left and right view blocks have an insertion base 
point at the back bottom corner, with the insertion base point for the top 
and bottom view blocks at the midpoint of the back edge.

For more information about blocks, see “Create Blocks” in the online 
AutoCAD User’s Guide.

create views for the top and 
bottom directions 

draw them on the XY plane.

create a block for an 
interference condition

create a block containing objects, such as mass 
elements, to be used as the subtractive body

If you want to . . . Then . . .
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Creating individual blocks for multi-view block definition

TIP It is helpful to have a naming convention as you save your views as 
blocks. For example, name the plan view block desk-p, and name the right 
view block desk-r.

Creating a New Multi-View Block Definition

Use this procedure to create a multi-view block definition from the view 
blocks you created to represent different views of a custom object.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects.

3 Right-click Multi-View Block Definitions, and click New.

4 Enter a name for the new multi-view block definition, and press ENTER. 
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5 To edit the new multi-view block definition, right-click its name, and click 
Edit:

6 Click OK.

Connecting View Blocks to View Directions

Use this procedure to connect view blocks to the view directions of the indi-
vidual display representations. 

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Multi-View Block Definitions.

3 Right-click the multi-view block definition to which you want to connect 
view blocks, and click Edit.

4 Click the View Blocks tab.

5 Select the display representation to which you want to connect view 
blocks. 

There are six display representations available for multi-view blocks:

If you want to . . . Then . . .

connect view blocks to the 
view directions of the 
different display 
representations

see “Connecting View Blocks to View Directions” on 
page 2487.

add notes and files to the 
multi-view block definition

see “Attaching Notes and Files to a Multi-View Block 
Definition” on page 2488.

add classifications to a 
multi-view block definition

see “Adding Classifications to a Multi-View Block 
Definition” on page 2489.

specify a cut body for the 
multi-view block when the 
block is used as 
interference in other 
objects (for example, walls, 
curtain walls, spaces, slabs)

click Set Interference Block, select a block, and click 
OK.

Display Representation Is used for . . .

General all Plan views, Section views, and Sketch views

Model all Model views.
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6 Click Add, and select a view block for the display representation.

7 Click OK.

8 Select the view directions that correspond with the selected block.

For example, to connect the view block to the left side of the multi-view 
block definition, select Left and clear all other directions. 

You can connect a view block to multiple view directions. For example, if 
you have a symmetrical element that looks identical from left and right, 
you can select Left and Right.

The Other view direction represents a view that displays the block three-
dimensionally. It is used for non-orthogonal (isometric or perspective) 
views of the custom object.

To ensure that the multi-view block is visible in all views, assign a block to 
every view direction.

9 To specify view blocks in other display representations, continue from 
step 5.

10 Click OK.

Attaching Notes and Files to a Multi-View Block 
Definition

Use this procedure to enter notes and attach reference files to a multi-view 
block definition. You can also edit notes and edit or detach reference files 
from a multi-view block.

1 On the Format menu, click Style Manager.

2 Expand Multi-Purpose Objects, and expand Multi-View Block Definitions.

3 Right-click the multi-view block definition to which you want to attach 
notes or files, and click Edit.

4 Click the General tab.

Plan all Plan views.

Plan High Detail all Plan High Detail views.

Plan Low Detail all Plan Low Detail views.

Reflected all Reflected views.

Display Representation Is used for . . .
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5 To add a description to the multi-view block, enter the description under 
Description.

6 Click Notes.

7 To add or edit a note, click the Notes tab, and enter the note.

8 Click the Reference Docs tab, and attach, edit, or detach a reference file:

9 Click OK twice.

Adding Classifications to a Multi-View Block 
Definition

Use this procedure to specify classifications for any classification definition 
applied to a multi-view block definition.

For more information about creating and applying classification definitions, 
see “Classification Definitions” on page 2289.

1 Open a tool palette that has a multi-view block definition tool.

2 Right-click a multi-view block definition tool, and click Multi-View Block 
Definitions.

3 Right-click the definition that you want to change, and click Edit.

4 Click the Classifications tab.

By default, the classification for all classification definitions is Unspeci-
fied. If no classification definitions are listed, none are applied to multi-
view block definitions.

5 For each classification definition, select the classification you want to 
apply to the current multi-view block definition.

6 Click OK twice.

If you want to . . . Then . . .

attach a reference file click Add, select a file, and click OK.

edit the description of a 
reference file

select the file, and click Edit. Edit the description, 
and click OK.

edit a reference file double-click the reference file name to start its 
application. Click OK when you are done editing.

detach a reference file select the file name, click Delete, and click OK.
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Adding a Multi-View Block Definition to 
DesignCenter

Use this procedure to add a multi-view block to DesignCenter. When you 
have added a multi-view block definition to DesignCenter, you can create 
new multi-view blocks by dragging and dropping them from DesignCenter 
to your drawing. To add a multi-view block definition to DesignCenter, you 
need to create a *.dwg file using the AEC Content Wizard.

 For a detailed description of the AEC Content Wizard, see “Using Design 
Content” on page 2321.

1 On the Format menu, click AEC Content Wizard.

2 Select Multi-View Block. 

3 Under Current Drawing, select a multi-view block definition, and click 
Add to add it to the Content File list.

4 Click Next. 

5 Select the layer key to use when the multi-view block is inserted, and spec-
ify any additional properties:

6 Click Next.

If you want to . . . Then . . .

automatically explode the 
multi-view block when it 
is inserted in a drawing

select Explode on Insert.

specify an elevation for 
the multi-view block

enter a value for Preset Elevation.

associate an anchor with 
the multi-view block

select an anchor type.

specify the scale for the 
multi-view block

enter X, Y, and Z scale values, and select an option 
for Additional Scaling.

scale the multi-view block 
based on the drawing 
units specified in the 
Drawing Setup dialog box

select Enable AEC Unit Scaling

specify properties for 
attributes associated with 
the multi-view block

select options for Attribute Text Style and Attribute 
Text Angle.
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7 Specify the drawing file in which to store the multi-view block definition: 

8 Select the icon to represent the multi-view block in DesignCenter:

9 Enter a description of the multi-view block.

The description is displayed in DesignCenter, along with the icon repre-
senting the multi-view block.

10 Select Save Preview Graphics to enable previewing in DesignCenter, or 
clear Save Preview Graphics to disable previewing.

11 Click Finish.

Creating a Multi-View Block Tool

Use this procedure to create a multi-view block tool and add it to a tool pal-
ette. You may want to create your own multi-view block tool for customized 
multi-view blocks you plan to use repeatedly in your drawing. For example, 
you are creating an office floor plan in which each conference room and 
office contains a floor lamp. Conference rooms and executive offices get the 
deluxe model floor lamp, and all other rooms get the standard model. You 
define multi-view blocks to represent each type of floor lamp, and then cre-
ate a floor lamp tool for each type. You can then select the appropriate tool 
to place a floor lamp in each room.

You can use any of the following methods to create a multi-view block tool:

� Drag a multi-view block that has the properties you want to a tool palette.

If you want to store the 
multi-view block . . .

Then . . .

 in the current drawing select Current Drawing.

 in a different drawing clear Current Drawing, and then either enter a 
file name or click Browse to specify a file.

If you want to . . . Then . . .

use a bitmap of the 
drawing as the icon 

click Default Icon.

specify a bitmap (.bmp) 
file containing the image 
to be used as the icon

click New Icon, and select a bitmap file.
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� Drag a multi-view block definition from the Style Manager to a tool pal-
ette, and then customize the properties of the new tool.

� Copy an existing multi-view block tool, and then customize the properties 
of the new tool.

� Drag a multi-view block tool from a tool catalog in the Content Browser, 
and then customize the properties of the tool.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

4 Enter a name for the tool.

5 Click the setting for Description, enter a description of the tool, and click 
OK.

This description is used as the tool’s tooltip on the tool palette, and to 
describe the tool if it is stored in a tool catalog.

6 Expand Basic and expand General.

7 Enter a description of the tool.

8 If you do not want to use the default layer key for multi-view blocks, select 
a Layer Key.

If you want to . . . Then . . .

create a tool from a multi-view 
block in the drawing

select the multi-view block and drag it to the 
tool palette.

create a tool from a multi-view 
block definition in the Style 
Manager

on the Format menu, click Style Manager. 
Locate the definition you want to copy, and 
drag it to the tool palette. Click OK to close 
the Style Manager.

copy a multi-view block tool 
from a tool catalog

in the Content Browser, locate the multi-view 
block tool you want to copy, then click 

the  icon associated with the tool and 
drag it to the tool palette in the workspace.

copy a tool in the current 
palette

right-click the tool, click Copy, and click Paste.

copy a tool from another 
palette

open the other tool palette. Right-click the 
tool, and click Copy. Open the other palette, 
and click Paste.
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9 If you want to override the default layer name for multi-view blocks, select 
a Layer Override.

10 Select a multi-view block definition.

11 For Style location, select the drawing file containing the definition used 
for this multi-view block, or select Browse and use a standard file selection 
dialog box to select the file.

12 Expand Scale.

13 Specify the scale of the multi-view block:

14 Expand Location.

15 Specify the rotation of the multi-view block:

16 Expand Advanced.

17 Click Insertion offset, and enter X, Y, and Z offsets for each view block in 
the multi-view block, as needed.

18 Click OK.

19 Click Attributes, and edit the prompt and value of each attribute, as 
needed.

20 Click OK twice.

If you want to . . . Then . . .

specify fixed values for 
the scale

select No for Specify scale on screen, and enter X, Y, 
and Z values for the scale.

allow users to specify 
the scale of the object 
upon insertion

select Yes for Specify scale on screen.

If you want to . . . Then . . .

specify a fixed value for 
the rotation

select No for Specify rotation on screen, and enter a 
value for Rotation.

allow users to specify 
the rotation of the 
object upon insertion

select Yes for Specify rotation on screen.
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Adding Multi-View Blocks to a Drawing

Multi-view blocks are inserted in a drawing by referencing their definitions 
in one or more of the following locations:

� DesignCenter
� Tool palettes
� Tool catalogs

Predefined multi-view blocks supplied with Autodesk Architectural Desktop 
are available with DesignCenter. These blocks represent items such as furni-
ture elements, electrical appliances, pipes, ducts, annotation symbols, and 
schedule tags.

A generic multi-view block reference tool is supplied in the Autodesk Archi-
tectural Desktop Stock Tool catalog. This tool is in the General Purpose Tools 
category, Helper Tools subcategory.

How you access a custom multi-view block definition—for example, blocks 
that you or someone else in your organization defined—depends on what 
you do with the block after you define it. You can use the multi-view block 
definition to create AEC content in DesignCenter, or to create a multi-view 
block tool that can be stored in a tool palette or tool catalog.

When you insert a multi-view block reference in a drawing, you are 
prompted to specify the insertion point for the block. Depending on how the 
multi-view block was defined, you may be prompted to specify rotation angle 
and scale values.

Related Procedure

� Inserting a Multi-View Block

Inserting a Multi-View Block

Use this procedure to add a multi-view block to a drawing.

1 Find the multi-view block definition and begin the insertion process:

If the multi-view block is . . . Then . . .

stored as AEC content use DesignCenter to locate the AEC 
content, and double-click the content.
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2 Specify the insertion point for the block. 

If you added additional insertion points to the view blocks, you can cycle 
through all of the points with the CTRL key.

3 Specify the scale, if prompted:

4 Specify the rotation angle, if prompted:

5 To insert additional references to the multi-view block, continue from step 
2.

6 Press ENTER to finish inserting blocks.

inserted using a tool on a tool 
palette

open the palette containing the multi-
view block tool, and click the tool.

inserted using a tool stored in a tool 
catalog

use the Content Browser to locate the 

tool, then click the  icon associated 
with the tool and drag it to the drawing 
area.

If you want to . . . Then . . .

specify a scale value enter a value at the Command prompt.

dynamically set the scale use the pointing device, and click when you see 
the appropriate scale.

set the scale to match that 
of another multi-view block 
in the drawing

enter m (match) at the Command prompt, and 
select a multi-view block to match in scale.

If you want to . . . Then . . .

specify a rotation value enter a value at the Command prompt.

dynamically set the rotation use the pointing device, and click when you see 
the appropriate rotation.

set the rotation to match 
that of another multi-view 
block in the drawing

enter m (match) at the Command prompt, and 
select a multi-view block to match in rotation.

If the multi-view block is . . . Then . . .
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Modifying Multi-View Blocks

You can change the attributes of a multi-view block in a drawing. For exam-
ple, you can change the rotation or the scaling factor.

Related Procedures

� Changing the Rotation of a Multi-View Block

� Changing the Associated Multi-View Block Definition

� Changing the Scale Factor of a Multi-View Block

� Changing the Offset of a Multi-View Block

� Changing the Location of a Multi-View Block

� Attaching Hyperlinks, Notes, or Files to a Multi-View Block

� Editing the Attributes of a Multi-View Block

� Updating Multi-View Block Attributes

Changing the Rotation of a Multi-View Block

Use this procedure to change the rotation of a multi-view block.

1 Double-click the multi-view block whose rotation you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Enter a value for Rotation. 

Changing the Associated Multi-View Block 
Definition

Use this procedure to change the multi-view block definition associated to 
the multi-view block. For information about the relationship between multi-
view blocks and multi-view block definitions, see “Creating Multi-View Block 
Definitions” on page 2483.

1 Double-click the multi-view block you want to change.

2 On the Properties palette, expand Basic, and expand General.

3 Click Definition, and select a new multi-view block definition for the 
multi-view block.

Changing the Scale Factor of a Multi-View Block 

Use this procedure to change the scale factor of a multi-view block.

1 Double-click the multi-view block you want to change.
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2 On the Properties palette, expand Basic, and expand Scale.

3 Change the scale factor as needed: 

Changing the Offset of a Multi-View Block

Use this procedure to change the offset of a multi-view block from its inser-
tion point.

When you first add a multi-view block to a drawing, the offset value is set to 
0. You can change the position of the multi-view block by offsetting it from 
its original insertion point.

1 Double-click the multi-view block you want to change.

2 On the Properties palette, expand Advanced.

3 Click Insertion Offsets.

4 Select the view block to change. 

5 Change the offset of the view block from its insertion point: 

6 Click OK.

Changing the Location of a Multi-View Block

Use this procedure to relocate an existing multi-view block by changing the 
coordinate values of its insertion point. The multi-view block also has an ori-
entation with respect to the WCS or the current UCS. For example, if the top 
and bottom of the multi-view block are parallel to the XY plane, its normal 

If you want to . . . Then . . .

change the X scale factor enter a new value for X.

change the Y scale factor enter a new value for Y.

change the Z scale factor enter a new value for Z.

If you want to change 
the offset . . .

Then . . .

from the X insertion point enter a new value for X.

from the Y insertion point enter a new value for Y.

from the Z insertion point enter a new value for Z.



2498 | Chapter 38 Multi-View Blocks

is parallel to the Z axis. You can change the orientation of the multi-view 
block by aligning its normal with another axis. You can also rotate the multi-
view block on its plane by changing the rotation angle.

For information about the world coordinate system (WCS) and the user coor-
dinate system (UCS), see “Use Coordinates and Coordinate Systems” in the 
online AutoCAD User’s Guide.

1 Double-click the multi-view block you want to relocate from its original 
insertion point.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional Information.

4 Specify the location of the multi-view block:

5 Click OK.

Attaching Hyperlinks, Notes, or Files to a Multi-
View Block

Use this procedure to attach hyperlinks, enter notes, or attach reference files 
to a multi-view block in a drawing. You can also edit notes and edit or detach 
reference files from a multi-view block.

1 Double-click the multi-view block you want to attach information to.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click the setting for Hyperlink, and specify the link.

If you want to . . . Then . . .

relocate the multi-view 
block 

enter new coordinate values under Insertion Point.

locate the multi-view block 
on the XY plane

make the normal of the multi-view block parallel to 
the Z axis: under Normal, enter 1 for Z, and enter 0 
for X and Y. 

locate the multi-view block 
on the YZ plane

make the normal of the multi-view block parallel to 
the X axis: under Normal, enter 1 for X, and enter 0 
for Y and Z. 

locate the multi-view block 
on the XZ plane

make the normal of the multi-view block parallel to 
the Y axis: enter 1 for Y, and enter 0 for X and Z.

change the rotation of the 
multi-view block 

under Rotation, enter a new value for Angle.
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For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add or edit a note, click  next to Notes, enter text, and click OK.

5 Click  next to Reference documents, and attach, detach, or edit a ref-
erence file:

Editing the Attributes of a Multi-View Block

Use this procedure to display the attributes defined for a multi-view block. 

1 Double-click the multi-view block whose attributes you want to edit.

2 On the Properties palette, expand Advanced.

3 Click Attributes.

4 Edit each attribute, as needed.

5 Click OK.

Updating Multi-View Block Attributes

Use this procedure to update the attributes of blocks in your drawing, using 
the current attributes defined for the view blocks upon which each multi-
view block is based. You need to do this if you change attribute definitions 
in one or more of the block definitions that the multi-view block is based on.

1 On the Format Menu, click Multi-View Block, and click Multi-View Block 
Update.

2 Select the multi-view blocks to be updated.

3 Press ENTER.

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .
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4  Enter y (Yes) to include text style properties (for example, width factor, 
oblique, mirroring) when updating attributes, or n (No) to update all 
attributes properties except those relating to text style. 

5 Press ENTER to end the update process.
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Cameras

The camera is a visualization tool, modeled 
after a real camera, using a point-and-shoot pro-
cess to help you view the drawing as if you were 
standing within it. You can save perspective 
views of your drawing by using a camera. 

You can use camera grips to modify the view 
and see the results in selected viewports. You 
can add any number of camera views to your 
drawing. You can also create a video dry run of 
your design model with the camera. 

NOTE To create more complex perspective 
view setups, for example using clipping planes, 

use the AutoCAD® 3D dynamic view (DVIEW).

Tool palettes provided with Autodesk® Architec-
tural Desktop let you quickly place cameras by 
selecting a camera tool with predefined proper-
ties. 

In this chapter

� Inserting a Camera

� Inserting a Camera with User-
specified Settings

� Creating a Camera Tool

� Using Grips to Change the 
Camera View

� Editing Camera Settings

� Changing the Location of a 
Camera

� Applying Tool Properties to an 
Existing Camera

� Creating a Camera View

� Adjusting the Camera Position

� Creating a Video Dry Run

� Creating a Video

� Specifying the Display 
Properties of a Camera

39
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Related Procedures

� Inserting a Camera

� Inserting a Camera with User-specified Settings

� Creating a Camera Tool

� Using Grips to Change the Camera View

� Editing Camera Settings

� Changing the Location of a Camera

� Applying Tool Properties to an Existing Camera

� Creating a Camera View

� Adjusting the Camera Position

� Creating a Video Dry Run

� Creating a Video

� Specifying the Display Properties of a Camera

Inserting a Camera

Use this procedure to add a camera to a drawing. You generally insert cameras 
within plan views. You specify a source point (camera insertion point) and a 
target point (what the camera is looking at), and then adjust the camera's 
zoom to change its field of view (FOV).

Camera view parameters

1 Open the tool palette that you want to use, and select a camera tool.

A camera tool is located with Helper Tools in the Autodesk® Architectural 
Desktop Stock Tool Catalog. You can add this tool to any tool palette. For 
more information, see “Content Browser” on page 171.
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TIP You can enter X, Y, and Z values for the camera source point and the 
camera target point.

2 Specify the insertion point for the camera.

3 Specify the target point for the camera.

Adding a camera

You can change camera settings, such as Zoom, and how the camera displays, 
such as the color of the viewing cone. For more information about camera 
settings, see “Editing Camera Settings” on page 2509. For more information 
about camera display properties, see “Specifying the Display Properties of a 
Camera” on page 2517.
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Inserting a Camera with User-specified 
Settings

Use this procedure to insert a camera with settings that you specify. If you are 
adding single-use cameras, you might want to specify a special setting. 

1 Open the tool palette that you want to use, and select a camera tool.

A camera tool is located with Helper Tools in the Autodesk® Architectural 
Desktop Stock Tool Catalog. You can add this tool to any tool palette. For 
more information, see “Content Browser” on page 171.

TIP You can enter X, Y, and Z values for the camera source point and the 
camera target point.

2 On the Properties palette, expand Basic, and expand General.

3 Expand Location.

4 Enter a height value for Eye Level.

5 In the drawing area, specify the insertion point of the camera.

You can move or hide the Properties palette to expose more of the drawing 
area.

6 Specify the camera target point.

If you want to . . . Then . . .

specify a name for the camera enter a name for Name.

add a description enter text for Description.

specify a focal length for the field of 
view

enter a value for Zoom.

generate a perspective view after 
specifying the insertion and target 
points for the camera

select Yes in Generate view after add.

remain in plan view after specifying the 
insertion and target points for the 
camera

select No in Generate view after add.
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Creating a Camera Tool

Use this procedure to create a camera tool and add it to a tool palette. You 
may want to create your own camera tools if you are placing multiple cam-
eras that will use the same properties. 

For example, you are creating camera views of trim details in an office. 
Although all cameras use the same zoom factor, the eye level for the camera 
view of the baseboard is different than that for the crown molding. To work 
efficiently, create camera tools for each eye level. Then select the appropriate 
camera tool to place the cameras with the correct eye level in each area of the 
floor plan.

You can use any of the following methods to create a camera tool:

� Drag a camera tool containing the desired properties to a tool palette.
� Drag a copy of a tool from another palette to the current palette, and then 

customize the properties of the new tool.
� Copy an existing tool in the current palette and then customize the prop-

erties of the new tool.
� Drag a tool from the Content Browser to a tool palette and then customize 

the properties of the new tool.

1 Open the tool palette where you want to create a tool.

2 Create the tool:

3 Right-click the new tool, and click Properties.

If you want to . . . Then . . .

create a tool from a camera in 
the drawing

select the camera, and drag it to the tool 
palette.

copy a tool in the current tool 
palette

right-click the tool, and click Copy. Right-click, 
and click Paste.

copy a tool from another tool 
palette

open the other tool palette. Press CTRL, and 
drag the tool you want to copy to the tool 
palette.

copy a tool from the Content 
Browser

open the Content Browser, and locate the tool 
you want to copy. Position the cursor over the 
i-drop handle, and drag the tool to the tool 
palette.
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4 Specify properties for the tool: 

5 Expand Basic, and expand General. 

6 Specify properties for the camera created from the tool:

7 Expand Location.

8 Enter a height value for Eye Level.

9 Click OK.

If you want to . . . Then . . .

name the image on the tool 
palette

enter text for Name.

add a tooltip description to the 
image

enter text for Description.

If you want to . . . Then . . .

name the tool enter text for Name.

enter a description of the tool click Description, enter a description of the 
tool, and click OK.

specify a unique layer key for 
the object type

click Layer Key, select a layer key, and click 
OK.

specify a layer override for the 
tool

click Layer Overrides, clear Do not specify 
Layer Overrides, select the Layer Overrides, 
and click OK. 

specify a focal length for the 
field of view

enter a value for Zoom, and press ENTER.

generate a perspective view 
after adding a camera

select Yes for Generate view after add.

remain in plan view after 
adding a camera

select No for Generate view after add.

select the last used setting for 
generating views

select -- for Generate view after add.



Using Grips to Change the Camera View | 2507

Using Grips to Change the Camera View

You can change the field of view and the source and target points of a camera 
using grips. Refer to the illustrations and steps in this topic to use grips to edit 
cameras.

If you use grips to edit the camera in plan view, the Z axis is ignored. You can-
not accidentally snap the camera to a set of objects with a different Z value. 
The camera is effectively locked to the viewing plane. 

You can also change the camera view on the Properties palette.

NOTE When a camera is not selected, only the small camera icon is displayed. 
Selecting the camera displays the field of view. 

Changing the Camera Field of View

1 Select the camera.

2 Select a grip at either end of the field of view, and move the grip to encom-
pass what you want to see.

The Zoom property updates to reflect the new magnification. 

Using grips to change a Camera field of view
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Changing the Camera Source Point

1 Select the camera.

2 Select the source point grip, and move the camera source point to a new 
location. 

The Rotation property updates to reflect the new position. 

Using grips to change a Camera source point

Changing the Camera Target Point

1 Select the camera.

2 Select the target point grip, and move the camera target point to a new 
location. 

The Rotation property is updated to reflect the new position. 
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Using grips to change a Camera target point

Editing Camera Settings

Use this procedure to modify the settings on the Properties palette as needed 
for a camera. You can also change the camera view graphically. For more 
information, see “Using Grips to Change the Camera View” on page 2507.

1 Double-click the camera you want to change.

2 On the Properties palette, expand Basic, and expand General. 

3 Change general information of the camera:

4 Expand Location.

If you want to . . . Then . . .

change the name of the camera enter a name for Name.

change the description enter text for Description.

change the layer select a layer for Layer.

change the focal length for the field of 
view

enter a value for Zoom.
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5 Change where the camera is placed in the drawing: 

For more information, see “Changing the Location of a Camera” on 
page 2510.

Related Procedures

� Changing the Location of a Camera

Changing the Location of a Camera

Use this procedure to relocate a camera by changing the coordinate values of 
its insertion point. The camera has an orientation with respect to the world 
coordinate system (WCS) or the current user coordinate system (UCS). For 
example, if the top and bottom of the camera are parallel to the XY plane, its 
normal is parallel to the Z axis. You can change the orientation of the camera 
by aligning its normal with another axis. You can also rotate the camera on 
its plane by changing the rotation angle.

1 Double-click the camera you want to change.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information. 

4 Specify the placement of the camera:

If you want to . . . Then . . .

change the rotation angle enter a value for Rotation.

change the height value enter a value for Eye Level.

If you want to . . . Then . . .

relocate the camera enter new coordinate values under Insertion Point.

locate the camera on the 
XY plane

make the normal of the camera parallel to the Z 
axis: under Normal, enter 1 for Z, and enter 0 for X 
and Y. 

locate the camera on the 
YZ plane

make the normal of the camera parallel to the X 
axis: under Normal, enter 1 for X and enter 0 for Y 
and Z. 
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5 Click OK.

Related Procedures

� Editing Camera Settings

Applying Tool Properties to an Existing 
Camera

Use this procedure to apply the properties of a camera tool to one or more 
cameras. The properties include any settings specified in the tool you select.

1 Open the tool palette you want to use.

2 Right-click the camera tool, and click Apply Tool Properties to Camera.

3 Select the cameras, and press ENTER.

Creating a Camera View

Use this procedure to create a final representation of your perspective view. 

1 Select the camera from which to generate a view, right-click, and click Cre-
ate View.

locate the camera on the 
XZ plane

make the normal of the camera parallel to the Y 
axis: under Normal, enter 1 for Y, and enter 0 for X 
and Z.

change the rotation of the 
camera

enter a new value for Rotation Angle.

If you want to . . . Then . . .



2512 | Chapter 39 Cameras

Viewing a camera and target

A perspective view is displayed in the current viewport.

Resulting perspective view

2 Enter HIDE or SHADE to create a simple shaded view of the objects in your 
drawing.

TIP To return to a plan view, press ALT. Enter v (View), 3 (3D Views), and t 
(Top).
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Adjusting the Camera Position

Use this procedure to change the camera view incrementally in various direc-
tions.

1 Select the camera you want to adjust, right-click, and click Adjust View.

2 Click the appropriate button to adjust the view. 

� Change the Step value: This value controls how far each click of the 
following buttons moves the camera: Forward, Back, Left, Right, Up, 
and Down.

� Change the Angle value: This value controls how far each click of the 
following buttons moves the camera angle: Turn Left, Turn Right, Look 
Up, and Look Down.

� Change the Zoom percentage: This value controls how far each click of 
the button zooms the camera for Zoom In and Zoom Out.

� Click Hide to view the drawing with hidden lines removed. 

If the view in the drawing wasn’t the camera’s view, then the first selected 
button places the drawing into the camera’s view.

As you click each button, the view changes in increments determined by 
values in the Adjustment Increments section. If Auto View is selected, you 
can see the change after you click each button. If Auto View is cleared, 
click View to see the changes.

3 Click OK.

Creating a Video Dry Run

Use this procedure to watch the movement of a camera along a specified path 
before recording a video. You can use a polyline or wall as a path for the cam-
era. The camera path is determined by the direction that the selected polyline 
or wall was drawn. With a dry run, you can confirm that the angle of the 
camera and the relationship of the camera to the building is correct. A dry 
run shows the path of the camera and is not a preview of how the video will 
appear. 

Producing a dry run in a 2D wireframe view results in better performance. 

1 Select the camera from which to develop a video, right-click, and click 
Create Video.
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2 Under Camera Path, click Pick Path and select an existing polyline path in 
the drawing for the camera to follow, or click Pick Point to select a point 
for the camera to move to.

If you select a path, enter a name for the path, and click OK.

Generating a video by specifying a camera path

3 Under Target Path, either click Pick Path and select a polyline path for the 
camera to focus on as it moves, or click Pick Point to select a point for the 
camera to focus on.

If you select a path, enter a name for the path, and click OK.

If you select the camera path as the target path, the camera maintains its 
original view direction. 

Generating a video by specifying a target path

4 Specify the number of frames and the rate at which you want the frames 
to appear on your screen.

5 Select Dry Run.
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6 Select Corner Deceleration if you want the camera to move more slowly 
as it turns a corner. 

7 Click OK.

The camera moves along the camera path, pointing at the target path or tar-
get point.

Creating a Video

Use this procedure to create a video file of the camera moving in your draw-
ing, pointing at a stationary point or along its own path. You can use the set-
tings from a dry run or specify new settings. The camera follows the direction 
in which the polyline was drawn.

1 Select the camera from which to develop a video, right-click, and click 
Create Video.

2 Under Camera Path, click Pick Path, and select an existing polyline path 
for the camera to follow, or click Pick Point to select a point for the camera 
to move to.

If you select a path, enter a name for the path, and click OK.

Generating a video by specifying a camera path

3 Under Target Path, either click Pick Path and select a polyline path for the 
camera to focus on as it moves, or click Pick Point to select a point for the 
camera to focus on.

If you select a path, enter a name for the path, and click OK.

If you select the camera path as the target path, the camera maintains its 
original view direction. 
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Generating a video by specifying a target path

4 Select the Regen type:

Selecting a regen option other than As Displayed performs a full regener-
ation of each frame and specifies the shading options for the AVI file gen-
erated. 

It is much quicker to select a 3D shading option in your drawing before 
you create your video, and then select the As Displayed regen option. For 
more information, see “Add Simple Shading to 3D Objects” in the 
AutoCAD® 2004 User’s Guide.

5 Specify the number of frames and the rate at which you want the frames 
to appear on your screen.

6 Clear Dry Run.

If you want to . . . Then . . .

run the video with the current 
display settings

select As Displayed.

run the video with all frames in 
a hidden view

select Hide.

run the video with all frames in 
a shaded color view

select Shade - 256 Color. 

run the video with all frames in 
a shaded edge view

select Shade - 256 Edge. 

run the video with all frames in 
a shaded view

select Shade - Filled. 
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7 Select Corner Deceleration if you want the camera to move more slowly 
as it turns a corner. 

8 Click OK.

9 Specify a location for the file, and enter the name of the AVI (audio/video 
interleave) file.

10 Click Save.

11 Select the Compressor and Compression Quality for the video.

12 Click OK.

The video is displayed as it is created. 

13 Click Yes to view the video, or click No to close the dialog box. 

You can view the video later by using the AVI file you created.

Specifying the Display Properties of a 
Camera

Use this procedure to change the properties of the following display compo-
nents of an individual camera:

� Visibility (display component is on or off)
� Layer
� Color
� Linetype
� Lineweight
� Linetype scale

1 Select the camera you want to change, right-click, and click Edit Object 
Display.

2 Click the Display Properties tab.

3 Select the display representation in which the changes should appear, and 
select Object Override.

4 If necessary, click .

5 Click the Layer/Color/Linetype tab.

6 Select the component to change, and select a different setting for the 
property.

7 Click OK twice.
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Napkin Sketch

Use Napkin Sketch to create freehand sketch 
geometry from objects in a drawing. Create a 
napkin sketch to reflect ambiguity in a work-in-
progress design or to present a more artistically 
pleasing version of a drawing. You can also gen-
erate a napkin sketch of a portion of a drawing 
that you want to designate as still in the design 
stage.

You can create a napkin sketch from an entire 
drawing or from a portion of a drawing. You can 

select both AutoCAD® and AEC objects to 
include in your napkin sketch.

In this chapter

� Creating a Napkin Sketch

� Editing a Napkin Sketch

40
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How Objects Appear in a Napkin Sketch
When you generate a napkin sketch, random bumpy line segments are cre-
ated along objects that you select to include in your sketch. The bumpy lines 
are short line segments that emulate the freehand strokes of a traditional 
sketch. Lines where segments cross each other are extended in the napkin 
sketch.

Generating a napkin sketch

Line Formats for Napkin Sketches
When you generate the napkin sketch, you choose from one of three line for-
mats that control the appearance of the sketch:

� Tight line format traces the selected geometry once to create the appear-
ance of a more accurate sketch. 

� Loose line format, the default setting, traces the selected geometry twice.
� Messy line format traces the selected geometry three times.

Line format options
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Each pass at tracing the geometry adds more artistic flare to the sketch.

Managing Napkin Sketches
When you create a napkin sketch, the geometry is packaged in a named block 
and placed on top of the original objects in model space. This means that you 
can move the original drawing and the sketch drawing independently of 
each other. You can also edit the napkin sketch as you do with other refer-
enced blocks. Each of the sketch segments retains the layer and color of the 
original geometry from which it is generated. 

Depending on the line format you select, up to three complex polylines are 
generated for each selected object in your drawing. This can significantly 
increase your drawing size when you generate the napkin sketch. To keep 
your drawing size down, you can cut and paste your napkin sketches into 
new drawings. 

When you are working with three-dimensional (3D) drawings or complex 
models, first create a hidden line projection, two-dimensional (2D) section, 
or 2D elevation object. Unless your drawing is very simple, generating your 
napkin sketch from these 2D objects saves line work and time. 

When you are working with external references, double-click on the napkin 
sketch and edit it like any other block. For more information about editing 
external references, see “Managing Xrefs” on page 573.

Napkin Sketch and Intended Plot Scale
You can also specify the intended plot scale to control the size of the sketch 
segments and extensions. Select a larger scale to increase the size of the 
sketch segments and extensions in the final sketch.

Specifying a plot scale

Related Procedures

� Creating a Napkin Sketch

� Editing a Napkin Sketch
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Creating a Napkin Sketch

Use this procedure to produce a napkin sketch in a plan, isometric, or eleva-
tion view. Unless your drawing is very simple, generate the napkin sketch 
from a two-dimensional (2D) hidden line projection, section, or elevation 
when you are working with three-dimensional (3D) drawings. For more 
information, see “Creating a Hidden Line Projection,” “Sections,”and “Eleva-
tions.”

1 Open a tool palette that contains a napkin sketch tool.

A napkin sketch tool is located with the Helper Tools in the Stock Tool cat-
alog. For more information, see “Content Browser.”

2 Select a napkin sketch tool.

3 Select the objects to include in the napkin sketch, and press ENTER. 

4 Enter a name for the block created of the napkin sketch.

5 Specify a line format for generating the napkin sketch geometry. 

6 Clear Extend Sketch Lines At Corners if you do not want the extended 
lines to appear on the napkin sketch.

Extending sketch lines at corners

If you want to . . . Then . . .

trace over objects once to create 
the appearance of a more accurate 
sketch

select Tight.

trace over objects twice to create a 
looser sketch

select Loose.

trace over objects three times to 
create a very loose sketch

select Messy.
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7 Under Intended Plot Scale, select the scale at which you intend to plot 
your sketch, or select Other and enter a custom scale.

8 Click OK.

The napkin sketch geometry is generated and placed as a block reference 
over the drawing objects that you selected. Use the Move command to 
relocate the sketch block reference in the drawing, or cut and paste it into 
a new drawing. 

Editing a Napkin Sketch

Use this procedure to edit the block reference generated when you create a 
napkin sketch. For more information about editing external references, see 

“Overview of Blocks” in theAutoCAD® 2004 User’s Guide.

1 Select the napkin sketch that you want to edit, right-click, and click Edit 
Block in-place. 

The Reference Edit dialog box opens. For more information, see “Refer-
ence Edit dialog box” in the AutoCAD® 2004 User’s Guide.

2 Select the reference to edit if necessary.

3 Specify how nested objects in the napkin sketch are selected:

4 Specify lock settings for the napkin sketch.  

If you want to . . . Then . . .

make changes to the sketch lines 
or any component of the object 
that the sketch was drawn from

select Automatically select all nested 
objects. 

work with specific nested objects 
within a napkin sketch, such as a 
hatch pattern

select Prompt to select nested objects.

If you want to . . . Then . . .

allow changes to be made to 
objects other than those selected 
as your working set

select the Settings tab, and clear Lock 
objects not in working set.
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For information about the Settings tab, see “Reference Edit dialog box” in 
the AutoCAD® 2004 User’s Guide.

5 Click OK.

The block reference that represents the napkin sketch is highlighted in 
your drawing, and the Refedit toolbar opens on your drawing screen.

6 Make changes to the block reference as you would to any drawing object. 

7 Use the Refedit toolbar to save or discard changes made to the napkin 
sketch:

8 Click OK.

prevent changes from being made 
to objects other than those you 
selected as your working set

select the Settings tab, and select Lock 
objects not in working set.

If you want to . . . Then . . .

not save any of the changes you 
made to the napkin sketch select  changes to reference. 

save edits made to the named 
napkin sketch select  back changes to reference.

If you want to . . . Then . . .
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Converting Objects to 
3D Solids

You can convert objects to 3D solids when pre-
paring to use CNC machining applications to 
create a physical building model from a com-
puter-generated building model. You may also 
want to convert objects to 3D solids if you want 
the objects to interact with other 3D solids.

You cannot convert the following objects or 
blocks:

� Objects with no integral 3D presence, such as 
building grids or cameras

� 3D sections
� Objects in a block or an external reference
� Multi-view blocks and multi-view parts 

(MvParts)
� Custom display blocks created from 3D sol-

ids

For more information, see “Create 3D Solids” in 

the AutoCAD® 2004 User’s Guide. 

In this chapter

� Converting Objects to 3D Solid 
Objects
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Converting Objects to 3D Solid Objects

Use this procedure to convert objects, such as walls, doors, and mass ele-

ments into three-dimensional (3D) solid AutoCAD® objects. 

TIP Convert custom display blocks to Free Form mass elements, and then con-
vert the mass elements to 3D solids.

1 Open a tool palette that contains a Convert to 3D Solid tool.

A default Convert to 3D Solid tool is located with the Modeling Tools in 
the Autodesk ® Architectural Desktop Stock Tools catalog. You can add this 
tool to any tool palette. For more information, see “Content Browser” on 
page 171.

2 Select the objects to convert, and press ENTER.

3 Enter y (Yes) to erase the selected geometry after conversion, or enter n 
(No) to keep the geometry in the drawing.

4 Press ENTER.

Any selected objects that cannot be converted are filtered out during the 
conversion. Highly-faceted objects, such as curved railing and stairs, may 
take a longer time to convert.

After you convert an object to a solid, you can convert it to a Free Form mass 
element and modify it using grips or the Properties palette. You can then con-
vert the Free Form mass elements back to a 3D solid. For more information, 
see “Using the Model Explorer to Create Mass Models” on page 646.
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Visual Audit

Visual Audit is a utility that helps you manage 
the integrity of your design data by identifying 

non-AEC objects, such as AutoCAD® objects 
and exploded AEC objects, in your drawings. 

Autodesk® Architectural Desktop does not 
schedule properly or respect changes in the dis-
play system for non-AEC objects. 

When you perform a visual audit, all of the AEC 
objects in the drawing are temporarily removed 
from the display, leaving only non-AEC objects 
in view. You can inspect the remaining objects 
more closely to see if they should be replaced 
with AEC objects. 

To add clarity to the audit, a visual audit also 
removes single and multi-line text, leaders, and 
dimension objects from the display. Attribute 
text remains visible in the drawing. All objects 
are displayed again when you end the visual 
audit.

In the following illustration, the railing, door, 
and the framed opening are exploded AEC 
objects.

In this chapter

� Performing a Visual Audit

42
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Performing a visual audit with AEC and non-AEC objects in the drawing

Performing a Visual Audit

Use this procedure to perform a visual audit on your drawing.

NOTE For best results, perform a visual audit in a 2D wireframe view.

1 On the Window menu, click Pulldowns, and click CAD Manager Pull-
down.

2 On the CAD Manager menu, click Visual Audit. 

All AEC objects are removed from the display. Attribute text remains visi-
ble in the drawing.

3 Pan and Zoom to inspect the drawing:

If you want to . . . Then . . .

access zoom options enter ‘z (Zoom). You can use real time zoom or right-
click to access additional zoom options.
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4 Press ENTER.

All objects are restored to the display.

access pan options enter ‘p (Pan). You can pan or right-click to access pan 
options.

If you want to . . . Then . . .
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Quick Slice

You can create a “quick slice” through an object 
or objects in your drawing. The Quick Slice 
command extracts a polyline from objects that 
you can use to create profile shapes.

Related Procedures

� Creating a Quick Slice

In this chapter

� Creating a Quick Slice
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Creating a Quick Slice

Use this procedure to extract a polyline outline of a “slice” through one or 
more 3D objects. The Quick Slice command generates a plane that slices 
through objects to produce a single polyline on the current layer rather than 
the several polyline segments that section objects and slice objects produce. 
Unlike slices created with the Generate Slice command, a “quick slice” does 
not have a slice marker. For more information about the Generate Slice com-
mand, see “Generating a Slice” on page 318.

For example, if you have a 3D model of stairs in your current drawing, you 
can use a quick slice to create a polyline outline of the stair in a section view 
instead of using the section object. You can use the Quick Slice command to 
produce profile shapes, such as roof trusses, or to slice through mass groups. 

You can also slice through both AutoCAD® blocks and xrefs. For more infor-
mation about section views, see “Sections” on page 2089.

The slice plane creates a polyline outline from the objects that you sliced 
through. Any overlapping parts of the outline are combined in a Boolean 
operation and converted into a polyline that is inserted on the current layer. 
You can select the quick slice and then open the Object Viewer to view the 
slice polyline. 

1 Open the tool palette that you want to use, and select a quick slice tool.

A quick slice tool is located with the Helper Tools in the Stock Tool Cata-
log. You can add this tool to any tool palette. For more information, see 
“Content Browser” on page 171.

2 Select one or more objects that you want to slice through, and press 
ENTER.

3 Specify a starting point for the slice plane.

4 Specify a second point to complete a slice plane through the objects. 



2533

Reference AEC Objects

You can create reference copies of objects that 
are updated automatically when you change 
the original object. You can add identical 
objects, such as columns, to your drawing.

Related Procedures

� Creating an AEC Entity Reference

In this chapter

� Creating an AEC Entity 
Reference

44
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Creating an AEC Entity Reference

You can create an entity reference from all Autodesk® Architectural Desktop 

and AutoCAD® objects. These entity references are automatically updated 
when you change the original object. When you select an object to reference, 
you must specify a point on the original object as an insertion point for the 
marker of the entity reference. A reference marker is displayed in the drawing 
to mark the insertion point. 

You can place the entity reference in the drawing at any location or rotation 
angle. The distance between the entity reference and the reference marker 
remains equal to the distance between the original object and the insertion 
point specified. You can change this distance by specifying a new insertion 
point at a new location in relation to the original object. 

When you change the properties of the original object or edit it with grips, 
the reference object reflects the changes. For example, if you want to add cus-
tom-shaped mass elements to a drawing, you can add one mass element and 
reference it. If you make changes to the original, the entity reference is 
updated. 

Related Procedures

� Adding a Reference to an Object

� Attaching an Object to an Existing Entity Reference

� Attaching Hyperlinks, Notes, and Files to an Entity Reference

� Changing the Location of an Entity Reference

Adding a Reference to an Object
Use this procedure to create a entity reference from another object.

1 Open the tool palette that you want to use, and select an AEC entity ref-
erence tool. 

An AEC entity reference tool is located in the Helper Tools category of the 
Autodesk Architectural Desktop Stock Tool catalog. For more information, 
see “Content Browser” on page 171.

2 Enter ad (Add), and press ENTER.

3 Select the object that you want to reference.

4 Specify a point on the original object to use as the insertion point for the 
entity reference marker.

5 Specify a location for the entity reference in the drawing.
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The distance between the entity reference and the reference marker is 
equal to the distance between the original object and the insertion point 
that you specified.

6 Enter a rotation angle for the entity reference, or press ENTER for zero 
rotation.

7 Press ENTER.

The entity reference and reference mark are placed in the drawing at the spec-
ified location and rotation angle. If you edit the original object, the same 
changes are made to the entity reference. 

Attaching an Object to an Existing Entity Reference
Use this procedure to attach an object to an existing entity reference.

1 Open the tool palette that you want to use, and select an AEC entity ref-
erence tool. 

An AEC entity reference tool is located in the Helper Tools category of the 
Autodesk Architectural Desktop Stock Tool catalog. For more information, 
see “Content Browser” on page 171.

2 Enter at (Attach), and press ENTER.

3 Select the reference marker that you want to use.

4 Select the new object that you want to use to replace the entity referenced, 
and press ENTER.

The new entity reference replaces the former entity reference. The original 
object is unchanged.

Attaching Hyperlinks, Notes, and Files to an Entity Reference
Use this procedure to attach hyperlinks, enter notes, or attach reference files 
to an entity reference in a drawing. You can also edit notes and edit or detach 
reference files from an entity reference.

1 Double-click the entity reference to which to attach information.

2 On the Properties palette, click the Extended Data tab.

3 To add a hyperlink, click  next to Hyperlink, and specify the link.

For more information about adding hyperlinks, see the AutoCAD® 2004 
Command Reference.

4 To add or edit a note, click  next to Notes, enter text, and click OK.
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5 Click  next to Reference documents, and attach, detach, or edit a ref-
erence file:

6 Click OK twice.

Changing the Location of an Entity Reference
Use this procedure to relocate an existing entity reference by changing the 
coordinate values of its insertion point. The entity reference also has an ori-
entation with respect to the world coordinate system (WCS) or the current 
user coordinate system (UCS). For example, if the top and bottom of the ref-
erence object are parallel to the XY plane, its normal is parallel to the Z axis. 
You can change the orientation of the entity reference by aligning its normal 
with another axis. You can also rotate the entity reference on its plane by 
changing the rotation angle. 

For more information about the world coordinate system and the user coor-
dinate system, see “Use Coordinates and Coordinate Systems” in the online 

AutoCAD®  2004 User’s Guide.

1 Double-click the entity reference you want to relocate or reorient.

2 On the Properties palette, expand Basic, and expand Location.

3 Click Additional information. 

4 Specify the location of the entity reference:

If you want to . . . Then . . .

attach a reference file
click , select a file, and click Open.

edit the description of a 
reference file

enter text under Description.

edit a reference file double-click the reference file name to start its 
application.

detach a reference file
select the file name, and click .

If you want to . . . Then . . .

relocate the entity 
reference

enter new coordinate values under Insertion Point.
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5 Click OK.

locate the entity reference
on the XY plane

make the normal of the entity reference
parallel to the Z axis: under Normal, enter 1 for Z, 
and enter 0 for X and Y. 

locate the entity reference
on the YZ plane

make the normal of the entity reference
parallel to the X axis: under Normal, enter 1 for X 
and enter 0 for Y and Z. 

locate the entity reference
on the XZ plane

make the normal of the entity reference
parallel to the Y axis: under Normal, enter 1 for Y, 
and enter 0 for X and Z.

change the rotation of the 
entity reference

enter a new value for Rotation Angle.

If you want to . . . Then . . .
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Hidden Line Projection

You can create flat 2D projections with hidden 
background lines from a 3D view of objects in 
your drawing. The Hidden Line Projection com-
mand produces quick sections and elevations of 
objects in your drawings that are not updated 
automatically when you make changes to your 
3D model.

Related Procedures

� Creating a Hidden Line Projection

In this chapter

� Creating a Hidden Line 
Projection
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Creating a Hidden Line Projection

Use this procedure to create a 2D graphic from a 3D view of one or more 
objects in your drawing. The 2D graphic that you create is a flattened repre-
sentation of the objects in the current 3D view, with hidden background 
lines. Use the Hidden Line Projection command to create quick 2D eleva-
tions and sections. 

After you create an elevation or section hidden line projection, you can 
hatch or shade the cut areas. You can also use hidden line projections to cre-
ate detail drawings. For more information about creating elevations and sec-
tions, see “Elevations” on page 2147 and “Sections” on page 2089.

When you create hidden line projections, the 3D objects that you select are 
copied and collected into an unnamed (also called anonymous) 2D block. 
The unnamed block can be placed in your drawing in the current 3D view, 
or placed parallel to the XY plane to be viewed in plan view. You can edit or 
explode the inserted block. If you want to insert the block in another draw-
ing as a named block, define the block. For more information about inserting 

blocks, see “Insert Blocks” in the online AutoCAD® 2004 User’s Guide.

NOTE Your 2D hidden line projections are not dynamically linked to the 
objects in the 3D view. Therefore, if you edit the original object or objects in 
3D view, the 2D graphic does not change. You must edit or re-create the 
2D hidden line projection to reflect any changes that you make to the original 
objects.

1 Open the tool palette that you want to use, and select a hidden line pro-
jection tool. 

A hidden line projection tool is located with the Helper Tools in the Stock 
Tool Catalog. For more information, see “Content Browser” on page 171.

2 In a 3D view select one or more objects that you want to use to create your 
hidden line projection, and press ENTER. 

3 Specify an insertion point in your current drawing for the 2D hidden line 
projection.

4 Specify the insertion point for the 2D hidden line projection into your 
drawing:

� Press ENTER to insert the 2D block in plan view.
� Enter n (No) to insert the 2D block in the current view. 
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Object Viewer

The Object Viewer displays objects you select in 
your drawing, based on the current display con-
figuration in the drawing.

Related Procedures

� Using the Object Viewer

In this chapter

� Using the Object Viewer

46
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Using the Object Viewer

The Object Viewer displays objects you select in your drawing, based on the 
current display configuration in the drawing. You can manipulate the view-
ing angle and then set the drawing view equal to the view in the Object 
Viewer.

To display objects from your drawing in the Object Viewer, select the objects, 
right-click, and click Object Viewer.

The view in the Object Viewer is the same as the drawing view. If the drawing 
is in plan view, the objects in the Object Viewer are in 2D plan view. If you 
are viewing your drawing in 3D, then the objects are displayed in 3D. 

Icon Description

Wireframe: Displays objects in the current viewport with all lines present, 
including those hidden by other objects.

Hidden: Displays objects in the 3D wireframe representation with hidden 
lines.
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From the list at the right side of the Object Viewer, you can select the 
following.

� Top, Bottom, Left, Right, Front, or Back: Sets the current view to the 
selected view.

� SW Isometric, SE Isometric, NE Isometric, or NW Isometric: Sets the cur-
rent view to the selected isometric view.

Named views are also available from this list.

You can choose the following zoom options from the Object Viewer: Zoom 
Window, Zoom Center, Zoom Extents, Zoom In, Zoom Out, or Zoom Factor. 

Flat Shaded: Shades objects in a 3D view between the polygon faces. 
Objects appear flatter and less smooth than Gouraud shaded objects.

Gouraud Shaded: Shades objects in a 3D view and smooths the edges 
between polygon faces. Objects appear smoother and more realistic than 
flat shaded objects. AEC objects use a faceted representation, so there is 
no visible change when you switch from flat shading to Gouraud shading.

Pan Realtime: Pans the view in the graphics area of the Object Viewer.

Zoom Realtime: Real-time Zooms the Object Viewer display as you 
move your pointing device.

3D Orbit: Sets the display window to 3D orbit view. 

Move: Displaces objects a specified distance in a specified direction.

Icon Description

Save Image: Saves the current view as a separate file. The supported file 
formats are .png, .jpg, .bmp and .tif.

Parallel: Sets the view to a parallel plane.

Perspective: Sets a perspective view.

Set View: Sets the view in the drawing equal to the view in the Object 
Viewer.

Icon Description
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Increases or decreases the apparent size of objects in the current viewport.

From the directly above the image in the Object Viewer, you can select the 
display configuration.

� Display Configuration: Sets which display configuration is shown in the 
viewer. 

NOTE Hold down SHIFT and click to pan in the Object Viewer. Hold down 
CTRL and click to zoom in the Object Viewer.
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Glossary

A

additive
1. To expand the volume of a mass group by joining one or more mass ele-
ments with it.

2. A Boolean operation that manages 3D objects as true solids.

AEC content
Content, such as architectural symbols, object styles, and annotation rou-
tines unique to Architectural Desktop, that you can access in the Custom 
view in AutoCAD DesignCenter. 

AEC Object Enabler
A distributable utility which allows users without Autodesk AEC applications 
to use Autodesk AEC objects in AutoCAD 2000, Volo View Express, AutoCAD 
Map 2000, and 3D Studio VIZ 3.0.

AEC profile
Outline to delineate custom elements, such as openings or extrusions. Pro-
files can be created from one or more closed polylines and may contain 
voids.

AIA
American Institute of Architects

anchor
1. A feature that creates a relationship between two objects. 
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2. To fasten, or anchor, an object to another object. The anchored object’s 
movement and/or size is constrained by the object to which it is anchored.

annotation
Text, dimensions, symbols, or reference marks. For example, Architectural 
Desktop annotation includes break marks, leaders, bar scales, revision clouds, 
detail boundaries, elevation marks, and arrows.

apply
To put to specific use. For example, after making changes in a dialog box, 
click Apply to execute and view the changes.

attach
To establish a relationship between two objects, for example, between a mass 
element and a mass group, or between a mass group and a slice representing 
a floor plate.

AutoCAD DesignCenter
A window that is displayed in the drawing area from which the user can use 
selection aids to find, load, and import drawings and drawing components. 
In the Custom view in AutoCAD DesignCenter, the user can choose AEC con-
tent from the hierarchical tree in the Architectural Desktop folder, and drag 
the content from the palette into an open drawing.

automatic property definition
Properties that are built into objects and styles when you create them, such 
as width, length, and height, or data automatically retrieved from other 
sources, such as information from the project or the object’s material. Typi-
cally, you attach automatic properties to object styles, rather than objects. 

B

base curve
A curve used to define particular drawing objects, such as lines, polylines, 
arcs, mass elements, and walls. For example, the base curve of a wall is at its 
base elevation, located at the justification position (where left, right, center, 
or baseline grips display). Many objects, such as doors, windows, or 
mvblocks, do not have a base curve and must be used with the curve anchor 
or layout curve commands.

baseline
An established, but imaginary line on which objects can rest. The baseline of 
a wall establishes the line from which all component edge offsets are mea-
sured.
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bay
In grid layouts, a regularly repeated spatial element defined by gridlines.

Boolean
Type of action performed by mathematical operations (add, subtract, inter-
sect) when 3D solid objects are combined. For example, mass elements per-
form Boolean operations when they join to make a mass group, and their 
common, or overlapping, areas combine.

boundary
A delineation of an interior space which will later become a wall. Boundaries 
are created from spaces or drawn to enclose spaces. Spaces can be linked with 
boundaries so that when either is changed, the correct relationship between 
boundary and space is retained.

break mark
Notation that signifies that an object has been broken, or has a piece 
removed.

C

camera
A display feature that correlates with adjusting the view of an object as if 
looking through the lens of a camera.

category
The internal structure of a building project. Each category is represented by 
a folder containing elements, constructs, views or sheets.

ceiling grid
A rectangular arrangement of parallel lines forming a pattern for laying out 
ceiling tile and fixtures in a building.

cell
An area within which an AEC object can be attached. Controls the width and 
depth of the object, in addition to its position and rotation.

cell anchor
A feature that fastens, or anchors, an object to the cell position of a 2D or 3D 
layout object. The anchored object’s movement and size is constrained by 
the cell.

classification property definition
Classification properties in a property set definition are used for schedules 
and enable you to report classification data for the objects in a schedule.
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classifications
A definition for a group of named properties or characteristics that you can 
assign to objects of a particular style. Classifications enable you to track 
objects by construction status, project phase, building element, vendor, or 
any other criteria that you need. Classifications can have property sets 
attached.

cleans up
Joins appropriate parts of two different walls by lengthening, shortening, or 
breaking lines that represent boundaries of the wall components.

clipping boundary
A boundary which automatically adjusts the size of a ceiling grid to fill a 
given area, such as a space.

column grids
An arrangement, either rectangular or radial, of spaces, or bays, delineated 
with parallel or radial lines. At the line intersection points are column 
positions.

component
A fundamental element of an object, such as the frame of a door, or the 
hatching of a wall.

Communication Center
An in-product notification system that keeps you up-to-date on service pack 
availability as well as information for Autodesk Subscription Program mem-
bers, such as extension availability, product tips and tricks, and product sup-
port information.

conceptual design phase
Initial design phase of a building project, including mass modeling and space 
planning. Sometimes also referred to as schematic design.

construct
A type of project file within a building project. Constructs represent unique 
portions of the building and have at least one level and one division 
assigned.

construction documents
The working drawings, schedules, and specifications required to construct a 
building. Also referred to as CDs.

construction documents phase
The phase during which the architect produces construction documents.

Construction Line
The location in stairs at which the tread length is calculated. 



Glossary | 2549

Construction Specifications Institute
(CSI): A professional association that provides technical information and 
products to the construction industry, such as the five-digit MasterFormat 
numbering system used to organize one of the imperial content menus 
included with AutoCAD Architectural Desktop. See MasterFormat.

content
User definable, pre-configured elements, which are provided with Architec-
tural Desktop to aid in getting started on a project. Examples of supplied con-
tent are templates, styles, and symbols.

Content Browser

An independent application within Autodesk® Architectural Desktop that 
lets you store, share, and exchange Autodesk Architectural Desktop content, 
tools, and tool palettes. The Content Browser allows you to exchange tools 

and tool palettes with other Autodesk applications, such as VIZ® Render.

CSI
A professional association that provides technical information and products 
to the construction industry, such as the five-digit MasterFormat numbering 
system used to organize one of the imperial content menus included with 
AutoCAD Architectural Desktop. 

curve anchor
A feature that fastens, or anchors, an object to the base curve of another 
object. The anchored object’s movement is constrained by the object it is 
anchored to.

cut-plane
The height at which an object is cut to produce the plan representation. The 
cut-plane determines the position of the break mark in plan representation 
of a stair and railing.

D

default
A predefined, or previous value for objects or parameters.

design content
Generic blocks that represent real-world building components, such as appli-
ances, electrical fixtures, furniture, etc. Design content can be accessed from 
the AEC DesignCenter.
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design development phase
The phase during which the architect develops the conceptual design into a 
completed building. Sometimes referred to as preliminary design.

detach
To remove the relationship between two objects, for example, between a 
mass element and a mass group or between a mass group and a slice repre-
senting a floor plate.

detail mark
Notation that references another drawing which contains a detail of the orig-
inal drawing.

direction dependent
A condition where the display of an object is dependent on the view direc-
tion. For example, a door might appear open in plan view, but closed in ele-
vation view. 

display configuration
The arrangement of how objects are displayed in individual viewports. Dis-
play configurations could be a fixed view or a direction-dependent view. 
Each display configuration will have one or more display sets associated with 
it.

display range
A user-defined range above and below the global cut plane that can be 
included in the Plan view. Many objects have specific display components 
for displaying above and below the cut plane.

display representation
A level of display control in which the user can specify display settings for 
individual components of objects, such as layer, color, linetype, and visibility 
display properties, to affect how a particular object is displayed.

display set
A saved set of display representations, which can be associated with a display 
configuration.

division (wing)
A division, or wing, segments a building in the vertical plane. Divisions in 
Autodesk Architectural Desktop are created and organized in the Drawing 
Management feature. 

documentation
Any output records of an architectural project, consisting of working draw-
ings, specifications, schedules, and other information pertaining to the 
building.
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Drawing Management
A new feature facilitating the creation an maintenance of large drawing 
projects.

Drawing management uses external reference and XML technology as the 
basis of the drawing project.

E

edge offset
The distance from the face of a component to a specific base line. For wall 
components, the edge offset determines where the width of the component 
is measured from.

element
A type of project file within a building project. Elements represent generic, 
re-usable portions of the building.

endcap
A user definable end condition for the end of a free-standing wall or the ver-
tical edges at a door or window opening.

entity reference
An object that makes a reference to another object, and which will update 
dynamically if the referenced object is altered. Entity references are similar to 
blocks, except that their “definitions” must remain as objects in the drawing 
editor.

entref
An object that makes a reference to another object, and which will update 
dynamically if the referenced object is altered. Entity references are similar to 
blocks, except that their “definitions” must remain as objects in the drawing 
editor. 

extrusion
A custom mass element created by extruding a planar profile along the Z axis.

F

Floating Viewer
A separate window that displays objects with orbit commands.
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formula property definition
A property definition with values computed based on the values of other 
properties on an object. Formulas can contain variables, operators, and func-
tions allowed in VBScript functions. 

G

global cut plane
A cut plane that is set globally for a display configuration in a drawing. the 
global cut plane can be overridden by an object-specific cut plane.

Graphics Path
The path in stairs containing symbols that show the up and down direction 
of the stair independent of the construction line.

I

in-place editing
Direct manipulation on screen of profiles and polylines, such as wall endcaps 
and roof/floor lines. Changes made with in-place editing can be saved back 
to the style. 

intersect
1. To reduce the volume of a mass group to that which is shared with the 
mass element creating a new region from the area common to two or more 
overlapping regions. 

2. A Boolean operation that manages 3D objects as true solids.

L

layer keying
A method of automatically placing objects in a specific layer as they are 
drawn. A particular layer key (for example, “WALL”) can be assigned to any 
predefined layer name (for example, “A-WALL”). This layer name is con-
trolled by the current layer key style.

layer key style
A set of layer keys with their associated layer names.
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Layer Manager
A utility used for grouping layers by industry standards or by user-defined 
designations.

layer snapshots
A combination of layer property settings that can be saved.

layer standard
A pre-defined list of layer names or layer group names, and a set of rules 
determining how new layer names are created. 

layout curve
A linear grid that attaches node points to an object with a base curve, for 
example, walls, mass elements, and polylines.

layout mode
A setting by which the nodes in a grid can be spaced evenly, repeatedly, or 
manually.

level
A level segments a building in the horizontal plane. Levels in Autodesk Archi-
tectural Desktop are created and organized in the Drawing Management fea-
ture. 

location property definition
A property definition with values obtained from property data on AEC poly-
gons, areas, or spaces in or near where an object is located. An object with a 
location property definition has a Data Location grip which is used to 
retrieve the data. 

M

manual property definition
A property definition you need to enter values for when you attach them to 
objects or object styles. Typically, manual properties are added to objects 
rather than object styles. 

masking block
A special block which can be used to mask the graphic display of part of an 
object in a particular view. Masking blocks can add additional graphics over 
the masked section.

mass element
A primitive object representing a specific shape and having definable para-
metric behaviors. Some Architectural Desktop mass elements shapes are 
gable, arch, cone, column, and cylinder. 
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mass group
An assemblage of mass elements combined in a specific order with Boolean 
(add, subtract, intersect) operations.

MasterFormat
A system provided by the Construction Specifications Institute (CSI) used to 
organize construction resources using a five-digit numbering system. One of 
the imperial content menus provided with AutoCAD Architectural Desktop 
uses the CSI MasterFormat system to organize its design content.

material
Corresponds to a specific structural finish material in a building model, such 
as brick, concrete or glass.

material component
Display components that determine the appearance of object components to 
which a material has been assigned.

material property definition
A property definition with values that are obtained from an object’s compo-
nent materials or from property data specified for an object’s component 
materials.

model
A two- or three-dimensional representation of one or more objects.

Model Explorer
A separate display window that contains a hierarchical tree pane in which 
the user can control the organization of mass groups and mass elements. It 
also contains a preview pane in which the user can view and navigate draw-
ing objects.

multi-view block
(mvblock): A special Architectural Desktop block which can contain multiple 
AutoCAD blocks set to display differently in different views.

mvblock
A special Architectural Desktop block which can contain multiple AutoCAD 
blocks set to display differently in different views.

N

net to gross offset
The distance between the net area outline of a space and the gross area out-
line.
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node anchor
A feature that fastens, or anchors, an object to the node position of an object. 
The anchored object’s movement is constrained by the other object. 

nodes
Points to which an AEC object can be attached. Controls the position and 
rotation of the object.

O

object
A collection of one or more graphical elements, such as lines, circles, 
polylines, text, or dimensions, treated as a single element for creation, 
manipulation, and modification. An Architectural Desktop object is a special 
entity with predefined behavior and display characteristics.

object anchors
1. A feature that creates a relationship between two objects.

2. To fasten, or anchor, an object to another object. The anchored object’s 
movement and/or size is constrained by the object to which it is anchored.

Object Enabler
A distributable utility which allows users without Autodesk AEC applications 
to use Autodesk AEC objects in AutoCAD 2000, Volo View Express, AutoCAD 
Map 2000, and 3D Studio VIZ 3.0.

object-specific cut plane
A cut plane that is set for one individual object or object style. The object-
specific cut plane overrides the global cut plane-

Object Viewer
A separate window that can display any drawing objects. You can manipulate 
and view the objects with orbit commands. 

operation
A mass element property which determines how the mass element contrib-
utes its volume to a mass group.

orbit
To navigate an object in a graphics display window, such as the Floating 
Viewer, Object Viewer, or Model Explorer, with user-selected view geometry 
rotating around a center axis. 3D orbit allows the user to inspect the object 
in real time. The user can right-click to display a shortcut menu with more 
viewing options.
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ortho close
A special command, available when adding multiple walls and space bound-
aries, which closes the defined space by automatically placing the last seg-
ment perpendicular to the first. It is most useful when creating rectangular 
rooms.

P

plan hatch
Material component used for hatching display components in plan views, 
such as wall component hatches, mass element hatches, and slab hatches.

priority
The parameter which determines component cleanup at wall intersections. 
The lower the priority number, the higher the priority. For example, a prior-
ity 1 component will extend through a priority 2 component at an intersec-
tion.

profile
Outline to delineate custom elements, such as openings or extrusions. Pro-
files can be created from one or more closed polylines and may contain 
voids.

project
An umbrella structure for all DWG and XML files stored in a building model 
created with the Drawing Management feature. The project is saved in an APJ 
file, which is an XML format. 

project property definition
Properties with values that are obtained from the Drawing Management 
project in which an object is located.

A project property definition is a type of automatic property, because the 
value it displays is determined automatically based on its definition and can-
not be edited directly.

Properties palette
Centralized location to enter and change the properties of an object. You can 
enter information about the style, dimensions, location, schedule data and 
other important characteristics of an object in the Properties palette.

property data format
A property data format is applied to each property definition within a prop-
erty set definition. Property data formats specify how the data for each prop-
erty displays in a schedule table, schedule tag, or the property palette. 
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property set data 
Data drawn from an object with property set definitions. A property set def-
inition “Height” could, for a specific object, return the property set data “1.4 
meters.” 

property set definition
A group of property definitions, or related properties of objects and object 
styles, that you want to report in a schedule. Once attached to an object or 
its style, a property set becomes the container for the data associated with the 
object. The values for the properties are obtained directly from the object or 
are entered manually for the object or the style.

Q

Quick Slice
A plane generated from two selected points and an entity used to slice 
through an AEC object, such as roof and mass groups. The resultant profile 
becomes a polyline which is added to the current layer.

R

radial column grid
A circular pattern of spaces, or bays, around a central axis point. At the line 
intersection point of the bays are column positions.

rectangular column grid
A pattern of spaces, or bays, delineated by lines at right angles. At the line 
intersection points are column positions.

representation sets
A saved set of display representations, which can be associated with a display 
configuration.

S

schedule
A tabulation of data extracted from objects in the drawing.

schedule table
The graphic representation, in tabular form, of schedule data extracted from 
the drawing, and formatted based on rules set in a schedule table style.
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schedule tag
A special annotation tag, linked to a drawing object by a schedule anchor, for 
the purpose of extracting schedule data, and displaying it on the drawing. 

section
1. A representation of an object as it would appear if cut by an imaginary 
plane, showing the internal structure. 

2. A representation of a building, or portion thereof, drawn as if it were cut 
vertically to show the interior. 

section hatch
A material component used for hatches on object faces cut by a section line.

section/elevation mark
Notation used to designate where source objects are being cut to generate a 
section/elevation view.

sheet (plotting sheet)
A type of project file within a building project. Sheets reference views to cre-
ate a plot of a specific building view.

shrink wrap
The union of all object faces cut by a section line, merged into one compo-
nent with one hatch pattern. This is a frequently used view of a 2D section.

slice
An object representing a horizontal section, or slice, through any collection 
of AEC objects. Usually used to create floor plate footprints from a mass 
grouping.

slice elevation
The height at which the floor plate footprint outline is cut. 

solid form
A boundary segment type with user-defined width that is used to capture pre-
liminary wall information and to control space layout.

space boundaries
A delineation of an interior space which will later become a wall. Boundaries 
are created from spaces or drawn to enclose spaces. Spaces can be linked with 
boundaries so that when either is changed, the correct relationship between 
boundary and space is retained.

spaces
Areas or sections in the interior of a building designated for specific use. 
Spaces have a ceiling and floor boundaries, height, width, and length.
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stair flight
The stairs between landings, usually including any landing extensions, 
excepting railing heights and automatic extensions.

stair run
The entire stair, from one floor to another, including landings.

stair walking path
The defining path of a stair. Treads are generally perpendicular to this 
polyline, except in the case of winder turn types. Stair edges may not inter-
sect this line. If they do, then a defect marker is displayed.

stock tool catalog
A catalog within the Content Browser that contains a collection of tools for 
all basic Autodesk Architectural Desktop objects and object-related com-
mands. These tools cannot be edited or deleted.

straight length
The overall length of the stair as if it had no landings. It’s equal to the num-
ber of risers minus one times the tread depth.

styles
Group of preset characteristics assigned to an object that determine appear-
ance and function.

Style Manager
A centralized location in Autodesk Architectural Desktop where you can cre-
ate, modify, move, and delete object styles and definitions. 

subtractive
1. To reduce the volume of a mass group by removing the common area that 
a mass element shares with it.

2. A Boolean operation that manages 3D objects as true solids.

surface hatch
1. A hatch pattern on three-dimensional (3D) objects that display in 3D 
model views and elevation views

2. A material component used for hatching display components in 3D model 
views, sections, and elevations

T

target
A value guideline to help the user maintain preferred length and area of 
spaces.
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title mark
Notation that identifies a drawing.

tool
Represents an individual objects you can add to a drawing. A tool contains 
properties, style, and display information about the object it represents. 
Whenever you add an object with a specific object tool, it has all of the set-
tings you have defined in the tool. This eases the design process immensely 
and enhances consistency across a project. 

tool catalog
An XML based file containing a collection of tools or tool palettes. Tool cat-
alogs are created and maintained in the Content Browser.

tool catalog library 
A collection of tool catalogs in the Content Browser. A number of predefined 
tool catalogs are shipped with Autodesk Architectural Desktop, but you can 
also create your own user-defined tool catalogs and add them to a catalog 
library. 

tool package
Collections of tools in the Content Browser that users can select and use. For 
example, a tool package may contain a set of productivity tools and utilities.

tool palette
Page within the tool palettes set containing a number of user-selected tools. 
Tool palettes can be grouped by object, by design phase or by any other sys-
tematic. You can add and remove tool palettes. 

tool palettes set
the visual representation of a tool catalog in Autodesk Architectural Desktop. 
The tool palettes set contains the tool palettes you are using in the current 
Autodesk Architectural Desktop session. 

V

view
A type of project file within a building project. Views reference constructs to 
create a partial or complete view of the building.

volume
Similar to a cell, volume controls all three dimensions of an attached object, 
in addition to its position and rotation.
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W

wall anchor
A feature that fastens, or anchors, an object to the base curve of a wall. The 
anchored object’s movement is constrained by the wall.

workspace
The new user interface of Autodesk Architectural Desktop. The workspace 
includes menus, toolbars, tool palettes, the Properties palette, the Project 
Navigator Palette, and the status bar. You can save a specific workspace con-
figuration in a user profile.

X

XML (Extensible Markup Language)
A markup technology used for data exchange. In Autodesk Architectural 
Desktop, XML is used for the Structural Member catalog and for the Drawing 
Management feature. 
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2D elevation styles, 2182
classifications, 2194
creating, 2184
design rules, 2192, 2193, 2194
display components

adding, 2185
removing, 2186

display properties, 2190
layer, color, and linetype, 2194
notes and reference files, 2195
subdivisions, display of, 2152
 See Also 2D section styles

2D elevations, 2148
3D body component of materials, 2191
creating, 2154, 2167
direction, reversing, 2172
editing, 2169
erased component, 2189
hidden component, 2189
hyperlinks, notes, and reference files,

2180
linework, 2177, 2178
location, 2179
material boundaries, 2153, 2173
materials, 502, 2151, 2186
styles, changing, 2173
subdivisions, 2149, 2164, 2170, 2190
surface hatch linework, 2188
updating, 2180

2D graphic, creating from 3D view, 2540
2D plan view materials, 499, 500
2D section styles, 2128

classifications, 2143
creating, 2130
design rules

adding, 2141
changing, 2142
removing, 2143

display components, 2131, 2132
display properties, 2143
materials, 2128, 2139
notes and reference files, 2144
subdivisions, 2128, 2139

2D sections, 2089
creating, 2096, 2108
defined, 2090
direction, reversing, 2117
display components, 2132
editing, 2114
hyperlinks, notes and reference files,

2125
linework, 2123, 2124, 2140
location, 2124
materials, 502, 528
section lines, 2099
styles, changing, 2118
subdivision display, 2115
updating, 2126
 See also 2D section styles

3D body material components, 500
3D elevations, 2149

creating, 2154, 2167
direction, reversing, 2172
editing, 2169
hyperlinks, notes, and reference files,

2180
location, 2179
materials, 2151, 2186
subdivisions, 2149, 2164, 2171, 2190
updating, 2180

3D model view materials, 500
3D sections, 2089

creating, 2096, 2108
defined, 2091
direction, reversing, 2117
display components, 2132
editing, 2114
hyperlinks, notes, and reference files,

2125
location, 2124
section lines, 2099
subdivision display, 2116
updating, 2126

3D solids, converting objects to, 2525, 2526
addendums, alternates, and as-builts within 
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projects, 381
additive mass elements, 634, 652
AEC content, 41

AEC blocks, 2344
custom commands, 2353
file locations, 565
insert options, 2344, 2348
masking blocks, 2350
multi-view blocks, 2348
preview graphics, 2346
wizard, 2343

AEC dimension chains
AEC dimension styles, 2402
all edges, 2367, 2368
bounding box, 2367, 2368
center, 2367, 2369
center of opening, 2365
changing, 2405
distance, 2407
extension line length, 2407
facing edges, 2367, 2369
height of openings display, 2408
opening width, 2365
outer boundaries, 2364, 2366, 2368
wall intersections, 2364
wall length, 2364
wall width, 2364

AEC dimension points
adding, 2386
removing, 2387
restoring, 2389

AEC dimension style wizard, 2408
AEC dimension styles

AutoCAD dimension styles, 2399, 2406
chain distance, 2407, 2408
chain properties, changing, 2402
changing, 2393
creating, 2400
defined, 2398
dimension chain contents, 2405
dimension points, 2403
display components, changing, 2402
extension lines, 2408
notes, 2410
opening height, 2408
wizard, 2399

AEC dimension tools

creating, 2383
finding in palettes, 2374

AEC dimensions
AEC dimension tools, creation with,

2376
AEC object dimension points, 2366
associative, 2360
associative points, restoring, 2389
attaching objects, 2385
AutoCAD linework dimension points,

2367
automatic, 2360
copying properties of AEC dimensions 

to AutoCAD dimensions, 2382
creating, 2376
detaching objects, 2385
dimension chains

moving, 2391
resetting, 2392

dimension points, 2386, 2387
dimension texts

moving, 2391
resetting, 2392

dimension types, 2357, 2370
doors in walls dimension points, 2365
enhancements to, 52
extension lines

moving, 2391
resetting, 2392

external references, 382, 2370
files, 2397
from AutoCAD dimensions, 2380
global underlines for overrides, 2396
grid dimension points, 2365
hiding overline of overridden values,

2397
hiding segments, 2393
hyperlinks, 2397
logical dimension points, 2360, 2362, 

2363
manual, 2362

adding, 2380
creating, 2378
point mode, 2378

methods for dimensioning, 2359
modifying, 2390
multiple, with same style, 2383
notes, 2397
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openings in walls dimension points,
2365

options, 2371
overriding dimension values, 2393, 

2395, 2396
point mode for manual, 2378
preferences, 2371
Q&A, 2411
redrawing, 2372
rescaling, 2373
restoring associative points, 2389
superscript, 2373
trailing zero suppression, 2373
units, 2373
wall dimension points, 2364
windows in walls dimension points,

2365
xref dimension points, 2370

AEC drawings, creating, 2346
AEC Editor settings, 561
AEC facet deviation, 1409
AEC Object Explode feature, 566
AEC objects

adding a reference, 2534
anchoring. See object anchors
attaching to reference, 2535
creating reference copies, 2534
default display representations, 559
default layer keys, 409
display system, 435
exploding, 562, 569, 572, 573
layer keying, 408
mask blocks. See mask blocks
referencing, 2534
 See Also objects

AEC polygon grips, 730
AEC polygon styles

changing, 732
creating, 742
defined, 741
display properties, 745
edge justification, 743
edge width, 743
files, 749
hatching, 747
notes, 749
true color display, 748

AEC polygon tools
creating, 727
finding in palettes, 725

AEC polygons, 60
3D graphics system display, 751
ambient light intensity, 751
classifications, 750
color, changing, 746
components, 722
creating, 725, 726
creating polylines from, 739
creating profiles from, 739
curtain walls, 722
defeating lighting and shading effects,

751
dividing, 736
edges, 743
editing, 730
elevation, changing, 739
global rendering material, 752
holes, 733
hyperlinks, 741
inserting

into curtain walls, 839
into door assemblies, 1147
into window assemblies, 1147

intersections, creating from, 735
joining, 732
layer, changing, 746
linetype, changing, 746
location, 740
mask blocks, 748
multiple, with same style, 727
notes, 741
polylines, creating from, 728
profiles, creating from, 729
reference files, 741
rendering exact colors, 751
rotation, changing, 739
straight line segments, creating from,

725
subtracting one from another, 733
trimming, 736
true colors, hiding, 748
vertices, 737, 738

AecPurgeLayerStyles command, 432
AIA layer key style, 408
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AIA Long Format layer standard, 421, 424
Always on Top, Content Browser option,

199
anchors

doors, changing position of, 1027, 
1029

multiple, with same style, 773
openings, changing position of, 1295, 

1296
stair to landing, 1483
tools, creating, 773
windows, changing position of, 1926, 

1928
 See Also object anchors, cell anchors, 

curve anchors, leader anchors, 
node anchors, volume anchors

angular dimensions, 2315
annotation

angular dimensions, 2315
break marks, 2312
default information, 2318
detail marks, 2313
elevation marks, 2314
plot size, 2308
project, 341, 342, 343, 344
radial dimensions, 2315
revision clouds, 2311
scaling symbols, 2310
section marks, 2316
title marks, 2317
tools, creating, 2318

APJ project files, 228
deleted or corrupted, 380

appearance of objects, setting, 531
 See Also styles

appliances See kitchen fittings symbols
application status bar, 91
arc constraints, spiral stairs, 1438
arch mass elements, 590, 606
arcs, generating spaces from, 669
area calculation modifier styles. See 

calculation modifier styles
area decomposition

defined, 2028
display settings, 2030
displaying, 2029
layer, color, linetype settings, 2030

methods, 2032
text settings, 2033

area dimensions, changing, 2005
area evaluation document formats

TXT (ASCII text), 2086
XLS (spreadsheet), 2085
XLT (spreadsheet), 2086

area evaluations
content, defining, 2077
data format style properties, 2082
default templates, 2084
defined, 2074
documents. See area evaluation 

document formats
image display, 2080
preparing the area, 2075
selecting areas, 2075

area grips, editing areas using, 2005
area group styles

changing, 2049
classifications, 2063
component hatching, 2060
creating, 2057
defined, 2056
display components, 2059
display properties, 2062
files, 2064
hatching components, 2060
notes, 2064
symbol size, changing, 2062

area group templates
contents, 2071
creating, 2070
defined, 2069
files, 2073
group structure, 2069, 2071
notes, 2073
properties, 2071
shortcut menu commands, 2072

area group tools
area groups, creating, 2040
creating, 2045

area groups, 20
areas

attaching, 2017
detaching, 2017

attaching to other groups, 2047, 2052
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calculation type, 2050, 2051
content rules, 2049
creating, 2038, 2041
defined, 2034
detaching from other groups, 2048
group templates, creating from, 2044
hyperlinks, 2056
location, 2053
modifying, 2049
multiple, with same style, 2045
name definitions. See area name 

definitions
notes, 2056
ordering structure, 2054
polylines, creating, 2055
reference files, 2056
structure, 2054
templates, 2036, 2039, 2044

 See Also area group templates
tools, 2040, 2041

area name definitions
creating, 2067
defined, 2065
files, 2068
name list, 2067
notes, 2068
using, 2066

area space totals, 695
area styles

changing, 2006
classifications, 2022
creating, 2018
creating area tools from, 1997
defined, 2017
display components, 2019
hatching components, 2021
notes and files, 2022

area tags
attributes, 2001
AutoCAD DesignCenter, adding to,

2003
creating, 2000
property set definition location, 2000

area tools
areas, creating, 1990
copying, 1997
creating, 1996

areas, 20
area calculation modifier styles. See 

calculation modifier styles
area tools, 1990, 1992
assigning to different area group, 2007
attaching to groups, 2017
calculating and evaluating information. 

See area evaluations
calculation type, 2025
closed boundaries, creating from, 1995
construction areas, 1998
creating, 1992
decomposition. See area decomposition
designing from definition to object,

1988
designing from object to definition,

1990
detaching from groups, 2017
dividing, 2014
editing, 2004
examples for creating, 1998
holes, creating, 2010
hyperlinks, 2016
intersections, creating from, 2011
joining, 2009
linework, creating from, 1994
location, 2008
measuring from axis of wall, 1999
moving, 2004
multiple, with same style, 1996
notes, 2016
object outlines, creating from, 1994
polylines, creating, 2015
reference files, 2016
rings

removing, 2014
reversing all, 2015
reversing individual, 2015

tags. See area tags
task examples, 1998
trimming, 2013
vertices, adding, 2012
vertices, removing, 2013
workflow methods, 1987

audit of non-AEC objects, 2527
AutoCAD

Autodesk Architectural Desktop, 
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integration with, 169
dimension styles, 2400
exporting drawings to, 566, 574
exporting to, 61
layers, 170
materials, 170
objects, identifying, 2527
Properties palette, 170
revision clouds, 170
tool palettes, 169
tools, 169

AutoCAD DesignCenter. See DesignCenter
Autodesk Architectural Desktop

AutoCAD, integration with, 169
finding help, 2
introduction to, 2
licenses, 68
new user interface, 8, 77
starting, 81
workspace. See workspace

Autodesk Architectural Studio
exporting files from, 577
publishing drawings to, 577, 578

Autodesk Architectural Studio support, 71
Autodesk Building Systems support, 70
Autodesk Buzzsaw support, 71
Autodesk Developer Network, 73
Autodesk Express Viewer, 64
Autodesk Professional Services, 72
Autodesk VIZ Render, 54, 494

lighting, 56
materials, 55
rendering, 57
substitution, 58

barrel vault mass elements, 591
base height, wall, 1770
basepoints, project, 381
bathroom fittings (metric), DesignCenter,

2335
beams

creating, 1563, 1564
tools, 1554
 See Also structural members

block references, adding object tags, 2234
blocks

AEC content, 2344
door components, 1048

inserting into constructs, 284
masking, 2350
multi-view, 2348
opening components, 1306
section marks, 2106
window components, 1948

boundaries
layout grids, 1262
material. See material boundaries
space. See space boundaries

box mass elements, 591
braces

creating, 1567, 1568
tools, 1557
 See Also structural members

break marks, 2312
DesignCenter, 2324

BS1192 layer key style, 408
BS1192 layer standard, 421, 425, 426
building projects. See projects
calculation modifier styles, 2023

attaching to areas, 2006, 2051
calculation formula, 2026
calculation type, 2025
creating, 2024
defined, 2023
detaching from areas, 2006, 2051
notes and reference files, 2027

calculation rules
multi-landing stairs, 1422
spiral stairs, 1437
straight stairs, 1417
u-shaped stairs, 1430

calculation type
area groups, 2050
areas, 2025

cameras, 60, 2501
display properties, 2517
field of view, 2507
inserting, 2502
location, 2510
position, 2513
settings

modifying, 2509
user-specified, 2504

single-use, 2504
source point, 2508
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target point, 2508
tool properties, applying, 2511
tools, creating, 2505
videos, 2513, 2515
views

changing with grips, 2507
creating, 2511

catalog libraries, tool. See tool catalog 
libraries

catalogs, tool. See tool catalogs
categories, in tool catalogs, 189
categories, project, 260

benefits of, 262
changing, 266
creating by dragging folders, 264
creating in Project Navigator, 263
default folder structure, 228, 260
deleting, 267
mixing types, 261
overview, 217
subcategories, 265
user-defined, 261

ceiling boundaries, 663
ceiling grid tools

creating, 1231
finding in palettes, 1225

ceiling grids
clipping boundaries, creating with,

1230
clipping profiles, attaching, 1240
creating, 1227

dynamically, 1229
from layout grids, 1228

dimensions, changing, 1233
display, changing, 1244
holes, 1241
hyperlinks, 1242
layout grid, creating from, 1228
lines

adding, 1234, 1235
changing, 1233
moving, 1239
removing, 1236, 1237, 1238

linework, creating from, 1229
location, 1243
masking, 1240
modifying, 1232
multiple, with same style, 1231

notes, 1242
reference files, 1242

cell anchors
adding, 765
anchoring to different cells, 767
copying objects to all layout cells, 768
defined, 765
position of objects attached to, 

changing, 766
size of objects attached to, changing,

766
cell infills, curtain wall units

assigning, 946
panels, 949
removing, 932, 949

cell infills, curtain walls
alignment of objects in cells, 907
assigning, 833
editing objects in cells, 906
inserting objects, 839
offset of objects in cells, 907
orientation of objects in cells, 906
panel, 838
releasing anchored objects in cells, 908
removing, 818, 840

cell infills, door assemblies
alignment of objects in cells, 1198
assigning, 1140
editing objects in cells, 1197
offset of objects in cells, 1199
orientation of objects in cells, 1198
panel, 1146
releasing anchored objects in cells,

1199
removing, 1124, 1148

cell infills, window assemblies
alignment of objects in cells, 1198
assigning, 1140
editing objects in cells, 1197
offset of objects in cells, 1199
orientation of objects in cells, 1198
panel, 1146
releasing anchored objects in cells,

1199
removing, 1124, 1148

chamfering walls, 1789
chases, DesignCenter, 2324
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circles, generating spaces from, 669
circular mass elements, 609
classifications, 51, 2198, 2289

creating, 2293
definitions, entering in, 2295
displaying objects by, 471
editing, 2297
examples of, 2291
notes and reference files, 2300
object styles, 2294
property set definitions, attaching,

2296
schedules, including in, 2204
troubleshooting, 2305
viewing, 2299

cleanup circles in walls, 1812
cleanup group definitions, 531
cleanup priorities, walls, 1815
cleanup radius, changing, 1820
clipping profiles

ceiling grids, 1240
column grids, 1221
layout grids, 1262, 1263

closed boundaries, creating areas from,
1995

CNC machining applications, 2525
color palettes, 59
column grid tools, finding in palettes, 1203
column grids

clipping profiles, 1221
creating, 1204

dynamically, 1208
from layout grid, 1208
from linework, 1208

dimensioning, 1213
with AEC dimensions, 1213

display, changing, 1224
enhancements to, 36
holes, 1222
hyperlinks, 1223
labeling, 1210

extending lines, 1212
layout grid, creating from, 1208
lines

adding, 1215, 1216, 1217
changing, 1215
moving, 1220, 1221
removing, 1218, 1219

removing from manual grids, 1218
linework, creating from, 1208
location, 1224
masking, 1222
modifying, 1214
notes, 1223
overall dimensions, 1214
reference files, 1223

columns
anchoring to grids, 1576, 1577
freestanding, 1572, 1573
steel and concrete, 1624
tools, 1560
 See Also structural members

command line, 89
drawing management commands, 377
new project environment, selecting,

379
Project Browser, 378
Project Navigator, 378, 379
projects, refreshing, 378
views, regenerating, 378

command tools, 105
commands moved to Format menu, 106
commands, custom AEC, 2353
Communication Center, 91
components. See individual component 

names
concept phase in space planning, 656
conceptual models, 583

 See Also mass models
cone mass elements, 593
configurations, display. See display 

configurations
constraints, grip, 157
construction lines

multi-landing stairs, changing, 1450
u-shaped stairs, changing, 1455

constructs, project, 268, 271
blocks, inserting, 284
content of, 271
creating, 272, 289
deleting, 287, 289
display configurations, 339
dragging objects into, 281
elements

compared to, 291
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converting to, 287
external references

attaching, 283
displaying, 285

legacy drawings, converting, 269, 276, 
277

levels and divisions, 268, 289
levels, copying to, 270, 275
names, 289
opening and closing, 279
overview, 212
properties, 286
referencing elements into multiple,

284
referencing objects into, 282
templates, 270
views, compared to, 268
when to start with, 270
XML files, 269

consulting, Autodesk Professional Services,
72

Content Browser, 12
Always on Top option, 199
catalog items

dragging, 206
opening, 206

command prompt, starting from, 208
multiple windows, 204
rows, specifying number of, 179
tool catalogs, opening, 205
tools

adding, 136
removing links, 140
updating, 138, 139

user interface, 174
window, keeping on screen, 199
 See also tool catalog libraries, tool 

catalogs, tool packages, tool 
palettes

Create AEC Content wizard, 2343, 2346, 
2460

CSI Division 1 General Requirements 
symbols, 2330

CSI Division 10 Specialties symbols, 2331
CSI Division 11 Equipment symbols, 2332
CSI Division 12 Furnishing symbols, 2332
CSI Division 13 Special Construction 

symbols, 2333

CSI Division 14 Conveying Systems 
symbols, 2334

CSI Division 15 Mechanical symbols, 2334
CSI Division 16 Electrical symbols, 2335
CSI Division 2 Site Construction symbols,

2331
CSI Master format imperial symbols, 2330
curtain wall cells

cell assignments, 841
filling with panels, 838
infills, 812, 840
objects, inserting, 839

curtain wall components
custom graphics, 856
display, 853
hatching, 855
layer, color, and linetype, 854

curtain wall dimensions, 783
curtain wall frames, 824

assigning definitions, 843
curtain wall grids, 777

cells, 833
fixed number, 804
fixed size, 801
manually defining number and size,

805
custom, 788
divisions, 799, 800, 808, 833
frame edges, 844, 845
frames, adding, 844
gables, excluding, 807
mullions, 825, 827, 828, 831
nested grids, 834
offset, 809
polylines, 808
steps, excluding, 807

curtain wall grips, editing curtain walls 
using, 881

curtain wall properties, 860, 969
curtain wall styles

assigning
definitions to elements, 832
definitions to mullions, 846
divisions to grids, 833
infills to cells, 833

assignments, removing, 842
cell infills, 818, 833
changing, 885
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creating, 797
cut planes, 857
defined, 793
division definitions, 811
elements of, 796, 832
frames, 818, 820

offsets, 823
profiles, 821

grid cells, 799, 801
infills

alignment, 815
offset, 816
overriding, 860

matching styles, 885
modifying element definitions, 878
mullions, 825

assignments, 847, 848
offsets, 830
profiles, 828
removing definitions, 831
removing from grid, 849
width and depth, 827

notes and reference files, 858
overrides, 859
overview, 794
panel infills, 813

curtain wall tools, 791
curtain wall unit cells

cell assignments, 950
filling with panels, 949
infills, 927, 949

curtain wall unit components
custom graphics, 966
display, 963
hatching, 964
layer, color, and linetype, 964

curtain wall unit frames, 938
assigning definitions, 952

curtain wall unit grids, 909
cells, 946

fixed number, 923
fixed size, 920
manually defining number and size,

924
custom, 913
divisions, 918, 919
frame edges, 954, 955
frames, 953
mullions, 939, 940, 941, 942, 945

offset, 926
curtain wall unit grips, 990
curtain wall unit styles

assigning
definitions to elements, 945
definitions to mullions, 956
infills to cells, 946

assignments, 952
cell infills, 932, 946
changing, 994
creating, 916
cut planes, 967
defined, 915
division definitions, 927
elements of, 916, 945
frames

defining, 932, 934
defining by profile, 935
offsets, 937
profiles, 935

grid cells, 918, 920
infills

alignment, 930
offset, 930
overriding, 970

matching styles, 994
mullions

assignments, 957, 958
defining, 939
defining by width and depth, 940
offsets, 943
profiles, 941, 942
removing definitions, 945
removing from grid, 959

notes and reference files, 968
overrides, 969
panel infills, 929

curtain wall units
alignment of anchored, 998
auto-adjusting cells, 922
base height, 992
cell markers, 970
components, 960
creating, 911
dimensions, 995
display of, 962
division overrides, 983, 984
door assemblies, inserting into, 1147
editing, 989
frame and mullion overrides, 976, 977
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frame edges, 979
hyperlinks, 998
infill overrides, 973
in-place editing, 981
length, 993
location, 996, 997
matching properties, 994
merging cells, 971
mitered corners, 995
moving, 989
mullion edges, 979
nested grids, 947
notes and reference files, 998
offset, 998
overrides, removing, 988
window assemblies, 1147

curtain walls
AEC polygon infills, 722
alignment of objects in cells, 907
anchored objects in cells, 908
auto-adjusting cells, 803
base height, 882
cell and edge assignments, 860, 969
cell markers, 861
cells, merging, 861
creating, 780, 782

from walls, 790
curved, 783, 785
curves, referencing, 785
custom grids, 788
dimensions, 886
direction, reversing, 886
display of, 852
divisions, overriding, 872, 873
editing, 880
editing objects in cells, 906
enhancements to, 31
floor lines, 894, 899

editing, 895
height, 897
modifying, 891
shape, 897

frame edges, 868
frames and mullions, overriding, 866
gables, adding, 897
hyperlinks, 890
infills

for inserting objects, 814

overrides, 863
in-place editing, 871
interference conditions, 887, 888
length, 883
matching properties, 885
materials, 851, 961
mitered corners, 889
moving, 880, 887
mullion edges, 868
multiple, with same style, 791
nested grids, 834, 837
notes and reference files, 890
offset of objects in cells, 907
orientation of objects in cells, 906
overrides, removing, 878
radius, 884
roof lines, 892, 899

editing, 895
height, 897
modifying, 891
shape, 897

straight, 785
swapping two objects, 907

curve anchors
adding, 755
anchoring to new, 757
changing position of objects, 756
defined, 754

curved surfaces, hatching, 505
curves, layout. See layout curves
custom blocks, railing components, 1689
custom commands, AEC content, 2353
Custom view, DesignCenter, 2322
cut planes, 362

anchoring objects, 375
display range, 362
global, 362
and levels, 363
manual, 376
object-specific, 362, 373, 374
overriding for walls, 374
overview, 218
stairs, 1510
wall styles, 1882
walls, 1808

cylinder mass elements, 594
defining lines, sections, 2135
defining mullions, 1132
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definitions
cleanup group, 531
mask block, 531
multi-view block, 531
profile, 531
property set, 531

dependent files, 197
design rules

2D elevation styles, 2192, 2193, 2194
2D section styles, 2141, 2142, 2143
door styles, 1039
window styles, 1940

DesignCenter
AEC content, 2343
AEC drawings, 2346
annotation symbols, 2309
break marks, 2324
chases, 2324
content file locations, 565
CSI Division 1 General Requirements 

symbols, 2330
CSI Division 10 Specialties symbols,

2331
CSI Division 11 Equipment symbols,

2332
CSI Division 12 Furnishing symbols,

2332
CSI Division 13 Special Construction 

symbols, 2333
CSI Division 14 Conveying Systems 

symbols, 2334
CSI Division 15 Mechanical symbols,

2334
CSI Division 16 Electrical symbols,

2335
CSI Division 2 Site Construction 

symbols, 2331
CSI Master format symbols, 2330
Custom view, 2322
detail marks, 2325
documentation symbols, 2327
elevation labels, 2325
elevation marks, 2326
fixture layout, 2339, 2341
imperial symbols, adding, 2324
leaders, 2327
metric symbols, 2324, 2335

multi-view block definitions, adding,
2490

revision clouds, 2328
schedule tags, 2328
section marks, 2329
title marks, 2330
See also imperial symbols, metric 

symbols
detail marks, 2313

DesignCenter, 2325
developer support, 73
diagnostic messages, 561
dialog boxes, placement of, 561
diamond pattern in window muntins, 1958
digital signatures, 66
dimension column grids, 1213
dimension labels

attributes, 2418
behavior, 2433
blocks, 2439
Design Center, adding to, 2440
display representations, 2419
doors, 2419
editing, 2430
multi-view block definitions, 2430
openings, 2419
prefixes, 2421
stairs, 2420
standard dimension labels, 2419
superscript, 2422
trailing zero suppression, 2422
units, 2422
user-defined, 2434
windows, 2419

dimension scale overrides, 2308
dimensions

AEC. See AEC dimensions
area, 2005
curtain wall units, 990, 995
curtain walls, 881, 886
door assemblies, 1095, 1192
door. See door dimensions
dynamic, 149, 155
project, 355
sections, 2103
space styles, 689
spaces, 681
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stair. See stair dimensions
window assemblies, 1188, 1192
window. See window dimensions

direct manipulation of objects, 18
display configurations, 445, 458

copying between drawings, 477
creating, 459, 461
default, 448, 468
deleting, 475
emailing, 478, 486
exporting, 482
importing, 478
notes and reference files, 476
predefined, in templates, 435
project, 339
purging, 486
renaming, 474
templates, 436
tips for working with, 460
view direction, 467
viewing, 451
viewports, 467, 468
xrefs, 468, 470

display management
layers, 388
 See Also display system

Display Manager, 449, 473
enhancements to, 16
left pane, 449
opening, 451
right pane, 449
view direction icons, 450
 See Also display system, display 

representations, display sets, 
display configurations

display representations, 437
assigning to display sets, 465
creating, 463
default, 439, 440, 457, 559
deleting, 475
editing, 464
importing and exporting, 477
materials, 503
purging, 487
renaming, 474
spaces, 685
structural members, 1604

tips for working with, 460
viewing, 454
viewing objects that use, 455, 456

display sets, 443
classifications, 471
creating, 462
default, 445
deleting, 475
display representations, 443

assigning, 465
viewing, 456

exporting, 484
importing, 480
notes and reference files, 476
purging, 486
renaming, 474
tips for working with, 460
view direction, 444
viewing, 452

display system, 435
elements of, 435
materials definition, 436
troubleshooting, 487, 488
 See Also display representations, display 

sets, display configurations, 
Display Manager

divisions
curtain wall units, 918, 919
curtain walls, 799, 800
door assemblies, 1108, 1109
project, 257

changing, 258
creating, 258, 259
deleting, 259, 260
ID, 260
name, 260
overview, 216

window assemblies, 1108, 1109
documentation symbols

DesignCenter, 2327
See Also annotation

dome mass elements, 594
door assemblies

alignment of objects in cells, 1198
anchored objects in cells, 1199
auto-adjusting cells, 1112
cell markers, 1168
cells, merging, 1169
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centering in walls from xref drawings,
1825

creating, 1092, 1095
curtain walls, inserting into, 839
custom grids, 1098
dimensions, 1192
display of, 1160
divisions, overriding, 1180
door assembly tools, creation with,

1094
editing, 1186
editing objects in cells, 1197
enhancements to, 33
frame edges, 1176
frames and mullions, overriding, 1173, 

1174
freestanding, 1193
height, 1188, 1190
hyperlinks, 1196
infills

for inserting objects, 1120
overrides, 1171

in-place editing, 1178
interference conditions, 1194, 1195
matching properties, 1192
materials, 1159
mitered corners, 1195, 1196
moving, 1186, 1191
mullion edges, 1176
multiple, with same style, 1100
nested grids, 1142, 1145
notes and reference files, 1196
offset of objects in cells, 1199
orientation of objects in cells, 1198
overrides, removing, 1185
positioning, 1095
sizes, 1188
swapping two objects, 1199
width, 1188, 1189

door assembly cells
cell assignments, 1148
filling with panels, 1146
infills

defining, 1117
removing, 1148

objects, inserting, 1147
door assembly components

custom graphics, 1163
display, 1161
hatching, 1162
layer, color, and linetype, 1162

door assembly dimensions, 1095
door assembly frames, 1131

assigning definitions, 1151
door assembly grids

cells, 1140
fixed number, 1113
fixed size, 1110
manually defining number and size,

1114
custom, 1098
divisions, 1108, 1109, 1140
elements, 1090
frame edges, 1152, 1153
frames, adding, 1151
mullions, 1132, 1134, 1135, 1136, 

1137, 1138
nested grids, 1142
offsets, 1115

door assembly grips, 1188
door assembly height, 1188
door assembly styles, 1132

assigning
definitions to elements, 1139
definitions to mullions, 1154
divisions to grids, 1140
infills to cells, 1140

assignments, 1150
cell infills, 1140
changing, 1191
creating, 1106
cut planes, 1165
defined, 1102
division definitions, 1117
element definitions, 1185
elements of, 1105, 1139
frame offsets, 1130
frames, 1125

profiles, 1127, 1128
width and depth, 1126

grid cells, 1108, 1110
infills

alignment, 1121
definitions, 1124
offset, 1122
overriding, 1168
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matching styles, 1192
mullions

assignments, 1155
offsets, 1137
profiles, 1135, 1136
removing definitions, 1138
removing from grid, 1156
width and depth, 1134

notes and files, 1166
overrides, 1167
overview, 1103
panel infills, 1119
shape, 1193

door assembly tools, creating, 1100
door assembly width, changing custom,

1188
door components

custom blocks for, 1048
display of, turning off, 1051
door styles, removing from, 1051
layer, color, and linetype, 1047

door dimensions
changing, 1020
changing for door styles, 1038

door frames, assigning materials, 1045
door grips

editing doors using, 1011
editing railings using, 1653

door head height, aligning doors by, 1007
door height, changing custom, 1012
door hinges, changing location, 1016
door leaf, changing, 1020
door materials, assigning, 1045
door measurements. See door dimensions
door muntins

display of, turning off, 1086
door styles, removing from, 1086
editing, 1085
glass, 1058
materials, 1045
prairie-lights, 1065
rectangular or diamond, 1060
starburst, 1071
sunburst, 1077
void for, 1056, 1057

door opening endcaps, 1033
door opening percents, 1052
door panels, materials, 1045

door properties, 1011
door rise, changing, 1018
door sizes

changing, 1012
properties, 2245
specifying, 1006

door stops, materials, 1045
door styles

changing, 1019
components, 1049, 1051
creating, 1036
creating door tools from, 1008
custom door shapes, 1041
defined, 1035
dimensions, 1038
display of components, turning off,

1051
door shapes, 1041
door swings, 1052
geometry, 1042
materials, 1048
muntins, 1086
notes and files, 1054
opening percentage, 1052
specifying design rules for, 1039
standard sizes, 1040

door swings
angles, 1021
direction, 1017
direction properties, 2246
displaying as straight line, 1052
location, 1017
opening percent, 1021

door thresholds
aligning doors by, 1007
display properties, 1053
symbols, 1053

door tools
copying, 1009
creating, 1008
finding in palettes, 1004

door width
changing custom, 1012
changing how measured, 1020

doors
centering in walls from xref drawings,

1825
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creating in walls, 1005
curtain walls, inserting into, 839
custom shapes, 1041
dimension label, 2417
display components and materials,

1043
door assemblies, inserting into, 1147
door tools, creation with, 1004
editing, 1010
enhancements to, 27
freestanding, 1034
geometry, 1042
height, 1012
horizontal position, 1027
insertion, 1007
moving, 1010

along walls, 1016, 1023
to different wall, 1033
within walls, 1016, 1025

multiple, with same style, 1008
notes and reference files, 1035
opening endcap style, 1033
positioning, 1007

along walls, 1016, 1023
horizontally, 1031
within walls, 1016, 1025

releasing from walls, 1033
schedule tags, adding, 2233
shapes, 1041
space boundaries, creation in, 1005
standard sizes, 1040
threshold or head height, alignment 

by, 1007
type and shape, 1039
vertical alignment, changing, 1022
vertical orientation, 1032
vertical position, 1029
width, 1012
window assemblies, inserting into,

1147
doric column mass elements, 596
dormers in roof slabs, 1376
drag points, spaces, 666
drape mass elements, 596
drawing annotation. See annotation
drawing management, 44

command line, 377
frequently asked questions, 380

overview, 211
drawing sheets, 45
drawing window status bar, 14, 90
drawings

AEC Object Explode feature, 566
AEC, creating, 2346
closing in Style Manager, 541, 543
converting legacy to project, 219
creating

from scratch, 552
from templates, 551
in Style Manager, 542

default display representations, 559
displaying objects with facets, 564
dragging in Style Manager, 542
elevations, 2147
exporting

to AutoCAD, 566, 574
to DXF files, 566, 575

layer key styles, 557
layer management, 388
layer standards, 557
legacy, opening, 552
Object Enabler, 566, 569
opening in Style Manager, 540, 542
project-related information, 

removing, 238
proxy graphics, 566, 568
read-only status indicator, 536
scale, 556, 2308, 2309
security, 64
sets, 63
setting up, 553
sharing with other users, 566, 568
status of, 541
thumbnails, 62
units, specifying, 554

DWG file performance, 61
DXF files, exporting drawings to, 566, 575
dynamic dimensions, 149, 155
Edit-in-Place, 20
electrical services symbols (metric), 

DesignCenter, 2336
elements, 290

constructs
compared to, 291
converting to, 305

creating, 294
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deleting, 302, 307
dragging objects into, 301
external references, displaying, 305
legacy drawings, converting, 291, 296, 

297
name, 307
opening and closing, 299
overview, 213
projects, adding to, 307
properties, 301
referencing in multiple constructs, 292
referencing into other elements, 303
templates, 291
when to use, 292, 293
XML files, 291

elevation labels, 2443
attributes, 2451, 2454
blocks, 2451, 2455
coordinate systems, 2449
creating, 2446
defined, 2444
DesignCenter, 2325, 2456
elevation values, 2449
graphic symbols, 2454
hyperlinks, notes, and reference files,

2452
modifying, 2448
multi-view blocks, 2449, 2456
offset, 2450
property set definitions, 2453
scale factor, 2450
tools

creating, 2447
creating with, 2445

user-defined, 2452
user-specified settings, 2446

elevation lines, 2148, 2157
changing, 2160
dimensions, 2162
drawing with elevation marks, 2160
hyperlinks, notes, and reference files,

2166
location, 2165
subdivisions, 2160, 2164
viewing, 2158

elevation marks, 2148, 2314
attributes, 2165

DesignCenter, 2326
drawing, 2160

elevations, 2147
dimensions, 2162
enhancements to, 46
live section views, 2150
materials, 2151
subdivisions, 2149, 2164
 See Also 2D elevations, 3D elevations, 

elevation lines, elevation 
marks

endcap styles, walls, 1886
endcaps

door opening, 1033
opening, 1291
window opening, 1932

entity references
changing location, 2536
notes and reference files, 2535

erased component, sections, 2138
exploded objects, identifying, 2527
extension lines, AEC dimension styles,

2408
external references (xrefs)

constructs, attaching to, 283
dimensioning, 382, 2370
display configurations, 337, 338, 468, 

470
display settings, 335
exploding objects, 573
overview, 212
projects, 220
Quick Slice, 2532
troubleshooting, 1824, 1825

extrusion mass elements, 597
extrusions, hatching, 507
faces, hatching multiple, 506
facet deviation, 999, 1409
FACETDEV variable, 1590, 1898
fascia, 1743

in roof styles, 1335, 1392, 1701
fields, layer standards, 423

AIA Long Format, 425
BS1192, 426, 427

files, LY, 409
files, reference. See reference files
filleting walls, 1787
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fills, gradient, 59
filters, layer. See layer filters
fittings

bathroom, 2335
kitchen, 2337

fixture layouts, DesignCenter, 2339
floor boundaries, spaces, 664
floor lines

curtain walls, 894
changing, 891, 899
changing vertices, 900

editing, 1799
offsetting, 1795
projecting, 1795
reversing, 1801
steps, adding, 1798
walls, 1795

changing, 1793, 1798
changing vertices, 1802

floor plans, evaluating. See area evaluation
floor settings

changing, for stairs, 1480
multi-landing stairs, 1423
spiral stairs, 1438
u-shaped stairs, 1432

floorplates. See slices
Format menu, commands moved to, 106
formulas, 49
frames, curtain wall units

offsets, 937
profiles, 935
removing, 938
width and depth, 934

frames, curtain walls
offsets, 823
profiles, 821
removing, 824
width and depth, 820

frames, door, 1045
frames, door assemblies

profiles, 1128
removing, 1131
width and depth, 1126

frames, window, 1944
frames, window assemblies

offsets, 1130
profiles, 1128

removing, 1131
width and depth, 1126

free form mass elements, 599
freestanding columns, 1572, 1573
freestanding door assemblies, 1193
freestanding doors

creating, 1005
location, 1034

freestanding window assemblies, 1193
freestanding windows

creating, 1905
location, 1933

furniture symbols (metric), 2336
office, 2338

gable mass elements, 595, 607, 608
gable roof lines

curtain walls, adding to, 897
settings, 901
in walls, 1796

gable roofs
creating, 1320
creating with roof tools, 1316

geometry
door, 1042
window, 1941

glass, door muntins, 1058
global cut planes, 362, 364

clipped model view, 370
display range, 365, 366, 367
displaying different levels, 368

gothic pattern in window muntins, 1977
gradient fills, 59
graphics path

multi-landing stairs, changing, 1450
u-shaped stairs, changing, 1455

graphics, preview, 2346
graphlines in walls, 1812
grid lines

layout grids, 1258, 1259
layout volumes, 1268, 1269

grids, 1220
anchoring objects to, 1202
anchoring to objects, 753
ceiling grid tools, creation with, 1227
column grid tools, creation with, 1204
curtain wall units, 911
curtain walls, 786
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door assemblies, 1097
evenly spaced, 1202
fixed baysize, 1202
layout modes, 1201
window assemblies, 1097
 See Also ceiling grids, column grids, 

curtain wall unit grids, curtain 
wall grids, door assembly grids, 
layout grids, window assembly 
grids

grids, door assembly, 1132
grids, window assembly, 1132
grips, 19

AEC dimensions
dimension text, moving, 2391
extension lines, moving, 2391

AEC polygon, 730
area, 2005
color, 152
constraints, 157
curtain wall, 881
curtain wall unit, 990
direct editing with, 149
door, 1011
door assembly, 1188
dynamic dimensions, 155
opening, 1288
railing, 1653
roof, 1324
roof slab, 1351
slab, 1712
stair, 1443
temporary coordinate systems, 157
tooltips, 151
trigger, 154
wall, 1770
window, 1911
window assembly, 1188

groups, layer. See layer groups
hatches

AEC polygon styles, 747
curved surfaces, 505
extrusions, 507
free form mass elements, 509
material, 165
material components, 500
multiple faces, 506

wall styles, 1882
 See Also surface hatches

head height
door, 1007
openings, 1280

height
door, 1012
door assembly, 1188
wall, 1770
window assembly, 1188

help sources, 2
hidden component, sections, 2138
hidden line projection, creating, 2540
hinges

door, 1016
window, 1917

horizontal orientation
spiral stairs, 1434
u-shaped stairs, 1427

icons, layer, 388
i-drop icon for tool catalogs, 178
imperial symbols, 2324
in-place editing, 20, 157

3D body modifiers, 164
curtain wall units, 981
curtain walls, 871
door assemblies, 1178
material hatches, 165
polyline-based components, 159
profile-based objects and components,

161
window assemblies, 1178

insertion point
of doors, 1007
of openings, 1280
of windows, 1907

interference conditions
adding to walls, 1863
removing from walls, 1864
spaces, 680
stairs, 1490

in curtain walls, 1496
in door assemblies, 1497, 1498
in slabs, 1492
in slabs, removing from, 1493
in spaces, 1495
in walls, 1491, 1492
in window assemblies, 1497, 1498
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interior space planning, 656
isosceles triangle mass elements, 592
joining walls, 1787
keys, layer. See layer keys
kitchen fittings symbols (metric), 

DesignCenter, 2337
landing shapes, 1454
LAYER command, 553
layer filters

layer colors, 398
layer names, 401
layer standards, 400
linetype, 399
specifying, 396

layer groups
creating, 394
filter groups, 394, 395, 396
layers, adding, 402
properties, changing, 403
renaming and deleting, 404
rules for, 393
types of, 393
user-defined, 394

layer icons, 388
layer key styles, 408

AIA, 408
BS1192, 408
creating, 414
creating from LY files, 415
defined, 385
editing, 415
in Style Manager, 531, 532
notes and reference files, 417
overrides to, 409
properties of, 408
specifying, 557

layer keying
defined, 385
values for new layer keys, 413

layer keys
default, 409, 421
default values, 413
defined, 385, 408
overrides, 418

specifying, 419
turning on and off, 420

remapping, 420

Layer Manager
enhancements to, 17
layer groups, 394

properties, 403
layer icons, 388
layer snapshots, 405
layer standards, 422
layers

creating, 389, 390
creating nonstandard, 390
deleting, 391
making current, 389
renaming, 391

opening, 389
optimizing, 388, 562
overview, 386

layer snapshots
creating, 405
deleting, 406
editing, 405
exporting, 407
importing, 407
restoring, 406

layer standards
AIA Long Format, 421, 424
assigning layers to, 392
BS1192, 421, 425, 426
component fields, 422
creating, 428
creating layers conforming to, 389
defined, 385
editing, 429, 430, 431
fields, 423
importing and exporting, 432, 433
included with Layer Manager, 422
match description, 424
purging, 432
specifying, 557

layers
adding with same name, 390
AEC Editor, 561
AutoCAD, 170
current, 389
deleting, 391
description, 392
display management, 388
layer standards, 389, 392
nonstandard, 390
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renaming, 391
 See Also Layer Manager

layout curves, 1245
adding, 1248
anchoring to objects, 753
display properties, 1252
hyperlinks, notes, and reference files,

1252
nodes

adding, 1249
removing, 1250

objects used as, 1246
spacing modes, 1250
switching to other objects, 1251
tools, creating, 1247
versus layout grids, 1246

layout grids, 1245, 1253
boundaries, 1262
curtain wall units, 911
curtain walls, 786, 834
display properties, 1261
door assemblies, 1097, 1142
grid lines, 1258, 1259
holes, 1262, 1263
hyperlinks, notes, and reference files,

1264
location, 1263
radial, 1255, 1257
rectangular, 1257, 1258
spacing mode, 1260
tools, creating, 1254
versus layout curves, 1246
window assemblies, 1097, 1142

layout modes (grids)
evenly spaced, 1202
fixed baysize, 1202

layout volumes, 1245, 1264
adding, 1267
changing, 1268
display properties, 1271
grid lines, 1268, 1269
hyperlinks, notes, and reference files,

1272
location, 1271
spacing modes, 1270
tools, creating, 1265

leader anchors

adding, 758
changing position of objects anchored 

to, 759
copying objects to all layout nodes,

761
defined, 758
extending leaders, 760
grip editing, 759

leaders, DesignCenter, 2327
leaf, door, 1020
legacy drawings, opening, 552
length

limits for stairs, 1481
wall, 1770

levels, 44, 250
copying, 251, 253
creating, 251, 256
cut planes, 250
defaults, 251
deleting, 255, 256
floor elevation, 256
floor-to-floor height, 256
IDs, 256
name, 256
overview, 216
properties, 254

licensing, 68
lines

ceiling grids, 1234
column grids, 1215
generating spaces from, 669

linetype scale
display properties of AEC objects and 

LTSCALE, 490
troubleshooting, 490

linetype settings, AEC Editor, 561
linework

2D elevations, 2177, 2178
2D sections, 2123, 2124, 2140
areas, creating, 1994
erased component (2D elevations),

2189
generating spaces from, 671
hidden component (2D elevations),

2189
section hatch, 2137
section surface hatch, 2137
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structural members, creating, 1580
surface hatch (2D elevations), 2188

linework material components, 499
linking objects. See object anchors
live section views, 2092

creating, 2098, 2110, 2111
display settings, 472
editing, 2110
enhancements to, 47
in elevations, 2150
materials, 502
removing, 2114
section lines, creating from, 2099
sectioned body, displaying, 2112
updating, 2112

location properties, 50
l-shaped stairs

creating, 1424
LY files, creating layer key styles from, 409
mask block definitions

creating, 2460
from existing definitions, 2462
from polylines, 2461

editing, 2464
exporting, 2463, 2464
importing, 2462
purging, 2466
Style Manager, 531, 2460

mask blocks, 2459
adding, 2468
AEC content, 2350
attaching to objects, 2472
definitions. See mask block definitions
detaching from objects, 2473
display properties, 2477, 2478
editing, 2473
grips, editing with, 2474
hyperlinks, notes, and reference files,

2478
location, 2474
profiles, editing, 2475
tool properties, 2477
tools

adding using, 2467
creating, 2469

user-specified settings, 2469
mass element styles, 620

creating, 620
display properties, 624
hatching, 625
materials, 621
notes and reference files, 626

mass elements, 22, 584
3D objects, converting to, 599
additive, 634, 652
arch, 590, 606
barrel vault, 591
Boolean operations, 611
box, 591
circular, 609
cone, 593
creating, 588
creating with massing tools, 586
cylinder, 594
display components, 642
display properties, 616
dividing, 611
dividing face of, 613
dome, 594
doric column, 596
drape, 596
editing, 601
editing with grips, 602
free form, 599
gable, 595, 607, 608
hatching, 616
hatching free form, 509
height, 605
hyperlinks, notes, and reference files,

619
intersections, 636, 654
isosceles triangle, 592
joining faces of, 613
location, 618
mass groups, 610, 652

adding to, 632, 633
attaching objects to, 652
detaching from, 634

materials, 615, 641, 644
Model Explorer, 651
moving, 605, 656
order, 655
profiles

extruding, 597, 598
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revolving, 597, 599
pyramid, 592
rectangular, 604
right triangle, 593
shapes, 588, 610
size, 588, 610
sphere, 595
subtractive, 635, 653
tools, creating, 600
trimming, 612
user-specified settings, 589

mass groups, 584
Boolean operations, 628
changing, 610
creating, 628
display components, 642
hyperlinks, notes, and reference files,

639
location, 638
markers, 630, 632
mass elements, 652

adding, 632
attaching, 633, 652
detaching, 634

mass group markers, 628
materials, 629, 631, 641, 644
Model Explorer, 651
moving, 656
nested, 638
tools, 640

creating with, 627
mass models, 584

Model Explorer, 646
massing studies, 584

 See Also mass groups
massing tools

mass elements, 586
mass groups, 627

material boundaries, 2095
creating, 2118
editing, 2119, 2174
highlights, 2118
masks, 2118
rings, 2176, 2177

adding, 2121
removing, 2122
replacing, 2122

vertices, 2175

adding, 2120
removing, 2121

material components, 498
2D section and elevation linework, 502
3D body, 500
linework, 499
patterns, 521
plan hatch, 500
section hatch, 502
sectioned body and sectioned 

boundary, 502
surface hatch, 500

material definitions
creating, 519
notes and reference files, 530

materials, 42
2D section shrinkwrap, 528
2D section styles, 2128, 2139
AutoCAD, 170
Autodesk VIZ rendering, 494
creating, 497
curtain wall styles, 851, 961
display settings, 436, 472
door assembly styles, 1159
door components, 1045
door styles, 1048
doors, 1043
in display representations, 503
in elevations, 2151
listing, 516
mass elements, 641, 644
mass groups, 629, 641, 644
naming, 518
objects, 496, 497
objects that support, 495
overview, 491
properties, defining, 520
queries, 517
railings, 1640
rendering, 526
roof slab components, 1387, 1406
roof slab styles, 1385
roof slabs, 1378
roofs, 1328
section components, 2132
sections, 2093
slab components, 1736, 1752
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slab edge style, 1753
slab styles, 1735, 1739
space styles, 690, 692
spaces, 657, 683, 686
structural member styles, 1601, 1602
structural members, 1543
styles, 518
window assembly styles, 1159
window components, 1944
window styles, 1947
windows, 1943
 See also material boundaries

menus, enhancements to, 14
messages, diagnostic, 561
metric symbols, 2324, 2335

bathroom fittings, 2335
electrical services, 2336
furniture, 2336
kitchen fittings, 2337
office furniture, 2338
pipes and ducts, 2338
site symbols, 2339

mitered corners
curtain wall units, 995
curtain walls, 889
door assemblies, 1196
window assemblies, 1196

Model Explorer, 584
display commands, 648
left pane, 646
mass commands, 650
mass elements, 651

attaching, 652
mass groups, 651
mass models, 646
menu bar and toolbar, 647
opening, 648
right pane, 647
toolbar commands, 650
viewing objects, 649
zoom percentage and position, 650

mullions, curtain wall units
definitions, removing, 945
profiles, 941, 942
width and depth, 940

mullions, curtain walls
definitions, removing, 831

profiles, 828
width and depth, 827

mullions, door assemblies
definitions, removing, 1138
offsets, 1137
profiles, 1135, 1136
width and depth, 1134

mullions, window assemblies
definitions, removing, 1138
offsets, 1137
profiles, 1135, 1136
width and depth, 1134

multi-landing stairs
calculation rules, 1422
creating, 1418
floor settings, 1423
terminating with, 1421
turn types, 1420
vertical orientation, 1420

multiline text (MTEXT), enhancements to,
62

multi-view block definitions
classifications, 2466, 2489
creating, 2483, 2484
DesignCenter, adding to, 2490
in Style Manager, 531
notes and reference files, 2488
view blocks

connecting, 2487
creating, 2484
creating from, 2486

multi-view block references, object tags,
2234

multi-view blocks, 2481
adding to drawings, 2494
AEC content, 2348
attributes

editing, 2499
updating, 2499

definitions, changing associated, 2496
hyperlinks, notes, and reference files,

2498
location, 2497
modifying, 2496
offset, 2497
predefined, 2482
rotation, 2496
scale factor, 2496
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section marks, 2106
tools, creating, 2491
types of objects represented, 2482
 See Also multi-view block definitions

muntins, door. See door muntins
muntins, window. See window muntins
name definitions. See area name definitions
napkin sketch, 60

appearance of objects, 2520
changing, 2523
line formats, 2520
lock settings, 2523
napkin sketch tools, creation with,

2522
nested objects, 2523

node anchors
adding, 762
anchoring to different nodes, 763
changing position of objects anchored 

to, 763
copying objects to all layout nodes,

764
defined, 761

nodes, layout curves, 1249, 1250
non-AEC objects, identifying, 2527
object anchors

positioning, 772
releasing, 772
types, user-defined, 754
 See Also cell anchors, curve anchors, 

leader anchors, node anchors, 
volume anchors

Object Enabler, 566, 569
object tags, adding, 2234
Object Viewer, 2542
objects

adding to AEC dimension chain, 2385
alignment

in curtain walls, 907
in door assemblies, 1198
in window assemblies, 1198

command tools, 105
converting to 3D solids, 2525, 2526
default display properties, 457
detaching from AEC dimension chain,

2385
detaching mask blocks, 2473

direct manipulation, 18
display system, 435
displaying in viewports, 446
editing

in curtain walls, 906
in door assemblies, 1197
in window assemblies, 1197

existence in drawings, 489
facets, displaying, 564
layer, color, and linetype settings, 561
mask blocks, attaching, 2472
methods for adding, 96
methods for modifying, 102
offset

in curtain walls, 907
in door assemblies, 1199
in window assemblies, 1199

orientation
in curtain walls, 906
in door assemblies, 1198
in window assemblies, 1198

outlines, creating areas from, 1994
releasing

anchored objects in curtain walls, 908
anchored objects in door assemblies,

1199
anchored objects in window 

assemblies, 1199
subtracting from walls, 1856
walls, adding to, 1855

office furniture symbols (metric), 
DesignCenter, 2338

opening components
custom blocks for, 1306
display of, turning off, 1308
opening styles, removing from, 1309

opening endcap styles, 1894
applying, 1895
creating, 1895
notes and files, 1896
walls, 1894

opening endcaps, 1291
opening grips, editing openings using,

1288
opening head height, 1280
opening height, AEC dimension styles,

2408
opening percents

door, 1052
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window, 1951
opening sizes, 1279
opening thresholds, 1280
opening tools

copying, 1286
creating, 1286
finding in palettes, 1276

openings
aligning by threshold or head height,

1287
centering in walls from xref drawings,

1825
components, 1307, 1309
creating, 1278
creating in walls, 1278
custom shapes, 1281, 1283
dimension label, 2417
dimensions, 1290
display components, 1304, 1308
display properties, 1303
editing, 1288
enhancements to, 30
flipping, 1290
hatching, 1304
horizontal position, 1295
hyperlinks, 1303
insertion, 1280
location, 1302
moving, 1288
multiple, with same style, 1286
notes and reference files, 1303
opening endcap style, 1291
opening tools, creation with, 1277
positioning, 1280, 1287

horizontally, 1299
profiles, 1281
repositioning, 1292
shape, 1290
space boundaries, creation in, 1278
threshold or head height, alignment 

by, 1280
tool properties, 1292
vertical orientation, 1300
vertical position, 1296

optimization
Layer Manager, 388
limiting snap points, 561

Ortho Close option, 1408, 1897
palettes, default folders, 565
panels, door, 1045
password protection, 64
performance. See optimization
perspectives, generating, 60
pipe and duct symbols (metric), 

DesignCenter, 2338
plan hatch material components, 500
plan views, dimensioning. See elevation 

labels
planes, cut. See cut planes
plotting sheets, 324

annotation, 324
changing, 333
content of, 326
creating, 327
deleting, 332
external references, displaying, 332
opening and closing, 328
overview, 215
properties, 331
templates, 325
viewports, 324
views, referencing, 330
when to start with, 326
XML files, 325

Polyline Close option, 1897
creating a closed space, 1408

polyline outline from objects, 2532
polylines

converting to spaces, 667, 703
converting to wall modifiers, 1843
from area groups, 2055
from areas, 2015
generating spaces from, 669
roof slabs, 1343
slabs, 1710

prairie-12 lights in window muntins, 1966
prairie-9 lights in window muntins, 1962
preliminary studies. See mass models
preview graphics, 2346
profile definitions in Style Manager, 531
profiles

door geometry, 1042
railing components, 1689, 1693
window geometry, 1941
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Project Browser, 224
closing, 238
command line, 378
details, exporting, 380
displaying at startup, 224
drawings, opening, 235
Internet Explorer view, 227
navigation bar, 226
overview, 223
project header, 226
project selector, 226
projects

closing, 237
deleting, 237
moving, 236
renaming, 236

properties, 235
Project Navigator, 220, 239

AutoCAD undo commands, 240
categories, creating, 263
command line, 378

closing, 379
drag-and-drop operations, 249
MDI compliance, 383
opening, 240
project status bar, 249
shortcut menu, 246
tabs, 241

Constructs, 242
Project, 241
Sheets, 244
Views, 243

toolbar, 247
working without open drawings, 240

Project Navigator palette, 92
projects, 44

addendums, alternates, and as-builts,
381

AEC dimensions and external 
references, 382

annotating, 341
schedules, 343, 344
tagging, 342

archiving, 381
basepoints, 381
closing, 237
command line, 378

new project environment, 379
constructs

copying, 382
moving, 382

copying, 234
creating, 229, 233
current, selecting, 229
cut planes, 362

anchoring objects, 375
display range, 362
and levels, 363
manual, 376
object-specific, 362, 373, 374
overriding for walls, 374
overview, 218

default folders, 565
deleting, 237
details, adding, 231
dimensioning, 355
disk space needed for project files, 381
elements

copying, 382
locking, 382

external references, 220, 382
global cut planes, 362, 364

clipped model view, 370
display range, 365, 366, 367
displaying different levels, 368

legacy drawings, 219
moving, 236
opening drawings, 235
overview, 211
paths, 333
process overview, 221
project (APJ) file, 228
project-related information, 

removing, 238
properties, changing, 235
property sets, 344, 346, 348, 382

example of using, 352
renaming, 236
schedule tables, 351
schedule tags, 382
subcategories, 265
tips for working with, 220
title blocks, 356, 357

creating tools, 360
inserting, 360
multi-view blocks, 359
project attributes, 357
project blocks, 359

user access, 221, 381
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wall cleanup work, 382
XML files, 212, 220, 380

corrupted, 380
 See Also categories, constructs, 

divisions, Project Browser, 
Project Navigator

properties
AEC dimension styles, 2402
door, 1011
manual properties for objects, 2206
removing from objects, 2206
section lines, 2106
styles and definitions, 2207
types of, 2200
window, 1910

Properties palette, 11, 89, 142
appearance, 144
AutoCAD, 170
Design tab, 146
docking, 144
Extended Data tab, 147
hiding, 144
opening, 144
transparency, 145
worksheets, 148

property data formats, 2201, 2284
applying, 2284
creating, 2285
data types, 2284
managing, 2285
notes and reference files, 2289
property set definitions, 2242
using different, 2285

property set data
adding, 2204, 2231
attaching to objects and styles, 2207, 

2213
browsing, 2209
displaying, 2233
editing, 2204, 2228
exporting, 2213, 2221
objects and styles, attaching to, 2205
renumbering, 2220
schedule tags, 2201
styles and definitions, removing from,

2208
updating, 2213

property set definitions, 2199, 2241
automatic properties, 2243, 2252
classifications, 2259, 2296
creating, 2247
default, 2202
defining, 2241
door size properties, 2245
door swing direction properties, 2246
editing, 2265
formula property definitions, 2254
in Style Manager, 531
location property definitions, 2258
managing, 2242
manual property definitions, 2251
material property definitions, 2262
merging, 2268
notes and reference files, 2248
project property definitions, 2263
property data formats, 2242
slab and roof slab properties, 2245
specifying application of, 2248
structural member length properties,

2246
wall area properties, 2243
wall length properties, 2245
wall volume properties, 2244

property sets, 2241
formulas, 2246
manual and automatic properties,

2206, 2241
removing, 2206, 2268
schedule tables, 2199
types of properties, 2200

proxy graphics, 566, 568
pulldown menus, 83

locating commands, 106
restoring Release 3.3 menus, 107

pyramid mass elements, 592
queries, material, 517
Quick Slice command, 2532
radial dimensions, 2315
radial layout grids, 1255, 1257
radius, wall, 1770
railing styles

bottom rail location, 1677
changing, 1663
classifications, 1687
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components, 1680
creating, 1674
custom blocks

adding, 1689
removing, 1698
turning off, 1697

custom blocks and profiles, 1689
custom profiles

adding, 1693
turning off, 1697

defined, 1672
display components, 1686
extensions, 1682
files, 1688
materials, 1684, 1685
notes, 1688
post location, 1678
profile from closed polyline, 1681
upper rail location, 1675

railing tools
creating, 1651
finding in palettes, 1641

railings
anchor properties, changing, 1669
anchoring

to objects, 1659
to stairs, 1657

bottom rails, changing, 1664
direction, reversing, 1657
editing, 1652
enhancements to, 35
freestanding, 1647
hyperlinks, 1671
location, 1670
materials, 1640
multiple, with same style, 1651
notes, 1671
polylines, creating from, 1650
posts

adding, 1654
changing, 1665
hiding, 1656
redistributing, 1655
removing, 1655
showing hidden, 1657

railing extensions, 1667, 1668
railing tools, creation with, 1643
reference files, 1671
releasing anchored, 1660

stairs, attaching to, 1643
tool properties, 1671
upper rails, changing, 1663

ramps, creating, 1439
read-only drawings, status indicator, 536
rectangular layout grids, 1257, 1258
rectangular mass elements, 604
rectangular pattern in window muntins,

1955
reference AEC objects, 2534
reference files

AEC dimension styles, 2410
AEC polygon styles, 749
area group styles, 2064
area group templates, 2073
area name definitions, 2068
areas, 2022
calculation modifiers, 2027
curtain wall units, 968
curtain walls, 858
door assemblies, 1166
doors, 1054
opening endcap styles, 1896
railing styles, 1688
roof slab edges, 1407
roof slabs, 1392
slab edges, 1753
slabs, 1742
wall cleanup definitions, 1828
wall endcap styles, 1893
wall modifier styles, 1853
wall styles, 1885
walls, 1810
window assemblies, 1166
windows, 1953

removing frame, 824, 938, 1131
removing from style

curtain wall styles, 824
curtain wall unit styles, 938
door assembly styles, 1131
window assembly styles, 1131

rendering materials, assigning, 526
repeated components. See elements
reports, space totals, 696
representations, display. See display 

representations
revision clouds
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AutoCAD, 170
DesignCenter, 2328
symbols, 2311

revolution mass elements, 597
right triangle mass elements, 593
rigid frame structural members, 1627

first and second rafters, 1632
second segment, 1633

rise
door, 1018
window, 1918

roof dormers, 1376
roof fascia, 1392
roof grips, editing roofs using, 1324
roof lines

editing, 1799
offsetting, 1794
projecting, 1794
reversing, 1801
steps, adding, 1798
wall, 1774

roof lines, curtain walls
changing, 891, 899
offsetting, 892
projecting, 892
vertices, changing, 900

roof lines, walls, 1794
changing, 1793, 1798
vertices, changing, 1802

roof slab bodies, 1333
roof slab edge material components, 1405
roof slab edge styles, 1394

angles, 1401
creating, 1394
defined, 1392
edge cuts, 1401
fascia

geometry, 1398, 1750
placement, 1393
specifying, 1402

materials, 1404
notes and reference files, 1407
overhang, 1401
profile edges and extrusion, 1397
profiles

fascia, 1395
polylines, 1396, 1397
soffits, 1395

soffits
geometry, 1398, 1750
placement, 1393
specifying, 1402

roof slab edges, 40
creating with grips, 1353
defined, 1334
editing, 1362
overhang, 1354

roof slab grips, 1351
roof slab material components, 1386
roof slab materials, 1387, 1406
roof slab offsets, 1361
roof slab slope

changing, 1361
changing with grips, 1356

roof slab styles
classifications, 1391, 1741
creating, 1384
cut plane height, 1391
defined, 1383
display components and materials,

1385
display properties, 1388
fixed thickness, 1384
hatching, 1389
notes and reference files, 1392

roof slab thickness
changing, 1361
changing with grips, 1359
roof slab styles, 1384

roof slab tools
creating, 1348
finding in palettes, 1337

roof slabs, 39
adding objects to, 1374
based on walls, 1340
clipped gable, 1373
creating, 1332, 1338, 1345

from roofs, 1327, 1339
cutting, 1369
defined, 1311
display properties, 1379
dormers, 1376
edge styles, 1392
editing, 1350
extending, 1364
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hatching, 1380
holes, 1371, 1373
location, 1382
materials, 1378
mitering, 1367, 1368
moving, 1350
multiple with same style, 1348
notes and reference files, 1382
plane height, 1381
polylines, 1343
properties, 1360, 2245
removing objects from, 1376
styles, 1362
subtracting objects from, 1375
trimming, 1363
vertices, 1370, 1371
xcut, 1373

roof soffits, 1392
roof tools

creating, 1322
finding in palettes, 1313

roofs
dimensions, 1325
display components and materials,

1328
display properties, 1328
edges and faces, 1326
editing, 1323
hatching, 1329
location, 1331
moving, 1323
multiple, with same style, 1322
notes and reference files, 1331
polylines, creating from, 1318
roof slabs, converting to, 1327
tool properties, 1324
walls, creating from, 1317

room finish tags, 2235
room tags, 2235
rooms. See space boundaries
rules, design. See design rules
sash, window, 1944
scale

documentation symbols, 2310
specifying in drawings, 556

schedule table styles, 2197, 2212, 2269
columns, 2276, 2279

creating, 2271
default, 2202
default format of, 2273
display properties, 2282
filtering by classification, 2275
headings, 2278
notes and reference files, 2283
sort order, 2280
specifying objects, 2274
title formats, 2281
troubleshooting, 2303

schedule tables, 2197
adding, 2216
adding objects to, 2218
cell data, editing, 2228
creating, 2211

using tools, 2211
display properties, 2222
editing, 2211
enhancements to, 48
exporting, 2221
exporting property set data, 2221
external source properties, 2226
hyperlinks, notes, and reference files,

2228
markers, turning off, 2217
placement, 2225
properties, 2223
property set data, adding, 2231
removing objects from, 2219
reselecting objects, 2219
selection criteria, 2224
showing objects, 2219
table breaks, 2226
tools, creating, 2214
troubleshooting, 2300
updating, 2218
 See Also schedule table styles

schedule tags, 2231
adding, 2231
anchoring to objects, 2236
custom, 2237

adding to DesignCenter, 2240
blocks, 2238

default, 2202
DesignCenter, 2328
doors and windows, adding to, 2233
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property set data, 2201, 2233
relationships with objects, 2236
releasing anchored objects, 2236
room finish tags, 2235
room tags, 2235
wall tags, 2235

schedules, 2197
classifications, 2204
creating, 2202
renumbering property set data, 2220
 See Also schedule tables

section hatch linework, 2137
section hatch material components, 502
section lines, 2099

changing, 2100
defined, 2090
graphic subdivisions, 2105
hyperlinks, notes and reference files,

2107
location properties, 2106
and section marks, 2101
viewing, 2099

section marks, 2316
attributes, 2106
defined, 2090
Design Center, 2329
and section lines, 2101

section subdivisions. See subdivisions, 
section

section views, dimensioning. See elevation 
labels

sectioned bodies in live section views, 2112
sectioned body material components, 502
sectioned boundary material components,

502
sections

defining lines, 2135
dimensions, changing, 2103
display components, 2132
enhancements to, 46
erased component, 2138
hidden component, 2138
live section views, 2092, 2110, 2150
location properties, 2106
material boundaries, 2095, 2118
materials, 502, 2093, 2133
section hatch linework, 2137

shrinkwrap, 2135
shrinkwrap hatch, 2136
subdivisions, 2094, 2101, 2138
surface hatch linework, 2137
See also 2D sections and 3D sections

security enhancements, 64
Select Color dialog box, 59
shaded viewport plotting, 60
sheet creation, automatic, 45
shortcut menus, 87
shrinkwrap, 2135

cut plane display, 1808, 1882
shrinkwrap hatch, 2136
signatures, digital, 66
sills, 1301
sills of openings, changing, 1301
sills of windows, changing, 1952
site symbols (metric), DesignCenter, 2339
sizes

door, 1012
door assemblies, 1188
doors, 1006
openings, 1279
window assemblies, 1188
windows, 1906

slab edge styles, 1745
angles, 1746
creating, 1745
defined, 1743
edge cuts, 1746
fascia

placement, 1743
specifying, 1749

materials, 1753
notes and reference files, 1753
overhang, 1746
profiles

fascia, 1747
soffits, 1747

soffits
placement, 1743
specifying, 1749

slab edges, 40
defined, 1700
editing, 1722
overhang, 1718

slab properties, 2245
slab styles
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changing, 1714
creating, 1733
cut plane height, 1741
defined, 1732
display components and materials,

1735
display properties, 1737
fixed thickness, 1734
hatching, 1739
materials, 1739
notes and reference files, 1742

slab tools
creating, 1706
finding in palettes, 1703

slabs, 40
adding objects to, 1729
based on walls, 1708
bodies, 1699
components, 1738
creating, 1704
creating with slab tools, 1703
cutting, 1725
dimensions, 1712
edge styles, 1743
editing, 1711
extending, 1724
grips, 1712
holes, 1727, 1729
justification, 1705
location, 1731
material components, 1735
materials, 1736, 1752
moving, 1711, 1731
multiple walls, 1709
multiple with same style, 1706
notes and reference files, 1731
offsets, 1716
perimeters, 1714
pivot points, 1721
polylines, 1710
removing objects from, 1730
slopes, 1719, 1720
subtracting objects from, 1730
thickness, 1715, 1734
tool properties, 1722
trimming, 1722
vertices, 1726, 1727

slices, 713
attaching objects, 715
converting

to boundaries, 702
to polylines, 716

detaching objects, 716
elevation, 715
generating, 714
hyperlinks, notes, and reference files,

717
location, 716

sloped roofs
creating, 1319
creating with roof tools, 1314

snapshots, layer. See layer snapshots
soffits, 1743

roof styles, 1335, 1392, 1701
space boundaries, 696

anchoring objects, 709
converting

sketching to, 703
slices to, 702
spaces to, 702
to walls, 710

creating, 698
edges, 704, 705, 709
editing, 710, 711
hyperlinks, notes, and reference files,

712
location, 712
merging, 704
moving

doors along, 1016, 1023
doors within, 1016, 1025
windows along, 1922
windows within, 1925

releasing objects, 709
spaces, attaching, 703
splitting, 704

space styles, 657, 677, 687
creating, 688
dimensions, 689
display properties, 693
hatching, 693
materials, 690, 692
notes and reference files, 695
tools, creating with, 658
 See Also mass element styles
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spaces, 21, 656
area totals, 695
boundaries

attaching to, 703
converting to, 702

ceiling boundaries, 663
component dimensions, 681
constraining, 665
converting polylines to, 667
creating, 660
display components, 684, 691
display representations, 685
dividing, 679
drag points, 666
editing, 675
editing with grips, 677
floor boundaries, 664
generating

from linework, 671
from walls, 667
from walls, lines, arcs, polylines, and 

circles, 669
hyperlinks, notes, and reference files,

682
interference conditions, 680
joining, 679
location, 681
materials, 657, 683, 686
planning, 656
reports, 696
size, 677
styles, 677
tools, 658, 673
updating, 672
user-defined settings, 660
variables tracked, 657
viewing information, 695

spacing modes
layout curves, 1250
layout grids, 1260
layout volumes, 1270

special conditions in a wall, 1833
sphere mass elements, 595
spiral stairs

arc constraints, 1438
calculation rules, 1437
constraints, changing, 1473
creating, 1432

drawn direction, changing, 1472
floor settings, 1438
horizontal orientation, 1434
outside edge, changing, 1474
terminating with, 1436
vertical orientation, 1435

stair anchors
landing, 1483
releasing, 1485

stair dimensions
height, changing, 1471
justification, changing, 1472
multi-landing stairs, changing, 1446
spiral, changing, 1456
straight stairs, changing, 1444
u-shaped, changing, 1452
width, changing, 1458

stair flights
components, changing, 1500
shape, 1460

stair height
multi-landing stairs, changing, 1449, 

1451
spiral stairs, changing, 1457
straight stairs, changing, 1445
u-shaped stairs, changing, 1455

stair interference conditions, 1490
curtain walls, 1496
door assemblies, 1497, 1498
size, changing, 1498
slabs, 1492, 1493
spaces, 1495
walls, 1491, 1492
window assemblies, 1497, 1498

stair landings
components, changing, 1501
extensions, changing, 1503
shape, 1463

stair location
multi-landing stairs, changing, 1447
spiral stairs, changing, 1457
straight stairs, changing, 1444
u-shaped stairs, changing, 1453

stair sides, changing shape, 1464
generating polyline, 1470
offsetting side, 1469
projecting side, 1467
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removing changes, 1471
stair styles

changing, 1472
classifications, 1533
color, 1529
components, 1523, 1527
creating, 1518
defined, 1516
dimension properties, 1519
display properties, 1528, 1530
editing, 1519
files, 1534
landing extensions, 1524
layer, 1529
linetype, 1529
materials, 1526, 1527
notes, 1534
riser numbering display, 1532
stringers, 1520

stair tools
creating, 1440
finding in palettes, 1413

stair winder styles
creating, 1535
defined, 1535
files, 1537
notes, 1537
settings, 1536

stair winders
editing, 1485
manual editing, 1489
single point editing, 1486

stairs
AEC options, 1412
attaching railings, 1643
components, 1510
cut planes, 1510
dimension label, 2417
dimensions, 1477
display properties, 1512
display properties, changing, 1509
editing, 1441
enhancements to, 34
files, 1515
grips, 1443
hyperlinks, 1515
location, 1507

materials, specifying, 1508
multiple, with same style, 1440
notes, 1515
overlapping, 1505
riser numbers, displaying, 1514
shape, 1448
stair tools, creation with, 1414
tool properties, 1507

standards, layer. See layer standards
starburst pattern in window muntins, 1970
status indicator for read-only drawings, 536
steps, adding to roof or floor line, 903, 1798
Stock Tool catalog

categories, 189
viewing, 176

stops, door, 1045
straight curtain walls

curtain wall tools, creation with, 781
straight stairs

calculation rules, 1417
creating, 1414
terminating with, 1416
vertical orientation, 1416

structural column grid tools, 1209
structural column grids, 1209
Structural Member Catalog, 1540

browsing, 1546
content of, 1547
opening, 1548
opening catalog files, 1550
organization of, 1546
shapes, locating, 1550
structural member styles, creating,

1546, 1547, 1549
structural member length properties, 2246
Structural Member Style wizard, 1540

structural member styles, creating,
1551

structural member styles, 1599
catalog shapes, creating from, 1547, 

1549
changing, 1597
classifications, 1613
custom, 1636, 1637, 1638
custom blocks

adding, 1610, 1611
removing, 1613
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turning off, 1612
cut plane elevation, 1609
display problems, 539
display properties, 1603
hatching, 1608
layer, color, and linetype, 1607
materials, 1601, 1602
notes and reference files, 1614
Structural Member Catalog, 1546
Structural Member Style wizard, 1551
Style Manager, 1600

structural members, 1539
creating, 1545
curved structural members, 1590
custom shapes

adding, 1620
copying, 1636
creating, 1634
editing, 1637
purging, 1638

display representations, 1604
editing, 1581
enhancements to, 37
grips, editing with, 1581
hyperlinks, notes, and reference files,

1598
justification, 1591
length, 1586
linework, creating from, 1580
location, 1597
materials, 1543
modifying, 1617, 1619
multi-component, 1624, 1627
radius of curved, 1589
rigid frames. See rigid frame structural 

members
shapes, adding, 1620
start and end offsets, 1587
styles, 1597
tool properties, 1597
tools, 1553, 1562

beam tools, 1554
brace tools, 1557
column tools, 1560

trim planes, 1593, 1594, 1596
type of, 1592

Style dialog box, 533
Style Manager

drawings and templates
closing, 541, 543
creating new, 542
determining status of, 541
dragging, 542
opening, 540, 542

enhancements to, 16
left pane, 534
menu bar and toolbar, 535
opening, 535
overview, 532
right pane, 534
status bar, 535
structural member styles, 1600
styles

creating, 543
dragging to tool palettes, 532
sorting, 536
viewing, 539

styles
attaching property set data, 2207
copying between drawings, 545
creating, 543
creating tools from, 532, 544
displaying, 534
entering properties, 2207
layer key, 531, 532
location of files, 167
materials, 496, 518
opening endcaps, 1894
predefined, 532
previewing, 534
removing property set data, 2208
renaming, 544
sending to other users, 546
sorting, 536
spaces, 687
structural member, 539
unused, removing, 547
viewing, 539
viewing across multiple drawings, 539
wall endcaps, 1886
walls, 1782
 See also individual component names, 

Style Manager
subcategories. See categories, project
subdivisions, section, 2092, 2094, 2101

components, 2138
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display of, 2115, 2116
section lines, 2105

subtractive mass elements, 635, 653
sunburst pattern in window muntins, 1973
support files, location of, 167
support, Autodesk Professional Services, 72
surface hatch linework, sections, 2137
surface hatch material components, 500
surface hatches, 504

curved surfaces, 505
extrusions, 507
free form mass elements, 509
hidden, displaying, 512
hiding, 511
multiple faces, 506
offset, horizontal and vertical, 514
overrides, editing, 516
overriding, 510
patterns, 523
rotation, 513

swings, door
angles, 1021
direction, 1017
displaying as straight line, 1052
location, 1017

swings, window
angles, 1920
direction, 1917
location, 1917

symbols, design content. See DesignCenter
templates

area evaluation documents, 2084
closing in Style Manager, 541, 543
creating drawings from, 551
creating in Style Manager, 542
default folders, 550, 565
defined, 550
dragging in Style Manager, 542
location of files, 167
opening in Style Manager, 540, 542
predefined display configurations, 435, 

436
terminating with

multi-landing stairs, 1421
spiral stairs, 1436
straight stairs, 1416
u-shaped stairs, 1429

third-party support, 73
thresholds, door

display properties, 1053
symbols, 1053

thumbnails, drawing, 62
title blocks, 356, 357

inserting, 360
multi-view blocks, 359
project attributes, 357
project blocks, 359
tools, creating, 360

title marks, 2317
DesignCenter, 2330

tool catalog libraries, 172
catalogs

adding, 182
copying, 183
creating, 181
editing properties, 185
moving, 183
removing, 186
viewing, 176

opening, 186
renaming, 187
websites, adding, 184

tool catalogs
catalog libraries, 182
categories, definition of, 189, 191
copying, 183

tool packages, 203
tool palettes, 202

creating, 181
customizing tools, 198
deleting items, 199
dragging items to workspace, 179
i-drop icon, 178
linked and unlinked items, 200, 201
moving, 183
moving tools between, 196
name limitations, 182
opening in Content Browser, 205
properties, editing, 185
read-only, 178
refresh options for tool palettes, 204
removing, 186
searching, 187, 188
supplied with Autodesk Architectural 

Desktop, 173



2600 | Index

tool packages, adding, 193
tool palettes, adding, 193
tools

adding, 194
using, 201

viewing, 176
tool packages

adding to tool catalogs, 193
adding tools, 194
copying, 195, 203
moving, 195
moving tools between, 196
opening in Content Browser, 206
overview, 191

tool palettes, 8, 88, 108
adding to tool catalogs, 193
adding tools, 136, 194
appearance, 116
AutoCAD, 169
centralized location, 120
Content Browser

adding from, 121
updating from, 122

copying, 195, 202
creating, 116
dragging to workspace, 179
moving, 195
moving tools between, 196
opening in Content Browser, 206
overview, 190
refreshing, 204
updating tools, 138, 139

tool palettes set
appearance, 111
creating, 114
docking, 112
hiding, 112
opening, 110
renaming, 113
switching between different, 114
transparency, 113

toolbars, 84
tools

AEC dimension, 2374, 2383
AEC polygon, 725, 727
anchor, 773
annotation, 2318

area, 1996, 1997
area group, 2045
AutoCAD, 169
ceiling grid, 1225, 1231
centralized location, 136
column grid, 1203
copying from tool palettes, 131
creating, 126

DesignCenter, 133
from objects, 131
Style Manager, 132

creating from styles, 532, 544
curtain wall, 791
custom commands, 134
deleting, 141
door, 1004, 1008, 1009
door assembly, 1100
images, 128
layout curves, 1247
layout grids, 1254
layout volumes, 1265
openings, 1276, 1286
overview, 109, 123
properties, 127
railing, 1641, 1651
refreshing, 203
reimporting styles, 141
removing links, 140
roof, 1313, 1322
roof slabs, 1337, 1348
slab, 1703, 1706
stair, 1413, 1440
structural column grid, 1209
style location, 125
tool palettes

adding to, 136
updating, 138, 139

wall, 1759, 1766
window, 1904, 1907
window assembly, 1100

training, Autodesk Professional Services, 72
trigger grips, 154
trim planes, structural members, 1593, 

1594, 1596
troubleshooting

AEC Editor, 561
classifications, 2305
display changes upon dragging, 489
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display system, 487
existence of objects in drawings, 489
linetypes, 490
schedule table styles, 2303
schedule tables, 2300
viewports, 488
wall cleanups, 1821

true colors, 59
AEC polygons, 748
masking in AEC polygons, 748

turn types
multi-landing stairs, 1420
u-shaped stairs, 1427

UNITS command, redefined, 553
units, specifying in drawings, 554
user interface

enhancements, 8
user interface, locating objects and 

commands, 96
u-shaped stairs

alignment, changing, 1499
calculation rules, 1430
constraints, 1431
creating, 1425
floor settings, 1432
horizontal orientation, 1427
terminating with, 1429
turn types, 1427
vertical orientation, 1428

utilities
referencing AEC objects, 2534

vertical orientation
multi-landing stairs, 1420
spiral stairs, 1435
straight stairs, 1416
u-shaped stairs, 1428

vertices in roof and floor lines, 904, 1802
videos

creating, 2515
dry runs, 2513

view directions
and display representations, 455
assigning display sets, 467

viewers, placement of, 561
viewport layer mapping, 572
viewports

display configurations, 445

assigning, 467
default, 468

displaying objects, 435, 446
plotting shaded, 60
troubleshooting, 488

views, 307
annotation, 309
changing, 323
and constructs, 308
content, 323
creating, 312, 313

assigning levels and divisions, 315
defining properties, 313
selecting constructs, 316
setting viewport defaults, 318

deleting, 323, 324
external references, displaying, 319
layer snapshots, 309
names and categories, 323
opening and closing, 320
overview, 214
and plotting sheets, 308
projects, adding to, 323
properties, 321
regenerating, 322, 378
templates, 311
updating, 310
when to start with, 311
XML files, 310

Visual Audit utility, 2527
volume anchors

adding, 769
anchoring to different volumes, 771
copying objects to all layout volumes,

771
defined, 769
position of objects attached to, 

changing, 770
size of objects attached to, changing,

770
volumes, layout. See layout volumes
wall area properties, 2243
wall base height, 1770
wall body modifiers

editing, 1860
geometry, 1858
removing, 1860
restoring to mass element, 1861
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wall components
adding to, 1855
replacing, 1857
subtracting from, 1856

working with, 1854
wall cleanup definitions, notes and 

reference files, 1828
wall cleanup groups

assigning different definitions, 1818
creating, 1827
definitions, 1826

wall cleanups, troubleshooting, 1821
wall component index, 1871
wall components

cleanup priorities of, 1871
hatching, 1806, 1881
layer, color, and linetype, 1805, 1880
material components, 1877

wall endcap styles, 1886
applying, 1887
creating, 1887
geometry, 1891
notes and files, 1893
overriding graphically, 1783
polylines used in, 1886
polylines, creating from, 1889
wall endcap profile, 1890

wall grips, 1770
wall interference conditions, 1861
wall length

changing, 1770
properties, 2245

wall modifier styles
creating, 1853
notes and files, 1853

wall modifiers
adding, 1845
apply opposite face, 1841
bump-outs or chases, 1841
converting polylines to, 1843
editing, 1847
placement, 1851
removing, 1864
working with, 1841

wall properties, 1864
wall radius, 1770
wall roof lines, 1774

wall styles
adding component from another style,

1875
classifications, 1884
complex endcaps, 1883
components, 1868, 1872

creating, 1872
hatching, 1881
miters, 1883
removing, 1876
viewing, 1869
width and offset, 1899

components browser, 1870
creating, 1866
cut planes, 1882
defined, 1865
display properties, 1879
endcap styles, 1868
information, 1883
materials, 1876, 1878
notes and reference files, 1885

wall sweeps
adding to walls, 1836
editing, 1840
geometry, 1838
mitering, 1840
profiles, creating for, 1836
removing, 1840

wall tags, 2235
wall tools

creating, 1766
finding in palettes, 1759

wall volume properties, 2244
wall width, 1770
walls

3D objects, creating from, 1765
adding and subtracting objects, 1855, 

1856
anchoring objects to, 1832
base height, changing, 1776
chamfering, 1789
cleanup, 1811, 1818
cleanup circles, 1812
cleanup guidelines, 1817
cleanup priorities, 1815
cleanup radius, 1820
converting

polylines to wall modifiers, 1843
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space boundaries to, 710
converting to curtain walls, 790
creating, 1760
creating roofs from, 1317
curved walls, 1898
customized surfaces, 1833
cut plane display, 1808
defaults, 1758
direction, 1756, 1793
display properties, 1805, 1809
door assemblies, adding, 1831
doors, adding to, 1704, 1831
duplicated in xref drawings, 1825
editing, 1769
endcap styles, 1886
enhancements to, 24
filleting, 1787
floor line vertices, 1898
floor lines, 1793, 1795
gable roof lines, 1796
generating spaces from, 667, 669
graphlines, 1812, 1819
interference conditions, 1863, 1864
interference objects, modifying, 1864
joining, 1787
justification, 1762, 1777
length, changing, 1777
linework, creating from, 1764
location, 1783
materials, 1804
merging, 1784
modifier styles, 1853
modifiers, 1841, 1847
moving, 1769, 1778
multiple, with same style, 1766
notes and reference files, 1810
objects

adding, 1829
detaching, 1833
removing, 1832

offsets, 1763, 1778
opening endcap styles, 1894, 1895
openings, 1830
position, 1781
profiles for sweeps, 1836
releasing doors from, 1033
removing all merged, 1786

removing individual merged, 1786
replacing walls with objects, 1857
repositioning, 1780
roof line vertices, 1898
roof lines, 1793, 1794
shape, changing, 1775
special conditions, 1833
start and end points, 1793
styles, 1782
sweeps, 1835

adding to, 1836
editing, 1840
geometry, 1838
mitering, 1840
removing, 1840

tool properties, 1782
trimming, 1792
true length, 1897
vertices in roofs and floors, 1802
wall component priorities, changing,

1820
wall modifiers, 1845, 1851
wall styles, width, 1899
wall tools, creation with, 1759
width, changing, 1776
window assemblies, adding, 1831
windows, adding, 1829

websites, adding to tool catalog libraries,
184

width
door, 1012, 1020
door assembly, 1188
wall, 1770
window assembly, 1188

winders
editing, 1485
manual editing, 1489
single point editing, 1486

window assemblies
alignment of objects in cells, 1198
auto-adjusting cells, 1112
cell markers, 1168
centering in walls from xref drawings,

1825
creating, 1092, 1095
curtain walls, inserting into, 839
custom grids, 1098
dimensions, 1192
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display of, 1160
division overrides, 1180
editing, 1186
editing objects in cells, 1197
enhancements to, 33
frame and mullion overrides, 1174
frame edges, 1176
frames and mullion overrides, 1173
freestanding, 1193
height, 1188, 1190
hyperlinks, 1196
infills

for inserting objects, 1120
overrides, 1171

in-place editing, 1178
interference conditions, 1194, 1195
matching properties, 1192
materials, 1159
merging cells, 1169
mitering, 1195, 1196
moving, 1186, 1191
mullion edges, 1176
multiple, with same style, 1100
nested grids, 1142, 1145
notes and reference files, 1196
offset of objects in cells, 1199
orientation of objects in cells, 1198
positioning, 1095
releasing anchored objects in cells,

1199
removing overrides, 1185
sizes, 1188
swapping two objects, 1199
width, 1188, 1189
window assembly tools, creation with,

1094
window assembly cells

cell assignment, 1148
filling with panel, 1146
infills

defining, 1117
removing, 1148

objects, inserting, 1147
window assembly components

custom graphics, 1163
display, 1161
hatching, 1162

layer, color, and linetype, 1162
window assembly dimensions, 1095
window assembly frame, 1131
window assembly frames, 1151
window assembly grids

cells, 1140
fixed size, 1110
manually defining number and size,

1114
custom, 1098
divisions, 1108, 1109, 1140
elements, 1090, 1091
fixed number, 1113
frame edges, 1152, 1153
frames, adding, 1151
mullions, 1132, 1134, 1135, 1136, 

1137, 1138
nested grids, 1142
offset, 1115

window assembly grips
editing window assemblies using, 1188

window assembly height, 1188
window assembly properties, 1167
window assembly styles, 1132

assigning
definitions to elements, 1139
definitions to mullions, 1154
divisions to grids, 1140
infills to cells, 1140

assignments, 1150
cell infills, 1140
changing, 1191
creating, 1106
creating cut planes, 1165
defined, 1102
division definitions, 1117
element of, 1185
elements of, 1105, 1139
frame offsets, 1130
frames, 1125

width and depth, 1126
grid cells, 1108, 1110
infills

alignment, 1121
definitions, 1124
offset, 1122
overriding, 1168

matching styles, 1192
mullions
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assignments, 1155
definitions, 1138
offsets, 1137
removing from grids, 1156
width and depth, 1134

notes and reference files, 1166
overrides, 1167
overview of creating, 1103
panel infills, 1119
profiles

frames, 1127, 1128
mullions, 1135, 1136

shape, 1193
window assembly tools, 1100
window assembly width, 1188
window components

custom blocks for, 1948
display of, turning off, 1950
layer, color, and linetype, 1946
window styles, removing from, 1951

window dimensions
changing, 1920
changing for window styles, 1937

window frames, assigning materials to,
1944

window grips, 1911
window head height, aligning window by,

1907
window hinges, 1917
window materials, 1944
window measurements. See window 

dimensions
window muntins

diamond pattern, 1958
display of, turning off, 1980
editing, 1979
gothic pattern, 1977
materials, 1944
prairie-12 lights, 1966
prairie-9 lights, 1962
rectangular pattern, 1955
starburst pattern, 1970
sunburst pattern, 1973
window styles, removing from, 1981

window opening endcaps, 1932
window opening percents, 1951
window properties, 1910
window rise, 1918

window sash materials, 1944
window sill height, 1907
window sills, 1952
window sizes, 1906
window styles

changing, 1919
components, 1948, 1951
creating, 1936
creating window tools from, 1908
custom window shapes, 1939
defined, 1935
design rules for, 1940
dimensions, 1937
display of components, turning off,

1950
geometry, 1941
materials, 1947
muntins, 1981
notes and files, 1953
opening percentage, 1951
standard sizes, 1938

window swings
angles, 1920
direction, 1917
location, 1917
opening percent, 1920

window tools
creating, 1907
finding in palettes, 1904

window width, 1920
windows

aligning by head height or sill height,
1907

centering in walls from xref drawings,
1825

creating
in space boundaries, 1905
in walls, 1905

custom shapes, 1939
dimension label, 2417
display components and materials,

1943
editing, 1910
enhancements to, 29
freestanding, 1933
geometry, 1941
horizontal position, 1926
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inserting, 1907
into door assemblies, 1147
into window assemblies, 1147

inserting into curtain walls, 839
moving, 1910

along walls, 1922
within walls, 1925

multiple with same style, 1907
notes and reference files, 1934
opening endcap styles, 1932
positioning, 1906, 1910

horizontally, 1930
schedule tags, adding, 2233
standard sizes, 1938
type and shape, 1940
vertical alignment, changing, 1921
vertical orientation, 1932
vertical position, 1928
window tools, creation with, 1904

wings. See divisions
wizard, Create AEC Content, 2343, 2460
workspace, 77

application status bar, 91
command line, 89

Communication Center, 91
configurations, 93
Content Browser, 79
direct manipulation, 79
drawing management, 80
drawing window status bar, 90
in-place editing, 79
Project Navigator palette, 92
Properties palette, 78, 89
pulldown menus, 83
shortcut menus, 87
styles, 79
templates, 79
tool palettes, 78, 88
toolbars, 84
tools, 78

XML files
constructs, 269
corrupted or deleted, 380
elements, 291
plotting sheets, 325
project, 212, 220, 380

xrefs. See external references (xrefs)


